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About the Documentation

• Documentation and Release Notes on page li

• Documentation Conventions on page li

• Documentation Feedback on page liii

• Requesting Technical Support on page liv

Documentation and Release Notes

To obtain the most current version of all Juniper Networks
®
technical documentation,

see the product documentation page on the Juniper Networks website at

https://www.juniper.net/documentation/.

If the information in the latest release notes differs from the information in the

documentation, follow the product Release Notes.

Juniper Networks Books publishes books by Juniper Networks engineers and subject

matter experts. These books go beyond the technical documentation to explore the

nuances of network architecture, deployment, and administration. The current list can

be viewed at https://www.juniper.net/books.

Documentation Conventions

Table 1 on page lii defines notice icons used in this guide.
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Table 1: Notice Icons

DescriptionMeaningIcon

Indicates important features or instructions.Informational note

Indicates a situation that might result in loss of data or hardware damage.Caution

Alerts you to the risk of personal injury or death.Warning

Alerts you to the risk of personal injury from a laser.Laser warning

Indicates helpful information.Tip

Alerts you to a recommended use or implementation.Best practice

Table 2 on page lii defines the text and syntax conventions used in this guide.

Table 2: Text and Syntax Conventions

ExamplesDescriptionConvention

To enter configuration mode, type the
configure command:

user@host> configure

Represents text that you type.Bold text like this

user@host> show chassis alarms

No alarms currently active

Represents output that appears on the
terminal screen.

Fixed-width text like this

• A policy term is a named structure
that defines match conditions and
actions.

• Junos OS CLI User Guide

• RFC 1997,BGPCommunities Attribute

• Introduces or emphasizes important
new terms.

• Identifies guide names.

• Identifies RFC and Internet draft titles.

Italic text like this

Configure themachine’s domain name:

[edit]
root@# set system domain-name
domain-name

Represents variables (options for which
you substitute a value) in commands or
configuration statements.

Italic text like this
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

• To configure a stub area, include the
stub statement at the [edit protocols
ospf area area-id] hierarchy level.

• Theconsoleport is labeledCONSOLE.

Represents names of configuration
statements, commands, files, and
directories; configurationhierarchy levels;
or labels on routing platform
components.

Text like this

stub <default-metricmetric>;Encloses optional keywords or variables.< > (angle brackets)

broadcast | multicast

(string1 | string2 | string3)

Indicates a choice between themutually
exclusive keywords or variables on either
side of the symbol. The set of choices is
often enclosed in parentheses for clarity.

| (pipe symbol)

rsvp { # Required for dynamicMPLS onlyIndicates a comment specified on the
same lineas theconfiguration statement
to which it applies.

# (pound sign)

community namemembers [
community-ids ]

Encloses a variable for which you can
substitute one or more values.

[ ] (square brackets)

[edit]
routing-options {
static {
route default {
nexthop address;
retain;

}
}

}

Identifies a level in the configuration
hierarchy.

Indention and braces ( { } )

Identifies a leaf statement at a
configuration hierarchy level.

; (semicolon)

GUI Conventions

• In the Logical Interfaces box, select
All Interfaces.

• To cancel the configuration, click
Cancel.

Representsgraphicaluser interface(GUI)
items you click or select.

Bold text like this

In the configuration editor hierarchy,
select Protocols>Ospf.

Separates levels in a hierarchy of menu
selections.

> (bold right angle bracket)

Documentation Feedback

We encourage you to provide feedback so that we can improve our documentation. You

can use either of the following methods:

• Online feedback system—Click TechLibrary Feedback, on the lower right of any page

on the Juniper Networks TechLibrary site, and do one of the following:
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• Click the thumbs-up icon if the information on the page was helpful to you.

• Click the thumbs-down icon if the information on the page was not helpful to you

or if you have suggestions for improvement, and use the pop-up form to provide

feedback.

• E-mail—Sendyourcommentsto techpubs-comments@juniper.net. Includethedocument

or topic name, URL or page number, and software version (if applicable).

Requesting Technical Support

Technical product support is available through the JuniperNetworksTechnicalAssistance

Center (JTAC). If you are a customer with an active Juniper Care or Partner Support

Services support contract, or are covered under warranty, and need post-sales technical

support, you can access our tools and resources online or open a case with JTAC.

• JTAC policies—For a complete understanding of our JTAC procedures and policies,

review the JTAC User Guide located at

https://www.juniper.net/us/en/local/pdf/resource-guides/7100059-en.pdf.

• Product warranties—For product warranty information, visit

https://www.juniper.net/support/warranty/.

• JTAC hours of operation—The JTAC centers have resources available 24 hours a day,

7 days a week, 365 days a year.

Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online

self-service portal called the Customer Support Center (CSC) that provides youwith the

following features:

• Find CSC offerings: https://www.juniper.net/customers/support/

• Search for known bugs: https://prsearch.juniper.net/

• Find product documentation: https://www.juniper.net/documentation/

• Find solutions and answer questions using our Knowledge Base: https://kb.juniper.net/

• Download the latest versions of software and review release notes:

https://www.juniper.net/customers/csc/software/

• Search technical bulletins for relevant hardware and software notifications:

https://kb.juniper.net/InfoCenter/
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• Join and participate in the Juniper Networks Community Forum:

https://www.juniper.net/company/communities/

• Create a service request online: https://myjuniper.juniper.net

Toverify serviceentitlementbyproduct serial number, useourSerialNumberEntitlement

(SNE) Tool: https://entitlementsearch.juniper.net/entitlementsearch/

Creating a Service Request with JTAC

You can create a service request with JTAC on theWeb or by telephone.

• Visit https://myjuniper.juniper.net.

• Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see

https://support.juniper.net/support/requesting-support/.
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PART 1

Overview

• Working with Connectivity Services Director on page 3

• Service View Tasks and Lifecycle Modes on page 35

• Network Services Overview on page 51
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CHAPTER 1

Working with Connectivity Services
Director

• Connectivity Services Overview on page 3

• Getting Started with Connectivity Services Director on page 5

• Connectivity Services Director REST API Overview on page 8

• Understanding the Need for Connectivity Services Director for Managing

Services on page 12

• Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity

Services Director on page 13

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Understanding the Usage and Layout of Connectivity Services Director Views and

Tasks on page 23

• Understanding Task Categories in Connectivity Services Director on page 24

• Understanding Connectivity Services Director User Administration on page 26

• Logging In to Connectivity Services Director on page 27

• Accessing the Services Activation Director GUI on page 28

• Changing Your Password for Connectivity Services Director on page 30

• Logging Out of Connectivity Services Director on page 31

• Getting Started Assistant Overview in Services Activation Director on page 32

Connectivity Services Overview

Connectivity services include Layer 2 VPN and Layer 3 VPN services, quality-of-service

(QoS) profile services, timing synchronization services, tunneling and label-switched

path (LSP) services, and connectivity fault management (CFM) services.

With connectivity services, you can perform the following tasks in your deployment:
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• Design, provision, andmonitor Label Discovery Protocol (LDP) and Border Gateway

Protocol (BGP) services, and VPN services, for the management of Layer 2 and Layer

3 protocols, on devices.

• Configure the Operation, Administration and Maintenance (OAM) functionality on all

devicesandmonitor, detect, isolate, and troubleshootnetworking faults. Thesupported

OAM features include link fault management (LFM), CFM, and real-time performance

monitoring (RPM).

• Configure Precision Time Protocol (PTP) and synchronous Ethernet services, which

are timing functionalities for devices.

• Design, provision, and deploy MPLS-dynamic, RSVP-signaled LSP, and static LSP

services on devices.

• Configure QoS or class-of-service (CoS) capabilities for services on devices.

To enable you to design and provision connectivity services in your network, you can use

Connectivity Services Director, which is a robust and highly-intuitive next-generation

application that runson the JunosSpaceNetworkManagementPlatform.Thisapplication

also enables validation andmonitoring of service performance, andmanagement of

timing and clock synchronization.

Related
Documentation

Understanding the Need for Connectivity Services Director for Managing Services on

page 12

•

• Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity

Services Director on page 13

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Understanding theUsageandLayoutofConnectivityServicesDirectorViewsandTasks

on page 23

• Understanding Task Categories in Connectivity Services Director on page 24

• Understanding Connectivity Services Director User Administration on page 26

• Logging In to Connectivity Services Director on page 27

• Logging Out of Connectivity Services Director on page 31
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Getting Started with Connectivity Services Director

Based on your network deployment needs and configuration settings, youmight require

different service types, such as E-Line, IP, E-LAN, or RSVP LSP services, to be applied on

devices in your topology. It is essential to discover or add the devices that you want to

be administered using Connectivity Services Director to the application database, before

you can enable and define services. Youmust configure the basic andmandatory device

settings such as routing instances, routing protocols, and administrative groups before

they are imported or discovered for additional modifications, such as configuration of

services and using the network management application.

When you install Connectivity Services Director, the single application package installs

thecapabilities for configuringnetwork services, suchasE-Line, IP, andE-LAN, configuring

MPLSandRSVP label-switchedpath (LSP) services, configuringPrecisionTimeProtocol

(PTP) and synchronous Ethernet services, configuring the OAM (Operations,

Administration and Maintenance) functionality, and configuring class of service (CoS)

profiles. To install Connectivity Services Director, see the Installation Instructions for

Connectivity Services Director, Release 2.1 section in Junos Space Connectivity Services

Director Release Notes, Release 2.1.

Startingwith Connectivity Services Director Release 2.1, you can also access the Services

Activation Director GUI interface to launch workspaces to configure functionalities. To

access the Services Activation Director GUI, see “Accessing the Services Activation

Director GUI” on page 28.

The followingworkflowdescribes the tasks that youneed toperformafter the installation

of the application to enable effective and streamlinedmanagement, provisioning, and

troubleshooting of devices and services configured using Connectivity Services Director.

After you install the Connectivity Services Director application, follow the tasks given

below to enable effective management, provisioning, and troubleshooting of devices

and services using the application:
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1. Discover devices usingConnectivity ServicesDirectorGUI or the JunosSpacePlatform

workspace. See “Discovering Devices” on page 179 for instructions on discovering

devices using Connectivity Services Director. See Discovering Devices in the Junos

SpaceNetworkManagementPlatformUserGuide for instructionsondiscoveringdevices

using the Junos Space Platformworkspace.

NOTE:

Ensure the following before you add a device using device discovery:

• SSH v2 is enabled on the device. To enable SSH v2 on a device, run the
following CLI command:

set system services ssh protocol-version v2

• The NETCONF protocol over SSH is enabled on the device. To enable
the NETCONF protocol over SSH on a device, run the following CLI
command:

set system services netconf ssh

• The device is configured with a static management IP address that is
reachable from the Junos Space server. The IP address can be in-band
or out-of-band.

• A user with full administrative privileges is created on the device for the
Junos Space administrator.

• If you use SNMP to probe devices as part of device discovery, ensure
that SNMP is enabled on the device with appropriate read-only
V1/V2C/V3 credentials.

2. Discover the roles of devices and assign network-provider edge (N-PE) roles as

necessary. Toprestagedevices andassigndevice roles, see “DiscoveringDeviceRoles”

on page 372 and “Excluding Devices from N-PE Role Assignment” on page 373.

3. Create service templates. Templates provide a powerful mechanism to configure

advanced service-related options that are not exposed via the service order creation

workflow. Templates are attached to a service definition. To work with service

templates, see “Service TemplatesWorkflow” on page 1709 and “Applying a Service

Template to a Service Definition” on page 1710.

4. Review predefined service definitions that are available by default, and determine

whether you want to create a new customzied service definition. A service definition

specifies the attributes that are common among a group of service orders that have

similar service requirements. Toworkwith service definitions, see “Predefined Service

Definitions” on page 451, Creating an E-Line Service Definition, “Creating a

Multipoint-to-Multipoint E-LAN Service Definition” on page 619, “Creating a

Point-to-Multipoint E-LAN Service Definition” on page 641, “Creating a Full-Mesh IP

Service Definition” on page 669, and “Creating a Hub-and-Spoke (One Interface) IP

Service Definition” on page 678.
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5. Create customers that denote the users to be associated with service orders. New

customers must be identified to the system before you can provision and activate a

serviceorder for them.Tocreatecustomers, see “AddingaNewCustomer”onpage697.

6. Create class-of-service profiles to prioritize the traffic flow and define policies for

handling received packets to avoid network congestion and traffic disruption. See

“Creating and ManagingWired CoS Profiles” on page 222.

7. Create serviceorders for the typesofprotocols that your networkenvironment requires

for optimal and cohesive management of large numbers of devices. A service order

is an instance of the service definition that completes the definition for a specific

customer’s use.Toworkwith serviceorders, see “CreatingaServiceOrder” onpage773.

8. Deploy service orders to propagate the service configuration to the corresponding

devices. To transfer service order configurations to devices and apply the settings on

the devices, see “Deploying Services Configuration to Devices” on page 959 and

“Managing Service Configuration Deployment Jobs” on page 957.

9. Perform audit operations, such as functional and configuration audit, to examine the

status of interfaces, LDP sessions, neighbor links, and endpoints of E-Line services.

Youcanalso identifywhether theserviceconfigurationon thedevicehasbeenchanged

out of band. In addition, you can use op scripts to perform any function available

through the remote procedure calls (RPCs) supported by either the Junos XML

management protocol or the Junos XML API. For more information, see “Performing

aFunctionalAudit” onpage 1019, “PerformingaConfigurationAudit” onpage 1027, and

“Troubleshooting N-PE Devices Before Provisioning a Service” on page 1030.

10. Monitor thehealth (workingcondition), operatingefficiency, traffic-handlingcapacity,

and performance status of the managed devices and configured services. Several

monitors or widgets are displayed to enable you to track, diagnose, and rectify

problems and discrepancies associated with services configured on devices. To

evaluate and diagnose the services, traffic-flow, and device states, see “Service

Monitoring Capabilities in Connectivity Services Director” on page 1134.

11. View information about the health of your network and changing conditions of your

equipment.UseFaultmode to findproblemswithequipment, pinpoint securityattacks,

or to analyze trends and categories of errors. For example, if you find that a particular

device or a service has recorded a large number of critical or major alarms, you can

then navigate to the appropriate device settings page or service order page to correct

andmodify the attributes or diagnose the problems that might be generating the

alarms. To view alarms and events, see “Understanding Fault Mode in Connectivity

Services Director” on page 47.

Related
Documentation

Prestaging Devices Overview on page 55•

• Junos Space Layer 2 Services Overview on page 56

• Junos Space Layer 3 Services Overview on page 65

• Provisioning Process Overview on page 67

• Seamless MPLS Support in Junos Space Overview on page 70

• Service Attributes Overview on page 72
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• Service Order States and Service States Overview on page 87

Connectivity Services Director REST API Overview

The Juniper Networks Connectivity Services Director APIs are based on the

Representational State Transfer (REST) standards. REST defines a set of principles for

definingWeb services, including how a system’s resource states are transferred over

HTTP. Clients can be written in any language that sends HTTP requests.

You use standard HTTPmethods to access the Connectivity Services Director APIs. For

example, HTTP GET is used by a client application to retrieve a resource, get data from

aWeb server or to execute a query. Common HTTPmethods for REST are:

• GET – Retrieve a resource from the server.

• POST – Update a resource on the server.

• PUT – Create a resource state on the server.

• DELETE – Remove a resource state on the server.

The following media types are supported:

• For APIs that employ theGETmethod—Accept is used because a Response is the only

involvedoperationhere.TheAccept typedetermines the typeof theResponseobtained.

The Response can be either in XML or in JSON format.

• For APIs that employ the POSTmethod—Content-type that determines the type of

the input payload or request that is sent, is used.

• For APIs that employ the PUTmethod—Content-type that determines the type of the

input payload or request that is sent, is used.

• For APIs that employ the DELETEmethod—Accept is used because a Response is the

only involved operation here.

The Accept type determines the type of the response obtained. The Response can be

either in XML or in JSON format. For example, for the Add Customer API, the Content

and Accept types for XML are as follows:

Content-Type—application/vnd.net.juniper.space.customer-management.customers+xml

Accept—application/vnd.net.juniper.space.customer-management.customers-status+xml

Retrieved resources are displayed in human-readable format. Connectivity Services

Director APIs return data in XML or JavaScript Object Notation (JSON).

The following RESTful Web Services are exposed under the Junos Space Connectivity

Services Director root URI:

• Customers

• Provider edge (PE) devices

• Prestage devices
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• Resource pools

• Service definitions for E-Line , E-LAN, and IP services

• Service orders for E-Line , E-LAN, and IP services

• Service operations for E-Line , E-LAN, and IP services

• Service templates forE-Line , E-LAN, and IP services

• Bulk operations for E-Line services

• Functional and configuration audit

• CFM profiles for services

• Performancemanagement (PM) statistics

• Service definitions and service orders for LSP services

• OAM services for LFM, CFM, and SLA iterators

• Services for RFC 2544-based benchmarking tests

• Timing services for synchronous Ethernet and PTP

Connectivity Services Director RESTful Web Services provide programmatic access to

the resources thataredefined in JunosSpaceConnectivityServicesDirector. Connectivity

Services Director RESTful Web Services follow the same standards and conventions as

the Junos Space Network Application Platform RESTful Web Services. T

NOTE: Connectivity Services Director-related RESTful Web Services are
exposed under the /api/juniper/spaceURI.

Example resource
returned inXMLformat <Data xmlns="services.schema.networkapi.jmp.juniper.net">

<Customers>
 <Customer>
  <Common>
   <Name>Customer_005</Name>
  </Common>
  <AccountNo>40132324005</AccountNo>
  <ContactName>customer005</ContactName>
  <ContactEmail>customer005@example.com</ContactEmail>
 </Customer>
</Customers>
</Data>

Example resource
returned in JSON

format

{ "Data" : { "Customers" : { "Customer" : { "AccountNo" : 40132324005,
              "Common" : { "Name" : "Customer_005" },
              "ContactEmail" : "customer005@example.com",
              "ContactName" : "customer005"
            } } } }
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Format and Conventions of RESTfulWeb Services

Themedia type for theConnectivityServicesDirectorapplicationmustbe in the following

format:

application/vendor.space.service.type+syntax;version=version number or

vendor.space.service.type+syntax;version=version number

For example, application/vnd.net.juniper.space.monitoring.alarmscount+json;version=1

Table 3 on page 10 describes these parameters.

Table 3: Media parameters

DescriptionParameter

Vendor of the media type.

Media typesdefinedby JuniperNetworksusevnd.net.juniper. Third-partiesmustuse their ownvendor
string when defining web services in applications that are deployed on Junos Space.

vendor

Name of the Junos Space-specific service.

Service names are lowercase alphanumeric tokens with hyphen separators; for example,
device-management, incident-management.

service

Type of resource.

Types are all lowercase alphanumeric tokens with hyphen separators; for example, device, incident.

type

Representation of the resource. For example, xml.syntax

Version of the API; versions begin with the numeral 1.version

REST standards are well-described in books and on the Internet. It is not the intent of

this guide to discuss the RESTful architecture. This document deals with the REST APIs

exposed by Connectivity Services Director.

For information about Junos Space SDK, see Junos Space SDK .

Payload and Response Types Supported in XML and JSON Formats

Payload or request can be in both XML format and JSON format, although this reference

guide illustratesonly theXML type inputor payload in the sampleAPIs. AnAPI is available

for converting any given XML payload into a JSON payload. See “Conversion of XML

Format to JSON Format” on page 11, for detailed information on converting the XML

format into a JSON format. Responses to the API request calls can be in both the XML

format and JSON format, although this reference guide describes only the XML type

responses in the samples.
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Conversion of XML Format to JSON Format

For the ease of the users, an additional API has been provided for converting the XML

inputs to JSON format. If the XML inputs pertaining to the NetworkAppsAPI are given as

input, then the corresponding JSON format output can be obtained from the API.

api/space/nsas/xml-json/convert">URI

GETHTTPMethod

application/xmlConsumes

application/jsonContent-Type

Collects all the configured E-LINE LDP service orders.Produces

Input (Converting the AddCustomer XML-Input to JSON-Input)

Sample XML Input <Data xmlns="services.schema.networkapi.jmp.juniper.net">
<Data xmlns="services.schema.networkapi.jmp.juniper.net">
<Customers>
 <Customer>
  <Common>
   <Name>Customer_005</Name>
  </Common>
  <AccountNo>40132324005</AccountNo>
  <ContactName>customer005</ContactName>
  <ContactEmail>customer005@example.com</ContactEmail>
 </Customer>
</Customers>
</Data>

Output (JSON Format of the Preceding Input)

Sample XMLOutput <Data xmlns="services.schema.networkapi.jmp.juniper.net">
{"Data":{"Customers":{"Customer":{"Common":{"Name":"Customer_005"},
"AccountNo":40132324005,"ContactName":"customer005","
ContactEmail":"customer005@example.com"}}}}

NOTE: Read this guide in conjunction with the Network Director API Reference

for information about the REST APIs that you can configure for some of the
functionalities available in views other than Service view of Connectivity
Services Director. These APIs also define the fault and alarm notification
APIs.
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Understanding the Need for Connectivity Services Director for Managing Services

An important aspect of any networkmanagement system is tomonitor, control, andplan

network infrastructure. With networks constantly increasing in size, heterogeneity, and

complexity, effective management and planning of networks becomemore important.

The following networkmanagement capabilities are essential for effectivemanagement

of services on devices:

• Network management systemsmust be able to manage hybrid networks that offer

both legacy TDM and next-generation IP-based services.. Simplification of essential

tools required to set up, configure, provision, and operate devices and the services that

run on them are key to keeping operational costs down and achieving efficiency.

• A networkmanagement systemmust offer simple and efficient tools to detect service

faults and performance so that service levels are assured. Such a system includes

tools to correlate faults with the alarms and traps generated on devices, and provide

a real-time view of the complete operational status of a network.

• Any new network management system needs to provide seamless support for legacy

functions while enabling new features to support packet-based networks. This may

require the use of standards-based open interfaces to enable such OAM systems to

query, configure, provision, andmanage the new devices and services being deployed.

• An ideal network management system should present a unified device management

interface for all devices from the access network to the core network. In the context

of mobile backhaul, a unified network device management interface is essential to

efficiently deploy a large number of devices such as cell site gateways.

Assuming that thesedevicesarehosted in remote locations, after thedevice isdeployed,

it is essential to ensure that the device management interfaces (DMIs) provide the

right level of automation to reduce the time required to set up and configure each

device without requiring additional manual intervention at the site.

• Network Management systemsmust be standards compliant and provide open

interfaces for interoperability with existing systems in an operator’s network.

Standards-based northbound interfaces that use REST APIs are becoming the norm

for such interoperability.Mobile backhaul networks typically contain tensof thousands

of cell sites connected to aggregation devices and further, into the core network.

• Networkmanagement systemsmust be able to scale and offer efficient, user-friendly

mechanisms to provision services in bulk. For example, reduction in the number of

steps required toprovisionapseudowire fromend toendgreatly improves theefficiency

of a network provisioner, while also reducing the number of provisioning errors.

NOTE: Starting from Release 2.0, Connectivity Services Director supports
E-Lineservices,VPNservices,E-LANservices, andRSVPLSPservices.Service
types other than E-Line services, VPN services, E-LAN services, and RSVP
LSP services can be configured using the Services Activation Director GUI,
which is installed with the Connectivity Services Director software image.
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Related
Documentation

Connectivity Services Overview on page 3•

• Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity

Services Director on page 13

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Understanding theUsageandLayoutofConnectivityServicesDirectorViewsandTasks

on page 23

• Understanding Task Categories in Connectivity Services Director on page 24

• Understanding Connectivity Services Director User Administration on page 26

• Getting Started Assistant Overview in Services Activation Director on page 32

• Logging In to Connectivity Services Director on page 27

• Logging Out of Connectivity Services Director on page 31

Benefits of a Unified User Interface for Routing and Tunnel Serviceswith Connectivity
Services Director

Junos SpaceConnectivity ServicesDirector application helps you configure,monitor, and

deploy Layer 2 and Layer 3 services.

The followingare thesalientbenefits andcapabilitiesof theConnectivityServicesDirector

application:

• The Connectivity Services Director UI helps youmanage, administer, and handle

activities and service deployments through various stages and phases on your device.

• You can install this application to leverage Layer 2, Layer 3, label-switched path (LSP),

and class of service (CoS) functionalities on devices in your network based on your

deployment needs and device models to bemanaged.

• If you are deploying the network management utility in your topology for the first time

for routingand tunnel servicesprovisioning, and if youhavepreviouslydeployedNetwork

Director for the administration of devices, such as EX Series switches and QFX Series

switches, you can seamlessly install the Connectivity Services Director application.

You can install the Connectivity Services Director software package on different

appliances to perform Layer 2 through Layer 3 services management on several

platforms, such as ACX Series routers, M Series routers, MX Series routers, PTX Series

routers, and TCA Series Timing Appliances.

NOTE: Network Director cannot be installed on the same system as
Connectivity Services Director.

Related
Documentation

Connectivity Services Overview on page 3•
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• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Understanding theUsageandLayoutofConnectivityServicesDirectorViewsandTasks

on page 23

• Understanding Task Categories in Connectivity Services Director on page 24

• Understanding Connectivity Services Director User Administration on page 26

• Logging In to Connectivity Services Director on page 27

• Logging Out of Connectivity Services Director on page 31

Connectivity Services Director Overview

Service providers and enterprises must be able to rapidly provision and offer newMPLS

and Carrier Ethernet services across their networks. In order to reduce operational costs

and enable quick service rollouts, network operators need an intelligent provisioning

application that facilitates the design, deployment, andmanagement of services. Junos

Space Connectivity Services Director facilitates lifecycle management of connectivity

services such as E-Line, E-LAN, L2VPN, IP, and RSVP LSP services, QoS profile

configuration, service performance validation andmonitoring, and synchronization

management. In addition to an intuitive graphical user interface, the application also

supports a rich setofAPI functions toenablenorthbound interface integrationandservice

orchestration with other operations support systems (OSS) platforms.

Telecommunication establishments and organizations worldwide that offer MPLS and

Carrier Ethernet services face common business challenges such as controlling capital

andoperatingexpenses,accelerating timetomarket, and increasingcustomersatisfaction.

At the same time, these companies also have to deal with the following technical

challenges:

• Provisioning a customer service rapidly and accurately

• Scaling to keep up with customer demand

• Tracking site-specific quality of service (QoS)

• Troubleshooting and pinpointing problems in the network

• Finding trained personnel with expertise in networking and MPLS technologies

Junos Space Connectivity Services Director allows service providers and enterprises to

rapidlyenablenewserviceofferings. It facilitatesanautomatedandstreamlinedapproach

to the service design and provisioning process, and helps reduce fallout from

misconfiguredcustomer services.Besidesautomatingkeyprovisioning tasks, JunosSpace

Connectivity Services Director also provides a complete network management solution,

including automated service discovery, MPLS resource management, point-and-click

serviceprovisioning, validation, and troubleshooting forMPLSandcarrier Ethernet service

environments.
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Junos Space Connectivity Services Director is a Junos Space application for unified

management of the ACX Series routers, M Series routers, MX Series routers, PTX Series

routers, and TCA Series Timing Appliances in your network.

Junos Space Connectivity Services Director essentially manages the lifecycle of Layer 2

and Layer 3 services. The application helps in resource poolmanagement, service design

and provisioning, troubleshooting and performancemonitoring, and service

decommissioning.

The Connectivity Services Director application helps in:

• Automating the design of Layer 2 and IP services, activating and provisioning services,

validating Layer 2 and IP services acrossMPLSandCarrier Ethernet networks, enabling

serviceproviders toefficientlyandcost-effectivelymanagedeploymentswhile reducing

fallout frommisconfigured services.

• Designing, provisioning, and activating RSVP-signaled label-switched paths (LSPs),

as well as static LSPs, which can be configured as end-to-end, point-to-point,

point-to-multipoint, or full-mesh LSPs.

• Monitoring faults and performance of VPN services using standards-based protocols

and technologies such as Ethernet connectivity fault management (CFM), Ethernet

link-level fault detectionandmanagement, andBidirectional ForwardDetection (BFD).

• Configuring and applying class-of-service (CoS) profiles to interfaces of devices.

• Provisioning synchronization of interfaces such as IEEE1588- 2008 (PTP) and

Synchronous Ethernet.

Related
Documentation

Connectivity Services Overview on page 3•

• Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity

Services Director on page 13

• Understanding the Connectivity Services Director User Interface on page 16

• Understanding theUsageandLayoutofConnectivityServicesDirectorViewsandTasks

on page 23

• Understanding Task Categories in Connectivity Services Director on page 24

• Understanding Connectivity Services Director User Administration on page 26

• Logging In to Connectivity Services Director on page 27

• Logging Out of Connectivity Services Director on page 31
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Understanding the Connectivity Services Director User Interface

Junos Space Connectivity Services Director provides a simple-to-use, HTML5-based,

Web 2.0 user interface that you can access through standardWeb browsers. The user

interface uses task-basedworkflows to help youaccomplish administrative tasks quickly

and efficiently. It provides you with the flexibility to work with single or multiple devices

grouped by logical relationship, location, or device type. You can filter, sort, and select

columns in tables, making looking for specific information easy.

This topic describes:

• Connectivity Services Director Banner on page 16

• View pane on page 17

• Views list on page 18

• Tasks Pane on page 18

• Alarms on page 18

• MainWindow orWorkspace on page 18

• Filtering the Network Tree on page 19

• Tables in Connectivity Services Director on page 20

Connectivity Services Director Banner

Use the Connectivity Services Director banner to select the working mode. You can also

use the Connectivity Services Director banner to perform other global tasks, such as

setting up your preferences or accessing Junos Space. Table 4 on page 16 describes the

functions available to you on the banner.

Table 4: Connectivity Services Director Banner Functions

FunctionItem

Click the Junos Space logo to access the Junos Space Network
Management Platform application.

Select Connectivity Services Director from the Applications list
to access the CSD application.

NOTE: You can switch back and forth between Connectivity
Services Director and Junos Space Network Management
Platformwithout logging in again.

Accessing Junos Space
Network Management
Platform

Select the network view that you want to work in. You can
choose any one of the following views from the Views list:

• Dashboard View

• Service View

• Device View

• Custom Group View

• Topology View

Views
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Table 4: Connectivity Services Director Banner Functions (continued)

FunctionItem

Select the task category youwant towork in. You can select any
one of the following task categories to work in:

• Build

• Deploy

• Monitor

• Fault

• Report

NOTE: Youmight not have access to all the Connectivity
Services Director task categories. Your user role determines the
task categories you have access to.

Task Categories

Displays the username you use to log in toConnectivity Services
Director.

User

Click the System button to view Audit Logs pane.System

Click thearrownext to theSystembuttonandselectPreferences
to access and update system and user preferences.

Preferences

Click thearrownext to theSystembuttonandselectAbout from
the list to view the version number and licensing information of
your Connectivity Services Director application.

About

Click the arrow next to the System button and select Help from
the list to access the Connectivity Services Director Online Help
page.

Help

Click the arrow next to the username and select Logout to log
out of Connectivity Services Director and Junos Space.

Logout

View pane

TheService paneprovides youwith a unified, hierarchal viewof your networks in the form

ofa tree that is expandableandcollapsible. By selectinganode fromthe tree, you indicate

the scope over which you want an operation or task to occur. For example:

For example, by selecting the MX240 node in Device View, you indicate that the scope

for a task is all MX240 routers in your network.

NOTE: The view pane displayed depends on the network view you choose
from the Views list.
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Views list

You can use the Views list on the Connectivity Services Director banner to choose any

one of the following network views:

• Dashboard View—This is a customizable view that provides information about your

network. You can select and addmonitoring widgets to the Dashboard View based on

your requirements. This is the default view that opens when you log in to Connectivity

Services Director.

• ServiceView—Youcancreate services, policies, and filters for devices that aremanaged

by Connectivity Services Director. The service templates and attributes for services,

policies, and filters help you classify and control the way packets are handled by the

various services.

• Device View—Devices are organized by device type: routers. Within each device type

displayed in theDeviceViewpane, devicesareorganizedbydevicemodel. For example,

all models of MX240 routers are grouped together under one node in the tree.

• Custom Group View—If you have defined one or more custom groups, Connectivity

ServicesDirectordisplaysgroups in this view.Youcanmanually adddevices toacustom

group or define a rule to automatically add devices to the custom group after they are

discovered in Connectivity Services Director.

• TopologyView—This viewdisplaysagraphical representationof thediscovereddevices

in your network, organized by groups or zones. The topology map window displays

important links and node properties. Links are color coded according to utilization. You

can also view physical and logical connectivity between various discovered

interconnected devices.

Tasks Pane

The Tasks pane is available in the Service View, Device View, and Custom Group View

of the Views list. The Task pane lists tasks specific to that view. In addition to changing

according to the view selected, tasks listed in the Tasks pane can change. For example,

some tasks are appropriate only at the device level and thus appear only when you have

selected an individual device. Clicking a task brings up task-specific content in the main

window. To perform a task in Connectivity Services Director, you navigate to the task.

Alarms

The Alarms bar that is displayed at the bottom of your browser window provides a quick

summary of howmany critical, major, minor, and informational alarms are currently

active in the network and is visible in every mode.

To display more information about alarms, click the alarm count or the Alarms bar. You

are automatically placed in Fault mode and the Fault modemonitors are displayed.

MainWindow orWorkspace

Themain window or workspace displays content relevant to ta particular view, scope,

and task you have selected. When you log in to Connectivity Services Director, the main
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window displays the dashboard. The dashboard enables you to allow users who are

assigned roles toquicklymonitor health and statusof themanageddevices. The sections

of the dashboard allows the operator to understand the device problem or fault at the

macro level (comprehensive and widespread network health and status) and themicro

level (individual device health and status).

Filtering the Network Tree

Tomake it easier for you to focus on selected aspects of your network, you can apply

predefined filters to your network tree so that only nodes and devices thatmeet the filter

criteria are shown.

To apply filters:

1. From the View pane, click the filter icon:

The Filters page is displayed.

NOTE: Theviewpanedisplayeddependson thenetwork viewyouchoose
from the Views list. The filter feature is available only in the Service View
and Device View.

2. From the Filters page, click Show available filters.

The Available Filters section of the page appears.

3. From the Available Filters page, select the tab for the view you want to use to define

your filter. For example, if you want to filter devices, click the Device tab.

The filters that you can apply are listed below the Device tab.

4. To select a filter, click click the add (+) icon next to the device.

The filter appears on the Selected Filters section of the Filters page.

NOTE: Youcanaddmultiple filtersata time.Alternatively, youcan remove
a filter from the Selected Filters section of the Filters Page by clicking the
trash can icon next to the device.

5. Click Apply.

The Filters dialog box closes and the filters are applied. The words 'Filter applied'

appears below the filter icon. Alternatively, you can click Clear (next to 'Filter applied')

to remove any filters applied. `
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To remove a filter, click the filter icon, click the trash can next to the filter on the Selected

Filters list, and click Apply.

• Expanding or Collapsing Nodes in the Network Tree on page 20

• Searching the Network Tree on page 20

Expanding or Collapsing Nodes in the Network Tree

To expand a node in the network tree, select the node and then click the Expand All (+)

icon:

The node you selected and any child nodes under the selected node are expanded to

show their contents.

Similarly, to collapse a node in the network tree, select the node and then click the

Collapse (-) icon (next to the Expand icon). The node you selected is collapsed and no

nodes under it are shown.

Searching the Network Tree

To quickly find and select a device or device group, use the search function.

To perform a search, type three or more characters in the search box and press Enter.

Connectivity Services Director finds the first instance of a node whose name contains

the characters. You can use the arrows next to the search box to see the other instances..

NOTE: Searches are not case-sensitive: searchingwla115 orWLA115 returns
the same results. You can also use wildcard characters in search strings.

Tables in Connectivity Services Director

Tables are used throughout Connectivity Services Director to display data. These tables

share common features. By becoming familiar with these features, you can navigate and

manipulate tabular data quickly and efficiently.

The following sections describe:

• Moving and resizing columns

• Navigating pages

• Displaying column lists

• Sorting a column

• Hiding and exposing columns

• Searching table contents

• Filtering table contents
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Moving and Resizing Columns

You can reposition and resize columns in a table. Tomove a column, drag the column

head to the new location. Connectivity Services Director displays a green check mark

when youmouse over a valid column location. To resize a column, mouse over the edge

of a column until the cursor becomes two vertical lines with outward arrows. Drag the

columnwidth to the new size.

Navigating Pages

Controls at the bottom of a page allows you to navigate through entries on the pages

when the inventory is too large to fit on one page. Using these controls, you can go to a

specific page, navigate between pages, or refresh content in a page.

Displaying the Column list

A list allows you to perform additional operations on columns. To display the column

list, mouse over the column head. An arrow appears. Click the arrow to display the list.

Sorting a Column

You can sort a table based on a columnby clicking the column head—each click changes

the direction of the sort. In addition, you can use theSort Ascending andSort Descending

options on the list.

Connectivity ServicesDirector uses a lexical sort for tabular data that is not strict numeric

data, whichmeans that data such as IP addresses do not sort in numerical sequence, as

shown in Table 5 on page 21.

Table 5: Numerical Sorts and Lexical Sorts

Lexical SortNumerical Sort

10.93.200.12910.93.200.65

10.93.200.19910.93.200.129

10.93.200.6510.93.200.199

Hiding and Exposing Columns

You can customize your tables by hiding or exposing columns. This way, you can choose

to see only relevant information.

To hide or unhide columns, display the column list of any column head andmouse over

the Columns option. In the list that appears, select the check box beside a column head

to unhide it. Clear the check box beside a column to hide it.

As a general rule, Connectivity ServicesDirector displays all columns in a table by default.

However, some tableshavemorecolumns that can fit easilywithin thepageandcolumns

are hidden by default.
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Searching Table Contents

You can search for specific data in large tables by using search criteria.

To search for an item in a table, enter the search term in the text box within the table.

Select ANY from the list to search for the term in all columns in the table. Every table

has a predefined default column that the system searches before it searches other

columns.

You can also choose to search a particular column for a term.

NOTE: When you enter a search expression, note the following:

• Youmust add a back slash “\” if you want to use the following special
characters in the search text:

+ ~ && || ! ( ) { } [ ] ^ “ ~ * ? : \

• Field names are case-sensitive.

For example, if you have a few systems running on Junos OS 12.3 Release
4.5, then os: 12.3R4.5 returns search results, whereas OS: 12.3R4.5 does
not return search results. This is because the field name that is indexed is
os and notOS.

• If you want to search for a term that includes a space, enclose the term
within double quotationmarks.

For example, to search for all devices that are synchronized (that is, In
Sync), enter “In Sync” in the Search field.

• Youmust append "*" if you want to search using partial keywords.
Otherwise, the search returns 0 (zero) matches or hits.

• If youwant to search formore than one termat a time, separate each term
with AND.

Filtering Table Contents

For large tables, it is helpful to be able to sort data to show only relevant entries. When

youmouse over the Filters option on the column list, a fill-in box appears where you can

type filter criteria. If you type a text string and click GO, entries that do not contain the

text string (filter criterion) are removed from the table. The filter icon appears on the

column head to indicate that the column has been filtered. To restore all entries to the

table, clear the Filters checkbox in the list.

For example, to filter the Device Inventory page so that only devices in the 192.168.1.0
subnet are displayed:

1. Mouse over the IP Address column head and click the arrow.

The Column list is displayed.
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2. Mouse over Filters to display the fill-in box.

3. Type 192.168.1. in the field and click Go.

The devices in the 192.168.1.0 subnet are shown.

Related
Documentation

Connectivity Services Overview on page 3•

• Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity

Services Director on page 13

• Connectivity Services Director Overview on page 14

• Understanding theUsageandLayoutofConnectivityServicesDirectorViewsandTasks

on page 23

• Understanding Task Categories in Connectivity Services Director on page 24

• Understanding Connectivity Services Director User Administration on page 26

• Logging In to Connectivity Services Director on page 27

• Logging Out of Connectivity Services Director on page 31

Understanding the Usage and Layout of Connectivity Services Director Views and
Tasks

The Connectivity Services Director user interface uses task-basedworkflows to help you

accomplish tasks quickly and efficiently. The interface has five network views and five

task categories that you can access from the application banner.

The View pane provides you a unified, hierarchical view of your networks in the form of

a tree that is expandable and collapsible. You can select a network view from the Views

list to display the workspaces and settings that you can define for network services and

tunnel services. The view pane displayed depends on the network view you choose from

the Views list.

The Task Categories displayed on the banner guides you through the different phases

of configuration andmonitoring that you can performwith Network View.

The Tasks pane lists tasks specific to that task category. In addition to tasks changing

according to the task category selected, tasks listed on the Tasks pane can change based

on the view you select from the Views list. Clicking a task brings up task-specific content

in the main window.

See “Understanding the Connectivity Services Director User Interface” on page 16 for

more information on themain components of the Connectivity Services Director GUI.

Related
Documentation

Connectivity Services Overview on page 3•

• Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity

Services Director on page 13
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• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Understanding Task Categories in Connectivity Services Director on page 24

• Understanding Connectivity Services Director User Administration on page 26

• Logging In to Connectivity Services Director on page 27

• Logging Out of Connectivity Services Director on page 31

Understanding Task Categories in Connectivity Services Director

ConnectivityServicesDirector enablesautomateddesignandprovisioningofVPNservices

such as E-Line services, E-LAN services, and IP services; label-switched path (LSP)

services such as MPLS, RSVP, and static LSP services; configuration of QoS profiles;

validation andmonitoring of service performance; andmanagement of synchronization.

Connectivity Services Director application enables you to easily discover, configure,

monitor, andmanage devices in large networks.

The Connectivity Services Director user application uses task-based workflows to help

you accomplish tasks quickly and efficiently. The interface has five task categories that

you can access from the application banner.

NOTE: Taskcategoriesarenotavailable in theDashboardViewandTopology
View.

The task categories you can access are as follows:

• Build—You use Build task category to discover the devices in your network, to create

andmanage device configurations, and tomanage devices. You can also organize your

devices into hierarchal groups based on logical relationships or physical locations. To

support flexible, large-scale deployment of devices, the Build task category enables

you to apply configurations across multiple devices grouped by logical relationships,

physical locations, or type.

In Build mode, you can create services for devices that are managed by Connectivity

Services Director. You can define service templates and attributes of different services,

andalso specify policies and filters to classify and control themanner inwhichpackets

are handled by various services. You can define E-Line services to provide transport

and encapsulation of Layer 2 Ethernet circuits between two endpoints. You can also

configure E-LAN service, which in turn provides multipoint-to-multipoint services and

point-to-multipoint services, and Layer 3 virtual private network (VPN) functionality

by using IP service,which supports full-mesh and hub-and-spoke services. The service

designer is responsible for creating service definitions that a service provisioner uses

to create a service order.

• Deploy—The Deploy task category enables you to deploy service order configuration

changes to devices. When youmake configuration changes in Build task category, the
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changes are not deployed to devices automatically. Youmust manually deploy the

changes to devices. Configuration changes are deployed to devices at the device level.

When youdeploy configuration changes to a device, all pending configuration changes

for that device are deployed. You can do the following configuration deployment tasks

on devices that have pending changes:

• Run configuration deployment jobs immediately or schedule them for later.

• Preview pending configuration changes before deploying the service settings to

devices.

• Validate that the pending changes are compatible with the device configuration.

• Manage configuration deployment jobs.

• Monitor—Monitor task category in Connectivity Services Director enables you to view

your network status and performance. The Connectivity Services Director application

monitors its managed services on devices andmaintains the information it collects

from the devices in a database. Monitor task category displays this information in

graphs and in tables that you can sort and filter, allowing you to quickly visualize the

state of your network, spot trends developing over time, and find important details.

Themain purpose of monitoring functionalities is to allow the operators to quickly

monitor the health (working condition), operating efficiency, traffic-handling capacity,

and performance status of the managed devices and configured services.

• Fault—Fault task category in Connectivity Services Director enables you to view your

network health. e. Fault task category displays alarms in graphs and in tables that you

can sort and filter, enabling you to resolve system conditions that generate the alarms.

When certain types of events are persistent, or when the condition causing the event

crosses a threshold, SNMP sends a notification (also called a trap) to the Connectivity

Services Director application. Connectivity Services Director application correlates

traps, describing a condition, into an alarm. To assist in diagnosing network problems

and theoperating efficiency of devices, the task category shows you information about

the health of your network and changing conditions of your equipment.

NOTE: Starting in Release 2.0, the Report task category is disabled.

Related
Documentation

Connectivity Services Overview on page 3•

• Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity

Services Director on page 13

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Understanding theUsageandLayoutofConnectivityServicesDirectorViewsandTasks

on page 23

• Understanding Connectivity Services Director User Administration on page 26

• Logging In to Connectivity Services Director on page 27
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• Logging Out of Connectivity Services Director on page 31

Understanding Connectivity Services Director User Administration

Connectivity Services Director application uses the user administration features of Junos

Space Network Management Platform to add, delete, and edit user accounts and roles.

Formore informationonuseradministration, see JunosSpaceNetworkApplicationPlatform

User Guide.

When you install the Connectivity Services Director application, additional user

administrationoptions specific to theapplicationareavailable in JunosSpace. In addition

to the Super Administrator role, the following predefined roles are also available to

Connectivity Services Director users:

• Device Manager role---allows an administrator to discover devices.

• Service Manager role-–allows an administrator to perform device pre-staging actions

including discovering and assigning device roles.

• ServiceDesigner role-–allowsanadministrator tocreateandpublishaservicedefinition.

• ServiceActivator (lessprivileged) role---allowsanadministrator toperformprovisioning

tasks including creating andmanaging customers, service orders, and services.

NOTE: You can create custom roles to grant users different access rights.
Access is controlled at the task category level. If you grant a user access to
a task category, the user has access to all tasks in that category.

Access to Connectivity Services Director system preferences is controlled by
user access rights. For more information, see “Setting Up User and System
Preferences” on page 121

If you try to log in to Connectivity Services Director by using an account that does not

have access rights to any Connectivity Services Director task category, you are redirected

to Junos Space instead.

Related
Documentation

Connectivity Services Overview on page 3•

• Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity

Services Director on page 13

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Understanding theUsageandLayoutofConnectivityServicesDirectorViewsandTasks

on page 23

• Understanding Task Categories in Connectivity Services Director on page 24

• Logging In to Connectivity Services Director on page 27
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• Logging Out of Connectivity Services Director on page 31

Logging In to Connectivity Services Director

You connect to Connectivity Services Director using your Web browser. The following

Web browsers are supported: Internet Explorer 9.0 and 10.0, Mozilla Firefox version 3.6

and later, and Google Chrome version 17 and later. Theminimum screen resolution is

1280 x 1024.

To log in to Connectivity Services Director directly:

1. In the Address field of your browser, enter the following URL:

https://<n.n.n.n>/csd/

where n.n.n.n is the IP address of the Junos SpaceWeb interface. You can bookmark

the login page for future use.

2. Enter the login credentials, such as the username and password.

The default username and password are the same for both Junos Space and

Connectivity Services Director:

• Username—super

• Password—juniper123

After successful login, the Dashboard page of Connectivity Services Director is

displayed.

To log in to Connectivity Services Director through Junos Space:

1. In the Address field of your Web browser, enter the following URL:

https://<n.n.n.n>/mainui

where n.n.n.n is the IP address of the Junos SpaceWeb interface.

The Junos Space login page is displayed.

2. In the Username text box, enter your username.

For information about how to change your username, consult your system

administrator.

3. In the Password text box, enter your password.

The default username and password are the same for both Junos Space and

Connectivity Services Director:

• Username—super

• Password—juniper123
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For information about how to change your password, see “Changing Your Password

for Connectivity Services Director” on page 30.

4. (Optional) If the remote authentication server is configured for Challenge/Response,

you are presented with the challenge questions. Provide valid responses to the

challenge questions you are asked, to log in successfully.

5. Click Log In.

The Junos Space home page appears. If the home page is not set, the Junos Space

Dashboard page is displayed.

If the homepage is inaccessible due to role or domain restrictions, awarningmessage

is displayed and the Junos Space Dashboard page is loaded.

NOTE: If you are a user with access tomore than one domain, then an
informational message about switching domains is displayed in a dialog
box.

Do one of the following:

• To prevent the informational message from appearing again, ensure
that the Don’t show again check box is selected and clickOK. The Don’t

show again check box is selected by default.

• To allow the informational message to continue appearing, clear the
Don’t show again check box and clickOK.

You can then switch to the Connectivity Services Director interface by selecting

Connectivity Services Director from the Applications list in the left pane of the Junos

Space user interface. To access the older version of the Services Activation Director

GUI, select Services Activation Director from the Applications list of the Junos Space

user interface.

Related
Documentation

Logging Out of Connectivity Services Director on page 31•

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

Accessing the Services Activation Director GUI

FromConnectivityServicesDirectorRelease2.0onwards, youcanalsoaccess theServices

Activation Director GUI interface to launch workspaces to configure functionalities. You

must install JunosSpacePlatformbefore trying toaccess theServicesActivationDirector

GUI, perform the following steps after Junos Space Platform is installed:
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NOTE: The appendixes at the end of this documentation describes the
workspaces and functionalities that you can configure using the Services
Activation Director GUI. The applications in the Services Activation Director
suite are a legacy implementation that provide backward compatibility and
are no longer recommended for use. Although you can configure features
such as service orders and service definitions using the Services Activation
Director GUI, we recommend that you use the Network Services utility of the
Connectivity Services Director GUI to define such capabilities. The older
look-and-feel of the GUI might be removed completely in a future release.
In Connectivity Services Director Release 2.0, the Service Templates, and
Threshold Alarm Profile workspaces or windows of the Network Activate
application of the Services Activation Director suite are not implemented.
You can use the Services Activation Director GUI to navigate to these
workspaces and configure the corresponding functionalities.

NOTE: The software image for Connectivity Services Director Release 2.0
enables you to install the Connectivity Services Director GUI. Also, Network
Activate, Transport Activate, OAM Insight, and Sync Design are installed and
presented in the same look-and-feel as Services Activation Director, after
you installConnectivityServicesDirector.TheRepresentationalStateTransfer
(REST) APIs for Connectivity Services Director are installed along with the
GUI.

Before You Begin:

• Configure the Junos Space appliance with a Junos Space image. For complete

configuration steps, see Configuring a Junos Space Appliance or Configuring the Basic

Settings of a Junos Space Virtual Appliance.

• Install the Connectivity Services Director image on the Junos Space appliance. See

Installing Connectivity Services Director for step-by-step instructions on installing the

image.

To access the Services Activation Director GUI:

1. Log in to Junos Space by using the following URL:

https://<n.n.n.n>/mainui

where n.n.n.n is the IP address of the Junos SpaceWeb interface.

The Junos Space login page appears.

2. Enter your login credentials, such as the username and password, and click Log In.

The Junos Space Platform GUI is displayed.
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3. Select Services Activation Director from the Applications list on the left pane of the

Junos Space user interface.

The Services Activation Director GUI is launched.

Alternatively, if you select Connectivity Services Director from the Applications list on

the left pane of the Junos Space user interface, the Connectivity Services Director GUI

is launched.

Related
Documentation

Logging In to Connectivity Services Director on page 27•

• Logging Out of Connectivity Services Director on page 31

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

Changing Your Password for Connectivity Services Director

Any user, regardless of user role, can change his or her password.

Youuse thesameusernameandpassword that youuse for JunosSpaceandConnectivity

Services Director.

To change your password:

1. From the Connectivity Services Director user interface, click the Junos Space icon on

the Connectivity Services Director banner.

The Junos Space Platform user interface is displayed.

2. Click the User Settings icon on the Junos Space banner.

The Change User Settings dialog box appears.

3. In theOld Password text box, enter your old password.

NOTE: Mouse over the information icon (small blue i) next to the New

Password text box to view the rules for password creation. For more

informationabout thepassword rules, seeModifying JunosSpaceNetwork
Management Platform Settings.

4. In the NewPassword text box, enter your new password. Theminimum value for this

field is 6 (the default) and themaximum value is 999. The password can include

alphanumeric and special characters, but not control characters.

5. In the Confirm Password text box, enter your new password again to confirm it.
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NOTE: The fields on the X.509 Certificate tab are applicable when you

want to use certificate-based authentication. If you are using
password-based authentication, you can ignore these fields. For more
information about certificate-based authentication, see the Certificate
Management Overview topic in the Junos Space Network Management
PlatformWorkspaces Feature Guide.

6. (Optional) Select theManage objects from all assigned domains check box on the

Object Visibility tab to view andmanage objects from all the domains for which you

are assigned.

7. ClickOK.

You are logged out of the system. To log in to Junos Space again, youmust use your

newpassword. Other sessions logged inwith the sameusernameare unaffected until

the next login.

Related
Documentation

Logging In to Connectivity Services Director on page 27•

• Accessing the Services Activation Director GUI on page 28

• Logging Out of Connectivity Services Director on page 31

Logging Out of Connectivity Services Director

After you finish using Connectivity Services Director, log out to prevent unauthorized

access. You can log out manually or set an automatic logout period for Connectivity

Services Director to automatically log you out.

Logging out manually—To log out of Connectivity Services Director manually, click the

downarrownext to theusernameontheConnectivityServicesDirectorbannerandselect

Logout from the list.

Logging out automatically—Connectivity Services Director automatically logs you out if

you have not performed any action on it, such as by using keystrokes or mouse-clicks,

for a set period of time. This automatic logout conserves server resources and protects

the system from unauthorized access. By default, automatic logout occurs if a session

has been idle for 60minutes. You can change the setting on the Applications inventory

page. Select Administration > Applications > NetworkManagement Platform >Modify

Application Settings (from the Actions menu) > User.
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Connectivity Services Director uses the same automatic logout period as Junos Space.

To change the automatic logout period:

1. Click the System Platform icon on the Connectivity Services Director banner.

The logout page appears.

2. Click the Click here to log in again link on the logout page to log in to the system again.

3. Navigate to Administration > Applications.

The Applications page is displayed.

4. Right-click NetworkManagement Platform and selectModify Application Settings..

The Modify Application Settings page appears.

5. In the Modify Network Management Settings page, select User.

The User page is displayed.

6. In the Automatic logout after inactivity (minutes) field, move the slider to modify the

automatic logout setting.

The logout setting is modified.

7. ClickModify to save the setting.

You are returned to the Modify Applications page.

Related
Documentation

Logging In to Connectivity Services Director on page 27•

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Accessing the Services Activation Director GUI on page 28

Getting Started Assistant Overview in Services Activation Director

The Getting Started assistant is a section in the sidebar that shows you how to perform

common tasks. The tasks in the Getting Started assistant are workspace specific. The

tasks displayed in this section vary according to the workspace. The Getting Started

assistant provides instructions on how to perform tasks related to a device, service

template, or a policy and filter template configuration.

TheGettingStarted topics are context- sensitiveper application.GettingStarteddisplays

all the stepsof a task. Fromastep in a task, youcan jump to thatpoint in theuser interface

to actually complete it. If ShowGetting Started on Startup check box is selected, the

Getting Started assistant automatically displays the tasks when you log in. If this check
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box was not selected, click the Help icon and click Getting Started from the resulting

sidebar.

To use a Getting Started assistant:

1. Select an application from the Applications list above the task tree.

2. In the sidebar, expand Getting Started.

A main Getting Started topic link appears on the sidebar.

If the sidebar is not displayed, select theHelp ( ) icon at the right side of the Junos

Space header. The sidebar appears.

3. Select a main topic.

Forexample, if youare in theNetworkManagementPlatformapplicationuser interface,

click the Increase Space Capacity link. A list of required steps appears in the sidebar.

Each step contains a task link and a link to Help.

4. Perform a specific step by clicking the link.

You jumpto thatpoint in theuser interface. Theassistant remains visibleon the sidebar

to aid navigation to subsequent tasks.

5. Access help for a specific step by clicking the Help icon next to that step.

Related
Documentation

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Logging In to Connectivity Services Director on page 27

• Logging Out of Connectivity Services Director on page 31

• Accessing the Services Activation Director GUI on page 28
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CHAPTER 2

Service View Tasks and Lifecycle Modes

• Understanding the Service View Tasks Pane in Build Mode on page 35

• Understanding the Service View Tasks Pane in Deploy Mode on page 38

• Understanding the Service View Tasks Pane in Monitor Mode on page 40

• Understanding the Service View Tasks Pane in Fault Mode on page 43

• About Build Mode in Service View of Connectivity Services Director on page 43

• About Deploy Mode in Service View of Connectivity Services Director on page 45

• About Fault Mode in All Views of Connectivity Services Director on page 47

• About Monitor Mode in Service View of Connectivity Services Director on page 47

Understanding the Service View Tasks Pane in Build Mode

TheTaskspane inServiceViewcontains all theoperations that you canperform to create

the network managed by Junos Space Connectivity Services Director by using the

prestaging process that discovers devices in the Junos Space database and assigns roles

to those devices and their interfaces. In Buildmode, you can use the Tasks pane to define

service definitions,which specify the service parameters for thedevices or endpoints and

associated interfaces for controlling traffic flow.

Click a specific task to begin that task. Not all tasks are available in the Service View

when you launch it the first time. Depending on the service definitions that you create,

those configured service definitions are displayed under the corresponding service trees,

such as E-LAN or IP, in the task pane. Service View tasks are divided into the following

categories in the Tasks pane.
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• Key Tasks—Connectivity Services Director enables you to group the tasks that you

perform frequently and create a list of key tasks. Themost preferred tasks that you

want to do while using the Service View are listed under Key Tasks. You can add tasks

from the service task menu to the Key Tasks category. The Key Tasks category is a

duplicate of the added tasks from the Service Provisioning and Service Design tasks

menu. You can add any task from the Tasks pane to the Key Tasks list by selecting a

task and clicking the plus (+) sign that appears adjacent to the task. For somemodes,

you can see that Connectivity Services Director has predefined some key tasks for you.

Youcanalsomodify this set of tasks to suit your requirements. Thismodification feature

is available in the Task pane irrespective of your current mode, scope, or view.

• Manage Service Templates (accessible from the Services Activation Director

GUI)—Provides a powerful mechanism to configure advanced service-related options

that are not exposed via the service order creation workflow. Create and attach one

or more service templates to a service definition to define any provisioning-related

configuration option beyond the current coverage of Connectivity Services Director.

• Service Design—Enables you to create andmanage service definitions and service

templates. A servicedefinition specifies theattributes that are commonamongagroup

of service orders that have similar service requirements. Service templates are specific

to service definitions. Both are specific to service types, so that if you are dealing with

an IP service type, for example, both your service definition and service templatemust

be of that type.

• Manage Service Definitions—Provides a set of predefined service definitions for E-Line

services, multipoint-to-multipoint (full mesh) services, point- to-multipoint (hub and

spoke) services, and RSVP LSP services. These service definitions are capable of

providing the basis for most of the service orders your organization will need to create.

• View Services—Enables you to view the configured E-Line, IP, and E-LAN services by

the service types and the service statuses. In the View pane, if you select the

Connectivity item in the tree under Network Services, without expanding the tree and

selectingaspecific service type, suchasE-LineServices, IPServices, or E-LANServices,

the top pane displays a set of five pie charts that enable you to view the different

service orders configured, and their associated audit andmonitoring statuses. The FA

Status chart displays the functional audit status for the service orders. The Device

State graph displays the statuses of devices on which services are being provisioned

andcommissioned.TheFaultStatuschartdisplays theconnectivity faultmanagement

details for the serviceorders. TheSLAStatus chart displays the service-level agreement

details for the service orders. The PM Status chart displays the performance

management details for the service orders. The count or percentage of service orders

in the pie chart segments sum up to the total number of configured service orders.

Mouse over each segment of the pie to view the number corresponding to the

percentage of service orders for each of the charts. These charts provide a visual

overview of customers and service orders on your network, and enables you to quickly

access related and commonly needed information. For example, you can check for

failed service orders and then access a list of failed requests so you can begin to take

restoration measure.

• View LSPs—Enables you to view the configured RSVP LSP services.
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• View Details—Enables you to view comprehensive information about the configured

parameters of a service.

• Audit/Results—Enables you to run configuration and functional audit operations, and

view the results of the audit job.

• Configuration Audit—Enables you to perform a configuration audit and view the

results of the operation. A configuration audit can help you determine whether the

service configuration on the device has been changed out of band.

• Functional Audit—Enables you to perform a functional audit and view the results of

the operation.

• Troubleshoot—Enables you to run the operational scripts that are either created or

imported to the platform from the local machine before you start troubleshooting

the services or you can run the scripts that are of local type directly from the

Functional Audit Result window by clicking the Troubleshoot button.

• Prestage Devices—Enables you to change the device and interface role assignments,

view prestaging rules, andmanage resource pools.

• PrestageDevices—Enables you to assign network provider edge (N-PE) and provider

(P) roles to devices and user-to-network interface (UNI) roles to interfaces.

• Prestage Rules—Enables you to view the prestaging rule details.

• Manage Resources—Enables you to view resource pools, such as IP addresses and

VLANs, and create IP address pools to be used in services.

• Customer—Displays the tasks that you can perform tomanage customers

• Add Customers—Enables you to add new customers on the system before you can

provision and activate a service order for each of them.

• Delete Customer—Enables you to delete a previously created customer.

• View Customer—Enables you to view customers for which service orders need to be

configured and deployed.

Related
Documentation

Understanding the Service View Tasks Pane in Deploy Mode on page 38•

• Understanding the Service View Tasks Pane in Monitor Mode on page 40

• Understanding the Service View Tasks Pane in Fault Mode on page 43

• About Build Mode in Service View of Connectivity Services Director on page 43

• About Deploy Mode in Service View of Connectivity Services Director on page 45

• About Fault Mode in All Views of Connectivity Services Director on page 47

• About Monitor Mode in Service View of Connectivity Services Director on page 47
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Understanding the Service View Tasks Pane in DeployMode

The Tasks pane in Deploymode lists the operations that you can perform in Service View

to propagate and provision the configuration settings of the service orders to the

corresponding devices. All Deploy mode tasks are always available, regardless of the

scope selected in the View pane. Service View tasks are divided into the following

categories in the Tasks pane.

• Key Tasks—Connectivity Services Director enables you to group the tasks that you

perform frequently and create a list of key tasks. Themost preferred tasks that you

want to do while using the Service View are listed under Key Tasks. You can add tasks

from the service task menu to the Key Tasks category. The Key Tasks category is a

duplicate of the added tasks from the Service Provisioning and Service Design tasks

menu. You can add any task from the Tasks pane to the Key Tasks list by selecting a

task and clicking the plus (+) sign that appears adjacent to the task. For somemodes,

you can see that Connectivity Services Director has predefined some key tasks for you.

Youcanalsomodify this set of tasks to suit your requirements. Thismodification feature

is available in the Task pane irrespective of your current mode, scope, or view.

• Service Provisioning—The tasks you do to create andmanage service orders for the

topology of your network. A service order is an instance of the service definition that

completes thedefinition fora specific customer’suse.Theserviceorderalwaysspecifies

the customer and the endpoints that link the customer sites through the network.

• Deploy Services: Manage Network Services andManage LSP—Enables you to modify,

delete, validate, and deploy services to enable the configuration parameters to be

propagated and provisioned on themanaged devices. You can perform the following

tasks from the Manage Network Services page:

• Create a New Service Order—Creates a service order for E-Line, E-LAN, IP, and RSVP

LSP protocols. A service order is an instance of the service definition that completes

the definition for a specific customer’s use. The service order always specifies the

customer and the endpoints that link the customer sites through the network

• Modify a Service—Modifies a previously configured service for E-Line, E-LAN, IP, and

RSVPLSPprotocols.When a service is based on a service definition that you created

in theServiceDesignworkflow (Buildmode of Service View), you can edit only those

parameters of a service that were marked as Editable in Service Order in the service

definition.

• Reactivate a Service—Reactivates a previously disabled service order for E-Line,

E-LAN, IP, and RSVP LSP services. After you disable a service order to deactivate

the configuration settings on devices mapped to the service, youmight require the

service settings to be reenabled after you havemodified the service parameters,

either directly on the device or using the Connectivity Services Director application.

• Deactivate a Service—Disables a service order for a particular protocol that you have

previously created on the network. By disabling a service, the traffic processing for

the traversed packets is impacted. In certain network topologies, youmight require

a service-related settings to be disabled for a certain period to perform

troubleshooting or modification to the traffic-handling method.
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• DecommissionaService—Decommissionsaservice thatacustomerno longerneeds.

Youcannotdecommissionaservice if a serviceorder requestingactionon that service

is in the Requested, Scheduled, In Progress, or Invalid state.

• Force-Deploy a Service—Forcefully deploys the service to push the configuration to

the device. Forceful deployment pushes the same configuration to the device that

was pushed during the deployment of the service, thus allowing the operator to

recover from a state in which the configuration on the device was lost or changed

out-of-band.

• Run Functional Audit—Performs a functional audit and view the results of the

operation. A functional audit determines whether a deployed service instance is

functioning.

• Run Configuration Audit—Performs a configuration audit and view the results of the

operation. A configuration audit can help you determine whether the service

configuration on the device has been changed out of band.

• ViewAlarms—Displays the Alarm Detail monitor to locate a specific alarm, research

the events causing the alarm, and to assign a disposition to the alarm. When an

alarm is highlighted in the sorting sequence, the events contributing to the alarmare

listed in the Event Details monitor and the variable settings are shown in the Event

Attribute Detail table.

• Deploy Services: Manage Service Orders andManage LSP Deployment—Schedule a

service order for deployment on the network at a particular time, or propagate the

service settings to devices for publishing and commissioning the settings immediately.

You can perform the following tasks from the Manage Service Orders page:

• Modify a Service Order—Enables you tomodify a previously configured service order

for E-Line, E-LAN, and IP protocols. When a service order is based on a service

definition that you created in the Service Design workflow (Build mode of Service

View), you can edit only those parameters of a service that weremarked as Editable

in Service Order in the service definition. The other attributes can be updated only in

the service definition or service template.

• Deploy now—Propagates the service settings and provisions them on the devices

immediately.

• Schedule Deploy—Commissions the service settings on the devices at a specified

future time.

• Discard Pending Configuration—Discards all the pending service configurations that

were made on a device

• Validate Pending Configuration—Performs analysis and validation checks to verify

that thependingchangesarecompatiblewithadevicewhenyoudeployconfiguration

changes to the device.

• View Pending Configuration—Displays the configuration of a service order that is in

the requested state, the scheduled state, the invalid state, or the failed deployment

state.
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• Delete Partial Configuration—Removes the residual configuration for a failed service

order of type Provisioning that can leave parts of the service configuration on the

devices.

• Deploy Configuration Changes—Deploys pending configuration changes to devices.

• View Deployment Jobs—Manages configuration deployment jobs. When you deploy

configuration changes or schedule a configuration deployment, a configuration

deployment job is created. You can view the details of a service configuration

deployment job or cancel a scheduled service configuration deployment job.

Related
Documentation

Understanding the Service View Tasks Pane in Build Mode on page 35•

• Understanding the Service View Tasks Pane in Monitor Mode on page 40

• Understanding the Service View Tasks Pane in Fault Mode on page 43

• About Build Mode in Service View of Connectivity Services Director on page 43

• About Deploy Mode in Service View of Connectivity Services Director on page 45

• About Fault Mode in All Views of Connectivity Services Director on page 47

• About Monitor Mode in Service View of Connectivity Services Director on page 47

Understanding the Service View Tasks Pane in Monitor Mode

The Tasks pane in Monitor mode displays a list of operations that you can perform to

analyze and identify network conditions that require corrective action for the configured

servicesondevices. A set of graphsandstatistical details in tablesaredisplayed toenable

you to easily view the state of your network in an intuitive format. Connectivity Services

Director monitors its managed services on devices andmaintains the information it

collects from the devices in a database. Service View tasks are divided into the following

categories in the Tasks pane.

• Key Tasks—Connectivity Services Director enables you to group the tasks that you

perform frequently and create a list of key tasks. Themost preferred tasks that you

want to do while using the Service View are listed under Key Tasks. You can add tasks

from the service task menu to the Key Tasks category. You can add any task from the

Tasks pane to the Key Tasks list by selecting a task and clicking the plus (+) sign that

appears adjacent to the task. For somemodes, you can see that Connectivity Services

Director has predefined some key tasks for you. You can also modify this set of tasks

to suit your requirements. This modification feature is available in the Task pane

irrespective of your current mode, scope, or view.

• Service Summary—Displays the consolidated and cumulative status of a service. This

tab is applicable for E-Line, IP, and E-LAN services. The Connectionsmonitor show the

status of the connection or link (up or down) between peer devices. In the table

displayed for thismonitor, the row represents thesourcedeviceand thecolumndenotes

thedestinationdevice. The statusof the link is displayed for E-LineandE-LANservices.

The Traffic Summarymonitor represents the total Egress (Packets out) traffic passing

through all the UNI or CE interfaces that are part of the cumulative services. It is
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displayed for E-Line , IP, and VPLS services. The Current Active Alarmsmonitor shows

any active alarm that has not yet been cleared

• Service Transport—Displays the transport or packet statistics for data against time

between the source and destination devices that you select, and based on the LSP

that is used by the endpoint. The source device is the row selected in the Connection

Matrix widget on the Service Transport tab. The destination device is chosen from the

TrafficStatisticswidgeton theServiceTransport tab.Bydefault, nodestinationdevices

are selected. Service transport statistical values are displayed for E-Line, E-LAN, and

IP services.

• ServiceTraffic—Displays theend-to-end trafficmatrix that signifies the traffic between

peer devices. You can view statistical counters andmetrics for input packets, input

bytes, output packets, and output bytes. The Interface Statisticsmonitor shows traffic

data on all the user-to-network interfaces (UNI) or site interfaces that are part of the

service. These values are on-demand statistical values and the data is retrieved from

the device directly without being cached (polling at periodic intervals and displaying

a snapshot). This tab is supported for E-Line, E-LAN, and IP services. The data is

available only if queues are enabled on the interface.

• Y1731—Displays frame delay, frame loss, frame delay variation, and service availability.

These measurements are achieved by triggering a one-way delay, two-way delay, or

loss The performancemeasurement is useful for generating periodic service-level

agreement conformance reports from the deployed network and for studying traffic

patterns in the network over a period of time. In proactive mode, SLAmeasurements

are triggered by an iterator application. An iterator is designed to periodically transmit

SLAmeasurement packets in form of ITU-Y.1731-compliant frames for two-way delay

measurementor lossmeasurement for eachof theconnections registered to it. Iterators

make sure that measurement cycles do not occur at the same time for the same

connection to avoid CPU overload. The iterator profiles are configured on remote MEP

for measurement of Ethernet frame delay measurement (ETH-DM), Ethernet frame

loss measurement (ETH-LM), and statistical frame loss (SFL).

• RFC2544—Displays theRFC2544 test profiles created tomeasure throughput, latency,

frame loss rate, andbursty frames.AnRFC2544-basedbenchmarking test isperformed

by transmitting testpackets fromadevice that functionsas thegenerator or the initiator

(which is also called the originator). These packets are sent to a device that functions

as a reflector, which receives and returns the packets to the initiator. The test

methodology enables you to define various parameters such as different frame sizes

to be examined, the test time for each test iteration, and the frame format

(UDP-over-IP).

• LSP Summary—Displays a comprehensive and cohesive view about the configured

RSVP LSP service. The status of the LSP and the status of connections between the

ingress router and egress routers in an LSP are displayed. The LSP status details are

shown for the ingress router. You can also view the ingress, egress, and transit LSP

information, such as the primary and secondary states.

• Clear Interface Statistics—Deletes all of the interface-related counters and values

associated with the selected service. It is effective for E-Line, E-LAN, and IP services.
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• ClearLSPStatistics—Deletesall of the interface-relatedcountersandvaluesassociated

with the selected RSVP LSP service.

• MPLSPing—Sends a probe from one endpoint to the other endpoint of a service, such

as E-Line, IP, LSP, and E-LAN. Use the Ping MPLS functionality to diagnose the state

of label-switched paths (LSPs), Layer 2 and Layer 3 virtual private networks (VPNs),

and Layer 2 circuits. You can ping an MPLS endpoint using various options. You can

send variations of ICMP echo request packets to the specified MPLS endpoint.

• MPLS Traceroute—Enables you to trace the route followed by an LDP-signaled LSP.

LDP LSP traceroute is based on RFC 4379, Detecting Multi-Protocol Label Switched

(MPLS) Data Plane Failures. This feature allows you to periodically trace all paths in

a FEC.

• Show Interface Statistics—Displays the interface-related settings and parameters

associated with the selected service, such as E-Line, IP, and E-LAN.

• ShowInterfaceStatus—Displays interface statusdetails tomonitor interfacebandwidth

utilization and traffic statistics associated with the selected service, such as E-Line,

IP, and E-LAN.

• ShowRouting Table—Displays the routing table information for the selected virtual

routing instance. For IP services, you can determine which LSPs or tunnels are being

used by looking at the routing tables.

• ShowMACTable—Displays the learnedMACaddress information foradeviceassociated

with a particular service:

• OAM>Y1731—Enables you to start and stop the collection of performancemonitoring

statistical details.

• OAM>RFC2544—Enables you to run RFC 2544 benchmarking tests.

Related
Documentation

Understanding the Service View Tasks Pane in Build Mode on page 35•

• Understanding the Service View Tasks Pane in Deploy Mode on page 38

• Understanding the Service View Tasks Pane in Fault Mode on page 43

• About Build Mode in Service View of Connectivity Services Director on page 43

• About Deploy Mode in Service View of Connectivity Services Director on page 45

• About Fault Mode in All Views of Connectivity Services Director on page 47

• About Monitor Mode in Service View of Connectivity Services Director on page 47
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Understanding the Service View Tasks Pane in Fault Mode

The Tasks pane in Fault mode provides you with a set of tools for effectively managing

alarmsonyour system.Whencertain typesof eventsarepersistent, orwhen thecondition

causing the event crosses a threshold, SNMP sends a notification, also called a trap to

Connectivity Services Director that are correlated and displayed as alarms.

From the Tasks pane, you can filter known alarms to locate a specific alarm or error

condition by clicking Search Alarms. Use this task to isolate alarms that occurred during

a known time-frame or that have annotations associated with them. Although each of

theFaultmodemonitorscansort thealarms,SearchAlarmsenableyou tosubmitmultiple

search and sort arguments as part of your search query.

In addition,ConnectivityServicesDirector enables you togroup the tasks that youperform

frequently and create a list of key tasks. You can add any task from the Tasks pane to

the Key Tasks list by selecting a task and clicking the plus (+) sign that appears adjacent

to the task. For somemodes, you can see that Connectivity Services Director has

predefined some key tasks for you. You canmodify this set of tasks to suit your

requirements. This feature is available in Task pane irrespective of your current mode,

scope, or view.

The following monitors are displayed in Fault mode:

• Alarms by Severity—Displays the fault alarm details sorted based on severity—that is

in the following order: critical, major, minor, and info.

• Alarms By Category—Displays the fault alarm details sorted based on category—that

is in the following order: active, acknowledged, and cleared.

• Alarms By State—Displays the fault alarm details sorted based on state—that is in the

following order: active, acknowledged, and cleared.

• Current Active Alarms—Displays any active alarm that has not yet been cleared.

Related
Documentation

Understanding the Service View Tasks Pane in Build Mode on page 35•

• Understanding the Service View Tasks Pane in Deploy Mode on page 38

• Understanding the Service View Tasks Pane in Monitor Mode on page 40

• About Build Mode in Service View of Connectivity Services Director on page 43

• About Deploy Mode in Service View of Connectivity Services Director on page 45

• About Fault Mode in All Views of Connectivity Services Director on page 47

• About Monitor Mode in Service View of Connectivity Services Director on page 47

About Build Mode in Service View of Connectivity Services Director

In Build mode, you can create services for devices that are managed by Connectivity

Services Director. You can define service templates and attributes of different services,
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and also specify policies and filters to classify and control the manner in which packets

must be handled by the various services.

Configuring a service has amajor impact on the flow of routing information or packets

within and through the router. For example, you can configure a routing service that does

not allow routes associated with a particular customer to be placed in the routing table.

As a result of this configured service, the customer routes are not used to forward data

packets to various destinations and the routes are not advertised by the routing protocol

toneighbors.Theservicedesigneruses theBuildmode formanaging theservicedefinitions

that the service provisioner uses as the basis for creating a service order. You can create

a service definition that specifies the attributes that are common among a group of

service orders that have similar service requirements, and a service order, which is an

implementation object or a derivative of a service definition.

This topic describes the following functionalities that are available in Build mode of

Service View:

• Manage Service Definitions on page 44

• Prestage Devices on page 44

• Prestage Services on page 44

• Manage Threshold Alarm Profiles on page 45

• Service Definition Operations on page 45

• Audit and Troubleshooting of Services on page 45

Manage Service Definitions

Connectivity Services Director software provides a set of predefined service definitions

for E-Line services,multipoint-to-multipoint (fullmesh) services, andpoint-to-multipoint

(hub and spoke) services. These service definitions are capable of providing the basis

for most of the service orders your organization will need to create. In case these

predefined service definitions are not adequate for all your needs, however, the Network

Activate software enables you to create service definitions of your own.

Prestage Devices

Prestaging takes the devices already under Junos Spacemanagement and prepares

them for service activation. The prestaging process discovers network provider edge

(N-PE) devices in the Junos Space database and assigns roles to those devices and their

interfaces. N-PE routers and user-to-network interfaces (UNIs) are basic building blocks

required for Layer 2 and Layer 3 provisioning

Prestage Services

The Service Recovery feature functions within the pre-staging operation of the Network

Activate application. Service Recovery has two parts. First, Service Recovery parses each

device’s configuration searching for service configurations and existing Network Activate

service elements (E-Line service, Layer 2 circuits, routing instances, firewalls, policy

options, routing options, andOAM interface branches of JunosSpace configurations that

are being processed).
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Manage Threshold Alarm Profiles

You can create profiles to measure performancemonitoring counters and parameters,

and attach such threshold alarm profiles to a service definition. In performance

management (PM), the Connectivity Services Director application provides an option to

measure the framedelay, frame loss, framedelay variation, andserviceavailability. These

measurements are achieved in either of the following ways:

• Triggering a one-way delay

• Triggering a two-way delay

• Loss

The performancemeasurement is useful for generating periodic service level agreement

conformance reports from the deployed network and for studying traffic patterns in the

network over a period of time. The iterator profiles are configured on remote MEP for

measurement of framedelay (ETH-DM), frame loss (ETH-LM) and statistical frame loss

(SFL).

Service Definition Operations

You can perform several tasks on service definitions, such as editing, publishing, or

unpublishing a service definition. You canmodify a service definition to suit your network

needs. The service designermust publish a customized service definition before a service

provisioner can use that definition to create a service request. The service designer can

unpublish a custom service definition to make it unavailable to service provisioners for

creating a service request. You cannot unpublish a predefined service definition.

Audit and Troubleshooting of Services

After the service is deployed, a functional audit establishes whether the service is up or

down. If the functional audit reports that the service is up, the customer can begin using

the service. Once the service is active, the service provisioner canmonitor the health of

the service by running a functional audit or a configuration audit. Users assigned the

Service Activator role can perform these service provisioning tasks.

Related
Documentation

About Deploy Mode in Service View of Connectivity Services Director on page 45•

• About Monitor Mode in Service View of Connectivity Services Director on page 47

About DeployMode in Service View of Connectivity Services Director

The Deploy mode enables you to deploy service order configuration changes to devices.

When youmake configuration changes in Build mode, the changes are not deployed to

devicesautomatically.Youmustmanuallydeploy thechanges todevices inDeploymode.

Every time youmake configuration changes in Buildmode that affect a service, youmust

propagate the service order changes to the device by commissioning the configuration

to the device. Configuration changes are deployed to devices at the device level. When

you deploy configuration changes to a device, all pending configuration changes for that

device are deployed.
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This topic describes the following functionalities that are available in Deploy mode of

Service View:

• Manage Network Services on page 46

• Manage Deployment of Service Orders on page 46

Manage Network Services

A service is an instance of the service order that defines the configuration parameters

and attributes for transmission andmanagement of traffic in a customer network. A

service is created for a deployed service order. The service always specifies the customer

and the endpoints that link the customer sites through the MPLS network. For each

endpoint, the service provisioner specifies the network provider edge device and the UNI

on that device that connects the customer site to the N-PE device. The service can also

specify any additional attributes that are configured in the service definition as editable

in the service order. These attributesmight include the virtual circuit ID (VCID),maximum

transmission unit (MTU) for the ingress or user-to-network interface (UNI), MTU for the

connection across the network, VLAN-ID, rate limiting bandwidth, and so forth.

You canmodify the properties of the service, conduct a functional or configuration audit,

activate or deactivate the service, and view alarms associated with a particular service

order for debugging and corrective action.

You can decommission a service that a customer no longer needs. You cannot

decommission a service if a service order requesting action on that service is in the

Requested or Draft, Scheduled, In Progress, or Invalid state.

Manage Deployment of Service Orders

A service order is an instance of the service definition that completes the definition for a

specific customer’s use. In Deploy mode, you can do the following configuration

deployment tasks on devices for which service orders are configured to be provisioned

or that have pending changes:

• Modify the parameters of a service order to suit your deployment needs or to resolve

traffic-forwarding problems caused by service attributes.

• Validate the configuration of service orders.

• Delete partial configuration of services on devices.

• Discard the pending configuration of services from being deployed to devices.

• Run configuration deployment jobs immediately or schedule them for future times.

• Preview pending configuration changes before deploying.

• Manage configuration deployment jobs.

Related
Documentation

About Build Mode in Service View of Connectivity Services Director on page 43•

• About Monitor Mode in Service View of Connectivity Services Director on page 47
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About Fault Mode in All Views of Connectivity Services Director

Fault mode in Connectivity Services Director provides you visibility into your network

status and performance by displaying alarms and events generated on devices and

configured services on devices. Connectivity Services Director monitors its managed

devices andmaintains the information it collects from the devices in a database. Fault

mode displays this information in easy-to-understand graphs and in tables that you can

sort and filter, allowing you to quickly visualize the state of your network, spot trends

developing over time, and find important details. When certain types of events are

persistent, or when the condition causing the event crosses a threshold, SNMP sends a

notification, also called a trap to Connectivity Services Director.

Connectivity Services Director correlates traps, describing a condition, into an alarm . For

example, multiple power supply traps coming from a device are correlated into a single

power supply alarm for the device. Themain purpose and benefit of monitoring

functionalities is toallow theoperators toquicklymonitor thehealth (working condition),

operating efficiency, traffic-handling capacity, and performance status of the managed

devices and configured services such as E-Line, E-LAN, and IP.

Themonitoring mechanism is tool that enables the operator to understand the network

health and status by drilling down to all the components of a device. The device status

is marked as green, red, orange, or blue, based on the health, availability, performance

and other important key performance indicators.

• Red denotes an emergency condition, which is a systempanic or other conditions that

cause the routingplatformto stop functioning. It also indicates that thedevice is offline

or turned down.

• Orange denotes an alert, which can be conditions thatmust be corrected immediately,

such as a corrupted system database.

• Yellow indicates a notice, which signifies conditions that are not error conditions but

are of interest or might warrant special handling. It can also include a severity level

equivalent to informational or debugging messages.

• Blue denotes an informational message; no action is necessary. Informational alarms

donot necessarily indicate anerror. It could indicate that adevice or entity has changed

state.

Related
Documentation

About Build Mode in Service View of Connectivity Services Director on page 43•

• About Deploy Mode in Service View of Connectivity Services Director on page 45

• About Monitor Mode in Service View of Connectivity Services Director on page 47

About Monitor Mode in Service View of Connectivity Services Director

Monitormode inConnectivityServicesDirectorprovides youvisibility into the transmission

of packets between peer devices, health and traffic-handling capacity, and consolidated

statistical details of important packet metrics based on the services configured. The

47Copyright © 2019, Juniper Networks, Inc.

Chapter 2: Service View Tasks and Lifecycle Modes



Connectivity Services Director applicationmonitors itsmanaged services on devices and

maintains the information it collects from the devices in a database. Monitor mode

displays this information in easy-to-understand graphs and in tables that you can sort

and filter, allowing you to quickly visualize the state of your network, spot trends

developing over time, and find important details.

This topic describes the following functionalities that are available in Monitor mode of

Service View:

• Quick Access to Important Troubleshooting Details on page 48

• Performance Monitoring on page 48

• View and Clear Interface Information on page 48

• View Interface Status on page 49

• View Routing Table on page 49

• ViewMAC Table on page 49

• Traceroute for an MPLS LSP on page 49

• MPLS Ping on page 49

Quick Access to Important Troubleshooting Details

Themain purpose and benefit of monitoring functionalities is to allow the operators to

quickly monitor the health (working condition), operating efficiency, traffic-handling

capacity, and performance status of the managed devices and configured services.

Several monitors or widgets are displayed to enable you to track, diagnose, and rectify

problemsanddiscrepanciesassociatedwith services configuredondevices. For example,

youmight observe that an L3VPN service is reported as down from the summarized

information presented for that service on themonitoring page. This high-level view

enables you tonavigate to the settings for that serviceand tune themproperly to function

properly.

PerformanceMonitoring

You can employ the ITU-T Y.1731 standard-compliant Ethernet loss measurement

(ETH-LM), Ethernet synthetic loss measurement (ETH-SLM), and Ethernet delay

measurement (ETH- DM) capabilities to analyze and examine the operating efficiency

and performance status. These performancemonitoring functionalities can be run for

E-Line and E-LAN services. You can start and stop the collection of performance

monitoring statistics on the services that you want to monitor. The retrieval and

computation of statistical details are performed using SNMPMIBs.

View and Clear Interface Information

You can view the learned MAC address information for a device associated with a

particular service, the interface statistical counters andmetrics, and the status of an

interface. The functionalities available in Monitor mode of Service View are equivalents

to the operational commands you can run from the Junos CLI interface to view interface

informationorMACaddressdetails. Youcanalsoclear the interface statisticsmaintained

on a device.
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View Interface Status

You can view the interface status to monitor interface bandwidth utilization and traffic

statistics on the device. When you view the interface status for a particular service, all

the interfaces configured on the different devices associated the service are retrieved

and displayed.

View Routing Table

TheRoutingTablewindowenables youview the routing table information for the selected

virtual routing instance. For L3VPN services, you can determine which LSPs or tunnels

are being used by looking at the routing tables.

ViewMAC Table

You can view the learned MAC address information for a device associated with a

particular service. YoucanmanageMACentriesmoreefficiently by viewing theconfigured

aging time for a MAC entry, which is the maximum time that an entry can remain in the

MAC address table before it is deleted because it has reached its maximum age

Traceroute for anMPLS LSP

You can performa traceroute operation to examine the network reachability and identify

connection failures from a source or ingress host to a remote host for an MPLS LSP

signaled by RSVP. It a debugging tool to locate MPLS label-switched path (LSP)

forwarding issues in a network. (Currently supported for IPv4 packets only.)

MPLS Ping

You can use theMPLS ping application to examine the network reachability and identify

any broken links for diagnostic purposes. In IP networks, the ping and traceroute

functionalities enable you to verify network connectivity and find broken links or loops.

In MPLS-enabled networks, you can use the ping capability to determine whether IP

connectivity exists to a destination even when the ping packets must traverse multiple

LSPs.

Related
Documentation

• About Build Mode in Service View of Connectivity Services Director on page 43

• About Deploy Mode in Service View of Connectivity Services Director on page 45

• About Fault Mode in All Views of Connectivity Services Director on page 47
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• Getting Started with Connectivity Services Director on page 52

• Prestaging Devices Overview on page 55

• Junos Space Layer 2 Services Overview on page 56

• Junos Space Layer 3 Services Overview on page 65

• Provisioning Process Overview on page 67

• Seamless MPLS Support in Junos Space Overview on page 70

• Service Attributes Overview on page 72

• Service Order States and Service States Overview on page 87

• Understanding VLANManipulation (Normalization and VLANMapping) on Ethernet

Services on page 89

• VLAN Pool Profiles Overview on page 94

• Redundant Pseudowires for Layer 2 Circuits and VPLS on page 95

• VPLS over GRE Overview on page 96

• Junos Space Network Topology Overview on page 97

• Service Recovery Overview on page 98

• Multicast L3VPN Overview on page 99

• Multi-Chassis Automatic Protection Switching Overview on page 100

• Inverse Multiplexing for ATMOverview on page 101

• Rendezvous Point on page 102

• Understanding Multicast Rendezvous Points, Shared Trees, and Rendezvous-Point

Trees on page 102

• Understanding PIM Sparse Mode on page 104

• ConfiguringShared-TreeDataDistributionAcrossProviderCores forProviders ofMBGP

MVPNs on page 107

• ConfiguringSPT-OnlyMode forMultiprotocol BGP-BasedMulticast VPNsonpage 108

• Configuring VRF Route Targets for Routing Instances for an MBGPMVPN on page 110

• Static Pseudowire Provisioning for VPLS Services on page 111
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Getting Started with Connectivity Services Director

Based on your network deployment needs and configuration settings, youmight require

different service types, such as E-Line, IP, E-LAN, or RSVP LSP services, to be applied on

devices in your topology. It is essential to discover or add the devices that you want to

be administered using Connectivity Services Director to the application database, before

you can enable and define services. Youmust configure the basic andmandatory device

settings such as routing instances, routing protocols, and administrative groups before

they are imported or discovered for additional modifications, such as configuration of

services and using the network management application.

When you install Connectivity Services Director, the single application package installs

thecapabilities for configuringnetwork services, suchasE-Line, IP, andE-LAN, configuring

MPLSandRSVP label-switchedpath (LSP) services, configuringPrecisionTimeProtocol

(PTP) and synchronous Ethernet services, configuring the OAM (Operations,

Administration and Maintenance) functionality, and configuring class of service (CoS)

profiles. To install Connectivity Services Director, see the Installation Instructions for

Connectivity Services Director, Release 2.1 section in Junos Space Connectivity Services

Director Release Notes, Release 2.1.

Startingwith Connectivity Services Director Release 2.1, you can also access the Services

Activation Director GUI interface to launch workspaces to configure functionalities. To

access the Services Activation Director GUI, see “Accessing the Services Activation

Director GUI” on page 28.

The followingworkflowdescribes the tasks that youneed toperformafter the installation

of the application to enable effective and streamlinedmanagement, provisioning, and

troubleshooting of devices and services configured using Connectivity Services Director.

After you install the Connectivity Services Director application, follow the tasks given

below to enable effective management, provisioning, and troubleshooting of devices

and services using the application:
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1. Discover devices usingConnectivity ServicesDirectorGUI or the JunosSpacePlatform

workspace. See “Discovering Devices” on page 179 for instructions on discovering

devices using Connectivity Services Director. See Discovering Devices in the Junos

SpaceNetworkManagementPlatformUserGuide for instructionsondiscoveringdevices

using the Junos Space Platformworkspace.

NOTE:

Ensure the following before you add a device using device discovery:

• SSH v2 is enabled on the device. To enable SSH v2 on a device, run the
following CLI command:

set system services ssh protocol-version v2

• The NETCONF protocol over SSH is enabled on the device. To enable
the NETCONF protocol over SSH on a device, run the following CLI
command:

set system services netconf ssh

• The device is configured with a static management IP address that is
reachable from the Junos Space server. The IP address can be in-band
or out-of-band.

• A user with full administrative privileges is created on the device for the
Junos Space administrator.

• If you use SNMP to probe devices as part of device discovery, ensure
that SNMP is enabled on the device with appropriate read-only
V1/V2C/V3 credentials.

2. Discover the roles of devices and assign network-provider edge (N-PE) roles as

necessary. Toprestagedevices andassigndevice roles, see “DiscoveringDeviceRoles”

on page 372 and “Excluding Devices from N-PE Role Assignment” on page 373.

3. Create service templates. Templates provide a powerful mechanism to configure

advanced service-related options that are not exposed via the service order creation

workflow. Templates are attached to a service definition. To work with service

templates, see “Service TemplatesWorkflow” on page 1709 and “Applying a Service

Template to a Service Definition” on page 1710.

4. Review predefined service definitions that are available by default, and determine

whether you want to create a new customzied service definition. A service definition

specifies the attributes that are common among a group of service orders that have

similar service requirements. Toworkwith service definitions, see “Predefined Service

Definitions” on page 451, Creating an E-Line Service Definition, “Creating a

Multipoint-to-Multipoint E-LAN Service Definition” on page 619, “Creating a

Point-to-Multipoint E-LAN Service Definition” on page 641, “Creating a Full-Mesh IP

Service Definition” on page 669, and “Creating a Hub-and-Spoke (One Interface) IP

Service Definition” on page 678.
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5. Create customers that denote the users to be associated with service orders. New

customers must be identified to the system before you can provision and activate a

serviceorder for them.Tocreatecustomers, see “AddingaNewCustomer”onpage697.

6. Create class-of-service profiles to prioritize the traffic flow and define policies for

handling received packets to avoid network congestion and traffic disruption. See

“Creating and ManagingWired CoS Profiles” on page 222.

7. Create serviceorders for the typesofprotocols that your networkenvironment requires

for optimal and cohesive management of large numbers of devices. A service order

is an instance of the service definition that completes the definition for a specific

customer’s use.Toworkwith serviceorders, see “CreatingaServiceOrder” onpage773.

8. Deploy service orders to propagate the service configuration to the corresponding

devices. To transfer service order configurations to devices and apply the settings on

the devices, see “Deploying Services Configuration to Devices” on page 959 and

“Managing Service Configuration Deployment Jobs” on page 957.

9. Perform audit operations, such as functional and configuration audit, to examine the

status of interfaces, LDP sessions, neighbor links, and endpoints of E-Line services.

Youcanalso identifywhether theserviceconfigurationon thedevicehasbeenchanged

out of band. In addition, you can use op scripts to perform any function available

through the remote procedure calls (RPCs) supported by either the Junos XML

management protocol or the Junos XML API. For more information, see “Performing

aFunctionalAudit” onpage 1019, “PerformingaConfigurationAudit” onpage 1027, and

“Troubleshooting N-PE Devices Before Provisioning a Service” on page 1030.

10. Monitor thehealth (workingcondition), operatingefficiency, traffic-handlingcapacity,

and performance status of the managed devices and configured services. Several

monitors or widgets are displayed to enable you to track, diagnose, and rectify

problems and discrepancies associated with services configured on devices. To

evaluate and diagnose the services, traffic-flow, and device states, see “Service

Monitoring Capabilities in Connectivity Services Director” on page 1134.

11. View information about the health of your network and changing conditions of your

equipment.UseFaultmode to findproblemswithequipment, pinpoint securityattacks,

or to analyze trends and categories of errors. For example, if you find that a particular

device or a service has recorded a large number of critical or major alarms, you can

then navigate to the appropriate device settings page or service order page to correct

andmodify the attributes or diagnose the problems that might be generating the

alarms. To view alarms and events, see “Understanding Fault Mode in Connectivity

Services Director” on page 47.

Related
Documentation

Prestaging Devices Overview on page 55•

• Junos Space Layer 2 Services Overview on page 56

• Junos Space Layer 3 Services Overview on page 65

• Provisioning Process Overview on page 67

• Seamless MPLS Support in Junos Space Overview on page 70

• Service Attributes Overview on page 72
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• Service Order States and Service States Overview on page 87

Prestaging Devices Overview

In the Junos Space Connectivity Services Director product, prestaging takes the devices

already under Junos Spacemanagement and prepares them for service activation. The

prestaging process discovers network provider edge (N-PE) devices in the Junos Space

database and assigns roles to those devices and their interfaces. N-PE routers and

user-to-network interfaces (UNIs) arebasicbuildingblocks required for Layer 2andLayer

3 provisioning.

NOTE: The Connectivity Services Director application does not support
provisioning for J Series devices.

The Junos Space software makes it easy to complete all the prestaging activities you

need for up to several hundred devices.

Prestaginguses theConnectivityServicesDirector application toautomatically determine

the role of a router based on rules that exist in the system. If a router is an N-PE router,

the Junos Space software assigns it the N-PE role. The Junos Space software qualifies

each interface on the N-PE router to be a serviceable UNI.

N-PEandUNI recommendationsmadeautomaticallyby theConnectivityServicesDirector

application are appropriate for most situations. In some networks, however, youmight

need to make some exceptions. Youmight have recommended N-PE devices that you

don’twant to assign theN-PE role for provisioning. In addition, youmightwant to exclude

some interfaces from qualification as UNIs.

Although the prestaging mechanism is automatically run in the background by default

in the Connectivity Services Director application of Connectivity Services Director, you

canmanually configure the prestaging settings by using the Services Activation Director

GUI, which provides the prestaging workspace.

To prestage devices while accepting all recommendations made by the Connectivity

ServicesDirectorapplication, see“DiscoveringandAssigningAllN-PEDevices”onpage349.

Tomake exceptions to the Connectivity Services Director recommendations, see

“Discovering and Assigning N-PE Devices with Exceptions” on page 351.
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NOTE: After a device is prestaged in Connectivity Services Director, the
prestaging job is not initiated on the same device again. When a device
notification is received by the application, Connectivity Services Director
synchronizes the prestaging database on the UI interfaces. If a mismatch is
detected in the UNI status of the interface in Connectivity Services Director
database and the UNI status of the interface on the device (caused by the
application being down or network accessibility problems), the
synchronization of the UNI interfacemight not occur. In such a case, the
synchronizationoperationoccurswhenaconfiguration-commiton thedevice
is done the next time. Tomanually resolve this discrepancy in the UNI status
of the interface, you can unassign the UNI role of the interface, which causes
prestaging to perform a synchronization.

Related
Documentation

Prestaging Devices Process Overview on page 342•

• Prerequisites for Prestaging Devices in Connectivity Services Director on page 348

• Discovering and Assigning All N-PE Devices on page 349

• Discovering and Assigning N-PE Devices with Exceptions on page 351

• Prestaging ATM and TDM Pseudowire Devices on page 354

• Prestaging Rules on page 362

Junos Space Layer 2 Services Overview

Junos Space Connectivity Services Director application enables you to provision the

following types of services:

• E-Line services across networks that use LDP or BGP for signaling in the network core.

These services use directed pseudowire virtual circuits across the network to establish

point-to-point virtual private networks (VPNs). The provisioner must specify the

addresses of the ingress and egress routers of the virtual circuits.

• Multipoint services across networks that use LDP or BGP signaling in the network core.

The Connectivity Services Director application supportsmultipoint-to-multipoint (full

mesh) services and point-to-multipoint (hub and spoke) services.

For details about Juniper Networks Layer 2 technologies, see the Junos OS VPNs

Configuration Guide.

E-Line services andmultipoint services support the following interface types:

• Port-to-port—All traffic is transported across the network.

• 802.1Q (dot1.q)—Supports 802.1Q VLAN-tagged network traffic in an E-Line or

multipoint Ethernet service. Network traffic is constrained using VLAN IDs.

• Q-in-Q—Supports double-tagged traffic in an E-Line or multipoint Ethernet service.
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• Asymmetric tag depth—Allows port-based, 802.1Q and Q-in-Q interfaces for UNIs to

coexist in a service.

• ATM—Supports the transmission of ATM cells through point-to-point connections in

an ATM network.

• TDM—Supports configuring SAToP or CESoPSN physical encapsulation of packets

for transmission over the TDM interface.

Table 6 on page 57 provides a guide to selecting the appropriate type of Layer 2 service

for a specific customer need.

Table 6: Selecting a Layer 2 Service

Provision This ServiceCustomer Requirement

Layer 2 VPN port-to-port service

OR

Layer 2 VPNQ-in-Q to Q-in-Q service for all
traffic

Send all VLAN traffic from one site to other sites
in the service.

Layer 2 VPN 802.1Q-to-802.1Q serviceSend traffic associated with one specific VLAN
from one site to other sites in the service.

Layer 2 VPN Q-in-Q to Q-in-Q service for a
range of VLANs

Send traffic associatedwitha rangeofVLANs from
one site to other sites in the service.

Juniper Networks refers to this kind of connection as a Layer 2 circuit. For details about

Layer 2 circuits, see the Junos OS VPNs Configuration Guide.

TheConnectivityServicesDirector applicationenables you toprovisiona rangeof services

from the following service families for your enterprise customers:

• E-Line Services on page 57

• E-LAN Services on page 61

E-Line Services

E-Line services provide transport and encapsulation of Layer 2 Ethernet circuits between

two endpoints. To provision an E-Line service, the provisioner must select the network

provider-edge (N-PE) routers that will be the service endpoints and configure the

user-network interfaces (UNIs)at thoseendpoints. The JunosSpacesoftwareautomates

the end-to-end provisioning of the pseudowire by establishing a virtual circuit between

the N-PE routers using a unique virtual circuit ID (VC ID).

The IETF refers to these connections in RFC 4905, Encapsulation Methods for Transport

of Layer 2 Frames over MPLS Networks as emulated virtual circuits, and in RFC 4447,

Pseudowire Setup and Maintenance Using the Label Distribution Protocol (LDP) as

pseudowire emulation (see IETF RFC 4447).
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The Metro Ethernet Forum (MEF) refers to these connections as E-Line services. See

Metro Ethernet Services – A Technical Overview by Ralph Santitoro.

The Junos Space software enables you to provision the following E-Line service options

for your enterprise customers:

• Port-to-Port Service on page 58

• Single VLAN Service Using 802.1Q Interfaces on page 58

• All Traffic Service Using Q-in-Q Interface on page 59

• Range of VLANs Service with Q-in-Q Interfaces on page 59

Port-to-Port Service

A port-to-port service transports all traffic on a port on a provider edge (N-PE) router

across the network to a port of another N-PE router. enterprise customers needs to

purchase only a single physical port for all their traffic. However, a single port might cost

more than the bandwidth for a single VLAN or selected range of VLANs.

The service provider needs no knowledge of the enterprise customer’s VLAN structure,

because all the customer’s traffic is transported.

Figure 1 on page 58 shows an example in which a port-to-port connection transports all

VLAN traffic for an enterprise customer from customer site A to customer site B across

the network.

Figure 1: E-Line LDP Connection Transports Traffic

Single VLAN Service Using 802.1Q Interfaces

802.1Q services transport VLAN traffic from one site to another across the network. The

selected payload is a single VLAN, so the enterprise customer needs to purchase only

the bandwidth necessary to transport that VLAN. To implement this type of service, the

service provider must exchange VLAN information with the enterprise customer.

Consider the example shown in Figure 2 on page 59. VLAN 100might be used for payroll

andspanssitesAandB.VLAN200 isusedbyengineeringandspanssitesAandC.Payroll

and engineering are securely separated by provisioining separate point-to-point

connections for each VLAN, each on a separate VCID. Service multiplexing at customer

site A allowsmultiple virtual circuits to share the same port, yet provide secure

connections to separate sites.
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Figure 2: E-Line Ethernet Services with 802.1Q Interfaces

All Traffic Service Using Q-in-Q Interface

This type of E-Line (LDP) service uses Q-in-Q interfaces and transports all customer

traffic from one site to another across the network. The Q-in-Q interface adds a service

provider tag to the frame,which isolates theenterprise customer’sVLAN tags. The service

provider does not need knowledge of the customer’s VLAN structure because all traffic

is transported to the destination site.

Range of VLANs Service with Q-in-Q Interfaces

This type of E-Line (LDP) service uses Q-in-Q interfaces and carries a range of VLANs

across the network. The service provider must establish with the enterprise customer

which VLANs are to be transported. The service provider allocates a service provider

VLAN ID as a second tag to the selected VLAN ID range, which isolates the traffic on

selected VLANs from other traffic.

Figure 3 on page 60 shows an example in which an enterprise customer has six VLANs

with VLAN IDs 100, 200, 300, 400, 500, and 600. The service is provisioned to carry only

VLANs 100, 200, and 300 by tagging themwith the service provider VLAN ID of 2000.

VLANs 400, 500, and 600 do not cross the network.
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Figure 3: E-Line Service with Q-in-Q Interfaces for Range of VLANs.

You can use separate service VLAN IDs to segregate traffic into secure groups of VLAN

IDs. For example,VLANs 100, 200, and300mightall bepart of anenterprise’s engineering

organization,whileVLANs400,500, and600mightexchange informationwith suppliers.

In this example, VLANs 100, 200, and 300 can be double-tagged with service VLAN ID

2000 and get transported only to the remote engineering site, while VLANs 400, 500,

and 600might be tagged with the service VLAN ID of 2001 and get transported only to

the supplier’s site along a separate pseudowire, as shown in Figure 4 on page 60.

Figure 4: E-Line Service with Q-in-Q Interfaces for Range of VLANs on Separate Service
Provider VLANs
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E-LAN Services

The Connectivity Services Director application supports E-LAN service, which in turn

provides multipoint-to-multipoint services and point-to-multipoint services.

The Metro Ethernet Forum (MEF) refers to these connections as E-LAN services. See

Metro Ethernet Services – A Technical Overview by Ralph Santitoro.

Figure 5 on page 61 shows an example of a multipoint service connecting four customer

sites.

Figure 5: Multipoint-to-Multipoint E-LAN Service—Full Mesh

This full mesh design enables direct communication among all PE routers in the service.

This topology is efficient for services inwhichall sites need to communicatewith all other

sites.

Figure 6 on page 62 shows a point-to-multipoint service with a single hub. The service

provides connectivity between the hub router (PE1) and each of the spokes (PE2, PE3,

and PE4), but no connectivity exists among the spokes.
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Figure 6: Point-to-Multipoint E-LAN Service with Single Hub

This kind of topology is effective for services in which one site needs to communicate

with all other sites, but communication among spokes is not required. For example, the

hub site might house corporate headquarters, while each of the spoke sites is a region.

Figure 7 on page 62 shows a point-to-multipoint service with two hubs. In this case, all

spokes connect to both hubs.

Figure 7: Point-to-Multipoint E-LAN Service with Multiple Hubs
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Typical use for dual hub routers is to provide redundancy in case of failure. For example,

a data center might be duplicated at customer sites A and B, requiring access to both

sites from each spoke for effective redundancy.

For all E-LAN topologies, route targets and route distinguishers designate themultipoint

connectivity among the participating endpoints.

Service Autodiscovery

BGP uses autodiscovery to establish connectivity among the N-PE routers quickly and

efficiently. Figure 8 on page 63 shows an example.

Figure 8: Autodiscovery of Service Connectivity

In this example, deviceN-PE-1 is the first tobeadded to the service. It exports route target

100 and imports route target 100. When N-PE-2 is added to the service, it also exports

and imports route target 100. The Junos OS on the device automatically makes the

association and creates the connectivity path between the two devices. Similarly, when

you add a third device to the service, so long as it exports/imports the same route targets

as the N-PE devices in the existing service, the new device is added to the service and

connectivity with both existing N-PE devices is established automatically.

For a point-to-multipoint service, route target/route distinguisher pairs have different

values for import and export. These values for import and export are the same for all

spokes, but reversed for the hub, thereby enabling communication between each spoke

and the hub, but not among spokes. Figure 9 on page 64 shows an example. In this case,

device N-PE-1 (the hub router) exports route target:route distinguisher pair 100:6 and

imports 100:5. Each spoke imports 100:6 and exports 100:5 enabling communication

with the hub, but not with each other.
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Figure 9: Autodiscovery in a Point-to-Multipoint Service

VPLS and Normalization

Similar toE-Line services, theUNIsof E-LANservices canbeport-to-port, 802.1Q,Q-in-Q,

or asymmetric tag depth. The type of VLANmapping—or normalization—is specified in

the service definition. VLAN normalization applies only to MX Series devices.

NormalizationsupportsautomaticmappingofVLANs.Normalizationperformsoperations

on VLAN tags to achieve the desired translation. The Connectivity Services Director

application supports the following forms of VLAN normalization:

• Normalize to VLAN all—The customer VLAN ID is preserved across the network. That

is, the broadcast domain includes the interfaces that have the same VLAN ID across

the E-LAN service. For double-tagged packets (Q-in-Q interfaces), a pop operation at

ingress strips the service VLAN ID from the packet. A corresponding push operation at

egress inserts the service VLAN ID known at the local site. Hence, the service VLAN ID

at egress does not have to match the service VLAN ID at ingress.

For single-tagged packets (802.1Q interfaces), “Normalize to VLAN all” has no effect,

because the packet has no service VLAN ID to pop or push.

• Normalize to VLAN none—The customer VLAN ID is not preserved across the network.

The broadcast domain includes all VLANs at any site provisioned in the service. For

single-tagged packets (802.1Q interfaces), a pop operation at ingress removes the

customer VLAN ID from the packet. A corresponding push operation at egress adds a

local customer VLAN ID.

For double-tagged packets (Q-in-Q interfaces), both customer VLAN ID and service

VLAN ID are popped from the packet at ingress and pushed at egress.

• Normalize toDot1q tag—TheVLAN tag is preserved across the network. The broadcast

domain includes all VLANs at any site provisioned in the service. For information about

howframesare translated toprovide the requiredVLANtags for interfaceswithdifferent

tag heights, see the section “VLANMapping for E-LAN Services” in “Understanding
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VLANManipulation (Normalization and VLANMapping) on Ethernet Services” on

page 89.

• Normalize toQinQ tags—The inner VLAN tag and outer VLAN tag are preserved across

the network. The broadcast domain includes all VLANs at any site provisioned in the

service. For information about how frames are translated to provide the requiredVLAN

tags for interfaceswith different tag heights, see the section “VLANMapping for E-LAN

Services” in “Understanding VLANManipulation (Normalization and VLANMapping)

on Ethernet Services” on page 89.

Normalization works well with automatically assigned VLAN IDs, because the service

provider does not need to specify the VLAN IDs that are popped and pushed. Without

normalization, the service providermust specify explicitly the customer VLAN ID and the

service VLAN ID.

• Normalization not required—If normalization is not used, then all customer VLAN IDs

and all service VLAN IDs must match to be part of the same broadcast domain.

NOTE: For information on the VLAN normalization requirements for each
Ethernet interface option, see the table in the topic“Specifying Connectivity
InformationWhen Signaling Is BGP” on page 601

Related
Documentation

Junos Space Layer 3 Services Overview on page 65•

• Provisioning Process Overview on page 67

• Seamless MPLS Support in Junos Space Overview on page 70

• Service Attributes Overview on page 72

Junos Space Layer 3 Services Overview

To configure Layer 3 virtual private network (VPN) functionality, you must enable VPN

support on theprovider edge (PE) router. Youmustalsoconfigureanyprovider (P) routers

that service the VPN, and youmust configure the customer edge (CE) routers so that

their routes are distributed into the VPN.

This topic covers:

• Overview on page 65

• Layer 3 VPN Platform Support on page 66

• Layer 3 VPN Attributes on page 66

• Device Configuration for a Layer 3 VPN on page 67

Overview

RFC 4364 VPNs are also known as BGP/MPLS VPNs because BGP is used to distribute

VPN routing information across the provider’s backbone, and MPLS is used to forward

VPN traffic across the backbone to remote VPN sites.
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Customer networks, because they are private, can use either public addresses or private

addresses, asdefined inRFC 1918,AddressAllocation forPrivate Internets.Whencustomer

networks that use private addresses connect to the public Internet infrastructure, the

private addressesmight overlap with the same private addresses used by other network

users. MPLS/BGP VPNs solve this problem by adding a VPN identifier prefix to each

address fromaparticular VPNsite, thereby creating anaddress that is uniquebothwithin

the VPN and within the public Internet. In addition, each VPN has its own VPN-specific

routing table that contains the routing information for that VPN only.

Junos Space Connectivity Services Director application enables you to provision IP full

mesh services.

For more information about Layer 3 VPNs, see the Junos Software VPNs Configuration

Guide.

Layer 3 VPN Platform Support

Layer 3VPNsare supportedonmost combinationsof JuniperNetworks routingplatforms

and PICs that are capable of running the Junos Software.

MX Series routers configured in Ethernet services mode can support some of the Junos

OS Layer 3 VPN features. For Layer 3 VPNs, Ethernet servicesmode supports configuring

a loopback interface for a VPN routing and forwarding (VRF) instance. You can configure

up to two VRF instances in Ethernet servicesmode. Each VRF instance can handle up to

10,000 routes, The pingmpls l3vpn operational mode command is also supported.

Layer 3 VPNAttributes

Connectivity Services Director application supports the following Layer 3 VPNattributes.

For more information, see the Junos OS VPNs Configuration technical documentation.

• Target VPN—Identifies a set of siteswith aVPN towhich aPE router distributes routes.

This attributes is also called the route target. A PE egress router uses the route target

to determine whether a received route is destined for a VPN that the router services.

• Route distinguisher—a 6-byte number that you can specify using one of the following

formats:

• as-number:number, where as-number is an AS number (a 2-byte value) and number

is any 4-byte value. The AS number can be in the range 1 through 65,535. We

recommend that you use an Internet AssignedNumbers Authority (IANA)-assigned,

nonprivate AS number, preferably the Internet service provider’s (ISP’s) own or the

customer’s own AS number.

• ip-address:number, where ip-address is an IP address (a 4-byte value) and number

is any 2-byte value. The IP address can be any globally unique unicast address. We

recommend that you use the address that you configure in the router-id statement,

which is a nonprivate address in your assigned prefix range.
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Device Configuration for a Layer 3 VPN

To implement Layer 3 VPNs in the JUNOS Software, you configure one routing instance

for each VPN. You configure the routing instances on PE routers only. Each VPN routing

instance consists of the following components:

• VRF table—On each PE router, you configure one VRF table for each VPN.

• Set of interfaces that use the VRF table—The logical interface to each directly

connected CE router must be associated with a VRF table. You can associate more

than one interface with the same VRF table if more than one CE router in a VPN is

directly connected to the PE router.

• Policy rules—These control the import of routes into and the export of routes from the

VRF table.

• One or more routing protocols that install routes from CE routers into the VRF

table—You can use the BGP and OSPF routing protocols and static routes.

Related
Documentation

Junos Space Layer 2 Services Overview on page 56•

• Provisioning Process Overview on page 67

• Seamless MPLS Support in Junos Space Overview on page 70

• Service Attributes Overview on page 72

Provisioning Process Overview

Provisioning is a multistep process that makes services available to customers. Dividing

theprovisioningprocess intodistinct activitiesallowsyou touse role-basedaccesscontrol

to configure which type of user is allowed to perform each step. Complete the following

tasks to provision a service:

1. Discover Devices

2. Discover Roles

3. Assign NPE Role

4. Review Predefined Service Definitions or Create Service Definition

5. Create Customer

6. Create Service Order

7. Deploy Service Order

8. Perform Configuration Audit

9. Perform Functional Audit

10. (Optional) View Provisioned Services

11. (Optional) Decommission Provisioned Services
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Steps in the sequence are often performed by users with different levels of privilege. The

JunosSpacesoftwareprovidespredefinedadministrator roles thatprovide thenecessary

privilege for each step in the sequence:

• The Device Manager role allows an administrator to discover devices (step 1).

• TheServiceManager role allowsanadministrator toperformdeviceprestagingactions

including discovering and assigning device roles (steps 2 and 3).

• The Service Designer roles allows an administrator to create and publish a service

definition (step 4).

• The Service Activator (less privileged) role allows an administrator to perform

provisioning tasks including creating andmanaging customers, service orders, and

services (steps 5 through 9).

For details about predefined administrator roles, see Predefined Roles Overview in the

Junos Space Network Application Platform User Guide.

Network Operator Tasks—Provisioning Prerequisites

Network operators are usually responsible for performing the prerequisite tasks before

the following service designer or service provisioner can perform their tasks:

• Discovering devices

• Launching role discovery

• Assigning N-PE roles

Discovering devices is the process for bringing your network devices under Junos Space

management. Network operatorswhoare assigned theDeviceManager role canperform

this task. SeeDevice Discovery Overview in the Junos Space Network Application Platform

User Guide for more information about discovering devices.

Launching role discovery and assigning N-PE roles are collectively known as prestaging

tasks. Prestaging finds the N-PE devices among those already under Junos Space

management and assigns appropriate MPLS N-PE roles to these devices and

user-to-network interface (UNI) roles to their interfaces.Once these rolesare established,

the devices are ready for provisioning. Users who are assigned the Service Manager role

can perform device role discovery and role assignment. See Prestaging Devices Overview

for more information about prestaging devices.

Service Designer Tasks

The service designer is responsible for the creation andmanagement of the service

definitions that the service provisioner uses as the basis for creating a service order.

A service definition specifies the attributes that are common among a group of service

orders that have similar service requirements. For example, a service definition might

specify a port-to-port service, whether the associated VCID should be assigned

automatically from a predefined pool or specified by the user, and what range of

bandwidthscanbeassigned in theserviceorder. Theservicedefinitionalsodefineswhich

attributes of the service can be edited in the service order.
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The JunosSpaceConnectivityServicesDirector productprovides several standard service

definitions which support most needs. If the standard service definitions do not support

yourneeds, then theservicedesignerneeds tocreatenew, customizedservicedefinitions.

Users who are assigned the Service Designer role can create andmanage service

definitions.

Service Provisioner Tasks

Service provisioner tasks include the following:

• Creating the customer.

• Creating the service order.

• Deploying the service.

• Performing a configuration audit.

• Performing a functional audit.

A service order is an instance of the service definition that completes the definition for a

specific customer’suse.Theserviceorderalwaysspecifies thecustomerandtheendpoints

that link the customer sites through the MPLS network. For each endpoint, the service

provisioner specifies the N-PE device and the UNI on that device that connects the

customer site to the N-PE device. The service order can also specify any additional

attributes that are configured in the service definition as editable in the service order.

These attributesmight include theVCID,MTU for theUNI,MTU for the connection across

the network, VLAN-ID, and bandwidth.

Deploymentofaserviceorderpushesaservice to thenetworkdevices.Beforedeployment

completes, a series of pre-validation checks takes place. If the pre-validation checks

indicate that the service is valid, the deployment proceeds. If the pre-validation checks

indicatean invalid service, the serviceprovisionermust re-create theserviceorder correctly

before trying again to deploy it.

After the service is deployed, a functional audit establishes whether the service is up or

down. If the functional audit reports that the service is up, the customer can begin using

the service.

Once the service is active, the service provisioner canmonitor the health of the service

by running a functional audit or a configuration audit.

Users assigned the Service Activator role can perform these service provisioning tasks.

Related
Documentation

Discovering Devices section in Understanding Build Mode in Views Other than Service

View of Connectivity Services Director on page 171

•

• Junos Space Layer 2 Services Overview on page 56

• Junos Space Layer 3 Services Overview on page 65

• Seamless MPLS Support in Junos Space Overview on page 70

• Service Attributes Overview on page 72
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SeamlessMPLS Support in Junos Space Overview

MPLS-based Layer 2 services are growing in demand among enterprise and service

providers, creating new challenges related to interoperability between Layer 2 and Layer

3 services for service providers who want to provide end-to-end value-added services.

Service providers are able to expand service offerings, support multiple Layer 2 services

andprotocols at the same time, and toexpandgeographically by stitchingdifferent Layer

2 services to one another and to Layer 3 services, moving toward a seamless MPLS

environment..

Interconnecting a Layer 2 VPLS network with a Layer 3 network enables the sharing of

a service provider's core network infrastructure between IP andLayer 2 services, reducing

the cost of providing those services. A Layer 2 MPLS circuit allows service providers to

create a Layer 2 circuit service over an existing IP and MPLS backbone.

Service providers do not have to invest in separate Layer 2 equipment to provide Layer

2 services. A service provider can configure a provider edge router to run any Layer 3

protocol in addition to the Layer 2 protocols. Customers who prefer to maintain control

over most of the administration of their own networks want Layer 2 circuit connections

with their service provider instead of a Layer 3 VPN connection.

Using MPLS pseudowires makes it possible to encapsulate Layer 2 packets and extend

Layer 2 services into Layer 3 networks. Junos Space supports the trend toward

accomplishing Seamless MPLS with these two features:

• VPLS Access Into Layer 3 Networks

• Pseudowire Access Into a Layer 3 VPN

VPLS Access Into Layer 3 Networks

IntegratedRouting andBridging (IRB)provides simultaneous support for Layer 2bridging

and Layer 3 routing within the same bridge domain, and as well as in the same routing

instance. If the IRB interface configured as a Layer 3 interface is being used in a routing

instance, that routing instance will specifically declare it as routing-interface rather than

regular VPLS interface (whichacts like the interfaceona specific VPLSSite). This feature

requires a normalized VLAN (vlan-id=xxx which is the same as the unit name on which

the inet4 address is specified)
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Junos Space uses the two peer subinterfaces of the IRB to create the link between an

existing VLAN and the Layer 3 network. An extra VPLS node is required to support the

IRB interface which allows the rest of the VPLS nodes to be able to access all Layer 3

networks reachable through that interface. Providing the VPLS access into Layer 3

networks enhances basic VPLS services. Because this feature requires a normalized

VLAN, it is available only on the Juniper Networks MX 3D Router series.

Pseudowire Access Into Layer 3 VPNs

While technically not a VPLS feature, Junos Space uses pseudowires, also known as

pseudowire stitching, to link Layer 2 services together and toLayer 3 services. Pseudowire

access into the L3 VPN enhances the standard E-Line LDP and E-Line services. The link

into the L3VPNnetwork can be port-based or VLAN-based. At least one node in the peer

mustbea logical tunnel (LT) interface. Thepeermustappear in theL3VPNconfiguration.

PE-2
BGP group

PE-0
BGP group

PE-1
BGP group L3VPN Network

UNI

UNI

UNI

g0
17

79
4

ge-1/1/1

lt-1/1/1.0

Interface UNI
Interface lt-1/1/1.1

pseudowire

In Junos, this Layer 2 access into Layer 3 VPNs is accomplished by using a tunnel PIC to

create a peer link between pseudowire and a Layer 3 network interface.

71Copyright © 2019, Juniper Networks, Inc.

Chapter 3: Network Services Overview



Related
Documentation

Creating a Service Definition for VPLS Access into Layer 3 Networks on page 666•

• Creating a Service Order for VPLS Access into Layer 3 Networks on page 867

Service Attributes Overview

A service is defined by a set of attributes. Some attributes are common to all service

instancescreated fromoneservicedefinition, andare thereforesetduringservicedefinition

time. Other attributes are specific to a service instance andmust be set in the service

order. Some attributes can be set either in the service definition or in the service order; in

such cases it is up to the service designer to determine when the attribute will be set.

The Connectivity Services Director user interface groups service attributes as follows:

• General attributes—General informationabout theservice, suchaswhether theservice

is E-Line, multipoint-to-multipoint E-LAN (full mesh VPLS), or point-to-multipoint

E-LAN,what signalingmechanism isused in thenetworkcore,whetherqualityof service

(QoS) is enabled on the service, and who the enterprise customer is who uses the

service.

• Connectivity settings—Information about connectivity among customer sites through

the network. For E-Line services in a network with LDP switching in the network core,

these settings include the VC ID. For multipoint Ethernet (or E-LAN) services, these

settings include the route target and route distinguisher.

• Advanced settings—Information about advanced connectivity among customer sites

through thenetwork. FormultipointEthernet (orE-LAN)services, thesesettings include

tunnel services, local switching, fast-reroute-priority, label block size, and connection

type.

• UNI settings—Information about each customer site, including the N-PE device and

interface the site uses to connect to the network, the encapsulation method used

(physical and logical), MTU, customer VLAN ID and range, service VLAN ID, bandwidth

limiting, and so on.

General Attributes

The following general attributes are defined for each service:

• Service Type on page 73

• Signaling on page 73

• Comments on page 73

• Service Template on page 73

• Threshold Alarm Profile on page 73

• Interface Type on page 73

• Enabling Additional Features on page 73

• Customer on page 74

• Enable QoS on page 74
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Service Type

TheService typeattribute specifies anetwork topology to include in the servicedefinition.

The service type is the first attribute to be determined during service definition. It can be

one of the following values:

• E-Line—Virtual circuit between two customer sites in the network core.

• E-LAN(Multipoint-to-multipoint)—Virtual privateLANservice (VPLS)amongmultiple

customer sites in the network core to provide full mesh connectivity.

• E-LAN (Point-to-multipoint) —VPLS amongmultiple customer sites in the network

core to provide connectivity between a hub site andmultiple spoke sites.

• IP—Supports fullmeshandhub-spokeconnectivity throughdifferent routingprotocols

such as BGP, OSPF, or static protocols, or a combination of these.

Signaling

The Signaling attribute specifies the protocol that controls signaling in the network core.

You can select BGP or LDP.

Comments

The Comments attribute .

Service Template

The Service Template attribute .

Threshold Alarm Profile

The Threshold Alarm Profile attribute.

Interface Type

The Interface type attribute . You can specify one of the following:

• Ethernet

• TDM

• ATM

Enabling Additional Features

In addition to the interface type, depending on the Service type topology and Signaling

you specify, you can enable the following features for a service:

• Static pseudowire—For networks that do not support LDP or do not have LDP enabled.

You define pseudowires by configuring static values for the inbound and outbound

labels of the connection.

• Enable PW access to L3 VPN networks

• Enable L3 Access
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• Enable Multihoming

• Enable PWExtension

• Enable PWResiliency

• Decouple Service Status fromPort Status—Isolates events related to an interface in

the OpenNMS database. Only traps related to pseudowires are monitored.

Customer

This attribute specifies the enterprise customer who will use the service instance. This

attribute is always specified in the service order.

Enable QoS

Thisattribute specifieswhetherQoS is enabledon theservice todivide traffic intoclasses

and offer various levels of throughput and packet loss when congestion occurs. When

youenableQoS in theservicedefinition, theQoSSettingsboxappearswhenyouconfigure

the service order.

NOTE: When you enable QoS in the service definition, bandwidth settings
are also configurable in the service order.

NOTE: AQoS profile that specifies a level-three scheduler is not supported
on port-to-port services. Only non-hierarchical port scheduler profiles are
supported.

UNI Settings

The following attributes are defined for the service endpoints or customer sites that are

connected by the service:

• Ethernet Options on page 75

• Interface on page 75

• MTU on page 75

• Customer Traffic Type on page 75

• Customer VLAN ID on page 76

• Service VLAN ID and VLAN ID Range on page 76

• Physical Encapsulation on page 76

• Logical Encapsulation on page 77

• Rate Limiting and Bandwidth on page 77

• UNI Settings for TDM Interfaces on page 78

• UNI Settings for ATM Interfaces on page 78
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Ethernet Options

This attribute identifies the interface type at the endpoint by defining the level of packet

tagging for the UNI. It can have the following values:

• asymmetric tag depth

Allows port-based, 802.1Q and Q-in-Q interfaces for UNIs to coexist in a service.

• port-port

Transfers all data from the UNI to the other end of the LSP trunk.

• dot1q

An 802.1Q interface that tags each packet with a VLAN ID, thus allowing a specific

VLAN to traverse the network.

• qinq

A Q-in-Q interface that double tags each frame. The inner tag is added by the service

provider. The service provider can use this inner tag to differentiate among services.

For example, you can configure VLANs for a customer’s intranet with a different inner

tag from VLANs used for working with providers or partners.

Interface

Specifies the physical interface on the N-PE device that connects the customer site or

CE device to the N-PE device.

MTU

Themaximum transmission unit (MTU) represents the largest frame size, in bytes, that

passes through the UNI. MTU is configurable.

NOTE: This value is distinct from theMTUassigned to the connectivity in the
network core.

Customer Traffic Type

Thisattributeplaces restrictionson the traffic that canbe transportedacross thenetwork

by the associated service. It can have the following values:

• Transport single VLAN

Restricts the associated service to transporting just one VLANacross the network. You

can use this option with 802.1Q and Q-in-Q interface types.

• Transport VLAN range

Allows the associated service to transport a range of VLANs across the network. You

can use this option with 802.1Q and Q-in-Q interface types.

• Transport all traffic
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Allows the associated service to transport all traffic across the network. You can use

this option with Q-in-Q interface types only.

The traffic typeattribute is not applicable toport-to-port services. Port-to-port services

always transport all traffic.

• Transport VLAN list

Allows the associated service to transport a list of VLANs across the network. You can

use this option with dot1q, qinq, and asymmetric tag depth VLAN tagging types.

Customer VLAN ID

Specifies a VLAN ID that is attached to each packet to permit VLANs to be shared across

the network.

This attribute can be used only with 802.1Q and Q-in-Q interface types.

Service VLAN ID and VLAN ID Range

The service VLAN ID (VLAN ID) specifies a second level of tagging to segregate groups

of VLANs.

The VLAN range specifies a range of VLANs to be transported across the network by

associating themwith a service VLAN ID.

These options are configurable only for Q-in-Q interfaces.

Physical Encapsulation

Specifies the physical link-layer encapsulation type.

• flexible-ethernet-services—Offers themost flexibility, dependingon thecharacteristics

of the N-PE device and its line modules.

For Gigabit Ethernet IQ interfaces and Gigabit Ethernet PICs with small form-factor

pluggable transceivers (SFPs) only, use flexible Ethernet services encapsulation when

you want to configure multiple per-unit Ethernet encapsulations. This encapsulation

type allows you to configure any combination of route, TCC, CCC, and VPLS

encapsulations on a single physical port. Aggregated Ethernet bundles cannot use this

encapsulation type. If you configure flexible Ethernet services encapsulation on the

physical interface,VLAN IDs from1 through511 areno longer reserved for normalVLANs.

In the Junos Space Connectivity Services Director product, you can use this

encapsulation type with 802.1Q interfaces and Q-in-Q interfaces in E-Line services

and in multipoint Ethernet services.

• vlan-ccc—You can use Ethernet VLAN encapsulation on CCC interfaces. This option

restricts the range of available VLAN IDs to 512 through 4094. VLAN IDs 1 through 511

are reserved for internal use.

In the Junos Space Connectivity Services Director product, you can use this

encapsulation type with 802.1Q interfaces and Q-in-Q interfaces in E-Line services.

• extended-vlan-ccc—UseextendedVLANencapsulationonCCC interfaceswithGigabit

Ethernet interfaces that must accept packets carrying 802.1Q values.
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In the Junos Space Connectivity Services Director product, you can use this

encapsulation type with 802.1Q interfaces and Q-in-Q interfaces in E-Line services.

• ethernet-vpls—Use Ethernet VPLS encapsulation on Ethernet interfaces that have

VPLS enabled and that must accept packets carrying standard TPID values.

In the Junos Space Connectivity Services Director product, this encapsulation is used

only for dedicated port interface types in multipoint Ethernet services.

Logical Encapsulation

Specifies the logical link-layer encapsulation type. Logical encapsulation with 802.1Q

interfaces allows you to route multiple services through the same physical interface.

• vlan-ccc—Use Ethernet virtual LAN (VLAN) encapsulation on CCC interfaces. When

you use this encapsulation type, you can configure the family ccc only.

• extended-vlan-ccc—UseextendedVLANencapsulationonCCC interfaceswithGigabit

Ethernet interfaces that must accept packets carrying 802.1Q values.

• vlan-vpls—Use VLAN VPLS encapsulation on Ethernet interfaces with VLAN tagging

and VPLS enabled. Interfaceswith VLANVPLS encapsulation accept packets carrying

standard Tag Protocol (TPID) values only.

Table 7 onpage 77 defines the logical encapsulation types that are valid for eachphysical

encapsulation type in an E-Line service.

Table 7: Physical and Logical Encapsulation Compatibilities in E-Line Services

Valid Interface TypesLogical EncapsulationPhysical Encapsulation

802.1Q and Q-in-Qvlan-cccflexible-ethernet-services

802.1Q and Q-in-Qvlan-cccvlan-ccc

802.1Q and Q-in-Qextended-vlan-cccextended-vlan-ccc

dedicated portnot applicableethernet-ccc

Table8onpage 77defines the logical encapsulation types that are valid for eachphysical

encapsulation type in multipoint Ethernet services.

Table8:PhysicalandLogicalEncapsulationCompatibilities inMultipointE-LANServices

Valid Interface TypesLogical EncapsulationPhysical Encapsulation

802.1Q and Q-in-Qvlan-vplsflexible-ethernet-services

dedicated portnot applicableethernet-vpls

Rate Limiting and Bandwidth

Rate limiting allows you to specify the maximum bandwidth permitted for a service.
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The burst rate is automatically calculated as two times the MTU of the UNI.

NOTE: When a service is QoS enabled, you can also configure rate limiting
and bandwidth in the service.

UNI Settings for TDM Interfaces

The following TDM options are configurable for TDM interfaces:

• Physical IF encapsulation—satop or cesopsn

• Jitter buffer

MSeries: 1 through 340

• Idle pattern—0 through 255

• Excessive packet loss rate—1 through 100%

• Payload size

MSeries: 64 through 1024

UNI Settings for ATM Interfaces

The following ATM options are configurable for ATM interfaces:

• Physical IF encapsulation—The type of encapsulation to apply to the interface. Use

atm-ccc-cell-relay for ATM cell relay encapsulation. Use atm-ccc-cell-mux for ATM

VC for CCC.

• VPI selection—The virtual path identifier

• VCI selection—This integer uniquely identifies the virtual circuit that the service uses.

• Cell bundle size—Cell bundle size can be 1 through 34.

Connectivity Settings

The following attributes are defined for the connectivity among UNI endpoints across

the network:

• Virtual Private LAN Service Identifier (VPLS ID) on page 79

• Auto Discovery on page 79

• Virtual Circuit Identifier (VCID) (E-Line Services Only) on page 79

• Route Targets and Route Distinguishers on page 79

• Normalized VLAN (Multipoint Services Only) on page 79

• MAC Learning on page 80
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Virtual Private LAN Service Identifier (VPLS ID)

This VPLS ID is available if the signaling is LDP and the Auto Discovery check box is

disabled. The VPLS ID can be selected automatically ormanually. The VPLS ID identifies

the virtual circuit identifier used for the VPLS routing instance.

Auto Discovery

The Auto Discovery check box is available only if the signaling is LDP. If you enable Auto

Discovery, the attributes Route target, Route distinguisher, and VPN ID appear and are

provisionable.

Virtual Circuit Identifier (VCID) (E-Line Services Only)

This unique identifier can be assigned automatically from a pool of VCIDs or can be

manually specified. It uniquely identifiesapoint-to-point virtual circuit through thenetwork

and is provided for all switched E-Line services.

Route Targets and Route Distinguishers

Route targetsand routedistinguishersareapplied toE-Line services inwhichBGPcontrols

the connections in the network core.

Route targets and route distinguishers are always automatically generated by the Junos

Space software for multipoint E-LAN services. Route targets and route distinguishers

designate themultipoint connectivity among the participating endpoints of amultipoint

service. They identify the members of the virtual LAN.

Normalized VLAN (Multipoint Services Only)

Similar to E-Line services, the UNIs of E-LAN services can be port-to-port, 802.1Q, or

Q-in-Q.The typeofVLANmapping—ornormalization—is specified in theservicedefinition.

VLAN normalization applies only to MX Series devices.

Normalization supports automaticmappingofVLANsandperformsoperationsonVLAN

tags to achieve the desired translation. The Connectivity Services Director application

supports the following forms of VLAN normalization:

• Normalize to VLAN all—The customer VLAN ID is preserved across the network. That

is, the broadcast domain includes the interfaces that have the same VLAN ID across

the E-LAN service. For double-tagged packets (Q-in-Q interfaces), a pop operation at

ingress strips the service VLAN ID from the packet. A corresponding push operation at

egress inserts the service VLAN ID known at the local site. Hence, the service VLAN ID

at egress does not have to match the service VLAN ID at ingress.

For single-tagged packets (802.1Q interfaces), “Normalize to VLAN All” has no effect,

because the packet has no service VLAN ID to pop or push.

• Normalize to VLAN none—The customer VLAN ID is not preserved across the network.

The broadcast domain includes all VLANs at any site provisioned in the service. For

single-tagged packets (802.1Q interfaces), a pop operation at ingress removes the

customer VLAN ID from the packet. A corresponding push operation at egress adds a

local customer VLAN ID.
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For double-tagged packets (Q-in-Q interfaces), both customer VLAN ID and service

VLAN ID are popped from the packet at ingress and pushed at egress.

• Normalize toDot1q tag—TheVLAN tag is preservedacross thenetwork. Thebroadcast

domain includes all VLANs at any site provisioned in the service. For information about

howframesare translated toprovide the requiredVLANtags for interfaceswithdifferent

tagheights, see thesection “VLANMapping forE-LANServices” inUnderstandingVLAN

Manipulation (Normalization and VLANMapping) on Ethernet Services.

• Normalize toQinQ tags—The inner VLAN tag and outer VLAN tag are preserved across

the network. The broadcast domain includes all VLANs at any site provisioned in the

service. For information about how frames are translated to provide the requiredVLAN

tags for interfaceswith different tag heights, see the section “VLANMapping for E-LAN

Services” in Understanding VLANManipulation (Normalization and VLANMapping) on

Ethernet Services.

• Normalizationnot required—Forport-to-port servicesonly. Specifies thatnormalization

is not used.

If normalization is not used, then all customer VLAN IDs and all service VLAN IDs must

match to be part of the same broadcast domain. Serviceswith dedicated port interfaces

cannot use normalization.

Normalization works well with automatically assigned VLAN IDs, because the service

provider does not need to specify the VLAN IDs that are popped and pushed. Without

normalization, the service providermust specify explicitly the customer VLAN ID and the

service VLAN ID.

NOTE: ForadescriptionofhowtheConnectivityServicesDirectorapplication
manipulates VLANs, seeUnderstanding VLANManipulation (Normalization
and VLANMapping) on Ethernet Services.

MAC Learning

YoucanenableMAC learning for a virtual switch, for abridgedomain, for a specific logical

interface in a bridge domain, or for a set of bridge domains associated with a Layer 2

trunk port. MAC learning is enabled by default.

When MAC learning is enabled, you can configure the following settings:

Interface MAC Limit

You can specify the maximum number of media access control (MAC) addresses that

can be learned by the VPLS routing instance. You can configure the same limit for all

interfaces configured for a routing instance. You can also configure a limit for a specific

interface. The default is 1024 addresses. The range is 16 through 65,536MAC addresses.

This option is supported for MX-series routers only.
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MAC Statistics

You can enable MAC accounting either for a specific bridge domain, or for a set of bridge

domains associated with a Layer 2 trunk port. MAC statistics is disabled by default. This

option is supported for MX-series routers only.

MAC Table Size

You canmodify the size of the MAC address table for the bridge domain, a set of bridge

domains associated with a trunk port, or a virtual switch. The default is 5120 MAC

addresses.

Advanced Settings

The following attributes are defined for advanced connectivity among UNI endpoints

across the network:

• Tunnel Services on page 81

• Local Switching on page 81

• Fast Reroute Priority on page 81

• Label Block Size on page 82

• Connectivity Type on page 82

Tunnel Services

Youcanenable tunnel services tospecify that traffic forparticularVPLS routing instances

be forwarded to specific virtual tunnel (VT) interfaces, allowing you to load-balance

VPLS traffic among all the available VT interfaces on the router.

Tunnel services are disabled by default.

Local Switching

In local switching mode, you can terminate multiple Layer 2 circuit pseudowires at a

single VPLSmesh group.

Local switching is disabled by default.

NOTE: In a point-to-multipoint topology, youmust enable local switching
on the hub router and disable local switching on the spokes.

Fast Reroute Priority

Specify the fast reroute priority for a VPLS routing instance. You can configure high,

medium, or low fast reroute priority to prioritize specific VPLS routing instances for faster

convergence and traffic restoration. Because the router repairs next hops for high-priority

VPLS routing instances first, the traffic traversing a VPLS routing instance configured

with high fast reroute priority is restored faster than the traffic for VPLS routing instances

configured with medium or low fast reroute priority. The default setting is LOW.
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Label Block Size

VPLSMPLS packets have a two-label stack. The outer label is used for normal MPLS

forwarding in the service provider’s network. If BGP is used to establish VPLS, the inner

label is allocated by a PE router as part of a label block. One inner label is needed for

each remote VPLS site. Four sizes are supported. We recommend using the default size

of 8, unless the network design requires a different size for optimal label usage, to allow

the router to support a larger number of VPLS instances.

If youallocatea largenumberof small label blocks to increaseefficiency, youalso increase

the number of routes in the VPLS domain. This has an impact on the control plane

overhead.

Changing the configured label block size causes all existing pseudowires to be deleted.

For example, if you configure the label block size to be 4 and then change the size to 8,

all existing label blocks of size 4 are deleted, which means that all existing pseudowires

aredeleted.Thenew labelblockof size8 is created, andnewpseudowiresareestablished.

Four label block sizes are supported: 2, 4, 8, and 16. Consider the following scenarios:

• 2—Allocate the label blocks in increments of 2. For a VPLS domain that has only two

sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8 (default)—Allocate the label blocks in increments of 8.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you

tominimize thenumberof routes in theVPLSdomain.Use this settingonly if thenumber

of routes is the most important concern.

Connectivity Type

You can configure the VPLS routing instance to take down or maintain its VPLS

connections depending on the status of the interfaces configured for the VPLS routing

instance. By default, the VPLS connection is taken down whenever a customer-facing

interface configured for the VPLS routing instance fails. This behavior is explicitly

configured by specifying the ce option. You can alternatively specify the irb option to

ensure that the VPLS connection remain up so long as an integrated routing and bridging

(IRB) interface is configured for the VPLS routing instance.

Node Settings

Nodes refer to the devices or network elements that are used in establishing a network

connection for a particular protocol. You can define configuration parameters and

attributes that are common and apply to several nodes in your topology in a single,

one-step task by selecting suchnodesor devices and specifying the commondefinitions.

Some of the settings need to be unique for each node, and in such cases, you can specify

ormodify suchproperties individually for eachnode. After you select the nodes that need

to be associated with a service definition or order, you can select the interfaces

corresponding toeachdevice todefine the interface-specific characteristicsor capabilities.

Node-wise parameters provide a quick, effectivemechanism for applying configurations
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on devices. You can select one or more devices from the list of displayed devices that

arepreviously configured formanagementby theConnectivityServicesDirectordatabase.

After you select the devices and add them, they are mapped with the service definition.

The following attributes can be configured as node-level settings, depending on the type

of service order, such as IP or E-LAN:

Static Routes

Routes that are permanent fixtures in the routing and forwarding tables are often

configured as static routes. These routes generally do not change, and often include only

one or very few paths to the destination. To create a static route in the routing table, you

must, at minimum, define the route as static and associate a next-hop address with it.

Thestatic route in the routing table is inserted into the forwarding tablewhen thenext-hop

address is reachable.All traffic destined for the static route is transmitted to thenext-hop

address for transit. You can specify options that define additional information about

static routes that is included with the route when it is installed in the routing table. All

static options are optional. A router uses static routes in the following scenarios:

NOTE: Although you can configure next-hop tables using service templates,
you can configure only next-hop addresses in the service order.

When it does not have a route to a destination that has a better (lower) preference value.

When it cannot determine the route to a destination.

When it is forwarding unroutable packets.

For thedestinationprefix of the static route, youmust specify thedestination of the route

(in route destination-prefix) in one of the following ways:

network/mask-length, where network is the network portion of the IP address and

mask-length is the destination prefix length.

default if this is the default route to the destination. This is equivalent to specifying an

IP address of 0.0.0.0/0.

NOTE: IPv4 packets with a destination of 0.0.0.0 (the obsoleted limited
broadcastaddress)and IPv6packetswithadestinationof0::0arediscarded
by default. To forward traffic destined to these addresses, you can add a
static route to 0.0.0.0/32 for IPv4 or 0::0/128 for IPv6.

For the next-hop portion of the static route, youmust configure the IPv4, IPv6, or ISO

network address of the next hop or the name of the interface on which to configure an

independent metric or preference for a static route.

PIM Settings

Protocol Independent Multicast (PIM) emerged as an algorithm to overcome the

limitations of dense-mode protocols such as the Distance Vector Multicast Routing
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Protocol (DVMRP), which was efficient for dense clusters of multicast receivers, but did

not scalewell for the larger, sparser, groups encountered on the Internet. The Core Based

Trees (CBT) Protocol was intended to support sparse mode as well, but CBT, with its

all-powerful core approach, made placement of the core critical, and large

conference-type applications (many-to-many) resulted in bottlenecks in the core. PIM

was designed to avoid the dense-mode scaling issues of DVMRP and the potential

performance issuesofCBTat the same time.PIMoperates in severalmodes: bidirectional

mode, sparsemode, densemode, andsparse-densemode. In sparse-densemode, some

multicast groups are configured as densemode (flood-and-prune, [S,G] state) and

others are configured as sparsemode (explicit join to rendezvous point [RP], [*,G] state).

To join the shared tree, or rendezvous-point tree (RPT) as it is called in PIM sparsemode,

the router must do the following: Determine the IP address of the RP for that group.

Determining the address can be as simple as static configuration in the router, or as

complex as a set of nested protocols.

• Build the shared tree for that group. The router executes an RPF check on the RP

address in its routing table, which produces the interface closest to the RP. The router

now detects that multicast packets from this RP for this group need to flow into the

router on this RPF interface.

• Senda joinmessageouton this interfaceusing thepropermulticastprotocol (probably

PIM sparse mode) to inform the upstream router that it wants to join the shared tree

for that group. This message is a (*,G) join message because S is not known. Only the

RP is known, and the RP is not actually the source of themulticast packets. The router

receiving the (*,G) joinmessage adds the interface onwhich themessagewas received

to its outgoing interface list (OIL) for the group and also performs an RPF check on the

RP address. The upstream router then sends a (*,G) join message out from the RPF

interface toward the source, informing the upstream router that it also wants to join

the group.

You can specify the following attributes: PIMmode on the interface. The choice of PIM

mode is closely tied to controlling how groups are mapped to PIMmodes, as follows:

bidirectional-sparse—Use if all multicast groups are operating in bidirectional, sparse, or

SSMmode. bidirectional-sparse-dense—Use if multicast groups, except those that are

specified in the dense-groups statement, are operating in bidirectional, sparse, or SSM

mode. dense—Use if all multicast groups are operating in densemode. sparse—Use if all

multicast groups are operating in sparse mode or SSMmode. sparse-dense—Use if

multicast groups, except those that are specified in the dense-groups statement, are

operating in sparse mode or SSMmode

Name of the interface on which PIMmust be enabled. Specify the full interface name,

including the physical and logical address components.

Configure the routing device as an actual or potential rendezvous point (RP). A routing

device can be an RP for more than one group.

Name of the interface on the device that functions as the RP.

Address ranges for themulticast groups forwhich the routing device is theRP. By default,

a routingdevice runningPIM is eligible tobe theRP for all IPv4or IPv6groups (224.0.0.0/4
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or FF70::/12 to FFF0::/12). The following example limits the groups for which this routing

device can be the RP.

MVPNSettings

Multiprotocol BGP-basedmulticast VPNs (also referred to as next-generation Layer 3

VPNmulticast) constitute the next evolution after dual multicast VPNs (draft-rosen)

and provide a simpler solution for administrators who want to configure multicast over

Layer 3 VPNs. For MBGPMVPNs (also referred to as next-generation Layer 3 multicast

VPNs), the defaultmode of operation supports only intersite shortest-path trees (SPTs)

for customer PIM (C-PIM) join messages. It does not support rendezvous-point trees

(RPTs) for C-PIM join messages. The default mode of operation provides advantages,

but it requireseither that thecustomer rendezvouspoint (C-RP)be locatedonaPE router

or that the Multicast Source Discovery Protocol (MSDP) be used between the C-RP and

a PE router so that the PE router can learn about active sources advertised by other PE

routers. If the default mode is not suitable for your environment, you can configure

RPT-SPTmode (also knownas shared-treedatadistribution), asdocumented in section

13of theBGP-MVPNdraft (draft-ietf-l3vpn-2547bis-mcast-bgp-00.txt).RPT-SPTmode

supports the native PIMmodel of transmitting (*,G) messages from the receiver to the

RP for intersite shared-tree join messages. This means that the type 6 (*,G) routes get

transmitted from one PE router to another. In RPT-SPTmode, the shared-treemulticast

routes are advertised from an egress PE router to the upstream router connected to the

VPN site with the C-RP. The single-forwarder election is performed for the C-RP rather

than for the source. The egress PE router takes the upstream hop to advertise the (*,G)

and sends the type 6 route toward the upstreamPE router. To send the data on the RPT,

either inclusive or selective provider tunnels can be used. After the data starts flowing

on the RPT, the last-hop router switches to SPTmode, unless you include the

spt-threshold infinity statements in the configuration.

You can specify the following parameters:

• Indicatewhether the shared-tree data distributionmode or the shortest path tree only

(SPT-only) mode of MVPNmust be enabled to learn about active multicast sources

using multicast VPN source-active routes. the default mode of operation is shortest

path tree only (SPT-only) mode. In SPT-only mode, the active multicast sources are

learnedthroughmulticastVPNsource-active routes.Thismodeofoperation isdescribed

in section 14 of the BGP-MVPN draft (draft-ietf-l3vpn-2547bis-mcast-bgp-00.txt).

• Specify the export and import targets specified specifically for sender sites or receiver

sites, or can be borrowed from a configured unicast route target. Note that a sender

site export route target is always advertised when security association routes are

exported. By default, the VPN routing and forwarding (VRF) import and export route

targets (configured either using VRF import and export policies or using the vrf-target

statement) are used for importing andexporting routeswith theMBGPMVPNnetwork

layer reachability information (NLRI). You can use the export-target and import-target

options to override the default VRF import and export route targets.

• Specify the export target to enable you to override the Layer 3 VPN import and export

route targets used for importing and exporting routes for the MBGPMVPN network

layer reachability information (NLRI).

• Specify the target value when importing sender and receiver site routes.
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• Specify a unicast target community as the import target while importing sender and

receiver site routes.

• Specify if youwant to enable automatic selection of an export targert if a configuration

is not provided. An imported automatic discovery route is treated as belonging to both

the sender site set and the receiver site set.

• Specify the export and import target community names.

• Specify the provider tunnel name to configure virtual private LAN service (VPLS)

floodingof unknownunicast, broadcast, andmulticast traffic usingpoint-to-multipoint

LSPs. Also configure point-to-multipoint LSPs for MBGPMVPNs.

• Specify the site type of the MBGPMVPN. An MBGPMVPN defines two types of site

sets, a sender site set and a receiver.

• Configure the upstreammulticast hop (UMH) to denote a router to use the unicast

route preference to determine the single forwarder election.

MACSettings

You can specify the following attributes related to the MAC application of a node:

Enable or disable MAC learning for all logical interfaces in a specified bridge domain, or

fora specific logical interface inabridgedomain.DisablingdynamicMAC learningprevents

the specified interfaces from learning source MAC addresses. A limit on the number of

MAC addresses learned froma specific bridge domain or froma specific logical interface

that belongs to a bridge domain. For an access port, the default limit on the maximum

number ofMACaddresses that can be learned on an access port is 1024. For a trunk port,

the default limit on the maximum number of MAC addresses that can be learned on a

trunk port is 8192.

Enable or disable packet accounting either for a router or switch as a whole or for a

specific VLAN. After you enable packet accounting, the Junos OSmaintains packet

counters for each MAC address learned. By default, MAC accounting is disabled. Size of

the MAC address table for each VLAN. The default table size is 5120 addresses. The

minimum you can configure is 16 addresses, and themaximum is 1,048,575 addresses.

If the MAC table limit is reached, new addresses can no longer be added to the table.

Unused MAC addresses are removed from the MAC address table automatically. This

frees space in the table, allowing new entries to be added.

Topology Settings

Automatically assign a route distinguisher to the routing instance. Alternatively, specify

the route distinguisher manually by specifying an identifier attached to a route, enabling

you to distinguish to which VPN or VPLS the route belongs. Each routing instancemust

have a unique route distinguisher associated with it. The route distinguisher is used to

place bounds around aVPN so that the same IP address prefixes can be used in different

VPNs without having them overlap.

Related
Documentation

Junos Space Layer 2 Services Overview on page 56•

• Junos Space Layer 3 Services Overview on page 65
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• Provisioning Process Overview on page 67

• Seamless MPLS Support in Junos Space Overview on page 70

Service Order States and Service States Overview

Service provisioners create service orders which are requests to provision a service,

validate a service, or decommission a service. The service order for provisioning a service

defines all the service attributes.

Service Order States

Before a service order can affect a service, it must transition through several states as

shown in Figure 10 on page 87.

Figure 10: Service Order States and State Transitions

When the service provisioner has created the service order, but has not yet attempted

to deploy it or schedule it for deployment, the service order is in the Draft state (also,

formerly, called Requested state).

After the service provisioner has scheduled the service order for deployment, the service

order transitions to the Scheduled state. If the service provisioner schedules the service

order for immediate deployment, then the service order will be in the Scheduled state

only briefly. However, if the service provisioner has scheduled a later deployment, the

service order could be in this state for several hours or days.

When a scheduled service order reaches its time for deployment, it transitions to the

transitory InProgress state. Fromthis state, the JunosSpacesoftwareattempts todeploy

the service. Successful deployment transitions the service order to the Completed state.

If the Junos Space software cannot deploy the service because of invalid information in

the service order itself, the service order enters the Invalid state. The service provisioner
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must resolve the issues that cause the failure before re-creating the service order and

rescheduling it for deployment.

If the device is down or the Junos Space software is unable to push the service

configuration to the device, the service order transitions to the Failed Deploy state. A

network operator might need to resolve the problem before the service provisioner

reschedules the service order.

After you disable a service order to deactivate the configuration settings on devices

mapped to the service, youmight require the service settings to be reenabled after you

havemodified the service parameters, either directly on the device or using the

Connectivity Services Director application. In such a case, you can use the reactivation

functionality to revive and activate the service properties on devices. To disable a service,

the service must not contain any pending or uncommitted changes. Also, the service

must be in the Deactivated state. By disabling a service, the traffic processing for the

traversed packets is impacted.

In certain network topologies, youmight require a service-related settings to be disabled

for a certain period to perform troubleshooting or modification to the traffic-handling

method, and youmight want to reactivate a disabled service later when you have

completed networkmaintenance andanalysiswork. In such a case, itmight bebeneficial

to use the deactivation functionality for a service order.When you disable a service order,

the configuration attributes associated with such a service order are deactivated and

commented out in the device settings. The deactivated service is propagated to the

devices associated with the service order. To disable a service, the service must not

contain any pending or uncommitted changes. Also, the servicemust be in the Deployed

or Re-Activated state.

When you cancel a job, the service ordermay not fail, but changes the service order state

to Scheduled. When the job state is In Progress and until the device responds, the service

order state is Scheduled. When the job is Cancelled, the job state becomes Cancelled

and the service order state is Scheduled. As a result, the service order cannot be deleted

or edited. However, you canmove the service order state to Draft by right-clicking any

service order or by clicking Actions at the header of the grid and selecting Cancel Order

option. The Cancel Order option is enabled or disabled, depending on the state of the

service order. This option is enabled only when the service order state is Scheduled and

the job state is Cancelledwhile it is disabled for all the other service order states. When

the state of the service order is Draft, you canmodify and deploy or delete the service

order.

The Deployed-Active or Active state denotes a service that has been deployed and is in

an active state (enabled). The Deployed-Inactive or Inactive state denotes a service that

has been deployed and is in a deactivated state (disabled). The Deployment-Pending

or Pending state denotes a service for which deployment of the service to a device is

pending to be performed.

Service States

A service is created when a service order to provision a service reaches the Completed

state.
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If a service exists, it is in the Deployed state. If a new service fails to deploy, the service

does not exist.

If an attempt to modify a service fails, the service enters the Fail Deploy state. When a

service is in the Fail Deploy state, you can attempt to redeploy it, or you can delete it.

The service also has an audit state of Up or Down, depending on whether the service

passed or failed functional audit.

If you modify a service order and successfully redeploy the service, the modified service

will operate according to the updated configuration.

Related
Documentation

Publishing a Custom Service Definition on page 613•

• Unpublishing a Custom Service Definition on page 614

• Deactivating a Service on page 809

• Reactivating a Service on page 810

Understanding VLANManipulation (Normalization and VLANMapping) on Ethernet
Services

To effectively manage Ethernet frames that are transported across bridge domains and

VPLS routing instances, frames are processed and, if necessary, translated to provide

the required VLAN tags. When the customer sites participating in a VPLS domain send

traffic of different tag heights (untaggged, single tagged, or dual tagged packets) across

a service, Internet service providers (ISPs) need to provide a network environment to

transport traffic of different tag heights. The Connectivity Services Director application

supports VLANmanipulation on E-LAN services. VLANmanipulation allows transport of

trafficwithdifferent tagheightsbetweendifferent customeraccess siteswhilepreserving

the customer traffic profiles that are transported over an MPLS core. You can also use

VLANmanipulation for the following purposes:

• Specifydifferentnormalizedvalues forouter and innerVLANtagswhile troubleshooting

packet captures to identify wrong inner/ outer VLAN tag configuration issues.

• Simplify provisioning across a BGP/LDP scenario because VLAN tagmanipulation is

performed on customer facing interfaces only.

• Simplify the process for troubleshooting predetermined tag values.

• Enable end-to-end communication between clients employing different VLAN

topologies.

• Provide ISPs the flexibility to enforce their own QoS policies throughmetro area and

core networks because customer traffic classification is not impacted.
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NOTE: To support all access types (port-based [untagged], single-tag, and
dual-tag) in a VPLS instance, we recommend that normalization is based on
a two-tag operation. However, when only port-based or single-tag access is
required, normalizing traffic to a single tagmight be sufficient.

For Ethernet services and Ethernet services with flexible VLAN tagging (asymmetric tag

height), the type of VLANmanipulation applied depends on the type of device sending

and receiving packets. MX Series devices can use VLANmapping or normalization to

translate VLANs tags. M Series devices use only VLANmapping to translate VLAN tags.

VLAN Translation (Normalization) for E-LAN Services

A packet received on a physical port is only accepted for processing if the VLAN tags of

the received packet match the VLAN tags associated with one of the logical interfaces

configured on the physical port. The VLAN tags of the received packet are translated

only if they are different than the normalized VLAN tags. For the translation case, the

VLAN identifier tags specify the normalized VLAN.

The VLAN tags of a received packet are compared with the normalized VLAN tags

specifiedwith either the vlan-id or vlan-tags statements. If the VLAN tags of the received

packetaredifferent fromthenormalizedVLANtags, thenappropriateVLANtagoperations

(such as push-push, pop-pop, pop-swap, swap-swap, swap, and others) are implicitly

made to convert the received VLAN tags to the normalized VLAN tags. Then, the source

MACaddressofa receivedpacket is learnedbasedon thenormalizedVLANconfiguration.

For output packets, if the VLAN tags associated with an egress logical interface do not

match thenormalizedVLANtagswithin thepacket, thenappropriateVLANtagoperations

(such as push-push, pop-pop, pop-swap, swap-swap, swap, and others) are implicitly

made to convert the normalized VLAN tags to the VLAN tags for the egress logical

interface. Formore informationabout theseoperations, see the JunosOSRoutingProtocols

Configuration Guide.

VLANMapping for VPLS Services

For Ethernet services and Ethernet services with flexible VLAN tagging (asymmetric tag

depth), the Connectivity Services Director application uses the VLAN configuration data

that you specified in the service order to apply the appropriate VLAN tags to the input

and output VLANmaps for the ingress and egress logical interfaces, respectively. The

following steps outline the process of bridging a packet received over a Layer 2 logical

interface when a normalizing VLAN identifier (vlan-id number or vlan-tags statement) is

specified for a bridge domain or VPLS routing instance:

1. When a packet is received on a physical port, it is accepted only if the VLAN identifier

of the packet matches the VLAN identifier of one of the logical interfaces configured

on that port.

2. The VLAN tags of the received packet are then compared with the normalizing VLAN

identifier. If the VLAN tags of the packet are different from the normalizing VLAN

identifier, the VLAN tags are rewritten, as described in Table 9 on page 91.
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3. If the source MAC address of the received packed is not present in the source MAC

table, it is learned based on the normalizing VLAN identifier.

4. The packet is then forwarded toward one ormore outbound Layer 2 logical interfaces

based on the destination MAC address. A packet with a known unicast destination

MAC address is forwarded only to one outbound logical interface. For each outbound

Layer 2 logical interface, the normalized VLAN identifier configured for the bridge

domainorVPLS routing instance is comparedwith theVLANs tags thatareconfigured

on that logical interface. If theVLANtagsassociatedwithanoutbound logical interface

do notmatch the normalizing VLAN identifier that is configured for the bridge domain

or VPLS routing instance, the VLAN tags are rewritten, as described in

Table 10 on page 92.

Table 9 on page 91 and Table 10 on page 92 show how VLAN tags are applied when

traffic is sent to and from the bridge domain, depending on how the VLAN IDs and VLAN

tags (inner and outer) are configured for the bridge domain and on howVLAN identifiers

are configured for the logical interfaces in a bridge domain or VPLS routing instance.

Depending on the configuration of the Ethernet services that you create in Connectivity

Services Director, the following rewrite operations are performed on VLAN tags:

• pop—Remove the VLAN tag from the top of the VLAN tag stack.

• pop/pop—Remove both the outer and inner VLAN tags of the frame.

• pop/swap—Remove the outer VLAN tag of the frame and replace the inner VLAN tag

of the frame.

• swap—Replace the inner VLAN tag of the frame.

• push—Add a new VLAN tag to the top of the VLAN stack.

• push/push—Push two VLAN tags in front of the frame.

• swap/push—Replace the VLAN tag of the frame and add a new VLAN tag to the top

of the VLAN stack.

• swap/swap—Replace both the outer and inner VLAN tags of the frame.

No operationmeans that the VLAN tags of the inbound or outbound packet are not

translated for the specified output logical interface or input logical interface. NAmeans

not applicable.

Table 9: VLAN Tag Rewrite Operations at UNI Ingress for Ethernet Services

vlantagsouter 100, inner
300

vlan-id allvlan-id 200vlan-id noneVLAN Identifier of Logical
Interface

push 100, push 300NApush 200no operationnone

swap200to300,push 100no operationno operationpop 200200

swap 1000 to 300, push
100

no operationswap 1000 to 200,pop 10001000
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Table 9: VLAN Tag Rewrite Operations at UNI Ingress for Ethernet Services (continued)

swap 2000 to 100pop 200pop 2000, swap 300
to 200

pop 2000, pop
300

vlan-tags outer 2000, inner
300

NAno operationNANAvlan-id range 10-100

NApop 200NANAvlan-tags outer 200, inner
range 10-100

Table 10: VLAN Tag Rewrite Operations at UNI Egress for Ethernet Services

vlan tags outer 100,
inner 300

vlan-id allvlan-id 200vlan-id noneVLAN Identifier of Logical
Interface

pop 100, pop 300NApop 200no operationnone

pop200, swap300 to200no operationno operationpush 200200

pop 100, swap 300 to
1000

no operationswap 200 to 1000push 10001000

swap 100 to 2000push 2000swap 200 to 300,
push 3000

push 2000, push
300

vlan-tags outer 2000, inner
300

NAno operationNANAvlan-id range 10-100

NApush 200NANAvlan-tags outer 200, inner
range 10-100

Sample VLAN Configuration onMX Series andMSeries PE Routers

MX Series devices can use VLANmapping or normalization to translate VLANs tags. M

Series devices use only VLANmapping to translate VLAN tags. The following sample

configurations show the VLAN and VPLS routing-instance configurations for an MX960

PE interface and M320 PE interface.

M320 PE Interface ConfigurationMX960 PE Interface Configuration
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interfaces {   
 ge-1/1/1 {
    unit 1 {    
            encapsulation vlan-vpls;
            vlan-tags outer 22 inner 2;
## Q-in-Q tags configured on the PE interface ##        

input-vlan-map {
swap-swap;
##normalizing the inner and outer tags towards the core 
by swapping both tags##
  vlan-id 2;
  inner-vlan-id 1;
  }
 output-vlan-map swap-swap; 
## Put the original tags back for the packets towards the
 VPLS CE ##  
  family vpls
 }
  }
   }

interfaces {   
 ge-0/0/0 {
    unit 1 {    
            encapsulation vlan-vpls;
            vlan-tags outer 5 inner 5;
##normalizing the inner and outer tags 
towards the core with Push/Push operations##

 family vpls
  }
   }
    }

Related
Documentation

Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827•

• Creating a Point-to-Multipoint E-LAN Service Order on page 847
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VLAN Pool Profiles Overview

A VLAN pool profile specifies the ranges of valid VLAN IDs that are available for use on

MX Series devices, on each physical interface. Themaximum theoretical pool of VLAN

IDs contains 4096 VLAN IDs—IDs 0 through 4095.

VLAN ID 0 and VLAN ID 4095 are never valid VLAN IDs.

The Connectivity Services Director system provides the following predefined VLAN pool

profiles:

• maximum-range—Any VLAN ID pool created using themaximum-range profile allows

any VLAN ID from 1 through 4094. This is the default VLAN profile.

• vlan-ccc—Any VLAN ID pool created using the vlan-ccc profile allows any VLAN IDs

from 512 through 4094 available for use. VLAN IDs 1 through 511 are reserved for use

by Juniper Networks.

For eachphysical interface that JunosSpace recommendsasaUNI, the systemattempts

to determine the best VLAN pool profile. For example, if a UNI has the vlan-ccc

encapsulation setting, the rules recommend the vlan-ccc pool profile for that interface.

When the correct VLAN pool profiles have been assigned to each UNI, Connectivity

Services Director creates a VLAN ID pool for each UNI containing only the allowed VLAN

IDs specified in the VLAN pool profile for that UNI.

If the device interface is already running encapsulation before being brought under Junos

Spacemanagement, theConnectivityServicesDirectorapplicationassigns theappropriate

VLAN range.

For details about encapsulation, see the Junos OS VPNs Configuration Guide.

Related
Documentation

Adding a UNI on page 369•

• Unassigning Device Roles on page 370

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373
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Redundant Pseudowires for Layer 2 Circuits and VPLS

A redundant pseudowire can act as a backup connection between PE routers and CE

devices, maintaining Layer 2 circuit and VPLS services after certain types of failures. This

feature can help improve the reliability of certain types of networks (metro for example)

where a single point of failure can interrupt service for multiple customers. Redundant

pseudowires cannot reduce traffic loss to zero. However, they provide away to gracefully

recover from pseudowire failures in such a way that service can be restarted within a

known time limit.

When you configure redundant pseudowires to remote PE routers, you configure one to

act as the primary pseudowire over which customer traffic is being transmitted and you

configure another pseudowire to act as a backup in the event the primary fails. You

configure the two pseudowires statically. A separate label is allocated for the primary

and backup neighbors.

The following sections provide an overview of redundant pseudowires for Layer 2 circuits

and VPLS:

• Types of Redundant Pseudowire Configurations on page 95

• Pseudowire Failure Detection on page 96

Types of Redundant Pseudowire Configurations

You can configure redundant pseudowires for Layer 2 circuits and VPLS in either of the

following manners:

• You can configure a single active pseudowire. The PE router configured as the primary

neighbor is given preference and this connection is the one used for customer traffic.

For the LDPsignaling, labels are exchanged for both incomingandoutgoing trafficwith

the primary neighbor. The LDP label advertisement is accepted from the backup

neighbor, but no label advertisement is forwarded to it, leaving the pseudowire in an

incomplete state. The pseudowire to the backup neighbor is completed only when the

primary neighbor fails. The decision to switch between the two pseudowires is made

by the device configured with the redundant pseudowires. The primary remote PE

router is unawareof the redundantconfiguration, ensuring that traffic is alwaysswitched

using just the active pseudowire.

• Alternatively, you can configure two active pseudowires, one to each of the PE routers.

Using this approach, control plane signaling is completed and active pseudowires are

established with both the primary and backup neighbors. However, the data plane

forwarding is done only over one of the pseudowires (designated as the active

pseudowire by the local device). The other pseudowire is on standby. The active

pseudowire is preferably established with the primary neighbor and can switch to the

backup pseudowire if the primary fails.

The decision to switch between the active and standby pseudowires is controlled by the

local device. The remote PE routers are unaware of the redundant connection, and so

both remote PE routers send traffic to the local device. The local device only accepts

traffic from the active pseudowire and drops the traffic from the standby. In addition,
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the local device only sends traffic to the active pseudowire. If the active pseudowire fails,

traffic is immediately switched to the standby pseudowire.

Pseudowire Failure Detection

When a failure is detected, traffic is switched to the redundant pseudowire, which is then

alsodesignatedas theactivepseudowire. The switch is nonreversible,meaning that once

traffic has been switched to the redundant pseudowire, it remains active unless it also

fails unless the switch to the redundant pseudowire is never done unless there is a failure

in the currently active pseudowire. For example, a primary pseudowire has failed and

traffic has been successfully switched to the redundant pseudowire. After a period of

time, the cause of the failure of the primary pseudowire has been resolved and it is now

possible to reestablish the original connection. However, traffic is not switched back to

the original pseudowire unless a failure is detected on the now active pseudowire.

Related
Documentation

Creating an E-Line Service Definition•

• Creating a Multipoint-to-Multipoint E-LAN Service Definition on page 619

• Creating a Point-to-Multipoint E-LAN Service Definition on page 641

VPLS over GREOverview

Generic routing encapsulation (GRE) is one of the tunnelingmechanisms that uses IP as

the transport protocol. The tunnels behave as virtual point-to-point links that have two

endpoints identified by the tunnel source and tunnel destination addresses at each

endpoint.

Theprimary useofGRE is to carry non-IPpackets throughan IPnetwork. GREalso carries

IP packets such as IP broadcast, IP multicast through an IP cloud. A GRE tunnel has the

following characteristics:

• GRE tunnel is stateless, and offers no flow control mechanisms.

• GRE is multiprotocol and can tunnel any OSI Layer 3 protocol.

• GRE enables routing protocols to travel through the tunnel.

• GRE has weak security features.

• GRE provides no reliability or sequencing. Such features are typically handled by

upper-layer protocols.

• GRE tunnels carry multicast traffic.

TheVPLSoverGRE featureallowsyou tocombine flow-basedandpacket-basedservices

in a single device. You can deploy large-scale VPLS over GRE.

To better understand this configuration, consider the following scenarios:

In the first scenario, pseudowires enable the creation of point-to-point circuits between

two endpoints carried over the MPLS network. Ignoring the signaling protocols for this

discussion, these connections are just point-to-point connections. Using this approach
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provides an end-to-end wire between sites. This is beneficial from a traffic processing

point of view because the gateways do not need to learn MAC addresses; they simply

forward anything they receive to the pseudowire. Deploying this configuration can be

difficult when trying to provide connectivity to multiple branch offices.

In thesecondscenario,VPLSprovidesaLayer2networkabstraction.WithVPLS,endpoints

typically negotiate LSPs and pseudowires with every other endpoint (that is, they are

fully meshed). When a node receives an Ethernet frame from one of its LAN interfaces,

the source MAC address is learned, if it is not already known, and flooded using every

pseudowire connecting to all other branch nodes. However, if the destination has been

previously learned, then the frame is sent to theappropriatedestination.WhenanEthernet

frame is received through one of the pseudowires (that is, from the MPLS network),

source MAC address learning is performed. The next time a frame is sent to that MAC it

does not need to be flooded and the frame is flooded to every single LAN interface in the

node, but not over the pseudowires. The network acts as a distributed Layer 2 switch

providingany-to-anyEthernetconnectivitybetweenthedevicesconnected to thedifferent

nodes in the network.

While the second scenario provides significant advantages (any-to-any connectivity,

automated provisioning, and simple abstraction), it is more complex. Every PE node has

toperformLayer 2 learning and floodingof traffic,which can causeproblemswheneither

multiple broadcast/multicast or frames to unknownMAC addresses are used. For

example, in a topology with a thousand branch offices, each office that receives a

broadcastpacketmust replicate it 999 times, encapsulateeachcopy inGRE, and forward

the resulting traffic. Additionally, because each node performs Layer 2 learning, the

maximum number of MAC addresses that each node can learn is limited, limiting the

total number of nodes in the domain.

Related
Documentation

Creating a Multipoint-to-Multipoint E-LAN Service Definition on page 619•

• Creating a Point-to-Multipoint E-LAN Service Definition on page 641

Junos Space Network Topology Overview

Network topology is the arrangement of various elements including nodes and links. It

is thegraphical representationofphysical devicesand their interconnection. The topology

has the following three components:

1. Physical topology

2. Link topology

3. IP connectivity

Each application registers itself to the topology framework so that you can view and

change topology on the application layer. To view the network topology, select Network

Management Platform > NetworkMonitoring > Topology.

In a network topology, you can:
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• Monitor the status and configurations of the discovered devices and their

interconnections.

• View source and destination information for the device interconnections that exist

within the discovered topologies.

• Select a service and view all the devices associated with the service.

• Discover IS-IS configuration devices.

The network topology helps you to understand and visualize the physical and logical

interconnection between the network devices and the services. It also enables you to

viewtheend-to-endnetworkandzoominto thesegmentsof thenetwork formanagement

and troubleshooting.

Related
Documentation

Creating a Service Order on page 773•

• Creating an E-Line ATM or TDM Pseudowire Service Order on page 774

• Creating an E-Line Service Order on page 784

• Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827

• Creating a Point-to-Multipoint E-LAN Service Order on page 847

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901

Service Recovery Overview

The Service Recovery operation recovers services that are present on devices that Junos

Space is not managing. Themissing entity can be an entirely new service or the missing

component of an existing service.

The Service Recovery operation has two parts. First, you select one or more devices for

which services are to be recovered. Service Recovery recovers and identifies the missing

services and displays the result. Second, you select a service to bemanaged, providing

any missing information about the recovered service. When you provide missing

information for a service, the recovered service is converted to amanaged service.

The Connectivity Services Director application supports Service Recovery for E-Line

services, E-LAN services, and IP services. You can perform Service Recovery only using

the Services Activation Director GUI and nor using the Connectivity Services Director GUI.

Besides the supported capabilities of recovery of new services and new endpoints for

existing services, recovery of CFM profiles attached to services is also supported. Also,

theServiceRecovery taskenablesyou to recovermodificationsmade toexistingendpoints

associated with services and recover deleted endpoints for services.

The Service Recovery task is displayed in the Connectivity tree node under Network

Services root node of the View pane. Recovery of services is supported only for E-Line,

IP, and E-LAN services. The following tasks are available under the Service Recovery

section of the Tasks pane:
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• Recover Services—Enables you to create or modify a service recovery request. You can

also initiate the recovery operation for a request that you created. The Create Service

Recovery Request wizard is available to create a service recovery request. The Recover

Servicesbuttonenables you to initiate the recovery job.Youcanalsoviewthe recovered

status of services.

• Recover OutOfBand Changes—Enables you to recover out-of-band changes that are

performedonpreviouslydeployedservice.AnetworkmanagedbyConnectivityServices

Director has three repositories of information about the configuration of a network

device—the configuration stored on the device itself, the device configuration record

maintained by Junos Space, and the Build mode configuration maintained by

ConnectivityServicesDirector.When theconfigurationcontained inall three repositories

match, the device configuration state is shown as In Sync in Connectivity Services

Director. When the repositories do not match, the configuration state is shown as Out

of Sync. A common cause for this state is out-of-band configuration changes—that is,

configuration changes made to a device outside of Connectivity Services Director.

• Rejected Services—Displays the services that were rejected during service recovery

process with the reject reason.

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

Multicast L3VPNOverview

The Junos Space Connectivity Services Director application uses Multiprotocol-BGP

(MBGP) Multicast L3VPNs (MVPN) to implement MVPNs because it is simpler. This

methoddoesnot requireaserviceprovider toconfiguremulticast in itsproviderbackbone

to connect PE routers.

For the control plane, MBGPMVPN uses the intra-autonomous system (AS)

next-generation BGP. The data plane is configured with Protocol Independent Multicast

(PIM) sparsemode.ConnectivityServicesDirectormaintainsPIMstate informationusing

the same architecture that is used for unicast VPNs.

TheMBGPMVPNmethod avoids potential control and data plane scaling problems that

can occur with the requirement to maintain two routing and forwarding mechanisms,

one for VPN unicast and one for VPNmulticast.

TheConnectivityServicesDirectorapplicationaddressesaspectsofpublishedstandards

as follows:

• IP service, as defined by RFC 4364, is supported to enable service providers to

implement IP multicast for IP services.

• The architecture defined by RFC 4364 for unicast VPNs is supported to enable service

providers to configure BGP for the control plane between PE routers.

• Unicast with extensions for intra-Autonomous System (AS) and inter-AS

communication, as defined by RFC 4364, is supported.
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ForMVPNs,ConnectivityServicesDirector enables you toconfigure twosite sets, a sender

site set and a receiver site set. Site sets have the following properties:

• Hosts within a sender site can originate multicast traffic for receivers in a receiver site

set.

• Receivers outside the receiver site set should not be able to receive traffic sent from

the sender site.

• Hosts within the receiver site set can receivemulticast traffic originated from any host

in the sender site set.

• Hostswithin the receiver site set shouldnotbeable to receivemulticast trafficoriginated

from any host that is not in the sender site set.

A host can be in both the sender site set and the receiver site set. Therefore, such a host

can both originate and receive multicast traffic. For example, the sender site set could

be the sameas the receiver site set. In this case, all hosts could both originate and receive

multicast traffic from one another.

Administrative policies define an MBGPMVPN. The policies define both the sender site

setand receiver site set.Customersestablish thepoliciesbut thepoliciesare implemented

by service providers, which use the existing BGP and MPLS VPN infrastructure.

Related
Documentation

VPLS over GRE Overview on page 96•

• Junos Space Network Topology Overview on page 97

• Service Recovery Overview on page 98

• Multi-Chassis Link Aggregation Group Overview

• Multi-Chassis Automatic Protection Switching Overview on page 100

Multi-Chassis Automatic Protection Switching Overview

Automatic protection switching (APS) is a linear protection scheme designed to protect

VLAN-based Ethernet networks.

With APS, a protected domain is configured with two paths: a working path and a

protection path. Both working and protection paths can bemonitored. Normally, traffic

is carried on the working path (that is, the working path is the active path), and the

protection path is disabled. If the working path fails, its protection status is marked as

degraded (DG) and APS switches the traffic to the protection path, then the protection

path becomes the active path.

APS uses twomodes of operation: linear 1+1 protection switching architecture and linear

1:1 protection switching architecture. The linear 1+1 protection switching architecture

operates with either unidirectional or bidirectional switching. The linear 1:1 protection

switching architecture operates with bidirectional switching.

Related
Documentation

Creating an E-Line ATM or TDM Pseudowire Service Definition on page 604•
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InverseMultiplexing for ATMOverview

The Inverse multiplexing for ATM (IMA) protocol defines a technique for transporting

ATM traffic over a bundle of T1 or E1 interfaces. IMA processes traffic differently from

multiplexing.Whilemultiplexingcombinesmultiple signals intoasingle signal, IMAdivides

a data stream into multiple concurrent streams that are transmitted at the same time

acrossseparatechannels (suchasT1orE1 interfaces).Thedatastreamsare reconstructed

into the original data stream at the far end. IMA speeds up the flow of data across a

slower interface, such as a T1 or E1 interface, by load balancing the data stream across

multiple T1 or E1 interfaces, which increases the line capacity.

You can deploy IMA on Juniper Networks M7, MX and ACX devices. IMA includes the

following operational features:

• Aggregateddevicecount—Adevicecount is thenumberof IMAgroup interfacescreated

on a CT1 or CE1 interface. As part of an IMA group, a logical ATM interface is identified

by the naming format: “at-fpc/pic/port”. The port number is derived from the last port

on the MIC plus 1.

For example, for an ACX2000 router with a 16-port built-in T1/E1 TDMMIC, IMA group

interface numbering starts with at-0/0/16. That interface number is incremented by

1 to at-0/0/17, and so on. For an ACX1000 router with an 8-port built-in T1/E1 TDM

MIC, IMA group interface numbering starts with at-0/0/8. That interface number is

incremented by 1 to at-0/0/9, and so on.

• Framingmode—An emulation mechanism duplicates the essential attributes of a

service, such as T1 or E1, over a packet-switched network. On the ACX Series routers,

you can configure the built-in channelized T1 and E1 interfaces (CT1 and CE1) to work

in either T1 or E1 mode. You can configure these child T1 and E1 interfaces to carry ATM

services over the packet-switched network.

• Built-in channelized interface—The Juniper Networks devices that support ATM IMA

are deployed with one full T1 or E1 interface on the channelized CT1 or CE1 interface.

You cannot configure the built-in interface. However, on the built-in interface, you

configure the parameters for a child T1 or E1 interface.

• T1 or E1 interface member of IMA group for IMA link—Each child T1 or E1 interface of a

channelized CT1 or CE1 interface is the physical interface over which the ATM signals

are transmitted. To ensure that the IMA link operates correctly, you specify the T1 or

E1 interface to be amember of an IMA group.

• IMA group interface configuration—To ensure proper operation, youmust configure

each IMA group interface (at-fpc/pic/g) with all ATM properties, which include the

logical link-layer encapsulation type and the circuit cross-connect protocol suite.

Further, youmust dedicate the entire ATM device to the ATM cell relay circuit.

Related
Documentation

Inverse Multiplexing for ATMOverview on page 101•

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052
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Rendezvous Point

The RP router serves as the information exchange point for the other routers. All routers

in a PIM domain must provide mapping to an RP router. It is the only router that needs

to know the active sources for a domain—the other routers just need to know how to get

to the RP. In this way, the RPmatches receivers with sources.

The RP router is downstream from the source and forms one end of the SPT. As shown

in Figure 11 on page 102, the RP router is upstream from the receiver and thus forms one

end of the RPT.

Figure 11: Rendezvous Point as Part of the RPT and SPT

The benefit of using the RP as the information exchange point is that it reduces the

amount of state in non-RP routers. No network flooding is required to provide non-RP

routers information about active sources.

Related
Documentation

Understanding Multicast Rendezvous Points, Shared Trees, and Rendezvous-Point

Trees on page 102

•

• Understanding PIM Sparse Mode on page 104

• ConfiguringShared-TreeDataDistributionAcrossProviderCores forProviders ofMBGP

MVPNs on page 107

• ConfiguringSPT-OnlyMode forMultiprotocol BGP-BasedMulticast VPNsonpage 108

• Configuring VRF Route Targets for Routing Instances for an MBGPMVPN on page 110

UnderstandingMulticast Rendezvous Points, Shared Trees, and Rendezvous-Point
Trees

In a shared tree, the root of the distribution tree is a router, not a host, and is located

somewhere in the core of the network. In the primary sparse modemulticast routing

protocol, Protocol Independent Multicast sparse mode (PIM SM), the core router at the

root of the shared tree is the rendezvous point (RP). Packets from the upstream source

and join messages from the downstream routers “rendezvous” at this core router.

In theRPmodel, other routers donot need to know theaddresses of the sources for every

multicast group. All they need to know is the IP address of the RP router. The RP router

discovers the sources for all multicast groups.

The RPmodel shifts the burden of finding sources ofmulticast content from each router

(the (S,G) notation) to the network (the (*,G) notation knows only the RP). Exactly how
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the RP finds the unicast IP address of the source varies, but theremust be somemethod

to determine the proper source for multicast content for a particular group.

Consider a set ofmulticast routerswithout any activemulticast traffic for a certain group.

When a router learns that an interested receiver for that group is on one of its directly

connected subnets, the router attempts to join the distribution tree for that group back

to the RP, not to the actual source of the content.

To join the shared tree, or rendezvous-point tree (RPT) as it is called in PIM sparsemode,

the router must do the following:

• Determine the IP address of the RP for that group. Determining the address can be as

simple as static configuration in the router, or as complex as a set of nested protocols.

• Build the shared tree for that group. The router executes an RPF check on the RP

address in its routing table, which produces the interface closest to the RP. The router

now detects that multicast packets from this RP for this group need to flow into the

router on this RPF interface.

• Senda joinmessageouton this interfaceusing thepropermulticastprotocol (probably

PIM sparse mode) to inform the upstream router that it wants to join the shared tree

for that group. This message is a (*,G) join message because S is not known. Only the

RP is known, and the RP is not actually the source of themulticast packets. The router

receiving the (*,G) joinmessage adds the interface onwhich themessagewas received

to its outgoing interface list (OIL) for the group and also performs an RPF check on the

RP address. The upstream router then sends a (*,G) join message out from the RPF

interface toward the source, informing the upstream router that it also wants to join

the group.

Each upstream router repeats this process, propagating join messages from the RPF

interface, building the shared tree as it goes. The process stops when the join message

reaches one of the following:

• The RP for the group that is being joined

• A router along the RPT that already has amulticast forwarding state for the group that

is being joined

In either case, the branch is created, and packets can flow from the source to the RP and

from the RP to the receiver. Note that there is no guarantee that the shared tree (RPT)

is the shortest path tree to the source. Most likely it is not. However, there are ways to

“migrate” a shared tree to an SPT once the flow of packets begins. In other words, the

forwarding state can transition from (*,G) to (S,G). The formation of both types of tree

depends heavily on the operation of the RPF check and the RPF table.

Related
Documentation

Rendezvous Point on page 102•

• Understanding PIM Sparse Mode on page 104

• ConfiguringShared-TreeDataDistributionAcrossProviderCores forProviders ofMBGP

MVPNs on page 107

• ConfiguringSPT-OnlyMode forMultiprotocol BGP-BasedMulticast VPNsonpage 108
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• Configuring VRF Route Targets for Routing Instances for an MBGPMVPN on page 110

Understanding PIM SparseMode

A Protocol Independent Multicast (PIM) sparse-mode domain uses reverse-path

forwarding (RPF) to create a path fromadata source to the receiver requesting the data.

When a receiver issues an explicit join request, an RPF check is triggered. A (*,G) PIM join

message is sent toward theRP from the receiver's designated router (DR). (By definition,

this message is actually called a join/prunemessage, but for clarity in this description, it

is called either join or prune, depending on its context.) The join message is multicast

hop by hop upstream to the ALL-PIM-ROUTERS group (224.0.0.13) by means of each

router’s RPF interface until it reaches the RP. The RP router receives the (*,G) PIM join

message and adds the interface on which it was received to the outgoing interface list

(OIL) of the rendezvous-point tree (RPT) forwarding state entry. This builds the RPT

connecting the receiver with the RP. The RPT remains in effect, even if no active sources

generate traffic.

NOTE: State—the (*,G) or (S,G) entries—is the information used for
forwarding unicast or multicast packets. S is the source IP address, G is the
multicast group address, and * represents any source sending to group G.
Routers keep track of themulticast forwarding state for the incoming and
outgoing interfaces for each group.

When a source becomes active, the source DR encapsulatesmulticast data packets into

a PIM register message and sends them bymeans of unicast to the RP router.

If the RP router has interested receivers in the PIM sparse-mode domain, it sends a PIM

join message toward the source to build a shortest-path tree (SPT) back to the source.

The source sends multicast packets out on the LAN, and the source DR encapsulates

the packets in a PIM register message and forwards the message toward the RP router

bymeans of unicast. TheRP router receives PIM registermessages back from the source,

and thus adds a new source to the distribution tree, keeping track of sources in a PIM

table. Once an RP router receives packets natively (with S,G), it sends a register stop

message to stop receiving the register messages by means of unicast.

In actual application,many receiverswithmultiple SPTs are involved in amulticast traffic

flow. To illustrate the process, we track the multicast traffic from the RP router to one

receiver. In such a case, the RP router begins sending multicast packets down the RPT

toward the receiver’s DR for delivery to the interested receivers. When the receiver’s DR

receives the first packet from the RPT, the DR sends a PIM join message toward the

source DR to start building an SPT back to the source. When the source DR receives the

PIM join message from the receiver’s DR, it starts sending traffic down all SPTs. When

the first multicast packet is received by the receiver’s DR, the receiver’s DR sends a PIM

prunemessage to the RP router to stop duplicate packets from being sent through the

RPT. In turn, the RP router stops sending multicast packets to the receiver’s DR, and

sends a PIM prunemessage for this source over the RPT toward the source DR to halt

multicast packet delivery to the RP router from that particular source.
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If the RP router receives a PIM register message from an active source but has no

interested receivers in the PIM sparse-mode domain, it still adds the active source into

the PIM table. However, after adding the active source into the PIM table, the RP router

sends a register stopmessage. The RP router discovers the active source’s existence and

no longer needs to receive advertisement of the source (which utilizes resources).

NOTE: If the number of PIM joinmessages exceeds the configuredMTU, the
messages are fragmented in IPv6 PIM sparsemode. To avoid the
fragmentation of PIM join messages, themulticast traffic receives the
interface MTU instead of the path MTU.

Themajor characteristics of PIM sparse mode are as follows:

• Routers with downstream receivers join a PIM sparse-mode tree through an explicit

join message.

• PIM sparse-mode RPs are the routers where receivers meet sources.

• Senders announce their existence to one or more RPs, and receivers query RPs to find

multicast sessions.

• Once receivers get content fromsources through theRP, the last-hop router (the router

closest to the receiver) can optionally remove the RP from the shared distribution tree

(*,G) if the new source-based tree (S,G) is shorter. Receivers can then get content

directly from the source.

The transitional aspect of PIM sparse mode from shared to source-based tree is one

of the major features of PIM, because it prevents overloading the RP or surrounding

core links.

Thereare related issues regarding source,RPs, and receiverswhensparsemodemulticast

is used:

• Sources must be able to send to all RPs.

• RPsmust all know one another.

• Receivers must send explicit join messages to a known RP.

• Receivers initially need to know only one RP (they later learn about others).

• Receivers can explicitly prune themselves from a tree.

• Receivers that never transition to a source-based tree are effectively running Core

Based Trees (CBT)`.

PIM sparse mode has standard features for all of these issues.

Rendezvous Point

The RP router serves as the information exchange point for the other routers. All routers

in a PIM domain must provide mapping to an RP router. It is the only router that needs

to know the active sources for a domain—the other routers just need to know how to

reach the RP. In this way, the RPmatches receivers with sources.

105Copyright © 2019, Juniper Networks, Inc.

Chapter 3: Network Services Overview



The RP router is downstream from the source and forms one end of the shortest-path

tree. As shown in Figure 11 on page 102, the RP router is upstream from the receiver and

thus forms one end of the rendezvous-point tree.

Figure 12: Rendezvous Point as Part of the RPT and SPT

The benefit of using the RP as the information exchange point is that it reduces the

amount of state in non-RP routers. No network flooding is required to provide non-RP

routers information about active sources.

RPMapping Options

RPs can be learned by one of the following mechanisms:

• Static configuration

• Anycast RP

• Auto-RP

• Bootstrap router

We recommend a static RPmappingwith anycast RP and a bootstrap router (BSR)with

auto-RP configuration, because static mapping provides all the benefits of a bootstrap

router and auto-RP without the complexity of the full BSR and auto-RPmechanisms.

Protocol Independent Multicast (PIM) sparse mode is the most commonmulticast

protocol used on the Internet. PIM sparse mode is the default mode whenever PIM is

configured on any interface of the device. However, because PIMmust not be configured

on the network management interface, youmust disable it on that interface.

Each any-sourcemulticast (ASM) group has a shared tree through which receivers learn

about newmulticast sources and new receivers learn about all multicast sources. The

rendezvous point (RP) router is the root of this shared tree and receives the multicast

traffic from the source. To receivemulticast traffic from the groups served by the RP, the

device must determine the IP address of the RP for the source.

You can configure a static rendezvous point (RP) configuration that is similar to static

routes. A static configuration has the benefit of operating in PIM version 1 or version 2.

When you configure the static RP, the RP address that you select for a particular group

must be consistent across all routers in a multicast domain.

One commonway for the device to locate RPs is by static configuration of the IP address

of the RP. A static configuration is simple and convenient. However, if the statically

defined RP router becomes unreachable, there is no automatic failover to another RP

router. To remedy this problem, you can use anycast RP.
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Related
Documentation

Rendezvous Point on page 102•

• Understanding Multicast Rendezvous Points, Shared Trees, and Rendezvous-Point

Trees on page 102

• ConfiguringShared-TreeDataDistributionAcrossProviderCores forProviders ofMBGP

MVPNs on page 107

• ConfiguringSPT-OnlyMode forMultiprotocol BGP-BasedMulticast VPNsonpage 108

• Configuring VRF Route Targets for Routing Instances for an MBGPMVPN on page 110

ConfiguringShared-TreeDataDistributionAcrossProviderCores forProvidersofMBGP
MVPNs

For MBGPMVPNs (also referred to as next-generation Layer 3 multicast VPNs), the

defaultmodeofoperation supportsonly intersite shortest-path trees (SPTs) for customer

PIM (C-PIM) joinmessages. It does not support rendezvous-point trees (RPTs) for C-PIM

joinmessages. The defaultmode of operation provides advantages, but it requires either

that thecustomer rendezvouspoint (C-RP)be locatedonaPE router or that theMulticast

Source Discovery Protocol (MSDP) be used between the C-RP and a PE router so that

the PE router can learn about active sources advertised by other PE routers.

If the default mode is not suitable for your environment, you can configure RPT-SPT

mode (also known as shared-tree data distribution), as documented in section 13 of the

BGP-MVPNdraft (draft-ietf-l3vpn-2547bis-mcast-bgp-00.txt).RPT-SPTmodesupports

the native PIMmodel of transmitting (*,G) messages from the receiver to the RP for

intersite shared-tree join messages. This means that the type 6 (*,G) routes get

transmitted from one PE router to another. In RPT-SPTmode, the shared-treemulticast

routes are advertised from an egress PE router to the upstream router connected to the

VPN site with the C-RP. The single-forwarder election is performed for the C-RP rather

than for the source. The egress PE router takes the upstream hop to advertise the (*,G)

and sends the type 6 route toward the upstreamPE router. To send the data on the RPT,

either inclusive or selective provider tunnels can be used. After the data starts flowing

on the RPT, the last-hop router switches to SPTmode, unless you include the

spt-threshold infinity statements in the configuration.

NOTE: TheMVPN single-forwarder election follows the rule documented in
section 9.1.1 of the BGP-MVPN draft
(draft-ietf-l3vpn-2547bis-mcast-bgp-00.txt). Thesingle-forwarder election
winner is based on the following rules:

• If the active unicast route to the source is through the interface, then this
route is used to determine the upstreammulticast hop (UMH).

• If the active unicast route to the source is a VPN route, MVPN selects the
UMH based on the highest IP address in the route import community for
theVPNroutes, and the localmaster loopbackaddress for localVRF routes.
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The switch to SPTmode is performed by PIM and not byMVPN type 5 and type 6 routes.

After the last-hop router switches to SPTmode, the SPT (S,G) join messages follow the

same rules as the SPT-only default mode.

The advantage of RPT-SPTmode is that it provides amethod for PE routers to discover

sources in the multicast VPNwhen the C-RP is located on the customer site instead of

on a PE router. Because the shared C-tree is established between VPN sites, there is no

need to run MSDP between the C-RP and the PE routers. RPT-SPTmode also enables

egress PE routers to switch to receiving data from the PE connected to the source after

the source information is learned, instead of receiving data from the RP.

In Junos OS Release 15.1 and later, in RPT-SPTmode, PIM SSG Joins are created on the

egress PE even if no directly-connected receivers are present.

CAUTION: When you configure RPT-SPTmode, receivers or sources directly
attached to the PE router are not supported. As a workaround, place a CE
router between any receiver or source and the PE router.

Related
Documentation

Rendezvous Point on page 102•

• Understanding Multicast Rendezvous Points, Shared Trees, and Rendezvous-Point

Trees on page 102

• Understanding PIM Sparse Mode on page 104

• ConfiguringSPT-OnlyMode forMultiprotocol BGP-BasedMulticast VPNsonpage 108

• Configuring VRF Route Targets for Routing Instances for an MBGPMVPN on page 110

Configuring SPT-Only Mode for Multiprotocol BGP-BasedMulticast VPNs

For MBGPMVPNs (also referred to as next-generation Layer 3 multicast VPNs), the

defaultmodeofoperation is shortestpath treeonly (SPT-only)mode. InSPT-onlymode,

the active multicast sources are learned throughmulticast VPN source-active routes.

This mode of operation is described in section 14 of the BGP-MVPN draft

(draft-ietf-l3vpn-2547bis-mcast-bgp-00.txt).

In contrast to SPT-only mode, rendezvous point tree (RPT)-SPTmode (also known as

shared-tree data distribution) supports the native PIMmodel of transmitting (*,G)

messages from the receiver to the RP for intersite shared-tree join messages.

In SPT-only mode, when a PE router receives a (*, C-G) join message, the router looks

for an active source transmitting data to the customer group. If the PE router has a

source-active route for the customer group, the router creates a source tree customer

multicast route and sends the route to the PE router connected to the VPN site with the

source. The source is determined by MVPN's single-forwarder election. When a receiver

sends a (*,G) join message in a VPN site, the (*,G) join message only travels as far as the

PE router. After the join message is converted to a type 6multicast route, which is
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equivalent toa (S,G) joinmessage, the route is installedwith theno-advertise community

setting.

NOTE: TheMVPN single-forwarder election follows the rule documented in
section 9.1.1 of the BGP-MVPN draft
(draft-ietf-l3vpn-2547bis-mcast-bgp-00.txt). Thesingle-forwarder election
winner is based on the following rules:

• If the active unicast route to the source is through the interface, then this
route is used to determine the upstreammulticast hop (UMH).

• If the active unicast route to the source is a VPN route, MVPN selects the
UMH based on the highest IP address in the route import community for
theVPNroutes, and the localmaster loopbackaddress for localVRF routes.

Single-forwarder electionguarantees selectionofaunique forwarder for agivencustomer

source (C-S). The upstream PE router might differ for the source tree and the shared

tree because the election is based on the customer source and C-RP, respectively.

Although the single-forwarder election is sufficient for SPT-only mode, the alternative

RPT-SPTmode involves procedures to prevent duplicate traffic from being sent on the

shared treeand thesource tree. Theseproceduresmight requireadministrator-configured

parameters to reduce duplicate traffic and reduce blackholes during RPT to SPT switch

and the reverse.

In SPT-only mode, when a source is active, PIM creates a register state for the source

both on the DR and on the C-RP (or on a PE router that is running Multicast Source

Discovery Protocol [MSDP] between itself and the C-RP). After the register states are

created, MVPN creates a source-active route. These type 5 source-active routes are

installedonall PE routers.When the egressPE routerwith the (*,G) joinmessage receives

the source-active route, it has two routes that it can combine to produce the (S,G)

multicast route. The type 6 route informs the PE router that a receiver is interested in

group G. The source active route informs the PE router that a source S is transmitting

data to group G. MVPN combines this information to produce amulticast join message

andadvertises this to the ingressPE router, asdeterminedby thesingle-forwarderelection.

For some service providers, the SPT-only implementation is not ideal because it creates

a restriction on C-RP configuration. For a PE router to create customer multicast routes

from (*, C-G) join messages, the router must learn about active sources through MVPN

type 5 source-active routes. These source-active routes can be originated only by a PE

router. This means that a PE router in the MVPNmust learn about all PIM register

messages sent to the RP, which is possible only in the following cases:

• The C-RP is colocated on one of the PEs in the MVPN.

• MSDP is run between the C-RP and the VRF instance on one of the PE routers in the

MVPN.

If this restriction is not acceptable, providers can use RPT-SPTmode instead of the

default SPT-only mode. However, because SPT-only mode does not transmit (*,G)
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routes between VPN sites, SPT-only mode has the following advantages over RPT-SPT

mode:

• Simplified operations by exchanging and processing only source-tree customer

multicast routes among PE routers

• Simplifiedoperationsbyeliminating theneed for the serviceprovider to suppressMVPN

transient duplicates during the switch from RPT to SPT

• Less control plane overhead in the service provider space by limiting the type of

customer multicast routes exchanged, which results in more scalable deployments

• More stable traffic patterns in the backbone without the traffic shifts involved in the

RPT-SPTmode

• Easier maintenance in the service provider space due to less state information

Related
Documentation

Rendezvous Point on page 102•

• Understanding Multicast Rendezvous Points, Shared Trees, and Rendezvous-Point

Trees on page 102

• Understanding PIM Sparse Mode on page 104

• ConfiguringShared-TreeDataDistributionAcrossProviderCores forProviders ofMBGP

MVPNs on page 107

• Configuring VRF Route Targets for Routing Instances for an MBGPMVPN on page 110

Configuring VRF Route Targets for Routing Instances for anMBGPMVPN

By default, the VPN routing and forwarding (VRF) import and export route targets

(configuredeitherusingVRF importandexportpoliciesorusing thevrf-target statement)

are used for importing and exporting routes with the MBGPMVPN network layer

reachability information (NLRI).

You can use the export-target and import-target statements to override the default VRF

import and export route targets. Export and import targets can also be specified

specifically for sender sitesor receiver sites, or canbeborrowed fromaconfiguredunicast

route target.Note that a sender site export route target is alwaysadvertisedwhensecurity

association routes are exported.

NOTE: Whenyou configure anMBGPMVPN routing instance, you should not
configure a target value for an MBGPMVPN specific route target that is
identical to a target value for a unicast route target configured in another
routing instance.

Specifying route targets in the MBGPMVPN NLRI for sender and receiver sites is useful

when there is a mix of sender only, receiver only, and sender and receiver sites. A sender

site route target is used for exporting automatic discovery routes by a sender site and for

importing automatic discovery routes by a receiver site. A receiver site route target is
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used for exporting routesbya receiver site and importing routesbya sender site. A sender

and receiver site exports and imports routes with both route targets.

A provider edge (PE) routerwith sites in a specificMBGPMVPNmust determinewhether

a received automatic discovery route is from a sender site or receiver site based on the

following:

• If the PE router is configured to be only in a sender site, route targets are imported only

from receiver sites. Imported automatic discovery routes must be from a receiver site.

• If the PE router is configured to be only in a receiver site, route targets are imported

only from sender sites. Imported automatic discovery routes must be from a sender

site.

• If a PE router is configured to be in both sender sites and receiver sites, these guidelines

apply:

• Along with an import route target, you can optionally configure whether the route

target is from a receiver or a sender site.

• If a configuration is not provided, an imported automatic discovery route is treated

as belonging to both the sender site set and the receiver site set.

Related
Documentation

Rendezvous Point on page 102•

• Understanding Multicast Rendezvous Points, Shared Trees, and Rendezvous-Point

Trees on page 102

• Understanding PIM Sparse Mode on page 104

• ConfiguringShared-TreeDataDistributionAcrossProviderCores forProviders ofMBGP

MVPNs on page 107

• ConfiguringSPT-OnlyMode forMultiprotocol BGP-BasedMulticast VPNsonpage 108

Static Pseudowire Provisioning for VPLS Services

A virtual private LAN service (VPLS) domain consists of a set of PE routers that act as a

single virtual Ethernet bridge for the customer sites connected to these routers. By

configuring static pseudowires for the VPLS domain, network providers do not need to

configure the LDP or BGP protocols that are normally used for signaling. Static

pseudowires require that you configure a set of in and out labels for each pseudowire

configured for theVPLSdomain. Youstill need toconfigureaVPLS identifier andneighbor

identifiers forastaticVPLSdomain.Youcanconfigurebothstaticanddynamicneighbors

within the same VPLS routing instance.

Themanual configuration of a static pseudowire in MPLS requires configuring many

parameters at the two PE sides. We recommend that you configure the parameters on

both sides the same tomake the pseudowire operational. A mismatch in one or more

parameters on either end can cause the pseudowire not to operate correctly. In the case

of a dynamic pseudowire, these parameters are negotiated at either end through a
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signaling session. For static pseudowire, there is no such signaling session and therefore

parameters must be pre-selected and configured on both PE ends.

To enable static VPLS on a router, you need either to configure a virtual tunnel interface

(requires the router to have a tunnel services PIC) or to configure a label-switching

interface (LSI).

To configure an LSI, include the no-tunnel-services statement at the [edit protocols vpls

static-vpls] hierarchy level.

NOTE: This Enable Static PW Labels option is available in the

Point-to-Multipoint andMultipoint-to-Multipoint service types when the
signaling type is LDP and only in the Point-to-Multipoint service type when
the signaling type is BGP.

Related
Documentation

• Creating a Multipoint-to-Multipoint E-LAN Service Definition on page 619

• Creating a Point-to-Multipoint E-LAN Service Definition on page 641

• Creating a Service Definition for VPLS Access into Layer 3 Networks on page 666
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PART 2

GettingStartedWithConnectivityServices
Director

• Understanding Connectivity Services Director System Administration and

Preferences on page 115
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CHAPTER 4

Understanding Connectivity Services
Director System Administration and
Preferences

• Understanding Connectivity Services Director User Administration on page 115

• Understanding the System Tasks Pane on page 116

• Audit Logs Overview on page 117

• Viewing Audit Logs From Connectivity Services Director on page 117

• Managing Jobs on page 118

• Collecting Logs for Troubleshooting on page 120

• Setting Up User and System Preferences on page 121

Understanding Connectivity Services Director User Administration

Connectivity Services Director application uses the user administration features of Junos

Space Network Management Platform to add, delete, and edit user accounts and roles.

Formore informationonuseradministration, see JunosSpaceNetworkApplicationPlatform

User Guide.

When you install the Connectivity Services Director application, additional user

administrationoptions specific to theapplicationareavailable in JunosSpace. In addition

to the Super Administrator role, the following predefined roles are also available to

Connectivity Services Director users:

• Device Manager role---allows an administrator to discover devices.

• Service Manager role-–allows an administrator to perform device pre-staging actions

including discovering and assigning device roles.

• ServiceDesigner role-–allowsanadministrator tocreateandpublishaservicedefinition.

• ServiceActivator (lessprivileged) role---allowsanadministrator toperformprovisioning

tasks including creating andmanaging customers, service orders, and services.
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NOTE: You can create custom roles to grant users different access rights.
Access is controlled at the task category level. If you grant a user access to
a task category, the user has access to all tasks in that category.

Access to Connectivity Services Director system preferences is controlled by
user access rights. For more information, see “Setting Up User and System
Preferences” on page 121

If you try to log in to Connectivity Services Director by using an account that does not

have access rights to any Connectivity Services Director task category, you are redirected

to Junos Space instead.

Related
Documentation

Connectivity Services Overview on page 3•

• Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity

Services Director on page 13

• Connectivity Services Director Overview on page 14

• Understanding the Connectivity Services Director User Interface on page 16

• Understanding theUsageandLayoutofConnectivityServicesDirectorViewsandTasks

on page 23

• Understanding Task Categories in Connectivity Services Director on page 24

• Logging In to Connectivity Services Director on page 27

• Logging Out of Connectivity Services Director on page 31

Understanding the System Tasks Pane

The System Tasks pane provides tasks for viewing audit logs of Connectivity Services

Director user activities, for managing jobs, and for collecting troubleshooting logs.

To access the System Tasks pane, click System in the Connectivity Services Director

banner. The tasks are described in Table 11 on page 116.

Table 11: System Tasks

DescriptionTask

View a history of user activities on Connectivity Services Director, including
log in, log out, and task initiation and completion.

View Audit Logs

View all jobs that are scheduled to run or have been run by Connectivity
Services Director. You can cancel jobs that are in progress or scheduled to
run in the future.

Manage Jobs

Download a zip file containing logs and troubleshooting data from both
Connectivity Services Director and Junos Space.

Collect Jobs for
Troubleshooting
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Related
Documentation

Understanding Connectivity Services Director User Administration on page 26•

• Audit Logs Overview on page 117

Audit Logs Overview

Audit logs provide a record of login history and user-initiated tasks that are performed

from the user interface. From the Audit Logs page, you canmonitor user login–logout

activity over time, track device management tasks, view services that were provisioned

on devices, and so forth. Audit logging does not record non-user initiated activities, such

as device-driven activities, and is not designed for debugging purposes.

Administrators can sort and filter on audit logs to determinewhich users performedwhat

actions on what objects at what time. For example, an administrator can use audit log

filtering to track the user accounts thatwere addedona specific date, track configuration

changesacrossaparticular typeofdevice, viewservices thatwereprovisionedonspecific

devices, or monitor user login–logout activity over time.

Over time, Connectivity Services Director will archive a large volume of log entries. Such

log entriesmight ormight not be reviewed, but theymust be retained for a period of time.

The audit logs can be saved to a local server (the server that functions as the active node

for Connectivity Services Director) or a remote network host or media.

Related
Documentation

Viewing Audit Logs From Connectivity Services Director on page 117•

• Collecting Logs for Troubleshooting on page 120

Viewing Audit Logs FromConnectivity Services Director

Audit logsaregenerated for loginactivity and tasks that are initiated fromtheConnectivity

Services Director application. The Audit Logs page displays the logs for all user-initiated

activities.

You can do the following on the Audit Logs page:

• Sort, filter, and search the log entries using the standard table manipulation features

in Connectivity Services Director.

• Obtainmore information about a log entry by double-clicking the entry or by selecting

the entry and clicking ShowDetails. The Audit Log Details window is displayed.

• For a user-initiated task that runs as a job, you can obtain more information about the

job by clicking the job ID in the Job ID column.

To display the Audit Logs page:

1. Click System in the Connectivity Services Director banner.

2. Select View Audit Logs from the Tasks pane.
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The Audit Logs page is displayed with the fields listed in Table 12 on page 118.

Table 12: Audit Logs Page Fields

DescriptionField

The login ID of the user that initiated the taskUser Name

The IP address of the client computer fromwhich the user initiated the taskUser IP

The name of the task that triggered the audit logTask

The data and time when the user initiated the taskTime

The execution result of the task that triggered the audit log:

• Success—Job completed successfully

• Failure—Job failed and was terminated

• Job Scheduled—Job is scheduled but has not yet started

Result

A description of the audit logDescription

The job ID for any task that runs as a jobJob ID

Related
Documentation

Audit Logs Overview on page 117•

• Collecting Logs for Troubleshooting on page 120

Managing Jobs

Connectivity Services Director enables you to view andmanage jobs. You can view the

status of completed jobs and cancel the jobs that are scheduled to execute at a later

time or jobs that are in progress.

The JobManagementpage, accessibleasaSystemtask, enables you toviewandmanage

all jobs. Inaddition,ConnectivityServicesDirector enables you toviewspecial pre-filtered

versions of this page from various other tasks, such as View Discovery Status or View

Image Deployment Jobs. These pages contain the same fields (although some fields

might be hidden) and have the same functionality as the Job Management page, but

they list only those jobs relevant to particular tasks.

To display the Job Management page:

1. Click System on the Connectivity Services Director banner.

2. SelectManage Jobs from the Tasks pane. The Job Management page appears.
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3. To view the details of a job, select a row and click ShowDetails or double-click a row.

4. To cancel a scheduled job, select a job that is scheduled for a later time or a job that

is in progress and click Cancel.

The fields in the Job Management page are described in Table 13 on page 119. To view

any hidden column, keep themouse on any column heading and select the down arrow

and then click Columns. Select the check box to display the hidden columns.

NOTE: You can also view the CSDDeployment Jobs page in Deploymode of
Service View by selecting the View Deployment Jobs option in the task pane.

NOTE: Details of jobs initiated from Connectivity Services Director will be
available only from Connectivity Services Director. These jobs will not be
listed in the JobManagement pane in Junos Space platform and vice-versa.

Table 13: JobManagement Page Fields

DescriptionField

The unique ID assigned to the jobJob ID

The name of the jobName

The percentage of completion of the jobPercent

The status of the job:

• Success—Job completed successfully

• Failure—Job failed and was terminated

• Job Scheduled—Job is scheduled but has not yet started

• In progress—Job is has started, but not completed

• Cancelled—Job is cancelled

State

The type of the jobJob Type

Summary of the job scheduled and executed with statusSummary

The time when the job is scheduled to startScheduled
Start Time

The actual time when the job startedActual Start
Time

The time when the job was completedEnd Time

The login ID of the user that initiated the taskUser
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Table 13: JobManagement Page Fields (continued)

DescriptionField

The recurrent time when the job will be restarted.Recurrence

Related
Documentation

Managing Service Configuration Deployment Jobs on page 957•

• Deploying Services Configuration to Devices on page 959

Collecting Logs for Troubleshooting

Connectivity Services Director enables you to collect logs and other data from both

ConnectivityServicesDirectorandJunosSpace thatcanassist inmanagingandmonitoring

Connectivity Services Director servers.

Connectivity Services Director collects the logs and troubleshooting data into a

compressed file that you can download. This file is named

troubleshoot_yyyy-mm-dd_hh-mm-ss.zip—for example,

troubleshoot_2012-12-21_11-25-12.zip. The date and time in the file name is the server

Coordinated Universal Time (UTC) date and time.

To retrieve troubleshooting data and log files, follow these steps:

1. Click System on the Connectivity Services Director banner.

2. From the Tasks pane, click Collect Logs for Troubleshooting. The Collect Logs for

Troubleshooting page appears.

3. Click the Download troubleshooting data and logs fromConnectivity Services Director

and Junos Space link.

Connectivity Services Director begins collecting the logs and data. It can take a few

minutes for Connectivity Services Director to collect the information and create the

zip file.

4. When the standard file download window for your browser opens, save the

troubleshoot_yyyy-mm-dd_hh-mm-ss.zip file.

5. When you contact the Juniper Technical Assistance Center, describe the problem you

encountered and provide the JTAC representative with the troubleshoot.zip file.

Table 14 on page 120 lists the files included in the

troubleshoot_yyyy-mm-dd_hh-mm-ss.zip file.

Table 14: Log Files in the troubleshooting.zip File

LocationDescription

/var/log/jboss/servers/server1Jboss log files
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Table 14: Log Files in the troubleshooting.zip File (continued)

LocationDescription

/var/log/jboss/CSD.logConnectivity Services Director application log files

/var/log/jboss/CSDMoniotring.logConnectivity Services Director monitoring log files

/home/jmp/mssosadpater/var/errorLog/MSSOS adapter log files

/opt/opennms/logs/daemon/Daemon log files

/var/log/platformPlatform log files

/var/log/httpdAccess Log Files

/var/log/httpd/Log files for Apache, NMA,Webproxy

/var/log/Watchdog log file

Related
Documentation

Audit Logs Overview on page 117•

• Viewing Audit Logs From Connectivity Services Director on page 117

Setting Up User and SystemPreferences

Depending on your system authority, Preferences page can display either user settings

or a combination of user settings and system settings. One or more of these preference

tabs appear when you open the Preferences page:

• User—All users can choose whether monitors and reports display local time or server

time.

• Search—Administrators can configure options for search indexing.

• Monitoring—NetworkAdministrators canchange thepolling interval for data collection

for Monitor modemonitors and enable or disable the internal processes used for data

collection.

• Fault—Network Administrators can enable or disable alarms. They can also set the

retention period for alarms and the number of events per alarm.

• Report—Network Administrators can specify length of time Connectivity Services

Director reports are retained.

• Topology—Network Administrators can specify the topology server to which the

Connectivity Services Director application can establish a connection. Also, you can

specify settings for the automatic update and refresh of the topology. In addition, you

can define a retention period for the deleted links in Topology.
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• Service Activation—Network Administrators canmodify the configuration settings for

services activation-related components or functionalities of the Connectivity Services

Director application.

• Optical—NetworkAdministratorscanenableordisableopticalperformancemonitoring.

• NorthStar—Network Administrators can select NorthStar Controller for the

management of LSPs.

Based on thePreference settings, LSPswill be deployed either throughCSDor through

NorthStar Controller using REST APIs.

This topic describes:

• Accessing the Preferences page on page 122

• Choosing Server Time or Local Time on page 122

• Specifying Search Preferences on page 122

• Retaining Connectivity Services Director Reports on page 123

• Modifying Services Activation Parameter Settings on page 123

• Specifying Topology Preferences on page 128

• Changing Monitor Mode Settings on page 128

• Changing Alarm Settings on page 131

• Disabling Optical Performance Monitoring on page 153

• Specifying NorthStar Controller Preferences on page 153

Accessing the Preferences page

To open the Preferences page, click in the Connectivity Services Director banner

and select Preferences.

The Preferences page opens with User Preferences as the default tab.

Choosing Server Time or Local Time

All users can specify whether Connectivity Services Director displays local time or the

server’s time in monitors and reports on the User Preferences tab. The default setting is

to display local time. To change the setting to display the server’s time:

1. In the Preferences page, select Use Server Time from the list.

2. ClickOK to save your changes or click Cancel to close Preferences.

Specifying Search Preferences

Connectivity Services Director indexes the device inventory data periodically to enable

users toperformefficient searches.Youcanspecifya time intervalafterwhichConnectivity

Services Director initiates the next indexing on the Search tab. You can also specify to

stop indexing while devices are imported into Connectivity Services Director. If you are

Copyright © 2019, Juniper Networks, Inc.122

Connectivity Services Director User Guide



running short of systemmemory, selecting this option can help save somememory and

speed up the discovery and import of new devices. By default this option is selected and

the search index update interval is set to 900 seconds.

Retaining Connectivity Services Director Reports

By default, Connectivity Services Director keeps reports for 30 days. However, Network

Administrators canchange the retentionperiod from0to365days. Tochange the setting,

move the slider right or left on the Report tab of Preferences to the new setting. ClickOK

to save the setting.

Modifying Services Activation Parameter Settings

To understand the parameters of the services-activation settings, such as the attributes

and functionalities that apply to themanagement, provisioning, andmonitoringofE-Line,

IP, RSVP LSP, and E-LAN services, refer to Table 15 on page 123.

Table 15: Parameters in the Services Activation Tab

DescriptionFields

Deployment

Select this check box to validate the version of the service being configured.Check service version

Select this check box to deploy the configuration to the device.Deploy configuration to the
device

Select this check box to enable the service alarms. Enabling the service alarms causes a GUI
impact on the Connectivity Services Director application.When you select the check box and
deploy the service, the interface goes down, resulting in the failure to update the fault status.
When you right-click Service and selectViewServiceAlarms, the latter does not appear in the
results.

Enable service alarms

Select this check box to save the configuration of the device in XML format.Save configuration in XML
format

Select this check box to display the configuration in set format.Showconfiguration inset format

Select this check box to push the configuration on all the network elements automatically,
making either one or all successful.

Use two-phase commit for
service provisioning

When this check box is selected, normalization of VLAN tags is performed using the input or
output VLANmaps.

This check box is selected by default.

NOTE: Starting from Connectivity Services Director Release 2.1R1 onward, Use vlanmaps for
flexible tagged services under Setting Up User and System Preferences is renamed to Use
vlanmaps for E-Line services.

UsevlanmapsforE-Lineservices
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Table 15: Parameters in the Services Activation Tab (continued)

DescriptionFields

When this check box is cleared, normalization of VLAN tags is performed using normalized
tags under routing instance.

This check box is cleared by default.

NOTE: Starting from Connectivity Services Director Release 2.1R1 onward, normalization of
VLAN tags is performed using normalized tags under routing instance while setting up user
and system preferences.

Usevlanmapsfor flexible tagged
services instead of normalized
vlan (VPLS)

Select this checkbox to causea validation tobeperformed todetermine if anyof the selected
devices have pending out-of-band notification, before deploying a service order. If a pending
out-of-bandnotificationexists foradevice, deployment isblockedwith the followingmessage:

Cannot deploy service order, since pending notification exists for device(s) : <dev-1>,
<dev-2>,<dev-3>

Block deployment on pending
notifications

Audit

Select this check box to perform the functional audit automatically, after the service is
deployed successfully. By default, the functional audit is not checked. Extra time is taken to
complete both the functional audit and deployment.

Enable Functional Audit after
deployment

Specify the initial wait time to auto-schedule a functional audit job after deployment.

If the entered value is greater than 30minutes, it is reset to 30minutes. If the entered value
is less than 1 minute, the wait time is ignored.

The range is from 1 minute through 30minutes.

Functional AuditWaiting Time
after deployment

Select this check box to make the functional audit ignore the data plane verification and to
consider only the control plane.

Perform Functional Audit on
Control plane only

User Interface

Select this check box to allow the templates to be changed during the service modification.Allow templatemodification for
service

Specify the bandwidth combo items count.

In Create E-Line service order page, if the bandwidth range exceeds the bandwidth combo
items count, then the bandwidth input is taken in text field.

The default value is 100.

Bandwidth Combo Items Count

Specify the period of time in seconds as the wait period for retrieving service details during
service template modification.

Service Detail Wait Time (sec)

Monitoring

Select this check box to performmonitoring if the functional audit fails.PerformMonitoring on Failed
Functional Audit
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Table 15: Parameters in the Services Activation Tab (continued)

DescriptionFields

Select this check box to dump the configuration files.

Specify the time delay to issue the remote procedure call (RPC) call for redundancy service.
Since there is no support for the fault management for redundancy service, it should not
update the fault status as down, when the interface goes down as the service will be running
with the help of backup device. The RPC is issued to check the status of the service. If the
value of this time delay is 2 seconds and the interface goes down, it waits for 2 seconds to
check whether the service is up, with the help of the backup device and correspondingly
updates the fault status.

The default value is 2 seconds.

Pseudowire Redundancy
Transition TimeDelay

Specify the manner in which the aggregated results are returned for a query that polls and
retrieves data from devices. Two aggregation values are supported:

• Total: Sum of the number of packets received in the interval

• Average: Average of the total number of packets received in the interval

StatisticsAggregationReporting

Logging

By default, the configuration files are not dumped into the log directory. This is enabled, if
there is a need to provide troubleshooting to Juniper Networks Technical Assistance Center
(JTAC).

DumpConfiguration Files

Select this check box to write the configlets and error response from the JUNOS devices into
the log directory..

DumpDeployment Data

Specify the default path of the log directory: /var/tmp/jbossLog Directory

Prestage Devices

Specify the number of seconds for which the task to trigger a job for prestaging devicesmust
wait after receiving the first notification for prestaging devices. For example, if you specify
the prestage wait time as 20 seconds, the prestaging task waits for a period of 20 seconds,
after receiving the first notification for prestaging devices, and then initiates the
prestaging-devices job.

Pre-stageWait Time (Sec)

Specify the number of seconds after which the job for prestaging devices is initiated, if no
notification is received during the idle period. For example, if you specify the prestage idle
time as 10 seconds and if no notification for prestaging devices is received within this period,
the job for prestaging devices is triggered immediately after 10 seconds. The prestage idle
time value takes precedence over the prestage wait time value.

Pre-stage Idle Time (Sec)

Specify the logical unit of the loopback interface that must be used as the default loopback
logical interface for all provisioning tasks thatare initiated fromConnectivityServicesDirector.
The default logical unit for the loopback interface is 0.

Loopback Unit

Route Target
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Table 15: Parameters in the Services Activation Tab (continued)

DescriptionFields

Specify the least value in the preferred range of numbers, among which a certain number is
assigned for each BGP service. Route target allows you to distribute VPN routes to only the
routers that need them.When a route target value is enteredmanually, it should be either of
the following two formats: Autonomous System number format or IPv4 format. For
AutonomousSystemnumber format, the pattern is as-number:2-byte-number. For example,
target:100:200.

Range: The Autonomous System number format number can be in the range from 1 through
65,535.

The IPv4 format is ip-address:2-byte-number. For example, target:10.1.1.1:2.

BeginIndex

Specify the greatest value in the preferred range of numbers, amongwhich a certain number
is assigned for each BGP service. Route target allows you to distribute VPN routes to only the
routers that need them.When a route target value is enteredmanually, it should be either of
the following two formats: Autonomous System number format or IPv4 format. For
AutonomousSystemnumber format, the pattern is as-number:2-byte-number. For example,
target:100:200.

Range: The Autonomous System number format number can be in the range from 1 through
65,535.

The IPv4 format is ip-address:2-byte-number. For example, target:10.1.1.1:2. The EndIndex
value should be lesser than themaximum assigned value.

EndIndex

Virtual Circuit ID

Specify the least value in the preferred range of numbers, among which a certain number is
assigned as the VirtualCircuitID to the new circuit created. This VCID can bemanually chosen
by the customer or auto-generated by the system. For example, if BeginIndex = 100 and
EndIndex = 200, then the VCID would be somewhere between 100 and 200.

Minimum: 1

The value of BeginIndex should be less than or equal to EndIndex value.

The range is from 0 through 200000.

BeginIndex

Specify the greatest value in the preferred range of numbers, amongwhich a certain number
is assigned as the VirtualCircuitID to the new circuit created. This VCID can bemanually
chosen by the customer or auto-generated by the system. For example, if BeginIndex = 100
and EndIndex = 200, then the VCID would be somewhere between 100 and 200.

Maximum: 2147483647.

The range is from 0 through 200000.

EndIndex

PerformanceMonitoring

DataSetSize is the size of the performancemonitoring data set in days. This field indicates
the number of days of performancemonitoring data could be stored for display.

The default value is 2880.

DataSetSize
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Table 15: Parameters in the Services Activation Tab (continued)

DescriptionFields

Select the check box to collect the performance data through scripts and opennmswill store
the data in its database. If this check box is not selected, then performance data such as
one-way delay, two-way delay, and frame loss are collected through RPC and stored in the
application database.

Enable PerformanceMonitoring
through scripts

OSS Config Parameters

Specify the IP address of the primary server.Alcatel Primary Server IP

Specify the port number of the primary server.Alcatel Primary Server Port

Specify the IP address of the backup server.Backup Server IP

Specify the port number of the backup server.Backup Server Port

Specify the duration of HTTP connection before the time-out elapses.HTTP Connection Timeout

Specify the maximum number of simultaneous API requests permitted.MaximumAPI Requests

Specify the directory path of the OSS log directory.OSS Log Directory

Specify the OSS log filename.OSS Log Filename

Specify the user name for accessing the OSS server.OSSUser Name

Specify the hashed password for accessing the OSS server.OSSUser Password

Sets the daily time at which the CPP system synchronizes third-party devices, added or
deleted from the CPP system, with the OSS server.

SynchronizeOSS Inventory daily
at given time

If the check box is enabled, the CPP system communicates with the primary OSS server.Use primary server

Service Decommission

Specify the device synchronization waiting time. This is themaximumwait time to complete
thedevice synchronization. After this timeduration, irrespective of the device synchronization
status, the resources are released.

The default value is 60 seconds.

The range is from 30 seconds through 300 seconds.

Device SyncWait Time

Select this check box to wait for the device synchronization before resources are released.
To revert the decommissioning to the normal behavior, clear this check box.

Wait for Device Sync Before
Releasing Resource

Service Recovery
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Table 15: Parameters in the Services Activation Tab (continued)

DescriptionFields

Select either of the following options from the OutofBand Notification Action list to specify
the action you want to be performed when an OutOfBand notification is received by
Connectivity Services Director:

• MakeDeviceOutOfSync—Causes thedevice tobemadeOutOfSyncanddisablessubsequent
provisioning on that device until it changes to the In Sync state again

• Ignore Notification—Causes the notification to be ignored and device will remain InSync

OutofBand Notification

Select the checkbox to enable the storageofOutOfBandnotificationXML in theConnectivity
Services Director database. By default, this check box is not selected, which disables the
saving of OutofBand notification XML in the Connectivity Services Director database.

Store OutofBand Notification
XML

Specifying Topology Preferences

From the Topology tab of the Preferences page (which you can launch by clicking the

down arrow beside the System button on the Connectivity Services Director banner and

selecting Preferences), you can specify the topology server IP and the credentials for

enabling the Connectivity Services Director to connect to the topology server.

For Layer 2 topology settings, you canalsodisable theautomatic updates to the topology

and, instead, enable the topology updates to bemanually triggered by selecting the

Disable Autoupdate of Topology check box. In the Deleted Link Retention Period (Days)

field, drag the square over the line to specify the number of days that youmight want to

retain the deleted link.

For Layer 3 topology settings, you can select or clear theUse PCEP check box. Select the

UsePCEPcheckbox touse thePathComputationElementProtocol (PCEP) for discovery

of LSPs. PCEP enables communication between a PCC and the CSD-Topology to learn

about the network and LSP path state and communicate with the Path Computation

Clients (PCCs). By default, this check box is not selected.

Enter the server IPaddress in theTopologyServer field, and theauthenticationcredentials

in the Username and Password fields.

In the Refresh Topology Interval (days) field, drag the square over the line to specify the

frequency in number of days at which the Layer 3 topology must be refreshed and

displayed in the Topology View. By default, the topology is refreshed once every day.

Drag the square to the leftmost end of the line to disable the refresh of topology. Drag

the square to the rightmost end of the line to enable the refresh of topology once every

365 days or a year, which is the largest frequency you can specify for the refresh setting.

ChangingMonitor Mode Settings

The Monitoring tab of Preferences has three tabs under it. These are:

• MonitorSettings—Enables you to change thedefault polling interval for data collection

for Monitor modemonitors. You can also disable or reenable the internal processes

used for data collection on this sub-tab.
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• Client Session History—Enables you to set the retention period for history records and

the frequency that these records are checked for deletion.

This section describes:

• Disabling Data Collection for Monitors on page 129

• Changing the Polling Interval on page 130

• Specifying Database History Retention on page 131

Disabling Data Collection for Monitors

Connectivity Services Director internally gathers data for monitors by using a set of data

collection processes. You can disable these data collectors if they do not pertain to your

installation. For example, if you do not use Virtual Chassis, you can disable the data

collection processes used for Virtual Chassis.

The data collection processes are divided into the following categories:

• Equipment

• FM

• Traffic

One data collector can be used bymultiple monitors. Likewise, somemonitors can be

supported by multiple data collectors. These data collectors are enabled by default. To

ensure proper data collection, if you enable the equipment data collectors, youmust

also enable the traffic collectors..

To disable or reenable a data collector:

1. Determine which monitors are used by the data collectors. Use Table 16 on page 129

to determine the relationship between the data collectors and themonitors.

Table 16: Monitor Mapping for Data Collectors

CategoryData CollectorMonitor

EquipmentProvisioningMonitorInterfaceStatsCollectorShow Interface Statistics

EquipmentProvisioningMonitorInterfaceStatusCollectorShow Interface Status

EquipmentProvisioningMonitorServiceStatusCollectorService Traffic, Service Summary,
Service Transport

EquipmentProvisioningMonitorLSPStatsCollectorLSP Statistics

EquipmentProvisioningMonitorLDPStatsCollectorLDP Statistics

EquipmentProvisioningMonitorY1731PMCollectorService Performance

EquipmentProvisioningMonitoringRFC2544PollerRFC2544 Benchmarking Tests
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Table 16: Monitor Mapping for Data Collectors (continued)

CategoryData CollectorMonitor

EquipmentEquipmentMonitorDeviceStatusCollectorPort Status (physical)

TrafficPortTrafficMonitorCollectorTraffic Trend

FMFMAlarmCountCollectorAlarms

TrafficProvisioningMonitorLSPToServiceAssociationCollectorCollection of LSPs and Service
Association for Topology View

2. Clear the check box to disable the collector or select to enable the collector.

3. Click Save and Close to save the configuration and to close the window.

Changing the Polling Interval

The frequency at which data is collected is determined by the polling interval.

Table 17 on page 130 shows the default polling intervals used by each data collector.

Table 17: Default Polling Intervals

Polling IntervalCollector

5minutesProvisioningMonitorInterfaceStatsCollector

10 minutesProvisioningMonitorInterfaceStatusCollector

10 minutesProvisioningMonitorServiceStatusCollector

10 minutesProvisioningMonitorLSPStatsCollector

5 minutesProvisioningMonitorLDPStatsCollector

5 minutesProvisioningMonitorY1731PMCollector

5 minutesProvisioningMonitoringRFC2544Poller

10 minutesEquipmentMonitorDeviceStatusCollector

10 minutesPortTrafficMonitorCollector

5 minutesProvisioningMonitorLSPToServiceAssociationCollector

To change the polling interval:

1. Select the polling interval for a data collector in the Monitor Settings table.
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2. Type the new interval level in wholeminutes. For example, do not specify 1.5minutes.

Recommended intervals are 5, 10, or 20minutes.

3. ClickOK and then Yes to verify the change to the configuration.

Specifying Database History Retention

To keep the databasemanageable, the systemperiodically checks the age of the records

and retires those that have past an expiration date. By default, Connectivity Services

Director agesdatabase recordsoff at90daysand runsadatabasecleanupevery6hours.

Use the Client Session History sub-tab to change the default values:

1. Select from the lists new values.

• Age of history records (in days) from 1 to 365 days.

• Cleanup job frequency (in hours) from 1 through 24 hours.

2. ClickOK to save the changes.

Changing Alarm Settings

Use theFault tab toenable individual alarms, set the retentionperiod for alarms, configure

alarm notifications, configure threshold alarms, and to specify the number of events to

keep for each alarm. The Fault tab has multiple sections, which you can expand and

collapse by clicking the arrow next to the section title:

• Global Settings, for configuring Faults settings such as global alarm notifications and

alarm data retention.

• Individual Alarms andThreshold Settings, for configuring settings for individual alarms

and threshold alarms.

This section describes the following tasks that you can perform by using the Fault tab:

• Configuring Global Alarm Notifications on page 131

• Retaining Alarm History on page 132

• Specifying Event History on page 132

• Enabling Alarms on page 132

• Changing the Severity of Individual Alarms on page 151

• Configuring Threshold Alarms on page 152

• Configuring Individual Alarm Notifications on page 152

Configuring Global AlarmNotifications

Youcanconfigureglobal e-mail notifications tobesentwhenanyalarmwithnotifications

enabled is generated. Toconfigureglobal e-mail notifications, enter thee-mail addresses

to receive global alarm notifications in the Alarm Notifications Destinations field in the

Global Settings section. Separate addresses with a comma (,). For information about
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enabling notification for an alarm, see “Configuring Individual Alarm Notifications” on

page 152.

Retaining AlarmHistory

Use theNo.ofdays tokeepAlarm field in theGlobalSettings section to specify thenumber

of days to keep alarm history. The default retention time is 120 days; but you can specify

a period of 7 through 1000 days. Specifying a longer retention time consumesmore

database resources. To change the alarm retention duration, type a new value and click

OK and Yes to confirm the change.

Specifying Event History

Use the Events/Alarm field in the Global Settings section to specify the number of event

entries that are kept in the alarm history. The default setting for events is 20. To change

the setting, type a new value and clickOK and Yes to confirm the change.

Enabling Alarms

Ensure all devices are configured to send traps to Connectivity Services Director. This

task is performed for the devices in Deploy mode through Set SNMP Trap Configuration.

Use the Individual Alarms and Threshold Settings section to disable and re-enable

individual alarmsor all alarms. Alarmsappear onboth tabs in the section: AlarmSettings

and Threshold Settings. Fault alarms are preconfigured and initially enabled. To enable

or disable alarms:

1. (Optional)Sort thealarms.Bydefault, the list ofalarms is sortedalphabeticallywithin

each category. You can also sort by description or alarm severity within a category by

clicking a column heading.

2. Review the alarms and either select the check box in the heading to select all of the

alarms or select the check box for the individual alarms you want to enable. For a full

description of each of the alarms, see Table 18 on page 132.

3. ClickOK and Yes to confirm the alarm change.

Table 18: Alarm Descriptions

Device TypeDescriptionAlarm Name

BFD

ACX, M, MX, and
PTX Series routers

Generatedwhen the threshold value for detection
time is set and the BFD session detection-time
adapts to a value greater than the threshold.

BfdSessionDetectionTimeAlarm

ACX, M, MX, and
PTX Series routers

Generated when the threshold value for transmit
interval (in microseconds) is exceeded.

BfdSessionTxAlarm

BGP
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

ACX, M, MX, and
PTX Series routers

Generated when the BGP FSMmoves from a
higher-numberedstate toa lower-numberedstate.

BgpM2BackwardTransitionAlarm

ACX, M, MX, and
PTX Series routers

Generated when the BGP Finite State Machine
(FSM) enters the ESTABLISHED state.

BgpM2EstablishedAlarm

Chassis

ACX, M, MX, and
PTX Series routers

Generated when the specified cooling fan or
impeller has failed (is not spinning).

FanFailureAlarm

ACX, M, MX, and
PTX Series routers

Generated when the Forwarding Engine Board
(FEB) has switched over.

FEBSwitchoverAlarm

ACX, M, MX, and
PTX Series routers

Generated when the device has detected that a
field-replaceableunit (FRU),hassomeoperational
errors and has gone into check state.

FRUCheckAlarm

ACX, M, MX, and
PTX Series routers

Generated when a FRU has failed.FRUFailedAlarm

ACX, M, MX, and
PTX Series routers

Generated when the system detects that the
specified FRU is inserted into the chassis.

FRUInsertionAlarm

ACX, M, MX, and
PTX Series routers

Generated when the specified FRU goes offline.FRUOfflineAlarm

ACX, M, MX, and
PTX Series routers

Generated when the specified FRU goes online.FRUOnlineAlarm

ACX, M, MX, and
PTX Series routers

Generatedwhen the specifiedFRU ispoweredoff.FRUPowerOffAlarm

ACX, M, MX, and
PTX Series routers

Generatedwhen the specified FRU is powered on.FRUPowerOnAlarm

ACX, M, MX, and
PTX Series routers

Generated when the system detects that the
specified FRUwas removed from the chassis.

FRURemovalAlarm

ACX, M, MX, and
PTX Series routers

Generated when the hard disk for the specified
routing engine has failed.

HardDiskFailedAlarm

ACX, M, MX, and
PTX Series routers

Generated when the hard disk in the specified
routing engine ismissing from theboot device list.

HardDiskMissingAlarm

ACX, M, MX, and
PTX Series routers

Generated when the specified power supply has
failed (bad DC output).

PowerSupplyFailureAlarm
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

ACX, M, MX, and
PTX Series routers

Generated when a graceful Routing Engine
switchover (GRES) occurs on a switch with dual
Routing Engines or on a Virtual Chassis.

RedundancySwitchOverAlarm

ACX, M, MX, and
PTX Series routers

Generated when the device has over heated.TemperatureAlarm

Cluster/Modo

ACX, M, MX, and
PTX Series routers

Generated when the cluster configuration failed
to apply.

Cluster Sync Failure

Configuration (Configuration)

ACX, M, MX, and
PTX Series routers

Generated when the jnxCMCfgChgEventTable
records a configuration management event.

CmCfgChangeAlarm

ACX, M, MX, and
PTX Series routers

Generated when a change is made to the rescue
configuration.

CMRescueChangeAlarm

Core and controllers (Controllers)

ACX, M, MX, and
PTX Series routers

Generated when the device status changes (up
to down or down to up).

Device alarm

CoS

ACX, M, MX, and
PTX Series routers

Generated when only 10% of CoS queues are
available.

CoSAlmostOutOfDedicatedQueuesAlarm

ACX, M, MX, and
PTX Series routers

Generated when there are nomore available
dedicated CoS queues.

CoSOutOfDedicatedQueuesAlarm

DHCP

ACX, M, MX, and
PTX Series routers

Generated when a DHCP client is detected
changing interfaces.

JdhcpLocalServerDupClientAlarm

ACX, M, MX, and
PTX Series routers

Generated when the client limit is reached on an
interface.

JdhcpLocalServerlfLimitExceededAlarm

ACX, M, MX, and
PTX Series routers

Generated when the client limit is reached on an
interface for DHCPv6.

Jdhcpv6LocalServerLimitExceededAlarm

DOM

ACX, M, MX, and
PTX Series routers

Generated when an interface detects Digital
Optical Monitor (DOM) alarm conditions.

DomAlertSetAlarm
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

General

ACX, M, MX, and
PTX Series routers

Generated when a protocol message is received
that is not properly authenticated.

Authentication Failure Alarm

ACX, M, MX, and
PTX Series routers

Generated when a device is re-initializing and its
configuration might have changed.

Cold Start Alarm

ACX, M, MX, and
PTX Series routers

Generated when a link is down. The trap is
generated when the ifOperStatus object for a
communication link is about to enter the down
state from another state other than notPresent.
This other state is indicated by the included value
of ifOperStatus.

Link Down Alarm

ACX, M, MX, and
PTX Series routers

Generated when a link comes up that was
previously in thedownstate. The trap is generated
whenthe ifOperStatusobject foracommunication
link left the down state and transitioned into
another state other than notPresent state. This
other state is indicated by the included value of
ifOperStatus.

Link Up Alarm

ACX, M, MX, and
PTX Series routers

Generated when a device is re-initializing and its
configuration has not changed.

Warm Start Alarm

Generic (GenericEvent)

ACX, M, MX, and
PTX Series routers

Generated by an Op script or event policies. This
notification can include one or more
attribute-value pairs. The pairs are identified by
the jnxEventAvAttribute and jnxEventAvValue
objects.

GenericEventTrapAlarm

OTN Notification

PTX Series routersGenerated as a notification of an OTM alarm that
is set. An alarm is triggeredwhen an optical PIC or
field-replaceable unit (FRU) is removed or
reinserted, or transitions between in-service and
out-of-service states.

FRU: OTN Admin Notification Set

PTX Series routersGenerated as Optical Channel Payload (OPU)
Payload Type Mismatch defect trigger.

ODU::OdukPtmAlarm

PTX Series routersGenerated as OC target of evaluation (TOE)
security functionality (TSF) defect trigger.

ODU::OdukTcm

PTX Series routersGenerated as ODU Background Block Error
Threshold crossing defect trigger in the 15-minute
interval threshold.

ODU::OdukTcm15MinThreshBBETCA
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX Series routersGenerated as ODU Bit interleaved parity for
SONET section overhead defect trigger in the
15-minute interval threshold.

ODU::OdukTcm15MinThreshBip8TCA

PTX Series routersGenerated as ODU errored seconds
threshold-crossing defect trigger in the 15-minute
interval threshold.

ODU::OdukTcm15MinThreshESTCA

PTX Series routersGenerated as ODU severely errored seconds
threshold-crossing defect trigger in the 15-minute
interval threshold.

ODU::OdukTcm15MinThreshSESTCA

PTX Series routersGenerated as ODU unavailable seconds
threshold-crossing defect trigger in the 15-minute
interval threshold.

ODU::OdukTcm15MinThreshUASTCA

PTX Series routersGenerated as ODU Background Block Error
Threshold crossing defect trigger in the 15-minute
interval threshold.

ODU::OdukTcm15MinThreshBBETCA

PTX Series routersGenerated as ODU Bit interleaved parity for
SONET section overhead defect trigger in the
24-hour or 1-day interval threshold.

ODU::OdukTcm24HourThreshBip8TCA

PTX Series routersGenerated as ODU errored seconds
threshold-crossing defect trigger in the 24-hour
or 1-day interval threshold.

ODU::OdukTcm24HourThreshESTCA

PTX Series routersGenerated as ODU severely errored seconds
threshold-crossing defect trigger in the 24-hour
or 1-day interval threshold.

ODU::OdukTcm24HourThreshSESTCA

PTX Series routersGenerated as ODU unavailable seconds
threshold-crossing defect trigger in the 24-hour
or 1-day interval threshold.

ODU::OdukTcm24HourThreshUASTCA

PTX Series routersGenerated asODUAlarm Indication Signal defect
trigger.

ODU::OdukTcmAisAlarm

PTX Series routersGenerated as ODU Backward Defect Indication
defect trigger.

ODU::OdukTcmBdiAlarm

PTX Series routersGenerated as ODU client signal failure alarm.ODU::OdukTcmCSfAlarm

PTX Series routersGenerated as ODU degradation alarm.ODU::OdukTcmDegAlarm

PTX Series routersGenerated as ODU incoming alignment error
alarm.

ODU::OdukTcmIaeAlarm

PTX Series routersGenerated as ODU threshold crossing alert (TCA)
alarm.

ODU::OdukTcmLTCAlarm
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX Series routersGenerated as ODU locked defect trigger.ODU::OdukTcmLckAlarm

PTX Series routersGenerated as ODU open connection indication
alarm.

ODU::OdukTcmOciAlarm

PTX Series routersGenerated as ODU server signal failure alarm.ODU::OdukTcmSSfAlarm

PTX Series routersGenerated as ODU trace identifier mismatch
alarm.

ODU::OdukTcmTimAlarm

PTX Series routersGenerated as ODU no-alarmwhen threshold
crossing alert occurs.

ODU::OtnOdukTcmNoAlarm

PTX Series routersGenerated as a notification when OTN alarm is
set.

OTN Admin Notification Set

PTX Series routersGenerated as OTU alarm indication signal trigger.OTU::OdukTcmAisAlarm

PTX Series routersGenerated as an alarmwhen OTU uncorrected
words in the 15-minute threshold is exceeded.

OTU::15MinThUnCorrectedWordsTCA

PTX Series routersGenerated as an alarmwhen OTU background
block error count in the 15-minute threshold is
exceeded.

OTU::15MinThreshBBETCA

PTX Series routersGenerated as an alarmwhen OTU bit interleaved
parity count in the 15-minute threshold is
exceeded.

OTU::15MinThreshBip8TCA

PTX Series routersGenerated as an alarmwhen errored seconds
count in the 15-minute threshold is exceeded.

OTU::15MinThreshESTCA

PTX Series routersGenerated as an alarmwhen severely errored
seconds count in the 15-minute threshold is
exceeded.

OTU::15MinThreshSESTCA

PTX Series routersGenerated as an alarmwhen pre-forward error
correction bit error rate count in the 15-minute
threshold is exceeded.

OTU::15MinThreshPreFECBERTCA

PTX Series routersGeneratedasanalarmwhenunavailable seconds
count in the 15-minute threshold is exceeded.

OTU::15MinThreshUASTCA

PTX Series routersGenerated as an alarmwhen OTU background
block error count in the 24-hour threshold is
exceeded.

OTU::24HourThreshBBETCA

PTX Series routersGenerated as an alarmwhen OTU bit interleaved
parity count in the 24-hour threshold is exceeded.

OTU::24HourThreshBip8TCA
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX Series routersGenerated as an alarmwhen errored seconds
count in the 24-hour threshold is exceeded.

OTU::24HourThreshESTCA

PTX Series routersGenerated as an alarmwhen severely errored
seconds count in the 24-hour threshold is
exceeded.

OTU::24HourThreshPreFECBERTCA

PTX Series routersGenerated as an alarmwhen pre-forward error
correction bit error rate count in the 24-hour
threshold is exceeded.

OTU::24HourThreshSESTCA

PTX Series routersGeneratedasanalarmwhenunavailable seconds
count in the 24-hour threshold is exceeded.

OTU::24HourThreshUASTCA

PTX Series routersGenerated as an OTN loss of signal alarm.OTU:OtnLofAlam

PTX Series routersGenerated as an OTN loss of frame alarm.OTU:OtnLosAlarm

PTX Series routersGenerated as an OTN loss of multiframe alarm.OTU:OtnLomAlarm

PTX Series routersGenerated as an OTN no alarm.OTU:OtnNoAlarm

PTX Series routersGenerated as an OTU backward defect indication
alarm.

OTU:OtuBdiAlarm

PTX Series routersGenerated as an OTU backward error indication
alarm.

OTU:OtuBiaeAlarm

PTX Series routersGenerated as an OTU degraded alarm.OTU:OtuDegAlarm

PTX Series routersGenerated as an OTU excessive errors alarm.OTU:OtuFecExcessiveErrsAlarm

PTX Series routersGenerated as an OTU incoming alignment defect
alarm.

OTU:OtuIaeAlarm

PTX Series routersGenerated as an OTU server signal alarm.OTU:OtuSsAlarm

PTX Series routersGenerated as an OTN trail trace identifier
mismatch defect alarm.

OTU:OtuTimAlarm

PTX Series routersGenerated as an OTU TOE security functionality
(TSF) alarm.

OTU:OtuTsfAlarm

PTX Series routersGenerated as input loss of signal alarm.Optical::LOS

PTX Series routersGenerated as wavelength lock error alarm.Optical::WavelenthLockErr

PTX Series routersGenerated as Tx high power alarm.Optical::PowerHighAlarm
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX Series routersGenerated as Tx low power alarm.Optical::PowerLowAlarm

PTX Series routersGenerated as Bias Current High alarm.Optical::BiasCurrentHighAlarm

PTX Series routersGenerated as Bias Current Low alarm.Optical::BiasCurrentLowAlarm

PTX Series routersGenerated as Temperature High alarm.Optical::TemperatureHighAlarm

PTX Series routersGenerated as Temperature low alarm.Optical::TemperaturelowAlarm

PTX Series routersGenerated as transmitted phase-locked loop lock
alarm.

Optical::TxPLLLockAlarm

PTX Series routersGenerated as received phase-locked loop lock
alarm.

Optical::RxPLLLockAlarm

PTX Series routersGenerated as avaerage power alarm.Optical::AvgPowerAlarm

PTX Series routersGenerated as Rx Loss Avg Power alarm.Optical::RxLossAvgPowerAlarm

PTX Series routersGenerated as Loss of AC Power alarm.Optical::LossofACPowerAlarm

PTX Series routersGenerated as transmitted temperature high
threshold setting trigger.

Optical::TxPowerHighThreshAlert

PTX Series routersGenerated as transmitted temperature low
threshold setting trigger.

Optical::TxPowerLowThreshAlert

PTX Series routersGeneratedas received temperaturehigh threshold
setting trigger.

Optical::RxPowerHighThreshAlert

PTX Series routersGenerated as received temperature low threshold
setting trigger.

Optical::RxPowerLowThreshAlert

PTX Series routersGenerated as temperature high threshold setting
trigger.

Optical::ModuleTempHighThreshAlert

PTX Series routersGenerated as temperature low threshold setting
trigger.

Optical::ModuleTempLowThreshAlert

PTX Series routersGenerated as transmitted temperature high
threshold setting triggerwithin the24-hourperiod.

Optical::24HourTxPowerHighThreshAlert

PTX Series routersGenerated as transmitted temperature low
threshold setting triggerwithin the24-hourperiod.

Optical::24HourTxPowerLowThreshAlert

PTX Series routersGeneratedas received temperaturehigh threshold
setting trigger within the 24-hour period.

Optical::24HourRxPowerHighThreshAlert
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX Series routersGenerated as received temperature low threshold
setting trigger within the 24-hour period.

Optical::24HourRxPowerLowThreshAlert

PTX Series routersGenerated as temperature high threshold setting
trigger within the 24-hour period.

Optical::24HourModuleTempHighThreshAlert

PTX Series routersGenerated as temperature low threshold setting
trigger within the 24-hour period.

Optical::24HourModuleTempLowThreshAlert

PTX Series routersGenerated as received high power alarm.Optical::RxPowerHighAlarm

PTX Series routersGenerated as received low power alarm.Optical::RxPowerLowAlarm

PTX Series routersGenerated as Rx high power warning.Optical::TxPowerHighWarning

PTX Series routersGenerated as Rx high power warning.Optical::TxPowerLowWarning

PTX Series routersGenerated as Rx high power warning.Optical::RxPowerHighWarning

PTX Series routersGenerated as Rx high power warning.Optical::RxPowerLowWarning

PTX Series routersGenerated as module temperature high warning.Optical::ModuleTempHigh

PTX Series routersGenerated as module temperature lowwarning.Optical::ModuleTempLowWarning

PTX Series routersGenerated as received carrier frequency high
warning.

Optical::RxCarrierFreqHigh

PTX Series routersGenerated as received carrier frequency low
warning.

Optical::RxCarrierFreqLow

PTX Series routersGenerated as chromatic dispersion high warning.Optical::ChromaticDispHighWarning

PTX Series routersGenerated as chromatic dispersion lowwarning.Optical::ChromaticDispLowWarning

PTX Series routersGenerated as low quality factor warning.Optical::QLowWarning

PTX Series routersGenerated as low signal-to-noise ratio warning.Optical::OSNRLowWarning

PTX Series routersGenerated as carrier frequency high threshold
setting trigger.

Optical::CarrierFreqHighAlert

PTX Series routersGenerated as carrier frequency low threshold
setting trigger.

Optical::CarrierFreqLowAlert

PTX Series routersGenerated as carrier frequency high threshold
setting triggerwithin the24-hour threshold interval
period.

Optical::24HourCarrierFreqHighAlert
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX Series routersGenerated as carrier frequency low threshold
setting triggerwithin the24-hour threshold interval
period.

Optical::24HourCarrierFreqLowAlert

ILA Notification

PTX Series routersGenerated when the EDFA in the direction from
optical supervisory channel (OSC) A to OSC B
(Eab) has a calibration table error.

ILA::edfaEabCaliTableErr

PTX Series routersGenerated when the EDFA case temperature
exceeds the configured threshold in the direction
fromOSC A to OSC B.

ILA::edfaEabCaseTemperature

PTX Series routersGenerated when the input loss of signal (LOS) is
detected in the direction fromOSC A to OSC B.

ILA::edfaEabInputLOS

PTX Series routersGeneratedwhentheOut-of-ServiceOut-of-Group
(OOSOOG)conditionoccurs in thedirection from
OSC A to OSC B.

ILA::edfaEabOOG

PTX Series routersGenerated when the Out-of-Policy (OOP)
condition occurs in the direction fromOSC A to
OSC B.

ILA::edfaEabOOP

PTX Series routersGenerated when an output LOS condition occurs
in the direction fromOSC A to OSC B.

ILA::edfaEabOutputLOS

PTX Series routersGenerated when the end-of-life (EoL) state for
pump 1 of the EDFA occurs in the direction from
OSC A to OSC B.

ILA::edfaEabPump1EOL

PTX Series routersGenerated when the end-of-life (EoL) state for
pump 2 of the EDFA occurs in the direction from
OSC A to OSC B.

ILA::edfaEabPump2EOL

PTX Series routersGenerated when the temperature exceeds the
threshold for pump 1 of the EDFA occurs in the
direction fromOSC A to OSC B.

ILA::edfaEabPump1Temperature

PTX Series routersGenerated when the temperature exceeds the
threshold for pump 1 of the EDFA occurs in the
direction fromOSC A to OSC B.

ILA::edfaEabPump2Temperature

PTX Series routersGenerated when the radio frequency loss (RFL)
occurs for the EDFA occurs in the direction from
OSC A to OSC B.

ILA::edfaEabRFL

PTX Series routersGenerated when the EDFA in the direction from
optical supervisory channel (OSC) B to OSC A
(Eba) has a calibration table error.

ILA::edfaEbaCaliTableErr
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX Series routersGenerated when the EDFA case temperature
exceeds the configured threshold in the direction
fromOSC B to OSC A.

ILA::edfaEbaCaseTemperature

PTX Series routersGenerated when the input loss of signal (LOS) is
detected in the direction fromOSC B to OSC A.

ILA::edfaEbaInputLOS

PTX Series routersGeneratedwhentheOut-of-Gain(OOG)condition
occurs in the direction fromOSC B to OSC A.

ILA::edfaEbaOOG

PTX Series routersGenerated when the Out-of-Power (OOP)
condition occurs in the direction fromOSC B to
OSC A.

ILA::edfaEbaOOP

PTX Series routersGenerated when an output LOS condition occurs
in the direction fromOSC B to OSC A.

ILA::edfaEbaOutputLOS

PTX Series routersGenerated when the end-of-life (EoL) state for
pump 1 of the EDFA occurs in the direction from
OSC B to OSC A.

ILA::edfaEbaPump1EOL

PTX Series routersGenerated when the end-of-life (EoL) state for
pump 2 of the EDFA occurs in the direction from
OSC B to OSC A.

ILA::edfaEbaPump2EOL

PTX Series routersGenerated when the temperature exceeds the
threshold for pump 1 of the EDFA occurs in the
direction fromOSC B to OSC A.

ILA::edfaEbaPump1Temperature

PTX Series routersGenerated when the temperature exceeds the
threshold for pump 1 of the EDFA occurs in the
direction fromOSC B to OSC A.

ILA::edfaEbaPump2Temperature

PTX Series routersGenerated when the radio frequency loss (RFL)
occurs for the EDFA occurs in the direction from
OSC B to OSC A.

ILA::edfaEbaRFL

PTX Series routersGenerated when the ILA board temperature
reaches an abnormal level.

ILA::ilaBoardTemperatureAbnormal

PTX Series routersGenerated when the communication channel
between the NMS system and the ILA reaches an
abnormal level.

ILA::ilaCommunicationAbnormal

PTX Series routersGenerated when the ILA AC power reaches an
abnormal level.

ILA::ilaACPowerAbnormal

PTX Series routersGenerated when the ILA DC power reaches an
abnormal level.

ILA::ilaDCPowerAbnormal
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX Series routersGenerated when the ILA fan tray controller 1 that
is online reaches an abnormal level.

ILA::ilaFan1OnlineAbnormal

PTX Series routersGenerated when the speed of the ILA fan tray
controller 1 reaches an abnormal level.

ILA::ilaFan1SpeedAbnormal

PTX Series routersGenerated when the ILA fan tray controller 1 that
is online reaches an abnormal level.

ILA::ilaFan2OnlineAbnormal

PTX Series routersGenerated when the speed of the ILA fan tray
controller 1 reaches an abnormal level.

ILA::ilaFan2SpeedAbnormal

PTX Series routersGenerated when the ILA fan tray controller 1 that
is online reaches an abnormal level.

ILA::ilaFan3OnlineAbnormal

PTX Series routersGenerated when the speed of the ILA fan tray
controller 1 reaches an abnormal level.

ILA::ilaFan3SpeedAbnormal

PTX Series routersGeneratedwhen the ILA software version reaches
an abnormal level.

ILA::ilaSoftwareVersionAbnormal

PTX Series routersGenerated when the ILA table error occurs.ILA::ilaTableErr

PTX Series routersGenerated when the addition of power LOS
condition occurs for the OSC A.

ILA::oscaAddPowerLOS

PTX Series routersGenerated when the dropping of power LOS
condition occurs for the OSC A.

ILA::oscaDropPowerLOS

PTX Series routersGenerated when the addition of power LOS
condition occurs for the OSC B.

ILA::oscbAddPowerLOS

PTX Series routersGenerated when the dropping of power LOS
condition occurs for the OSC B.

ILA::oscbDropPowerLOS

IPLC Notification

PTX3000 Packet
Transport Routers

Generated as the FPCarrayedwaveguide gratings
(AWG) add LOS alarm for the IPLC

jnxIplcFpcAwgAddLosAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC input LOS alarm for the
express-in mode of the IPLC.

jnxIplcFpcExpInLosAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC add LOS alarm for the
optical supervisory channel (OSC) of the IPLC.
The OSC is an in-band channel used to
communicate with ILAs and other optical nodes
in the line system that are not directly accessible
over the DCN. OSC framing logic is implemented
in the FPGA.

jnxIplcFpcOscAddLosAlarm
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Device TypeDescriptionAlarm Name

PTX3000 Packet
Transport Routers

Generatedas theFPCdropLOSalarm for theOSC
of the IPLC.

jnxIplcFpcOscDrpLosAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC input line-in LOS alarm for
the IPLC.

jnxIplcFpcLineInLosAlarm

PTX3000 Packet
Transport Routers

Generatedas theFPCerbiumdoped fiberamplifier
(EDFA) 1 reflect power alarm for the IPLC. EDFA1
is considered as ingress EDFA and EDFA2 is
considered as egress EDFA

jnxIplcFpcEdfa1RefPwAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA1 output power alarm
for the IPLC.

jnxIplcFpcEdfa1OutPwAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA1 output gain alarm
for the IPLC

jnxIplcFpcEdfa1OutGain

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA1 pump end-of-life
(EoL) alarm for the IPLC.

jnxIplcFpcEdfa1PumpEolAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA1 temperature alarm
for the IPLC.

jnxIplcFpcEdfa1TempAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA1 output LOS alarm
for the IPLC.

jnxIplcFpcEdfa1OutLosAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA1 input LOS alarm for
the IPLC.

jnxIplcFpcEdfa1InLosAlarm

PTX3000 Packet
Transport Routers

Generatedas theFPCerbiumdoped fiberamplifier
(EDFA) 1 reflect power alarm for the IPLC. EDFA1
is considered as ingress EDFA and EDFA2 is
considered as egress EDFA

jnxIplcFpcEdfa2RefPwAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA2 output power alarm
for the IPLC.

jnxIplcFpcEdfa2OutPwAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA2 output gain alarm
for the IPLC

jnxIplcFpcEdfa2OutGainAlarm

PTX3000 Packet
Transport Routers

Generatd as the FPC EDFA2 pump end-of-life
(EoL) alarm for the IPLC.

jnxIplcFpcEdfa2PumpEolAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA2 temperature alarm
for the IPLC.

jnxIplcFpcEdfa2TempAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA2 output LOS alarm
for the IPLC.

jnxIplcFpcEdfa2OutLosAlarm
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Device TypeDescriptionAlarm Name

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA2 input LOS alarm for
the IPLC.

jnxIplcFpcEdfa2InLosAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC wavelength selective
switching (WSS) temperature alarm for the IPLC.

jnxIplcFpcWssTempAlarm

PTX3000 Packet
Transport Routers

Generated as the FPCWSS voltage alarm for the
IPLC.

jnxIplcFpcWssVoltAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC internal diagnostic alarm
for the IPLC.

jnxIplcFpcInterDiagAlarm

PTX3000 Packet
Transport Routers

Generatedas theFPCfirmwareconsistencyalarm
for the IPLC.

jnxIplcFpcFwCnsistAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC hardware failure alarm for
the IPLC.

jnxIplcFpcHwFailAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC firmware failure alarm for
the IPLC.

jnxIplcFpcFwFailAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC optical channel module
(OCM) failure alarm for the IPLC.

jnxIplcFpcOcmFailAlarm

PTX3000 Packet
Transport Routers

Generated as the FPCWSS failure alarm for the
IPLC.

jnxIplcFpcWssFailAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA2 failure alarm for the
IPLC.

jnxIplcFpcEdfa2FailAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC EDFA1 alarm for the IPLC.jnxIplcFpcEdfa1FailAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC power rail failure alarm for
the IPLC.

jnxIplcFpcPwrFailAlarm

PTX3000 Packet
Transport Routers

Generatedasanalarmwhen theOSCtransmitted
high power exceeds the threshold within the
15-minute interval for the IPLC.

jnxIplcOscTxPowerHigh15minAlert

PTX3000 Packet
Transport Routers

Generatedasanalarmwhen theOSCtransmitted
low power exceeds the threshold within the
15-minute interval for the IPLC.

jnxIplcOscTxPowerLow15minAlert

PTX3000 Packet
Transport Routers

Generated as an alarmwhen the OSC received
high power exceeds the threshold within the
15-minute interval for the IPLC.

jnxIplcOscRxPowerHigh15minAlert
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Device TypeDescriptionAlarm Name

PTX3000 Packet
Transport Routers

Generated as an alarmwhen the OSC received
low power exceeds the threshold within the
15-minute interval for the IPLC.

jnxIplcOscRxPowerLow15minAlert

PTX3000 Packet
Transport Routers

Generated as an alarmwhen the OSC fiber high
LOS exceeds the threshold within the 15-minute
interval for the IPLC.

jnxIplcOscFiberLosHigh15minAlert

PTX3000 Packet
Transport Routers

Generated as an alarmwhen the OSC fiber low
LOS exceeds the threshold within the 15-minute
interval for the IPLC.

jnxIplcOscFiberLosLow15minAlert

PTX3000 Packet
Transport Routers

Generated as the line-out Variable Optical
Attenuator (VOA) high threshold setting trigger
within the 15-minute period for the IPLC.

jnxIplcLineOutVoaHigh15minAlert

PTX3000 Packet
Transport Routers

Generated as the line-out Variable Optical
Attenuator (VOA) low threshold setting trigger
within the 15-minute period for the IPLC.

jnxIplcLineOutVoaLow15minAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA input power high
threshold setting trigger within the 15-minute
period for the IPLC.

jnxIplcIngressEdfaInputPwHigh15minAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA input power low
threshold setting trigger within the 15-minute
period for the IPLC.

jnxIplcIngressEdfaInputPwLow15minAlert

PTX3000 Packet
Transport Routers

Generated as the OCMmodule power high
threshold setting trigger within the 15-minute
period for the IPLC.

jnxIplcOcmPwHigh15minAlert

PTX3000 Packet
Transport Routers

Generated as the OCMmodule power low
threshold setting trigger within the 15-minute
period for the IPLC.

jnxIplcOcmPwLow15minAlert

PTX3000 Packet
Transport Routers

Generated as the OSC transmitted high power
threshold setting trigger within the 15-minute
period for the IPLC.

jnxIplcOscTxPowerHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the OSC transmitted high power
threshold setting trigger within the 15-minute
period for the IPLC.

jnxIplcOscTxPowerLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as an alarmwhen the OSC received
high power exceeds the threshold within the
24-hour interval for the IPLC.

jnxIplcOscRxPowerHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as an alarmwhen the OSC received
low power exceeds the threshold within the
24-hour interval for the IPLC.

jnxIplcOscRxPowerLow24hourAlert
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX3000 Packet
Transport Routers

Generated as an alarmwhen the OSC fiber high
LOS exceeds the threshold within the24-hour
interval for the IPLC.

jnxIplcOscFiberLosHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as an alarmwhen the OSC fiber low
LOS exceeds the threshold within the 24-hour
interval for the IPLC.

jnxIplcOscFiberLosLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the line-out Variable Optical
Attenuator (VOA) high threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcLineOutVoaHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the line-out Variable Optical
Attenuator (VOA) low threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcLineOutVoaLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA input high power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcIngressEdfaInputPwHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA input low power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcIngressEdfaInputPwLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA output high power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcIngressEdfaOutputPwHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA output low power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcIngressEdfaOutputPwLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA signal high power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcIngressEdfaSignalPwHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA signal low power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcIngressEdfaSignalPwLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA pump current high
temperature threshold setting trigger within the
24-hour period for the IPLC.

jnxIplcIngressEdfaPumpCurrentHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the ingress EDFA pump current low
temperature threshold setting trigger within the
24-hour period for the IPLC.

jnxIplcIngressEdfaPumpCurrentLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the egress EDFA input high power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcEgressEdfaInputPwHigh24hourAlert
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX3000 Packet
Transport Routers

Generated as the egress EDFA input low power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcEgressEdfaInputPwLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the egress EDFA output high power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcEgressEdfaOutputPwHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the egress EDFA output low power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcEgressEdfaOutputPwLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the egress EDFA signal high power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcEgressEdfaSignalPwHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the egress EDFA signal low power
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcEgressEdfaSignalPwLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the egress EDFA pump current high
temperature threshold setting trigger within the
24-hour period for the IPLC.

jnxIplcEgressEdfaPumpCurrentHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the egress EDFA pump current low
temperature threshold setting trigger within the
24-hour period for the IPLC.

jnxIplcEgressEdfaPumpCurrentLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the power monitor AWG add high
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcPowerMonitorAwgAddHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the power monitor AWG add low
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcPowerMonitorAwgAddLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the powermonitor express-inmode
high threshold setting trigger within the 24-hour
period for the IPLC.

jnxIplcPowerMonitorExpressInHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the powermonitor express-inmode
low threshold setting trigger within the 24-hour
period for the IPLC.

jnxIplcPowerMonitorExpressInLow24hourAlert

PTX3000 Packet
Transport Routers

Generated as the OCMmodule power high
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcOcmPwHigh24hourAlert

PTX3000 Packet
Transport Routers

Generated as the OCMmodule power low
threshold setting triggerwithin the24-hour period
for the IPLC.

jnxIplcOcmPwLow24hourAlert
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

PTX3000 Packet
Transport Routers

Generated as the FPC SFP loss of signal (LOS)
alarm for the IPLC.

jnxIplcFpcSfpLosAlarm

PTX3000 Packet
Transport Routers

Generated as the FPC SFP loss of frame (LOF)
alarm for the IPLC.

jnxIplcFpcSfpLofAlarm

L2ALD

ACX, M, MX, and
PTX Series routers

Generated when the MAC limit is reached for the
entire system. This trap is sent only once, when
the limit is reached.

L2aldGlobalMacLimitAlarm

ACX, M, MX, and
PTX Series routers

Generated when the given interface reaches the
MAC limit (jnxl2aldInterfaceMacLimit).

L2aldInterfaceMacLimitAlarm

ACX, M, MX, and
PTX Series routers

Generated when the MAC limit is reached for a
given routing instance (jnxl2aldRoutingInst).

L2aldRoutingInstMacLimitAlarm

L2CP

ACX, M, MX, and
PTX Series routers

Generated when LACP has timed out.LacpTimeOutAlarm

ACX, M, MX, and
PTX Series routers

Generated when the port’s BPDU error state
(no-error or detected) changes.

PortBpduErrorStatusChangeTrapAlarm

ACX, M, MX, and
PTX Series routers

Generated when the port’s loop-protect state
(no-error or loop-prevented) changes.

PortLoopProtectStateChangeTrapAlarm

ACX, M, MX, and
PTX Series routers

Generated when the port’s root-protect state
(no-error or root-prevented) changes.

PortRootProtectStateChangeTrapAlarm

MAC Forwarding Database (MACFDB)

ACX, M, MX, and
PTX Series routers

GeneratedwhenMACaddressesof themonitored
devices are learned or removed from the
forwarding database (FDB).

MacChangedNotificationAlarm

Misc.

Wireless LAN
controller

Generated when counter measures are started
against a rogue device.

Counter Measures Alarm

Wireless LAN
controller

Generated when the running configuration of the
switch is written to the configuration file.

Device Configuration Saved

Wireless LAN
controller

Generated when amultimedia call fails.Multimedia Call Failure
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

ACX, M, MX, and
PTX Series routers

Generated when Power over Ethernet (PoE) has
failed on the indicated port.

PoE failure

Network Service

ACX, M, MX, and
PTX Series routers

Generated when an LSP service is affected.LSP Service

ACX, M, MX, and
PTX Series routers

Generated when an E-LAN service is affected.VPN Service

Passive Monitoring (PassiveMonitoring)

ACX, M, MX, and
PTX Series routers

Generatedwhenanoverloadcondition isdetected
on a Passive Monitoring Interface.

PMonOverloadSetAlarm

Ping

ACX, M, MX, and
PTX Series routers

Generated when egress time jitter
(jnxPingMaxEgressUsminus
jnxPingResultsMinEgressUs) exceeds the
configured threshold
(jnxPingCtlEgressJitterThreshold) causing the
egressJitterThreshold bit to be set.

PingEgressJitterThresholdExceededAlarm

ACX, M, MX, and
PTX Series routers

Generated when the standard deviation of the
egress time (jnxPingResultsStddevEgressUs)
exceeds the configured threshold
(jnxPingCtlEgressTimeThreshold)andcauses the
egress bit to be set.

PingEgressStdDevThresholdExceededAlarm

ACX, M, MX, and
PTX Series routers

Generated when the egress time
(jnxPingResultsStdevEgressUs) exceeds the
configured threshold
(jnxPingCtlEgressTimeThreshold) and the egress
threshold bit is set in jnxPingCtlTrapGeneration.

PingEgressThresholdExceededAlarm

ACX, M, MX, and
PTX Series routers

Generated when ingress time jitter
(jnxPingResultsMaxIngressUsminus
jnxPingResultsMinIngressUs) exceeds the
configured threshold
(jnxPingCtlIngressJitterThreshold) and the
ingressJitterThreshold bit is set in
jnxPingCtlTrapGeneration.

PingIngressJitterThresholdExceededAlarm

ACX, M, MX, and
PTX Series routers

Generated when the standard deviation of the
ingress time (jnxPingResultsStdDevIngressUs)
exceeds the configured threshold
(jnxPingCtlIngressStddevThreshold) and the
ingress StdDevThreshold bit is set in
jnxPingCtlTrapGeneration.

PingIngressStddevThresholdExceededAlarm
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Table 18: Alarm Descriptions (continued)

Device TypeDescriptionAlarm Name

ACX, M, MX, and
PTX Series routers

Generated when the ingress time jitter
(jnxPingResultsIngressUs)exceeds theconfigured
threshold (jnxPingCtlIngressTimeThreshold) and
the ingress threshold bit
(jnxPingIngressThresholdExceeded) is set in
jnxPingCtlTrapGeneration.

PingIngressThresholdExceededAlarm

ACX, M, MX, and
PTX Series routers

Generated when the round trip time jitter
(jnxPingResultsMaxRttUs minus
jnxPingResultsMinRttUs) exceeds the configured
threshold (jnxPingCtlRttJitterThreshold) and the
rttJitterThreshold bit is set in
jnxPingCtlTrapGeneration.

PingRttJitterThresholdExceededAlarm

ACX, M, MX, and
PTX Series routers

Generated when the standard deviation of the
round trip time (jnxPingResultsStdDevRttUs)
exceeds the configured threshold
(jnxPingCtlRTTStdDev) and the
rttStdDevThreshold bit is set in
jnxPingCtlTrapGeneration.

PingRttStdDevThresholdExceededAlarm

ACX, M, MX, and
PTX Series routers

Generated when the round trip time
(jnxPingCtlRttThreshold) exceeds the configured
threshold (jnxPingCtlRttThreshold) and the
rttThresholdbit is set in jnxPingCtlTrapGeneration.

PingRttThresholdExceededAlarm

RMon

ACX, M, MX, and
PTX Series routers

Generated when a GET request for an alarm
variable returns an error. The specific error is
identified by a varbind in
jnxRmonAlarmGetFailReason.

RmonAlarmGetFailureAlarm

Changing the Severity of Individual Alarms

You can change the severity of the alarms to match your corporate procedures and

guidelines. For example, at your company a DoS attack might be considered a critical

alarm, while Connectivity Services Director has a default severity for DoS attacks as a

major alarm.Alarmsappear onboth tabs in the IndividualAlarmsandThresholdSettings

section: Alarm Settings and Threshold Settings.

To change the severity of an alarm:

1. Select the current severity in the Severity column. A list of the severity levels appear.

2. Select the new severity level for the alarm.

3. ClickOK and Yes to confirm the change to the severity setting.

151Copyright © 2019, Juniper Networks, Inc.

Chapter 4: Understanding Connectivity Services Director System Administration and Preferences



To configure alarm notifications, see “Configuring Individual Alarm Notifications” on

page 152.

Configuring Threshold Alarms

Threshold alarms are alarms that are generated when amonitored value crosses the

configured threshold.Theyprovideenhancedvisibility intopotential issueson thenetwork.

You configure andmanage threshold alarms the sameway as other alarms. You also

have the option of setting the threshold level of individual threshold alarms.

To set threshold alarm thresholds:

1. Select the Threshold Settings tab in the Individual Alarms and Threshold settings

section of the Fault tab.

2. Click Edit Settings in the Threshold Settings column of the alarm threshold you want

to edit.

3. Set the threshold in the window that opens.

4. Click Save to save the new threshold.

To configure alarm notifications, see “Configuring Individual Alarm Notifications” on

page 152.

Configuring Individual AlarmNotifications

You can configure e-mail notifications to be sent when an individual alarm is generated.

When you enable notification for an alarm, the notifications are sent to the e-mail

addresses configured for the alarm and the addresses configured for global alarm

notifications. Alarmsappear onboth tabs in the IndividualAlarmsandThresholdSettings

section: Alarm Settings and Threshold Settings.

To configure e-mail notification for an alarm name:

1. Select the check box in the alarm’s Notification column.

If you later want to disable notification for the alarm, clear the check box.

2. ClickEditNotification in theNotificationcolumn.TheAlarmNotificationDetailswindow

opens.

3. Enteroneormoree-mail addresses in theNotificationEmailAddresses field.Separate

addresses with a comma (,).

You can later edit the addresses to send notifications to different addresses.
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4. (Optional) Enter a comment in the Comments field. This comment is included in the

e-mail notification message.

5. Click Save.

Disabling Optical PerformanceMonitoring

From theOptical tab of the Preference page, you can disable optical performance

monitoring by selecting the Disable Optical PerformanceMonitoring check box.

Select theDisableOpticalPerformanceMonitoring check box, if youdonot intend to store

optical parameters.

Specifying NorthStar Controller Preferences

Starting fromRelease 3.0 onward, you can choose NorthStar Controller tomanage LSPs

fromtheConnectivityServicesDirectoruser interface.TheNorthStar tab in thePreferences

page displays the attributes listed in Table 19 on page 153.

Table 19: NorthStar Controller Preferences

DescriptionFields

Select this check box to manage LSPs through the NorthStar Controller server.Enable NorthStar LSPManagement

Select this check box to enable PCEP as the provisioning type for LSPs.PCEP for Provisioning

Select either RSVP or Segment Routing as the provisioning type.

Default: RSVP

Provisioning Type

Enter the NorthStar server IP, Username, and Password to validate your access to
the NorthStar server.

Credentials

See Also • Understanding Connectivity Services Director User Administration on page 26
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PART 3

Working with the Dashboard

• About the Dashboard on page 157

• Using the Dashboard on page 159

• DashboardWidget Reference on page 161
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CHAPTER 5

About the Dashboard

• Understanding the Dashboard on page 157

Understanding the Dashboard

When you log in to the Connectivity Services Director interface, the first page that is

displayed is the Dashboard page. Service Dashboard andMonitoring provide a proactive

account of the services and devices health status and working efficiency of devices in a

bird's eye, comprehensive, and intuitive format at the network level and service levels. A

single pane of glass (SPOG) view helps the operator to view various alarms and quickly

identify and isolate issues. The dashboard andmonitoring feature aggregates and

correlates data fromdifferent sources such as SNMPand systemevent logs. The defined

threshold values enable operators to specify monitoring criteria critical for service

operations and administration. The performancemanagement view also highlights the

topor first threenon-confirmingdevicesandprovidesahistorical contextwith timegraph

and additional data from the logging system. The Dashboard page contains several

monitors or frames.

The Dashboard is a customizeable page to view information about the network, and is

the default page that opens when you log in. You select monitoring widgets to display

on the Dashboard that show various information about the network. The Dashboard is

a view. To open a different view, select a view from the Views list in the Connectivity

Services Director banner.

Related
Documentation

• Using DashboardWidgets on page 159
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CHAPTER 6

Using the Dashboard

• Using DashboardWidgets on page 159

Using DashboardWidgets

The Dashboard is a customizeable page for viewing information about the network. You

select monitoring widgets to display on the Dashboard that show various information

about the network. The Dashboard is the default view that openswhen you log in.When

a different view is selected, select Dashboard View from the Select View list in the

Connectivity Services Director banner to open the Dashboard.

To select what appears on the Dashboard:

1. To add amonitor to the Dashboard:

a. Select AddWidgets. Thumbnails of the available widgets appear.

b. To add a widget to the Dashboard, mouse over the widget’s thumbnail, then click

the Add button that appears on the widgets.

c. When you are finished addingwidgets, clickDone. The newwidgets appear on the

Home page.

2. To refresh a widget’s data, click the Refresh button in its title bar.

3. To see additional information for a widget, click theMaximize button in the widget’s

title bar.

4. To remove a widget from the Dashboard, click the Close button (X) in its title bar.

5. To open online help for a widget, click the Help button (?) in its title bar.

6. Tomove a widget, click its title bar and drag it to the new location.

Related
Documentation

• Understanding the Dashboard on page 157
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CHAPTER 7

DashboardWidget Reference

• Device AlarmsWidget on page 161

• Service Alarms by Severity Widget on page 162

• Config Deployment Jobs StatusWidget on page 162

• Device & Port Utilization HeatmapWidget on page 163

• Port Status - Physical Widget on page 167

Device AlarmsWidget

The Device Alarms widget displays summary information about alarms generated for

the devices present in the network that is managed by Connectivity Services Director.

The summarized way in which you can view statistical details enables you to examine

thehealthandoperating-efficiencyofdevices, and theperformanceof services. It provides

a bird's eye, high-level view of parameters that enables effective and simplified

troubleshooting and administration. For example, if you find that a particular device has

recorded a large number of critical or major alarms, you can then navigate to the

Monitoring page or the appropriate device settings page to correct andmodify the

attributes or diagnose the problems that might be generating the alarms.

Critical, major, andminor alarms are displayed in a pie chart with percentage values of

each type of alarm. When youmove themouse over the segments of the pie chart, the

total number of alarms of each type are displayed. Mouse over each segment in the pie

chart to highlight and display the number of alarms for each severity level.

Alarm severity levels are:

• Critical (Red)—A critical condition exists; immediate action is necessary.

• Major (Orange)—Amajor error has occurred; escalate or notify as necessary.

• Minor (Yellow)—Aminor error has occurred; notify or monitor the condition.

• Info (Wedgewood Blue)—An informational message; no action is necessary.

Informational alarmsdonot necessarily indicate an error. It could indicate that a device

or entity has changed state.

Related
Documentation

Service Alarms by Severity Widget on page 162•

• Port Status - Physical Widget on page 167

161Copyright © 2019, Juniper Networks, Inc.



• Config Deployment Jobs StatusWidget on page 162

• Device & Port Utilization HeatmapWidget on page 163

Service Alarms by SeverityWidget

The Service Alarms by Severity widget displays comprehensive and cohesive details

about the alarms generated by different devices for which services, such as E-Line, IP,

LSPs, and E-LAN, are configured. You can view critical, salient information about the

configured devices and services in an intuitive, easily-navigable format. The summarized

way in which you can view statistical details enables you to examine the health and

operating-efficiency of devices, and the performance of services. These alarm details

enable effective and simplified troubleshooting and administration. For example, if you

find that a particular device has recorded a large number of critical or major alarms for

a service, youcan thennavigate to thedesignandprovisioningpagesof the typeof service

to correct andmodify the attributes or diagnose the problems that might be generating

the alarms.

Critical, major, andminor alarms are displayed in a pie chart with percentage values of

each type of alarm. When youmove themouse over the segments of the pie chart, the

total number of alarms of each type are displayed.

Alarm severity levels are:

• Critical (Red)—A critical condition exists; immediate action is necessary.

• Major (Orange)—Amajor error has occurred; escalate or notify as necessary.

• Minor (Yellow)—Aminor error has occurred; notify or monitor the condition.

• Info (Wedgewood Blue)—An informational message; no action is necessary.

Informational alarmsdonot necessarily indicate an error. It could indicate that a device

or entity has changed state.

Related
Documentation

Device & Port Utilization HeatmapWidget on page 163•

• Port Status - Physical Widget on page 167

• Device AlarmsWidget on page 161

• Config Deployment Jobs StatusWidget on page 162

Config Deployment Jobs StatusWidget

The Config Deployment Jobs Status widget provides summary and detailed information

about the status of configuration deployment jobs.

This topic describes:

• Config Deployment Jobs StatusWidget Summary on page 163

• Config Deployment Jobs StatusWidget Details on page 163
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Config Deployment Jobs StatusWidget Summary

The Config Deployment Jobs Status widget displays summary information about the

status of configuration deployment jobs. The information appears in a table. The vertical

axis lists the job statuses. The horizontal axis shows the timeswhen job status data was

collected. You can do the following tasks:

• Select a time period to view from the Deployment Trend list.

• Click the Refresh button to refresh the information displayed.

Config Deployment Jobs StatusWidget Details

To open the Config Deployment Jobs Status widget details page, click theMaximize

button in thewidget’s titlebar. TheConfigDeployment JobsStatuswidgetdetailswindow

displays detailed information about the status of configuration deployment jobs. The

page shows the same summary information table as the widget. It also shows a table

of detailed configuration job status information. To close the details page, click the

Minimize button in the title bar.

Related
Documentation

Device AlarmsWidget on page 161•

• Service Alarms by Severity Widget on page 162

• Port Status - Physical Widget on page 167

• Device & Port Utilization HeatmapWidget on page 163

Device & Port Utilization HeatmapWidget

The Device & Port Utilization Heatmap widget provides a graphical view of device port

utilization percentage. The heat map represents each device as a color-coded box. The

color coding indicates the overall level of port utilization on a device. Cooler colors (for

example, green) indicate lower port utilization , while hotter colors (for example, red)

indicate higher port utilization.

You can view the utilization level for each port on a device by clicking on the box

representing the device. A heatmap is displayed that represents each port on the device

as a color-coded box, with the color coding representing the level of port utilization.

• Using the Global Controls on page 164

• Interacting with the Heat Maps on page 164

• Viewing Active Flows on a Port on page 164

• Flow Analysis Details Window on page 165
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Using the Global Controls

Use the controls in the upper right corner tomake global changes to how the device and

port heat maps are displayed. You can:

• Select the time period over which device utilization and port utilization are shown.

• Display information about the devices or the ports in either graphical heat map or

tabular format by clicking either (graphical) or (tabular).

• Select how to organize the heat map by clicking the Settings icon ( ), and then

selecting an option from theGroupDevices By list. Each option creates a different view

of the heat map, with device boxes grouped according to your selection.

Interacting with the Heat Maps

You can interact with the device and port heat maps as follows:

• If you have grouped the devices by location, you can drill down into the heat map’s

hierarchybyclickingoneof thedevicecontainernames(for example, a siteorbuilding).

Tomove back up the hierarchy, click the navigation arrows above the heat map.

• Mouse over a device box to see detailed device-level port utilization information in a

pop-up window. In the pop-up window, you can click the View top 5 ports link to view

the top five ports that use the most bandwidth on the device.

• Click on a device box to display a heatmap of the ports on the device. In this port-level

heat map, each port is represented by a box that is color-coded to show its level of

utilization. To return to the device view, click the navigation arrows above the heat

map.

• Mouseover aport box todisplay informationabout theport—suchasport name, status,

speed, and percent utilization—in a pop-up window. For ports on devices that support

CloudAnalyticsEngine, youcanviewanyexisting flowanalysis resultson flows through

the port by clicking View active flows through this link. See “Viewing Active Flows on a

Port” on page 164 for more information.

• Slide the circular controls along the bar under the heat map to Filter the devices or

ports shown in the heat map by degree of port utilization..

Viewing Active Flows on a Port

For devices that support Cloud Analytics Engine, you can view the results of the most

recent flow analysis traces on application flows on the port by mousing over the port

and clicking View active flows through this link. The Current Active Flows window is

displayed.

The Current Active Flows window lists only application flows for which flow analysis

tracesexist—theremightbeotheractiveapplication flowson theport thatarenot shown.

Each flow is uniquely defined by source IP address and TCP/UDP port, destination IP

address and TCP/UDP port, and transport protocol. Table 20 on page 165 describes the

fields in this window.
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Table 20: Fields in the Current Active FlowsWindow

DescriptionField

Source IP address and source TCP/UDP port for the flow. In the case of a flow between two
VMS, the IP address is the source VTEP address.

If the port is associated with a well-known service, the service name is also shown.

Source IP
Source Port

Destination IP address and destination TCP/UDP port for the flow. In the case of a flow between
two VMS, the IP address is the destination VTEP address.

If the port is associated with a well-known service, the service name is also shown.

Destination IP
Destination Port

Either TCP or UDP.Protocol

Bandwidth used by the flow. This is a count of the number of packets through the port for the
flow up to this point in time.

For a value to be displayed in this field, flow analysis must have been performed on flowwith
the Capture Bandwidth option enabled.

Bandwidth

Click View Results to see the results of the most recent flow analysis trace. The Flow Analysis
Details window opens.

NOTE: The View Results link is not available for VM to VM flows.

Flow Analysis

Flow Analysis DetailsWindow

The Flow Analysis Details window provides detailed information about a flow trace.

The Flow Analysis Details window is divided into three sections:

• The flow path diagram—This diagram shows the path taken by a probe through the

network. By default, the path shown is the path taken by the probe that experienced

the highest per-hop latency in the trace. You can change this diagram to reflect the

path taken by a different probe by selecting the probe from the top Latency Trend

chart.

• Latency Trend charts—These charts show the change in latency experienced by the

probes during the trace. The bars in the top chart are grouped by completed probes,

with each bar in a probe group representing the latency experienced by the probe at a

hop. By clicking on a probe group, you can change the flow path diagram and the

Analysis Results section to reflect the results of that probe. For traces of long duration,

the bar chart shows only a portion of the trace results.

The bottom area chart graphs the highest latency experienced by each probe over the

entire duration of the trace. You can use the provided controls to focus on a portion of

the trace—the portion you choose is reflected in the top bar chart. By default, the focus

is on the portion of the trace that had the highest latency. If the trace is ongoing, a

rotating circle appears at the end of the plotted area and the chart is periodically

refreshed to show new results.
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Both charts display a path change icon ( ) when the path a probe takes through the

network differs from the path taken by the previous probe.

• Analysis Results—This section provides details about the overall trace results and

about the selected probe:

• The Latency table provides overall latency information for the trace: the highest and

lowest latency experienced at a single hop and the average latency of all hops.

• The Latency for Selected Path table shows the latency experienced by the selected

probe at each hop.

You can perform the following actions in the Flow Analysis Details window.

General actions:

• For bidirectional traces, you can select the direction for which you want results by

clicking one of the arrows at the top of the window (these arrows do not appear for

unidirectional traces).

• To stop an active flow analysis, click Stop Flow Analysis at the bottom of the window.

When you stop an active flow analysis, the results up to the time you stopped the flow

analysis are retained and the previously active trace is marked as complete.

On the flow path diagram, you can:

• Reposition the topology diagramby dragging it or reposition devices by dragging them.

• Zoom in or out by clicking the plus or minus signs on the left.

• Mouse over the link connecting two devices to get the connecting port names. The

names are displayed in green if the link is up and in red if the link is down.

• Mouse over a device to view details about the device, such as name, connection state,

and IP address. The details shown depends on the device type.

If a device in the flow path does not support Cloud Analytics Engine, it is shown in the

diagram in light grey color andminimal details, such as IP address, are available.

• Display the traffic statistics for switches by mousing over the device to display the

device details and clicking the Show Traffic Data link. If you selected the Capture

Bandwidth option when you started the flow analysis, the flow bandwidth is also

displayed along with the traffic statistics.

• Display the active flows associated with a VM, BMS, or virtualized host by mousing

over the device and clicking ShowActive Flows in the details box.

On the Latency Trend charts, you can:

• Mouse over a bar group in the top bar chart. A pop-up box displays the latency figures

for each hop taken by the probe.

• Click a bar group in the top bar chart. The flow path diagram and the Analysis Results

change to reflect the information for the probe.
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• Mouse over a path change icon in the top bar chart. Information about the old and new

paths is displayed.

• Change the span and position of the focus indicator on the bottom area chart:

• To increase or decrease the time span of the focus—in other words, to zoom in or

zoom out on a portion of the trace—click on one of the handle controls ( ) and

move it in either direction.

• To change the focus to another time period, click on the arrows at either end of the

slider bar.

Related
Documentation

Config Deployment Jobs StatusWidget on page 162•

• Device AlarmsWidget on page 161

• Service Alarms by Severity Widget on page 162

• Port Status - Physical Widget on page 167

Port Status - PhysicalWidget

The Port Status - Physical widget provides summary and detailed information about the

status of physical ports onmanaged devices.

This topic describes:

• Port Status - Physical Widget Summary on page 167

• Port Status - Physical Widget Details on page 167

Port Status - PhysicalWidget Summary

The Port Status - Physical widget displays summary information about the status of

physical ports onmanaged devices. It has the following pie charts:

• Admin Status pie chart—Shows the distribution of ports that are administratively up

or downand states the total number of ports.Mouse over a chart segment to seemore

information about it.

• Free vs.Usedpie chart—Shows thedistributionof ports that are freeor usedand states

the total number of ports. Mouse over a chart segment to seemore information about

it.

Port Status - PhysicalWidget Details

The Port Status - Physical widget details window has a table containing detailed

information about the status of physical ports onmanaged devices. See Port Status

Monitor for descriptions of the table columns.

Related
Documentation

• Config Deployment Jobs StatusWidget on page 162

• Device AlarmsWidget on page 161

167Copyright © 2019, Juniper Networks, Inc.

Chapter 7: DashboardWidget Reference



• Service Alarms by Severity Widget on page 162

• Device & Port Utilization HeatmapWidget on page 163
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PART 4

Working in Build Mode

• About Build Mode on page 171

• Discovering Devices on page 179

• Creating Custom Device Groups on page 185

• Configuring Quick Templates on page 191

• Configuring Device Settings on page 199

• Configuring Class of Service (CoS) on page 217

• Configuring Link Aggregation Groups (LAGs) on page 243

• Managing Network Devices on page 249
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CHAPTER 8

About Build Mode

• Understanding Build Mode in Views Other than Service View of Connectivity Services

Director on page 171

• Understanding theBuildModeTasksPane inViewsOther thanServiceViewonpage 174

Understanding Build Mode in Views Other than Service View of Connectivity Services
Director

In Build mode, you build the network managed by Junos Space Connectivity Services

Director. It provides you with the ability to use device discovery to bring devices under

Connectivity Services Director management, to customize your view of the devices, to

configure devices, and to perform some common device management tasks.

This topic describes:

• Discovering Devices on page 171

• Building the Custom View on page 172

• Configuring Devices on page 172

• Managing Devices on page 174

Discovering Devices

Devicediscovery finds your networkdevices andbrings themunderConnectivity Services

Director management. You provide Connectivity Services Director with identifying

information about the devices you want Connectivity Services Director to manage—an

IPaddressor hostname, an IPaddress range, an IP subnetwork, or aCSV file that contains

this information. Connectivity ServicesDirector uses the information toprobe thedevices

by using either ping or SNMP get requests. If a device probe is successful, Connectivity

Services Director then attempts tomake anSSH connection to the device using the login

credentials you supply. If the connection is successful and the device is a supported

device,ConnectivityServicesDirector adds thedevice to itsdatabaseofmanageddevices.

Connectivity Services Director uses Juniper Network’s Device Management Interface

(DMI), which is an extension to theNETCONFnetwork configuration protocol, to connect

to and configure its managed devices.

You can also discover devices using the device discovery feature provided by the Junos

Space Network Management Platform. Devices you discover using Junos Space device
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discovery are brought under Connectivity Services Director management if they are

supported by Connectivity Services Director.

Besides bringing your devices under Connectivity Services Director management, device

discovery:

• Reads thedevice configuration and saves it in the JunosSpace configurationdatabase.

Connectivity ServicesDirector uses this recordof thedevice configuration todetermine

what configuration commands it needs to send to a device when you deploy the

configuration on the device. For this reason, it is important for the Junos Space

configuration record to match, or be in sync with, the device configuration. For more

information about how the Junos Space configuration record and device configuration

are kept in sync, see “Understanding Resynchronization of Device Configuration” on

page 733.

• Imports thedeviceconfiguration into theBuildmodeconfiguration. Formore information

about importing device configurations, see “Importing Device Configurations” on

page 173.

Building the CustomView

When a device is discovered in the physical network mode, it is added to the network

tree in the View pane.

The Custom Group View displays only the top level—My Network—until you create one

or more custom groups. Custom group is another way of grouping your devices based

on your business needs. You can create custom groups and add devices to each custom

group. You canmanually add devices to a custom group or you can define rules to add

devices, that match the rule condition, to the custom group once they are discovered by

Connectivity Services Director. You can view the custom groups and devices that are

assigned to each group in the Custom Group view.

NOTE: This section does not apply to virtual devices that Connectivity
Services Director manages.

Configuring Devices

In Build mode, you can define the configuration of network devices in your Physical

network. To support rapid, large-scale deployment of devices, you can define much of

your Build mode configuration in a set of profiles. You can reference profiles in other

profiles or apply them tomultiple objects in your network—devices, ports, radios, logical

entities. For example, youcancreateaclass-of-service (CoS)profile that contains settings

that are appropriate for E-Line, IP, and E-LAN services that you canmanage, provision,

andmonitor in Service View of Connectivity Services Director.

In addition to creating configuration profiles, in Build mode you can configure Link

Aggregation Groups (LAGs) on routers.

Copyright © 2019, Juniper Networks, Inc.172

Connectivity Services Director User Guide



Deploying Device Configurations

After you build your device configurations in Build mode, you need to deploy the

configurations on the devices. None of the configurations you create in Buildmode affect

your devices until the configurations are actually deployed on the devices.

To deploy the configuration on devices, use Deploy mode. When you change a device’s

configuration in Build mode, the device becomes available in Deploy mode for

configuration deployment.

Importing Device Configurations

As part of device discovery, Connectivity Services Director analyzes the configuration of

a newly discovered device and automatically imports the configuration into the Build

mode configuration for that device.

As it imports the device configuration, Connectivity Services Director automatically

createsprofiles tomatch theconfiguration. It first determineswhetheranyexistingprofiles

match the configuration, and if so, assigns those profiles to the device. It then creates

and assigns new profiles as needed. For example, if an access switch has some ports

that match the configuration of an existing Port profile, Connectivity Services Director

assigns the existing Port profile to those ports. For the other ports, Connectivity Services

Director creates as many Port profiles as needed to match the port configurations and

assigns them to the ports.

You canmanage the profiles that Connectivity Services Director creates as part of device

discovery in the sameway that youmanageuser-createdprofiles—that is, youcanmodify,

delete, or assign them to other devices.

Out-of-Band Configuration Changes

Out-of-band configuration changes are configuration changesmade to a device outside

of Connectivity Services Director. Examples include changes made by:

• Using the device CLI.

• Using the deviceWeb-basedmanagement interface (the J-Web interface or Web

View).

• Using the Junos Space Network Management Platform configuration editor.

• Using RingMaster software.

• Restoring or replacing device configuration files.

When an out-of-band change is made, the device configuration no longer matches the

Buildmode configuration, and the device configuration state changes to out of sync. You

cannot deploy configurationonadevice that is out of sync.Use theResynchronizeDevice

Configuration task in Deploy mode to resynchronize the device configuration. For more

informationabouthowConnectivityServicesDirector resolvesout-of-bandconfiguration

changes and synchronizes the Build mode configuration with the device configuration,

see “Understanding Resynchronization of Device Configuration” on page 733.
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TIP: Before youmake configuration changes in Build mode, make sure that
devices that will be affected are in sync. Resynchronizing the device
configuration can result in losing pending Buildmode configuration changes
for that device.

Managing Devices

In addition to the tasks that allow you to build your network, Build mode provides a

number of tasks for day-to-day device management. For example, you can:

• View a device’s hardware component inventory or its installed licenses

• Reboot a device or groups of devices

• Connect to a device’s CLI through SSH or to its web-basedmanagement interface

• View the profiles assigned to a device

Related
Documentation

Understanding theBuildModeTasksPane inViewsOther thanServiceViewonpage 174•

Understanding the Build Mode Tasks Pane in Views Other than Service View

The Tasks pane in Build mode contains all the tasks you can do in Build mode. Click a

specific task to begin that task.

The tasks listed in the Tasks pane depend on the scope you select in theViewpane—that

is, what view (Device or Custom Group) you have selected and what object you have

selected. Not all tasks are available in all scopes. As you change your selections in the

View pane, the contents of the Tasks pane also change.

Build mode tasks are divided into the following categories in the Tasks pane.

Connectivity Services Director enables you to perform the following tasks for devices in

your physical network:

• Device Discovery—Before your devices can bemanaged by Connectivity Services

Director, you must use device discovery to discover them. As Connectivity Services

Director discovers devices, it adds them to your network view in the View pane.

Table 21 on page 175 describes the device discovery tasks.

• DeviceManagement—After devices have been discovered, you can perform

administrative taskson them, suchasviewinga list of thedevice’sphysical components,

connecting to adevice usingSSH, or rebooting adevice. Table 22onpage 175describes

the device management tasks.

• Wired—You can create configuration profiles and quick templates for the different

wired devices—ACXSeries routers, M Series routers, MX Series routers, and PTXSeries

routers.
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• Profile and ConfigurationManagement—Connectivity Services Director provides a set

of configuration profiles that you can create to provision multiple devices in your

network. Table 24 on page 176 describes the profile and configuration management

tasks.

• Key Tasks—Connectivity Services Director enables you to group the tasks that you

perform frequently and create a list of key tasks. You can add any task from the Tasks

pane to theKeyTasks list by selecting a task and clicking the plus (+) sign that appears

adjacent to the task. For somemodes, you can see that Connectivity Services Director

has predefined some key tasks for you. You canmodify this set of tasks to suit your

requirements. This feature is available in Task pane irrespective of your current mode,

scope, or view.

Formore informationaboutBuildmode features, see “UnderstandingBuildMode inViews

Other than Service View of Connectivity Services Director” on page 171.

Table 21 onpage 175 throughTable24onpage 176describe the tasks that youcanperform

in the physical network category, including the scope in the View pane that youmust

select to access the task.

Table 21: Device Discovery Tasks

ScopeDescriptionTask

AnyDiscovers supported routers in the network and brings them under
Connectivity Services Director management.

Discover Devices

AnyDisplays the status of device discovery jobs.View Discovery Status

Table 22: Device Management Tasks

ScopeDescriptionTask

View: All
Object: All

Deletes a device as amanaged device from Connectivity
Services Director. If you select a scope that contains more
than one router, you can choose which devices are deleted.

Delete Devices

View: All
Object: Individual device

Launches theWeb-basedmanagement interface for the
selected device in a separate window: the J-Web interface
for routers.

LaunchWeb View

View: All
Object: Individual router

Creates andmanages Link Aggregation Groups (LAGs).Manage LAG

View: All
Object: All

Reboots devices. If you select a scope that contains more
than one router, you can choose which devices get deleted.

Reboot Devices

View: All
Object: Individual device

Shows the running configuration on a device.Show Current
Configuration

View: All
Object: Individual device

Launches an SSH connection to the selected device.SSH to Device
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Table 22: Device Management Tasks (continued)

ScopeDescriptionTask

View: All
Object: All

Displays information about all the devices in the currently
selected object and all its child objects.

View Inventory

View: All
Object: Individual device

View the licenses installed on the device and their status.View License Information

View: All
Object: Individual device

Displays information about the selected device’s hardware
components.

View Physical Inventory

Table 23: Connectivity Tasks

ScopeDescriptionTask

View: Device
Object: Individual device

Displays the connection details of a device with its neighbors in
graphical and grid views. If the selected device is connected tomore
than 60 devices, then the connection details are displayed only in
grid view.

View Device
Connectivity

Table 24: Profile and Configuration Management Tasks

ScopeDevice FamilyDescriptionTask

All,
except
wireless
devices

ACX Series

M Series

MX Series

PTX Series

Enables you to create andmanage quick templates. Quick
templates enable you to define your network configuration in the
form of templates that you can apply to multiple devices in your
network.

Manage Quick
Templates

All,
except
wireless
devices

ACX Series

M Series

MX Series

PTX Series

Enables you to view the list of quick templates that are deployed.View Deployed
Templates

AnyACX Series

M Series

MX Series

PTX Series

Creates andmanages CoSprofiles. Use CoSprofiles to configure
class-of-service (CoS) attributes to be applied to interfaces or
to user traffic.

CoS

AnyACX Series

M Series

MX Series

PTX Series

Creates andmanages Device Common Settings profiles. Use
Device Common Settings profiles to configure basic system
settings, such as users, time and time servers, SNMP, system
logging, and so on.

Device Common
Settings
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Related
Documentation

• Understanding Build Mode in Views Other than Service View of Connectivity Services

Director on page 171
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CHAPTER 9

Discovering Devices

• Discovering Devices on page 179

• Troubleshooting Device Discovery Error Messages on page 181

• Viewing the Brownfield Job on page 182

Discovering Devices

When you start Connectivity ServicesDirector for the first time, the systemdoes not have

any devices. The first step is to build your network. Evenwith large networks, Connectivity

Services Director has made this step relatively easy and straightforward. You will add

devices to Connectivity Services Director and the database by using a process called

device discovery. Once a device is discovered, it shows in the interface and Connectivity

Services Director begins to monitor the device.

Connectivity Services Director provides a wizard for device discovery. The following

example shows the path for device discovery through the wizard. For an alternate path,

you can get a step-by-step instruction from the help system.

In this example, we provide an IP address range, and Connectivity Services Director

populates the database with all supported devices within that range.

1. While in the Buildmode, select Location View, Device View, or CustomGroup View

from the View selector.

2. To discover physical devices, click Discover Devices in the Tasks pane. Eachmode has

a Tasks Pane that displays the actions you can take while in that mode and that

particular network view.

3. (Optional) Type a name for the discovery job. The default name is ND Discovery.

4. Click Add in the Device Targets window. You can add a single device IP address, a

range of IP addresses, an IP subnet, or a hostname. In this example, we select an IP

address range.
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5. Provide the initial or the lowest IP address value and the ending or highest IP address

value for the range and click Add. You can have up to 1024 devices in a range. After

you click Add, the address range is listed in the Device Targets window.

6. Click Next or click Discovery Options to proceed to specify the device credentials and

method of discovery.

7. Click Add in the Device Credentials window and enter the username and password

assigned for administrative access.

8. Select Ping , SNMP, or both as the method of device discovery. Selecting both is the

preferred method if the device is configured for SNMP.

If you select SNMP, the Add SNMP Settings dialog box is displayed. In this example,

because we run SNMP version 2, we need to provide the community string. Click Add

to save the setting.

NOTE: You cannot choose amethod for device discovery for virtual
Connectivity Services Discovery.

9. ClickNext or ScheduleOptions to proceed to schedule the timewhen discovery is run.

NOTE: Scheduling options are not available for virtual Connectivity
Services Discovery.

10. Indicate whether to run the device discovery now or set up a schedule to minimize

network traffic. In this example, we set the schedule to run during off hours.

11. Click Review to review the settings before you exit the wizard.

12. Click Finish to complete the discovery setup and to save the settings.

13. Click View Discovery Status to view all scheduled and completed jobs. After a job

completes, you can click ShowDetails to view further information on any unexpected

results.
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Troubleshooting Device Discovery Error Messages

While you are discovering devices by using Connectivity Services Director, you might

encounter some issues. Connectivity Services Director enables you to detect the errors

and provide solutions to the potential errors that you encounter.

SolutionError Message

Error Messages Displayed During Discovery of Routers

For routers, Connectivity Services Director
connects to port 22 (default port) on the
JA2500 Appliance or the Junos Space Virtual
Appliance by using SSH. Ensure that you have
configured port 22 on the Space appliance
through Administration > Applications in the
Junos Space Plattform page. To do this, select
Network Application Platform and click Actions
>ModifyApplicationSettings. ChangeSSHport
for device connection field to 22.

If port 22 isopenon the JunosSpaceAppliance,
and you still get the error, then check if port 22
is open on the switch and if the switch is
accepting SSH connections on port 22.

SSH connection failed. Devicemight not be reachable.

Check the read and write credentials used
during device discovery.

User Authentication failed.

If ping is enabled during device discovery, then
check whether the switch is reachable using
the CLI command ping.

Device is not reachable.

If the SNMP option is enabled in Connectivity
ServicesDirector duringdevicediscovery, check
andensure thatSNMP isenabledon theswitch.
Also, check and ensure that the SNMP settings
on Connectivity Services Director and Junos
Spacematch with the SNMP settings on the
switch.

Junos Space is unable to query the device information throughSNMP. Check the
SNMPsettingsonthedevice toverifySNMPisnotblockedandtheSNMPsettings
specified in Junos Spacematch the device SNMP settings.

General Error Messages

This message is displayed if the switch is too
busy to respond to operational commands. Try
discovering the device again.

Device Failed to return System information.

Check whether the Edit lock is open on the
switch and close it if it is open. The
configuration commit fails if the Edit lock is
open.

Failed to configure device, Check Device state.
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SolutionError Message

Try to resynchronize the devices manually. For
details, see “Resynchronizing Device
Configuration” on page 738.

Device has been added, but failed to synchronize. Please trymanual
re-synchronization. Error while reading config from device: device_name, Detail
- Fail while executing following RPC: <get-configuration
database=committed><configuration></configuration></get-configuration>

Check the hardware details of the switch using
theCLI command showchassishardwaredetail.

If the output displays a message error:
command is not valid, then the JunosOS image
on the specified switch is corrupted and you
need to upgrade to the latest version of Junos
OS.

Error while reading config from device: device-name Failed while executing the
following RPC: <get-hardware-inventory/>

Related
Documentation

Viewing the Brownfield Job on page 182•

• Discovering Devices in a Physical Network

Viewing the Brownfield Job

Starting in Release 2.1R1, Connectivity Services Director initiates the brownfield job

immediately after the device discovery. The Brownfield Job window displays the job and

the device details. To open the Brownfield Job window double-click the brownfield job

name in the Job Management table. The following table describes the information

provided in the Brownfield Job page:

Table 25: Brownfield Job Page Fields

DescriptionTable Column

Job name (user-created)Job Name

Job’s actual start timeJob Start Time

Time when the job endedJob End Time

Percentage of the job that is completePercentage Completed

Job status. The possible states are:

• CANCELLED—The job was cancelled by a user.

• FAILURE—The job failed. This state is applied if any of the devices in the job failed. But some of
the devices might have completed successfully. View the job details for the status of each
device.

• INPROGRESS—The job is running.

• SCHEDULED—The job is scheduled but has not run yet.

• SUCCESS—The job completed successfully. This state is applied if all of the devices in the job
completed successfully.

Job Status

Copyright © 2019, Juniper Networks, Inc.182

Connectivity Services Director User Guide



Table 25: Brownfield Job Page Fields (continued)

DescriptionTable Column

The devices section lists device details such as device name, IP address of the device, job status
of the device, job start and end times and the summary of the brownfield job. For a successful job,
the summary column displays the message “Brownfield is Successful”. For a job that is skipped,
the summary column lists the error or warning message along with a View link. Double-click on
the View link to open the Brownfield Errors page, which displays the device profile name along
with the error associated with that device.

Devices

Release History Table DescriptionRelease

Starting in Release 2.1R1, Connectivity Services Director initiates the
brownfield job immediately after the device discovery.

2.1R1

Related
Documentation

• Troubleshooting Device Discovery Error Messages on page 181

• Discovering Devices in a Physical Network
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CHAPTER 10

Creating Custom Device Groups

• Understanding Custom Device Groups on page 185

• Creating Custom Device Groups on page 186

Understanding CustomDevice Groups

Custom group is way of grouping your devices based on your business needs. You can

create custom groups and add devices to each custom group. You canmanually add

devices to a custom group or you can define rules to add devices, that match the rule

condition, to thecustomgrouponce theyarediscoveredbyConnectivityServicesDirector.

You can view the custom groups and devices that are assigned to each group in the

Custom Group view.

A customgroup can include devices such as different routing platforms. Creating custom

device groups enables the configuration of multiple devices simultaneously—you can

create multiple custom groups and directly associate devices at any level. Up to this

point, Custom Groups are the same as selecting related items in the view tree. What

makes Custom Groups unique is that you can also configure a custom group to

automatically add devices after discovery. You indicate the criteria for additional devices

by editing rules. Customgroups can then be created in a hierarchy up to eight levels deep.

Each layer can contain up to 32 peer containers under a single parent container.

• Where Is the Custom Group Function Located in Connectivity Services

Director? on page 185

• How Do Custom Group RulesWork? on page 186

• What HappensWhen I Edit a Custom Group Rule? on page 186

• When Are Rules Executed? on page 186

Where Is the CustomGroup Function Located in Connectivity Services Director?

Connectivity ServicesDirector has different views that you select to see different aspects

of your data. You select one of these views at a time from the Select View option in the

Connectivity Services Director banner. The options are Device View, CustomGroup View,

and Topology View. To create a Custom Group, Connectivity Services Director must be

in Custom Group View. Custom Groups are created at the top level of the network—My

Network.
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Once Custom Groups are created, they appear in all views as options for profile

assignment—assigning a profile to a Custom Group assigns that profile to all members

of the group.

HowDo CustomGroup RulesWork?

Adding rules to a Custom group consists of creating a three part rule statement, with a

rule basis, an operator, andmatching criteria. Possible combinations are shown in

Table 26 on page 186.

Table 26: Three Options of a Rule Statement

Matching CriteriaOperatorRule Basis

RouterEquals or Not EqualsDevice Type

You provide serial numbers or lettersEquals or ContainsSerial Number

You provide model numbers or lettersEquals or ContainsSKU or Model

You provide IP addressEquals or RegexManagement IP Address

RouterEquals or Not EqualsDevice Type

You provide a full or partial firmware version for
devices

Equals or ContainsFirmware Version

What HappensWhen I Edit a CustomGroup Rule?

When you edit a rule, devices thatwere added to the group but no longer qualify because

of the rule edit are not automatically removed from the group. Youmust remove those

devices manually. If more devices are now qualified to join the group because of your

rule edit, the devices are added to the group on the next device notification change to

the network.

When Are Rules Executed?

The option Associate devices based on the rules for the custom groupswhile saving group

information is enabledbydefault. If theoption is disabled, the rule enginewill beactivated

only when there is some change in the device property. When a device property change

occurs, rules are processed and devices are added to the group, if the group has a rule

for those actions.

Related
Documentation

Creating Custom Device Groups on page 186•

Creating CustomDevice Groups

From Connectivity Services Director, you can create a custom group, then add devices,

such as routers, to the group. Creating custom device groups enables the configuration

of multiple devices simultaneously—you can also create multiple custom groups and
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directly associate devices at any level. What makes Custom Groups unique is that you

can also configure a custom group to automatically add devices after discovery. You

indicate the criteria for additional deviceswith rules. Custom groups can then be created

in a hierarchy up to eight levels deep. Each layer can contain up to 32 peer containers

under a single parent container.

NOTE: A device can be part of a group at only one level in a hierarchy.

This topic describes:

• Creating Custom Groups on page 187

• Creating a Custom Group on page 187

Creating CustomGroups

To create custom groups:

1. In the top banner, under Views, select CustomGroup View.

2. Click the Build icon in the Connectivity Services Director banner.

3. Click Set Up CustomGroup under Key Tasks in the Tasks pane.

TheSetUpCustomGrouppageopens,displayinga listof currently configuredCustom

Groups.

4. Configure the custom group, following the directions “Creating a Custom Group” on

page 187.

5. Click Done.

The new custom group appears in the Groups List.

Creating a CustomGroup

Use the Set Up Custom Group page to define a group of devices that you can configure

simultaneously.

To add a new custom group:

1. Type a Custom Group Name for the new group and then click Add.

The Custom Group tree is displayed with your new group added.

2. ClickDonenowtocreate thegroupwithnochildgroups, devices, or rules. TheMessage

Data Saved Successfully is displayed. ClickOK.

For additional configuration, select your new group.
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The options Add Child Group, Assign Devices, and Add/Edit Rule appear.

3. To add a child group under the new custom group:

a. Be sure the correct custom group is selected—this group will become the parent

group.

b. Click Add Child Group.

The Add Child Group window opens, displaying a default child group name such

as Group-0.

c. Replace the default child group name.

d. Click Add.

The new child group appears in the CustomGroup list tree under the parent group.

TIP: Custom groups can be created in a hierarchy up to eight levels deep.
Each layer can contain up to 32 peer containers under a single parent
container.

4. To assign devices to a custom group:

a. Select a customgroup, either a parent or child group, and then clickAssignDevices.

TheAssignDevicesToCustomGroupwindowopens, displaying a list of discovered

network devices, their IP addresses, and their platforms. Platforms include

junos-acx, junos-m, junos-mx, and junos-ptx. These are devices that canbe added

to the group.

b. Select one or more devices by adding a check mark and then click Add.

The devices are listed under the appropriate group in the Custom Groups List.

NOTE: A device can be part of a group at only one level in a hierarchy.

5. To add a rule that will automatically add devices to a parent or child custom group:

a. Select a custom group, either a parent or child group, that will have devices added

to it automatically when a specific rule has beenmet.

b. Click Add/Edit Rule(s).

The Add/Edit Rules window opens.
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c. Click Add Rule.

A rule statement is displayedwith three columns—two columns display thewords

Please select.... The third column is blank.

d. From the first Please select... option in the rule statement, select the basis for the

rule. You are indicating that automatic additions to the list will be based on either

Device Type, Firmware Version, Serial Number, SKU/Model,Management IP.

e. From the second Please select... option in the rule statement, select an available

operator, eitherEquals,NotEquals ,Like,Regex, orContains—theoperatorspresented

depend on the basis you selected in the first column. For example, if the basis for

the rule is SKU/Model, then the only operator options are Equals and Not Equals.

TIP: The Equals operationmatches all characters of thematching

criteria. The Like operationmatches the first few characters of the

matching criteria.

f. For the third option in the rule statement, provide amatching criteria. Matching

criteria are indicated in the third column of the list shown in Table 27 on page 189.

TIP: Some rules have no third option.

Table 27: Three Options of a Rule Statement

Matching CriteriaOperatorRule Basis

RouterEquals or Not EqualsDevice Type

You provide serial numbers or lettersEquals or ContainsSerial Number

You provide model numbers or lettersEquals or ContainsSKU or Model

You provide IP address or regular expression

TIP: For example, (?<=\.) {2,}(?=[A-Z]) is a
regular expression.

Equals or Regex

TIP: Regex, a regular expression, consists
of a sequence of characters that forms a
search pattern.

Management IP

You provide a full or partial firmware version for
devices.

Equals or ContainsFirmware Version

g. ClickOK.

Rules are executed when new devices are discovered. Devices that match the

defined rules are added to the group dynamically once discovery is complete.
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TIP: If you addmore than one rule to a CustomGroup, then all rulesmust
bemet for a device to join the group.

6. The option Associate devices based on the rules for the custom groups while saving

group information is enabled by default. When a device property change occurs, rules

are processed and devices are added to the group, if the group has a rule for those

actions. If you disable the option, the rule engine will be activated only when there is

some change in the device property.

7. Click Done.

A status window opens with either the message Data saved successfully or with an

error message. ClickOK.

8. Toedit a rule, select theappropriate customgroupand thenclickAdd/EditRule.When

you edit a rule, devices in the group that no longer qualify because of the rule change

are not automatically removed from the group. Youmust remove those devices

manually. Ifmore devices are nowqualified to join the group because of your rule edit,

the devices are added to the group on the next device notification change to the

network.

TIP: Todeleteadevice fromthegroup, select thedeviceand thenclickDelete.

To delete an entire CustomGroup, select the group and then click Delete.

You are asked to confirm the deletion—clickOK.

See Also • Understanding Custom Device Groups on page 185
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CHAPTER 11

Configuring Quick Templates

• Understanding Quick Templates on page 191

• Configuring and Managing Quick Templates on page 192

Understanding Quick Templates

Quick templates is a way to create a base build for the devices. This feature enables you

to use a CLI-based text editor to define your network configuration in the form of a

template that you can apply tomultiple devices in your network in addition to the profile

assignment feature. Becausequick templatesaredrivenbyDeviceManagement Interface

(DMI) schema, youcanuse themtosetall theconfigurationparameters for anysupported

device.

Quick templatesmakes network configuration easier by providing aCLI-based text editor

in which you can specify network configuration in a text file in the form of a template.

You can apply this template to multiple devices in the network. For example, you can

use quick templates to configure routing protocols such as BGP, OSPF, ISIS, or static

routes by specifying the device configuration.

You can append or add the system commands or the user-defined commands in the

form of the variables. The user-defined commands support variables in the format

$(variable_name), which must be populated with data when you apply a template to a

device.

The variable name defined for each CLI must be unique. Otherwise, you cannot assign

different values to thosevariableseven though theyareused indifferentCLIs. For example,

if a variable say $(description) is used in two CLIs set vlans $(name) description

$(description) and set snmp description $(description), you will not be able to define

different values to the descriptions. To define different values, youmust change the

variable name for one of the commands.

TheTable28onpage 191 showsdata types supported for thevaluesentered for variables.

Table 28: Variable Data Types

DescriptionData Type

Holds other data types.Container
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Table 28: Variable Data Types (continued)

DescriptionData Type

Contains character strings.String

Specifies a numeric value without a fractional component.Integer [Number]

Has two possible values: true and false. True if checked and False if unchecked.Boolean

Defines a variable to be a set of predefined constants. The variable is equal to one of
the values that have been predefined for it.

Enumeration

Provides a radio button. Check the radio button to use the configuration option in the
template.

Choice

Identifies the uniqueness of the record in the table. If the table has a key specified , only
one record with the given key could exist.

String - Key [column in a table]

TheSaveoption in theCreateQuickTemplatespageenables you to saveandalsovalidate

a template. If there are any conflicts in the configuration, youmust resolve the conflicting

variables in the configuration elements manually, before you deploy the configuration

to the devices. Upon successful validation (and after you apply a template to a device),

you can deploy the configurations (specified in the templates) to the devices. You can

choose to deploy the configuration immediately, or at a later time. Depending upon the

approvalmode selected for your deployment, you can either deploy the changes directly

or you can get an approval from the approver before deploying the changes. For more

information about types of approval modes supported for deployments in Connectivity

Services Director, see “Setting Up User and System Preferences” on page 121.

Related
Documentation

Configuring and Managing Quick Templates on page 192•

Configuring andManaging Quick Templates

You can create andmanage custom templates for your device configurations that are

deployable through Connectivity Services Director. Unlike other features that support

implementation of only some of the device configurations, quick templates enables you

to set up all the configuration parameters for any supported device because it is Device

Management Interface (DMI) schema-driven.

Each device type is described by a unique datamodel that contains all the configuration

data for that device. The Schemawindow shows the device family that you select while

you create a template and theDMI schema that lists all the possible fields and attributes

for a type of device. The latest schema describe the new features associatedwith recent

device releases. After you create a quick template, you can add or delete device

configuration details to and fromquick templates by loading the configuration data from

the schema. You need to apply these templates to devices manually.
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If you click theMore tips link you are guided on the variable and the command syntax

usages. It also provides instructions on how to issue sub-commands.Whendefining your

network configuration in quick templates by using a particular command, ensure that

youdefine thesub-commands individually.Statingsub-commandsasasinglecommand

causes errors. For example, the commands set snmp location xyz and set snmp contact

admin@example.com are valid when defined individually. However, if you combine these

commands into the single command set snmp location xyz contact admin@example.com

schema validation treats the end command, contact, as an extra entry and displays an

error.

To avoid any conflicts with the profile configurations while creating the template, a

warning message Please don’t create any Profile conflict configuration is displayed to

indicate that youmust not create a configuration as part of the template if the same

configuration is available as part of the profile configuration.

The Templates page in the Quick Templates workspace lists the device templates

created, in a tabular view. The Table 29 on page 193 lists the columns in the table along

with a description:

Table 29: Quick Templates

DescriptionColumn

Date and time when the template was created.Creation Time

Name of the quick template.Template Name

Name of the device family for which the template is created.

Selecting the option Common indicates that the template is applicable for all the
device families.

Device Family

Junos OS version of the device family selected.OS Version

Description of the quick template.Description

Date and time when the template was last modified.Last Updated Time

User name of the person who created the template.Last Updated By

This topic describes:

• Creating a Quick Template on page 194

• Applying Templates to Devices on page 195

• Editing a Quick Template on page 196

• Deleting a Quick Template on page 196

• Cloning a Quick Template on page 196

• Using the Quick Template Details Window on page 196

• Viewing Deployed Quick Templates on page 197
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Creating a Quick Template

Quick templates enable you create a template to define configurations for your devices.

You can create and deploy quick templates from theWired workspace.

To create a quick template:

1. Click the Build icon in the Connectivity Services Director banner.

2. SelectWired > Tasks >Manage Quick Templates in the Tasks pane.

The Manage Quick Template page appears.

3. Click Create.

The Create Quick Template page opens.

4. Specify the following details:

• Name—Type a name for the quick template. The quick template name is required.

The quick template namemust be unique and limited to 63 characters.

• Description—Type a description for the quick template. The description is optional

and limited to 255 characters.

• Device Family—From the Device Family list, select an appropriate device family.

Selecting the option Common in device family creates a generic template, which

can be applied to any device family. Therefore, specify only the most common

settings such as system, SNMP, or track group settings that are applicable to all

theplatforms. If youwant todefine the settings that are specific to aplatformselect

the appropriate platform from the device family instead of the Common option.

For the list of device families supported by Connectivity Services Director, see the

latest Connectivity Services Director Release Notes.

NOTE: ACXSeries routersare listedwhenyouselect theCommonoption

from the Device Family list on the Create Quick Template page. If you
select the option asMX from the Device Family list, only MX Series

routers are displayed on the Assign Quick Templates page. To apply
quick templates for ACX Series routers, youmust select the Common
option as the device family type.

• OS Version—From the OS Version list, select an appropriate DMI Schema version

running on that platform. If you are unable to locate the DMI schema for a device

family, you can update theDMI schema version on the Junos Space server. Formore

information about updating the DMI schema on the Junos Space server, see Junos

Space documentation.

The Schemawindow displays the device family and the OS version selected in this

step.
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5. Type or paste the Junos commands in the text area provided in the CLI commands

section. Alternatively, you can navigate through the configuration option levels (at

the left side) in Schema and double-click the configuration option you want to add

to the quick template. The selected configuration option is displayed in the CLI

Commands text area. The configuration options available here depend on the device

family you selected.

6. Optionally, you canmodify the configuration in the CLI Commands text area by using

the tool bar functionalities such as undo, redo, cut, copy, paste, and find.

7. Click Save.

The template you created is displayed in the quick templates table.

Applying Templates to Devices

After you create a template, you can define your device configuration to bemanaged by

using the quick templates, and apply these templates to the multiple devices.

To assign a template to a device:

1. Select the check box against the quick template for which you want to assign the

profile.

2. Click Assign.

The Assign Quick Template : template names page opens.

3. Choose at least one device to which the profile needs to be assigned.

4. Click Next.

5. Choose adevice and specify the quick template variables in Configure attributes page

and click Save.

For example,whenyouconfigureaVLAN interface inaquick template, youcanspecify

the variables VLAN and interface names for that template for a selected device.

6. Optionally, you can apply the settings specified here to all the selected devices of a

device family by selecting the check box against the option Apply above settings to

all other selected devices.

7. Click Next and then click Finish.

8. Review the profile association with the quick template and then click Finish.
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Editing a Quick Template

You can edit a quick template to modify configurations for your devices.

To edit a quick template:

1. Select the check box against the quick template that you want to modify.

2. Click Edit.

The Edit Quick Template : template name page opens.

3. Make the required changes to the quick template and click Save.

Deleting a Quick Template

To delete a quick template:

1. Select the check box against the quick template that you want to delete.

2. Click Delete.

The Delete Quick Templates window opens.

3. Click Yes to delete the quick template; else click No.

Cloning a Quick Template

A cloned quick template is a copy of an existing quick template. You can use the quick

template as amaster copy to create clone of that template. When you clone a quick

template, you create a copy of the entire device configuration, including its settings, and

other contents. Cloning a quick template saves time if you are deploying device

configuration that are similar to the master copy, rather than creating a template and

defining configurations multiple times.

To create a copy of an existing template:

1. Select the check box against the quick template you want to clone.

2. Click Clone.

The cloned template namedmaster template-clone is shown in the list of templates.

Using the Quick Template DetailsWindow

Use the Quick Template Details window to view the details of the quick template.

Table 30 on page 197 describes the fields in this window.
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Table 30: Quick Template Details

DescriptionField

Displays the name of the quick template.Name

Provides a description of the quick template.Description

Displays the device family for which quick template is created.Device Family

Displays the Junos OS version for the selected device family.OS Version

Displays the CLI commands configured for the device family.CLI Commands

Viewing Deployed Quick Templates

You deploy the device configurations defined in a quick template after you have applied

the template to a device. The ViewDeployed Templates option enables an administrator

or an operator to view the list of templates that are deployed to the devices.

You canmouse over the template name to view the date and time when the template

was created and last modified.

The View Deployed Templates page lists the deployed templates device in a tabular

view. The Table 31 on page 197 lists the columns in the table along with a description.

Table 31: View Deployed Template

DescriptionColumn

Indicates the name of the template whose configuration is deployed to the system.Template Name

Indicates the date and time when the template was created.Creation Time

Indicates the date and time when the template was last modified.Last Updated Time

Indicates the user name of the person who created the template.User Name

Depending upon the type of approval mode configured—Manual Approval or Auto

Approvalmode—you caneither deploy thedevice configurations defined in the template

directly or by pursuing an approval from a configuration approver for the device changes.

To view the list of quick templates that are deployed to a device:

1. Click the Build Mode icon in the Connectivity Services Director banner.

2. Select a device in the View pane.

The View Deployed Templates option appears under Wired>Tasks.

3. Click View Deployed Templates.
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The Deployed Templates For Device: device name page displays listing the templates

applied for that device.
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CHAPTER 12

Configuring Device Settings

• Understanding Device Common Settings Profiles on page 199

• Creating and Managing Device Common Settings on page 199

• Assigning Device Common Settings to Devices on page 212

Understanding Device Common Settings Profiles

Connectivity Services Director enables you to configure device-level settings for routers

in the Device Common Settings profile. Once you create the profiles, you can assign the

profiles to a switch or a controller and you can deploy the profiles using the Deploymode

tasks.

Connectivity Services Director also creates Device Common Settings profiles when it

discoversdevices. It createsaDeviceCommonSettingsprofile for eachdevice it discovers,

importing the device-level settings from the device into the profile.

While configuring the profiles, you can specify the basic settings, which includes the

profile name, device user list, and time settings. Apart from the basic settings, you can

optionally specify the management and protocol settings too.

Related
Documentation

Creating and Managing Device Common Settings on page 199•

• Assigning Device Common Settings to Devices on page 212

Creating andManaging Device Common Settings

Use the Manage Device Common Settings page to create new device common settings

for routing devices and to manage the existing device common settings.

This topic describes:

• Managing Device Common Settings on page 200

• Creating a Device Common Settings Profile on page 201

• Specifying Basic Settings for Device Common Settings on page 203

• Specifying Management Settings for Routing Device Common Settings on page 206

• Specifying Protocol Settings for Routing Device Common Settings on page 209
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• Reviewing and Saving a Device Common Settings Configuration on page 211

• What to Do Next on page 212

Managing Device Common Settings

From the Manage Device Common Settings page, you can:

• Create a new Device Common Settings profile by clicking Add. For directions, see

“Creating a Device Common Settings Profile” on page 201.

• Modify an existing Device Common Settings profile by selecting it and clicking Edit.

• Assign a Device Common Settings profile to a device by selecting a profile and clicking

Assign. For directions, see “AssigningDeviceCommonSettings toDevices” onpage212.

• Modify an existing assignment of a Device Common Settings profile by selecting the

profile and clicking Edit Assignment.

• View information about a Device Common Settings profile by either double-clicking

the profile name or by selecting the profile and clicking Details.

• Delete a Device Common Settings profile by selecting a profile and clicking Delete.

TIP: You cannot delete common settings profiles that are in use—that is,
assigned to devices or used by other profiles. To see the current
assignments for a profile, select the profile and click Details.

• Clone a Device Common Settings profile by selecting a profile and clicking Clone.

Table 32 on page 200 describes the device information available on the Manage Device

Common Settings page. This page lists all Device profiles defined for your network,

regardless of your current selected scope in the network view.

Table 32: Manage Device Common Settings Settings

ActionField Name

Name given to the profile when the profile was created.Profile Name

Thedevice family; ACXSeries router,MSeries router,MXSeries router,
and PTX Series router.

Family Type

Descriptionof theDeviceprofile enteredwhen theprofilewascreated.Description

Displays the assignment state of the profile. A profile can be:

• Unassigned—When the profile is not assigned to any device

• Deployed—When theprofile is assigned toadeviceand is deployed
from Deploy mode

• PendingDeployment—When the profile is assigned to a device, but
not yet deployed in the network. For deployment directions, see
Deploying Configuration to Devices.

Assignment State
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Table 32: Manage Device Common Settings Settings (continued)

ActionField Name

Displays the number of devices to which the profile assignment is
done.

Assigned to

Date and time when the profile was created.Creation Time

Date and time when the profile was last modified.Last Updated Time

The username of the person who created or modified the profile.User Name

TIP: All columnsmight not be displayed. To show or hide fields listed in the
ManageAuthorizationProfiles table, click thedownarrowonthe fieldheader,
select Columns, and select or clear the check box adjacent to the field that

you want to show or hide.

Creating a Device Common Settings Profile

In Connectivity Services Director, as an administrator, you can configure Device Common

Settings profiles by using the Create Device Profile page for devices. You can view the

summary of the configurations before saving the Device profile.

At minimum, youmust specify the Device profile and profile name in the workflow. You

can include additional configuration such as:

• Device users

• Management services

• Multicast, spanning-tree protocol (STP)

• Domain Name Server

• DHCP servers, DHCPRelay servers, Login Banner, andGlobal PoE settings for switches

Youcancreateprofiles on thebasis of thedevice family andeachDeviceprofile is specific

to a device family. After you create a Device profile, you assign the profiles to different

devices.

NOTE: You can assign only one profile to a device. However, you can assign
the same profile tomultiple devices.
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To create a Device profile:

1. Under Views, select one of these options: Logical View, Device View or CustomGroup

View.

TIP: Do not select Dashboard View or Topology View.

2.

Click in the Connectivity Services Director banner.

3. From the Tasks pane, select the type of network, the appropriate functional area, and

select the name of the profile that you want to create. For example, to create a QoS

profile for a device, clickWired > Profiles > CoS. The appropriate Manage Profile page

opens.

4. Click Add to add a new profile.

If you chose to create a profile for the wired network, Connectivity Services Director

opens the Device Family Chooser window.

a. From the Device Family Chooser, select the device family for which you want to

createaprofile. Theavailabledevice families areSwitching(EX),CampusSwitching

ELS (Enhanced Layer 2 Software),DataCenterSwitchingNon-ELSandDataCenter

Switching ELS.

b. ClickOK.

The Create Device Common Settings wizard for the selected device family is

displayed. It consists of four sections, Basic Settings, Management Settings,

Protocol Settings, and Review.

If you chose to create a profile for thewireless network, Connectivity Services Director

opens the Create Device Common Settings for Wireless wizard.

5. Specify the basic settings. Complete the Basic Setting wizard page as described in

both the online help and in “Specifying Basic Settings for Device Common Settings”

on page 203.

6. When you have completed the basic settings, either click Next or clickManagement

Settings at the top of the wizard window.

7. Complete the Management Settings described in both the online help and in the

section “Specifying Management Settings for Routing Device Common Settings” on

page 206.

8. When you have completed themanagement settings, click Next.
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9. Complete the protocol settings.

10.When you have completed the protocol settings, either click Next or click Review at

the top of the wizard window.

11. You can either save your profile ormake changes to your profile from theReviewpage.

For more information, see “Reviewing and Saving a Device Common Settings

Configuration” on page 211.

12. Click Finish to save the Device profile configuration.

Thesystemsaves theDeviceprofileanddisplays theManageDeviceCommonSettings

page. Your new or modified Device profile is listed in the table.

Specifying Basic Settings for Device Common Settings

Toconfigure thebasic settings for anyDeviceCommonSettingsprofile, enter the settings

described in Table 33 on page 203. Mandatory settings are indicated by a red asterisk (*)

that appears next to the field label in the user interface.

Table 33: Device Profile Basic Settings

ActionField

Type a name for the profile.Profile Name

Type a description of the profile containing up to 256 characters.Description

Enter the banner text—this text is displayed in thebannerwhen you
log in to the device.

Login Banner for EX Series
switches, Campus
Switching ELS, and Data
Center Switching

Select the country code for the wireless LAN controllers. Country
code settings are required on the primary wireless seed controller.

TIP: Do not set the country code if you plan to provision the Device
profile for active secondary andmember nodes that will be part of
a cluster.

Country Code for wireless
LAN controllers only

Device Users
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Table 33: Device Profile Basic Settings (continued)

ActionField

To add a device user:

1. Click Add under Device Users.

The Add User window opens.

2. Provideausernameandpassword.Confirm thepassword. Enter
a combination of 6 through 128 alphanumeric characters and
special characters. The password is case sensitive andmust be
a combination of at least two different types of characters or a
combination of upper case and lower case letters.

TIP: Do not create a user with the name root.

3. Select a role for the user:

• For switches, the role options are:Operator, Read-only,
Super-user, or Unauthorized. Operators have clear, network,
reset, trace, and view privileges. Super-Users have all
privileges.

• For wireless controllers, the role options are: Framed,
Administrative, or NAS-Prompt. Framed users have network
user access only. Administrative users have access to the
controller, including the enabled (configuration) mode.
NAS-Prompt users have administrative access to the
controller, excluding enabledmode.

4. ClickOK.

The user is added to the list of Device Users.

TIP: To edit an entry, select a row from the Device Users table and
click Edit tomodify the information. To delete an entry select a row
from the Device Users table and click Delete to delete the user.

Task: Add a Device User

Time Settings

Time settings apply to all platforms. However, the setting for offset applies exclusively towireless.

Select a country and time zone from the list. For wireless, you can
also change the setting for Offset.

Time Zone
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Table 33: Device Profile Basic Settings (continued)

ActionField

To add a time server:

1. Click Add under Time Server.

The Add Time Server window opens.

2. Provide an IP address and, optionally for switches only, mark
the corresponding time server as Preferred.

TIP: Valid IP addresses are 1.0.0.1 through 255.255.255.254
excluding 127.x.x.x and 224.0.0.0 through 239.255.255.255.255

3. ClickOK.

The server is added to the list of Time Servers.

TIP: To edit the settings of a time server, select it and then click
Edit.

Add a Time Server

To configure management settings, click Next or clickManagement Settings at the top

of the wizard window. To skip the management settings and protocol settings, click

Review at the top of the wizard window.
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SpecifyingManagement Settings for Routing Device Common Settings

To configure the management settings for an Routing Device profile:
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1. Enter the settings described in Table 34 on page 207. All settings are optional. Default

values are applied to the configuration if you skip the management settings

configuration.

Table 34: Device Profile Management Settings for Routing

ActionTask

You can enable one ormore network protocol services for this Device profile: FTP,
TELNET, HTTPS, or HTTP.

Enable
Services

To add Power over Ethernet (PoE) configuration for Routing, enable Configure
PoE and provide these settings:

Configure
PoE

NOTE: PoE configuration will be added only to switches that support PoE.

a. Using the arrows, adjust the Guard Band value from 0 through 19 watts. A
guard band reserves a specified amount of power from the PoE power budget
for the router or line card in case of a spike in PoE consumption. For routers
with multiple PoE line cards, the guard band wattage is set to the specified
value on all line cards, unless a line card has been explicitly configured with a
different value.

b. Select a Management Mode for PoE, either Class or Static:

• ClassManagement—InclassPoEmanagementmode, themaximumpower
for an interface isdeterminedby theclassof theconnectedpowereddevice.

• Static Management—In the static PoEmanagementmode, you specify the
maximum power for each PoE interface. The PoE controller then allocates
this amount of power to the interface from its total budget.

c. For PoE Global, you can indicate Enable All, Disable All, or None.

NOTE: If you deselect Configure PoE, PoE is disabled and the global PoE settings
supported by this profile (poe guard-band, poe fpc all guard-band, poe
management, poe fpc all management, and poe interface all) are deleted from
the switch when the profile is deployed on the switch.

Syslog Settings

Optionally, expand the Syslog Settings and provide the following system logging settings.
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Table 34: Device Profile Management Settings for Routing (continued)

ActionTask

To enable device logging for switches:

a. Under Enable Device Log, click Add.

The Add Log window opens.

b. Select the log type for switching, either Console, File, User, or Host.

• Console logging sends system logmessages to the console.

• File logging sends system logmessages to the file you specify in File Name.

• User logging sends system logmessages to the terminal session of the user
specified in User Name. You will also need to provide the name of the user.

• Host logging sends system logmessages to the server specified in Host.
Host can be either an IP address or host name.

c. Under Services, click Add.

ThephraseClick to enter valueappears inboth theService columnandSeverity
Filter column.

d. Click the phrase Click to enter value in the Service column.

A list box replaces the phrase in the Service column.

e. From the Service list, select a logging service: Any, Authorization, Change-log,
Conflict-log,Daemon,DFC,External,Firewall,FTP, Interactive-commands,Kernel,
NTP, PFE, Security or User.

f. Click the phrase Click to enter value in the Severity Filter column.

A list box replaces the phrase in the Severity Filter column.

g. Select an available severity filter from the list, either Alert, Any, Critical,
Emergency, Error, Info, None, Notice, orWarning.

The filter is added to the list of Severity Filters. The filter is activatedwhen the
corresponding service is triggered.

h. ClickOK.

The log is added to the Enable Device Log list.

Enable
Device
Logging for
Switches

Select a Log Type from the Enable Device Log list and click Edit to change the
configuration.

Edit Logging
Settings

Copyright © 2019, Juniper Networks, Inc.208

Connectivity Services Director User Guide



Table 34: Device Profile Management Settings for Routing (continued)

ActionTask

Select a Log Type from the Enable Device Log list and click Delete to remove the
server configuration.

Delete
Logging
Settings

To configure protocol settings, either click Next or click Protocol Settings. To use the

default protocol settings, skip to final review by clicking Review at the top of the wizard

window.

Specifying Protocol Settings for Routing Device Common Settings

To configure the protocol settings for an Routing Device profile, enter the settings

described in Table 35 on page 209. All settings are optional.

Table 35: Device Profile Protocol Settings for Routing

ActionField

Enable Storm Control

Select this option to enable storm control on a switch.

Spanning Tree Settings

Select one of spanning-tree protocol (STP) settings for switches:STP,RSTP (default),MSTP,
or None of these.

• Spanning Tree Protocol—With STP configured, the switches use the IEEE 802.1D 2004
specification, force version 0. This configuration runs a version of RSTP that is compatible
with classic, basic STP as defined in the 802.1D 1998 specification.

• Rapid Spanning Tree Protocol—RSTP provides faster reconvergence time than the original
STP both by identifying certain links as point-to-point and by using protocol handshake
messages rather than fixed timeouts. VLAN Spanning Tree Protocol (VSTP) and RSTP can
be configured concurrently. You can selectively configure up to 253 VLANs by using VSTP;
the remaining VLANs will be configured by using RSTP. VSTP and RSTP are the only
spanning-tree protocols that can be configured concurrently on a switch.

• Multiple Spanning Tree Protocol—MSTP enables multiple VLANs to bemapped to the
same spanning-tree instance, reducing the number of spanning-tree instances needed to
support a large number of VLANs.MSTPprovidesmultiple forwarding paths for data traffic
andenables load-balancing. It improves the fault toleranceof thenetworkbecausea failure
in one instance, or forwarding path, does not affect other instances.

You can also select the Enable VSTP check box to enable VSTP.

Spanning Tree Protocol
Settings for switches only

Multicast Settings

Selecting thisoptionenables InternetGroupManagementProtocol (IGMP)onall the interfaces
for the selected device. Default is disabled. IGMP is a communications protocol used by both
hosts and adjacent routers on IP networks to establish multicast groupmemberships.

Enable IGMP

Enables IGMP snooping on all VLANs. Default is enabled.Enable IGMP Snooping
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Table 35: Device Profile Protocol Settings for Routing (continued)

ActionField

Enable DHCP Relay

Select this option to display the DHCP Relay settings.

To add DHCP Relay to this Device Profile:

1. Select Legacy DHCP Relay (default).

2. Add one or more DHCP servers to the Device Common Settings profile:

a. Click Add under DHCP Servers.

The Add Server window opens.

b. Type an IP Address.

c. ClickOK.

The server is added to the list of DHCP Servers.

Add DHCP Relay to Device
Profile
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Table 35: Device Profile Protocol Settings for Routing (continued)

ActionField

To add Extended DHCP Relay to this Device Profile:

1. Select Extended DHCP Relay instead of Legacy DHCP Relay.

2. Add one or more DHCP Server Groups to the Device Common Settings profile:

a. Click Add under Add DHCP Servers Group.

The Add Server Group window opens.

b. Provide a name for the server group.

c. Optionally, make this an active server group by checking Active Group.

d. Add servers to the group by clicking Add under DHCP Servers.

The phrase Click to enter value appears in the IP Address column.

e. Select Click to enter value and then enter an IP Address.

f. ClickOK.

The server is added to the DHCP server group list.

g. Add a relay interface group by clicking Add under Add Relay Interface Group.

The Add DHCP Relay Interface window opens.

h. Type a DHCP interface group name.

i. Select a server group from the Server Group list.

j. ClickOK.

The group is added to the Relay Interface Group list.

Add Extended DHCP Relay to
a Device Profile

Click eitherNext or Review, to see the Review page. For review directions, see “Reviewing

and Saving a Device Common Settings Configuration” on page 211.

Reviewing and Saving a Device Common Settings Configuration

From this page, you can save or make changes to Device Common Settings:

• Tomake changes to the settings, click the Edit associated with the configuration you

want to change.

Alternatively, you can also click appropriate sections of the workflow at the top of the

page that corresponds to the configuration you want to change.
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When you have completed your modifications, click Review to return to this page.

• To save a new profile or to savemodified settings to an existing profile, click Finish.

The Manage Device Common Settings page is displayed with the new or modified

profile listed

What to Do Next

Once the Device Common Settings profile is created, youmust assign the profile to the

required device by using the Manage Device Profile page and then deploy the Device

profile by using theDeploymode. ToassignaDeviceCommonSettingsprofile to adevice,

see Security Director Release Notes.

NOTE: Adevice can have only oneDevice profile assigned to it. However, you
can assign the same Device profile tomultiple devices.

Related
Documentation

Understanding Device Common Settings Profiles on page 199•

• Assigning Device Common Settings to Devices on page 212

Assigning Device Common Settings to Devices

OnceaDeviceCommonSettingsprofile is createdordiscovered (system-createdprofile),

youmust assign it to devices using the steps described in this topic. You can assign a

Device profile to a either single device, a series of single devices, or a Custom Group of

devices (see “Creating Custom Device Groups” on page 186).

NOTE: Adevice can have only oneDeviceCommonSettings profile assigned
to it.

Youmust have one or more device profiles created or discovered before you can assign

adeviceprofile to adevice.Whenyoudeployanassigneddeviceprofile, the configuration

is pushed onto the device.

This topic describes:

• Assigning Device Common Settings on page 213

• Editing the Assignments of the Device Common Setting on page 214
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Assigning Device Common Settings

To assign device common settings to either a single device, a series of single devices, or

members of a Custom Group:

1. Click Build task category in the Connectivity Services Director banner.

2. SelectDeviceCommonSettings fromtheProfileandConfigurationManagementmenu

in the Tasks pane.

The Manage Device Common Settings page is displayed. The page displays all the

device profiles that you configured as well as the system-created profiles detected

during device discovery.

3. Select an undeployed profile from the list of profiles and then click Assign.

The Assign Device Profile page for the selected device family appears with a wizard

consisting of three parts, Device Selection, Profile Assignment, and Review. Device

Selection is displayed.

4. Expand the Device Selection object tree and select one ormore objects to receive the

device profile. Youmust place a check next to a device to select it—simply highlighting

the device does not select it.

NOTE: If Connectivity Services Director fails to read the configuration of
oneormoredevicesafterdevicediscovery, thosedevicesarenotdisplayed
in the Device Selection list. Youwill not be able to assign profiles to those
devices. The Manage Jobs page in Systemmode displays details of the
device discovery jobs. Use the information displayed on this page to take
appropriate corrective steps to enable Connectivity Services Director to
reread the configuration of the failed device. For more information, see
Discovering Devices in a Physical Network.

5. Click either Next or click Profile Assignment from the wizard workflow.

The Profile Assignment page opens, displaying your selections, including their Device

(name), Type, Assigned To, and Attributes. The Assigned To column now has the

entry DEVICE and the Attributes column has the entry Undefined.

6. Click Define in the Attributes column in the Assignments table to configure the

attributes.

The Configure Attributes window opens, listing all the Layer 3 interfaces available on

the device.

a. Select the Layer 3 interfaces that are required for DHCP relay from the Available

list and using the right arrow, move them to the Selected list. You can reorder the

interfaces using the UP and DOWN arrows.
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b. Click Save to save the interface list and close the Configure Attributes window.

7. You can view the assignment details for the selected device and also remove any

assignments:

• To view the assignment details, select the device and click View Assignments.

The Profile Details page for selected device appears. Expand the Device name to

view the details of the assignment. The assignment status displays the status

whether the device is deployed or is pending device update, and so on.

• To delete a device common setting assignment for a device, select the device from

the Assignments table and click Remove.

8. Click Next or click Review from the wizard workflow to review the assignments. On

the Review page, click Edit to edit the profile assignment.

9. Click Finish once you are done reviewing the profile assignment.

The Create Profile Assignments Job Details window appears with a status report for

the profile assignment job—clickOK to close this window. If you have assigned the

profile to a large number of objects, the profile assignment job can take some time

to complete. Instead ofwaiting for the Job Details dialog box to report job completion

status, you can close it and check the details of the profile assignment job at a later

time using the Manage Job task in Systemmode.

NOTE: If any assignment fails, the profile assignment job fails and none
of theassignmentsarecreated.Checkthedetails for theprofileassignment
job for information about why the assignment failed.

An assignedDevice profile has the Assignment StatePending Deployment in theManage

Device Common Settings list. Deploy any device profile in this state.

To view the details of a profile, select the profile from the Manage Device Common

Settings page and then click Details.

Editing the Assignments of the Device Common Setting

Use the Edit Assignments page to change device common setting assignments. To edit

an existing assignment:

1. Select a profile from theManage Device Common Settings page and click Edit

Assignment.

The Edit Assignments page for the selected device appears.

2. Expand theDevices cabinet andmake the desired change from theOperation column

of the table.

3. Click Define from the Attributes column of the table to modify the attributes.
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The Configure attributes page is displayed listing all the Layer 3 interfaces available

on the device.

• Select the Layer 3 interfaces that are required for DHCP relay from the Available

box and using the right arrow, move them to the Selected box.

You can rearrange the order of the interfaces using the up and down arrows.

• Click Save after you are done with selecting the interfaces.

4. Click Apply once you are done with the changes.

The Manage Device Common Settings page is displayed.

Related
Documentation

• Understanding Device Common Settings Profiles on page 199

• Creating and Managing Device Common Settings on page 199
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CHAPTER 13

Configuring Class of Service (CoS)

• Understanding Class of Service (CoS) Profiles on page 217

• Creating and ManagingWired CoS Profiles on page 222

Understanding Class of Service (CoS) Profiles

When a network experiences congestion and delay, some packets must be prioritized to

avoid random loss of data. Class of service (CoS) (also known as QoS) accomplishes

this prioritizationbydividing similar typesof traffic, suchas e-mail, streaming video, voice,

large document file transfer, into classes. You then apply different levels of priority, such

as those for throughput and packet loss, to each group, and thereby control traffic

behavior. For example, when packets must be dropped, you can ensure that packet loss

takes place according to your configured rules. CoS also enables you to rewrite the

Differentiated Services code point (DSCP), IP precedence, or 802.1p CoS bits of packets

exiting a specific interface, thus enabling you to tailor outgoing packets to meet the

network requirements of remote peers.

On Data Center Switching devices, CoS can be used to configure Ethernet interfaces to

support Fibre Channel over Ethernet (FCoE) traffic.

• HowWould I Use CoS (also known as QoS)? on page 217

• How Does CoSWork? on page 218

• WhatWireless Network Traffic Aspects Can I Control Using CoS? on page 219

• What CoS Parameters Can I Control? on page 220

• What Are the Default CoS Traffic Types? on page 220

• Data Center Switching CoS Configuration on page 221

• How Do I Implement Class of Service? on page 221

• Editing Discovered CoS Profiles on page 221

HowWould I Use CoS (also known as QoS)?

On an Ethernet trunk, you canmark frames with a class-of-service (CoS) value. CoS is

used to define trunk connections as full-duplex, incoming only, or outgoing only.

Network devices such as routers and switches can be configured to use existing CoS

values on incoming packets from other devices (trust mode), or can rewrite the CoS

values to something completely different. Layer 2markings also can extend to theWAN;
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for example, with a frame relay network. CoS is usually limited to use within an

organization's intranet.

With legacy telephone systems, CoS can be used to define the permissions an extension

will haveonaprivatebranchexchange(PBX)orCentrex.Someusersmightneedextended

voicemail message retention or the ability to forward calls to a cell phone, while others

have no need tomake calls outside the office. Permissions for a group of extensions can

be changed bymodifying a CoS variable applied to the entire group.

NOTE: CoS configurations can be complicated, so unless it is required, we
recommend that you do not alter the default class names or queue number
associations.

HowDo I Create CoS Groups?

Use 802.1Q tagged VLANs to group users and enable CoS to set priorities supported by

downstream devices.

How Is CoS Different FromQoS?

CoS operates only on 802.1Q VLAN Ethernet at the data link layer (layer 2), while

quality-of-service (QoS)mechanisms operate at the IP network layer (layer 3). 802.1p

Layer 2 tagging can be used by QoS to differentiate and shape network traffic.

HowDoes CoSWork?

CoS is a 3-bit field in an Ethernet frame header when 802.1Q VLAN tagging has been

applied. The 3-bit field specifies a priority value between 0 and 7 that can be used by

QoS to differentiate and shape network traffic. Different devices use different priority

values. When you choose to create a CoS profile, Connectivity Services Director displays

the priority based on the device family that you chose. You canmodify these or addmore

priority values

It is helpful to think of forwarding classes as output queues. In effect, the end result of

classification is the identificationof anoutputqueue for aparticular packet. For a classifier

to assign an output queue to each packet, it must associate the packet with one of the

forwarding classes listed in Table 36 on page 218.

Table 36: 3-Bit CoS Field in Ethernet Header with VLAN Tagging

Priority AppliedCoS Value

Best-effort is a backward compatibility feature.0

Assured-forwarding offers a high-level of assurance that the packets are delivered as long as the packet
flow from the client stays within a certain Service profile that you define.

1
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Table 36: 3-Bit CoS Field in Ethernet Header with VLAN Tagging (continued)

Priority AppliedCoS Value

Multicast assured-forwarding offers a high level of assurance that the multicast packets are delivered as
longas thepacket flow fromthe customer stayswithin a certainServiceprofile that youdefine. The software
accepts excess traffic, but it applies a tail drop profile to determine if the excess packets are dropped and
not forwarded. Up to two drop probabilities (low and high) are defined for this service class.

Multicast expedited-forwarding delivers assured bandwidth, low loss, low delay, and low delay variation
(jitter) end-to-end for multicast packets in this service class. The software accepts excess traffic in this
class, but in contrast to themulticast assured forwardingclass, out-of-profilemulticast expedited-forwarding
class packets can be forwarded out of sequence or dropped.

Multicast best-effort does not apply any special CoS handling to the multicast packets. These packets are
usually dropped under congested network conditions.

2

3

4

Expedited-forwarding delivers assured bandwidth, low loss, low delay, and low delay variation (jitter)
end-to-end for packets in this service class.

5

6

Network-connect7

Note: The forwarding classes multicast expedited-forwarding, multicast

assured-forwarding, andmulticast best-effort are applicable to ACX, M, MX, PTX Series

routers.

Differentiated Services indicate how a packet is forwarded. Because the three bits used

inLayer 2 simplepriority taggingprovideminimaldirection inmanaging traffic, theprotocol

DifferentiatedServices (DSorDiffServ)was developed to enhance traffic differentiation.

WhatWireless Network Traffic Aspects Can I Control Using CoS?

In addition to separating traffic into classes, you can also optionally configure these

settings with CoS:

• Apply a bandwidth limit to the data sessions and to aggregated categories such as

trunk interfaces, Layer 3 interfaces, access interfaces, and routed VLAN interfaces.

• Assign the same CoS level to all traffic on the Service profile SSID. This is called static

CoS and overrides settings indicated on the 802.1p, overrides DSCPmarkings in the

packets themselves, and disregards any filters that mark CoS. You indicate the value

assigned to all user traffic.

• Allow the controller to use the client DSCP for radio ingress traffic and ignoreWi-Fi

Multimedia (WMM).

• Specify a traffic class for voice traffic and optionally apply a bandwidth limit to the

voice sessions and to aggregated categories. You can also enable static CoS for voice

traffic, which overrides settings indicated on the 802.1p, overrides DSCPmarkings in
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the packets themselves, and disregards any filters that mark CoS. You indicate the

value assigned to all voice traffic.

• Specify which of 11 forwarding queues are used. You canmodify the action

corresponding to each forwarding queue to suit your requirements. This is referred to

as access categories.

What CoS Parameters Can I Control?

You can use CoS profiles to group a set of class of service (CoS) parameters and apply

it to one or more interfaces. You can configure the following parameters within a CoS

profile:

• Classifiers—Packet classification refers to the examination of an incoming packet. This

function associates the packet with a particular CoS servicing level.

• Schedulermaps—Schedulersdefine thepropertiesofoutputqueues. Theseproperties

include the amount of interface bandwidth assigned to the queue, the size of the

memory buffer allocated for storing packets, the priority of the queue, and the drop

profiles associated with the queue. You associate the schedulers with forwarding

classes bymeans of schedulermaps. You can then associate each schedulermapwith

an interface, therebyconfiguring thequeues, packet schedulers, and tail dropprocesses

that operate according to this mapping.

• Rewrite values—A rewrite rulemodifies the appropriate CoSbits in an outgoing packet.

Modification of CoS bits enables the next downstream device to classify the packet

into the appropriate service group. Rewriting or marking outbound packets is useful

when the device is at the border of a network andmust alter the CoS values to meet

the policies of the targeted peer.

• Traffic-control profile—Traffic-control profiles enable traffic limitation of a certain

class to a specified bandwidth and burst size. Packets exceeding the limits can be

discarded, or can be assigned to a different forwarding class, a different loss priority,

or both.

What Are the Default CoS Traffic Types?

On EX Series switches, the system provides you with these four predefined traffic

types—Data, Voice, Video, and Network Control—with these default traffic configuration

and shaping details:

• Data—Forwarding queue 0 (nd_best-effort), Buffer size 50%, Bandwidth reserved

30%

• Voice—Forwarding queue 5 (nd_expedited-forwarding), Buffer size 20%, Bandwidth

reserved 0%

• Video—Forwarding queue 4 (nd_video-forwarding), Buffer size 20%, Bandwidth

reserved 70%

• Network Control—Forwarding queue 7 (nd_network-control), Buffer size 10%,

Bandwidth reserved 0%
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For Campus Switching ELS, the system provides you with these four predefined traffic

types—Data, Voice, Video, and Network Control—with these default traffic configuration

and shaping details:

• Data—Forwarding queue 0 (nd_best-effort), Buffer size 50%, Bandwidth reserved

30%

• Voice—Forwarding queue 1 (nd_expedited-forwarding), Buffer size 20%, Bandwidth

reserved 0%

• Video—Forwardingqueue2(nd_video-forwarding),Buffersize20%,Bandwidth reserved

70%

• Network Control—Forwarding queue 3 (nd_network-control), Buffer size 10%,

Bandwidth reserved 0%

For Campus Switching ELS with Hierarchal Post Scheduling (Juniper Networks EX4600

Ethernet switches),ConnectivityServicesDirectorprovidesyouwithpredefined forwarding

classes—nd_cs_best-effort, nd_cs_video-forwarding, nd_cs_expedited-forwarding, and

nd_cs_network-control. These forwarding classes are grouped under two priority

groups—data_video_pg and voice_control_pg.

On data center switches, the system provides you with forwarding

classes—nd_dc_best-effort, nd_dc_network-control, nd_dc_fcoe, nd_dc_no-loss, and

nd_dc_mcast. These forwarding classes are grouped under three priority

groups—data_control_pg, fcoe_noloss_pg, andmulticast_pg.

For both Campus Switching ELS with Hierarchal Post Scheduling and Date Center

Switching, you canmodify and customize each of these priority groups and forwarding

classes. For more details, see “Creating and ManagingWired CoS Profiles” on page 222.

Data Center Switching CoS Configuration

For data center switching devices, these additional CoS features are available:

• Hierarchical Port Scheduling (ETS)—Hierarchical port scheduling (Enhanced

Transmission Selection, or ETS) is a two-tier process that provides better port

bandwidth utilization and greater flexibility to allocate resources to queues and to

groups of queues.

• Priority-based flow control (PFC)—A link-level flow control mechanism.

HowDo I Implement Class of Service?

CoS can be implemented from the MSS CLI, from Connectivity Services Director.

RingMaster configuresunicast trafficbutdoesnotconfiguremulticast traffic. Fordirections

to implementCoS fromConnectivityServicesDirector, see “CreatingandManagingWired

CoS Profiles” on page 222.

Editing Discovered CoS Profiles

Duplicate scheduler configuration is deployed to the device when you edit a CoS profile

thatareautomatically createdbyConnectivityServicesDirectoraspartofdevicediscovery

or out-of-band changes. In CoS configuration, a single classifier can be associated to
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multiple ports regardless of the other CoS configuration. When Connectivity Services

Director discovers a device with such configuration it will create multiple profiles, based

on thedifference inotherCoSconfigurations, andmappedtosameclassifier configuration.

If youmodify classifier settings in such a CoS profile that is created automatically by

Connectivity Services Director, Connectivity Services Director cannot modify the

configuration because it is mapped tomultiple profiles. Whenever youmodify such a

CoS profile that is created automatically, Connectivity Services Director will create new

classifier settings configuration on the device andmap the same to it, without affecting

theexistingclassifier settings.Newlycreatedclassifier settingswill haveanamegenerated

based on the profile name. Even if only one profile is mapped to the classifier settings,

Connectivity Services Director creates new classifier settings and the old settings are

orphaned.

NOTE: This behavior is applicable to both hierarchical and non hierarchical
profiles, and is applicable for congestion notification profile name, traffic
control profile name, scheduler map name, classifier name and rewrite rule
settings.

Related
Documentation

Creating and ManagingWired CoS Profiles on page 222•

Creating andManagingWired CoS Profiles

CoS profiles enable the grouping of class-of-service (CoS) parameters and apply them

to one or more interfaces. Connectivity Services Director provides you with predefined

traffic types for each CoS profile that you create. These traffic types represent the most

common types of traffic for the device type. Each of these templates has preconfigured

values for all CoS parameters based on the typical application requirements. You can

change the preconfigured values of these parameters to suit your requirements.

This topic describes:

• ManagingWired CoS Profiles on page 223

• Using the Default CoS Profiles for Routers on page 224

• Using the Default CoS Profiles for Campus Switching ELS with Hierarchical Port

Scheduling on page 224

• Using the Default CoS Profiles for Data Center Switching on page 224

• Creating aWired CoS Profile on page 225

• Specifying Settings for a Routing, Switching, and Campus Switching ELS CoS

Profile on page 226

• Specifying Settings for a Campus Switching ELS CoS Profile with Hierarchical Port

Scheduling (ETS) on page 230

• Specifying Settings for a Data Center Switching CoS Profile on page 234

• What to Do Next on page 241
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ManagingWired CoS Profiles

From the Manage CoS Profiles page, you can:

• Create a newCoSprofile by clickingAdd. For details, see “Creating aWiredCoSProfile”

on page 225.

• Modify an existing CoS profile by selecting it and clicking Edit.

• View information about a profile by selecting the profile and clicking Details.

• Delete a CoS profile by selecting a profile and clicking Delete.

TIP: You cannot delete profiles that are in use—that is, assigned to objects
orusedbyotherprofiles.Tosee thecurrentassignments foraprofile, select
the profile and click Details.

• Clone an existing CoS profile by selecting it and clicking Clone.

Table 37 on page 223 describes the information provided aboutwiredCoSprofiles on the

Manage CoS Profiles page. This page lists all CoS profiles defined for your network,

regardless of the scope you selected in the network view.

Table 37: ManagingWired CoS Profile Fields

DescriptionField

Name given to the profile when the profile was created.Profile Name

Thedevice familyonwhich theprofilewascreated:ACXSeries routers,
M Series routers, MX Series routers, PTX Series routers.

Family Type

Description of the profile that was entered when the profile was
created. If theprofilewascreatedbyusing theCLI and thendiscovered
by Connectivity Services Director, the description is Profile created as
part of device discovery.

TIP: To display the entire description, youmight need to resize the
Description column by clicking the column border in the heading and
dragging it.

Description

Date and time when the profile was created.Creation Time

Date and time when the profile was last modified.Update Time

The username of the user who created or modified the profile.User Name

TIP: All columnsmight not be displayed. To show or hide fields listed in the
ManageAuthorizationProfiles table, click thedownarrowonthe fieldheader,
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select Columns, and select or clear the check box adjacent to the field that

you want to show or hide.

Using the Default CoS Profiles for Routers

When you install Connectivity Services Director, a default CoS profile

(juniper_CoS_template) is added to the Manage CoS Profiles page for routers and EX

Series switches, and another with the same name is added for Campus Switching ELS.

DefaultCoSprofiles havemostbasic settingspreconfigured. For example, the forwarding

classes in the default CoS profile have already been assigned with default scheduler

values. However, you can use the Edit CoS Profile page to optimize your communication

with the network by customizing the bandwidth and buffer size assigned to each of the

forwarding classes in the default CoS profile.

Using the Default CoS Profiles for Campus Switching ELSwith Hierarchical Port Scheduling

When you install Connectivity Services Director, juniper_CS_Hier_Ehernet_CoS is the

default CoS profiles that is installed for Campus Switching ELS with Hierarchical Port

Scheduling.

To see the settings configured for a default profile, select it on the Manage CoS Profiles

page, then click Details.

Using the Default CoS Profiles for Data Center Switching

When you install Connectivity Services Director, the following default CoS profiles are

installed for Data Center Switching:

• juniper_DC_NonHier_Ethernet_CoS

• juniper_DC_Hier_Ethernet_CoS

• juniper_DC_NonHier_CoS

• juniper_DC_Hier_CoS

• juniper_DC_Hier_FCoE_CoS

To see the settings configured for a default profile, select it on the Manage CoS Profiles

page, then click Details.
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Creating aWired CoS Profile

In Connectivity Services Director, you can create a CoS profile to group a set of Class of

Service parameters and apply it to one or more network sessions.

For a CoS profile, youmust specify the profile name. You can use defaults for the other

values.

To create a wired CoS profile:

1.

Click in the Connectivity Services Director banner.

2. Under Select View, select one of the following:Device View or CustomGroup View.

TIP: Do not select Dashboard View or Topology View.

3. From the Tasks pane, expandWired, expand Profiles, and then select CoS.

4. Click Add to add a new profile.

Connectivity Services Director opens the Device Family Chooser window.

5. From the Device Family Chooser, select the wired device family for which you want

to create aprofile. The available device families areSwitching (EX),CampusSwitching

ELS>Non-Hierarchial Port Scheduling,Campus Switching ELS>Hierarchial Port

Scheduling, and Data Center Switching.

6. Click OK.

7. Complete the appropriate settings using the stepsmentioned in “Specifying Settings

for a Routing, Switching, and Campus Switching ELS CoS Profile” on page 226,

“Specifying Settings for a Campus Switching ELS CoS Profile with Hierarchical Port

Scheduling (ETS)” on page 230, or “Specifying Settings for a Data Center Switching

CoS Profile” on page 234.
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Specifying Settings for a Routing, Switching, and Campus Switching ELS CoS Profile

Create a CoS profile for switching by providing a profile name and, optionally, changing

any default settings for Traffic Configuration and Shaping.

1. Enter theCoS switching settings described in Table 38 onpage 226. Required settings

are indicated by a red asterisk (*) that appears next to the field label in the user

interface.

Table 38: CoS Profile Settings for Routers, EX and Campus Switching ELS

ActionField

Type the name of the profile.

Youcanuseup to64characters for profiles created forwireddevices.
Profile namemust not contain special characters or spaces. Note
that profiles that are automatically created by Connectivity Services
Director as part of device discovery or out-of-band changes may
contain the underscore (_) character.

Profile Name

Type a description of the profile.Description

2. Connectivity Services Director includes four predefined traffic types, Data, Voice,

Video, and Network Control. You can either modify those traffic types or you can

create your own traffic type. Modify and customize any listed traffic type by selecting

the traffic type from the list and clicking Edit, then changing any of the settings

described in Table 39 on page 226.

3. To create your own traffic type, click Add and then configure the settings described

in Table 39 on page 226.

Table 39: Traffic Configuration and Shaping for EX Switching and Campus Switching
ELS

DescriptionField

If you are editing a Connectivity Services Director default traffic type,
this field cannot be changed. If you are adding a traffic type, indicate
the type of traffic—this can be any value, such as a server name or
something to do with your business.

Traffic Type
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Table 39: Traffic Configuration and Shaping for EX Switching and Campus Switching
ELS (continued)

DescriptionField

If you are editing a Connectivity Services Director default traffic type,
this field cannot be changed. If you are adding a traffic type, you can
use one of the predefined forwarding classes for your switch or you
can create your own forwarding class. These forwarding classes are
always provided: nd_best-effort, nd_network-control,
nd_video-forwarding, and nd_expedited-forwarding. To create your
own forwarding class, type a name instead of selecting an option.

Most switches support the four predefined forwarding classes listed
above. The exception is the EX4300 switch, which has eight default
forwarding classes, including the standard four classes, plus
multicast-network-connect,multicast-assured-forwarding,
multicast-expedited-forwarding, andmulticast-network-connect.

Forwarding Name

Existing forwarding classes already have associated queues that
cannotbealtered. If youdefinedanewforwardingclassby specifying
your own Forwarding Name, then select an internal queue number
to which forwarding classes are assigned. Most switches support
queues 0 - 10. The exception is the EX4300 switch, which supports
queues 0 - 11.

By default, if a packet is not classified, it is assigned to the class
associated with queue 0. You can assign more than one forwarding
class to a queue number.

Forwarding Queue

Scheduler Map

A note in the Scheduler Map section indicates howmuch buffer size and bandwidth you have
available to configure. For example, the message “You have been left with 0 percent buffer size
and 0 percent bandwidth.” means that you have no available buffer or bandwidth, and youmust
reconfigure existing traffic types to free some bandwidth before configuring additional traffic
types.

Enable Low Priority if you want the queue to receive low priority.Low Priority

EnableStrictHighPriority if youwant thequeue to receivepreferential
treatmentover a low-priority queue.Unlimitedbandwidth is assigned
to a strict-high priority queue.

A strict-high priority queue receives preferential treatment over a
low-priority queue. Unlimited bandwidth is assigned to a strict-high
priorityqueue.Queuesare scheduledaccording to thequeuenumber,
starting with the highest queue, 7, with decreasing priority down
through queue 0. Traffic in higher-numbered queues is always
scheduled prior to traffic in lower-numbered queues. In other words,
in case of two high-priority queues, the queue with the higher queue
number is processed first.

NOTE: You canmodify this field in the Traffic Configuration and
Shaping table or from theTraffic Configuration andShapingwindow.

Strict High Priority
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Table 39: Traffic Configuration and Shaping for EX Switching and Campus Switching
ELS (continued)

DescriptionField

Buffer Size (%) is the size of thememory buffer allocated for storing
packets.Use theslider tospecify theschedulerBufferSizepercentage.

NOTE: You canmodify this value by double-clicking this field in the
Traffic Configuration and Shaping table or by sliding the bar in the
Traffic Configuration and Shaping window.

Buffer Size (%)

Bandwidth Reserved (%) is the amount of interface bandwidth
assigned to the queue. Move the slider to specify the Bandwidth
Reserved percentage. Defaults are:

• Data: 30%

• Voice: Strict High

• Video: 70%

• Network control: 0%

If Strict-High is enabled for this traffic type, you cannot reserve
bandwidth.

NOTE: This field displays the value based on either your input or on
the transmit-rate parameter from the switch, if that parameter is
configured. While specifying transmit-rate on the EX Series switch, if
youchoose to specify thevalueasanexact rate,ConnectivityServices
Director converts this value and displays it as a percentage in the
Bandwidth Reserved (%) field. You canmodify this percentage value
from the CoS Profile page.

Bandwidth Reserved (%)

Move the Shaping Rate slider to throttle the rate of packet
transmission by setting amaximum bandwidth (rate in bits per
second) or a maximum percentage of bandwidth for a queue or a
forwarding class.

Shaping Rate

Traffic Classification

Behavior aggregate classification classifies packets. The DSCP or DSCP IPv6 precedence bits of
the IP header convey the behavior aggregate class information. The information might also be
found in the IEEE 802.1ad, or IEEE 802.1p CoS bits.

Select a classifier type—DSCP, DSCP-IPv6, INET-precedence, or
IEEE-802.1—and associate the corresponding code-point aliases to
loss priorities.

NOTE: Youcanspecify code-point—losspriorityassociations forone
or more classifier types.

• DSCP—Differentiated services code point, a field in IPv4 headers,
is used to classify traffic.

• DSCP-IPv6—Differentiated services code point, a field in IPv6
headers, is used to classify traffic.

• INETprecedence—Field that indicatesclassof service rewrite rules
are used to classify traffic.

• IEEE-802.1—IEEE 802.1ad, or IEEE 802.1p CoS bits are used to
classify traffic.

Classifier Type
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Table 39: Traffic Configuration and Shaping for EX Switching and Campus Switching
ELS (continued)

DescriptionField

Classifier Code Points

Thecodepoints list includesall availableandunselectedcodepoints
for the selected classifier type.

Specify one or more code-point aliases or bit sets to associate with
a forwarding class by moving the value to one of the two lists, Loss
Priority Low or Loss Priority High.

Code Points

Indicate that packets have low loss priority by selecting code-point
aliases from the Code Points table and using the LEFT and RIGHT
arrows to move them into the appropriate loss priority table.

Loss Priority Low

Indicate that packets havemedium-low loss priority by selecting
code-point aliases from the Code Points table and using the LEFT
and RIGHT arrows to move them into the appropriate loss priority
table.

Loss Priority Medium-Low

Indicate that packets havemedium-high loss priority by selecting
code-point aliases from the Code Points table and using the LEFT
and RIGHT arrows to move them into the appropriate loss priority
table.

LossPriorityMedium-High

Indicate that packets have high loss priority by selecting code-point
aliases from the Code Points table and using the LEFT and RIGHT
arrows to move them into the appropriate loss priority table.

Loss Priority High

4. ClickOK toclose theAddTrafficandClassificationwindowandsaveyour configuration.

Your changes are added to this CoS profile.

NOTE: If all bandwidth has already been reserved, your changes are not
made. Reduce the bandwidth reserved from another Traffic Type, then
repeat the configuration.

5. To configure rewrite rules for a forwarding queue, click Configure Rewrite Rules at the

bottom of the screen. The Configure Rewrite Rules window appears. Specify rewrite

rule settings as described below to alter CoS values in outgoing packets on the

outbound interfaces of an edge switch:

a. Select the forwarding class for which you want to create or modify rewrite rules.

Connectivity Services Director lists all the forwarding classes that you have used

for configuring traffic in the Traffic Configuration and Shaping section.
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b. For each classifier’s loss priority, select a code-point alias for each loss-priority

type—Low, Medium-Low, Medium-High, and High.

6. ClickOK to save the rewrite rules and close the Configure Rewrite Rules window.

The system saves the rewrite rules and returns to the Create CoS Profile page.

7. Click Done.

After you create a CoS profile for switching devices, associate the CoS profile with a Port

profile. For directions, see Creating and Managing Port Profiles.

Specifying Settings for a Campus Switching ELSCoSProfile with Hierarchical Port Scheduling
(ETS)

YoucancreateaCoSprofile forCampusSwitchingELSwithHierarchicalPostScheduling

by specifying the profile settings and the traffic configuration and shaping details.

Hierarchical port scheduling is a two-tier process that provides better port bandwidth

utilization and greater flexibility to allocate resources to queues and to groups of queues.

Hierarchical scheduling includes the JunosOS implementationof enhanced transmission

selection (ETS, described in IEEE 802.1Qaz).

When you open the Create CoS Profile page, Connectivity Services Director displays two

predefinedpriority groups—data_video_pgandvoice_control_pg—withdefault forwarding

classes grouped under each of them. You canmodify these priority groups or forwarding

classes according to your network requirements.

To specify the settings for the CoS profile:

1. Enter the settings described in Table 40 on page 230. Required settings are indicated

by a red asterisk (*) that appears next to the field label in the user interface.

Table 40: CoS Profile Basic Settings for Campus Switching ELS CoS Profile with
Hierarchical Port Scheduling (ETS)

ActionField

Type the name of the profile.

Youcanuseup to64characters for profiles created forwireddevices.
Profile namemust not contain special characters or spaces. Note
that profiles that are automatically created by Connectivity Services
Director as part of device discovery or out-of-band changes may
contain the underscore (_) character.

Profile Name

Type the description of the profile.Description

2. Specify settings in the Priority Group and Traffic Settings section.
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The table listspriority groupsand the forwardingclasses theycontain inanexpandable

list. Priority groups refer to forwarding class sets in the device. You can perform these

tasks on priority groups and forwarding classes:

• To add a new priority group, click Add Priority Group. The Add Priority Group and

Traffic Control Profile Window opens. Enter the settings as described in

Table 41 on page 231.

Table 41: Add Priority Group and Traffic Control ProfileWindow

DescriptionField

Enter a name for the priority group.Priority Group Name

Traffic Control Profile Settings

Select a transmit rate percentage for the priority group.Transmit Rate (%)

Select a shaping rate percentage for the priority group.Shaping Rate (%)

• To edit a priority group or forwarding class’s properties, click the field that youwant

to edit in the table. The properties that can be edited are described in

Table 42 on page 231.

Table 42: Priority Group and Traffic Settings Table Properties

DescriptionField

Select to make the forwarding class lossless. Not applicable to priority groups.No Loss

Select tocause the forwardingclass to receivepreferential treatmentover a low-priorityqueue.
Unlimitedbandwidth is assigned toastrict-highpriorityqueue.Notapplicable topriority groups.

Strict High

Select thepercentageof interfacebandwidthassigned to the forwardingclassorpriority group.

If you have enabled Strict-High, you cannot reserve bandwidth for this traffic type.

Transmit Rate (%)

Select a shaping rate percentage for the forwarding class or priority group.Shaping Rate (%)

Select the percentage of the memory buffer allocated for storing packets for the forwarding
class. Not applicable to priority groups.

Buffer Size (%)

• To edit a forwarding class’s properties, click its name. The Edit Traffic Classification

and Shaping for priority group window opens. Enter the settings as described in

Table 43 on page 231.

Table 43: Edit and Add Traffic Classification and Shaping for Priority GroupWindow

DescriptionField

Select or specify a name for the forwarding class.Forwarding Class Name

Specify the internal queue numbers to which forwarding classes are assigned.Forwarding Class Queue
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Table 43: Edit and Add Traffic Classification and Shaping for Priority GroupWindow (continued)

DescriptionField

Select to make the forwarding class lossless.No Loss

Scheduler Map

Select if you want the queue to receive preferential treatment over a low-priority queue.
Unlimited bandwidth is assigned to a strict-high priority queue.

Strict High

Select the percentage of interface bandwidth assigned to the forwarding class.

If you have enabled Strict-High, you cannot reserve bandwidth for this traffic type.

Transmit Rate

Select a shaping rate percentage for the forwarding class.Shaping Rate

Select thepercentageof thememorybuffer allocated for storingpackets for the forwarding
class.

Buffer Size (%)

Traffic Classification

Select the classifier type that maps packets to a forwarding class and a loss priority.Classifier Type

Specify one or more code-points for associating with a forwarding class.Code Points

Indicates that packets have low loss priority. Select code points from the Code Points
table and use the LEFT and RIGHT arrows tomove them into the appropriate loss priority
table.

Loss Priority Low

Indicates that packets havemedium high loss priority. Select code points from the Code
Points table and use the LEFT and RIGHT arrows to move them into the appropriate loss
priority table.

Loss Priority Medium High

Indicates that packets have high loss priority. Select code points from the Code Points
table and use the LEFT and RIGHT arrows tomove them into the appropriate loss priority
table.

Loss Priority High

• To add a forwarding class to a priority group, click the Add Forwarding Class link at

theendof thepriority group’s list of forwardingclasses. TheAddTrafficClassification

and Shaping for priority group window opens. Enter the settings as described in

Table 43 on page 231.

• To remove a priority group or forwarding class, click theX at the end of its table row.

3. Specify priority-based flow control (PFC) settings in the PFC Settings section. Enter

the settings as described in Table 44 on page 232.

Table 44: PFC Settings for Campus Switching ELS CoS Profile with Hierarchical Port Scheduling (ETS)

DescriptionField

Enter the length of the cable attached to the input interface, in meters.Input Cable Length (meter)

Input
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Table44:PFCSettings forCampusSwitchingELSCoSProfilewithHierarchicalPortScheduling (ETS) (continued)

DescriptionField

Click to add an input congestion notification profile (CNP). A new entry appears in
the table.

Add

Click to remove the selected input CNP.Remove

Select the IEEE code point for the input CNP.IEEE Code Point

Enter the maximum receive unit (MRU) on an interface for traffic that matches the
PFC priority, in bytes.

Maximum Receive Size (bytes)

Output

Click to add an output CNP. A new entry appears in the table.Add

Click to remove the selected output CNP.Remove

Select the IEEE code point for the output CNP.IEEE Code Point

Select output queues on which to enable flow control (PFC pause).Queue List

4. Specify rewrite rule settings in the Rewrite Rule Settings section. Enter the settings

as described in Table 45 on page 233.

Table 45: Rewrite Rule Settings for Campus Switching ELS CoS Profile with Hierarchical Port Scheduling (ETS)

DescriptionField

The name of the forwarding class.Forwarding Name

The number corresponding to the forwarding queue. You cannot modify this
field.

Queue

Select a rewrite-rules mapping for the traffic that passes through the various
queues on the interface.

Rewrite Type

Specify a code-point for associationwith a forwarding class for loss priority low.Egress Code Point - Loss Priority Low

Specify a code-point for association with a forwarding class for loss priority
medium high.

EgressCodePoint - LossPriorityMediumHigh

Specify a code-point for association with a forwarding class for loss priority
high.

Egress Code Point - Loss Priority High

5. Click Done to save the changes to the profile.
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Specifying Settings for a Data Center Switching CoS Profile

YoucancreateaCoSprofile by specifying theprofile settingsand the traffic configuration

and shaping details.

To specify the settings for the CoS profile:

1. Enter the settings described in Table 46 on page 234. Required settings are indicated

by a red asterisk (*) that appears next to the field label in the user interface.

Table 46: CoS Profile Basic Settings for Data Center Switching

ActionField

Type the name of the profile.

Youcanuseup to64characters for profiles created forwireddevices.
Profile namemust not contain special characters or spaces. Note
that profiles that are automatically created by Connectivity Services
Director as part of device discovery or out-of-band changes may
contain the underscore (_) character.

Profile Name

Type the description of the profile.Description

2. In the Traffic Classification and Shaping Settings section, select one of these options:

• Hierarchical Port Scheduling (ETS)—Hierarchical port scheduling (Enhanced

Transmission Selection, or ETS) is a two-tier process that provides better port

bandwidth utilization and greater flexibility to allocate resources to queues and to

groups of queues (for QFX and QFabric devices).

• NonHierarchicalPortScheduling—Non-hierarchical scheduling is a one-tier process

that provides port bandwidth utilization and allocates resources to queues (for

EX4500 and EX4550 transit switches).

3. If you selected Hierarchical Port Scheduling (ETS), specify settings in the Priority

Group and Traffic Settings section.

The table listspriority groupsand the forwardingclasses theycontain inanexpandable

list. Priority groups refer to forwarding class sets in the device. You can perform these

tasks on priority groups and forwarding classes:
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• To add a new priority group, click Add Priority Group. The Add Priority Group and

Traffic Control Profile Window opens. Enter the settings as described in

Table 47 on page 235.

Table 47: Add Priority Group and Traffic Control ProfileWindow

DescriptionField

Enter a name for the priority group.Priority Group Name

Traffic Control Profile Settings

Select a transmit rate percentage for the priority group.Transmit Rate (%)

Select a shaping rate percentage for the priority group.Shaping Rate (%)

• To edit a priority group or forwarding class’s properties, click the field that youwant

to edit in the table. The properties that can be edited are described in

Table 48 on page 235.

Table 48: Priority Group and Traffic Settings Table Properties

DescriptionField

Select to make the forwarding class lossless. Not applicable to priority groups.No Loss

Select tocause the forwardingclass to receivepreferential treatmentover a low-priorityqueue.
Unlimitedbandwidth is assigned toastrict-highpriorityqueue.Notapplicable topriority groups.

Strict High

Select thepercentageof interfacebandwidthassigned to the forwardingclassorpriority group.

If you have enabled Strict-High, you cannot reserve bandwidth for this traffic type.

Transmit Rate (%)

Select a shaping rate percentage for the forwarding class or priority group.Shaping Rate (%)

Select the percentage of the memory buffer allocated for storing packets for the forwarding
class. Not applicable to priority groups.

Buffer Size (%)

• To edit a forwarding class’s properties, click its name. The Edit Traffic Classification

and Shaping for priority group window opens. Enter the settings as described in

Table 49 on page 235.

Table 49: Edit and Add Traffic Classification and Shaping for Priority GroupWindow

DescriptionField

Select or specify a name for the forwarding class.Forwarding Class Name

Specify the internal queue numbers to which forwarding classes are assigned.Forwarding Class Queue

Select to make the forwarding class lossless.No Loss

Scheduler Map
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Table 49: Edit and Add Traffic Classification and Shaping for Priority GroupWindow (continued)

DescriptionField

Select if you want the queue to receive preferential treatment over a low-priority queue.
Unlimited bandwidth is assigned to a strict-high priority queue.

Strict High

Select the percentage of interface bandwidth assigned to the forwarding class.

If you have enabled Strict-High, you cannot reserve bandwidth for this traffic type.

Transmit Rate

Select a shaping rate percentage for the forwarding class.Shaping Rate

Select thepercentageof thememorybuffer allocated for storingpackets for the forwarding
class.

Buffer Size (%)

Traffic Classification

Select the classifier type that maps packets to a forwarding class and a loss priority.Classifier Type

Specify one or more code-points for associating with a forwarding class.Code Points

Indicates that packets have low loss priority. Select code points from the Code Points
table and use the LEFT and RIGHT arrows tomove them into the appropriate loss priority
table.

Loss Priority Low

Indicates that packets havemedium high loss priority. Select code points from the Code
Points table and use the LEFT and RIGHT arrows to move them into the appropriate loss
priority table.

Loss Priority Medium High

Indicates that packets have high loss priority. Select code points from the Code Points
table and use the LEFT and RIGHT arrows tomove them into the appropriate loss priority
table.

Loss Priority High

• To add a forwarding class to a priority group, click the Add Forwarding Class link at

theendof thepriority group’s list of forwardingclasses. TheAddTrafficClassification

and Shaping for priority group window opens. Enter the settings as described in

Table 49 on page 235.

• To remove a priority group or forwarding class, click theX at the end of its table row.

4. If you selected Non Hierarchical Port Scheduling, specify settings in the Traffic

Configuration and Shaping table.

The table lists forwarding classes. You canperform these tasks on forwarding classes:

• To add traffic configuration and shaping details for different types of traffic, click

Add in the Traffic Configuration and Shaping box. The Add Traffic Classification

and Shaping window opens.

• Tomodify the details of an existing traffic configuration, select the traffic

configuration from the list and click Edit. The Edit Traffic Classification andShaping

window opens.
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NOTE: You canmodify some of the details in the Traffic Configuration
andShaping tablewithout having to open the Edit Traffic Classification
and Shaping window—by clicking on the field that you want tomodify.

• To delete a traffic configuration entry, select the traffic configuration from the list

and click Remove.

The system deletes the selected traffic configuration entry.

To create your own traffic type, click Add and then configure the settings described

in Table 50 on page 237.

Table 50: Traffic Configuration and Shaping for EX Switching and Campus Switching
ELS

DescriptionField

If you are editing a Connectivity Services Director default traffic type,
this field cannot be changed. If you are adding a traffic type, indicate
the type of traffic—this can be any value, such as a server name or
something to do with your business.

Traffic Type

If you are editing a Connectivity Services Director default traffic type,
this field cannot be changed. If you are adding a traffic type, you can
use one of the predefined forwarding classes for your switch or you
can create your own forwarding class. These forwarding classes are
always provided: nd_best-effort, nd_network-control,
nd_video-forwarding, and nd_expedited-forwarding. To create your
own forwarding class, type a name instead of selecting an option.

Most switches support the four predefined forwarding classes listed
above. The exception is the EX4300 switch, which has eight default
forwarding classes, including the standard four classes, plus
multicast-network-connect,multicast-assured-forwarding,
multicast-expedited-forwarding, andmulticast-network-connect.

Forwarding Name

Existing forwarding classes already have associated queues that
cannotbealtered. If youdefinedanewforwardingclassby specifying
your own Forwarding Name, then select an internal queue number
to which forwarding classes are assigned. Most switches support
queues 0 - 10. The exception is the EX4300 switch, which supports
queues 0 - 11.

By default, if a packet is not classified, it is assigned to the class
associated with queue 0. You can assign more than one forwarding
class to a queue number.

Forwarding Queue

Scheduler Map

A note in the Scheduler Map section indicates howmuch buffer size and bandwidth you have
available to configure. For example, the message “You have been left with 0 percent buffer size
and 0 percent bandwidth.” means that you have no available buffer or bandwidth, and youmust
reconfigure existing traffic types to free some bandwidth before configuring additional traffic
types.

Enable Low Priority if you want the queue to receive low priority.Low Priority
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Table 50: Traffic Configuration and Shaping for EX Switching and Campus Switching
ELS (continued)

DescriptionField

EnableStrictHighPriority if youwant thequeue to receivepreferential
treatmentover a low-priority queue.Unlimitedbandwidth is assigned
to a strict-high priority queue.

A strict-high priority queue receives preferential treatment over a
low-priority queue. Unlimited bandwidth is assigned to a strict-high
priorityqueue.Queuesare scheduledaccording to thequeuenumber,
starting with the highest queue, 7, with decreasing priority down
through queue 0. Traffic in higher-numbered queues is always
scheduled prior to traffic in lower-numbered queues. In other words,
in case of two high-priority queues, the queue with the higher queue
number is processed first.

NOTE: You canmodify this field in the Traffic Configuration and
Shaping table or from theTraffic Configuration andShapingwindow.

Strict High Priority

Buffer Size (%) is the size of thememory buffer allocated for storing
packets.Use theslider tospecify theschedulerBufferSizepercentage.

NOTE: You canmodify this value by double-clicking this field in the
Traffic Configuration and Shaping table or by sliding the bar in the
Traffic Configuration and Shaping window.

Buffer Size (%)

Bandwidth Reserved (%) is the amount of interface bandwidth
assigned to the queue. Move the slider to specify the Bandwidth
Reserved percentage. Defaults are:

• Data: 30%

• Voice: Strict High

• Video: 70%

• Network control: 0%

If Strict-High is enabled for this traffic type, you cannot reserve
bandwidth.

NOTE: This field displays the value based on either your input or on
the transmit-rate parameter from the switch, if that parameter is
configured. While specifying transmit-rate on the EX Series switch, if
youchoose to specify thevalueasanexact rate,ConnectivityServices
Director converts this value and displays it as a percentage in the
Bandwidth Reserved (%) field. You canmodify this percentage value
from the CoS Profile page.

Bandwidth Reserved (%)

Move the Shaping Rate slider to throttle the rate of packet
transmission by setting amaximum bandwidth (rate in bits per
second) or a maximum percentage of bandwidth for a queue or a
forwarding class.

Shaping Rate

Traffic Classification

Behavior aggregate classification classifies packets. The DSCP or DSCP IPv6 precedence bits of
the IP header convey the behavior aggregate class information. The information might also be
found in the IEEE 802.1ad, or IEEE 802.1p CoS bits.
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Table 50: Traffic Configuration and Shaping for EX Switching and Campus Switching
ELS (continued)

DescriptionField

Select a classifier type—DSCP, DSCP-IPv6, INET-precedence, or
IEEE-802.1—and associate the corresponding code-point aliases to
loss priorities.

NOTE: Youcanspecify code-point—losspriorityassociations forone
or more classifier types.

• DSCP—Differentiated services code point, a field in IPv4 headers,
is used to classify traffic.

• DSCP-IPv6—Differentiated services code point, a field in IPv6
headers, is used to classify traffic.

• INETprecedence—Field that indicatesclassof service rewrite rules
are used to classify traffic.

• IEEE-802.1—IEEE 802.1ad, or IEEE 802.1p CoS bits are used to
classify traffic.

Classifier Type

Classifier Code Points

Thecodepoints list includesall availableandunselectedcodepoints
for the selected classifier type.

Specify one or more code-point aliases or bit sets to associate with
a forwarding class by moving the value to one of the two lists, Loss
Priority Low or Loss Priority High.

Code Points

Indicate that packets have low loss priority by selecting code-point
aliases from the Code Points table and using the LEFT and RIGHT
arrows to move them into the appropriate loss priority table.

Loss Priority Low

Indicate that packets havemedium-low loss priority by selecting
code-point aliases from the Code Points table and using the LEFT
and RIGHT arrows to move them into the appropriate loss priority
table.

Loss Priority Medium-Low

Indicate that packets havemedium-high loss priority by selecting
code-point aliases from the Code Points table and using the LEFT
and RIGHT arrows to move them into the appropriate loss priority
table.

LossPriorityMedium-High

Indicate that packets have high loss priority by selecting code-point
aliases from the Code Points table and using the LEFT and RIGHT
arrows to move them into the appropriate loss priority table.

Loss Priority High

5. If you selectedHierarchical Port Scheduling (ETS), specify priority-based flow control

(PFC) settings in the PFC Settings section. Enter the settings as described in

Table 51 on page 240.

239Copyright © 2019, Juniper Networks, Inc.

Chapter 13: Configuring Class of Service (CoS)



Table 51: PFC Settings for Data Center Switching Hierarchical Port Scheduling (ETS) CoS Profile

DescriptionField

Enter the length of the cable attached to the input interface, in meters.Input Cable Length (meter)

Input

Click to add an input congestion notification profile (CNP). A new entry appears in
the table.

Add

Click to remove the selected input CNP.Remove

Select the IEEE code point for the input CNP.IEEE Code Point

Enter the maximum receive unit (MRU) on an interface for traffic that matches the
PFC priority, in bytes.

Maximum Receive Size (bytes)

Output

Click to add an output CNP. A new entry appears in the table.Add

Click to remove the selected output CNP.Remove

Select the IEEE code point for the output CNP.IEEE Code Point

Select output queues on which to enable flow control (PFC pause).Queue List

6. If you selected Non-Hierarchical Port Scheduling, specify priority-based flow control

(PFC) settings in the PFC Settings section. Enter the settings as described in

Table 52 on page 240.

Table 52: PFC Settings for Data Center Switching Non-Hierarchical Port Scheduling CoS Profile

DescriptionField

Input

Click to add an input congestion notification profile (CNP). A new entry appears in the
table.

Add

Click to remove the selected input CNP.Remove

7. If you selected Hierarchical Port Scheduling (ETS), specify rewrite rule settings in the

Rewrite Rule Settings section as described in Table 53 on page 240.

Table 53: Rewrite Rule Settings for Data Center Switching CoS Profile

DescriptionField

The name of the forwarding class.Forwarding Name
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Table 53: Rewrite Rule Settings for Data Center Switching CoS Profile (continued)

DescriptionField

The number corresponding to the forwarding queue. You cannot modify this
field.

Queue

Select a rewrite-rules mapping for the traffic that passes through the various
queues on the interface.

Rewrite Type

Specify a code-point for associationwith a forwarding class for loss priority low.Egress Code Point - Loss Priority Low

Specify a code-point for association with a forwarding class for loss priority
medium high.

EgressCodePoint - LossPriorityMediumHigh

Specify a code-point for association with a forwarding class for loss priority
high.

Egress Code Point - Loss Priority High

8. If you selected Non-Hierarchical Port Scheduling, click Configure Rewrite Rules at the

bottom of the screen to configure rewrite rules for a forwarding queue. The Configure

Rewrite Rules window appears. Specify rewrite rule settings as described below to

alter CoS values in outgoing packets on the outbound interfaces of an edge switch:

a. Select the forwarding class for which you want to create or modify rewrite rules.

Connectivity Services Director lists all the forwarding classes that you have used

for configuring traffic in the Traffic Configuration and Shaping section.

b. For each classifier’s loss priority, select a code-point alias for each loss-priority

type—Low, Medium-Low, Medium-High, and High.

9. Click Done to save the changes to the profile.

What to Do Next

After you have created a CoS profile for switching devices, you can associate the CoS

profile to a Port profile.

Related
Documentation

• Understanding Class of Service (CoS) Profiles on page 217
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CHAPTER 14

Configuring Link Aggregation Groups
(LAGs)

• Understanding Link Aggregation on page 243

• Managing and Creating a Link Aggregation Group on page 243

Understanding Link Aggregation

You can combine multiple physical Ethernet ports to form a logical point-to-point link,

known as a link aggregation group (LAG) or bundle. A LAG provides more bandwidth

than a single Ethernet link can provide. Additionally, link aggregation provides network

redundancy by load-balancing traffic across all available links. If one of the links fails,

the system automatically load-balances traffic across all remaining links. In a Virtual

Chassis, LAGs can be used to load-balance network traffic betweenmember routers.

Themaximum number of interfaces that can be grouped into a LAG and themaximum

number of LAGs supported on a router varies according to the router model and the

version of and the version of Juniper Networks Junos operating system (Junos OS) that

is running on that router.

Related
Documentation

Managing and Creating a Link Aggregation Group on page 243•

Managing and Creating a Link Aggregation Group

IEEE 802.3ad link aggregation enables you to group Ethernet interfaces to form a single

link layer interface, also known as a link aggregation group (LAG) or bundle.

Aggregating multiple links between physical interfaces creates a single logical

point-to-point trunk linkoraLAG.LinkAggregationControlProtocol (LACP), acomponent

of IEEE 802.3ad, provides additional functionality for LAGs.

LACP ensures that both ends of the Ethernet link are functional and aremembers of the

aggregation group before the link is added to the LAG. If you use LACP, make sure that

LACP is enabled at both the local and remote ends of the link.When LACP is configured,

it detects misconfigurations on the local end or the remote end of the link. Thus, LACP

can help to prevent communication failure.When LACP is not enabled, a local LAGmight

attempt to transmitpackets toa remotesingle interface,whichcauses thecommunication
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to fail. However, when LACP is enabled, a local LAG cannot transmit packets unless a

LAGwith LACP is also configured on the remote end of the link.

Themaximum number of interfaces that can be grouped into a LAG and themaximum

number of LAGs supported on a router varies according to the router model and the

version of Juniper Networks Junos operating system (Junos OS) that is running on that

router.Beawareof themaximumnumberof interfacesperLAGandthemaximumnumber

of LAGs that are supported on your routers by referring to your device specific

documentation before implementing LAG in your network.

NOTE: Youonly see theManageLagoptionunderDeviceManagementwhen
a qualified router is selected in the View Pane.

When creating LAGs, follow these guidelines:

• Youmust configure the LAG on both sides of the link.

• Youmust set the interfaces on either side of the link to the same speed.

• You can configure and apply firewall filters on a LAG.

NOTE: Youonly see theManageLagoptionunderDeviceManagementwhen
a qualified router is selected in the View Pane.

This topic includes:

• Link Aggregation Group Options on page 244

• Creating a Link Aggregation Group on page 245

• What To Do Next on page 247

Link Aggregation Group Options

From the Manage LAG page, you can:

• Create a new Link Aggregation by clickingCreate. The Create Link Aggregationwindow

opens—for directions, see “Creating a Link Aggregation Group” on page 245.

• Modify an existing Link Aggregation by selecting it and clicking Edit. The Modify Link

Aggregationwindowopens.Youcanmodifyall the fields in theModifyLinkAggregation

window, except the Interface Name field.

• Delete a Link Aggregation Group by selecting it and clicking Delete.

Table 54 on page 245 describes the information provided about the link aggregation

configurations on the LACP (Link AggregationControl Protocol) Configuration page. This

page lists all link aggregation groups defined on the selected device.
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Table 54: LACP (Link Aggregation Control Protocol) Configuration Fields

DescriptionField

Name given to the aggregated interface when the LAGwas created.Logical Interface Name

Names of individual member interfaces.Member Interfaces

Mode in which LACP packets are exchanged between the interfaces.

The possible modes are:

• Active—Indicates that the interface initiates transmission of LACP
packets

• Passive—Indicates that the interface responds only to LACP
packets.

LACPMode

The description for the LAG.

TIP: If you cannot view the entire description, you can resize the
Description column by clicking the column border in the heading and
dragging it.

Description

The deployment state of the link aggregation. Deployment state can
be:

• Pending Deployment—Indicates that the LAG is not yet deployed
on the device.

• Deployed—Indicates that the LAG is deployed on the device.

• Pending Removal—Indicates that the LAG is deleted.

Deployment State

Date and time when this profile was created.Creation Time

Date and time when this profile was last modified.Update Time

The username of the user who created or modified the profile.User Name

TIP: All columnsmight not be displayed. To show or hide fields in the LACP
(Link Aggregation Control Protocol) Configuration table, click the DOWN
arrow on the field header, select Columns, and select or clear the check box

adjacent to the field that you want to show or hide.

Creating a Link Aggregation Group

You can create one ormore LAGs for your device in Device view. The number of interfaces

that can be grouped into a LAG and the total number of LAGs supported on a router

varies according to router model.
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To create a link aggregation group:

1. In the View pane, select a router for link aggregation.

NOTE: TheManage LAG task is only available when a qualified router is
selected in the View pane.

2. Click the Build icon in the Connectivity Services Director banner.

3. SelectWired >Manage LAG in the Tasks pane.

The Manage LAG page opens.

4. Click Create.

The Create Link Aggregation window opens.

5. Use the up and down arrows to select an AE Name for the aggregation interface. The

interface name begins with ae followed by an interface number.

6. Select the mode in which LACP packets are to be exchanged between interfaces,

either Active or Passive.

• Active—Indicates that the interface initiates transmission of LACP packets

• Passive—Indicates that the interface responds only to LACP packets.

7. Enter a description for the link aggregation.

8. Configure up to eight available interfaces on the LAG. Select one or more interfaces

from the Available list and then click the RIGHT arrow tomove them to the Selected

list.

NOTE: The Available interfaces list displays only those interfaces that
are not part of any link aggregation.

9. If the device is capable of using MC-LAGs, an MC-LAGs section also appears in the

Create Link Aggregation window. For information about MC-LAG configuration, see

MC-LAG Settings.

10. ClickOK to save the link aggregation configuration.
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Amessage confirms that the link aggregation is created successfully and ready to be

deployed to a device. If the configuration contains an error, the message instead

indicates the error.

11. ClickOK to close the information message.

The LAG appears in the Manage LAG list.

What To Do Next

The configuration changes that youmake in the Build mode are not deployed to devices

automatically. After you create a link aggregation group, youmust manually deploy the

changes to the routerss inDeploymode. Fordetails, seeDeployingConfiguration toDevices.

TIP: Even though link aggregation configuration is not contained within a
profile, you can view the link aggregationgroupsassigned toa router by using
the View Assigned Profiles task in Build mode.

Related
Documentation

• Understanding Link Aggregation on page 243

247Copyright © 2019, Juniper Networks, Inc.

Chapter 14: Configuring Link Aggregation Groups (LAGs)



Copyright © 2019, Juniper Networks, Inc.248

Connectivity Services Director User Guide



CHAPTER 15

Managing Network Devices

• Viewing the Device Inventory Page in Device View of Connectivity Services

Director on page 250

• Viewing the Physical Inventory of Devices on page 252

• Viewing LicensesWith Connectivity Services Director on page 253

• ViewingaDevice'sCurrentConfiguration fromConnectivityServicesDirectoronpage254

• Accessing a Device’s CLI from Connectivity Services Director on page 254

• Accessing a Device’s Web-Based Interface from Connectivity Services

Director on page 255

• Deleting Devices on page 257

• Rebooting Devices on page 257
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Viewing the Device Inventory Page in Device View of Connectivity Services Director

The Device Inventory page lists devices managed by Connectivity Services Director and

provides basic information about the devices, such as IP address and current operating

status. TheDevice Inventory page is available inBuild andDeploymodeand is thedefault

landing page for Build mode.

The scope you have selected in the View pane and the network view that you have

selected fromtheViewselectordetermineswhichdevicesare listed in theDevice Inventory

page. For example:

• If youare in theDeviceViewandselectMyNetwork, all devicesmanagedbyConnectivity

Services Director are listed.

The Device Inventory page provides three pie charts that summarize the status of the

devices in your selected scope:

• Devices by Family—Indicates the proportion of devices in each device family.

• Connection State—Shows the proportion of devices that are up or down. In this chart,

Virtual Chassis count as one device.

• Configuration State—Shows the proportion of devices in each configuration state. See

theConfigStateentry inTable55onpage250 fordefinitionsof theconfiguration states.

Mouse over a pie segment to view the actual number of devices and the percentage

represented by that pie segment.

Table 55 on page 250 describes the fields in the Device Inventory table.

Table 55: Fields in the Device Inventory Table

DescriptionField

Configured name of the device or IP address if no hostname is configured.Hostname

IP Address of the device.IP Address

Serial number of device chassis.Serial Number

Model number of the device.Platform

Operating system version running on the device.OS Version

Device family of the device, such as JUNOS for MX Series routers.Device Family

Type of the device:

• ROUTER—ACX Series routers, M Series routers, MX Series routers, and
PTX Series routers

Device Type
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Table 55: Fields in the Device Inventory Table (continued)

DescriptionField

Connection status of the device in Connectivity Services Director:

• UP—Device is connected to Connectivity Services Director.

• DOWN—Device is not connected to Connectivity Services Director.

• N/A—Access point state is unavailable to Connectivity Services Director.

Connection State

Displays the configuration status of the device:

• In Sync—The configuration on the device is in sync with the Connectivity
Services Director configuration for the device.

• Out Of Sync—The configuration on the device does not match the
Connectivity Services Director configuration for the device. This state is
usually the result of the device configuration being altered outside of
Connectivity Services Director.

You cannot deploy configuration on a device from Connectivity Services
Director when the device is Out Of Sync. To resolve this state, use the
Resynchronize Device Configuration task in Deploy mode.

• Sync failed—An attempt to resynchronize an Out Of Sync device failed.

• Synchronizing—The device configuration is in the process of being
resynchronized.

• N/A—The device is down or is an access point.

Config State

Displays if the device is directly manageable or not.

This is a hidden field. To display the Manageability State field, click any
column, click the down arrow to expand the list, select Columns from the
list, and then enableManageability State.

Manageability
State

Related
Documentation

Viewing the Physical Inventory of Devices on page 252•

• Viewing LicensesWith Connectivity Services Director on page 253

• ViewingaDevice'sCurrentConfiguration fromConnectivityServicesDirectoronpage254
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Viewing the Physical Inventory of Devices

Youcanviewthephysical inventoryofall thedevices in yournetwork in theDevicePhysical

Inventory page. The Device Physical Inventory page displays information about the slots

that are available for a device and provides information about power supplies, chassis

cards, fans, part numbers, and so on. Connectivity Services Director displays hardware

inventory by device name, based on data retrieved both from the device during discovery

and resynchronizing operations, and from the data stored in the hardware catalog. For

eachmanaged device, the physical inventory page provides descriptions for field

replaceable units (FRUs), part numbers, model numbers, and the pluggable locations

fromwhich empty slots are determined.

To view the Device Physical Inventory page, while in the Build mode, select a router from

the View pane and select DeviceManagement > Physical Inventory from the Tasks pane.

The physical inventory page displays themodel number, part number, serial number, and

description for the following, depending on the device that you selected:

• For standalone routers, the pagedisplays details of the switch, the chassis, the Flexible

PICConcentrator (FPC), thePIC slot, thePIC installed in thePIC slot, the power supply,

the fan tray, and the routing engine.

You can view the following details from the Device Physical Inventory page as described

in Table 56 on page 252.

Table 56: Fields in the Device Physical Inventory Table

DescriptionField

Nameof the device and the components that are part of the device. By default, Connectivity
Services Director displays the device and components in an expanded tree structure. You
can click a device or component to collapse or expand the sub-components.

Item

Model number of the FRU hardware component.Model Number

Part number of the router chassis component.Part Number

The hardware serial number of the device.Serial Number

The description about the component.Description

Related
Documentation

Viewing the Device Inventory Page in Device View of Connectivity Services Director on

page 250

•

• Viewing LicensesWith Connectivity Services Director on page 253

• ViewingaDevice'sCurrentConfiguration fromConnectivityServicesDirectoronpage254
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Viewing LicensesWith Connectivity Services Director

Juniper Networks devices require a license to operate some features. You can view the

licenses for devices connected to Connectivity Services Director.

To view the license for a Juniper Networks device on your network:

1. Select the Build icon in the Connectivity Services Director banner.

2. In the View pane, select a device.

3. In the Tasks pane, select View License Information.

The Licenses page for that object is displayed with the fields listed in

Table 57 on page 253.

Table 57: Viewing Licenses with Connectivity Services Director

DescriptionField

Name of the licensed SKU or feature. It can be used to look up the license with
Juniper Networks. Not all devices support this.

Feature Name

Number of times an item has been licensed. This value can have contributions
frommore than one licensed SKU or feature. Alternatively, it can be 1, no matter
howmany times it has been licensed.

License Count

Numberof times the feature is used. For sometypesof licenses, the licensecount
will be 1, no matter howmany times it is used. For capacity-based licensable
items, if infringement is supported, the license count can exceed the given count,
which has a corresponding effect on the need count.

Used Count

Numberof times the feature is usedwithout a license.Notall devices canprovide
this information.

Need Count

Number of instances of the feature that are provided by default.Given Count

NOTE: If a device does not have a license, a blank page is displayed with
themessage,No license is installedon this device. If you are sure the device

has a license, try resynchronizing the device before displaying the license
again.

NOTE: If youapplyanewlicense toanexistingdevice, youmust resynchronize
the device before the new license is seen in Connectivity Services Director.
For directions, see “Resynchronizing Device Configuration” on page 738.
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Related
Documentation

Viewing the Device Inventory Page in Device View of Connectivity Services Director on

page 250

•

• Viewing the Physical Inventory of Devices on page 252

• ViewingaDevice'sCurrentConfiguration fromConnectivityServicesDirectoronpage254

Viewing a Device's Current Configuration fromConnectivity Services Director

You can view a device’s current configuration from Connectivity Services Director. This

is a convenient way to view device configurations without leaving Connectivity Services

Director.

To view a device's current configuration:

1. Click Build or Deploy in the Connectivity Services Director banner.

2. Select the device in the View pane.

3. Select DeviceManagement > ShowCurrent Configuration in the Tasks pane.

4. The device’s current configuration displays in the main window.

Related
Documentation

Viewing the Device Inventory Page in Device View of Connectivity Services Director on

page 250

•

• Viewing the Physical Inventory of Devices on page 252

• Viewing LicensesWith Connectivity Services Director on page 253

Accessing a Device’s CLI fromConnectivity Services Director

Connectivity Services Director enables you to connect to the CLI for devices in your

network, using SSH.

This topic describes the steps to connect to a router by using SSH (Secure Shell). SSH

isacryptographicnetworkprotocol used for remote shell servicesor commandexecution.

SSH is one of the many access services that are supported on the Juniper Networks

devices. All Juniper Network devices have SSH enabled by default.

To connect to a device by using SSH:

1. Do one of the following:

• In the View pane, select the device to which you want to connect.

• In the Topology View, locate the device to which you want to connect.

2. Do one of the following:
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• With the device selected in the View pane, select Buildmode and select Tasks >

DeviceManagement > SSH to Device.

• While in the Topology View, select the device to which you want to launch the SSH

connection and click DeviceManagement > SSH To Device.

The SSH to Device dialog box appears.

3. Enter theusernameandpassword toconnect to the selecteddeviceandclickConnect.

NOTE: Ensure that you have removed Pop-Up blockers, if any, before you
click Connect.

TheSSHconsole to the router or controller opens in a separatebrowser taborwindow

depending on your browser settings. Refer to theMXSeries documentation for more

information about using the CLI for MX Series routers.

NOTE: Any configuration changes youmake toadevice, using theCLI qualify
as out-of-band changes in Connectivity Services Director. Out-of-band
configurationchangescancause theconfigurationstateofamanageddevice
tobecomeoutof sync,which indicates that thedeviceconfigurationno longer
matches the Buildmode configuration for the device. Use the Resynchronize
Device Configuration task in Deploymode to resynchronize the device
configuration.

Related
Documentation

Accessing a Device’s Web-Based Interface from Connectivity Services Director on

page 255

•

Accessing a Device’sWeb-Based Interface fromConnectivity Services Director

Connectivity Services Director enables you to connect to the routers in your network,

using the deviceWeb-based interface.

This topic describes the steps to connect to a router by using the J-Web interface or to

a controller by usingWeb View. The J-Web interface is a graphical user interface, using

which you canmonitor, configure, troubleshoot, andmanage routers. Web View is a

web-basedmanagementapplication thatenables you toperformcommonconfiguration

andmanagement tasks on devices.

You can connect and configure a device by using the J-Web interface or Web View only

if the device is configured to accept HTTP or HTTPS as amanagement service. You can

configure HTTP or HTTPS as amanagement service using the Device Common Settings

profile.
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To connect to a device using the J-Web interface or Web View:

1. Do one of the following:

• In the View pane, select the device to which you want to connect.

• In the Topology view, locate the device to which you want to connect.

2. Do one of the following:

• While selecting the device in the View pane, select Build mode and select Tasks

pane > DeviceManagement > LaunchWeb View.

• While in the Topology View, select the device for which youwant to launch theWeb

connection and click DeviceManagement > LaunchWeb View.

TheWeb View or J-Web Login page appears.

3. Enter the username and password to connect to the selected router and click Login.

If the credentials that you entered are valid, the system displays the J-Web orWeb

View home page for the selected device.

NOTE: Any configuration changes youmake to a device using theWeb
interface qualify as out-of-band changes in Connectivity Services Director.
Out-of-band configuration changes can cause the configuration state of a
managed device to become out of sync, which indicates that the device
configuration no longermatches theBuildmodeconfiguration for thedevice.
Use the Resynchronize Device Configuration task in Deploymode to
resynchronize the device configuration.

Related
Documentation

Accessing a Device’s CLI from Connectivity Services Director on page 254•
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Deleting Devices

You can delete devices that are no longer used from Connectivity Services Director.

Deleting adevice removes all device configuration anddevice inventory information from

the Junos Space database. Once a device is deleted from the database, all the profiles

associations, device configurations, and inventory information of the deleted device are

also deleted. However, the systemmaintains the audit logs andmonitoring data for the

device even after the device is deleted.

Use the Delete Devices page to delete devices fromConnectivity Services Director.While

inBuildmode, clickDeleteDevices fromtheTasks>DeviceManagementmenu.TheDelete

Devices page appears.

The Delete Devices page displays the devices contextually depending on your selection

in the View pane. For example, if you select a particular switch family in Device View and

click Delete Devices, only switches that belong to that switch family are displayed.

To delete devices, complete the following tasks:

1. Select the check box adjacent to the devices that you want to delete.

2. Click Done.

ConnectivityServicesDirectorprompts you toconfirm thedeletion.ClickYes to confirm

the deletion or No to go back andmake changes to the selection.

Related
Documentation

Rebooting Devices on page 257•

Rebooting Devices

Use the Reboot Devices task to immediately reboot the selected device. This task is

available in all scopes when in Build mode. To reboot one or more devices immediately:

1. Select the scope in the View pane that contains the devices you want to reboot.

2. Select Reboot Devices from the Tasks pane.

3. Expand the tree on the page as needed to locate the available devices.

4. Select the check box for one or more devices.

5. Click Done to start the reboot or click Cancel to return to the Device Inventory page.

The rebooting process triggers a Cold Start Alarm that can be seen in Fault mode.
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Related
Documentation

• Deleting Devices on page 257

Copyright © 2019, Juniper Networks, Inc.258

Connectivity Services Director User Guide



PART 5

Building a Topology View of the Network

• Downloading and Installing CSD-Topology on page 261

• Configuring Topology Acquisition and Connectivity Between the CSD-Topology and

Path Computation Clients on page 289

• Accessing the Topology View of CSD-Topology on page 299
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CHAPTER 16

Downloadingand InstallingCSD-Topology

• CSD-Topology Installation and Configuration Overview on page 261

• Installation Prerequisites on page 262

• Installing the CSD-Topology Software Using the RPM Bundle on page 262

• MinimumHardwareandSoftwareRequirements for JunosVMonVMWareonpage263

• Installing the JunosVM for CSD-Topology on page 264

• Connecting an x86 Server to the Network on page 281

• Interactive Method of Installing the RPM Image and CSD-Topology Software from a

USB or DVD Drive on page 286

CSD-Topology Installation and Configuration Overview

Install JuniperNetworksCSD-Topologybydownloading and installing theCSD-Topology

RPM bundle.

For the RPM bundle installation, we recommend that you install CentOS 6.6 or 6.7 with

the minimal ISO. If you are using a different version of Linux, contact JTAC to determine

whether your Linux version is supported.

After you successfully install the CSD-Topology software on an x86 server, you must

establish a connection between the CSD-Topology and the network by configuring Path

Computation Element Protocol (PCEP) on each PE router to configure the router as a

Path Computation Client (PCC). A PCC supports the configurations related to the Path

Computation Element (PCE) and communicates with the CSD-Topology (PCE), which

by default is configured to accept a PCEP connection from any source address. After you

have established communication between the CSD-Topology and the PCCs, you can

configure topology acquisition usingBGP-LS. For BGP-LS topology acquisition, youmust

configure both the CSD-Topology and the PCC routers.
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NOTE:

We recommend that you use BGP-LS instead of IGP adjacency for topology
acquisition for the following reasons:

• The OSPF and IS-IS databases have lifetime timers, whichmeans that if
the OSPF or IS-IS neighbor is down, the corresponding database is not
removed immediately. CSD-Topology is, therefore, not able to determine
whether the topology is valid.

• Using BGP-LSminimizes the risk of making the JunosVM a transit router
between AS areas if the GREmetric is not properly configured.

• Typically, CSD-Topology is located in a Network Operations Center (NOC)
Data Center, multihops away from the backbone andMPLS TE routers.
This iseasilyaccommodatedbyBGP-LS,butmoredifficult for IGPprotocols
because they would have to employ a tunnelingmechanism such as GRE
to establish adjacency.

Related
Documentation

Connecting an x86 Server to the Network on page 281•

Installation Prerequisites

Before you install CSD-Topology, ensure your systemmeets the following requirements:

• Recommendedminimum hardware requirements:

• 32 GB RAM

• 500 GB HDD

• CSD-Topology supports the CentOS 6.x versions only. CentOS 7 is not supported.

Related
Documentation

Connecting an x86 Server to the Network on page 281•

Installing the CSD-Topology Software Using the RPMBundle

We recommend that you install CentOS 6.6 or 6.7 with the minimal ISO. CentOS can be

downloaded from http://mirror.centos.org/centos/6/isos/x86_64. If you are using a

different version of Linux, contact JTAC to determine whether your Linux version is

supported.

For thehardware requirements thatmustbemet for installing theCSD-Topologysoftware

or virtual machine (VM), see “Installation Prerequisites” on page 262.

1. Access the Junos Space Connectivity Services Director software download page:

https://www.juniper.net/support/downloads/?p=spacecsd
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2. Select the Software tab.

3. From the Version drop-downmenu, select 2.0.

4. From under the Application Package heading, download CSD-Topology.

5. Install the RPM bundle.

[root@hostname~]# rpm -ivh 
CSD-Topology-Bundle-2.1.0-20160703_202104_67972_345.x86_64.rpm
[root@hostname~]# cd /opt/csd/csd_topology_bundle/
[root@hostname csd_topology_bundle]# ./install.sh 

During the installation, youmay need to respond to prompts about configuring bridge

interfaces. The existing eth0 bridge will need to bemigrated to external0 bridge, and

the existing eth1 bridge tomgmt0 bridge. If the systemEthernet interface name is not

already eth0, you must manually create the bridge interface.

The installation process prompts you to enter different credentials to use such as

credentials for the Cassandra server. Specifically, the user credentials that are used

to access the GUI are also used to validate API users.

Youmust ensure that the security settings (such as iptables and SELinux) allow the

required services and that the underlying networking settings (such as IP addresses

and interfaces)arecorrectly configured. In thecontextofConnectivityServicesDirector,

access to the following ports is necessary:

• Access to port 8443

• Outbound SSH connections to perform the CLI data collection

• Inbound PCEP connections (TCP port 4189) for networks using PCEP

Related
Documentation

Installation Prerequisites on page 262•

MinimumHardware and Software Requirements for Junos VM on VMWare

Table 58 on page 263 lists the hardware requirements.

Table 58: MinimumHardware Requirements for VMware

ValueDescription

Minimum of 2Number of cores

2 GBMemory

Local or NASStorage

Table 59 on page 264 lists the software requirements.
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Table 59: Software Requirements for VMware

ValueDescription

ESXi 5.5 Update 2Hypervisor

vSphere 5.5 or vCenter ServerManagement Client

Related
Documentation

Installing the JunosVM for CSD-Topology on page 264•

Installing the JunosVM for CSD-Topology

TheCSD-Topology runs Junos ina virtualmachine (JunosVM) that uses routingprotocols

tocommunicatewith thenetworkanddynamically learn thenetwork topology. Toprovide

real-time updates of the network topology, the JunosVM, which is based on a virtual

route reflector (VRR), establishes aBGP-link state (LS)peering sessionwith oneormore

routers from the existing MPLS TE backbone network.

The VRR feature allows you to implement route reflector capability using a general

purposevirtualmachine that canbe runona64-bit Intel-basedbladeserver or appliance.

Becausea route reflectorworks in thecontrol plane, it can run ina virtualizedenvironment.

A virtual route reflector on an Intel-based blade server or appliance works the same as

a route reflector on a router, providing a scalable alternative to full mesh internal BGP

peering. For more information regarding VRR, see Understanding Virtual Route Reflector

VRRsupportsdifferentphysicalPCIdevicessuchasE1000andVRRNET3.Theprocedure

in this section is specific to E1000 and VRRNET3 devices.

The JunosVM (VRR) software image is located at

https://www.juniper.net/support/downloads/?p=vrr#sw.

The IP address of the JunosVM is configurable in the northstar.cfg file. The name of the

property is ntad_host and it defaults to 172.16.16.2. In the sample configuration scenario

described in this topic, an IP address is assigned to the Ethernet interface, eth1, of the

CSD-Topology VM, and an IP address is assigned to themanagement Ethernet interface,

em0, of the JunosVM.

NOTE: Theconfigurationdiscussed in this sectionassumes that the JunosVM
can be reached at the 172.16.16.2 address. If a different address is used for
the connection between the JunosVM and CSD-Topology VM, youmust
update the /opt/csd-topology/data/northstar.cfg file (the property name is

ntad_host=172.16.16.2) to point to the correct address where the JunosVM
can be reached.

The interfaces, eth0 and eth2, of the CSD-Topology VMmust be connected to the

management Ethernet interfaces, em1 and em2, respectively, of the JunosVM or the
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Hypervisor. The connection between eth0 and em1 is the router-facing link, whereas the

connection between eth2 and em2 is the management link.

NOTE: The procedure for installing the JunosVM for CSD-Topology has been
validated only for Junos OS Release 14.2R6.

To installVRRwithvSphere forE1000andVRRNET3adaptersandconfigure the JunosVM

(VRR VM) for CSD-Topology, perform these tasks:

• Setting Up the Datastore on page 265

• Creating VRR VMs on page 267

• Configuring the JunosVM on page 275

• Configuring the CSD-Topology Server with the JunosVM IP Address on page 276

• Verifying theConnectivityBetween theCSD-TopologyServer and JunosVMonpage277

• Verifying That the CSD-Topology Services Are Running on page 277

• Stopping Firewall on theCSD-Topology Server on page 278

• Configuring Peer Routers and Topology Acquisition on the JunosVM on page 278

• Specifying the Topology Details in the Connectivity Services Director GUI on page 280

Setting Up the Datastore

To upload VRR to the ESXi datastore:

1. Download the VRR software package for VMware from the VRR page.

2. Launch the vSphereWeb Client for your ESXi server and log in to the server.

3. Click the Summary tab, select the datastore under Storage, right-click, and select

Browse Datastore.
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4. In the Datastore Browser, click the Upload button, select Upload File, and upload the

jinstall64-vrr*.vmdk files for the package contents
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Creating VRR VMs

To create a JunosVM or VRR VM:

1. In the left navigation pane, select the ESXi server. In the Getting Started tab, click

Create a new virtual machine.

The Create New Virtual Machine wizard appears.

2. In the Configuration pane, select the Custom button and click Next.
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3. In the Name and Location pane, specify the name of the VM and click Next. For

example, CSD-Topology_JunosVM for the JunosVM.

4. In the Storage pane, select appropriate datastore (for example, datastore1) for the

destination storage of the VM and click Next.
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5. In the Virtual Machine Version pane, select the Virtual Machine Version: 8 button and

click Next.

6. In the Guest Operating System pane, select theOther button, selectOther (64-bit)

from the list, and click Next.
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7. In the CPUs pane, select 2 for the number of cores per virtual socket and click Next.

8. In the Memory pane, select 2 GB from the Memory Size list for the VM and click Next.
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9. In the Network pane, select 3 from the list, assign the proper vswitch to the E1000

adapters, and click Next.

10. In the SCSI Controller pane, select the LSI Logic SAS button (default option is LSI

Logic Parallel) and click Next.
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11. In the Select a Disk pane, select the Use an existing virtual disk button and click Next.

12. In theSelect ExistingDisk pane, clickBrowse to select the appropriate jinstall64-vmx*

file from the datastore and click Next.
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13. In the Advanced Options pane, click Next to accept the default options.

14. In the Ready to Complete pane, click Finish.
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Configuring the JunosVM

To configure the JunosVM:
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1. Enter the following commands from the JunosOSCLI interface. Replace the variables

with actual values to suit your network needs

set system host-name csd_topology_junosvm
set system root-authentication encrypted-password xxxx
set system login announcement "This JunOS VM is running in non-persistent 
mode.\nIf you make any change on this JunOS VM,\nPlease make sure you save to
 the Host using net_setup.py utility, otherwise the config will be lost if 
this VM is restarted.\n\n"

set system processes routing force-32-bit
set interfaces em0 unit 0 family inet address Management IP address on JunosVM
set interfaces em2 unit 0 family inet address Management IP address on JunosVM
set interfaces lo0 unit 0 family inet filter input protect-re
set interfaces lo0 unit 0 family mpls
set routing-options static route 0.0.0.0/0 next-hop next-hop-address
set routing-options autonomous-system 36000
set protocols topology-export
set protocols mpls traffic-engineering database import igp-topology
set protocols mpls traffic-engineering database import policy TE
set protocols bgp group csdtopology  type internal
set protocols bgp group csdtopology  description "csdtopology  BGP-TE Pering"
set protocols bgp group csdtopology  local-address JunosVM management IP address
set protocols bgp group csdtopology  family traffic-engineering unicast
set protocols bgp group csdtopology  allow 0.0.0.0/0
set protocols isis traffic-engineering igp-topology
set policy-options prefix-list internal-net csdtopology  server IP address
set policy-options policy-statement TE term 1 from family traffic-engineering
set policy-options policy-statement TE term 1 then accept
set policy-options policy-statement TE from family traffic-engineering
set policy-options policy-statement TE then accept
set firewall interface-set mgmt-intf em0.0
set firewall filter protect-re term mgmt-intf from interface-set mgmt-intf
set firewall filter protect-re term mgmt-intf then accept
set firewall filter protect-re term internal-net from prefix-list internal-net
set firewall filter protect-re term internal-net then accept
set firewall filter protect-re term ssh from protocol tcp
set firewall filter protect-re term ssh from port ssh
set firewall filter protect-re term ssh then accept
set firewall filter protect-re term bgp from protocol tcp
set firewall filter protect-re term bgp from port bgp
set firewall filter protect-re term bgp then accept
set firewall filter protect-re term ntp from protocol udp
set firewall filter protect-re term ntp from port ntp
set firewall filter protect-re term ntp then accept
set firewall filter protect-re term ospf from protocol ospf
set firewall filter protect-re term ospf then accept
set firewall filter protect-re term icmp from protocol icmp
set firewall filter protect-re term icmp then accept
set firewall filter protect-re term traceroute from protocol udp
set firewall filter protect-re term traceroute from port 33200-33600
set firewall filter protect-re term traceroute then accept
set firewall filter protect-re term default-discard then syslog
set firewall filter protect-re term default-discard then discard

Configuring the CSD-Topology Server with the JunosVM IP Address
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To associate the CSD-Topology VMwith JunosVM:

1. Establish an SSH session with the server running the CSD-Topology software.

2. Edit northstar.cfg file as follows:

modify /opt/csd-topology/data/northstar.cfg ntad_host=Management IP address of
the JunosVM

wherentad_host is thenameof the topologydiscoveryprocess runningon the JunosVM.

In this example, the management IP address of the JunosVM is 172.16.16.2.

3. Restart the JunosVM services.

sservice csd_topology restart all

Verifying the Connectivity Between the CSD-Topology Server and JunosVM

To verify the connectivity between the CSD-Topology server and JunosVM:

1. Establish a session with the server running the CSD-Topology software.

2. Run the netstat command to verify that connectivity is established between the

CSD-Topology server and JunosVM.

[root@csd-topo ~]# netstat -an | grep 450
tcp        0      0 172.16.16.1:35178           172.16.16.2:450             
ESTABLISHED

Verifying That the CSD-Topology Services Are Running

To verify that the CSD-Topology services are running correctly:

1. Access CSD-Topology server VM.

2. Run the csd_topology status command.

[root@csd-topo ~]# csd_topology status
infra:cassandra                  RUNNING   pid 1881, uptime 4 days, 21:12:20
infra:ha_agent                   RUNNING   pid 1880, uptime 4 days, 21:12:20
infra:haproxy                    RUNNING   pid 1877, uptime 4 days, 21:12:20
infra:nodejs                     RUNNING   pid 2558, uptime 4 days, 21:10:47
infra:rabbitmq                   RUNNING   pid 1879, uptime 4 days, 21:12:20
infra:zookeeper                  RUNNING   pid 1878, uptime 4 days, 21:12:20
listener1:listener1_00           RUNNING   pid 1876, uptime 4 days, 21:12:20
northstar:mladapter              RUNNING   pid 2707, uptime 4 days, 21:10:04
northstar:npat                   RUNNING   pid 2661, uptime 4 days, 21:10:15
northstar:npat_ro                RUNNING   pid 2658, uptime 4 days, 21:10:15
northstar:pceserver              RUNNING   pid 2586, uptime 4 days, 21:10:36
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northstar:pcserver               RUNNING   pid 2620, uptime 4 days, 21:10:25
northstar:toposerver             RUNNING   pid 2659, uptime 4 days, 21:10:15

Stopping Firewall on theCSD-Topology Server

You can optionally stop firewall services. To stop firewall services on the CSD-Topology

server:

1. Access CSD-Topology server VM.

2. Stop firewall services on the CSD-Topology server.

[root@csd_topo csd_topology_bundle]# service iptables stop

Configuring Peer Routers and Topology Acquisition on the JunosVM

To configure the peer route settings on the JunosVM for BGP peering:

1. Configure a policy.

[edit policy-options]
user@PE1# set policy-statement TE term 1 from family traffic-engineering
user@PE1# set policy-statement TE term 1 then accept
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2. Configure BGP-link state (LS) distribution on the CSD-Topology for topology

acquisition

a. Specify the autonomous system (AS) number for the node (BGP peer).

[edit routing-options]
user@csd_topology_junosvm# set autonomous-system AS_number

b. Specify the BGP group name and type for the node.

[edit protocols bgp]
user@csd_topology_junosvm# set group group_1 type internal

c. Specify a description for the BGP group for the node.

[edit protocols bgp group group_1]
user@csd_topology_junosvm# set description “CSD-Topology BGP-TE Peering”

d. Specify the address of the local end of a BGP session.

This is the IP address for the JunosVM external IP address which is used to accept

incoming connections to the JunosVM peer and to establish connections to the

remote peer.

[edit protocols bgp group group_1]
user@csd_topology_junosvm# set local-address <junosVM IP address>

e. Enable the traffic engineering features for the BGP routing protocol.

[edit protocols bgp group group_1]
user@csd_topology_junosvm# set family traffic-engineering unicast

f. Specify the IPaddress for theneighbor router that connectswith theCSD-Topology.

[edit protocols bgp group group_1]
user@csd_topology_junosvm# set neighbor <router loopback IP address>

NOTE: You can specify the router loopback address if it is reachable
by the BGP peer on the other end. But for loopback to be reachable,
usually some IGP has to be enabled between the CSD-Topology
JunosVM and the peer on the other end.

3. Import the routes into the traffic-engineering database.

[edit protocols mpls traffic-engineering database]
user@PE1# set import policy TE
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4. Configure a BGP group by specifying the IP address of the router that peers with the

CSD-Topologyas the local address (typically the loopbackaddress)and the JunosVM

external IP address as the neighbor.

[edit routing-options]
user@PE1# set autonomous-system AS Number

[edit protocols bgp group csd-topology]
user@PE1# set type internal
user@PE1# set description “CSD-Topology BGP-TE Peering”
user@PE1# set local-address <router-IP-address>
user@PE1# set family traffic-engineering unicast
user@PE1# set export TE
user@PE1# set neighbor <JunosVM IP-address>

Specifying the Topology Details in the Connectivity Services Director GUI

To specify the topology preferences on the Connectivity Services Director server:

1. Fromthe JunosSpaceuser interface, click theSystem iconon theConnectivityServices

Director banner.

The options that you can configure in Systemmode are displayed in a drop-down

menu.

2. Select Preferences from the drop-downmenu to open the Preferences page.

The Preferences page opens with User Preferences as the default tab.

3. Click the Topology tab to configure the CSD-Topology preference settings.

The settings that you can configure on the Topology tab are displayed.

4. In the L3 Topology Settings section, do the following:

a. Select the Use PCEP check box to use the Path Computation Element Protocol

(PCEP) for discovery of LSPs. PCEP enables communication between a PCC and

theCSD-Topology to learnabout thenetworkandLSPpathstateandcommunicate

with the Path Computation Clients (PCCs). If you select the Use PCEP check box,

the LSP data is collected by using PCEP.

By default, this check box is not selected. If you do not enable this option to use

PCEP for discovery of LSPs, Connectivity Services Director discovers the LSPs by

parsing the configuration statements and operational command outputs of the

devices that it manages.

b. In the Topology Server field, specify the topology server IP address, which is the IP

address of the system on which the CSD-Topology application is running.

c. In the UserName and Password fields, specify the username and password of the

user to allow the Connectivity Services Director to connect to the topology server.
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d. ClickValidatebeside thePassword field,which triggers a task toexamineandverify

the entered credentials for connecting to the CSD-Topology server. A dialog box

is displayed to indicate whether the specified credentials are valid or not.

e. ClickOK to close the dialog box. If the login credentials for communicating with

the CSD-Topology are invalid, correct the username and password values and

revalidate them.

5. ClickOK to save the settings.

You are prompted to confirm the changes youmade to topology preferences.

6. Click Yes to confirm.

The Preferences page is closed. A dialog box is displayed to confirm the successful

saving of topology preferences. ClickOK to close the dialog box.

Related
Documentation

Connecting an x86 Server to the Network on page 281•

Connecting an x86 Server to the Network

For minimum hardware requirements, see “Installation Prerequisites” on page 262.

To establish basic TCP connectivity to the network, youmust connect your x86 64-bit

network appliance (running the CSD-Topology software) directly to a switch or router.

Before configuring the x86 server to connect to the network, download and install the

RPM bundle as described in “Installing the CSD-Topology Software Using the RPM

Bundle” on page 262.

After installing the RPM bundle, the following default settings apply:

• Host machine:

• User=root

• Password=csdtopology

• IP addresses:

• external0=dhcp

• host mgmt0=172.16.17.1/24

• host management:internal network=172.16.16.1/24

NOTE: The Path Computation Server (PCS) runs native on the host
machine, and the host address is the PCS.

• JunosVM:
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• User=csdtopology

• Password=csdtopology

• Root Password=csdtopology

• IP addresses:

• em0=172.16.16.2/24

• em1=none

• em2=172.16.17.2/24

NOTE:

The following default values are also configured for the JunosVM
configuration:

• JunosVM internal IP address: 172.16.16.2

• JunosVM internal netmask: 255.255.255.0

NOTE: The JunosVM internal IP and netmask should not be
changed.

NOTE: For network security, by default, JunosVM SSH and telnet access is
restricted and available only from the host server (PCS server) using the
172.16.16.2 IP address. To remove this restriction, you canmanually remove
the firewall filter on the JunosVM lo0 (loopback) configuration.

Figure 13 on page 283 shows the default interfaces and preconfigured addresses on the

x86 appliance.
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Figure 13: Interfaces and Addresses Preconfigured on the x86 Appliance

To establish basic connectivity between the x86 network appliance and a switch or

router:

1. Power on the x86 network appliance.

2. Use one of the following options to access the x86 console:

• Use a serial cable to connect to the serial console.

You can use an SSH client (hypertem, minicom, or securecrt) to connect to the

serial console.

NOTE: To set up the serial port connection, refer to your hardware
manual.

NOTE: The serial port setting should be 9600-8-N-1with hardware

control enabled.

• If your network appliance has two or more Ethernet ports, use an Ethernet cable to

connect to the x86 appliancemanagement interface.

a. Connect an Ethernet cable from a laptop computer to 1-Gigabit Ethernet port 1

on the x86 appliance.

b. Configure the IP address on your laptop to 172.16.17.10/24.

c. Using an SSH client, connect to the x86 appliance at IP address 172.16.17.1.

3. On the network appliance, connect a 1-Gigabit Ethernet or 10-Gigabit Ethernet port

to the LAN switch or router that you will use to access the network.
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NOTE: The Ethernet interface on the switch or router must be configured
in access/untaggedmode.

4. From prompt, log in to the x86 systemwith the username root and password
password.

5. To configure the required network settings, access the Main Menu:

[root@csd-topo ~]# /opt/csd-topology/utils/net_setup.py

TheMainMenu, shown inFigure 14onpage284,displays theoptions that youcanselect

to configure the host and JunosVM settings, verify network settings, perform

maintenance and troubleshooting, and collect trace and log files.

Figure 14: CSD-Topology Main Menu

NOTE: To establish connectivity between the x86network appliance and
a switch or router, the host IP and JunosVM IP addresses (including
netmask and default gateway)must be from the same subnet.

a. To create the host configuration:
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NOTE: Youmust provide settings for the host external IP address, host
external netmask, and host default gateway. All other host settings
are optional.

1. Type A at the prompt and press Enter to update the host configuration.

The current CSD-Topology host configuration settings are displayed.

2. For each host setting youwant to configure, enter the number that corresponds

to the specific host parameter (host external IPaddress, host external netmask,

host management IP address, host default gateway, and so forth), and enter

the appropriate value.

3. After you configure the required host settings, typeB to apply the host settings.

b. To create the JunosVM configuration:

NOTE: Youmust provide settings for the JunosVMexternal IP address,
JunosVM external netmask, JunosVM default gateway, and BGP AS
number. All other JunosVM settings are optional.

1. Type B at the prompt and press Enter to update the CSD-Topology JunosVM
configuration.

The current JunosVM configuration settings are displayed.

2. For each JunosVM setting you want to configure, enter the number that

corresponds to the specific JunosVM parameter (JunosVM external IP address,

JunosVMexternalnetmask, JunosVMmanagement IPaddress, JunosVMdefault

gateway, and BGP AS number), and enter the appropriate value.

3. After configuring the required JunosVM settings, type C to apply the JunosVM
settings.

6. Verify the host and JunosVM configurations and deploy.

a. Type C at the prompt and press Enter to view all current host configuration and

JunosVM configuration settings.

b. Toapplyall updatedhostand JunosVMconfiguration settings to theCSD-Topology,

type Y and press Enter.

Related
Documentation

Configuring Connectivity for BGP-LS Topology Acquisition on page 291•

• Configuring Connectivity for OSPF Topology Acquisition on page 294

• Configuring Connectivity for IS-IS Topology Acquisition on page 295
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Interactive Method of Installing the RPM Image and CSD-Topology Software from a
USB or DVDDrive

You can install the CSD-Topology RPM image on any x86 64-bit network appliance.

Before configuring the x86 server to connect to the network, download and install the

RPM bundle as described in “Installing the CSD-Topology Software Using the RPM

Bundle” on page 262.

If you have a keyboard andmonitor as part of your system, the interactive installation

method is preferred. To install the ISO image on the x86 network appliance from a USB

drive using the interactive method:

1. Power on the x86 network appliance.

The CSD-Topology login prompt is displayed after you power on the appliance.

2. Enter the following command to launch the interactive user interface:

[root@csd-topo ~]# /csd-topology/csd_topology_2.0.0_interactive_install.md

3. Plug in the USB or DVD drive with the RPM image of the CSD-Topology package to

the x86 appliance.

4. When the “Welcome to CSD-Topology(SCL 6.6R2.0)” screen is displayed, select the

appropriate Boot option (the default isBoot fromLocal HDD), and press Enter to start

the CSD-Topology installation.

The CentOS 6 logo screen is displayed.

5. ClickNext.

6. Select your preferred language for the installation process, and clickNext.

7. Choose your preferred storage type, and clickNext.

8. Indicate your time zone, and clickNext.

9. Enter and confirm the root password, and clickNext.

10. Select a partitioning option, and clickNext.

NOTE: Because CSD-Topology is installed in /opt/, be sure to allocate
sufficient space for /opt.
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11. Indicate your preferences regarding boot loader (two screens), and clickNext after
completing each screen.

12. Select Core installation, and clickNext.

13. The CentOS 6 logo screen is displayed, showing installation progress. When the

installation completes, the screen shows that all packages are completed.

14. Two errors are displayed because the password has not yet been initialized and the

license key has not yet been added:

• The state of all CSD-Topology processes shows as STOPPED.

• The state of the PCServer process shows as FATAL.

15. To resolve the license error, copy the npatpw license file to /opt/pcs/db/sys.

NOTE: Be sure the owner of the file is pcs.

16. To resolve the password error, access the Main Menu:

[root@csd-topo ~]# /opt/csd-topology/utils/net_setup.py

From the Main Menu shown in Figure 15 on page 287, select D for Maintenance &
Troubleshooting.

Figure 15: CSD-Topology Controller Main Menu

287Copyright © 2019, Juniper Networks, Inc.

Chapter 16: Downloading and Installing CSD-Topology



Select 9 to Initialize all credentials.

The state of all processes should now show as RUNNING.

Disconnect the USB flash drive or DVD drive that is connected to the x86 network

appliance.

17. Power on the x86 network appliance.

The system requires a fewminutes to power on. Then theCSD-Topology login prompt

is displayed.

18. From the CSD-Topology login prompt, enter user root and the root password you
selected during the installation to log in to the CSD-Topology CLI.

19. Runeachof the followingcommands toverify that the JunosVMandPathComputation

Server (PCS)processesare runningand that keydirectoriesweresuccessfully installed:

a. As root user, run the service csdtopology status command to verify that JunosVM

is running. This command tells you the status of all processes, the disk space being

used, network configuration check results, and JunosVM check results.

b. After your license is set, run the ps-ef | grep PCS command to verify that the PCS

is running on specific ports.

Related
Documentation

• Installation Prerequisites on page 262

• Installing the CSD-Topology Software Using the RPM Bundle on page 262
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CHAPTER 17

Configuring Topology Acquisition and
Connectivity Between the CSD-Topology
and Path Computation Clients

• Configuring PCEP on a PE Router (from CLI) on page 289

• Configuring Connectivity for BGP-LS Topology Acquisition on page 291

• Configuring Connectivity for OSPF Topology Acquisition on page 294

• Configuring Connectivity for IS-IS Topology Acquisition on page 295

Configuring PCEP on a PE Router (fromCLI)

A Path Computation Client (PCC) supports the configurations related to the Path

Computation Element (PCE) and communicates with the CSD-Topology, which by

default is configured toacceptaPathComputationElementProtocol (PCEP)connection

from any source address. However, youmust configure PCEP on each PE router to

configure the router as a PCC and establish a connection between the PCC and the

CSD-Topology. A PCC initiates path computation requests, which are then executed by

the CSD-Topology.

The following requirements apply for each PCC in the network that the CSD-Topology

can access:

• The corresponding JSDN package (with PCEP support) is installed on the router.

NOTE: Youmust boot the PCC router with the Junos OS 14.2X1.1 image, and
then boot the router a second timewith the JSDN image. After the router
boots up a second time, the router (functioning as a PCC) is able to support
the configurations related to the PCE and communicate with the
CSD-Topology.
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NOTE: For a PCEP connection, the PCC can connect to the CSD-Topology
using an in-band or out-of-bandmanagement network, provided that IP
connectivity is establishedbetween thePathComputationServer (PCS)and
the specified PCEP local address. In some cases, an additional static route
might be required from the CSD-Topology to reach the PCC, if the IP address
is unreachable from the CSD-Topology default gateway.

To configure a PE router as a PCC:

1. Enable external control of LSPs from the PCC router to the CSD-Topology.

[edit protocols]
user@PE1# setmpls lsp-external-controller pccd

2. Specify the loopback address of the PCC router as the local address, for example:

[edit protocols]
user@PE1# set pcep pce csdtopology local-address 10.0.0.101

NOTE: As a best practice, the router ID is usually the loopback address,
but is not necessarily configured this way.

3. Specify the CSD-Topology (csdtopology) as the PCE that the PCC connects to, and
specify the CSD-Topology host external IP address as the destination address.

[edit protocols]
user@PE1# set pcep pce csdtopology destination-ipv4-address 10.99.99.1

4. Configure the destination port for the PCC router that connects to the CSD-Topology

(PCE server) using the TCP-based PCEP.

[edit protocols]
user@PE1# set pcep pce csdtopology destination-port 4189

5. Configure the PCE type.

[edit protocols]
user@PE1# set pcep pce csdtopology pce-type active
user@PE1# set pcep pce csdtopology pce-type stateful

6. Enable LSP provisioning.

[edit protocols]
user@PE1# set pcep pce csdtopology lsp-provisioning
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7. To verify that PCEP has been configured on the router, open a telnet session to access

the router, and run the following commands:

user@PE1> show configuration protocolsmpls

Sample output:

lsp-external-controller pccd;

user@PE1> show configuration protocols pcep

Sample output:

pce csdtopology {
local-address 10.0.0.101;
destination-ipv4-address 10.99.99.1;
destination-port 4189;
pce-type active-stateful;
lsp-provisioning;

}

Related
Documentation

Configuring Connectivity for BGP-LS Topology Acquisition on page 291•

• Configuring Connectivity for OSPF Topology Acquisition on page 294

• Configuring Connectivity for IS-IS Topology Acquisition on page 295

Configuring Connectivity for BGP-LS Topology Acquisition

After you have successfully established a connection between the CSD-Topology and

the network, you can configure topology acquisition using Border Gateway Protocol Link

State (BGP-LS). For BGP-LS topology acquisition, youmust configure both the

CSD-Topology and the PCC routers.

NOTE:

We recommend that you use BGP-LS instead of IGP adjacency for the
following reasons:

• The OSPF and IS-IS databases have a lifetime timer, and if the OSPF or
IS-IS neighbor is down, the OSPF or IS-IS database is not removed
immediately, and theCSD-Topologywill not be able to determinewhether
the topology is valid or not.

• Using BGP-LSminimizes the risk of making the JunosVM a transit router
between AS areas if the GREmetric is not properly configured.

• Typically, theCSD-Topology is located inaNOCDataCenterandmultihops
away from the backbone routers andMPLS TE routers.
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NOTE: If BGP-LS is used, JunosVM is configured to automatically accept any
I-BGP session from, in this example, 0.0.0.0/0. However, youmust verify
that JunosVM is correctly configured and that it has IP reachability to the
peering router.

Before you begin, complete the following tasks:

• Verify IP connectivity between a switch (or router) and the x86 appliance on which

CSD-Topology software is installed.

• Make sure that PCEP is configured on each PE router in the network topology.

To configure BGP-LS topology acquisition, see:

• Configuring BGP-LS Topology Acquisition on the CSD-Topology on page 292

• Configuring Topology Acquisition on the PCC Routers on page 293

Configuring BGP-LS Topology Acquisition on the CSD-Topology

ToconfigureBGP-LSon theCSD-Topology for topologyacquisition, performthe following

configuration steps from the CSD-Topology JunosVM:

1. InitiateanSSHor telnet session to the JunosVMexternal IPormanagement IPaddress.

2. Specify the autonomous system (AS) number for the node (BGP peer).

[edit routing-options]
user@csd_topology_junosvm# set autonomous-system AS_number

3. Specify the BGP group name and type for the node.

[edit protocols bgp]
user@csd_topology_junosvm# set group group_1 type internal

4. Specify a description for the BGP group for the node.

[edit protocols bgp group group_1]
user@csd_topology_junosvm# set description “csd-topology BGP-TE Peering”

5. Specify the address of the local end of a BGP session.

This is the IP address for the JunosVM external IP address which is used to accept

incomingconnections to the JunosVMpeerand toestablish connections to the remote

peer.

[edit protocols bgp group group_1]
user@csd_topology_junosvm# set local-address <junosVM IP address>
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6. Enable the traffic engineering features for the BGP routing protocol.

[edit protocols bgp group group_1]
user@csd_topology_junosvm# set family traffic-engineering unicast

7. Specify the IP address for the neighbor router that connects with the CSD-Topology.

[edit protocols bgp group group_1]
user@csd_topology_junosvm# set neighbor <router loopback IP address>

NOTE: You can specify the router loopback address if it is reachable by
the BGP peer on the other end. But for loopback to be reachable, usually
some IGP has to be enabled between the CSD-Topology JunosVM and
the peer on the other end.

Configuring Topology Acquisition on the PCC Routers

To enable the CSD-Topology to discover the network, youmust add the following

configuration on each each router that peers with the CSD-Topology. The CSD-Topology

JunosVMmust peer with at least one router from each area (autonomous system).

To configure topology acquisition, initiate a telnet session to each PCC router and add

the following configuration:

1. Configure a policy.

[edit policy-options]
user@PE1# set policy-statement TE term 1 from family traffic-engineering
user@PE1# set policy-statement TE term 1 then accept

NOTE: This configuration is appropriate for both OSPF and IS-IS.

2. Import the routes into the traffic-engineering database.

[edit protocols mpls traffic-engineering database]
user@PE1# set import policy TE

3. Configure a BGP group by specifying the IP address of the router that peers with the

CSD-Topologyas the local address (typically the loopbackaddress)and the JunosVM

external IP address as the neighbor.

[edit routing-options]
user@PE1# set autonomous-system AS Number

[edit protocols bgp group bgp group1]
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user@PE1# set type internal
user@PE1# set description “CSD-Topology BGP-TE Peering”
user@PE1# set local-address <router-IP-address>
user@PE1# set family traffic-engineering unicast
user@PE1# set export TE
user@PE1# set neighbor <JunosVM IP-address>

See Also Configuring PCEP on a PE Router (from CLI) on page 289•

• Configuring Connectivity for OSPF Topology Acquisition on page 294

• Configuring Connectivity for IS-IS Topology Acquisition on page 295

Configuring Connectivity for OSPF Topology Acquisition

If BGP-LS is not being used, one of the IGP protocols must be configured on the

CSD-Topology. ToenableOSPFonCSD-Topology, before youbegin, verify IP connectivity

between a switch (or router) and the x86 appliance on which CSD-Topology software

is installed.

To configure OSPF topology acquisition, see:

• Configuring OSPF on the CSD-Topology on page 294

• Configuring OSPF Over GRE on the CSD-Topology on page 295

Configuring OSPF on the CSD-Topology

To configure OSPF on the CSD-Topology:

1. Configure the policy.

[edit policy-options]
user@csd_topology_junosvm# set policy-statement TE term 1 from family
traffic-engineering

user@csd_topology_junosvm# set policy-statement TE term 1 then accept

2. Populate the traffic engineering database.

[edit]
user@csd_topology_junosvm#setprotocolsmpls traffic-engineeringdatabase import
policy TE

3. Configure OSPF.

[edit]
user@csd_topology_junosvm# set protocols ospf area area interface interface
interface-type p2p
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Configuring OSPFOver GRE on the CSD-Topology

Once you have configured OSPF on the CSD-Topology, you can take the following

additional steps to configure OSPF over GRE:

1. Initiate an SSH or telnet session using the IP address for the CSD-Topology JunosVM

external IP address.

2. Configure the tunnel.

[edit interfaces]
user@csd_topology_junosvm# set gre unit 0 tunnel source local-physical-ip
user@csd_topology_junosvm# set gre unit 0 tunnel destination destination
user@csd_topology_junosvm# set gre unit 0 family inet addresstunnel-ip-addr
user@csd_topology_junosvm# set gre unit 0 family iso
user@csd_topology_junosvm# set gre unit 0 family mpls

3. Enable OSPF traffic engineering on the JunosVM and add the GRE interface to the

OSPF configuration.

[edit protocols ospf]
user@csd_topology_junosvm# set traffic-engineering
user@csd_topology_junosvm# set area area interface gre.0 interface-type p2p
user@csd_topology_junosvm# set area area interface gre.0metric 65530

See Also Configuring PCEP on a PE Router (from CLI) on page 289•

• Configuring Connectivity for BGP-LS Topology Acquisition on page 291

• Configuring Connectivity for IS-IS Topology Acquisition on page 295

Configuring Connectivity for IS-IS Topology Acquisition

If BGP-LS is not being used, youmust configure one of the IGP protocols on the

CSD-Topology. To enable IS-IS on the CSD-Topology, before you begin, complete the

following tasks:

1. Verfiy IP connectivity between a switch (or router) and the x86 appliance on which

CSD-Topology software is installed.

2. Configure interfaces on the JunosVM for IS-IS routing, for example:

[edit]
user@csd_topology_junosvm# set interfaces em0 unit 0 family inet address
172.16.16.2/24

user@csd_topology_junosvm# set interfaces em1 unit 0 family inet address
192.168.179.117/25

user@csd_topology_junosvm# set interfaces em0 unit 0 family inet address
172.16.16.2/24

user@csd_topology_junosvm# set interfaces em2 unit 0 family mpls
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user@csd_topology_junosvm# set interfaces lo0 unit 0 family inet address
88.88.88.88/32 primary

user@csd_topology_junosvm# set routing-options static route 0.0.0.0/0 next-hop
192.168.179.126

user@csd_topology_junosvm# set routing-options autonomous-system 1001

To configure IS-IS topology acquisition, see:

• Configuring IS-IS on the CSD-Topology on page 296

• Configuring IS-IS Over GRE on the CSD-Topology on page 296

Configuring IS-IS on the CSD-Topology

To configure IS-IS topology acquisition and enable IS-IS routing, perform the following

steps on the CSD-Topology JunosVM:

1. Configure the policy.

[edit policy-options]
user@csd_topology_junosvm# set policy-statement TE term 1 from family
traffic-engineering

user@csd_topology_junosvm# set policy-statement TE term 1 then accept

2. Populate the traffic engineering database.

[edit protocols]
user@csd_topology_junosvm# setmpls traffic-engineeringdatabase importpolicyTE

3. Configure IS-IS.

[edit protocols]
user@csd_topology_junosvm# set isis interface interface level levelmetricmetric
user@csd_topology_junosvm# set isis interface interface point-to-point

Configuring IS-IS Over GRE on the CSD-Topology

Once you have configured IS-IS on the CSD-Topology, you can take the following

additional steps to configure IS-IS over GRE:

1. Initiate an SSH or telnet session using the IP address for the CSD-Topology JunosVM

external IP address.

2. Configure the tunnel.

[edit interfaces]
user@csd_topology_junosvm# set gre unit 0 tunnel source local-physical-ip
user@csd_topology_junosvm# set gre unit 0 tunnel destination destination
user@csd_topology_junosvm# set gre unit 0 family inet addresstunnel-ip-addr
user@csd_topology_junosvm# set gre unit 0 family iso
user@csd_topology_junosvm# set gre unit 0 family mpls
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3. Add the GRE interface to the IS-IS configuration.

[edit protocols isis]
user@csd_topology_junosvm# set interface gre.0 level levelmetric 65530
user@csd_topology_junosvm# set interface gre.0 point-to-point

See Also • Configuring PCEP on a PE Router (from CLI) on page 289

• Configuring Connectivity for BGP-LS Topology Acquisition on page 291

• Configuring Connectivity for OSPF Topology Acquisition on page 294
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CHAPTER 18

Accessing the Topology View of
CSD-Topology

• Understanding the Network Topology in Connectivity Services Director on page 300

• Monitoring the Topology of Network Elements Managed by CSD-Topology

Overview on page 301

• Specifying Topology Preferences on page 302

• CSD-Topology Topology MapWindowOverview on page 304

• Working with the Graphical Image in the Topology ViewWindow on page 306

• Expanding and Collapsing Groups by Using the Topology Map Grouping Shortcut

Menu on page 308

• Filtering Links, LSPs, and Services by Using the Topology Map Node Shortcut

Menu on page 309

• Removing the Highlighted LSPs by Using the Topology Map LSPs Shortcut

Menu on page 311

• Viewing theServicePathbyUsing theTopologyMapServiceShortcutMenuonpage312

• Filtering Devices, LSPs, and Services for Sorting and Segregating the Topology

View on page 313

• Segregating the Displayed Devices by Searching the Entire Topology View on page 314

• Resynchronizing the Topology View on page 315

• Viewing Device Details of a CSD-Topology for Examining Traffic

Transmission on page 316

• Viewing LSP Details of a CSD-Topology for Analyzing Network Changes on page 318

• Viewing Link Details of a CSD-Topology for Determining the Operational

Status on page 321

• ViewingServiceDetails of aCSD-Topology forMonitoring andTroubleshootingService

Parameters on page 322

• Viewing Topology Map Group Details in a Pop-Up Dialog Box on page 325

• Viewing Topology Map Device Details in a Pop-Up Dialog Box on page 327

• Viewing Topology Map Link Details in a Pop-Up Dialog Box on page 329

• Viewing Topology Map LSP Details in a Pop-Up Dialog Box on page 331
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• Viewing Topology Map Service Details in a Pop-Up Dialog Box on page 333

• Enabling the Collection of LSP and Service Association Details on page 335

• Using Custom Grouping for Devices in a CSD Topology on page 335

• Viewing Generated Alarms for Services in the Topology View on page 336

• Viewing the Optical Link Details for Examining the Performance of Optical

Links on page 337

Understanding the Network Topology in Connectivity Services Director

JunosSpaceConnectivityServicesDirectorprovides features formonitoringandmanaging

Juniper Networks ACXSeries routers, M Series routers, MXSeries routers, and PTXSeries

routers. Connectivity between devices and their association with their location provide

the foundation for rendering topology in a complete manner.

Asanetworkadministrator, youmusthaveaclearunderstandingof thevariousnetworking

devices in yournetwork, their physical locations, andhowthesedevicesare interconnected

in your network. The network topology represents the interconnection between various

devices in your network, which are managed by Connectivity Services Director, based on

their connectivity and association to their physical surroundings. The network topology

provides a visual insight into the network, which is useful for debugging, troubleshooting,

planning, and executing administrative actions.

Before you access the topological view of your network, youmust:

• Discover the devices managed by Connectivity Services Director in your network. For

details about discovering devices, see Discovering Devices in a Physical Network.

NOTE: Youmust specify the SNMP parameters during device discovery to
have all the devices discovered andmanaged by Connectivity Services
Director available in Topology View.

NOTE: Ensure that you have enabled the LLDP, STP, or RSTP protocols
on the devices as Connectivity Services Director uses these protocols to
determine the connectivity of devices with their neighbors in the network.
LLDP and RSTP protocols are enabled by default on all MX Series routers.

Network topology enables you to view all the discovered devices in your network, where

the devices are located along with their physical interconnection with other devices in

your network. Topology also provides visualization aroundphysical connectivity between

various discovered interconnected devices. Multiple links displayed between nodes use

line bending to avoid hidden trunks in the topology.

You can use the Topology View to zoom in or zoom out of a site to a group of devices

and a group of devices to a site. In the Topology View, you can also double-click a site

or a zone to view the devices in a site. You can also see the connectivity between a device

and its immediate neighbors, alarms details, and so on.
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Network topology also provides visualization around physical connectivity between

various discovered interconnected devices. You canmove the topology map by holding

down the left mouse button, dragging the mouse to another point, and letting go of the

mouse.

Related
Documentation

Monitoring the Topology of Network Elements Managed by CSD-Topology Overview

on page 301

•

• Specifying Topology Preferences on page 128

• CSD-Topology Topology MapWindowOverview on page 304

• Working with the Graphical Image in the Topology ViewWindow on page 306

Monitoring the Topology of Network Elements Managed by CSD-Topology Overview

Connectivity Services Director enables you to monitor the network elements, such as

devicesand links, that are configured, administered, andmaintainedusingCSD-Topology.

The CSD-Topology enables granular configuration and control of IP and MPLS flows in

large service provider and enterprise networks. By establishing a connection between

the CSD-Topology, which is a topology server from the perspective of Connectivity

Services Director, and the server on which Connectivity Services Director is running, a

topological network viewormap ispresented that enables you tovisualize label-switched

paths (LSPs), links, and services formonitoring and debugging network faults and traffic

outages in IP and MPLS networks. Fault, configuration, accounting, performance, and

security (FCAPS) is an explicit model that is used to achieve the operational objectives

of networkmanagement. Connectivity ServicesDirector offers aneffectivemanagement

system for a complete FCAPS functionality.

To compute optimal paths through the network, the CSD-Topology requires a

consolidated view of the network topology. The Topology View of the network includes

the nodes, links, and their attributes (metric, link utilization bandwidth, and so forth) that

form the network topology. Therefore, any router CLI configuration changes to interior

gateway protocol (IGP) metric, Resource Reservation Protocol (RSVP) bandwidth,

Priority/Hold values, and so forth are instantly available from the Topology View of

Connectivity Services Director.

Without the need to traverse to the CSD-Topology GUI, you can use the Topology View

fromwithin the Connectivity Services Director GUI to obtain a global and expansive view

of the network state for monitoring, management, and proactive planning. In the

CSD-Topology, a Path Computation Client (PCC) is a client application that requests

the Path Computation Element (PCE) to perform path computations for the PCC’s

external label-switched paths (LSPs). The Path Computation Element Protocol (PCEP)

enables communication between a PCC and the CSD-Topology to learn about the

network and LSP path state and communicate with the PCCs. By providing a view of the

global network state and bandwidth demand in the network, the CSD-Topology is able

to compute optimal paths and provide the attributes that the PCC uses to resignal the

LSPs.
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You can also sort and classify the devices, LSPs, or services of interest and applicability

for your network environment to diagnose the traffic-handling capacity, performance,

and operating efficiency of the paths through which packets traverse through the circuit

managed by the CSD-Topology.

You can also view the optical links configured on the optical interfaces of devices, such

as PTX Series routers, on the topology map. You can sort and filter the optical links to

be displayed on the topology map for easier and optimal monitoring. Only PTX3000

routers are currently supported for display on the topology map, which can contain

integrated photonic line cards (IPLCs) that work in conjunction with optical inline

amplifiers (optical ILAs).

Related
Documentation

Specifying Topology Preferences on page 128•

• CSD-Topology Topology MapWindowOverview on page 304

• Working with the Graphical Image in the Topology ViewWindow on page 306

Specifying Topology Preferences

Youmust first configure the communication and authentication settings between the

CSD-Topology system and the Connectivity Services Director server by using the

Preferences page before you can view the topology, which is a pictorial representation

of thebaselinenetwork that shows thesites, nodes, interconnecting links, label-switched

paths (LSPs) configuredoverpseudowire links, andservices. The settings that youspecify

on the Preferences page establish the connection between the system on which the

Connectivity Services Director application is running and the CSD-Topology server. The

CSD-Topology server runs on a virtual machine (CSD-Topology VM), which works in

conjunctionwith JunosOS running on another virtualmachine (JunosVM), to use routing

protocols to communicatewith thenetwork anddynamically learn thenetwork topology.

Youmust configure the Connectivity Services Director application with the IP address of

the CSD-Topology server and the login credentials to access the CSD-Topology system.

If you do not configure the connection between the CSD-Topology and Connectivity

ServicesDirector serverswhenyounavigate to theTopologyView, amessage is displayed

stating that youmust first set up the connection before you can view the topology map

that shows the interconnections among devices.

To specify topology preferences on the Connectivity Services Director server:

1. Fromthe JunosSpaceuser interface, click theSystem iconon theConnectivityServices

Director banner.

The options that you can configure in Systemmode are displayed on a drop-down

menu.

2. Select Preferences from the drop-downmenu to open the Preferences page.

The Preferences page opens with User Preferences as the default tab.

3. Click the Topology tab to configure topology preference settings.
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The settings that you can configure on the Topology tab are displayed.

4. In the L2 Topology Settings section, do the following:

a. In the Deleted Link Retention Period (Days) field, drag the slider to the right or left

to specify a retention period for the deleted links in the Topology View.

By default, the deleted links are retained for one day. Drag the slider to the leftmost

end of the line to specify the period for which deleted links must be preserved as

one day. Drag the slider to the rightmost end of the line to specify the period for

which deleted links must be preserved as 365 days or a year, which is the longest

duration for which deleted links are preserved.

b. Select the Disable Autoupdate of Topology check box to disable the automatic

updates to the topology and, instead, enable the topology updates to bemanually

triggered by the user.

By default, automatic updates to the topology are disabled.

5. In the L3 Topology Settings section, do the following:

a. Select the Use PCEP check box to use the Path Computation Element Protocol

(PCEP) for discovery of LSPs. PCEP enables communication between a PCC and

theCSD-Topology to learnabout thenetworkandLSPpathstateandcommunicate

with thePathComputationClients (PCCs).Bydefault, this checkbox isnot selected.

If you do not enable this option to use PCEP for discovery of LSPs, Connectivity

Services Director discovers the LSPs by parsing the configuration statements and

operational command outputs of the devices that it manages.

b. In the Topology Server field, specify the topology server IP address, which is the IP

address of the system on which the CSD-Topology application is running.

c. In the UserName and Password fields, specify the username and password of the

user to allow the Connectivity Services Director to connect to the topology server.

d. ClickValidatebeside thePassword field,which triggers a task toexamineandverify

the entered credentials for connecting to the CSD-Topology server.

A dialog box is displayed to indicate whether the specified credentials are valid or

not.

e. ClickOK to close the dialog box. If the login credentials for communicating with

the CSD-Topology are invalid, correct the username and password values and

revalidate them.

f. In the Refresh Topology Interval (Days) field, drag the slider right or left to specify

the frequency in number of days at which the Layer 3 topology must be refreshed

and displayed in the Topology View.
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By default, the topology is refreshed once every day. Drag the slider to the leftmost

endof the line todisable the refreshof the topology.Drag the slider to the rightmost

end of the line to enable the refresh of topology once every 365 days or a year,

which is the largest frequency you can specify for the refresh setting.

6. ClickOK to save the settings.

You are prompted to confirm the changes youmade to topology preferences.

7. Click Yes to confirm.

The Preferences page is closed. A dialog box is displayed to confirm the successful

saving of topology preferences. ClickOK to close the dialog box.

Related
Documentation

Monitoring the Topology of Network Elements Managed by CSD-Topology Overview

on page 301

•

• CSD-Topology Topology MapWindowOverview on page 304

• Working with the Graphical Image in the Topology ViewWindow on page 306

CSD-Topology TopologyMapWindowOverview

Asanetworkadministrator, youmusthaveaclearunderstandingof thevariousnetworking

devices in yournetwork, their physical locations, andhowthesedevicesare interconnected

in your network. Connectivity between devices and their association with their locations

provide the foundation for rendering topology inacompletemanner.ConnectivityServices

Director enables you to monitor the devices that are managed by the CSD-Topology,

besides offering a centralized view of the connectivity. The CSD-Topology topologymap

represents the interconnection between various devices in your network, which are

managed by Junos Space Connectivity Services Director, based on their connectivity to

andassociationwith their physical surroundings.This information isuseful fordebugging,

troubleshooting, planning, and executing administrative actions.

Before you can view the topologymap, which is a pictorial representation of the baseline

network that shows the sites, nodes, interconnecting links, label-switched paths (LSPs)

configuredoverpseudowire links, andservices, youmustestablish theconnectionbetween

the system on which the Connectivity Services Director application is running and the

CSD-Topology server. After you select Topology View from the View selector in Build

mode, the topology (map)window is themainwork area for any live network or network

model you load into the system.Multiple links displayed between nodes use line bending

to avoid hidden trunks in the topology. The topology map enables expandable and

collapsible views, which is useful when several nodes or devices are present in groups.

Linebending refers tomultipleparallel connector linesamongdevicesdisplayedascurves

to avoid overlapping between the lines.

On the topologymap,devicesornodesarepresent inanungroupedmanneroraregrouped

based on the configured custom groups or sites. Sites represent a geographical region,

such as a zone or a general area, within which devices are located. Different devices in a
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site are interconnectedby links andLSPs. Servicesare configuredon thedifferent devices

in a site. You can view the interconnection among sites, devices, links, LSPs, and services

on the topology map.

NOTE: LSP names that are not unique in the network are not displayed on
the topologymap.

NOTE: You cannot view node locations by their geographic coordinates on
the worldmap using latitude and longitude or automatic layouts on the
Connectivity Services Director GUI.

The topology window displays important link and node properties. Links are color coded

according to utilization. Alternatively, you can view links by other properties such as trunk

type, protocols, coloring, status, and area. Nodes are color coded by symbols, icons, or

vendor types.

Path information can be displayed in the topology window. The path function displays

detailed path information between any two nodes found in the network based on factors

suchas the routingmethodused, reservedandactual bandwidthallocation, linkdistance,

or oversubscription.

The topology window contains the following main components:

Filterdialogbox(afunnelsymbol)—Forsortingandchanging thesettingsof theTopology
View

Search(magnifyingglass icon)—For specifying thesearchcriteria for filteringandviewing
relevant data

Plus sign—For zooming in to the topology map for a detailed view of the elements on

themap

Minus sign—For zooming out of the topologymap for a high-level view of the entiremap

Pictorial representationof thenetworkontheupperportionof thepage—Fordisplaying
the network

The upper portion of the right pane, which shows the topology map, is the middle

portion of the topology window. In this area, you can double-click the zones that are

displayed to expand and display the devices contained in that zone. The pop-up

menu is accessed by right-clicking in the center pane that shows the topologymap.

Right-click a node, link, or group on themap to display a pop-upmenu for that

element.

Tablesonthe lowerportionof thepage—For viewingdetailed informationaboutdevices,
links, LSPs, and services configured for the network topology
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Downward arrow at the bottom of the page—For hiding the table that displays
information about devices, links, and LSPs, and for displaying the topology map in

the entire canvas

Zoom in and zoom out—For zooming in and out by using the mouse scroll wheel for a
detailed or high-level representation of the topology map

Moving themap—For dragging the map around by holding down the left mouse button

Related
Documentation

Monitoring the Topology of Network Elements Managed by CSD-Topology Overview

on page 301

•

• Specifying Topology Preferences on page 128

• Working with the Graphical Image in the Topology ViewWindow on page 306

Working with the Graphical Image in the Topology ViewWindow

In the Topology Viewof Buildmode, the topology (map)window shown is themainwork

area for any live network or network model you load into the system. Multiple links

displayed between nodes use line bending to avoid hidden trunks in the topology. The

topology incorporates node aggregation collapsible views. You can also view node

locations by their geographic coordinates on the worldmap using latitude and longitude

or automatic layouts in the Topology View of Build mode.

The Topology Viewwindow displays important link and node properties, and also the

devices contained in sites. Links interconnecting the devices are color coded according

to utilization. Alternatively, you can view links by other properties such as trunk type,

protocols, coloring, status, and area. Nodes are color-coded by symbols, icons, or vendor

types.

Path information can be displayed in the Topology Viewwindow. The path function

displays detailed path information between any two nodes found in the network based

on factors such as routing method used, reserved and actual bandwidth allocation, link

distance, or oversubscription.

The Topology View is a graphical representation of the baseline network.

• When the cursor is positioned over a network element in the Topology View, a

description of the network element is displayed above each device.

• Double-click an element icon to collapse the devices or network elements and view

the entire site or zone as an icon.

• Right-click an element to viewmore options for that element.

• Hold the left mouse button to drag the map around.

• Use themouse scroll wheel to zoom in and out of the map.

Right-clickingon themapareadisplaysapop-upmenu formore functions.Youcanmove

themap by holding down the left mouse button and dragging. You can zoom in and out

by using the mouse scroll wheel.
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In the Topology View, zones or sites are displayed as circular discs with devices when

they are expanded or as small group symbolswhen they are collapsed. Devices or nodes

are displayed within the appropriate zones as squares with the device icons. Links are

displayedasgray solid connector lines. LSPsaredisplayedascolor-codedsolid connector

lines. Services that are configured on nodes are displayed as dotted connector lines.

NOTE: LSP names that are not unique in the network are not displayed in
the Topology View.

There are several ways to select nodes and links in the Topology View.

• Press Ctrl-click or Shift-click nodes and links.

• Right-click a node and use the Select options.

• Right-click a link and use the Select options.

• Click the plus sign to zoom in and theminus sign to zoom out of the Topology View.

Whenmoving nodes on themap area, you are changing the graphical coordinates rather

than the geographical coordinates. Graphical coordinates are the positions of the nodes

in the Topology Viewwindow. Geographical coordinates are positions of the nodes

according to actual physical locations (for example, latitude and longitude).

You can perform the following tasks with the View Topology page:

• Filtering Devices, LSPs, and Services for Sorting and Segregating the Topology View

on page 313

• Viewing Device Details of a CSD-Topology for Examining Traffic Transmission on

page 316

• Viewing LSP Details of a CSD-Topology for Analyzing Network Changes on page 318

• Viewing Link Details of a CSD-Topology for Determining the Operational Status on

page 321

• ViewingServiceDetails of aCSD-Topology forMonitoring andTroubleshootingService

Parameters on page 322

The Map Preferences settings are saved to each client.
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NOTE:

In the CSD-Topology database, the topology information that gets saved for
each network includes the following:

NOTE: By default, the graphcoordaux file is automatically saved
when closing a network to avoid losing auxiliary changesmade to
themap, such asmap legend settings. Clear this check box to
disable this feature.

group file—Groupings of network devices are saved in the group file

graphcoord file—Graphical coordinates of network devices are saved in the
graphcoord file

graphcoordaux file—Stores the followingmap settings data:

Legends—Node and link color settings, link utilization color bar settings,
and line styles.

Labels—Whichnodeor link labelsare turnedonand labelingpreferences
for the bottom bar

Background Image—Background images to use

Country Maps—Country maps to use

Groups—Which groups are collapsed and which groups are expanded

Related
Documentation

Monitoring the Topology of Network Elements Managed by CSD-Topology Overview

on page 301

•

• Specifying Topology Preferences on page 128

• CSD-Topology Topology MapWindowOverview on page 304

ExpandingandCollapsingGroupsbyUsing theTopologyMapGroupingShortcutMenu

In the Topology View displayed in Build mode on the Connectivity Services Director GUI,

you can collapse any groups, thereby displaying them as small group symbols, which

enables you toobtainahigh-level viewof largenetworkdeploymentswith several devices

and links. You can also expand any collapsed group in the topology to display and view

details of the network elements.
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To expand or collapse groups displayed in the Topology View:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed on the upper portion of the page. A table with details

of devices, services, links, and LSPs is displayed on the lower portion of the page.

3. Right-click a zone or a group on the upper portion of the topology window and select

either of the following options from the shortcut menu:

CollapseGroups—Collapses any groups, displaying themas small group symbolswith

their contents hidden

ExpandGroups—Expandsanycollapsedgroup in the topology.Thegroupsaredisplayed

as discs and the contents are visible.

Related
Documentation

Filtering Links, LSPs, and Services by Using the Topology Map Node Shortcut Menu on

page 309

•

• Removing the Highlighted LSPs by Using the Topology Map LSPs Shortcut Menu on

page 311

• Viewing theServicePathbyUsing theTopologyMapServiceShortcutMenuonpage312

Filtering Links, LSPs, and Services by Using the TopologyMap Node Shortcut Menu

In a network topology that contains a large number of links configured among devices

or nodes, it might be necessary to hide some of the links to avoid a cluttered view of

multiple connector lines and display only the links that are of relevance for your network

administration tasks. Also, youmight need to filter LSPs and services for a particular

device or node to selectively display only the LSPsand services configured for that device

or node. You can obtain such a restricted set of necessary links, LSPs, and services by

using the shortcut menu for each device or node.

Toobtain a filtereddisplayof LSPs, links, and services for aparticular node in theTopology

View:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.
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The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed on the upper portion of the page. A table with details

of devices, services, links, and LSPs is displayed on the lower portion of the page.

3. Select the Devices tab on the lower portion of the page.

The configured device details are displayed in a table.

4. Select the check boxes beside thedevices that youwant to viewon the topologymap.

The selected devices in the corresponding zones or custom groups are displayed on

the topology map.

5. Mouse over a node icon or set of nodes and right-click to display a menu.

When youmouse over a device or a node, the name of the device or node is displayed

as a tooltip.

The following options are available on the shortcut menu when you right-click each

device or node:

SelectDevice—Highlights the device to indicate that it has been selected amongother

nodes displayed in the Topology View

Show Links—Displays the current route and the defined routes (for example, primary

and backup) of the given tunnel in the Topology View. If multiple tunnels are

selected, their primary paths are highlighted in the Topology View, and the tunnel

currently selected in the path window is highlighted with a different color.

Hide Links—Removes the connector lines that are displayed to signify the links from

the selected or source device to destination pairs of all tunnels on the topology

map

Filters > Filter LSPs—Displays the LSPs thatmatch the filter criteria that you specified

for LSPs, such as whether LSPs that are up or downmust be displayed, and

whether delegated LSPs, CSD-Topology–initiated or PCEP–initiated LSPs, or

router–initiated or PCC–initiated LSPsmust be displayed.

Filters > Filter Services—Displays the services that match the filter criteria that you

specified for services, such as whether E-Line, IP, or E-LAN services must be

displayed

Related
Documentation

ExpandingandCollapsingGroupsbyUsing theTopologyMapGroupingShortcutMenu

on page 308

•

• Removing the Highlighted LSPs by Using the Topology Map LSPs Shortcut Menu on

page 311

• Viewing theServicePathbyUsing theTopologyMapServiceShortcutMenuonpage312
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Removing the Highlighted LSPs by Using the TopologyMap LSPs Shortcut Menu

You can remove the highlighted LSPs from being displayed in the Topology View in

network scenarios in which several LSPs are configured for a service to prevent the

topologymap from being cluttered with a large set of connector lines. Youmight require

to specifically focus on some of the LSPs that you want to troubleshoot and diagnose

for faults and traffic disruptions.

NOTE: In the Topology View displayed in Build mode on the Connectivity
Services Director GUI, mouse over an LSP and right-click to display amenu.
When youmouse over an LSP, the name of the link is displayed as a tooltip.

To remove the highlighted LSPs from display in the Topology View:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed on the upper portion of the page. A table with details

of devices, services, links, and LSPs is displayed on the lower portion of the page.

3. Select the LSPs tab on the lower portion of the page.

The configured LSP details are displayed in a table.

4. Select the check boxes beside the LSPs that you want to view on the topology map.

The selected LSPs are displayed as different color-coded lines on themap.

5. Mouse over an LSP and right-click to display a menu.

When youmouse over an LSP, the name of the link is displayed as a tooltip. The

following option is available on the shortcut menu when you right-click each LSP:

Remove LSP Highlight > LSPName—Removes the selected LSPs displayed on the

shortcut menu from being highlighted in the Topology View. This option is useful

when a service is configured with multiple LSPs and you do not want the LSPs

to be highlighted and shown.

Related
Documentation

ExpandingandCollapsingGroupsbyUsing theTopologyMapGroupingShortcutMenu

on page 308

•

• Filtering Links, LSPs, and Services by Using the Topology Map Node Shortcut Menu on

page 309

311Copyright © 2019, Juniper Networks, Inc.

Chapter 18: Accessing the Topology View of CSD-Topology



• Viewing theServicePathbyUsing theTopologyMapServiceShortcutMenuonpage312

Viewing the Service Path by Using the TopologyMap Service Shortcut Menu

A service path is a connector that displays the LSP configured for a particular service on

a device in the Topology View. Because of a large number of services that might be

configured among devices in a topology, it is required to distinguish only the LSPs or

service paths that connect from one device to another device. In such a case, you can

select a service displayed in the Topology View and choose to hide or show the service

path for analysis purposes.

NOTE: In the Topology View displayed in Build mode on the Connectivity
ServicesDirectorGUI,mouse over a service and right-click to display amenu.
When youmouse over a service, the name of the service is displayed as a
tooltip.

To hide or display a service path associated with a device in the Topology View:

1. Select Topology View from the Views list in the Connectivity Services Director

application.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed.

2. Select the Service tab on the lower portion of the page.

The service details are displayed in a table.

3. Select the check box beside a service configured for devices in the topology.

The service paths that traverse the different devices on which the selected service is

configured are displayed as highlighted lines in the Topology View.

4. Right-click a service path and select one of the following options available on the

shortcut menu:

Hide Service Path—Removes the LSPs highlighted in the Topology View.

Retrieve Service Path—Retrieves an LSP associated with the service path.

NOTE: Starting from Connectivity Services Director Release 2.0R4,
you canalso selectRetrieveServicePath to retrieve anLSPassociated

with a service path.

ShowService Path—Displays the LSPs associated with the service.
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Release History Table DescriptionRelease

Starting from Connectivity Services Director Release 2.0R4, you can also
selectRetrieve Service Path to retrieve an LSP associated with a service
path.

2.0R4

Related
Documentation

ExpandingandCollapsingGroupsbyUsing theTopologyMapGroupingShortcutMenu

on page 308

•

• Filtering Links, LSPs, and Services by Using the Topology Map Node Shortcut Menu on

page 309

• Removing the Highlighted LSPs by Using the Topology Map LSPs Shortcut Menu on

page 311

Filtering Devices, LSPs, and Services for Sorting and Segregating the Topology View

In network environments that contain several thousands of devices, it might be helpful

to sort and segregate the devices and their associated LSPs and links, based on certain

filter conditions. You can specify the criteria that must bematched for the network

elements shown in the Topology View. For example, you can specify that only devices

that are up or only LSPs for devices on which IP services are definedmust be displayed.

To specify the filter criteria for segregating the displayed elements in the Topology View:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed on the upper portion of the page. A table with details

of devices, services, links, and LSPs is displayed on the lower portion of the page.

3. Click the Filter icon (the funnel symbol) at the top-left corner of the Topology View

window.

The Filter dialog box is displayed.

4. On the Devices tab, mouse over the tab to view the drop-downmenu and do the

following:

• Select ShowAll, Up, or Down from the Device Status list to display the devices that

are in any state, in the up state, or in the down state respectively.

• Select the ShowUnmanaged Devices check box to display the unmanaged devices

that are present in the links in the topology. Alternatively, clear this check box to

view only the managed devices in the topology.
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• Select CustomGroup,OSPF Area, or ASNumber from the Group by list to group the

devices in the topology based on the configured custom groups, OSPF area, or

autonomous system (AS) number respectively.

5. OntheLinks tab,mouseover the tab toviewthedrop-downmenuanddothe following:

• Select the ShowAll Links check box to display all the links originating from each

node in the topology.

• Select the ShowOptical Links check box to display only the optical links originating

from each node in the topology.

• Select Up or Down from the Operational Status list to display links that are either

active or disabled.

6. Click Filter to save the filter criteria.

The dialog box is closed and you are returned to the Topology View.

Related
Documentation

Viewing Device Details of a CSD-Topology for Examining Traffic Transmission on

page 316

•

• Viewing LSP Details of a CSD-Topology for Analyzing Network Changes on page 318

• Viewing Link Details of a CSD-Topology for Determining the Operational Status on

page 321

• ViewingServiceDetails of aCSD-Topology forMonitoring andTroubleshootingService

Parameters on page 322

Segregating the Displayed Devices by Searching the Entire Topology View

In the Topology View displayed in Build mode on the Connectivity Services Director GUI,

you can enter the strings or terms that youwant to use as search labels to search for any

node, link, or group and filter the display. The Search box is displayed on the top-right

corner of the Topology View. You can search based on only one term or criterion at a

time. You can search for nodes or devices on the topology map based on router ID,

hostname, management IP address, and serial number of the device. In certain network

deployments, youmight require a certain set of devices that match a particular subnet

to be viewed for obtaining a subset of the entire topology that is of interest and relevance

to you. In such cases, you can specify the IP address of the device as the search term to

view only the appropriate device that matches the search term.

To specify a search criterion for classifying the displayed devices in the Topology View:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.
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The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed.

3. Click the Search icon (magnifying glass symbol) and enter the search term in the text

field that is displayed.

TheSearchbox isdisplayedon the top-rightcornerof theTopologyView.Adrop-down

list prompts you to select a term that matches the characters you enter in the search

field. The node that matches the search term is highlighted in the Topology View.

You can search based on only one criterion at a time. You can search for nodes or

devices in the Topology View based on the router ID, hostname, management IP

address, and serial number of the device. Delete the search term that you entered to

remove the term from the search criterion.

Related
Documentation

Resynchronizing the Topology View on page 315•

Resynchronizing the Topology View

You can resynchronize the topologymap displayed on the Connectivity Services Director

GUI, which enables the latest links information, label-switched path (LSP) details, and

device states to be retrieved from the CSD-Topology application and shown in the

Topology View. This resynchronization capability enables you to view themost recent

synchronization of paths signaled across routed network elements. It is essential to view

the latest topology information in a network that has changing traffic conditions and

transmission states to be able to modify the link and LSP settings according to the

deployment needs. The resynchronization functionality enables you to obtain the

up-to-date topology states.

To create a job to resynchronize the topology map:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed.

3. Click theResynch theTopology icon (5o’clock symbol) to create a job to resynchronize

the topology map.

A job is triggered and a pop-up dialog box displays the job ID.

4. ClickOK to close the pop-up dialog box.
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You can navigate to the Job Management page to view the status of the

resynchronization job (which you can launch by clicking the System button on the

Connectivity Services Director banner and selectingManage Jobs from the Tasks

pane).

Related
Documentation

Configuring PCEP on a PE Router (from CLI) on page 289•

Viewing Device Details of a CSD-Topology for Examining Traffic Transmission

You can view the details of all of the devices or nodes in a Topology View that are

managed by the CSD-Topology. Node addresses for the Node A and Node Z elements

define the endpoint nodes for the tunnel. Devices that are discovered as part of the

topology acquisition by the CSD-Topology and are not managed devices in the

ConnectivityServicesDirector databasearedisplayed in gray.Devices that arediscovered

by the CSD-Topology using BGP andMPLS and aremanaged devices in the Connectivity

Services Director database are displayed in blue.

NOTE: Because of the way in which the link-state database (LSDB) interior
gateway protocols (IGPs) represent LAN connections (in order to improve
scaling), multiple entries for the same hostnamemight be displayed on the
Devices tab of the Topology View. Similarly, multiple entries for the same
hostnamemight be displayed on the Devices tab because of themanner in
whichOSPFand ISIS associatewith broadcast interfaces. The pseudonodes
are represented in a distinct way on the GUI. When the IGP (OSPF or ISIS)
builds neighboring relationships on broadcastmedia (such as Ethernet), the
IGP represents this deployment as a hub-and-spoke topologywith all nodes
in the same broadcast domain having a point-to-point connection with a
pseudonode. In such instances, the traffic engineering database includes a
pseudonodeoneach interface that is configuredwith the interface-typeLAN
(the default). If such pseudonodes are not added, the topology displays a
full-mesh of point-to-point connections between all nodes in the same LAN
segment (this case occurs if youmanually configure the interface type as
point-to-multipoint [P2MP], andmanually add each neighbor). The GUI
represents these pseudonodes in a way that enables you to easily see that
these are not real nodes (it can represent the pseudonode as a different
entity, such as a special node or a LAN segment).

To view details of devices or nodes in the Topology View:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.
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The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed on the upper portion of the page. A table with details

of devices, services, links, and LSPs is displayed on the lower portion of the page.

3. Select the Devices tab on the lower portion of the page.

For columns in the table that contain an empty text field displayed at the top of the

table on each tab, you can enter the search criterion that you want to use for that

particular column or parameter to sort and classify the display of values in the table.

For parameters that you can enable or disable, you can select or clear the check boxes

respectively. The page is refreshed to display the devices that match the specified

criterion. The search criteria that you have entered are displayed above the first row

of the table. You can click Clear All displayed beside each of the search terms to

remove the previously defined search terms.

• Name—Hostname of the device. Click in the first cell in this column to enter the

hostname as the criterion for filtering and displaying the devices in the table.

• Management Address—Management IP address of the node. Click in the first cell

in this column to enter themanagement IP address as the criterion for filtering and

displaying the devices in the table.

• Serial Number—Hardware serial number of the device

• Software Version—Junos OS software version and release number running on the

device

• Platform—Platform type of the device, such as MX240 or MX480

• Platform Series—Device family to which the device belongs, such as MX Series for

an MX240 router

Related
Documentation

Filtering Devices, LSPs, and Services for Sorting and Segregating the Topology View

on page 313

•

• Viewing LSP Details of a CSD-Topology for Analyzing Network Changes on page 318

• Viewing Link Details of a CSD-Topology for Determining the Operational Status on

page 321

• ViewingServiceDetails of aCSD-Topology forMonitoring andTroubleshootingService

Parameters on page 322
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Viewing LSP Details of a CSD-Topology for Analyzing Network Changes

You can view the details of all the label-switched paths (LSPs) configured for devices

in the Topology View that are managed by the CSD-Topology. For MPLS-enabled

networks, after you configure an LSP, you should also configure a standby or secondary

LSP to provide an alternate route in the event the primary route fails. The tunnel ID, from

node, tonode, and IPaddressofa secondaryor standby tunnelmustbe identical to those

of the primary tunnel.

When you expand a zone or a group in the Topology View, and select an LSP on themap,

the LSP is highlighted. Different highlighting colors are used to distinguish the LSPs on

themap.

To view details of LSPs in the Topology View:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed.

3. Select the LSPs tab on the lower portion of the page.

NOTE: LSP names that are not unique in the network are not displayed
in the Topology View.

For columns in the table that contain an empty text field displayed at the top of the

table on each tab, you can enter the search criterion that you want to use for that

particular column or parameter to sort and classify the display of values in the table.

For parameters that you can enable or disable, you can select or clear the check boxes

respectively. The page is refreshed to display the devices that match the specified

criterion. The search criteria that you have entered are displayed above the first row

of the table. You can click Clear All displayed beside each of the search terms to

remove the previously defined search terms.

• Name—Name of the LSP. Click in the first cell in the Name column to enter the

name of the LSP that you want to use as the filter for viewing the LSPs.

• Start Node Router ID—Node ID of the LSP head end. A router ID is used to uniquely

identify the router within a BGP autonomous system (AS). The router ID is the IP

address of the loopback interface.

• Start Node Hostname—Hostname of the router at the LSP head end

• End Node Router ID—Node ID of the LSP tail end
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• End Node Hostname—Hostname of the router at the LSP tail end

• EndA IP—IPaddressof theLSPheadend.Click in the first cell in theEndA IPcolumn

to enter the IP address of the head end that youwant to use as the filter for viewing

the LSPs.

• End B IP— IP address of the LSP tail end. Click in the first cell in the End B IP column

to enter the IP address of the tail end that you want to use as the filter for viewing

the LSPs.

• Operational Status—Whether the LSP is active (up) or inactive (down). Click in the

first cell in the Operational Status column to select the status from the drop-down

menu that you want to use as the filter for viewing the LSPs.

• PathType—Whether the path is a primary path (explicit or dynamic) or a secondary

path (explicit or dynamic)

• Control Type—Whether the LSP is router controlled or PCC initiated, CSD-Topology

initiated or PCEP initiated, or CSD-Topology managed or delegated LSP. Click in

the first cell in the Control Type column to specify the type of LSP from the

drop-downmenu that you want to use as the filter for viewing the LSPs.

• Metric—LSP tunnel metric

• Setup Priority—Setup priority supported by RSVP for the tunnel traffic

NOTE: Youmust assign priorities according to network policies to
prevent resource poaching and LSP thrashing. The hold priority values
should be lower than or equal to the setup priority value.

• Holding Priority—Hold priority supported by RSVP for the tunnel traffic
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NOTE: Thedefault ispriority07andhold07,which is thestandardMPLS
LSP definition in Junos OS. Setup priority determines whether a new
LSP that preempts an existing LSP can be established. For preemption
tooccur, thesetuppriorityof thenewLSPmustbehigher than thesetup
priorityof theexistingLSP. Inaddition, theactofpreempting theexisting
LSPmust provide sufficient bandwidth to support the new LSP.
Therefore, preemption occurs only if the new LSP can be set up
successfully. You can configure each LSPwith a setup priority and hold
priority to provide a preemption strategy whereby a new LSP can claim
resources from an existing LSP. Each LSP can claim resources from an
existing LSP. Priority levels range from 0 (highest priority) through 7
(lowest priority). If traffic engineering admission control determines
that there are insufficient resources available to accept a request to set
up a new LSP, the setup priority is evaluated against the hold priority of
the existing LSPs (per standard JunosOSbehavior). An LSPwith a hold
priority lower than the setup priority of the new LSP can be preempted.
The existing LSP is terminated tomake resources available for the new
LSP.

• Current Bandwidth—Bandwidth that is specified for the tunnel traffic (bandwidth

applies for each direction)

4. Mouse over an LSP and click the LSP to display a menu.

When youmouse over an LSP, the name of the LSP is displayed on a pop-upmenu.

The following fields are displayed in the pop-up dialog box when youmouse over the

LSP:

• Name—Name of the LSP. The names of all the LSPs that are configured for the

particular link are displayed.

• View Details—Detailed information about the selected LSP.

Related
Documentation

Filtering Devices, LSPs, and Services for Sorting and Segregating the Topology View

on page 313

•

• Viewing Device Details of a CSD-Topology for Examining Traffic Transmission on

page 316

• Viewing Link Details of a CSD-Topology for Determining the Operational Status on

page 321

• ViewingServiceDetails of aCSD-Topology forMonitoring andTroubleshootingService

Parameters on page 322
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Viewing Link Details of a CSD-Topology for Determining the Operational Status

It is necessary to determine the operational status of links configured among devices in

a topology toexamineand troubleshootdata traffic lossandpacket-forwardingproblems.

You can view the details of all the links configured for devices in the Topology View that

aremanaged by the CSD-Topology. For explicit routing, from theMap view, click the links

or nodes todefineanalternate routebetween the source (NodeA)anddestination (Node

Z) nodes to provide a path that is diverse from the path specified in the primary tunnel.

When you schedule a maintenance event on nodes or links, the CSD-Topology routes

delegated label-switchedpaths (LSPs) around those nodes and links that are scheduled

for maintenance. After the completion of the maintenance event, delegated LSPs are

reverted to optimal paths.

To view details of links in the Topology View:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed on the upper portion of the page. A table with details

of devices, services, links, and LSPs is displayed on the lower portion of the page.

3. Select the Links tab on the lower portion of the page.

For columns in the table that contain an empty text field displayed at the top of the

table on each tab, you can enter the search criterion that you want to use for that

particular column or parameter to sort and classify the display of values in the table.

For parameters that you can enable or disable, you can select or clear the check boxes

respectively. The page is refreshed to display the devices that match the specified

criterion. The search criteria that you have entered are displayed above the first row

of the table. You can click Clear All displayed beside each of the search terms to

remove the previously defined search terms.

• Link Name—Name of the configured link

• End A RouterId—Router ID of the starting node of the link. The router ID is used to

uniquely identify a router and is the IP address of the loopback interface.

• End B RouterId—Router ID of the ending node of the link

• EndpointAHostname—Hostnameof the routerat thestartingnodeof the link.Click

in the first cell in the Endpoint A IP column to enter the IP address of the LSP head

end that you want to use as the filter for viewing the links.

• End B Hostname—Hostname of the router at the ending node of the link. Click in

the first cell in the Endpoint A IP column to enter the IP address of the LSP tail end

that you want to use as the filter for viewing the links.
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• End A Interface Name—Name of the interface on the router at the starting point of

the link

• End B Interface Name—Name of the interface on the router at the ending point of

the link

• End A Interface Address—IP address of the interface on the router at the starting

point of the link

• End B Interface Address—IP address of the interface on the router at the ending

point of the link

• Link Type—Whether the link is an IP link or an optical link

• Operational Status—Whether the link is active (up) or inactive (down). Click in the

first cell in the Operational Status column to open the drop-downmenu and select

the type of operational status that you want as the filter for viewing for the links.

Related
Documentation

Filtering Devices, LSPs, and Services for Sorting and Segregating the Topology View

on page 313

•

• Viewing Device Details of a CSD-Topology for Examining Traffic Transmission on

page 316

• Viewing LSP Details of a CSD-Topology for Analyzing Network Changes on page 318

• ViewingServiceDetails of aCSD-Topology forMonitoring andTroubleshootingService

Parameters on page 322

ViewingServiceDetailsofaCSD-Topology forMonitoringandTroubleshootingService
Parameters

You can view the consolidated and cumulative information pertaining to a service to

examine and diagnose the deployment and fault statuses for debugging and corrective

action. The overall information pertaining to the service that you can obtain from the

Topology View enables you to navigate to the appropriate device or service settings page

andmodify the configuration parameters appropriately.

You can view the details of all the services configured for devices on a topologymap that

are managed by the CSD-Topology. This information display of service attributes is

especially helpful if devices that are managed by the CSD-Topology are also added to

the Connectivity Services Director database for administration andmonitoring. You can

view the topology map based on the services and other filter conditions, such as their

deployment states, functional audit statuses, or customer name. E-Line, E-LAN, and IP

services defined on devices can be viewed.

To view details of services on a topology map:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.
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2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed on the upper portion of the page. A table with details

of devices, services, links, and LSPs is displayed on the lower portion of the page.

3. Select the Services tab on the lower portion of the page.

For columns in the table that contain an empty text field displayed at the top of the

table on each tab, you can enter the search criterion that you want to use for that

particular column or parameter to sort and classify the display of values in the table.

For parameters that you can enable or disable, you can select or clear the check boxes

respectively. The page is refreshed to display the devices that match the specified

criterion. The search criteria that you have entered are displayed above the first row

of the table. You can click Clear All displayed beside each of the search terms to

remove the previously defined search terms.

• Name—Nameof the serviceconfigured for adevice.Click in the first cell in theName

column to enter the service name that you want to use as the filter for viewing the

services.

• Service Type—Type of service, such as E-Line, IP, or E-LAN. Click in the first cell in

theServiceType column to select the typeof service from thedisplayeddrop-down

menu that you want to use as the filter for viewing the services.

• Customer Name—Name of the customer associated with the service. Click in the

first cell in the Customer Name column to enter the customer name that you want

to use as the filter for viewing the services.

• Topology Type—Design of the network, such as a point-to-point topology,

point-to-multipoint or hub-and-spoke format, andmultipoint-to-multipoint or

full-mesh format. Click in the first cell in the Topology Type column to select the

type of topology from the displayed drop-downmenu that you want to use as the

filter for viewing the services. The followingoptions are displayedon thedrop-down

menu:

• POINT2POINT—Point-to-point topology type

• POINT2MULTIPOINT—Point-to-multipoint topology type

• MULTIPOINT2MULTIPOINT—Multipoint-to-multipoint topology type for E-LAN

services

• FULLMESH—Full-mesh topology type for IP services

• HUBSPOKE1INTF—Hub-and-spoke topology type with one interface

• HUBSPOKE2INTF—Hub-and-spoke topology type with two interfaces

• Deployment State—Status of deployment, such as whether the deployment is

successful, failed, or pending. Click in the first cell in the Deployment State column

to select thedeployment status fromthedisplayeddrop-downmenu that youwant

to use as the filter for viewing the services. The following values are displayed on

the drop-downmenu:
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• Deployed—The service is deployed and is in an active state (enabled) or inactive

state (disabled).

• Deployment-Pending—The service has not yet been deployed.

• Failed Deploy—Attempt to modify the service failed.

• Fault Status—Fault management status of the service, such as whether a service

fault is active on a device (red bell icon) or the service fault that was generated for

the device has been cleared (green bell icon)

• FA Status—Whether the link is active (up) or inactive (down). Click in the first cell

under the FAStatus column to select the functional audit status from the displayed

drop-downmenu that you want to use as the filter for viewing the services. The

following values are displayed on the drop-downmenu:

• Pending—Functional audit operation is pending to be performed for the service.

• Failed—Functional audit operation has failed for the service.

• Up—Functional audit completed successfully for the service.

• Last Updated Date—Date and time that the information for the service was last

modified

Related
Documentation

Filtering Devices, LSPs, and Services for Sorting and Segregating the Topology View

on page 313

•

• Viewing Device Details of a CSD-Topology for Examining Traffic Transmission on

page 316

• Viewing LSP Details of a CSD-Topology for Analyzing Network Changes on page 318

• Viewing Link Details of a CSD-Topology for Determining the Operational Status on

page 321
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Viewing TopologyMap Group Details in a Pop-Up Dialog Box

In the Topology View of Build mode, the upper portion of the page, which shows the

topology map, is the main display area. In this area, you can double-click the zones that

are displayed to expand and display the devices contained in that zone. Mouse over a

node, link, or group on themap to display a pop-upmenu for that element. Mouse over

a group to view the group information. When youmouse over a group, the name of the

group is displayed on a pop-upmenu.

In a large network that comprises devices or nodes situated in several groups, which

denote the geographical locations or zones, it might be essential to view the details of a

particular group that is of relevance for your networkmanagement needs. In such cases,

apart from viewing the number of devices that are associatedwith a group, you can also

view information on the alarms generated for these devices. For example, youmight

want to modify the grouping of devices by transferring devices to a different group or

zone for better load-balancing of traffic or optimizing packet flows. Also, if you find that

a particular group has recorded a large number of critical or major alarms, you can then

navigate to the Alarm Detail widget in Monitor mode or the appropriate device settings

page to correct andmodify the attributes or diagnose the problems that might be

generating the alarms.

NOTE: Right-clicking themap area displays a pop-upmenu for more
functions. You canmove themap by holding down and dragging the left
mouse button. You can zoom in and out by using themouse scroll wheel.
Double-click an element icon to collapse the devices or network elements
and view the entire site or zone as an icon.

To view group details in a pop-up dialog box:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed on the upper portion of the page. A table with details

of devices, services, links, and LSPs is displayed on the lower portion of the page.

3. In the graphical representation of the topology displayed , select the group for which

you want to view the device details by double-clicking the group.

The group is expanded and the devices contained in the group are displayed within a

circle.

Devices that are discovered as part of the topology acquisition by the CSD-Topology

and are not managed devices in the Connectivity Services Director database are

displayed in gray. Devices that are discovered by the CSD-Topology using BGP and
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MPLS and are managed devices in the Connectivity Services Director database are

displayed in blue.

4. Mouse over the group for which you want to view the configuration settings.

The group pop-upmenu is displayed with the number of devices contained in the

group.

5. Click the View Details link from the pop-upmenu.

The Group Details pop-up dialog box is displayed, which displays the name of the

group and the number of devices contained in the group. Also, the Fault Details field

displays four colored circles—red, orange, yellow, and blue—to signify the four alarm

severity levels as follows:

• Critical (red)—A critical condition exists for a device in the zone; immediate action

is necessary.

• Major (orange)—Amajor error has occurred for a device in the zone; escalate or

notify as necessary.

• Minor (yellow)—Aminor error hasoccurred for adevice in the zone; notify ormonitor

the condition.

• Info (blue)—An informationalmessage has been generated for a device in the zone;

no action is necessary. Informational alarms do not necessarily indicate an error. It

could indicate that a device or entity has changed state.

6. Click the Close icon at the top-right corner of the pop-up dialog box to return to the

topology map.

Related
Documentation

Viewing Topology Map Device Details in a Pop-Up Dialog Box on page 327•

• Viewing Topology Map Link Details in a Pop-Up Dialog Box on page 329

• Viewing Topology Map LSP Details in a Pop-Up Dialog Box on page 331

• Viewing Topology Map Service Details in a Pop-Up Dialog Box on page 333
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Viewing TopologyMap Device Details in a Pop-Up Dialog Box

In the Topology View of Build mode, the upper portion of the page shows the topology

map, which is themain display area. In this area, you can double-click the zones that are

displayed to expand and display the devices contained in that zone. The pop-upmenu

is accessed by double-clicking the group in the center pane that shows the topology

map. Mouse over a device on themap to display a pop-upmenu for that device.

In a geographically diverse network with several groups or zones, after you expand and

view a particular group, you can also view the salient configuration details of devices

contained in that group. Both the devices that are managed by Connectivity Services

Director and the devices that are not managed by Connectivity Services Director, but

have been only acquired as part of the CSD-Topology topology acquisition, are displayed

in the expanded groups on the topology map. You can view important, high-level device

details such as the JunosOS release that is running on a particular device for determining

any JunosOS imageupgradeasnecessary and thedevice status. If you identify the status

of the device to be down, you can then view the device configuration settings and take

any corrective action.

NOTE: Right-clicking themap area displays a pop-upmenu for more
functions. You canmove themap by holding down and dragging the left
mouse button. You can zoom in and out by using themouse scroll wheel.
Double-click an element icon to collapse the devices or network elements
and view the entire site or zone as an icon.

Devices that are discovered as part of the topology acquisition by the
CSD-Topology and are not managed devices in the Connectivity Services
Director database are displayed in gray. Devices that are discovered by the
CSD-Topology using BGP andMPLS and aremanaged devices in the
Connectivity Services Director database are displayed in blue.

Mouse over a node icon or set of nodes and double-click to display a menu. When you

mouse over a device or a node, the name of the device is displayed on a pop-upmenu.

The following fields are displayed in the pop-up dialog box when youmouse over the

device or node:

• Host Name—Hostname of the selected device or node

• IP Address—IP address of the selected device or node

• Device Status—Status of the selected device or node, such as Up or Down

• View Details—Detailed information about the selected device or node. Click the link in

View Details to open a pop-up dialog box that displays these details.

When you select a particular device by expanding a groupor zone and clicking the device,

the device icon is highlighted and displayed.
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To view device details in a pop-up dialog box:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed.

3. In the graphical representation of the topology displayed on the right pane, select the

group for which you want to view the device details by double-clicking the group.

The group is expanded and the devices contained in the group are displayed within a

circle.

4. Mouse over the device or node for which you want to view the configuration settings.

The device pop-upmenu is displayed.

5. Click the View Details link from the pop-upmenu.

The Device Details dialog box is displayed on the right pane, which contains the

following fields:

• Host Name—Hostname of the device or node

• Serial Number—Serial number of the chassis component. The serial number of the

backplane is also the serial number of the router chassis. Use this serial number

when you need to contact Juniper Networks Customer Support about the router or

switch chassis.

• OS Version—Operating system firmware version running on the device or node

• Device Family—Device family of the device or node, such as JUNOS for MX Series

routers

6. Click the Close icon at the top-right corner of the pop-up dialog box to return to the

topology map.

Related
Documentation

Viewing Topology Map Group Details in a Pop-Up Dialog Box on page 325•

• Viewing Topology Map Link Details in a Pop-Up Dialog Box on page 329

• Viewing Topology Map LSP Details in a Pop-Up Dialog Box on page 331

• Viewing Topology Map Service Details in a Pop-Up Dialog Box on page 333
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Viewing TopologyMap Link Details in a Pop-Up Dialog Box

In the Topology View of Build mode, the upper portion of the page shows the topology

map,which is themaindisplayarea. In thisarea, youcanclickor right-click theconnecting

lines, which represent the links that transmit traffic between devices, to view the link

details. The pop-upmenu is accessed by double-clicking in the center pane that shows

the topology map. Mouse over a link on themap to display a pop-upmenu for that link.

For a specific zone and a set of devices in that zone, you can view the links connecting

the devices. You can view the link details, such as the node identifier and the node IP

address of the head end or originating router and the tail end or the destination router.

These link details are useful for diagnosing and troubleshooting any link problems that

cause traffic drops or loss in transmission of packets.

NOTE: Right-clicking themap area displays a pop-upmenu for more
functions. You canmove themap by holding down and dragging the left
mouse button. You can zoom in and out by using themouse scroll wheel.
Double-click an element icon to collapse the devices or network elements
and view the entire site or zone as an icon.

To view link details in a pop-up dialog box:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed.

3. In the graphical representation of the topology displayed on the page, select the link

by clicking the link or right-clicking the link for which you want to view details.

The link is highlighted and displayed as a colored line.

4. Mouse over a link and click the link to display a menu.

When youmouse over a link, the name of the link is displayed on a pop-upmenu. The

following fields are displayed in the pop-up dialog box when youmouse over the link:

• Operational Status—Status of the link, such as Up or Down

• View Details—Detailed information about the selected link. Click the link in View

Details to open a pop-up dialog box that displays these details.

5. Click the View Details link from the pop-upmenu.
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The Link Details pop-up dialog box is displayed on the right pane. The link details are

displayed in a table as follows:

• End A Device—Node ID of the LSP head end

• End B Device—Node ID of the LSP tail end

• End A IP—IP address of the LSP head end

• End B IP—IP address of the LSP tail end

• Operational Status—Whether the link is active (up) or inactive (down)

6. Click the Close icon at the top-right corner of the pop-up dialog box to return to the

topology map.

Related
Documentation

Viewing Topology Map Group Details in a Pop-Up Dialog Box on page 325•

• Viewing Topology Map Device Details in a Pop-Up Dialog Box on page 327

• Viewing Topology Map LSP Details in a Pop-Up Dialog Box on page 331

• Viewing Topology Map Service Details in a Pop-Up Dialog Box on page 333
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Viewing TopologyMap LSP Details in a Pop-Up Dialog Box

In the Topology View of Build mode, the upper portion of the page shows the topology

map,which is themaindisplayarea. In thisarea, youcanclickor right-click theconnecting

lines,which represent the label-switchedpaths (LSPs) configuredover pseudowire links,

that transmit traffic between devices, to view the LSP details. Mouse over an LSP on the

map to display a pop-upmenu for that LSP.

For a specific zone and a set of devices in that zone, you can view the links and LSPs

connecting thedevices.Whenyouview theLSPdetails, the linkdetails arealsodisplayed.

You can determine the path type of the LSP—primary or backup. You can then decide

whether you want to automatically configure a tunnel to have its secondary or standby

paths diverse from its primary path. You can also design two different tunnels to have

diverse primary paths, and set the primary and backup paths to perform explicit routing

or dynamic routing. You can also verify the type of LSP—CSD-Topology managed

(Delegated) LSP, path computation element protocol (PCEP) initiated LSP, or path

computation client (PCC) or router initiated LSP—and change the type of delegation to

be performed for the LSP.

NOTE: Right-clicking themap area displays a pop-upmenu for more
functions. You canmove themap by holding down and dragging the left
mouse button. You can zoom in and out by using themouse scroll wheel.
Double-click an element icon to collapse the devices or network elements
and view the entire site or zone as an icon.

Mouse over an LSP and click the link to display a menu. When youmouse over an LSP,

the name of the LSP is displayed on a pop-upmenu. The following fields are displayed

in the pop-up dialog box when youmouse over the LSP:

• Name—Name of the configured LSP. The names of all LSPs configured for a particular

link are displayed.

• ViewDetails—Detailed informationabout the selectedLSP.Click the link inViewDetails

to open a pop-up dialog box that displays these details.

To view LSP details in a pop-up dialog box:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed.

3. Select the LSPs tab on the lower portion of the page.
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The configured LSP details are displayed in a table.

4. Select the check boxes beside the LSPs that you want to view on the topology map.

The selected LSPs are displayed as different color-coded lines on themap.

5. In the graphical representation of the topology displayed on the upper portion of the

page, select the LSP by clicking the LSP or right-clicking the LSP for which you want

to view details.

The LSP is highlighted and displayed as a colored line.

6. Click the View Details link from the pop-upmenu.

The LSPDetails and Link Details pop-up dialog boxes are displayed on the right pane.

The LSP details are displayed in a table as follows:

• Name—Name of the configured LSP on the specific link

• Status—Whether the LSP is active (up) or inactive (down)

• PathType—Whether the path is a primary path (explicit or dynamic) or a secondary

path (explicit or dynamic)

• Control Type—Whether the LSP is router-controlled or PCC-initiated,

CSD-Topology-initiated or PCEP-initiated, or CSD-Topologymanaged or delegated

LSP

The link details are displayed in a table as follows:

• End A Device—Node ID of the LSP head end

• End B Device—Node ID of the LSP tail end

• End A IP—IP address of the LSP head end

• End B IP—IP address of the LSP tail end

• Operational Status—Specifies whether the link is active (up) or inactive (down)

7. Click the Close icon at the top-right corner of the pop-up dialog box to return to the

topology map.

Related
Documentation

Viewing Topology Map Group Details in a Pop-Up Dialog Box on page 325•

• Viewing Topology Map Device Details in a Pop-Up Dialog Box on page 327

• Viewing Topology Map Link Details in a Pop-Up Dialog Box on page 329

• Viewing Topology Map Service Details in a Pop-Up Dialog Box on page 333
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Viewing TopologyMap Service Details in a Pop-Up Dialog Box

In the Topology View of Build mode, the upper portion of the page shows the topology

map, which is the main display area. In this area, you can click or right-click the dotted

connecting links, which represent the services configured across devices, to view the

service details. The pop-upmenu is accessed by double-clicking a group in the center

pane that shows the topologymap.Mouse over a service on themap to display a pop-up

menu for that service.

The topology map enables you to obtain a comprehensive view of services configured

on devices in the entire network. Because you can narrow down to a specific service that

is of relevance to you in the topology map, you can easily view important configuration

specificationsof a service, suchas the typeof service, the customerwithwhich the service

is associated, whether the service is successfully deployed or is pending deployment,

and whether the service is in the requested, scheduled, or pending status. Such salient

service-specific details enable you to obtain a comprehensive view of the health of

services, and navigate to the Service View in Deploymode tomodify the service settings

for debugging and corrective action.

NOTE: Right-clicking themap area displays a pop-upmenu for more
functions. You canmove themap by holding down and dragging the left
mouse button. You can zoom in and out by using themouse scroll wheel.
Double-click an element icon to collapse the devices or network elements
and view the entire site or zone as an icon.

Mouseover thedotted lines thatdenote theservicesconfiguredacrossdifferentendpoints

on the topology map and click the service to display a menu. The following fields are

displayed in the pop-up dialog box when youmouse over the service:

• Name—Name of the configured service

• Customer Name—Name of the customer for which the service is configured

• Service Type—Type of the configured service, such as E-LINE Martini, IP, or E-LAN

• Service State—State of the service, such as whether the service is deployed or not

• Service Status—Status of the service, such as whether the service is in requested,

scheduled, or pending status

• View Details—Detailed information about the selected service. Click the link in View

Details to open a pop-up dialog box that displays these details.

333Copyright © 2019, Juniper Networks, Inc.

Chapter 18: Accessing the Topology View of CSD-Topology



To view service details in a pop-up dialog box:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed.

3. Select the Services tab on the lower portion of the page.

The configured service details are displayed in a table.

4. Select the check box beside the services that you want to view on the topology map.

The selected services are displayed as different dotted color-coded lines on themap.

5. In the graphical representation of the topology displayed on the upper portion of the

page, select the service by clicking the dotted lines or right-clicking the dotted lines

for which you want to view details.

The service is highlighted and displayed as a colored dotted line.

6. Click the View Details link from the shortcut menu.

The Service Details pop-up dialog box is displayed on the right pane.

The service details are displayed in a table as follows:

• Customer Name—Name of the customer for which the service is configured

• ServiceType—Typeof theconfiguredservice, suchasELINEMartini, L3VPN,orVPLS

• Service State—State of the service, such as whether the service is deployed or not

• Service Status—Status of the service, such as whether the service is in requested,

scheduled, or pending status

7. Click the Close icon at the top-right corner of the pop-up dialog box to return to the

topology map.

Related
Documentation

Viewing Topology Map Group Details in a Pop-Up Dialog Box on page 325•

• Viewing Topology Map Device Details in a Pop-Up Dialog Box on page 327

• Viewing Topology Map Link Details in a Pop-Up Dialog Box on page 329

• Viewing Topology Map LSP Details in a Pop-Up Dialog Box on page 331
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Enabling the Collection of LSP and Service Association Details

From theMonitoring tab of the Preferences page (which you can launch by clicking the

down arrow beside the System button on the Connectivity Services Director banner and

selecting Preferences), you can enable the collection of LSPs configured on the links of

the PCC devices in a topology and also to enable retrieval of service association details

with the LSPs. When you enable this functionality, the details are obtained from the

devices at periodic polling intervals.

To specify the monitoring setting for Topology:

1. Fromthe JunosSpaceuser interface, click theSystem icon in theConnectivityServices

Director banner.

The options that you can configure in Systemmode are displayed in a drop-down

menu.

2. Select Preferences from the drop-downmenu to open the Preferences page.

The Preferences page opens with User Preferences as the default tab.

3. Click theMonitoring tab to configure the frequency at which the association between

LSPs and services must be retrieved for the topology.

The settings that you can configure on the Monitoring tab are displayed.

4. Select theProvisioningMonitorLSPToServiceAssociationCollector check box to enable

the collection of LSPs configured on the links of the PCC devices in a topology and

also to enable retrieval of service association details with the LSPs.

When you select this check box, the details are obtained from the devices at periodic

polling intervals. By default, the polling interval is 5 minutes.

Related
Documentation

Configuring PCEP on a PE Router (from CLI) on page 289•

Using CustomGrouping for Devices in a CSD Topology

Youcanuse thecustomgroupingmethodology inConnectivityServicesDirector to cluster

the devices that the CSD-Topology provisions PCEP for establishing LSPs between the

PCC routers.Customgroup iswayofgroupingyourdevicesbasedonyourbusinessneeds.

You can create customgroups and add devices to each customgroup. You canmanually

add devices to a custom group or you can define rules to add devices, that match the

rule condition, to the custom group once they are discovered by Connectivity Services

Director. You can view the custom groups and devices that are assigned to each group

in the Custom Group view.

Using the custom groups feature, you can control how the group is displayed on the

topologymap—asasinglegroupentity or as individualmembernodes.Whenyouexpand
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a group on the topology map by double-clicking the group icon, all the member nodes

are listed in a circle with interconnecting links and are displayed on themap. When you

collapse a group on the topology map by double-clicking the circle that contains the

member nodes, only the group is displayed and represented by a single icon on themap.

Related
Documentation

Configuring PCEP on a PE Router (from CLI) on page 289•

Viewing Generated Alarms for Services in the Topology View

Apart from displaying a graphical representation of the nodes and interconnecting links

in a network deployment, the Topology View also displays the alarms of each severity

level generated for services configured on nodes in the network topology at the top-left

corner of the View Topology page. Information is displayed about the alarms generated

bydifferentdevices forwhich services, suchasE-Line, IP, LSPs, andE-LAN, are configured.

The summarized way in which you can view alarm details enables you to examine the

healthandoperating-efficiencyofdevices, and theperformanceof services. Thesealarm

details enable effective and simplified troubleshooting and administration.

For example, if you find that a particular device has recorded a large number of critical

ormajor alarms for a service, you can then navigate to the design and provisioning pages

of the type of service to correct andmodify the attributes or diagnose the problems that

might be generating thealarms. You can then clear the appropriate alarm from theAlarm

Detail monitor in Fault mode of Service View after examining the alarm and associated

events, and taking any corrective action needed to resolve the alarm condition on the

corresponding device.

NOTE: Only service-level alarms are displayed; alarms generated for LSPs
configured on the links connecting the nodes are not shown.

Related
Documentation

Configuring PCEP on a PE Router (from CLI) on page 289•
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Viewing the Optical Link Details for Examining the Performance of Optical Links

In theTopologyViewof Buildmode, in addition to the Layer 3 links configured for services

(such as Layer 3 VPNs), you can view the optical links or connections that are configured

on optical interfaces of devices such as PTX Series Packet Transport Routers. You can

sort and filter the optical links for viewing only the links of interest for your network. You

can easily identify the type of links—Layer 3 or optical—by using the Type field on the

Links tab displayed on the lower portion of the View Topology page.

Selecting a particular optical link on the Links tab highlights the link with a color-coded

connector line in the Topology View. Also, the optical inline amplifiers (optical ILAs) that

are installedon thePTX3000 routers aredisplayedon the topologymapwhenyou select

an optical link that connects two optical ILAs. The optical ILAs are not plotted on the

topology map unless you select an optical link on the Links tab.

To view optical links on a topology map:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Topology View.

The topologymap of the sites or zones and the devices configured in each zone using

the CSD-Topology is displayed on the upper portion of the page. A table with details

of devices, services, links, and LSPs is displayed on the lower portion of the page.

3. Select the Links tab on the lower portion of the page.

The link details are displayed in a table.

4. Select thecheckboxnext to the link forwhich the value in theTypecolumn isdisplayed

as Optical.

The selected optical link is displayed as a color-coded line on the topologymap. Also,

the optical ILAs on PTX3000 routers that are present on either sides of the selected

optical links are displayed on the topology map.

5. (Optional) Mouse over an optical ILA and click View Details from the pop-upmenu

to open a pop-up dialog box that displays detailed information about the optical ILA.

6. (Optional) Mouse over an optical link and click View Details from the pop-upmenu

to open a pop-up dialog box that displays detailed information about the optical link.

7. (Optional) Click the Filter icon at the top right of the topology map, and select the

ShowOptical Links check box from the Links drop-downmenu.
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Only the optical connections, and any optical ILAs between which the links exist, on

the topology map are filtered and displayed in the topology window.

Related
Documentation

• Enabling the Collection of LSP and Service Association Details on page 335

• Using Custom Grouping for Devices in a CSD Topology on page 335

• Viewing Generated Alarms for Services in the Topology View on page 336
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PART 6

Prestaging

• Prestaging Devices Overview on page 341

• Prestaging: Managing Devices and Device Roles on page 367

• Prestaging: Managing IP Addresses on page 385

• Device Configuration Prerequisites to Prestaging Examples on page 391

• Prestaging Services on page 397
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CHAPTER 19

Prestaging Devices Overview

• Prestaging Devices Process Overview on page 342

• PrestagingWorkflow in Connectivity Services Director on page 345

• Prerequisites for Prestaging Devices in Connectivity Services Director on page 348

• Discovering and Assigning All N-PE Devices on page 349

• Discovering and Assigning N-PE Devices with Exceptions on page 351

• Prestaging ATM and TDM Pseudowire Devices on page 354

• Discovering and Assigning Provider Role or LSP Role for Devices with

Exceptions on page 357

• Discovering and Assigning All Provider or LSP Devices on page 360

• Prestaging Rules on page 362
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Prestaging Devices Process Overview

After Junos Space has discovered the devices, a two- or three-stage process to prestage

devices is performed automatically in the backend by the Connectivity Services Director

application. The following events occur in a sequential manner for preparing the devices

to be compatible and qualified for configuration of services:

1. Discover roles. In this stage, the JunosSpace software searches thedatabase forN-PE

devices that have not yet been assigned.

2. Examine the results of the role discovery andmake any exceptions to the system

recommendations. Specifically, you might:

• Exclude specified devices from N-PE role assignment.

Youmight need to exclude a device that you know is not a PE device. For example,

Provider (P) devices that have loopback addresses pass the rules for N-PE role

assignment. For devices that you know are not PE devices, you can edit the

configuration out-of-band, and then run role discovery again.

• Select a different loopback address for a device.

• Exclude interfaces from UNI assignment.

3. Confirm the assignments.

When device assignments are confirmed internally by the Connectivity Services Director

application, those devices are removed from the list of recommendations. If, initially, you

exclude devices from assignment, you can return to the list of recommendations later

andmake further assignments.

When you addmore devices to your network, the role discovery operation runs again.

Running rolediscovery againoverwrites anydevices remaining in the rolediscovery results

list of recommended assignments, but has no effect on devices with confirmed

assignments.

• ThePrestageDevices screenshowsadevice inventoryofN-PE routers thatConnectivity

Services Director has discovered in its database that have not yet been assigned. You

can perform the following operations from the Prestage Devices screen:

• Select multiple devices to assign roles—Themost common and recommended

prestaging workflow is to select all devices in the Assign Roles screen and assign

them all. See “Discovering and Assigning All N-PE Devices” on page 349 for

step-by-step instructions for assigning all Junos Space recommendations.

• Select a single device to assign a role—Youmust select a single device to change

the the UNI assignments on that device. For step-by-step instructions on changing

UNIassignments, see “Excluding Interfaces fromUNIRoleAssignments”onpage374.

You can also exclude a single device using this screen.

• Exclude specified devices from the N-PE role. See “Discovering and Assigning N-PE

Devices with Exceptions” on page 351 for step-by-step instructions.
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• The Manage Interface Roles screen is an inventory of UNI-qualified interfaces for a

specific discovered device. You can view a separate Manage Interface Roles screen

for each discovered N-PE device. You can also excludemultiple interfaces from

qualification as UNIs. For step-by-step instructions on excluding interfaces from the

list ofqualifiedUNIs, see “Excluding Interfaces fromUNIRoleAssignments”onpage374.

NOTE: The UNI role is assigned to an interface by a notification from the
managed device that is sent to the Connectivity Services Director
application, even when you unassign the UNI role from the interface using
the Prestage Devicesworkspace. For example, if you unassign the UNI role
on an interface of amanaged device, that interface is available for
provisioning services on devices, when you attempt to create a service
order. For the same interface, if you configure encapsulation on it directly
from the device and navigate to the Prestaging workspace in Connectivity
Services Director after a fewminutes, the interface status indicates that
UNI role is configured on it. This behavior occurs because the UNI role is
assigned to the interface by a device notification.

NOTE: After a device is prestaged in Connectivity Services Director, the
prestaging job is not initiated on the same device again. When a device
notification is received by the application, Connectivity Services Director
synchronizes the prestaging database on the UI interfaces. If a mismatch
is detected in the UNI status of the interface in Connectivity Services
Directordatabaseand theUNI statusof the interfaceon thedevice (caused
by the application being down or network accessibility problems), the
synchronization of the UNI interfacemight not occur. In such a case, the
synchronization operation occurs when a configuration- commit on the
device is done the next time. Tomanually resolve this discrepancy in the
UNI status of the interface, you can unassign the UNI role of the interface,
which causes prestaging to perform a synchronization.

TheE-LANserviceneeds tobeenabled inanetworkdevice, tomake thestaticpseudowire

functionality active in the device. You can activate the static pseudowire functionality

by configuring the network device through the CLI window. You need to enter the CLI

configuration mode of a network element and run the command

set protocols vpls static-vpls no-tunnel-services

commit

If the device is not configured through CLI, awarningmessage appears in the application

server log, that is the JBOSS Log:

<Device name> should be configuredwith static VPLS no tunnel service rule.

To discover the roles of the various network elements configured:
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1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices.

4. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayedwith the job ID of the discovery job that

is created to obtain the latest roles of the devices.

To remove the role of the network elements configured:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

5. ClickManageDeviceRolesand fromthedrop-down list, selectUnassignRole to remove

the role capability of a network element. You are prompted to confirm the operation. If

you clickOK, a request is submitted to remove the latest role of the network element or

device.

The device is removed from the list of network elements displayed on the Devices Chart

page.

To resynchronize the role of the network elements configured:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

5. ClickManageDevice Roles and from the drop-down list, select Re-sync Role Capability

resynchronize the role capability of a network element. You are prompted to confirm the

operation. If you clickOK, request is submitted to retrieve the latest role of the network

element or device.

The role is re-synced with the same device now.

Related
Documentation

Prerequisites for Prestaging Devices in Connectivity Services Director on page 348•

• Discovering and Assigning All N-PE Devices on page 349
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• Discovering and Assigning N-PE Devices with Exceptions on page 351

• Prestaging ATM and TDM Pseudowire Devices on page 354

• Prestaging Rules on page 362

PrestagingWorkflow in Connectivity Services Director

Prestaging of devices using the Services Activation Director GUI comprises the process

of discovering capabilities of devices in the network. Certain classifications are made,

depending on the result of the device prestaging process. Service provisioning is made

possibleon thedevicebasedon thediscoveredcapabilitiesandclassification. Thedevices

that do not confirm to an expected configuration are not made available for selection,

when youattempt toprovision services. These capability discoveries of devices are prone

to errors on certain occasions. A second level of control for the user to classify the device

above the prestaging classification is implemented inConnectivity ServicesDirector. This

additional level of segregation and selection enables you to choose to override the

capabilities discovered by the prestaging workflow. The information discovered by the

prestaging workflow serves as a tip for you tomodify the device-capability classification

accordingly. Device prestaging using the Services Activation Director GUI is a manual

process in which you need to prestage the device, before you can configure services on

the device. Design enhancements have beenmade to automate this process using the

automatedprestagingmechanism,where thedevices areprestagedautomaticallywhen

concerned events occur on the device, in the Junos Space Platform database, or the

deployment of the Connectivity Services Director application. Using this effective and

streamlined automated prestagingmethodology, the devices are always prestagedwith

latest configuration when you attempt to configure services on them.

The device prestaging workflow in Services Activation Director is slightly redundant and

also error-prone. An additional step of prestaging the devices before a service can be

configured on them is also not transparent and beneficial. As a result of this redundant

implementation, the service configuration on a particular device is impacted. The service

capabilities discovered for a service can be erroneous, owing to anomalies with device

prestaging. Additionally, the process of confirming a role discovered by the prestaging

workflow is regarded as an unnecessary step and is discarded in the redesigned and

optimized workflow. In Services Activation Director, the changes that affect the service

capability of thedevicearenotautomatically discovered. InConnectivityServicesDirector,

the devices are always prestaged services are configured on them to enable the latest

configuration tobesynchronizedbetweenthedeviceandtheapplication.Auto-discovering

thedevices, basedonchangesoccurringon thedeviceand JunosSpacePlatform ishighly

efficient and user-friendly.

Auto-Discovery and Auto Prestaging of Devices

The process of automatically synchronizing device configuration and service capability

discovery, based on the configuration setting changesmade on the device and using the

Junos Space Platform software application, is called device automatic prestaging. The

auto prestagingmechanism is triggered based on events occurring on the device and the

Junos Space Platform software. Certain events that occur on the devices are identified
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as conditions for triggering the auto prestaging workflow. The following are some of the

events that impact the capability of the device to enable Network Services to function:

• Device addition and deletion using the Junos Space Platform GUI

• Interface status alternating between up and down

• Loopback address change

• Interface addition and deletion

• Service type-related configuration (in scenarios when additional configuration such

as BGP or LDP changes aremade, which updates the service capability (L2, L3) of the

device)

• Management IP address or hostname change

• Changes to the interface family

• Changes in the interface encapulation type

Parallel Prestaging Jobs

Because auto prestaging is an automated process triggered by the change events from

the device and platform, there can bemultiple parallel prestaging jobs from a single

device and frommultiple devices. These jobs updates the corresponding device

information on completion. Service creation and deployment is not impacted by the

prestaging jobs and picks up the available configuration at the given point of time. In the

older version of Services Activation Director, only one prestaging job can run at any point

of time, which is valid with onlymanual prestaging because the prestaging job scans the

whole device inventory and prestages devicewhich are not already been assigned a role.

Havingasecond job run inparallel doesnot result in anyadvantage.With the introduction

of auto device prestaging feature, the scenario is different because auto-prestaging is

mostly per-device, and therefore, it is essential to have parallel prestaging jobs running

for different devices.

Auto Prestaging JobsWhen aManual Prestaging Job is Running

Manual prestaging process prestages the entire device inventory and auto assign device

roles to them.Therefore, havingaper-deviceautoprestaging job running inparallelmight

be redundant for the functionality because the concerned device could most likely be

taken care by the manual prestaging job. However, possibilities arise in which the

concerned device is prestaged before the new event and the latest configuration is not

synced. To avoid such race condition, the auto prestaging job has to run after themanual

job completes. For this sequencing of the types of prestaging jobs, auto prestaging event

request is stored in a memory queue against a particular device ID and is run by the

scheduler after the manual prestaging job completes.

Manual Prestaging JobsWhen an Auto Prestaging Job is Running.

Manual prestaging jobs are queued if there are auto prestaging jobs currently running.

Themanual prestaging job for a particular device is discarded if an auto prestaging job

is already in progress.
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Multiple Auto Prestaging Jobs for a Device

In cases where there are multiple events generated for a single device the event are

queued for execution, a validation is performed to determine if there are current jobs in

execution for the particular device and queue the request in which case. There can only

be one prestaging request per device in queue at any point in time.

Multiple Auto Prestaging Jobs for a Device

In this case, all the prestaging jobs has to run in parallel.With Services ActivationDirector

(onlymanual re-sync), theprestagingdata in overwrittenwhenanewprestage jobs runs,

until the role is assigned. However, with the latest changes, the role assignment happens

as part of manual or auto prestaging, and enhancements are made to support parallel

processing.

ScenariosWith a Clustered Environment

Therearepossibilitiesof raceconditions inaclustered JunosSpaceapplianceenvironment

where there can be parallel prestaging jobs queued up for the same type of devices as

the jobsbecause thequeuecontext is local toeach instance in thecluster. Thesescenarios

are prevented by using a cluster-level context for the queues is present.

Types of Prestaging

Because of scenarios where the manual and auto prestaging has to be identified

specifically, the support for distinguishing both the types needs to be added. Instead of

the handling of the auto prestaging andmanual prestaging jobs by a single job API in

which the jobdatadoes not contain any information regarding thenature of the jobbeing

manual or autoprestaging, the distinction is achievedby comparing thedevice ID against

null from the database job data and by running two separate jobs, one for manual

prestaging and the other for auto prestaging.

Prestaging takes the devices already under Junos Spacemanagement and prepares

them for service activation. The prestaging process discovers network provider edge

(N-PE) devices in the Junos Space database and assigns roles to those devices and their

interfaces. In Connectivity Services Director, device discovery and prestaging done

automatically whenever a device is added or updated.

Related
Documentation

Prestaging Devices Process Overview on page 342•

• Prerequisites for Prestaging Devices in Connectivity Services Director on page 348
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Prerequisites for Prestaging Devices in Connectivity Services Director

Before you can perform prestaging on your network devices, each device must meet

specificconfiguration requirements,andmustbebroughtunder JunosSpacemanagement

through device discovery.

The following configuration requirementsmust bemet before beginning the provisioning

process. Otherwise, service deployment fails:

• MPLSmust run on each N-PE device and on each P device.

• LDP signalingmust be established betweenN-PE devices that participate in the same

E-Line (LDP) service.

• MPBGPmust run on eachN-PEdevice that participates in a Layer 2multipoint or Layer

3 full mesh service.

• To runLayer 2, Layer 3, or E-LANservicesonanN-PEdevice, ensure thatanautonomous

system (AS) number is configured on the device.

Before you can prestage devices, youmust performdevice discovery to import all Juniper

Networks devices on your network that Junos Space canmanage. The Connectivity

Services Director prestaging workspace works on devices that have already been

discoveredand imported into the JunosSpacedatabase, buthavenot yetbeenprestaged.

TheE-LANserviceneeds tobeenabled inanetworkdevice, tomake thestaticpseudowire

functionality active in the device. You can activate the static pseudowire functionality

by configuring the network device through the CLI window. You need to enter the CLI

configuration mode of a network element and run the command

set protocols vpls static-vpls no-tunnel-services

commit

If the device is not configured through CLI, awarningmessage appears in the application

server log, that is the JBOSS Log:

<Device name> should be configuredwith static VPLS no tunnel service rule.

To discover the roles of the various network elements configured:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices.

4. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayedwith the job ID of the discovery job that

is created to obtain the latest roles of the devices.
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To remove the role of the network elements configured:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

5. ClickManageDeviceRolesand fromthedrop-down list, selectUnassignRole to remove

the role capability of a network element. You are prompted to confirm the operation. If

you clickOK, a request is submitted to remove the latest role of the network element or

device.

The device is removed from the list of network elements displayed on the Devices Chart

page.

To resynchronize the role of the network elements configured:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

5. ClickManageDevice Roles and from the drop-down list, select Re-sync Role Capability

resynchronize the role capability of a network element. You are prompted to confirm the

operation. If you clickOK, request is submitted to retrieve the latest role of the network

element or device.

The role is re-synced with the same device now.

Related
Documentation

PrestagingWorkflow in Connectivity Services Director on page 345•

• Prestaging Devices Process Overview on page 342

Discovering and Assigning All N-PE Devices

Prestagingall Connectivity ServicesDirector assignment recommendations is apowerful

yet simple way to prepare your devices for provisioning. This procedure provides the

prestaging steps that accept all system recommendations. To prestage devices and

make exceptions to the system recommendations, see “Discovering and Assigning N-PE

Devices with Exceptions” on page 351.

Before discovering and assigning N-PE devices, youmust have already run device

discovery. See the “Discovering Devices” section in the Junos Space Network Application

Platform User Guide.
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Prestaging has two parts:

1. Discovering Device Roles on page 350

2. Assigning Device Roles on page 350

Discovering Device Roles

To discover the roles of devices found during element discovery:

To discover the roles of the various network elements configured:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices.

4. View the values displayed under the Roles column of the discovered devices.

5. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayedwith the job ID of the discovery job that

is created to obtain the latest roles of the devices.

NOTE: You cannot discover a device as a PE device if no user-to-network
interfaces (UNIs) are available in the device.

The Connectivity Services Director application throws the following error
message:

2012-06-08 10:17:23,446 ERROR [PreStageDeviceManagerBean]
(PreStageDeviceManagerBean#savePreStageDeviceList Thread-6894
(group:HornetQ-client-global-threads-1332782448):) No ge/fe/at/t1
interfaces in thisPEdevice: junos-mx480-space; it canonlybeused for virtual
routers

Assigning Device Roles

If you need to exclude devices from role assignment, or you need to exclude interfaces

from the list of interfaces that can be used as UNIs, use the procedures documented in

“Discovering and Assigning N-PE Devices with Exceptions” on page 351.

To discover the roles of the various network elements configured:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.
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3. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices.

4. View the values displayed under the Roles column of the discovered devices.

5. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayedwith the job ID of the discovery job that

is created to obtain the latest roles of the devices.

The JobManagement page shows the progress and status of the role assignment job.

See Viewing Jobs in the Junos Space Network Application Platform User Guide for details.

While the job is ongoing, you cannotmake additional assignments from theAssignRoles

page. The Assign NPE Role action is dimmed to indicate you cannot select it.

Related
Documentation

Prestaging Devices Process Overview on page 342•

• Prerequisites for Prestaging Devices in Connectivity Services Director on page 348

• Discovering and Assigning N-PE Devices with Exceptions on page 351

• Prestaging ATM and TDM Pseudowire Devices on page 354

• Prestaging Rules on page 362

Discovering and Assigning N-PE Devices with Exceptions

Preparing network devices for service activation is usually a simple processwhich directs

the Connectivity Services Director application to prepare your devices automatically.

When you prestage devices, the Connectivity Services Director application scans the

database for devices that have already been discovered but have noMPLS role assigned,

and recommends a role for each device it finds, based on the device configuration data

anda set of predefined rules. Youcan thendisplay thosedevices and their recommended

settings for:

• MPLS role for the device (PE only)

• Loopback interface

• UNI interfaces

The Connectivity Services Director application allows you to exclude specific

recommendeddevices frombeing assigned theN-PE role and to exclude interfaces from

use as UNIs during service provisioning. You can also change the loopback address of a

PE device..

For step-by-step instructions on how to prepare devices for network activation using all

the recommendations forN-PE roleassignmentandUNIassignment that theConnectivity

Services Director application makes, see “Discovering and Assigning All N-PE Devices”

on page 349. These topics describe how to prestage devices with exceptions:

• Including Interfaces in UNI Role Assignments on page 352

• Committing Your Prestaging Choices on page 352
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Including Interfaces in UNI Role Assignments

To include interfaces from the list of interfaces that the prestaging rules determinedwere

suitable for use as UNIs:

1. In the address bar of your browser window, enter: https://<1.1.1.1>/mainui/ where

<1.1.1.1> is theWeb IP address for Web access to the Services Activation Director GUI.

Alternatively, from the Connectivity Services Director GUI, click the Junos Space icon

in the Connectivity Services Director banner. The Junos Space Network Management

Platform page is displayed.

2. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices >Manage Device Roles.

The results of themost recent role discovery operation appear, including any changes

you have subsequently made to your prestaging data.

Repeat Step 2 through Step 7 for each device for which you want to include some

recommended UNI selections:

3. In the Devices Chart page, select the device for which you want to manage UNIs.

4. Select a device and clickManage Interface Roles.

TheManage Interface Roleswindow shows all the device interfaces for the selected

device and indicates those that the Connectivity Services Director application

recommends for use as UNIs.

5. In theManage Interface Roleswindow, select the check box under the UNI column

that you want to assign to the device.

To assign more than one UNI, use the multiple selection capability.

6. ClickOK to submit the selection and return to the Devices Chart page.

See Also Excluding Devices from N-PE Role Assignment on page 373•

Committing Your Prestaging Choices

This procedure provides instructions for assigning the N-PE role to selected devices and

committing all device prestaging information to the database.

Before performing these steps, youmust complete the following tasks:

• Discover devices that have not yet been assigned an MPLS role.

• Exclude fromthe listofdiscovereddevices thosedevices that youdonotwant toassign

the N-PE role to.

• On each device, exclude the interfaces you do not want used as UNIs.
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To commit your prestaging choices to the database:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices>Manage

Device Roles > Assign Roles.

4. Examine the list of devices to be sure these are the devices you want to assign the

N-PE role.

5. Select all devices.

6. ClickManage Device Roles and select Discover Roles. A job is submitted to obtain the

roles of the devices.

7. To view the assignment status, in the Job Management screen, click the job ID of the

assignment job.

The JobManagement page shows the progress and status of the role assignment job.

NOTE: Alternatively, todisplay the JobManagementpage, click theSystem

icon on theConnectivity Services Director banner, and selectManage Jobs

from the Tasks pane. You can also view the CSD Deployment Jobs page
in Deploymode of Service View by selecting the View Deployment Jobs

option in the task pane.

While the job is ongoing, you cannot make additional assignments from the Assign

Roles page. The Assign NPE Role action is dimmed to indicate you cannot select it.

NOTE: If youmodify the configuration of a device after the device is
prestaged, remove the device from prestaged status and then Discover
Roles and prestage the device again.

Related
Documentation

Prestaging Devices Process Overview on page 342•

• Prerequisites for Prestaging Devices in Connectivity Services Director on page 348

• Discovering and Assigning All N-PE Devices on page 349

• Prestaging ATM and TDM Pseudowire Devices on page 354

• Prestaging Rules on page 362
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Prestaging ATM and TDMPseudowire Devices

Junos Space supports ATM and TDM pseudowires in IP/MPLS networks on M Series

Multiservice Edge Routers with Circuit Emulation Service (CES) Physical Interface Cards

(PICs). The ATM and TDM pseudowires run over an LSP connection.

Static pseudowires are designed for networks that do not support LDP or do not have

LDP enabled. You define pseudowires by configuring static values for the inbound and

outbound labels of the connection. For details on configuring pseudowire connections

in Junos OS, see the Junos OS VPNs Configuration Guide, the Layer 2 VPN Configuration

Example, and Configuring Layer 2 Circuit and Layer 2 VPN Pseudowires.

Prerequisites for M Series Routers

One of the following CES PICs is required:

• 4-Port ChOC3/STM1 CES PIC

• 12-Port T1/E1 CES PIC

Prerequisites for the BX Series Gateway

The BX Series devices have a fixed configuration with 3 Gigabit Ethernet (GE) interfaces

and 16 T1/E1 ports that can be used by ATM/TDM pseudowire services. The correct level

of firmware is required. Refer to the release notes that correspond to the release of Junos

Space that you are running for the correct level information.

RFCs Supported

RFC 4553, Structure-Agnostic Time Division Multiplexing (TDM) over Packet (SAToP)

Before discovering and assigning N-PE devices, youmust have already have run device

discovery. See the “Discovering Devices” section in the Junos Space Network Application

Platform User Guide.

Whenyou run thediscoveryprocess forATMandTDMdevices, theyneed tobediscovered

as N-PE devices. In addition, the BX Series devices require an additional device role

defined as a cell site router (CSR). This figure shows the discovered devices.
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After you discover the devices, use Connectivity Services Director Prestaging feature to

bring the PE and CSR devices into Network Services together with their UNI interfaces.

In theNetworkServices>Connectivity taskpane, selectPrestageDevices>ManageDevice

Roles.

Double-click a listed device. In this example; you can see that an MPLS role and an

additional device role as a CSR are assigned.
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Double-click another listed device. In this example, the details window shows the

channelized ATM and T1 interfaces.
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Related
Documentation

Prestaging Devices Process Overview on page 342•

• Prerequisites for Prestaging Devices in Connectivity Services Director on page 348

• Discovering and Assigning All N-PE Devices on page 349

• Discovering and Assigning N-PE Devices with Exceptions on page 351

• Prestaging ATM and TDM Pseudowire Devices on page 354

Discovering and Assigning Provider Role or LSP Role for Devices with Exceptions

Preparing network devices for service activation is usually a simple processwhich directs

the Connectivity Services Director application to prepare your devices automatically.

When you prestage devices, the Connectivity Services Director application scans the

database for devices that have already been discovered but have noMPLS role assigned,

and recommends a role for each device it finds, based on the device configuration data

anda set of predefined rules. Youcan thendisplay thosedevices and their recommended

settings for:
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• MPLS role for the device (PE only)

• Loopback interface

• UNI interfaces

The Connectivity Services Director application allows you to exclude specific

recommended devices from being assigned the P or LSP role and to exclude interfaces

from use as UNIs during service provisioning. You can also change the loopback address

of an LSP device..

For step-by-step instructions on how to prepare devices for network activation using all

the recommendations for P or LSP role assignment and UNI assignment that the

Connectivity Services Director application makes, see “Discovering and Assigning All

N-PEDevices”onpage349.Thesetopicsdescribehowtoprestagedeviceswithexceptions:

• Including Interfaces in UNI Role Assignments on page 358

• Committing Your Prestaging Choices on page 359

Including Interfaces in UNI Role Assignments

To include interfaces from the list of interfaces that the prestaging rules determinedwere

suitable for use as UNIs:

1. In the address bar of your browser window, enter: https://<1.1.1.1>/mainui/ where

<1.1.1.1> is theWeb IP address for Web access to the Services Activation Director GUI.

Alternatively, from the Connectivity Services Director GUI, click the Junos Space icon

in the Connectivity Services Director banner. The Junos Space Network Management

Platform page is displayed.

2. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices >Manage Device Roles.

The results of themost recent role discovery operation appear, including any changes

you have subsequently made to your prestaging data.

Repeat Step 2 through Step 7 for each device for which you want to include some

recommended UNI selections:

3. Select a device and clickManage Interface Roles.

TheManage Interface Roleswindow shows all the device interfaces for the selected

device and indicates those that the Connectivity Services Director application

recommends for use as UNIs.

4. In theManage Interface Roleswindow, select the check box under the UNI column

that you want to assign to the device.

To assign more than one UNI, use the multiple selection capability.

5. ClickOK to submit the selection and return to the Devices Chart page.
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See Also Excluding Devices from N-PE Role Assignment on page 373•

Committing Your Prestaging Choices

This procedure provides instructions for assigning the P or LSP role to selected devices

and committing all device prestaging information to the database.

Before performing these steps, youmust complete the following tasks:

• Discover devices that have not yet been assigned an MPLS role.

• Exclude fromthe listofdiscovereddevices thosedevices that youdonotwant toassign

the P or LSP role to.

• On each device, exclude the interfaces you do not want used as UNIs.

To commit your prestaging choices to the database:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices>Manage

Device Roles > Assign Roles.

4. Examine the list of devices to be sure these are the devices you want to assign the P

or LSP role.

5. Select all devices.

6. ClickManage Device Roles and select Discover Roles. A job is submitted to obtain the

roles of the devices.

7. To view the assignment status, in the Job Management screen, click the job ID of the

assignment job.

The JobManagement page shows the progress and status of the role assignment job.

NOTE: Alternatively, todisplay the JobManagementpage, click theSystem

icon on theConnectivity Services Director banner, and selectManage Jobs

from the Tasks pane. You can also view the CSD Deployment Jobs page
in Deploymode of Service View by selecting the View Deployment Jobs

option in the task pane.

While the job is ongoing, you cannot make additional assignments from the Assign

Roles page. The Assign NPE Role action is dimmed to indicate you cannot select it.
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NOTE: If youmodify the configuration of a device after the device is
prestaged, remove the device from prestaged status and then Discover
Roles and prestage the device again.

Related
Documentation

Prestaging Devices Process Overview on page 342•

• Prerequisites for Prestaging Devices in Connectivity Services Director on page 348

• Discovering and Assigning All N-PE Devices on page 349

• Prestaging ATM and TDM Pseudowire Devices on page 354

• Prestaging Rules on page 362

Discovering and Assigning All Provider or LSP Devices

Prestagingall Connectivity ServicesDirector assignment recommendations is apowerful

yet simple way to prepare your tunneling or label-switched path (LSP) devices for

provisioning. This procedure provides the prestaging steps that accept all system

recommendations. To prestage LSP or tunneling devices andmake exceptions to the

system recommendations, see “Discovering and Assigning Provider Role or LSP Role for

Devices with Exceptions” on page 357.

Before discovering and assigning provider (P) or LSP devices, youmust have already run

device discovery. See the “Discovering Devices” section in the Junos Space Network

Application Platform User Guide.

Prestaging has two parts:

1. Discovering LSP Device Roles on page 360

2. Assigning Provider Device Roles on page 361

Discovering LSP Device Roles

To discover the roles of LSP devices found during element discovery:

To discover the roles of the various network elements configured:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices.

4. View the values displayed under the Roles column of the discovered devices.
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5.ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayedwith the job ID of the discovery job that

is created to obtain the latest roles of the devices.

NOTE: You cannot discover a device as a PE device if no user-to-network
interfaces (UNIs) are available in the device.

The Connectivity Services Director application throws the following error
message:

2012-06-08 10:17:23,446 ERROR [PreStageDeviceManagerBean]
(PreStageDeviceManagerBean#savePreStageDeviceList Thread-6894
(group:HornetQ-client-global-threads-1332782448):) No ge/fe/at/t1
interfaces in thisPEdevice: junos-mx480-space; it canonlybeused for virtual
routers

Assigning Provider Device Roles

If you need to exclude devices from role assignment, or you need to exclude interfaces

from the list of interfaces that can be used as UNIs, use the procedures documented in

“Discovering and Assigning Provider Role or LSP Role for Devices with Exceptions” on

page 357.

To discover the roles of the various network elements configured:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in this mode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices.

4. View the values displayed under the Roles column of the discovered devices.

5. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayedwith the job ID of the discovery job that

is created to obtain the latest roles of the devices.

The JobManagement page shows the progress and status of the role assignment job.

See Viewing Jobs in the Junos Space Network Application Platform User Guide for details.

NOTE: Alternatively, to display the JobManagement page, click the System

icon on the Connectivity Services Director banner, and selectManage Jobs

from the Tasks pane. You can also view the CSD Deployment Jobs page in
Deploymode of Service View by selecting the View Deployment Jobs option

in the task pane.
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While the job is ongoing, you cannotmake additional assignments from theAssignRoles

page. The Assign LSP Role action is dimmed to indicate you cannot select it.

Related
Documentation

Prestaging Devices Process Overview on page 342•

• Prerequisites for Prestaging Devices in Connectivity Services Director on page 348

• Discovering and Assigning N-PE Devices with Exceptions on page 351

• Prestaging ATM and TDM Pseudowire Devices on page 354

• Prestaging Rules on page 362

Prestaging Rules

Prestaging rules are predefined. These rules contain criteria for classifying theMPLS role

of each device, in addition to recommending which physical interfaces should be UNI

interfaces. For each recommended UNI interface, the system recommends its primary

loopback address and its VLAN pool profile.

Correctly assigning MPLS roles to devices is critical for provisioning the correct MPLS

behavior. Each MPLS role has a different behavior. For example, N-PE is the only role

allowed to terminate MPLS sessions..

The rules used by the Junos Space software to determine the recommended role

assignment are described for devices, UNIs, and VLAN pool profiles in the following

sections:

N-PE Device Classification Rules

The system recommends the N-PE role for devices that satisfy the following criteria:

• The comment field in the device configuration identifies the device as an N-PE device.

• The device role is set to N-PE unless EBGP is enabled for the device. Specifically, the

device role is set to N-PE unless the device configuration has

configuration/protocols/bgp/group/type set to external. IF EBGP is enabled, the device

role is set to P.

• The device is assigned a loopback address. A device that has no loopback address

cannot function as an N-PE device.

• LDP is enabled on the loopback interface for the device. LDPmust be enabled on the

loopback interface if the device is to be a assigned the PEMPLS role. (Required E-Line

services).

• L2 VPN signaling for BGP is enabled. Specifically, the rule checks whether the device

configuration has configuration/protocols/bgp/family/l2vpn/signaling or

configuration/protocols/bgp/group/l2vpn/signaling set. (Required for Layer 2 Ethernet

services.)

• inet-vpn unicast for BGP is enabled. Specifically, the rule checks whether the device

configuration has configuration/protocols/bgp/family/inet-vpn/unicast set. (Required

for IP services.)
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UNI Classification Rules

Before an interface on an N-PE device can be provisioned as a UNI, it must satisfy the

following criteria:

• The interface must be Gigabit Ethernet (ge), 10-Gigabit Ethernet (xe), Aggregated

Ethernet (ae), or Fast Ethernet (fe) type.

Fast Ethernet (fe) interfaces are supported for the Ethernet service configurations (on

M Series devices with Junos OS Release 10.2R1.6).

• Checks forGigabitEthernet (ge) interfaceswithinanAggregatedEthernet (ae) interface.

ExcludesGigabitEthernet interfaces thatareconfiguredwithinanAggregatedEthernet

interface from UNI assignment.

• Checks for bridge family on logical interfaces. Excludes interfaces fromUNIassignment

if interface configuration on the device has /interface/unit/family/bridge set.

• Checks for the following configurations on a device interface. An interface is excluded

from UNI assignment when all of the following configurations are present and the

logical interface is Unit 0:

• An IP address is defined on the physical interface. The interface configuration on the

device has interface/unit/name/../family/inet/address/name set. For example:

interfaces {    
 ge-0/1/0 {
    unit 0 {
   family inet {
    address 10.10.30.52;
   } 
   }
 }
}

• MPLS is enabled on the physical port. The interface configuration on the device has

interface/unit/name/../family/mpls set. For example:

interfaces {    
 ge-0/1/0 {
  unit 0 {
   family mpls;
   }
 }
}

• OSPF is running on the logical interface. The interface configuration on the device

has configuration/protocols/ospf/area/interface set. For example:

interfaces {    
 ge-5/0/0 {
    unit 0 {
   family inet {
    address 10.10.34/30;
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     } 
    family mpls;
     }
   }
 }
protocols {
 ospf {
  traffic-engineering;
   area 0.0.0.0. {
    interface ge-5/0/0.0;
   }
  }
 }

• MPLS is running on the physical interface. The interface configuration on the device

has configuration/protocols/mpls/interface set. For example:

interfaces {    
 ge-5/0/0 {
    unit 0 {
   family inet {
    address 10.10.34/30;
   } 
   family mpls;
   }
  }
 }
protocols {
 mpls {
  interface ge-5/0/0.0;
  }
 }

VLAN Pool Profile Classification Rules

The Junos Space software assigns VLAN pool ranges to the UNIs, depending on the

configured encapsulation.

Auto Discovery Only

The Junos Space software enables the router to process only the autodiscovery network

layer reachability information (NLRI) update messages for LDP-based VPLS update

messages.

Related
Documentation

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376
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• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379
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CHAPTER 20

Prestaging: Managing Devices andDevice
Roles

• Discovering Tunnel Devices on page 367

• Adding a UNI on page 369

• Unassigning Device Roles on page 370

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376

• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379

• Managing Prestage Device Jobs on page 381

• Specifying theWait and Idle Times for Prestaging Devices on page 382

Discovering Tunnel Devices

When you start Connectivity ServicesDirector for the first time, the systemdoes not have

any devices. The first step is to build your network. Evenwith large networks, Connectivity

Services Director has made this step relatively easy and straightforward. You will add

devices to Connectivity Services Director and the database by using a process called

device discovery. Once a device is discovered, it shows in the interface and Connectivity

Services Director begins to monitor the device.

Connectivity Services Director provides a wizard for device discovery. The following

example shows the path for device discovery through the wizard. For an alternate path,

you can get a step-by-step instruction from the help system.
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Before you discover tunneling devices:

• Ensure that the devices that you want to discover are configured for MPLS with the

required interface in the Junos OS configuration hierarchy [edit protocols mpls]. See

the Junos Software MPLS Configuration Guide.

In this example, we provide an IP address range, and Connectivity Services Director

populates the database with all supported devices within that range.

1. While in the Buildmode, select Device View or CustomGroup View from the View

selector.

2. To discover physical devices, click Discover Devices in the Tasks pane. Eachmode has

a Tasks Pane that displays the actions you can take while in that mode and that

particular network view.

3. (Optional) Type a name for the discovery job. The default name is ND Discovery.

4. Click Add in the Device Targets window. You can add a single device IP address, a

range of IP addresses, an IP subnet, or a hostname. In this example, we select an IP

address range.

5. Provide the initial or the lowest IP address value and the ending or highest IP address

value for the range and click Add. You can have up to 1024 devices in a range. After

you click Add, the address range is listed in the Device Targets window.

6. Click Next or click Discovery Options to proceed to specify the device credentials and

method of discovery.

7. Click Add in the Device Credentials window and enter the username and password

assigned for administrative access.

8. Select Ping , SNMP, or both as the method of device discovery. Selecting both is the

preferred method if the device is configured for SNMP.

If you select SNMP, the Add SNMP Settings dialog box is displayed. In this example,

because we run SNMP version 2, we need to provide the community string. Click Add

to save the setting.

NOTE: You cannot choose amethod for device discovery for virtual
network discovery.

9. ClickNext or ScheduleOptions to proceed to schedule the timewhen discovery is run.
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NOTE: Scheduling options are not available for virtual network discovery.

10. Indicate whether to run the device discovery now or set up a schedule to minimize

network traffic. In this example, we set the schedule to run during off hours.

11. Click Review to review the settings before you exit the wizard.

12. Click Finish to complete the discovery setup and to save the settings.

13. Click View Discovery Status to view all scheduled and completed jobs. After a job

completes, you can click ShowDetails to view further information on any unexpected

results.

Related
Documentation

Viewing LSP Service Orders in a Table on page 1661•

• Deactivating an LSP Service on page 1662

• Reactivating an LSP Service on page 1664

Adding a UNI

To add a UNI to the list of UNIs that can be assigned to a service on a specific device:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

4. In the Devices Chartwindow, select the device on which you want to add an interface

to the list of potential UNIs.

5. ClickManage Interface Roles to assign UNI interfaces to the specified device.

6. TheManage Interface Roleswindow appears, displaying all interfaces on the device

that have not been assigned.
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7. Select the check box under the UNI column to specify the interface youwant tomake

available for assignment as a UNI. To select multiple interfaces, use the multiple

selection feature.

8. ClickOK to submit the configuration changes. You are returned to the Devices Chart

page.

Related
Documentation

Unassigning Device Roles on page 370•

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376

• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379

Unassigning Device Roles

If you need to exclude devices from role assignment, or you need to exclude interfaces

from the list of interfaces that can be used as UNIs, use the procedures documented in

“Discovering and Assigning N-PE Devices with Exceptions” on page 351.

To unassign all discovered roles and interfaces:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

4. In the Devices Chartwindow, select the device on which you want to add an interface

to the list of potential UNIs.

5. ClickManageDeviceRolesand fromthedrop-down list, selectUnassignRole to remove

the role capability of a network element. You are prompted to confirm the operation.

If you clickOK, a request is submitted to remove the latest role of the network element

or device.
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The device is removed from the list of network elements displayed on the Devices

Chart page.

6. To view the assignment status, in the JobManagementwindow from the Junos Space

Platform UI, click the job ID of the assignment job.

NOTE: Alternatively, todisplay the JobManagementpage, click theSystem

icon on theConnectivity Services Director banner, and selectManage Jobs

from the Tasks pane. You can also view the CSD Deployment Jobs page
in Deploymode of Service View by selecting the View Deployment Jobs

option in the task pane.

Related
Documentation

Adding a UNI on page 369•

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376

• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379

Deleting UNIs

After performing the initial assignment of N-PE devices and UNIs, you can still exclude

additional interfaces from the list of UNIs so long as those UNIs are not assigned to

services.

To remove an interface from consideration as a UNI:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

4. In the Devices Chartwindow, select the device on which you want to add an interface

to the list of potential UNIs.
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5. ClickManage Interface Roles.

TheManage Interface Roleswindow appears, showing all interfaces assigned the UNI

role.

6. Select the interface you no longer want to have the UNI role. To unassign multiple

interfaces, use the multiple selection feature.

NOTE: The UNI role is assigned to an interface by a notification from the
managed device that is sent to the Connectivity Services Director
application, evenwhen you unassign theUNI role from the interface using
the Prestage Devices workspace. For example, if you unassign the UNI
role on an interface of amanaged device, that interface is available for
provisioning services on devices, when you attempt to create a service
order. For the same interface, if you configure encapsulation on it directly
from the device and navigate to thePrestagingworkspace in Connectivity
Services Director after a fewminutes, the interface status indicates that
UNI role is configured on it. This behavior occurs because the UNI role is
assigned to the interface by a device notification.

7. ClickOK to submit the selection. You are returned to the Devices Chart page.

Related
Documentation

Adding a UNI on page 369•

• Unassigning Device Roles on page 370

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376

• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379

Discovering Device Roles

To discover the roles of devices found during element discovery:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.
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3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

4. In the Devices Chartwindow, select the device on which you want to add an interface

to the list of potential UNIs.

5. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRole to retrieve

the role capability of a network element. A job is created to obtain the latest role of

the network element or device.

Device role discovery is now complete. To assign device and interface roles, follow the

steps in the next section, “Discovering and Assigning All N-PE Devices” on page 349.

Related
Documentation

Adding a UNI on page 369•

• Unassigning Device Roles on page 370

• Deleting UNIs on page 371

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376

• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379

Excluding Devices fromN-PE Role Assignment

The rules-driven process that the Connectivity Services Director application uses to

discover device roles recommends the correct roles in most cases. To exclude a device

from N-PE role assignment:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.
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4. In the Devices Chartwindow, select the device on which you want to add an interface

to the list of potential UNIs.

5. ClickManageDeviceRolesand fromthedrop-down list, selectUnassignRole to remove

the role capability of a network element. You are prompted to confirm the operation.

If you clickOK, a request is submitted to remove the latest role of the network element

or device.

The device is removed from the list of network elements displayed on the Device

Statistics page.

Related
Documentation

Adding a UNI on page 369•

• Unassigning Device Roles on page 370

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376

• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379

Excluding Interfaces fromUNI Role Assignments

To exclude interfaces from the list of interfaces that the prestaging rules determined

were suitable for use as UNIs:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

4. In the Devices Chartwindow, select the device on which you want to add an interface

to the list of potential UNIs.

5. ClickManage Interface Roles.

TheManage Interface Roleswindow appears, showing all interfaces assigned the UNI

role.
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6. Deselect the check box under the UNI Role column for the interface you no longer

want to have the UNI role. To unassign multiple interfaces, use the multiple selection

feature.

7. ClickOK to submit the selection. You are returned to the Device Statistics page.

Related
Documentation

Adding a UNI on page 369•

• Unassigning Device Roles on page 370

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376

• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379

Unassigning N-PE Devices

To unassign an N-PE device so that it can no longer be assigned to a service:

NOTE: Before you an unassign an N-PE device, it must not be assigned to
any deployed service.

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

4. In the Devices Chartwindow, select the device on which you want to add an interface

to the list of potential UNIs.

5. ClickManageDeviceRolesand fromthedrop-down list, selectUnassignRole to remove

the role capability of a network element. You are prompted to confirm the operation.

If you clickOK, a request is submitted to remove the latest role of the network element

or device.
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The device is removed from the list of network elements displayed on the Devices

Chart page.

Related
Documentation

Adding a UNI on page 369•

• Unassigning Device Roles on page 370

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Viewing N-PE Devices on page 376

• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379

Viewing N-PE Devices

You can view network devices that have been assigned theN-PE role or provider (P) role.

The following topic provides a procedure for viewing N-PE devices:

• Viewing N-PE Devices in a Table on page 376

Viewing N-PE Devices in a Table

To view N-PE devices in a table:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

The Devices Chart page displays the following information about all N-PE devices on

your network:

• Name—The assigned device name.

• Roles—The role assigned to the device.

Copyright © 2019, Juniper Networks, Inc.376

Connectivity Services Director User Guide



• Management address—The IP address to which the Junos Space fabric connects

to the device.

• Loopback address—The IP address type used by a device to send a packet to itself.

4. To viewmore device details and UNI information, double-click the table row for the

device. Alternatively, select a service, and click Device Details at the top of the table.

The NPE Detailswindow appears. The detailed view lists all UNIs discovered on the

device with the applied VLAN pool profile and includes the following device

information:

• Name—The name assigned to the device

• Version—Operating system firmware version running on the device. For example,

13.1X49D29.1.

• Platform—Devicemodel number or the platform type of the discovered device. For

example, MX480. •

• Loopback address—The IP address type used by a device to send a packet to itself.

• Connection status—up or down.

• Service capability—N-PE device role: L2 or L3.

The following tabs are displayed:

• UNI—All assigned user-to-network interfaces (UNIs) on the devicewith the applied

VLAN pool profile. “0” in the Encapsulation field means that no encapsulation has

been applied and the UNI is available for allocation.

• NNI—All the assigned network-to-network interfaces (NNIs) on the device. Also,

the encapsulation typesdefined for the NNI interfaces are shown.

• Admin Groups—Names of the administrative groups configured for the interfaces

on the device. Administrative groups, also known as link coloring or resource class,

are manually assigned attributes that describe the “color” of links, such that links

with the same color conceptually belong to the same class. You can use

administrative groups to implement a variety of policy-based LSP setups.

Administrativegroupsaremeaningfulonlywhenconstrained-pathLSPcomputation

is enabled.

• Path—The path name, IP address, and type are shown.

Related
Documentation

Adding a UNI on page 369•

• Unassigning Device Roles on page 370

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375
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• Viewing Prestaging Statistics on page 378

• Viewing Prestaging Rules on page 379

Viewing Prestaging Statistics

The landing page for the Prestage Devices workspace contains charts and graphs that

provide information about available capacity on discovered N-PE devices. You can

determine which devices have UNIs available, or which devices have plenty of available

capacity for routing services.

The following topicsdescribeviewingstatistics in thePrestageDevicesworkspace landing

page:

• Viewing the Prestaged Device Details on page 378

• Viewing Services for Devices and Device Roles in a Graphical Form on page 379

Viewing the Prestaged Device Details

To view the details of the prestaged devices:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

The Prestage Devices page in the lower part of the right pane displays the following

information about all N-PE devices on your network:

• Name—The assigned device name.

• Roles—The role assigned to the device.

• Service Capability—Indicates whether the device is capable of supporting Layer 2,

Layer 3, or MPLS services.

• Management address—The IP address to which the Junos Space fabric connects

to the device.

• Loopback address—The IP address type used by a device to send a packet to itself.

4. Enter a criterion in the Search box and press Enter to sort and filter the devices that

match the search condition.
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Viewing Services for Devices and Device Roles in a Graphical Form

To view the number of services provisioned on each N-PE device and the number of

devices with different roles in your network:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Devices.

The Device Statistics page in the upper part of the right pane displays two pie charts.

One of the pie charts represents the different types of services configured on devices

in your network. You can remove or restore a category (segment) from the pie chart

by clicking that segment in the chart. A color-code is used to denote different portions

of the pie chart for the service types. Mouse over each portion of the pie to view the

number of services corresponding to the percentage of each service type. The

color-coding legends reference the service types, such as E-LINE Martini, E-LINE

Kompella, IP, E-LAN, and E-Line services.

Theother pie chart displays the rolesof devices, suchasnetworkprovider edge (N-PE)

and provider (P) roles. A color-code is used to denote different portions of the pie

chart for the device roles. Mouse over each portion of the pie to view the number of

devices corresponding to thepercentageof eachdevice role. Thecolor-coding legends

reference the device roles, such as N-PE or P.

Related
Documentation

Adding a UNI on page 369•

• Unassigning Device Roles on page 370

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376

Viewing Prestaging Rules

Prestaging rules contain criteria for classifying the MPLS role of each device and

recommendingwhichphysical interfacesshouldbeUNI interfaces.Foreach recommended

UNI interface, the system recommends its primary loopback address.
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These prestaging rules are predefined and cannot be configured. They are neither

selectable nor configurable. However, you canmodify the results of the rules before

committing the recommended assignments to the database.

The following topic shows how to view prestaging rules. You can view a summary of all

prestaging rules, see a summary, or view details of a specific prestaging rule.

• Viewing Prestaging Rules in a Table on page 380

Viewing Prestaging Rules in a Table

To view prestaging rules in a tabular format:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. FromtheNetworkServices>Connectivity taskpane, selectPrestageDevices >Prestage

Rules.

The Ruleswindow appears.

The Ruleswindow lists all the prestaging rules by type, along with the name and a

brief description of each rule.

• Name—The name of the prestaging rule.

• Rule Type—The category of the rule, such as an NNI rule or a UNI rule.

• Description—Textual description that illustrates the purpose and functionality of

the rule.

• Loopback address—The IP address type used by a device to send a packet to itself.

Related
Documentation

Adding a UNI on page 369•

• Unassigning Device Roles on page 370

• Deleting UNIs on page 371

• Discovering Device Roles on page 372

• Excluding Devices from N-PE Role Assignment on page 373

• Excluding Interfaces from UNI Role Assignments on page 374

• Unassigning N-PE Devices on page 375

• Viewing N-PE Devices on page 376
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Managing Prestage Device Jobs

Connectivity Services Director enables you to view andmanage device prestaging jobs.

You can view the status of completed prestaging jobs and cancel the prestaging jobs

that are scheduled to execute at a later time or jobs that are in progress.

After Junos Space has discovered the devices, a two- or three-stage process to prestage

devices is performed automatically in the backend by the Connectivity Services Director

application. Prestaging is the process of preparing the devices to be compatible and

qualified for configuration of services, by discovering the roles of devices and assigning

network-provider edge (N-PE) roles as necessary. Because auto prestaging is an

automated process triggered by the change events from the device and platform, there

can bemultiple parallel prestaging jobs from a single device and frommultiple devices.

These jobs update the corresponding device information on completion.

Manualprestagingprocessprestages theentiredevice inventoryandautomatically assign

device roles to them.Therefore, havingaper-deviceautoprestaging job running inparallel

might be redundant for the functionality because the concerned device couldmost likely

be taken care by the manual prestaging job.

The Prestage Device Jobs page shows the progress and status of the role assignment

job. Although you can view details about the status of all the jobs initiated in the

ConnectivityServicesDirector application fromthePrestageDevice Jobspageaccessible

as a System task, you can use the Prestage Device Jobs page in Build mode of Service

viewtoobtaina filtereddisplayofonly theprestaging jobs for easyanalysis anddebugging.

To display the Prestage Device Jobs page:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Network Services > Connectivity task pane, select Prestage Devices > View

Prestage Jobs.

The Prestage Device Jobswindow appears.

4. To view the details of a job, select a row and click ShowDetails or double-click a row.

5. To cancel a scheduled job, select a job that is scheduled for a later time or a job that

is in progress and click Cancel.

The fields in the Prestaging Device Jobs page are described in Table 60 on page 382. To

view any hidden column, keep themouse on any column heading and select the down

arrow and then click Columns. Select the check box to display the hidden columns.
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NOTE: Details of jobs initiated from Connectivity Services Director will be
available only from Connectivity Services Director. These jobs will not be
listed in the Prestage Device Jobs pane in Junos Space platform and
vice-versa.

Table 60: Prestage Device Jobs Page Fields

DescriptionField

The unique ID assigned to the jobJob ID

The name of the jobName

The percentage of completion of the jobPercent

The status of the job:

• Success—Job completed successfully

• Failure—Job failed and was terminated

• Job Scheduled—Job is scheduled but has not yet started

• In progress—Job is has started, but not completed

• Cancelled—Job is cancelled

State

The type of the jobJob Type

Summary of the job scheduled and executed with statusSummary

The time when the job is scheduled to startScheduled
Start Time

The actual time when the job startedActual Start
Time

The time when the job was completedEnd Time

The login ID of the user that initiated the taskUser

The recurrent time when the job will be restarted.Recurrence

Related
Documentation

Managing Service Configuration Deployment Jobs on page 957•

• Deploying Services Configuration to Devices on page 959

Specifying theWait and Idle Times for Prestaging Devices

After Junos Space has discovered the devices, a two- or three-stage process to prestage

devices is performed automatically in the backend by the Connectivity Services Director

application. Prestaging takes the devices already under Junos Spacemanagement and
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prepares them for service activation by assigning roles to those devices and their

interfaces..

To specify the wait and idle times to be used for triggering jobs for prestaging devices:

1. Fromthe JunosSpaceuser interface, click theSystem iconon theConnectivityServices

Director banner.

The options that you can configure in Systemmode are displayed in a drop-down

menu.

2. Select Preferences from the drop-downmenu to open the Preferences page.

The Preferences page opens with User Preferences as the default tab.

3. Click the Services Activation tab to configure the services activation-related settings.

The settings that you can configure on the Services Activation tab are displayed.

4. Click the right arrow beside the Prestage Device section to expand it.

The parameters that you can configure for prestaging devices are displayed.

5. In the Pre-stageWait Time (Sec) field, specify the number of seconds for which the

task to trigger a job for prestagingdevicesmustwait after receiving the first notification

forprestagingdevices. Forexample, if youspecify theprestagewait timeas20seconds,

theprestaging taskwaits for aperiodof 20seconds, after receiving the first notification

for prestaging devices, and then initiates the prestaging-devices job.

6. In the Pre-stage Idle Time (Sec) field, specify the number of seconds after which the

job for prestagingdevices is initiated, if nonotification is receivedduring the idle period.

For example, if you specify the prestage idle time as 10 seconds and if no notification

for prestaging devices is received within this period, the job for prestaging devices is

triggered immediately after 10 seconds. Theprestage idle timevalue takesprecedence

over the prestage wait time value.

7. ClickOK to save the settings. You are prompted to confirm the changes youmade to

services-activation preferences.

8. Click Yes to confirm. The Preferences page is closed. A dialog box is displayed to

confirm the successful saving of the preferences. ClickOK to close the dialog box.

Related
Documentation

• Modifying the Application Settings of Connectivity Services Director on page 1032
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CHAPTER 21

Prestaging: Managing IP Addresses

• Creating an IP Address Pool on page 385

• Managing Resources on page 387

• Specifying IPv4 Addressing Assignment in IP Service Definitions on page 389

Creating an IP Address Pool

You, the Service Designer, can create consistent IP address pools for Layer 3 VPNs by

selectingPrestageDevices>Resources>Add IPAddressPools fromtheNetworkServices

> Connectivity task pane in Build mode of Service View. The IP addresses assigned to

each PE/CE link need to allow routing across the customer’s entire Layer 3 VPN, as long

as thePE/CE addresses are not exposed outside of that VPN. If the PE/CE link addresses

are accessible fromoutside the customer’s VPN, then those IP addressesmay also need

to be globally unique across the internet, instead of just within the customer’s VPN.

When you create an IP address pool, it appears in the Prestage Devices > Resources

inventory page. See “Creating an IP Address Pool” on page 385

NOTE: Preferably, create all IPv4 address pools at the beginning of the
prestaging process (see “Prestaging Devices Overview” on page 55), before
you run Role Discovery (see “Discovering andAssigning All N-PEDevices” on
page 349), so that any IPv4 IP addresses found on devices during the role
discovery process can bemarked as already allocated in the corresponding
IPv4 IP address pools.

To create an IPv4 IP address pool:

1. In the Network Services > Connectivity task pane, select Prestage Devices >Manage

Resources. The Resource Utilization Status page is displayed. The status of various

resources suchasVLAN, virtual circuit, route target, routedistinguisher, and IPaddress

pool are displayed in a tabular format. You can create a customized IP pool based on

your network deployment needs.

2. Under the Allocated column, click the link in the displayed number to open the

Resource Allocated Details dialog box. If the resource pool is an IP address pool, the

IP addresses allocated from the selected resource pool are displayed in a table.
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Similarly, for other resources such as VLAN or virtual circuit, information regarding the

element or device to which the resource is allocated is displayed.

3. ClickAddat the topof the tableof displayed resources. TheAdd IPAddressPooldialog

box appears.

4. In thePoolTypedrop-down list box, select the IPpool typeaseitherGlobalorCustomer.

• A Global IP address pool pertains to the service provider. There can bemore than

one global IPv4 address pool. However, each global pool must have its own unique

name and its set of IPv4 addressesmust not overlapwith those of any other global

pool. You can allocate addresses from global pools across multiple Layer 3 VPNs

across multiple customers.

• A Customer IP address pool pertains to an existing customer. These pools are

associated with the corresponding customer. You can associate more than one

customer IPv4 pool with each customer. However, each customer pool must have

its own set of IPv4 addresses which must not overlap with those of any other pool

belonging to the same customer. You can allocate addresses from customer pools

across multiple Layer 3 VPNs for a particular customer.

5. In the Pool Name field, enter a unique name.

An IP address pool name can be nomore than 50 characters.

6. In the IP Address Pool field, enter an IPv4 IP address pool.

Any IPv4 address pool in Junos Spacemaps directly onto the Classless Interdomain

Routing (CIDR) notation for IPv4 network addresses. The CIDR network address,

192.168.1.0/24 is a contiguous block of 256 individual IPv4 addresses: 192.168.1.0/32

through 192.168.1.255/32, inclusive. Thenetworkaddress 10.0.99.20/30 isacontiguous

block of 4 individual IPv4 addresses: 10.0.99.20/32 through 10.0.99.23/32, inclusive.

As a consequence, any Junos Space IPv4 address pool directly maps to (and is

identified by) its CIDR network address. The Junos Space IPv4 address pool,

192.168.1.0/24, contains all of the addresses from 192.168.1.0/32 to 192.168.1.255/32,

while the IPv4 address pool, 10.0.99.20/30 contains all of the addresses from

10.0.99.20/32 to 10.0.99.23/32.

7. In the Subnet (/) field, enter the destination IP prefix length or the subnet mask. The

subnetmask indicates the number of bits used for the network portion of the address

(for example, 10.10.20.0/24).

8. If youarecreatingaCustomer IPaddresspool, theAssociatewithcustomerdrop-down

list box appears. Select an existing customer name. To create a customer, see “Adding

a New Customer” on page 697.

9. Click Create.
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Junos Space saves the IP address pool information in the database. The IP address

pool appears in the Resources inventory page. The Pool Type column differentiates

global from customer IP address pools.

NOTE: You need to create IP address pools only if the operation of your
network requires it. Alternatively, you can use the global IP pools provided
by the Connectivity Services Director application for IP services.

NOTE: When you delete an IP address pool, youmust ensure that such a
pool is not being currently utilized or allocated to amanaged element.
Otherwise, you cannot delete such an allocated IP address pool.

Related
Documentation

Managing Resources on page 387•

• Specifying IPv4 Addressing Assignment in IP Service Definitions on page 389

Managing Resources

You can use the Manage Resource page to view existing IP address pools created for

global use or for specific customers. Besides the IP address pool information, the status

of various other resources such as VLAN IDs, virtual circuit IDs, route distinguisher, and

route targets that are created for utilization in services is also displayed. You can also

view the details of allocated or utilized resources, such as the VLAN ID allocated to the

corresponding interface and the logical unit association with a particular interface on a

device. For more information about creating an IPv4 IP address pool, see “Creating an IP

Address Pool” on page 385.

Viewing Resources

Starting in Connectivity Services Director Release 2.1R1, you can view andmanage a

particular pool of resources by selecting an option from the Pool Type list. TheManage

Resource page displays the list of resource pools that can be configured. You can filter

the resources displayed on this page by device name, interfaces on the device, and a

customer associated with the device.

Viewing Detailed Resources Information

To view andmanage detailed information about resources:

1. In the Connectivity Services Director application, select Service View from the Views

list.

2. From the Tasks pane, select Prestage Devices >Manage Resource.

The Manage Resource page is displayed.

387Copyright © 2019, Juniper Networks, Inc.

Chapter 21: Prestaging: Managing IP Addresses



3. Fill in the fields in the Manage Resource page as indicated in Table 61 on page 388.

Table 61: Resource Pool Landing Page Details

DescriptionDetail

Select one of the following options from the list to view andmanage a particular pool of resources:

• Global Pool—tomanage pools of IPv4 addresses related to the service provider.

• Unit Pool—tomanage units for interfaces in a resource pool.

• VLAN Pool—tomanage pools of IPv4 address for a VLAN.

• Customer IP Pool—tomanage pools of IPv4 addresses applicable to a particular customer.

NOTE: Starting in Connectivity Services Director Release 2.1R1, the Pool Type list is available in the
Manage Resource page.

Pool Type

Select a device from the list to view resource types specific to interfaces on that device.

NOTE: This field is available only if you select Unit Pool or VLAN Pool from the Pool Type list.

Device Name

Choose an interface of the selected device from the list.

NOTE: This field is available only if you select Unit Pool or VLAN Pool from the Pool Type list.

Interface Name

Click Select to view the list of customers. The Choose Customerwindow is displayed.

To choose a customer, select the check box next to the customer and clickOK.

Customer

Click Filter to execute the search.Filter

Click Add to add a new IPv4 address pool.Add

Click Delete to delete an existing IPv4 address pool.Delete

This column displays the names of IPv4 address pools.Pool Name

This column displays the user-defined description of the resource pool.Description

This column displays the number of resources allocated from the pool.Allocated

Release History Table DescriptionRelease

Starting in Connectivity Services Director Release 2.1R1, the Pool Type list
is available in the Manage Resource page.

2.1R1

Related
Documentation

Creating an IP Address Pool on page 385•

• Specifying IPv4 Addressing Assignment in IP Service Definitions on page 389
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Specifying IPv4 Addressing Assignment in IP Service Definitions

You, the Service Designer, can specify the IPv4 IP address settings to use for PE/CE link

when provisioning IP service definitions.

When configuring Layer 3 VPNs, it is necessary to assign consistent IP addresses to the

logical interfaces on both sides of each PE/CE link. The IP addresses assigned to each

PE/CE link need to allow routing across the customer’s entire Layer 3 VPN, and only need

to be unique within the confines of the customer’s VPN, as long as the PE/CE addresses

are not exposed outside of that VPN. If the PE/CE link addresses are accessible from

outside of the customer’s VPN, then those IP addresses may also need to be globally

unique across the Internet, instead of just within the customer’s VPN.

The Connectivity Services Director application automatically assigns IPv4 addresses to

both sides of each PE/CE link, aswell as keeps track ofwhich IPv4 addresses are already

in use. It ensures the correct assignment of IP addresses and prevents the reuse of IP

addresses.

To specify auto-assigning of the PE/CE link addresses from IPv4 pools, you select the

Auto Pick option, the IP pool type—global or customer, and the number of contiguous

IPv4 addresses—size of the IPV4 address block that is allocated for each PE/CE link.

Which particular global or customer IPv4 address pool to use is chosen during service

provisioning when filling out the IP Service Order.

For auto-assignment scenarios, the service designer can always select the Allow editing

in Service Order option at the right of each service definition setting to allow the

corresponding IPv4 pool setting to be overridden later when filling out the IP Service

Order.

To specify manual assignment of PE/CE link addresses, the designer simply selects the

manual-assignment option.

To specify IP address settings in an IP service definition:

1. In the IP Address Settings area PE Interface IP Address check boxes, select one of the

following:

• AutoPick—SpecifieswhetherPE/CE linkaddressesareautomatically assigned from

an IPv4 IP address pool.

• Select Manually—Specifies whether the service designer manually assigns PE/CE

link addresses from the same IPv4 IP address pool.

2. In the IP Pool Types drop-down list box, select one of the following:

• Global—Pools of IPv4 addresses pertaining to the Service Provider. There can be

more than one global IPv4 address pool. However, each global pool must have its

own unique name and its set of IPv4 addressesmust not overlap with those of any

other global pool. You can allocate addresses from global pools across multiple

Layer 3 VPN across multiple customers.
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• Customer—Poolsof IPv4addressespertaining toaparticular customer.Thesepools

are associated with the corresponding customer. There can bemore than one

customer IPv4 pool associated with each customer. However, each customer pool

must have its own set of IPv4 addresses which must not overlap with those of any

other pool belonging to the same customer. Addresses from customer pools can

be allocated across multiple Layer 3 VPNs for a particular customer.

3. In the IPAddressBlockSize field, enter the size of the IPv4 IP addresse block allocated

for each PE/CE link.

4. Select the Editable in service order check box on the right of each IP address setting

to overwrite the corresponding IPv4 IP address pool settingwhen creating the service

order.

5. Click another Layer 3 VPN Settings link to continue specifying settings or click Finish.

If you click Finish, the custom IP service definition appears on theManage Service

Definitions inventory page.

Related
Documentation

• Creating an IP Address Pool on page 385

• Managing Resources on page 387

Copyright © 2019, Juniper Networks, Inc.390

Connectivity Services Director User Guide



CHAPTER 22

Device Configuration Prerequisites to
Prestaging Examples

• Example: Base Configuration for N-PE Device in a Multipoint Service on page 391

• Example: Base Configuration for N-PE Device in an E-Line (LDP) Service on page 392

• Example: Base Configuration for a P Router on page 394

Example: Base Configuration for N-PE Device in aMultipoint Service

An N-PE device to be used in a multipoint service must have the following entities

configured before you assign the N-PE role to the device:

• Gigabit Ethernet interfaces to the network core

• Loopback interface

• Routing options

• MPLS protocol

• BGP protocol

• OSPF protocol

• LDP protocol

TheN-PE device in this configuration example has just one interface to the network core.

In amore complexnetwork inwhich theN-PEdevice connects tomore thanonePdevice,

you need to configure multiple interfaces.

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
                address 10.1.22.2/30;
            }
            family mpls;
        }
    }

    }
    lo0 {
        unit 0 {
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            family inet {
                address 192.168.1.30/32;
            }
        }           
    }

}
routing-options {
    autonomous-system 65410;
}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
    bgp {
        group CA-Peer {
            type internal;
            local-address 192.168.1.30;
            family l2vpn {
                signaling;
            }
            neighbor 192.168.1.40;
            neighbor 192.168.1.10;
            neighbor 192.168.1.20;
            neighbor 192.168.1.50;
            neighbor 192.168.1.60;
        }
    }
    ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
}

Related
Documentation

Example: Base Configuration for N-PE Device in an E-Line (LDP) Service on page 392•

• Example: Base Configuration for a P Router on page 394

Example: Base Configuration for N-PE Device in an E-Line (LDP) Service

AnN-PEdevice tobeused inanE-Line servicemusthave the followingentities configured

before you assign the N-PE role to the device:

• Gigabit Ethernet interfaces to the network core

• Loopback interface

• MPLS protocol
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• OSPF protocol

• LDP protocol

TheN-PE device in this configuration example has just one interface to the network core.

In amore complexnetwork inwhich theN-PEdevice connects tomore thanonePdevice,

you need to configure multiple interfaces.

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
                address 10.1.18.2/30;
            }
            family mpls;
        }           
    }

   }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.20/32;
            }
        }
    }

}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
     ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }

NOTE: If the N-PE router will also be used inmultipoint services, do not use
this base configuration. Instead, use the base configuration for multipoint
services.

Related
Documentation

Example: Base Configuration for N-PE Device in a Multipoint Service on page 391•

• Example: Base Configuration for a P Router on page 394
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Example: Base Configuration for a P Router

P routers in your MPLS networkmust have the following entities configured before these

devices are prestaged:

• A Gigabit Ethernet interface to each router in the network

• Loopback interface

• MPLS protocol

• OSPF protocol

• LDP protocol

Figure 16 on page 394 shows a simple network with one P router connecting five N-PE

routers.

Figure 16: Connectivity in a Simple Network

The following example shows a P router configuration for the simple network shown in

Figure 16 on page 394.

interfaces {
        ge-0/0/2 {
        unit 0 {
            family inet {
                address 10.1.14.1/30;
            }
            family mpls;
        }
    }
    ge-0/0/3 {
        unit 0 {
            family inet {
                address 10.1.15.2/30;
            }
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            family mpls;
        }
    }
    ge-5/0/0 {
        unit 0 {
            family inet {
                address 10.1.17.1/30;
            }
            family mpls;
        }
    }
    ge-5/0/1 {
        unit 0 {
            family inet {
                address 10.1.18.1/30;
            }
            family mpls;
        }
    }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.1/32;
            }
        }
    }
}

}
protocols {
    mpls {
        interface ge-0/0/2.0;
        interface ge-0/0/3.0;
        interface ge-5/0/0.0;
        interface ge-5/0/1.0;
        interface lo0.0;
    }
    ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface ge-0/0/2.0;
            interface ge-0/0/3.0;
            interface ge-5/0/0.0;
            interface ge-5/0/1.0;
            interface lo0.0 {
                passive;
            }
        }
    }               
    ldp {
        interface ge-0/0/2.0;
        interface ge-0/0/3.0;
        interface ge-5/0/0.0;
        interface ge-5/0/1.0;
    }
}

Related
Documentation

• Example: Base Configuration for N-PE Device in a Multipoint Service on page 391
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• Example: Base Configuration for N-PE Device in an E-Line (LDP) Service on page 392
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CHAPTER 23

Prestaging Services

• Creating and Handling a Service Recovery Request on page 398

• Selecting a Service Definition in theWizard for Creating a Service Recovery

Request on page 400

• Specifying Devices and Filters in theWizard for Creating a Service Recovery

Request on page 401

• Reviewing the Configured Settings in theWizard for Creating a Service Recovery

Request on page 404

• Viewing Service Recovery Report on page 406

• Performing a Service Recovery on a Defined Service on page 407

• Processing of Device Change Notifications Overview on page 408

• Handling of Out-of-Band Notifications for Service Recovery on page 411

• Viewing Service Recovery Instance Details on page 412

• Managing Out-of-Band Notifications for Recovered Services on page 416

• Viewing Details of an Out-of-Band Notification for Recovered Services on page 418

• Viewing Services Rejected During a Service Recovery on page 419

• Viewing Service Recovery Jobs on page 421

• Performing a Configuration Audit for Recovered Services on page 423

• Viewing Configuration Audit Results of Recovered Services on page 425

• RecoveringModifications andDeletions Performed for Existing Endpoints on page 428

• REST API Changes in Connectivity Services Director for Service Recovery on page 432

• Sample XPath Notifications Received on Devices for Deleted Endpoints on page 433

• Sample XPath Notifications Received on Devices for a Modified E-LAN

Service on page 436

• Sample XPath Notifications Received on Devices for a Created E-LAN

Service on page 440

• Sample XPath Notifications Received on Devices for a Created IP Service on page 444

• SampleXPathNotificationsReceivedonDevices foraCreatedE-LineServiceonpage445
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• Sample XPath Notifications Received on Devices for CFM Profiles Associated with an

E-Line Service on page 446

• Sample XPath Notifications Received on Devices for CoS Profiles Associated with an

E-Line Service on page 448

Creating and Handling a Service Recovery Request

The Service Recovery feature functions within the pre-staging operation of the Network

Activate application. Service Recovery has two parts.

First, Service Recovery parses each device’s configuration searching for service

configurations and existing Network Activate service elements (E-Line services, Layer 2

circuits, routing instances, firewalls, policy options, routing options, and OAM interface

branches of Junos Space configurations that are being processed).

Second, Service Recovery stitches the service elements by identifying related service

attributesacrossdevices, suchasVCIDs forMartini servicesand route targets forKompella

(L2VPN) services, to form Network Activate services.

NOTE: When you attempt to recover E-LANand IP services using theService
Recovery feature, youmustnotselectanyservice templates thatareattached
withsuchservices for recovery.Thebasicconfigurationofservices is recovered
in such a scenario. This is an expected behavior with performing a service
recovery for E-LAN and IP services. For E-Line services, you can recover QoS
templates that are attached with such services.

Awizard is available to create a Service Recovery request in an intuitive and

easily-navigable format. The settings that you can configure in the service order are

organized in separatepagesof thewizard,whichyoucan launchbyclicking theappropriate

buttons at the top of the Create Service Recovery Request page. Alternatively, you can

proceed to thecorresponding setting-relatedpagesbyclicking theBackandNextbuttons

at any point in the wizard during the creation of the Service Recovery request.

To perform Service Recovery, in the Network Services > Connectivity task pane, select

Service Recovery > Recover Services. Initially, Service Recovery generates the following

Alert message, which describes the process you are about to start and recommends

saving previously recovered services.

To create a service recovery request:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.
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3. FromtheViewpane, select theNetworkServices>Connectivitynodewithoutexpanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. From the Network Services > Connectivity Tasks pane, select Service Recovery > View

Recovered Services.

The Service Recovery page is displayed with a list of recovered services.

NOTE: The Latest Recovery Job field at the top of the page displays the
job ID and job status in blue hyperlink. Click the hyperlink in the job ID and
status to open the Job Details dialog box. The job ID, start and end times
of the job, percentage of completion, and status of the job are displayed.
Click Close to close the job dialog box.

5. The Create Service Recovery Requestwizard contains two pages— Select Service

Recovery Options and Review.

In the Select Service Definition page of the wizard, you can select one or more service

types: E-Line, E-LAN, and IP.

The Select Service Definition table on the of the Select Service Recovery Options page

of the wizard also presents a table that lists the names of all services of the selected

Service Type.

The Select Devices and Filter Criteria sections of the Select Service Recovery Options

page of thewizard displays the devices and filters, with the devices listed in theName

column. You can specify a VCID Range and Route target range to complete the

definition of the service recovery profile search.

The following topics describe the different pages of the Create Service Recovery

Request wizard:

• Selecting a Service Definition in theWizard for Creating a Service Recovery Request

on page 400

• SpecifyingDevices andFilters in theWizard for Creating aServiceRecoveryRequest

on page 401

• Reviewing the Configured Settings in theWizard for Creating a Service Recovery

Request on page 404

Related
Documentation

Viewing Service Recovery Report on page 406•

• Performing a Service Recovery on a Defined Service on page 407
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Selecting a Service Definition in theWizard for Creating a Service Recovery Request

On the first page of the wizard to create a service recovery request, you can select the

service type, which causes the page to be populated with the services that match the

selected service type. For example, if you want to recover E-Line services, you can select

this service type to view the relevant services of this type. You can also select multiple

service types, based on your network needs. You can select a service definition for which

you want to create a service recovery request.

To select a service type and definition in the service recovery request creation wizard:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. From the Network Services > Connectivity Tasks pane, select Service Recovery > View

Recovered Services.

The Service Recovery page is displayed with a list of recovered services.

NOTE: The Latest Recovery Job field at the top of the page displays the
job ID and job status in blue hyperlink. Click the hyperlink in the job ID and
status to open the Job Details dialog box. The job ID, start and end times
of the job, percentage of completion, and status of the job are displayed.
Click Close to close the job dialog box.

5. Click the New icon above the table of listed service names and service definitions.

The Select Service Recovery Options page of the Create Service Recovery Request

wizard is displayed.
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6. In the Select Service Definition table of the Select Service Recovery Options page, fill

in the fields as described in the following table.

ActionField

Click the Add button to open the Choose Service Definition page. The Choose Service Definition inventory page
displays only those published service definitions designed to work with the type of services you need.

Select the check boxes beside the types of service definitions for which you want to create a service recovery
request. The search utility that is present in the Choose Service Definition dialog box that is displayed when you
clickSelectbeside theServiceDefinition fieldenables you to searchbyName,Createdby, andSignalingcolumns;
the search utility is not supported for other columns in the dialog box.

ClickOK to add the selected definitions to the service recovery request. The dialog box closes and you are
returned to the Select Service Definition table that lists the service definitions you selected.

Add

Select the check boxes beside the service definitions youwant to remove from the service recovery request, and
click the Delete button to remove the service definitions from the table.

Delete

Select the check boxes for the service definitions whose services you want to recover.

All the published service definitions based on service type selected are listed.

Name

7. Proceed to “SpecifyingDevicesandFilters in theWizard forCreatingaServiceRecovery

Request” on page 401.

Related
Documentation

Viewing Service Recovery Report on page 406•

• Performing a Service Recovery on a Defined Service on page 407

Specifying Devices and Filters in theWizard for Creating a Service Recovery Request

After you select a service definition to create a service recovery request, you can specify

thedevicesand filters toassociatewith theservice recovery request. TheRuleParameters

page of the wizard displays the devices and filters, with the devices listed in the Name

column. You can specify aVCIDRange andRouteTargetRange to complete the definition

of the service recovery profile search.

To specify the rule parameters in the service recovery request creation wizard:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.
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The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. From the Network Services > Connectivity Tasks pane, select Service Recovery > View

Recovered Services.

The Service Recovery page is displayed with a list of recovered services.

5. Click the New icon above the table of listed service orders and service definitions.

The Select Service Recovery Options page of the Create Service Recovery Request

wizard is displayed.

6. In theSelectDevices and FilterCriteria sections of thewizard page, specify the devices

and filters for the service recovery operation.

7. Fill in the fields as described in the following table.

ActionField

Select Devices

Select the check boxes beside the devices whose services you want to recover. The hostnames, IP
addresses, managed states, OS versions, and roles of the devices are displayed in a table.

Devices

Click the Add button to open a dialog box to select the N-PE device you want to associate with the
service recovery request. From the Choose Endpoints dialog box that appears, select the devices that
you want to participate in the service. Use themultiple selection feature to select one or more devices.
Thesearchbox that ispresent in theChooseEndpointsdialogboxenablessearchacrossall thecolumns
displayed in the dialog box.

ClickOK to add the devices to the service recovery request. The dialog box closes and you are returned
to the Select Devices table that lists the endpoints that you selected.

Add

Select the check boxes beside the devices you want to remove from the service recovery request, and
click the Delete button to remove the devices from the table.

Delete

Filter Criteria

Select this checkbox to recover service templatesduring theservice recoveryoperation for theassociated
devices.

Recover Templates

Select this check box to recover the deleted endpoints during the service recovery operation.Recover Deleted
EndPoints

Select this check box to recover the modified endpoints during the service recovery operation.Recover Modified
EndPoints
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ActionField

This field is displayed if you have selected an E-Line service definition.

Specify the VCID range within which services are to be recovered.

Range: 1 through 2147483647

NOTE: The VCID Range parameter enables you to change the VCID range for services that had been
configured previously outside of the context of Junos Space.

VCID Range

This field is displayed for all the service types.

Specify the route target range within which services are to be recovered. You can express the range in
Autonomous System number format or IPv4 format:

• ASnumber format—Autonomoussystem(AS)number format:<l2vpn-id:as-number:2-byte-number>.
For example, 100:200. The AS number can be in the range from 1 through 65,535.

• IPv4 format—<l2vpn-id:ip-address:2-byte-number>. For example, l2vpn-id:10.1.1.1:2. Make sure that
this value is lower than the value specified as the maximum route target allowed.

NOTE: The Route target parameter enables you to change the route target range for services that had
been configured previously outside of the context of Junos Space.

Route Target Range

This field is displayed if you have selected an E-LAN service definition.

Specify the VPLS ID range within which the services are to be recovered.

Range: 1 through 2147483647

VPLS ID Range

This field is displayed if you have you have selected an E-LAN or IP service definition.

Specify the Hub-Route target range within which services are to be recovered. You can express the
range in Autonomous System number format or IPv4 format:

• ASnumber format—Autonomoussystem(AS)number format:<l2vpn-id:as-number:2-byte-number>.
For example, 100:200. The AS number can be in the range from 1 through 65,535.

• IPv4 format—<l2vpn-id:ip-address:2-byte-number>. For example, l2vpn-id:10.1.1.1:2. Make sure that
this value is lower than the value specified as the maximum route target allowed.

Hub-Route Target
Range

This field is displayed if you have selected an E-LAN or IP service dfinition.

Specify the Spoke-Route target range within which services are to be recovered. You can express the
range in Autonomous System number format or IPv4 format:

• ASnumber format—Autonomoussystem(AS)number format:<l2vpn-id:as-number:2-byte-number>.
For example, 100:200. The AS number can be in the range from 1 through 65,535.

• IPv4 format—<l2vpn-id:ip-address:2-byte-number>. For example, l2vpn-id:10.1.1.1:2. Make sure that
this value is lower than the value specified as the maximum route target allowed.

Spoke-Route Target
Range

8. When you complete defining the Service Recovery Profile, proceed to “Reviewing the

ConfiguredSettings in theWizard forCreatingaServiceRecoveryRequest”onpage404.

Alternatively, click Done to trigger the service recovery operation.

TheConnectivity ServicesDirector application fetches the latest device configuration.

It then processes the device configuration to derive the configuration of selected
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service types. A message is displayed to denote that the service recovery request is

being saved in the database.

NOTE:
• In case of an IP service with pseudowire attached, you have to first
recover the IP service, and then the E-Line service.

When the service recovery operation completes, the Service Recovery Reportwindow

appears. The service recovery report for each service is displayed in different tabs.

Related
Documentation

Viewing Service Recovery Report on page 406•

• Performing a Service Recovery on a Defined Service on page 407

Reviewing the Configured Settings in theWizard for Creating a Service Recovery
Request

The Review page of the service recovery job creation andmodification wizards enable

you to view and evaluate the service parameters and components you configured in

preceding steps or pages of thewizard. This page provides a comprehensive, single-page

view of all the service elements configured in the different pages of the wizard. You can

either click the buttons corresponding to the various settings at the top of the wizard

page to directly traverse to the page you want to modify or click the navigation buttons

at the bottom of the wizard page to go to the different pages of the wizard.

After you click Start on the Review page of the service recovery request creation wizard,

the Service Recovery Request job starts. After the job is completed, all the configuration

parameters for all the devices are retrieved, but only those configurations that match

the filter are processed and are populated in the Service Recovery page. Also, when a

service recovery request job starts, the action denotes that only a discovery is initiated

of all the possible services that can be recovered from the device. They are not yet stored

in the Connectivity Services Director application database. Their status is initiallymarked

as Partial as shown on the Service Recovery page.

Toexamine theconfiguredservice recovery request settings in theservice recovery request

creation wizard:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.
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The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. From the Network Services > Connectivity Tasks pane, select Service Recovery > View

Recovered Services.

The Service Recovery page is displayed with a list of recovered services.

5. Click the New icon above the table of listed service definitions.

The Select Service Recovery Options page of the Create Service Recovery Request

wizard is displayed.

6. Click the Review button at the top of the wizard page to examine the configured

settings. Alternatively, click Next after you specify the rule parameters.

7. You can examine andmodify the created service recovery request parameters.

Alternatively, click the correspondingbuttonsat the topof thewizardpage tonavigate

to the specific pages pertain to the settings you want to modify.

8. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

9. Click Finish to save the service recovery request.

10. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes. The Service Recovery page appears.

11. When you complete defining the service recovery profile, click Done To submit the

service recovery request.

TheConnectivity ServicesDirector application fetches the latest device configuration.

It then processes the device configuration to derive the configuration of selected

service types. A message is displayed to denote that the service recovery request is

being saved in the database.

NOTE:
• In case of an IP service with pseudowire attached, you have to first
recover the IP service, and then the E-Line service.

When the service recovery operation completes, the Service Recovery Reportwindow

appears. The service recovery report for each service is displayed in different tabs.

Related
Documentation

Viewing Service Recovery Report on page 406•

• Performing a Service Recovery on a Defined Service on page 407
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Viewing Service Recovery Report

When the service recovery operation completes, the Service Recoverywindow appears.

The Service Recoverywindow displays the recovered services according to service type.

The service recovery report for for all services is displayed in a table.

To view the service recovery report:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. In the Network Services > Connectivity task pane, select Service Recovery > Recover

Services.

The Service Recovery window is displayed.

The following fields are displayed in the window:

DescriptionColumn

Recovered Services—Lists the recovered service instances for the different services.

Name of the recovered service instance.Service Name

Name of the service definition attached to a service.Service Definition

One of the following:

• E-Line

• E-LAN

• IP

Service Type

Partial or RecoveredStatus

Customer for which the service is createdCustomer

Comments to describe the service.Comments
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Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

• Performing a Service Recovery on a Defined Service on page 407

Performing a Service Recovery on a Defined Service

You can perform a service recovery operation on a service instance that you have

previously configured in the Service Recovery page, instead of running the recovery job

during the process of creation of the recovery request. In certain situations, youmight

require a set of service instances to be defined separately, before you want to run the

recovery task on all such services. In such cases, you can perform the recovery,

independent of the recovery job creation, at a future time.

Partially recoveredservicesareavailableon theRecoverService landingpage, fromwhich

you can select one or more services and click on Recover button. After you click the

Recover button, a pop-up dialog box is displayed, in which you need to provide the

necessary attributes such as the customer for which the service is created and a

meaningful description of the service. Once the user clicks on Start the Service Recovery

Request job starts. After the job is completed, all the configurations for all the devices

will be retrieved, but only those configurations that match the filter are processed and

populated in Service Recovery page.

An important point to note here is that the recover action only discovers all the possible

services that canbe recovered fromthedevice. Theyarenot yet stored in theConnectivity

Services Director application database. Their status will be initially marked as Partial as

shown in grid.

To trigger a service recovery request on a previously configured service instance:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. From the Network Services > Connectivity Tasks pane, select Service Recovery > View

Recovered Services.

The Service Recovery page is displayed with a list of recovered services with the

Recovered Services tab selected.
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NOTE: The Latest Recovery Job field at the top of the page displays the
job ID and job status in blue. Click the the job ID and status to open the
JobDetailsdialogbox.The job ID, startandendtimesof the job,percentage
of completion, and status of the job are displayed. Click Close to close the
job dialog box.

5. Select the check box next to the service for which you want to perform the recovery

operation again.

6. Click theManage button above the table of listed service instances.

The Manage Recovery of a Service dialog box is displayed.

7. Select a customer from the Customer list to be associated with the service recovery

job.

8. Enter a meaningful, easily-identifiable description in the Comments box.

9. For IP services, select a hub of a full-mesh or a hub-and-spoke IP service from the

Select Hub list.

10. ClickManage to initiate the recovery job. Alternatively, click Cancel to discard the job.

If you clickManage, a dialog box is displayed stating that a service recovery job has

been initiated. Click the link in the job ID to view the job details. ClickOK to close the

dialog box.

You can view the details of the recovered service from the Service Recovery page.

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

• Viewing Service Recovery Report on page 406

Processing of Device Change Notifications Overview

All the device change notifications are processed by the following EJB:

net.juniper.jmp.cm.notification.inventory.device.cmp.CMDeviceChangeNotificationMDB

Themethod handleDeviceChange() is called passing a result of type

DeviceChangeDiffResult, which provides the following parts of information:

• Device ID—The ID of the device in the notification

• Notification Meta Data—The type of update—whether the configuration has been

modified out-of-band or using Connectivity Servcices Director.
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• DiffResults—Amap containing the changed configuration fromdifferent configuration

parameters on the CLI. Themap contains the following keys:

• Configuration

• hardware-inventory

• interface-inventory

• software-inventory

• license-inventory

• system-information

• logical-interface-inventory

• configuration-version

• Device ID—The ID of the device in the notification

• Changed XPath List—The changed XPath list can be retrieved by querying

getChangedXpathList() on result object.

For Service Recovery, Connectivity Services Director examines notifications that will

match following criteria:

• Type of update is OutOfBand.

• DiffResults for “configuration” is not empty.

• Changed XPath list is from the interested XPath list for services supported in

Connectivity Services Director. For the Connectivity Services Director application, an

interested XPath list is maintained. If the changed XPath list contains any XPath from

the interested XPath list, the configuration difference is processed.

• XPaths of Relevance to Connectivity Services Director on page 409

• ProcessingofXPathNotifications forOut-of-BandConfigurationChangesonpage410

XPaths of Relevance to Connectivity Services Director

All the XPaths are not processed for service recovery. Instead, an interested or relevant

XPath list is maintained for Connectivity Services Director. If the changed XPath list

contains any of the following XPath attributes, the configuration differential-set is

processed to determine the impacted service because of an update to service settings.

/configuration/routing-instances/instance
/configuration/firewall/family/vpls
/configuration/firewall/family/ccc
/configuration/firewall/policer/
/configuration/interfaces/interface
/configuration/interfaces/interface/unit
/configuration/policy-options/
/configuration/protocol/l2circuit
/configuration/protocol/local-switching
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Processing of XPath Notifications for Out-of-Band Configuration Changes

AnetworkmanagedbyConnectivityServicesDirectorhas three repositoriesof information

about theconfigurationofanetworkdevice—theconfigurationstoredon thedevice itself,

the device configuration record maintained by Junos Space, and the Build mode

configuration maintained by Connectivity Services Director. When the configuration

contained in all three repositories match, the device configuration state is shown as In

Sync in Connectivity Services Director. When the repositories do not match, the

configuration state is shownasOutofSync.Acommoncause for this state is out-of-band

configuration changes—that is, configuration changes made to a device outside of

Connectivity Services Director.

When a device state is Out of Sync, you cannot deploy configuration changes on the

device inDeploymode.Use theResynchronizeDeviceConfiguration task to resynchronize

the three configuration repositories and change the device configuration state back to

In Sync.

This section describes the different scenarios for out-of-band configuration change on

thedeviceand theapproach todetermine theservice impactedby thechange.AnyXPath

change list and configuration differences can belong to any of the following categories:

• Change to the existing endpoint on the service

• Missing or new endpoint on the service

• Endpoint for the new service

• Deleted endpoint for the existing service

The following list of attributes is used to identify neighbor service elements:

When serviceType is ServiceTypesEnum.ELINEMARTINI

 vcID
 lsName
 lsEndName/LsEndIf:
 deviceID

When serviceType is ServiceTypesEnum.ELINEKOMPELLA

 routeTarget

When serviceType is ServiceTypesEnum.VPLS

  vplsID
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 routeTarget
 hubRouteTarget
 spokeRouteTarget

When serviceType is ServiceTypesEnum.L3VPN

 routeTarget
 hubRouteTarget
 spokeRouteTarget

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

Handling of Out-of-Band Notifications for Service Recovery

After a device goes into the Out Of Sync state, a notification is displayed in the status

bar at the bottom of the Connectivity Services Director GUI with the count of devices

currently out of sync due to out-of-band notifications. The action to be taken when an

out-of-band notification is received for the device can be defined using the Preferences

page (which you can launch by clicking the down arrowbeside the Systembutton on the

Connectivity Services Director banner and selecting Preferences).

The Service Activation tab of the Preferences page contains the following check box in

the Deployments section for service recovery:

• Blockdeployment onpendingnotifications—Select this check box to cause a validation

to be performed to determine if any of the selected devices have pending out-of-band

notification, before deploying a service order. If a pending out-of-band notification

exists for a device, deployment is blocked with the following message:

Cannot deploy service order, since pending notification exists for device(s) : <dev-1>,

<dev-2>,<dev-3>

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•
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Viewing Service Recovery Instance Details

The Service Recoverywindow displays the recovered services according to service type.

The service recovery report for each service is displayed in a table. You can view the

individual and fine-grained details of the services recovered by double-clicking the name

of a service instance from the table displayed in the Service Recovery window.

To view the details of a service recovery instance:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. In the Network Services > Connectivity Tasks pane, select Service Recovery > Recover

Services. The Service Recovery window is displayed.

The Details button enables you to view information about a service selected in the

Recovered Services tab of the Service Recovery window.

5. Double-click a service instance in the Service Recovery window to open the View

Service Detailswindow. This window contains several sections or panels that provide

details about the recovered services.

The View Service Detailswindow displays information about a service selected in the

Recovered Services tab of the Service Recovery window. You can view detailed,

in-depth information about a selected service.

The Service Details window is divided into three sections—Basic Details, Advanced

Details, and Endpoint Details. The service tree contains the service name as the root

node. The device node is the child of the service node and it contains the provisioned

UNIs as the child nodes. The details panel in the Endpoint Details table displays

configuration parameters and their corresponding values for the service in the tree

and based on the service type.

Under the Basic Details section, the general details about the node details are shown.

Also, the device configuration parameters are displayed. Under the Advanced Details

section, which you can open or close by clicking the View Less or ViewMore toggle

links, theadvancedconnectivity settingsbetweensites in the serviceprovider network

are shown, suchas routedistinguisher andVRF route label details.Under theEndpoint

Details table, the configuration parameters of the UNI are displayed. The right pane
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displays the details corresponding to the node or element you selected on the left

pane.

Basic Details

This section is applicable for all types of services and displays the following details.

• Name—Name of the selected service

• Customer—Name of the customer associated with the service.

• Service Definition—Name of the service definition that is used to create the service.

• Service Type—Selected service type, such as E-Line, IP, or E-LAN.

• Comments—User-defined description of the recovered service.

• Signalling—Type of signaling, namely, BGP or LDP.

• Order Type—Type of the service order, which is indicated as Recovery to signify a

recovered service.

• Status—Status of the recovered service, such as Partial or Recovered.

• Recovered By—Name of the user that performed the service recovery operation.

Advanced Details

This section displays the advanced, fine-grained connectivity settings between sites,

such as the configured route distinguisher, VRF route label. The parameters displayed

under this section are similar to the advanced parameters displayed in the wizard for

service order creation.

DescriptionColumn

Advanced Details

Virtual channel identifier number

This field is displayed for E-Line services only.

VCID

Type of the service order, such as Ethernet, E-LAN, or IP.Service Order Type

Maximum transmission unit number

This field is displayed for E-Line and E-LAN services.

MTU (Bytes)

The factor by which the MTU value that you specify for the service is multiplied.MTU (Factor)

Route target of the recovered service.Route Target

Route distinguisher of the recovered service.Route Distinguisher

Type of normalization for VLAN IDs, such as Q-in-Q or dot1q.VLANNormalization

Type of restrictions placed on the traffic that can be transported across the network by the
associated service, such as whether the associated service is restricted to transporting just
one VLAN across the network, transporting a VLAN range, or VLAN list.

Customer Traffic Type
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DescriptionColumn

If theUnmanaged IP field includes a valid IP address, the selected service is valid but the other
end is an ummanaged device. If the field displays Unmanaged IP, the IP address of the
unmanaged device is unknown. Youmust provide the IP address.

NOTE: If Service Recovery finds an endpoint attached to a recovered service for a device that
was not selected for Service Recovery, the endpoint is reported as an Unmanaged IP. The
endpoint is recovered and attached to the service when Service Recovery is executed on the
particular device.

This field is displayed for E-Line services only.

Unmanaged IP

If one endpoint is an unmanaged device, the interface information is unknown. Youmust
provide the interface for the endpoint.

This field is displayed for E-Line services only.

Unmanaged Interface

VPLS ID of the recovered service

This field is displayed for E-LAN services only.

VPLS ID

Layer 2 VPN ID of the recovered service

This field is displayed for E-LAN services only.

L2VPN ID

Route target of the hub.

This field is displayed only for E-LAN and IP services.

Hub Route Target

Route target of the spoke.

This field is displayed for E-LAN and IP services only.

Spoke Route Target

When this check box is selected, the VPN facilitates VRF table lookup, based onMPLS labels.

This field is displayed for IP services only.

VRF Table

Provider edge (PE) and customer edge (CE) routing protocol configured for the service.

This field is displayed for IP services only.

Routing Protocol

Hub device for the hub-and-spoke IP service.

This field is displayed for IP services only. This is applicable for hub-and-spoke IP service only.

Hub

Denotes whether auto discovery is enabled, which indicates that route target, route
distinguisher, and VPN ID are provisionable. This field is applicable only if signaling is LDP.

Auto Discovery

The VLAN to push at the relevant end points. This should be the same VLAN specified as the
VLAN ID.

Normalized Vlan ID

Revert time for redundant Layer 2 circuits and VPLS pseudowires. This field is applicable only
if signaling is LDP.

Revert Time

Delay to wait before the backup pseudowire takes over.Switch Over Delay
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DescriptionColumn

Tag number of the dot1q VLAN.Dot1QVLANTag

Indicates whether the service provisioner can override the AS number or not.ASOverride

Indicates whether the functionality to export direct routes to remote sites is enabled.Export Direct Routes

Indicates whether mapping of the inner label of a packet to a specific VRF, thereby allowing
the examination of the encapsulated IP header, is enabled.

VRF Table Label

Endpoint Details

A tabular view is displayed of the configured device and UNI Details that are part for

the service. Each row in the tabledisplays thebasic, salient parameters, suchasDevice

Name, InterfaceName,Unit ID, EncapsulationandDescription.Youcanuse thepaging

controls to navigate across multiple pages of endpoints as necessary. A minimum of

20 endpoints per page are displayed.

The following fields are displayed in the End Points table:

• End Point—Name of the device configured as the source or origin (A) endpoint and

the destination or target (Z) endpoint. This field is displayed for E-Line services.

Click the plus sign beside the device name for E-Line services to expand the

device-related parameters and view the detailed settings.

• Device Name—Name of the device for which the service is created. Click the plus

sign beside the device name for E-LANand IP services to expand the device-related

parameters and view the detailed settings.

• Interface—Name of the physical interface associated with the service

• Tagging—Typeofpacket tagging for the interface, suchasEthernet, dot1Q,orQ-in-Q

• UnitId—Logical unit identifier of the interface

• VlanId—VLAN identifier of the interface

• Role—Indicates whether the node is a hub or a spoke

• Template—Name of the service template that is used to create the service order

• CoS Profiles—Name of the COS profile associated with the service

6. View the information of a recovered service in the Basic Details and Advanced Details

panel. Click Close to close the View Service Details window and return to the Service

Recovery window.

The Service Recoverywindow displays the status of all the recovered services. It also

indicates the configuration that are converted to service orders. You can view the status

of a recovered service in its corresponding tab. The Service Recoverywindow displays

one of the following status indications:

• Managed—The service is nowmanaged successfully
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• Failed—Service Recovery did not convert the service to a service order

• Partial—The service cannot bemanaged yet

NOTE: You can access the Recovered Service Statuswindowwhenever you

want to attempt to recover additional services.

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

• Performing a Service Recovery on a Defined Service on page 407

Managing Out-of-Band Notifications for Recovered Services

The service recovery module contains a landing page for out of band device change

notifications where all the device change notifications are listed. You can perform the

following actions with the Service Recovery—Recover Out of Band Changes page:

• View the out-of-band notifications for recovered services and detailed information for

each notification.

• Accept an out-of-band notification

• Delete an existing out-of-band notification

• Ignore an out-of-band notification

TheServiceRecoveryReportwindowdisplays the recovered services according to service

type. The service recovery report for each service is displayed in a table. You can view

the individual and fine-grained details of the services recovered by double-clicking the

name of a service instance from the table displayed in the Service Recovery window.

To view andmanage out-of-band notifications for a service recovery instance:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. In the Network Services > Connectivity task pane, select Service Recovery >Manage

Out of Band Changes.
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The Manage Out of Band Changes window is displayed.

The following fields are displayed in this window:

• Device Name—Name of the device to which the notification belongs

• State—Indicates whether the notification is processed or not. One of the following

states is displayed:

• Ignored—Notification is ignored and device changes to InSync again.

• Failed—Processing failed and services was not recovered. The device remains in

the OutOfSync state.

• Pending—Notifications are not processed. The device continues to remain

OutOfSync. Notifications for successfully recovered services are removed from

grid and device are brought to InSync state.

• Notification XML—– A View link shows the configuration difference for all the out

of band notifications received for that device. Each time a notification is received,

it is merged with earlier out-of-band notifications received. A single copy of each

notification ismaintainedperdevice. ClickView to view theconfigurationdifferences

in XML format.

• Create Timestamp—Date and time at which the record was created. The record

will be created when the first out-of-band notification is received for the device.

• Update Timestamp—Date and time at which the most recent out-of-band

notification is received for the device

5. Select thecheckboxbesideadevice forwhichanout-of-bandnotification isdisplayed,

and click Accept above the table to navigate to the Create Service Recovery Request

wizard with the devices and service definitions preselected on the landing page. The

out-of-band notification is accepted and removed from the table of out-of-band

entries.

You can select a notification and clickAccept to recover endpoints. The following two

options are available for recovering endpoints:

• When Connectivity Services Director is able to determine the service to which the

endpoint belongs—Here, the service typeand servicedefinition in useare identified.

In that case, the service is recovered only for the selected endpoint. You can select

multiple endpoints and say recover service and all the selected endpoints will

recovered.

• When Connectivity Services Director is unable to determine the service to which

theendpointbelongs—Here, the service typeandservicedefinitionarenot identified,

and therefore, the existing service recovery flow is invoked. Only devices are

preselected and youmust select the appropriate service definition. If the recovery

of the service fails, the operator can use existing option of force-deploy from

ConnectivityServicesDirector tomake the serviceondevice in-syncwith the service

in Connectivity Services Director and then discard the notification on out-of-band

changes landing page to make device In Sync again.

6. Select thecheckboxbesideadevice forwhichanout-of-bandnotification isdisplayed,

and click Ignore above the table to ignore the notification.
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The notification is discarded and device is marked as In-Sync. The notification is not

removed from the table.

7. Select thecheckboxbesideadevice forwhichanout-of-bandnotification isdisplayed,

and click Delete above the table to delete the record from the table.

Only processed or discarded records are enabled to be deleted.

8. Select thecheckboxbesideadevice forwhichanout-of-bandnotification isdisplayed,

and click Details above the table to open a pop-up dialog box that displays the type

of update performed on the device that caused the out-of-band notification.

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

• Performing a Service Recovery on a Defined Service on page 407

Viewing Details of an Out-of-Band Notification for Recovered Services

On the Manage Out of Band Changes page, the Details button displays granular and

comprehensive information for a selected service recovery notification.

TheManage Out of Band Changes page displays the devices for which the configuration

settings have beenmodified outside of the Connectivity Services Director application.

Theconfiguration stateofadevice is shownas InSyncwhen theconfiguration information

inall three repositoriesmatch(settingsmadeusing thedevicesCLI,ConnectivityServices

Director in Build mode, or Junos Space Network Management Platform). If there is a

conflict between the configuration information in one or more of the repositories, the

device configuration state is Out of Sync. An Out of Sync state is usually the result of

out-of-band configuration changes—that is, configuration changes made to a device

using amanagement tool other than Connectivity Services Director.

To view detailed information that pertains to an out-of-band notification of a service

recovery instance:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.
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4. In the Network Services > Connectivity task pane, select Service Recovery >Manage

Out of Band Changes.

The Manage Out of Band Changes window is displayed.

5. Select thecheckboxbesideadevice forwhichanout-of-bandnotification isdisplayed,

and click Details above the table.

The Details pop-up dialog box appears that contains the following fields:

• Service Name—The configuration difference received in the device change

notificationwill be processed to see ifweare able to determine the nameof service.

If name of service can be determined it will displayed.

• Service Type—The type of service (E-Line, E-LAN, or IP)

• Service Definition—The definition associated with service

• Customer—The customer associated with service

• Type of update—Indicates the type of modification performed as follows:

• CREATE—Missing endpoint added to the service

• MODIFY—Existing endpoint modified for the service

• DELETE—Endpoint deleted for the service

6. ClickOK to close the Details dialog box.

You are returned to the Out of band Changes page.

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

• Performing a Service Recovery on a Defined Service on page 407

Viewing Services Rejected During a Service Recovery

You can view the services that were rejected during the service recovery operation. The

reason for the failure of the service recovery operation is also displayed, which enables

you to analyze and resolve the problem and perform a service recovery task again.

To view services that are rejected during a service recovery operation:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.
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3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. In the Network Services > Connectivity task pane, select Service Recovery > View

Recovered Services.

The Service Recovery page is displayed with a list of recovered services with the

Recovered Services tab selected.

5. Select the Rejected Endpoints tab. The Service Recovery—Rejected Services window

is displayed.

The following fields are displayed in a table:

• Service Name—Name of the rejected service

• Configuration XML—Click View to open a dialog box that displays the configuration

differences in XML format for the corresponding device on which out-of-band

changes have beenmade. Close the dialog box after viewing the out-of-band

configuration changes. Configuration changes are shown only when the device

configuration differs from the Junos Space configuration record—that is, when the

device configuration state in Junos Space is not In Sync.

NOTE: The Junos XML API is an XML representation of Junos
configuration statements and operational mode. It defines an XML
equivalent for all statements in the Junos configuration hierarchy and
many of the commands that you issue in CLI operational mode. Each
operational mode commandwith a Junos XML counterpart maps to a
request tag element and, if necessary, a response tag element.

• Service Type—Type of the rejected service, such as E-Line, IP, or E-LAN

• Device Name—Name of the device for which the service was rejected

• Interface—Name of the interface on the device for which the service was rejected

• Unit—Logical unit number of the interface associated with the device

• Rejected Reason—Cause for the service recovery operation to reject the service

6. Foreachdevicedisplayedunder theDevicescolumn, youcanviewdetailed information

regarding the services for which out-of-band notification was generated.

From the Manage Out of Band Changes page, select the check box beside a device

for which an out-of-band notification is displayed, and click Details above the table

to open a pop-up dialog box that displays the following fields:

Copyright © 2019, Juniper Networks, Inc.420

Connectivity Services Director User Guide



• Service Name—The configuration difference received in the device change

notificationwill be processed to see ifweare able to determine the nameof service.

If name of service can be determined it will displayed.

• Service Definition—Name of the definition associated with the service

• Customer—Name of the customer associated with the service

• Type of update—Indicates the type of modification performed as follows:

• CREATE—Missing endpoint added to the service

• MODIFY—Existing endpoint modified for the service

• DELETE—Endpoint deleted for the service

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

• Performing a Service Recovery on a Defined Service on page 407

Viewing Service Recovery Jobs

You can perform a service recovery operation on a service instance that you have

previously configured in the Service Recovery page, instead of running the recovery job

during the process of creation of the recovery request. In certain situations, youmight

require a set of service instances to be defined separately, before you want to run the

recovery task on all such services. In such cases, you can perform the recovery,

independent of the recovery job creation, at a future time.

The Service Recovery Jobs page shows the progress and status of the service recovery

job. Although you can view details about the status of all the jobs initiated in the

Connectivity Services Director application from the Jobs page accessible as a System

task, you can use the Service Recovery Jobs page in Buildmode of Service view to obtain

a filtered display of only the service recovery jobs for easy analysis and debugging.

To the service recovery jobs:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.
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4. In theNetworkServices>Connectivity taskpane, selectServiceRecovery>ViewService

Recovery Jobs.

The Service Recovery Jobswindow appears.

5. To view the details of a job, select a row and click ShowDetails or double-click a row.

6. To cancel a scheduled job, select a job that is scheduled for a later time or a job that

is in progress and click Cancel.

The fields in the Prestaging Device Jobs page are described in Table 60 on page 382. To

view any hidden column, keep themouse on any column heading and select the down

arrow and then click Columns. Select the check box to display the hidden columns.

NOTE: Details of jobs initiated from Connectivity Services Director will be
available only from Connectivity Services Director. These jobs will not be
listed in the Jobs pane in Junos Space platform and vice-versa.

Table 62: Service Recovery Jobs Page Fields

DescriptionField

The unique ID assigned to the jobJob ID

The name of the jobName

The percentage of completion of the jobPercent

The status of the job:

• Success—Job completed successfully

• Failure—Job failed and was terminated

• Job Scheduled—Job is scheduled but has not yet started

• In progress—Job is has started, but not completed

• Cancelled—Job is cancelled

State

The type of the jobJob Type

Summary of the job scheduled and executed with statusSummary

The time when the job is scheduled to startScheduled
Start Time

The actual time when the job startedActual Start
Time

The time when the job was completedEnd Time

The login ID of the user that initiated the taskUser
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Table 62: Service Recovery Jobs Page Fields (continued)

DescriptionField

The recurrent time when the job will be restarted.Recurrence

Related
Documentation

Managing Service Configuration Deployment Jobs on page 957•

• Deploying Services Configuration to Devices on page 959

Performing a Configuration Audit for Recovered Services

A configuration audit can help you determine whether the service configuration on the

device has been changed out of band. To this end, you can compare the results of a

configuration audit with the service configuration in the Junos Space database. The

following example shows a sample comparison.

To perform a configuration audit:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. In the Network Services > Connectivity task pane, select Service Recovery > View

Recovered Services.

The Service Recovery page is displayed with a list of recovered services with the

Recovered Services tab selected.

5. Select a recovered service, and click the Audit button at the top of the table of listed

services and select Configuration Audit > Run Configuration Audit.

6. In the Schedule Configuration Auditwindow, either:

• Select Audit Now, then clickOK.

An informational dialog appears, stating that the configuration audit job is

successfully triggered with the job ID, and anOK button.

• Select Audit Later, enter a date and time, then clickOK.
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7. Tomonitor the progress of an audit after selecting Audit Now, click the Job ID in the

Audit Informationwindow. The JobManagement page shows information about the

configuration audit job.

NOTE: Alternatively, todisplay the JobManagementpage, click theSystem

icon on theConnectivity Services Director banner, and selectManage Jobs

from the Tasks pane. You can also view the CSD Deployment Jobs page
in Deploymode of Service View by selecting the View Deployment Jobs

option in the task pane.

The State field indicates whether the service passed or failed the audit. If the service

failed the audit, then the Summary field provides information about the failure.

Tomonitor the progress of an audit after selecting Audit Later, after the scheduled

time of the audit:

a. On the Junos Space Network Management Platform user interface, select Jobs .

b. In the Job Types chart, select the Configuration Audit segment of the pie chart.

c. Select theconfigurationaudit of interest fromthe list on the JobManagementpage.

Summary information about the audit appears in the quick look panel.

d. In the filter bar, select the table view icon to see additional information about the

job. If the service failed the audit, information about the failure appears in the

Summary field.

8. In the Audit Informationwindow, click the job ID of the configuration audit.

The JobManagementwindow appears and shows a filtered view of the job inventory,

showing only the configuration audit job.

NOTE: If a resynchronization between a device and the Junos Space
database is ongoing when the configuration audit job starts, the
configuration audit job suspends until the resynchronization job finishes.
If the resynchronization job fails tocomplete, theaudit couldbesuspended
indefinitely. To allow the audit to proceed, go to the JobManagement

workspaceandcancel the resynchronization job, asdescribed inCanceling
a Job.

9. In theStatus column, check the status of the audit to determinewhether it succeeded

or failed.

Check the Summary column, which contains useful service information such as the

VC ID and endpoint information. For some failed deployments, this column also

contains information about why the deployment failed.
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NOTE: When a configuration audit is performed, the XPATH attributes that
are present in the service configuration are used. Only the addition,
modification, ordeletionof theXPATHattributes isdetected, and thecreation
of a new attribute (child XPATH ) on a device is not determined. The audit
operationdisregardssuchattributesanddoesnot identify them.Thisbehavior
is expected and occurs because Junos Space Platform software audits only
the settings present a user template. If the template has a container, Junos
Space Platform only audits to determine whether the device is configured
with this container. If auserwants toaudit anycontainer child, theuserneeds
add it into the template. This scenario is similar to an out-of-band
configuration change on the device, which Junos Space Platform can
determineonly if the systemof record (SOR)mode is set for the JunosSpace
Network Management Platform application.

Related
Documentation

Performing a Functional Audit on page 1019•

• Troubleshooting N-PE Devices Before Provisioning a Service on page 1030

• Modifying the Application Settings of Connectivity Services Director on page 1032

• Troubleshooting the Endpoints of Services on page 1038

• Viewing Configuration Audit Results on page 1046

• Viewing Functional Audit Results on page 1048

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052

Viewing Configuration Audit Results of Recovered Services

After performing a configuration audit of a recovered service, check the detailed results

of the audit:

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in Service View of the Connectivity Services Director banner.

The functionalities that you can configure in Build mode are displayed on the Tasks

pane.

3. In the View pane, select the Network Services > Connectivity node without expanding

the tree and selecting a type of service.

The tasks that are applicable for the different connectivity services are displayed on

the Tasks pane.

4. In the Network Services > Connectivity task pane, select Service Recovery > View

Recovered Services.
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The Service Recovery page is displayed with a list of recovered services with the

Recovered Services tab selected.

5. Select a recovered service, and click the Audit button at the top of the table of listed

services and select Configuration Audit > View Audit Results.

The configuration audit results are displayed if an audit operation was previously

performed on the selected service.

Examine the audit results formissing configuration information, and keep thewindow

open for later comparisonwith the service configuration in the JunosSpace database.

You can validate policies for the hub and spoke (1 interface).

NOTE: In the Service Configuration tab of the Configuration Audit dialog
box, you can observe several lineswith the delete statement in the service

settings. These delete statements indicate the policy attributes that are

deleted from the corresponding service on a device. Whenever a service
is created or modified, the policy options are always deleted from the
device to prevent the previously existing policies from interferingwith the
service. The presence of the delete statements is an expected behavior

and does not indicate any incorrect service configuration.

6. To view the service configuration in the Junos Space database, in Deploy mode, from

the Network Services > Connectivity task pane, select Service Provisioning > Deploy

Services. The Manage Service Deployment page is displayed on the bottom part of

the right pane. Select a service from theManageServiceDeployment page, then in the

Actionsmenu, select View Service Configuration.

A newwindow opens and shows the service configuration.

If a CFM is configured in E-Line service or E-LAN service, the configuration audit result

displays the CFM configuration details.

7. Compare the contents of the Service Configuration with those of the Configuration

Audit Resultswindow for each device in turn. If you see discrepancies, then it is likely

that the service configuration wasmodified out-of-band. If so, youmight need to

synchronize the device with the Junos Space database.

For step-by-step instructions about synchronizing devices, see Resynchronizing

Managed Devices with the Network for details.

After the audit job is completed, you can view the output of the operation in the

Configuration Audit Results window that is displayed on the right pane. The left pane

displays a tree of devices associated with the specified service. You can select a

Service-name> Interface-nameDevice-name in the left paneof thewindow.Theattribute

definitions and parameters defined in the service are displayed in the right pane. The

right pane contains three tabs— Service Configuration, Template Configuration, and

AuditResults. TheServiceConfiguration tabdisplays the settings specified for the service
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on the device in CLI format. This tab displays the elements or components specified for

a service template in the form of configuration stanzas and hierarchy levels. This display

is similar to the show command that you can use at a certain [edit] hierarchy level to

view the defined settings. The Template Configuration tab displays the service attributes

and options defined in the service template, if any, that is associated with the service.

The Audit Results tab displays the status of the audit job that was run, such as whether

the job succeeded or failed. You can also view the service definition and associated

template details under the Service Config and Template Config tabs in Junos OS XML

API format, instead of the CLI format.

Click theShowXMLConfig button at the top-right corner of thewindow to view the audit

results inXMLAPI format.Alternatively, click theShowSetbutton toviewtheaudit results

in themanner inwhich theyaredisplayed in the JunosOSCLI interface.TheShowXML/Set

button is a toggle button.

The JunosOScommand-line interface(CLI)andthe JunosOS infrastructurecommunicate

using XML. When you issue an operational mode command in the CLI, the CLI converts

the command into XML format for processing. After processing, Junos OS returns the

output in the form of an XML document, which the CLI converts back into a readable

format for display. Remote client applications also use XML-based data encoding for

operational and configuration requests on devices running JunosOS. The Junos XMLAPI

is an XML representation of Junos configuration statements and operational mode

commands. It defines an XML equivalent for all statements in the Junos configuration

hierarchy andmany of the commands that you issue in CLI operational mode. Each

operationalmodecommandwitha JunosXMLcounterpartmaps toa request tagelement

and, if necessary, a response tag element.

ClickReloadResultat the top-right corner of thewindowto refreshanddisplay the results

of theaudit.Whenyouclick this button, only theoutput of theaudit operation is displayed

afresh and the audit job is not run again. You can refresh the results only for completed

audit instances. When you select Service-name in the left pane of the window, service

status information is displayed in the right pane. Click Run Configuration Audit after

selecting the services you need to run the audit job again.

Configuration audit can be run for multiple services from Build mode of Service View of

the Connectivity Services Director GUI. From the Manage Network Services page, select

the check boxes beside multiple srvices, click the Audit button at the top of the table of

configured services, and select Run Configuration Audit from the drop-downmenu.

We recommend that you configure a script as a local script for effective and optimal

debugging and analysis of the configuration settings contained in the script. Themain

advantage of a local script is that you need not download the script to a device (because

a connection is established with the device by the GUI application and the script is run)

and you need not remove the script from a device after you decommision a service.

Related
Documentation

Viewing Functional Audit Results on page 1048•

• Performing a Functional Audit on page 1019

• Performing a Configuration Audit on page 1027
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RecoveringModifications and Deletions Performed for Existing Endpoints

Until Connectivity Services Director Release 1.0R2, the service recovery operation did not

support the recovery of updated configurations made on existing endpoints associated

with services. The only supported operations were recovery of new services and new

endpoints for existing services, and recovery of connectivity fault management (CFM)

profiles.

Starting with Release 2.0R1, the following recovery operations are supported in addition:

• Recovering modifications to existing endpoints

• Recovering endpoint deletions for a service

Also, recovery of the swap of hubs and spokes for hub-and-spoke IP and E-LAN services

are supported. In addition, recovery of changes in configuration of backup endpoints for

point-to-point A and Z endpoints is supported.

Recovery of templates, recovery for devices with different Junos OS versions running on

them, and recovery of class of service (CoS) profiles are not supported.

Recovering Parameters for E-Line Services

Table 63 on page 428 describes the fields or parameters that are supported for recovery

during a service recovery operation and the corresponding XPath notifications for those

configurationparameters. This tablealsodenotes the serviceoperation that is supported,

such as creation, edit, or deletion of a service

Table 63: Mapping of Parameters, XPaths, and Supported Operations for E-Line Services

Supported
OperationXPathField

Modify serviceconfiguration/interfaces/interface/mtuInterface MTU

Modify service/configuration/firewall/policer/if-exceeding/bandwidth-limitInterface
bandwidth

Modify service/configuration/interfaces/unit/vlan-tags/inner-rangeStarting C-VLAN
ID in a range

Modify service/configuration/interfaces/unit/vlan-tags/inner-rangeEnding C-VLAN ID
in a range

Modify service/configuration/interfaces/unit/vlan-tags/inner (Q-in-Q)C-VLAN ID

Modify service/configuration/interfaces/unit/vlan-tags/outer (Q-in-Q)

/configuration/interfaces/unit/vlan-id (Dot1Q)

V-LAN ID

Create, modify, and
delete service

/configuration/interfaces/interface/unit/input-vlan-map/tag-protocol-id

/configuration/interfaces/interface/unit/output-vlan-map/tag-protocol-id

Outer TPID
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Table 63: Mapping of Parameters, XPaths, and Supported Operations for E-Line Services (continued)

Supported
OperationXPathField

Create, modify, and
delete service

/configuration/interfaces/interface/unit/input-vlan-map/inner-tag-protocol-id

/configuration/interfaces/interface/unit/output-vlan-map/inner-tag-protocol-id

Inner TPID

Create, modify, and
delete service

/configuration/protocols/l2circuit/neighbor/interface/community

/configuration/policy-options/policy-statement/term/then/install-nexthop/lsp

Endpoint LSP
association

Create, modify, and
delete service

/configuration/interfaces/interface/unit/descriptionInterface
description

Not applicableNot supportedChanging,
disabling, and
enabling CFM
profile

Recovering Parameters for IP Services

Table 64 on page 429 describes the fields or parameters that are supported for recovery

during a service recovery operation and the corresponding XPath notifications for those

configurationparameters. This tablealsodenotes the serviceoperation that is supported,

such as creation, edit, or deletion of a service

Table 64: Mapping of Parameters, XPaths, and Supported Operations for IP Services

Supported OperationXPathField

Modify serviceconfiguration/interfaces/interface/mtuInterface MTU

Modify service/configuration/firewall/policer/if-exceeding/bandwidth-limitInterface bandwidth

Modify service/configuration/interfaces/unit/vlan-tags/inner-rangeStarting C-VLAN ID in a range

Modify service/configuration/interfaces/unit/vlan-tags/inner-rangeEnding C-VLAN ID in a range

Modify service/configuration/interfaces/unit/vlan-tags/inner (Q-in-Q)C-VLAN ID

Modify service/configuration/interfaces/unit/vlan-tags/outer (Q-in-Q)

/configuration/interfaces/unit/vlan-id (dot1Q)

V-LAN ID

Create, modify, and delete serviceGets prefixed to VLAN tags, for example:

<vlan-tags>        
<outer>0x88a8.51</outer>        
<inner-range>0x9100.56-65</inner-range> 
</vlan-tags> 

Outer TPID
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Table 64: Mapping of Parameters, XPaths, and Supported Operations for IP Services (continued)

Supported OperationXPathField

Create, modify, and delete service
<vlan-tags>        
<outer>0x88a8.51</outer>        
<inner-range>0x9100.56-65</inner-range> 
</vlan-tags> 

Inner TPID

Not applicableNot supportedMAC table size

Not applicableNot supportedInterface MAC limit

Not applicableNot supportedMesh group name change

Create, modify, and delete service/configuration/interfaces/interface/unit/descriptionInterface description

Create and delete serviceAdditionofpoint-to-point spokeandupdateofneighbor
in hub are supported

/configuration/routing-instances/instance/instance/protocols/vpls/mesh-group/vpls-id

/configuration/routing-instances/instance/instance/protocols/vpls/mesh-group/neighbor

PWextension (BGP and LDP)

Create and delete serviceAdditionofabackuphubandupdateofneighbordetails
in point-to-point spoke and E-LAN LDP spoke are
supported

Update of neighbor to primary hub is not supported

/configuration/routing-instances/instance/protocols/vpls/neighbor/backup-neighbor/name
for LDP spoke

/configuration/protocols/l2circuit/neighbor/interface/backup-neighbor/name
for point-to-point spoke

PW resiliency (LDP)

Not applicableNot supportedChanging, disabling, and
enabling CFM profile

Recovering Parameters for E-LAN Services

Table 65 on page 430 describes the fields or parameters that are supported for recovery

during a service recovery operation and the corresponding XPath notifications for those

configurationparameters. This tablealsodenotes the serviceoperation that is supported,

such as creation, edit, or deletion of a service

Table 65: Mapping of Parameters, XPaths, and Supported Operations for E-LAN Services

Supported OperationXPathField

Modify serviceconfiguration/interfaces/interface/mtuInterface MTU

Modify service/configuration/firewall/policer/if-exceeding/bandwidth-limitInterface bandwidth
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Table 65: Mapping of Parameters, XPaths, and Supported Operations for E-LAN Services (continued)

Supported OperationXPathField

Not applicableNot supportedTagging

Modify service/configuration/interfaces/unit/vlan-tags/inner-rangeStarting C-VLAN ID in a range

Modify service/configuration/interfaces/unit/vlan-tags/inner-rangeEnding C-VLAN ID in a range

Modify service/configuration/interfaces/unit/vlan-tags/inner
(Q-in-Q)

C-VLAN ID

Modify service/configuration/interfaces/unit/vlan-tags/outer
(Q-in-Q)

/configuration/interfaces/unit/vlan-id
(dot1Q)

V-LAN ID

Modify service/configuration/interfaces/interface/unit/family/inet/address/nameIP address

Modify service/configuration/routing-instances/instance/protocols/bgp/group/neighbor/nameNeighbor IP address

Create andmodify service/configuration/routing-instances/instance/protocols/bgp/group/peer-asPeer AS

Create, modify, and delete service/configuration/routing-instances/instance/protocols/bgp/group/as-overrideAS override

Create, modify, and delete service/configuration/interfaces/interface/unit/descriptionInterface description

Not applicableNot supportedStatic routes (destination prefix, next
hop)

Not applicableNot supportedEnable or disable of MVPN andMC-LAG
(addition of MVPN capability to an
existing L3VPN)

Not applicableNot supportedPE-CESettings,OSPFDomain ID, version

Not applicableBoth services must be recovered
individually according to the current
behavior

Stitching into an E-Line service

Not applicableNot supportedRoute distinguisher (full-mesh OSPF_

Recovering Endpoint Deletions from a Service

The following scenarios are supportedwhen recovering endpoint deletion froma service:

• Recovery of a deleted endpoint for multipoint-to-multipoint E-LAN and full-mesh IP

services

• Recovery of a deleted spoke for point-to-multipoint E-LAN and hub-and-spoke IP

services
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Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

REST API Changes in Connectivity Services Director for Service Recovery

Theprevious implementationofServiceRecovery inServicesActivationDirector contained

three different REST APIs to create a service request report. The three REST APIs were

as follows:

PUT method
 @Path("/deviceList")
 @Consumes({ "application/json" })
 public void putDeviceList(List<DeviceBean> deviceList);

PUT method
 @Path("/sdList")
 @Consumes({ "application/json" })
 public void putServiceDefinitionList(List<ServiceDefinitionBean> sdList);

POST method
 @Path("/start")
 @Consumes({ "application/x-www-form-urlencoded", "application/json" })
 public Response startServiceRecovery(ServiceRecoveryProfileBean svcRecProfileBean,

   @Context HttpServletRequest request);

In Connectivity Services Director, all these three REST APIs for creating a service request

report are being merged into one REST API as follows:

POST method
 @Path("/startServiceRecovery")
 @Consumes({ "application/x-www-form-urlencoded", "application/json" })
public Response startServiceRecovery_V2(ServiceRecoveryProfileBean 
svcRecProfileBean, List<DeviceBean> deviceList, (List<ServiceDefinitionBean> 
sdList, @Context 
HttpServletRequest request);

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•
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Sample XPath Notifications Received on Devices for Deleted Endpoints

For endpoints that are removed from a service, such as an E-LAN service, the changed

XPath list contains the following values for removedendpoint,which includes the routing

instance along with its logical unit of the interface, firewall, and policy, that are deleted

from the device.

The following are the changed XPath attributes:

/configuration/routing-instances/instance/protocols/vpls/mac-table-size/limit,
 /configuration/firewall/family/vpls/filter/term/name,
 /configuration/firewall/policer/if-exceeding/bandwidth-limit,
 /configuration/firewall/policer/if-exceeding/burst-size-limit
 /configuration/interfaces/interface/unit/name
 /configuration/routing-instances/instance/interface/name
 /configuration/routing-instances/instance/instance-type
 /configuration/firewall/policer/name
 /configuration/routing-instances/instance/protocols/vpls/site/interface/name
 /configuration/routing-instances/instance/protocols/vpls/site/site-preference 
 /configuration/interfaces/interface/unit/vlan-id 
 /configuration/interfaces/interface/unit/family/vpls/filter/input/filter-name
 /configuration/routing-instances/instance/route-distinguisher/rd-type
 /configuration/routing-instances/instance/name
 /configuration/interfaces/interface/unit/encapsulation
 /configuration/routing-instances/instance/vrf-export
 /configuration/routing-instances/instance/protocols/vpls/no-mac-learning
 /configuration/firewall/policer/then/discard
 /configuration/routing-instances/instance/protocols/vpls/site/site-identifier
 /configuration/routing-instances/instance/protocols/vpls/interface-mac-limit/limit

 /configuration/firewall/family/vpls/filter/name
 /configuration/routing-instances/instance/protocols/vpls/no-tunnel-services
 /configuration/firewall/family/vpls/filter/interface-specific 
/configuration/firewall/family/vpls/filter/term/then/policer 
 /configuration/firewall/family/vpls/filter/term/then/accept 
 /configuration/routing-instances/instance/protocols/vpls/site/name
 /configuration/routing-instances/instance/vrf-import

The following is the differential configuration set for the XPath attributes:

<?xml version="1.0" encoding="UTF-8"?>
<rpc-reply op="U">
  <configuration op="U">
    <interfaces op="U">
      <interface op="U">
        <name>ge-0/1/7</name>
        <flexible-vlan-tagging/>
        <mtu>1522</mtu>
        <encapsulation>flexible-ethernet-services</encapsulation>
        <unit op="D">
          <name op="D">29</name>
          <encapsulation op="D">vlan-vpls</encapsulation>
          <vlan-id op="D">34</vlan-id>
          <family op="D">
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            <vpls op="D">
              <filter op="D">
                <input op="D">
                  <filter-name op="D">filter_in_ge-0/1/7_29</filter-name>
                </input>
              </filter>
            </vpls>
          </family>
        </unit>
      </interface> 
    </interfaces>
    <firewall op="U">
      <family op="U">
        <vpls op="U">
          <filter op="D">
            <name op="D">filter_in_ge-0/1/7_29</name>
            <interface-specific op="D"/>
            <term op="D">
              <name op="D">1</name>
              <then op="D">
                <policer op="D">policer_in_ge-0/1/7_29</policer>
                <accept op="D"/>
              </then>
            </term>
          </filter>
          <filter op="D">
            <name op="D">filter_in_ge-0/1/8_102</name>
            <interface-specific op="D"/>
            <term op="D">
              <name op="D">1</name>
              <then op="D">
                <policer op="D">policer_in_ge-0/1/8_102</policer>
                <accept op="D"/>
              </then>
            </term>
          </filter>
        </vpls>
      </family>
      <policer op="D">
        <name op="D">policer_in_ge-0/1/7_29</name>
        <if-exceeding op="D">
          <bandwidth-limit op="D">10m</bandwidth-limit>
          <burst-size-limit op="D">15220</burst-size-limit>
        </if-exceeding>
        <then op="D">
          <discard op="D"/>
        </then>
      </policer>
      <policer op="D">
        <name op="D">policer_in_ge-0/1/8_102</name>
        <if-exceeding op="D">
          <bandwidth-limit op="D">10m</bandwidth-limit>
          <burst-size-limit op="D">15220</burst-size-limit>
        </if-exceeding>
        <then op="D">
          <discard op="D"/>
        </then>
      </policer>
    </firewall>
    <routing-instances op="U">
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      <instance op="D">
        <name op="D">VplsBgpPW</name>
        <instance-type op="D">vpls</instance-type>
        <interface op="D">
          <name op="D">ge-0/1/7.29</name>
        </interface>
        <route-distinguisher op="D">
          <rd-type op="D">36000:23</rd-type>
        </route-distinguisher>
        <vrf-import op="D">VplsBgpPW-import</vrf-import>
        <vrf-export op="D">VplsBgpPW-export</vrf-export>
        <protocols op="D">
          <vpls op="D">
            <mac-table-size op="D">
              <limit op="D">5120</limit>
            </mac-table-size>
            <interface-mac-limit op="D">
              <limit op="D">1024</limit>
            </interface-mac-limit>
            <no-mac-learning op="D"/>
            <no-tunnel-services op="D"/>
            <site op="D">
              <name op="D">Site_2</name>
              <site-identifier op="D">2</site-identifier>
              <site-preference op="D">primary</site-preference>
              <interface op="D">
                <name op="D">ge-0/1/7.29</name>
              </interface>
            </site>
          </vpls>
        </protocols>
      </instance>
    </routing-instances>
  </configuration>
</rpc-reply>

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•
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Sample XPath Notifications Received on Devices for a Modified E-LAN Service

While developing configlets, XPaths and Regular Expressions would be used intensively.

Itwouldbedesirable to let theuserdefine frequentlyusedXPathsandRegular expressions

in such a way that they can be referred when required. User can define these templates

from theXpath andRegex task group in the CLI Configletsworkspace of the Junos Space

Platform GUI. For an E-LAN service that is modified using the Connectivity Services

Director application, the XPath attributes corresponding to the modified configuration

settings and parameters are sent to the associated devices of the service for the revised

configuration elements to be applied on the devices. This topic illustrates the differential

configuration,which is thedeltaor the change-set of the configuration that youareabout

todeployon thedevices, and theXPathattributesassociatedwith thedelta configuration

for a modified E-LAN service:

The following is the changed XPath attribute for a routing instance of a modified E-LAN

service:

/configuration/routing-instances/instance/route-distinguisher/rd-type

The following is the differential configuration set for the XPath attribute for a routing

instance of a modified E-LAN service:

<?xml version="1.0" encoding="UTF-8"?>
<rpc-reply op="U">
<configuration op="U">
<routing-instances op="U">
      <instance op="U">
        <name>VplsBasicSO</name>
        <instance-type>vpls</instance-type>
        <interface>
          <name>ge-0/1/4.69</name>
        </interface>
        <route-distinguisher op="U">
          <rd-type op="U">36001:7</rd-type>
        </route-distinguisher>
        <vrf-target>
          <community>target:36000:6</community>
        </vrf-target>
        <protocols>
          <vpls>
            <mac-table-size>
              <limit>5120</limit>
            </mac-table-size>
            <interface-mac-limit>
              <limit>1024</limit>
            </interface-mac-limit>
            <no-tunnel-services/>
            <site>
              <name>Site_1</name>
              <site-identifier>1</site-identifier>
              <site-preference>primary</site-preference>
              <interface>
                <name>ge-0/1/4.69</name>
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              </interface>
            </site>
          </vpls>
        </protocols>
      </instance>
    </routing-instances>
  </configuration>
</rpc-reply>

For thepolicy-statement statementat the [editpolicy-options]hierarchy level, the correct

XPath Notification is not received if changes happen only to the policy-statement. The

notificationdoes not contain the changedXPath and configurationdifference. Therefore,

it is not possible to determine the instance of service impacted due to the change (when

only localized topolicy-options->policy-statement). Full service recovery is recommended

in such cases.

The following is the changed XPath attribute for physical interfaces:

/configuration/interfaces/interface

The following is theconfigurationdifference for theXPathattributeofphysical interfaces:

<?xml version="1.0" encoding="UTF-8"?>
<rpc-reply op="U">
  <configuration op="U">
    <system>
      <services/>
    </system>
    <chassis/>
    <interfaces op="U">
      <interface op="U">
        <name>ge-0/0/5</name>
        <flexible-vlan-tagging/>
        <mtu op="U">1520</mtu>
        <encapsulation>flexible-ethernet-services</encapsulation>
        <unit>
          <name>29</name>
          <encapsulation>vlan-vpls</encapsulation>
          <vlan-tags>
            <outer>34</outer>
          </vlan-tags>
          <family>
            <vpls>
              <filter>
                <input>
                  <filter-name>filter_in_ge-0/0/5_29</filter-name>
                </input>
              </filter>
            </vpls>
          </family>
        </unit>
      </interface>
    </interfaces>
   </configuration>
</rpc-reply>
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The following is the changed XPath attribute for the logical unit of an interface:

/configuration/interfaces/interface/unit/vlan-tags/outer

The following is the configuration difference for the XPath attribute of logical unit of an

interface:

<?xml version="1.0" encoding="UTF-8"?>
<rpc-reply op="U">
  <configuration op="U">
    <system>
      <services/>
    </system>
    <chassis/>
    <interfaces op="U">
      <interface op="U">
        <name>ge-0/0/5</name>
        <flexible-vlan-tagging/>
        <mtu>1522</mtu>
        <encapsulation>flexible-ethernet-services</encapsulation>
        <unit op="U">
          <name>29</name>
          <encapsulation>vlan-vpls</encapsulation>
          <vlan-tags op="U">
            <outer op="U">34</outer>
          </vlan-tags>
          <family>
            <vpls>
              <filter>
                <input>
                  <filter-name>filter_in_ge-0/0/5_29</filter-name>
                </input>
              </filter>
            </vpls>
          </family>
        </unit>
      </interface>
    </interfaces>
    </configuration>
</rpc-reply>

The following are the changed XPath attributes for a firewall filter at the [edit firewall

family vpls] hierarchy level:

/configuration/firewall/family/vpls/filter/term/then/discard, 
        /configuration/firewall/family/vpls/filter/term/name

The following is the configuration difference for the XPath attribute of a firewall filter in

an E-LAN family:

<?xml version="1.0" encoding="UTF-8"?>
<rpc-reply op="U">
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  <configuration op="U">
    <system>
      <services/>
    </system>
    <chassis/>
    <interfaces op="U">
      <interface op="U">
        <name>ge-0/0/5</name>
        <flexible-vlan-tagging/>
        <mtu op="U">1520</mtu>
        <encapsulation>flexible-ethernet-services</encapsulation>
        <unit>
          <name>29</name>
          <encapsulation>vlan-vpls</encapsulation>
          <vlan-tags>
            <outer>34</outer>
          </vlan-tags>
          <family>
            <vpls>
              <filter>
                <input>
                  <filter-name>filter_in_ge-0/0/5_29</filter-name>
                </input>
              </filter>
            </vpls>
          </family>
        </unit>
      </interface>
    </interfaces>
   </configuration>
</rpc-reply>

The following are the changed XPath attributes for the policer statement at the [edit

firewall] hierarchy level:

/configuration/firewall/policer/if-exceeding/bandwidth-percent
/configuration/firewall/policer/if-exceeding/bandwidth-limit

The following is the configuration difference for the XPath attribute of a firewall policer:

<?xml version="1.0" encoding="UTF-8"?>
<rpc-reply op="U">
  <configuration op="U">
    <system>
      <services/>
    </system>
    <chassis/>
    <interfaces op="U">
      <interface op="U">
        <name>ge-0/0/5</name>
        <flexible-vlan-tagging/>
        <mtu op="U">1520</mtu>
        <encapsulation>flexible-ethernet-services</encapsulation>
        <unit>
          <name>29</name>
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          <encapsulation>vlan-vpls</encapsulation>
          <vlan-tags>
            <outer>34</outer>
          </vlan-tags>
          <family>
            <vpls>
              <filter>
                <input>
                  <filter-name>filter_in_ge-0/0/5_29</filter-name>
                </input>
              </filter>
            </vpls>
          </family>
        </unit>
      </interface>
    </interfaces>
   </configuration>
</rpc-reply>

The service instance cannot be determined if the changes to policer occur and in such

cases ,you need to determine the type of service and also identify whether the change

is to existing service or a new service. You can select a service instance and the operation

type (suchas createormodify) to recover service for that endpoint.Using changedXPath

and applying the differential configuration to the changed XPath, you can determine the

type of change and the name of the changed configuration parameter.

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

Sample XPath Notifications Received on Devices for a Created E-LAN Service

This topic illustrates the differential configuration, which is the delta or the change-set

of the configuration that youare about to deploy on thedevices, and theXPath attributes

associated with the delta configuration for a newly created E-LAN service:

The followingare theconfiguration stanzasanddevice settings for anewly createdE-LAN

service at the different hierarchy levels of the CLI interface:

[edit interfaces ge-0/1/7]
unit 29 {
encapsulation vlan-vpls;
vlan-id 34;
family vpls {
filter {
input filter_in_ge-0/1/7_29;

}
}

}

[edit firewall family vpls]
filter filter_in_ge-0/1/8_102 { ... }
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filter filter_in_ge-0/1/7_29 {
interface-specific;
term 1 {
then {
policer policer_in_ge-0/1/7_29;
accept;

}
}

}

[edit firewall]
policer policer_in_ge-0/1/8_102 { ... }
policer policer_in_ge-0/1/7_29 {
if-exceeding {
bandwidth-limit 10m;
burst-size-limit 1g;

}
then discard;

}

[edit routing-instances]
VplsBgpPW {
instance-type vpls;
interface ge-0/1/7.29;
route-distinguisher 36000:23;
vrf-import VplsBgpPW-import;
vrf-export VplsBgpPW-export;
protocols {
vpls {
mac-table-size {
5120;

}
interface-mac-limit {
1024;

}
no-mac-learning;
no-tunnel-services;
site Site_2 {
site-identifier 2;
site-preference primary;
interface ge-0/1/7.29;

}
}

}
}

The following are the changed XPath attributes for a newly created E-LAN service:

/configuration/routing-instances/instance/protocols/vpls/mac-table-size/limit 
/configuration/firewall/family/vpls/filter/term/name
/configuration/firewall/policer/if-exceeding/burst-size-limit
/configuration/interfaces/interface/unit/name
/configuration/routing-instances/instance/interface/name
/configuration/routing-instances/instance/instance-type
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/configuration/firewall/policer/name
/configuration/routing-instances/instance/protocols/vpls/site/interface/name
/configuration/routing-instances/instance/protocols/vpls/site/site-preference
/configuration/interfaces/interface/unit/vlan-id
/configuration/interfaces/interface/unit/family/vpls/filter/input/filter-name
/configuration/routing-instances/instance/route-distinguisher/rd-type
/configuration/routing-instances/instance/name
/configuration/interfaces/interface/unit/encapsulation
/configuration/routing-instances/instance/vrf-export
/configuration/routing-instances/instance/protocols/vpls/no-mac-learning
/configuration/firewall/policer/then/discard
/configuration/routing-instances/instance/protocols/vpls/site/site-identifier
/configuration/routing-instances/instance/protocols/vpls/interface-mac-limit/limit
/configuration/firewall/family/vpls/filter/name
/configuration/routing-instances/instance/protocols/vpls/no-tunnel-services
/configuration/firewall/family/vpls/filter/interface-specific
/configuration/firewall/family/vpls/filter/term/then/policer
/configuration/firewall/family/vpls/filter/term/then/accept
/configuration/routing-instances/instance/protocols/vpls/site/name
/configuration/routing-instances/instance/vrf-import

The following is the differential configuration set for the XPath attributes of a newly

created E-LAN service:

<?xml version="1.0" encoding="UTF-8"?>
<rpc-reply op="U">
  <configuration op="U">
    <interfaces op="U">
      <interface op="U">
        <name>ge-0/1/7</name>
        <flexible-vlan-tagging/>
        <mtu>1522</mtu>
        <encapsulation>flexible-ethernet-services</encapsulation>
        <unit op="C">
          <name op="C">29</name>
          <encapsulation op="C">vlan-vpls</encapsulation>
          <vlan-id op="C">34</vlan-id>
          <family op="C">
            <vpls op="C">
              <filter op="C">
                <input op="C">
                  <filter-name op="C">filter_in_ge-0/1/7_29</filter-name>
                </input>
              </filter>
            </vpls>
          </family>
        </unit>
      </interface>
    </interfaces>
    <firewall op="U">
      <family op="U">
        <vpls op="U">
          <filter op="C">
            <name op="C">filter_in_ge-0/1/7_29</name>
            <interface-specific op="C"/>
            <term op="C">
              <name op="C">1</name>
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              <then op="C">
                <policer op="C">policer_in_ge-0/1/7_29</policer>
                <accept op="C"/>
              </then>
            </term>
          </filter>
        </vpls>
      </family>
      <policer op="C">
        <name op="C">policer_in_ge-0/1/7_29</name>
        <if-exceeding op="C">
          <bandwidth-limit op="C">10m</bandwidth-limit>
          <burst-size-limit op="C">1g</burst-size-limit>
        </if-exceeding>
        <then op="C">
          <discard op="C"/>
        </then>
      </policer>
    </firewall>
    <routing-instances op="U">
      <instance op="C">
        <name op="C">VplsBgpPW</name>
        <instance-type op="C">vpls</instance-type>
        <interface op="C">
          <name op="C">ge-0/1/7.29</name>
        </interface>
        <route-distinguisher op="C">
          <rd-type op="C">36000:23</rd-type>
        </route-distinguisher>
        <vrf-import op="C">VplsBgpPW-import</vrf-import>
        <vrf-export op="C">VplsBgpPW-export</vrf-export>
        <protocols op="C">
          <vpls op="C">
            <mac-table-size op="C">
              <limit op="C">5120</limit>
            </mac-table-size>
            <interface-mac-limit op="C">
              <limit op="C">1024</limit>
            </interface-mac-limit>
            <no-mac-learning op="C"/>
            <no-tunnel-services op="C"/>
            <site op="C">
              <name op="C">Site_2</name>
              <site-identifier op="C">2</site-identifier>
              <site-preference op="C">primary</site-preference>
              <interface op="C">
                <name op="C">ge-0/1/7.29</name>
              </interface>
            </site>
          </vpls>
        </protocols>
      </instance>
    </routing-instances>
  </configuration>
</rpc-reply>

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•
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Sample XPath Notifications Received on Devices for a Created IP Service

This topic illustrates the differential configuration, which is the delta or the change-set

of the configuration that youare about to deploy on thedevices, and theXPath attributes

associated with the delta configuration for a newly created IP service:

The following is the changed XPath attribute for routing instances of a newly created IP

service:

/configuration/routing-instances/instance/route-distinguisher/rd-type

For thepolicy-statement statementat the [editpolicy-options]hierarchy level, the correct

XPath Notification is not received if changes happen only to the policy-statement. The

notificationdoes not contain the changedXPath and configurationdifference. Therefore,

it is not possible to determine the instance of service impacted due to the change (when

only localized topolicy-options->policy-statement). Full service recovery is recommended

in such cases.

The following is the changed XPath attribute for physical interfaces:

/configuration/interfaces/interface/mtu

The following is the changed XPath attribute for the logical unit of interfaces:

/configuration/interfaces/interface/unit/description

The following are the changed XPath attributes for the policer statement at the [edit

firewall] hierarchy level:

/configuration/firewall/policer/if-exceeding/bandwidth-percent
/configuration/firewall/policer/if-exceeding/bandwidth-limit

The service instance cannot be determined if the changes to policer occur and in such

cases ,you need to determine the type of service and also identify whether the change

is to existing service or a new service. You can select a service instance and the operation

type (suchas createormodify) to recover service for that endpoint.Using changedXPath

and applying the differential configuration to the changed XPath, you can determine the

type of change and the name of the changed configuration parameter.

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•
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Sample XPath Notifications Received on Devices for a Created E-Line Service

This topic illustrates the differential configuration, which is the delta or the change-set

of the configuration that youare about to deploy on thedevices, and theXPath attributes

associated with the delta configuration for a newly created E-Line service. The following

two scenarios need to be handled for E-Line services. Accordingly, the mechanism to

identify impacted services is implemented.

• A or Z endpoint of the existing service

• A pseudowire extension for E-LAN or E-LAN services

The following is the changed XPath attribute for Layer 2 circuit of a newly created E-Line

service:

/configuration/protocols/l2circuit/neighbor/interface/description

The following is the configuration difference corresponding to the XPath attribute for

Layer 2 circuit:

<protocols op="U">
      <l2circuit op="U">
        <neighbor op="U">
          <name>128.220.3.158</name>
          <interface>
            <name>ge-0/1/5.560</name>
            <virtual-circuit-id>1</virtual-circuit-id>
            <mtu>1522</mtu>
          </interface>
          <interface>
            <name>ge-0/1/5.512</name>
            <virtual-circuit-id>2</virtual-circuit-id>
            <mtu>1522</mtu>
          </interface>
          <interface op="U">
            <name>ge-0/0/3.0</name>
            <virtual-circuit-id>221</virtual-circuit-id>
            <description op="U">TestP2P2</description>
            <community>R2-to-R1</community>
            <mtu>1522</mtu>
          </interface>
        </neighbor>
    </l2circuit>
 </protocols>

For thepolicy-statement statementat the [editpolicy-options]hierarchy level, the correct

XPath Notification is not received if changes happen only to the policy-statement. The

notificationdoes not contain the changedXPath and configurationdifference. Therefore,

it is not possible to determine the instance of service impacted due to the change (when

only localized topolicy-options->policy-statement). Full service recovery is recommended

in such cases.
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The following is the changed XPath attribute for physical interfaces:

/configuration/interfaces/interface/mtu

The following is the changed XPath attribute for the logical unit of interfaces:

/configuration/interfaces/interface/unit/description

The following are the changed XPath attributes for the policer statement at the [edit

firewall] hierarchy level:

/configuration/firewall/policer/if-exceeding/bandwidth-percent
/configuration/firewall/policer/if-exceeding/bandwidth-limit

The followingare thechangedXPathattributes for the filter statementat the [edit firewall

family family-name filter filter-name term term-name] hierarchy level

/configuration/firewall/filter 

The service instance cannot be determined if the changes to policer occur and in such

cases ,you need to determine the type of service and also identify whether the change

is to existing service or a new service. You can select a service instance and the operation

type (suchas createormodify) to recover service for that endpoint.Using changedXPath

and applying the differential configuration to the changed XPath, you can determine the

type of change and the name of the changed configuration parameter.

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

Sample XPath Notifications Received on Devices for CFMProfiles Associatedwith an
E-Line Service

This topic illustrates the differential configuration, which is the delta or the change-set

of the configuration that youare about to deploy on thedevices, and theXPath attributes

associatedwith thedelta configuration forCFMprofiles associatedwithanE-Line service:

The following is the changed XPath attribute for CFM profiles of an E-Line service:

/configuration/protocols/oam/ethernet/connectivity-fault-management/maintenance-domain/
maintenance-association/continuity-check/loss-threshold
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The following is the configuration difference corresponding to the XPath attribute for

CFM profiles associated with an E-Line service:

<protocols op="U">
      <oam op="U">
        <ethernet op="U">
          <connectivity-fault-management op="U">
            <maintenance-domain op="U">
              <name>Default-Domain</name>
              <level>1</level>
              <maintenance-association>
                <name>PW_1001_P2P-CFM992015-12-30-05</name>
                <continuity-check>
                  <interval>1s</interval>
                  <loss-threshold>3</loss-threshold>
                  <hold-interval>10</hold-interval>
                </continuity-check>
                <mep>
                  <name>1</name>
                  <interface>
                    <interface-name>ge-0/0/5.1</interface-name>
                  </interface>
                  <direction>up</direction>
                  <auto-discovery/>
                  <lowest-priority-defect>all-defects</lowest-priority-defect>
                </mep>
              </maintenance-association>
              <maintenance-association>
                <name>PW_101_P2P-Asym-CFM2015-12-30-</name>
                <continuity-check>
                  <interval>1s</interval>
                  <loss-threshold>3</loss-threshold>
                  <hold-interval>10</hold-interval>
                </continuity-check>
                <mep>
                  <name>3</name>
                  <interface>
                    <interface-name>ge-0/0/4.0</interface-name>
                  </interface>
                  <direction>up</direction>
                  <auto-discovery/>
                  <lowest-priority-defect>all-defects</lowest-priority-defect>
                </mep>
              </maintenance-association>
              <maintenance-association op="U">
                <name>PW_221_P2PService1</name>
                <continuity-check op="U">
                  <interval>1s</interval>
                  <loss-threshold op="U">5</loss-threshold>
                  <hold-interval>10</hold-interval>
                </continuity-check>
                <mep>
                  <name>1</name>
                  <interface>
                    <interface-name>ge-0/0/2.0</interface-name>
                  </interface>
                  <direction>up</direction>
                  <auto-discovery/>
                  <lowest-priority-defect>all-defects</lowest-priority-defect>
                </mep>
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              </maintenance-association>
            </maintenance-domain>
          </connectivity-fault-management>
        </ethernet>
      </oam>
    </protocols>

Related
Documentation

Creating and Handling a Service Recovery Request on page 398•

Sample XPath Notifications Received on Devices for CoS Profiles Associatedwith an
E-Line Service

This topic illustrates the differential configuration, which is the delta or the change-set

of the configuration that youare about to deploy on thedevices, and theXPath attributes

associatedwith thedeltaconfiguration forCoSprofilesassociatedwithanE-Lineservice:

The following is the changed XPath attribute for CoS profiles of an E-Line service:

/configuration/class-of-service/interfaces/interface/shaping-rate/rate

The following is the configuration difference corresponding to the XPath attribute for

CoS profiles associated with an E-Line service:

<class-of-service op="U">
      <interfaces op="U">
        <interface op="U">
          <name>ge-0/0/3</name>
          <scheduler-map>nd_schedulerMap</scheduler-map>
          <unit>
            <name>513</name>
            <classifiers>
              <dscp>
                <name>dscp_nd_classifer</name>
              </dscp>
            </classifiers>
          </unit>
          <shaping-rate op="C">
            <rate op="C">160001</rate>
          </shaping-rate>
        </interface>
      </interfaces>
    </class-of-service>

Related
Documentation

• Creating and Handling a Service Recovery Request on page 398
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PART 7

Service Design: Working with Service
Definitions

• Service Design: Predefined Service Definitions on page 451

• Service Design: Managing E-Line Service Definitions on page 579

• Service Design: Managing E-LAN Service Definitions on page 619

• Service Design: Managing IP Service Definitions on page 669
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CHAPTER 24

Service Design: Predefined Service
Definitions

• Predefined Service Definitions on page 451

• Predefined E-Line Service Definitions on page 503

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 536

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 562

• Predefined Full Mesh IP Service Definitions on page 575

• Predefined Hub-and Spoke IP Service Definitions on page 576

Predefined Service Definitions

Connectivity Services Director provides predefined service definitions that a service

provisioner can use when creating a service order.

If none of the predefined service definitions is appropriate for your needs, you can create

a service definition as described in Creating an E-Line Service Definition, “Creating a

Point-to-MultipointE-LANServiceDefinition”onpage641, or “CreatingaServiceDefinition

for VPLS Access into Layer 3 Networks” on page 666.

The Junos Space Connectivity Services Director product provides predefined service

definitions for E-Line services and for E-LAN services. The following sections describe

these service definitions:

• E-Line Predefined Service Definitions on page 451

• Multipoint-to-Multipoint Predefined Service Definitions on page 475

• Point-to-Multipoint Service Definitions on page 500

E-Line Predefined Service Definitions

TheEthernetActivator softwareprovidespredefinedservicedefinitions for E-Line services

that use LDP switching in the network core. These services are sometimes knows as

E-Line Martini services. Figure 17 on page 452 shows an example of such a service.
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Figure 17: E-Line Service

Information specific to each service instance, such as the device name, endpoint name,

and customer VLAN ID, is provided in the service order. Attributes that can apply across

many service instances are typically defined in the service definition. These attributes

include:

• Ethernet option (dot1.q, port-port, qinq, asymmetric tag depth)

• Traffic type (single vlan, vlan range, all traffic, Transport vlan List)

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 66onpage452 lists each of the standard E-Line service definitions. Each standard

service definition is then described in detail in the sections that follow.

Table 66: Standard Service Definitions

Service AttributesStandardServiceDefinitionName

• E-Line service for M Series and MX Series devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN” on
page 454

• E-Line service for J Series, M Series, and MX Series
devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN-CCC” on
page 456
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Table 66: Standard Service Definitions (continued)

Service AttributesStandardServiceDefinitionName

• E-Line service for J Series, M Series, and MX Series
devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN-Ext-CCC”
on page 458

• E-Line service for J Series, M Series, and MX Series
devices

• Gigabit Ethernet interfaces

• Port-based UNI

• Ethernet-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-PortBased” on page 460

• E-Line service for M Series and MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN” on page 462

• E-Line service for J series, M Series, and MX Series
devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN-CCC” on
page 465

• E-Line service for J Series, M Series, and MX Series
devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN-Ext-CCC” on
page 467
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Table 66: Standard Service Definitions (continued)

Service AttributesStandardServiceDefinitionName

• E-Line service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange”onpage469

• E-Line service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange-CCC” on
page 471

• E-Line service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Extended-vlan-ccc physical encapsulation

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange-Ext-CCC”
on page 473

ELine-Dot1q-SingleVLAN

This service definition provides a base for creating E-Line services that transport a single

VLAN across an LDP network core using 802.1Q endpoint interface types and

flexible-ethernet-services as the physical encapsulation type. Service provisioners can

limit the bandwidth of services built from this service definition to specific values from

10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 454

• Configuration on Endpoint Z on page 455

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
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        description "Dot1q Eline Martini ";
        encapsulation vlan-ccc;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}

firewall {
   policer policer_in_ge-0/1/1_1 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }               
    then discard;   
} 

family ccc {    
 filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }

protocols {
    l2circuit {
       neighbor 192.168.1.40
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "Dot1q Eline Martini ";
        encapsulation vlan-ccc;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
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    }
}

firewall {
   policer policer_in_ge-0/1/1_1 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }               
    then discard;   
} 

family ccc {    
 filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }

protocols {
    l2circuit {
       neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
}

ELine-Dot1q-SingleVLAN-CCC

This service definition provides a base for creating E-Line services that transport a single

VLAN across an LDP network core using 802.1Q endpoint interface types and vlan-ccc

as the physical encapsulation type. Service provisioners can limit the bandwidth of

services built from this service definition to specific values from 10 Mbps through 100

Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 456

• Configuration on Endpoint Z on page 457

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 { 
     flexible-vlan-tagging;
     mtu 1522;
     encapsulation vlan-ccc;
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     unit 513 {
        description VLANCCC-SR;
        encapsulation vlan-ccc;
        vlan-id 513;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_513;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_513 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_513 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_513;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {     
        neighbor 192.168.1.40 {
            interface ge-0/1/1.513 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

 ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation vlan-ccc;
    unit 513 {
        description VLANCCC-SR;
        encapsulation vlan-ccc;
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        vlan-id 513;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_513;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_513 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_513 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_513;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.513 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-Dot1q-SingleVLAN-Ext-CCC

This service definition provides a base for creating E-Line services that transport a single

VLAN across an LDP network core using 802.1Q endpoint interface types and

extended-vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 459

• Configuration on Endpoint Z on page 460
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 1 {
        description Extended-SR;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }           
}               

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}   

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}
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Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 1 {
        description Extended-SR;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }           
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
} 

protocols {
   l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-PortBased

This servicedefinitionprovidesabase for creatingE-Line services that transport all traffic

across an LDP network core using an entire port at each endpoint using ethernet-ccc as
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the physical encapsulation type. Service provisioners can limit the bandwidth of services

built from this service definition to specific values from 10 Mbps to 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 461

• Configuration on Endpoint Z on page 462

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    encapsulation ethernet-ccc;
    unit 0 {
        family ccc {
            filter {
                input filter_in_ge-0/1/1;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 6250000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {     
            interface ge-0/1/1.0 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}
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Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
        encapsulation ethernet-ccc;
        unit 0 {
            family ccc {
                filter {
                    input filter_in_ge-0/1/1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 6250000;
        }
        then discard;
    }
    family ccc {           
        filter filter_in_ge-0/1/1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1;
                    accept;
                }
            }
        }
    }
}      

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.0 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-AllVLAN

This service definition provides a base for creating E-Line services that transport all

customer traffic across an LDP network core using Q-in-Q endpoint interface types and

flexible-ethernet-services as the physical encapsulation type. Service provisioners can

limit the bandwidth of services built from this service definition to specific values from

10 Mbps through 100Mbps.
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The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 463

• Configuration on Endpoint Z on page 464

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

 ge-0/1/1 {           
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "AllVlanTransport";
        encapsulation vlan-ccc;
        vlan-tags outer 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

}
firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
}
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Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 1 {
        description "AllVlanTransport";
        encapsulation vlan-ccc;
        vlan-tags outer 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }   
        }       
    }           
}

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }           
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }       
        }
    }
}
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ELine-QinQ-AllVLAN-CCC

This service definition provides a base for creating E-Line services that transport all

customer traffic across an LDP network core using Q-in-Q endpoint interface types and

vlan-cccas thephysical encapsulation type. Serviceprovisioners can limit thebandwidth

of services built from this service definition to specific values from 10 Mbps through 100

Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 465

• Configuration on Endpoint Z on page 466

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 515 {  
            description QinQ-ALLVLAN;
            encapsulation vlan-ccc;
            vlan-tags outer 515;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_515;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_515 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }

    family ccc {
        filter filter_in_ge-0/1/1_515 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_515;
                    accept;
                }
            }
        }
    }
}
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protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.515 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }   
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation vlan-ccc;
    unit 515 {
        description QinQ-ALLVLAN;
        encapsulation vlan-ccc;
        vlan-tags outer 515;
        family ccc {
            filter {
                 input filter_in_ge-0/1/1_515;
            }   
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_515 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {    
        filter filter_in_ge-0/1/1_515 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_515;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.515 {
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                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }   
    }
}

ELine-QinQ-AllVLAN-Ext-CCC

This service definition provides a base for creating E-Line services that transport all

customer traffic across an LDP network core using Q-in-Q endpoint interface types and

extended-vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 467

• Configuration on Endpoint Z on page 468

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation extended-vlan-ccc;
        unit 1 {
            description Ext-AllVLAN;
            vlan-tags outer 1;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }       
        }           
    }               

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
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                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }

}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation extended-vlan-ccc;
        unit 1 {
            description Ext-AllVLAN;
            vlan-tags outer 1;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
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                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {     
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange

This service definition provides a base for creating E-Line services that transport a range

of VLANs across an LDP network core using Q-in-Q endpoint interface types and

flexible-ethernet-services as the physical encapsulation type. Service provisioners can

limit the bandwidth of services built from this service definition to specific values from

10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 469

• Configuration on Endpoint Z on page 470

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {                                    
       flexible-vlan-tagging;
       mtu 1522;
       encapsulation flexible-ethernet-services;
         unit 2 {
         description "QinQ Eline Martini";
         encapsulation vlan-ccc;
         vlan-tags outer 2 inner-range 100-110;
         family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }
        }
    }
}
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firewall {
policer policer_in_ge-0/1/1_2 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }

family ccc {
    filter filter_in_ge-0/1/1_2 {
        interface-specific;
        term 1 {
            then {
                policer policer_in_ge-0/1/1_2;
                accept;
            }

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 2 {
        description "QinQ Eline Martini";
        encapsulation vlan-ccc;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
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        then discard;
    }

    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }   
            }
        }
    }
}

protocols {
    l2circuit {     
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange-CCC

This service definition provides a base for creating E-Line services that transport a range

ofVLANsacrossanLDPnetworkcoreusingQ-in-Qendpoint interface typesandvlan-ccc

as the physical encapsulation type. Service provisioners can limit the bandwidth of

services built from this service definition to specific values from 10 Mbps through 100

Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 471

• Configuration on Endpoint Z on page 472

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

    ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 514 {
            description VLANRANGE-SR;
            encapsulation vlan-ccc;
            vlan-tags outer 514 inner-range 600-610;
            family ccc {
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                filter {
                    input filter_in_ge-0/1/1_514;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_514 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_514 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_514;
                    accept;
                }   
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.514 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }

        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

 ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 514 {
            description VLANRANGE-SR;
            encapsulation vlan-ccc;
            vlan-tags outer 514 inner-range 600-610;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_514;
                }
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            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_514 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_514 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_514;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.514 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange-Ext-CCC

This service definition provides a base for creating E-Line services that transport a range

of VLANs across an LDP network core using Q-in-Q endpoint interface types and

extended-vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 474

• Configuration on Endpoint Z on page 475
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 2 {    
        description Ext-VLANRange;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }   
        }       
    }           
}   

firewall {          
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }
            }
        }
    }
}     

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
             }
         }
    }
}
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Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 2 {
        description Ext-VLANRange;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }   
        }
    }
} 

firewall {
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
             }
         }
    }
}

Multipoint-to-Multipoint Predefined Service Definitions

TheEthernetActivator softwareprovidespredefinedservicedefinitions forE-LANservices

thatuseBGPswitching in thenetworkcore. s. This sectioncoversmultipoint-to-multipoint

(or fullmesh)servicedefinitions. Figure 18onpage476showsanexampleofsuchaservice.
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Figure 18: Multipoint—to—Multipoint Service

Information specific to each service instance, such as the device name, endpoint name,

and customer VLAN ID, is provided in the service order. Attributes that can apply across

many service instances are typically defined in the service definition. These attributes

include:

• Ethernet option (dot1.q, port-port, qinq, asymmetric tag depth)

• Traffic type (single vlan, vlan range, all traffic, transport vlan list)

• VLAN normalization

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 67 on page 476 lists each of the standard E-LAN service definitions. Each standard

service definition is then described in detail in the sections that follow.

Table 67: Standard Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-Dot1q-Normalized-VLAN-None”on
page 478
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Table 67: Standard Service Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service for M Series or
MX Series devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-Dot1Q-SingleVLAN” on page 481

• Multipoint Ethernet service for M series and
MX Series devices

• Gigabit Ethernet interfaces

• Port-based UNIs

• Transports all customer traffic

• E-LAN as physical encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-PortBased” on page 485

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN” on page 488

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN-Normalized-All” on
page 491

477Copyright © 2019, Juniper Networks, Inc.

Chapter 24: Service Design: Predefined Service Definitions



Table 67: Standard Service Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• VLAN IDs not preserved

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN-Normalized-None”
on page 495

• Multipoint Ethernet service for MX Series
devices only

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint interface types

• Transports specified VLAN range

• Flexible Ethernet services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-Range-Normalized-VLAN”
on page 498

ELAN-BGP-Dot1q-Normalized-VLAN-None

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic from a single VLAN on an endpoint across a BGP network

core using802.1Qendpoint interface typesand flexible-ethernet-services as thephysical

encapsulation type. VLAN IDs are not preserved across the network—traffic passes from

the single VLAN on an endpoint to any VLANs in the broadcast domain. Service

provisioners can limit thebandwidthof servicesbuilt fromthis servicedefinition to specific

values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 478

• Configuration on Endpoint B on page 479

• Configuration on Endpoint Z on page 480

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/0/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
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            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }               
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        interface ge-0/0/1.1;
        route-distinguisher 65410:1;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

    ge-0/0/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
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            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        interface ge-0/0/1.1;
        route-distinguisher 65410:0;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }           
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

SJC:

    ge-0/0/1 {      
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
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            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        interface ge-0/0/1.1;
        vlan-id none;
        route-distinguisher 65410:2;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }
    }

ELAN-BGP-Dot1Q-SingleVLAN

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic on a single VLAN across a BGP network core using 802.1Q

endpoint interface types and flexible-ethernet-services as the physical encapsulation

type. No VLANmapping is performed—the VLAN IDmust be the same on all endpoints.

Service provisioners can limit the bandwidth of services built from this service definition

to specific values from 10 Mbps through 100Mbps.
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The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 482

• Configuration on Endpoint B on page 483

• Configuration on Endpoint Z on page 484

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }

        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:4;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
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                    interface ge-0/0/2.1;
                }
            }
        }           
    }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}

routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:3;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/2.1;
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                }
            }
        }
    }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }       
        }           
    }               

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {   
        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:5;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/2.1;
                }
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            }
        }
    }

ELAN-BGP-PortBased

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic onanentire port acrossaBGPnetwork coreusingE-LAN

as the physical encapsulation type. Service provisioners can limit the bandwidth of

services built from this service definition to specific values from 10 Mbps through 100

Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 485

• Configuration on Endpoint B on page 486

• Configuration on Endpoint Z on page 487

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

 ge-0/1/3 {      
        mtu 1522;
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/1/3;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/3 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/3;
                    accept;
                }
            }
        }
    }
}
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routing-instances {
    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/1/3.0;
        route-distinguisher 65410:3;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/3.0;
                }
            }
        }
    }
} 

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

 ge-0/1/3 {
        mtu 1522;   
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/1/3;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/3 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }           
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/3;
                    accept;
                }
            }
        }
    }
}
routing-instances {
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    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/1/3.0;
        route-distinguisher 65410:2;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/3.0;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

 ge-0/2/2 {
        mtu 1522;
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/2/2;
                }
            }
        }
    }

}
firewall {
    policer policer_in_ge-0/2/2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/2/2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/2/2;
                    accept;
                }
            }
        }
    }
}

routing-instances {
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    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/2/2.0;
        route-distinguisher 65410:4;
        vrf-target target:65410:1;
        protocols { 
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/2/2.0;
                }
            }
        }
    }

ELAN-BGP-QinQ-AllVLAN

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type. No

VLANmapping is performed—customer VLAN IDs and service provider VLAN IDs must

match on each endpoint that is to send or receive traffic. Service provisioners can limit

the bandwidth of services built from this service definition to specific values from 10

Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 488

• Configuration on Endpoint B on page 489

• Configuration on Endpoint Z on page 490

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/1/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
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        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family vpls {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }           
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/1/1.1;
        route-distinguisher 65410:13;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/1.1;
                }
            }
        }
    }
}

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/1/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
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        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/1/1.1;
        route-distinguisher 65410:12;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/1.1;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/5 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/5_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/5_1 {
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        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/5_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/5_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/0/5.1;
        route-distinguisher 65410:14;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/5.1;
                }
            }
        }
    }
}

ELAN-BGP-QinQ-AllVLAN-Normalized-All

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type.

Customer VLAN IDs are preserved across the network—traffic passes only among

matching customer VLAN IDs. However, traffic can pass among any service provider

VLAN ID in thebroadcastdomain. Serviceprovisioners can limit thebandwidthof services

built from this service definition to specific values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 492

• Configuration on Endpoint B on page 493

• Configuration on Endpoint Z on page 494
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/1/0 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {    
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/0_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/0_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/0_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/0_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        interface ge-0/1/0.1;
        route-distinguisher 65410:10;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/0.1;
                }
            }
        }
    }
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Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/1/0 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/0_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/0_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/0_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/0_1;
                    accept;
                }
            }
        }           
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        interface ge-0/1/0.1;
        route-distinguisher 65410:9;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/0.1;
                }
            }
        }
    }

493Copyright © 2019, Juniper Networks, Inc.

Chapter 24: Service Design: Predefined Service Definitions



Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/4 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/4_1;
                }
            }
        }
    }
firewall {
    policer policer_in_ge-0/0/4_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/4_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/4_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {             
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        interface ge-0/0/4.1;
        vlan-id all;
        route-distinguisher 65410:11;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/4.1;
                }
            }
        }
    }
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ELAN-BGP-QinQ-AllVLAN-Normalized-None

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type. VLAN

IDs are not preserved across the network—traffic passes between any customer VLAN

or service provider VLAN in the broadcast domain. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 495

• Configuration on Endpoint B on page 496

• Configuration on Endpoint Z on page 497

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
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routing-instances {          
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        interface ge-0/0/3.1;
        route-distinguisher 65410:7;
        vrf-target target:65410:2;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
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routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        interface ge-0/0/3.1;
        route-distinguisher 65410:6;
        vrf-target target:65410:2;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
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routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        interface ge-0/0/3.1;
        vlan-id none;
        route-distinguisher 65410:8;
        vrf-target target:65410:2;
        protocols { 
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

ELAN-BGP-QinQ-Range-Normalized-VLAN

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic froma rangeofVLANsonanendpointacrossaBGPnetwork

core usingQ-in-Qendpoint interface typesand flexible-ethernet-services as thephysical

encapsulation type. Services built from this service definitionmust useMXSeries devices

on the provider edge. Customer VLAN IDs are preserved across the network—traffic

passes among like customer VLAN IDs on any service provider VLAN in the broadcast

domain. Service provisioners can limit the bandwidth of services built from this service

definition to specific values from 10 Mbps through 100Mbps.

The following sections show the configuration data for a servicewith only twoendpoints,

SJC and SFO.

• Configuration on Endpoint A on page 498

• Configuration on Endpoint Z on page 499

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device SJC):

ge-0/0/6 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 2 {    
            encapsulation vlan-vpls;
            vlan-tags outer 2 inner-range 1500-2000;
            family vpls {
                filter {
                    input filter_in_ge-0/0/6_2;
                }
            }
        }
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    }

firewall {
    policer policer_in_ge-0/0/6_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/6_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/6_2;
                    accept;
                }
            }       
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-Range-Normalized-VLAN-SR1 {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/6.2;
        vlan-id all;
        route-distinguisher 65410:19;
        vrf-target target:65410:6;
        protocols {
            vpls {  
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/6.2;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SFO):

ge-0/0/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1 inner-range 1500-2000;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
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                }   
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-Range-Normalized-VLAN-SR1 {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/1.1;
        route-distinguisher 65410:18;
        vrf-target target:65410:6;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }
    }

Point-to-Multipoint Service Definitions

TheEthernetActivator softwareprovidespredefinedservicedefinitions forE-LANservices

that use BGP switching in the network core. This section covers point-to-multipoint (or

hub and spoke) service definitions. Figure 19 on page 501 shows an example of such a

service.
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Figure 19: Point-to-Multipoint Service

Information specific to each service instance, such as the device name, endpoint name,

customer VLAN ID, andwhether a specific endpoint is a hub or a spoke is provided in the

serviceorder. Attributes that canapplyacrossmanyservice instancesare typically defined

in the service definition. These attributes include:

• Ethernet option (dot1.q, port-port, qinq, asymmetric tag depth)

• Traffic type (single vlan, vlan range, all traffic, transport vlan list)

• VLAN normalization

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 68 on page 501 lists each of the standard E-LAN service definitions. Each standard

service definition is then described in detail in the sections that follow.

Table 68: Standard Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service for M Series and MX
Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical encapsulation
type

• Rate limiting from 10 Mbps to 100Mbps with 10
Mbps increment

“ELAN-Hub-Spoke-QinQ-AllVLAN” on
page 502
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Table 68: Standard Service Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries orMXSeries
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical encapsulation
type

• Rate limiting from 10 Mbps to 100Mbps with 10
Mbps increment

“ELAN-Hub-Spoke-QinQ-AllVLAN-No”
on page 502

ELAN-Hub-Spoke-QinQ-AllVLAN

This service definition provides a base for creating point-to-multipoint Ethernet services

that transport all traffic onanendpointacrossaBGPnetworkcoreusingQ-in-Qendpoint

interface types and flexible-ethernet-services as the physical encapsulation type.

CustomerVLAN IDsarepreservedacross thenetwork—trafficpassesamong likecustomer

VLAN IDs on any service provider VLAN in the broadcast domain. Service provisioners

can limit the bandwidth of services built from this service definition to specific values

from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 19 on page 501:

• Configuration on Endpoint A on page 502

• Configuration on Endpoint B on page 502

• Configuration on Endpoint Z on page 502

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ELAN-Hub-Spoke-QinQ-AllVLAN-No

This service definition provides a base for creating point-to-multipoint Ethernet services

that transport all traffic onanendpointacrossaBGPnetworkcoreusingQ-in-Qendpoint

interface types and flexible-ethernet-services as the physical encapsulation type. VLAN

IDs are not preserved across the network—traffic passes from the single VLAN on an
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endpoint to any VLANs in the broadcast domain. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 19 on page 501:

• Configuration on Endpoint A on page 503

• Configuration on Endpoint B on page 503

• Configuration on Endpoint Z on page 503

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A(device IND):

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

Related
Documentation

Creating an E-Line Service Definition•

• Creating a Multipoint-to-Multipoint E-LAN Service Definition on page 619

Predefined E-Line Service Definitions

The Connectivity Services Director application provides predefined service definitions

that a service provisioner can choose fromwhen creating a service order. This section

provides informationaboutpredefinedservicedefinitionsused for creatingE-Lineservices.

For informationaboutpredefinedservicedefinitionsused tocreateother typesof service,

see the following topics:

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 536

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 562

• Predefined Full Mesh IP Service Definitions on page 575

• Predefined Hub-and Spoke IP Service Definitions on page 576

If none of the predefined E-Line service definitions described here is appropriate for your

needs, you can create a service definition as described in Creating an E-Line Service

Definition,

The Connectivity Services Director application provides predefined service definitions

for E-Line services that use LDP switching or BGP in the network core. The LDP based

services are sometimes known as E-Line Martini services, and the BGP based services
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aresometimesknownasE-LineKompellaservices.Figure 17onpage452showsanexample

of such a service.

Figure 20: E-Line Service

Information specific to each service instance, such as the device name, endpoint name,

and customer VLAN ID, is provided in the service order. Attributes that can apply across

many service instances are typically defined in the service definition. These attributes

include:

• Ethernet option (dot1.q, port-port, qinq, asymmetric tag depth)

• Traffic type (single VLAN, VLAN range, all traffic, VLAN list)

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 66onpage452 lists each of the standard E-Line service definitions. Each standard

service definition is then described in detail in the sections that follow.

Table 69: Standard E-Line Service Definitions

Service AttributesStandardServiceDefinitionName

• E-Line service for M Series and MX Series routers

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN” on
page 454

• E-Line service for M Series and MX Series routers

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN-CCC” on
page 456
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Table 69: Standard E-Line Service Definitions (continued)

Service AttributesStandardServiceDefinitionName

• E-Line service for M Series and MX Series routers

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN-Ext-CCC”
on page 458

• E-Line service for M Series and MX Series routers

• Gigabit Ethernet interfaces

• Port-based UNI

• Ethernet-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-PortBased” on page 460

• E-Line service for M Series and MX Series routers

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN” on page 462

• E-Line service for M Series and MX Series routers

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN-CCC” on
page 465

• E-Line service for M Series and MX Series routers

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN-Ext-CCC” on
page 467

• E-Line service for MX Series routers only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange”onpage469
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Table 69: Standard E-Line Service Definitions (continued)

Service AttributesStandardServiceDefinitionName

• E-Line service for MX Series routers only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Vlan-ccc physical encapsulation type

• Rate limiting from 10Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange-CCC” on
page 471

• E-Line service for MX Series routers only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Extended-vlan-ccc physical encapsulation

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange-Ext-CCC”
on page 473

• E-Line service for MX Series routersonly

• T1 interfaces

• satop physical encapsulation

TDM Interface

• E-Line service for MX Series routers only

• T1 interfaces

• satop physical encapsulation

• Static pseudowire

Static TDM pseudowire

• E-Line service for MX Series routers only

• ATM/T1interfaces

• atm-cc-cell-relay physical encapsulation

ATM pseudowire

• E-Line service for MX Series routers only

• ATM/T1interfaces

• atm-ccc-vc-mux/aal5 physical encapsulation

ATM-AAL5 pseudowire

• E-Line service for MX Series routers only

• ATM/T1 interfaces

• atm-ccc-cell-relay/atm physical encapsulation

• Static pseudowire

Static ATM pseudowire

• E-Line service for MX Series routers only

• ATM/T1 interfaces

• atm-ccc-vc-mux / aal5 physical encapsulation

• Static pseudowire

Static ATM-AAL5 pseudowire
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Table 69: Standard E-Line Service Definitions (continued)

Service AttributesStandardServiceDefinitionName

• Ethernet service forMSeries,MXSeries, andACXSeries
routers

• Gigabit Ethernet interface

• Q-in-Q endpoint interface type

• Transport all traffic

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

“Eline-BGP-QinQ-AllVLAN” on
page 533

• Ethernet service forMSeries,MXSeries, andACXSeries
routers

• Gigabit Ethernet interface

• 802.1Q endpoint interface types

• Single VLAN traffic

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

“Eline-BGP-Dot1q-SingleVLAN” on
page 531

• Ethernet service for M Series, MX Series, and ACX
routers

• Gigabit Ethernet interface

• Port-based UNIs

• Ethernet-ccc physical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-BGP-Port-Based”onpage529

ELine-Dot1q-SingleVLAN Service Definition

This service definition provides a base for creating E-Line services that transport a single

VLAN across an LDP or BGP network core using 802.1Q endpoint interface types and

flexible-ethernet-services as the physical encapsulation type. Service provisioners can

limit the bandwidth of services built from this service definition to specific values from

10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 507

• Configuration on Endpoint Z on page 508

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
      flexible-vlan-tagging;
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      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "Dot1q Eline Martini ";
        encapsulation vlan-ccc;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}

firewall {
   policer policer_in_ge-0/1/1_1 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }               
    then discard;   
} 

family ccc {    
 filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }

protocols {
    l2circuit {
       neighbor 192.168.1.40
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "Dot1q Eline Martini ";
        encapsulation vlan-ccc;
        vlan-id 1;
        family ccc {
            filter {
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                input filter_in_ge-0/1/1_1;
            }
        }
    }
}

firewall {
   policer policer_in_ge-0/1/1_1 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }               
    then discard;   
} 

family ccc {    
 filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }

protocols {
    l2circuit {
       neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
}

ELine-Dot1q-SingleVLAN-CCC Service Definition

This service definition provides a base for creating E-Line services that transport a single

VLAN across an LDP or BGP network core using 802.1Q endpoint interface types and

vlan-cccas thephysical encapsulation type. Serviceprovisioners can limit thebandwidth

of services built from this service definition to specific values from 10 Mbps through 100

Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 510

• Configuration on Endpoint Z on page 511
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 { 
     flexible-vlan-tagging;
     mtu 1522;
     encapsulation vlan-ccc;
     unit 513 {
        description VLANCCC-SR;
        encapsulation vlan-ccc;
        vlan-id 513;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_513;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_513 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_513 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_513;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {     
        neighbor 192.168.1.40 {
            interface ge-0/1/1.513 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}
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Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

 ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation vlan-ccc;
    unit 513 {
        description VLANCCC-SR;
        encapsulation vlan-ccc;
        vlan-id 513;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_513;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_513 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_513 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_513;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.513 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-Dot1q-SingleVLAN-Ext-CCC Service Definition

This service definition provides a base for creating E-Line services that transport a single

VLAN across an LDP or BGP network core using 802.1Q endpoint interface types and
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extended-vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 512

• Configuration on Endpoint Z on page 513

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 1 {
        description Extended-SR;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }           
}               

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}   

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
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                mtu 1522;
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 1 {
        description Extended-SR;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }           
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
} 

protocols {
   l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}
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ELine-PortBased Service Definition

This servicedefinitionprovidesabase for creatingE-Line services that transport all traffic

across an LDP or BGP network core using an entire port at each endpoint using

ethernet-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

to 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 514

• Configuration on Endpoint Z on page 515

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    encapsulation ethernet-ccc;
    unit 0 {
        family ccc {
            filter {
                input filter_in_ge-0/1/1;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 6250000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {     
            interface ge-0/1/1.0 {
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                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
        encapsulation ethernet-ccc;
        unit 0 {
            family ccc {
                filter {
                    input filter_in_ge-0/1/1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 6250000;
        }
        then discard;
    }
    family ccc {           
        filter filter_in_ge-0/1/1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1;
                    accept;
                }
            }
        }
    }
}      

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.0 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}
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ELine-QinQ-AllVLAN Service Definition

This service definition provides a base for creating E-Line services that transport all

customer traffic across an LDP or BGP network core using Q-in-Q endpoint interface

types and flexible-ethernet-services as the physical encapsulation type. Service

provisioners can limit thebandwidthof servicesbuilt fromthis servicedefinition to specific

values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 516

• Configuration on Endpoint Z on page 517

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

 ge-0/1/1 {           
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "AllVlanTransport";
        encapsulation vlan-ccc;
        vlan-tags outer 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

}
firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
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            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 1 {
        description "AllVlanTransport";
        encapsulation vlan-ccc;
        vlan-tags outer 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }   
        }       
    }           
}

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }           
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {

517Copyright © 2019, Juniper Networks, Inc.

Chapter 24: Service Design: Predefined Service Definitions



                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }       
        }
    }
}

ELine-QinQ-AllVLAN-CCC Service Definition

This service definition provides a base for creating E-Line services that transport all

customer traffic across an LDP or BGP network core using Q-in-Q endpoint interface

types and vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 518

• Configuration on Endpoint Z on page 519

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 515 {  
            description QinQ-ALLVLAN;
            encapsulation vlan-ccc;
            vlan-tags outer 515;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_515;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_515 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }

    family ccc {
        filter filter_in_ge-0/1/1_515 {
            interface-specific;
            term 1 {
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                then {
                    policer policer_in_ge-0/1/1_515;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.515 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }   
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation vlan-ccc;
    unit 515 {
        description QinQ-ALLVLAN;
        encapsulation vlan-ccc;
        vlan-tags outer 515;
        family ccc {
            filter {
                 input filter_in_ge-0/1/1_515;
            }   
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_515 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {    
        filter filter_in_ge-0/1/1_515 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_515;
                    accept;
                }
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            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.515 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }   
    }
}

ELine-QinQ-AllVLAN-Ext-CCC Service Definition

This service definition provides a base for creating E-Line services that transport all

customer traffic across an LDP or BGP network core using Q-in-Q endpoint interface

types and extended-vlan-ccc as the physical encapsulation type. Service provisioners

can limit the bandwidth of services built from this service definition to specific values

from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 520

• Configuration on Endpoint Z on page 521

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation extended-vlan-ccc;
        unit 1 {
            description Ext-AllVLAN;
            vlan-tags outer 1;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }       
        }           
    }               

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
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            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }

}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation extended-vlan-ccc;
        unit 1 {
            description Ext-AllVLAN;
            vlan-tags outer 1;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
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        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {     
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange Service Definition

This service definition provides a base for creating E-Line services that transport a range

of VLANs across an LDP or BGP network core using Q-in-Q endpoint interface types and

flexible-ethernet-services as the physical encapsulation type. Service provisioners can

limit the bandwidth of services built from this service definition to specific values from

10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 522

• Configuration on Endpoint Z on page 523

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {                                    
       flexible-vlan-tagging;
       mtu 1522;
       encapsulation flexible-ethernet-services;
         unit 2 {
         description "QinQ Eline Martini";
         encapsulation vlan-ccc;
         vlan-tags outer 2 inner-range 100-110;
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         family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }
        }
    }
}

firewall {
policer policer_in_ge-0/1/1_2 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }

family ccc {
    filter filter_in_ge-0/1/1_2 {
        interface-specific;
        term 1 {
            then {
                policer policer_in_ge-0/1/1_2;
                accept;
            }

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 2 {
        description "QinQ Eline Martini";
        encapsulation vlan-ccc;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }
        }
    }
}
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firewall {
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }

    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }   
            }
        }
    }
}

protocols {
    l2circuit {     
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange-CCC Service Definition

This service definition provides a base for creating E-Line services that transport a range

of VLANs across an LDP or BGP network core using Q-in-Q endpoint interface types and

vlan-cccas thephysical encapsulation type. Serviceprovisioners can limit thebandwidth

of services built from this service definition to specific values from 10 Mbps through 100

Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 525

• Configuration on Endpoint Z on page 526
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

    ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 514 {
            description VLANRANGE-SR;
            encapsulation vlan-ccc;
            vlan-tags outer 514 inner-range 600-610;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_514;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_514 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_514 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_514;
                    accept;
                }   
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.514 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }

        }
    }
}
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Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

 ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 514 {
            description VLANRANGE-SR;
            encapsulation vlan-ccc;
            vlan-tags outer 514 inner-range 600-610;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_514;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_514 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_514 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_514;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.514 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}
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ELine-QinQ-VLANRange-Ext-CCC Service Definition

This service definition provides a base for creating E-Line services that transport a range

of VLANs across an LDP or BGP network core using Q-in-Q endpoint interface types and

extended-vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 527

• Configuration on Endpoint Z on page 528

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 2 {    
        description Ext-VLANRange;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }   
        }       
    }           
}   

firewall {          
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }
            }
        }
    }
}     
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protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
             }
         }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 2 {
        description Ext-VLANRange;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }   
        }
    }
} 

firewall {
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.2 {
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                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
             }
         }
    }
}

ELine-BGP-Port-Based

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 529

• Configuration on Endpoint Z on page 530

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

routing-instances{
    instance-type l2vpn;
    interface ge-1/0/7.0;
    route-distinguisher 69:27;
    vrf-target target:69:49165;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_1 {
                site-identifier 1;
                mtu 1522;
                interface ge-1/0/7.0 {
                   remote-site-id 2;
                   description P2P-BGP-PortBased;
               }
           }
        }
    }
}

ge-1/0/7 {
    mtu 1522;
    encapsulation ethernet-ccc;
    unit 0 {
        family ccc {
            filter {
                input filter_in_ge-1/0/7;
            }
        }
    }
}

firewall{

    family ccc {
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       filter filter_in_ge-1/0/7 {
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-1/0/7;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-1/0/7 {
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

routing-instances{
    instance-type l2vpn;
    interface ge-1/0/8.0;
    route-distinguisher 69:27;
    vrf-target target:69:49165;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_2 {
                site-identifier 2;
                mtu 1522;
                interface ge-1/0/8.0 {
                   remote-site-id 1;
                   description P2P-BGP-PortBased;
               }
           }
        }
    }
}

ge-1/0/8 {
    mtu 1522;
    encapsulation ethernet-ccc;
    unit 0 {
        family ccc {
            filter {
                input filter_in_ge-1/0/8;
            }
        }
    }
}
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firewall{

    family ccc {

       filter filter_in_ge-1/0/8 {
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-1/0/8;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-1/0/8 {
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Eline-BGP-Dot1q-SingleVLAN

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 531

• Configuration on Endpoint Z on page 532

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

routing-instances {
    instance-type l2vpn;
    interface ge-0/0/2.823;
    route-distinguisher 69:26;
    vrf-target target:69:49164;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_1 {
                site-identifier 1;
                interface ge-0/0/2.823 {
                    remote-site-id 2;
                }
            }
        }
    }
}

ge-0/0/2 {
    enable;
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    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 823 {
        description "ELine-BGP-Dot1Q";
        encapsulation vlan-ccc;
        vlan-id 823;
        family ccc {
            filter {
                input filter_in_ge-0/0/2_823;
            }
        }
    }
}

firewall{

    family ccc {

       filter filter_in_ge-0/0/2_823 {
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-0/0/2_823;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-0/0/2_823 {
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

routing-instances {
    instance-type l2vpn;
    interface ge-0/0/3.823;
    route-distinguisher 69:26;
    vrf-target target:69:49164;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_2 {
                site-identifier 2;
                interface ge-0/0/3.823 {
                    remote-site-id 1;
                }
            }
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        }
    }
}

ge-0/0/3 {
    enable;
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 823 {
        description "ELine-BGP-Dot1Q";
        encapsulation vlan-ccc;
        vlan-id 823;
        family ccc {
            filter {
                input filter_in_ge-0/0/3_823;
            }
        }
    }
}

firewall{

    family ccc {

       filter filter_in_ge-0/0/3_823 {
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-0/0/3_823;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-0/0/3_823 {
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Eline-BGP-QinQ-AllVLAN

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 17 on page 452:

• Configuration on Endpoint A on page 534

• Configuration on Endpoint Z on page 535
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

routing-instances {
    instance-type l2vpn;
    interface ge-0/0/1.981;
    route-distinguisher 69:15;
    vrf-target target:69:49160;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_1 {
                site-identifier 1;
                mtu 1522;
                interface ge-0/0/1.981 {
                    remote-site-id 2;
                    description P2P-BGP-QnQAllVLan;
                }
            }
        }
    }
}

ge-0/0/3 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;    
    unit 981 {
        description "No description available for selected UNI interface.";
        encapsulation vlan-ccc;
        vlan-tags outer 981;
        family ccc {
            filter {
                input filter_in_ge-0/0/3_981;
            }
        }
    }
}

firewall{

    family ccc {

       filter filter_in_ge-0/0/3_981;{
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-0/0/3_981;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-0/0/3_981;{
     if-exceeding {
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            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

routing-instances {
    instance-type l2vpn;
    interface ge-0/0/5.981;
    route-distinguisher 69:15;
    vrf-target target:69:49160;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_2 {
                site-identifier 2;
                mtu 1522;
                interface ge-0/0/5.981 {
                    remote-site-id 1;
                    description P2P-BGP-QnQAllVLan;
                }
            }
        }
    }
}

ge-0/0/5 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;    
    unit 981 {
        description "No description available for selected UNI interface.";
        encapsulation vlan-ccc;
        vlan-tags outer 981;
        family ccc {
            filter {
                input filter_in_ge-0/0/5.981 
            }
        }
    }
}

firewall{

    family ccc {

       filter filter_in_ge-0/0/5.981 {
           interface-specific;
            term 1 {
               then {
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                   policer policer_in_ge-0/0/5.981 
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-0/0/5.981 {
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Related
Documentation

ChoosingaPredefinedServiceDefinitionorCreatingaNewServiceDefinitiononpage579•

• Creating an E-Line Service Definition

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 536

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 562

• Predefined Full Mesh IP Service Definitions on page 575

• Predefined Hub-and Spoke IP Service Definitions on page 576

PredefinedMultipoint-to-Multipoint Ethernet Service Definitions

The Connectivity Services Director application provides predefined service definitions

that a service provisioner can choose fromwhen creating a service order. This section

provides information about predefined service definitions used for creating

mutlipoint-to-multipoint Ethernet services. For information about predefined service

definitions used to create E-Line service definitions or point-to-multipoint service

definitions, see the following topics:

• Predefined E-Line Service Definitions on page 503

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 562

If none of the multipoint-to-multipoint predefined service definitions described here is

appropriate for your needs, you can create a service definition as described in “Creating

a Multipoint-to-Multipoint E-LAN Service Definition” on page 619.

The Connectivity Services Director application provides predefined service definitions

for E-LAN services that use BGP switching in the network core. These services are

sometimes known as E-LAN services. This section covers multipoint-to-multipoint (or

full mesh) service definitions. Figure 18 on page 476 shows an example of such a service.
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Figure 21: Multipoint-to-Multipoint Service

Information specific to each service instance, such as the device name, endpoint name,

and customer VLAN ID, is provided in the service order. Attributes that can apply across

many service instances are typically defined in the service definition. These attributes

include:

• Ethernet option (dot1.q, port-port, qinq, asymmetric tag depth)

• Traffic type (single VLAN, VLAN range, all traffic, VLAN list)

• VLAN normalization

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 67 on page 476 lists each of the standard E-LAN service definitions. Each standard

service definition is then described in detail in the sections that follow.

Table 70: Standard Multipoint-to-Multipoint Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-Dot1q-Normalized-VLAN-None”on
page 478
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Table 70: Standard Multipoint-to-Multipoint Service Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service for M Series or
MX Series devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-Dot1Q-SingleVLAN” on page 481

• Multipoint Ethernet service for M series and
MX Series devices

• Gigabit Ethernet interfaces

• Port-based UNIs

• Transports all customer traffic

• Ethernet VPLS as physical encapsulation
type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-PortBased” on page 485

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN” on page 488

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN-Normalized-All” on
page 491
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Table 70: Standard Multipoint-to-Multipoint Service Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• VLAN IDs not preserved

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN-Normalized-None”
on page 495

• Multipoint Ethernet service for MX Series
devices only

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint interface types

• Transports specified VLAN range

• Flexible Ethernet services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-Range-Normalized-VLAN”
on page 498

ELAN-BGP-Dot1q-Normalized-VLAN-None Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic from a single VLAN on an endpoint across a BGP network

core using802.1Qendpoint interface typesand flexible-ethernet-services as thephysical

encapsulation type. VLAN IDs are not preserved across the network—traffic passes from

the single VLAN on an endpoint to any VLANs in the broadcast domain. Service

provisioners can limit thebandwidthof servicesbuilt fromthis servicedefinition to specific

values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 539

• Configuration on Endpoint B on page 540

• Configuration on Endpoint Z on page 541

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/0/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
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        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }               
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/1.1;
        route-distinguisher 65410:1;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

    ge-0/0/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
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            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/1.1;
        route-distinguisher 65410:0;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }           
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

    ge-0/0/1 {      
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
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        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/1.1;
        vlan-id none;
        route-distinguisher 65410:2;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }
    }

ELAN-BGP-Dot1Q-SingleVLAN Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic on a single VLAN across a BGP network core using 802.1Q

endpoint interface types and flexible-ethernet-services as the physical encapsulation

type. No VLANmapping is performed—the VLAN IDmust be the same on all endpoints.
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Service provisioners can limit the bandwidth of services built from this service definition

to specific values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 543

• Configuration on Endpoint B on page 544

• Configuration on Endpoint Z on page 545

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }

        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:4;
        vrf-target target:65410:1;
        protocols {
            vpls {
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                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/2.1;
                }
            }
        }           
    }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}

routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:3;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
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                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/2.1;
                }
            }
        }
    }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }       
        }           
    }               

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {   
        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:5;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
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                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/2.1;
                }
            }
        }
    }

ELAN-BGP-PortBased Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic on an entire port across a BGP network core using

ethernet-vpls as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 546

• Configuration on Endpoint B on page 547

• Configuration on Endpoint Z on page 548

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

 ge-0/1/3 {      
        mtu 1522;
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/1/3;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/3 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/3;
                    accept;
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                }
            }
        }
    }
}
routing-instances {
    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/1/3.0;
        route-distinguisher 65410:3;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/3.0;
                }
            }
        }
    }
} 

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

 ge-0/1/3 {
        mtu 1522;   
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/1/3;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/3 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }           
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/3;
                    accept;
                }
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            }
        }
    }
}
routing-instances {
    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/1/3.0;
        route-distinguisher 65410:2;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/3.0;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

 ge-0/2/2 {
        mtu 1522;
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/2/2;
                }
            }
        }
    }

}
firewall {
    policer policer_in_ge-0/2/2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/2/2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/2/2;
                    accept;
                }
            }

Copyright © 2019, Juniper Networks, Inc.548

Connectivity Services Director User Guide



        }
    }
}

routing-instances {
    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/2/2.0;
        route-distinguisher 65410:4;
        vrf-target target:65410:1;
        protocols { 
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/2/2.0;
                }
            }
        }
    }

ELAN-BGP-QinQ-AllVLAN Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type. No

VLANmapping is performed—customer VLAN IDs and service provider VLAN IDs must

match on each endpoint that is to send or receive traffic. Service provisioners can limit

the bandwidth of services built from this service definition to specific values from 10

Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 549

• Configuration on Endpoint B on page 550

• Configuration on Endpoint Z on page 551

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/1/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
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            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family vpls {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }           
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/1/1.1;
        route-distinguisher 65410:13;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/1.1;
                }
            }
        }
    }
}

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/1/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
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            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/1/1.1;
        route-distinguisher 65410:12;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/1.1;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/5 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/5_1;
                }
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            }
        }
    }

firewall {
    policer policer_in_ge-0/0/5_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/5_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/5_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/0/5.1;
        route-distinguisher 65410:14;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/5.1;
                }
            }
        }
    }
}

ELAN-BGP-QinQ-AllVLAN-Normalized-All Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type.

Customer VLAN IDs are preserved across the network—traffic passes only among

matching customer VLAN IDs. However, traffic can pass among any service provider

VLAN ID in thebroadcastdomain. Serviceprovisioners can limit thebandwidthof services

built from this service definition to specific values from 10 Mbps through 100Mbps.
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The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 553

• Configuration on Endpoint B on page 554

• Configuration on Endpoint Z on page 555

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/1/0 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {    
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/0_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/0_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/0_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/0_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        vlan-id all;
        interface ge-0/1/0.1;
        route-distinguisher 65410:10;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
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                    site-preference primary;
                    interface ge-0/1/0.1;
                }
            }
        }
    }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/1/0 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/0_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/0_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/0_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/0_1;
                    accept;
                }
            }
        }           
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        vlan-id all;
        interface ge-0/1/0.1;
        route-distinguisher 65410:9;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
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                    site-preference primary;
                    interface ge-0/1/0.1;
                }
            }
        }
    }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/4 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/4_1;
                }
            }
        }
    }
firewall {
    policer policer_in_ge-0/0/4_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/4_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/4_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {             
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/4.1;
        vlan-id all;
        route-distinguisher 65410:11;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
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                    site-preference primary;
                    interface ge-0/0/4.1;
                }
            }
        }
    }

ELAN-BGP-QinQ-AllVLAN-Normalized-None Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type. VLAN

IDs are not preserved across the network—traffic passes between any customer VLAN

or service provider VLAN in the broadcast domain. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 18 on page 476:

• Configuration on Endpoint A on page 556

• Configuration on Endpoint B on page 557

• Configuration on Endpoint Z on page 558

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
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            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {          
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/3.1;
        route-distinguisher 65410:7;
        vrf-target target:65410:2;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/3_1 {
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            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/3.1;
        route-distinguisher 65410:6;
        vrf-target target:65410:2;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family vpls {
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        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/3.1;
        vlan-id none;
        route-distinguisher 65410:8;
        vrf-target target:65410:2;
        protocols { 
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

ELAN-BGP-QinQ-Range-Normalized-VLAN Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic froma rangeofVLANsonanendpointacrossaBGPnetwork

core usingQ-in-Qendpoint interface typesand flexible-ethernet-services as thephysical

encapsulation type. Services built from this service definitionmust useMXSeries devices

on the provider edge. Customer VLAN IDs are preserved across the network—traffic

passes among like customer VLAN IDs on any service provider VLAN in the broadcast

domain. Service provisioners can limit the bandwidth of services built from this service

definition to specific values from 10 Mbps through 100Mbps.

The following sections show the configuration data for a servicewith only twoendpoints,

SJC and SFO.

• Configuration on Endpoint A on page 560

• Configuration on Endpoint Z on page 561
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device SJC):

ge-0/0/6 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 2 {    
            encapsulation vlan-vpls;
            vlan-tags outer 2 inner-range 1500-2000;
            family vpls {
                filter {
                    input filter_in_ge-0/0/6_2;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/6_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/6_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/6_2;
                    accept;
                }
            }       
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-Range-Normalized-VLAN-SR1 {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/6.2;
        vlan-id all;
        route-distinguisher 65410:19;
        vrf-target target:65410:6;
        protocols {
            vpls {  
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/6.2;
                }
            }
        }
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    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SFO):

ge-0/0/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1 inner-range 1500-2000;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }   
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-Range-Normalized-VLAN-SR1 {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/1.1;
        route-distinguisher 65410:18;
        vrf-target target:65410:6;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
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            }
        }
    }

Related
Documentation

Predefined Service Definitions on page 451•

• Predefined E-Line Service Definitions on page 503

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 562

• Predefined Full Mesh IP Service Definitions on page 575

• Predefined Hub-and Spoke IP Service Definitions on page 576

Predefined Point-to-Multipoint Ethernet Service Definitions

The Connectivity Services Director application provides predefined service definitions

that a service provisioner can choose fromwhen creating a service order. This section

provides information about predefined service definitions used for creating

point-to-multipoint services. For information about predefined service definitions used

to create E-Line service definitions or multipoint-to-multipoint service definitions, see

the following topics:

• Predefined E-Line Service Definitions on page 503

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 536

If none of the point-to-multipoint predefined service definitions described here is

appropriate for your needs, you can create a service definition as described in “Creating

a Point-to-Multipoint E-LAN Service Definition” on page 641.

The Connectivity Services Director application provides predefined service definitions

for E-LAN services that use BGP switching in the network core. These services are

sometimes known as E-LAN services. This section covers point-to-multipoint (or

hub-and-spoke) service definitions.

Information specific to each service instance, such as the device name, endpoint name,

customer VLAN ID, andwhether a specific endpoint is a hub or a spoke is provided in the

serviceorder. Attributes that canapplyacrossmanyservice instancesare typically defined

in the service definition. These attributes include:

• Ethernet option (dot1.q, qinq)

• Traffic type (single VLAN, VLAN range, all traffic, VLAN list)

• VLAN normalization

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range
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Table 71 on page 563 lists each of the standard E-LAN service definitions. Each standard

service definition is then described in detail in the sections that follow.

Table 71: Standard Point-to-Multipoint Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries orMXSeries
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical encapsulation
type

• Rate limiting from 10 Mbps to 100Mbps with
10 Mbps increment

“ELAN-Hub-Spoke-QinQ-AllVLAN” on
page 502

• Multipoint Ethernet service for M Series and MX
Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical encapsulation
type

• Rate limiting from 10 Mbps to 100Mbps with
10 Mbps increment

“ELAN-Hub-Spoke-QinQ-AllVLAN-No”
on page 502

ELAN-Hub-Spoke-QinQ-AllVLAN-Normalized-All Service Definition

This service definition provides a base for creating point-to-multipoint Ethernet services

that transport all traffic onanendpointacrossaBGPnetworkcoreusingQ-in-Qendpoint

interface types and flexible-ethernet-services as the physical encapsulation type. VLAN

IDs are not preserved across the network—traffic passes from the single VLAN on an

endpoint to any VLANs in the broadcast domain. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 19 on page 501—a

point-to-multipoint service with one hub and two spokes.
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Figure 22: Point-to-Multipoint Service with One Hub

• Configuration on Endpoint A on page 564

• Configuration on Endpoint B on page 566

• Configuration on Endpoint Z on page 567

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device SFO). This device is configured as the

service hub.

interfaces {
    ge-0/0/2 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 4 {
            encapsulation vlan-vpls;
            vlan-tags outer 4;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_4;
                }
            }
        }
    }
policy-options {    
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-hm-export {
        term 1 {
            then {
                community add 
export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8;
                accept;
            }
        }
        term 2 {
            then reject;
        }
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    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-hm-import {
        term 1 {
            from {
                protocol bgp;
                community [ 
import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9 
import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 ];
            }
            then accept;
        }
        term 2 {
            then reject;
        }
    }
    community export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 
members target:65410:8;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 
members target:65410:8;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9 
members target:65410:9;
}
firewall {          
    family vpls {       
        filter filter_in_ge-0/0/2_4 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_4;
                    accept;
                }
            }
        }
    }
    policer policer_in_ge-0/0/2_4 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;
    }
}
routing-instances {
    ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/2.4;
        route-distinguisher 65410:15;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-hm-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-hm-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_2 {
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                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/2.4;
                }
            }
        }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device SJC). This device is a service spoke.

interfaces {
    ge-0/0/4 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 4 {
            encapsulation vlan-vpls;
            vlan-tags outer 4;
            family vpls {
                filter {
                    input filter_in_ge-0/0/4_4;
                }
            }
        }
    }

policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-export {
        term 1 {
            then {
                community add 
export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9;
                accept;
            }
        }
        term 2 {
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-import {
        term 1 {
            from {
                protocol bgp;
                community 
import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8;
            }
            then accept;
        }
        term 2 {    
            then reject;
        }
    }
    community export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9 
members target:65410:9;
    community import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 
members target:65410:8;
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}

firewall {
    family vpls {
        filter filter_in_ge-0/0/4_4 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/4_4;
                    accept;
                }
            }
        }
    }
    policer policer_in_ge-0/0/4_4 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }           
        then discard;
    }
}

routing-instances {
    ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/4.4;
        route-distinguisher 65410:16;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/4.4;
                }
            }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device Beijing). Thus device is a service spoke.

interfaces{
 ge-5/0/2 {
        unit 2 {
            encapsulation vlan-vpls;
            vlan-tags outer 2;
            family vpls {
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                filter {
                    input filter_in_ge-5/0/2_2;
                }
            }
        }
    }               

policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-export {
        term 1 {
            then {
                community add 
export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9;
                accept;
            }
        }
        term 2 {
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-import {
        term 1 {
            from {
                protocol bgp;
                community 
import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8;
            }
            then accept;
        }
        term 2 {
            then reject;
        }
    }
    community export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9 
members target:65410:9;
    community import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 
members target:65410:8;
}
firewall {
    family vpls {
        filter filter_in_ge-5/0/2_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-5/0/2_2;
                    accept;
                }
            }
        }
    }
    policer policer_in_ge-5/0/2_2 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;
    }
}
    ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All {
        instance-type vpls;
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        vlan-id all;
        interface ge-5/0/2.2;
        route-distinguisher 65410:14;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-5/0/2.2;
                }
            }
        }
    }
}

ELAN-Hub-Spoke-QinQ-AllVLAN Service Definition

This service definition provides a base for creating point-to-multipoint Ethernet services

that transport all traffic onanendpointacrossaBGPnetworkcoreusingQ-in-Qendpoint

interface types and flexible-ethernet-services as the physical encapsulation type.

CustomerVLAN IDsarepreservedacross thenetwork—trafficpassesamong likecustomer

VLAN IDs on any service provider VLAN in the broadcast domain. Service provisioners

can limit the bandwidth of services built from this service definition to specific values

from10Mbpsthrough100Mbps.Figure23onpage570showsapoint-to-multipointservice

with two hubs.

The following sections show the configuration data on endpoints A, B, and Z when you

use this service definition to create the service shown in Figure 23 on page 570—a

point-to-multipoint service with two service hubs and two spokes. The configuration for

endpoint Y is not described.
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Figure 23: Point-to-Multipoint Service with Two Hubs

• Configuration on Endpoint A on page 570

• Configuration on Endpoint B on page 572

• Configuration on Endpoint Z on page 573

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device SFO). This device is configured as a

service hub.

interfaces {
    ge-0/0/2 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 3 {
            encapsulation vlan-vpls;
            vlan-tags outer 3;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_3;
                }
            }
        }
    }

policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-hm-export {
        term 1 {
            then {
                community add export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4;

                accept;
            }
        }
        term 2 {    
            then reject;
        }
    }
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    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-hm-import {
        term 1 {
            from {
                protocol bgp;
                community [ import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 
import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 ];
            }
            then accept;
        }
        term 2 {
            then reject;
        }
    }
    community export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 members 
target:65410:5;
}

firewall {
    family vpls {  
        filter filter_in_ge-0/0/2_3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_3;
                    accept;
                }
            }
    }

    policer policer_in_ge-0/0/2_3 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;

}

    ELAN_Hub_Spoke_QinQ_AllVLAN {
        instance-type vpls;
        interface ge-0/0/2.3;
        route-distinguisher 65410:9;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN-hm-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN-hm-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
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                    interface ge-0/0/2.3;
                }
            }
        }
    }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device SJC). This device is configured as a

service hub.

interfaces {
  ge-0/0/4 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services
        unit 3 {
            encapsulation vlan-vpls;
            vlan-tags outer 3;
            family vpls {
                filter {
                    input filter_in_ge-0/0/4_3;
                }
           }
 }
policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-hm-export {
        term 1 {
            then {
                community add export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4;

                accept;
            }
        }
        term 2 {
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-hm-import {
        term 1 {
            from {
                protocol bgp;
                community [ import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 
import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 ];
            }
            then accept;
        }
        term 2 {
            then reject;
        }
    }
    community export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 members 
target:65410:5;
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}

firewall {
    family vpls {
        filter filter_in_ge-0/0/4_3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/4_3;
                    accept;
                }
            }
        }
 policer policer_in_ge-0/0/4_3 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;
    }

    ELAN_Hub_Spoke_QinQ_AllVLAN {
        instance-type vpls;
        interface ge-0/0/4.3;
        route-distinguisher 65410:10;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN-hm-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN-hm-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/4.3;
                }
            }
        }
    }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device Beijing). This device is configured as a

service spoke.

interfaces {
    ge-5/0/2 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 1 {
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            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-5/0/2_1;
                }
            }
        }
    }

policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-export {
        term 1 {
            then {
                community add export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5;
                accept;
            }
        }
        term 2 {
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-import {
        term 1 {    
            from {
                protocol bgp;
                community import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4;
            }
            then accept;
        }
        term 2 {
            then reject;
        }
    }
    community export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 members 
target:65410:5;
    community import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
}
firewall {
    family vpls {
        filter filter_in_ge-5/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-5/0/2_1;
                    accept;
                }
            }
        }
    policer policer_in_ge-5/0/2_1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;
    }
}
routing-instances {
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    ELAN_Hub_Spoke_QinQ_AllVLAN {
        instance-type vpls;
        interface ge-5/0/2.1;
        route-distinguisher 65410:8;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-5/0/2.1;
                }
            }
        }
    }

Related
Documentation

Creating a Point-to-Multipoint E-LAN Service Definition on page 641•

• Predefined E-Line Service Definitions on page 503

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 536

Predefined Full Mesh IP Service Definitions

The Connectivity Services Director application section provides information about

predefined service definitions used for creating IP full mesh services.

If neither of thepredefinedservicedefinitionsdescribedhere is appropriate for your needs,

you can create a service definition as described in “Creating a Full-Mesh IP Service

Definition” on page 669.

The Connectivity Services Director application provides predefined service definitions

for IP services that use the BGP or OSPF protocols.

Information specific to each service instance, such as the device name, endpoint name,

VLAN ID, Interface IP, PeerAS (BGP), andwhether youwant to allowaserviceprovisioner

to create static routes on the service, is provided in the service order.

Table 72 on page 576 lists each of the standard VPLS service definitions. Each standard

service definition is then described in detail in the sections that follow.
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Table 72: Standard Full-Mesh IP Service Definitions

Predefined Service Attributes
Standard Service Definition
Name

• VLAN ID selection: Auto pick

• Route target: Auto pick

• Route distinguisher: Auto pick

• Allowed Routing Protocols

• OSPF/Static Route

• BGP/Static Route

• BGP/OSPF/Static Route

L3VPN-OSPF-STATIC L3 VPN
(Full Mesh)

• VLAN ID selection : Auto pick

• Route target: Auto pick

• Route distinguisher: Auto pick

• Allowed Routing Protocols

• OSPF/Static Route

• BGP/Static Route

• BGP/OSPF/Static Route

L3VPN-BGP-STATIC L3 VPN
(Full Mesh)

Related
Documentation

Creating a Full-Mesh IP Service Definition on page 669•

• Predefined Service Definitions on page 451

• Predefined E-Line Service Definitions on page 503

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 536

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 562

• Predefined Hub-and Spoke IP Service Definitions on page 576

Predefined Hub-and Spoke IP Service Definitions

The Connectivity Services Director application provides predefined service definitions

thatuseBGPorOSPF routingprotocols that you, theserviceprovisioner, canuse tocreate

a service order. Youmust have a Service Designer user role to use IP hub-and-spoke

service definitions.

Youviewpredefinedandcustomservicedefinitions in theServiceDesign>ManageService

Definitions inventory page. You can view service definition details or attributes in the

Manage Service Definitions inventory page by clicking the service definition.

You can also view service instance details by selecting Service Provisioning > Deploy

Services >Manage Service Orders in Deploy mode of Service View.

Table 73onpage577describes thepredefinedor standardhub-and-spoke (one interface)

service definitions and their preconfigured service attributes. You can not reconfigure

attributes in these predefined services. However, if you need custom attributes, create
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a new hub-and-spoke service definition to use, as described in the Creating a IP

Hub-and-Spoke Service Definition topic.

Table 73: Standard Hub-and-Spoke Service Definitions

Predefined Service AttributesDescription
Standard Service
Definition Name

• VLAN ID selection: Auto pick

This attribute is editable in the service order.

• Route target: Auto pick

• Pick VLANwithin this range: N/A

• Route target: Auto pick

• Route distinguisher: Auto pick

This attribute is editable in the service order.

The VRF table label option is selected.

• Allowed Routing Protocols: OSPF/Static Route

L3VPN Hub and Spoke 1
interface with OSPF/Static as
PE-CE routing protocol

L3VPN-OSPF-Static
(Hub-Spoke-1-Interface)

• VLAN ID selection: Auto pick

This attribute is editable in the service order.

• Route target: Auto pick

• Pick VLANwithin this range: N/A

• Route target: Auto pick

• Route distinguisher: Auto pick

This attribute is editable in the service order.

The VRF table label option is selected.

• Allowed Routing Protocols: BGP/Static Route

L3VPN Hub and Spoke 1
interface with BGP/Static as
PE-CE routing protocol

L3VPN-BGP-Static
(Hub-Spoke-1-Interface)

Related
Documentation

• Viewing Service Definitions on page 615

• Creating a Hub-and-Spoke (One Interface) IP Service Definition on page 678

• Creating a Full-Mesh IP Service Definition on page 669
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CHAPTER 25

Service Design: Managing E-Line Service
Definitions

• ChoosingaPredefinedServiceDefinitionorCreatingaNewServiceDefinitiononpage579

• Creating an E-Line ATM or TDM Pseudowire Service Definition on page 604

• Modifying a Custom Service Definition on page 612

• Publishing a Custom Service Definition on page 613

• Unpublishing a Custom Service Definition on page 614

• Deleting a Customized Service Definition on page 614

• Viewing Service Definitions on page 615

Choosing a Predefined Service Definition or Creating a New Service Definition

TheConnectivityServicesDirector softwareprovidesasetofpredefinedservicedefinitions

for E-Line services, multipoint-to-multipoint E-LAN (full mesh) services, and

point-to-multipointE-LAN(hubandspoke)services.Theseservicedefinitionsarecapable

of providing the basis formost of the service orders your organizationwill need to create.

In case these predefined service definitions are not adequate for all your needs, however,

the Connectivity Services Director software enables you to create service definitions of

your own.

The following topics review the predefined service definitions and provide instructions

on creating your own.

• Choosing a Predefined Service Definition on page 579

• Creating an E-Line Service Definition on page 585

Choosing a Predefined Service Definition

Table 74 on page 580 lists the predefined service definitions that Junos Space provides

for E-Line services that use LDP in the network core. Table 75 on page 582 lists the

predefined service definitions for multipoint-to-multipoint (full mesh) services.

Table 72 on page 576 lists the predefined service definitions for point-to-multipoint (hub

and spoke) services.
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Table 74: Standard E-Line Service Definitions

Service Attributes
Standard Service Definition
Name

• E-Line service for M Series and MX Series devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-Dot1q-SingleVLAN

• E-Lineservice for JSeries,MSeries, andMXSeriesdevices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-Dot1q-SingleVLAN-CCC

• E-Lineservice for JSeries,MSeries, andMXSeriesdevices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-Dot1q-SingleVLAN-Ext-CCC

• E-Lineservice for JSeries,MSeries, andMXSeriesdevices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Port-based UNI

• Rate limiting default 10 Mbps

ELine-PortBased

• E-Line service for M Series and MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• All customer traffic

• Flexible-ethernet-services physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-AllVLAN

• E-Lineservice for JSeries,MSeries, andMXSeriesdevices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• All customer traffic

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-AllVLAN-CCC
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Table 74: Standard E-Line Service Definitions (continued)

Service Attributes
Standard Service Definition
Name

• E-Lineservice for JSeries,MSeries, andMXSeriesdevices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• All customer traffic

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-AllVLAN-Ext-CCC

• E-Line service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• Customer traffic is range of VLANs

• Flexible-ethernet-services physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-VLANRange

• E-Line service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• Customer traffic is range of VLANs

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-VLANRange-CCC

• E-Line service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• Customer traffic is range of VLANs

• Extended-vlan-ccc physical encapsulation

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-VLANRange-Ext-CCC

• Ethernet service for M/MX/ACX device family

• Gigabit Ethernet interface

• Q-in-Q endpoint interface type

• Transport all traffic

• Flexible-ethernet-services physical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

Eline-BGP-QinQ-AllVLAN
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Table 74: Standard E-Line Service Definitions (continued)

Service Attributes
Standard Service Definition
Name

• Ethernet service for M/MX/ACX device family

• Gigabit Ethernet interface

• 802.1Q endpoint interface types

• Single VLAN traffic

• Flexible-ethernet-services physical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

Eline-BGP-Dot1q-SingleVLAN

• Ethernet service for M/MX/ACX device family

• Gigabit Ethernet interface

• Port-based UNIs

• Ethernet-ccc physical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

Eline-BGP-PortBased

Table 75: Standard Multipoint-to-Multipoint Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs not preserved

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-Dot1q-Normalized-VLAN-None

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-Dot1Q-SingleVLAN
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Table 75: Standard Multipoint-to-Multipoint Service Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint-to-multipoint Ethernet
service for M series and MX Series
devices

• Gigabit Ethernet interfaces

• Port-based UNIs

• Transports all customer traffic

• Ethernet VPLS as physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-PortBased

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-QinQ-AllVLAN

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint circuit types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-QinQ-AllVLAN-Normalized-All

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• VLAN IDs not preserved

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-QinQ-AllVLAN-Normalized-None-10-100M
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Table 75: Standard Multipoint-to-Multipoint Service Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint circuit types

• Transports specified VLAN range

• Flexible Ethernet services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-QinQ-Range-Normalized-VLAN

Table 76: Standard Point-to-Multipoint Service Definitions

Service AttributesStandard Service Definition Name

• Point to-multipoint Ethernet service for M Series and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-servicesphysicalencapsulation type

• Rate limiting from 10Mbps to 100Mbpswith 10Mbps
increment

ELAN-Hub-Spoke-QinQ-AllVLAN

• Point-to-multipoint Ethernet service for M Series or
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-servicesphysicalencapsulation type

• Rate limiting from 10Mbps to 100Mbpswith 10Mbps
increment

ELAN-Hub-Spoke-QinQ-AllVLAN-No

Manyof the serviceattributes canbeedited in the serviceorder,whichallows the flexibility

for creating most of the service orders you will need from these predefined service

definitions.

To view the contents of a predefined service definition, follow these steps:

1. in the Network Services > Connectivity view pane, select Service Design >Manage

Service Definitions.

TheManage Service Definitions page appears and shows all the service definitions

present on your system.
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2. Double click the predefined service definition you want to review.

Details of the service definition replace theManage Service Definitions page.

TIP: If predefined and customized service definitions both exist on your
system, you can easily find the predefined ones in the service definition
inventory page.

3. When you are done reviewing the service definition, clickBack to return to theManage

Service Definitions page.

For detailed descriptions of each of the predefined service definitions and their service

attributes, see “Predefined Service Definitions” on page 451

Creating an E-Line Service Definition

Use this procedure to create a definition for an E-Line service. The standard service

definitions that camewith your initial software installationaredesigned tobeappropriate

formost requirements. You canalso create a customized service definition—for example,

to set different bandwidth limits on the service than those offered in the standard service

definitions.

After the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating E-Line services on the network.

The windows appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

To create an E-Line service definition, complete these tasks, in the order shown:

1. Specifying General Information on page 586

2. Specifying UNI Settings on page 589

3. Specifying Connectivity InformationWhen Signaling Is LDP on page 600

4. Specifying Connectivity InformationWhen Signaling Is BGP on page 601

5. Reviewing the Configured Settings on page 603
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Specifying General Information

Awizard is available to create a service order in an intuitive and easily-navigable format.

The settings that you can configure in the service order are organized in separate pages

of the wizard, which you can launch by clicking the appropriate buttons at the top of the

Create a Service Definition page. Alternatively, you can proceed to the corresponding

setting-related pages by clicking the Back and Next buttons at any point in the wizard

during the creation of the service definition.

To specify the general information for an E-Line service definition:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. in the Network Services > Connectivity view pane, select Service Design >Manage

Service Definitions.

• Select E-Line to create an E-Line service definition.

• Select E-LAN to create an E-LAN service definition.

• Select IP to create an IP service definition.

TheManage Service Definitions page displays an inventory of all available E-Line

service definitions.

4. Click the New icon at the top of the lower half of the page that displays previously

created service orders, and click E-Line from the Select Service Type dialog box

appears. The General settings window appears.

5. Fill in the fields in the Generalwindow.

ActionField

Enter a name for the service definition.Service Definition Name

By default, the service type is E-Line .Service Type

Select a signaling type:

• BGP

• LDP

You cannot edit the Signaling type in the service order.

NOTE: If the signaling type is BGP, the Static Pseudowire and
the Enable PWAccess to L3 VPNNetwork check boxes are not
available. You cannot edit the Signaling type in the service
order.

Signaling
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ActionField

Enter a brief description or other comment that you want to
appear in the Service Definition table.

Range: 0 through 200 characters. Spaces and special
characters are allowed.

Description (Optional)

When you enableQoS in the service definition, you can specify
a QoS profile in the service order to classify traffic into defined
servicegroups toprovide the special treatmentof traffic across
the network service. For example, voice traffic can be sent
across certain links, and data traffic can use other links.

Enable QoS

Select the interface type:

• Ethernet

• TDM

• ATM

Pseudowire Type

Select an instance type to specify the type of routing instance
for the E-Lan service:

• l2vpn

• evpn-vpws

Instance Type

Toenable staticpseudowire, select theStaticPseudowirecheck
box. This check box is disabled if the signaling type is BGP.

Static Pseudowire

To enable the pseudowire access to L3 VPN network, select
theEnablePWAccess toL3VPNNetwork checkbox. This check
box is disabled if the signaling type is BGP, or if you have
selected the interface type as TDM/ATM.

If you select this check box, the Enable Multi Segment
Pseudowire check box is disabled.

Enable PWAccess to L3 VPNNetwork

Select this checkbox topair any twoN-PEdevices, forproviding
redundant connectivity.

When you select this check box, a Multihoming Mode list
appears based on the instance type. If you select evpn-vpws
instance type, you can select either single-active or all-active
as the multihomingmode.

Enable Multihoming

587Copyright © 2019, Juniper Networks, Inc.

Chapter 25: Service Design: Managing E-Line Service Definitions



ActionField

Select this check box to enable multi-segment pseudowire.

If you select this check box, the Enable PWAccess to L3 VPN
Network check box is disabled.

A multi-segment pseudowire (MS-PW) is a static or
dynamically configured set of two or more contiguous
pseudowire segments that behave and function as a single
E-Line pseudowire. Each end of an MS-PW, by definition,
terminates on a T-PE.

NOTE: The number of pseudowire segments that you can
stitch is limited to two.

For more information on E-Line pseudowire stitching, see
“Stitching Two E-Line Pseudowires” on page 807.

Enable Multi Segment Pseudowire

To enable the pseudowire resiliency, select the Enable PW
Resiliency check box. For more information on pseudowire
redundancy, see “Redundant Pseudowires for Layer 2 Circuits
and VPLS” on page 95.

Enable PWResiliency

Bydefault, all the events are saved in theOpenNMSdatabase.
To isolate the events related to an interface in the OpenNMS,
select theDecoupleServiceStatus FromPort Status check box.

NOTE: When you select this check box, only the pseudowire
traps aremonitored, and not the interface-related traps (such
as jnxVpnIfUp or jnxVpnIfDown).

Decouple Service Status FromPort Status

(Optional) To include a service template for the service, click
the Add icon or plus sign (+) to select a service template from
theServiceTemplate list. The list of available service templates
is displayed. Select the check box beside the template you
want and clickOK. You are returned to the General Settings
page.

The selected service template appears in the Default Service
Template field.

You can select one or more service templates as the default
service template. By default, the default service templates are
attached to the endpoints.

NOTE: You cannot add or delete a service template while
creating a service order.

The remaining service templates on the Service Template list
are termed as optional service templates. You can attach the
optional service templates to the endpoints on a need basis.

In theViewServiceDefinitionDetailswindow, the value for the
default service template in the Default Service Template
column is True.

For instructions on creating a service template, see “Creating
a Service Template” on page 1711.

Service Template
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ActionField

If you intend to run performance tests on services based on
this service definition, select a TCA Profile.

Threshold alarm profile

6. Click Next to save the information. You can proceed to “Specifying UNI Settings” on

page 589.

Specifying UNI Settings

In this step, youprovide theUNI serviceattributes for this servicedefinition. Theattributes

you set depend on whether you are setting attributes for a port, an 802.1Q interface, a

Q-in-Q interface, or a flexible VLAN tagging:

• Specifying UNI Settings for Port-to-Port Services on page 589

• Specifying UNI Settings for Services with 802.1Q Interface Types on page 591

• Specifying UNI Settings for Services with Q-in-Q Interface Types on page 594

• UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface

Types) on page 597

Specifying UNI Settings for Port-to-Port Services

To set UNI attributes for a port-to-port service, complete the following procedure.

1. Enter information in the UNI Settings window.

2. Fill in the fields in the UNI Settingswindow according to the following table.

ActionField

Traffic Treatment Settings

Select port from the list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet Option

This option is disabled. For port-to-port services, all traffic is always transported.Customer Traffic Type

In port-to-port services, all traffic and all VLANs on one port are transported to all other ports.VLAN ID Selection

For port-to-port services, VLAN normalization is disabled.VLANNormalization

Select this check box to allow the service provisioner to override the MTU setting.Editable in Service Order

Interface Settings

Selectethernet-vpls, theonly validphysical interfaceencapsulationmethodallowed forport-to-port
services.

Physical Interface
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ActionField

You cannot change this field because it is not relevant to port-to-port services.Logical Interface

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522 bytes.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTURange (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Calculate Burst Size list is enabled only when you select the Enable rate limiting check
box.

Calculate Burst Size

Bandwidth Settings

If you select this check box, you can override the MTU setting.Enable Rate Limiting
(check box)

Specify the default bandwidth value, in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

DefaultBandwidth(Mbps)

To override the default bandwidth value, select the Editable in Service Order check box.

Specify the minimum bandwidth value in Kbps:

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)
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ActionField

Specify the maximum bandwidth value, in Mbps.

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and ACX Series Routers:

Table 77: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

Specify a value in the range that is made available to the service provisioner.Increment (Kbps)

3. Click Next to proceed to specify the connectivity settings.

Specifying UNI Settings for Services with 802.1Q Interface Types

To set UNI attributes for a 802.1Q service, complete the following procedure.

1. To set UNI attributes for 802.1Q interfaces:

2. Fill in the fields in the UNI Settingswindow according to the following table:

ActionField

Traffic Treatment Settings

Select dot1q from the list.

The window expands to include options specific to dot1q interfaces.

Ethernet Option
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ActionField

Specify the customer traffic type.

• Select Transport Single VLAN to transport traffic for a specific VLAN across the network. When
you select this option, the service provisioner is prompted for the VLAN-ID when creating a
service order based on this service definition. You need to specify theOuter Tag protocol ID.

• Select Transport VLAN List to limit traffic across the network to a specific list of VLANs. If you
select this option, the serviceprovisioner is prompted for theVLAN-ID listwhencreatinga service
order based on this service definition.

The VLAN List can consist of a single VLAN-ID or a combination of single VLAN-ID andVLAN-ID
range separated by commas.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer Traffic Type

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually—Allows the service provider to specify the VLAN ID. This option is normally
used when no VLAN normalization is applied.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID range in VLAN range for manual input.

• Auto pick—This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

NOTE: When the range of VLAN IDs that are automatically assigned by the system (with the
auto-pick option enabled during the creation of a service definition) is less than or greater than
the range of VLAN IDs that are manually specified (with the manual selection option enabled
during the creation of a service definition), the following conditions apply during the creation of a
serviceorderwith theEditable inServiceOrder checkbox selectedduring servicedefinitioncreation:

• If you create a service order with the auto-pick option enabled, the VLAN ID is selected from the
auto-pick range, and the value is displayed in the VLAN range for manual input field. If you
attempt to change the VLAN IDmanually, the value is restricted to the manually configured
range.

• If you create a service order with the auto-pick option disabled, the VLAN ID is selected from
themanually configured range, and the value is displayed in the VLAN range for manual input
field. If you attempt to change the VLAN IDmanually, the value is restricted to the manually
configured range.

VLAN ID Selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer Traffic Type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPIDs) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer Traffic Type is Transport Single
VLAN or Transport Vlan List.

Inner Tag protocol ID

Select this check box to allow the service provisioner to override the MTU setting.Editable in service order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical Interface

Constrained by your selection in the Physical Interface box. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical Interface

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTURange (Bytes)

Calculation of Burst-Size
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ActionField

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Calculate Burst Size list is enabled only when you select the Enable rate limiting check
box.

Calculate Burst Size

3. Click Next to continue with connectivity settings.

Specifying UNI Settings for Services with Q-in-Q Interface Types

To set UNI attributes for a Q-in-Q service, complete the following procedure.

1. To set UNI attributes for Q-in-Q interfaces:

2. Fill in the fields in the UNI Settingswindow according to the following table:

ActionField

Traffic Treatment Settings

Select qinq from the list.

The window expands to include options specific to Q-in-Q interfaces.

Ethernet Option

Specify the customer traffic type:

• Transport All Traffic—Transports the traffic fromall VLANs across the network.When you select
this option, the service provisioner is prompted for the VLAN-ID when creating a service order
based on this service definition. You need to specify only theOuter Tag protocol ID.

• Transport Single VLAN—Transports traffic for a specific VLAN across the network. You need to
specify bothOuter Tag protocol ID and Inner Tag protocol ID.

• Select Transport VLAN List to limit traffic across the network to a specific list of VLANs. You
need to specify only theOuter Tag protocol ID.

If you select this option, the service provisioner is prompted for the VLAN-ID list when creating
a service order based on this service definition. The VLAN List can consist of a single VLAN-ID
or a combination of single VLAN-ID and VLAN-ID range separated by commas.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer Traffic Type
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ActionField

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually—Allows the service provider to specify the VLAN ID. This option is normally
used when no VLAN normalization is applied.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID range in VLAN range for manual input.

• Auto pick—This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

NOTE: When the range of VLAN IDs that are automatically assigned by the system (with the
auto-pick option enabled during the creation of a service definition) is less than or greater than
the range of VLAN IDs that are manually specified (with the manual selection option enabled
during the creation of a service definition), the following conditions apply during the creation of a
serviceorderwith theEditable inServiceOrder checkbox selectedduring servicedefinitioncreation:

• If you create a service order with the auto-pick option enabled, the VLAN ID is selected from the
auto-pick range, and the value is displayed in the VLAN range for manual input field. If you
attempt to change the VLAN IDmanually, the value is restricted to the manually configured
range.

• If you create a service order with the auto-pick option disabled, the VLAN ID is selected from
themanually configured range, and the value is displayed in the VLAN range for manual input
field. If you attempt to change the VLAN IDmanually, the value is restricted to the manually
configured range.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer Traffic Type is Transport single VLAN, Transport
VLAN List, or Transport all Traffic:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPIDs) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag protocol ID
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ActionField

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You can specify the Inner Tagprotocol IDonly if theCustomerTraffic Type is Transport single
VLAN.

Inner Tag protocol ID

Select this check box to allow the service provisioner to override the MTU setting.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical Interface

Constrained by your selection in the Physical Interface box. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical Interface

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTURange (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Calculate Burst Size list is enabled only when you select the Enable rate limiting check
box.

Calculate Burst Size

3. Click Next to continue with connectivity settings.
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UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface Types)

Youcanspecify theEthernet optionasymmetric tagdepth to createa service that includes

any combination of port-based interfaces, 802.1Q interfaces, and Q-in-Q interfaces.

1. Enter information in the UNI Settings window.

2. Specify the UNI Settings for asymmetric tag depth according to the following table:

ActionField

Traffic Treatment Settings

Select asymmetric tag depth from the list.Ethernet Option

Select the customer traffic type:

• Transport All Traffic—Transports the traffic fromall VLANs across the network.When you select
this option, the service provisioner is prompted for the VLAN-ID when creating a service order
based on this service definition. You need to specify only theOuter Tag protocol ID and Inner Tag
protocol ID.

• Transport Single VLAN—Transports traffic for a specific VLAN across the network. You need to
specify bothOuter Tag protocol ID and Inner Tag protocol ID.

• Select Transport VLAN List to limit traffic across the network to a specific list of VLANs. You
need to specify theOuter Tag protocol ID.

If you select this option, the service provisioner is prompted for the VLAN-ID list when creating
a service order based on this service definition.

The VLAN List can consist of a single VLAN-ID or a combination of single VLAN-ID andVLAN-ID
range separated by commas.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer Traffic Type

597Copyright © 2019, Juniper Networks, Inc.

Chapter 25: Service Design: Managing E-Line Service Definitions



ActionField

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually—Allows the service provider to specify the VLAN ID. This option is normally
usedwhennoVLANnormalization is applied.Specify theVLAN ID range inVLANrangeformanual
input.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Auto pick—This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID pool in VLAN range for auto-pick.

NOTE: When the range of VLAN IDs that are automatically assigned by the system (with the
auto-pick option enabled during the creation of a service definition) is less than or greater than
the range of VLAN IDs that are manually specified (with the manual selection option enabled
during the creation of a service definition), the following conditions apply during the creation of a
serviceorderwith theEditable inServiceOrder checkbox selectedduring servicedefinitioncreation:

• If you create a service order with the auto-pick option enabled, the VLAN ID is selected from the
auto-pick range, and the value is displayed in the VLAN range for manual input field. If you
attempt to change the VLAN IDmanually, the value is restricted to the manually configured
range.

• If you create a service order with the auto-pick option disabled, the VLAN ID is selected from
themanually configured range, and the value is displayed in the VLAN range for manual input
field. If you attempt to change the VLAN IDmanually, the value is restricted to the manually
configured range.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer Traffic Type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPIDs) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag protocol ID
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ActionField

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer Traffic Type is Transport all
traffic.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical Interface

Constrained by your selection in the Physical Interface box. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical Interface

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTU Range (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Calculate Burst Size list is enabled only when you select the Enable rate limiting check
box.

Calculate Burst Size

3. Click Next to continue with specifying the connectivity settings.
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Specifying Connectivity InformationWhen Signaling Is LDP

The fields displayed in the Connectivitywindow depend on the Signaling type (LDP or

BGP) that you selected in the General settings window.

To specify connectivity between sites across the network when signaling is LDP:

1. Fill in the fields in the Connectivitywindow.

ActionField

The VC ID selection is available only if the Signaling type is LDP.

In theVCIDselectionbox, specify howyouwant theVC ID tobechosenduring serviceorder creation:

• To allow the service provisioner to enter the VC ID, choose Selectmanually.

• To cause the Junos Space software to assign a VC ID automatically from the VC ID pool, select
Auto pick.

To allow the service provisioner to override the setting in the VC ID box, select Editable in Service
Order.

VC ID selection

In the Default MTU box, specify the MTU across the service provider network.

To allow the service provisioner to override the MTU setting, select Editable in Service Order. In the
MTU range, enter the highest and lowest MTU that the service provisioner can enter.

Default MTU

This field is available if you selected the Enable PWResiliency check box and if the Signaling is LDP
in the General settings.

Revert time (sec)—Revert time for redundant Layer 2 circuits and VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

Revert time (sec)

This field is available if you selected the EnablePWResiliency check box and if theSignaling is LDP,
in the General settings.

Switch Over Delay (sec)—Delay to wait before the backup pseudowire takes over.

Default: 0 second

Range: 0 through 180 seconds

Switch Over Delay (sec)

The options available in the VLAN normalization drop-down list are based on the value set for the
Ethernet interface.

VLANNormalization

This field is available if you selected the Static pseudowire check box in the General settings. By
default, the outgoing label selection is limited to manual.

Outgoing label selection
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The following table presents the available VLAN normalization options:

VLANNormalizationCustomer Traffic TypeEthernet Option

Normalization not required

Normalization to Dot1q tag

Normalization to QinQ tags

N/Aport

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport Single VLANdot1q

Normalization not requiredTransport VLAN Range

Normalization not requiredTransport VLAN List

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport All Trafficqinq

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport Single VLAN

Normalization not requiredTransport VLAN Range

Normalization not requiredTransport VLAN List

(Identical to qinq)(Identical to qinq)asymmetric tag
depth

2. Click Finish to complete the service definition.

Specifying Connectivity InformationWhen Signaling Is BGP

To specify connectivity between sites across the network when signaling is BGP, fill in

the fields in the Connectivity window:

1. When the signaling type is BGP, fill in the fields in the Connectivitywindow.
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• Route Distinguisher—Identifier attached to a route, enabling you to distinguish to

which VPN the route belongs. Each routing instancemust have a unique route

distinguisher associated with it.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

• Route Target—Allows you to distribute VPN routes to only the routers that need

them.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

• Default MTU (Bytes)—The default MTU established by the system.

• MTU range (Bytes)—Specify the range, in bytes, for the MTU.

• VLANnormalization—Theoptionsavailable in theVLANnormalization fieldarebased

on the value set for the Ethernet interface. The following table presents the options.
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VLANNormalizationCustomer Traffic TypeEthernet Option

Normalization not required

Normalization to Dot1q tag

Normalization to QinQ tags

N/Aport

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport Single VLANdot1q

Normalization not requiredTransport VLAN Range

Normalization not requiredTransport VLAN List

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport All Trafficqinq

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport Single VLAN

Normalization not requiredTransport VLAN Range

Normalization not requiredTransport VLAN List

(Identical to qinq)(Identical to qinq)asymmetric tag
depth

NOTE: For a description of how the Connectivity Services Director
softwaremanipulates VLANs, see “Understanding VLANManipulation
(Normalization and VLANMapping) on Ethernet Services” on page 89.

2. Click Review to analyze and verify the configured attributes for the service definition.

Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

603Copyright © 2019, Juniper Networks, Inc.

Chapter 25: Service Design: Managing E-Line Service Definitions



configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.

NOTE: On the Review page, in the Service Templates section, the names of
the service templates with which the service definition is associated are
displayed. The Default Service Template column indicates whether the
attached template is the default template.

To examine andmodify the configured service definition settings:

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

3. Click Finish to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

When the service definition is successfully created, you are returned to the Manage

Service Definitions window.

Related
Documentation

Creating an E-Line ATM or TDM Pseudowire Service Definition on page 604•

• Creating an E-Line Service Definition

• Publishing a Custom Service Definition on page 613

• Unpublishing a Custom Service Definition on page 614

• Deleting a Customized Service Definition on page 614

• Viewing Service Definitions on page 615

Creating an E-Line ATM or TDMPseudowire Service Definition

This procedure provides the steps to create adefinition for an E-LineATMorTDMservice.

The standard service definitions that came with your initial software installation are

designed to be appropriate for most requirements. You can also create a customized
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service definition—for example, to set different bandwidth limits on the service than

those offered in the standard service definitions.

After the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating E-Line ATM or TDM services on the network.

The windows appear in the order shown. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

To create an E-Line service definition, complete these tasks, in the order shown:

1. Specifying General Information for the ATM or TDM Service on page 605

2. Specifying UNI Settings for ATM and TDM Service Definitions on page 608

3. Specifying UNI Settings for ATM Interfaces on page 608

4. Specifying UNI Settings for TDM Interfaces on page 608

5. Specifying Connectivity Information for an ATM or a TDM Service on page 609

6. Reviewing the Configured Settings on page 611

Specifying General Information for the ATM or TDMService

1. In the Build mode of the Network Services > Connectivity task pane, select Service

Design >Manage Service Definitions > New> E-Line Service Definition.

The first Create E-Line Service Definitionwindow appears.

2. In the Name box, type a name for the service definition.

3. Select the signaling type:

• LDP

• BGP

NOTE: If the signaling type is BGP, the Static pseudowire, Enable PW

Resiliency, Enable Multi Segment Pseudowire and the Enable PW access to

L3 VPN network check boxes are not available.

4. (Optional) In the Description box, type a brief description or other comment that you

want to appear in the Service Definition table.

5. (Optional) For an ATM or TDM service, only l2vpn instance type is available if the

signaling type is BGP.

The instance type field is not available for LDP signaling type.
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6. TheEnableMultihoming checkbox is optional and is not available if the signaling type

is LDP.

7. (Optional) To include a service template for the service, click theAdd icon or plus sign

(+) to select a service template from the Service Template list. The list of available

service templates is displayed. Select the check box beside the template you want

and clickOK. You are returned to the General Settings page.

The selected service template appears in the Default Service Template field.

You can select one or more service templates as the default service template. By

default, the default service templates are attached to the endpoints.

NOTE: Youcannotaddordeleteaservice templatewhilecreatingaservice
order.

The remaining service templates on the Service Template list are termed as optional

service templates. You can attach the optional service templates to the endpoints

on a need basis.

In theViewServiceDefinitionDetailswindow, thevalue for thedefault service template

in the Default Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on

page 1711.

8. Select the interface type. If you select TDM or ATM as the interface type, the Enable

PW access to L3 VPN network check box is unavailable.

9. Select the Enable Multi Segment Pseudowire check box to enable multi-segment

pseudowire. This check box is available for LDP signaling only

Amulti-segment pseudowire is a static or dynamically configured set of two or more

contiguous pseudowire segments that behave and function as a single E-Line

pseudowire. Each end of a multi-segment pseudowire, by definition, terminates on a

T-PE.

NOTE: The number of pseudowire segments that you can stitch is limited
to two.

For more information on E-Line pseudowire stitching, see “Stitching Two E-Line

Pseudowires” on page 807.

10. Select theStaticpseudowirecheckbox to indicatewhether theE-Line servicedefinition

is a static pseudowire.
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11. To enable the pseudowire resilency, select the Enable PWResiliency check box. For

more information on pseudowire redundancy, see “Redundant Pseudowires for Layer

2 Circuits and VPLS” on page 95.

12. By default, all the events are saved in the OpenNMS database. To isolate the events

related to an interface in the OpenNMS, select the Decouple Service Status FromPort

Status check box.

NOTE: When you select this check box, only the pseudowire traps are
monitored, and not the interface-related traps (such as jnxVpnIfUp or
jnxVpnIfDown).

13. Click Next to continue to the Connectivity Settingswindow.
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Specifying UNI Settings for ATM and TDMService Definitions

In this step, youprovide theUNI serviceattributes for this servicedefinition. Theattributes

you set depend on whether you are setting attributes for an ATM or for a TDM interface.

Specifying UNI Settings for ATM Interfaces

To specify the UNI settings for ATM interfaces:

1. Fill in the fields as indicated in the table.

ActionField

Select the type of encapsulation to apply to the interface. Use atm-ccc-cell-relay for ATM cell relay
encapsulation. Use atm-ccc-cell-mux for ATM VC for CCC.

Physical Interface
Encapsulation

Select the virtual path identifier (VPI).

The combination of the VPI and VCID defines the next destination for a cell in the ATM network.

Autopick VPI

Select the virtual channel identifier (VCID)—This integer uniquely identifies the virtual circuit that the
service uses.

The VCID can be either set automatically by the Junos Space software, or the service provisioner can
set it manually in the service order. The service definition can force the system to pick the VCID, force
the service provisioner to pick the VCID, or allow the service provisioner to override the settings in the
service definition.

We recommend allocating the VCID automatically; however, service providers with their own systems
for allocating VCIDs may choose themanual setting.

In the previous example, by default, the system picks a VCID from its pool automatically, but allows
the service provisioner to override this value in the service order. Clear the check box to override the
servicedefinition setting.The formexpands to includeanadditional field for entering theVCIDmanually.

Autopick VCI

The range for the cell bundle size can be 1 through 34.Cell bundle size

2. Click Next to go to the Connectivity Settingswindow.

Specifying UNI Settings for TDM Interfaces

To specify the UNI settings for TDM interfaces:

1. Select the type of Physical Interface Encapsulation.

• SAToP—Structure-Agnostic time-divisionmultiplexing (TDM)overPacket (SAToP),

as defined in RFC 4553, Structure-Agnostic TDM over Packet (SAToP) is used for

pseudowire encapsulation for TDM bits (T1, E1). The encapsulation disregards any

structure imposed on the T1 and E1 streams, in particular the structure imposed by

standard TDM framing. SAToP is used over packet-switched networks, where the

provider edge (PE) routers do not need to interpret TDM data or participate in the

TDM signaling.
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• CESoPSN—Circuit Emulation Service over Packet-Switched Network (CESoPSN)

bundle represents an IP circuit emulation flow. With CESoPSN bundles, you can

groupmultiple DS0s on one IP circuit, and you can havemore than one circuit

emulation IP flow created from a single physical interface. For example, some DS0

channels from a T1 interface can go in an IP flow to destination A, and other DS0

channels from that same T1 interface can go to destination B.

NOTE: ThePhysical InterfaceEncapulsation is not editable in serviceorder.

2. Fill in the SAToP and CESoPSN fields as indicated in the table.

Default ValueValue RangeSAToP Field

5M Series: 1 through 340Jitter buffer

There is no default value for the jitter buffer on
BX7000 Gateway devices. Youmust specify a
value.

2550 through 255Idle pattern

20%1 through 100%Excessive packet loss rate

192

NOTE: For M Series, the value you specify must
be amultiple of 32.

M Series: 64 through 1024Payload size

NOTE: If the Physical Interface
Encapulsation type is CESoPSN, the
Payload size is unavailable.

3. Click Next to go to the Connectivity Settingswindow.

Specifying Connectivity Information for an ATM or a TDMService

In this step, you specify the attributes that define the connectivity between remote sites

across the service provider network. A sample window follows.
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1. Provide the following information to create connectivity between sites across the

network:

ActionField

This box is available only if the Signaling is LDP.VC ID selection

Specify how you want the VC ID chosen during service order creation:

• To allow the service provisioner to type the VC ID, choose Selectmanually.

• To cause the Junos Space software to assign a VC ID automatically from the VC ID pool, select
Auto pick.

To allow the service provisioner to override the setting in the VC ID box, select Editable in Service
Order.

This check box is available only if the signaling type is BGP.Enable Multihoming

Specify the MTU across the service provider network.Default MTU (Bytes)

To allow the service provisioner to override the MTU setting, select Editable in Service Order.

Specify the highest and lowest MTU that the service provisioner can type.MTU range (Bytes)

Range: 1522 bytes through 9192 bytes

This box is available only if the Signaling is LDP.Revert time (sec)

Revert time for redundant Layer 2 circuits and VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

This box is available only if the Signaling type is LDP.Switch Over Delay (sec)

Specify the delay to wait before the backup pseudowire takes over.

Default: 0 second

Range: 0 through 180 seconds

This box is available only if the Signaling type is BGP.Route Distinguisher

Specify an identifier attached to a route, enabling you to distinguish to which VPN the route
belongs. Each routing instancemust have a unique route distinguisher associated with it.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This box is available only if the Signaling is BGP.Route Target

Allows you to distribute VPN routes to only the routers that need them.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This field is available only if you have selected the Static pseudowire check box in the General
settings. By default, the outgoing label selection is limited to manual.

Outgoing label selection
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2. Click Review to examine the settings configured for the E-Line ATM/TDM service

definition.

Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.

NOTE: On the Review page, in the Service Templates section, the names of
the service templates with which the service definition is associated are
displayed. The Default Service Template column indicates whether the
attached template is the default template.

To examine andmodify the configured service definition settings:

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

3. Click Finish to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

When the service definition is successfully created, you are returned to the Manage

Service Definitions window.

Related
Documentation

ChoosingaPredefinedServiceDefinitionorCreatingaNewServiceDefinitiononpage579•

• Creating an E-Line Service Definition

• Publishing a Custom Service Definition on page 613

• Unpublishing a Custom Service Definition on page 614

• Deleting a Customized Service Definition on page 614

• Viewing Service Definitions on page 615
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Modifying a CustomService Definition

You canmodify a customized service definition only when it is in the unpublished state.

Predefinedservicedefinitionsarebydefault in thepublishedstateandcannotbemodified.

NOTE: Templates associated with the service definition can be added or
deleted while modifying a service definition. You can delete a template
associated with a service definition when there is no service or service order
associated with the service definition.

Tomodify a service definition:

1. In the Connectivity Services Director application, select Service View from the Views

selector.

2. Click the Build tab on the Task Categories banner.

3. From the Service View pane, select Network Services > Connectivity.

4. From the Tasks pane, select Service Design >Manage Service Definitions.

5. In the Manage Service Definitions page, select the customized service definition you

want to modify.

6. Click the Edit button.

The Edit Service Definition wizard for the selected service type is displayed

7. Modify the settings, as necessary, using the wizard, and save your changes by clicking

Done.

TheManageServiceDefinitions page reappears. The selected service definition is now

modified with the redefined settings.

Related
Documentation

ChoosingaPredefinedServiceDefinitionorCreatingaNewServiceDefinitiononpage579•

• Creating an E-Line ATM or TDM Pseudowire Service Definition on page 604

• Creating an E-Line Service Definition

• Unpublishing a Custom Service Definition on page 614

• Deleting a Customized Service Definition on page 614

• Viewing Service Definitions on page 615
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Publishing a CustomService Definition

You can use service definition in a service order only when it is in the published state. A

customized service definition, by default, is in the unpublished state when created. You

must publish the customized service definition before it can be used to create a service

request.

NOTE: By default, predefined service definitions are in the published state.

To publish a service definition:

1. In the Connectivity Services Director application, select Service View from the Views

selector.

2. Click the Build tab on the Task Categories banner.

3. From the Service View pane, select Network Services > Connectivity.

4. From the Tasks pane, select Service Design >Manage Service Definitions.

5. In the Manage Service Definitions page, select the unpublished customized service

definition you want to publish.

6. Click Publish.

The Information window is dispayed.

7. Click Yes in the Information window to publish the service definition.

TheManage Service Definitions page reappears. The selected customized service

definition is now in the published state.

Related
Documentation

ChoosingaPredefinedServiceDefinitionorCreatingaNewServiceDefinitiononpage579•

• Creating an E-Line ATM or TDM Pseudowire Service Definition on page 604

• Creating an E-Line Service Definition

• Unpublishing a Custom Service Definition on page 614

• Deleting a Customized Service Definition on page 614

• Viewing Service Definitions on page 615
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Unpublishing a CustomService Definition

You can unpublish a customized service definition to make it unavailable. A service

definition can be unpublished even if there are service orders (pending or active)

associated with it. However, an unpublished service definition cannot be deleted or

modified if it has services associated with it.

You can use theUnpublish featurewhen youwant to delete or add templates to a service

definition.

To unpublish a service definition:

1. In the Connectivity Services Director application, select Service View from the Views

selector.

2. Click the Build tab on the Task Categories banner.

3. From the Service View pane, select Network Services > Connectivity.

4. From the Tasks pane, select Service Design >Manage Service Definitions.

5. In the Manage Service Definitions page, select the customized service definition you

want to unpublish.

6. Click Unpublish.

The Information window is dispayed.

7. Click Yes in the Information window to unpublish the service definition.

The Manage Service Definition page reappears. The selected customized service

definition is now in the unpublished state.

Related
Documentation

Publishing a Custom Service Definition on page 613•

Deleting a Customized Service Definition

You can delete a customized service definition only when it is in the unpublished state.

You cannot delete an unpublished service definition if it has services or service orders

associated with it.

NOTE: You cannot delete a predefined service definition.
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To delete a customized service definition:

1. In the Connectivity Services Director application, select Service View from the Views

selector.

2. Click the Build tab on the Task Categories banner.

3. From the Service View pane, select Network Services > Connectivity.

4. From the Tasks pane, select Service Design >Manage Service Definitions.

5. In the Manage Service Definitions page, select the customized service definition you

want to delete.

NOTE: Youmust unpublish the service definition before you can delete
it. To unpublish a service definition, see “Unpublishing a Custom Service
Definition” on page 614.

6. Click Delete.

The Information window is displayed.

7. Click Yes in the Information window to confirm deletion.

The Manage Service Definition page refreshes with the selected service definition

removed.

Related
Documentation

Unpublishing a Custom Service Definition on page 614•

Viewing Service Definitions

The Manage Service Definitions inventory page allows you, the Service Designer, to view

the status of service definitions and list of service definitions that you have created to

include in service orders.

Service definitions are listed by name.

SelectServiceDesign>ManageServiceDefinitions to viewandperformactionsonservice

definitions. From the Manage Service Definitions inventory page, you can publish,

unpublish, and delete service definitions.

• Tabular View on page 616

• Searching for Service Definitions on page 617

• Viewing Service Definition Details on page 617

• Performing Actions on Service Definitions on page 617
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Tabular View

In tabular view, service definition information appears in table rows and columns.

Table 78 on page 616 describes the information presented in the table.

Table 78: Service Definition Table Fields

MeaningColumn

The unique name assigned to the service definition.Name

One of the following values:

• Published—The service definition is available for use by service
provisioners.

• Unpublished—The service definition is not yet available for use by
service provisioners.

State

One of the following:

• E-Line pseudowire (LDP)

• E-Line pseudowire (BGP)

• E-LAN (MultiPoint-to-MultiPoint)

• E-LAN (Point-to-MultiPoint)

• IP (Full Mesh)

• IP (Hub-Spoke 1 Interface)

Service Type

One of the following values:

• BGP

• LDP

Signaling

Type of pseudowire configured for the service.Pseudowire

Abrief commentoreasily-identifiabledescriptionspecified for theservice
definition.

Description

Number of service orders with which this service definition has been
associated.

Use Count

The screen name of the user who created the service definition.Created By

The date and Pacific Daylight Time (PDT) time when you created the
service definition.

Created Date

Names of the service templates with which the service definition is
associated. The Default Service Template column indicates whether
the attached template is the default template.

Service Templates

Copyright © 2019, Juniper Networks, Inc.616

Connectivity Services Director User Guide



Searching for Service Definitions

To search for a specific service definition, start typing it’s name in the Search field. The

service definition name(s) starting with the letters you type are listed in the Search

drop-down list box.

If you create tags to categorize service definitions, start typing the tag name in theSearch

field. Service definitions with the tag you type appears.

Viewing Service Definition Details

To view service definition detailed information, double-click the service definition row.

The Service Definition Details page displays a summary of the service definition settings:

General, Connectivity, and UNI settings.

Performing Actions on Service Definitions

From the Manage Service Definitions inventory page you can perform the following

actions:

• Publish Service Definition—See “Publishing a Custom Service Definition” on page 613.

• Unpublish Service Definition—See “Unpublishing a Custom Service Definition” on

page 614.

Related
Documentation

• Creating an E-Line ATM or TDM Pseudowire Service Definition on page 604

• Creating an E-Line Service Definition

• Creating a Multipoint-to-Multipoint E-LAN Service Definition on page 619

• Creating a Point-to-Multipoint E-LAN Service Definition on page 641

• Creating a Full-Mesh IP Service Definition on page 669

• Creating a Hub-and-Spoke (One Interface) IP Service Definition on page 678
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CHAPTER 26

Service Design: Managing E-LAN Service
Definitions

• Creating a Multipoint-to-Multipoint E-LAN Service Definition on page 619

• Creating a Point-to-Multipoint E-LAN Service Definition on page 641

• Creating a Service Definition for VPLS Access into Layer 3 Networks on page 666

Creating aMultipoint-to-Multipoint E-LAN Service Definition

This procedure provides the steps to create a definition for a multipoint-to-multipoint

E-LAN service.

The standard service definitions that came with your initial software installation are

designed to be appropriate for most requirements. You can also create a customized

service definition—for example, to set different bandwidth limits on the service than

those offered in the standard service definitions.

When the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating multipoint-to-multipoint Ethernet services on the network.

The windows appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

To create amultipoint-to-multipoint Ethernet service definition, complete these tasks,

in the order shown. As you finish a section and click Next, the attributes from the current

window are saved and the next window in the sequence appears.

• Specifying General Information for Multipoint-to-Multipoint E-LAN Service

Definitions on page 620

• Specifying Advanced Settings on page 623

• Specifying Site Settings for Multipoint-to-Multipoint E-LAN Service

Definitions on page 626

• UNI or Site Settings for Port-to-Port Interfaces in E-LAN Services on page 626

• UNI or Site Settings for 802.1Q Interfaces in E-LAN Services on page 629

• UNI or Site Settings for Q-in-Q Interfaces in E-LAN Services on page 633
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• UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface

Types) on page 637

• Reviewing the Configured Settings on page 641

Specifying General Information for Multipoint-to-Multipoint E-LAN Service Definitions

To specify the general information for a multipoint-to-multipoint service definition, in

the Network Services > Connectivity view pane, select Service Design >Manage Service

Definitions > New > E-LAN Service Definition.

The Generalwindow appears.

To specify the general information for a multipoint-to-multipoint service definition:

1. Fill in the fields on the Generalwindow.

ActionField

Type a name for the service definition.Service Definition Name

Select (E-LAN)Multipoint-to-MultipointService Type

Select an instance type to choose the type of routing instance for the MultiPoint-to-MultiPoint
E-LAN service:

• vpls

• evpn

• virtual-switch

NOTE: Virtual-switch supports only dot1q as the encapsulation type.

Normalization not required is the only available vlan normalization type.

Instance Type

Select the protocol type:

• vpls

• evpn

• evpn e-tree

NOTE: Different protocols are available based on the instance type you select.

Protocol
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ActionField

Select a signaling type:

• BGP— If BGP signaling is selected, the following fields are available in the Connectivity section
of the General Settings page:
• Auto-pick Route Target

• Auto-pick Route Distinguisher

• LDP—If LDP signaling is selected, the following fields are available in the Connectivity section
of the General Settings page:
• Enable BGP-based Auto Discovery

• Auto-pick Route Target, if Auto Discovery is enabled

• Auto-pick Route Distinguisher , if Auto Discovery is enabled

• Auto-pick VPLS ID, if Auto Discovery is disabled

• Auto-pick VPN ID, if Auto Discovery is enabled

NOTE: You cannot edit the Signaling type in the service order.

Signaling Protocol

Type a brief description or other comment that youwant to appear in the Service Definition table.

Range: 0 through 200 characters. Space and special characters are allowed.

Description (Optional)

When you enable QoS in the service definition, you can specify a QoS profile in the service order
to classify traffic into defined service groups to provide the special treatment of traffic across the
network service. For example, voice traffic can be sent across certain links, and data traffic can
use other links.

Enable QoS

Select this check box to create the link into Layer 3. If this check box is selected, the available
Ethernet option in the Site Settings window are:

• dot1q

• qinq

Enable L3 Access

Select this check box to enable a pseudowire connection by configuring static values.

NOTE: The Enable Static PW Labels check box is enabled only when the signaling type is LDP.

Enable Static PW Labels

(Optional) To include a service template for the service, click theAdd icon or plus sign (+) to select
a service template from the Service Template list. The list of available service templates is
displayed. Select the check box beside the template you want and clickOK. You are returned to
the General Settings page.

The selected service template appears in the Default Service Template field.

You can select one or more service templates as the default service template. By default, the
default service templates are attached to the endpoints.

NOTE: You cannot add or delete a service template while creating a service order.

The remaining service templates on the Service Template list are termed as optional service
templates. You can attach the optional service templates to the endpoints on a need basis.

In the View Service Definition Details window, the value for the default service template in the
Default Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 1711.

Service Template
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ActionField

BGP Connectivity Settings—This section is displayed if you select the signaling type as BGP.

Select this check box to enable route target to be configued automatically. Clear the check box
if you want the route target to bemanually configured. By default, manual configuration of route
target is enabled.

To override this setting in the service order, select the Editable in Service Order check box.

Auto-pick Route Target

Define a route distinguisher option:

• Select the check box to enable the service provider to specify the route distinguisher.

• Select the check box to enable the route distinguisher to be selected automatically.

To override this setting in the service order, select the Editable in Service Order check box.

Auto-pick Route
Distinguisher

(Optional)Select this checkbox topair any twoN-PEdevices, for providing redundant connectivity.

When you select this check box, aMultihomingMode list appears, if you select evpnor evpn e-tree
as the protocol type. You can select either single-active or all-active as the multihomingmode.

Enable Multihoming

LDP Connectivity Settings—This section is displayed if you select the signaling type as LDP.

The Auto Discovery check box is available only if the signaling type is LDP.

NOTE: If theEnableStaticPWLabelscheckbox in theGeneralwindow is selected forLDP signaling,
then the Auto Discovery check box is disabled.

The Auto Discovery check box is not available when the signaling type is BGP.

On disabling the auto discovery specify the VPLS ID.

Enable BGP-based Auto
Discovery

This field is available only if the signaling type is LDP and auto discovery is disabled.

Identifies the virtual circuit identifier used for theVPLS routing instanceand theVPN IDassociated
with the router.

Select this check box to enable the VPLS ID and VPN ID to be configued automatically. Clear the
checkbox if youwant theseattributes tobemanually configured.Bydefault,manual configuration
is enabled.

Auto-pick VPLS ID or VPN
ID

Select this check box to enable route target to be configued automatically. Clear the check box
if you want the route target to bemanually configured. By default, manual configuration of route
target is enabled.

Auto-pick Route Target

Define a route distinguisher option:

• Select the check box to enable the service provider to specify the route distinguisher.

• Select the check box to enable the route distinguisher to be selected automatically.

To override this setting in the service order, select the Editable in Service Order check box.

Auto-pick Route
Distinguisher

MAC Settings

To enableMAC learning, select the check box.MAC learning
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ActionField

Maximum number of MAC addresses learned from an interface.

Range: 1 through 131071 MAC addresses per interface

InterfaceMAC limit

To enableMAC statistic, select the check box.MAC statistics

Modify the size of the MAC address table for the bridge domain.

Range: 16 through 1048575

To allow the service provisioner to override the MAC settings, select Editable in Service Order.

MAC Table Size

2. Click Next to save the information and continue with UNI or site settings.

Specifying Advanced Settings

In this step, you can specify the parameters that define advanced connectivity between

sitesacross the serviceprovider network. Thes settings canbeconfigured in theAdvanced

settings section of the General Settings page of the Create E-LAN Service Definition

wizard.
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To specify advanced settings:
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1. Fill in the fields as indicated in the table.

AdvancedSettings—This section enables you to specify the parameters that define advanced connectivity between sites across
the service provider network

Select the Include check box for each advanced setting that you want to include in the service
definition.

Include

NOTE: If you select any advanced parameters for a service definition, youmust also select the
Include check box for the Disable tunnel services parameter, and select or clear the Disable tunnel
services check box.

For MX Series devices, if you deploy an E-LAN service without selecting the Include check box for
Disable tunnel services parameter, the E-LAN service is down. As a work around, you can push the
configuration to each PE device for the service by running the following command:

root@test_device# set chassis fpc 0 pic 1 tunnel-services bandwidth 1g

Enable or disable tunnel-services to specify that traffic for particular VPLS routing instances be
forwarded to specific virtual tunnel (VT) interfaces.

Disable Tunnel Services

• To enable tunnel-services, clear the Disable Tunnel Services check box.

• To disable tunnel-services, select the Disable Tunnel Services check box (default).

Enable or disable local switching. In local switching mode, you can terminate multiple Layer 2
circuit pseudowires at a single VPLSmesh group:

Disable Local Switching

• To enable local switching across the network, clear the Disable Local Switching check box.

• To disable local switching across the network, select the Disable Local Switching check box
(default).

In this drop-down list, specify the reroute priority for a VPLS routing instance:Fast Reroute-Priority

• HIGH—Set the fast reroute priority for a VPLS routing instance to high. During a fast reroute
event, the router repairs next hops for high-priority VPLS routing instances first.

• MEDIUM—Set the fast reroute priority for a VPLS routing instance to medium. During a fast
rerouteevent, the router repairs nexthops formedium-priorityVPLS instancesafter high-priority
VPLS routing instances but before low-priority VPLS routing instances.

• LOW—Set the fast reroute priority for aVPLS routing instance to low,which is the default. During
a fast reroute event, the router repairs next hops for low-priority VPLS routing instances last.

Configure the label block size for VPLS labels by using one of the following values.Label Block Size

• 2—Allocate the label blocks in increments of 2. Use this setting for a VPLS domain that has only
two sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8—Allocate the label blocks in increments of 8. This is the default.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you tominimize
the number of routes in the VPLS domain. Use this setting only if the number of routes is the
primary concern.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery check box is
enabled.
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Selectaconnection-type tospecifywhenaVPLSconnection is takendown,dependingonwhether
the interface for the VPLS routing instance is customer-facing or integrated routing and bridging
(IRB):

• ce—Require that for the VPLS connection to be up, the customer-facing interface for the VPLS
routing instancemust also be up. If the customer-facing interface fails, the VPLS connection is
taken down. This is the default.

• irb—AllowaVPLSconnection to remain up so long as an IRB interface is configured for theVPLS
routing instance.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Connectivity type

By default, each advanced setting that you include in the service definition can be edited in the
service order. To prevent the service provisioner from overriding an advanced setting in the service
order, clear the Editable in Service Order check box.

Editable in Service Order

2. Click Next to define the UNI or site parameters. Alternatively, click Back to return to

the previous page of the wizard; else click Cancel to discard the changes.

3. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

4. After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.

Specifying Site Settings for Multipoint-to-Multipoint E-LAN Service Definitions

In this step, you provide the UNI attributes for this service definition. The attributes you

set depend on the type of interface you are using in this E-LAN service definition. The

following interface types are supported:

• ports

• 802.1Q interfaces

• Q-in-Q interfaces

• asymmetric interface

UNI or Site Settings for Port-to-Port Interfaces in E-LAN Services

TheSiteSettingswindowprovides four expandingor collapsingpanels: TrafficTreatment,

Interface Settings, MTU Settings, and Bandwidth Settings.

To specify the UNI Settings for Port-to-Port interfaces:
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1. Fill in the fields on the Site Settingswindow.

ActionField

PE-CE Interface Settings- Ethernet Encapsulation

Select port-port from the list.

The VLAN tagging option you choose determines the other options you can select and specify on
the page.

VLAN Tagging

To allow the service provisioner to override the VLAN tagging or Ethernet option attribute, select
the check box.

Editable in Service Order

Selectethernet-vpls, theonly validphysical interfaceencapsulationmethodallowed forport-to-port
services.

Physical Interface
Encapsulation

You cannot select a choice in this field because it is not relevant to port-to-port services.Logical Interface
Encapsulation

This drop-down is disabled for port-to-port services. For port-to-port services, all traffic is always
transported.

Traffic Type

Select a value:

• Normalize to VLAN all—To preserve customer VLAN IDs (and customer QoS priorities) across
the network.

NOTE: For services that transport a range of VLANs, youmust select VLANNormalization to all.
You cannot transport a range of VLANs without normalization.

• Normalize to VLAN none—To preserve no VLAN IDs across the network.

• Normalized to Dot1q tag—To transport only single-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network

• Normalized to QinQ tags—To transport only double-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

NOTE: Starting with Release 1.0R2, when you newly install Connectivity Services Director, if you
select the option to not require normalization in a service definition, the auto-pick option for
VLAN IDs and the option to edit the auto-pick behavior in service order are disabled in the service
definition. When you create a service order by associating with that service definition, you need
to manually enter the VLAN IDs for the interfaces and cannot use the auto-pick functionality.
This same behavior also applies to default service templates in which if you select the
normalization-not-required functionality, the auto-pick option for VLAN IDs is disabled.

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 56.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 89.

VLANNormalization

This check box is disabled because in port-to-port services, all traffic and all VLANs on one port
are transported to all other ports.

Auto Pick VLAN ID

To allow the service provisioner to override the VLAN ID setting, select the check box. This check
box is not applicable for port-to-port services.

Editable in Service Order
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ActionField

The default MTU value is 1522 bytes.Default InterfaceMTU
(Bytes)

Specify the low and high values to define the MTU range that you want to define.

The default range is 1522 through 9192 bytes.

MTURange for
manual-config(Bytes)

PE-CE Interface Rate-Limiting Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are available in the service definitionwhen CoS profiles are associated.

Enable Interface Rate
Limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Defaultbandwidth(Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 79 on page 629

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

Bandwidth – Burst Size Settings

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Burst Period Based
If you select the option Burst Period Based, you can specify a value for Burst Period in the range
1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Burst Size Calculator list is enabled only when you select the Enable Interface Rate
Limiting check box.

Burst Size Calculator
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The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and

ACX Series Routers:

Table 79: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.

UNI or Site Settings for 802.1Q Interfaces in E-LAN Services

To specify the UNI Settings for 802.1Q interfaces:

1. Fill in the fields on the Site Settingswindow.

ActionField

PE-CE UNI Settings- Ethernet Encapsulation

Select dot1q from the list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

VLAN Tagging

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical Interface
Encapsulation

Constrained by your selection in the Physical interface encapsulation box. If you selected the
recommended physical encapsulation mode of flexible-ethernet-services, then your only option
is to select vlan-vpls for the logical encapsulation method.

Logical Interface
Encapsulation
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ActionField

Select Transport single vlan to transport the traffic for a specific VLAN across the network. When
you select this option, the service provisioner is prompted for the VLAN-IDwhen creating a service
order based on this service definition. You need to specify theOuter Tag protocol ID.

Select Transport vlan range to limit the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition.

Select Transport vlan list to limit the traffic across the network to a specific list of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID list when creating a
service order based on this service definition.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be able
to override this setting.

Traffic Type

Select a value:

• Normalize to VLAN all—To preserve customer VLAN IDs (and customer QoS priorities) across
the network.

NOTE: For services that transport a range of VLANs, youmust select VLANNormalization to all.
You cannot transport a range of VLANs without normalization.

• Normalized VLAN none—To preserve no VLAN IDs across the network.

• Normalized to Dot1q—To transport only single-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network

• Normalized to QinQ—To transport only double-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

NOTE: Starting with Release 1.0R2, when you newly install Connectivity Services Director, if
you select the option to not require normalization in a service definition, the auto-pick option
for VLAN IDs and the option to edit the auto-pick behavior in service order are disabled in the
service definition. When you create a service order by associating with that service definition,
you need to manually enter the VLAN IDs for the interfaces and cannot use the auto-pick
functionality. This same behavior also applies to default service templates inwhich if you select
the normalization-not-required functionality, the auto-pick option for VLAN IDs is disabled.

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 56.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 89.

VLANNormalization

Copyright © 2019, Juniper Networks, Inc.630

Connectivity Services Director User Guide



ActionField

Indicate how the VLAN ID is determined. By default, this check box is disabled.

• Clear this check box to allow the service provider to specify the VLAN ID. This option is normally
usedwhennoVLANnormalization is applied.Specify theVLAN ID range inVLANrangeformanual
input.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Select this check box when VLAN normalization is applied. Specify the VLAN ID pool in VLAN
range for auto-pick.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

NOTE: When the range of VLAN IDs that are automatically assigned by the system (with the
auto-pick option enabled during the creation of a service definition) is less than or greater than
the range of VLAN IDs that are manually specified (with the manual selection option enabled
during the creation of a service definition), the following conditions apply during the creation of a
serviceorderwith theEditable inServiceOrder checkbox selectedduring servicedefinitioncreation:

• If you create a service order with the auto-pick option enabled, the VLAN ID is selected from the
auto-pick range, and the value is displayed in the VLAN range for manual input field. If you
attempt to change the VLAN IDmanually, the value is restricted to the manually configured
range.

• If you create a service order with the auto-pick option disabled, the VLAN ID is selected from
themanually configured range, and the value is displayed in the VLAN range for manual input
field. If you attempt to change the VLAN IDmanually, the value is restricted to the manually
configured range.

Auto Pick VLAN ID

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

Outer Tag Protocol ID

To allow the service provisioner to override the outer tag protocol ID setting, select the check box
for those options.

Editable in Service Order

The default MTU value is 1522 bytes. To allow the service provisioner to override the MTU setting,
select the Editable in Service Order check box.

Default InterfaceMTU
(Bytes)
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ActionField

In the MTU range fields, type the lowest and highest values for MTU for each UNI.

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values.

MTU range for
manual-config

PE-CE Interface Rate-Limiting Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are available in the service definition when Manage CoS Profiles page
is configured with CoS profiles.

Enable Interface Rate
Limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 79 on page 629

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

Bandwidth – Burst Size Settings

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Burst Period Based
If you select the option Burst Period Based, you can specify a value for Burst Period in the range
1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Burst Size Calculator list is enabled only when you select the Enable Interface Rate
Limiting check box.

Burst Size Calculator
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2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.

UNI or Site Settings for Q-in-Q Interfaces in E-LAN Services

To specify the site or UNI settings for q-in-q interfaces:

1. Fill in the fields on the Site Settingswindow.

ActionField

PE-CE Interface Settings- Ethernet Encapsulation

Select qinq from the list.

The window expands to include options specific to Q-in-Q interfaces.

VLAN Tagging

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical Interface
Encapsulation

Constrained by your selection in the Physical Interface encapsulation box. If you selected the
recommended physical encapsulation mode of flexible-ethernet-services, then your only option
is to select vlan-vpls for the logical encapsulation method.

Logical Interface
Encapsulation

Transport all traffic Transports the traffic from all VLANs across the network.When you select this
option, the service provisioner is prompted for the VLAN-ID when creating a service order based
on this service definition. You need to specify only theOuter Tag protocol ID.

Transport single vlanTransports traffic for a specific VLAN across the network. You need to specify
bothOuter Tag protocol ID and Inner Tag protocol ID.

Transport vlan range Limits the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition. You need to specify only theOuter Tag protocol ID
.

Transport vlan list Limits the traffic across the network to a specific list of VLANs. If you select this
option, the serviceprovisioner is prompted for theVLAN-ID listwhencreatinga serviceorder based
on this service definition. You need to specify only theOuter Tag protocol ID.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be able
to override this setting.

Traffic Type
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ActionField

Select a value:

• Normalize to VLAN all—To preserve customer VLAN IDs (and customer QoS priorities) across
the network.

NOTE: For services that transport a range of VLANs, youmust select VLANNormalization to all.
You cannot transport a range of VLANs without normalization.

• Normalized VLAN none—To preserve no VLAN IDs across the network.

• Normalized to Dot1q—To transport only single-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network

• Normalized to QinQ—To transport only double-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

NOTE: Starting with Release 1.0R2, when you newly install Connectivity Services Director, if
you select the option to not require normalization in a service definition, the auto-pick option
for VLAN IDs and the option to edit the auto-pick behavior in service order are disabled in the
service definition. When you create a service order by associating with that service definition,
you need to manually enter the VLAN IDs for the interfaces and cannot use the auto-pick
functionality. This same behavior also applies to default service templates inwhich if you select
the normalization-not-required functionality, the auto-pick option for VLAN IDs is disabled.

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 56.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 89.

VLANNormalization

Indicate how the VLAN ID is determined. By default, this check box is disabled.

• Clear this check box to allow the service provider to specify the VLAN ID. This option is normally
usedwhennoVLANnormalization is applied.Specify theVLAN ID range inVLANrangeformanual
input.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Select this check box when VLAN normalization is applied. Specify the VLAN ID pool in VLAN
range for auto-pick.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

NOTE: When the range of VLAN IDs that are automatically assigned by the system (with the
auto-pick option enabled during the creation of a service definition) is less than or greater than
the range of VLAN IDs that are manually specified (with the manual selection option enabled
during the creation of a service definition), the following conditions apply during the creation of a
serviceorderwith theEditable inServiceOrder checkbox selectedduring servicedefinitioncreation:

• If you create a service order with the auto-pick option enabled, the VLAN ID is selected from the
auto-pick range, and the value is displayed in the VLAN range for manual input field. If you
attempt to change the VLAN IDmanually, the value is restricted to the manually configured
range.

• If you create a service order with the auto-pick option disabled, the VLAN ID is selected from
themanually configured range, and the value is displayed in the VLAN range for manual input
field. If you attempt to change the VLAN IDmanually, the value is restricted to the manually
configured range.

Auto Pick VLAN ID
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ActionField

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag Protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport single
VLAN.

Inner Tag Protocol ID

To allow the service provisioner to override the outer and inner tag protocol IDs, select the check
boxes for those options.

Editable in Service Order

The default MTU value is 1522 bytes. To allow the service provisioner to override the MTU setting,
select the Editable in Service Order check box.

Default InterfaceMTU
(Bytes)

In the MTU range fields, type the lowest and highest values for MTU for each UNI.

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values.

MTU range for
manual-config

PE-CE Interface Rate-Limiting Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are available in the service definition when Manage CoS Profiles page
is configured with CoS profiles.

Enable Interface Rate
Limiting
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ActionField

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 79 on page 629

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

Bandwidth – Burst Size Settings

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Burst Period Based
If you select the option Burst Period Based, you can specify a value for Burst Period in the range
1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Burst Size Calculator list is enabled only when you select the Enable Interface Rate
Limiting check box.

Burst Size Calculator

2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.
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UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface Types)

Youcanspecify theEthernet optionasymmetric tagdepth to createa service that includes

any combination of port-based interfaces, 802.1Q interfaces, and Q-in-Q interfaces.

To specify the UNI Settings for q-in-q interfaces:

1. Fill in the fields on the Site Settingswindow.

ActionField

PE-CE Interface Settings- Ethernet Encapsulation

Select asymmetric tag depth from the list.VLAN Tagging

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

For multipoint-to-multipoint services with Q-in-Q interfaces, the only option is
flexible-ethernet-services

Physical Interface
Encapsulation

Constrained by your selection in the Physical interface encapsulation box. If you selected the
recommended physical encapsulation mode of flexible-ethernet-services, then your only option
is to select vlan-vpls for the logical encapsulation method.

Logical Interface
Encapsulation

Transport all traffic Transports the traffic from all VLANs across the network.When you select this
option, the service provisioner is prompted for the VLAN-ID when creating a service order based
on this service definition. You need to specify only theOuter Tag protocol ID..

Transport single vlanTransports traffic for a specific VLAN across the network. You need to specify
bothOuter Tag protocol ID and Inner Tag protocol ID.

Transport vlan range Limits the traffic across the network to a specific range of VLANs. You need
to specify only theOuter Tag protocol ID.

Transport vlan list limits the traffic across the network to a specific list of VLANs. If you select this
option, the serviceprovisioner is prompted for theVLAN-ID listwhencreatinga serviceorder based
on this service definition. You need to specify only theOuter Tag protocol ID.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be able
to override this setting.

Traffic Type
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ActionField

Select a value:

• Normalize to VLAN all—To preserve customer VLAN IDs (and customer QoS priorities) across
the network.

NOTE: For services that transport a range of VLANs, youmust select VLANNormalization to all.
You cannot transport a range of VLANs without normalization.

• Normalize to VLAN none—To preserve no VLAN IDs across the network.

• Normalize to Dot1q tag—To transport only single-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network

• Normalize to QinQ tags—To transport only double-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

NOTE: Starting with Release 1.0R2, when you newly install Connectivity Services Director, if
you select the option to not require normalization in a service definition, the auto-pick option
for VLAN IDs and the option to edit the auto-pick behavior in service order are disabled in the
service definition. When you create a service order by associating with that service definition,
you need to manually enter the VLAN IDs for the interfaces and cannot use the auto-pick
functionality. This same behavior also applies to default service templates inwhich if you select
the normalization-not-required functionality, the auto-pick option for VLAN IDs is disabled.

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 56.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 89.

VLANNormalization

Indicate how the VLAN ID is determined. By default, this check box is disabled.

• Clear this check box to allow the service provider to specify the VLAN ID. This option is normally
usedwhennoVLANnormalization is applied.Specify theVLAN ID range inVLANrangeformanual
input.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Select this check box when VLAN normalization is applied. Specify the VLAN ID pool in VLAN
range for auto-pick.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

NOTE: When the range of VLAN IDs that are automatically assigned by the system (with the
auto-pick option enabled during the creation of a service definition) is less than or greater than
the range of VLAN IDs that are manually specified (with the manual selection option enabled
during the creation of a service definition), the following conditions apply during the creation of a
serviceorderwith theEditable inServiceOrder checkbox selectedduring servicedefinitioncreation:

• If you create a service order with the auto-pick option enabled, the VLAN ID is selected from the
auto-pick range, and the value is displayed in the VLAN range for manual input field. If you
attempt to change the VLAN IDmanually, the value is restricted to the manually configured
range.

• If you create a service order with the auto-pick option disabled, the VLAN ID is selected from
themanually configured range, and the value is displayed in the VLAN range for manual input
field. If you attempt to change the VLAN IDmanually, the value is restricted to the manually
configured range.

Auto Pick VLAN ID
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Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag Protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport all
traffic.

Inner Tag Protocol ID

To allow the service provisioner to override the outer and inner tag protocol IDs, select the check
boxes for those options.

Editable in Service Order

In the MTU range fields, type the lowest and highest values for MTU that the service provisioner
can type, for each UNI

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values that the service provisioner
can type.

MTU range for
manual-config

The default MTU value is 1522 bytes. To allow the service provisioner to override the MTU setting,
select the Editable in Service Order check box.

Default InterfaceMTU
(Bytes)

PE-CE Interface Rate-Limiting Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are available in the service definition when Manage CoS Profiles page
is configured with CoS profiles.

Enable Interface Rate
Limiting
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ActionField

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 79 on page 629

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

Bandwidth – Burst Size Settings

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Burst Period Based
If you select the option Burst Period Based, you can specify a value for Burst Period in the range
1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Burst Size Calculator list is enabled only when you select the Enable Interface Rate
Limiting check box.

Burst Size Calculator

2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.
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Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.

NOTE: On the Review page, in the Service Templates section, the names of
the service templates with which the service definition is associated are
displayed. The Default Service Template column indicates whether the
attached template is the default template.

To examine andmodify the configured service definition settings:

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

3. Click Finish to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

The service order inventory window appears.

Related
Documentation

Creating a Service Definition for VPLS Access into Layer 3 Networks on page 666•

Creating a Point-to-Multipoint E-LAN Service Definition

Thisprocedureprovides thesteps tocreateadefinition for apoint-to-multipointEthernet

service. Point-to-multipoint services are also known as hub and spoke services.

The standard service definitions that came with your initial software installation are

designed to be appropriate for most requirements. You can also create a customized

service definition—for example, to set different bandwidth limits on the service than

those offered in the standard service definitions.
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When the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating point-to-multipoint Ethernet services on the network.

The windows appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

• Specifying General Information for Point-to-Multipoint E-LAN Service

Definitions on page 642

• Specifying Advanced Settings on page 647

• Specifying UNI or Site Settings for Point-to-Multipoint E-LAN Service

Definitions on page 649

• UNI or Site Settings for Port-to-Port Interfaces in E-LAN Services on page 649

• UNI or Site Settings for 802.1Q Interfaces in E-LAN Services on page 652

• UNI or Site Settings for Q-in-Q Interfaces in E-LAN Services on page 656

• UNI or Site Settings for Services with Flexible VLAN Tagging (Asymmetric Interface

Types) on page 661

• Reviewing the Configured Settings on page 665

Specifying General Information for Point-to-Multipoint E-LAN Service Definitions

in theNetworkServices>Connectivity viewpane, selectServiceDesign>ManageService

Definitions > New> E-LAN Service Definition. The General settings window appears.

To specify the general information for a point-to-multipoint service definition:

1. Fill in the fields on theGeneral page of the wizard that enablesy ou to create a service

definition.

ActionField

Type a name for the service definition.Service Definition Name

Select (E-LAN) Point-to-Multipoint )Service Type
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ActionField

Select a signaling type:

• BGP— If BGP signaling is selected, the following fields are available in the Connectivity section
of the General Settings page:
• Route target

• Route distinguisher

• VLAN normalization

• MACSettings

• VCID, if Enable PWExtension is enabled

• LDP—If LDP signaling is selected, the following fields are available in the Connectivity section of
the General Settings page:

• Enable BGP-based Auto Discovery

• Auto-pick Route target, if Auto Discovery is enabled

• Auto-pick Route distinguisher, if Auto Discovery is enabled

• Auto-pick VPLS ID, if Auto Discovery is disabled

• Auto-pick VPN ID, if Auto Discovery is enabled

• VLAN normalization

• Mac Security Settings

NOTE: You cannot edit the Signaling type in the service order.

Signaling Protocol

Type a brief description or other comment that you want to appear in the Service Definition table.

Range: 0 through 200 characters. Space and special characters are allowed.

Description (Optional)

Select an instance type to choose the type of routing instance for the Point-to-MultiPoint E-LAN
service:

• vpls

• evpn

• virtual-switch

Instance Type

Different protocols are available based on the instance type you select:

• vpls

• evpn

• evpn e-tree

Protocol

When you enable QoS in the service definition, you can specify a QoS profile in the service order to
classify traffic into defined service groups to provide the special treatment of traffic across the
network service. For example, voice traffic can be sent across certain links, and data traffic can use
other links.

Enable QoS

Select this checkbox to create the link into Layer 3. If this checkbox is selected, theavailableEthernet
option in the Site Settings window are:

• dot1q

• qinq

Enable L3 Access

Select this check box to enable pseudowire extension. You cannot edit this check box in the service
order.

Enable PWExtension
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ActionField

Select this check box to enable resiliency. You cannot edit this field in the service order.

If the Signaling type is BGP, you need to select the Enable PWExtension check box to enable the
Enable PWResiliency check box.

For more information of pseudowire redundancy, see “Redundant Pseudowires for Layer 2 Circuits
and VPLS” on page 95.

Enable PWResiliency

Select this check box to enable a pseudowire connection by configuring static values.

NOTE: The Enable Static PW Labels check box is enabled for both signaling types: LDP and BGP.

When the signaling type is BGP, selection of this check box enables the Enable PWResiliency check
box and automatically selects the Enable PWExtension check box.

Enable Static PW Labels

(Optional) To include a service template for the service, click the Add icon or plus sign (+) to select
a service template fromtheServiceTemplate list. The list of available service templates isdisplayed.
Select the check box beside the template you want and clickOK. You are returned to the General
Settings page.

The selected service template appears in the Default Service Template field.

You can select oneormore service templates as thedefault service template. Bydefault, thedefault
service templates are attached to the endpoints.

NOTE: You cannot add or delete a service template while creating a service order.

The remaining service templates on the Service Template list are termed as optional service
templates. You can attach the optional service templates to the endpoints on a need basis.

In the View Service Definition Details window, the value for the default service template in the
Default Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 1711.

Service Template

BGP Connectivity Settings—This section is displayed if you select the signaling type as BGP.

Select this check box to enable route target to be configued automatically. Clear the check box if
you want the route target to bemanually configured. By default, manual configuration of route
target is enabled.

To override this setting in the service order, select the Editable in Service Order check box.

Auto-pick Route Target

Define a route distinguisher option:

• Select the check box to enable the service provider to specify the route distinguisher.

• Select the check box to enable the route distinguisher to be selected automatically.

To override this setting in the service order, select the Editable in Service Order check box.

Auto-pick Route
Distinguisher

Select this check box to pair any two N-PE devices, for providing redundant connectivity. When you
select this check box, a Multihoming Mode list appears, if you select evpn or evpn-etree as the
protocol type.

You can select either single-active or all-active as the multihomingmode.

Enable Multihoming

LDP Connectivity Settings—This section is displayed if you select the signaling type as LDP.
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ActionField

You cannot enable or disable the Auto Discovery check box if you have enabled the Enable PW
Extension or the Enable PWResiliency check boxes.

This check box is available only if the signaling type is LDP.

NOTE: If the Enable Static PW Labels check box in the Generalwindow is checked for the LDP
signaling, then the Auto Discovery check box is disabled in the Connectivity Settings page.

The Auto Discovery check box is not available in the Connectivity Settings page when the signaling
type is BGP.

On enabling the auto discovery, the following fields are available:

• Route target

• Route distinguisher

• VPN ID

On disabling the auto discovery specify the VPLS ID.

Enable BGP-based Auto
Discovery

This field is available only if the signaling type is LDP and auto discovery is disabled.

Identifies the virtual circuit identifier used for the VPLS routing instance and the VPN ID associated
with the router.

Select this check box to enable the VPLS ID and VPN ID to be configued automatically. Clear the
check box if you want these attributes to bemanually configured. By default, manual configuration
is enabled.

Auto-pickVPLS IDorVPN
ID

Select this check box to enable route target to be configued automatically. Clear the check box if
you want the route target to bemanually configured. By default, manual configuration of route
target is enabled.

Auto-pick Route Target

Define a route distinguisher option:

• Select the check box to enable the service provider to specify the route distinguisher.

• Select the check box to enable the route distinguisher to be selected automatically.

To override this setting in the service order, select the Editable in Service Order check box.

Auto-pick Route
Distinguisher

MAC Settings

To enableMAC learning, select the check box.MAC learning

Maximum number of MAC addresses learned from an interface.

Range: 1 through 131071 MAC addresses per interface

InterfaceMAC limit

To enableMAC statistic, select the check box.MAC statistics

Modify the size of the MAC address table for the bridge domain.

Range: 16 through 1048575

To allow the service provisioner to override the MAC settings, select Editable in Service Order.

MAC Table Size
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ActionField

Select this check box to create the link into Layer 3. If you enable the Layer 3 access, the available
Ethernet option in the Site Settings are:

• port-port

• dot1q

• qinq

• asymmetric tag depth

Enable L3 Access

Select this check box to enable pseudowire extension. You cannot edit this check box in the service
order.

Enable PWExtension

Select this check box to enable resiliency. You cannot edit this field in the service order.

If the Signaling type is BGP, you need to select the Enable PWExtension check box to enable the
Enable PWResiliency check box.

For more information of pseudowire redundancy, see “Redundant Pseudowires for Layer 2 Circuits
and VPLS” on page 95.

Enable PWResiliency

Select this check box to enable a pseudowire connection by configuring static values.

NOTE: The Enable Static PW Labels check box is enabled for both signaling types: LDP and BGP.

When the signaling type is BGP, selection of this check box enables the Enable PWResiliency check
box and automatically selects the Enable PWExtension check box.

Enable Static PW Labels

(Optional) To include a service template for the service, click the Add icon or plus sign (+) to select
a service template fromtheServiceTemplate list. The list of available service templates isdisplayed.
Select the check box beside the template you want and clickOK. You are returned to the General
Settings page.

The selected service template appears in the Default Service Template field.

You can select oneormore service templates as thedefault service template. Bydefault, thedefault
service templates are attached to the endpoints.

NOTE: You cannot add or delete a service template while creating a service order.

The remaining service templates on the Service Template list are termed as optional service
templates. You can attach the optional service templates to the endpoints on a need basis.

In the View Service Definition Details window, the value for the default service template in the
Default Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 1711.

Service Template
Definition

2. Click Next to save the information. Continue with “Specifying Advanced Settings” on

page 647.
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Specifying Advanced Settings

In this step, you can specify the parameters that define advanced connectivity between

sitesacross the serviceprovider network. Thes settings canbeconfigured in theAdvanced

settings section of the General Settings page of the Create E-LAN Service Definition

wizard.
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1. Fill in the fields as indicated in the table.

AdvancedSettings—This section enables you to specify the parameters that define advanced connectivity between sites across
the service provider network

Select the Include check box for each advanced setting that you want to include in the service
definition.

Include

NOTE: If you select any advanced parameters for a service definition, youmust also select the
Include check box for the Disable tunnel services parameter, and select or clear the Disable tunnel
services check box.

For MX Series devices, if you deploy an E-LAN service without selecting the Include check box for
Disable tunnel services parameter, the E-LAN service is down. As a work around, you can push the
configuration to each PE device for the service by running the following command:

root@test_device# set chassis fpc 0 pic 1 tunnel-services bandwidth 1g

Enable or disable tunnel-services to specify that traffic for particular VPLS routing instances be
forwarded to specific virtual tunnel (VT) interfaces.

Disable Tunnel Services

• To enable tunnel-services, clear the Disable Tunnel Services check box.

• To disable tunnel-services, select the Disable Tunnel Services check box (default).

Enable or disable local switching. In local switching mode, you can terminate multiple Layer 2
circuit pseudowires at a single VPLSmesh group:

Disable Local Switching

• To enable local switching across the network, clear the Disable Local Switching check box.

• To disable local switching across the network, select the Disable Local Switching check box
(default).

In this drop-down list, specify the reroute priority for a VPLS routing instance:Fast Reroute-Priority

• HIGH—Set the fast reroute priority for a VPLS routing instance to high. During a fast reroute
event, the router repairs next hops for high-priority VPLS routing instances first.

• MEDIUM—Set the fast reroute priority for a VPLS routing instance to medium. During a fast
rerouteevent, the router repairs nexthops formedium-priorityVPLS instancesafter high-priority
VPLS routing instances but before low-priority VPLS routing instances.

• LOW—Set the fast reroute priority for aVPLS routing instance to low,which is the default. During
a fast reroute event, the router repairs next hops for low-priority VPLS routing instances last.

Configure the label block size for VPLS labels by using one of the following values.Label Block Size

• 2—Allocate the label blocks in increments of 2. Use this setting for a VPLS domain that has only
two sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8—Allocate the label blocks in increments of 8. This is the default.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you tominimize
the number of routes in the VPLS domain. Use this setting only if the number of routes is the
primary concern.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery check box is
enabled.
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Selectaconnection-type tospecifywhenaVPLSconnection is takendown,dependingonwhether
the interface for the VPLS routing instance is customer-facing or integrated routing and bridging
(IRB):

• ce—Require that for the VPLS connection to be up, the customer-facing interface for the VPLS
routing instancemust also be up. If the customer-facing interface fails, the VPLS connection is
taken down. This is the default.

• irb—AllowaVPLSconnection to remain up so long as an IRB interface is configured for theVPLS
routing instance.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Connectivity type

By default, each advanced setting that you include in the service definition can be edited in the
service order. To prevent the service provisioner from overriding an advanced setting in the service
order, clear the Editable in Service Order check box.

Editable in Service Order

2. Click Next to define the UNI or site parameters. Alternatively, click Back to return to

the previous page of the wizard; else click Cancel to discard the changes.

3. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

4. After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.

Specifying UNI or Site Settings for Point-to-Multipoint E-LAN Service Definitions

In this step, you provide the UNI attributes for this service definition. The attributes you

set depend on the type of interface you are using in this E-LAN service definition. The

following interface types are supported:

• ports

• 802.1Q interfaces

• Q-in-Q interfaces

• asymmetric interface

UNI or Site Settings for Port-to-Port Interfaces in E-LAN Services

TheSiteSettingswindowprovides four expandingor collapsingpanels: TrafficTreatment,

Interface Settings, MTU Settings, and Bandwidth Settings.

To specify the UNI Settings for Port-to-Port interfaces:
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1. Fill in the fields on the Site Settingswindow.

ActionField

PE-CE Interface Settings- Ethernet Encapsulation

Select port-port from the list.

The VLAN tagging option you choose determines the other options you can select and specify on
the page.

VLAN Tagging

To allow the service provisioner to override the VLAN tagging or Ethernet option attribute, select
the check box.

Editable in Service Order

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
tab.

In the Physical Interface Encapsulation box, select ethernet-ccc, which is the only valid physical
interface encapsulation method for port-to-port services.

Physical Interface
Encapsulation

You can not select a choice in this field because it is not relevant to port-to-port services.Logical Interface
Encapsulation

This drop-down is disabled for port-to-port services. For port-to-port services, all traffic is always
transported.

Traffic Type

Select a value:

• Normalize to vlan all—To preserve customer VLAN IDs (and customer QoS priorities) across the
network.

NOTE: For services that transport a range of VLANs, youmust select VLANNormalization to all.
You cannot transport a range of VLANs without normalization.

• Normalize to vlan none—To preserve no VLAN IDs across the network.

• Normalize toDot1q tag—To transport only single-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network

• Normalize to QinQ tags—To transport only double-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

NOTE: Starting with Release 1.0R2, when you newly install Connectivity Services Director, if you
select the option to not require normalization in a service definition, the auto-pick option for
VLAN IDs and the option to edit the auto-pick behavior in service order are disabled in the service
definition. When you create a service order by associating with that service definition, you need
to manually enter the VLAN IDs for the interfaces and cannot use the auto-pick functionality.
This same behavior also applies to default service templates in which if you select the
normalization-not-required functionality, the auto-pick option for VLAN IDs is disabled.

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 56.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 89.

VLANNormalization
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ActionField

This check box is disabled because in port-to-port services, all traffic and all VLANs on one port
are transported to all other ports.

Auto Pick VLAN ID

To allow the service provisioner to override the VLAN ID setting, select the check box. This check
box is not applicable for port-to-port services.

Editable in Service Order

The default MTU value is 1522 bytes.Default InterfaceMTU
(Bytes)

Specify the low and high values to define the MTU range that you want to define.

The default range is 1522 through 9192 bytes.

MTURange for
manual-config(Bytes)

PE-CE Interface Rate-Limiting Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are available in the service definition when Manage CoS Profiles page
is configured with CoS profiles.

Enable Interface Rate
Limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Defaultbandwidth(Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 79 on page 629

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

Bandwidth – Burst Size Settings
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ActionField

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Burst Period Based
If you select the option Burst Period Based, you can specify a value for Burst Period in the range
1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Burst Size Calculator list is enabled only when you select the Enable Interface Rate
Limiting check box.

Burst Size Calculator

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and

ACX Series Routers:

Table 80: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.

UNI or Site Settings for 802.1Q Interfaces in E-LAN Services

To specify the UNI Settings for 802.1Q interfaces:

1. Fill in the fields on the Site Settingswindow.

ActionField

PE-CE UNI Settings- Ethernet Encapsulation
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ActionField

Select dot1q from the list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

VLAN Tagging

In the Physical Interface Encapsulation box, select the default physical encapsulation scheme to
be used by service orders based on this service definition. For point-to-multipoint services with
802.1Q interfaces, the only option is flexible-ethernet-services.

Physical Interface
Encapsulation

The Logical Interface Encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field. For the physical encapsulation mode of flexible-ethernet-services, your only
option is to select vlan-vpls for the logical encapsulation method.

Logical Interface
Encapsulation

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
tab.

In the Physical Interface Encapsulation box, select one of the following options:

• vlan-ccc

• extended-vlan-ccc

• flexible-ethernet-services

Physical Interface
Encapsulation

The Logical Interface Encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field.

For the physical encapsulation mode of vlan-ccc or flexible-ethernet-services, your only option is
to select vlan-ccc for the logical encapsulation method.

For the physical encapsulation mode of extended-vlan-ccc, your only option is to select
extended-vlan-ccc for the logical encapsulation method.

Logical Interface
Encapsulation

Select Transport single vlan to transport the traffic for a specific VLAN across the network. When
you select this option, the service provisioner is prompted for the VLAN-IDwhen creating a service
order based on this service definition. You need to specify theOuter Tag protocol ID.

Select Transport vlan range to limit the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition.

Select Transport vlan list to limit the traffic across the network to a specific list of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID list when creating a
service order based on this service definition.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be able
to override this setting.

Traffic Type
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ActionField

Select a value:

• Normalize to vlan all—To preserve customer VLAN IDs (and customer QoS priorities) across the
network.

NOTE: For services that transport a range of VLANs, youmust select VLANNormalization to all.
You cannot transport a range of VLANs without normalization.

• Normalize to vlan none—To preserve no VLAN IDs across the network.

• Normalize to Dot1q tag—To transport only single-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network

• Normalize to QinQ tags—To transport only double-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

NOTE: Starting with Release 1.0R2, when you newly install Connectivity Services Director, if
you select the option to not require normalization in a service definition, the auto-pick option
for VLAN IDs and the option to edit the auto-pick behavior in service order are disabled in the
service definition. When you create a service order by associating with that service definition,
you need to manually enter the VLAN IDs for the interfaces and cannot use the auto-pick
functionality. This same behavior also applies to default service templates inwhich if you select
the normalization-not-required functionality, the auto-pick option for VLAN IDs is disabled.

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 56.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 89.

VLANNormalization

Indicate how the VLAN ID is determined. By default, this check box is disabled.

• Clear this check box to allow the service provider to specify the VLAN ID. This option is normally
usedwhennoVLANnormalization is applied.Specify theVLAN ID range inVLANrangeformanual
input.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Select this check box when VLAN normalization is applied. Specify the VLAN ID pool in VLAN
range for auto-pick.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

NOTE: When the range of VLAN IDs that are automatically assigned by the system (with the
auto-pick option enabled during the creation of a service definition) is less than or greater than
the range of VLAN IDs that are manually specified (with the manual selection option enabled
during the creation of a service definition), the following conditions apply during the creation of a
serviceorderwith theEditable inServiceOrder checkbox selectedduring servicedefinitioncreation:

• If you create a service order with the auto-pick option enabled, the VLAN ID is selected from the
auto-pick range, and the value is displayed in the VLAN range for manual input field. If you
attempt to change the VLAN IDmanually, the value is restricted to the manually configured
range.

• If you create a service order with the auto-pick option disabled, the VLAN ID is selected from
themanually configured range, and the value is displayed in the VLAN range for manual input
field. If you attempt to change the VLAN IDmanually, the value is restricted to the manually
configured range.

Auto Pick VLAN ID
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ActionField

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag Protocol ID

To allow the service provisioner to override the outer tag protocol ID setting, select the check box
for those options.

Editable in Service Order

The default MTU value is 1522 bytes. To allow the service provisioner to override the MTU setting,
select the Editable in Service Order check box.

Default InterfaceMTU
(Bytes)

In the MTU range fields, type the lowest and highest values for MTU for each UNI.

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values.

MTU range for
manual-config

PE-CE Interface Rate-Limiting Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are available in the service definition when Manage CoS Profiles page
is configured with CoS profiles.

Enable Interface Rate
Limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)
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ActionField

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 79 on page 629

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

Bandwidth – Burst Size Settings

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Burst Period Based
If you select the option Burst Period Based, you can specify a value for Burst Period in the range
1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Burst Size Calculator list is enabled only when you select the Enable Interface Rate
Limiting check box.

Burst Size Calculator

2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.

UNI or Site Settings for Q-in-Q Interfaces in E-LAN Services

To specify the UNI Settings for q-in-q interfaces:

1. Fill in the fields on the Site Settingswindow.

ActionField

PE-CE Interface Settings- Ethernet Encapsulation

Select qinq from the list.

The window expands to include options specific to Q-in-Q interfaces

VLAN Tagging
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ActionField

In the Physical Interface Encapsulation box, select the default physical encapsulation scheme to
be used by service orders based on this service definition. For point-to-multipoint services with
802.1Q interfaces, the only option is flexible-ethernet-services.

Physical Interface
Encapsulation

The Logical Interface Encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field. For the physical encapsulation mode of flexible-ethernet-services, your only
option is to select vlan-vpls for the logical encapsulation method.

Logical Interface
Encapsulation

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
tab.

In the Physical Interface Encapsulation box, select one of the following options:

• vlan-ccc

• extended-vlan-ccc

• flexible-ethernet-services

Physical Interface
Encapsulation

The Logical Interface Encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field.

For the physical encapsulation mode of vlan-ccc or flexible-ethernet-services, your only option is
to select vlan-ccc for the logical encapsulation method.

For the physical encapsulation mode of extended-vlan-ccc, your only option is to select
extended-vlan-ccc for the logical encapsulation method.

Logical Interface
Encapsulation

Transport all traffic Transports the traffic from all VLANs across the network.When you select this
option, the service provisioner is prompted for the VLAN-ID when creating a service order based
on this service definition. You need to specify only theOuter Tag protocol ID.

Transport single vlanTransports traffic for a specific VLAN across the network. You need to specify
bothOuter Tag protocol ID and Inner Tag protocol ID.

Transport vlan range Limits the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition. You need to specify bothOuter Tag protocol ID and
Inner Tag protocol ID.

Transport vlan list Limits the traffic across the network to a specific list of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID list when creating a
service order based on this service definition. You need to specify only theOuter Tag Protocol ID.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be able
to override this setting.

Traffic Type
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ActionField

Select a value:

• Normalize to vlan all—To preserve customer VLAN IDs (and customer QoS priorities) across the
network.

NOTE: For services that transport a range of VLANs, youmust select VLANNormalization to all.
You cannot transport a range of VLANs without normalization.

• Normalize to vlan none—To preserve no VLAN IDs across the network.

• Normalize to Dot1q tag—To transport only single-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network

• Normalize to QinQ tags—To transport only double-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

NOTE: Starting with Release 1.0R2, when you newly install Connectivity Services Director, if
you select the option to not require normalization in a service definition, the auto-pick option
for VLAN IDs and the option to edit the auto-pick behavior in service order are disabled in the
service definition. When you create a service order by associating with that service definition,
you need to manually enter the VLAN IDs for the interfaces and cannot use the auto-pick
functionality. This same behavior also applies to default service templates inwhich if you select
the normalization-not-required functionality, the auto-pick option for VLAN IDs is disabled.

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 56.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 89.

VLANNormalization

Indicate how the VLAN ID is determined. By default, this check box is disabled.

• Clear this check box to allow the service provider to specify the VLAN ID. This option is normally
usedwhennoVLANnormalization is applied.Specify theVLAN ID range inVLANrangeformanual
input.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Select this check box when VLAN normalization is applied. Specify the VLAN ID pool in VLAN
range for auto-pick.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

NOTE: When the range of VLAN IDs that are automatically assigned by the system (with the
auto-pick option enabled during the creation of a service definition) is less than or greater than
the range of VLAN IDs that are manually specified (with the manual selection option enabled
during the creation of a service definition), the following conditions apply during the creation of a
serviceorderwith theEditable inServiceOrder checkbox selectedduring servicedefinitioncreation:

• If you create a service order with the auto-pick option enabled, the VLAN ID is selected from the
auto-pick range, and the value is displayed in the VLAN range for manual input field. If you
attempt to change the VLAN IDmanually, the value is restricted to the manually configured
range.

• If you create a service order with the auto-pick option disabled, the VLAN ID is selected from
themanually configured range, and the value is displayed in the VLAN range for manual input
field. If you attempt to change the VLAN IDmanually, the value is restricted to the manually
configured range.

Auto Pick VLAN ID
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ActionField

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag Protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport single
VLAN.

Inner Tag Protocol ID

To allow the service provisioner to override the outer and inner tag protocol IDs, select the check
boxes for those options.

Editable in Service Order

The default MTU value is 1522 bytes. To allow the service provisioner to override the MTU setting,
select the Editable in Service Order check box.

Default InterfaceMTU
(Bytes)

In the MTU range fields, type the lowest and highest values for MTU for each UNI.

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values.

MTU range for
manual-config

PE-CE Interface Rate-Limiting Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are available in the service definition when Manage CoS Profiles page
is configured with CoS profiles.

Enable Interface Rate
Limiting
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ActionField

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 79 on page 629

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

Bandwidth – Burst Size Settings

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Burst Period Based
If you select the option Burst Period Based, you can specify a value for Burst Period in the range
1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Burst Size Calculator list is enabled only when you select the Enable Interface Rate
Limiting check box.

Burst Size Calculator

2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.
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UNI or Site Settings for Services with Flexible VLAN Tagging (Asymmetric Interface Types)

Youcanspecify theEthernet optionasymmetric tagdepth to createa service that includes

any combination of port-based interfaces, 802.1Q interfaces, and Q-in-Q interfaces.

To specify the UNI Settings for q-in-q interfaces:

1. Fill in the fields on the Site Settingswindow.

ActionField

PE-CE Interface Settings- Ethernet Encapsulation

Select asymmetric tag depth from the list.VLAN Tagging

In the Physical Interface Encapsulation box, select the default physical encapsulation scheme to
be used by service orders based on this service definition. For point-to-multipoint services with
802.1Q interfaces, the only option is flexible-ethernet-services.

Physical Interface
Encapsulation

The Logical Interface Encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field. For the physical encapsulation mode of flexible-ethernet-services, your only
option is to select vlan-vpls for the logical encapsulation method.

Logical Interface
Encapsulation

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
tab.

In the Physical Interface Encapsulation box, select one of the following options:

• vlan-ccc

• extended-vlan-ccc

• flexible-ethernet-services

Physical Interface
Encapsulation

The Logical Interface Encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field.

For the physical encapsulation mode of vlan-ccc or flexible-ethernet-services, your only option is
to select vlan-ccc for the logical encapsulation method.

For the physical encapsulation mode of extended-vlan-ccc, your only option is to select
extended-vlan-ccc for the logical encapsulation method.

Logical Interface
Encapsulation
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ActionField

Transport all traffic Transports the traffic from all VLANs across the network.When you select this
option, the service provisioner is prompted for the VLAN-ID when creating a service order based
on this service definition. You need to specify only theOuter Tag protocol ID and Inner Tag protocol
ID.

Transport single vlanTransports traffic for a specific VLAN across the network. You need to specify
bothOuter Tag protocol ID and Inner Tag protocol ID.

Transport vlan range Limits the traffic across the network to a specific range of VLANs. You need
to specify bothOuter Tag protocol ID and Inner Tag protocol ID.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition.

Transport vlan list Limits the traffic across the network to a specific list of VLANs. If you select this
option, the serviceprovisioner is prompted for theVLAN-ID listwhencreatinga serviceorder based
on this service definition. You need to specify only theOuter Tag Protocol ID.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be able
to override this setting.

Traffic Type

Select a value:

• Normalize to vlan all—To preserve customer VLAN IDs (and customer QoS priorities) across the
network.

NOTE: For services that transport a range of VLANs, youmust select VLANNormalization to all.
You cannot transport a range of VLANs without normalization.

• Normalize to vlan none—To preserve no VLAN IDs across the network.

• Normalize to Dot1q tag—To transport only single-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network

• Normalize to QinQ tags—To transport only double-tagged frames across the network core. All
port, dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

NOTE: Starting with Release 1.0R2, when you newly install Connectivity Services Director, if
you select the option to not require normalization in a service definition, the auto-pick option
for VLAN IDs and the option to edit the auto-pick behavior in service order are disabled in the
service definition. When you create a service order by associating with that service definition,
you need to manually enter the VLAN IDs for the interfaces and cannot use the auto-pick
functionality. This same behavior also applies to default service templates inwhich if you select
the normalization-not-required functionality, the auto-pick option for VLAN IDs is disabled.

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 56.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 89.

VLANNormalization
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ActionField

Indicate how the VLAN ID is determined. By default, this check box is disabled.

• Clear this check box to allow the service provider to specify the VLAN ID. This option is normally
usedwhennoVLANnormalization is applied.Specify theVLAN ID range inVLANrangeformanual
input.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Select this check box when VLAN normalization is applied. Specify the VLAN ID pool in VLAN
range for auto-pick.

NOTE: Make sure to select Editable in Service Order if you want the service provisioner to be
able to override this setting.

NOTE: When the range of VLAN IDs that are automatically assigned by the system (with the
auto-pick option enabled during the creation of a service definition) is less than or greater than
the range of VLAN IDs that are manually specified (with the manual selection option enabled
during the creation of a service definition), the following conditions apply during the creation of a
serviceorderwith theEditable inServiceOrder checkbox selectedduring servicedefinitioncreation:

• If you create a service order with the auto-pick option enabled, the VLAN ID is selected from the
auto-pick range, and the value is displayed in the VLAN range for manual input field. If you
attempt to change the VLAN IDmanually, the value is restricted to the manually configured
range.

• If you create a service order with the auto-pick option disabled, the VLAN ID is selected from
themanually configured range, and the value is displayed in the VLAN range for manual input
field. If you attempt to change the VLAN IDmanually, the value is restricted to the manually
configured range.

Auto Pick VLAN ID

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag Protocol ID
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ActionField

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport all
traffic.

Inner Tag Protocol ID

To allow the service provisioner to override the outer and inner tag protocol IDs, select the check
boxes for those options.

Editable in Service Order

In the MTU range fields, type the lowest and highest values for MTU that the service provisioner
can type, for each UNI

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values that the service provisioner
can type.

MTU range for
manual-config

The default MTU value is 1522 bytes. To allow the service provisioner to override the MTU setting,
select the Editable in Service Order check box.

Default InterfaceMTU
(Bytes)

PE-CE Interface Rate-Limiting Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are available in the service definition when Manage CoS Profiles page
is configured with CoS profiles.

Enable Interface Rate
Limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 79 on page 629

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)
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ActionField

Bandwidth – Burst Size Settings

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 10.

• Burst Period Based
If you select the option Burst Period Based, you can specify a value for Burst Period in the range
1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Burst Size Calculator list is enabled only when you select the Enable Interface Rate
Limiting check box.

Burst Size Calculator

2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.

Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.

NOTE: On the Review page, in the Service Templates section, the names of
the service templates with which the service definition is associated are
displayed. The Default Service Template column indicates whether the
attached template is the default template.
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To examine andmodify the configured service definition settings:

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

3. Click Finish to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

The service order inventory window appears.

Related
Documentation

Creating a Multipoint-to-Multipoint E-LAN Service Definition on page 619•

• Creating a Service Definition for VPLS Access into Layer 3 Networks on page 666

Creating a Service Definition for VPLS Access into Layer 3 Networks

You can configure an Integrated Routing and Bridging (IRB) interface to provide access

from VPLS Layer 2 networks and services into Layer 3 networks. If the IRB interface

configured as a Layer 3 interface is being used in a routing instance, that routing instance

will specifically declare it as routing-interface rather thana regularVPLS interface (which

acts like the interface on a specific VPLS site). This feature requires a normalized VLAN

(vlan-id=xxxwhich is the sameas the unit nameonwhich the inet4 address is specified)

Junos Space uses the two peer subinterfaces of the IRB to create the link between an

existing VLAN and the Layer 3 network. An extra VPLS node is required to support the

IRB interface which allows the rest of the VPLS nodes to be able to access all Layer 3

networks reachable through that interface. Providing the VPLS access into Layer 3

networks enhances basic VPLS services. Because this feature requires a normalized

VLAN, it is available only on the Juniper Networks MX 3D Router series.

Prerequisites for VPLS Access into Layer 3 Networks

• The PE device with the IRBmust be a Juniper Networks MX 3D Series Router to

accommodate the normalized VLAN requirement.

• In addition to the PE device used for the IRB, 2 or more PEsmust exist on the VPLS

network for a minimum of 3 PE devices.

• A VLANmust already exist to configure this feature.
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To begin the configuration of the IRB interface, in the Network Services > Connectivity

task pane, select Service Design >Manage Service Definitions > Create E-LAN Service

Definition.

ActionField

Provide a name for the E-LAN service definition you want to create.Service Definition Name

Select the type of service from themenu list. To create theVPLS into Layer 3 service, use either
of the following service type:

Service Type

• (E-LAN)Multipoint-to-Multipoint

• (E-LAN) Point-to-Multipoint

Provide any comments or a description that will help explain the purpose of this definition.Description

Select an instance type to choose the type of routing instance for the E-LAN service:Instance Type

• vpls

• evpn

• virtual-switch

Different protocols are available based on the instance type you select:Protocol

• vpls

• evpn

• evpn e-tree

Select the check box to create the link into Layer 3.Enable L3 Access

Select this check box to pair any twoN-PEdevices, for providing redundant connectivity.When
you select this check box, a Multihoming Mode list appears if you select evpn or evpn e-tree
as the protocol type.

You can select either single-active or all-active as the multihomingmode.

Enable Multihoming

The Route target field is prepopulated with the Auto pick option.Route target

The Route distinguisher field is prepopulated with the Auto pick option.Route distingquisher

MAC Settings

MAC learning is on by default for E-LAN service definitions.MAC learning

The default value for InterfaceMAC limit is 1024. If you are using a different value, enter that
value.

InterfaceMAC limit

The table size is predetermined to correspond to the default MAC limit. If you are using a value
other than the default, specify that value.

MAC table size

1. Click Next to display the next screen, Site Settings, and continue creating the service

definition.
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Specifying Site or UNI Settings

ActionSite Settings Field

PE-CE Interface Settings – Ethernet Encapsulation

Indicate the Ethernet option to use for this E-LAN service definition. Choices are qinq,
dot1q, or asymmetric tag depth.

VLAN Tagging

The only option for E-LAN service definitions is Transport single VLAN.Customer VLANs

All E-LAN service definitions require VLAN normalization.VLAN normalization

The only option for E-LAN service definitions is Selectmanually.Auto Pick VLAN ID

The only option for E-LAN service definitions is flexible-ethernet-servicesPhysical Interface Encapsulation

The only option for E-LAN service definitions is vlan-vpls.Logical Interface Encapsulation

This field is populatedwith the default MTU value of 1522. If you are not using the default
value, enter the MTU value in bytes.

Default MTU (Bytes)

If you are specifying a customMTU value, indicate the range of values in bytes.MTU range (Bytes)

1. Click Finish to see the service definition inventory list.

2. Click on the unpublished service definition you just created.

3. Right-click on the selected service definition to choose publishing options.

4. Select the service definition and click Publish to save and publish the definition.

5. The next step is to create the service order. In theNetworkServices>Connectivity task

pane, select Service Provisioning.

Related
Documentation

• Creating a Multipoint-to-Multipoint E-LAN Service Definition on page 619

• Creating a Point-to-Multipoint E-LAN Service Definition on page 641
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CHAPTER 27

Service Design: Managing IP Service
Definitions

• Creating a Full-Mesh IP Service Definition on page 669

• Creating a Hub-and-Spoke (One Interface) IP Service Definition on page 678

• CreatingaServiceDefinition forE-LinePseudowireAccess intoaLayer3VPNonpage689

• Creating a Multicast VPN Service Definition on page 691

Creating a Full-Mesh IP Service Definition

You can create a customized service definition—for example, to set a different VLAN ID

range on the service than those offered in the standard service definitions. Network

operators or service provisioners can use the service definition as a base for creating and

then activating full-mesh ethernet services on the network.

You can use the tab panel at the top, or the Back and Next buttons to switch between

the wizard pages.

You can create a Full-Mesh IP Service Definition, by following the steps given in the

procedure.

Creating a full mesh IP service definition consists of the following steps:

1. Specifying General Settings Information on page 669

2. Specifying Site or UNI Settings on page 672

3. Reviewing the Configured Settings on page 677

Specifying General Settings Information

In theServiceViewpane, selectNetworkServices>Connectivity> IPServices. In theTasks

pane, select Service Design >Manage Service Definitions.

1. In theManage Service Definitions pane, click New.

The Create IP Service Definitionwizard appears.

2. To specify the general settings or service attributes for a full mesh service definition,

fill in the fields on the General page as indicated in Table 81 on page 670.
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Table 81: IP Service Definition - General Settings

ActionField

Type a unique name that identifies the full mesh IP definition.

Range: 3 through 50 characters.

Service Definition Name

Select IP (Full Mesh).Service Type

Select one of the following instance types:

• vrf—To advertise routes from the CE router to the PE router and vice versa.

• default—To add an IP Transit Service to the PE-CE router configuration.

• virtual router—To divide a router into multiple independent virtual routers where each router has
its own routing table.

The Connectivity Settings sections appear only if the instance type is vrf.

NOTE: Starting from Connectivity Services Director Release 2.0R4 onward, default instance type
and virtual router instance type are also added to full-mesh IP services.

Instance Type

Type a comment that identifies or describes the definition.

Range: 1 through 200 characters.

Description (Optional)

Select this check box to specify different routing instance name for each device selected in an IP
Service.

NOTE: Starting fromConnectivity Services Director 2.0R4 onward, you can specify a distinct routing
instance name for each device when you deploy a service onmultiple devices while creating a
full-mesh IP service definition.

Enable Distinct Instance
Name

Select this check box to isolate the events related to an interface in the OpenNMS.

NOTE: When you select this check box, only the MPLS traps are monitored, and not the
interface-related traps (such as jnxVpnIfUp or jnxVpnIfDown).

By default, all the events are saved in the OpenNMS database.

Decouple Service Status
FromPort Status

Connectivity Settings

Select this check box to create a policy-based vrf instance.

Deselect this check box to create a community-based vrf instance.

Route Leak is supported when Policy Based Route Target check box is selected.

For more information on creating policies for an IP service, see “Creating Policies for an IP Service”
on page 934.

Policy Based Route
Target
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Table 81: IP Service Definition - General Settings (continued)

ActionField

Select a route target option:

• Select theAuto-pick Route Target check box and the Policy Based Route Target check box to auto
generate route target policies.

• Select the Auto-pick Route Target check box and deselect the Policy Based Route Target check
box to auto generate a community. No policy will be used.

• When you clear this check box and select the Policy Based Route Target check box:

• You can create a route target policy and associate it with import and export policy.

• The route target policy will be auto generated.
Note that, you cannot manually select or modify policy during the modification of service.

To override this setting in the service order, you can select the Editable in Service Order check box.

Auto-pick Route Target

Select this check box in the Create IP Service Definitionwizard to enable internal and external route
leak as part of route target policy creation.

NOTE: Starting from Release 2.0R4 onward, Connectivity Services Director supports internal and
external route leakaspartof route targetpolicy creationwhile creatinga full-mesh IPservicedefinition.

Enable Auto Export
Routes

Select this check box in the Create IP Definition wizard to enable internal route leak feature as part
of route target policy creation.

Import Internal Route field is available only if Policy Based Route Target check box is selected.

Import Internal Routes

Select this check box in the Create IP Definition wizard to enable external route leak feature as part
of route target policy creation.

Import External Route field is available only if Policy Based Route Target check box is selected.

Import External Route

Select a route distinguisher option:

• Deselect the check box to enable the service provider to specify the route distinguisher.

• Select the check box to enable the route distinguisher to be selected automatically.

To override this setting in the service order, you can select the Editable in Service Order check box.

Auto-pick Route
Distinguisher

Select this check box to configure a separate label for each VRF to provide double lookup and egress
filtering.

To override this setting in the service order, you can select the Editable in Service Order check box.

VRF Table label

Select this check box to export direct routes.Export Direct Routes

Select the check box to enable multicast virtual private network (MVPN).Enable MVPN

671Copyright © 2019, Juniper Networks, Inc.

Chapter 27: Service Design: Managing IP Service Definitions



Table 81: IP Service Definition - General Settings (continued)

ActionField

(Optional) To include a service template for the service, click the Add icon or plus sign (+) to select
a service template from the Service Template list. The list of available service templates is displayed.
Select the check box beside the template you want and clickOK. You are returned to the General
Settings page.

The selected service template appears in the Default Service Template field.

You can select one ormore service templates as the default service template. By default, the default
service templates are attached to the endpoints.

NOTE: Starting with Connectivity Services Director Release 2.1, you can add or delete a service
template while creating a service order.

The remaining service templateson theServiceTemplate list are termedasoptional service templates.
You can attach the optional service templates to the endpoints on a need basis.

In theViewServiceDefinitionDetailswindow, the value for thedefault service template in theDefault
Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 1711.

NOTE: To provision an IP service for QinQ UNI type, you can create a service template with service
variables as interface name and unit name.

Service Template

3. ClickNext to save theGeneral page information. Continuewith “Specifying Site or UNI

Settings” on page 672.

Specifying Site or UNI Settings

To provide the site or UNI service attributes for this service definition:

1. Fill in the fields on the Site Settings page as indicated in Table 82 on page 672.

Table 82: IP Service Definition - PE-CE UNI Settings

ActionField

PE-CE UNI Settings

MTU Settings

You can specify an MTU value in this field. The default value
for MTU is 1522 bytes.

To see the permitted range for the MTU value, select the
Editable in Service Order check box. The MTU range is 1522
through 9192.

InterfaceMTU (Bytes)

Copyright © 2019, Juniper Networks, Inc.672

Connectivity Services Director User Guide



Table 82: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

If you select the check box Editable in Service Order, you can
specify a value range for MTU (in bytes). The permitted range
for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU by
multiplying the value you specify in the Default MTU (Bytes)
field by the value you specify forMTU Factor.

MTURange (Bytes)

Bandwidth Settings

When you enableQoS in the service definition, you can specify
a QoS profile in the service order to classify traffic into defined
servicegroups toprovide the special treatmentof traffic across
the network service. For example, voice traffic can be sent
across certain links, and data traffic can use other links.

If youenable the inclusionofQoSprofile settings for the service
in the service template or service definition, the list of CoS
profiles that you defined using the Manage CoS Profiles page
(byselectingCoSunderProfileandConfigurationManagement
in the Tasks pane) are displayed. Select the CoS profile you
want to associate with the service from the drop-down list.

Enable QoS

Select the check box to enable rate-limiting of trafic. Clear the
check box to disable rate-limiting.

Enable rate limiting (check box)

Specify the default bandwidth value, in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Bandwidth (Mbps)

To override the default bandwidth value, select the Editable
in Service Order check box.

Specify the minimum bandwidth value in Kbps:

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value, in Mbps.

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)
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Table 82: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and ACX Series Routers:

Table 83: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

Specify a value in the range that is made available to the
service provisioner.

Increment (Kbps)

You can choose one of the following as the Burst Size:

• MTU Based (default)

• Line Rate Based

Burst Size is the number of bytes that can pass unrestricted
through a policed interface when a burst of traffic pushes the
average transmit rate or receive rate above the configured
bandwidth limit.

NOTE: This field is enabled only when you select the Enable
Rate Limiting check box.

Burst Size

You can specify a value forMTU Factor in the range 1 through
1087902. The default value for MTU Factor is 10.

The value you configure forMTUFactor should not exceedone
tenth of the value you configured for burst size.

NOTE: This field is enabled only when you selectMTUBased
as the Burst Size.

MTU Factor

Specify a value for Burst Period in the range 10 through 1000.
The default value for Burst Period is 10.

NOTE: This field is enabled only when you select Line Rate
Based as the Burst Size.

Burst Period

PE-CE Interface Encapsulation Settings
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Table 82: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

Specify how the VLAN ID is determined:

• To allow the service provider to specify the VLAN ID, clear
this checkbox.Specify the range inVLANIDRangeforManual
Config.

• To allow the VLAN ID to be selected automatically from the
VLAN ID pool, select Auto-pick VLAN ID check box. This
option isused typicallywhenVLANnormalization isapplied.
Specify the range in VLAN ID Range for Auto-pick

NOTE: Select the Editable in Service Order check box, if you
want to override VLAN ID selection setting in the service order.

NOTE: When the range of VLAN IDs that are automatically
assigned by the system (with the auto-pick option enabled
during thecreationof a servicedefinition) is less thanor greater
than the range of VLAN IDs that are manually specified (with
the manual selection option enabled during the creation of a
service definition), the following conditions apply during the
creation of a service order with the Editable in Service Order
check box selected during service definition creation:

• If you create a service order with the Auto-pick VLAN ID
option enabled, the VLAN ID is selected from the auto-pick
range, and the value is displayed in the VLAN ID Range for
Auto-Pick field. If you attempt to change the VLAN ID
manually, the value is restricted to themanually configured
range.

• If you create a service order with the Auto-pick VLAN ID
option disabled, the VLAN ID is selected from themanually
configured range, and the value is displayed in the VLAN ID
range for Manual Config field. If you attempt to change the
VLAN IDmanually, the value is restricted to the manually
configured range.

Auto-pick VLAN ID

Specify the range.

Range: 1 through 4094.

VLAN range for auto-pick

Specify the range.

Range: 1 through 4094.

NOTE: This parameter reserves a range of VLANs for
provisioning Layer 3 VPNs. These VLANs are not used to
transport data from one end of a connection to the other.

VLAN ID Range for Manual Config

PE-CE Routing
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Table 82: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

Select one of the following options to allow each PE router to
distribute VPN-related routes to and from connected CE
routers:

• BGP/Static Route

• OSPF/Static Route

• BGP/OSPF/Static Route

NOTE: Starting inConnectivityServicesDirectorRelease2.1R1,
you can also select the BGP/OSPF/Static option from the
routingprotocol list to configurebothBGPandOSPFprotocols
while creating a full-mesh IP service definition.

Routing Protocols

PE-CE Interface Address Settings

Indicate the method to be used for assigning IP addresses to
PE and CE interfaces. The address-assignment pool feature
supports subscriber management and DHCPmanagement
functionalitybyenabling you tocreatecentralized IPv4address
pools independently of the client applications that use the
pools.

Select the check box to enable allocation of PE-CE IP
addresses from IP address pools. By default, this check box is
deselected. Clear the check box to disable the
address-assignment pools functionality.

Pool-based assignment

Select an IP pool type option:

• Global—A Global IP address pool pertains to the service
provider. There can bemore than one global IPv4 address
pool. However, each global pool must have its own unique
name and its set of IPv4 addresses must not overlap with
those of any other global pool. You can allocate addresses
from global pools across multiple Layer 3 VPNs across
multiple customers. The IP addresses allocated to services
are unique across customers.

• Customer—A Customer IP address pool pertains to an
existing customer. These pools are associated with the
corresponding customer. You can associate more than one
customer IPv4 pool with each customer. However, each
customer pool must have its own set of IPv4 addresses
which must not overlap with those of any other pool
belonging to thesamecustomer.Youcanallocateaddresses
from customer pools across multiple Layer 3 VPNs for a
particular customer. The IP addresses allocated to services
are unique within specified customer services.

For more information on creation an IP pool, see Creating an
IP Address Pool.

IP Pool Type
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Table 82: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

Select an option:

• Clear the check box to enable the service provider to specify
the IP address of a provider edge (PE) interface.

• Select the check box to cause the IP address of a provider
edge (PE) interface to be selected automatically.

To override this setting in the service order, you can select the
Editable in Service Order check box.

Auto-pick PE Interface IP Address

Specify the size of the IPv4 IP addressee block allocated for
each provider edge (PE) or customer edge (CE) link.

Range: 1 through 32

To override this setting in the service order, you can select the
Editable in Service Order check box.

IP Address Block Size

2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.

Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.

NOTE: On the Review page, in the Service Templates section, the names of
the service templates with which the service definition is associated are
displayed. The Default Service Template column indicates whether the
attached template is the default template.
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To examine andmodify the configured service definition settings:

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

3. Click Done to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

The service order inventory window appears.

Release History Table DescriptionRelease

Starting in Connectivity Services Director Release 2.1R1, you can also select the
BGP/OSPF/Static option from the routing protocol list to configure both BGP and
OSPF protocols while creating a full-mesh IP service definition.

2.1R1

Starting from Connectivity Services Director Release 2.0R4 onward, default
instance type and virtual router instance type are also added to full-mesh IP
services.

2.0R4

Starting from Connectivity Services Director 2.0R4 onward, you can specify a
distinct routing instance name for each device when you deploy a service on
multiple devices while creating a full-mesh IP service definition.

2.0R4

Starting from Release 2.0R4 onward, Connectivity Services Director supports
internal and external route leak as part of route target policy creation while
creating a full-mesh IP service definition.

2.0R4

Related
Documentation

Creating a Hub-and-Spoke (One Interface) IP Service Definition on page 678•

• Creating a Service Definition for E-Line Pseudowire Access into a Layer 3 VPN on

page 689

• Creating a Multicast VPN Service Definition on page 691

Creating a Hub-and-Spoke (One Interface) IP Service Definition

You can create a one-interface hub-and-spoke BGP/Static or OSPF/Static IP service

definition, for the Connectivity Services Director application, using predefined service

definitions.
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In the Service View pane, click Network Services > Connectivity > IP Services. In the Tasks

pane, click Service Design >Manage Service Definitions.

To create a new service definition, click New In theManage Service Definitions pane. You

canalsochooseapredefinedservicedefinition fromtheManageServiceDefinitionspane.

Inaone-interfacehub-and-spoke topology, there isonlyone interfaceusingacombination

of static routes, BGP, and OSPF routes between CE hub and PE hub routers. You can use

a one-interface hub-and-spoke IP service definition to configure a service to advertise a

default route from a hub to the spokes.

For more information about predefined one-interface hub-and-spoke BGP/Static or

OSPF/Static IP servicedefinitions, see “PredefinedHub-andSpoke IPServiceDefinitions”

on page 576. You can, however create a customized service definition—for example, to

set different bandwidth limits on the service than those offered in the standard service

definitions.

YoumusthaveaServiceDesigner user role to create IPhub-and-spoke servicedefinitions.

When you create and publish a new service definition, network operators or service

provisioners with a Service Activator role can use the completed service definition as a

base for creating and then activating hub-and-spoke Ethernet services on the network.

Creating a hub-and-spoke (one interface) IP service definition consists of the following

steps:

1. Specifying General Information on page 679

2. Specifying UNI or Site Settings on page 682

3. Reviewing the Configured Settings on page 687

Specifying General Information

To specify general information for a hub-and-spoke service definition:

1. Fill in the fields on the General page as indicated in Table 84 on page 679.

Table 84: IP Service Definition - General Settings

ActionField

Type a unique name that identifies the hub-and-spoke IP definition.

Range: 3 through 50 characters.

Service Definition Name

Select IP (Hub-Spoke 1 Interface).Service Type
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Table 84: IP Service Definition - General Settings (continued)

ActionField

Select one of the following instance types:

• vrf—To advertise routes from the CE router to the PE router and vice versa.

• default—To add an IP Transit Service to the PE-CE router configuration.

• virtual router—To divide a router into multiple independent virtual routers where each router has
its own routing table.

The Connectivity Settings sections appear only if the instance type is vrf.

NOTE: Starting from Connectivity Services Director Release 2.0R4 onward, default instance type
and virtual router instance type are also added to hub-and-spoke IP services.

Instance Type

Type a comment that identifies or describes the definition.

Range: 1 through 200 characters.

Description (Optional)

Select this check box to specify different routing instance name for each device selected in an IP
service.

NOTE: Starting fromConnectivity Services Director 2.0R4 onward, you can specify a distinct routing
instance name for each device when you deploy a service onmultiple devices while creating a
hub-and-spoke IP service definition.

Enable Distinct Instance
Name

Select this check box to isolate the events related to an interface in the OpenNMS.

NOTE: When you select this check box, only the MPLS traps are monitored, and not the
interface-related traps (such as jnxVpnIfUp or jnxVpnIfDown).

By default, all the events are saved in the OpenNMS database.

Decouple Service Status
FromPort Status

Connectivity Settings

Select this check box to create a policy-based vrf instance.

Deselect this check box to create a community-based vrf instance.

Route Leak is supported when Policy Based Route Target check box is selected.

For more information on creating policies for an IP service, see “Creating Policies for an IP Service”
on page 934.

Policy Based Route
Target

Select a route target option:

• Select theAuto-pick Route Target check box and the Policy Based Route Target check box to auto
generate route target policies.

• Select the Auto-pick Route Target check box and deselect the Policy Based Route Target check
box to auto generate a community. No policy will be used.

• When you clear this check box and select the Policy Based Route Target check box:

• You can create a route target policy and associate it with import and export policy.

• The route target policy will be auto generated.
Note that, you cannot manually select or modify policy during the modification of service.

To override this setting in the service order, you can select the Editable in Service Order check box.

Auto-pick Route Target
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Table 84: IP Service Definition - General Settings (continued)

ActionField

Select this check box in the Create IP Service Definitionwizard to enable internal and external route
leak as part of route target policy creation.

NOTE: Starting from Release 2.0R4 onward, Connectivity Services Director supports internal and
external route leak as part of route target policy creation while creating a hub-and-spoke IP service
definition.

Enable Auto Export
Routes

Select this check box in the Create IP Definition wizard to enable internal route leak feature as part
of route target policy creation.

Import Internal Route field is available only if Policy Based Route Target check box is selected.

Import Internal Routes

Select this check box in the Create IP Definition wizard to enable external route leak feature as part
of route target policy creation.

Import External Route field is available only if Policy Based Route Target check box is selected.

Import External Route

Select a route distinguisher option:

• Deselect the check box to enable the service provider to specify the route distinguisher.

• Select the check box to enable the route distinguisher to be selected automatically.

To override this setting in the service order, you can select the Editable in Service Order check box.

Auto-pick Route
Distinguisher

Select this check box to configure a separate label for each VRF to provide double lookup and egress
filtering.

To override this setting in the service order, you can select the Editable in Service Order check box.

VRF Table Label

Select this check box to export direct routes.Export Direct Routes

Select this checkbox toenableMVPNsettings in IP serviceorders tobebasedon this servicedefinition.Enable MVPN
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Table 84: IP Service Definition - General Settings (continued)

ActionField

(Optional) To include a service template for the service, click the Add icon or plus sign (+) to select
a service template from the Service Template list. The list of available service templates is displayed.
Select the check box beside the template you want and clickOK. You are returned to the General
Settings page.

The selected service template appears in the Default Service Template field.

You can select one ormore service templates as the default service template. By default, the default
service templates are attached to the endpoints.

NOTE: Starting with Connectivity Services Director Release 2.1, you can add or delete a service
template while creating a service order.

The remaining service templateson theServiceTemplate list are termedasoptional service templates.
You can attach the optional service templates to the endpoints on a need basis.

In theViewServiceDefinitionDetailswindow, the value for thedefault service template in theDefault
Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 1711.

NOTE: To provision an IP service for QinQ UNI type, you can create a service template with service
variables as interface name and unit name.

Service Template

2. Click Next to save the General information.

The Site Settings-Create IP Service Definition page appears.

Specifying UNI or Site Settings

To specify UNI interface settings for the service definition:

1. Fill in the fields on the Site Settings page as indicated in the table as indicated in

Table 85 on page 682.

Table 85: IP Service Definition - PE-CE UNI Settings

ActionField

PE-CE UNI Settings

MTU Settings

You can specify an MTU value in this field. The default value
for MTU is 1522 bytes.

To see the permitted range for the MTU value, select the
Editable in Service Order check box. The MTU range is 1522
through 9192.

InterfaceMTU (Bytes)
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Table 85: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

If you select the check box Editable in Service Order, you can
specify a value range for MTU (in bytes). The permitted range
for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU by
multiplying the value you specify in the Default MTU (Bytes)
field by the value you specify forMTU Factor.

MTURange (Bytes)

Bandwidth Settings

WhenyouenableQoS in theservicedefinition, youmustspecify
a QoS profile in the service order to classify traffic into defined
servicegroups toprovide the special treatmentof traffic across
the network service. For example, voice traffic can be sent
across certain links, and data traffic can use other links.

If youenable the inclusionofQoSprofile settings for the service
in the service template or service definition, the list of CoS
profiles that you defined using the Manage CoS Profiles page
(byselectingCoSunderProfileandConfigurationManagement
in the Tasks pane) are displayed. Select the CoS profile you
want to associate with the service from the drop-down list.

Enable QoS

Select the check box to enable rate-limiting of trafic. Clear the
check box to disable rate-limiting.

Enable rate limiting (check box)

Specify the default bandwidth value, in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Bandwidth (Mbps)

To override the default bandwidth value, select the Editable
in Service Order check box.

Specify the minimum bandwidth value in Kbps:

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value, in Mbps.

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)
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Table 85: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and ACX Series Routers:

Table 86: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

You can choose one of the following as the Burst Size:

• MTU Based (default)

• Line Rate Based

Burst Size is the number of bytes that can pass unrestricted
through a policed interface when a burst of traffic pushes the
average transmit rate or receive rate above the configured
bandwidth limit.

NOTE: This field is enabled only when you select the Enable
Rate Limiting check box.

Burst Size

You can specify a value forMTU Factor in the range 1 through
1087902. The default value for MTU Factor is 10.

The value you configure forMTUFactor should not exceedone
tenth of the value you configured for burst size.

NOTE: This field is enabled only when you selectMTUBased
as the Burst Size.

MTU Factor

Specify a value for Burst Period in the range 10 through 1000.
The default value for Burst Period is 10.

NOTE: This field is enabled only when you select Line Rate
Based as the Burst Size.

Burst Period

Specify a value in the range that is made available to the
service provisioner.

Increment (Kbps)

PE-CE Interface Encapsulation Settings
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Table 85: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

Specify how the VLAN ID is determined:

• To allow the service provider to specify the VLAN ID, clear
thecheckbox.Specify the range inVLANIDRangeforManual
Config..

• To allow the VLAN ID to be selected automatically from the
VLAN ID pool, select Auto-pick VLAN ID check box. This
option isused typicallywhenVLANnormalization isapplied.
Specify the range in VLAN ID Range for Auto-pick

NOTE: Select the Editable in Service Order check box, if you
want to override VLAN ID selection setting in the service order.

NOTE: When the range of VLAN IDs that are automatically
assigned by the system (with the auto-pick option enabled
during thecreationof a servicedefinition) is less thanor greater
than the range of VLAN IDs that are manually specified (with
the manual selection option enabled during the creation of a
service definition), the following conditions apply during the
creation of a service order with the Editable in Service Order
check box selected during service definition creation:

• If you create a service order with the Auto-pick VLAN ID
option enabled, the VLAN ID is selected from the auto-pick
range, and the value is displayed in the VLAN ID Range for
Manual Config field. If you attempt to change the VLAN ID
manually, the value is restricted to themanually configured
range.

• If you create a service order with the auto-pick option
disabled, the VLAN ID is selected from themanually
configured range, and the value is displayed in the VLAN
range for manual input field. If you attempt to change the
VLAN IDmanually, the value is restricted to the manually
configured range.

Auto-pick VLAN ID

Specify the range.

Range: 1 through 4094.

VLAN range for auto-pick

Specify the range.

Range: 1 through 4094.

NOTE: This parameter reserves a range of VLANs for
provisioning Layer 3 VPNs. These VLANs are not used to
transport data from one end of a connection to the other.

VLAN ID Range for Manual Config

PE-CE Routing
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Table 85: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

Select one of the following options to allow each PE router to
distribute VPN-related routes to and from connected CE
routers:

• BGP/Static Route

• OSPF/Static Route

• BGP/OSPF/Static Route

NOTE: Starting from Connectivity Services Director Release
2.1R1, you can also select the BGP/OSPF/Static option from
the routing protocol list to configure both BGP and OSPF
protocolswhile creatingahub-and-spoke IP servicedefinition.

Routing Protocols

PE-CE Interface Address Settings

Indicate the method to be used for assigning IP addresses to
PE and CE interfaces. The address-assignment pool feature
supports subscriber management and DHCPmanagement
functionalitybyenabling you tocreatecentralized IPv4address
pools independently of the client applications that use the
pools.

Select the check box to enable allocation of PE-CE IP
addresses from IP address pools. By default, this check box is
deselected. Clear the check box to disable the
address-assignment pools functionality.

Pool-based assignment

Select an IP pool type option:

• Global—A Global IP address pool pertains to the service
provider. There can bemore than one global IPv4 address
pool. However, each global pool must have its own unique
name and its set of IPv4 addresses must not overlap with
those of any other global pool. You can allocate addresses
from global pools across multiple Layer 3 VPNs across
multiple customers. The IP addresses allocated to services
are unique across customers.

• Customer—A Customer IP address pool pertains to an
existing customer. These pools are associated with the
corresponding customer. You can associate more than one
customer IPv4 pool with each customer. However, each
customer pool must have its own set of IPv4 addresses
which must not overlap with those of any other pool
belonging to thesamecustomer.Youcanallocateaddresses
from customer pools across multiple Layer 3 VPNs for a
particular customer. The IP addresses allocated to services
are unique within specified customer services.

For more information on creation an IP pool, see “Creating an
IP Address Pool” on page 385.

IP Pool Type
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Table 85: IP Service Definition - PE-CE UNI Settings (continued)

ActionField

Select an option:

• Clear the check box to enable the service provider to specify
the IP address of a provider edge (PE) interface.

• Select the check box to cause the IP address of a provider
edge (PE) interface to be selected automatically.

To override this setting in the service order, you can select the
Editable in Service Order check box.

Auto-pick PE Interface IP Address

Specify the size of the IPv4 IP addressee block allocated for
each provider edge (PE) or customer edge (CE) link.

Range: 1 through 32

To override this setting in the service order, you can select the
Editable in Service Order check box.

IP Address Block Size

2. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

After youcomplete reviewing thesettings, clickFinish to complete theservicedefinition

creation.

Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.

NOTE: On the Review page, in the Service Templates section, the names of
the service templates with which the service definition is associated are
displayed. The Default Service Template column indicates whether the
attached template is the default template.

687Copyright © 2019, Juniper Networks, Inc.

Chapter 27: Service Design: Managing IP Service Definitions



To examine andmodify the configured service definition settings:

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

3. Click Done to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

The service order inventory window appears.

Release History Table DescriptionRelease

Starting from Connectivity Services Director Release 2.1R1, you can also select
the BGP/OSPF/Static option from the routing protocol list to configure both BGP
and OSPF protocols while creating a hub-and-spoke IP service definition.

2.1R1

Starting from Connectivity Services Director Release 2.0R4 onward, default
instance type and virtual router instance type are also added to hub-and-spoke
IP services.

2.0R4

Starting from Connectivity Services Director 2.0R4 onward, you can specify a
distinct routing instance name for each device when you deploy a service on
multiple devices while creating a hub-and-spoke IP service definition.

2.0R4

Starting from Release 2.0R4 onward, Connectivity Services Director supports
internal andexternal route leakaspart of route targetpolicy creationwhile creating
a hub-and-spoke IP service definition.

2.0R4

Related
Documentation

Creating a Full-Mesh IP Service Definition on page 669•

• Creating a Service Definition for E-Line Pseudowire Access into a Layer 3 VPN on

page 689

• Creating a Multicast VPN Service Definition on page 691
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Creating a Service Definition for E-Line Pseudowire Access into a Layer 3 VPN

Creating a pseudowire between two terminating PE devices allows you to encapsulate

traffic from the Layer 2 VPN into a Layer 3 VPN, thereby providing access to Layer-3

services. Also known as pseudowire stitching, the benefit of this feature is that devices

running older technologies will continue to function when networks are upgraded and

Layer-3 technologies are in play.

To use this feature, the following prerequisites must bemet:

• An existing Layer 3 VPNmust be used as the target VPN.

• A device with an LT interface must be used to create the pseudowire.

To create the pseudowire, in the Network Services > Connectivity view pane, select

Service Design > New > E-Line Service Definition.

1. Define the general settings for the service definition.

ActionField

Provide a name for the service definition.Name

The service type is E-Line pseudowireService type

Enter any comments that will help describe the service definition and its purpose.Comments

Specify the type of interface as Ethernet. Also check the box to enable pseudowire access
into the Layer 3 VPN network.

Interface type

2. Click Next to display the Connectivitywindow.

ActionField

Choose from Auto pick or Select Manually for VC ID assignment.VC ID selection

Indicate the MTU size or use the default that appears in the field.Default MTU (Bytes)

3. Click Next to display the Site Settingswindow.

4. Define the UNI settings for the service definition. This definition can be created as a

port-to-port or 802.1q link. This procedure shows the port-to-port Ethernet settings.

ActionSite Settings Field

Traffic Treatment Settings
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ActionSite Settings Field

Indicate the Ethernet option to use for this E-Line service definition. Choices are port-port
or dot1q.

Ethernet option

This field can be left blank.Customer traffic type

This field can be left blank.VLAN ID selection

Interface Settings

The interface encapsulation for the port-to-port link must be specified as ethernet-ccc.Physical IF encapsulation

This field is not used.Logical IF encapsulation

MTU Settings

This field is populatedwith the default MTU value of 1522. If you are not using the default
value, enter the MTU value in bytes.

Default MTU (Bytes)

If you are specifying a customMTU value, indicate the range of values in bytes.MTU range (Bytes)

If you are creating an 802.1q link, use the following settings:

5. Click Finish and then create the service order.

NOTE: On the Review page, in the Service Templates section, the names
of the service templates with which the service definition is associated
are displayed. The Default Service Template column indicates whether
the attached template is the default template.

Related
Documentation

Creating a Full-Mesh IP Service Definition on page 669•

• Creating a Hub-and-Spoke (One Interface) IP Service Definition on page 678

• Creating a Multicast VPN Service Definition on page 691
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Creating aMulticast VPN Service Definition

This topic describes how the Connectivity Services Director application enables you to

createanL3VPNservicedefinitionpreliminary tocreatingaMulticastVPN(MVPN)service

order.

Refer to the topic “Creating a Full-Mesh IP Service Definition” on page 669.

NOTE: Multicast VPN services are supported on LN2600 andMX devices
only.

To create a L3VPN Service definition upon which to base a MVPN service order, in the

Network Services > Connectivity view pane, select Service Design >Manage Service

Definitions > New > L3VPN Service Definition.

1. Specify values for the parameters in the General and Site Settingswindows as

described in the following tables.

In the General settings window, add information in the relevant fields as described in

the following table:

DescriptionField

Type a name for this service definition.Service Definition Name

Select L3VPN (Full Mesh)Service type

Type comments to describe the service definition.Description

NoneService Template

Select this check box to enable MVPN settings in L3VPN service orders to
be based on this service definition.

Enable MVPN

Do not select this check box.Decouple Service Status fromPort Status

2. Click Next.

3. In the Site Settingswindow, add information in the relevant fields as described in the

following table:

DescriptionField

Select this check box.Ethernet

Select this check box.Auto-pick VLAN ID
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DescriptionField

N/AVLAN range for auto-pick

N/AVLAN range for manual input

AsitewithinaVPNthataPE router servicesand towhich thePE routerwill distribute routes.Auto-pick Route Target

An identifier attached to a route that distinguishes the VPN to which the route belongs.
Each routing instancemust have a unique route distinguisher associated with it.

Select Auto pick. JUNOS Space selects the route distinguisher automatically.

Auto-pick Router Distinguisher

AVRF table label distinguishes one VRF instance from another and enables double lookup
and egress filtering.

Select this check box.

VRF Table label

Select this check box.Export Direct Routes

Select BGP/Static RouteAllowed Routing Protocols

The IP address of the interface on the PE device.

Select Auto pick.

PE Interface IP Address

Global—A Global IP address pertains to the service provider. There can bemore than one
global IPv4 address pool. However, each global pool must have its own unique name and
its set of IPv4 addresses must not overlap with those of any other global pool. You can
allocate addresses from global pools across multiple Layer 3 VPNs across multiple
customers.

Customer—A Customer IP address pool pertains to an existing customer. These pools are
associated with the corresponding customer. You can associate more than one customer
IPv4 pool with each customer. However, each customer poolmust have its own set of IPv4
addresses which must not overlap with those of any other pool belonging to the same
customer. You can allocate addresses from customer pools across multiple Layer 3 VPNs
for a particular customer.

IP Pool Type

The size of the IPv4 addresses block allocated for each PE/CE link.

Range: 28–32

IP Address Bock Size

4. Click Review to examine the settings andmodify any attributes as required.

NOTE: On the Review page, in the Service Templates section, the names
of the service templates with which the service definition is associated
are displayed. The Default Service Template column indicates whether
the attached template is the default template.

5. Click Finish.
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Related
Documentation

• Creating a Full-Mesh IP Service Definition on page 669

• Creating a Hub-and-Spoke (One Interface) IP Service Definition on page 678

• Creating a Service Definition for E-Line Pseudowire Access into a Layer 3 VPN on

page 689
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PART 8

Service Provisioning: Working with
Customers

• Service Provisioning: Managing Customers on page 697
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CHAPTER 28

ServiceProvisioning:ManagingCustomers

• Adding a New Customer on page 697

• Deleting Customers on page 698

• Modifying an Existing Customer on page 699

• Viewing Customer Details on page 699

Adding a NewCustomer

New customers must be identified to the system before you can provision and activate

a service order for them.

To add a customer to the database:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In theNetworkServices>Connectivity taskpane, selectCustomer>ManageCustomers.

The View Customers window is displayed.

4. Click the Add icon above the table of listed customers. The Add Customer dialog box

is displayed.

5. OntheCreateCustomerdialogbox,provide the information requested for thecustomer,

similar to the following example.

Fill out the fields in the form.

The Name and Account number fields are required. All other fields are optional.

6. Click Create.

The View Customers page shows the new customer.
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Related
Documentation

Deleting Customers on page 698•

• Modifying an Existing Customer on page 699

• Viewing Customer Details on page 699

Deleting Customers

You cannot delete a customer from the database if an active service exists for that

customer. Youmust decommission all such services before you can delete the customer.

To delete a customer from the database:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In theNetworkServices>Connectivity taskpane, selectCustomer>ManageCustomers.

The View Customers window is displayed.

4. Select the customer you need to delete by clicking the row of the corresponding

customer.

5. Click the Delete above the list of displayed customers.

If theDelete option is dimmed, it indicates that you have not selected a customer that

must be cleared for the operation to succeed.

After successfully selecting the Delete action, a pop-up window appears requesting

confirmation.

6. Click Delete.

The View Customers page no longer lists the deleted customer.

Related
Documentation

Adding a New Customer on page 697•

• Modifying an Existing Customer on page 699

• Viewing Customer Details on page 699
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Modifying an Existing Customer

To edit the information about an existing customer:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In theNetworkServices>Connectivity taskpane, selectCustomer>ManageCustomers.

The ViewCustomerswindow is displayed, which shows the customers already added

to the system.

4. Select the customer you need to modify by clicking the row of the corresponding

customer.

5. Click the Edit icon above the table of displayed customers.

6. Make the required changes to the customer information.

7. ClickModify.

The View Customers page shows themodified information.

Related
Documentation

Adding a New Customer on page 697•

• Deleting Customers on page 698

• Viewing Customer Details on page 699

Viewing Customer Details

To view your customers:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In theNetworkServices>Connectivity taskpane, selectCustomer>ManageCustomers.

The ViewCustomerswindow is displayed, which shows the customers already added

to the system.
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4. Click the plus sign (+) next to the Customers tree in the Service View pane and select

the customer for which you need to view detailed, extensive information.

5. From the View Customers page, click the Details icon above the table of displayed

customers.

Alternatively, for details about a specific customer, double-click the listed customer.

The Detailswindow displays the customer name, account number, contact name,

contact e-mail address, and contact information in the upper half of the page. The

lower half of the page displays the Services Provisioned for Customer pane. This pane

contains three tabs: E-Line, E-LAN, and IP. The following fields are displayed in a table

under each tab, depending on the type of service associated with a customer.

DescriptionField

Name of the service order assigned during service creation or edit.Name

One of the following:

• E-Line (LDP)

• E-LAN—Eitheramultipoint-to-multipointserviceorapoint-to-multipoint
service

Service Type

Name of the enterprise customer who placed an order for the service.Customer

Status of the service order:

• Completed—Service order has been successfully deployed.

• Deploy failed—Device is down or the Connectivity Services Director
application was unable to push the service configuration to a device
configured for the service.

• In-progress—ConnectivityServicesDirectorapplication is in theprocess
of deploying the service.

• Requested—Service provisioner has created the service order, but has
not yet attempted to deploy it or schedule it for deployment.

• Scheduled—Service provisioner has scheduled the service order for
deployment.

• Invalid—Service order contains invalid data.

Order State

Status of functional audit of the service.FA Status

Fault management status of the service.Fault Status

Service-level agreement statusof theservice. If dataexceeds the threshold
value specified in the Threshold Alarm Profile, the system generates a
threshold alarm. The value in the SLA Status column changes to SLA
Violated. If the data does not cross the threshold value specified in the
Threshold Alarm Profile, the value in the SLA Status column changes to
SLA Violation Cleared.

SLA Status

Performancemanagement status of the service.PM Status

Name of the service definition upon which the service order is based.Definition
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DescriptionField

Date and time at which the service order was last activated.Activation Date

Date and time at which the profile was last updated.Last Modified Time

Name of the image file to pictorially depict the customer.Image Name

Unique domain identifier associated with the customer.Domain ID

6. To restrict the display of customers, enter a search criterion of one ormore characters

in the Search bar and press Enter. All customer names thatmatch the search criterion

are shown in the main display area.

Related
Documentation

• Adding a New Customer on page 697

• Deleting Customers on page 698

• Modifying an Existing Customer on page 699

• Adding a New Customer on page 697
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PART 9

Working in Deploy Mode

• About Deploy Mode on page 705

• Deploying and Managing Device Configurations on page 711

• Deploying and Managing Software Images on page 749
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CHAPTER 29

About Deploy Mode

• UnderstandingDeployMode inViewsOther thanServiceViewofConnectivity Services

Director on page 705

• Understanding the Deploy Mode Tasks Pane in Views Other than Service

View on page 708

UnderstandingDeployMode inViewsOther thanServiceViewofConnectivityServices
Director

The Deploy mode enables you to deploy configuration changes and software upgrades

to devices and perform several devicemanagement and configuration file management

tasks.

This topic describes:

• Deploying Configuration Changes on page 705

• Managing Software Images on page 707

• Managing Devices on page 707

• Managing Device Configuration Files on page 707

• Managing Baseline Configuration on page 707

Deploying Configuration Changes

When youmake configuration changes in Build mode, the changes are not deployed to

devicesautomatically.Youmustmanuallydeploy thechanges todevices inDeploymode.

Every time youmake configuration changes in Buildmode that affect a device, the device

is automatically added to the list of deviceswithpendingchanges. Configuration changes

are deployed to devices at the device level. When you deploy configuration changes to

a device, all pending configuration changes for that device are deployed.

You can deploy the device configurations in the following two ways:

• Auto Approval—In this mode, the device configuration changes are approved

automatically by the system and do not require explicit (manual) approval by a

configuration approver before they canbedeployed. This is thedefault approvalmode.
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• Manual Approval—In this mode, the device configuration changes are required to be

explicitly approved by a configuration approver before the changes can be deployed

to the device.

NOTE: Manual approval is not supported inConnectivity ServicesDirector.

For more information about enabling these modes, see “Setting Up User and System

Preferences” on page 121.

An operator performs device configurations and creates a change request for that

configuration and submits it for approval to an approver. The approvers are notified by

e-mail whenever a change request is created. If a configuration or a change to it is

approvedbyanapprover, then theoperator is able todeploy it. If a configuration is rejected

then the operator must make the necessary changes, resubmit the change request, and

procure an approval before the configuration can be deployed. For more information,

see “Approving Change Requests” on page 725

NOTE: You can specify any number of approvers. If you specify more than
oneapproverwhile configuring theManualApprovalmode,onceanapprover
accepts or rejects the proposed change, the change request is not listed for
the other approvers and they cannot approve or reject the same change
request.

You can do the following configuration deployment tasks on devices that have pending

changes:

• Run configuration deployment jobs immediately or schedule them for future times.

• Approve the change requests for pending configurations, if you have selected the

Manual Approval mode.

• Preview pending configuration changes before deploying the changes.

• Validate that the pending changes are compatible with the device’s configuration.

• Manage configuration deployment jobs.

Configurationchangesare validated for eachdeviceboth inConnectivityServicesDirector

and on the device. If any part of a configuration change for a device fails validation, no

configuration changes are deployed to the device. You can see the results of each

validation phase separately.

ConnectivityServicesDirectorwill notdeployconfiguration toadevicewithaconfiguration

that is out of sync (meaning that the device’s configuration differs from Connectivity

Services Director’s version of that device’s configuration), or to a device that has

uncommitted changes to its candidate configuration. Deployment to such devices will

fail.

When you schedule a deployment job, that job and any profiles and devices assigned to

that job are locked within Connectivity Services Director. You cannot edit the job or any
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of its assigned profiles until the job runs or gets cancelled. This locking feature prevents

you from deploying unintended configuration changes that could result from editing

profiles and devices that are already scheduled to deploy. To change any properties of

ascheduled job, cancel the jobandcreateanewscheduled jobwith thedesiredproperties.

You cannot edit the profile assignments of a device that has scheduled pending

configuration changes.

Managing Software Images

Connectivity Services Director canmanage software images on the nodes it manages.

You can do the following software imagemanagement tasks:

• Deploy a software image stored in an image repository on the Connectivity Services

Director server to multiple devices with a single job.

• Track the status of software imagemanagement jobs.

• Stage and install software images as separate tasks.

• Schedule staging and installation to happen at independent future times.

• Perform several software image upgrade options, such as rebooting devices

automatically after the upgrade finishes.

NOTE: Using nonstop software upgrade (NSSU) to upgrade EX Series
switches is supported in Connectivity Services Director.

Managing Devices

In Deploy mode you can perform several device management tasks, including:

• View the device inventory.

• Show a device’s current configuration.

• Resynchronize thedeviceconfigurationmaintained inBuildmodewith theconfiguration

on the device. For more information about resynchronization of device configuration,

see “Understanding Resynchronization of Device Configuration” on page 733

Managing Device Configuration Files

You can back up device configuration files to the Connectivity Services Director server.

You can perform several actions on backed up configuration files, such as restoring

configuration files to devices, and viewing and comparing configuration files.

Managing Baseline Configuration

You can baseline device configuration and the OS version to the Connectivity Services

Director server. You can perform several actions on baseline configuration files, such as

restoring configuration files to devices, and viewing and comparing configuration files.
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Related
Documentation

Understanding the Deploy Mode Tasks Pane in Views Other than Service View on

page 708

•

Understanding the DeployMode Tasks Pane in Views Other than Service View

The Tasks pane in Deploy mode lists the available tasks. All Deploy mode tasks are

always available, regardless of the scope selected in the View pane.

Deploy mode tasks are divided into the following categories:

• Configuration Deployment—These tasks enable you to deploy configuration changes

todevicesandmanageconfigurationdeployment jobs.Table87onpage708describes

the configuration deployment tasks.

• ImageManagement—These tasks enable you to manage software images on devices.

Table 88 on page 709 describes the imagemanagement tasks.

• DeviceManagement—These tasksenableyou toviewthedevice inventory, resynchronize

the configuration of out-of-sync devices, manage the administrative state of ports,

manage QFabric node groups, and convert QSFP+ port configuration.

Table 89 on page 709 describes the device management tasks.

• Device Configuration FileManagement—These tasks enable youmanage configuration

files onmanageddevices. Table 90onpage 709describes the device configuration file

management tasks.

• BaselineManagement—These tasks enable youmanage baseline configuration of

devices. Table 91 on page 709 describes the baseline management tasks.

• Key Tasks—Connectivity Services Director enables you to group the tasks that you

perform frequently and create a list of key tasks. You can add any task from the Tasks

pane to theKeyTasks list by selecting a task and clicking the plus (+) sign that appears

adjacent to the task. For somemodes, you can see that Connectivity Services Director

has predefined some key tasks for you. You canmodify this set of tasks to suit your

requirements. This feature is available in Task pane irrespective of your current mode,

scope, or view.

Table87onpage708throughTable90onpage709describethetasks ineachtaskcategory.

Table 87: Configuration Deployment Tasks

DescriptionTask

Deploys pending configuration changes to devices.Deploy Configuration Changes

Enables a configuration approver to approve or reject a change request, which
has been submitted for approval by an operator.

Approve Change Requests

EnablesSNMPtrapsonConnectivityServicesDevices so thatConnectivityServices
Director can collect andmanage event and error information from these devices.

Set SNMP Trap Configuration

Manages configuration deployment jobs.View Deployment Jobs
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Table 88: ImageManagement Tasks

DescriptionTask

Manages the software images repository on the server.Manage Image Repository

Deploys software images from the repository to devices.Deploy Images to Devices

Manages software image deployment jobs.View Image Deployment Jobs

Table 89: Device Management Tasks

DescriptionTask

Resynchronizes the device configuration maintained in Build mode with the
running configuration on the devices.

Resynchronize Device Configuration

Shows the selected device’s current configuration.Show Current Configuration

Displays the device inventory of the selected node.View Inventory

Table 90: Device Configuration File Management Tasks

DescriptionTask

Manages backup device configuration files.Manage Device Configuration Files

Manages device configuration file management jobs.View Configuration File Mgmt Jobs

Table 91: Baseline Management Tasks

DescriptionTask

Manages baseline configuration files.Manage Baseline

Manages baseline configuration file management jobs.View Baseline Mgmt Jobs

Related
Documentation

• UnderstandingDeployMode inViewsOther thanServiceViewofConnectivity Services

Director on page 705
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CHAPTER 30

Deploying and Managing Device
Configurations

• Deploying Configuration to Devices on page 711

• Managing Configuration Deployment Jobs on page 722

• Deploy ConfigurationWindow on page 724

• Approving Change Requests on page 725

• Enabling SNMP Categories and Setting Trap Destinations on page 727

• Understanding Resynchronization of Device Configuration on page 733

• Resynchronizing Device Configuration on page 738

• Managing Device Configuration Files on page 743

• Enabling or Disabling Network Ports on Routers on page 747

Deploying Configuration to Devices

When youmake configuration changes in Build mode, the changes are not deployed to

devicesautomatically.Youmustmanuallydeploy thechanges todevices inDeploymode.

To start deploying configuration changes:

1. Click Deploy in the Connectivity Services Director banner.

2. Select a node in the Viewpane that contains the devices towhich youwant to deploy.

3. In the Tasks pane, select Configuration Deployment > Deploy Configuration Changes.

Dependingupon the typeofapprovalmodeyouselectdifferentwindowsaredisplayed.

If you select the Auto Approval mode, the Devices with Pending Changes page opens

in the main window, listing the devices within the selected node that have pending

configuration changes.

If you select the Manual Approval mode, the following two sections open in themain

window:
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• Devices with recent configuration changes—This section lists the devices with

pending changes (along with the details of the change) performed by the user

currently logged into the system.

• Change Requests—This section lists the change requests created by the user

currently logged into the system.

This topic describes:

• Selecting Configuration Deployment Options on page 712

• Using the Change Request Details Page on page 715

• Creating a Change Request on page 716

• Validating Configuration on page 716

• Discarding the Pending Configurations on page 717

• Viewing Pending Configuration Changes on page 717

• Using the Pending ChangesWindow on page 718

• Using the Configuration or Pending ConfigurationWindow on page 718

• Using the Deploy Configuration Errors/WarningsWindow on page 718

• Using the Configuration ValidationWindow on page 719

• Deploying Configuration Changes to Devices Immediately on page 719

• Scheduling Configuration Deployment on page 719

• Specifying Configuration Deployment Scheduling Options on page 720

• Editing Change Requests on page 720

• Deleting Change Request on page 721

• Resubmitting a Change Request on page 721

• Performing a Rollback on page 722

Selecting Configuration Deployment Options

Basedon theapprovalmode, you can choose todeploy thedevice configuration changes

in the following ways:

• When you select the auto approval mode, the page Devices with Pending Changes

open. From the Devices with Pending Changes page, you can:

• Deploy configuration changes immediately by selecting one or more devices and

clicking Deploy Now. For more information, see “Deploying Configuration Changes

to Devices Immediately” on page 719.

• Schedule configuration deployment by selecting one or more devices and clicking

ScheduleDeploy. Formore information, see “SchedulingConfigurationDeployment”

on page 719.

• View configuration changes that are pending on a device by clicking View in the

Configuration Changes column. For more information, see “Viewing Pending

Configuration Changes” on page 717.
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• Validate that the pending changes for a device are compatible with the device’s

configuration by selecting up to ten devices and clicking Validate Pending

Configuration Changes. For more information, see “Validating Configuration” on

page 716.

• Discard the pending configuration changes. For more information, see “Discarding

the Pending Configurations” on page 717.

Table 92 on page 713 describes the information provided in the table on the Devices with

Pending Changes page. Only the subset of devices within the selected object that have

pending configuration changes are listed in the table.

Table 92: Devices with Pending Changes Page

DescriptionTable Column

Select to perform an action on the device in that rowCheck box

Device nameName

Device IP addressIP Address

Device ModelModel

Operating system version running on deviceOS Version

State of the connection to the device:

• Up—Connectivity Services Director can communicate with the device.

• Down—ConnectivityServicesDirector cannot communicatewith thedevice.Youcannotdeploy
configuration to devices that are down.

Connection State

Indicates whether the device’s configuration is in sync with Connectivity Services Director’s
version:

• In Sync—The configuration on the device is in sync with the Connectivity Services Director
configuration for the device.

• OutOfSync—Theconfigurationon thedevicedoesnotmatch theConnectivityServicesDirector
configuration for the device. This state is usually the result of the device configuration being
altered outside of Connectivity Services Director.

You cannot deploy configuration on a device when the device is Out Of Sync. To resolve this
state, use the Resynchronize Device Configuration task in Deploy mode.

• Synchronizing—The device configuration is in the process of being resynchronized.

• Sync failed—An attempt to resynchronize an Out Of Sync device failed.

Configuration State

Click to view pending configuration changes for a device. The Pending Changes window opens.Configuration Changes

If you select the Manual Approval mode, the windows Devices with recent configuration

changes and Change Requests opens.

From the Devices with recent configuration changes window, you can:
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• Create a device configuration change request approval and submit it for approval.

Upon submission, all device changes made by an operator are validated and all the

approvers are notified of the details of the proposed change request by e-mail. For

more information, see “Creating a Change Request” on page 716.

• View configuration changes that are pending on a device by clicking View in the

Configuration Changes column. For more information, see “Viewing Pending

Configuration Changes” on page 717.

• Validate that the pending changes for a device are compatible with the device’s

configuration . For more information, see “Validating Configuration” on page 716.

• Discard the pending configuration changes. For more information, see “Discarding the

Pending Configurations” on page 717.

NOTE: You cannot delete a device from the Devices with Pending Changes
list. To remove a device from the list, youmust undo the Build mode
configuration changes that placed the device on the list.

Table 93 on page 714 describes the information provided in the table on the Deviceswith

recent configuration changes page.

Table 93: Devices with recent configuration changes

DescriptionTable Column

Indicates the name of the device and profile node.

Below each device node, a profile node is listed.

Name

Indicates the type of the configuration change done to the device.Change Type

Lists the ports that are added to that profile.Associations Added

Lists the ports that are deleted from that profile.Associations Deleted

Click to view pending configuration changes for a device. The Pending Changes
window opens.

Configuration

Indicates the deployment state of a change request.Deployment State

From the Change Requests window, you can:

• Deployconfigurationchanges immediatelybyselectingoneormoredevicesandclicking

Deploy Now. For more information, see “Deploying Configuration Changes to Devices

Immediately” on page 719.

• Schedule configuration deployment by selecting one or more devices and clicking

Schedule Deploy. For more information, see “Scheduling Configuration Deployment”

on page 719.
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• Resubmit for thechange request for approval aftermaking thenecessarymodifications.

For more information, see “Resubmitting a Change Request” on page 721.

• Edit or delete the change requests by selecting one or more change requests and

clickingEdit orDelete respectively. Formore information, see “EditingChangeRequests”

on page 720and “Deleting Change Request” on page 721.

• Roll back the device configuration that is already deployed. For more information, see

“Performing a Rollback” on page 722.

• View the details of the change request created. For more information, see “Using the

Change Request Details Page” on page 715

Table 94 on page 715 describes the information provided in the table on the change

requests submitted for the devices for which configuration changes are sought.

Table 94: Change Requests

DescriptionTable Column

Select to perform an action on the device in that row.Check Box

Indicates the change request number of the change request that is waiting to be
deployed.

Change Request No

Indicates the title name of the change request.Title

Indicates the change request creation date.Created On

Indicates the username of the configuration approver.Approver

Indicates the date on which the change request status is changed.Last Action On

Indicates whether a change request is approved or rejected by the approver.Approval Status

Indicates whether a change request is deployed after the approval.Deployment Status

Records the audit trial details of a change request, such as operation performed on a
change request during a given period of time, username of the approver or operator,
and so on.

History Icon

Using the Change Request Details Page

Use theChangeRequestDetailswindow to view thedetails of the change request before

you either approve or reject a change request. This windowprovides you the details such

as change request number, title, username of the user who created the change request,

change request creation date and so on. A Devices table is also displayed showing the

deployment status. Table 95 on page 715 describes the fields in this table.

Table 95: Change Request Details

DescriptionColumn
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Table 95: Change Request Details (continued)

Indicates the name of the device and profile node. Below each device node, a profile
node is listed.

Name

Indicates the type of the configuration change done to the device.Change Type

Lists the ports that are added to that profile.Associations Added

Lists the ports that are deleted from that profile.Associations Deleted

Click to view pending configuration changes for a device. The Pending Changes
window opens.

Configuration

Indicates the deployment state of a change request.Deployment Status

Creating a Change Request

To create a change request for device configurations approval:

1. Click Create Change Request in the Devices with recent configuration changes page.

The Create Change Request page opens.

2. Enter the change request number.

You can either enter a number or retain the autogenerated number in this field.

3. Enter an appropriate title name for the change request.

4. Optionally, you can enter comments for the device configuration changes.

5. Click Submit.

The Create Change Request page opens, listing the change request details such as

change requestnumber, title, andcomment, alongwith thechange request submission

job details. A Devices table is also displayed showing the validation status of the

device and configuration generated for that device.

6. Click Close.

A new change request entrywith the status Pending Approval is added to the Change

Request section.

Validating Configuration

When you deploy configuration changes to a device, validation checks are performed to

validate that the pending changes are compatible with the device. You can also perform

this validation without deploying.
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NOTE: You can also verify the configuration from the Build mode by clicking
Tasks > DomainManagement > Validate Pending Configuration.

To validate that the pending changes for devices are compatible with the device

configuration:

1. ForAutoApprovalmode, select up to tendevices in theDeviceswithPendingChanges

page.

NOTE: For Manual Approval mode, you cannot choose the devices for
which validation needs to be done. All the configuration changes for all
the devices are validated.

2. Click Validate Pending Configuration Changes.

The Configuration Validation window opens. See “Using the Configuration Validation

Window” on page 719 for a description of the window.

Discarding the Pending Configurations

Use the Discard Local Configuration Changes Results window to discard all the pending

configurations that were made on a device. Once you discard the local configuration

changes on a device, the configuration state of the device changes to In Sync or Out of

Sync based on the system of record (SOR)mode set for the Junos Space Network

Management Platform. If the SORmode is set to Network as system of record (NSOR),

then theconfiguration statechanges to InSyncand if theSORmode is set to JunosSpace

as system of record (SSOR), then the configuration state changes to Out of Sync.

To discard the configuration changes:

1. For AutoApprovalmode, select the devices forwhich youwant to discard thepending

configuration and click Discard Pending Configuration.

TheDiscard Local ConfigurationChangesResultswindowopensdisplaying the status

of the discard pending configuration job.

2. Click Close to close the Discard Local Configuration Changes Results window.

Viewing Pending Configuration Changes

To view pending configuration changes for a device, click View in the Pending Changes

column.

The Pending Changes window opens. See “Using the Pending ChangesWindow” on

page 718 for a description of the window.
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Using the Pending ChangesWindow

Use the Pending Changes window to view the pending Connectivity Services Director

changes for a device. Table 96 on page 718 describes the fields in this window.

Table 96: Pending ChangesWindow

DescriptionField

Lists each selected device. Expand a device by Clicking its plus sign to see its pending changes. Each
pending change to a profile or other configuration object for the device is listed.

Name

Describes the nature of the pending change to the configuration object. These are the possible states:

• Added—The profile or configuration object was added to this device.

• Removed—The profile or configuration object was removed from the device

• Updated—The profile or configuration object was updated.

State

Click View to view the pending configuration changes for a device. The Pending Configuration window
opens. See “Using theConfigurationorPendingConfigurationWindow”onpage 718 for informationabout
the window.

NOTE: The device configuration statemust be In Sync for you to view the pending configuration changes.

Configuration

Click to close the window.Close

Using the Configuration or Pending ConfigurationWindow

Use the Pending Configuration window to view the configuration changes that will be

deployed to a devicewhen a job runs. Use the Configurationwindow to see changes that

were deployed to a device when a completed job ran. The configuration changes are

shown in these formats:

• Select the XML View tab to view the configuration changes in XML format. This view

shows the XML-formatted configuration that will be deployed to the device’s Device

Management Interface (DMI), which is used to remotely manage devices.

• Select the CLI View tab to view the configuration changes in CLI format. This view

shows the Junos configuration statements that will be deployed to the device.

In both views, the content is color-coded for easier reading:

• Black text indicates configuration that is already active on the device, and will not be

changed if you deploy.

• Green text indicates configuration that will be added if you deploy.

• Red text indicates configuration that will be removed if you deploy.

Using the Deploy Configuration Errors/WarningsWindow

Use the Deploy Configuration Errors/Warnings window to view the results of deploying

configuration toadevice. TheErrors/Warnings in validating thedeviceconfigurationpane
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shows the results of configuration validation by Connectivity Services Director. The

Errors/Warnings inUpdatingDevice configurationpaneshows the results of configuration

validation on the device.

Using the Configuration ValidationWindow

Use the Configuration Validation window to validate that the pending changes for a

device are compatible with the device’s configuration. Table 97 on page 719 describes

this window.

Table 97: Configuration ValidationWindow

DescriptionTable Column

Lists the devices you selected for validation. Click the arrow next to a device to expand it. If
there are no errors or warnings, one item labeled No Validation warnings appears. If the device
has errors or warnings, they appear under the device. The device contains a list of the profiles
that caused errors or warnings. Expand a profile name to see the of errors and warnings it
caused.

Object name

Describes the error or warning.Errors/Warnings

Deploying Configuration Changes to Devices Immediately

To deploy configuration changes to devices immediately:

1. Select the device or devices in the Devices with Pending Changes page.

2. Click Deploy Now.

The Deploy Options window opens.

3. In the Deploy Options window, enter a job name in the Deployment Job Name field,

then clickOK.

The configuration deployment job runs. The Deploy Configurationwindow opens and

shows the results of the deployment job. For a description of fields in this window,

see Deploy ConfigurationWindow.

Scheduling Configuration Deployment

To schedule configuration deployment to devices:

1. Select the device or devices in the Devices with Pending Changes page.

2. Click Schedule Deploy.

The Deploy Options window opens.

3. Use the Deploy Options window to schedule the configuration deployment. See

“SpecifyingConfigurationDeploymentSchedulingOptions”onpage720foradescription

of the window.
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Specifying Configuration Deployment Scheduling Options

Use the Deploy Options window to schedule configuration deployment jobs.

Table 98 on page 720 describes the actions for the fields in this window.

Table 98: Deploy OptionsWindow

ActionField

Enter a job name.Deployment Job Name

Enter the job’s start date and time.Date and Time

Click to accept changes and exit the window.OK

Click to cancel changes and exit the window.Cancel

Editing Change Requests

You can edit a change request to change the profile that was added to a device or delete

some of the profile associations. After editing a change request, you can resubmit the

change request for approval. While editing a change request, if you try to delete all the

profile associations in a given change request, the system prompts amessage that a

change request should have at least one valid association. Deleting all the associations

in a change request makes it invalid. Hence, you cannot delete all the associations in a

given change request. However, you can delete a change request itself to delete all the

associations for that change request.

NOTE: You are unable to delete a change request or an association of a
change request if an association is in pending removal state.

You are unable to edit a change request that is in Cancelled, Deployed,
Rollback Success, or Rollback Failed state.

To change a profile or delete the profile associations of a change request:

1. Select the change request in the Change Requests pending action page to edit.

2. Click Edit.

The Edit Change Request window opens.

3. Click the call out symbol to change the profile and choose the new profile that you

want to assign.. the change request.

4. To delete a profile association, click Delete

5. Click Save.
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The Edit Change Request window opens, listing the change request details such as

change requestnumber, title, andcomment, alongwith thechange request submission

job details. A Devices table is also displayed showing the validation status of the

device and configuration generated for that device.

6. Click Close.

Deleting Change Request

Sometimes youmight need to delete a change request from the change request list. A

change request is assigned with profile associations. If you delete a change request, all

the associations of that change request are also deleted.

To delete a change request:

1. Select the change request or change requests in theChangeRequests pending action

window.

2. Click Delete.

The Delete Change Request window opens, displaying themessage: Are you sure you

want to delete Change Request?.

3. Click Yes to delete the change request; else click No.

If you clicked Yes, the message: Change Request deleted successfully appears.

4. ClickOK.

Resubmitting a Change Request

You can resubmit only those change requests that are in Pending Approval, Pending

Deployment, Deploy Failed, and Create Failed state. You are unable to resubmit change

requests in Deployed, Cancelled, Rollback Success, or Rollback Failure state.

In certain situations, a device can go out of syncwhile a user is creating a change request

for that device. The change request is created, but the configuration changes for that

change request are not generated. You can select the change request and resubmit it

after thedevice is in syncagain,whichgenerates theconfiguration for this change request.

You can resubmit change requests only for devices that have pending configuration

changes.

To resubmit a change request:

1. Select the change request in the Change Requests pending action window to edit.

2. Click Resubmit.

A warning message pops up indicating if you want to resubmit the change request.
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3. Click Yes.

TheResubmit ChangeRequestwindowopens, listing the change request details such

as change request number, title, and comment, along with the change request

submission job details. ADevices table is also displayed showing the validation status

of the device and configuration generated for that device.

4. Click Close.

Performing a Rollback

In case of any misconfigurations, you can choose to roll back a configuration that has

already been deployed to the device. The following conditions apply for a rollback

operation:

• Themaximum number of change requests that you can roll back is the rollback limit

specified in Preferences.

• Change requestsare rolledback in reversechronologicalorder; the later change requests

are rolled back first. If there are any conflicting change requests, roll back is not

supported. For example, assume that a user assigns port profile P1 to ge-0/0/1 and

creates a change request CR1 and deploys the profile. After this, if the user edits P1,

creates another change request CR2 and deploys and removes P1 from the port by

assigning someother port profile anddeploys device changes or configurations as part

of CR3. If the user now tries to roll back CR1, an error message about the conflicting

change requests CR2 and CR3 is shown. To roll back CR1, the user must roll back CR3,

then CR2, and then CR1.

Related
Documentation

Managing Configuration Deployment Jobs on page 722•

Managing Configuration Deployment Jobs

When you deploy configuration changes or schedule a configuration deployment, a

configuration deployment job is created.

To start managing configuration deployment jobs:

1. Click Deploy in the Connectivity Services Director banner.

2. In the Tasks pane, select DeviceManagement > View Deployment Jobs.

The Deploy Configuration page opens in the main window. The table on that page

lists configuration deployment jobs.
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This topic describes:

• Selecting Configuration Deployment Job Options on page 723

• Viewing Configuration Deployment Job Details on page 724

• Canceling Configuration Deployment Jobs on page 724

Selecting Configuration Deployment Job Options

From the Deploy Configuration page, you can:

• View the details of a configuration deployment job by clicking Show Details. See

“Viewing Configuration Deployment Job Details” on page 724 for more information.

• Cancelascheduledconfigurationdeployment jobbyclickingCancel Job.See “Canceling

Configuration Deployment Jobs” on page 724 for more information.

Table 99 on page 723 describes the information provided on the Deploy Configuration

page

Table 99: Deploy Configuration Table Description

DescriptionTable Column

Select to perform an action on the job in that row.Check box

An identifier assigned to the job.Job Id

Job name (user-created).Job Name

Percentage of the job that is complete.Percent

Job status. The possible states are:

• CANCELLED—The job was cancelled by a user.

• FAILURE—The job failed. This state is applied if any of the devices in the job failed. But
some of the devices might have completed successfully. View the job details for the
status of each device.

• INPROGRESS—The job is running.

• SCHEDULED—The job is scheduled but has not run yet.

• SUCCESS—The job completed successfully. This state is applied if all of the devices in
the job completed successfully.

Status

Job summary.Summary

Job’s scheduled start timeScheduled Start Time

Time when the job started.Actual Start Time

Time when the job endedEnd Time

User who created the jobUser

This field is not used for configuration deployment jobs.Recurrence
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Viewing Configuration Deployment Job Details

To view the details of a configuration deployment job:

1. Select the job in the table.

2. ClickShowDetails. TheDeployConfigurationwindowopens. SeeDeployConfiguration

Window for a description of the window.

Canceling Configuration Deployment Jobs

To cancel a configuration deployment job:

1. Select the job in the table.

2. Click Cancel Job.

3. Click Yes in the confirmation window that opens.

See Also Deploying Configuration to Devices on page 711•

• Managing Device Configuration Files on page 743

Deploy ConfigurationWindow

The Deploy Configuration window shows the results of a completed deployment job or

information about a scheduled job. See Table 100 on page 724 for a description of the

fields in this window.

Table 100: Deploy ConfigurationWindow

DescriptionField

Job name.Job Name

Time when job started or will start.Job Start Time

Time when job ended.Job End Time

Percentage of the job that is complete.Percentage Completed

Number of devices in the deployment job.Number of Devices

Deployed Devices table

Device name.Name

Device IP address.IP Address
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Table 100: Deploy ConfigurationWindow (continued)

DescriptionField

Status of configuration deployment on device:

• Scheduled—Job is scheduled for future deployment.

• In Progress—Deployment is in progress.

• Success—Deployment completed successfully.

• Failed—Deployment failed.

Deployment Status

Click View to see the configuration changes that were deployed to the device.

For a scheduled job, this column does not contain a link. See “Deploying Services
Configuration to Devices” on page 959 for information about viewing pending
configuration changes for a device.

Configuration

Click View to see the results of configuration deployment for the device.Result Details

Click to close the window.Close

Related
Documentation

Deploying Configuration to Devices on page 711•

• Managing Configuration Deployment Jobs on page 722

Approving Change Requests

NOTE: This option is available only for the users who are assigned a
Configuration Approver role.

When you select the Approve Change Request option, the page Change request(s)

pending approval and the page approved/declined change request(s) open in the top

and bottom panels respectively.

The Table 101 on page 725 shows details of the change requests that are pending for

approval by the approver.

Table 101: Change request(s) pending approval

DescriptionTable Column

Indicates thechange request number thatwaseither approvedor rejectedby theapprover.Change Request No

Indicates the title of the change request.Title

Indicates theoperator namewhocreated thechange requestandsubmitted it for approval.Created By

Indicates the date on which the change request was created.Created On

Indicates the age of the change request, time since the change request was created.Age
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Table 101: Change request(s) pending approval (continued)

DescriptionTable Column

Indicates the deployment state of the change request.Deployment Status

Records the audit trial details of a change request, such as operation performed on a
change request during a given period of time, username of the operator, and so on.

History Icon

TheTable 102 on page 726 shows the change requests thatwere approved or rejected by

the currently logged in approver. The approver can also provide comments

Table 102: approved/declined change request(s)

DescriptionTable Column

Indicates thechange requestnumber thatwaseither approvedor rejectedby theapprover.Change Request No

Indicates the title of the change request.Title

Indicates the operator name who created the change request and submitted it for
approval.

Created By

Indicates the date on which the change request was created.Created On

Indicates the age of the change request, time since the change request was created.Age

Indicates the approval state of the change request.Approval Status

Indicates the deployment state of the change request.Deployment Status

Records the audit trial details of a change request, such as operation performed on a
change request during a given period of time, username of the approver, and so on.

History Icon

To approve or reject the change requests submitted by an operator:

1. Select Approve Change Requests under Configuration Deployment.

2. Select the check box against the change request and click on a change request in the

change request(s) pending approval page.

The Change Request Details page opens.

3. Review details of the profile and its associations.

4. Click on the View link.

The Pending Configuration device name page opens.

5. Click Close.
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6. Click Approve or Reject to approve or reject the device configuration changes

respectively.

The Change Request Details page opens.

7. Type your comments and click Approve to approve; else click Reject.

After the successful approval, you can deploy the device configurations immediately

or schedule the deployment for a later period.

Related
Documentation

Managing Configuration Deployment Jobs on page 722•

• Deploying Configuration to Devices on page 711

Enabling SNMPCategories and Setting Trap Destinations

SNMP traps must be enabled on network devices for Connectivity Services Director to

collect andmanage event and error information from these devices.

Connectivity Services Director organizes switch and controller traps by categories. These

categories must be enabled and deployed in order to forward trap information to

Connectivity Services Director.

NOTE: Connectivity Services Director uses protocol port 10162 for receiving
traps from devices. This port must be open on the devices.

This topic describes:

• Viewing Eligible Devices for Trap Forwarding on page 727

• Enabling Trap Forwarding on page 728

• Deploying SNMP Trap Configurations on page 729

Viewing Eligible Devices for Trap Forwarding

Traps are enabled on the Devices page in Deploy mode. To locate this page:

1. Select Deploy in the Connectivity Services Director banner.

2. Select Set SNMP Trap Configuration in the Tasks pane. The Devices page opens. For

a description of fields in the Devices page, view Table 103 on page 727.

Table 103: Device Page Fields

DescriptionField

Either the hostname or the IP address of the device.Name

Device IP address.IP Address
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Table 103: Device Page Fields (continued)

DescriptionField

Device model number.Model

Version and release level of the operating system running on the device.OS Version

State of connection to the device. Valid states are:

• Up—Connectivity Services Director is in communication with the device.

• Down—Connectivity Services Director cannot communicate with the device. You
cannot enable traps on devices that are in this state.

Connection State

Either the device’s configuration is in sync or out-of-syncwith Connectivity Services
Director’s version:

• IN_SYNC—The configuration is in-sync with the database.

• OUT_OF_SYNC—The configuration is out-of-sync with the database.

Configuration State

Enabling Trap Forwarding

Select Set SNMP Trap Configuration in Deploy mode to enable your network devices to

pass SNMP traps and events to Connectivity Services Director. Connectivity Services

Director creates a target group called networkdirector_trap_group using target port 10162.

The Community name is public and the access is read-write-notify..

Before enabling trap forwarding, completedevicediscovery for all thedevicesandensure

they are in the up state. Down devices cannot be enabled for trap forwarding.

SelectingSet SNMPTrapConfiguration displays theDevices pagewhich contains a table

of all discovered switches and controllers in the network. To enable SNMP traps on

switches and controllers:

1. Either select individual check boxes for devices, or select the check box next to the

Name heading to select all devices. These devicesmust be up and in the same device

family.

2. Click Deploy Trap Configuration. The Deploy Options window opens.

3. Fill inanewdeployment jobnameoraccept thedefault nameofDeploySNMPTargets.

4. Either select check boxes for individual traps, or select the check box next to the Trap

Name heading to select all traps. These traps are discussed further in “Deploying

SNMP Trap Configurations” on page 729.

TIP: To clear an existing configuration, do not select any of the check
boxes.
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5. ClickOk. TheDeployConfigurationwindowopens,whichshows thestatusofdeploying

the configuration change.

6. Review the outcome of the deployment.

After enabling the traps, enable the alarms and establish the alarm retention period.

These tasks are located in Preferences in the Connectivity Services Director banner.

Deploying SNMP Trap Configurations

The Deploy Options for trap forwarding enable you to select individual traps or all traps

for the selected device family.

The device family determines which traps are displayed in the Deploy Options window.

The following tables map the trap to one or more MIBs being used.

• EX Series switches traps and related MIBs are shown in Table 104 on page 729.

• Controllers traps and related MIBs are shown in Table 105 on page 730.

Table 104: EX Series Switches Traps

MIBTrap

jnxExMibRoot.mibChassis

snmpTraps.mibLink

jnxCfgMgnt.mibConfiguration

jnxJsAuth.mibAuthentication

jnxPing.mibRemote operations

jnx-ipv6.mibRouting

snmpTraps.mibStartup

jnxRmon.mibRmon-alarm

rfc2787a.mibVrrp-events

jnxServices.mibServices

jnx-sonetaps.mibSonet-alarms

jnxMIbs.mibOtn-alarms
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Table 105: Controllers Traps

MIBTrap

snmpTraps.mibLinkDown

snmpTraps.mibLlinkUp

snmpTraps.mibAuthentication

trpzTrapsV2.mibDeviceFail

trpzTrapsV2.mibDeviceOkay

trpzTrapsV2.mibPoEFail

trpzTrapsV2.mibMobilityDomainJoin

trpzTrapsV2.mibMobilityDomainTimeout

trpzTrapsV2.mibRFDetectAdhocUser

trpzTrapsV2.mibClientAuthenticationFailure

trpzTrapsV2.mibClientAuthorizationFailure

trpzTrapsV2.mibClientAssociationFailure

trpzTrapsV2.mibClientDeAssociation

trpzTrapsV2.mibClientRoaming

trpzTrapsV2.mibAutoTuneRadioPowerChange

trpzTrapsV2.mibAutoTuneRadioChannelChange

trpzTrapsV2.mibCounterMeasureStart

trpzTrapsV2.mibCounterMeasureStop

trpzTrapsV2.mibClientDot1xFailure

trpzTrapsV2.mibRFDetectDoS

trpzTrapsV2.mibRFDetectDoSPort

trpzTrapsV2.mibClientIpAddrChange

trpzTrapsV2.mibClientAssociationSuccess

trpzTrapsV2.mibClientAuthenticationSuccess
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Table 105: Controllers Traps (continued)

MIBTrap

trpzTrapsV2.mibClientDeAuthentication

trpzTrapsV2.mibRFDetectBlacklisted

trpzTrapsV2.mibRFDetectAdhocUserDisappear

trpzTrapsV2.mibApRejectLicenseExceeded

trpzTrapsV2.mibClientDynAuthorChangeSuccess

trpzTrapsV2.mibClientDynAuthorChangeFailure

trpzTrapsV2.mibClientDisconnect

trpzTrapsV2.mibMobilityDomainFailOver

trpzTrapsV2.mibMobilityDomainFailBack

trpzTrapsV2.mibRFDetectRogueDeviceDisappear

trpzTrapsV2.mibRFDetectSuspectDeviceDisappear

trpzTrapsV2.mibRFDetectedClientViaRogueWiredAP

trpzTrapsV2.mibRFDetectedClassificationChange

trpzTrapsV2.mibConfigurationSaved

trpzTrapsV2.mibAPNonOperStatus

trpzTrapsV2.mibMichaelMICFailure

trpzTrapsV2.mibApManagerChange

trpzTrapsV2.mibClientCleared

trpzTrapsV2.mibMobilityDomainResiliencyStatus

trpzTrapsV2.mibApOperRadioStatus

trpzTrapsV2.mibClientAuthorizationSuccess

trpzTrapsV2.mibRFDetectRogueDevice

trpzTrapsV2.mibRFDetectSuspectDevice

trpzTrapsV2.mibClusterFailure
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Table 105: Controllers Traps (continued)

MIBTrap

trpzTrapsV2.mibMultimediaCallFailure

trpzTrapsV2.mibApTunnelLimitExceeded

trpzTrapsV2.mibWsTunnelLimitExceeded

trpzTrapsV2.mibRFNoiseSource

trpzTrapsV2.mibM2UConvNotPossibleTrap

trpzTrapsV2.mibM2UConvAvailablityRestored

See Also Deploying Configuration to Devices on page 711•

• Managing Configuration Deployment Jobs on page 722
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Understanding Resynchronization of Device Configuration

In a network managed by Connectivity Services Director, three separate repositories

about device configuration are maintained:

• The configuration information on the devices themselves. Each device maintains its

own configuration record.

• The configuration information maintained by the Junos Space Network Management

Platform. When a device is discovered, either by Junos Space or Connectivity Services

Director, Junos Space stores a record of the configuration on that device.

ConnectivityServicesDirector uses theconfiguration recordmaintainedby JunosSpace

to determine what configuration commands need to be sent to the device when you

deploy configuration on the device in Deploy mode.

• The configuration information maintained by Connectivity Services Director in Build

mode. This information takes the form of the profiles assigned to the device, plus the

additional configuration, such as LAG and access point configuration, that you can do

under device management.

In Connectivity Services Director, the configuration state of a device is shown as In Sync

when the configuration information in all three repositories match. If there is a conflict

between the configuration information in one or more of the repositories, Connectivity

Services Director shows the device configuration state as Out of Sync.

An Out of Sync state is usually the result of out-of-band configuration changes—that is,

configurationchangesmade toadeviceusingamanagement toolother thanConnectivity

Services Director. Examples of such changes include changes made by:

• Using the device CLI.

• Using the deviceWeb-basedmanagement interface (the J-Web interface or Web

View).

• Using the Junos Space Network Management Platform configuration editor.

• Using RingMaster software.

• Restoring or replacing device configuration files.

You cannot deploy configuration on a device when the device configuration state is Out

of Sync.

This topic describes howConnectivity Services Director enables you to resynchronize the

device configuration state. It covers:

• The Resynchronize Device Configuration Task on page 734

• How ResynchronizationWorks in NSORMode on page 734

• How ResynchronizationWorks in SSORMode on page 736

• How Connectivity Services Director Resynchronizes the Build Mode

Configuration on page 738
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The Resynchronize Device Configuration Task

Connectivity Services Director provides a task in Deploy mode that enables you to

resynchronize the repositories of configuration information. When an out-of-band

configuration change is made, you can use this task to resynchronize both the Junos

Space configuration record and the Build mode configuration with the configuration on

the device.

How Connectivity Services Director performs resynchronization depends on the system

of record (SOR)mode set for the Junos Space Network Management Platform. There

are two possible modes:

• Network as system of record (NSOR). This is the default mode.

• Junos Space as system of record (SSOR).

You set the mode in Junos Space under Administration > Applications > Network

Management Platform >Modify Application Settings.

HowResynchronizationWorks in NSORMode

In NSORmode, the network device is considered the system of record for device

configuration,whichmeans theconfigurationmaintainedby thedevice takesprecedence

over the configuration maintained by Junos Space and Connectivity Services Director.

Thus when you perform a resynchronization, the Junos Space configuration record and

the Connectivity Services Director Build mode configuration are updated to match the

device configuration.

When an out-of-band change is made on amanaged device when Junos Space is in

NSORmode:

1. Junos Space detects that a configuration change has occurred on the device and

informs Connectivity Services Director about the change.

2. Both Junos Space and Connectivity Services Director set the device configuration

state to Out of Sync.

3. Junos Space and Connectivity Services Director automatically resynchronizes its

configuration record to match the device configuration and sets the device

configuration state to In Sync when the synchronization completes. Connectivity

Services Director performs auto-synchronization when it is operating in the Network

as SystemOf Record (NSOR)mode. The auto-resynchronization parameters are

defined in the Preferences page. These parameters enables auto-resynchronization

after the interval specified in this page. Formore information see, Setting Up User and

System Preferences.

4. When the device out-of-band changes does not conflict with Connectivity Services

Director, Connectivity Services Director automatically resynchronizes the network

changes and retains the local changes in Connectivity Services Directory. The

configuration state of the device and the profile associated with that device remains
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unaffected. For example, if youmodify the MTU value of the port ge-0/0/1 in

Connectivity Services Director and another user modifies the MTU value of port

ge-0/0/2 on the same device, Connectivity Services Director automatically

resynchronizes the changes on ge-0/0/2 into Connectivity Services Director and

retains the local changesonge-0/0/1. Theprofile corresponding toge-0/0/1 continues

to remain inPendingDeploymentstateand theprofile corresponding toportge-0/0/2

is in Deployed state.

5. Whenthedeviceout-of-bandchangesconflictwith thechangesmade inConnectivity

ServicesDirector, ConnectivityServicesDirector doesnotautomatically resynchronize

the device changes into Connectivity Services Director. The device is marked as Out

OfSync, andyoumustmanually resynchronize thechangesbyusing theResynchronize

Configuration task. After this, the local changes are discarded and are replaced by

the latest network configuration. For example, if youmodify MTU of ge-0/0/1 from

Connectivity Services Director and another user modifies MTU of the same port on

the device, Connectivity Services Director does not automatically synchronize and

marks this device as Out Of Sync.

6. When a profile associated with a device is either added or removed from that device

while another user tries to change the attributes corresponding to that profile,

Connectivity Services Director does not automatically synchronize the device and

marks the device as Out Of Sync, and youmust manually resynchronize the changes

by using the Resynchronize Configuration task.

7. When youmake local changes to profiles, the changes are merged with the new

profiles if there is no conflicting configuration. If there are conflicting changes,

Connectivity Services Director receives an Out Of Syncmessage from Junos Space

and you need to manually choose the appropriate profile value.

When you do notmake any local changes on a profile, the device associationwith the

profile is deleted and a new device association is created. However, when a profile

has local changes, the device association of the profile is not deleted.

8. If the configuration changedoes not affect configuration that you canperform inBuild

mode (for example, routing configuration), Connectivity Services Director also sets

the device configuration state to In Sync after the Junos Space resynchronization

completes. All three configuration repositories are now in sync.

If the configuration change affects configuration that you can perform in Build mode,

Connectivity Services Director does not set the device configuration state to In Sync.

Instead, it continues to show the device configuration state as Out of Sync because

the Build mode configuration does not match the device configuration.

9. To resolve the Out of Sync state in Connectivity Services Director, use the

ResynchronizeDeviceConfiguration task inDeploymode.ConnectivityServicesDirector

updates the Build mode configuration to match the out-of-band changes.

10. Connectivity Services Director sets the device configuration state to In Sync.
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NOTE: Automatic resynchronization, asdescribed inStep3above, isadefault
setting for the Junos Space Network Management Platform. If automatic
resynchronization is disabled, youmust manually resynchronize the Junos
Spaceconfigurationwith thedeviceconfiguration.Youcandoso in twoways:

• Use the Resynchronize with Network action in Junos Space. The Junos
Spaceconfiguration is synchronizedwith thedeviceconfiguration.However,
the Build mode configuration is not synchronized, so the device state in
Connectivity Services Director remains Out of Sync. Youmust use the
Resynchronize Device Configuration task in Deploymode to resynchronize
the Build mode configuration.

• Use the Resynchronize Device Configuration task in Deploymode. In this
case, Connectivity Services Director resynchronizes both the Junos Space
configuration and the Build mode configuration with the device
configuration.

HowResynchronizationWorks in SSORMode

When Junos Space is in SSORmode, Junos Space is considered the system of record for

device configuration. In this mode, when an out-of-band configuration change occurs

on a device, you can choose whether to accept the change or to overwrite the change

with the configuration maintained by Junos Space.

When an out-of-band change is made on amanaged device when Junos Space is in

SSORmode:

1. Junos Space detects that a configuration change has occurred on the device and

informs Connectivity Services Director about the change.

2. Junos Space sets the device configuration state as Device Changed, and Connectivity

Services Director sets the device configuration state to Out of Sync.

Connectivity Services Director sets the device configuration state to Out of Sync even

if the configuration change does not affect configuration you can perform in Build

mode. This allows you to resolve the Device Changed configuration state for Junos

Space from Connectivity Services Director.

3. In Connectivity Services Director, use the Resynchronize Device Configuration task to

accept or reject the out-of-band changes:

• If you accept the out-of-band changes, both the Junos Space configuration record

and theConnectivity ServicesDirector Buildmode configuration are resynchronized

to reflect the out-of-band configuration changes.
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• If you reject the out-of-band changes, the configuration on the device is overwritten

by the configuration record maintained by Junos Space. The Connectivity Services

Director Build mode configuration remains unchanged.

4. Both Junos Space and Connectivity Services Director set the device configuration

state to In Sync.

Theaboveprocessdiffers somewhatwhenout-of-bandconfigurationchangesaremade

through the Junos Space configuration editor. In this case:

1. Junos Space sets the device configuration state as Space Changed after the

configuration change is saved.

At this point, the changes have beenmade only in the Junos Space configuration

recordand thechangeshavenot yetbeendeployed to thedevice.ConnectivityServices

Director shows the device configuration state as In Sync.

NOTE: Because the device configuration state is In Sync in Connectivity
Services Director, you can deploy configuration on the device from
Connectivity Services Director at this point. If you do so, the Connectivity
ServicesDirectorchangesaredeployedonthedevice,but the JunosSpace
changesarenot.Thedevicestate in JunosSpace remainsSpaceChanged.

2. Whenthechangesaredeployed to thedevice fromJunosSpace, JunosSpacechanges

the device state to In Sync, while Connectivity Services Director changes the device

state to Out of Sync.

3. In Connectivity Services Director, use the Resynchronize Device Configuration task to

resolve the Out of Sync state. In this case, because the Junos Space configuration

record and the device configuration are in sync, you cannot reject the changes. When

you resynchronize the device in Connectivity Services Director, the Build mode

configuration is updated to reflect the configuration changes.

4. Connectivity Services Director sets the device configuration state to In Sync.

If you use Junos Space instead of Connectivity Services Director to resolve out-of-band

configuration changes in SSORmode, note the following:

• If you reject an out-of-band change, the device state becomes In Sync in both

Connectivity Services Director and Junos Space.

• If youacceptanout-of-bandchange thatdoesnotaffect theBuildmodeconfiguration,

the device state becomes In Sync in both Connectivity Services Director and Junos

Space.

• If you accept an out-of-band change that affects the Build mode configuration, the

device state becomes In Sync in Junos Space but remains Out Of Sync in Connectivity
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ServicesDirector. Youmust use theResynchronizeDevice Configuration task to resolve

the Out of Sync state.

NOTE: When Junos Space is in SSORmode, we recommend that you do not
make out-of-band changes to the cluster configuration on the secondary
seeds andmember controllers of amobility domain, such as disabling the
cluster on these devices. Use Connectivity Services Director tomodify the
cluster configuration on these devices.

HowConnectivity Services Director Resynchronizes the Build Mode Configuration

When you use the Resynchronize Device Configuration task to resynchronize the Build

mode configuration to the device configuration, Connectivity Services Director launches

a resynchronization job. This job deletes all profile assignments configured for the device.

The profiles themselves are not deleted—just the assignments of the profiles to the

device are deleted. It then reimports the device configuration, as if the device were a

newly discovered device. It reassigns existing profiles and creates new profiles as

necessary. Profiles that were originally assigned to the device will be reassigned to the

device if the profiles were unaffected by the out-of-band changes. All profiles assigned

to the device are in a deployed state at the end of the process. Any profile that is not

reassigned to the device and is not assigned to any other device will be in a unassigned

state.

Related
Documentation

Resynchronizing Device Configuration on page 738•

Resynchronizing Device Configuration

AnetworkmanagedbyConnectivityServicesDirectorhas three repositoriesof information

about theconfigurationofanetworkdevice—theconfigurationstoredon thedevice itself,

the device configuration record maintained by Junos Space, and the Build mode

configuration maintained by Connectivity Services Director.

When theconfigurationcontained inall three repositoriesmatch, thedevice configuration

state is shown as In Sync in Connectivity Services Director. When the repositories do not

match, the configuration state is shown as Out of Sync. A common cause for this state

is out-of-band configuration changes—that is, configuration changes made to a device

outside of Connectivity Services Director.

When a device state is Out of Sync, you cannot deploy configuration changes on the

device inDeploymode.Use theResynchronizeDeviceConfiguration task to resynchronize

the three configuration repositories and change the device configuration state back to

In Sync.

HowtheResynchronizeDeviceConfiguration taskperformsthe resynchronizationdepends

on the system of record (SOR)mode setting for the Junos Space Network Management

Platform:
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• When Junos Space is in network as system of record (NSOR)mode, the device is

considered the system of record for configuration. When you resynchronize a device

when Junos Space is in NSORmode, both the Junos Space configuration record and

the Connectivity Services Director Build mode configuration are updated to reflect the

device configuration—in other words, the out-of-band configuration changes are

incorporated into both the Junos Space and the Connectivity Services Director

configuration repositories.

• When JunosSpace is in JunosSpaceassystemof record (SSOR)mode, youcanchoose

whetheracceptor reject theout-of-bandchanges reflected in thedeviceconfiguration.

If you accept the changes, both the Junos Space configuration record and the

Connectivity Services Director Build mode configuration are updated to reflect the

device configuration. If you reject the changes, the out-of-band changes are rolled

back on the device so that the device configuration matches the Junos Space

configuration record and the Connectivity Services Director Build mode configuration.

Formore informationaboutout-of-bandconfigurationchanges, JunosSpaceSORmodes,

and how Connectivity Services Director resynchronizes device configuration, see

Understanding Resynchronization of Device Configuration.

This topic covers:

• The Resynchronize Device Configuration List of Devices on page 739

• Resynchronizing DevicesWhen Junos Space Is in NSORMode on page 740

• Resynchronizing DevicesWhen Junos Space Is in SSORMode on page 741

• Resynchronizing Devices in Manual Approval Mode on page 742

• Viewing the Network Changes on page 742

• Viewing Resynchronization Job Status on page 742

The Resynchronize Device Configuration List of Devices

The Resynchronize Device Configuration page displays a list of all devices in the selected

scopewhoseconfigurationwassuccessfully importedduringdevicediscoveryandwhose

configuration state is now Out Of Sync. You can select devices from this list and

resynchronize them.

Table 106 on page 739 describes the fields in the list of devices.

Table 106: Resynchronize Device Configuration Fields

DescriptionField

Device hostname or device IP address.Name

IP address of device.IP address

Model number of the device.Model

Operating system version currently running on the device.OS Version
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Table 106: Resynchronize Device Configuration Fields (continued)

DescriptionField

Connection state:

• UP—Connectivity Services Director is connected to the device

• DOWN—Connectivity Services Director cannot connect to the device

Connection State

Shows the configuration state of the device:

• Out Of Sync—The device configuration is out of sync with either the Connectivity Services Director
Build mode configuration or the Junos Space configuration record or both.

• Resynchronizing—The device configuration is in the process of being resynchronized.

• Sync Failed—The resynchronization attempt failed.

If the resynchronization is successful, the device is removed from the table.

Configuration State

Specifieswhether configuration changes have beenmade in Buildmode and are pending deployment
on the device.

• None—There are no configuration changes pending deployment.

• View—Thereareconfigurationchanges thatarependingdeployment.ClickView to view thechanges.
These changes will be lost if you resynchronize the Build mode configuration to match the device
configuration.

NOTE: ThePendingChangeswindowthatappearswhenyouclickViewallowsyou to seewhatprofiles
have been added, modified, or changed. However, because the device is not in sync, you cannot view
the specific changes in CLI or XML format.

Local Changes

Indicates whether you can view the out-of-band changes:

• None—Theout-of-bandchangesarenotavailable for viewing.Youcannotviewout-of-bandchanges
inNSORmode. InSSORmode, youcannot view theout-of-bandchanges if theyarealready resolved
in Junos Space—that is, the device configuration state in Junos Space is In Sync.

• View—You can view the out-of-band changes made on the device. Click View to view the changes
presented in XML format.

Network Changes

Resynchronizing DevicesWhen Junos Space Is in NSORMode

To resynchronizedeviceswhen the JunosSpaceNetworkApplicationPlatform is inNSOR

mode:

1. On theResynchronizationDeviceConfiguration page, select the device or devices that

you want to resynchronize.

2. (Optional) View any pending changes to a device’s configuration in Connectivity

ServicesDirectorbyclickingView in theLocalChangescolumn.Thesependingchanges

are deleted when you resynchronize the device.

3. Click Resynchronize Configuration.

The Resychronize Device Configuration Results window appears. This windowwill be

updated with status of the resynchronization when the resynchronization completes.

Copyright © 2019, Juniper Networks, Inc.740

Connectivity Services Director User Guide



Resynchronizing DevicesWhen Junos Space Is in SSORMode

To resynchronize devices when the Junos Space Network Management Platform is in

SSORmode:

1. On theResynchronizationDeviceConfiguration page, select the device or devices that

you want to resynchronize.

2. (Optional) View any pending changes to a device’s configuration in Connectivity

ServicesDirectorbyclickingView in theLocalChangescolumn.Thesependingchanges

aredeleted if youaccept theout-of-bandchangeswhenyou resynchronize thedevice.

3. (Optional) View the out-of-band configuration changes by selecting View in the

Network Changes column. If you accept the out-of-band changes when you

resynchronize the device, these changes will be reflected in the Build mode

configuration. If you reject the out-of-band changes when you resynchronize the

devices, these changes will be deleted from the device. For more information about

viewing the out-of-band changes, see “Viewing the Network Changes” on page 742.

NOTE: Out-of-band changes that weremade with the Junos Space
configuration editor or that were already accepted in Junos Space are not
shown. Such changes also cannot be rejected.

4. Click Resynchronize Configuration.

5. In the Confirm dialog box:

• Click Accept device changes if you want to accept the out-of-band changes.

• Click Reject device changes if youwant to reject the out-of-band changes and have

the configuration that existed on the device before the out-of-band changes were

made be reinstated.

click Submit.

The Resychronize Device Configuration Results window appears. This windowwill be

updated with status of the resynchronization when the resychronization completes.

NOTE: Device changesmade by the Junos Space configuration editor or
device changes that have been accepted in Junos Space cannot be rejected.
Even if you select Reject device changes, these changes will not be rejected
and instead will be incorporated into the Build mode configuration.
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Resynchronizing Devices in Manual Approval Mode

When out-of-band changes exist, device resynchronization merges the changes done

by using the CLI with the local changes provided that there are no conflicts. If there are

conflicting changes, the changes made using the CLI take precedence over the local

changes. Therefore, configuration changes that are part of a change request might be

lost. The configuration change requests that are lost are marked as Cancelled against

the corresponding device. When device resynchronization is initiated for a device, a

message is displayed that lists thechange requests thatwill be lost becauseof conflicting

CLI and local changes. All other changes remain unaffected.

Viewing the Network Changes

The Network Changes window shows the out-of-band configuration changes made to

a device when Junos Space is in SSORmode.

Not all out-of-band configuration changes are shown in this window. Configuration

changes are shown only when the device configuration differs from the Junos Space

configuration record—that is, when the device configuration state in Junos Space is not

In Sync. For example, if the out-of-band changes were deployed from the Junos Space

configuration editor or if theout-of-bandchangeswere alreadyaccepted in JunosSpace,

the configuration changes will not appear in this window.

The configuration changes are shown in XML format. If there have beenmultiple

out-of-band changes—that is, there has beenmore than one configuration commit, or

save, on the device—the changes are grouped by each commit.

The following information is provided for each configuration commit:

• junos:commit-seconds—Specifies the time when the configuration was committed

as the number of seconds since midnight on 1 January 1970.

• junos:commit-localtime—Specifies the time when the configuration was committed

as the date and time in the device’s local time zone.

• xmlns:junos—Specifies the URL for the DTD that defines the XML namespace for the

tag elements.

• junos:commit-user—Specifies the username of the user who requested the commit

operation.

Viewing Resynchronization Job Status

The Resychronize Device Configuration Results window appears after you start a

resynchronization job. This window is automatically updated with the resynchronization

status for each device when the job completes.

You can also view the status of the resynchronization jobs using the Manage Jobs task

in Systemmode. The following jobs are associated with resynchronization:

• ResynchNetworkElements—This job runs inNSORmodeand resynchronizes the Junos

Space configuration record with the device configuration.
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• Resolve OOB Changes—This job runs in SSORmode and resolves the out-of-band

changes for JunosSpace—either accepting the changes andupdating the JunosSpace

configuration or rejecting the changes and rolling back the changes on the device.

• Resynchronizedevices—This job runs inbothNSORandSSORmodeand resynchronizes

the Build mode configuration with the device configuration.

See Also Understanding Resynchronization of Device Configuration on page 733•

Managing Device Configuration Files

You can back up device configuration files to the Connectivity Services Director server.

You can perform several actions on backed up configuration files, such as restoring

configuration files to devices, and viewing and comparing configuration files.

To start managing device configuration files:

1. Click Deploy in the Connectivity Services Director banner.

2. In the Tasks pane, select Device Configuration Files >Manage Device Configuration

Files.

TheManage Device Configuration page opens in themain window. The table lists the

devices that have configuration files backed up.

This topic describes:

• Selecting Device Configuration File Management Options on page 743

• Backing Up Device Configuration Files on page 744

• Restoring Device Configuration Files on page 745

• Viewing Device Configuration Files on page 745

• Comparing Device Configuration Files on page 746

• Deleting Device Configuration Files on page 746

• Managing Device Configuration File Management Jobs on page 746

Selecting Device Configuration File Management Options

From the Manage Device Configuration page, you can:

• Back up device configuration files by clicking Backup. See “Backing Up Device

Configuration Files” on page 744 for more information.

• Restore backup device configuration files to devices by selecting devices and clicking

Restore. See “Restoring Device Configuration Files” on page 745 for more information.

• Viewbackedupconfiguration filesby selectingadeviceandclickingViewConfiguration

File. See “Viewing Device Configuration Files” on page 745 for more information.
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• Comparebackedupdeviceconfiguration filesbyselectingdevicesandclickingCompare

Config Files. See “Comparing Device Configuration Files” on page 746 for more

information.

• Delete backup device configuration files by selecting devices and clicking Delete. See

“Deleting Device Configuration Files” on page 746 for more information.

Table 107 on page 744 describes the information provided in the Manage Device

Configuration table.

Table 107: Manage Device Configuration Table

DescriptionTable Column

Device name.Device Name

Version number of the backup configuration file.Config File Version

Date when the oldest version of the backup configuration file was created.First Backup on

Date when the configuration file was backed upmost recently.Most Recent Backup on

Backing Up Device Configuration Files

To back up device configuration files:

1. Click Backup.

The Backup Devices Configuration page opens in the main window.

2. Select the devices to back up from the device tree.

3. To back up configuration files immediately, click Backup Now.

The backup job runs. When it finishes, the Manage Device Configuration table shows

updated information for the devices you backed up.

4. To schedule the backup to run later, click Schedule Backup.

The Schedule Backup window opens.

a. Select the Schedule at a later time check box.

b. Specify when the backup will run using the Date and Time fields.

c. Optionally, configure the backup job to repeat by selecting the Repeat check box,

then specifying the backup schedule using the provided fields.
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Optionally, you can specify when repeated backups will stop by selecting the End

Time check box, then specifying the last date on which the repeated backup job

will run using the Date and Time fields.

d. Click Schedule Backup.

Restoring Device Configuration Files

You can restore a backed up configuration file to the device fromwhich it was backed

up.

CAUTION: Restoring a configuration file to a device is considered an
out-of-bandconfigurationchange,whichcancausesomeunexpected results.
Formore information, see “Out-of-BandConfigurationChanges”onpage 173.

To restore backed up configuration files to devices:

1. Select the devices to restore from the Manage Device Configuration list.

2. Click Restore.

The Restore Device Configuration File(s) window opens.

3. To restore a configuration file that is older than themost recent version, click in the

Latest Version cell and select the version to restore.

4. Click Restore.

Viewing Device Configuration Files

To view the backed up configuration files for a device:

1. Select the device from the Manage Device Configuration list.

2. Click View Configuration File.

The Device Configuration Summary window opens, displaying the most recently

backed up configuration file.

3. To view an older stored configuration file version, select a version number from the

Config File Version list.
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Comparing Device Configuration Files

To compare backed up device configuration files:

1. Select the configuration files to compare from the Manage Device Configuration list.

2. Click Compare Configuration Files.

The Compare Configuration Files window opens.

3. Select a source device from theSourceDevice list and a configuration file version from

the Config File Version list.

4. Select a target device from the Target Device list and a configuration file version from

the Config File Version list.

5. Theconfiguration file versions you selectedaredisplayed in thewindow.The file name

and version appears at the top of each file. The differences between the configuration

files are color-coded. The color-coding legend appears at the top of the window.

Deleting Device Configuration Files

When you delete a device’s backed up configuration, all of the configuration file versions

for the device are deleted.

To delete device configuration files:

1. Select the configuration files to delete from the Manage Device Configuration list.

2. Click Delete.

The Delete Device Configuration File(s) window opens.

3. Verify that the correct devices are listed, then click Delete.

Managing Device Configuration File Management Jobs

Each time you back up or restore device configuration files, a device configuration file

management job is created.

Tomanage device configuration file management jobs:

1. Click Deploy in the Connectivity Services Director banner.

2. In the Tasks pane, select Device Configuration Files > View Configuration File Mgmt

Jobs.

The Device Configuration Jobs page opens in the main window, listing the device

configuration file management jobs.
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Managing these jobs is similar to managing other types of jobs using the Systemmode.

The advantage of accessing the jobs this way is that the jobs list showonly configuration

file management jobs. See “Managing Jobs” on page 118 for more information.

See Also Managing Configuration Deployment Jobs on page 722•

• Deploying Configuration to Devices on page 711

Enabling or Disabling Network Ports on Routers

Network ports connect Routers to the network and carry network traffic. You can enable

or disable network ports of Routers that are part of your network. When you enable or

disable a port, the administrative status of the port changes toUPorDOWN respectively.

When you disable a port, the systemmarks that port as administratively down, without

removing the port configurations.

You can enable or disable one or more ports at a time using the Manage Port Admin

State page. The status of the port is indicated by the Admin State and the Link State

fields. The administrative status of a port is indicated by the Admin State field.

To enable or disable a network interface:

1. Do one of the following:

• In the topology view, locate the device forwhich youwant to enable or disable ports

and click DeviceManagement >Manage Port Admin State from the Tasks pane.

• While in the Deploymode, select the device forwhich youwant to enable or disable

ports in the View pane and click DeviceManagement >Manage Port Admin State

from the Tasks pane.

TheManagePortAdminStatepageappears displayingall thephysical ports available

on the selected device and the current status of each port. This page also displays

the port mode of each interface, if any. Port mode can be access, tagged-access, or

trunk mode.

2. Do one of the following:

• Select the checkboxadjacent to theports that youwant to enable andclickChange

Admin State UP.

• Select the check box adjacent to the interfaces that you want to disable and click

Change Admin State DOWN.

3. Click Done. Connectivity Services Director changes the administrative status of the

ports and displays a confirmation message confirming the changes.

Related
Documentation

• Deploying Configuration to Devices on page 711

• Managing Configuration Deployment Jobs on page 722
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CHAPTER 31

DeployingandManagingSoftware Images

• Managing Software Images on page 749

• Deploying Software Images on page 752

• Managing Software Image Deployment Jobs on page 755

Managing Software Images

This topic describes how tomanage software images for managed devices.

To start managing software images:

1. Click Deploy in the Connectivity Services Director banner.

2. In the Tasks pane, select ImageManagement >Manage Image Repository.

The Device Image Repository page opens in the main window. The table lists the

software images in the repository.

3. In the Tasks pane, select Device Configuration File Management >Manage Device

Configuration.

TheManage Device Configuration page opens in themain window. The table lists the

devices that have configuration files backed up software images in the repository.

This topic describes:

• Selecting Software Image Management Options on page 749

• Adding Software Images to the Repository on page 750

• Using the Device Image UploadWindow on page 750

• Viewing Software Image Details on page 751

• Using the Device Image SummaryWindow on page 751

• Deleting Software Images on page 751

Selecting Software ImageManagement Options

From the Device Image Repository page, you can:
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• Add a software image to the repository by clicking Add.

• View details about a software image by selecting it and clicking Details.

• Delete software images from the repository by selecting them and clicking Delete.

Table 108onpage750describes the informationprovided in theDevice ImageRepository

table.

Table 108: Device Image Repository Table

DescriptionTable Column

Select to perform an action on the software image in that row.Check box

Software image name.Name

Software version.Version

Device series that uses the software image.Series

User who uploaded the software image.Uploaded By

Time when the software image was uploaded to the server.Created On

Size of the software image in megabytes.Size(MB)

Adding Software Images to the Repository

Software images are stored in a repository on the Connectivity Services Director server.

To add a software image to the repository:

1. Click Add.

The Device Image Upload window opens.

2. Use the Device Image Uploadwindow to upload a device software image. See “Using

the Device Image UploadWindow” on page 750 for a description of the window.

Using the Device Image UploadWindow

To use the Device Image Upload window to add a software image to the repository:

1. Click Browse and browse to the software image file.

2. Click Upload to add the file to the repository.
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Viewing Software Image Details

To view details about a software image:

1. Select the software image file in the table.

2. Click Details.

The Device Image Summary window opens. See “Using the Device Image Summary

Window” on page 751 for information about this window.

Using the Device Image SummaryWindow

Use the Device Image Summary window to view detailed information about a software

image. Table 109 on page 751 describes the fields in this window.

Table 109: Device Image SummaryWindow

DescriptionField

Software image filename.Name

Software version (release number).Version

Device series on which the software is supported.Series

Platforms on which the software is supported.Supported Platforms

User who uploaded the image to the server.Uploaded By

Date and time when the software image was uploaded.Created On

Size of the software image file, in megabytes.Size (MB)

Click to close the window.OK

Deleting Software Images

To delete software image files:

1. Select the check box in the rows of the software image files that you want to delete.

2. Click Delete.

See Also Managing Software Image Deployment Jobs on page 755•

• Deploying Software Images on page 752
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Deploying Software Images

This topic describes how to deploy software images to managed devices. Youmust

upload software images to the Connectivity Services Director server before you can

deploy them to devices. See “Managing Software Images” on page 749 for more

information.

To start deploying software images:

1. Click Deploy in the Connectivity Services Director banner.

2. Select a node in the View pane that contains the devices towhich youwant to deploy

software images.

3. In the Tasks pane, select ImageManagement > Deploy Images to Devices.

The Select Devices page of the Deploy Images to Devices wizard opens in the main

window.

This topic describes:

• Specifying Software Deployment Job Options on page 752

• Selecting Software Images To Deploy on page 753

• Selecting Options for Software Deployment on page 754

• Summary of Software Deployment on page 755

Specifying Software Deployment Job Options

To specify software deployment job options in the Select Devices page:

1. In the Job name field, enter a job name.

2. From the Device and deployment options list, select an option:

• SelectStagingonly(Download imagetothedevice) todownload thesoftware image

to the device but not install it.

• SelectUpgradeonly (Installpreviouslystaged imageondevice) toupgrade thedevice

to a software image that was previously staged on the device.

• Select Staging and Upgrade (Download and Install image on device) to download

the software image and install it on the device.

Devicesarenotautomatically rebootedafter upgrade tomake thedevicebegin running

thenewsoftwareversion.Youcanselect theoption to reboot thedeviceautomatically

after the upgrade in a later wizard page.

3. Click Next to continue to the next page.
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The Select Images page opens. Select a software image as described in “Selecting

Software Images To Deploy” on page 753.

Selecting Software Images To Deploy

The Select Images page includes a table listing each device group and device that you

selected for deployment. SeeTable 110onpage753 for adescriptionof the table columns.

If you selected the Upgrade only (Install previously staged image on device) option, only

devices that contain a previously staged software image appear in the table. You cannot

select a different image to install on these devices.

To select the software images to deploy, perform the following steps on the table row

for each device group or individual device that you want to upgrade:

1. In the Proposed Image Version/Profile column, click Select Image/Profile.

The Select Image/Profile list is displayed.

2. From the Select Image/Profile list, select a software image.

TIP: To clear this field, select Select Image/Profile from the list.

3. After you finish selecting software images, click Next to continue to the next page.

The Select Options page opens.

TIP: Apop-upmessage notifies you if you do not select a software image
for all the listed devices. This is just for your information. No actionwill be
taken on devices for which you do not select a software image. In effect,
this removes those devices from the job.

Selectoptions for softwaredeploymentasdescribed in “SelectingOptions forSoftware

Deployment” on page 754.

Table 110: Select images for devices Table

DescriptionTable Column

Device family to which the device belongs. Devices are grouped by family. To display
the devices within a device family, click the arrow next to the device family name.

Device Family

Number of devices contained within a device family.Count

Device’s IP address.IP Address

Device’s name.Device Name
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Table 110: Select images for devices Table (continued)

DescriptionTable Column

Device’s state:

• UP—Connectivity Services Director can communicate with the device.

• DOWN—Connectivity Services Director cannot communicate with the device.

State

Software version the device is running.Running Image Version

Software version that will be installed on the device when the job runs successfully.Proposed Image Version/Profile

Selecting Options for Software Deployment

The options that you can configure in the Select Options page are described in

Table 111 on page 754. The options that are available depend on the job flow you chose in

the Select Images page.

After you finish selecting options, click Next to continue to the next page. The Summary

pageopens.Reviewthe jobsummaryasdescribed in “SummaryofSoftwareDeployment”

on page 755.

Table 111: ImageManagement Job Options

ActionOption

Select Options

All Device Types

Select to delete any existing software images on devices before downloading the new
software image.

Delete any existing image before
download

Select to reboot the device after the software image is installed. A reboot is required to
begin running the new software version on the device.

NOTE: This optionmaygetdisabledbasedonyour details that you specify in the remaining
fields. This indicates that for the options that you specified, the systemwill automatically
reboot the device as per the requirement during or after the image upgrade.

Reboot device after successful
installation

Wired Devices

Select to validate the software package or bundle against the current configuration as a
prerequisite to adding the software package or bundle.

Check compatibility with current
configuration

Select if you want to perform a Nonstop software upgrade (NSSU) or Iin-service software
upgrade (ISSU).

ISSU enables you to upgrade between two different Junos OS releases with minimal
disruption on the control plane and with minimal disruption of traffic.

NSSU enables you to upgrade the software running on anMXSeries router with redundant
Routing Engines or onmost MX Series Virtual Chassis configuration by using a single
command and with minimal disruption to network traffic

ISSU/NSSU
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Table 111: ImageManagement Job Options (continued)

ActionOption

Select to take an archive snapshot of the files currently used to run the switch and copy
them to an external USB storage device connected to the switch.

Archive data (Snapshot)

Select to copy the new Junos OS image into the alternate root partition. This ensures that
the resilient dual-root partitions feature operates correctly.

This option is available only if you select Reboot device after successful installation.

Copy to alternate slice

Select Schedule

Select Stage now to start staging software images to devices as soon as the job runs.

Select Stage later time to schedule the staging for a later time.

Stage now

Stage later time

If you selected Stage later time, enter the date and time for staging to start.Staging Schedule

Select Upgrade now to start upgrading software images on devices as soon as staging
finishes.

Select Upgrade later time to schedule the software upgrade for a later time.

Upgrade now

Upgrade later time

If you selected Upgrade later time, enter the date and time for upgrade to start.

If you scheduled staging, youmust schedule the upgrade for at least 10minutes after
staging, to ensure that staging completes before upgrade starts.

Deployment Schedule

Summary of Software Deployment

On the Summary page, review the selections youmade for the job. To change selections,

click Edit in the area that youwant to change. You can also click the boxes in the process

flowchart above thewizard page to navigate between pages.When you are donemaking

selections, click Finish on the Summary page to save the job, and run it if you configured

the job to run immediately.

Related
Documentation

Managing Software Image Deployment Jobs on page 755•

• Managing Software Images on page 749

Managing Software Image Deployment Jobs

This topicdescribeshowtomanagesoftware image jobs. A software image job is created

each time you deploy software images to devices or schedule a software image

deployment. You can check the status of jobs, see job details, and cancel scheduled jobs.

To start managing software image jobs:

1. Click Deploy in the Connectivity Services Director banner.

2. In the Tasks pane, select ImageManagement > View Image Deployment Jobs.

755Copyright © 2019, Juniper Networks, Inc.

Chapter 31: Deploying and Managing Software Images



The Image Deployment Jobs page opens in the main window.

This topic describes:

• Selecting Software Image Management Options on page 756

• Viewing Software Image Job Details on page 757

• Using the Device Image StagingWindow on page 757

• Canceling Software Image Jobs on page 758

Selecting Software ImageManagement Options

From the Image Deployment Jobs page, you can:

• Showdeployment jobdetails by selectinga jobandclickingShowDetails. See “Viewing

Software Image Job Details” on page 757 for more information.

• Cancel a pending job by selecting the job and clicking Cancel Job. See “Canceling

Software Image Jobs” on page 758 for more information.

Table 112 onpage 756describes the informationprovided in theof the ImageDeployment

Jobs table.

Table 112: Image Deployment Jobs Table

DescriptionTable Column

An identifier assigned to the job.Job Id

Select to perform an action on the job in that row.Check box

Job name.Job Name

Percentage of the job that is complete.Percent

Job status. The possible states are:

• CANCELLED—The job was cancelled by a user.

• SCHEDULED—The job is scheduled but has not run yet.

• INPROGRESS—The job is running.

• SUCCESS—The job completed successfully. This state is applied if all of the devices in
the job completed successfully.

• FAILURE—The job failed. This state is applied if any of the devices in the job failed. But
some of the devices might have completed successfully. View the job details for the
status of each device.

Status

Job summary.Summary

Job’s scheduled start time.Scheduled Start Time

Time when the job started.Actual Start Time

Time when the job ended.End Time
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Table 112: Image Deployment Jobs Table (continued)

DescriptionTable Column

User who created the job.User

This field is not used for software imagemanagement jobs.Recurrence

Viewing Software Image Job Details

To view the details of a software image job:

1. Select the job in the table.

2. Click ShowDetails.

The Device Image Staging window opens. See “Using the Device Image Staging

Window” on page 757 for a description of the window.

Using the Device Image StagingWindow

Use the Device Image Staging window to view information about software image jobs.

Table 113 on page 757 describes this window.

Table 113: Device Image StagingWindowDescription

DescriptionField

Job name.Job Name

Job’s scheduled start time.Start Time

Time when the job ended.End Time

Percentage of the job that is complete.% Complete

Job status. The possible statuses are:

• CANCELLED—The job was cancelled by a user.

• SCHEDULED—The job is scheduled but has not run yet.

• INPROGRESS—The job is running.

• SUCCESS—The job completed successfully.

• FAILURE—The job failed.

Status

Host name of device.Host Name

Device status. The possible statuses are:

• INPROGRESS—The job is running.

• SUCCESS—The job completed successfully.

• FAILURE—The job failed.

Status
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Table 113: Device Image StagingWindowDescription (continued)

DescriptionField

Percentage of the job that is complete on the device.% Complete

Time when the job started on the device.Start Time

Time when the job ended on the device.End Time

Description of the job on the device. Can include error messages for failed devices.Description

Click to close the window.Close

Canceling Software Image Jobs

To cancel a software image job:

1. Select the job in the table.

2. Click Cancel.

See Also • Deploying Software Images on page 752

• Managing Software Images on page 749
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PART 10

ServiceProvisioning:WorkingwithService
Orders

• Service Provisioning: Viewing the Configured Services and Service Orders on page 761

• Service Provisioning: Managing E-Line Service Orders on page 773

• Service Provisioning: Managing E-LAN Service Orders on page 827

• Service Provisioning: Managing IP Service Orders on page 877

• Service Provisioning: Performing RFC 2544 Benchmark Testing on page 937
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CHAPTER 32

Service Provisioning: Viewing the
Configured Services and Service Orders

• Viewing Service Orders on page 761

• Viewing Service Order and Service Details on page 763

• Viewing Services on page 766

• Viewing the Configured E-Line, IP, and E-LAN Services on page 769

• Viewing the Configuration Details of VPN Services on page 771

Viewing Service Orders

The following topic describes how you can view service orders.

• Viewing Service Orders in a Table on page 761

Viewing Service Orders in a Table

To view and determine the status of service orders in a tabular form:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the Network Services >

Connectivity tree and select the type of service.

4. In theNetwork Services >Connectivity viewpane, selectServiceProvisioning>Deploy

Services.

The Manage Service Deployment page is displayed in the lower half of the window.
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A table of service orders on the systemappears in themaindisplay area. The following

fields are displayed on this page:

• Name—Unique name assigned to the service.

• Customer—Name of the customer for which the service is provided.

• State:

• Completed—Service order has been successfully deployed.

• Failed—Device is down or the Connectivity Services Director application was

unable to push the service configuration to a device configured for the service.

• In-progress—Connectivity Services Director application is in the process of

deploying the service.

• Invalid—Service order contains invalid data.

• Requested—Service provisioner has created the service order, but has not yet

attempted to deploy it or schedule it for deployment.

• Scheduled—Service provisioner has scheduled the service order for deployment.

• Service Type:

• E-Line pseudowire (LDP)

• E-Line pseudowire (BGP)

• E-LAN (MultiPoint-to-MultiPoint)

• E-LAN (Point-to-MultiPoint)

• IP (Full Mesh)

• IP (Hub-Spoke 1 Interface)

• Latest Job—Unique identifier assigned by the system for a deployment job. Click

the link in the job ID to open the CSDDeployment Jobs. The table on that page lists

configuration deployment jobs.

• Signaling Type:

• BGP

• LDP

• Created By—The screen name of the user who created the service order

• Created Date—The date and when you created the service order.
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From this page, you can create a service order, modify the properties of the service

order, conduct a functional or configuration audit, deploy or deactivate the service

order, and view alarms associated with a particular service order for debugging and

corrective action.

5. To view details of a specific service order, double-click the table row that summarizes

the service order.

Related
Documentation

Viewing Service Order and Service Details on page 763•

• Modifying a Saved Service Order on page 1052

• Viewing Services on page 766

Viewing Service Order and Service Details

In your network environment, it might be necessary to quickly view the list of deployed

services for different protocols that you have defined, such as IP or E-Line, and obtain a

high-level, comprehensive view of the different parameters defined for a service order.

Based on the currently defined service attributes, you canmodify them accordingly to

suit yourdeploymentneeds.Theserviceordersassociatedwithcustomers thatare shown

also enable you to view the customer information and update the user-related details

for a service order. The details for the service selected are displayed in a popup window

such as the general settings, PE devices, UNI settings, themapped service definition, and

the corresponding service customer details. All the values shown in the details view are

read-only fields.

You can launch the Service Detail window in two ways— by double-clicking a service

order from the Manage Services page in Deploy Mode of Service View, and by selecting

a service from the View pane and selecting Manage Services > View Details from the

task pane in Deploy Mode of Service View to display detailed information for deployed

services.

To view the consolidated details of a service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.
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• Select IP Services to manage IP service orders.

• Select E-Line Services to manage E-Line service orders.

• Select E-LAN Services to create andmanage E-LAN service orders.

Alternatively, you can drill-down the tree of each of the services, such as E-LAN or IP

services, to view the previously configured service orders andmodify their attributes.

5. From the task pane, which is the middle pane in the window, selectManage Services

>ViewDetails. TheServiceDetailswindow isdisplayed.Theservicedetails aregrouped

into various sections and only the applicable attributes are displayed for the selected

service, based on the service type.

Alternatively, selectDeployServices fromthe taskpane, and fromtheManageNetwork

Serviceswindow, selecta service.Thecorrespondingserviceorderdetails aredisplayed

in the Manage Service Orders window at the bottom of the right pane. Double-click

a service order to view the service order details.

The Service Details window is divided into three sections—Basic Details, Advanced

Details, and Endpoint Details. The service tree contains the service name as the root

node. The device node is the child of the service node and it contains the provisioned

UNIs as the child nodes. The details panel in the Endpoint Details table displays

configuration parameters and their corresponding values for the service in the tree

and based on the service type.

Under the Basic Details section, the general details about the node details are shown.

Also, the device configuration parameters are displayed. Under the Advanced Details

section, which you can open or close by clicking the View Less or ViewMore toggle

links, theadvancedconnectivity settingsbetweensites in the serviceprovider network

are shown, suchas routedistinguisher andVRF route label details.Under theEndpoint

Details table, the configuration parameters of the UNI are displayed. The right pane

displays the details corresponding to the node or element you selected on the left

pane.

Under the Device Details section, the service details displayed on the right pane are

organized under the following sections:

Basic Details

This section is applicable for all types of services and displays the following details.

• Name—Name of the selected service

• Customer—Name of the customer associated with the service.

• Service Definition—Name of the service definition that is used to create the service.

• Service Order—Unique identifier assigned by the system to denote the service order.

• Service Type—Selected service type, such as E-Line, IP, or E-LAN

• State—State of the selected service. Possible values are:
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NOTE: These states apply only for a service and not a service order

• Active—Denotesa service that hasbeendeployedand is in anactive state (enabled).

• Inactive–Denotes a service that has been deployed and is in a deactivated state

(disabled.

• Pending—Denotesaservice forwhichdeploymentof theservice toadevice ispending

to be performed.

• Deploy—An attempt to modify the service failed.

• State—State of the selected service order. Possible values are:

NOTE: These states apply only for a service order and not a service.

• Completed—Service order has been successfully deployed.

• Deploy failed—Device is down or the Connectivity Services Director application was

unable to push the service configuration to a device configured for the service.

• In-progress—ConnectivityServicesDirector application is in theprocessof deploying

the service.

• Requested—Service provisioner has created the service order, but has not yet

attempted to deploy it or schedule it for deployment.

• Scheduled—Service provisioner has scheduled the service order for deployment.

• Invalid—Service order contains invalid data.

• Validated—When all the information in the service order is successfully validated,

the service order transitions to the Validated state.

• Last Updated Date—Date and time at which the service was last modified.

• Functional Audit Status—Status of the functional audit for the selected service

• Configuration Audit Status—Status of the configuration audit for the selected service

• Fault Status—Fault status of the audit performed for the selected service

• SLA Status—SLA status of the audit performed for the selected service.

Advanced Details

This section displays the advanced, fine-grained connectivity settings between sites,

such as the configured route distinguisher, VRF route label. The parameters displayed

under this section are similar to the advanced parameters displayed in the wizard for

service order creation.

Endpoint Details

A tabular view is displayed of the configured device and UNI Details that are part for the

service. Each row in the tabledisplays thebasic, salientparameters, suchasDeviceName,
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Interface Name, Unit ID, Encapsulation and Description. You can use the paging controls

to navigate acrossmultiple pagesof endpoints as necessary. Aminimumof 20endpoints

per page are displayed.

The following fields are displayed in the End Points table:

• EndPoint—Nameof the device configured as the source or origin (A) endpoint and the

destination or target (Z) endpoint. This field is displayed for E-Line services. Click the

plus sign beside the device name for E-Line services to expand the device-related

parameters and view the detailed settings.

• Device Name—Name of the device for which the service is created. Click the plus sign

beside the device name for E-LAN and IP services to expand the device-related

parameters and view the detailed settings.

• Interface—Name of the physical interface associated with the service.

• Tagging—Type of packet tagging for the interface, such as Ethernet, dot1Q, or Q-in-Q.

• UnitId—Logical unit identifier of the interface.

• VlanId—VLAN identifier of the interface.

• Is Hub—Indicates whether the node is a hub or a spoke.

• Template—Name of the service template that is used to create the service order.

• CoS Profiles—Name of the COS profile associated with the service.

Device Details

Click theplus signbeside thedevicenameshownunder theEndpoint (for E-Line services)

or Device Name (for E-LAN or IP services) row of the table. The configured parameters

on the device for the service are expanded and displayed after selecting a device in the

navigation tree. The parameters to be shown are based on the service type. The

parameters displayed under this section are similar to the node parameters and UNI

parameters displayed in thewizard for service order creation, such as route distinguisher,

MVPNstatusof theservice (shownonly forMVPN-enabledL3VPNservices), andMC-LAG

status of the service (shown only for the MCLAG-enabled L3VPN services).

Related
Documentation

Viewing Service Orders on page 761•

• Modifying a Saved Service Order on page 1052

• Viewing Services on page 766

Viewing Services

The following topic describes how to view services:

• Viewing Services in a Table on page 767

Copyright © 2019, Juniper Networks, Inc.766

Connectivity Services Director User Guide



Viewing Services in a Table

To view the services inventory in a table:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Connectivity Services Director user interface, click the Deploy icon in the

Connectivity Services Director banner. The functionalities that you can configure in

this mode are displayed in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. In the Network Services > Connectivity task pane, select Service Provisioning > Deploy

Services.

In the top half of the window on the right pane, the Manage Network Services page

presents information on existing services in a table.

TheManage Network Services page provides the following information about each

service:

Table 114 on page 767 describes the fields in the service orders table.

Table 114: Fields in the Services Table

DescriptionField

Name of the service order assigned during service creation or edit.Name

One of the following:

• E-Line pseudowire (LDP)

• E-Line pseudowire (BGP)

• E-LAN (MultiPoint-to-MultiPoint)

• E-LAN (Point-to-MultiPoint)

• IP (Full Mesh)

• IP (Hub-Spoke 1 Interface)

Service Type

Name of the enterprise customer who placed an order for the service.Customer
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Table 114: Fields in the Services Table (continued)

DescriptionField

State of the service:

• Active—Denotes a service that has been deployed and is in an active
state (enabled).

• Inactive–Denotes a service that has been deployed and is in a
deactivated state (disabled.

• Pending—Denotes a service for which deployment of the service to a
device is pending to be performed.

• Failed—An attempt to modify the service failed.

Deployment State

Status of functional audit of the service.FA Status

Fault management status of the service.Fault Status

Service-level agreement status of the service. If data exceeds the
threshold value specified in the Threshold Alarm Profile, the system
generatesa thresholdalarm.Thevalue in theSLAStatuscolumnchanges
to SLA Violated. If the data does not cross the threshold value specified
in theThresholdAlarmProfile, thevalue in theSLAStatuscolumnchanges
to SLA Violation Cleared.

SLA Status

Performancemanagement status of the service.PM Status

Name of the service definition upon which the service order is based.Definition

Date and time at which the service order was last activated.Activation Date

Date and time at which the profile was last updated.Last Modified Time

6. To restrict the display of services, enter a search criterion of one or more characters

in the search bar and press Enter. All services that match the search criterion are

shown in the main display area.

7. To view details of a specific service, double-click the table row that summarizes the

service.

For an E-LAN service (point-to-multipoint or multipoint-to-multipoint), a table of

service details appears.

8. Select the check box beside a service to launch the Manage Service Orders page in

the lower half of the pane. The service orders associated with the selected service

are displayed. You can perform different actions, such as validating or discarding

configuration.

See Also Viewing Service Orders on page 761•

• Viewing Service Order and Service Details on page 763
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Related
Documentation

Understanding Service Validation on page 1014•

• Managing Jobs on page 118

• Deleting a Partial Configuration of an LSP Service Order on page 967

• Deleting a Service Order on page 968

• Deploying a Service on page 969

• Validating the Pending Configuration of a Service Order on page 971

• Viewing the Configuration of a Pending Service Order on page 972

Viewing the Configured E-Line, IP, and E-LAN Services

To view the services inventory in a table:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Junos Space user interface, click the Build icon in the Connectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. With the Connectivity item selected in the View pane, from the Network Services >

Connectivity task pane, select Service Provisioning > View Services.

The View Network Services page is divided into two panes. The top pane provides a

pictorial representationof the typesof services, statusesof services, andaudit-related

information.

In theViewpane, if youselect theConnectivity item in the treeunderNetworkServices,

without expanding the tree and selecting a specific service type, such as E-Line

Services, IP Services, or E-LAN Services, the top pane displays a set of five pie charts

that enable you to view the different service orders configured, and their associated

audit andmonitoring statuses. TheFAStatus chart displays the functional audit status

for the service orders. The Device State graph displays the statuses of devices on

which services are being provisioned and commissioned. The Fault Status chart

displays the connectivity fault management details for the service orders. The SLA

Status chart displays the service-level agreement details for the service orders. The

PMStatus chart displays theperformancemanagement details for the service orders.
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The count or percentage of service orders in the pie chart segments sum up to the

total number of configured service orders. Mouse over each segment of the pie to

view the number corresponding to the percentage of service orders for each of the

charts. These charts provide a visual overview of customers and service orders on

your network, and enables you to quickly access related and commonly needed

information. For example, you can check for failed service orders and then access a

list of failed requests so you can begin to take restoration measure.

In the View pane, if you do not expand the Network Services tree, and select the

NetworkServicesnode in theViewpane, the toppanedisplaysapie chart that enables

you to view and examine the different services configured for devices, and the types

of service protocols configured. The Services by Type graph displays the count of

services for each type of service definition. Mouse over each segment of the pie to

view the number of services corresponding to the percentage of service types. This

chart provides a visual overviewof customers and service orders on your network, and

enables you to quickly access related and commonly needed information.

TheViewNetworkServicespageprovides the following informationabouteachservice

in the bottom pane:

Table 114 on page 767 describes the fields in the View Network Services table.

Table 115: Fields in the Services Table

DescriptionField

Name of the service order assigned during service creation or edit.Name

One of the following:

• E-Line pseudowire (LDP)

• E-Line pseudowire (BGP)

• E-LAN (MultiPoint-to-MultiPoint)

• E-LAN (Point-to-MultiPoint)

• IP (Full Mesh)

• IP (Hub-Spoke 1 Interface)

Service Type

Name of the enterprise customer who placed an order for the service.Customer

State of the service:

• Active—Denotes a service that has been deployed and is in an active
state (enabled).

• Inactive–Denotes a service that has been deployed and is in a
deactivated state (disabled.

• Pending—Denotes a service for which deployment of the service to a
device is pending to be performed.

• Failed—An attempt to modify the service failed.

Deployment State

Status of functional audit of the service.FA Status

Fault management status of the service.Fault Status
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Table 115: Fields in the Services Table (continued)

DescriptionField

Service-level agreement status of the service. If data exceeds the
threshold value specified in the Threshold Alarm Profile, the system
generatesa thresholdalarm.Thevalue in theSLAStatuscolumnchanges
to SLA Violated. If the data does not cross the threshold value specified
in theThresholdAlarmProfile, thevalue in theSLAStatuscolumnchanges
to SLA Violation Cleared.

SLA Status

Performancemanagement status of the service.PM Status

Name of the service definition upon which the service order is based.Definition

Date and time at which the service order was last activated.Activation Date

Date and time at which the profile was last updated.Last Modified Time

6. To restrict the display of services, enter a search criterion of one or more characters

in the search bar and press Enter. All services that match the search criterion are

shown in the main display area.

7. To view details of a specific service, double-click the table row that summarizes the

service.

For an E-LAN service (point-to-multipoint or multipoint-to-multipoint), a table of

service details appears.

Related
Documentation

Viewing Service Orders on page 761•

• Viewing Service Order and Service Details on page 763

Viewing the Configuration Details of VPN Services

You can view the configuration of an E-Line, IP, or E-LAN service, which enables you to

see the parameters and attributes configured for a service on the associated devices in

the form of configuration statements and commands that are displayed in the Junos OS

CLI interface. You can use these settings to examine the existing service configuration

andmodify it as necessary to correct any traffic-handling problems or system

discrepancies.

To view the configuration of services:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.
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3. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

4. From the Network Services > Connectivity task pane, select Service Provisioning >

Deploy Services. The Manage Network Services page is displayed on the top part of

the right pane.

5. Select the check box next to a service for which you want to view the configuration

details.

6. Click the View Configuration option. The Service Configuration View dialog box is

displayed. The configuration is displayed in the CLI interface structure and in the form

of configuration stanzas.

The left pane displays a tree of devices associatedwith the specified service. You can

select a Service-name > Device-name in the left pane of the window to view the

configuration parameters of the corresponding device on the right pane. The right

pane contains two tabs— Service Configuration and Template Configuration. The

Service Configuration tab displays the settings specified for the service on the device

in CLI format. This tab displays the elements or components specified for a service

template in the form of configuration stanzas and hierarchy levels. This display is

similar to the show command that you can use at a certain [edit] hierarchy level to

view the defined settings. The Template Configuration tab displays the service

attributes and options defined in the service template, if any, that is associated with

the service.

7. ClickOK to close thedialogboxafter youcomplete viewing theconfigurationattributes

and settings.

Related
Documentation

• Deleting a Partial Configuration of an LSP Service Order on page 967

• Deleting a Service Order on page 968

• Deploying a Service on page 969

• Validating the Pending Configuration of a Service Order on page 971
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CHAPTER 33

Service Provisioning: Managing E-Line
Service Orders

• Creating a Service Order on page 773

• Creating an E-Line ATM or TDM Pseudowire Service Order on page 774

• Creating an E-Line Service Order on page 784

• Creating a Bulk-Provisioning Service Order for Pseudowire Services on page 797

• Creating an Inverse Multiplexing for ATM Service Order on page 799

• Provisioning a Single-Ended E-Line Service on page 803

• Selecting Specific LSPs for Connectivity Services on page 804

• Stitching Two E-Line Pseudowires on page 807

• Deactivating a Service on page 809

• Reactivating a Service on page 810

• Force-Deploying a Service on page 812

• Recovering a Service Definition through Force Upload on page 814

• Decommissioning a Service on page 816

• Viewing Alarms for a Service on page 818

• Inline Editing of E-LAN and IP Service Orders on page 819

• Interconnecting an IP Service with an E-LAN Service on page 822

• Changing the Logical Loopback Interface for Provisioning on page 824

Creating a Service Order

A service order is an instance of the service definition that completes the definition for a

specific customer’suse.Theserviceorderalwaysspecifies thecustomerandtheendpoints

that link the customer sites through the MPLS network. For each endpoint, the service

provisioner specifies the N-PE device and the UNI on that device that connects the

customer site to the N-PE device. The service order can also specify any additional

attributes that are configured in the service definition as editable in the service order.

These attributesmight include theVCID,MTU for theUNI,MTU for the connection across

the network, VLAN-ID, rate limiting bandwidth, and so forth.
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Related
Documentation

Creating an E-Line Service Order on page 784•

• Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827

• Creating a Point-to-Multipoint E-LAN Service Order on page 847

Creating an E-Line ATM or TDMPseudowire Service Order

To create an E-Line service order, complete the following tasks in order:

1. Selecting the Service Definition on page 774

2. Entering General/Connectivity Settings Information on page 775

3. Specifying Endpoint Information on page 778

4. Specifying Template Settings on page 781

5. Reviewing the Configured Settings on page 782

6. Deploying the New Service on page 783

Selecting the Service Definition

To select a service definition on which to base the new service order:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Connectivity Services Director user interface, click the Deploy icon in the

Connectivity Services Director banner. The functionalities that you can configure in

this mode are displayed in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. From the Tasks pane, select Service Provisioning >Manage Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

From theManage Network Services page, select New > E-Line Service Order.

The Create E-Line Service Order page displays an inventory of all available E-Line

service definitions.

The General/Connectivity Settings panel appears initially in the right panel, as shown

in the example.
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NOTE: In the service order creation wizard for E-Line services, the search
function has been enhanced to enable you to easily sort and filter the
parameters that are of interest and relevance for the services you want
to configure. The Choose Customer dialog box that is displayedwhen you
click Select beside the Customer field contains the Search box, which
enables you to perform a search on all of the columns. The search utility
that ispresent in theChooseServiceDefinitiondialogbox that isdisplayed
when you click Select beside the Service Definition field enables you to
search by Name, Created by, and Signaling columns; search utility is not
supported for other columns in the dialog box. The search box that is
present in the Choose Endpoints dialog box when you click Select beside
the PE Device and UNI Interface fields enables search across all the
columns displayed in the dialog box. For any string-based search (which
shows strings thatmatch any part of the text you enter in the search box),
only the Name, Platform, and OS Version columns are supported. For
exact string-based search (which shows strings that exactly match the
text you enter in the search box), the IPAddress, State, andManage State
columns are supported.

5. From theServiceDefinition field, clickSelect to choose the service definition youwant

to base your service order on. The Choose Service Definition inventory page displays

a view of only those published service definitions designed to work with the type of

services you need.

Based on the fields or parameters that you defined in the service definition to be

enabled for modification in the service order, the corresponding fields are available

for editing. The fields that are disabled for modification in the service order can only

be edited in the service definition.

6. Select the check box beside the service definition that youwant to associate with the

service order, and clickOK.

7. ClickView to open a popup dialog box that displays the details of the selected service

definition. The service definition properties, such as the name, signaling type (LDP or

BGP), service type (Ethernet, ATM, or TDM), are displayed. The interface-specific

attributes, such as rate-limiting details, encapsulation, and VLAN tags, are also

displayed in the dialog box. Close the dialog box to return to the service order creation

wizard.

If a template is attached to the service definition on which the service order is based,

you can invoke the template editor from the Template page of the wizard.

Entering General/Connectivity Settings Information

The General Settings panel is displayed on the right side of the service order window.
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To configure general settings in theGeneral Settings/Connectivity Settings panel, provide

the following information:

1. In the Name box, enter a unique name for the service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for a service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “vpls”, as the name of a service order.

2. In the Customer box, select the customer requesting the service.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 697.

3. In the Description box, enter a description of the service. This description appears in

information windows about the request or service instance created from the request.

4. In theConnectivitySettingsbox, specify theMTUfor theconnectionacross thenetwork.

The service definition can constrain the MTU to a specific value or allow the service

provisioner to override it in the service order. In this example, the service definition

sets the MTU, but allows the service provisioner to change the value.

Whenyouadvance to thenext step in creating your serviceorder, your newconnectivity

settings appear under the Connectivity image in the main graphic and new general

information is added to the text above the cloud. If you have incomplete or invalid

information in the General/Connectivity Settings panel, a warning icon appears next

to the cloud image.

5. Specify the virtual path identifier (VPI). This field is available only if you have selected

an ATM E-Line service definition.

The combination of theVPI andVCIDdefines the next destination for a cell in theATM

network.

Range: 0 through 255

6. Specify the virtual channel identifier (VCI). This field is available only if you have

selected an ATM E-Line service definition.

Range: 0 through 65535

7. Enter the virtual circuit identifier (VCID). This integer uniquely identifies the virtual

circuit that the service uses.
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The VCID can be set either automatically by the Junos Space software, or the service

provisioner can set it manually in the service order. The service definition can force

the system to pick the VCID, force the service provisioner to pick the VCID, or allow

the service provisioner to override the settings in the service definition.

We recommend allocating the VCID automatically; however, service providers with

their own systems for allocating VCIDs can choose themanual setting.

By default, the systempicks a VCID from its pool automatically, but allows the service

provisioner to override this value in the service order. The form expands to include an

additional field for typing the VCIDmanually.

This field is displayed only if the selected definition’s signaling type is LDP. You cannot

edit this field if you have not selected the Editable in Service Order in the service

definition.

8. Select theMCAPS check box to add the run show aps extensive command.

NOTE: This check box is available only in an LDP-based E-Line service
order with PWResilency enabled. The Interface typemust be ATM/TDM.

Formore informationonMC-APS, see “Multi-ChassisAutomaticProtectionSwitching

Overview” on page 100.

9. Enter the Route Distinguisher value.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This field is displayed only if the selected definition’s signaling type isBGP. You cannot

edit this field if you have not selected the Editable in Service Order in the service

definition.

10. Specify the Route Target.

1. Clear the Auto pick Route Target check box.

2. Enter the Route Target value.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This field is displayed only if the selected definition’s signaling type isBGP. You cannot

edit this field if you have not selected the Editable in Service Order in the service

definition.

11. Provideendpoint information for the first endpoint: click theEndpointAgraphicelement

or click Next.

The Endpoint Settings form appears in the right panel.
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Specifying Endpoint Information

OnM Series, MX Series, and ACX routers:

• The ATM interfaces always appear as an AT interface.

• The TDM interfaces with SAToP encapsulation always appear as a T1 interface; TDM

interfaces with CESoPSN encapsulation always appear as a DS interfaces.

To configure the endpoint settings:

1. In the PE Device box, select the N-PE device you want to use for the first endpoint.

From theChoose Endpoints dialog box that appears, select the devices that youwant

to participate in the service. Use the multiple selection feature to select one or more

devices. The lower part of thedialogbox refreshes todisplay the interfaces associated

with the selected device. Select the check boxes next to the interfaces you want to

associate with the service order.

NOTE: In the Choose Endpoints dialog box, you can sort and segregate
the devices and their corresponding interfaces based on the roles of the
devices to easily and quickly view only the devices of interest. Click the
down arrow on the Filter Rolemenu, and select P2E to view only the

provider edgedevices,P to viewonly the provider devices, and L2E to view

only Layer 2 Ethernet devices.

If you are unsure about which PE device to choose, go to the Prestaging Devices

workspace landingpage,whichshowscapacity informationaboutUNIsonPEdevices.

Youmust pick a device that has available UNIs.

This step is required for all service orders.

2. In theUNI interfacebox, select aUNI. The list includesallUNIs availableon the selected

device.

You can enter the description of the UNI interface in the UNI description field.

If you have selected the Enable Multi Segment Pseudowire check box in the service

definition, theUNI interfaceof thesecondendpoint lists the interworking (iw) interfaces

only.

For more information on E-Line pseudowire stitching, see “Stitching Two E-Line

Pseudowires” on page 807.

This step is required for all service orders.

Youcannot change the typeofPhysical IFencapsulation. This value is set in the service

definition.

Based on the type ofPhysical IF encapsulation, the corresponding fields are displayed.

For example, if the Physical IF encapsulation is CESoPSN, the following fields are

displayed:
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• Jitter buffer

• Idle pattern

• Excessive packet loss rate

NOTE: These fields are editable if you have selected the Editable in

Service Order check box in the service definition.

3. Specify the stitching unit.

Default: 0

Range: 0 through 255

NOTE: This field is displayed only in the second endpoint. Youmust have
selected the Enable Multi Segment Pseudowire check box in the service

definition.

4. If the Physical IF encapsulation type is CESoPSN, specify the Packetization Latency.

Packetization latency is the time required to create packets.

Range: 1000 through 8000microseconds

NOTE: Based on the number of time slots, the default Packetization
Latency value is as follows:

• If the number of time slots is equal to 1, the default value is either 5000
microseconds or 8000microseconds.

• If the number of time slots is 2, 3, or 4, the default value is 4000
microseconds.

• If the number of time slots is greater than 4, the default value is 1000
microseconds.

5. In the LSP tunnel name box, select the LSP tunnel you want to use for this device.

Youmust supply an LSP tunnel name for the interface on BX devices. If one is not

defined, youmust first use the Transport Activate application to create an LSP on the

BX7000 Gateway.

On the M Series router, the LSP tunnel is chosen automatically.

This field is displayed only if the selected definition’s signaling type is LDP.

6. Specify the cell bundle size. The value of the cell bundle size can be from 1 through

34.
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7. If you have selected Transport VLAN List as the customer traffic type in the selected

service definition, youmust specify either a single value or a range of values that are

separated by commas.

8. If you have enabled the Enable PWResiliency check box in the selected service

definition, fill in the following fields in the Backup settings and Resiliency settings:

• Enable

• PE device

• UNI interface

• MTU (Bytes)

• LSP tunnel name

• Revert time (sec)

• Switch Over Delay (sec)

For more information of pseudowire redundancy, see “Redundant Pseudowires for

Layer 2 Circuits and VPLS” on page 95.

9. If you selected the Static pseudowire check box in the selected service definition, you

need to specify theOutgoing label for the static pseudowire.

Range: 1000000 through 1048575

In case of multi-segment pseudowire, you have to specify a new outgoing label for

the second segment. The outgoing label for the second segment is not prepopulated

from the first segment.

NOTE: Youmustmanually compare the encapsulation, TDMbit rate, and
control word of the router with the remote peer router and ensure that
theseparametersmatch;otherwise thestaticpseudowiremightnotwork.

10. Select the Enable send-oamconfig check box to enable the send-oam command. You

can select or clear this check box even in the Modify Service page.

11. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

The service order that you have created is listed in the Manage Service Orders page.
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Specifying Template Settings

The Template Settings page of the service order creation andmodification wizards

enables you to associate service templates with an E-Line, E-LAN, and IP service order.

You can apply only the templates that are previously configured in a service definition

with the corresponding service order. The Template Settings page is available in the

service order wizard only if the service definition that you selected to apply to the service

order containsa service template.Otherwise, theTemplateSettingspage is notdisplayed

in the service order wizard. You can perform template operations for all endpoints in a

service order.

If you defined a service template as the default service template, it is attached to the

endpoint by default. You have the flexibility to create and provision a dynamic attribute

in a service template. You canmark an attribute of a service template as dynamic, and

you can obtain the values for these dynamic attributes from a specific device. To create

a dynamic attribute, youmust first mark an attribute of a service template as dynamic

and then specify the device XPath for the dynamic attribute.

The Template Settings page is displayed before the Review page, which is the final step

of the service order wizard.

In the Service Settings page, from the Select Service Definition field of the service order

creation wizard, you can double-click a service definition name displayed in the table to

view the details of the definition in a popup dialog box. You can use this information to

determine if the service definition is appropriate for your deployment needs. To filter and

sort the display of service templates, enter the nameof the template as amatch criterion

in the Search box and click the Search icon. The page refreshes to display only the

template names that match with the search term. You can use the paging controls to

navigate across multiple pages of templates as necessary.

All the tasks that you can performwith service templates are presented in the Template

Settings page. The page is divided into three panes. The top half of the page displays a

table of selected endpoints. All the endpoints or UNIs that you selected in the preceding

pages of the service order wizard are displayed in this table. You can configure the

template pertaining to only one endpoint at a point in time. If the selected endpoints (in

previous pages of the wizard) contained amanually-entered unit number, that number

is displayed in the tableof selectedendpoints.Otherwise, theAuto-pick label is displayed.

The lower half of the page is divided into two panes. The left pane displays the template

selection table for the endpoint you selected. All the templates associated with the

service definition are displayed. You can add and delete templates using the template

selection table. The right pane displays all the parameters that you canmodify for a

selected service template. All such editable paramters are displayed in a consolidated

form of a configuration page. This pane is displayed after you select a template. If any

configuration parameter in template is set as a service-specific value, such attributes

are not displayed in this pane.
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To associate a service template with a service order:

1. ClickAdd to include a service template for the endpoint. A dialog box is displayedwith

the list of service templatesassociatedwith the servicedefinition that is used to create

the service order. The templates selected in this dialog box are displayed in the

Template Selection table for the specified endpoint. Such templates are considered

to be attached to that endpoint.

If you specified a template as adefault template during the service definition creation,

the template is displayedbydefault in the template selection table. You canassociate

non-default templates with the serviceo rder by clicking the Add button.

2. Click the link in the template name to open the Template Details dialog box. The

template settings are displayed in the popup dialog box. For the selected template,

the Configuration Page is displayed in the lower-right pane of the Template Settings

page.

3. Modify any template-specific service components as necessary.

4. Click Save to submit the changes.

5. Select a template from the Template Selection table, and click Delete to remove the

template from being associated with the service order for a particular endpoint.

Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.
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NOTE: On the Review page, in the Service Templates section, the names of
the service templates with which the service definition is associated are
displayed. The Default Service Template column indicates whether the
attached template is the default template.

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

3. Click Finish to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

The service order inventory window appears.

Deploying the New Service

To deploy the new service:

1. Perform one of the following actions from the Deploy mode of the Service View of

Connectivity Services Director:

• To deploy the service immediately, select Deploy now, then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

2. Tomonitor the progress and status of the deployment, use the Jobs workspace.

Related
Documentation

Creating a Service Order on page 773•

• Creating an E-Line Service Order on page 784

• Creating a Bulk-Provisioning Service Order for Pseudowire Services on page 797

• Creating an Inverse Multiplexing for ATM Service Order on page 799

• Provisioning a Single-Ended E-Line Service on page 803

• Selecting Specific LSPs for Connectivity Services on page 804
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Creating an E-Line Service Order

To create an E-Line service order, complete the following tasks in order:

1. Selecting the Service Type on page 784

2. Entering General Settings Information on page 785

3. Specifying the Connectivity on page 787

4. Specifying QoS Settings on page 788

5. Specifying OAM Settings on page 789

6. Specifying Endpoint Information on page 789

7. Specifying Template Settings on page 794

8. Reviewing the Configured Settings on page 795

9. Specifying Connectivity and Endpoint Information for Managing VLANs on page 796

10. Deploying and Monitoring the Progress of the New Service on page 796

Selecting the Service Type

Awizard is available to create a service order in an intuitive and easily-navigable format.

The settings that you can configure in the service order are organized in separate pages

of the wizard, which you can launch by clicking the appropriate buttons at the top of the

Create a Service Order page. Alternatively, you can proceed to the corresponding

setting-related pages by clicking the Back and Next buttons at any point in the wizard

during the creation of the service order.

To select the service type as E-Line to base the new service order:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. From the Tasks pane, select Service Provisioning >Manage Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.
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5. From theManage Network Services page, click the New icon at the top of the lower

half of the page that displays previously created service orders. The Select Service

Type dialog box appears.

6. Select E-Line to create an E-Line service order.

The General/Connectivity Settings panel appears initially in the right panel, as shown

in the example.

NOTE: In the service order creation wizard for E-Line services, the search
function has been enhanced to enable you to easily sort and filter the
parameters that are of interest and relevance for the services you want
to configure. The Choose Customer dialog box that is displayedwhen you
click Select beside the Customer field contains the Search box, which
enables you to perform a search on all of the columns. The search utility
that ispresent in theChooseServiceDefinitiondialogbox that isdisplayed
when you click Select beside the Service Definition field enables you to
search by Name, Created by, and Signaling columns; search utility is not
supported for other columns in the dialog box. The search box that is
present in the Choose Endpoints dialog box when you click Select beside
the PE Device and UNI Interface fields enables search across all the
columns displayed in the dialog box. For any string-based search (which
shows strings thatmatch any part of the text you enter in the search box),
only the Name, Platform, and OS Version columns are supported. For
exact string-based search (which shows strings that exactly match the
text you enter in the search box), the IPAddress, State, andManage State
columns are supported.

Entering General Settings Information

To enter general parameters related to a service order in the General Settings box of the

General/Connectivity Settings page of the wizard:

1. In the Name field, enter a unique name for the service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for an E-Line service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “vpls”, as the name of a service order.

2. From theServiceDefinition field, clickSelect to choose the service definition youwant

to base your service order on. The Choose Service Definition inventory page displays

a view of only those published service definitions designed to work with the type of

services you need.
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Based on the fields or parameters that you defined in the service definition to be

enabled for modification in the service order, the corresponding fields are available

for editing. The fields that are disabled for modification in the service order can only

be edited in the service definition.

3. Select the check box beside the service definition that youwant to associate with the

service order, and clickOK.

4. ClickView to open a popup dialog box that displays the details of the selected service

definition. The service definition properties, such as the name, signaling type (LDP or

BGP), service type (Ethernet psuedowire, ATM, or TDM), are displayed. The

interface-specific attributes, such as rate-limiting details, encapsulation, and VLAN

tags, are also displayed in the dialog box. Close the dialog box to return to the service

order creation wizard.

If a template is attached to the service definition on which the service order is based,

you can invoke the template editor from the Template page of the wizard.

5. (Optional) Select the Enable LSP Association check box to create or associate LSPs.

Select the Create LSP check box to import an existing LSP service definition and also

select an LSP name pattern.

NOTE: You can also create an LSP name pattern of your preference,
instead of using an existing pre-defined pattern.

For informationaboutcreatinganLSPnamepattern, see “CreatingaName
Pattern for LSPs in the Service Order” on page 1643.

Select the Associate LSP check box to associate an existing LSP.

NOTE: The Enable LSP Association check box is not available on the
General Settings page if the signaling type is LDP.

6. In the Customer field, select the customer requesting the service.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 697.

7. In the Description field, enter a description of the service that you want to appear in

the request or in a service instance created from the request.

This description is displayed in the Manage Service Order page.

8. Configure connectivity settings. See “Specifying the Connectivity” on page 787.
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Specifying the Connectivity

In the Connectivity Settings box of the General/Connectivity Settings page of the wizard,

specify VCID and MTU information.

1. Specify the VCID. This is an integer that uniquely identifies the virtual circuit that the

service will use.

The VCID can be either set automatically by the Junos Space software, or it can be

set manually by the service provisioner in the service order. The service definition can

force the system to pick the VCID, force the service provisioner to pick the VCID, or

allow the service provisioner to override the settings in the service definition.

This field is displayed only if the selected definition’s signaling type is LDP. You cannot

edit this field if you have not selected Editable inServiceOrder in the service definition.

We recommend allocating the VCID automatically; however, service providers with

their own systems for allocating VCIDs can choose themanual setting.

In the previous example, by default, the system picks a VCID from its pool

automatically, but allows the service provisioner to override this value in the service

order. Clear the check box to override the service definition setting. The form expands

to include an additional field for entering the VCIDmanually.

2. Specify the MTU for the connection across the network.

The service definition can constrain the MTU to a specific value or allow the service

provisioner to override it in the service order. In this example, the service definition

sets the MTU, but allows the service provisioner to change the value.

Whenyouadvance to thenext step in creating your serviceorder, your newconnectivity

settings appear under the Connectivity image in the main graphic and new general

information is added to the text above the cloud. If you have incomplete or invalid

information in the General/Connectivity Settings panel, a warning icon appears next

to the cloud image.

3. Select the Enable MC LAG check box if you want the following configuration to be

pushed to the selected endpoint.

set protocols l2circuit neighbor x.x.x.x interface interface name
pseudowire-status-tlv

NOTE: This check box is available only for an LDP-based E-Line service
order with PWResilency enabled. The Interface typemust be Ethernet.

4. Specify the Route Distinguisher value.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This field is displayed only if the selected definition’s signaling type isBGP. You cannot

edit this field if you have not selected the Editable in Service Order check box in the

service definition.
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5. To specify the Route Target, clear the Auto pick Route Target check box.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This field is displayed only if the selected definition’s signaling type isBGP. You cannot

edit this field if you have not selected the Editable in Service Order check box in the

service definition.

6. TheVLANnormalizationdisplays the informationbasedontheoptionyouhaveselected

in the service definition.

7. If VLAN normalization is Normalize to Dot1q tag, specify the VLAN Tag to stack.

Default: 1

Range: 1 through 4094

8. If VLAN normalization is Normalize to QinQ tags, specify the Normalize – Outer VLAN

Tag and Normalize – Inner VLAN Tag fields.

Default: 1

Range: 1 through 4094

9. To provide endpoint information for the first endpoint, click the Endpoint A button or

click Next.

The Endpoint Settings form appears.

10. If you have enabled QoS, configure QoS settings. See “Specifying QoS Settings” on

page 788.

If QoS is not enabled, configure endpoint settings. See “Specifying Endpoint

Information” on page 789.

Specifying QoS Settings

NOTE: You can specify QoS parameters for an E-Line service only in the
servicedefinition.This sectionexplains theQoSattributes thatcanbedefined
or modified in a service definition. These settings cannot bemodified in the
service order.

If QoS is enabled on the service definition, configure the QoS Settings of the

General/Connectivity Settings panel.

1. In the CoS profile field, select a profile from the list.

TheCoSprofile list displays theCoSprofiles thatare currently configured in theManage

CoS Profiles page of the Connectivity Services Director application.

A CoS profile classifies traffic into defined service groups to provide the special

treatment of traffic across the network service.

2. Configure endpoint information. See “Specifying Endpoint Information” on page 789.
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Specifying OAMSettings

By default, OAM is enabled on the service definition. Enter the following information in

the OAM Settings of the General Settings panel:

1. In theOAMProfile field, select a profile from the list.

NOTE: ForOAMSettings, if you specify aCFMprofile (for example, a CFM
action profile with remote MEP), or an SLA-Iterator profile, first youmust
ensure that the profile is attached to the same device upon which you
intend to deploy the E-Line service order. If the profile is not previously
attached (using the OAM Insight application), it is not on the device to
support the service order.

To remove a previously associated CFM definition or OAM profile from a
service definition, click the Detach button next to the OAMProfile field to

remove the association. To associate a newOAM profile, youmust
dissociate the existing OAM profile and attach a fresh OAM profile.
Detaching anOAMprofile is enabledwhen youmodify a service or service
order.

NOTE: For Juniper Networks PTX3000 Packet Transport Routers, if you
attach a CFMDefinition to the service order, the CFM session operates for
MEPs in either the Up or Down direction when the service is deployed.

2. Click CFMDetails beside the OAMProfile field to view the profile configuration details

in a dialog box.

3. Configure endpoint information. See “Specifying Endpoint Information” on page 789.

Specifying Endpoint Information

If a service template is attached to the service definition, a link to that template is listed

in the Template page of the creation of service order wizard. The service templates

settings are same for both the endpoints. For instructions on working with service

templates in service orders, see “Creating a Service Order Based on a Service Definition

with a Template” on page 927.

Some of the fields differ from one interface type to another and also differ depending

on permissions assigned in the service definition.

To specify endpoint information:
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1. In the PE device field, select the N-PE device you want to use for the first endpoint.

If you are unsure about which PE device to choose, go to the Prestaging Devices

workspace landingpage,whichshowscapacity informationaboutUNIsonPEdevices.

Youmust pick a device that has available UNIs.

This step is required for all service orders.

You can configure the primary endpoint device as an unmanaged device. With the

primary endpoint as an unmanaged device, the following combinations of primary

and backup endpoints are supported:

• Primary (endpoint Z) as an unmanaged device and no backup (endpoint Z) device.

• Primary (endpoint Z) as an unmanaged device and backup (endpoint Z) as a

managed device.

The following combinations are not supported:

• Primary (endpoint Z) as an unmanaged device and backup (endpoint Z) as an

unmanaged device.

• Primary (endpoint Z) as amanaged device and backup (endpoint Z) as an

unmanaged device.

You cannot configure the backup endpoint Z as an unmanaged device using

Connectivity Services Director. P2P Resiliency cannot be configured if any one of the

endpoints is unmanaged. A validation is performed for the supported combinations

of endpoints.

NOTE: If this endpoint is a third-party device, select Unmanaged device

from the PE Device field list. You need to specify only the IP Address and

UnmanagedInterface. Formore information, seeProvisioningaSingle-Ended

Point-to-Point Service.

2. In the UNI interface field, select a UNI.

The list includes all UNIs available on the selected device.

This step is mandatory for all service orders.

If you have selected the Enable Multi Segment Pseudowire check box in the service

definition, theUNI interfaceof thesecondendpoint lists the interworking (iw) interfaces

only.

For more information on E-Line pseudowire stitching, see “Stitching Two E-Line

Pseudowires” on page 807.

You can enter the description of the UNI interface in the UNI description field.

3. (Optional) If you have selected the Enable Multihoming check box in the service

definition, the Backup Settings box is displayed. Youmust select the PE device and

UNI Interface.
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TheMultihomingmode is based on themode selected in the service definition.

4. Specify the stitching unit.

Default: 0

Range: 0 through 255

NOTE: This field is displayed only in the second endpoint. Youmust have
selected the Enable Multi Segment Pseudowire check box in the service

definition.

5. In the Traffic type field, designatewhether youwant the service to transport all traffic,

a single VLAN, a range of VLANs, or a list of VLANs.

Although this field is present for all service orders, the value is predetermined for some

types of interfaces. For example, a port-to-port interface always transports all traffic.

Moreover, for interface types that do support multiple traffic types, you can select

this value only if the service definition allows you to do so.

If you are allowed to select this field, depending on the interface type, you can choose

from the following values:

• Transport single vlan

• Transport vlan range

• Transport all traffic

• Transport vlan list

NOTE: The Physical IF encapsulation and Logical IF encapsulation fields

are not selectable. These values are set in the service definition.

The Vlan Range formanual input field displays the VLAN range that is specified in the

service definition.

If the Ethernet option is do1q or qinq, and the VLAN selection is Transport single vlan

type, theVlanRange formanual input range is used for validation ofmanually entered

VLAN.

If the Ethernet option is qinq, and the VLAN selection is Transport vlan range type, the

Vlan Range for manual input range is used for validation of manually entered outer

VLAN.

If the Ethernet option is do1q, and the VLAN selection is Transport vlan range type, the

VlanRangeformanual input range isused for validationofmanually enteredcustomer's

VLAN start and VLAN end.
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If the Ethernet option is do1q, and the VLAN selection is Transport vlan range type, the

VlanRangeformanual input range isused for validationofmanually enteredcustomer's

VLAN start and VLAN end.

6. In the C-VLAN ID field (or VLAN ID field), enter the customer’s VLAN ID.

This field is mandatory for service orders that transport a single customer VLAN. The

ID is provided by the customer.

7. In the C-Vlan Start and C-Vlan End fields, specify the beginning and end of the range

of customer VLANs that you want the service to transport.

This field is mandatory for all services that transport a specific range of customer

VLANs. These VLAN IDs are provided by the customer.

8. Select the Auto pick VLAN ID check box to have the system choose a service VLAN ID

automatically.

This field is present only for interface types that provide double tagging; that is, only

forQ-in-Qendpoint interface types. If this field is not set, thenyoumust enter a service

VLAN IDmanually.

9. In the VLAN ID field, specify the service VLAN ID that you want be used to provide the

outer tag for the service.

This field is present only for interface types that provide double tagging, and only if

the Auto pick VLAN ID check box is not selected.

10. Specify whether the Autopick UNIT ID can be selected automatically or manually.

• To assign the UNIT ID automatically, select the Autopick UNIT ID check box.

• To assign the UNIT IDmanually, clear the Autopick UNIT ID check box.

The window expands to include the UNIT ID field. In the UNIT ID field, type a value.

Range: 1 through 1073741823

NOTE: You can edit this field only if you have selected the Editable in

Service Order check box for the VLAN ID selection in the service definition.

11. In theMTU (Bytes) field, specify the maximum transmission unit size for the UNI.

This field is present in all service orders. However, you can set this field only if the

service definition allows you to do so.

12. If you selected the Static pseudowire check box in the selected service definition, you

need to specify theOutgoing label for the static pseudowire.
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Range: 1000000 through 1048575

In case of multi-segment pseudowire, you have to specify a new outgoing label for

the second segment. The outgoing label for the second segment is not prepopulated

from the first segment.

NOTE: Youmustmanually compare the encapsulation, TDMbit rate, and
control word of the router with the remote peer router and ensure that
theseparametersmatch;otherwise thestaticpseudowiremightnotwork.

13. In the Bandwidth (Mbps) field, select a value from the list to limit the bandwidth of

the service you are creating.

This field is present only if bandwidth limiting is allowed by the service definition, and

is configurable in the service order only if the service definition allows you to do so.

When you click another graphic element in themain graphic area, the selected device

name and interface name appear beneath the endpoint image in the main graphic.

14. If you have enabled theEnablePWaccess toL3VPNnetwork check box in the selected

service definition, fill in the following fields in PW Stitching:

• L3 routing instance name—Specify the name of the Layer 3 routing instance.

• Autopick interface IP—If this field is enabled, specify IP block size and IP address

pool; otherwise specify the Interface IP address.

• Autopick peer unit—To select the logical system unit number automatically, select

the check box; otherwise specify the Peer unit name.

NOTE: These fields are available only if you have selected an LT interface
in the UNI interface.

15. If you have enabled the Enable PWResiliency check box in the selected service

definition, fill in the following fields in the Backup settings and Resiliency settings:

• Enable

• PE device

• UNI interface

• MTU (Bytes)

• LSP tunnel name

• Revert time (sec)

• Switch Over Delay (sec)
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For more information of pseudowire redundancy, see “Redundant Pseudowires for

Layer 2 Circuits and VPLS” on page 95.

16. Select the Enable send-oamconfig check box to enable the send-oam command. You

can enable or disable this check box even in the Modify Service page.

17. To provide endpoint information for the second endpoint, click the Endpoint Z button

(or click Next).

The Endpoint Settings form appears in the right panel for the second endpoint.

Complete this form as for the first endpoint (repeat Step 1 through Step 18).

18. Click Next to proceed to the last step of the wizard, which is to examine the specified

service attributes and submit the changes. Alternatively, click Back to navigate to the

previous step of the wizard.

Specifying Template Settings

The Template Settings page of the service order creation andmodification wizards

enables you to associate service templates with an E-Line, E-LAN, and IP service order.

You can apply only the templates that are previously configured in a service definition

with the corresponding service order. The Template Settings page is available in the

service order wizard only if the service definition that you selected to apply to the service

order containsa service template.Otherwise, theTemplateSettingspage is notdisplayed

in the service order wizard. You can perform template operations for all endpoints in a

service order.

If you defined a service template as the default service template, it is attached to the

endpoint by default. You have the flexibility to create and provision a dynamic attribute

in a service template. You canmark an attribute of a service template as dynamic, and

you can obtain the values for these dynamic attributes from a specific device. To create

a dynamic attribute, youmust first mark an attribute of a service template as dynamic

and then specify the device XPath for the dynamic attribute.

The Template Settings page is displayed before the Review page, which is the final step

of the service order wizard.

In the Service Settings page of the Select Service Definition field of the service order

creation wizard, you can double-click a service definition name displayed in the table to

view the details of the definition in a popup dialog box. You can use this information to

determine if the service definition is appropriate for your deployment needs. To filter and

sort the display of service templates, enter the nameof the template as amatch criterion

in the Search box and click the Search icon. The page refreshes to display only the

template names that match with the search term. You can use the paging controls to

navigate across multiple pages of templates as necessary.

All the tasks that you can performwith service templates are presented in the Template

Settings page. The page is divided into three panes. The top half of the page displays a

table of selected endpoints. All the endpoints or UNIs that you selected in the preceding
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pages of the service order wizard are displayed in this table. You can configure the

template pertaining to only one endpoint at a point in time. If the selected endpoints (in

previous pages of the wizard) contained amanually-entered unit number, that number

is displayed in the tableof selectedendpoints.Otherwise, theAuto-pick label is displayed.

The lower half of the page is divided into two panes. The left pane displays the template

selection table for the endpoint you selected. All the templates associated with the

service definition are displayed. You can add and delete templates using the template

selection table. The right pane displays all the parameters that you canmodify for a

selected service template. All such editable paramters are displayed in a consolidated

form of a configuration page. This pane is displayed after you select a template. If any

configuration parameter in template is set as a service-specific value, such attributes

are not displayed in this pane.

To associate a service template with a service order:

1. ClickAdd to include a service template for the endpoint. A dialog box is displayedwith

the list of service templatesassociatedwith the servicedefinition that is used to create

the service order. The templates selected in this dialog box are displayed in the

Template Selection table for the specified endpoint. Such templates are considered

to be attached to that endpoint.

If you specified a template as adefault template during the service definition creation,

the template is displayedbydefault in the template selection table. You canassociate

non-default templates with the serviceo rder by clicking the Add button.

2. Click the link in the template name to open the Template Details dialog box. The

template settings are displayed in the popup dialog box. For the selected template,

the Configuration Page is displayed in the lower-right pane of the Template Settings

page.

3. Modify any template-specific service components as necessary.

4. Click Save to submit the changes.

5. Select a template from the Template Selection table, and click Delete to remove the

template from being associated with the service order for a particular endpoint.

Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.

795Copyright © 2019, Juniper Networks, Inc.

Chapter 33: Service Provisioning: Managing E-Line Service Orders



NOTE: On the Review page, in the Service Templates section, the names of
the service templates with which the service definition is associated are
displayed. The Default Service Template column indicates whether the
attached template is the default template.

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

3. Click Finish to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

The service order inventory window appears.

Specifying Connectivity and Endpoint Information for Managing VLANs

The Connectivity Services Director application provides greater flexibility for provisioning

VLANs for E-Line service orders by extending the VLAN normalization options.

You can create logical interfaces that define both theOuter-VLAN-tag-to-stack protocol

ID and Inner-VLAN-tag-to-stack protocol ID. The following illustration shows the

General/Connectivitywindow. The Connectivity Settings panel displays the

Outer-VLAN-tag-to-stack and Inner-VLAN-tag-to-stack parameters.

Connectivity Services Director now enables you to manually select a value for theOuter

VLAN tag to stack and Inner VLAN tag to stack parameters for a service that specifies the

qinq Ethernet option.

The following illustration displays the service order Connectivity Settings based upon a

service definition that set the VLAN normalization parameter to Normalize to Dot1q tag.

For service orders that are based on service definitions that set the Ethernet option to

dot1q or qinq, theUnit ID parameter appears in the Logical IF Settings panel in the service

order Endpoint Settingswindow.

Deploying andMonitoring the Progress of the New Service

To deploy the new service:

1. Perform one of the following actions in the Deploy mode of the Service View of

Connectivity Services Director:
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• To deploy the service immediately, select Deploy now, then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

2. Tomonitor the progress and status of the deployment, use the Jobs workspace.

Related
Documentation

Creating a Service Order on page 773•

• Creating an E-Line ATM or TDM Pseudowire Service Order on page 774

• Creating a Bulk-Provisioning Service Order for Pseudowire Services on page 797

• Creating an Inverse Multiplexing for ATM Service Order on page 799

• Provisioning a Single-Ended E-Line Service on page 803

• Selecting Specific LSPs for Connectivity Services on page 804

Creating a Bulk-Provisioning Service Order for Pseudowire Services

Bulk provisioningallows for deviceswith similar configurations tobedeployedasagroup.

The groups can be defined based on some characteristic common to all of the devices

in a group, such as their functional role. Mobile backhaul deployments, for example, can

run into hundreds of thousands of devices. These devices are commonly grouped

according to their functional rules such as Cell Site Devices, Pre-aggregation or Hub-site

devices, Aggregation Devices, Edge Routers and so on. To use this feature, tags must be

defined and created so that groups can be selected. This feature is intended to simplify

deployments of large groups of devices.

Prerequisites

• You can create a bulk provisioning service order only using the Services Activation

Director GUI and not using the Connectivity Services Director GUI.

• ExistingE-Linepseudowire servicedefinitions thatwill beused for thebulk-provisioning

service order.

• Tags - Youmust have defined tags in the Prestaging workspace that you intend to use

for groups of devices for which you will be creating the bulk service order. If you do not

have tags already created, you can select Prestage Devices >ManageDevice Roles and

either select existing tags to apply to devices or create new tags.

Tobegin the bulk provisioning process, in theNetworkActivate task pane, selectPrestage

Devices >Manage Device Roles and choose a service definition from the list. Click on the

tag view of the inventory list.

1. Select the tag you want to use from the left Tag panel.

2. Select the devices you want to include in the tagged group.
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3. Click, Apply Tag.

4. In the Network Activate task pane, select ServiceDesign>ManageServiceDefinitions.

The Manage Services Definitions page displays a list of service definitions.

5. Right-clickon theE-Line servicedefinition, andselectCreateBulkE-LineServiceOrder.

The Create Bulk E-Line Service Order window appears.

6. In the Bulk E-Line provisioning window, define the settings for the service order.

ActionField

Provide a name for the bulk service orderName

Select the customer name from the list of defined customers.Customer

The options available in the VLAN normalization are based on the value set for the
Ethernet interface.

For information on VLAN normalization, see “Creating an E-Line Service Definition” on
page 585.

VLAN normalization

Specify the bandwidth for the endpointsBandwidth

Specify the MTU size in bytes.MTU (Bytes)

Select the service tag from the defined list. This tag will be applied to the services you
create.

Service tag

Provide a description for the service tag.Description

Defining the Endpoint Settings

To define the endpoint settings, you will define both the A endpoint and the Z endpoint.

As an example of how you can use the bulk provisioning and how the endpoints work, if you want to establish a hub-spoke
pseudowire between an Aggregation PE and a set of CSR devices, you can tag all the CSRs with a certain tag in theManage
Device Roles page. You can then select the PE device on the A end and the tag that you have already created for all the CSR
devices on the Z end. If the endpoint is a tag then you can provide a wild-card interface (for example, ge-0/*/*) that matches
all the devices under that tag.

Define the A End Settings

Select the device or tag from the defined list.PE Device/Tag

Select the UNI interface from the listUNI interface

VLANs are created as part of this process. Enter the beginning VLAN ID that you want
to use for creating the new service orders.

VLAN ID
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ActionField

Indicate how the VLAN IDs will be assigned for each of the new services. The number
ofVLANscreateddependson thenumberof newservices youare creating.Oneservice
order will be created for each device in the tag group.

VLAN ID increment

Specify the unit ID.

Range: 1 through 1073741823

UNIT ID

Indicate how the unit IDs are assigned for each of the new services. The number of
units created depends on the number of new services you are creating. One service
order will be created for each device in the tag group.

UNIT ID increment

Define the Z End Settings

Select the device or tag from the defined list.PE Device/Tag

Select the UNI interface from the listUNI interface

Enter the VLAN ID from the list of existing VLANs. VLAN range cannot be used for this
feature.

VLAN ID

Indicate how the VLAN IDVLAN ID increment

Specify the unit ID.

Range: 1 through 1073741823

UNIT ID

Indicate how the unit IDs are assigned for each of the new services. The number of
units created depends on the number of new services you are creating. One service
order will be created for each device in the tag group.

UNIT ID increment

7. When required information has been entered, click Create.

The service order that you have created is graphically represented in the topology. To

view the serviceorder that youhavecreated in the topology, selectPlatform>Network

Monitoring > Topology > Service > NA service order name. Select the service order to

view its parameters.

8. From the Deploy Servicewindow, select the deployment method you wish to use.

Related
Documentation

Creating an E-Line ATM or TDM Pseudowire Service Definition on page 604•

Creating an InverseMultiplexing for ATMService Order

Beforeyoucancreateaserviceorder that implements InverseMultiplexing forATM(IMA),

youmust preconfigure a T1 or E1 IMA Group interface (at-fpc/pic/g) on the devices upon
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which youwant to deploy the service, before you prestage the devices in the JunosSpace

Connectivity Services Director application.

To create an inverse multiplexing for ATM service order:

A wizard is available to create a service order in an intuitive and easily-navigable format.

The settings that you can configure in the service order are organized in separate pages

of the wizard, which you can launch by clicking the appropriate buttons at the top of the

Create a Service Order page. Alternatively, you can proceed to the corresponding

setting-related pages by clicking the Back and Next buttons at any point in the wizard

during the creation of the service order.

With the Service View selected and in theDeploymode of Connectivity Services Director,

from theNetwork Services > Connectivity task pane, selectServiceProvisioning>Deploy

Services.

The Manage Network Services page is displayed in the upper part of the right pane.

Click theNew icon at the topof the lower half of thepage that displays previously created

service orders. The Select Service Type dialog box appears. Do one the following

• Select E-Line to create an E-Line service order.

• Select E-LAN to create an E-LAN service order.

• Select IP to create an IP service order.

• Select Bulk E-Line to create a bulk E-Line service order.

1. SelectE-Line to createanE-Line serviceorder. TheCreateE-LineServiceOrderwindow

appears.

2. Select the service definition upon which you want to create the service order. Click

Next to move to the next page of the wizard. The left panel displays a representation

of theconnectionyouareconfiguring.The rightpaneldisplays theGeneral/Connectivity

Settings.

3. Fill in the fields in the General/Connectivity panel.
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NOTE: In the service order creation wizard for E-Line services, the search
function has been enhanced to enable you to easily sort and filter the
parameters that are of interest and relevance for the services you want
to configure. The Choose Customer dialog box that is displayedwhen you
click Select beside the Customer field contains the Search box, which
enables you to perform a search on all of the columns. The search utility
that ispresent in theChooseServiceDefinitiondialogbox that isdisplayed
when you click Select beside the Service Definition field enables you to
search by Name, Created by, and Signaling columns; search utility is not
supported for other columns in the dialog box. The search box that is
present in the Choose Endpoints dialog box when you click Select beside
the PE Device and UNI Interface fields enables search across all the
columns displayed in the dialog box. For any string-based search (which
shows strings thatmatch any part of the text you enter in the search box),
only the Name, Platform, and OS Version columns are supported. For
exact string-based search (which shows strings that exactly match the
text you enter in the search box), the IPAddress, State, andManage State
columns are supported.

4. Click Next. The Endpoint Settings panel for Endpoint A appears.

5. Fill in the Endpoint A settings. Ensure that you select a device on which a T1 or E1 IMA

Group interface was preconfigured.

6. Click Next. The Endpoint Settings panel for Endpoint Z appears.

7. Fill in the Endpoint Z settings. Ensure that you select a device on which a T1 or E1 IMA

Group interface was preconfigured.

8. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify. Click Back to return to the previous page of the wizard; else click Cancel to

discard the changes.

9. After you complete reviewing the settings, click Finish to complete the service order

creation.

10. Todeployor deactivate the serviceorder ondevices, click theDeploy icon in theService

View of the Connectivity Services Director banner, and from the Network Services >

Connectivity task pane, selectServiceProvisioning>DeployServices>ManageService

Orders > service order name. Select the service order to view its configuration

parameters, decommission the settingsapplied todevices, or deploy the serviceorder

to devices.
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11. Select the deployment option youwant from the top of the page that lists the created

service orders:

• Deploy now

• Schedule deploy (Specify the date and time.)

The Connectivity Services Director application displays the Job Detailswindow,

which includes a Job Details ID number.

12. in theNetwork Services >Connectivity viewpane, selectServiceProvisioning>Deploy

Services.

13. In theManage Network Serviceswindow, you can view the status of the service.

Related
Documentation

Creating an E-Line ATM or TDM Pseudowire Service Definition on page 604•

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052
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Provisioning a Single-Ended E-Line Service

You can create a point-to-point link between the end points of a managed device and

an unmanaged device. An unmanaged device is a third-party device. In cases where

interoperability with a third-party device is necessary, Junos Space allows you to define

the link between a Juniper Networks managed device and the third-party device. You

need to specify the IP address and the end point interface name of the unmanaged

device. The Junos Space does not validate the information of an unmanaged device. You

cannot configure an unmanaged device. The Junos Space pushes the configuration only

to managed devices.

Youcanconfigure theprimaryendpointdeviceasanunmanageddevice.With theprimary

endpoint as an unmanaged device, the following combinations of primary and backup

endpoints are supported:

• Primary (endpoint Z) as an unmanaged device and no backup (endpoint Z) device.

• Primary (endpoint Z) asanunmanageddeviceandbackup (endpoint Z) asamanaged

device.

The following combinations are not supported:

• Primary (endpoint Z) as an unmanaged device and backup (endpoint Z) as an

unmanaged device.

• Primary (endpoint Z) asamanageddeviceandbackup (endpoint Z) asanunmanaged

device.

You cannot configure thebackup endpoint Z as anunmanageddevice usingConnectivity

Services Director. P2P Resiliency cannot be configured if any one of the endpoints is

unmanaged. A validation is performed for the supported combinations of endpoints.

To create a point-to-point link to an end point that is not managed by Junos Space, in

the Network Services > Connectivity view pane, select Service Provisioning>Manage

Service Orders> New > E-Line. TheManage Service Orders page displays an inventory of

all available E-Line service definitions.

1. Select the service definition uponwhich youwant to base your service order from the

Service Definition field.

2. Specify the general/connectivity settings. For details on creating an E-Line service

order, see “Creating an E-Line Service Order” on page 784

3. Click Next to specify the endpoint settings.

• If this end point is N-PE device, select a device from the PE Device. Configure the

endpoint settings as mentioned in “Creating an E-Line Service Order” on page 784

• If this endpoint is a third-party device, selectUnmanageddevice from thePEDevice.
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Fill in the fields as indicated in the table:

ActionsField

Since the endpoint is a third-party device, select Unmanaged device from the list.PE Device

Specify the loopback IP address of the third-party device.

Range: 1.0.0.1 through 223.255.255.254, excluding 127.x.x.x

Loopback IP Address

Specify the end point interface nameof the unmanaged device, which is the third-party
device.

Unmanaged Interface

4. Click Next to specify another endpoint settings.

NOTE: Both the endpoints cannot be a third-party device.

5. To finish creating the service order, click Finish.

NOTE: Thefunctionalaudit isperformedonlyontheJuniperNetworksdevices
(managed devices). To perform a successful functional audit of an
unmanaged device, configure the following attributes of an unmanaged
device:

• Neighbor IP

• Virtual circuit ID

• Unit ID

• Encapsulation

• Filter

• Policer

Related
Documentation

Creating an E-Line Service Order on page 784•

Selecting Specific LSPs for Connectivity Services

This feature allows you to associate a policy with an E-Line service. This in turn attaches

the pseudowire to an LSP, which satisfies the conditions of the policy. The configuration

for the service order includes the LSP name as the Next hop name. The following topics

provide information on attaching an LSP and viewing its details:

• Associating an LSP with an E-Line Service on page 805

• Viewing LSP Details in a Service Order on page 805
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• Viewing LSP Details in a Service on page 806

• Viewing LSP Configuration Details on page 806

Associating an LSPwith an E-Line Service

To associate an LSP with an E-Line service:

1. Create an E-Line service order.

a. From Deploy mode of Service View, In the Network Services > Connectivity task

pane, select Service Provisioning > Deploy Services, and from theManage Network

Services page, select New > E-Line.

TheManage Network Services page displays an inventory of all available E-Line

services. For each selected service, youcanview theassociated serviceorders from

theManage Service Orders page in the lower part of the right pane.

b. Select the service definition youwant to base your service order on, and clickNext.

The General/Connectivity Settingswindow is displayed.

c. Specify the general/connectivity settings.

d. ClickNext. The Endpoint Settingswindow is displayed. You can now attach an LSP

tunnel to a service order. To provision the specific LSP, select an LSP tunnel from

the LSP tunnel.

NOTE: The LSP tunnel is not amandatory field. The service order is

created even if you do not specify the LSP tunnel name.

e. Click Next to configure another endpoint. To provision the specific LSP, select an

LSP tunnel from the LSP tunnel

f. To create an E-Line service order, click Finish.

For more information on creating an E-Line service order, see “Creating an E-Line

Service Order” on page 784

2. Deploy the E-Line service order.

The LSP is now associated with the E-Line service order.

Viewing LSP Details in a Service Order

From the Deploymode of Service View, In theNetwork Services >Connectivity task pane,

select Service Provisioning > Deploy Services. The Manage Network Services page is

displayed in the top part of the right pane, which displays all of the configured services.

TheManage Service Orders page is displayed in the bottom part of the right pane, which

displays all of the service orders associated with a service.
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To view the details of an E-Line service order, double-click an E-Line service order in the

Manage Service Orders inventory page. If an LSP is associated with an E-Line service

order, the Endpoint Detailswindow includes the following information:

• LSP tunnel name—Name of the LSP tunnel attached to the E-Line service order.

• Community name—Name of the community. A community is a group of destinations

that share a common property.

• Community member—One or more community members.

Viewing LSP Details in a Service

From the Deploymode of Service View, In theNetwork Services >Connectivity task pane,

select Service Provisioning > Deploy Services. The Manage Network Services page is

displayed in the top part of the right pane, which displays all of the configured services.

TheManage Service Orders page is displayed in the bottom part of the right pane, which

displays all of the service orders associated with a service.

To view the details of an E-Line service, double-click an E-Line service in theManage

Network Services inventory page.

If an LSP is associated with an E-Line service order, the Endpoint Details of an E-Line

service includes the information on the LSP.

NOTE: You cannot modify the LSP tunnel in a service.

Viewing LSP Configuration Details

In the Network Services > Connectivity task pane, select Service Provisioning > Deploy

Services. TheManageNetworkServicespage is displayed in the toppart of the rightpane,

whichdisplaysall of theconfiguredservices. TheManageServiceOrderspage isdisplayed

in the bottom part of the right pane, which displays all of the service orders associated

with a service.

From the Manage Network Services page, select a service and click the View Service

Configuration button at the top of the table of listed services.

If an LSP selection is provisioned, you can view the LSP selection configuration in the

Service Configurationwindow.

Related
Documentation

Creating an E-Line Service Order on page 784•
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Stitching Two E-Line Pseudowires

Amulti-segment pseudowire (MS-PW) is a static or dynamically configured set of two

or more contiguous pseudowire segments that behave and function as a single E-Line

pseudowire. Each end of an MS-PW, by definition, terminates on a T-PE.

Pseudowiresaredeployed in largenetworks.Suchnetworks typicallyencompasshundreds

or thousands of aggregation devices at the edge, each ofwhichwould be a provider edge

(PE). These networks can be partitioned into separate metro and core pseudowire

domains, with multi-segment pseudowires connecting endpoints across the various

domains. You can stitch two E-Line pseudowires.

To stitch two E-Line pseudowires:

1. Create an E-Line service definition.

In the General tab, youmust select the Enable Multi Segment Pseudowire check box

to enable multi-segment pseudowire.

For more information on creating an E-Line service definition, see Creating an E-Line

Service Definition.

2. Create an E-Line service order.

The fieldsdisplayed in theE-Lineserviceorderarebasedon theE-Lineservicedefinition

that you created inStep 1. In the secondendpoint settingspage, select an interworking

(iw) interface and specify the stitching unit.

For more information on creating an E-Line service order, see “Creating an E-Line

Service Order” on page 784.

3. Deploy the E-Line service order.

a. Click the Deploy icon in the Service View of the Connectivity Services Director

banner. The functionalities that you can configure in thismode are displayed in the

task pane. From the Network Services > Connectivity task pane, select Service

Provisioning > Deploy Services.

The Manage Network Services page is displayed in the top part of the right pane,

which displays all of the configured services. The Manage Service Orders page is

displayed in the bottom part of the right pane, which displays all of the service

orders associated with a service.

b. In the Manage Service Orders page, select the E-Line service order you created in

Step 2.

c. Select the Deploy now option button at the top of the page and clickOK.

The service order is deployed.
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4. In theManageServices inventory page, select the check box next to the E-Line service

that you created and select Actions > Stitch PWSegment. The Stitch PW Segment

inventory page is displayed.

The Stitch PW Segment inventory page lists only the E-Line service definitions with

the Enable Multi Segment Pseudowire check box enabled. This inventory pagemust

also list the E-Line service definition you created in Step 1.

5. In Build mode of Service View, from the Manage Service Definitions page, select an

E-Line service definition and click Next.

6. Specify the General Setting, Connectivity Settings, and Endpoints details. For more

information on these fields, see “Creating an E-Line Service Order” on page 784.

NOTE: The fields of the first endpoint are auto-filled. Notice that the
second endpoint fields of the service order you created in Step 2 and the
first endpoint fields of this service order are same.

7. Deploy the stitched service order.

a. Click the Deploy icon in the Service View of the Connectivity Services Director

banner. The functionalities that you can configure in thismode are displayed in the

task pane. From the Network Services > Connectivity task pane, select Service

Provisioning > Deploy Services.

The Manage Network Services page is displayed in the top part of the right pane,

which displays all of the configured services. The Manage Service Orders page is

displayed in the bottom part of the right pane, which displays all of the service

orders associated with a service.

b. In the Manage Service Orders page, select the E-Line service order you created in

Step 6.

c. Select the Deploy now option button at the top of the page and clickOk.

The service order is deployed.

The two E-Line pseudowires are stitched.

TheManage Services lists both services. The E-Line Service Details window displays the

Stitch PWSegment details.

NOTE: The number of pseudowire segments that you can stitch is limited to
two.

You can perform a functional audit to the first service only. You can view the details of

the stitched pseudowire in the Functional Audit Results window.
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Related
Documentation

Creating an E-Line ATM or TDM Pseudowire Service Order on page 774•

• Creating an E-Line Service Order on page 784

Deactivating a Service

Thisproceduredisablesa service for aparticular protocol that youhavepreviously created

on the network. By disabling a service, the traffic processing for the traversed packets is

impacted. In certain network topologies, youmight require a service-related settings to

be disabled for a certain period to perform troubleshooting or modification to the

traffic-handlingmethod, and youmight want to reactivate a disabled service later when

you have completed networkmaintenance and analysis work. In such a case, it might be

beneficial to use the deactivation functionality for a service. When you disable a service,

the configuration attributes associated with such a service are deactivated and

commented out in the device settings. The deactivated service is propagated to the

devices associated with the service order. To disable a service, the service must not

contain any pending or uncommitted changes. Also, the servicemust be in the Deployed

or Re-Activated state.

NOTE: Tomodify a service order, it must not be in the Deactivated state.

To deactivate a service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and

the bottom part of the right pane displays the Manage Service Orders page, with the

table of service orders.
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TIP: In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

6. From theManageNetwork Services page, select the check box next to the service you

want to deactivate.

7. Click thedownarrowon theActionmenu, above the tableof listed services, and select

Deactivate to disable the selected service. A dialog box is displayed prompting you to

confirm your action.

8. Do one of the following in the Confirmation dialog box:

• To deactivate the service immediately, select Deactivate now, and click Yes. If you

clickYes, apendingchange request is created for eachselectedservice.Alternatively,

if you click No, the deactivate operation is discarded.

• To deactivate the service at a later time, select Deactivate later, and select a date

and time for deployment, then click OK. The time field specifies the time kept by

the server, but in the time zone of the client. After scheduling the service order for

deactivation, the provisioning software begins validating the service order.

9. Use the Jobs workspace to monitor the outcome of the deployment.

Related
Documentation

Reactivating a Service on page 810•

• Force-Deploying a Service on page 812

• Decommissioning a Service on page 816

Reactivating a Service

After you disable a service to deactivate the configuration settings on devices mapped

to the service, youmight require the service settings to be reenabled after you have

modified the service parameters, either directly on the device or using the Connectivity

Services Director application. In such a case, you can use the reactivation functionality

to revive and activate the service properties on devices. To disable a service, the service

Copyright © 2019, Juniper Networks, Inc.810

Connectivity Services Director User Guide



must not contain any pending or uncommitted changes. Also, the servicemust be in the

Deactivated state.

To reactivate a service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP Ethernet service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and

the bottom part of the right pane displays the Manage Service Orders page, with the

table of service orders.

TIP: In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

6. From theManageNetwork Services page, select the check box next to the service you

want to reactivate.

7. Click the downarrowon theActionmenu, above the table of listed service orders, and

select Reactivate to reenable the selected service order. A dialog box is displayed

prompting you to confirm your action.
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8. Do one of the following in the Confirmation dialog box:

• To reactivate the service immediately, select Reactivate now, and click Yes. If you

click Yes, the selected service is activated immediately. Alternatively, if you click

No, the deactivate operation is discarded.

• To reactivate the service at a later time, select Reactivate later, and select a date

and time for reactivating, then click OK. The time field specifies the time kept by

the server, but in the time zone of the client.

9. Use the Jobs workspace to monitor the outcome of the deployment.

Related
Documentation

Deactivating a Service on page 809•

• Force-Deploying a Service on page 812

• Decommissioning a Service on page 816

Force-Deploying a Service

When a service fails a configuration audit because configuration changes on a PE device

do notmatch the configuration required for the service, you can force-deploy the service

to push the configuration to the device.

Force deployment pushes the same configuration to the device that was pushed during

thedeployment of the service, thus allowing theoperator to recover fromastate inwhich

the configuration on the device was lost or changed out-of-band.

The validation before generating the configuration for a force-deployed service orderwill

be performed against the current configuration on the device and the configuration is

not pushed if the validation fails. If the forced deployment is unable to push the

configuration again, then youmight need to manually configure the device.

This procedure forces deployment of a service on the network.

You cannot force-deploy an invalid service order.

To schedule a service for forced deployment:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.
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• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and

the bottom part of the right pane displays the Manage Service Orders page, with the

table of service orders.

6. From theManageNetwork Services page, select the check box next to the service you

want to forcibly deploy.

TIP: In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

The top pane displays information about the services that have been previously

created, such as the nameof the service, the functional audit status, the performance

management status, and the status of the service. You canmodify the properties of

the service, conduct a functional or configuration audit, force-deploy or deactivate

the service, and view alarms associated with a particular service order for debugging

and corrective action. Services can be in one of the following service states:

• Completed—The service order has been successfully deployed.

• Scheduled for deployment—Theserviceprovisioner has scheduled the serviceorder

for deployment.

• Deployment Failed—An attempted service deployment was not successfully

completed or failed an audit.

• In Progress—The Connectivity Services Director application is in the process of

deploying the service.

• Requested—The service provisioner has created the service order, but has not yet

attempted to deploy it or schedule it for deployment.

• Invalid—The service order is not valid.

7. Open the Actionsmenu and click Force Deploy Service.

The Schedule Force Deploymentwindow appears.
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8. To deploy the service immediately, select Force deploy now, and clickOK .

To deploy the service at a later time, select Force deploy later, select a date and time

for deployment, then clickOK.

The time field specifies the time kept by the server, but in the time zone of the client.

After scheduling the service order for deployment, the provisioning software begins

validating the service order.

9. Use the Jobs workspace to monitor the outcome of the forced deployment.

Related
Documentation

Deactivating a Service on page 809•

• Reactivating a Service on page 810

• Decommissioning a Service on page 816

Recovering a Service Definition through Force Upload

You can use the force-upload feature to overwrite the service definitions that were

recoveredusing theservice recovery featureanddonotcontain thechangesmade through

CLI configuration or through templates. You do this by creating a service definition

containing templates thatmatches theconfiguration, anduploading it to theConnectivity

Services Director application.

NOTE: You use service recovery tomanage a service on the device. You can
only upload data which is part of the service definition. The Force Upload

feature is used to upload templates associated with the service definition.

NOTE: You can use templates to recover changesmade through the CLI
configuration. You use the Force Upload feature to upload a template for one

or more endpoints associated with the service.

In Connectivity Services Director Release 2.0 and earlier, you cannot recover changes

made to service definitions through CLI configuration or through templates.

To perform the force-upload action:

1. In the Connectivity Services Director Application, select Service View from the Views

list.

The workspaces applicable to the services are displayed.

2. Click the Deploy tab in the Task Categories banner.

The features that you can configure in this mode are displayed in the Tasks pane.
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3. From the Service View pane, click Network Services.

The tasks you can perform are displayed in the Tasks pane.

4. From the Tasks pane, select Key Tasks >Manage Services.

TheManage Network Services page is displayed.

5. Select the service you want to force-upload by selecting the check box next to the

service.

6. Click the Action tab and select Force Upload from the list of actions.

The Force Upload page is displayed.

7. From the Service Details table in the force upload page:

a. Click the arrow in theDeviceName column of the table. From the list that appears,

choose the device by selecting the check box next to it.

The device is added to the Device Name column.

NOTE: You can addmore than one device at a time.

b. Click the arrow in the Interfaces column of the table. From the list that appears,

you can select more than one interface associated with the device.

The interface is added to the Interfaces column.

NOTE: Selection of devices and interfaces is optional. If you select a
deviceoran interface, the templateassociatedwith theselecteddevice
or selected interface is uploaded.

If you select a device, all interfaces associated with that device are
uploaded. If you select a device and an interface, the interface
associated with that device is uploaded.

8. ClickOk to confirm force-upload.

The service definition is uploaded on the selected device and interface.

Related
Documentation

Deactivating a Service on page 809•

• Reactivating a Service on page 810

• Decommissioning a Service on page 816
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Decommissioning a Service

You can decommission a service that a customer no longer needs.

You cannot decommission a service if a service order requesting action on that service

is in the Requested, Scheduled, In Progress, or Invalid state. The Y.1731 monitoring

functionality must be in the disabled state (by selecting OAM > Y1731 > Start from the

taskpaneafter selecting the specified service in theViewpane inMonitormodeofService

View) for the service to be decommissioned.

To decommission a service:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

3. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

4. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and

thebottompart of the right panedisplays theManageServiceDeployment page,with

the table of service orders.

5. From theManageNetwork Services page, select the check box next to the service you

want to decommission.

TIP: In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.
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The top pane displays information about the services that have been previously

created, such as the nameof the service, the functional audit status, the performance

management status, and the status of the service. You canmodify the properties of

the service, conduct a functional or configuration audit, force-deploy or deactivate

the service, and view alarms associated with a particular service order for debugging

and corrective action. Services can be in one of the following service states:

• Completed—The service order has been successfully deployed.

• Scheduled for deployment—Theserviceprovisioner has scheduled the serviceorder

for deployment.

• Deployment Failed—An attempted service deployment was not successfully

completed or failed an audit.

• In Progress—The Connectivity Services Director application is in the process of

deploying the service.

• Requested—The service provisioner has created the service order, but has not yet

attempted to deploy it or schedule it for deployment.

• Invalid—The service order is not valid.

6. Open the Actionsmenu and click Decommission Service. Alternatively, select

Decommission by drilling down the Manage Services tree in the task pane.

The Schedule Decommissionwindow appears.

7. Do one of the following:

• To decommission the service immediately, selectDecommission now, and clickOK.

In theOrder Informationwindow, click the job ID of the decommission job.

The JobManagement page appears and shows a filtered view of the job inventory,

showing only the decommission job. See Viewing Jobs in the Junos Space Network

Application Platform User Guide for details.

NOTE: Alternatively, to display the JobManagement page, click the
System icon on the Connectivity Services Director banner, and select

Manage Jobs from the Tasks pane. You can also view the CSD

Deployment Jobs page in Deploymode of Service View by selecting the
View Deployment Jobs option in the task pane.

• To deploy the service at a later time, select Decommission later, select a date and

time to perform the operation, then clickOK.

If you decommission a service and the device confirms the deletion, the resources

associatedwith the service are immediately released and are available for reusewithout

waiting for the device synchronization. If you want the synchronization to happen before

the resources are released, you need to configure the decommissioning settings.

To configure the service decommissioning settings:
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1. SelectNetworkManagementPlatform>Administration>Applications. TheApplications

page displays the list of applications.

2. Right-click the Connectivity Services Director row and selectModify Applications

Settings. The Modify Connectivity Services Director Settings page displays the list of

parameters that can bemodified.

3. Select ServiceDecommission.

4. Specify values for the parameters in the Service Decommission page as described in

the following tables.

ActionField

Select this check box to wait for the device synchronization before resources are released.
To revert the decommissioning to the normal behavior clear this check box.

Wait for Device Sync Before
Releasing Resource

Specify thedevice synchronizationwaiting time.This is themaximumwait time tocomplete
thedevicesynchronization.After this timeduration, irrespectiveof thedevicesynchronization
status, the resources are released.

Default: 60 seconds

Range: 30 seconds to 300 seconds

Device sync wait time

5. ClickModify.

The service decommissioning settings are configured.

Related
Documentation

Viewing Service Order and Service Details on page 763•

Viewing Alarms for a Service

Activity on a network device consists of a series of events. A software component on the

network device, called an entity, is responsible for running the Simple Network

ManagementProtocol (SNMP) to log andmonitor these events. You can view thedetails

of alarms and events generated for a particular service order to examine and diagnose

theproblems thataregenerating thealarms.Thesealarmsprovideessential andcohesive

informationaboutsystemconditions,anydiscrepanciesandmalfunctioning,andprotocols

or components thatneed tobeexaminedanddebugged forbetter efficiencyandworking

capacity
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To view alarm and event details for a service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Junos Space user interface, click the Build icon in the Connectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

4. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and

thebottompart of the right panedisplays theManageServiceDeployment page,with

the table of service orders.

5. Fromthe taskpane, selectServiceProvisioning>DeployServices. The tableof services

is displayed.

6. Select the check box next to the service for which you want to view alarm details.

7. Click the View Alarms button, above the table of listed services.

The Alarm Detail dialog box is displayed.

8. ClickCloseafter you finishevaluating the information to return to theManageNetwork

Services page.

Related
Documentation

Alarm Detail Monitor (Service View) on page 1208•

Inline Editing of E-LAN and IP Service Orders

TheManageServiceOrderwindows thatenable theprovisioningof IPandE-LANservices

utilize grids as a navigation element to add sites and interfaces to a VPN. In addition,

grids are also used to select individual elements and configure any details that might be

required for such element to be part of the VPN. For example, a typical E-LAN

configuration workflow involves the following steps:

Entering general service parameters that apply to all nodes in theVPN, such as the name

of the service, signaling protocol used, route distinguishers, and route targets
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Selecting the set of nodes that participate in the VPN instance. Per-node parameters

can be configured by going through one node at a time, or though a bulk edit operation

by selecting and editing multiple nodes simultaneously.

Choosing the the set of interfaces on each node that connect to the customer devices

and configure the interface-specific characteristic of each interface. Similar to the node

settings, users can perform bulk edits to modify multiple interfaces at a time.

In your network environment, the E-LANand IP services, owing to theirmultipoint nature,

involve multiple devices and interfaces, which causes the configuration to require many

steps, and becomes cumbersome and complicated. To simplify and optimize the

configuration of multipoint services by allowing users to configure devices an interfaces

in a grid so that the operator can easily view andmodify themost important parameters

of the service, the inline editmechanism is implemented. Inlinemodification signifies the

ability to perform changes to previously defind settings in an easy and quick manner.

Embedded editing is enabled,which causes the grids showing the devices and interfaces

to becomemodifiable directly without the need to perform the process of highlighting,

editing, and saving the changes every time you want to edit a particular parameter. The

page that displays the configured settings presents as a form in which the fields or cells

of the table are editable.

Because the inline edit functionality enables you to directly edit the grids, only the salient

andmost important parameters for each service in the grids are displayed.

For parameters that you can enable or disable, you can select or clear the check boxes.

For parameters that require a value to be specified, an auto drop-down list is displayed

that enables you select a value from the list of available or configured values.

Advanced parameters can be continued to be edited by selecting the rows and clicking

Edit. A popup dialog box is displayedwith the list of all parameters supported for editing.

You can perform inline edits by double-clicking in the cell or the field under a particular

column in the table of displayed settings. The field becomes editable when you

double-click within the cell.

For an E-LAN service order, the following node settings can bemodified using the inline

edit method:

Service loopback, Hub, Mac learning, Mac Interface limit, Mac statistics

Parameter                   Editable       Dependencies
Node                       Yes             None
Status                      No             None
Platform                   No             None
Service loopback            Not available    None
Hub                         Yes             Only available for hub-spoke topologies
Mac learning                 Yes             None
Mac Interface limit        Yes             None
Mac statistics              Yes             None
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For an E-LAN service order, the following site settings can bemodified using the inline

edit method:

Node, Interface, Autopick Unit, Unit ID, VLAN tagging, Autopick VLAN ID, Outer VLAN ID,

Inner VLAN ID, Rate Limit, Interface Description

Parameter    Editable   Dependencies
Node      Yes          None
Interface          Yes          The Node name has to be configured
Status     No             None
Autopick Unit    Yes          None
Unit ID          Yes          Only enabled when autopick unit ID is not checked
VLAN tagging       Yes          None. This is a combo box with 3 options (Disabled,
 Dot1Q and QinQ)
Autopick VLAN ID  Yes          Enabled when VLAN tagging is set to Dot1Q or QinQ
Outer VLAN ID     Yes          Enabled when VLAN tagging is set to Dot1Q or QinQ
 and autopick VLAN ID is not checked
Inner VLAN ID     Yes          Only available for QinQ VLAN tagging
Rate Limit        Yes          None
Interface 
Description        Yes          None

For an IP service order, the following node settings can bemodified using the inline edit

method:

Node, Hub, Stitching point

Parameter    Editable    Dependencies
Node      Yes      None
Hub      Yes      Only editable for Hub-and-spoke topologies
Stitching point  Yes      When hub is selected, stitching point must be disabled

For an IP service order, the following site settings can bemodified using the inline edit

method:

Node, Interface, Autopick Unit, Unit ID, VLAN tagging, Autopick VLAN ID, Outer VLAN ID,

Inner VLAN ID, Auto pick IP, IP Address, Subnet

Parameter    Editable    Dependencies
Node            Yes               None
Interface        Yes               The Node name has to be configured
Status           No      None
Autopick Unit   Yes      None
Unit ID     Yes      Only enabled when autopick unit ID is not checked
VLAN tagging    Yes               Only enabled when the interface selected is not
 a loopback (lo0). For loopback interfaces the VLAN                             
                 tagging should be set to disabled. For other ethernet-based 
interfaces, this should be a combo box                                    with 3
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 options (Disabled, Dot1Q and QinQ)
Autopick VLAN ID  Yes       Enabled when VLAN tagging is set to Dot1Q or QinQ
Outer VLAN ID  Yes      Enabled when VLAN tagging is set to Dot1Q or QinQ and 
autopick VLAN ID is not checked
Inner VLAN ID    Yes              Only available for QinQ VLAN tagging
Auto pick IP       Yes               None
IP Address       Yes              If autopick is enabled this should be a combo 
box showing the available pools. If autopick is                                 
        disabled, this should be an input text box allowing users to enter the 
IP
Subnet             Yes              None, when autopick is enabled this sets the
 block size. Then autopick is disabled it sets up the                           
                       subnet size

Related
Documentation

Modifying an E-Line Service on page 976•

• Modifying a Multipoint-to-Multipoint Ethernet Service on page 977

• Modifying a Point-to-Multipoint Ethernet Service on page 984

• Modifying a Hub-and-Spoke IP Service Order on page 993

• Modifying a Full Mesh IP Service on page 1008

Interconnecting an IP Service with an E-LAN Service

You can stitch or interconnect an IP service with an E-LAN service. Youmust enable the

stitching functionality toperformthis interconnection. If the stitchingcapability is enabled,

when you select the interfaces for the endpoints added to a service, only the integrated

routing and bridging (IRB) physical and logical interfaces are available for selection. If

you select a physical IRB interface, a new logical interface is created with the logical unit

identifier of the interface you specify. If you select a logical IRB interface, the existing

logical interface is used to create the service.

You can stitch or interconnect an IP service with an E-LAN service during the creation or

modification of an IP service order. Follow the steps outlined in for performing the tasks

in the Service Settings and Node Settings pages of the wizard. To enable the stitching

of an IP service with an E-LAN service, you can select the Stitch check box for a device

associatedwith the serviceorder on theSiteSettingspageof the IP serviceorder creation

or modification wizard.

Before you begin:

• Ensure that you have already created an IP service.

• Complete the configuration of settings on the Service Settings and Node Settings

pages of the service order creation or modification wizard.
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To interconnect an IP service with an E-LAN service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the Tasks pane, select Service Provisioning > Deploy Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

6. From the Manage Network Services page, select New > IP Service.

The Create IP Service Orderwindow appears and shows a filtered inventory view of

only those published service definitions designed to work with multipoint Ethernet

services. You can select the service definition based on the signaling type.

See“CreatingaFullMesh IPServiceOrder”onpage879and“CreatingaHub-and-Spoke

IPServiceOrder” on page901 for detailed information about the settings that you can

configure on the Service Settings and Node Settings pages of the wizard.

7. After you complete the configuration of settings on the Service Settings and Node

Settings pages of the service order creation or modification wizard, click Site Settings

at the top of the wizard page.

The Site Settings page is displayed.

8. Select the check box beside the device for which you want to enable the stitching of

E-LAN and IP services.

The device that you select is available for stitching.

9. Select the Stitch check box to enable the interconnection of the IP service with an

E-LAN service.
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10. Click inside the Interface Name field to select an IRB interface. A popup dialog box is

displayed with the list of all configured IRB interfaces. If the stitching capability is

enabled, when you select the interfaces for the endpoints added to a service, only the

IRB physical and logical interfaces are available for selection.

11. Select a physical or logical IRB interface that you want to use to stitch the IP service

with an E-LAN service.

The selected interface is used for interconnection of the services.

12. (Optional) If you select a physical IRB interface, you can specify the logical unit of the

interface in the UNIT ID field.

The specified logical IRB interface is used for stitching the services.

13. For serviceorders associatedwitha servicedefinition that contains a service template,

click Next to modify the template settings.

14. Click Review to examine andmodify the settings as necessary.

15. Click Finishwhen you have completed examining the settings to confirm the creation

of the service order.

16. You can proceed to enable the stitching functionality for the same IRB interface with

the E-LAN service. See “Interconnecting an E-LAN Service with an IP Service” on

page 873 for detailed information about enabling the stitching functionality for the

E-LAN service.

Related
Documentation

Creating a Full Mesh IP Service Order on page 879•

• Creating a Hub-and-Spoke IP Service Order on page 901

• Interconnecting an E-LAN Service with an IP Service on page 873

Changing the Logical Loopback Interface for Provisioning

The loopback interface supports many different network and operational functions and

is an always-up interface. Thismeans that the loopback interface ensures that the device

is reachable, even if someof thephysical interfacesaredownor removed,oran IPaddress

has changed. In most cases, you always define a loopback interface.

Junos OS follows the IP convention of identifying the loopback interface as lo0.

Junos OS requires that the loopback interface always be configured with a /32 network

mask, thus avoiding any unnecessary allocation of address space.

Typically, the VRF or virtual-router routing instance IP address is drawn from among the

IP addresses associated with interfaces configured for that routing instance. If none of
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the interfaces associated with a VRF or virtual-router routing instance is configured with

an IP address, you need to explicitly configure a logical loopback interface with an IP

address. This interface must then be associated with the routing instance.

You change the logical unit of the loopback interface to be a logical unit other than unit

0 to be used as the default loopback logical interface for all provisioning tasks that are

initiated from Connectivity Services Director

NOTE: Although JunosOSallows you to assignmultiple loopback addresses
to the same loopback unit, the Junos Space software recognizes only the
first address assigned to the loopback unit. Therefore, when you change the
loopbackaddressofanN-PEdevice, itmustbe to thatofadifferent loopback
unit.

To change the logical unit of the loopback interface:

1. Fromthe JunosSpaceuser interface, click theSystem iconon theConnectivityServices

Director banner.

The options that you can configure in Systemmode are displayed in a drop-down

menu.

2. Select Preferences from the drop-downmenu to open the Preferences page.

The Preferences page opens with User Preferences as the default tab.

3. Click the Services Activation tab to configure the services activation-related settings.

The settings that you can configure on the Services Activation tab are displayed.

4. Click the right arrow beside the Prestage Device section to expand it.

The parameters that you can configure for prestaging devices are displayed.

5. In the Loopback Unit field, specify the logical unit of the loopback interface thatmust

be used as the default loopback logical interface for all provisioning tasks that are

initiated from Connectivity Services Director. The default logical unit for the loopback

interface is 0.

6. ClickOK to save the settings. You are prompted to confirm the changes youmade to

services-activation preferences.

7. Click Yes to confirm. The Preferences page is closed. A dialog box is displayed to

confirm the successful saving of the preferences. ClickOK to close the dialog box.

Related
Documentation

• Modifying the Application Settings of Connectivity Services Director on page 1032
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CHAPTER 34

Service Provisioning: Managing E-LAN
Service Orders

• Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827

• Creating a Point-to-Multipoint E-LAN Service Order on page 847

• Creating a Service Order for VPLS Access into Layer 3 Networks on page 867

• Creating an E-LAN Service Order with CFM on page 870

• Interconnecting an E-LAN Service with an IP Service on page 873

Creating aMultipoint-to-Multipoint E-LAN Service Order

The Connectivity Services Director application implements multipoint-to-multipoint

Ethernet services as E-LAN services.

To create amultipoint-to-multipoint Ethernet service order, complete these tasks in

order:

1. Selecting the Service Definition on page 827

2. Entering Service Parameters Information on page 829

3. Specifying OAM Settings on page 835

4. Selecting N-PE Devices on page 836

5. Specifying Node Settings on page 837

6. Modifying Site Settings on page 840

7. Specifying QoS Settings on page 844

8. Specifying Template Settings on page 844

9. Reviewing the Configured Settings on page 846

10. Deploying the New Service on page 846

Selecting the Service Definition

To select a service definition on which to base the new service order:
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1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Connectivity Services Director user interface, click the Deploy icon in the

Connectivity Services Director banner. The functionalities that you can configure in

this mode are displayed in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the Tasks pane, select Service Provisioning >Manage Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

6. From the Manage Network Services page, select New > E-LAN Service.

The Create E-LAN Service Orderwindow appears and shows a filtered inventory view

of only those published service definitions designed to work withmultipoint Ethernet

services. You can select the service definition based on the signaling type.

The Service Settings page appears.

7. From theServiceDefinition field, clickSelect to choose the service definition youwant

to base your service order on. The Choose Service Definition inventory page displays

a view of only those published service definitions designed to work with the type of

services you need.

Based on the fields or parameters that you defined in the service definition to be

enabled for modification in the service order, the corresponding fields are available

for editing. The fields that are disabled for modification in the service order can only

be edited in the service definition.

8. Select the check box beside the service definition that youwant to associate with the

service order, and clickOK.

9. ClickView to open a popup dialog box that displays the details of the selected service

definition. The service definition properties, such as the name, signaling type (LDP or

BGP), service type (Ethernet, ATM, or TDM), are displayed. The interface-specific

attributes, such as rate-limiting details, encapsulation, and VLAN tags, are also
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displayed in the dialog box. Close the dialog box to return to the service order creation

wizard.

10. (Optional) Select the Enable LSP Association check box to create or associate LSPs.

Select the Create LSP check box to import an existing LSP service definition and also

select an LSP name pattern.

NOTE: You can also create an LSP name pattern of your preference,
instead of using an existing pre-defined pattern.

For informationaboutcreatinganLSPnamepattern, see “CreatingaName
Pattern for LSPs in the Service Order” on page 1643.

Select the Associate LSP check box to associate an existing LSP.

Entering Service Parameters Information

This part of the create multipoint Ethernet service order procedure sets general

information about the service order in the Service Settings page of the Create E-LAN

Service Order wizard:

A wizard is available to create a service order in an intuitive and easily-navigable format.

The settings that you can configure in the service order are organized in separate pages

of the wizard, which you can launch by clicking the appropriate buttons at the top of the

Create a Service Order page. Alternatively, you can proceed to the corresponding

setting-related pages by clicking the Back and Next buttons at any point in the wizard

during the creation of the service order.

In the General Settings section of the Service Settings page, enter general settings or

service parameters information by doing the following tasks:

1. In the Name field, type a unique name for the multipoint service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for an E-LAN service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “vpls”, as the name of a service order.

2. In theCustomer field, select the customer requesting the service. To speedyour search,

type the first few letters of the customer name and then select from the list.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 697.
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3. In the Comments field, provide a description of the service. This description appears

in informationwindowsabout the requestor service instancecreated fromthe request.

The Customer traffic type parameter is not selectable. Its value is set in the service

definition.

QoS settings are added to a service order, depending on the configuration attributes

that are defined in the service templates associated with it.
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In the VPLS Settings section of the Service Settings page, enter the connectivity

information by doing the following tasks:

The Signaling cannot be changed in the service order.

The Instance type and Protocol parameters are not selectable. Their values are set in the

service definition.

The followingcheckboxesaredisplayedbasedon theservicedefinition youhaveselected:

• Enable PW Extension

• Enable PWResiliency

• Allow access to L3 network

• Enable Multihoming

You cannot change these check boxes in the service order.

1. Specify whether the route distinguisher can be selected automatically or manually.

NOTE: You cannot edit the route distinguisher if you have not selected
the Editable in Service Order check box in the service definition.

• To assign the route distinguisher automatically, select the Autopick Route

Distinguisher check box.

• To assign the route distinguisher manually, clear the Autopick Route Distinguisher

check box.

If you choose to assign the route distinguisher manually, the window expands to

include the Route distinguisher field. In the Route distinguisher field, type a value.

Junos Space accepts either of the following two formats:

• prefix-number: assigned-number

Where prefix-number can be any numeric value from 1 through 65,535, and

assigned-number can be any numeric value from 0 through 2,147,483,647

• IPV4-address: assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535

NOTE: The Route distinguisher field is available in either of the following

cases:

• The Signaling type is BGP

• The Signaling type is LDP and Auto Discovery is enabled
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2. Specify whether the route target can be selected automatically or manually.

NOTE: You cannot edit the route target if you have not selected the
Editable in Service Order check box in the service definition.

• To assign the route target automatically, select the Autopick Route target check

box.

• To assign the route target manually, clear the Autopick Route target check box.

If you choose to assign the route target manually, the window expands to include

the Route Target field. In the Route Target field, type a value. Junos Space accepts

either of the following two formats:

• prefix-number:assigned-number

Where prefix-number can be any numeric value from 1 through 65,535, and

assigned-number can be any numeric value from 0 through 2,147,483,647

• IPV4-address:assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535

NOTE: The Route Target field is available in either of the following cases:

• The Signaling type is BGP

• The Signaling type is LDP and Auto Discovery is enabled

3. In theRevert time (sec) field, specify the revert time for redundant Layer 2 circuits and

VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

This field is available only if you have enabled the Enable PWResiliency check box in

the selected service definition.

4. In the Switch Over Delay (sec) field, specify the time to wait before the backup

pseudowire takes over.

Default: 0 seconds

Range: 0 through 180 seconds

This field is available only if you have enabled the Enable PWResiliency check box in

the selected service definition.

5. If Autopick VPLS ID is disabled, specify the VPLS ID.

Copyright © 2019, Juniper Networks, Inc.832

Connectivity Services Director User Guide



Range: 1 through 2147483647

NOTE: If thesignaling type isLDPand ifautodiscovery isenabled,Autopick

VPLS ID appears dimmed. This field is not editable in the service order.

If the signaling type is BGP, Autopick VPLS ID is not available.

6. If Autopick VPN ID is enabled, specify the VPN ID.

Range: 1 through 65535

NOTE: If thesignaling type isLDPand ifautodiscovery isenabled,Autopick

VPN ID appears dimmed. This field is not editable in the service order.

If the signaling type is BGP, Autopick VPN ID is not available.

7. Select the Autopick Hub Route Target and Autopick Spoke Route Target check boxes

if you want the Route target chosen automatically by the Network Activate software.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

Tomanually assign a Route target:

1. Clear theAutopickHubRoute Target andAutopick SpokeRoute Target check boxes

to activate the Hub Route Target and Spoke Route Target fields respectively.

2. In the Route Target field, enter a value.

When youmanually enter route target, JunosSpace accepts either of the following

two formats:

• <prefix-number>: <assigned-number>

Where <prefix-number> can be any numeric value from 1 to 65535, inclusive.

The <assigned-number> can be any numeric value from 0 to 2,147,483,647,

inclusive.

• <IPV4-address>: <assigned-number>

Where<IPV4-address>canbeanyvalid IPV4address (inW.X.Y.Z "dot"notation),

and <assigned-number> can be any numeric value from 0 to 65535, inclusive.
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In the Site Settings section of the Service Settings page, enter the endpoint or device

settings information by doing the following tasks:

1. Select a value for Ethernet option.

• Port

• Dot1Q

Specifying the Dot1Q Ethernet option enables you to apply a Unit ID, a single VLAN

ID, a VLAN Range, or a VLAN List to the service order.

• QinQ

Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN

Range, or a VLAN List to the service order. For an IP service deployed on a dual

tagged interface, the inner tag determines the VPN routing and forwarding

instance(VRF).

2. In theBandwidth field, select a value from the list to limit the bandwidth of the service

you are creating.

This field is present only if bandwidth limiting is allowed by the service definition, and

is configurable in the service order only if the service definition allows it.

3. In theMTU field, type the maximum transmission unit size for the UNI.

This field is present in all service orders. However, you can set this field only if the

service definition allows it.

The Auto-pick VLAN range constraint field is displayed and validates the VLAN range

specified in the service definition.

4. Specify the Logical interface settings:

NOTE: The Autopick Interface Unit ID field is not available if you have

selected the Ethernet option as Port.

• Specify whether the Autopick Interface Unit ID can be selected automatically or

manually.

• To assign the Unit automatically, select the Autopick Interface Unit ID check box.

• To assign the Unitmanually, clear the Autopick Interface Unit ID check box.

The window expands to include the Unit field. In the Unit field, type a value.

Range: 1 through 1073741823

NOTE: You can edit this field only if you have selected the Editable in

ServiceOrdercheckbox for theVLANIDselection in theservicedefinition.
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• Specify whether the Autopick VLAN ID can be selected automatically or manually.

• To assign the VLAN ID automatically, select the Autopick VLAN ID check box.

• To assign the VLAN IDmanually, clear the Autopick VLAN ID check box.

The window expands to include the VLAN ID field. In the VLAN ID field, type a

value.

5. Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTU Factor in the

range 1 through 1087902.

The default value forMTU Factor is 10.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in

the range 1 through 7450milliseconds.

The default value for Burst Period is 1.

6. In theCustomer VLANRangeStart andCustomer VLANRange End fields, type the first

and last VLAN ID of the range of customer VLANs to be transported over the network.

These fields are present only for services with UNIs that have Q-in-Q interface types

and allow a range of VLANs to be transported.

7. In the Normalize - VLAN ID Tag field, type a value for the customer VLAN.

This field is present only for services that specify Normalize to Dot1q tags.

8. In the Normalize - Inner VLAN Tag (for QinQ) field, type a value to provide a default

inner VLAN tag for the UNI endpoints.

This field is present only for services that specify Normalize to QinQ tags.

9. In theNornalize - Outer VLANTag field, type a value to provide an outer VLAN tag that

matches the Outer VLAN tag of at least one of the UNI endpoints.

This field is present only for services that specify Normalize to QinQ tags.

10. ClickNext to proceed to the subsequent stepof thewizard,which is todefine thenode

or endpoint parameters.

Specifying OAMSettings

To enable OAM on the service definition, type information in the OAM Settings of the

Service Settings page of the wizard.

1. In theOAMProfile field, select a profile from the list.
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NOTE: ForOAMSettings, if you specify aCFMprofile (for example, a CFM
action profile with remote MEP), or an SLA-Iterator profile, first youmust
ensure that the profile is attached to the same device upon which you
intend to deploy the E-Line service order. If the profile is not previously
attached (using theOAM Insight application), itwill not be present on the
device to support the service order.

To remove a previously associated CFM definition or OAM profile from a
service definition, click the Detach button next to the OAMProfile field to

remove the association. To associate a newOAM profile, youmust
dissociate the existing OAM profile and attach a fresh OAM profile.
Detaching anOAMprofile is enabledwhen youmodify a service or service
order.

NOTE: For Juniper Networks PTX3000 Packet Transport Routers and
Junos Space Release 13.1P1, if you attach a CFMDefinition to the service
order, the CFM session will operate for MEPs in either the Up or Down
direction when the service is deployed.

2. Click CFMDetails beside the OAMProfile field to view the profile configuration details

in a dialog box.

3. Continue with specifying the endpoint information.

Selecting N-PE Devices

This part of the create multipoint Ethernet service order procedure selects the N-PE

devices. The selection is made from theNode Settings page of the Create E-LAN Service

Order wizard.

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Node Settings section of the window. For instructions on

working with service templates in service orders, see “Creating a Service Order Based on

a Service Definition with a Template” on page 927.

NOTE: The inline grid of the Node Settings page shows only assigned NPE

devices that have an AS number configured. If you do not see the device you
are looking for, use theCLIon thedevice tocheck forandassignanASnumber.

1. From the drop down, select the interface that you want to associate with the service.

2. ClickOK.

The Node Settingswindow appears.
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3. Continue with modifying or entering the node parameters.

Specifying Node Settings

This part of the create multipoint Ethernet service order procedure sets the attributes

that are usually common for all endpoints in the service.

NOTE: If you are using a definition withmultiple templates, you can set
different attributes for the endpoints.

In any case, the values that you typedependon the servicedefinitiononwhich the service

order is based. Follow the steps in one of the following tasks, depending on whether or

not the service provides flexible VLAN tagging. To create a service with flexible VLAN

tagging, the service definition that you selected for the service order must include the

Ethernet option asymmetric tag depth in the UNI settings step.

• Setting Attributes for Nodes or Devices on a Service on page 837

• Setting Attributes for Nodes or Devices on a Service with Flexible VLAN

Tagging on page 840

Setting Attributes for Nodes or Devices on a Service

If these attributes are not the same on all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later, or use a definition with multiple templates.

This procedure sets the attributes listed in the Node Settings page of the of the Create

E-LAN Service Order wizard. The attributes shown depend on the interface type and the

signaling type.

The Node Settings page displays configuration attributes for the device selected in the

table of all added nodes. If multiple devices are selected, data is displayed beneath the

table for the last selected device. If you do not select a device, the service definition

details for nodes are displayed.

To set attributes common tomost endpoints:
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1. Fill in the following fields under the MAC Settings section

ActionField

MACSettings

To enableMAC learning, select the check box.MAC learning

Maximum number of MAC addresses learned from an interface.

Range: 1 through 131071 MAC addresses per interface

InterfaceMAC limit

To enableMAC statistic, select the check box.MAC statistics

Modify the size of the MAC address table for the bridge domain.

Range: 16 through 1048575

To allow the service provisioner to override the MAC settings, select Editable in Service Order.

MAC Table Size

2. IfMultihoming check box is selected in the service definition, aMulti-Homing Settings

section, withMHRole and Peer Node tabs, is available.

To define primary and backup PE devices, select primary and backup, respectively,

from the MH Role tab.

You can select peer nodes for the chosen devices from the list.

3. Fill in the following fields under the Topology Settings section.

a. In theTopology field, the typeof network connectionor circuit is displayedasE-LAN

(MultiPoint-to-MultiPoint) or E-LAN (Point-to-MultiPoint), based on the type of

service definition selected. In this case, the topology is shown as

multipoint-to-multipoint.

b. Define a route distinguisher option from the Auto Pick Route Distinguisher check

box and Route Distinguisher field:

• Select the check box to enable the service provider to specify the route

distinguisher.

• Select the check box to enable the route distinguisher to be selected

automatically.

4. Fill in the following fields under the Advanced Settings section.

AdvancedSettings—This section enables you to specify the parameters that define advanced connectivity between sites across
the service provider network. Configuring advanced settings is optional. You can click on the Advanced link to view the default
values for Advanced Settings. If the advanced settings can be edited in the service order, you can override the default values.
If you do not click the Advanced link, the default advanced settings are applied to the service order.
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Select the Include check box for each advanced setting that you want to include in the service
definition.

NOTE: If you select any advanced parameters for a service definition, youmust also select the
Include check box for the Disable tunnel services parameter, and select or clear the Disable tunnel
services check box.

For MX Series devices, if you deploy an E-LAN service without selecting the Include check box for
Disable tunnel services parameter, the E-LAN service is down. As a work around, you can push the
configuration to each PE device for the service by running the following command:

root@test_device# set chassis fpc 0 pic 1 tunnel-services bandwidth 1g

Include

Enable or disable tunnel-services to specify that traffic for particular VPLS routing instances be
forwarded to specific virtual tunnel (VT) interfaces.

• To enable tunnel-services, clear the Disable Tunnel Services check box.

• To disable tunnel-services, select the Disable Tunnel Services check box (default).

Disable Tunnel Services

Enable or disable local switching. In local switching mode, you can terminate multiple Layer 2
circuit pseudowires at a single VPLSmesh group:

• To enable local switching across the network, clear the Disable Local Switching check box.

• To disable local switching across the network, select the Disable Local Switching check box
(default).

Disable Local Switching

In this drop-down list, specify the reroute priority for a VPLS routing instance:

• HIGH—Set the fast reroute priority for a VPLS routing instance to high. During a fast reroute
event, the router repairs next hops for high-priority VPLS routing instances first.

• MEDIUM—Set the fast reroute priority for a VPLS routing instance to medium. During a fast
rerouteevent, the router repairs nexthops formedium-priorityVPLS instancesafter high-priority
VPLS routing instances but before low-priority VPLS routing instances.

• LOW—Set the fast reroute priority for aVPLS routing instance to low,which is the default. During
a fast reroute event, the router repairs next hops for low-priority VPLS routing instances last.

Fast Reroute-Priority

Configure the label block size for VPLS labels by using one of the following values.

• 2—Allocate the label blocks in increments of 2. Use this setting for a VPLS domain that has only
two sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8—Allocate the label blocks in increments of 8. This is the default.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you tominimize
the number of routes in the VPLS domain. Use this setting only if the number of routes is the
primary concern.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery check box is
enabled.

Label Block Size

839Copyright © 2019, Juniper Networks, Inc.

Chapter 34: Service Provisioning: Managing E-LAN Service Orders



Selectaconnection-type tospecifywhenaVPLSconnection is takendown,dependingonwhether
the interface for the VPLS routing instance is customer-facing or integrated routing and bridging
(IRB):

• ce—Require that for the VPLS connection to be up, the customer-facing interface for the VPLS
routing instancemust also be up. If the customer-facing interface fails, the VPLS connection is
taken down. This is the default.

• irb—AllowaVPLSconnection to remain up so long as an IRB interface is configured for theVPLS
routing instance.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Connectivity type

5. Click Next.

The Site Settings page of the Create E-LAN Service Order wizard appears.

6. Continue with specifying the UNI or interface settings.

Setting Attributes for Nodes or Devices on a Service with Flexible VLAN Tagging

Aservicewith flexibleVLANtaggingcan includeport-based,802.1Q,andQ-in-Q interfaces.

If these attributes are not the same on all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later, or you can use a definition with multiple templates.

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Node Settings page of the wizard. For instructions on

working with service templates in service orders.

This procedure sets the attributes listed in the Node Settings page of the of the Create

E-LAN Service Order wizard. The attributes shown depend on the signaling type and

interface type. The following example shows the endpoints settings box for a

multipoint-to-multipoint servicewith flexibleVLANtagging that transports a singleVLAN

and specifies Normalize to Dot1Q tag.

Modifying Site Settings

This part of the create multipoint Ethernet service order procedure sets the attributes

for each interface of an endpoint or a device in the service. Selection is made using the

Site Settings page of the wizard that enables you to create an E-LAN service order.

This window shows one interface for each device that you selected from the inline grid

of the Node Settings page, as described in “Selecting N-PE Devices” on page 836.

The Site Settings page enables you to select a device to add interfaces for that device.

You can select multiple interfaces for the device. If the Enable L3 Access check box is

enabled, the UNI lists available integrated routing and bridging (IRB) interfaces for the

selected device. If the device role is a P2P spoke, you can select oneUNI and it is required

for suchdevices. If EthernetOption is set as port-to-port, theUNI canbeaddedonly once

as an endpoint for the device.
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The interface shown in theUNI Interface field is automatically selectedby theConnectivity

Services Director application, which chooses the UNI that has the highest available

capacity among interfaces that are in the Up state. To calculate the available capacity

of the interface, the system subtracts the bandwidth reserved for each service deployed

on that interface from the total capacity of the interface.

For eachendpoint, theSiteSettingspageshows the followingvalue for eachUNIattribute:

• For port-to-port services, the displayed values are Bandwidth and MTU.

• For 802.1Q UNIs, the displayed attributes are Bandwidth, Autopick VLAN ID, VLAN ID,

and MTU.

• For Q-in-Q UNIs, the displayed attributes include Bandwidth, AutoPick VLAN ID, and

VLAN ID. For a service with Q-in-Q UNIs that specifies a customer VLAN range, the

displayed attributes also include C-VLAN ID Start and C VLAN End.

For each endpoint on a servicewith flexible VLAN tagging, the Endpoint Settingswindow

shows the following value for each UNI attribute:

• For a service with flexible VLAN tagging that transports a single VLAN and specifies

Normalize to Dot1q tags, the displayed attributes include Ethernet Option, Bandwidth,

AutoPick VLAN ID, Inner VLAN ID, and MTU. For a service with flexible VLAN tagging

that specifies a customer VLAN range, the displayed attributes also include C-VLAN

ID Start and C VLAN End.

• For a service with flexible VLAN tagging that transports a single VLAN and specifies

Normalized to QinQ tags, the displayed attributes include Bandwidth, AutoPick VLAN

ID, and VLAN ID. For a service with flexible VLAN tagging that specifies a customer

VLAN range, the displayed attributes also include C-VLAN ID Start and C VLAN End.

• For a service with flexible VLAN tagging that transports a VLAN range, the displayed

attributes includeBandwidth,AutoPickVLAN ID, andVLAN ID. For a servicewith flexible

VLAN tagging that specifies a customer VLAN range, the displayed attributes also

include C-VLAN ID Start and C VLAN End.

The values shown are initially the values you set earlier on the Service Settings page of

the creation of E-LAN service order wizard, as described in “Specifying Node Settings”

on page 837.

To add a UNI and specify its settings:

1. Click the Add icon at the top of the Site Settings grid. The endpoints are displayed in

the inline grid.

2. Select the check box next to the endpoint or device fromwhich you want to add a

UNI to the service order.

3. ClickOK to save the settings. You are returned to the Site Settings page.

4. For a service with flexible VLAN tagging, set the interface type in the Ethernet Option

column for each endpoint in the service.
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5. To select a different UNI on a device, from the User-to-Network Interfaces section,

click the UNI name you want to change and choose another interface from the list.

6. Select theEnableCFM checkboxbesideaparticular interfaceof adevice in the service

order creation andmodification wizards to enable connectivity fault management

(CFM) on the interface. Based on your network needs, you can create a

point-to-multipoint and amultipoint-to- multipoint E-LAN service with service-level

CFM enabled. The CFM profile is propagated to a single endpoint whenmultiple

interfaces are selected for a given device (the last interface overrides the other

configurations). When you select the Enable CFM check box for an interface of a

particular device, you cannot enable CFM on other interfaces of the same device. The

CFM configuration is pushed only on the selected interface.

When you delete the interface with CFM enabled, the CFM configuration on the

particular device is also removed. When you attempt to delete an interface with CFM

enabled, you are prompted to confirm the deletion.

7. In theCustomer VLANRangeStart andCustomer VLANRange End fields, type the first

and last VLAN ID of the range of customer VLANs to be transported over the network.

These fields are present only for services with UNIs that have Q-in-Q interface types

and allow a range of VLANs to be transported.

8. Select a value for Ethernet option.

• Port

• Dot1Q

Specifying the Dot1Q Ethernet option enables you to apply a Unit ID, a single VLAN

ID, a VLAN Range, or a VLAN List to the service order.

• QinQ

Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN

Range, or a VLAN List to the service order. For an IP service deployed on a dual

tagged interface, the inner tag determines the VPN routing and forwarding

instance(VRF).

9. To enter the description for an UNI interface, click the corresponding Description cell.

10. To change the bandwidth on an endpoint, click the bandwidth value for the endpoint

and select another value from the list.

11. TheAutoPick InterfaceUnit IDand theUnit ID columnsappear, if youhavenot selected

the Ethernet option as port-to-port.

• To change an automatically selected service UNIT ID tomanual selection, clear the

AutoPick Interface Unit ID check box, and type a service UNIT ID value in the Unit ID

field.
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• To change frommanual selection to automatic selection, select the AutoPick

Interface Unit ID check box.

• To change the value of a manually selected service Unit ID, type a new value in the

Unit ID field.

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the Unit ID field.

12. For Q-in-Q interface endpoints, you can change how the service VLAN ID is selected:

• To change an automatically selected service VLAN ID to manual selection, clear

the AutoPick VLAN ID check box, and type an VLAN ID value in the VLAN ID field.

• To change frommanual selection to automatic selection, select theAutoPickVLAN

ID check box.

• To change the value of a manually selected service VLAN ID, type a new value in

the VLAN ID field.

13. For Q-in-Q interface endpoints with customer VLAN ranges specified, you can also

change the range limits for an endpoint.

14. For 802.1Q interface endpoints, you can change the customer VLAN ID.

15. To change the MTU for the UNI, click the value in theMTU field and type a new value.

16. To add aUNI on a selected device, clickAdd to open the Choose Endpoints dialog box

and then select the interface you want from the UNI interface list.

17. If the interface you selected in the previous step is already configured (duplicate) you

must either type a different value in theVLAN ID fieldmanually, or check theAutopick

VLAN ID field.

18. To delete a UNI from a device, select the interface and click Delete in the table that

displays the UNIs.

If the deleted UNI is the only UNI selected from the device, then the device is deleted

form the service configuration.

19. When you have finishedmodifying the endpoint settings, clickReview to examine and

modify the settings.

20.For serviceorders associatedwitha servicedefinition that contains a service template,

click Next to modify the template settings.
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21. Click Finishwhen you have completed examining the settings to confirm the creation

of the service order.

22. You can proceed with deploying the service.

Specifying QoS Settings

CoS profiles enable the grouping of class-of-service (CoS) parameters and apply them

to one or more interfaces. Connectivity Services Director provides you with predefined

traffic types for each CoS profile that you create. These traffic types represent the most

common types of traffic for the device type. Each of these templates has preconfigured

values for all CoS parameters based on the typical application requirements. You can

change thepreconfiguredvaluesof theseparameters to suit your requirements. Todisplay

the CoS Profiles page, in Build mode, select CoS under Profile and Configuration

Management in the Tasks pane. The Manage CoS Profiles page appears.

If QoS is enabledon the service definition, configure theQoSSettings of theSite Settings

panel of the service order creation wizard.

1. In theQoS profile field, select a profile from the list.

TheQoS profile list displays the QoS profiles that are currently configured in the

Manage CoS Profiles page of the Connectivity Services Director application.

A QoS profile classifies traffic into defined service groups to provide the special

treatment of traffic across the network service.

Specifying Template Settings

The Template Settings page of the service order creation andmodification wizards

enables you to associate service templates with an E-Line, E-LAN, and IP service order.

You can apply only the templates that are previously configured in a service definition

with the corresponding service order. The Template Settings page is available in the

service order wizard only if the service definition that you selected to apply to the service

order containsa service template.Otherwise, theTemplateSettingspage is notdisplayed

in the service order wizard. You can perform template operations for all endpoints in a

service order.

If you defined a service template as the default service template, it is attached to the

endpoint by default. You have the flexibility to create and provision a dynamic attribute

in a service template. You canmark an attribute of a service template as dynamic, and

you can obtain the values for these dynamic attributes from a specific device. To create

a dynamic attribute, youmust first mark an attribute of a service template as dynamic

and then specify the device XPath for the dynamic attribute.

The Template Settings page is displayed before the Review page, which is the final step

of the service order wizard.

In the Service Settings page of the Select Service Definition field of the service order

creation wizard, you can double-click a service definition name displayed in the table to

view the details of the definition in a popup dialog box. You can use this information to
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determine if the service definition is appropriate for your deployment needs. To filter and

sort the display of service templates, enter the nameof the template as amatch criterion

in the Search box and click the Search icon. The page refreshes to display only the

template names that match with the search term. You can use the paging controls to

navigate across multiple pages of templates as necessary.

All the tasks that you can performwith service templates are presented in the Template

Settings page. The page is divided into three panes. The top half of the page displays a

table of selected endpoints. All the endpoints or UNIs that you selected in the preceding

pages of the service order wizard are displayed in this table. You can configure the

template pertaining to only one endpoint at a point in time. If the selected endpoints (in

previous pages of the wizard) contained amanually-entered unit number, that number

is displayed in the tableof selectedendpoints.Otherwise, theAuto-pick label is displayed.

The lower half of the page is divided into two panes. The left pane displays the template

selection table for the endpoint you selected. All the templates associated with the

service definition are displayed. You can add and delete templates using the template

selection table. The right pane displays all the parameters that you canmodify for a

selected service template. All such editable paramters are displayed in a consolidated

form of a configuration page. This pane is displayed after you select a template. If any

configuration parameter in template is set as a service-specific value, such attributes

are not displayed in this pane.

To associate a service template with a service order:

1. ClickAdd to include a service template for the endpoint. A dialog box is displayedwith

the list of service templatesassociatedwith the servicedefinition that is used to create

the service order. The templates selected in this dialog box are displayed in the

Template Selection table for the specified endpoint. Such templates are considered

to be attached to that endpoint.

If you specified a template as adefault template during the service definition creation,

the template is displayedbydefault in the template selection table. You canassociate

non-default templates with the serviceo rder by clicking the Add button.

2. Click the link in the template name to open the Template Details dialog box. The

template settings are displayed in the popup dialog box. For the selected template,

the Configuration Page is displayed in the lower-right pane of the Template Settings

page.

3. Modify any template-specific service components as necessary.

4. Click Save to submit the changes.

5. Select a template from the Template Selection table, and click Delete to remove the

template from being associated with the service order for a particular endpoint.
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Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.

NOTE: On the Review page, in the Service Templates section, the names of
the service templates with which the service definition is associated are
displayed. The Default Service Template column indicates whether the
attached template is the default template.

To examine the configured service settings:

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.

3. Click Finish to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

The service order inventory window appears.

Deploying the New Service

This part of the create multipoint Ethernet service order procedure deploys the service.

To deploy the service from theManage Deploy Serviceswindow:

1. Perform one of the following actions in the Deploy mode of the Service View of

Connectivity Services Director:

• To deploy the service immediately, select Deploy now, then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.
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2. Tomonitor the status of the deployment, use the Jobs workspace.

The service order is now complete.

TheManage Service Orders page shows the service order you just added.

Related
Documentation

Creating a Point-to-Multipoint E-LAN Service Order on page 847•

• Creating a Service Order for VPLS Access into Layer 3 Networks on page 867

Creating a Point-to-Multipoint E-LAN Service Order

TheConnectivity Services Director application implements point-to-multipoint Ethernet

servicesasE-LANservices. These servicesarealso referred toashub-and-spoke services.

To create a point-to-multipoint Ethernet service order, complete the following tasks in

order:

• Selecting the Service Definition on page 847

• Entering Service Parameters Information on page 849

• Specifying OAM Settings on page 855

• Selecting N-PE Devices on page 856

• Specifying Node Settings on page 857

• Modifying Site Settings on page 861

• Specifying QoS Settings on page 864

• Specifying Template Settings on page 864

• Reviewing the Configured Settings on page 866

• Deploying the New Service on page 867

Selecting the Service Definition

To select a service definition on which to base the new service order:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP Ethernet service.
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• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the Tasks pane, select Service Provisioning >Manage Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

6. From theManage Network Services page, select New > E-LAN Service.

The Create E-LAN Service Orderwindow appears and shows a filtered inventory view

of only those published service definitions designed to work with point-to-multipoint

Ethernet services. You can select the service definition based on the signaling type.

The Service Settings page appears.

7. From theServiceDefinition field, clickSelect to choose the service definition youwant

to base your service order on. The Choose Service Definition inventory page displays

a view of only those published service definitions designed to work with the type of

services you need.

Based on the fields or parameters that you defined in the service definition to be

enabled for modification in the service order, the corresponding fields are available

for editing. The fields that are disabled for modification in the service order can only

be edited in the service definition.

8. Select the check box beside the service definition that youwant to associate with the

service order, and clickOK.

9. ClickView to open a popup dialog box that displays the details of the selected service

definition. The service definition properties, such as the name, signaling type (LDP or

BGP), service type (Ethernet, ATM, or TDM), are displayed. The interface-specific

attributes, such as rate-limiting details, encapsulation, and VLAN tags, are also

displayed in the dialog box. Close the dialog box to return to the service order creation

wizard.

If a template is attached to the service definition on which the service order is based,

you can invoke the template editor from the Template page of the wizard.

10. (Optional) Select the Enable LSP Association check box to create or associate LSPs.

Select the Create LSP check box to import an existing LSP service definition and also

select an LSP name pattern.
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NOTE: You can also create an LSP name pattern of your preference,
instead of using an existing pre-defined pattern.

For informationaboutcreatinganLSPnamepattern, see “CreatingaName
Pattern for LSPs in the Service Order” on page 1643.

Select the Associate LSP check box to associate an existing LSP.

Entering Service Parameters Information

This part of the create point-to-multipoint Ethernet service order procedure sets general

information about the service order in the Service Settings page of the Create E-LAN

Service Order wizard:

A wizard is available to create a service order in an intuitive and easily-navigable format.

The settings that you can configure in the service order are organized in separate pages

of the wizard, which you can launch by clicking the appropriate buttons at the top of the

Create a Service Order page. Alternatively, you can proceed to the corresponding

setting-related pages by clicking the Back and Next buttons at any point in the wizard

during the creation of the service order.

In the General Settings section of the Service Parameters page, enter general settings

or service parameters information by doing the following tasks:

1. In the Name field, type a unique name for the multipoint service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for an E-LAN service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “vpls”, as the name of a service order.

2. In theCustomer field, select the customer requesting the service. To speedyour search,

type the first few letters of the customer name and then select from the list.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 697.

3. In the Comments field, provide a description of the service. This description appears

in informationwindowsabout the requestor service instancecreated fromthe request.

The Customer traffic type parameter is not selectable. Its value is set in the service

definition.
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QoS settings are added to a service order, depending on the configuration attributes

that are defined in the service templates associated with it.

4. The Instance type and Protocol parameters are not selectable. Their values are set in

the service definition.
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In the VPLS Settings section of the Service Settings page, enter the connectivity

information by doing the following tasks:

The Signaling cannot be changed in the service order.

The followingcheckboxesaredisplayedbasedon theservicedefinition youhaveselected:

• Enable PW Extension

• Enable PWResiliency

• Allow L3 access

• AllowMultihoming

You cannot change these check boxes in the service order.

1. Specify whether the route distinguisher can be selected automatically or manually.

NOTE: You cannot edit the route distinguisher if you have not selected
the Editable in Service Order check box in the service definition.

• To assign the route distinguisher automatically, select the Autopick Route

Distinguisher check box.

• To assign the route distinguisher manually, clear the Autopick Route Distinguisher

check box.

If you choose to assign the route distinguisher manually, the window expands to

include the Route distinguisher field. In the Route distinguisher field, type a value.

Junos Space accepts either of the following two formats:

• prefix-number: assigned-number

Where prefix-number can be any numeric value from 1 through 65,535, and

assigned-number can be any numeric value from 0 through 2,147,483,647

• IPV4-address: assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535

NOTE: The Route distinguisher field is available in either of the following

cases:

• The Signaling type is BGP

• The Signaling type is LDP and Auto Discovery is enabled

2. Specify whether the route target can be selected automatically or manually.
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NOTE: You cannot edit the route target if you have not selected the
Editable in Service Order check box in the service definition.

• To assign the route target automatically, select the Autopick Route target check

box.

• To assign the route target manually, clear the Autopick Route target check box.

If you choose to assign the route target manually, the window expands to include

the Route Target field. In the Route Target field, type a value. Junos Space accepts

either of the following two formats:

• prefix-number:assigned-number

Where prefix-number can be any numeric value from 1 through 65,535, and

assigned-number can be any numeric value from 0 through 2,147,483,647

• IPV4-address:assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535

NOTE: The Route Target field is available in either of the following cases:

• The Signaling type is BGP

• The Signaling type is LDP and Auto Discovery is enabled

3. In theRevert time (sec) field, specify the revert time for redundant Layer 2 circuits and

VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

This field is available only if you have enabled the Enable PWResiliency check box in

the selected service definition.

4. In the Switch Over Delay (sec) field, specify the time to wait before the backup

pseudowire takes over.

Default: 0 seconds

Range: 0 through 180 seconds

This field is available only if you have enabled the Enable PWResiliency check box in

the selected service definition.

5. If Autopick VPLS ID is disabled, specify the VPLS ID.

Range: 1 through 2147483647

Copyright © 2019, Juniper Networks, Inc.852

Connectivity Services Director User Guide



NOTE: If thesignaling type isLDPand ifautodiscovery isenabled,Autopick

VPLS ID appears dimmed. This field is not editable in the service order.

If the signaling type is BGP, Autopick VPLS ID is not available.

6. If Autopick VPN ID is enabled, specify the VPN ID.

Range: 1 through 65535

NOTE: If thesignaling type isLDPand ifautodiscovery isenabled,Autopick

VPN ID appears dimmed. This field is not editable in the service order.

If the signaling type is BGP, Autopick VPN ID is not available.

7. Select the Autopick Hub Route Target and Autopick Spoke Route Target check boxes

if you want the Route target chosen automatically by the Network Activate software.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

Tomanually assign a Route target:

1. Clear theAutopickHubRoute Target andAutopick SpokeRoute Target check boxes

to activate the Hub Route Target and Spoke Route Target fields respectively.

2. In the Route Target field, enter a value.

When youmanually enter route target, JunosSpace accepts either of the following

two formats:

• <prefix-number>: <assigned-number>

Where <prefix-number> can be any numeric value from 1 to 65535, inclusive.

The <assigned-number> can be any numeric value from 0 to 2,147,483,647,

inclusive.

• <IPV4-address>: <assigned-number>

Where<IPV4-address>canbeanyvalid IPV4address (inW.X.Y.Z "dot"notation),

and <assigned-number> can be any numeric value from 0 to 65535, inclusive.
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In the Site Settings page, enter the endpoint or device settings information by doing the

following tasks:

1. Select a value for Ethernet option.

• Port

• Dot1Q

Specifying the Dot1Q Ethernet option enables you to apply a Unit ID, a single VLAN

ID, a VLAN Range, or a VLAN list to the service order.

• QinQ

Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN

Range, or aVLAN list to the serviceorder. For an IP servicedeployedonadual tagged

interface, the inner tag determines the VPN routing and forwarding instance(VRF).

2. In theBandwidth field, select a value from the list to limit the bandwidth of the service

you are creating.

This field is present only if bandwidth limiting is allowed by the service definition, and

is configurable in the service order only if the service definition allows it.

3. In theMTU field, type the maximum transmission unit size for the UNI.

This field is present in all service orders. However, you can set this field only if the

service definition allows it.

The Auto-pick VLAN range constraint field is displayed and validates the VLAN range

specified in the service definition.

4. Specify the Logical interface settings:

NOTE: The Autopick Interface Unit ID field is not available if you have

selected the Ethernet option as Port.

• Specify whether the Autopick Interface Unit ID can be selected automatically or

manually.

• To assign the Unit automatically, select the Autopick Interface Unit ID check box.

• To assign the Unitmanually, clear the Autopick Interface Unit ID check box.

The window expands to include the Unit field. In the Unit field, type a value.

Range: 1 through 1073741823

NOTE: You can edit this field only if you have selected the Editable in

ServiceOrdercheckbox for theVLANIDselection in theservicedefinition.

• Specify whether the Autopick VLAN ID can be selected automatically or manually.
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• To assign the VLAN ID automatically, select the Autopick VLAN ID check box.

• To assign the VLAN IDmanually, clear the Autopick VLAN ID check box.

The window expands to include the VLAN ID field. In the VLAN ID field, type a

value.

5. Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTU Factor in the

range 1 through 1087902.

The default value forMTU Factor is 10.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in

the range 1 through 7450milliseconds.

The default value for Burst Period is 1.

6. In theCustomer VLANRangeStart andCustomer VLANRange End fields, type the first

and last VLAN ID of the range of customer VLANs to be transported over the network.

These fields are present only for services with UNIs that have Q-in-Q interface types

and allow a range of VLANs to be transported.

7. In the Normalize - VLAN ID Tag field, type a value for the customer VLAN.

This field is present only for services that specify Normalize to Dot1q tags.

8. In the InnerNormalize - InnerVLANTag(forQinQ) field, typeavalue toprovideadefault

inner VLAN tag for the UNI endpoints.

This field is present only for services that specify Normalize to QinQ tags.

9. In theNornalize - Outer VLANTag field, type a value to provide an outer VLAN tag that

matches the Outer VLAN tag of at least one of the UNI endpoints.

This field is present only for services that specify Normalize to QinQ tags.

10. Click Next to proceed to the next step of the wizard, which is to define the node or

endpoint parameters.

Specifying OAMSettings

To enable OAM on the service order, type information in the OAMSettings of the Service

Parameters page of the wizard.

1. In theOAMProfile field, select a profile from the list.
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NOTE: ForOAMSettings, if you specify aCFMprofile (for example, a CFM
action profile with remote MEP), or an SLA-Iterator profile, first youmust
ensure that the profile is attached to the same device upon which you
intend to deploy the E-LAN service order. If the profile is not previously
attached (using theOAM Insight application), itwill not be present on the
device to support the service order.

To remove a previously associated CFM definition or OAM profile from a
service definition, click the Detach button next to the OAMProfile field to

remove the association. To associate a newOAM profile, youmust
dissociate the existing OAM profile and attach a fresh OAM profile.
Detaching anOAMprofile is enabledwhen youmodify a service or service
order.

NOTE: For Juniper Networks PTX3000 Packet Transport Routers and
Junos Space Release 13.1P1, if you attach a CFMDefinition to the service
order, the CFM session will operate for MEPs in either the Up or Down
direction when the service is deployed.

2. Click CFMDetails beside the OAMProfile field to view the profile configuration details

in a dialog box.

3. Continue with specifying the endpoint information.

Selecting N-PE Devices

This part of the create point-to-multipoint Ethernet service order procedure selects the

N-PE devices.The selection is made from the Node Settings page of the Create E-LAN

Service Order wizard.

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Node Settings section of the window. For instructions on

working with service templates in service orders, see “Creating a Service Order Based on

a Service Definition with a Template” on page 927.

NOTE: The inline grid of the Node Settings page shows only assigned N-PE

devices that have an AS number configured. If you do not see the device you
are looking for, use theCLIon thedevice tocheck forandassignanASnumber.

To select endpoint N-PE devices:
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1. In theNodeSettingspage, click theAdd icon at the top of theNodeSettings grid. From

the dialog box that appears, select the devices that you want to participate in the

service. Use the multiple selection feature to select one or more devices.

2. From the drop down, select the interface that you want to associate with the service.

3. ClickOK.

The Node Settingswindow appears.

4. Continue with modifying or entering the node parameters.

Specifying Node Settings

This part of the create point-to-multipoint Ethernet service order procedure sets the

attributes that are usually common for all endpoints in the service.

NOTE: If you are using a definition withmultiple templates, you can set
different attributes for the endpoints.

In any case, the values that you typedependon the servicedefinitiononwhich the service

order is based. Follow the steps in one of the following tasks, depending on whether or

not the service provides flexible VLAN tagging. To create a service with flexible VLAN

tagging, the service definition that you selected for the service order must include the

Ethernet option asymmetric tag depth in the UNI settings step.

• Setting Attributes for Nodes or Devices on a Service on page 857

• Setting Attributes for Nodes or Devices on a Service with Flexible VLAN

Tagging on page 860

Setting Attributes for Nodes or Devices on a Service

If these attributes are not the same on all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later, or use a definition with multiple templates.

This procedure sets the attributes listed in the Node Settings page of the of the Create

E-LAN Service Order wizard. The attributes shown depend on the interface type and the

signaling type.

The Node Settings page displays configuration attributes for the device selected in the

table of all added nodes. If multiple devices are selected, data is displayed beneath the

table for the last selected device. If you do not select a device, the service definition

details for nodes are displayed.

To set attributes common tomost endpoints:
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1. Fill in the following fields under the MAC Settings section

ActionField

MACSettings

To enableMAC learning, select the check box.MAC learning

Maximum number of MAC addresses learned from an interface.

Range: 1 through 131071 MAC addresses per interface

InterfaceMAC limit

To enableMAC statistic, select the check box.MAC statistics

Modify the size of the MAC address table for the bridge domain.

Range: 16 through 1048575

To allow the service provisioner to override the MAC settings, select Editable in Service Order.

MAC Table Size

2. IfMultihoming check box is selected in the service definition, aMulti-Homing Settings

section, withMHRole and Peer Node tabs, is available.

To define primary and backup PE devices, select primary and backup, respectively,

from the MH Role tab.

You can select peer nodes for the chosen devices from the list.

3. Fill in the following fields under the Advanced Settings section.

AdvancedSettings—This section enables you to specify the parameters that define advanced connectivity between sites across
the service provider network. Configuring advanced settings is optional. You can click on the Advanced link to view the default
values for Advanced Settings. If the advanced settings can be edited in the service order, you can override the default values.
If you do not click the Advanced link, the default advanced settings are applied to the service order.

Select the Include check box for each advanced setting that you want to include in the service
definition.

NOTE: If you select any advanced parameters for a service definition, youmust also select the
Include check box for the Disable tunnel services parameter, and select or clear the Disable tunnel
services check box.

For MX Series devices, if you deploy an E-LAN service without selecting the Include check box for
Disable tunnel services parameter, the E-LAN service is down. As a work around, you can push the
configuration to each PE device for the service by running the following command:

root@test_device# set chassis fpc 0 pic 1 tunnel-services bandwidth 1g

Include

Enable or disable tunnel-services to specify that traffic for particular VPLS routing instances be
forwarded to specific virtual tunnel (VT) interfaces.

• To enable tunnel-services, clear the Disable Tunnel Services check box.

• To disable tunnel-services, select the Disable Tunnel Services check box (default).

Disable Tunnel Services
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Enable or disable local switching. In local switching mode, you can terminate multiple Layer 2
circuit pseudowires at a single VPLSmesh group:

• To enable local switching across the network, clear the Disable Local Switching check box.

• To disable local switching across the network, select the Disable Local Switching check box
(default).

Disable Local Switching

In this drop-down list, specify the reroute priority for a VPLS routing instance:

• HIGH—Set the fast reroute priority for a VPLS routing instance to high. During a fast reroute
event, the router repairs next hops for high-priority VPLS routing instances first.

• MEDIUM—Set the fast reroute priority for a VPLS routing instance to medium. During a fast
rerouteevent, the router repairs nexthops formedium-priorityVPLS instancesafter high-priority
VPLS routing instances but before low-priority VPLS routing instances.

• LOW—Set the fast reroute priority for aVPLS routing instance to low,which is the default. During
a fast reroute event, the router repairs next hops for low-priority VPLS routing instances last.

Fast Reroute-Priority

Configure the label block size for VPLS labels by using one of the following values.

• 2—Allocate the label blocks in increments of 2. Use this setting for a VPLS domain that has only
two sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8—Allocate the label blocks in increments of 8. This is the default.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you tominimize
the number of routes in the VPLS domain. Use this setting only if the number of routes is the
primary concern.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery check box is
enabled.

Label Block Size

Selectaconnection-type tospecifywhenaVPLSconnection is takendown,dependingonwhether
the interface for the VPLS routing instance is customer-facing or integrated routing and bridging
(IRB):

• ce—Require that for the VPLS connection to be up, the customer-facing interface for the VPLS
routing instancemust also be up. If the customer-facing interface fails, the VPLS connection is
taken down. This is the default.

• irb—AllowaVPLSconnection to remain up so long as an IRB interface is configured for theVPLS
routing instance.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Connectivity type

4. Fill in the following fields under the Spoke Settings section.

For spoke devices you can update the Neighbor Hub details only if:

• The Signaling type is LDP and the Auto discovery check box is disabled

• The Signaling type is BGP and the Enable PWExtension check box is enabled

• Enable P2P-Spoke—If selected, the spoke acts as a stitched E-Line pseudowire.

This check box is available only if you have enabled the Enable PWExtension in the

selected service definition. If you have addedmore than one UNI interface for a

spoke device, you cannot select this check box.

• NeighborHub—Select the neighbor hub device from the list. If the Signaling type is

BGP, enable the Enable P2P-Spoke check box to select the neighbor hub.
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• Backup neighbor—Select the backup neighbor hub device from the list. This field is

available if the Enable PWResiliency check box is enabled in the selected service

definition. If the Signaling type is BGP, enable the Enable P2P-Spoke check box to

select the backup neighbor.

NOTE: You cannot select the same device forNeighborHub and Backup

neighbor.

• PW-Hub Connectivity name— If the Signaling type is BGP and if you have enabled

the Enable P2P-Spoke check box, select or type themesh group name from other

pseudowire spoke.

Range: 1 through 32 characters

If theSignaling type isLDP, thepseudowire-hubconnectivityname isautogenerated.

• Auto pick VC ID—This field is available if the Signaling type is BGP and if you have

enabled the Enable P2P-Spoke.

If the Signaling type is LDP, the VPLS ID of the routing instance is used.

• VC ID—If the Signaling type is BGP and if you have enabled Enable P2P-Spoke,

specify the VC ID.

You can also modify the VCID field in the Modify Service Order window.

Range: 1 through 2147483647

If the Signaling type is LDP, the VPLS ID of the routing instance is used.

5. Click Next.

The Site Settings page of the Create E-LAN Service Order wizard appears.

6. Continue with specifying the UNI or interface settings.

Setting Attributes for Nodes or Devices on a Service with Flexible VLAN Tagging

Aservicewith flexibleVLANtaggingcan includeport-based,802.1Q,andQ-in-Q interfaces.

If these attributes are not the same on all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later, or you can use a definition with multiple templates.

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Node Settings page of the wizard. For instructions on

working with service templates in service orders, see “Creating a Service Order Based on

a Service Definition with a Template” on page 927.

This procedure sets the attributes listed in the Node Settings page of the of the Create

E-LAN Service Order wizard. The attributes shown depend on the signaling type and

interface type. The following example shows the endpoints settings box for a
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point-to-multipoint servicewith flexible VLAN tagging that transports a single VLANand

specifies Normalize to Dot1Q tag.

Modifying Site Settings

This part of the create point-to-multipoint Ethernet service order procedure sets the

attributes for each interface of an endpoint or a device in the service. Selection is made

using the Site Settings page of the wizard that enables you to create an E-LAN service

order.

This window shows one interface for each device that you selected from the inline grid

of the Node Settings page, as described in “Selecting N-PE Devices” on page 836.

The Site Settings page enables you to select a device to add interfaces for that device.

You can select multiple interfaces for the device. If the Enable L3 Access check box is

enabled, the UNI lists available integrated routing and bridging (IRB) interfaces for the

selected device. If the device role is a P2P spoke, you can select oneUNI and it is required

for suchdevices. If EthernetOption is set as port-to-port, theUNI canbeaddedonly once

as an endpoint for the device.

The interface shown in theUNI Interface field is automatically selectedby theConnectivity

Services Director application, which chooses the UNI that has the highest available

capacity among interfaces that are in the Up state. To calculate the available capacity

of the interface, the system subtracts the bandwidth reserved for each service deployed

on that interface from the total capacity of the interface.

For eachendpoint, theSiteSettingspageshows the followingvalue for eachUNIattribute:

• For port-to-port services, the displayed values are Bandwidth and MTU.

• For 802.1Q UNIs, the displayed attributes are Bandwidth, Autopick VLAN ID, VLAN ID,

and MTU.

• For Q-in-Q UNIs, the displayed attributes include Bandwidth, AutoPick VLAN ID, and

VLAN ID. For a service with Q-in-Q UNIs that specifies a customer VLAN range, the

displayed attributes also include C-VLAN ID Start and C VLAN End.

For each endpoint on a servicewith flexible VLAN tagging, the Endpoint Settingswindow

shows the following value for each UNI attribute:

• For a service with flexible VLAN tagging that transports a single VLAN and specifies

Normalize to Dot1q tags, the displayed attributes include Ethernet Option, Bandwidth,

AutoPick VLAN ID, Inner VLAN ID, and MTU. For a service with flexible VLAN tagging

that specifies a customer VLAN range, the displayed attributes also include C-VLAN

ID Start and C VLAN End.

• For a service with flexible VLAN tagging that transports a single VLAN and specifies

Normalized to QinQ tags, the displayed attributes include Bandwidth, AutoPick VLAN

ID, and VLAN ID. For a service with flexible VLAN tagging that specifies a customer

VLAN range, the displayed attributes also include C-VLAN ID Start and C VLAN End.

• For a service with flexible VLAN tagging that transports a VLAN range, the displayed

attributes includeBandwidth,AutoPickVLAN ID, andVLAN ID. For a servicewith flexible
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VLAN tagging that specifies a customer VLAN range, the displayed attributes also

include C-VLAN ID Start and C VLAN End.

The values shown are initially the values you set earlier on the Service Settings page of

the creation of E-LAN service order wizard, as described in “Specifying Node Settings”

on page 837.

To add a UNI and specify its settings:

1. Click the Add icon at the top of the Site Settings grid. The endpoints are displayed in

the inline grid.

2. Select the check box next to the endpoint or device fromwhich you want to add a

UNI to the service order. After you select the check box, the view refreshes to display

the configured interfaces for that corresponding device in the lower part of the dialog

box

3. Select the check boxes next to the interfaces to add to the service order.

4. Click the Add icon to save the settings.. You are returned to the Site Settings page.

5. For a service with flexible VLAN tagging, set the interface type in the Ethernet Option

column for each endpoint in the service.

6. To select a different UNI on a device, from the User-to-Network Interfaces section,

click the UNI name you want to change and choose another interface from the list.

7. Select theEnableCFM checkboxbesideaparticular interfaceof adevice in the service

order creation andmodification wizards to enable connectivity fault management

(CFM) on the interface. Based on your network needs, you can create a

point-to-multipoint and amultipoint-to- multipoint E-LAN service with service-level

CFM enabled. The CFM profile is propagated to a single endpoint whenmultiple

interfaces are selected for a given device (the last interface overrides the other

configurations). When you select the Enable CFM check box for an interface of a

particular device, you cannot enable CFM on other interfaces of the same device. The

CFM configuration is pushed only on the selected interface.

When you delete the interface with CFM enabled, the CFM configuration on the

particular device is also removed. When you attempt to delete an interface with CFM

enabled, you are prompted to confirm the deletion.

8. In theCustomer VLANRangeStart andCustomer VLANRange End fields, type the first

and last VLAN ID of the range of customer VLANs to be transported over the network.

These fields are present only for services with UNIs that have Q-in-Q interface types

and allow a range of VLANs to be transported.

9. Select a value for Ethernet option.
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• Port

• Dot1Q

Specifying the Dot1Q Ethernet option enables you to apply a Unit ID, a single VLAN

ID, a VLAN Range, or a VLAN list to the service order.

• QinQ

Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN

Range, or aVLAN list to the serviceorder. For an IP servicedeployedonadual tagged

interface, the inner tag determines the VPN routing and forwarding instance(VRF).

10. To enter the description for an UNI interface, click the corresponding Description cell.

11. To change the bandwidth on an endpoint, click the bandwidth value for the endpoint

and select another value from the list.

12. TheAutoPick InterfaceUnit IDand theUnit ID columnsappear, if youhavenot selected

the Ethernet option as port-to-port.

• To change an automatically selected service UNIT ID tomanual selection, clear the

AutoPick Interface Unit ID check box, and type a service UNIT ID value in the Unit ID

field.

• To change frommanual selection to automatic selection, select the AutoPick

Interface Unit ID check box.

• To change the value of a manually selected service Unit ID, type a new value in the

Unit ID field.

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the Unit ID field.

13. For Q-in-Q interface endpoints, you can change how the service VLAN ID is selected:

• To change an automatically selected service VLAN ID to manual selection, clear

the AutoPick VLAN ID check box, and type an VLAN ID value in the VLAN ID field.

• To change frommanual selection to automatic selection, select theAutoPickVLAN

ID check box.

• To change the value of a manually selected service VLAN ID, type a new value in

the VLAN ID field.

14. For Q-in-Q interface endpoints with customer VLAN ranges specified, you can also

change the range limits for an endpoint.

15. For 802.1Q interface endpoints, you can change the customer VLAN ID.

16. To change the MTU for the UNI, click the value in theMTU field and type a new value.
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17. To add aUNI on a selected device, clickAdd to open the Choose Endpoints dialog box

and then select the interface you want from the UNI interface list.

18. If the interface you selected in the previous step is already configured (duplicate) you

must either type a different value in theVLAN ID fieldmanually, or check theAutopick

VLAN ID field.

19. To delete a UNI from a device, select the interface and click Delete in the table that

displays the UNIs.

If the deleted UNI is the only UNI selected from the device, then the device is deleted

form the service configuration.

20.When you have finishedmodifying the endpoint settings, clickReview to examine and

modify the settings.

21. Click Finishwhen you have completed examining the settings to confirm the creation

of the service order.

22. You can proceed with deploying the service.

Specifying QoS Settings

CoS profiles enable the grouping of class-of-service (CoS) parameters and apply them

to one or more interfaces. Connectivity Services Director provides you with predefined

traffic types for each CoS profile that you create. These traffic types represent the most

common types of traffic for the device type. Each of these templates has preconfigured

values for all CoS parameters based on the typical application requirements. You can

change thepreconfiguredvaluesof theseparameters to suit your requirements. Todisplay

the CoS Profiles page, in Build mode, select CoS under Profile and Configuration

Management in the Tasks pane. The Manage CoS Profiles page appears.

If QoS is enabledon the service definition, configure theQoSSettings of theSite Settings

panel of the service order creation wizard.

1. In theQoS profile field, select a profile from the list.

TheQoS profile list displays the QoS profiles that are currently configured in the

Manage CoS Profiles page of the Connectivity Services Director application.

A QoS profile classifies traffic into defined service groups to provide the special

treatment of traffic across the network service.

Specifying Template Settings

The Template Settings page of the service order creation andmodification wizards

enables you to associate service templates with an E-Line, E-LAN, and IP service order.

You can apply only the templates that are previously configured in a service definition

with the corresponding service order. The Template Settings page is available in the
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service order wizard only if the service definition that you selected to apply to the service

order containsa service template.Otherwise, theTemplateSettingspage is notdisplayed

in the service order wizard. You can perform template operations for all endpoints in a

service order.

If you defined a service template as the default service template, it is attached to the

endpoint by default. You have the flexibility to create and provision a dynamic attribute

in a service template. You canmark an attribute of a service template as dynamic, and

you can obtain the values for these dynamic attributes from a specific device. To create

a dynamic attribute, youmust first mark an attribute of a service template as dynamic

and then specify the device XPath for the dynamic attribute.

The Template Settings page is displayed before the Review page, which is the final step

of the service order wizard.

In the Service Settings page of the Select Service Definition field of the service order

creation wizard, you can double-click a service definition name displayed in the table to

view the details of the definition in a popup dialog box. You can use this information to

determine if the service definition is appropriate for your deployment needs. To filter and

sort the display of service templates, enter the nameof the template as amatch criterion

in the Search box and click the Search icon. The page refreshes to display only the

template names that match with the search term. You can use the paging controls to

navigate across multiple pages of templates as necessary.

All the tasks that you can performwith service templates are presented in the Template

Settings page. The page is divided into three panes. The top half of the page displays a

table of selected endpoints. All the endpoints or UNIs that you selected in the preceding

pages of the service order wizard are displayed in this table. You can configure the

template pertaining to only one endpoint at a point in time. If the selected endpoints (in

previous pages of the wizard) contained amanually-entered unit number, that number

is displayed in the tableof selectedendpoints.Otherwise, theAuto-pick label is displayed.

The lower half of the page is divided into two panes. The left pane displays the template

selection table for the endpoint you selected. All the templates associated with the

service definition are displayed. You can add and delete templates using the template

selection table. The right pane displays all the parameters that you canmodify for a

selected service template. All such editable paramters are displayed in a consolidated

form of a configuration page. This pane is displayed after you select a template. If any

configuration parameter in template is set as a service-specific value, such attributes

are not displayed in this pane.
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To associate a service template with a service order:

1. ClickAdd to include a service template for the endpoint. A dialog box is displayedwith

the list of service templatesassociatedwith the servicedefinition that is used to create

the service order. The templates selected in this dialog box are displayed in the

Template Selection table for the specified endpoint. Such templates are considered

to be attached to that endpoint.

If you specified a template as adefault template during the service definition creation,

the template is displayedbydefault in the template selection table. You canassociate

non-default templates with the serviceo rder by clicking the Add button.

2. Click the link in the template name to open the Template Details dialog box. The

template settings are displayed in the popup dialog box. For the selected template,

the Configuration Page is displayed in the lower-right pane of the Template Settings

page.

3. Modify any template-specific service components as necessary.

4. Click Save to submit the changes.

5. Select a template from the Template Selection table, and click Delete to remove the

template from being associated with the service order for a particular endpoint.

Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured inpreceding stepsorpagesof thewizard. This pageprovidesacomprehensive,

single-page view of all the service elements configured in the different pages of the

wizard. You can either click the buttons corresponding to the various settings at the top

of the wizard page to directly traverse to the page you want to modify or click the

navigation buttons at the bottom of the wizard page to go to the different pages of the

wizard.

To review the configured service settings in the wizard:

1. ClickReview to view thedefinedparameters. Youcanexamineandmodify the created

service order parameters. Alternatively, click the corresponding buttons at the top of

the wizard page to navigate to the specific pages pertain to the settings you want to

modify.

2. Click Edit next to the section that contains the parameter you want to modify. You

arenavigated to the correspondingpageof thewizard inwhich theparameter settings

are defined.
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3. Click Finish to save the service definition or service order.

4. ClickBack to return to the previous page of thewizard; else clickCancel to discard the

changes.

The service order inventory window appears.

Deploying the New Service

This part of the create point-to-multipoint Ethernet service order procedure deploys the

service.

To deploy the service from theManage Deploy Serviceswindow:

1. Perform one of the following actions in the Deploy mode of the Service View of

Connectivity Services Director:

• To deploy the service immediately, select Deploy now, then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

2. Tomonitor the status of the deployment, use the Jobs workspace.

The service order is now complete.

TheManage Service Orders page shows the service order you just added.

Related
Documentation

Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827•

• Creating a Service Order for VPLS Access into Layer 3 Networks on page 867

Creating a Service Order for VPLS Access into Layer 3 Networks

To select a service definition on which to base the new service order:

1. Select Service View from the View Selector. The workspaces that are applicable to

network and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.
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• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the Tasks pane, select Service Provisioning > Deploy Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

6. From theManage Network Services page, select New > E-LAN Service Order.

The Create E-LAN Service Orderwindow appears and shows a filtered inventory view

of only those published service definitions designed to work withmultipoint Ethernet

services.

7. From the Service Parameters page, select the service definition youwant to base your

service order

8. Specify the General Settings.

ActionField

Enter a unique name for the E-LANmultipoint service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for an E-LAN service order becomes the routing-instance name
in the device configuration when you deploy the service. Consequently, you cannot use any
Juniper Networks keywords, for example, “bgp” or “vpls”, as the name of a service order.

Name

Select the customer requesting the service. To speed your search, enter the first few letters
of the customer name and then select from the list.

If the customer is not in the list, youmust add the customer to thedatabasebeforeproceeding.
See “Adding a New Customer” on page 697.

Customer

Enter a description of the service. This description appears in the information screens about
the request or service instance created from the request.

The Customer traffic type field is not selectable. Its value is set in the service definition.

The Autopick Route Target field cannot be changed. Route targets are always selected
automatically.

Comments
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ActionField

(Optional) Select this check box to create or associate LSPs.

Select the Create LSP check box to import an existing LSP service definition and also select
an LSP name pattern.

NOTE: YoucanalsocreateanLSPnamepatternof yourpreference, insteadofusinganexisting
pre-defined pattern.

For information about creating an LSP name pattern, see “Creating a Name Pattern for LSPs
in the Service Order” on page 1643.

Select the Associate LSP check box to associate an existing LSP.

Enable LSP Association

Check the box if you are allowing the system to choose the VPLS routing instance.

NOTE: The Autopick route target is not editable in service order. By default, the check box is
always selected.

Autopick route target

Check this box to create the access path into the Layer 3 network.

Required for E-LAN service orders with access into Layer 3 networks.

NOTE: The Allow access to L3 network is not editable in service order. By default, the check
box is always selected.

Allow access to L3 network

9. Continue with the Node Settings page.

Node Settings

ActionField

Specify the bandwidth or use the default that appears in the field.Bandwidth

Specify the MTU value or use the default that appears in the field.MTU (Bytes)

Specify the VLAN ID associated with the IRB subinterface that will provide the link into the
Layer 3 network. This must be a VLAN that already exists.

VLAN ID

The E-LAN service definition requires a normalized VLAN. Indicate the VLAN to push at the
relevant end points. This should be the same VLAN specified as the VLAN ID.

VLAN Tag to stack

10. Click Next to display the device list where you will select the the interfaces for the

endpoint devices.

11. Select the devices you will use for this Layer 3 access.
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12. The E-LAN service order requires three interface: One IRB interface for the tunnel and

two endpoints to ping end-to-end. Add your three interfaces using the Site Settings

page.

13. Select the IRB interface and click Finish. The service order is saved.

Related
Documentation

Creating a Point-to-Multipoint E-LAN Service Order on page 847•

Creating an E-LAN Service Order with CFM

Ethernet interfaces support the IEEE 802.1ag standard for Operation, Administration,

andManagement(OAM).The IEEE802.1agspecificationprovides forEthernetconnectivity

fault management (CFM). CFMmonitors Ethernet networks that might comprise one or

more service instances for network-compromising connectivity faults.

Themajor features of CFM are:

• Fault monitoring using the continuity check protocol. This is a neighbor discovery and

health check protocol that discovers andmaintains adjacencies at the VLAN or link

level.

• Pathdiscoveryand fault verificationusing the linktraceprotocol. Similar to IP traceroute,

this protocol maps the path taken to a destination MAC address through one or more

bridged networks between the source and destination.

• Fault isolation using the loopback protocol. Similar to IP ping, this protocol works with

the continuity check protocol during troubleshooting.

CFM partitions the service network into various administrative domains. For example,

operators, providers, and customers might be part of different administrative domains.

Each administrative domain is mapped into onemaintenance domain providing enough

information toperform itsownmanagement, thusavoiding securitybreachesandmaking

end-to-endmonitoring possible. Eachmaintenance domain is associated with a

maintenance domain level from 0 through 7. Level allocation is based on the network

hierarchy, where outermost domains are assigned a higher level than the innermost

domains.

Customer endpoints have the highestmaintenancedomain level. In aCFMmaintenance

domain, each service instance is called amaintenance association. Amaintenance

association can be thought as a full mesh of maintenance endpoints (MEPs) having

similar characteristics. MEPs are active CFM entities generating and responding to CFM

protocol messages.

There is also amaintenance intermediate point (MIP), which is a CFM entity similar to

the MEP, but more passive (MIPs only respond to CFMmessages).

MEPs can be up MEPs or down MEPs. A link can connect a MEP at level 5 to a MEP at

level 7. The interface at level 5 is an up MEP (because the other end of the link is at MEP
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level 7), and the interface at level 7 is a downMEP (because the other end of the link is

at MEP level 5).

In a Metro Ethernet network, CFM is commonly used at two levels:

• By the service provider to check the connectivity among its provider edge (PE) routers

• By the customer to check the connectivity among its customer edge (CE) routers

NOTE: The configured customer CFM level must be greater than service
provider CFM level.

In many Metro Ethernet networks, CFM is used to monitor connectivity over a VPLS and

bridge network.

The CFMprofile is propagated to a single endpointwhenmultiple interfaces are selected

for agivendevice (the last interfaceoverrides theother configurations).Whenyouenable

CFM for an interface of a particular device, you cannot enable CFM on other interfaces

of the same device. The CFM configuration is pushed only on the selected interface.

When youdelete the interfacewithCFMenabled, theCFMconfigurationon theparticular

device is also removed. When you attempt to delete an interface with CFM enabled, you

are prompted to confirm the deletion.

To create an E-LAN service order with CFM enabled:

1. Select Service View from the View Selector. The workspaces that are applicable to

network and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the Tasks pane, select Service Provisioning > Deploy Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.
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6. From theManage Network Services page, select New > E-LAN Service Order.

The Create E-LAN Service Orderwindow appears and shows a filtered inventory view

of only those published service orders designed to work with multipoint Ethernet

services.

See “Creating a Multipoint-to-Multipoint E-LAN Service Order” on page 827 and

“Creating a Point-to-Multipoint E-LAN Service Order” on page 847 for detailed

information about the settings that you can configure on the Service Settings and

Node Settings pages of the wizard.

7. After you complete the configuration of settings on the Service Settings and Node

Settings pages of the service order creation or modification wizard, click Site Settings

at the top of the wizard page.

The Site Settings page is displayed.

8. Select theEnableCFM checkboxbesideaparticular interfaceof adevice in the service

order creation andmodification wizards to enable connectivity fault management

(CFM) on the interface. Based on your network needs, you can create a

point-to-multipoint and amultipoint-to- multipoint E-LAN service with service-level

CFM enabled. The CFM profile is propagated to a single endpoint whenmultiple

interfaces are selected for a given device (the last interface overrides the other

configurations). When you select the Enable CFM check box for an interface of a

particular device, you cannot enable CFM on other interfaces of the same device. The

CFM configuration is pushed only on the selected interface.

When you delete the interface with CFM enabled, the CFM configuration on the

particular device is also removed. When you attempt to delete an interface with CFM

enabled, you are prompted to confirm the deletion.

9. For serviceorders associatedwitha servicedefinition that contains a service template,

click Next to modify the template settings.

10. Click Review to examine andmodify the settings as necessary.

11. Click Finishwhen you have completed examining the settings to confirm the creation

of the service order.

Related
Documentation

Creating a Point-to-Multipoint E-LAN Service Order on page 847•
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Interconnecting an E-LAN Service with an IP Service

You can stitch or interconnect an E-LAN service with an IP service. Youmust enable the

stitching functionality toperformthis interconnection. If the stitchingcapability is enabled,

when you select the interfaces for the endpoints added to a service, only the integrated

routing and bridging (IRB) physical and logical interfaces are available for selection. If

you select a physical IRB interface, a new logical interface is created with the logical unit

identifier of the interface you specify. If you select a logical IRB interface, the existing

logical interface is used to create the service.

You can stitch or interconnect an E-LAN service with an IP service during the creation or

modification of an E-LAN service order. Follow the steps outlined in for performing the

tasks in the Service Settings and Node Settings pages of the wizard. To enable the

stitching of an E-LAN service with an IP service, you can select the Stitch check box for

a device associatedwith the service order on the Site Settings page of the E-LAN service

order creation or modification wizard.

• Ensure that you have already created an E-LAN service.

• Complete the configuration of settings on the Service Settings and Node Settings

pages of the service order creation or modification wizard.

To interconnect an E-LAN service with an IP service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the Tasks pane, select Service Provisioning > Deploy Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

6. From the Manage Network Services page, select New > E-LAN Service.
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The Create E-LAN Service Orderwindow appears and shows a filtered inventory view

of only those published service definitions designed to work withmultipoint Ethernet

services. You can select the service definition based on the signaling type.

See “Creating a Multipoint-to-Multipoint E-LAN Service Order” on page 827 and

“Creating a Point-to-Multipoint E-LAN Service Order” on page 847 for detailed

information about the settings that you can configure on the Service Settings and

Node Settings pages of the wizard.

7. After you complete the configuration of settings on the Service Settings and Node

Settings pages of the service order creation or modification wizard, click Site Settings

at the top of the wizard page.

The Site Settings page is displayed.

8. Select the check box beside the device for which you want to enable the stitching of

E-LAN and IP services.

The device that you select is available for stitching.

9. Select the Stitch check box to enable the interconnection of the E-LAN service with

an IP service.

10. Click inside the Interface Name field to select an IRB interface. A popup dialog box is

displayed with the list of all configured IRB interfaces. If the stitching capability is

enabled, when you select the interfaces for the endpoints added to a service, only the

IRB physical and logical interfaces are available for selection.

11. Select a physical or logical IRB interface that you want to use to stitch the E-LAN

service with an IP service.

The selected interface is used for interconnection of the services.

12. (Optional) If you select a physical IRB interface, you can specify the logical unit of the

interface in the UNIT ID field.

The specified logical IRB interface is used for stitching the services.

13. For serviceorders associatedwitha servicedefinition that contains a service template,

click Next to modify the template settings.

14. Click Review to examine andmodify the settings as necessary.
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15. Click Finishwhen you have completed examining the settings to confirm the creation

of the service order.

16. You can proceed to enable the stitching functionality for the same IRB interface with

the IP service. See “Interconnecting an IP Servicewith an E-LANService” on page 822

for detailed information about enabling the stitching functionality for the IP service.

Related
Documentation

• Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827

• Creating a Point-to-Multipoint E-LAN Service Order on page 847

• Interconnecting an IP Service with an E-LAN Service on page 822
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CHAPTER 35

Service Provisioning: Managing IP Service
Orders

• Stitching a Pseudowire to an IP Service on page 877

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901

• Selecting a Published IP Service Definition for a Service Order on page 921

• Entering IP Service Order Information on page 923

• Selecting Endpoint PE Devices or Nodes on page 925

• Creating a Service Order Based on a Service Definition with a Template on page 927

• Deploying an IP Service Order on page 929

• Creating a Multicast VPN Service Order on page 931

• Creating Policies for an IP Service on page 934

Stitching a Pseudowire to an IP Service

You can terminate an E-Line pseudowire service into an existing Layer 3 VPN, thereby

providing access to Layer 3 services. The benefit of the pseudowire stitching feature is

that devices running on Layer 2 technology continue to function when networks are

upgraded and Layer 3 technologies are used. In order to stitch Layer 2 services to one

another and to Layer 3 services, Junos Space utilizes tunnel PICs to peer up a pseudowire

and a Layer 3 VPN.

To stitch a pseudowire to an IP service:

1. Create an E-Line service definition.

In the General page of the Create E-Line Service Definition wizard, select the Enable

PW access to IP network check box to enable pseudowire access to the Layer 3 VPN

network.

For more information on creating an E-Line service definition, see Creating an E-Line

Service Definition.

2. Create an IP service definition.
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For information about creating a full mesh IP service definition, see “Creating a

Full-Mesh IP Service Definition” on page 669. For information about creating a

hub-and-spoke service definition, see “Creating a Hub-and-Spoke (One Interface) IP

Service Definition” on page 678.

3. Create and deploy an IP service order.

For information about creating a full mesh IP service order, see “Creating a Full Mesh

IPServiceOrder” onpage879. For informationabout creatingahub-and-spokeservice

order, see “Creating a Hub-and-Spoke IP Service Order” on page 901.

4. In Deploy mode of Service View, from the Manage Network Services inventory page,

select an IP service that you created and select Extend PWService from the Actions

menu

The Extend PWService inventory page lists the E-Line service definitions that are

enabled for Layer 3 access. This inventory pagemust also list the E-Line service

definition you created in Step 1.

5. Select the E-Line service definition and click Next.

6. Create an E-Line service order.

The stitched end of the E-Line service is prepopulated with IP service details.

The fieldsdisplayed in theE-Lineserviceorderarebasedon theE-Lineservicedefinition

selected in Step 5. For example, in the E-Line service definition, when pseudowire

resiliency is enabled, then theRevert time (sec) and the SwitchOver Delay (sec) fields

are available in the service order.

You can select any one of the devices from the PE device field. Only the devices with

logical tunnel interfaces are listed. These devices are associated with the IP service.

Specify the following information in the PW Stitching box:

• L3 routing instance name—Name of the Layer 3 routing instance

NOTE: This field isprepopulated forastitchedendof theE-Lineservice.

• Autopick interface IP—If enabled, specify IPblocksizeand IPaddresspool; otherwise

specify the Interface IP address.

• Autopick peer unit—To peer logical system unit number, select the check box;

otherwise specify the Peer unit name.

For more information on creating an E-Line service order, see “Creating an E-Line

Service Order” on page 784.

The IP Service Details window now displays the PWExtension details.
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When you perform a functional audit for an IP service with pseudowire termination, by

default the functional audit is applicable only to the IP service. To perform a functional

audit for the pseudowires, select the Include all extensions check box in the Schedule

Functional Audit window.

NOTE: For pseudowires, the functional audit is launched as a separate job.

Similarly, to performa Force Deploy for the pseudowires, select the Includeall extensions

check box in the Schedule Force Deployment window.

You can view the details of the stitched pseudowire in the Functional Audit Results

window.

Related
Documentation

Creating an E-Line ATM or TDM Pseudowire Service Order on page 774•

• Creating an E-Line Service Order on page 784

Creating a Full Mesh IP Service Order

You can use Connectivity Services Director application to implement IP services.

Creating an IP full mesh Ethernet service order consists of the following tasks:

1. Selecting the Service Definition on page 879

2. Configuring Service Parameters Information on page 881

3. Selecting N-PE Devices or Nodes on page 885

4. Setting Attributes for Endpoints or Nodes on page 886

5. Adding and Deleting UNI Interfaces on page 891

6. Setting Attributes for UNIs or Sites on page 892

7. Specifying QoS Settings on page 898

8. Specifying Template Settings on page 898

9. Reviewing the Configured Settings on page 900

10. Deploying the New Service on page 900

Selecting the Service Definition

To select a service definition to base the new service order on:

1. From the Connectivity Services Director application, select Service View from the

Views list.

The workspaces that are applicable to routing and tunnel services are displayed.

2. From the Junos Space user interface, click the Deploy tab in the Task Categories

banner. The features that you can configure in this mode are displayed in the task

pane.
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3. From the Service View pane, click the plus sign (+) to expand the tree and select the

type of service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. Select IP Services and from the Tasks pane, select Service Provisioning >Manage

Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

6. From the Manage Network Services page, select New > IP Service Order.

The Service Settings page in the Create IP Service Order wizard is displayed.

7. From theServiceDefinition field, clickSelect to choose the service definition youwant

to base your service order on.

The Choose Service Definition inventory page displays a view of only those published

service definitions designed to work with the type of services you need.

Based on the fields or parameters that you defined in the service definition to be

enabled for modification in the service order, the corresponding fields are available

for editing. The fields that are disabled for modification in the service order can only

be edited in the service definition.

8. Select the check box beside the service definition that youwant to associate with the

service order, and clickOK.

9. (Optional) Select the Enable LSP Association check box to create or associate LSPs.

Select the Create LSP check box to import an existing LSP service definition and also

select an LSP name pattern.

NOTE: You can also create an LSP name pattern of your preference,
instead of using an existing pre-defined pattern.

For informationaboutcreatinganLSPnamepattern, see “CreatingaName
Pattern for LSPs in the Service Order” on page 1643.

Select the Associate LSP check box to associate an existing LSP.

Copyright © 2019, Juniper Networks, Inc.880

Connectivity Services Director User Guide



Configuring Service Parameters Information

In this topic you configure general settings, VPN settings that can be applied to all end

points, and routing protocol settings for the provider edge (PE) and customer edge (CE)

devices.

• Specifying General Settings on page 881

• Specifying PE-CE Settings Information on page 884

Specifying General Settings

To specify general information for an IP Service Order:
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1. Fill in the fields on the Service Settings page as indicated in Table 116 on page 882.

Table 116: IP Service Order - Service Settings

DescriptionField

General Settings

Type a unique name for the service. The service order name can consist of only letters,
numbers, and underscores.

Name

NOTE: Thenameyouspecify for an IPServiceOrder becomes the routing-instancename
in the device configuration when you deploy the service.

Type a description of the service.Comments

Click Select to select name of the enterprise customer that requests for a service.Customer

Click Clear to clear the current selection.

Service Definition • Click Select to choose a service definition from the Choose Service Definition pop-up.

The Service Order is created based on the service definition you choose.

Select the check box beside the service definition that you want to associate with the
service order, and clickOK.

• Click View to view details of the service definition you selected.

The type of Service Definition you choose determines the fields that are available in the
Connectivity Settings section, VPN Settings section, and the PE-CE Settings section of
the Settings Page of the IP Service Order wizard.

The type of Service Definition you choose will determine the Instance Type displayed in
the field.

Instance Type

Select this check box to specify a distinct instance name for each device.Enable Distinct Instance Name

NOTE: Starting from Connectivity Services Director 2.0R4 onward, you can specify a
distinct routing instance name for each device when you deploy a service onmultiple
devices while creating a full-mesh IP service order.

Connectivity Settings

Select this check box to create a policy-based vrf instance.Policy Based Route Target

Clear this check box to create a community-based vrf instance.

For more information on creating policies for an IP service, see “Creating Policies for an
IP Service” on page 934.

Clear this check box, to enable the Route Target field.Auto Pick Route Target

To override this setting in the service order, you can select the Editable in Service Order
check box in the create Layer 3 full-mesh service definition wizard.
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Table 116: IP Service Order - Service Settings (continued)

DescriptionField

Specify the route target range in any of the following formats:

• AS Number format:

• AS Number Range: 1 through 4294967295

• IPv4 address format:

• If AS Number or IP is less than or equal to 65535, range is 0 through 65535.

• If AS Number or IP is greater than 65535, range is 0 through 4294967295.

NOTE: Youmust clear the Auto Pick Route Target check box to enable this field.

NOTE: Starting from Release 2.1R1 onward, Connectivity Services Director supports a
mix of both 2-byte and 4-byte AS numbers while creating a full-mesh IP service order.

Route Target

Select this check box to automatically generate a Hub Route Target.

Clear this check box to manually enter a Hub Route Target.

NOTE: The Auto Pick Hub Route Target check box is visible if the selected Instance Type
is vrf.

You can edit this field if you select the Editable in Service Order check box in the Create
Layer 3 Hub-and-Spoke Service Definitionwizard.

Auto Pick Hub Route Target

Specify the hub route target range in any of the following formats:

• prefix-number:assigned-number

Prefix-number can be any numeric value from 1 through 65535. Assigned-number can
be any numeric value from 0 through 2147483647.

• IPV4-address:assigned-number

IPV4-address canbeanyvalid IPv4address, andassigned-number canbeanynumeric
value from 0 through 65635.

NOTE: Tomanually enter the Hub Route Target, clear the Auto Pick Hub Route Target
check box.

Hub Route Target

Select this check box to automatically generate a Spoke Route Target.

Clear theAutoPickSpokeRouteTarget check box tomanually enter a SpokeRouteTarget.

NOTE: TheAutoPickSpokeRouteTarget checkbox is visible only if InstanceType selected
is vrf.

You can edit this field if you select the Editable in Service Order check box in the Create
Layer 3 Hub-and-Spoke Service Definitionwizard.

Auto Pick Spoke Route Target
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Table 116: IP Service Order - Service Settings (continued)

DescriptionField

Specify the spoke route target range in any of the following formats:

• prefix-number:assigned-number

Prefix-number can be any numeric value from 1 through 65535. Assigned-number can
be any numeric value from 0 through 2147483647.

• IPV4-address:assigned-number

IPV4-address canbeanyvalid IPv4address, andassigned-number canbeanynumeric
value from 0 through 65635.

Spoke Route Target

VPN Settings

Select this check box while creating a service definition to configure a separate label for
each VRF to provide double lookup and egress filtering.

This check box is visible only if the selected Instance Type is vrf.

VRF Table Label

Select this check box in the Create Layer 3 Full Mesh Service Definitionwizard to export
direct routes.

Export Direct Routes

You can select this check box in the Create IP Service Definitionwizard to enable internal
and external route leak as part of route target creation.

Enable Auto Export Routes

Select this check box in theCreate IPServiceDefinitionwizard to enable the internal route
leak feature as part of route target policy creation.

Import Internal Routes

Select this check box in theCreate IPServiceDefinitionwizard to enable the external route
leak feature as part of route target policy creation.

Import External Routes

Select this check box to enable multicast VPN (MVPN) settings.

If you select this check box, the Enable MC-LAG check box is disabled.

Enable MVPN

Default UNI Settings

Specify a value forMTUFactor in the range 1 through 1087902. The default value for MTU
Factor is 10.

The value you configure for MTU Factor should not exceed one tenth of the value you
configured for burst size.

NOTE: This field is enabled only if you selectMTUBased as the Burst Size.

MTU Factor

Specify a value for Burst Period in the range 10 through 1000. The default value for Burst
Period is 10.

NOTE: This field is enabled only when you select Line Rate Based as the Burst Size.

Burst Period

Specifying PE-CE Settings Information

YouconfigureVPNattributes that areusually common for all theendpoints in the service.

Depending on the service definition on which the service order is based, the values that

you provide vary.
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If you do not expect these attributes to be the same on all endpoints, you can set them

to be the same for now and thenmake changes later, or you can skip this step and apply

the attribute values one at a time later.

Fill in the PE-CE Settings as indicated in Table 117 on page 885:

Table 117: Layer 3 VPN Service Order - PE-CE Settings

DescriptionField

PE-CE Settings

The routing protocol in use is displayed.Routing Protocol

Select this check box to allow a service provisioner to override the AS number.

This check box is available if you select BGP as the routing protocol while creating the
service definition.

ASOveride

Range: 1 through 4294967295

This feature limits the number of unique destinations in a routing instance.

MaximumPrefixes

• ID Range Prefix: 1 through 65535

• ID Range Postfix: 0 through 4294967295

This check box is available only if you select OSPF as the routing protocol while creating
the service definition.

OSPF Domain ID

Choose an OSPF version from theOSPF Version list:

• Ver 2

• Ver 3

Junos OS supports OSPF version 2 (OSPFv2) and OSPF version 3 (OSPFv3).

This check box is available only if OSPF is selected as the routing protocol while creating
the service definition.

OSPF Version

Click Next

The Node Settings page appears.

Selecting N-PE Devices or Nodes

In this topic you select the N-PE devices that you want to host the service endpoints.

To select endpoint N-PE devices:
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1. Click Add in the Node Settings page of the Create IP Service Orderwizard to add a

device.

A new row is added to the existing table.

NOTE: You can create a new policy by clicking Create Policy.

This option is available if you select Policy Based Route Target check box

and clear the Auto Pick Route Target check box.

For more information on creating a policy, see “Creating Policies for an IP
Service” on page 934

2. Click the arrow in the name field.

3. From the list, select a device you want to add to the service.

You can select more than one device.

4. ClickOK.

The device is added to the table.

NOTE: Youcanmodify thedevice settingsby selecting the checkboxnext
to the device and clicking Edit.

ClickOk to save your changes.

Continue with modifying or entering the node parameters.

Setting Attributes for Endpoints or Nodes

For instructionsonworkingwith service templates in serviceorders, seeCreatingaService

Order Based on a Service Definition with a Template.

You set attributes for each endpoint in the service from the Node Settings page.

For each endpoint, the Node Settings page shows the value for each UNI attribute.

You can enter topology settings, create static routes on the service, and enterMVPN/PIM

settings in the Node Settings page. To specify these settings for a CE device on the Node

Settings page:

1. Select the device and click Edit.

The Node Settings window appears.

2. Fill in the fields to configure or change topology settings as indicated in

Table 118 on page 887:
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Table 118: IP Service Order - Topology Settings

DescriptionField

The type of network circuit in use is displayed in this field:

• Full Mesh

• Hub-and-spoke

Topology

Clear this check box.

If you select the Enable MC- LAG check box in the General Settings window, the Is Stitching Point
check box is available for each endpoint. If you select the Is Stitching Point check box, all the
parameters of that endpoint are disabled.

Is Stitching Point

Select this check box to enable the node to function as a hub.

Clear this check box if you want the device to function as a spoke.

NOTE: This field is not applicable for full-mesh IP services.

Is Hub

Select a policy from the list.

Policies associated with other devices and policies created as part of the service are listed. You
can select more than one policy.

You have the option to:

• Select a policy from the list.

• Clear the current selection by clicking Clear.

NOTE: You can also add or delete a policy while modifying the service.

Import RT Policy

Select a policy from the list

Policies associated with other devices and policies created as part of the service are listed. You
can select more than one policy.

You have the option to:

• Select a policy from the list.

• Clear the current selection by clicking Clear.

NOTE: You can also add or delete a policy while modifying the service.

Export RT Policy

Select this check box to assign the Route Distinguisher automatically.

This field is enabled if you have selected the Editable in Service Order check box in the service
definition.

Auto pick Route
Distinguisher
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Table 118: IP Service Order - Topology Settings (continued)

DescriptionField

Enter a valid Route Distinguisher range:

• as-number:id—Range: 1 through 65535

• ip-address:id—Range:

• ip address: any unique unicast address

• id: 1 through 65535

Each routing instancemust have a unique route distinguisher (RD) associated with it. The RD is
used to place bounds around a VPN so that the same IP address prefixes can be used in different
VPNs without any overlap.

This field is available only if you have selected full-mesh as the service type while creating the
service definition.

Route Distinguisher

Select this check box to assign the Hub Route Distinguisher automatically.

This field is enabled if you selected the Editable in Service Order check box in the service definition.

Auto pick Hub Route
Distinguisher

Enter a valid Hub Route Distinguisher range:

• as-number:id—Range: 1 through 65535

• ip-address:id—Range:

• ip address: any unique unicast address

• id: 1 through 65535

This field is available only if you selected hub-and-spoke as the service type while creating the
service definition.

Hub Route Distinguisher

Select this check box to assign the Spoke Route Distinguisher automatically.

This field is enabled only if you selected the Editable in Service Order check box in the service
definition.

Auto pick Spoke Route
Distinguisher

Enter a valid Spoke Route Distinguisher range:

• as-number:id—Range: 1 through 65535

• ip-address:id—Range:

• ip address: any globally unique unicast address

• id: 1 through 65535

This field is available only if you selected hub-and-spoke as the service type while creating the
service definition.

SpokeRouteDistinguisher

3. Fill in the fields to create static routes on the service as indicated in

Table 119 on page 889:
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Table 119: IP Service Order - Static Routes

ActionField

Enter the endpoint for the static route in this field.

• IP address–Destination IP address that the router uses to identify packets.

• Network mask–Network mask for associated IP subnet.

Netmask value: 0-32

Destination Prefix

Choose an option type from theOption Type list:

• next-hop

• next-table

• community

NOTE: Starting from Connectivity Services Director Release 2.1R1 onward, you can also configure
static routes by adding next table and community as option types while creating a full-mesh IP
service order.

Option Type

Enter a valid IP address in this field. You can havemultiple hop for every destination prefix.

This field is available only if you choose next-hop as theOption Type.

Hop Address

Choose one of the following options as the route table name:

• inet.0

• inet.3

This field is available only if you choose next-table as theOption Type.

Route Table Name

Choose one of the following values as the member type:

• no-export

• no-advertise

• no-export-subconfed

This field is available only if you choose community as theOption Type.

Member

Click Add to add a static route to the Static Route Table.

A new row is added to the table.

Add

Select the row you want to delete and click Delete to remove the static route from the Static Route
Table.

Delete

The Attribute column displays theOption Type you selectAttribute

The Attribute Value column displays the corresponding value for everyOption Type you select.Attribute Value

4. Specify the MVPN and PIM Settings as indicated in Table 120 on page 890:
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NOTE: TheMVPN and PIM Settings sections are displayed only if you
select the Enable MVPN check box in the Service Settings page of the

Create IP Service Orderwizard.

Table 120: IP Service Order - MVPN and PIM Settings

DescriptionField

PIM Settings

Choose the PIMMode from the drop down list.

Only sparse mode is currently supported.

PIMMode

MVPNSettings

Choose one of the following MVPNmodes from theMVPN
Mode list:

• rpt-spt

• spt-only

MVPNMode

Choose one of the following MBGPMVPN site types from the
list:

• sender

• receiver

Site Type

Specify the provider tunnel name to configure virtual private
LAN service (VPLS) flooding of unknown unicast, broadcast,
andmulticast traffic using point-to- multipoint LSPs in this
field. You can also configure point-to-multipoint LSPs for
MBGPMVPNs.

Provider Tunnel Name

Select this check box to configure the upstreammulticast hop
(UMH).

UpstreamMulticast Hop

Specify the import targets for sender and receiver sites in this
field.

Select the Sender radio button to import targets for sender
sites, select the Receiver radio button to import targets for
receiver sites.

Import Target

Specify the import targets specifically for sender sites or
receiver sites in this field. You can also borrow import targets
from a configured unicast route target.

NOTE: A sender site export route target is always advertised
when security association routes are exported. By default, the
VPN routing and forwarding (VRF) import and export route
targets (configuredeither usingVRF import andexport policies
or using the vrf-target statement) are used for importing and
exporting routes with the MBGPMVPN network layer
reachability information (NLRI).

Import Unicast Target
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Table 120: IP Service Order - MVPN and PIM Settings (continued)

DescriptionField

Select this check box to specify the export target to enable
you to override the Layer 3 VPN export route targets used for
importing and exporting routes for the MBGPMVPN network
layer reachability information (NLRI).

Export Unicast Target

Select this check box to enable automatic selection of an
export target if a configuration is not provided.

Auto pick Export Target

Specify the target community value tobeusedwhenexporting
sender and receiver site routes in this field.

You can specify this value manually if you clear the Autopick
Export Target check box.

Target Community

ClickOk to accept all configured values.

Click Cancel to reject all configured values.

5. Click Nextwhen you have finished configuring node settings.

The Site Settings page is displayed.

Adding and Deleting UNI Interfaces

In the Site Settings page, you can add or delete UNI interfaces on the PE devices that

participate in a service.

To add a UNI interface on a selected device:

1. Click Add to add a new row to the table.

2. From the newly added row, click the arrow in the Device Name field.

A list of interfaces is displayed.

3. Select the check boxes beside the UNIs that you want to associate with the service

order and clickOk. You can select more than one UNI.

The table now displays the UNI interfaces configured on the selected device.

TodeleteaUNI Interface fromaselecteddevice, select thecheckboxnext to the interface

that you want to delete, and click the Delete button above the table.

NOTE: If the deleted UNI is the only UNI selected from the device, then the
device is deleted from the service configuration.
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Setting Attributes for UNIs or Sites

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Site Settings section of the screen. For instructions on

working with service templates in service orders, see “Creating a Service Order Based on

a Service Definition with a Template” on page 927.

This part of the create Ethernet service order procedure sets the attributes for each

endpoint in the service. Selection is made using the Site Settings page.

The interface shown in theUNI Interface field is automatically selectedby theConnectivity

Services Director application, which chooses the UNI that has the highest available

capacity among interfaces that are in the Up state. To calculate the available capacity

of the interface, the system subtracts the bandwidth reserved for each service deployed

on that interface from the total capacity of the interface.

For each endpoint, the Site Settings page shows the value for each UNI attribute.

Tomodify the values of a UNI interface:

1. Tomodify the device settings, select the device by clicking the check box next to it.

The row is highlighted in blue.

2. You can edit details in the row based on Table 121 on page 892:

Table 121: IP Service Order - Modify or alter UNI Interface

DescriptionField

Displays the name of the device associated with the UNI.Device Name

Displays the selected interface name.

To add a new interface:

a. Click the arrow in the Interface Name field.

b. To select the interface, select the check box that corresponds to the interface.

c. ClickOk.

The interface name is displayed and the corresponding fields are updated.

Interface Name

Displays the interface’s status.

• A Green Up arrow indicates devices that are up and running.

• A Red Down arrow indicates devices that are down.

Interface Status

Select this check box to assign the Unit ID automatically.

Clear this check box to assign the Unit IDmanually.

Unit Autopick
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Table 121: IP Service Order - Modify or alter UNI Interface (continued)

DescriptionField

Enter a value in this field.

Range: 1 through 1073741823

This field is available only if you clear the Unit Autopick checkbox.

Unit ID

Select one of the following options from the list:

• Port

• Dot1Q

• QinQ(All)

• QinQ(Single)

Specifying theDot1QEthernet option enables you toapply aUnit ID, a singleVLAN ID, aVLANRange,
or a VLAN list to the service order.

Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN Range, or a VLAN
list to the serviceorder. For an IP servicedeployedonadual tagged interface, the inner tagdetermines
the VPN routing and forwarding instance(VRF).

VLAN Tagging

Select this check box to assign the VLANOuter ID automatically.

Clear this check box to assign the VLANOuter IDmanually.

VLANAutopick

Enter a value in this field.

This field is available if you clear the Unit Autopick check box.

VLANOuter

Enter a value in this field.

This field is available if you choose Dot1Q or QinQ(All) as the VLAN Tagging value.

VLAN Inner

Select this check box to assign the IP address automatically.

Clear this check box to assign the IP address manually.

You cannot edit this check box if you have not selected the Editable in Service Order check box in
the service definition.

IP Autopick

You can enter an IP address in this field if you have cleared the IP Autopick check box.

You can choose an IP address from the list if you have selected the IP Autopick check box.

IP Address

Enter a valid IP subnet in this field.IP Subnet
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To configure or edit Site Settings:

1. Select the interface that you want to edit by clicking the check box next to it.

The selected row is highlighted in blue.

2. You can edit the interface details by following Table 122 on page 894:

Table 122: IP Service Order - Configure Site Settings

ActionField

Site Settings

The name of the interface you choose is displayed in this field.Interface

Type a description that describes the UNI Interface.

Range: 0 to 128 characters.

Description

UNI Settings

Choose an encapsulation value from the Encapsulation list:

• Port

• Dot1Q

• QinQ(Single)

• QinQ(All)

If you choose Port as the encapsulation value, no field in the UNI settings section is enabled.

If you choose Dot1Q as the encapsulation value, Auto pick Interface Unit and Auto pick VLAN ID
check boxes are enabled.

If you chooseQinQ(Single) orQinQ(All) as the encapsulation value, Customer VLAN Type and
Outer TP ID fields are enabled.

Encapsulation

Select this check box to automatically assign the Unit ID.

Clear this check box to manually enter the Unit ID.

Auto pick Interface Unit

Enter a unit ID in this field.

Range - 1 through 16385

This field becomes available when you clear the Auto pick Interface Unit check box.

Unit ID

Select this check box to assign the VLAN ID automatically.

Clear this check box to manually enter the VLAN ID.

Auto pick VLAN ID

Enter a VLAN ID in this field.

Range - 1 through 4094

This field is available when you clear the Auto pick VLAN ID check box.

VLAN ID
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Table 122: IP Service Order - Configure Site Settings (continued)

ActionField

Choose a customer VLAN type from the Customer VLAN Type drop down box:

• Transport All Traffic—Transports traffic from all VLANs across the network

• Transport Single VLAN—Transports traffic for a specific VLAN across the network.

This field is available only when the encapsulation value you select isQinQ(Single) orQinQ(All)

Customer VLAN Type

Enter a Customer VLAN ID in this field.

Range - 1 through 4094

This field is available only when you select Transport Single VLAN as the Customer VLAN type.

Customer VLAN ID

Choose a value form theOuter TP ID list:

• empty (default)

• 0x8100

• 0x88a8

• 0x9100

Outer TP ID

Choose a value form the Inner TP ID list:

• empty (default)

• 0x8100

• 0x88a8

• 0x9100

This field is available when you select Transport Single VLAN as the customer VLAN type.

Inner TP ID

IP Settings

Select this check box to choose an interface IP from IP Address Pool drop down list.

Clear this check box to manually enter an interface IP in the Interface IP Address field.

Autopick Interface IP

Displays the IP Pool Type you have selected.

• Global

• Customer

• None

IP Pool Type

Enter an interface IP address.

This field is available only when you clear the Autopick Interface IP check box.

Interface IP Address

Choose an interface IP address from the IP Address Pool drop down list.

This field is available only if you select the Autopick Interface IP check box.

IP Address Pool
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Table 122: IP Service Order - Configure Site Settings (continued)

ActionField

Enter a valid IP address block size value in this field.

Range - 1 through 32

NOTE: Starting from Connectivity Services Director Release 2.1R1 onward, you can configure an
IP block size using a wider range from 1 through 32 while creating a full-mesh IP service order.

IP Block size

PE-CE Settings

Select a protocol from the list:

• BGP

• OSPF

• Static

Routing Protocol

Enter an OSPF area id.

Valid IP Range - 0.0.0.0 through 255.255.255.255

This field is available only if OSPF is selected as the routing protocol in the service definition.

OSPF Area ID

Enter an OSPF version number.

• Ver 2

• Ver 3

This field is available only if OSPF is selected as the routing protocol in the service definition.

OSPF Version

Enter a group name.

Range - 0 to 255 characters

This field is available only if BGP is selected as the routing protocol in the service definition.

Group Name

This field is available if BGP is selected as the routing protocol in the service definition.Local Address

Select this field if you want to automatically generate a Neighbour IP. You can edit this field if
you select Editable in Service Order check box.

This field is available only if BGP is selected as the routing protocol in the service definition.

Autopick Neighbour IP

Enter a vaild IP address in this field.

Range - 1.0.0.1 through 223.225.225.254, excluding 127.x.x.x

This field is available if BGP is selected as the routing protocol in the service definition.

Neighbour IP

Enter a Peer AS range in this field.

Range - 1 through 4294967295

This field is available if BGP is selected as the routing protocol in the service definition.

Peer AS
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Table 122: IP Service Order - Configure Site Settings (continued)

ActionField

Select the policy from the list.

Policies associated with other devices and policies created as part of the service is listed. You
can select more than one policy from the list.

You also have the option to:

• Select a policy from the list.

• Clear the current selection by clicking Clear.

You can also add or delete a policy while modifying the service.

Import Policy

Select the policy from the list.

Policies associated with other devices and policies created as part of the service is listed. You
can select more than one policy from the list.

• Select a policy from the list.

• Clear the current selection by clicking Clear.

You can add or delete a policy while modifying the service.

Export Policy

PIM Settings

Click Add to add a new row in the PIM Settings table.Add

Click Delete to delete a row from the PIM Settings table.Delete

Click the arrow in this field to select a device from the drop down list.Rendezvous Point (device)

Enter a group IP address.

Range - 224.0.1.0 through 239.255.255.255

Group Address

Click Update to update the Rendezvous Point (device) and Group Address to the PIM Settings
table.

Click Cancel to cancel any updates.

Update or Cancel

3. ClickOk after you enter the site settings details in the Site Settingswindow.

The site settings page is displayed.

4. Click Next.

The Review page is displayed.

You can examine andmodify the created service order parameters. Alternatively, you

can click the corresponding buttons at the top of the wizard page to navigate to the

specific pages.
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5. Click Done. The Confirmation dialogue box appears.

You can choose one of the following options:

• Save & Validate

• Save & Deploy

6. ClickOk to confirm the deployment option.

Specifying QoS Settings

CoS profiles enable the grouping of class-of-service (CoS) parameters and apply them

to one or more interfaces. Connectivity Services Director provides you with predefined

traffic types for each CoS profile that you create. These traffic types represent the most

common types of traffic for the device type. Each of these templates has preconfigured

values for all CoS parameters based on the typical application requirements. You can

change thepreconfiguredvaluesof theseparameters to suit your requirements. Todisplay

the CoS Profiles page, in Build mode, select CoS under Profile and Configuration

Management in the Tasks pane. The Manage CoS Profiles page appears.

If QoS is enabledon the service definition, configure theQoSSettings of theSite Settings

panel of the service order creation wizard.

1. In theQoS profile field, select a profile from the list.

TheQoS profile list displays the QoS profiles that are currently configured in the

Manage CoS Profiles page of the Connectivity Services Director application.

A QoS profile classifies traffic into defined service groups to provide the special

treatment of traffic across the network service.

Specifying Template Settings

The Template Settings page of the service order creation andmodification wizards

enables you to associate service templates with an E-Line, E-LAN, and IP service order.

You can apply only the templates that are previously configured in a service definition

with the corresponding service order. The Template Settings page is available in the

service order wizard only if the service definition that you selected to apply to the service

order containsa service template.Otherwise, theTemplateSettingspage is notdisplayed

in the service order wizard. You can perform template operations for all endpoints in a

service order.

If you defined a service template as the default service template, it is attached to the

endpoint by default. You have the flexibility to create and provision a dynamic attribute

in a service template. You canmark an attribute of a service template as dynamic, and

you can obtain the values for these dynamic attributes from a specific device. To create

a dynamic attribute, youmust first mark an attribute of a service template as dynamic

and then specify the device XPath for the dynamic attribute.

The Template Settings page is displayed before the Review page, which is the final step

of the service order wizard.
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In the Service Settings page of the Select Service Definition field of the service order

creation wizard, you can double-click a service definition name displayed in the table to

view the details of the definition in a popup dialog box. You can use this information to

determine if the service definition is appropriate for your deployment needs. To filter and

sort the display of service templates, enter the nameof the template as amatch criterion

in the Search box and click the Search icon. The page refreshes to display only the

template names that match with the search term. You can use the paging controls to

navigate across multiple pages of templates as necessary.

All the tasks that you can performwith service templates are presented in the Template

Settings page. The page is divided into three panes. The top half of the page displays a

table of selected endpoints. All the endpoints or UNIs that you selected in the preceding

pages of the service order wizard are displayed in this table. You can configure the

template pertaining to only one endpoint at a point in time. If the selected endpoints (in

previous pages of the wizard) contained amanually-entered unit number, that number

is displayed in the tableof selectedendpoints.Otherwise, theAuto-pick label is displayed.

The lower half of the page is divided into two panes. The left pane displays the template

selection table for the endpoint you selected. All the templates associated with the

service definition are displayed. You can add and delete templates using the template

selection table. The right pane displays all the parameters that you canmodify for a

selected service template. All such editable parameters are displayed in a consolidated

form of a configuration page. This pane is displayed after you select a template. If any

configuration parameter in template is set as a service-specific value, such attributes

are not displayed in this pane.

To associate a service template with a service order:

1. ClickAdd to include a service template for the endpoint. A dialog box is displayedwith

the list of service templatesassociatedwith the servicedefinition that is used to create

the service order. The templates selected in this dialog box are displayed in the

Template Selection table for the specified endpoint. Such templates are considered

to be attached to that endpoint.

If you specified a template as adefault template during the service definition creation,

the template is displayedbydefault in the template selection table. You canassociate

non-default templates with the service order by clicking the Add button.

2. Click the link in the template name to open the Template Details dialog box. The

template settings are displayed in the popup dialog box. For the selected template,

the Configuration Page is displayed in the lower-right pane of the Template Settings

page.

3. Modify any template-specific service components as necessary.

4. Click Save to submit the changes.

5. Select a template from the Template Selection table, and click Delete to remove the

template from being associated with the service order for a particular endpoint.
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Reviewing the Configured Settings

You can examine andmodify the created service order parameters in the Review page

of the Create IP Service Orderwizard.

If you want to modify a particular section in the review page, click the Edit button

corresponding to that section.

Click Done to save the service order. The Confirmation dialogue box appears.

Deploying the New Service

From the Confirmation dialogue box that appears, you can choose one of the following

options to deploy the service:

• Choose Save & Validate to validate the service.

• Choose Save & Deploy to deploy the service immediately.

The service order is now complete.

Release History Table DescriptionRelease

Starting from Release 2.1R1 onward, Connectivity Services Director supports a
mix of both 2-byte and 4-byte AS numbers while creating a full-mesh IP service
order.

2.1R1

Starting from Connectivity Services Director Release 2.1R1 onward, you can also
configure static routes by adding next table and community as option types while
creating a full-mesh IP service order.

2.1R1

Starting from Connectivity Services Director Release 2.1R1 onward, you can
configure an IP block size using a wider range from 1 through 32 while creating a
full-mesh IP service order.

2.1R1

Starting from Connectivity Services Director 2.0R4 onward, you can specify a
distinct routing instance name for each device when you deploy a service on
multiple devices while creating a full-mesh IP service order.

2.0R4

Related
Documentation

Stitching a Pseudowire to an IP Service on page 877•

• Creating a Hub-and-Spoke IP Service Order on page 901

• Selecting a Published IP Service Definition for a Service Order on page 921
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Creating a Hub-and-Spoke IP Service Order

ConnectivityServicesDirector canconfigureanddeploy IPhub-and-spokeserviceorders.

Creating a hub-and-spoke IP service order involves the following tasks:

1. Selecting the Service Definition on page 901

2. Configuring Service Parameters Information on page 902

3. Selecting N-PE Devices or Nodes on page 907

4. Setting Attributes for Endpoints or Nodes on page 907

5. Adding and Deleting UNI Interfaces on page 912

6. Setting Attributes for UNIs or Sites on page 913

7. Specifying QoS Settings on page 919

8. Specifying Template Settings on page 919

9. Reviewing the Configured Settings on page 921

10. Deploying the New Service on page 921

Selecting the Service Definition

To select a service definition on which to base the new service order:

1. From the Connectivity Services Director application, select Service View from the

Views list.

The workspaces that are applicable to routing and tunnel services are displayed.

2. From the Junos Space user interface, click the Deploy tab in the Task Categories

banner. The features that you can configure in this mode are displayed in the task

pane.

3. From the Service View pane, click the plus sign (+) to expand the tree and select the

type of service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. Select the IP Services and from the Tasks pane, select Service Provisioning >Manage

Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.
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6. From theManage Network Services page, select New > IP Service Order.

The Service Settings page in the Create IP Service Order wizard is displayed.

7. From theServiceDefinition field, clickSelect to choose the service definition youwant

to base your service order on. The Choose Service Definition inventory page displays

a view of only those published service definitions designed to work with the type of

services you need.

Based on the fields or parameters that you defined in the service definition to be

enabled for modification in the service order, the corresponding fields are available

for editing. The fields that are disabled for modification in the service order can only

be edited in the service definition.

8. Select the check box beside the service definition that youwant to associate with the

service order, and clickOK.

Configuring Service Parameters Information

In this topic you configure general settings, VPN settings that can be applied to all end

points, and routing protocol settings for the provider edge (PE) and customer edge (CE)

devices.

• Specifying General Settings on page 902

• Specifying PE-CE Settings Information on page 906

Specifying General Settings

To specify general information for an IP service order:
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1. Fill in the fields on the Service Settings page as indicated in Table 116 on page 882.

Table 123: IP Service Order - Service Settings

DescriptionField

General Settings

Type a unique name for the service. The service order name can consist of only letters,
numbers, and underscores.

Name

NOTE: Thenameyouspecify for an IPServiceOrder becomes the routing-instancename
in the device configuration when you deploy the service.

Type a description of the service.Comments

Click Select to select name of the enterprise customer that requests for a service.Customer

Click Clear to clear the current selection.

Service Definition • Click Select to choose a service definition from the Choose Service Definition pop-up.

The Service Order is created based on the service definition you choose.

Select the check box beside the service definition that you want to associate with the
service order, and clickOK.

• Click View to view details of the service definition you selected.

The type of Service Definition you choose determines the fields that are available in the
Connectivity Settings section, VPN Settings section, and the PE-CE Settings section of
the Settings Page of the IP Service Order wizard.

(Optional) Select this check box to create or associate LSPs.Enable LSP Association

Select the Create LSP check box to import an existing LSP service definition and also
select an LSP name pattern.

NOTE: You can also create an LSP name pattern of your preference, instead of using an
existing pre-defined pattern.

For information about creating an LSP name pattern, see “Creating a Name Pattern for
LSPs in the Service Order” on page 1643.

Select the Associate LSP check box to associate an existing LSP.

The type of Service Definition you choose will determine the Instance Type displayed in
the field.

Instance Type

Select this check box to specify a distinct instance name for each device.Enable Distinct Instance Name

NOTE: Starting from Connectivity Services Director 2.0R4 onward, you can specify a
distinct routing instance name for each device when you deploy a service onmultiple
devices while creating a hub-and-spoke IP service order.

Connectivity Settings
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Table 123: IP Service Order - Service Settings (continued)

DescriptionField

Select this check box to create a policy-based vrf instance.

Clear this check box to create a community-based vrf instance.

For more information on creating policies for an IP service, see “Creating Policies for an
IP Service” on page 934.

Policy Based Route Target

Clear this check box, to enable the Route Target field.

To override this setting in the service order, you can select the Editable in Service Order
check box in the create Layer 3 full-mesh service definition wizard.

Auto Pick Route Target

Specify the route target range in any of the following formats:

• AS Number format:

• AS Number Range: 1 through 4294967295

• IPv4 address format:

• If AS Number or IP is less than or equal to 65535, range is 0 through 65535.

• If AS Number or IP is greater than 65535, range is 0 through 4294967295.

NOTE: Youmust clear the Auto Pick Route Target check box to enable this field.

NOTE: Starting from Release 2.1R1 onward, Connectivity Services Director supports a
mix of both 2-byte and 4-byte AS numbers while creating a hub-and-spoke IP service
order.

Route Target

Select this check box to automatically generate a Hub Route Target.

Clear this check box to manually enter a Hub Route Target.

NOTE: The Auto Pick Hub Route Target check box is visible if the selected Instance Type
is vrf.

You can edit this field if you select the Editable in Service Order check box in the Create
Layer 3 Hub-and-Spoke Service Definitionwizard.

Auto Pick Hub Route Target

Specify the hub route target range in any of the following formats:

• prefix-number:assigned-number

Prefix-number can be any numeric value from 1 through 65535. Assigned-number can
be any numeric value from 0 through 2147483647.

• IPV4-address:assigned-number

IPV4-address canbeanyvalid IPv4address, andassigned-number canbeanynumeric
value from 0 through 65635.

NOTE: Tomanually enter the Hub Route Target, clear the Auto Pick Hub Route Target
check box.

Hub Route Target
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Table 123: IP Service Order - Service Settings (continued)

DescriptionField

Select this check box to automatically generate a Spoke Route Target.

Clear theAutoPickSpokeRouteTarget check box tomanually enter a SpokeRouteTarget.

NOTE: TheAutoPickSpokeRouteTarget checkbox is visible only if InstanceType selected
is vrf.

You can edit this field if you select the Editable in Service Order check box in the Create
Layer 3 Hub-and-Spoke Service Definitionwizard.

Auto Pick Spoke Route Target

Specify the spoke route target range in any of the following formats:

• prefix-number:assigned-number

Prefix-number can be any numeric value from 1 through 65535. Assigned-number can
be any numeric value from 0 through 2147483647.

• IPV4-address:assigned-number

IPV4-address canbeanyvalid IPv4address, andassigned-number canbeanynumeric
value from 0 through 65635.

Spoke Route Target

VPN Settings

Select this check box while creating a service definition to configure a separate label for
each VRF to provide double lookup and egress filtering.

This check box is visible only if the selected Instance Type is vrf.

VRF Table Label

Select this check box in the Create Layer 3 Full Mesh Service Definitionwizard to export
direct routes.

Export Direct Routes

You can select this check box in the Create IP Service Definitionwizard to enable internal
and external route leak as part of route target creation.

Enable Auto Export Routes

Select this check box in theCreate IPServiceDefinitionwizard to enable the internal route
leak feature as part of route target policy creation.

Import Internal Routes

Select this check box in theCreate IPServiceDefinitionwizard to enable the external route
leak feature as part of route target policy creation.

Import External Routes

Select this check box to enable multicast VPN (MVPN) settings.

If you select this check box, the Enable MC-LAG check box is disabled.

Enable MVPN

Default UNI Settings

Specify a value forMTUFactor in the range 1 through 1087902. The default value for MTU
Factor is 10.

The value you configure for MTU Factor should not exceed one tenth of the value you
configured for burst size.

NOTE: This field is enabled only if you selectMTUBased as the Burst Size.

MTU Factor
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Table 123: IP Service Order - Service Settings (continued)

DescriptionField

Specify a value for Burst Period in the range 10 through 1000. The default value for Burst
Period is 10.

NOTE: This field is enabled only when you select Line Rate Based as the Burst Size.

Burst Period

Specifying PE-CE Settings Information

YouconfigureVPNattributes that areusually common for all theendpoints in the service.

Depending on the service definition on which the service order is based, the values that

you provide vary.

If you do not expect these attributes to be the same on all endpoints, you can set them

to be the same for now and thenmake changes later, or you can skip this step and apply

the attribute values one at a time later.

Fill in the PE-CE Settings as indicated in Table 124 on page 906:

Table 124: IP Service Order - PE-CE Settings

DescriptionField

PE-CE Settings

The routing protocol in use is displayed.Routing Protocol

Select this check box to allow a service provisioner to override the AS number.

This check box is available if you select BGP as the routing protocol while creating the
service definition.

ASOveride

Range: 1 through 4294967295

This feature limits the number of unique destinations in a routing instance.

MaximumPrefixes

• ID Range Prefix: 1 through 65535

• ID Range Postfix: 0 through 4294967295

This check box is available only if you select OSPF as the routing protocol while creating
the service definition.

OSPF Domain ID

Choose an OSPF version from theOSPF Version list:

• Ver 2

• Ver 3

Junos OS supports OSPF version 2 (OSPFv2) and OSPF version 3 (OSPFv3).

This check box is available only if OSPF is selected as the routing protocol while creating
the service definition.

OSPF Version

Click Next
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The Node Settings page appears.

Selecting N-PE Devices or Nodes

In this topic you select the N-PE devices that you want to host the service endpoints.

To select endpoint N-PE devices:

1. Click Add in the Node Settings page of the Create IP Service Orderwizard to add a

device.

A new row is added to the existing table.

NOTE: You can create a new policy by clicking Create Policy.

This option is available if you select Policy Based Route Target check box

and clear the Auto Pick Route Target check box.

For more information on creating a policy, see “Creating Policies for an IP
Service” on page 934

2. Click the arrow in the name field.

3. From the list, select a device you want to add to the service.

You can select more than one device.

4. ClickOK.

The device is added to the table.

NOTE: Youcanmodify thedevice settingsby selecting the checkboxnext
to the device and clicking Edit.

ClickOk to save your changes.

Continue with modifying or entering the node parameters.

Setting Attributes for Endpoints or Nodes

If a service template is attached to the service definition, there is a link to that template

at thebottomof theEndpointSettings sectionof thewindow.For instructionsonworking

with service templates in service orders, see “Creating aServiceOrder Based on aService

Definition with a Template” on page 927.

You set attributes for each endpoint in the service from the Node Settings page.

For each endpoint, the Node Settingswindow shows the value for each UNI attribute.
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You can enter topology settings, create static routes on the service, and enterMVPN/PIM

settings in the Node Settings page. To specify these settings for a CE device on the Node

Settings page:

1. Select the device and click Edit.

The Node Settings window appears.

2. Fill in the fields to configure or change topology settings as indicated in

Table 125 on page 908:

Table 125: IP Service Order - Topology Settings

DescriptionField

The type of network circuit in use is displayed in this field:

• Full Mesh

• Hub-and-spoke

Topology

Clear this check box.

If you select the Enable MC- LAG check box in the General Settings window, the Is Stitching Point
check box is available for each endpoint. If you select the Is Stitching Point check box, all the
parameters of that endpoint are disabled.

Is Stitching Point

Select this check box to enable the node to function as a hub.

Clear this check box if you want the device to function as a spoke.

NOTE: This field is not applicable for full-mesh IP services.

Is Hub

Select a policy from the list.

Policies associated with other devices and policies created as part of the service is listed. You can
select more than one policy.

You have the option to:

• Select a policy from the list.

• Clear the current selection by clicking Clear.

NOTE: You can also add or delete a policy while modifying the service.

Import RT Policy

Select a policy from the list

Policies associated with other devices and policies created as part of the service is listed. You can
select more than one policy.

You have the option to:

• Select a policy from the list.

• Clear the current selection by clicking Clear.

NOTE: You can also add or delete a policy while modifying the service.

Export RT Policy
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Table 125: IP Service Order - Topology Settings (continued)

DescriptionField

Select this check box to assign the Route Distinguisher automatically.

This field is enabled if you have selected the Editable in Service Order check box in the service
definition.

Auto pick Route
Distinguisher

Enter a valid Route Distinguisher range:

• as-number:id—Range: 1 through 65535

• ip-address:id—Range:

• ip address: any unique unicast address

• id: 1 through 65535

Each routing instancemust have a unique route distinguisher (RD) associated with it. The RD is
used to place bounds around a VPN so that the same IP address prefixes can be used in different
VPNs without any overlap.

This field is available only if you have selected full-mesh as the service type while creating the
service definition.

Route Distinguisher

Select this check box to assign the Hub Route Distinguisher automatically.

This field is enabled if you selected the Editable in Service Order check box in the service definition.

Auto pick Hub Route
Distinguisher

Enter a valid Hub Route Distinguisher range:

• as-number:id—Range: 1 through 65535

• ip-address:id—Range:

• ip address: any unique unicast address

• id: 1 through 65535

This field is available only if you selected hub-and-spoke as the service type while creating the
service definition.

Hub Route Distinguisher

Select this check box to assign the Spoke Route Distinguisher automatically.

This field is enabled only if you selected the Editable in Service Order check box in the service
definition.

Auto pick Spoke Route
Distinguisher

Enter a valid Spoke Route Distinguisher range:

• as-number:id—Range: 1 through 65535

• ip-address:id—Range:

• ip address: any globally unique unicast address

• id: 1 through 65535

This field is available only if you selected hub-and-spoke as the service type while creating the
service definition.

SpokeRouteDistinguisher

3. Fill in the fields to create static routes on the service as indicated in

Table 119 on page 889:
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Table 126: IP Service Order - Static Routes

ActionField

Enter the endpoint for the static route in this field.

• IP address–Destination IP address that the router uses to identify packets.

• Network mask–Network mask for associated IP subnet.

Netmask value: 0-32

Destination Prefix

Choose an option type from theOption Type list:

• next-hop

• next-table

• community

NOTE: Starting from Connectivity Services Director Release 2.1R1 onward, you can also configure
static routes by adding next table and community as option types while creating a hub-and-spoke
IP service order.

Option Type

Enter a valid IP address in this field. You can havemultiple hop for every destination prefix.

This field is available only if you choose next-hop as theOption Type.

Hop Address

Choose one of the following options as the route table name:

• inet.0

• inet.3

This field is available only if you choose next-table as theOption Type.

Route Table Name

Choose one of the following values as the member type:

• no-export

• no-advertise

• no-export-subconfed

This field is available only if you choose community as theOption Type.

Member

Click Add to a static route to the Static Route Table.

A new row is added to the table.

Add

Select the row you want to delete and click Delete to remove the static route from the Static Route
Table.

Delete

The Attribute column displays theOption Type you selectAttribute

The Attribute Value column displays the corresponding value for everyOption Type you select.Attribute Value

4. Specify the MVPN and PIM Settings as indicated in Table 127 on page 911:

Copyright © 2019, Juniper Networks, Inc.910

Connectivity Services Director User Guide



NOTE: TheMVPN and PIM Settings sections are displayed only if you
select the Enable MVPN check box in the Service Settings page of the

Create IP Service Orderwizard.

Table 127: IP Service Order - MVPN and PIM Settings

DescriptionField

PIM Settings

Choose the PIMMode from the list.

Only sparse mode is currently supported.

PIMMode

MVPNSettings

Chooseoneof the followingMVPNmode fromtheMVPNMode
list:

• rpt-spt

• spt-only

MVPNMode

Choose one of the following MBGPMVPN site type from the
list:

• sender

• receiver

Site Type

Specify the provider tunnel name to configure virtual private
LAN service (VPLS) flooding of unknown unicast, broadcast,
andmulticast traffic using point-to- multipoint LSPs in this
field. You can also configure point-to-multipoint LSPs for
MBGPMVPNs.

Provider Tunnel Name

Select this check box to configure the upstreammulticast hop
(UMH).

UpstreamMulticast Hop

Specify the import targets for sender and receiver sites in this
field.

Select the Sender radio button to import targets for sender
sites, select the Receiver radio button to import targets for
receiver sites.

Import Target

Specify the import targets specifically for sender sites or
receiver sites in this field. You can also borrow import targets
from a configured unicast route target.

NOTE: A sender site export route target is always advertised
when security association routes are exported. By default, the
VPN routing and forwarding (VRF) import and export route
targets (configuredeither usingVRF import andexport policies
or using the vrf-target statement) are used for importing and
exporting routes with the MBGPMVPN network layer
reachability information (NLRI).

Import Unicast Target
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Table 127: IP Service Order - MVPN and PIM Settings (continued)

DescriptionField

Select this check box to specify the export target to enable
you to override the IP export route targets used for importing
and exporting routes for the MBGPMVPN network layer
reachability information (NLRI).

Export Unicast Target

Select this check box to enable automatic selection of an
export target if a configuration is not provided.

Auto pick Export Target

Specify the target community value tobeusedwhenexporting
sender and receiver site routes in this field.

You can specify this value manually if you clear the Autopick
Export Target check box.

Target Community

ClickOk to accept all configured values.

Click Cancel to reject all configured values.

5. Click Nextwhen you have finished configuring node settings.

The Site Settings page is displayed.

Adding and Deleting UNI Interfaces

In the Site Settings page, you can add or delete UNI interfaces on the PE devices that

participate in a service.

To add a UNI interface on a selected device:

1. Click Add to add a new row to the table

2. From the newly added row, click the arrow in the Device Name field.

A list of UNI devices is displayed.

3. Select the check boxes beside the UNIs that you want to associate with the service

order and clickOk. You can select more than one UNI.

The table now displays the UNI interfaces configured on the selected device.

TodeleteaUNI Interface fromaselecteddevice, select thecheckboxnext to the interface

you want to delete, and click the Delete button above the table.

NOTE: If the deleted UNI is the only UNI selected from the device, then the
device is deleted from the service configuration.
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Setting Attributes for UNIs or Sites

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Site Settings section of the screen. For instructions on

working with service templates in service orders, see “Creating a Service Order Based on

a Service Definition with a Template” on page 927.

This part of the create Ethernet service order procedure sets the attributes for each UNI

or interface in the service. Selection is made using the Site Settings screen.

The interface shown in theUNI Interface field is automatically selectedby theConnectivity

Services Director application, which chooses the UNI that has the highest available

capacity among interfaces that are in the Up state. To calculate the available capacity

of the interface, the system subtracts the bandwidth reserved for each service deployed

on that interface from the total capacity of the interface.

For each endpoint, the Site Settings page shows the value for each UNI attribute.

Tomodify the values of a UNI interface:

1. Tomodify the device settings, select the device by clicking the check box next to it.

The row is highlighted in blue.

2. You can alter details in the row based on Table 128 on page 913:

Table 128: IP Service Order - Modify or alter UNI Interface

DescriptionField

Displays the name of the device associated with the UNI.Device Name

Displays the selected interface name.

To add a new interface:

a. Click the arrow in the Interface Name field.

b. To select the interface, select the check box that corresponds to the interface.

c. ClickOk.

The interface name is displayed and the corresponding fields are updated.

Interface Name

Displays the interface’s status.

• A Green Up arrow indicates devices that are up and running.

• A Red Down arrow indicates devices that are down.

Interface Status

Select this check box to assign the Unit ID automatically.

Clear this check box to assign the Unit IDmanually.

Unit Autopick
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Table 128: IP Service Order - Modify or alter UNI Interface (continued)

DescriptionField

Enter a value in this field.

Range: 1 through 1073741823

This field is available only if you clear the Unit Autopick checkbox.

Unit ID

Select one of the following options from the list:

• Port

• Dot1Q

• QinQ(All)

• QinQ(Single)

Specifying theDot1QEthernet option enables you toapply aUnit ID, a singleVLAN ID, aVLANRange,
or a VLAN list to the service order.

Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN Range, or a VLAN
list to the serviceorder. For an IP servicedeployedonadual tagged interface, the inner tagdetermines
the VPN routing and forwarding instance(VRF).

VLAN Tagging

Select this check box to assign the VLANOuter ID automatically.

Clear this check box to assign the VLANOuter IDmanually.

VLANAutopick

Enter a value in this field.

This field is available if you clear the Unit Autopick check box.

VLANOuter

Enter a value in this field.

This field is available if you choose Dot1Q or QinQ(All) as the VLAN Tagging value.

VLAN Inner

Select this check box to assign the IP address automatically.

Clear this check box to assign the IP address manually.

You cannot edit this check box if you have not selected the Editable in Service Order check box in
the service definition.

IP Autopick

You can enter an IP address in this field if you have cleared the IP Autopick check box.

You can choose an IP address from the list if you have selected the IP Autopick check box.

IP Address

Enter a valid IP subnet in this field.IP Subnet
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To configure or edit Site Settings:

1. Select the interface that you want to edit by clicking the check box next to it.

The selected row is highlighted in blue.

2. You can edit the interface details by following Table 129 on page 915:

Table 129: IP Service Order - Configure Site Settings

ActionField

Site Settings

The name of the interface you choose is displayed in this field.Interface

Type a description that describes the UNI Interface.

Range: 0 to 128 characters.

Description

UNI Settings

Choose an encapsulation value from the Encapsulation list:

• Port

• Dot1Q

• QinQ(Single)

• QinQ(All)

If you choose Port as the encapsulation value, no field in the UNI settings section is enabled.

If you choose Dot1Q as the encapsulation value, Auto pick Interface Unit and Auto pick VLAN ID
check boxes are enabled.

If you chooseQinQ(Single) orQinQ(All) as the encapsulation value, Customer VLAN Type and
Outer TP ID fields are enabled.

Encapsulation

Select this check box to automatically assign the Unit ID.

Clear this check box to manually enter the Unit ID.

Auto pick Interface Unit

Enter a unit ID in this field.

Range - 1 through 16385

This field becomes available when you clear the Auto pick Interface Unit check box.

Unit ID

Select this check box to assign the VLAN ID automatically.

Clear this check box to manually enter the VLAN ID.

Auto pick VLAN ID

Enter a VLAN ID in this field.

Range - 1 through 4094

This field becomes available when you clear the Auto pick VLAN ID check box.

VLAN ID
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Table 129: IP Service Order - Configure Site Settings (continued)

ActionField

Choose a customer VLAN type from the Customer VLAN Type drop down box:

• Transport All Traffic—Transports traffic from all VLANs across the network

• Transport Single VLAN—Transports traffic for a specific VLAN across the network.

This field is available onlywhen theencapsulation value you selected isQinQ(Single)orQinQ(All)

Customer VLAN Type

Enter a Customer VLAN ID in this field.

Range - 1 through 4094

This field is available only when you select Transport Single VLAN as the Customer VLAN type.

Customer VLAN ID

Choose a value form theOuter TP ID list:

• empty (default)

• 0x8100

• 0x88a8

• 0x9100

Outer TP ID

Choose a value form the Inner TP ID list:

• empty (default)

• 0x8100

• 0x88a8

• 0x9100

This field is available when you select Transport Single VLAN as the customer VLAN type.

Inner TP ID

IP Settings

Select this check box to choose an interface IP from IP Address Pool drop down list.

Clear this check box to manually enter an interface IP in the Interface IP Address field.

Autopick Interface IP

Displays the IP Pool Type you have selected.

• Global

• Customer

• None

IP Pool Type

Enter an interface IP address.

This field is available only when you clear the Autopick Interface IP check box.

Interface IP Address

Choose an interface IP address from the IP Address Pool list.

This field is available only if you select the Autopick Interface IP check box.

IP Address Pool
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Table 129: IP Service Order - Configure Site Settings (continued)

ActionField

Enter a valid IP address block size value in this field.

Range - 1 through 32

NOTE: Starting from Connectivity Services Director Release 2.1R1 onward, you can configure an
IP block size using a wider range from 1 through 32 while creating a hub-and-spoke IP service
order.

IP Block size

PE-CE Settings

Select a protocol from the list:

• BGP

• OSPF

• Static

Routing Protocol

Enter an OSPF area id.

Valid IP Range - 0.0.0.0 through 255.255.255.255

This field is available only if OSPF is selected as the routing protocol in the service definition.

OSPF Area ID

Enter an OSPF version number.

• Ver 2

• Ver 3

This field is available only if OSPF is selected as the routing protocol in the service definition.

OSPF Version

Enter a group name.

Range - 0 to 255 characters

This field is available only if BGP is selected as the routing protocol in the service definition.

Group Name

This field is available if BGP is selected as the routing protocol in the service definition.Local Address

Select this field if you want to automatically generate a Neighbour IP. You can edit this field if
you select Editable in Service Order check box.

This field is available only if BGP is selected as the routing protocol in the service definition.

Autopick Neighbour IP

Enter a vaild IP address in this field.

Range - 1.0.0.1 through 223.225.225.254, excluding 127.x.x.x

This field is available if BGP is selected as the routing protocol in the service definition.

Neighbour IP

Enter a Peer AS range in this field.

Range - 1 through 4294967295

This field is available if BGP is selected as the routing protocol in the service definition.

Peer AS
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Table 129: IP Service Order - Configure Site Settings (continued)

ActionField

Select the policy from the list.

Policies associated with other devices and policies created as part of the service is listed. You
can select more than one policy from the list.

You also have the option to:

• Select a policy from the list.

• Clear the current selection by clicking Clear.

You can also add or delete a policy while modifying the service.

Import Policy

Select the policy from the list.

Policies associated with other devices and policies created as part of the service is listed. You
can select more than one policy from the list.

• Select a policy from the list.

• Clear the current selection by clicking Clear.

You can add or delete a policy while modifying the service.

Export Policy

PIM Settings

Click Add to add a new row in the PIM Settings table.Add

Click Delete to delete a row from the PIM Settings table.Delete

Click the arrow in this field to select a device from the drop down list.Rendezvous Point (device)

Enter a group IP address.

Range - 224.0.1.0 through 239.255.255.255

Group Address

Click Update to update the Rendezvous Point (device) and Group Address to the PIM Settings
table.

Click Cancel to cancel any updates.

Update or Cancel

3. ClickOk after you enter the site settings details in the Site Settingswindow.

Alternatively, click Cancel if you do not want to make any change.

The site settings page is displayed.

4. Click Next.

The Review page is displayed.

You can examine andmodify the created service order parameters. Alternatively, you

can click the corresponding buttons at the top of the wizard page to navigate to the

specific pages.
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5. Click Done. The Confirmation dialogue box appears.

You can choose one of the following options:

• Save & Validate

• Save & Deploy

6. ClickOk to confirm the deployment option.

Specifying QoS Settings

CoS profiles enable the grouping of class-of-service (CoS) parameters and apply them

to one or more interfaces. Connectivity Services Director provides you with predefined

traffic types for each CoS profile that you create. These traffic types represent the most

common types of traffic for the device type. Each of these templates has preconfigured

values for all CoS parameters based on the typical application requirements. You can

change thepreconfiguredvaluesof theseparameters to suit your requirements. Todisplay

the CoS Profiles page, in Build mode, select CoS under Profile and Configuration

Management in the Tasks pane. The Manage CoS Profiles page appears.

If QoS is enabledon the service definition, configure theQoSSettings of theSite Settings

panel of the service order creation wizard.

1. In theQoS profile field, select a profile from the list.

TheQoS profile list displays the QoS profiles that are currently configured in the

Manage CoS Profiles page of the Connectivity Services Director application.

A QoS profile classifies traffic into defined service groups to provide the special

treatment of traffic across the network service.

Specifying Template Settings

The Template Settings page of the service order creation andmodification wizards

enables you to associate service templates with an E-Line, E-LAN, and IP service order.

You can apply only the templates that are previously configured in a service definition

with the corresponding service order. The Template Settings page is available in the

service order wizard only if the service definition that you selected to apply to the service

order containsa service template.Otherwise, theTemplateSettingspage is notdisplayed

in the service order wizard. You can perform template operations for all endpoints in a

service order.

If you defined a service template as the default service template, it is attached to the

endpoint by default. You have the flexibility to create and provision a dynamic attribute

in a service template. You canmark an attribute of a service template as dynamic, and

you can obtain the values for these dynamic attributes from a specific device. To create

a dynamic attribute, youmust first mark an attribute of a service template as dynamic

and then specify the device XPath for the dynamic attribute.

The Template Settings page is displayed before the Review page, which is the final step

of the service order wizard.
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In the Service Settings page of the Select Service Definition field of the service order

creation wizard, you can double-click a service definition name displayed in the table to

view the details of the definition in a popup dialog box. You can use this information to

determine if the service definition is appropriate for your deployment needs. To filter and

sort the display of service templates, enter the nameof the template as amatch criterion

in the Search box and click the Search icon. The page refreshes to display only the

template names that match with the search term. You can use the paging controls to

navigate across multiple pages of templates as necessary.

All the tasks that you can performwith service templates are presented in the Template

Settings page. The page is divided into three panes. The top half of the page displays a

table of selected endpoints. All the endpoints or UNIs that you selected in the preceding

pages of the service order wizard are displayed in this table. You can configure the

template pertaining to only one endpoint at a point in time. If the selected endpoints (in

previous pages of the wizard) contained amanually-entered unit number, that number

is displayed in the tableof selectedendpoints.Otherwise, theAuto-pick label is displayed.

The lower half of the page is divided into two panes. The left pane displays the template

selection table for the endpoint you selected. All the templates associated with the

service definition are displayed. You can add and delete templates using the template

selection table. The right pane displays all the parameters that you canmodify for a

selected service template. All such editable paramters are displayed in a consolidated

form of a configuration page. This pane is displayed after you select a template. If any

configuration parameter in template is set as a service-specific value, such attributes

are not displayed in this pane.

To associate a service template with a service order:

1. Click Add to include a service template for the endpoint. The templates selected in

this dialogboxaredisplayed in theTemplateSelection table for the specifiedendpoint.

Such templates are considered to be attached to that endpoint.

When you click Add, a dialog box is displayed with the list of service templates

associated with the service definition that is used to create the service order. If you

specified a template as a default template during the service definition creation, the

template is displayed by default in the template selection table. You can associate

non-default templates with the serviceo rder by clicking the Add button.

2. Click the link in the template name to open the Template Details dialog box. The

template settings are displayed in the popup dialog box. For the selected template,

the Configuration Page is displayed in the lower-right pane of the Template Settings

page.

3. Modify any template-specific service components as necessary.

4. Click Save to submit the changes.

5. Select a template from the Template Selection table, and click Delete to remove the

template from being associated with the service order for a particular endpoint.
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Reviewing the Configured Settings

You can examine andmodify the created service order parameters in the Review page

of the Create IP Service Orderwizard.

If you want to modify a particular section in the review page, click the Edit button

corresponding to that section.

Click Done to save the service order. The Confirmation dialogue box appears.

Deploying the New Service

From the Confirmation dialogue box that appears, you can choose one of the following

options to deploy the service:

• Choose Save & Validate to validate the service.

• Choose Save & Deploy to deploy the service immediately.

The service order is now complete.

Release History Table DescriptionRelease

Starting fromRelease 2.1R1 onward, Connectivity Services Director supports amix
of both 2-byte and 4-byte AS numberswhile creating a hub-and-spoke IP service
order.

2.1R1

Starting from Connectivity Services Director Release 2.1R1 onward, you can also
configure static routes by adding next table and community as option types while
creating a hub-and-spoke IP service order.

2.1R1

Starting from Connectivity Services Director Release 2.1R1 onward, you can
configure an IP block size using a wider range from 1 through 32 while creating a
hub-and-spoke IP service order.

2.1R1

Starting from Connectivity Services Director 2.0R4 onward, you can specify a
distinct routing instance name for each device when you deploy a service on
multiple devices while creating a hub-and-spoke IP service order.

2.0R4

Related
Documentation

Stitching a Pseudowire to an IP Service on page 877•

• Creating a Full Mesh IP Service Order on page 879

• Selecting a Published IP Service Definition for a Service Order on page 921

Selecting a Published IP Service Definition for a Service Order

To select a service definition on which to base the new service order:
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1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the Tasks pane, select Service Provisioning > Deploy Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

6. In theManage Network Services page, select New > IP Service Order.

TheChooseServiceDefinition inventory page,which openswhen you clickSelect from

the Service Definition Name field of the Service Settings page of the service order

creation wizard, displays a view of only those published service definitions designed

to work with IP services you need.

7. Select the service definition you want to base your service order on, then click Next

to display the Service Parameterswindow.

Related
Documentation

Stitching a Pseudowire to an IP Service on page 877•

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901
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Entering IP Service Order Information

You, the Service Activator must set settings for an IP service order, including general

settings, VPN settings that are applied to all end points, and routing protocol settings

for the PE and CE devices.

1. Setting General Settings on page 923

2. Entering VPN and Connectivity Settings Information on page 923

3. Entering PE-CE Settings on page 925

Setting General Settings

Before You Begin

• Youmust add the customer to the database that requested the service order before

proceeding. See “Adding a New Customer” on page 697.

Youmust specify the following general informationabout the service order in theGeneral

Settings section of the Service Parameters page:

1. In the Name field, enter a unique name for the IP service.

The service order name can consist of only letters, numbers, and underscores. It must

be no longer than 50 characters.

NOTE: The name you specify for an IP service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “ospf”, as the name of a service order.

2. In the Customer drop-down , select the customer who requested the service.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 697.

3. In theComments field, enter adescriptionof the serviceno longer than200characters.

This description appears in information screens about the request or service instance

created from the request.

You cannot change the Route Target field. Route targets are always selected

automatically.

Entering VPN and Connectivity Settings Information

Youmust set VPNattributes that are usually common for all the endpoints in the service.

The values that you enter vary, depending on the service definition on which the service

order is based.
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If these attributeswill not be the sameon all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later.

To set attributes common tomost endpoints on a service:

1. The Autopick VLAN ID option is automatically selected for Network Activate to

automatically chose the VLAN ID. Deselect the check box if you want to manually

assigned the VLAN ID.

The VLAN ID text box appears.

2. If you deselected the Autopick VLAN ID option, enter a value in the VLAN ID field.

3. The Autopick Route Target option is selected, and you cannot deselect it. Network

Activate automatically selects the route target.

4. The Autopick Route Distinguisher option is selected, and you cannot deselect it.

5. The Autopick Interface IP Address option is selected, and you cannot deselect it.

Network Activate automatically selects the interface IP address.

6. The VRF Table label option is selected, and you cannot deselect it. Network Activate

automatically selects the interface IP address.
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Entering PE-CE Settings

In the PE-CE Settings section of the Service Parameters page, depending on the PE-CE

routing protocol—OSPF/Static Route or BGP/Static Route—do one of the following:

• If BGP/Static Route routing protocol is specified in the service definition:

a. The AS override option is selected to allow a service provisioner to override the AS

number. Clear the AS override check box to prevent a service provisioner from

overriding the AS number.

b. Enter a value for the maximum number of prefixes accepted by a PE router from a

CE router.

• IfOSPF/Static Route routing protocol is specified in the service definition, in theOSPF

domain ID field, enter a IP address.

You can enter from 1.0.0.1 to 223.255.255.254. excluding 127.x.x.x.

1. Click Next.

The Node Settings page appears.

Related
Documentation

Stitching a Pseudowire to an IP Service on page 877•

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901

• Selecting a Published IP Service Definition for a Service Order on page 921

Selecting Endpoint PE Devices or Nodes

NOTE: The Choose Endpointswindow, which you can open by clicking Add

above the Nodes table on the Node Parameters page of the Create L3VPN
Service Order wizard, shows only assigned NPE devices that have an AS
number configured. If you do not see the device you are looking for, use the
CLI on the device to check for and assign an AS number.

N-PE devices that are L2VPN-only will not appear.

To select endpoint N-PE devices:

925Copyright © 2019, Juniper Networks, Inc.

Chapter 35: Service Provisioning: Managing IP Service Orders



1. In the Node Parameters page, click Add in the Service Nodes table. From the Choose

Endpoints dialog box that appears, select the devices that you want to participate in

the service. Use the multiple selection feature to select one or more devices.

NOTE: In the Choose Endpoints dialog box, you can sort and segregate
the devices and their corresponding interfaces based on the roles of the
devices to easily and quickly view only the devices of interest. Click the
down arrow on the Filter Rolemenu, and select P2E to view only the

provider edgedevices,P to viewonly the provider devices, and L2E to view

only Layer 2 Ethernet devices.

2. Based on the devices you select in the top half of the dialog box, the interfaces that

are present in the selected device are displayed in the lower half of the dialog box.

Select the check boxes next to the interfaces that you want to associate with the

service.

3. ClickOK.

The Node Parameterswindow appears.

4. Continue with modifying or entering the node parameters.

Related
Documentation

Stitching a Pseudowire to an IP Service on page 877•

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901

• Selecting a Published IP Service Definition for a Service Order on page 921
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Creating a Service Order Based on a Service Definition with a Template

Creating a service order using a service definition with service templates attached to it

facilitates endpoint configuration.

Bymeansof a template, a number of service attributes identifiedby the service definition

designer can be not only applied as a group to one or more endpoints in a service order,

but also, in some cases, edited. Some attributes can only be set by service provisioners.

For this reason, servicedefinitiondesigners canmake these values editableby the service

provisioner during service order creation.

A service definition can havemultiple templates attached to it. If you use a definition

with more than one template, you are not obliged to apply the same settings to all

endpoints. You can create a service order in which each endpoint is configured using a

different template. In other words, each endpoint can use a subset of templates defined

in the service definition, and there, template choice is per service order.

Fromaserviceprovisioner’sperspective, theservice template takes the formofacollection

of flexible service attributes accessible through a link in the service order.

This topic describes how toworkwith a service template fromwithin a service order, that

is, while creating the service order.

These instructions assume that the service order is based on a service definition that has

at least one template attached to it. The instructions apply to a definition with multiple

templates, because the procedure for a definition with a single template is simpler.

To see if a definition has any templates before you begin creating a service order, view

the details of the definition on the Service Settings page of the Select Service Definition

field of Create Service Order. The presence or absence of an attached Service Template

is indicated below Name and Type.

To configure a service order based on a service definition with multiple templates:

1. To start creating a service order, follow the instructions in the topic listed below that

is relevant to your service order type :

• Creating an E-Line Service Order on page 784

• Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827

• Creating a Point-to-Multipoint E-LAN Service Order on page 847

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901

2. At the Node Parameters page, with an endpoint selected, make the appropriate

selection or enter the appropriate data (guidelines for this are in “Creating an E-Line

Service Order” on page 784).
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3. (Optional for a service definition containing multiple templates). Examine all the

attributes in all the templates to determine whether to apply all templates to all

endpoints. You can delete templates and add templates back at will.

4. To display and, if necessary, edit the attributes a page contains, select the page in the

panel on the left.

On the right, underneath the name of the page, appear the attributes on the selected

page of the template.

Usually the names of the attributes are ambiguous (for example, “description,”),

therefore youmustmouse over the field next to the name to see its context in the DMI

schema hierarchy.

5. For each page in each applicable template, make the appropriate changes in the field

on the right.

6. (Optional) If you determine that one of the templates contained in the definition is

superfluous, select it in the panel on the left.

The name of the first page of the template appears at the top of the panel on the

right.

7. Click the red “X” icon near the top of the panel on the left.

The template disappears.

NOTE: If you delete a template bymistake, you can add it again. Click the
green “+” icon.

The Add Template window appears, displaying a list of all the templates
previously deleted from the current endpoint’s group of flexible service
attributes.

Select the templates you want to add, and click Add Template.

The Flexible Service Attributes window reappears, displaying the newly
added templates

8. When you have finished configuring the current endpoint’s group of flexible service

attributes, clickOK.

The Endpoint Settings page reappears.

9. (Optional) Repeat the preceding steps for other endpoints.

To verify your work:
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1. In Deploy mode, select a service from the Service View pane, and navigate to Service

Provisioning > Deploy Services in the task pane, select the service you deployed, and

select View Service Configuration Change from the Actions drawer.

The Service Configurationwindow opens.

2. Select the appropriate device from the panel on the left.

If a template was deployed to the device, the Template Configuration tab appears to

the right of the Service Configuration tab.

3. Click the Template Configuration tab to display the configlet that was deployed as a

result of the template.

Related
Documentation

Stitching a Pseudowire to an IP Service on page 877•

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901

• Selecting a Published IP Service Definition for a Service Order on page 921

• Entering IP Service Order Information on page 923

• Selecting Endpoint PE Devices or Nodes on page 925

Deploying an IP Service Order

Youmust deploy a service for it to run on devices in the network.

To deploy the service, make selections from theManage Service Orderswindow.

1. Select Service View from the View Selector. The workspaces that are applicable to

network and tunnel services are displayed.

2. From the Connectivity Services Director user interface, click the Deploy icon in the

Connectivity Services Director banner. The functionalities that you can configure in

this mode are displayed in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select a E-Line service.

• Expand the E-LAN Services tree to select a E-LAN service.

5. From the Tasks pane, select Service Provisioning > Deploy Services.
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TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

6. Select the check box next to an IP service in the Manage Network Services page. The

corresponding service orders for the selected service are displayed in the Manage

Service Orders page in the lower half of the main display area.

7. Select the check box next to the IP service order you want to deploy.

8. Perform one of these actions from Deploy mode in the Service View of Connectivity

Services Director :

• To deploy the service immediately, select Deploy now and then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

and then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

• To validate the service, click Validate.

9. Use theDeployConfigurationpage toview the jobandmonitor the statusof the service

deployment.

Related
Documentation

Stitching a Pseudowire to an IP Service on page 877•

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901

• Selecting a Published IP Service Definition for a Service Order on page 921

• Entering IP Service Order Information on page 923

• Selecting Endpoint PE Devices or Nodes on page 925

• Creating a Service Order Based on a Service Definition with a Template on page 927
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Creating aMulticast VPN Service Order

This topic describes how to use the Connectivity Services Director application to create

a Multicast VPN (MVPN) service order.

NOTE: Multicast VPN services are supported on LN2600 andMX devices
only.

1. Select Service View from the View Selector. The workspaces that are applicable to

network and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP Ethernet service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the Tasks pane, select Service Provisioning > Deploy Services.

TheManageNetworkServicespage isdisplayed in the tophalf of the rightpane,which

displays all of the configured services. The Manage Service Orders page is displayed

in the bottom half of the right pane, which displays all of the service orders

corresponding to a service.

6. To select a service definition onwhich tobase thenewservice order, from theNetwork

Services page, select New> IP Service Order.

7. In the Service Parameterswindow, from the Select Service Definition field, select the

service definition upon which you want to base your service order.

8. In the Service Parameterswindow, enter the service attributes-related information in

the relevant fields as described in the following table:

DescriptionField

The service definition upon which this service order is based.Service Definition

Type a name for the service order.Name
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DescriptionField

Enter the customer for which you are creating the service order.Customer

Enter comments to describe the service order (optional).Comments

(Optional) Select this check box to create or associate LSPs.

Select the Create LSP check box to import an existing LSP service definition and also select
an LSP name pattern.

NOTE: You can also create an LSP name pattern of your preference, instead of using an
existing pre-defined pattern.

For information about creating an LSP name pattern, see “Creating a Name Pattern for LSPs
in the Service Order” on page 1643.

Alternatively, you can select the Associate LSP check box to associate an existing LSP with
a pattern provided for the service you create.

Youmust enter the LSP Regex value in the Node Settings page to associate LSPs with a
pattern.

Enable LSP Association

If selected, this checkbox indicates that the serviceorder is intended to function inaMulticast
VPN. This check box is selected if it was selected in the service definition upon which this
service order is based.

MVPN

TheVPNsettings listed in thispanel correspond to thesettingsselected in theservicedefinition
upon which this service order is based.

VPN Settings

This checkbox is selectedautomatically if itwas selected in the service definition uponwhich
this service order is based.

Autopick VLAN ID

This checkbox is selectedautomatically if itwas selected in the service definition uponwhich
this service order is based.

Autopick Hub Route Target

This checkbox is selectedautomatically if itwas selected in the service definition uponwhich
this service order is based.

Autopick Spoke Route Target

This checkbox is selectedautomatically if itwas selected in the service definition uponwhich
this service order is based.

AutopickHubRouteDistinguisher

This checkbox is selectedautomatically if itwas selected in the service definition uponwhich
this service order is based.

Autopick Spoke Route
Distinguisher

This checkbox is selectedautomatically if itwas selected in the service definition uponwhich
this service order is based.

Autopick Interface IP Address

This checkbox is selectedautomatically if itwas selected in the service definition uponwhich
this service order is based.

VRF Table Label

This checkbox is selectedautomatically if itwas selected in the service definition uponwhich
this service order is based.

Export Direct Routes

PE-CE Settings

Copyright © 2019, Juniper Networks, Inc.932

Connectivity Services Director User Guide



DescriptionField

OSPF/Static Route–This routing protocol corresponds to the protocol selected in the service
definition upon which this service order is based.

Routing Protocol

This field is optional.

Range: 1.0.0.1 to 223.255.255.254 (excluding 127.x.x.x)

OSPF domain ID

9. Click Next.

10. Select the device for which you want to implement the service order.

11. Click Next.

12. In the Site Settingswindow, enter information as described in the following table:

DescriptionField

Choose Endpoints

Add the devices for which you intend to implement this service order.Device

Select the interface on each device for which you intend to implement this service order.UNI Interface

Enter the description for the selected UNI interface. The Description field is displayed in Modify
Service Order, View Service Order Details, Modify Service, and View Service windows. You can
edit this field while modifying an IP service order or service.

Range: 0 through 128 characters

UNI Description

Select this check box to create a loopback interface for the service order.

NOTE: If you provision a loopback interface for an IP service, an operator is able to identify a
VRF routing instance. Thereafter, an operator canmanually ping a remote CE router from a
local PE router.

Set loopback

VLAN

This field displays the value specified in the service definition upon which you are basing this
service order.

Encapsulation

Select the interface on the device for which you intend to implement this service order.UNI interface

This check box is selected automatically if it was selected in the service definition upon which
this service order is based.

Autopick interface IP

Global

This field displays the value specified in the service definition upon which this service order is
based.

IP pool type
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DescriptionField

Select the IP address pool from the list.IP address pool

This field displays the value specified in the service definition upon which this service order is
based.

IP block size

This check box is selected automatically if it was selected in the service definition upon which
this service order is based.

Autopick VLAN ID

BGP

This field displays the value specified in the service definition upon which this service order is
based.

Routing protocol

This check box is selected automatically if it was selected in the service definition upon which
this service order is based.

Autopick neighbor IP

The peer autonomous system number.

Select a Peer AS from the list.

Peer AS

13. Click Review.

14. Click Finish to complete the creation of the service order.

Related
Documentation

Stitching a Pseudowire to an IP Service on page 877•

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901

• Selecting a Published IP Service Definition for a Service Order on page 921

• Entering IP Service Order Information on page 923

• Selecting Endpoint PE Devices or Nodes on page 925

• Creating a Service Order Based on a Service Definition with a Template on page 927

Creating Policies for an IP Service

Starting fromConnectivity Services Director Release 2.0R4 onward, you can create route

target policies or protocol policies. These policies can be associated with provider edge

protocols and customer edge protocols, and route target. In releases earlier than

Connectivity Services Director Release 2.0R4, the Connectivity Services Director

application automatically generates route target polices. You can create these policies

on the Node Settings page of the Create IP Service Order wizard.

To create a route target policy, youmust select the Policy Based Route Target check box

in the Create IP Service Definition wizard. If you have cleared the Policy Based Route
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Target check box, the Connectivity Services Director application does not generate the

policy.

If you have selected the Policy Based Route Target check box, you have an option to

create a policy on the Node Settings page of the Create IP Service Order wizard. If you

have not defined a policy in the Create IP Service Order wizard, the Connectivity Services

Director application automatically generates the necessary policy.

Creating PE–CE protocol policies is optional.

1. On the Node Settings page of the Create IP Service Order wizard, click Create Policy.

The Policy Settings window appears.

2. Fill in the following fields in the Policy Settings window:

DescriptionField

This drop downmenu lists the devices that are part of the IP service. Select a device that you want
to apply the policy.

Device Name

Option Settings

Select an option type:

• Community

Specify the following attributes:

• Community name—Specify the name of the community.
Range: 0 through 255 characters

• Member—Specify the member value in AS-number or IP address:ID format
AS Number Range: 1 through 65535

IP address Range: Globally unique unicast address.

• As-path

Specify the following attributes:

• AS-path name—Specify the name of the AS path.
Range: 0 through 255 characters

• Path—Specify the path.
Range: Regular expressions

• prefix-list

Specify the following attributes:

• Prefix List Name—Specify the name of the prefix list.
Range: 0 through 255 characters

• Prefix Address—Specify the prefix address.
IP address Range: Globally unique address with subnet mask.

Option Type

Click Add to validate option attribute values. The attribute is listed in the table.Add

Select an attribute from the table and click Delete to delete an option attribute row.Delete

Policy Settings
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DescriptionField

Specify the name of the policy.

Range: 0 through 255 characters

Policy Name

Specify the name of the policy term.

Range: 0 through 255 characters

Name

Select one of the following clause:

• From

• Then

Clause

If the Clause type is From select one of the following attributes:

• route filter

• community

• protocol

• family

• as-path

• prefix-list

• prefix-list-filter

If the Clause type is Then, select one of the following attributes:

• community

• local-preference

• accept

• reject

Attribute selection

Click Add to validate policy setting values. The attribute is listed in the table.Add

Select an attribute from the table and click Delete to delete a policy term.Delete

3. Click Save.

The policy is created.

Release History Table DescriptionRelease

Starting from Connectivity Services Director Release 2.0R4 onward, you
can create route target policies or protocol policies.

2.0R4

Related
Documentation

•
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CHAPTER 36

ServiceProvisioning:PerformingRFC2544
Benchmark Testing

• RFC 2544 Testing Overview on page 937

• Creating an RFC 2544 Test Profile for Services on page 939

• Creating an RFC 2544 Test Profile for Devices on page 946

• Deploying RFC 2544 Tests on page 951

• Viewing RFC 2544 Test Results on page 952

RFC 2544 Testing Overview

The RFC 2544 test methodology defines specific set of tests that operator can use to

measure and report the performance characteristics of network devices and services.

These tests measure throughput, latency, frame loss rate, and bursty frames. The test

methodology enables you to define various parameters such as different frame sizes to

be examined, the test time for each test iteration, and the frame format (UDP-over-IP).

The RFC 2544methodology can be used to measure various parameters based on SLA

agreements and certify it. By providing performance availability, transmission delay, link

burstability and service integrity measurements, a carrier can certify that the working

parameters of the delivered ethernet circuit comply with the contract.

An RFC2544-based benchmarking test is performed by transmitting test packets from

adevice that functionsas thegenerator or the initiator (which is also called theoriginator).

These packets are sent to a device that functions as a reflector, which receives and

returns the packets to the initiator.

The following are some of RFC 2544 benchmarking tests methodology types that you

can use to test, measure, and report performance characteristics of network devices.

• Throughput—The throughput test calculates the maximum rate at which none of the

offered frames are dropped by the device/system under test (DUT/SUT).This

measurement translates the obtained rate into the available bandwidth of the service.

• Latency—The latency test (for store-and-forward devices) refers to the time interval
that begins when the last bit of the input frame reaches the input port and ends when

the first bit of the output frame is seen on the output port. It is the time taken by a bit
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togo through thenetworkandback. Latencyvariability canbeaproblem.Withprotocols

like VoIP, a variable or long latency can cause degradation in voice quality.

• Frame Loss—The frame loss test calculates the percentage of frames that should
have been forwarded by a network device under steady state (constant) loads, that

were not forwarded due to lack of resources. This measurement can be used for

reporting the performance of a network device in an overloaded state, as it can be a

useful indicationof howadevicewouldperformunderpathological network conditions

such as broadcast storms.

• Burst—The burstability or back-to-back test refers to the fixed length of frames that
are presented at a rate such that there is the minimum legal separation for a given

medium between frames (maximum rate) over a short to medium period of time,

starting froman idle state. The test result provides the number of frames in the longest

burst that the device or network under test will handle without the loss of any frames.

• Supported Devices for RFC2544 on page 938

• Before You Begin on page 938

• Performing an RFC 2544 test for a Service on page 938

• Performing an RFC 2544 Test Between Devices on page 939

Supported Devices for RFC2544

The following devices support RFC 2544:

• ACX Series Universal Access Routers

• MX Series 5G Universal Routing Platforms

Before You Begin

RFC2544 is part of Operation, Administration, and Maintenance (OAM). Before starting

an OAM test, youmust discover OAM capable devices. To discover OAM devices, log in

to Connectivity Services Director (CSD), navigate to Service Activation Director (SAD)

and clickOAM-Prestage Devices >Manage OAMDevices > Discover Devices in the

Applications pane on the left side of the page.

Performing an RFC 2544 test for a Service

Use the following steps to perform an RFC test on a service and view the results:

1. Create an RFC 2544 test profile—For step-by-step instructions on creating an RFC

2544 test profile, see “Creating an RFC 2544 Test Profile for Services” on page 939.

2. Start RFC 2544 test—To start an RFC 2544 test, select the test profile in the RFC2544

tab, and selectOAM > RFC2544 Test > Start Test in the Tasks pane on the right side.

The Test Status in the RFC2544 displays the status of the tests.

3. Stop RFC 2544 test—To stop an RFC 2544 test, select the test profile in the RFC2544

tab, and selectOAM > RFC2544 Test > Stop Test in the Tasks pane on the right side.
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TheTestStatus appears asStopped in theRFC2544 tab. The test results are available

for the iteration till the test was stopped.

4. View the test results—Formore information on viewing test results, see “Viewing RFC

2544 Test Results” on page 952.

Performing an RFC 2544 Test Between Devices

Use the following steps toperformanRFC testbetweendevicesandview the test results:

1. Create an RFC 2544 test profile—See “Creating an RFC 2544 Test Profile for Devices”

on page 946 for step-by-step instructions on creating an RFC 2544 test profile.

2. Modify an RFC 2544 test profile—Tomodify an RFC 2544 test, go to the

OAM-RFC2544-Test >Manage Tests page, select the test you want to modify, and

click Actions >Modify. TheModify Test page appears displaying the parameters of

the test. See “Creating an RFC 2544 Test Profile for Devices” on page 946 for details

about the parameters of an RFC 2544 test.

NOTE: After youmodifyanRFC2544test, youhavetovalidateanddeploy
it again for themodified configuration to be deployed to the device.

3. DeployanRFC2544test—See“DeployingRFC2544Tests”onpage951 forstep-by-step

instructions on deploying an RFC 2544 test.

4. Start RFC2544 test—To start an RFC 2544 test, go to theOAM-RFC2544-Test >

Manage Tests page, select the test you want to run, and click Actions > Start Test.

5. StopRC2544 test—To stop anRFC2544 test, go to theOAM-RFC2544-Test>Manage

Tests page, select the test you want to stop, and click Actions > Stop Test. The RFC

TestStatusappearsasStopped in theManageTestpage.The test resultsareavailable

for the iteration till the test was stopped.

6. View the test results— To view the results of an RFC 2544 test, go to the

OAM-RFC2544-Test >Manage Tests page, select the test for which you want to view

the results, and click Actions > ViewTest Result. For more information on viewing test

results, see “Viewing RFC 2544 Test Results” on page 952.

Related
Documentation

Creating an RFC 2544 Test Profile for Services on page 939•

• Creating an RFC 2544 Test Profile for Devices on page 946

• Deploying RFC 2544 Tests on page 951

• Viewing RFC 2544 Test Results on page 952

Creating an RFC 2544 Test Profile for Services

Youmust create a test profile (parameters for the RFC 2544-based benchmarking test),

which specifies the type of test and themanner in which it must be performed, and

associate the test profile with a test name.
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Before you begin to create an RFC test for a service, ensure that:

• You have created an E-LINE or IP service on which you want to perform the RFC test.

•

NOTE: You can perform RFC tests on E-LINE and IP services only.

•

NOTE: Youmust configure unit 0 for E-line service and interface IP for
IP services to run an RFC 2544 test. You can configure unit 0 for E-line
service and interface IP for IP services by using device or service
templates. You can delete these service templates after the test is
completed. For more information, see Configuring RFC 2544-Based

Benchmarking Tests onMX Series Routers.

•

NOTE: Youcannot performanRFC test onanE-LANservice as it cannot
be provisioned on ACX 2k devices, it can only be provisioned on ACX 5k
devices. The initiator PE device can only be an ACX 2k device. ACX 5k
devices cannot serve as the initiator, only as the reflector. Therefore, you
will not be able to perform the RFC 2544 test on an E-LAN service. You
can, however, runanRFC2544 test at device-level. Formore information
on this, see “Creating anRFC2544Test Profile for Devices” onpage946.
You can also refer Example: Configuring Benchmarking Tests to Measure

SLA Parameters for E-LAN Services on anMX104 Router Using VPLS to

understand how to configure benchmarking tests for E-LAN services
using VPLS.

• The functional audit status (FA Status) is Up for the service that you want to perform

an RFC test.

To create an RFC 2544 test profile:

1. Log into Junos Space application and select Connectivity Services Director in the

Applications pane on the left.

The Connectivity Services Director dashboard is displayed.

2. On the Connectivity Services Director banner, click Views and select Service View.

The Service View page is displayed.

3. From the Service View pane on the left, select an E-LINE or IP service on which you

want perform an RFC test.

The details of the service is loaded in the View Service Details pane.

4. On the Connectivity Services Director banner, clickMonitor in Task Categories.
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The Service Summary tab is loaded.

5. Select the RFC2544 tab.

The RFC2544 tab is loaded.

6. On the Tasks pane on the right side of the page, selectOAM > RFC2544 Test > Create

Test.

The Create RFC Test Profile page is displayed.

7. Complete the configuration of the RFC test according to the guidelines provided in

Table 130 on page 941.

8. Click Save.

The test profile is created, saved, and deployed. The details of the test profile is

displayed on the Create RFC Test Profile page in view-only mode.

9. ClickOK to close the Create RFC Test Profile page.

The newly created RFC 2544 test profile appears in the RFC2544 tab.

For more information on running the RFC test and viewing the results, see “RFC 2544

Testing Overview” on page 937.

Table 130 on page 941 describes the fields in the Create Test page.

Table 130: Fields on the Create Test Page

DescriptionField

General Settings

Enterauniquestringofalphanumeric characters, dashes, andunderscores.
Colons, and periods are not allowed, and themaximum length is 10
characters.

Name

Enter a description for the RFC 2544 test; maximum length is 250
characters.

Description

Select the test performancemetric for the test profile. You canmeasure
the throughput, latency, frame loss, and back-to-back of a service.

NOTE: You can choose one performancemetric for each test profile. If you
want to test more than one performancemetric, you must create one test
profile for each performancemetric.

For example, if you want to measure the throughput and latency for a
service, then youmust create one test profile to measure throughput and
another test profile to measure latency.

RFC Test Profile
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Table 130: Fields on the Create Test Page (continued)

DescriptionField

Enter anumerical value for thebandwidth (inKbps) thatneeds tobe tested.
Themaximum value is 1000000.

Bandwidth

Select the packet size(s) for the test. You can select multiple packet sizes
for a test; the maximum number of packet sizes you can select is 10.

Packet Size

Enter a numerical value for the frame loss ratio. Themaximumvalue is 100.

NOTE: Step percent information is only applicable if you select FrameLoss
as the RFC test profile.

Step Percent

Initiator Settings

PE device lists all the devices on which the service is running. Select the
device that you want to act as the initiator for the RFC 2544 test.

NOTE: The initiator PE device can only be an ACX device.

Provider Edge (PE)
Device

Select the address type family for the benchmarking test.

NOTE: This field is auto-populated based on the types of service you have
selected.

Family

Select the logical interface on which the service (that you want to run an
RFC test on) is running. This parameter is required only if you selected the
ccc family.

NOTE: By default, only the interfaces on which the service is running is
listed.

Test Interface

Enter the source IPv4 address of the initiator. This parameter is required
only if you have selected IPv4 family inet.

Source IPv4
Address

Enter the source MAC address of the initiator. The MAC address is only
applicable for the ccc family.

Source MAC
Address

Enter the UDP port of the source to be used in the UDP header for the
generated frames.

Source UDP Port

Enter the destination IPv4 address of the reflector. This parameter is
required only if you have selected IPv4 family inet.

Destination IPv4
Address

Enter the destination MAC address of the reflector. The MAC address is
only applicable for the ccc family.

Destination MAC
Address

Enter the UDP port of the destination to be used in the UDP header for the
generated frames.

Destination UDP
Port
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Table 130: Fields on the Create Test Page (continued)

DescriptionField

Select the direction of the interface on which the test must be run. This
parameter is valid only for the ccc family. To enable the test to be run in
the egress direction of the interface (network-to-network interface (NNI)),
use the egress option. To enable the test to be run in the ingress direction
of the interface (user-to-network interface (UNI)), use the ingress option.

Direction

Specify the value of the Differentiated Services (DiffServ) field within the
IP header of host-generatedRPMpackets. TheDiffServ codepoint (DSCP)
bits value must be set to a valid 6-bit pattern.

DSCP Code Points

Forwarding classes (FCs) allow you to group packets for transmission and
to assign packets to output queues. The forwarding class and the loss
priority define the per-hop behavior (PHB in DiffServ) of a packet.

• assured-forwarding—Provides a group of values you can define and
includes four subclasses—AF1, AF2, AF3, and AF4—eachwith three drop
probabilities (low, medium, and high).

• best-effort—Provides no service profile. For theBE forwarding class, loss
priority is typically not carried in a class-of-service (CoS) value, and
random early detection (RED) drop profiles are more aggressive.

• expedited-forwarding—Provides a low-loss, low-latency, low-jitter,
assured-bandwidth, end-to-end service.

• network-control—This class is typically high priority because it supports
protocol control.

Forwarding Class

For dynamic VLAN interfaces, enter the VLAN ID to rewrite for the inner tag
of the final packet.

Inner VLAN ID

Select this option to disable the Address Resolution Protocol (ARP) test
iteration for IPv4or inet servicesduringabenchmarking test. Thisparameter
is valid only for an inet family. An ARP test iteration is a three-second
iteration that is run for all inet tests. The results of this iteration are
disregarded in the test result calculations. TheARP test iteration is executed
by sending test frames to all the devices on the path to the destination for
3 seconds. This is to ensure that all devices add ARP entries in the cache
of the corresponding devices.

This parameter is not applicable for the ccc family.

Skip ARP Iteration

Enter thedurationof each iteration in seconds,withavalue from10seconds
to 1,728,000 seconds.

Test Iteration
Duration

Reflector Settings

PE device lists all the devices on which the service is running. Select the
device that you want to act as the reflector for the RFC 2544 test.

PE Device

Select the address type family for the benchmarking test.Family
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Table 130: Fields on the Create Test Page (continued)

DescriptionField

Select the logical interface on which the service (that you want to RFC
test) is running.

NOTE: By default, only the interfaces on which the service is running is
listed.

Test Interface

Enter the source IPv4 address of the reflector. This parameter is required
only if you selected IPv4 family inet.

Source IPv4
Address

Enter the source MAC address of the reflector. The MAC address is only
applicable for the ccc family.

Source MAC
Address

Enter the UDP port of the source to be used in the UDP header for the
generated frames.

Source UDP Port

Enter the destination IPv4 address of the reflector. This parameter is
required only if you have selected IPv4 family inet.

Destination IPv4
Address

Enter the destination MAC address of the reflector. The MAC address is
only applicable for the ccc family.

Destination MAC
Address

Enter the UDP port of the destination to be used in the UDP header for the
generated frames.

Destination UDP
Port

Select the direction of the interface on which the test must be run. This
parameter is valid only for the ccc family. To enable the test to be run in
theegressdirectionof the interface (network-to-network interface (NNI)),
use the egress option. To enable the test to be run in the ingress direction
of the interface (user-to-network interface (UNI)), use the ingress option.

Direction

Specify the value of the Differentiated Services (DiffServ) field within the
IPheaderofhost-generatedRPMpackets.TheDiffServcodepoint (DSCP)
bits value must be set to a valid 6-bit pattern.

DSCP Code Points

Forwarding classes (FCs) allow you to group packets for transmission and
to assign packets to output queues. The forwarding class and the loss
priority define the per-hop behavior (PHB in DiffServ) of a packet.

• assured-forwarding—Provides a group of values you can define and
includes four subclasses—AF1, AF2, AF3, andAF4—eachwith three drop
probabilities (low, medium, and high).

• best-effort—Provides no service profile. For the BE forwarding class,
loss priority is typically not carried in a class-of-service (CoS) value, and
random early detection (RED) drop profiles are more aggressive.

• expedited-forwarding—Provides a low-loss, low-latency, low-jitter,
assured-bandwidth, end-to-end service.

• network-control—This class is typically high priority because it supports
protocol control.

Forwarding Class
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Table 130: Fields on the Create Test Page (continued)

By default, the RFC 2544-based benchmarking test ignores a prefix-down
event (when the prefix associated with the test goes down) and continues
to run. If you select this option, a prefix thatmoves to the down state causes
the corresponding tests to be stopped. The show command output for the
test displays that the test was aborted due to the prefix going down.

Halt on Prefix
Down

For dynamic VLAN interfaces, enter the VLAN ID to rewrite for the inner tag
of the final packet.

Inner VLAN ID

The Outer VLAN ID field is disabled unless you provide a value for the Inner
VLAN ID.

Enter the outer VLAN ID for the test frames. Range: 0 through 4094 This
parameter is valid only for family ccc mode.

Outer VLAN ID

Select this option to disable the Address Resolution Protocol (ARP) test
iteration for IPv4 or inet services during a benchmarking test. This parameter
is valid only for an inet family. An ARP test iteration is a 3-second iteration
that is run for all inet tests. The results of this iteration are disregarded in the
test result calculations. The ARP test iteration is performed by sending test
frames for 3 seconds to ensure that all devices on the path to destination add
ARP entries in the cache of the corresponding devices.

This parameter is not applicable for the ccc family.

Skip ARP
Iteration

Enter the duration of each iteration in seconds, with a value from 10 seconds
to 1,728,000 seconds.

Test Iteration
Duration

Related
Documentation

RFC 2544 Testing Overview on page 937•

• Viewing RFC 2544 Test Results on page 952
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Creating an RFC 2544 Test Profile for Devices

Youmust create a test profile (parameters for the RFC 2544-based benchmarking test),

which specifies the type of test and themanner in which it must be performed, and

associate the test profile with a test name. The test name that you configure contains

details, such as the address family and the testmode, for the test. You can associate the

same test profile with multiple test names.

RFC 2544 test profile configuration is done in two parts:

• Configure General Settings—Use the General Settings pane to define the tests
(throughput, latency, back-to-back, and frame loss) that you want to be part of the

RFC 2544 test.

• ConfigureTestSettings—Use theTestSettingspane todefine the initiator and reflector
device settings for the RFC 2544 test.

To create an RFC 2544 test profile:

1. Log into JunosSpaceapplicationandclickon JunosSPACE in theConnectivityServices

Director banner.

2. From the Applications pane on the left, select Services Activation Director.

The Services Activation Director dashboard is displayed.

3. From the pane on the left, clickOAM-RFC2544-Test >Manage Test Configuration >

Create RFC2544 Test.

The General Settings pane displays fields required for configuring an RFC 2544 test.

4. Complete the configuration for General Settings according to the guidelines provided

in Table 131 on page 947.

5. Click Next after you have completed configuring General Settings.

The Test Settings pane displays fields required for configuring the test devices.

6. Complete the configuration for Test Settings according to the guidelines provided in

Table 132 on page 949.

7. Click Finish.

The Deployment Options page appears providing various deployment options.

8. Select Save only and Validate options to validate the test profile against the device

and save in the database.

•

• Select Deploy Now option deploy the test profile to the device.
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• Select Schedule Deployment option to deploy the test profile at a scheduled date

and time; enter the date and time at which the test profile needs to be deployed to

the device.

9. ClickOK to save/deploy the test profile.

The Job Details page appears displaying the job ID that has been created to validate

and save/deploy the test profile. You can double-click on the job ID to view the details

of the job.

10. ClickOK to close the Job Details page.

The newly created RFC 2544 test profile appears in the Manage Service Orders page.

Double-click on the it to view the details of the test profile.

If you have just saved the new test profile, it is listed in theManage Test Configuration

page. Once you deploy the test profile, it is listed inManage Test page. For more

information ondeploying anRFC2544 test, see “DeployingRFC2544Tests” onpage951.

For more information on running the RFC 2544 and viewing the results, see “RFC 2544

Testing Overview” on page 937.

Table 131 on page 947 describes the fields in the General Settings pane.

Table 131: Fields on the General Settings Pane

DescriptionField

Enter a unique string of alphanumeric characters, dashes, and underscores.
Colons, and periods are not allowed, and themaximum length is 50 characters.

Name

Enter a description for the RFC 2544 test; maximum length is 250 characters.Comments

Select Throughput to add it as test parameter in the RFC 2544 test. When you
select a test parameter, the other test parameters are disabled.

NOTE: You can choose only one performancemetric for each test profile. If
you want to test more an than one performancemetric, you must create one
test profile for each performancemetric.

For example, if you want to measure the throughput and latency for a device,
then youmust create two test profiles—one test profile tomeasure throughput
and another to measure latency.

Throughput

Enter a numerical value for the bandwidth for which throughput needs to be
tested. Themaximum value is 1000000.

Bandwidth

Select thepacket size(s) for the throughput test. Youcanselectmultiplepacket
sizes for the test; the maximum number of packet sizes you can select is 10.

Packet Size
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Table 131: Fields on the General Settings Pane (continued)

DescriptionField

Select Frame Loss to add it as test parameter in the RFC 2544 test. When you
select a test parameter, the other test parameters are disabled.

NOTE: You can choose only one performancemetric for each test profile. If
you want to test more an than one performancemetric, you must create one
test profile for each performancemetric.

For example, if you want to measure the throughput and latency for a device,
then youmust create two test profiles—one test profile tomeasure throughput
and another to measure latency.

Frame Loss

Enter a numerical value for the bandwidth for which frame loss needs to be
tested. Themaximum value is 1000000.

Bandwidth

Select the packet size(s) for the frame loss test. You can selectmultiple packet
sizes for the test; the maximum number of packet sizes you can select is 10.

Packet Size

Enter the numerical value for the frame loss ratio. Themaximum valueis 100.Step Percent

Select Latency toadd it as test parameter in theRFC2544 test.Whenyouselect
a test parameter, the other test parameters are disabled.

NOTE: You can choose only one performancemetric for each test profile. If
you want to test more an than one performancemetric, you must create one
test profile for each performancemetric.

For example, if you want to measure the throughput and latency for a device,
then youmust create two test profiles—one test profile tomeasure throughput
and another to measure latency.

Latency

Enter a numerical value for the bandwidth forwhich latency needs to be tested.
Themaximum value is 1000000.

Bandwidth

Select the packet size(s) for the latency test. You can select multiple packet
sizes for the test; the maximum number of packet sizes you can select is 10.

Packet Size

SelectBack-to-Back to add it as test parameter in the RFC 2544 test.When you
select a test parameter, the other test parameters are disabled.

NOTE: You can choose only one performancemetric for each test profile. If
you want to test more an than one performancemetric, you must create one
test profile for each performancemetric.

For example, if you want to measure the throughput and latency for a device,
then youmust create two test profiles—one test profile tomeasure throughput
and another to measure latency.

Back-to-Back

Enter a numerical value for the bandwidth for which back-to-back (or burst)
needs to be tested. Themaximum value is 1000000.

Bandwidth

Select the packet size(s) for the back-to-back test. You can select multiple
packet sizes for the test; the maximum number of packet sizes you can select
is 10.

Packet Size
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Table 132 on page 949 describes the fields in the Test Settings pane.

Table 132: Fields in the Test Settings Pane

DescriptionField

Initiator

Select the device that you want to be the initiator or reflector for the RFC
2544 test.

Device Name

Select the address type family for the benchmarking test. The inet option
indicates that the test is run on an IPv4 service.

Family

Specify the logical interface on which the RFC 2544-based benchmarking
test is run.

NOTE: You can only select the test interface for the reflector device. This
field is disabled for the initiator device.

Test Interface

Enter the source IPv4 address of the initiator. This parameter is required only
if you selected IPv4 family inet.

Source IPv4
Address

Enter the source MAC address of the initiator. The MAC address is only
applicable for the ccc family.

Source MAC
Address

Enter the UDP port of the source to be used in the UDP header for the
generated frames.

Source UDP Port

Enter the destination IPv4address of the reflector. This parameter is required
only if you have selected IPv4 family inet.

Destination IPv4
Address

Enter the destination MAC address of the reflector. The MAC address is only
applicable for the ccc family.

Destination MAC
Address

Enter the UDP port of the destination to be used in the UDP header for the
generated frames.

Destination UDP
Port

Select the direction of the interface on which the test must be run. This
parameter is valid only for the ccc family. To enable the test to be run in the
egress direction of the interface (network-to-network interface (NNI)), use
the egress option. To enable the test to be run in the ingress direction of the
interface (user-to-network interface (UNI)), use the ingress option.

Direction

Specify the value of the Differentiated Services (DiffServ) field within the IP
header of host-generatedRPMpackets. TheDiffServ codepoint (DSCP) bits
value must be set to a valid 6-bit pattern.

DSCP Code
Points
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Table 132: Fields in the Test Settings Pane (continued)

DescriptionField

Forwarding classes (FCs) allow you to group packets for transmission and
toassignpackets tooutput queues. The forwarding class and the losspriority
define the per-hop behavior (PHB in DiffServ) of a packet.

• assured-forwarding—Provides a group of values you can define and
includes four subclasses—AF1, AF2, AF3, and AF4—each with three drop
probabilities (low, medium, and high).

• best-effort—Provides no service profile. For the BE forwarding class, loss
priority is typically not carried inaclass-of-service (CoS)value, and random
early detection (RED) drop profiles are more aggressive.

• expedited-forwarding—Provides a low-loss, low-latency, low-jitter,
assured-bandwidth, end-to-end service.

• network-control—This class is typically high priority because it supports
protocol control.

Forwarding Class

By default, the RFC 2544-based benchmarking test ignores a prefix-down
event (when the prefix associated with the test goes down) and continues
to run. If you select this option, a prefix that moves to the down state causes
the corresponding tests to be stopped. The show command output for the
test displays that the test was aborted due to the prefix going down.

Halt on prefix
down

For dynamic VLAN interfaces, enter the VLAN ID to rewrite for the inner tag
of the final packet.

Inner VLAN ID

initiate-and-terminate—Causes the test frames to be initiated at the router
and the reflectedback frames tobe terminated.Thismode requiresa reflector
to be configured at the peer end of the network to return back the generated
frames. For initiator device, the initiate-and-terminate mode is selected by
default.

reflect—Causes the received test frames to be reflected back on the
configured service (for example, inet, ccc). For reflector device, the reflect
mode is selected by default.

Mode

The Outer VLAN ID field is disabled unless you provide a value for the Inner
VLAN ID.

Enter the outer VLAN ID for the test frames. Range: 0 through 4094 This
parameter is valid only for family ccc mode.

Outer VLAN ID

Select this option to disable the Address Resolution Protocol (ARP) test
iteration for IPv4 or inet services during a benchmarking test. This parameter
is valid only for an inet family. AnARP test iteration is a three-second iteration
that is run for all inet tests. The results of this iteration are disregarded in the
test result calculations. The ARP test iteration is executed by sending test
frames to all the devices on the path to the destination for 3 seconds. This
is toensure thatall devicesaddARPentries in thecacheof thecorresponding
devices.

This parameter is not applicable for the ccc family.

Skip ARP
Iteration

Enter the duration of each iteration in seconds, with a value from 10 seconds
to 1,728,000 seconds.

Test Iteration
Duration
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Table 132: Fields in the Test Settings Pane (continued)

DescriptionField

Specify the EtherType to be used for reflection of the test frames. EtherType
isa two-octet field inanEthernet frame thatdefines theprotocol in the frame
payload. This statement is valid only if you configure the test mode to be a
reflector. If you do not configure this statement, all EtherTypes are reflected.

Reflect eType

Select the reflection mode for the benchmarking test.

• mac-swap—Swaps the source and destination MAC addresses in the test
frame. This is the default behavior.

• no-mac-swap—DoesnotswapthesourceanddestinationMACaddresses
in the test frame. The frame is returned to the originator without any
modification to the MAC addresses.

• mac-rewrite—(ACX Series routers only) Enable rewriting of the MAC
addresson the reflected frames.TheMACaddressesspecified in theSource
MAC Address and Destination MAC Address options are used.

Reflect Mode

Related
Documentation

RFC 2544 Testing Overview on page 937•

• Deploying RFC 2544 Tests on page 951

• Viewing RFC 2544 Test Results on page 952

Deploying RFC 2544 Tests

After you create an RFC 2544 test, youmust deploy the configuration to the test devices.

To deploy an RFC 2544 test:

1. Go toOAM-RFC2544-Test >Manage Test Configuration.

TheManage Test Configuration page appears displaying a list of the validated (Order

Status is Validated) but un-deployed RFC 2544 tests.

2. To deploy an RFC 2544 test, select it and click Actions > Deploy Service Order.

TheScheduleServiceOrderDeploymentpageappearsprovidingdeploymentoptions.

• Select Deploy Now option to deploy the RFC 2544 test to the device immediately.

• Select Deploy Later if you want to schedule the deployment for a later date and

time. Enter the deployment date and time in the Date and time field and select the

time zone for the deployment.

3. ClickOK.

If you have chosen Deploy Now, a Job Details page appears indicating that a job has

been created to deploy the RFC 2544 to the device. You can click on the job ID link to

view the details and status of the job in the JobManagement page.
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Related
Documentation

RFC 2544 Testing Overview on page 937•

• Creating an RFC 2544 Test Profile for Devices on page 946

Viewing RFC 2544 Test Results

After the test run is completed, you can view the results as follows:

• To view the test results of an RFC 2544 test in CSD, select the test profile in the

ServicePerformance-RFC2544 tab. The test results are displayed in the bottom pane.

• To view the test results of an RFC 2544 test in SAD, go to theOAM-RFC2544-Test >

Manage Tests page, select the test for which you want to view the results, and click

Actions > View Test Result.

The test results are based on the test parameter or metric that you chose while creating

the test profile.

• If you have created a test profile to measure throughput, the following tabs appear:

• Throughput Chart—Displays a chart that shows the throughput achieved for various

frame lengths. Hover over various frame lengths on the chart to view details such as

theoretical rate, transmitted (TX) packets, received packets (RX) packets, TX bytes,

RX bytes, bandwidth, and iteration count. You can viewmore information on the test

results in the Throughput Test Result tab.

• Throughput Test Result—Displays the throughput results for different packet sizes

and bandwidths.

• Throughput Summary—Displays the test profile and test configuration.

• If you have created a test profile to measure frame loss, the following tabs appear:

• Frameloss Chart—Displays a chart that shows the frame loss percentage for various

frame lengths. Hover over various frame lengths on the chart to view details such as

theoretical rate, TXpackets, RXpackets, TXbytes, RXbytes, bandwidth, and iteration

count. Youcanviewmore informationon the test results in theFramelossTestResult

tab.

• Frameloss Test Result—Displays the frame loss results for different packet sizes

and bandwidths.

• Frameloss Summary—Displays the test profile and test configuration.

• If you have created a test profile to measure latency, the following tabs appear:

• Latency Chart—Displays a chart that shows the latency for various frame lengths.

Hover over various frame lengths on the chart to view details such as elapsed time,

TX packets, RX packets, packets-per-second (PPS), measured bandwidth, and

iteration count. You can viewmore information on the test results in the Latency

Test Result tab.

• Latency Test Result—Displays the latency results for different packet sizes and

bandwidths.
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• Latency Summary—Displays the test profile and test configuration.

• If you have created a test profile to measure bursty frames, the following tabs appear:

• Back Back Frame Chart—Displays a chart that shows the throughput achieved for

various frame lengths. Hover over various frame lengths on the chart to view details

such as elapsed time, TX packets, RX packets, TX bytes, RX bytes, bandwidth, and

iteration count. You can viewmore information on the test results in the Back Back

Frame Test Result tab.

• Back Back Frame Test Result—Displays the back-to-back frame results for different

packet sizes and bandwidths.

• Back Back Frame Summary—Displays the test profile and test configuration.

Related
Documentation

• RFC 2544 Testing Overview on page 937

• Creating an RFC 2544 Test Profile for Devices on page 946
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PART 11

Service Provisioning: Working with
Services Deployment

• Service Provisioning: Managing Deployed Services on page 957
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CHAPTER 37

Service Provisioning: Managing Deployed
Services

• Managing Service Configuration Deployment Jobs on page 957

• Deploying Services Configuration to Devices on page 959

• Deploy ConfigurationWindow on page 966

• Deleting a Partial Configuration of an LSP Service Order on page 967

• Deleting a Service Order on page 968

• Deploying a Service on page 969

• Validating the Pending Configuration of a Service Order on page 971

• Viewing the Configuration of a Pending Service Order on page 972

• Viewing Decommissioned E-Line, E-LAN, and IP Service Orders on page 974

• Modifying an E-Line Service on page 976

• Modifying a Multipoint-to-Multipoint Ethernet Service on page 977

• Modifying a Point-to-Multipoint Ethernet Service on page 984

• Modifying a Hub-and-Spoke IP Service Order on page 993

• Modifying a Full Mesh IP Service on page 1008

• Understanding Service Validation on page 1014

• Highlighting of Endpoints in the IP, RSVP LSP, and E-LAN Service Modification

Wizards on page 1014

Managing Service Configuration Deployment Jobs

When you Deployment Jobs changes or schedule a configuration deployment, a service

configuration deployment job is created.

To start managing configuration deployment jobs:

1. Click Deploy in the Connectivity Services Director banner.

2. In the Tasks pane, select View Deployment Jobs.

The CSD Deployment Jobs page opens in the bottom part of the main window. The

table on that page lists configuration deployment jobs.
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This topic describes:

• Selecting Service Configuration Deployment Job Options on page 958

• Viewing Service Configuration Deployment Job Details on page 959

• Canceling Service Configuration Deployment Jobs on page 959

Selecting Service Configuration Deployment Job Options

From the Deployment Jobs page, you can:

• View the details of a service configuration deployment job by clicking Show Details.

See “ViewingConfigurationDeployment JobDetails” onpage724 formore information.

• Cancel a scheduled service configuration deployment job by clicking Cancel Job. See

“Canceling Configuration Deployment Jobs” on page 724 for more information.

Table 99 on page 723 describes the information provided on the Deployment Jobs page

Table 133: Deployment Jobs Table Description

DescriptionTable Column

Select to perform an action on the job in that row.Check box

An identifier assigned to the job.Job Id

Job name (user-created).Job Name

Percentage of the job that is complete.Percent

Job status. The possible states are:

• CANCELLED—The job was cancelled by a user.

• FAILURE—The job failed. This state is applied if any of the devices in the job failed. But
some of the devices might have completed successfully. View the job details for the
status of each device.

• INPROGRESS—The job is running.

• SCHEDULED—The job is scheduled but has not run yet.

• SUCCESS—The job completed successfully. This state is applied if all of the devices in
the job completed successfully.

Status

Job summary.Summary

Job’s scheduled start timeScheduled Start Time

Time when the job started.Actual Start Time

Time when the job endedEnd Time

User who created the jobUser

This field is not used for configuration deployment jobs.Recurrence
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Viewing Service Configuration Deployment Job Details

To view the details of a configuration deployment job:

1. Select the job in the table.

2. Click ShowDetails. The Deployment Jobs window opens. See Deploy Configuration

Window for a description of the window.

Canceling Service Configuration Deployment Jobs

To cancel a configuration deployment job:

1. Select the job in the table.

2. Click Cancel Job.

3. Click Yes in the confirmation window that opens.

Deploying Services Configuration to Devices

When youmake configuration changes in Build mode, the changes are not deployed to

devicesautomatically.Youmustmanuallydeploy thechanges todevices inDeploymode.

To start deploying configuration changes:

1. From the View selector, select Service View. The workspaces that are applicable to

this view are displayed.

2. Click Deploy in the Connectivity Services Director banner.

3. Click the plus sign (+) beside Connectivity to expand the tree in the View pane and

view the list of service types.

4. Select the type of service, such as E-Line, L2VPN, or E-LAN, for which you want to

deploy the service order.

5. In the Tasks pane, select Service Provisioning > Deploy Services. The Manage Service

Deployment window is displayed in the bottom part of the right pane.

TIP: From Build mode of Service View, in the View pane, if you select the
Connectivity item in the tree under Network Services, without expanding
the tree and selecting a specific service type, such as E-Line Services, IP
Services, or E-LAN Services, the top pane displays a set of five pie charts
that enable you to view the different service orders configured, and their
associated audit andmonitoring statuses. The FA Status chart displays
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the functional audit status for the service orders. The Device State graph
displays the statuses of devices on which services are being provisioned
and commissioned. The Fault Status chart displays the connectivity fault
management details for the service orders. TheSLAStatus chart displays
the service-level agreement details for the service orders. The PM Status
chartdisplays theperformancemanagementdetails for theserviceorders.
The count or percentage of service orders in the pie chart segments sum
up to the total number of configured service orders. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. These charts provide a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

The following fields are displayed in this window:

• Name—Unique name assigned to the service.

• Customer—Name of the customer for which the service is provided.

• State—Status of the service order. Service orders canbeoneof the following states:

• Completed—The service order has been successfully deployed.

• Scheduled for deployment—The service provisioner has scheduled the service

order for deployment.

• Deployment Failed—An attempted service deployment was not successfully

completed or failed an audit.

• In Progress—The Connectivity Services Director application is in the process of

deploying the service.

• Requested—The service provisioner has created the service order, but has not

yet attempted to deploy it or schedule it for deployment.

• Invalid—The service order is not valid.

• Signaling—Type of signaling, namely, BGP or LDP.
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• Created By—Name of the user that created the service order.

• Created Date—Date and time at which the service order was created.

This topic describes:

• Selecting Configuration Deployment Options on page 961

• Validating Configuration on page 961

• Deleting the Partial Service Configurations on page 963

• Discarding the Pending Configurations on page 964

• Deploying Configuration Changes to Devices Immediately on page 965

• Scheduling Configuration Deployment on page 965

• Specifying Configuration Deployment Scheduling Options on page 966

Selecting Configuration Deployment Options

Basedon theapprovalmode, you can choose todeploy thedevice configuration changes

in the following ways:

• When you select the auto approval mode, the page Devices with Pending Changes

open. From the Devices with Pending Changes page, you can:

• Deploy configuration changes immediately by selecting one or more devices and

clicking Deploy Now. For more information, see “Deploying Configuration Changes

to Devices Immediately” on page 719.

• Schedule configuration deployment by selecting one or more devices and clicking

ScheduleDeploy. Formore information, see “SchedulingConfigurationDeployment”

on page 719.

• View configuration changes that are pending on a device by clicking View in the

Configuration Changes column.

• Validate that the pending changes for a device are compatible with the device’s

configuration by selecting up to ten devices and clicking Validate Pending

Configuration Changes. For more information, see “Validating Configuration” on

page 716.

• Discard the pending configuration changes. For more information, see “Discarding

the Pending Configurations” on page 964.

Validating Configuration

When you deploy configuration changes to a device, validation checks are performed to

validate that the pending changes are compatible with the device. You can also perform

this validation without deploying.

NOTE: You can also verify the configuration from the Build mode by clicking
Tasks > DomainManagement > Validate Pending Configuration.
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To view the configuration of such service orders:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Network Services > Connectivity task pane, select Service Provisioning >

DeployServices. TheManageService Deployment page is displayed on the right pane.

TIP: From Build mode of Service View, in the View pane, if you select the
Connectivity item in the tree under Network Services, without expanding
the tree and selecting a specific service type, such as E-Line Services, IP
Services, or E-LAN Services, the top pane displays a set of five pie charts
that enable you to view the different service orders configured, and their
associated audit andmonitoring statuses. The FA Status chart displays
the functional audit status for the service orders. The Device State graph
displays the statuses of devices on which services are being provisioned
and commissioned. The Fault Status chart displays the connectivity fault
management details for the service orders. TheSLAStatus chart displays
the service-level agreement details for the service orders. The PM Status
chartdisplays theperformancemanagementdetails for theserviceorders.
The count or percentage of service orders in the pie chart segments sum
up to the total number of configured service orders. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. These charts provide a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

4. Select a service order that is in either of the following states:
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• Requested

• Invalid

• Scheduled

• Failed deployment

NOTE: TheOrder State column displays the state of the service order.

5. Right-click the service order and select the View Pending Order Configuration. The

Pending Order Configurationwindow is displayed. The configuration is displayed in

xml format.

NOTE: TheViewPendingOrder Configuration appears to be dimmed if the

service order state is Completed.

6. Select a device to view the configuration details. You can also view the template

configuration if a template is attached to the service order.

Deleting the Partial Service Configurations

A failed service order of type Provisioning can leave parts of the service configuration on

the devices.

To remove thepartial configurationof services that arepresent on theassociateddevices

of the service order:

1. From the View selector, select Service View. The workspaces that you can configure

in this view are displayed.

2. Click the Deploy icon in the Connectivity Services Director banner. The functionalities

that are applicable to this lifecycle mode are displayed.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and
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the bottom part of the right pane displays the Manage Service Orders page, with the

table of service orders.

6. FromtheManageServiceOrderspage, select theservices forwhichyouwant todelete

the partial configuration and clickDeletePartial Configuration from theActionsmenu.

A dialog box is displayed, prompting you to specify whether you want to delete the

partial service configuration immediately or schedule the partial deletion for a future

specified time.

7. To delete the pending changes of the service immediately, select Partial Delete Now,

and clickOK. To discard the pending changes of the service at a later time, select

Partial Delete Later, select a date and time for deletion, then click OK. The time field

specifies the timekeptby the server, but in the timezoneof theclient. After scheduling

the service order for deployment, the provisioning software begins validating the

service order.

You are returned to the Manage Service Orders page.

Discarding the Pending Configurations

Use the Discard Local Configuration Changes Results window to discard all the pending

service configurations that were made on a device. Once you discard the local

configuration changes on a device, the configuration state of the device changes to In

Sync or Out of Sync based on the system of record (SOR)mode set for the Junos Space

Network Management Platform. If the SORmode is set to Network as system of record

(NSOR), then the configuration state changes to In Sync and if the SORmode is set to

Junos Space as system of record (SSOR), then the configuration state changes to Out

of Sync.

To discard the configuration changes:

1. From the View selector, select Service View. The workspaces that you can configure

in this view are displayed.

2. Click the Deploy icon in the Connectivity Services Director banner. The functionalities

that are applicable to this lifecycle mode are displayed.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.
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5. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and

thebottompart of the right panedisplays theManageServiceDeployment page,with

the table of service orders.

6. From the Manage Service Deployment page, select the services for which you want

to discard the pending configuration and clickDiscardPendingConfiguration from the

Actions menu.

7. You are prompted to confirm whether you want to discard the service order, which

causes the associated service to be deleted along with it. ClickOK to confirm the

deletion.

8. ClickOK to close the dialog box that displays the job ID. The Manage Service Orders

page appears.

Deploying Configuration Changes to Devices Immediately

To deploy configuration changes to devices immediately:

1. Select the check box next to the service you want to deploy from theManage Service

Deployment page.

2. Click Deploy Now.

The Deploy Options window opens.

3. In the Deploy Options window, enter a job name in the Deployment Job Name field,

then clickOK.

The configuration deployment job runs. The Deploy Configurationwindow opens and

shows the results of the deployment job.

Scheduling Configuration Deployment

To schedule configuration deployment to devices:

1. Select the check box next to the service you want to deploy from theManage Service

Deployment page.

2. Click Schedule Deploy.

The Deploy Options window opens.

3. Use the Deploy Options window to schedule the configuration deployment. See

“SpecifyingConfigurationDeploymentSchedulingOptions”onpage720foradescription

of the window.
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Specifying Configuration Deployment Scheduling Options

Use the Deploy Options window to schedule configuration deployment jobs.

Table 98 on page 720 describes the actions for the fields in this window.

Table 134: Deploy OptionsWindow

ActionField

Enter a job name.Deployment Job Name

Enter the job’s start date and time.Date and Time

Click to accept changes and exit the window.OK

Click to cancel changes and exit the window.Cancel

Deploy ConfigurationWindow

The Deploy Configuration window shows the results of a completed deployment job or

information about a scheduled job. See Table 100 on page 724 for a description of the

fields in this window.

Table 135: Deploy ConfigurationWindow

DescriptionField

Job name.Job Name

Time when job started or will start.Job Start Time

Time when job ended.Job End Time

Percentage of the job that is complete.Percentage Completed

Number of devices in the deployment job.Number of Devices

Deployed Devices table

Device name.Name

Device IP address.IP Address

Status of configuration deployment on device:

• Scheduled—Job is scheduled for future deployment.

• In Progress—Deployment is in progress.

• Success—Deployment completed successfully.

• Failed—Deployment failed.

Deployment Status
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Table 135: Deploy ConfigurationWindow (continued)

DescriptionField

Click View to see the configuration changes that were deployed to the device.

For a scheduled job, this column does not contain a link. See “Deploying Services
Configuration to Devices” on page 959 for information about viewing pending
configuration changes for a device.

Configuration

Click View to see the results of configuration deployment for the device.Result Details

Click to close the window.Close

Related
Documentation

Deploying Configuration to Devices on page 711•

• Managing Configuration Deployment Jobs on page 722

Deleting a Partial Configuration of an LSP Service Order

A failed service order of type Provisioning can leave parts of the service configuration on

the devices. To remove this partial configuration:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP Ethernet service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and

thebottompart of the right panedisplays theManageServiceDeployment page,with

the table of service orders.

6. From the Network Services > Connectivity task pane, select Service Provisioning >

Deploy Services > service order name.
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7. In theManage Service Deployment page, select the failed service order for which you

want to delete the partial configuration.

8. Open the Actionsmenu and select Delete Partial Configuration.

9. In the confirmation screen, select Delete.

Related
Documentation

Managing Service Configuration Deployment Jobs on page 957•

• Deploying Services Configuration to Devices on page 959

• Deploy ConfigurationWindow on page 724

• Managing Jobs on page 118

Deleting a Service Order

You can delete a service order that is in the requested state, the scheduled state, the

invalid state, or the failed deployment state.

To delete a service order from the database:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Network Services task pane, select Connectivity or Tunnel.

4. In the Tasks task pane, select Decommissioned Service Orders.

5. In the Decommissioned Service Orders page, select the service order to be deleted

from the Connectivity Services Director application database.

6. Click Delete.

TheManage Service Deployment page reappears with the deleted service orders

removed.

To delete a service order from a service, which is not decommissioned:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.
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3. From the Network Services task pane, select a service in Connectivity or Tunnel.

4. In the Tasks task pane, select Service Provisioning >Manage Services.

5. In theManage Network Service page, select a service fromwhich the service order

must be deleted.

6. In theManage Service Order page, select the service order.

7. Click Actionsmenu, and select Discard pending Configuration.

The selected service order along with the associated service is deleted.

Related
Documentation

Creating an E-Line Service Order on page 784•

• Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827

• Creating a Point-to-Multipoint E-LAN Service Order on page 847

Deploying a Service

This procedure schedules a service for deployment on the network. Use this procedure

to perform the following tasks:

• Deploy a new service.

• Deploy amodified service.

• Redeploy a service order that failed deployment.

You cannot deploy an invalid service order.

To schedule a service for deployment:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Network Services > Connectivity task pane, select Service Provisioning >

DeployServices. TheManageService Deployment page is displayed on the right pane.

TIP: From Build mode of Service View, in the View pane, if you select the
Connectivity item in the tree under Network Services, without expanding
the tree and selecting a specific service type, such as E-Line Services, IP
Services, or E-LAN Services, the top pane displays a set of five pie charts
that enable you to view the different service orders configured, and their
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associated audit andmonitoring statuses. The FA Status chart displays
the functional audit status for the service orders. The Device State graph
displays the statuses of devices on which services are being provisioned
and commissioned. The Fault Status chart displays the connectivity fault
management details for the service orders. TheSLAStatus chart displays
the service-level agreement details for the service orders. The PM Status
chartdisplays theperformancemanagementdetails for theserviceorders.
The count or percentage of service orders in the pie chart segments sum
up to the total number of configured service orders. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. These charts provide a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

4. In theManage Service Deployment page, select the service order that you want to

deploy.

5. Click the Deploy Service Order button at the top of the page.

The Deploy Servicewindow appears.

6. To deploy the service immediately, select Deploy now, and clickOK.

To deploy the service at a later time, select Schedule Deploy, and select a date and

time for deployment, then clickOK.

The time field specifies the time kept by the server, but in the time zone of the client.

After scheduling the service order for deployment, the provisioning software begins

validating the service order.

7. Use the Jobs workspace to monitor the outcome of the deployment.
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Related
Documentation

Validating the Pending Configuration of a Service Order on page 971•

• Viewing the Configuration of a Pending Service Order on page 972

Validating the Pending Configuration of a Service Order

This procedure validatesa serviceorder butdoesnotpush theconfiguration to thedevice.

Use this procedure to perform the following tasks:

• Validate a service request in the REQUESTED state.

• Validate a service request in the INVALID state after making necessary configuration

changes on one or more PE devices associated with the service order.

When you create a service order, it is is automatically validated in Connectivity Services

Director. However, if subsequent changes to service configuration attributes and settings

have occurred for the devices or endpoints to which they are associated, you can use the

functionality to validate pending service order configuration. You can validate the

configuration of a service order that is in the requested state, the scheduled state, the

invalid state, or the failed deployment state

To schedule a service order for validation, follow these steps:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select a IP t service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and

thebottompart of the right panedisplays theManageServiceDeployment page,with

the table of service orders.

6. From the Manage Service Deployment page, select the service order you want to

validate and save.

7. Open the Actionsmenu and click Validate Pending Configuration.
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The Schedule Service Request Validationwindow appears.

8. You can validate a service now or at some future time:

• To validate the service immediately, select Validate now, and clickOK.

• To validate the service at a later time, select Validate later, select a date and time

for deployment, and then clickOK.

NOTE: When specifying a time to validate the service, the time field
specifies the time kept by the server, but in the time zone of the client.

After scheduling the service order for validation, the provisioning software begins

validating the service order.

9. You can use the JobManagementwindow to viewdetails about the service validation.

NOTE: Alternatively, todisplay the JobManagementpage, click theSystem

icon on theConnectivity Services Director banner, and selectManage Jobs

from the Tasks pane. You can also view the CSD Deployment Jobs page
in Deploymode of Service View by selecting the View Deployment Jobs

option in the task pane.

Related
Documentation

Deleting a Partial Configuration of an LSP Service Order on page 967•

• Deleting a Service Order on page 968

• Deploying a Service on page 969

Viewing the Configuration of a Pending Service Order

You can view the configuration of a service order that is in the requested state, the

scheduled state, the invalid state, or the failed deployment state.

To view the configuration of such service orders:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Network Services > Connectivity task pane, select Service Provisioning >

Deploy Services. The Manage Service Deployment page is displayed on the bottom

part of the right pane.
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TIP: From Build mode of Service View, in the View pane, if you select the
Connectivity item in the tree under Network Services, without expanding
the tree and selecting a specific service type, such as E-Line Services, IP
Services, or E-LAN Services, the top pane displays a set of five pie charts
that enable you to view the different service orders configured, and their
associated audit andmonitoring statuses. The FA Status chart displays
the functional audit status for the service orders. The Device State graph
displays the statuses of devices on which services are being provisioned
and commissioned. The Fault Status chart displays the connectivity fault
management details for the service orders. TheSLAStatus chart displays
the service-level agreement details for the service orders. The PM Status
chartdisplays theperformancemanagementdetails for theserviceorders.
The count or percentage of service orders in the pie chart segments sum
up to the total number of configured service orders. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. These charts provide a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

4. Select a service order that is in either of the following states:

• Requested

• Invalid

• Scheduled

• Failed deployment

NOTE: TheOrder State column displays the state of the service order.
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5. Select the service order for which you want to view the configuration details.

6. Open the Actionsmenu and select the View Pending Order Configuration option. The

Pending Order Configurationwindow is displayed. The configuration is displayed in

xml format.

NOTE: TheViewPendingOrder Configuration appears to be dimmed if the

service order state is Completed.

7. Select a device to view the configuration details. You can also view the template

configuration if a template is attached to the service order.

Based on the application’s settings, the configuration is displayed in xml format or in set

format. To view the configuration in set format:

1. Select Platform > Administration > Applications > Connectivity Services Director.

2. Right-click theConnectivityServicesDirector applicationandselectModifyApplication

Settings. The Modify Connectivity Services Director Settings window is displayed.

3. Select the show configuration in set format check box.

Related
Documentation

Deleting a Partial Configuration of an LSP Service Order on page 967•

• Deleting a Service Order on page 968

• Deploying a Service on page 969

• Validating the Pending Configuration of a Service Order on page 971

Viewing Decommissioned E-Line, E-LAN, and IP Service Orders

In certain situations, youmight decommission a service that a customer no longer needs.

You cannot decommission a service if a service order requesting action on that service

is in the Requested, Scheduled, In Progress, or Invalid state. You can view the

decommissioned service orders in a separate page to determine whether you want to

delete it completely.

To view and determine the status of decommissioned service orders in a tabular form:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Connectivity Services Director user interface, click the Deploy icon in the

Connectivity Services Director banner. The functionalities that you can configure in

this mode are displayed in the task pane.
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3. From the View pane, click the plus sign (+) to expand the Network Services tree, and

select the Connectivity node.

4. In the Network Services > Connectivity view pane, select Service Provisioning >

Decommissioned Service Orders.

The Decommissioned Service Orders page is displayed on the right pane.

A table of service orders on the systemappears in themaindisplay area. The following

fields are displayed on this page:

• Name—Unique name assigned to the service.

• Customer—Name of the customer for which the service is provided.

• State:

• Completed—Service order has been successfully deployed.

• Deploy failed—Device is down or the Connectivity Services Director application

wasunable topush the service configuration toadevice configured for the service.

• In-progress—Connectivity Services Director application is in the process of

deploying the service.

• Invalid—Service order contains invalid data.

• Requested—Service provisioner has created the service order, but has not yet

attempted to deploy it or schedule it for deployment.

• Scheduled—Service provisioner has scheduled the service order for deployment.

• Service Type:

• E-Line pseudowire (LDP)

• E-Line pseudowire (BGP)

• E-LAN (MultiPoint-to-MultiPoint)

• E-LAN (Point-to-MultiPoint)

• IP (Full Mesh)

• IP (Hub-Spoke 1 Interface)

• Latest Job—Unique identifier assigned by the system for a deployment job. Click

the link in the job ID to open the CSDDeployment Jobs. The table on that page lists

configuration deployment jobs.

• Signaling Type:

• BGP

• LDP

• Created By—The screen name of the user who created the service order

• Created Date—The date and when you created the service order.
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From this page, you can delete a decommissioned service order and view the details

of a service order.

5. Select the check box beside a decommissioned service order that youwant to delete,

and click Delete above the table of listed service orders.

Youareprompted toconfirm thedeletion.ClickOK to confirm thedeletion. Thedeleted

service order is removed from the list of decommissioned service orders.

6. To view details of a specific service order, double-click the table row that summarizes

the service order.

Modifying an E-Line Service

You canmodify the following entities of an E-Line service:

• MTU across the network

• Rate limiting bandwidth of an endpoint

• MTU of an endpoint

After modifying a service, the configuration audit and functional audit information is

cleared and the functional audit status is set to pending.

Tomodify the attributes of a service:

NOTE: When youmodify a service or a service order, the read-only fields in
the different pages of thewizard for service or service ordermodification are
grayed out to indicate that you cannot modify those attributes.

1. In theNetworkServices>Connectivity task pane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service you want to modify.

3. Click theModify icon at the top of the page.

A graphical image of the service appears, showing device images that represent the

service endpoints The General Settings box contains a unique name for the service

order that will request the change.

4. In the Name field, change the name of the modification service order, if desired.

5. Change the MTU setting, as required.
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6. If you have configured the CFM, the General/Connectivity Settings panel provides an

option todisable theCFMservice. You can select theDisableCFM checkbox todisable

the CFM service, if desired.

If you have not configured the CFM, the General/Connectivity Settings panel provides

an option to enable the CFM service. You can select the CFM definition from theOAM

Profile list, if desired.

7. Click Next.

The service order endpoint settings information for endpoint A appears in the right

panel.

8. Change the bandwidth or MTU setting as required.

9. Change the Revert time (sec) and Switch Over Delay (sec) as required.

10. Select or clear the Enable send-oam config check box.

11. Click Next andmake any required changes to endpoint Z.

12. ClickModify.

The Connectivity Services Director application modifies the service.

13. Use the System>Manage Jobs > JobManagementworkspace to check for successful

completion of the action.

NOTE: Alternatively, to display the JobManagement page, access the
Jobs workspace from the Junos Space Network Management Platform
UI, and selectManage Jobs from the Tasks pane. You can also view the

CSD Deployment Jobs page in Deploymode of Service View by selecting
the View Deployment Jobs option in the task pane.

Related
Documentation

Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827•

• Creating a Point-to-Multipoint E-LAN Service Order on page 847

• Creating an E-Line Service Order on page 784

Modifying aMultipoint-to-Multipoint Ethernet Service

Foramultipoint-to-multipoint service, youcanchange thebandwidthorMTUofaspecific

UNI, add or delete a UNI, change C-VLAN range values, and change advanced settings

for a device endpoint or add a new device endpoint.
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You cannot change the interface of an existing UNI. Neither can you change the

service VLAN ID.

To perform the equivalent of changing the interface on an existing UNI, add a new UNI

with the desired interface, and then delete the old UNI.

After modifying a service, the configuration audit and functional audit information is

cleared and the functional audit status is set to pending.

Modifying a service creates a new service order based on the attribute settings of the

existing service.

NOTE: When youmodify a service or a service order, the read-only fields in
the different pages of thewizard for service or service ordermodification are
grayed out to indicate that you cannot modify those attributes.

The following topics provide instructions for modifying amultipoint-to-multipoint (full

mesh) Ethernet service:

• Adding an Endpoint on page 978

• Adding a UNI Interface on page 980

• Deleting a UNI Interface and Deleting an Endpoint on page 981

• Changing the Endpoint Bandwidth on page 982

• Changing Advanced Settings for an Endpoint on page 983

Adding an Endpoint

To add an endpoint to amultipoint-to-multipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManageServices page, select the service towhich youwant to add an endpoint.

3. ClickModify at the top of the table of listed service orders.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. If you have configured the CFM, the Service Parameters panel provides an option to

disable the CFM service. You can select theDisableCFM check box to disable the CFM

service, if desired.
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If you have not configured the CFM, the Service Parameters panel provides an option

to enable the CFM service. You can select the CFM definition from theOAMProfile

list, if desired.

6. Click the Node Settings button to view the endpoints or devices that are associated

with the service.

7. In the Service Nodes table, click Add.

The Choose Endpointswindow shows available N-PE devices that are not part of the

service.

8. Select the devices on which you want to add new endpoints, then clickOK. You are

returned to the Node Settings page of the Manage Service Orders wizard.

To filter and sort the display of objects, enter the name of the object as amatch

criterion in the Search box and click the Search icon. The page refreshes to display

only the object names that match with the search term. You can use the paging

controls to navigate across multiple pages of objects as necessary.

Based on the devices you select in the top half of the dialog box, the interfaces that

are present in the selected device are displayed in the lower half of the dialog box.

Select the check boxes next to the interfaces that you want to associate with the

service.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices forUNI. To select a differentUNI, see “Adding aUNI Interface” onpage980. To

select a different bandwidth than the applied default, see “Changing the Endpoint

Bandwidth” on page 982.

9. Click Finish to complete the modification of the service order and save the settings.

10. In Deploy mode of the Service View of the Connectivity Services Director, select one

of the following from the Manage Services page:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

11. ClickOK.

12. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.
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Adding a UNI Interface

To add a UNI on a device that is already part of a multipoint-to-multipoint Ethernet

service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service to which you want to add a UNI.

3. ClickModify at the top of the table of listed service orders.

Current service settings appear in the main display area. The Service Parameters box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. Click theSite/Endpoint Settings button to view the interfaces on endpoints or devices

that are associated with the service.

6. In the User-to-Network Interfaces table, click Add.

The Choose Endpointswindow shows available N-PE devices that are not part of the

service.

7. Select the devices on which you want to add new interfaces. The window refreshes

to display all the user-to-network (UNI) or ingress interfaces for the selected device

in the lower part of the window as a tabular grid. Select the interfaces that you want

to assign to the service order, and then clickOK.

To filter and sort the display of objects, enter the name of the object as amatch

criterion in the Search box and click the Search icon. The page refreshes to display

only the object names that match with the search term. You can use the paging

controls to navigate across multiple pages of objects as necessary.

You are returned to the Node Settings page of the Manage Service Orders wizard.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices forUNI. Toselectadifferentbandwidth than theapplieddefault, see “Changing

the Endpoint Bandwidth” on page 982.

8. If the interface you selected in the previous step is already configured (duplicate) you

must eithermanually enter a different value in the service VLAN ID fields, or check the

Autopick VLAN ID field.

9. Select an interface from the UNI Interface column.
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10. Click Finish to complete the modification of the service order and save the settings.

11. In Deploy mode of the Service View of the Connectivity Services Director, select one

of the following from the Manage Services page:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

12. ClickOK.

13. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, and select Jobs >Manage Jobs from the Tasks pane.

You can also view the CSD Deployment Jobs page in Deploymode of
Service View by selecting the View Deployment Jobs option in the task

pane.

Deleting a UNI Interface and Deleting an Endpoint

To delete a UNI from amultipoint-to-multipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service fromwhich you want to delete a UNI.

3. ClickModify at the top of the table of listed service orders.

Current service settings appear in themain display area. TheServiceParameters page

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. Click theSite/Endpoint Settings button to view the interfaces on endpoints or devices

that are associated with the service.

6. In theUser-to-Network Interfaces table, select the interfaces that youwant to remove

from being assigned to the service order, and click Delete at the top of the table.

The selected UNI is removed from the table. If the deleted UNI was the only UNI

selected on that device, then the device is deleted from the Endpoint Settings table.

7. Click Finish to save the modified service order.
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8. In Deploy mode of the Service View of the Connectivity Services Director, select one

of the following from the Manage Services page:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

9. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, to display the JobManagement page, from the Jobs
workspace of the Junos Space Platform UI, selectManage Jobs from the

Tasks pane. You can also view the CSD Deployment Jobs page in Deploy
mode of Service Viewby selecting theViewDeployment Jobs option in the

task pane.

Changing the Endpoint Bandwidth

To change the rate limit or bandwidth for an endpoint of a multipoint-to-multipoint

Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service on which you want to change the

bandwidth of an endpoint.

3. ClickModify at the top of the table of listed service orders.

Current service settings appear in themain display area. TheServiceParameters page

of thewizard containsauniquename for the serviceorder thatwill request thechange.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. Click the Site/Endpoint Settings button to navigate to the corresponding page of the

wizard. Click on the Bandwidth entry for the UNI on which you want to change the

bandwidth.

6. From the list of valid bandwidth settings, select the setting youwant, then click Finish.

7. In Deploy mode of the Service View of Connectivity Services Director, select one of

the following:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.
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8. ClickOK.

9. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Changing Advanced Settings for an Endpoint

To change advanced settings for an endpoint of a multipoint-to-multipoint Ethernet

service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service on which you want to change one or

more advanced settings for an endpoint.

3. ClickModify at the top of the table of listed service orders.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modified service order, if

desired.

5. In the Endpoint Settings page of the wizard, find the device endpoint you want to

modify, and click Advanced for that table row.

The Advanced Settingwindow displays the security and advanced settings that you

can configure for a device.

See the Service Attributes Overview for more information about configuring MAC

security settings and advanced settings.

6. In theMACSecuritySettingsbox,make selections forMAC learning andMACstatistics

and enter values for Interface MAC limit, MAC table size, and MAC table aging time.

7. Enable or disable tunnel services by selecting or clearing the disable-tunnel-service

check box.

8. Enable or disable local switching by selecting or clearing the disable-local-switching

check box.
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9. In the Fast reroutepriority field, specify the reroute priority for a VPLS routing instance.

10. In the Label block size field, specify the label block size for VPLS labels.

11. In the Connectivity type field, select a connection-type to specify when a VPLS

connection is taken down, depending on whether or not the interface for the VPLS

routing instance is customer-facing or integrated routing and bridging (IRB)

12. ClickOK to save all your changes in the Advanced Setting window.

13. Click Finish.

14. In Deploy mode of the Service View, select one of the following:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

15. ClickOK.

16. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Related
Documentation

Creating a Full Mesh IP Service Order on page 879•

• Creating a Hub-and-Spoke IP Service Order on page 901

Modifying a Point-to-Multipoint Ethernet Service

For a point-to-multipoint service, you can add a spoke or a hub, change the role of a

device from hub to spoke or spoke to hub, change the bandwidth or MTU of a specific

UNI, or add or delete a UNI.

You cannot change the interface of an existing UNI or the service VLAN ID.

To perform the equivalent of changing the interface on an existing UNI, add a new UNI

with the desired interface, and then delete the old UNI.

After modifying a service, the configuration audit and functional audit information is

cleared and the functional audit status is set to pending.
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Modifying a service creates a new service order based on the attribute settings of the

existing service.

The following topics provide instructions for modifying amultipoint Ethernet (E-LAN)

service:

NOTE: When youmodify a service or a service order, the read-only fields in
the different pages of thewizard for service or service ordermodification are
grayed out to indicate that you cannot modify those attributes.

• Adding a Spoke on page 985

• Adding a Hub on page 986

• Changing a Spoke to a Hub on page 987

• Changing a Hub to a Spoke on page 988

• Adding a UNI Interface on page 989

• Deleting a UNI Interface or Deleting an Endpoint on page 990

• Changing the Endpoint Bandwidth on page 991

• Changing Advanced Settings for an Endpoint on page 992

Adding a Spoke

To add an endpoint configured as a spoke to amultipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManageServicespage, select the point-to-multipoint service towhich youwant

to add a spoke.

3. Click theModify icon at the top of the table of previously created service orders.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. If you have configured the CFM, the General Settings panel provides an option to

disable the CFM service. You can select theDisableCFM check box to disable the CFM

service, if desired.

If you have not configured the CFM, the General Settings panel provides an option to

enable the CFM service. You can select the CFM definition from theOAMProfile list,

if desired.
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6. Click the Node Settings button to view the endpoints or devices that are associated

with the service.

7. In the Service Nodes table, click Add.

The Choose Endpoints dialog box shows available N-PE devices that are not part of

the service.

The dialog box is divided into two halves. The top half of the dialog box displays the

devices that you can associate with the service. Based on the devices you select in

the top half of the dialog box, the interfaces that are present in the selected device

are displayed in the lower half of the dialog box. Select the check boxes next to the

interfaces that you want to associate with the service.

8. In the Endpoint Settings table, check Spoke for the device you just added.

9. Click Finish to complete the modification of the service order and save the settings.

10. In Deploy mode of the Service View of Connectivity Services Director, select one of

the following from the Manage Services page:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

Adding a Hub

To add an endpoint to amultipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service to which you want to add a hub.

3. Click theModify icon at the top of the table of previously created service orders.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. Click the Node Settings button to view the endpoints or devices that are associated

with the service.

6. In the Service Nodes table, click Add.

The Choose Endpointswindow shows available N-PE devices that are not part of the

service.
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The dialog box is divided into two halves. The top half of the dialog box displays the

devices that you can associate with the service. Based on the devices you select in

the top half of the dialog box, the interfaces that are present in the selected device

are displayed in the lower half of the dialog box. Select the check boxes next to the

interfaces that you want to associate with the service.

7. In the Endpoint Settings table, check Spoke for the device you just added.

8. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Changing a Spoke to a Hub

To change a spoke to a hub in a point-to-multipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManageServicespage, select thepoint-to-multipoint service forwhichyouwant

to change a spoke to a hub.

3. Click theModify icon at the top of the table of previously created service orders.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In theDevice columnof the Endpoint Settings table, find the spoke endpoint youwant

to change to a hub and select the Hub check box.

6. Click Finish to save the modified service order properties.

7. In Deploy mode of the Service View of Connectivity Services Director, select one of

the following:

• Schedule the change for immediate deployment.
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• Schedule the change for later deployment.

8. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Changing a Hub to a Spoke

NOTE: You cannot change the only hub of a point-to-multipoint service to
a spoke. Youwill receiveanerrormessagewhenyou try to save sucha service
configuration.

To change a hub to a spoke in a point-to-multipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManageServicespage, select thepoint-to-multipoint service forwhichyouwant

to change a hub to a spoke.

3. Click theModify icon at the top of the table of previously created service orders.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In theDevice columnof the Endpoint Settings table, find the spoke endpoint youwant

to change to a hub and clear the Hub check box.

6. Click Finish to save the modified service order properties.

7. In Deploy mode of the Service View of Connectivity Services Director, select one of

the following:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

8. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.
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NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Adding a UNI Interface

To add a UNI on a device that is already part of a multipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service to which you want to add a UNI.

3. Click theModifyService iconat the topof thepageofpreviouslydefinedserviceorders.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. Click theSite/Endpoint Settings button to view the interfaces on endpoints or devices

that are associated with the service.

6. In the User-to-Network Interfaces table, click Add.

The Choose Endpointswindow shows available N-PE devices that are not part of the

service.

7. Select the devices on which you want to add new interfaces. The window refreshes

to display all the user-to-network (UNI) or ingress interfaces for the selected device

in the lower part of the window as a tabular grid. Select the interfaces that you want

to assign to the service order, and then clickOK.

To filter and sort the display of objects, enter the name of the object as amatch

criterion in the Search box and click the Search icon. The page refreshes to display

only the object names that match with the search term. You can use the paging

controls to navigate across multiple pages of objects as necessary.

You are returned to the Node Settings page of the Manage Service Orders wizard.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices for UNI.
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8. If the interface you selected in the previous step is already configured (duplicate) you

must either enter a different value in the service VLAN ID field manually, or check the

Autopick VLAN ID field.

9. ClickModify.

10. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

11. ClickOK.

12. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Deleting a UNI Interface or Deleting an Endpoint

NOTE: You cannot delete the last endpoint on the only hub device in the
service. Youwill receive an errormessagewhen you try to save such a service
configuration.

To delete a UNI from amultipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service fromwhich you want to delete a UNI.

3. Click the Delete icon at the top of the page.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.
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5. Click theSite/Endpoint Settings button to view the interfaces on endpoints or devices

that are associated with the service.

6. In theUser-to-Network Interfaces table, select the interfaces that youwant to remove

from being assigned to the service order, and click Delete at the top of the table.

The selected UNI is removed from the table. If the deleted UNI was the only UNI

selected on that device, then the device is deleted from the Endpoint Settings table.

7. Click Finish to save the modified service order.

8. In Deploy mode of the Service View of Connectivity Services Director, select one of

the following from the Manage Services page:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

9. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Changing the Endpoint Bandwidth

To change the rate limit or bandwidth for an endpoint of a multipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service on which you want to change the

bandwidth of an endpoint.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. Click the Site/Endpoint Settings button to navigate to the corresponding page of the

wizard. Click on the Bandwidth entry for the UNI on which you want to change the

bandwidth.
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6. Fromthe list of validbandwidth settings, select the setting youwant, thenclickModify.

7. In Deploy mode of the Service View of Connectivity Services Director, select one of

the following:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

Changing Advanced Settings for an Endpoint

To change advanced settings for an endpoint of a point-to-multipoint Ethernet service:

1. in theNetworkServices>Connectivity viewpane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service on which you want to change one or

more advanced settings for an endpoint.

3. Click theModify icon at the top of the page.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modified service order, if

desired.

5. In theAction columnof theEndpointSettings table, find the device endpoint youwant

to modify, and click Advanced for that table row.

The Advanced Settingwindow displays the security and advanced settings that you

can configure for a device.

6. In theMACSettings box, make selections for MAC learning and MAC statistics and

enter values for Interface MAC limit, MAC table size, and MAC table aging time.

7. Enable or disable tunnel services by selecting or clearing the disable-tunnel-service

check box.

8. Enable or disable local switching by selecting or clearing the disable-local-switching

check box.

9. In the Fast reroutepriority field, specify the reroute priority for a VPLS routing instance.

10. In the Label block size field, specify the label block size for VPLS labels.
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11. In the Connectivity type field, select a connection-type to specify when a VPLS

connection is taken down, depending on whether the interface for the VPLS routing

instance is customer-facing or integrated routing and bridging (IRB)

12. ClickOK to save all your changes in the Advanced Settingwindow.

13. In Deploy mode of the Service View in the Connectivity Services Director GUI, select

one of the following:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

14. ClickOK.

15. Use the System>Manage Jobs > JobManagementworkspace tomonitor the progress

and status of the deployment.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Related
Documentation

Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827•

• Creating a Point-to-Multipoint E-LAN Service Order on page 847

• Creating an E-Line Service Order on page 784

Modifying a Hub-and-Spoke IP Service Order

You canmodify and deploy previously configured IP hub-and-spoke service orders.

Modifying a service order involves the following tasks:

NOTE: When youmodify a service or a service order, the read-only fields in
the different pages of thewizard for service or service ordermodification are
grayed out to indicate that you cannot modify those attributes.

1. Viewing the Service Definition on page 994

2. Configuring Service Parameters Information on page 995

3. Selecting N-PE Devices or Nodes on page 1000

4. Setting Attributes for Endpoints or Nodes on page 1001

5. Adding and Deleting UNI Interfaces on page 1004
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6. Setting Attributes for UNIs or Sites on page 1005

7. Deploying the New Service on page 1008

Viewing the Service Definition

To view the service definition on which the service order is based:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Fromthe JunosSpaceuser interface, click theDeploy iconon theConnectivityServices

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

5. Select IP Services to manage IP Ethernet service orders.

6. You canmodify a service order or a deployed service in either of the following ways:

From the Manage Network Services page, do the following:

a. Select the check box beside the service that you want to modify.

b. Click Edit at the top of the table of the listed services.

The Edit Service Order wizard is displayed. You can navigate to the various pages

of thewizardbyclicking thebuttonsat the topof thepageor thenavigationbuttons

at the bottom of the page.

From the Manage Service Deployment page, do the following:

a. FromtheManageServiceDeploymentpage, select thecheckboxbeside theservice

you want to modify.

b. Click Edit at the top of the table of the listed services.

TheReviewpage or step of the Edit ServiceOrderwizard is displayed. You can click

Edit beside the sections in the page forwhich youwant to update the configuration

parameters. The settings that you can configure in the service order are organized

in separate pages of the wizard, which you can launch by clicking the appropriate

buttons at the top of the Edit Service Order page. Alternatively, you can proceed

to the corresponding setting-related pages by clicking the Back and Next buttons

at any point in the wizard.

7. From the Service Definition field, click View to open a popup dialog box that displays

the details of the selected service definition. The service definition properties, such

as the name, signaling type (LDP or BGP), service type (Ethernet, ATM, or TDM), are
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displayed.The interface-specificattributes, suchas rate-limitingdetails, encapsulation,

and VLAN tags, are also displayed in the dialog box. Close the dialog box to return to

the service order modification wizard.

Based on the fields or parameters that you defined in the service definition to be

enabled for modification in the service order, the corresponding fields are available

for editing. The fields that are disabled for modification in the service order can only

be edited in the service definition.

Configuring Service Parameters Information

In this topic you configure general settings, VPN settings that can be applied to all end

points, and routing protocol settings for the provider edge (PE) and customer edge (CE)

devices.

• Specifying General Settings on page 995

• Specifying PE-CE Settings Information on page 999

Specifying General Settings

You configure general information about the service order in the General Settings box of

the Enter Order Information window.

If a service template is attached to the service definition, there is a link to that template

at thebottomof theEndpointSettings sectionof thewindow.For instructionsonworking

with service templates in service orders, see “Creating aServiceOrder Based on aService

Definition with a Template” on page 927.

Youmust add the customer to the database before proceeding. See “Adding a New

Customer” on page 697.

To enter general settings information:

1. In the Name field, type a unique name for the full mesh service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for an IP service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “ospf”, as the name of a service order.

2. In the Customer field, select the customer who is requesting the service.

3. In the Comments field, type a description of the service.

Thisdescriptionappears in informationwindowsabout the requestor service instance

created from the request.
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To enter connectivity settings information:

1. Specifywhether theAutopickRouteTarget canbe selectedautomatically ormanually.

• To assign the Route Target automatically, select the Auto Pick Route target check

box.

• To assign the Route Target, clear the Auto Pick Route Target check box.

The window expands to include the Route Target field. In the Route Target field,

type a value.

NOTE: For Hub-and-Spoke service order, clear the Auto Pick Hub Route

Target andAutopick SpokeRoute Target check boxes to activate theHub

Route Target and Spoke Route Target fields, respectively.

When youmanually type a route target, JunosSpace accepts either of the following

two formats:

• prefix-number:assigned-number

Where prefix-number can be any numeric value from 1 through 65,535. The

assigned-number can be any numeric value from 0 through 2,147,483,647.

• IPV4-address:assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

2. Specify whether the Auto Pick Route Distinguisher can be selected automatically or

manually.

• To assign the Route Distinguisher automatically, select the Auto Pick Route

Distinguisher check box.

• To assign the Route Distinguishermanually, clear the Auto Pick Route Distinguisher

check box.

The window expands to include the Route Distinguisher field. In the Route

Distinguisher field, type a value.

When youmanually type route distinguishers, Junos Space accepts either of the

following two formats:

• prefix-number: assigned-number

Where prefix-number can be any numeric value from 1 through 65,535. The

assigned-number can be any numeric value from 0 through 2,147,483,647.

• IPV4-address: assigned-number
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Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

3. Select the Autopick Hub Route Target and Autopick Spoke Route Target check boxes

if youwant theRoute target chosenautomaticallyby theConnectivityServicesDirector

application.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

Tomanually assign a Route target:

1. Clear theAutopickHubRoute Target andAutopick SpokeRoute Target check boxes

to activate the Hub Route Target and Spoke Route Target fields respectively.

2. In the Route Target field, enter a value.

When youmanually enter route target, JunosSpace accepts either of the following

two formats:

• <prefix-number>: <assigned-number>

Where <prefix-number> can be any numeric value from 1 to 65535, inclusive.

The <assigned-number> can be any numeric value from 0 to 2,147,483,647,

inclusive.

• <IPV4-address>: <assigned-number>

Where<IPV4-address>canbeanyvalid IPV4address (inW.X.Y.Z "dot"notation),

and <assigned-number> can be any numeric value from 0 to 65535, inclusive.

4.

5. Select theAutopickHubRouteDistinguisherand theAutopickSpokeRouteDistinguisher

check boxes if you want the Route distinguisher chosen automatically by the

Connectivity Services Director application.

Tomanually assign a Route distinguisher:

1. Clear the Autopick Hub Route Distinguisher and the Autopick Spoke Route

Distinguisher check boxes to activate theHubRoute distinguisher and SpokeRoute

distinguisher fields respectively.

2. In the Route distinguisher field, enter a value.

When youmanually enter route distinguishers, Junos Space accepts either of the

following two formats:

• <prefix-number>: <assigned-number>
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Where <prefix-number> can be any numeric value from 1 to 65535, inclusive.

The <assigned-number> can be any numeric value from 0 to 2,147,483,647,

inclusive.

• <IPV4-address>: <assigned-number>

Where<IPV4-address>canbeanyvalid IPV4address (inW.X.Y.Z "dot"notation),

and <assigned-number> can be any numeric value from 0 to 65535, inclusive.

To enter VPN settings details:

1. To configure a separate label for each VRF to provide double lookup and egress

filtering, select the VRF Table label check box.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

The Export Direct Routes check box is not editable in the service order.

2. Select theEnableMVPNcheckbox toenablemulticast virtualprivatenetwork (MVPN).

To enter default UNI settings information:

1. Select a value for Ethernet Option:

• Port

• Dot1Q

Specifying the Dot1Q Ethernet option enables you to apply a Unit ID, a single VLAN

ID, a VLAN Range, or a VLAN list to the service order.

• QinQ

Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN

Range, or aVLAN list to the serviceorder. For an IP servicedeployedonadual tagged

interface, the inner tag determines the VPN routing and forwarding instance(VRF).

2. Select or clear the Autopick Interface IP check box.

• To specify the Interface IP address, clear the Autopick interface IP check box.

• To specify the IPAddressPool and IPBlockSize field values in theSite Settings page

of the service order creation wizard, select the Autopick interface IP check box.

If you have selected the Enable MC- LAG check box in the Service Settings section,

the maximum andminimum values for IP block size are 29 and 28, respectively.

NOTE: You cannot edit the Autopick Interface IP check box if you have

not selected the Editable in Service Order check box in the service

definition.
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NOTE: The fields specified in the Default UNI Settings section are based
on the Ethernet Option type. The Logical IF Settings box is not available if

you have selected the Ethernet Option as Port.

3. Specifywhether theAutopick InterfaceUnitcanbeselectedautomatically ormanually.

• To assign the Unit ID automatically, select the Autopick Interface Unit check box.

• To assign the Unit IDmanually, clear the Autopick Interface Unit check box.

The window expands to include the Unit ID field. In the Unit ID field, type a value.

Range: 1 through 1073741823

NOTE: You can edit this field only if you have selected the Editable in

Service Order check box for the VLAN ID selection in the service definition.

4. Specify whether the Autopick VLAN ID can be selected automatically or manually.

• To assign the VLAN ID automatically, select the Autopick VLAN ID check box.

• To assign the VLAN IDmanually, clear the Autopick VLAN ID check box.

Thewindow expands to include the VLAN ID field. In the VLAN ID field, type a value.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

Specifying PE-CE Settings Information

YouconfigureVPNattributes that areusually common for all theendpoints in the service.

The values that youprovide vary, dependingon the service definition onwhich the service

order is based.

If you do not expect these attributes to be the same on all endpoints, you can set them

to be the same for now and thenmake changes later, or you can skip this step and apply

the attribute values one at a time later.
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In the PE-CE Settings section of the Service Parameters page, depending on the PE-CE

routing protocol—OSPF/Static Route or BGP/Static Route—do one of the following:

• If BGP/Static Route routing protocol is specified in the service definition:

a. The AS override option is selected to allow a service provisioner to override the AS

number. Clear the AS override check box to prevent a service provisioner from

overriding the AS number.

b. Enter a value for the maximum number of prefixes accepted by a PE router from a

CE router.

• IfOSPF/Static Route routing protocol is specified in the service definition, in theOSPF

domain ID field, enter a IP address.

You can enter from 1.0.0.1 to 223.255.255.254. excluding 127.x.x.x.

1. Click Next.

The Node Parameters page appears.

Selecting N-PE Devices or Nodes

In this topic you select theN-PE devices that youwant to host the service endpoints. The

selection is made from the Select Endpoint PE Deviceswindow.

NOTE: TheChooseEndpointswindow,whichyoucanviewbyclicking theAdd

icon on the Node Parameters page, shows only assigned N-PE devices that
have an AS number configured. If you do not see the device you are looking
for, use the CLI on the device to check for and assign an AS number.

N-PE devices that have L2VPN only do not appear.

To select endpoint N-PE devices:

1. In the Node Parameters page, click Add in the Service Nodes table. From the Choose

Endpoints dialog box that appears, select the devices that you want to participate in

the service. Use the multiple selection feature to select one or more devices.

NOTE: In the Choose Endpoints dialog box, you can sort and segregate
the devices and their corresponding interfaces based on the roles of the
devices to easily and quickly view only the devices of interest. Click the
down arrow on the Filter Rolemenu, and select P2E to view only the

provider edgedevices,P to viewonly the provider devices, and L2E to view

only Layer 2 Ethernet devices.

2. ClickOK.
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The Node Parameterswindow appears.

3. Continue with modifying or entering the node parameters.

Setting Attributes for Endpoints or Nodes

If a service template is attached to the service definition, there is a link to that template

at thebottomof theEndpointSettings sectionof thewindow.For instructionsonworking

with service templates in service orders, see “Creating aServiceOrder Based on aService

Definition with a Template” on page 927.

You set attributes for each endpoint in the service from the Endpoint Settings window.

The interface shown in theUNI Interface field is automatically selectedby theConnectivity

Services Director application, which chooses the UNI that has the highest available

capacity among interfaces that are in the Up state. To calculate the available capacity

of the interface, the system subtracts the bandwidth reserved for each service deployed

on that interface from the total capacity of the interface.

For each endpoint, the Endpoint Settingswindowshows the value for eachUNI attribute.

As a service provider, you can create static routes on the service. To specify static routes

for a CE device on the Node Parameters page:

1. Click the Add icon above the Static Routes table. A new row is added to the table and

highlighted in yellow to denote that you can enter the destination prefix and next-hop

address.

2. In the Destination Prefix field, enter the endpoint for the static route.

3. In the Next-Hop field, enter the IP address of the next-hop. You can enter a dotted

decimal notation, between 1.0.0.1 and 223.255.255.254 except 127.x.x.x.

4. Insert as many static routes as you require. To delete an existing route, select the

check box beside the route, and click Delete above the listed routes.

TheMVPNandPIMSettings sections are displayed only if you selected the EnableMVPN

check box in the Service Parameters page of the creation of service order wizard. To

specify PIM settings for the service order:

1. From the PIMMode list, specify the mode of PIM. Only PIM sparse mode is currently

supported.
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NOTE: A Protocol Independent Multicast (PIM) sparse-mode domain
uses reverse-path forwarding (RPF) to create a path from a data source
to the receiver requesting the data.When a receiver issues an explicit join
request, anRPFcheck is triggered.A (*,G)PIM joinmessage is sent toward
the RP from the receiver's designated router (DR). (By definition, this
message is actually called a join/prunemessage, but for clarity in this
description, it is called either join or prune, depending on its context.) The
joinmessage ismulticast hopbyhopupstreamto theALL-PIM-ROUTERS
group (224.0.0.13)bymeansof each router’sRPF interfaceuntil it reaches
the RP. The RP router receives the (*,G) PIM join message and adds the
interface on which it was received to the outgoing interface list (OIL) of
the rendezvous-point tree (RPT) forwarding state entry. This builds the
RPT connecting the receiver with the RP. The RPT remains in effect, even
if no active sources generate traffic.

2. From the Interface list, select the interface to be used for PIM.When youmodify a UNI

from the list of interfaces on the Site Settings page, the GUI does not automatically

delete the UNI from the Endpoint list. However, the newly added UNIs are added to

the Interface list for the selected device or node.

To specify rendezvous point (RP) settings:

1. Click theAdd iconabove the tableofRPaddresses.TheAddRendezvousPointAddress

dialog box is displayed.

2. In the Rendezvous Point (device) field, configure the routing device as an actual or

potential rendezvous point (RP). A routing device can be an RP for more than one

group.

3. In the Interface field, specify the nameof the interface onwhichPIMmust be enabled.

Specify the full interfacename, including thephysical and logical addresscomponents.

UNIs for the selecteddevice include lo0 if the selecteddevice is enabledwith loopback.

4. In the Group Address field, configure the address ranges of the multicast groups for

which this routingdevice canbea rendezvouspoint (RP). Bydefault, the routingdevice

is eligible tobe theRP for all IPv4or IPv6groups (224.0.0.0/4or FF70::/12 toFFF0::/12).

5. ClickOK to add the RP addresses to the table on the Node Parameters page.

6. Tomodify an added RP address, select the check box beside the row and click Edit.

The dialog box is displayed to enable youmodify the settings.

7. To delete an added RP address, select the check box beside the row and click Delete.

The selected RP address is removed from the table.
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To define MVPN settings for the service order:

1. From theMVPNmode list, indicate whether the shared-tree data distribution mode

(RPT-SPT) or the shortest path tree only (SPT-only)modeofMVPNmust be enabled

to learn about activemulticast sources usingmulticast VPN source-active routes. the

default mode of operation is shortest path tree only (SPT-only) mode. In SPT-only

mode, the active multicast sources are learned throughmulticast VPN source-active

routes. This mode of operation is described in section 14 of the BGP-MVPN draft

(draft-ietf-l3vpn-2547bis-mcast-bgp- 00.txt). If the default mode is not suitable for

your environment, youcanconfigureRPT-SPTmode (also knownas shared-treedata

distribution), as documented in section 13 of the BGP-MVPN draft

(draft-ietf-l3vpn-2547bis-mcast-bgp-00.txt). RPT-SPTmode supports the native

PIMmodel of transmitting (*,G) messages from the receiver to the RP for intersite

shared-tree join messages. This means that the type 6 (*,G) routes get transmitted

from one PE router to another. In RPT-SPTmode, the shared-tree multicast routes

are advertised froman egress PE router to the upstream router connected to the VPN

site with the C-RP

2. In theProviderTunnelName field, specify theprovider tunnel name toconfigure virtual

private LAN service (VPLS) flooding of unknown unicast, broadcast, andmulticast

traffic using point-to- multipoint LSPs. Also configure point-to-multipoint LSPs for

MBGPMVPNs.

3. From the Site Type list, specify the site type of the MBGPMVPN. An MBGPMVPN

defines two types of site sets, a sender site set and a receiver.

4. Select the UpstreamMulticast Hop check box to configure the upstreammulticast

hop (UMH) to denote a router to use the unicast route preference to determine the

single forwarder election.

5. In the Import Unicast Target field, specify the import targets specifically for sender

sites or receiver sites, or can be borrowed froma configured unicast route target. Note

that a sender site export route target is always advertised when security association

routes are exported. By default, the VPN routing and forwarding (VRF) import and

export route targets (configured either using VRF import and export policies or using

the vrf-target statement) are used for importing and exporting routes with the MBGP

MVPN network layer reachability information (NLRI). You can use the export-target

and import-targetoptions to override thedefault VRF import and export route targets.

Select the Sender radio button to import unicast targets for sender sites, select the

Receiver radio button to import unicast targets for receiver sites, or select None to

disable the import of unicast targets.

6. In the Import Target field, specify the import targets for sender and receiver sites.

Select the Sender radio button to import targets for sender sites, select the Receiver

radio button to import targets for receiver sites.
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7. Select the Export Unicast Target check box to specify the export target to enable you

to override the Layer 3 VPN export route targets used for importing and exporting

routes for the MBGPMVPN network layer reachability information (NLRI).

8. In the Target Community field, specify the target community value to be used when

exporting sender and receiver site routes. You can specify this value manually if you

deselect the Autopick Export Target check box.

9. Select the Autopick Export Target check box to specify that you want to enable

automatic selectionof an export targert if a configuration is not provided. An imported

automatic discovery route is treated as belonging to both the sender site set and the

receiver site set.

If you have selected the Enable MC- LAG check box in the General Settings window, the

Is Stitching Point check box is available for each endpoint. If you select this check box,

all the parameters of that endpoint are disabled.

To configure or change the topology settings on the Node Parameters page:

1. The type of network circuit is displayed in the Topology field as full-mesh or

hub-and-spoke.

2. Make sure the Is Stitching Point check box is not selected.

3. To add the loopback interface for an IP service, select the Add Loopback check box.

NOTE: If you provision a loopback interface for an IP service, an operator
is able to identify a VRF routing instance. Thereafter, an operator can
manually ping a remote CE router from a local PE router.

4. Select the Is Hub check box to enable the node to function as a hub. Deselect the

check box if you want the device to function as a spoke. This field is not applicable

for full-mesh IP services.

5. When you have finished configuring the endpoint settings, click Next.

The Site Settings page of the Create IP Service Order wizard appears.

Adding and Deleting UNI Interfaces

You can add or delete UNI interfaces on the PE devices that participate in a service:
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To add a UNI interface on a selected device:

1. Select the Add icon in above the table of listed UNI interfaces, and from the Choose

Endpointswindow, select the device fromwhich youwant to retrieve theUNI interface

to associate with the service order. The window refreshes to display all the UNI

interfaces configured on the selected device.

2. Select the check boxes beside the UNIs that you want to associate.

3. Click Add to close the window. You are returned to the Site Settings page, and the

selected UNIs are displayed in the table.

4. If the interface you selected in the previous step is already configured (duplicate)

either type a different value in theVLAN ID fieldmanually, or check theAutopickVLAN

ID field.

To delete a UNI interface from a selected device:

• Select the check box adjacent to the interface you want to delete, and click the Delete

icon above the list of displayed interfaces.

If the deleted UNI is the only UNI selected from the device, then the device is deleted

from the service configuration.

You can set or modify attributes for a UNI endpoint.

Tomodify a UNI interface for a selected device:

1. Select the row for the UNI endpoint that you want to modify.

The UNI Settings dialog box appears.

2. Modify the UNI Settings fields.

3. Eitherapply theattributesyoualreadyspecifiedoraddvalues that youdidnotconfigure

for different attributes of a UNI.

4. When you have finishedmodifying the endpoint settings, clickOK.

The Site Settings page appears.

Setting Attributes for UNIs or Sites

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Site Settings section of the screen. For instructions on

working with service templates in service orders, see “Creating a Service Order Based on

a Service Definition with a Template” on page 927.

This part of the create Ethernet service order procedure sets the attributes for each UNI

or interface in the service. Selection is made using the Site Settings screen.

The interface shown in theUNI Interface field is automatically selectedby theConnectivity

Services Director application, which chooses the UNI that has the highest available

capacity among interfaces that are in the Up state. To calculate the available capacity

of the interface, the system subtracts the bandwidth reserved for each service deployed

on that interface from the total capacity of the interface.
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For each endpoint, the Site Settings page shows the value for each UNI attribute.

To configure or change the site or UNI settings:

1. Select a value for Encapsulation.

• Port

• Dot1Q

Specifying the Dot1Q Ethernet option enables you to apply a Unit ID, a single VLAN

ID, a VLAN Range, or a VLAN list to the service order.

• QinQ

Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN

Range, or aVLAN list to the serviceorder. For an IP servicedeployedonadual tagged

interface, the inner tag determines the VPN routing and forwarding instance(VRF).

• Flexible UNI

Specifying the Flexible UNI Ethernet option enables you to apply different values

for the Unit ID and vlan-tags.

NOTE: Prior to release 13.1P6.1,NetworkActivate set theunit andvlan-id
parameters to the same value.

To create a service order that specifies the Flexible UNI Ethernet option, youmust

complete two preliminary tasks. First youmust create a service template in which

you specify both outer and inner vlan tags. Then youmust create a service definition

that associates the service template with the service definition.

2. To select a different UNI on a device, click the UNI interface and choose another

interface from the list.

3. In the UNI Description, you can enter the description for the selected UNI interface.

The Description field is displayed in Modify Service Order, View Service Order Details,

Modify Service, and View Service windows. You can edit this field while modifying a

IP service order or service.

Range: 0 through 128 characters

4. Specifying the encapsulation settings for a particular UNI:

NOTE: The fields specified in the Encapsulation Settings box are based
on theEncapsulation type. TheEncapsulationSettingsbox is notavailable

if you have selected the Encapsulation as Port.

• If you have selected the Encapsulation as Dot1Q, or,QinQ, or Flexible UNI, specify

whether the Autopick Interface Unit can be selected automatically or manually.

• To assign the Unit ID automatically, select the Autopick Interface Unit check box.
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• To assign the Unit IDmanually, clear the Autopick Interface Unit check box.

The window expands to include the Unit ID field. In the Unit ID field, type a value.

Range: 1 through 1073741823

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the Unit ID field.

• If you have selected the Encapsulation as Dot1Q, or,QinQ, or Flexible UNI, specify

whether the Autopick VLAN ID can be selected automatically or manually.

• To assign the VLAN ID automatically, select the Autopick VLAN ID check box.

• To assign the VLAN IDmanually, clear the Autopick VLAN ID check box.

The window expands to include the VLAN ID field. In the VLAN ID field, type a

value.

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the UNIT ID field.

• If you have selected the Encapsulation asQinQ, select the Customer VLAN Type.

If the Customer VLAN type is Transport all traffic, select theOuter TP ID.

If the Customer VLAN type is Transport single vlan, select the Customer VLAN, Inner

TP ID, andOuter TP ID.

NOTE: You can optionally specify Inner TP ID andOuter TP ID.

5. In the IP section of the Site Settingsp age, clear the Autopick Interface IP check box

to specify the Interface IP address.

Select the Autopick Interface IP check box to specify the IP Address Pool and IP Block

Size.

NOTE: You cannot edit theAutopick Interface IP check box if you have not

selected the Editable in Service Order check box in the service definition.

6. In the Routing Protocol section of the Site Settings page, select the Protocol type.

If the Protocol type is BGP, specify the following information:

• Neighbor IP address
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NOTE: You need to clear the Autopick neighbor IP check box to specify

the Neighbor IP address.

• Peer AS

If the Protocol type isOSPF, specify the following information:

• OSPF area ID-–Specify any valid IPV4 address inW.X.Y.Z "dot" notation.

Range: 0.0.0.0 through 225.255.255.255

• OSPF version-–Select the OSPF version from the list.

7. When you have finished configuring the endpoint settings, click Review to examine

thedefinedsettings.Youcanexamineandmodify thecreatedserviceorderparameters.

Alternatively, click the correspondingbuttonsat the topof thewizardpage tonavigate

to the specific pages pertain to the settings you want to modify. Click Back to return

to the previous page of the wizard; else click Cancel to discard the changes.

Deploying the New Service

To deploy the service:

1. From theManage Deploy Serviceswindow in Deploy mode of Service View of

Connectivity Services Director, perform one of these actions:

• To deploy the service immediately, select Deploy now and then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

and then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

• To validate the service, click Validate.

2. Navigate to the Deployment Configuration Changes window to view the status of the

deploy job.

The service order is now complete.

Related
Documentation

Stitching a Pseudowire to an IP Service on page 877•

• Creating a Full Mesh IP Service Order on page 879

• Selecting a Published IP Service Definition for a Service Order on page 921

Modifying a Full Mesh IP Service

For a fullmesh IP service, you canaddanewdevice endpoint, addor deleteaUNI, change

routing protocol parameters, remove or add static routes, change IP addresses, swap

betweenBGPand static routing protocols (if service definition specifies BGPandStatic),
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swap between OSPF and static routing protocols (if service definition specifies OSPF

and Static).

NOTE: You cannot change the interface of an existing UNI. To perform the
equivalent of changing the interface on an existing UNI, add a newUNI with
the desired interface, and then delete the old UNI.

After modifying a service, the configuration audit and functional audit information is

cleared and the functional audit status is set to pending.

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Endpoint Settings section of the window. For instructions

on working with service templates in service orders, see “Creating a Service Order Based

on a Service Definition with a Template” on page 927.

Modifying a service creates a new service order based on the attribute settings of the

existing service.

NOTE: When youmodify a service or a service order, the read-only fields in
the different pages of thewizard for service or service ordermodification are
grayed out to indicate that you cannot modify those attributes.

• Adding an Endpoint on page 1009

• Adding a UNI Interface on page 1011

• Deleting a UNI Interface and Deleting an Endpoint on page 1012

Adding an Endpoint

To add an endpoint to amultipoint-to-multipoint Ethernet service:

1. In theNetworkServices>Connectivity task pane, selectServiceProvisioning>Manage

Services.

2. In theManageServices page, select the service towhich youwant to add an endpoint.

3. Click theModify iconat the topof thepage that displays thepreviously created service

orders.

TheModify Service page appears.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.

4. In theOrder name field, change the name of themodification service order, if desired.

5. Click the Node Settings button to view the endpoints or devices that are associated

with the service.
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6. In the Service Nodes table, click Add.

The Choose Endpointswindow shows available N-PE devices that are not part of the

service.

7. Select the devices and the interfaces corresponding to the selected devices onwhich

you want to add new endpoints, then clickOK. You are returned to the Node Settings

page of the Manage Service Orders wizard.

To filter and sort the display of objects, enter the name of the object as amatch

criterion in the Search box and click the Search icon. The page refreshes to display

only the object names that match with the search term. You can use the paging

controls to navigate across multiple pages of objects as necessary.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices for UNI.

8. Select the devices on which you want to add new endpoints, and then click Next.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices for UNI. To select a different UNI, see “Adding a UNI Interface” on page 1011.

9. Click Finish to save themodified service order. You are returned to theManageService

Orders page.

10. In Deploy mode of the Service View of Connectivity Services Director, select one of

the following:

• Deploy now to deploy modified service immediately when you click, OK

• Schedule deployment to specify a date and time to deploy the modified service

later. The default time is the current date and time when you select the option.

11. ClickOK.

The service modification deployment job ID is assigned.

12. Click the Job ID.

You see the servicemodification deployment job details in the System>Manage Jobs

> JobManagement page. The JobManagement page presents the job information by

job ID, Name, Percent complete, State, Job Type, Summary, Scheduled Start,

Username, andRecurrence. The State column indicateswhether themodified service

deployment is successful.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.
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Adding a UNI Interface

To add a UNI on a device that is already part of a multipoint-to-multipoint Ethernet

service:

1. In theNetworkServices>Connectivity task pane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service to which you want to add a UNI.

3. Click theModify iconat the topof thepage that displays thepreviously created service

orders.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. Click theSite/Endpoint Settings button to view the interfaces on endpoints or devices

that are associated with the service.

6. In the User-to-Network Interfaces table, click Add.

The Choose Endpointswindow shows available N-PE devices that are not part of the

service.

7. Select the devices on which you want to add new interfaces. The window refreshes

to display all the user-to-network (UNI) or ingress interfaces for the selected device

in the lower part of the window as a tabular grid. Select the interfaces that you want

to assign to the service order, and then clickOK.

To filter and sort the display of objects, enter the name of the object as amatch

criterion in the Search box and click the Search icon. The page refreshes to display

only the object names that match with the search term. You can use the paging

controls to navigate across multiple pages of objects as necessary.

Based on the devices you select in the top half of the dialog box, the interfaces that

are present in the selected device are displayed in the lower half of the dialog box.

Select the check boxes next to the interfaces that you want to associate with the

service.

You are returned to the Node Settings page of the Manage Service Orders wizard.

8. The Interface IP field displays the interface IP address.
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9. The Autopick VLAN ID check box is selected by default to allow Network Activate to

select a VLAN ID. If you deselect the Autopick VLAN ID check box, youmust either

enter a different value in the service VLAN ID field manually.

10. Select a routing protocol from the drop-down list box.

11. ClickModify.

12. ClickModify.

You can now deploy the modified service.

13. In the Deployment Options dialog box, select one of the following:

• Save only and Validate to save the service modification and validate it.

• Deploy now to deploy modified service immediately when you click, OK

• Schedule deployment to specify a date and time to deploy the modified service

later. The default time is the current date and time when you select the option.

14. ClickOK.

The service modification deployment Job ID link appears.

15. Click the Job ID.

You see the servicemodification deployment job details in the System>Manage Jobs

> JobManagement page. The JobManagement page presents the job information by

job ID, Name, Percent complete, State, Job Type, Summary, Scheduled Start,

Username, andRecurrence. The State column indicateswhether themodified service

deployment is successful.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Deleting a UNI Interface and Deleting an Endpoint

To delete a UNI from amultipoint-to-multipoint Ethernet service:

1. In theNetworkServices>Connectivity task pane, selectServiceProvisioning>Manage

Services.

2. In theManage Services page, select the service fromwhich you want to delete a UNI.

3. Click theModify iconat the topof thepage that displays thepreviously created service

orders.
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Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. Click theSite/Endpoint Settings button to view the interfaces on endpoints or devices

that are associated with the service.

6. In the User-to-Network Interfaces table, click Add.

The Choose Endpointswindow shows available N-PE devices that are not part of the

service.

7. Select the devices on which you want to add new interfaces. The window refreshes

to display all the user-to-network (UNI) or ingress interfaces for the selected device

in the lower part of the window as a tabular grid. Select the interfaces that you want

to assign to the service order, and then clickOK.

To filter and sort the display of objects, enter the name of the object as amatch

criterion in the Search box and click the Search icon. The page refreshes to display

only the object names that match with the search term. You can use the paging

controls to navigate across multiple pages of objects as necessary.

Based on the devices you select in the top half of the dialog box, the interfaces that

are present in the selected device are displayed in the lower half of the dialog box.

Select the check boxes next to the interfaces that you want to associate with the

service.

You are returned to the Node Settings page of the Manage Service Orders wizard.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices for UNI.

8. Click Finish to complete the modification of the service order and save the settings.

9. In Deploy mode of the Service View of the Connectivity Services Director, select one

of the following from the Manage Services page:

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

10. You see the service modification deployment job details in the System > Jobs > Job

Management page. The JobManagement page presents the job information by job ID,

Name, Percent Complete, State, Job Type, Summary, Scheduled Start, Username,

andRecurrence.TheStatecolumn indicateswhether themodified servicedeployment

is successful.
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NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

Related
Documentation

Modifying a Multipoint-to-Multipoint Ethernet Service on page 977•

• Modifying a Point-to-Multipoint Ethernet Service on page 984

• Modifying a Hub-and-Spoke IP Service Order on page 993

Understanding Service Validation

Youcanusea functional audit andaconfigurationaudit tomonitor thehealth of a service

for any of the following reasons:

• You have just deployed a service andwant to verify that it works before your customer

starts to use it.

• You want to perform periodic verification that a service is functioning correctly.

• A customer has reported that a service is not functioning correctly and you need to

find out what the problem is and fix it.

The following sections provide instructions for functional audit and configuration audit:

• Performing a Functional Audit on page 1019

• Performing a Configuration Audit on page 1027

Related
Documentation

Viewing Configuration Audit Results on page 1046•

• Viewing Functional Audit Results on page 1048

HighlightingofEndpoints in the IP,RSVPLSP,andE-LANServiceModificationWizards

In the Edit E-LAN Service and Edit IP Service wizards that you use to modify the

corresponding service types, the Node Settings and Site Settings pages that display the

endpoints and interfaces associated with a service are enhanced to provide an

easily-identifiable color-coding format for quickly understanding the changes made to

these pages of the wizards. A new row that you add to these pages is displayed in blue.

An existing row that is deleted from these pages is displayed in red. An existing row that

you update on these pages is shaded in gray. Similarly, the Node Parameters page of the

Edit RSVP LSP Service wizard uses this color-coding format to denote added, modified,

and deleted nodes.

For the modified and deleted endpoints or nodes that are highlighted in gray and red,

respectively, you can select the check boxes beside such rows and click Revert to cancel
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thechangesanddeletionsmade to thesenodes.YoucanclickRevert only for themodified

and deleted nodes, which restores the nodes in the states in which they were present in

the service before you changed or deleted them.
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PART 12

Auditing Services and Viewing Audit
Results

• Service Provisioning: Auditing Services on page 1019

• Troubleshooting Devices and Services on page 1059
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CHAPTER 38

Service Provisioning: Auditing Services

• Performing a Functional Audit on page 1019

• Performing a Configuration Audit on page 1027

• Troubleshooting N-PE Devices Before Provisioning a Service on page 1030

• Modifying the Application Settings of Connectivity Services Director on page 1032

• Troubleshooting the Endpoints of Services on page 1038

• Basic Requirements of Operational Scripts on page 1043

• Viewing Configuration Audit Results on page 1046

• Viewing Functional Audit Results on page 1048

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052

• Modifying a Saved Service Order on page 1052

• Viewing Service-Level Alarms on page 1056

Performing a Functional Audit

A functional audit determines whether a deployed service instance is functioning. It

checks the control plane to ensure connectivity among endpoints and that the UNIs are

functioning correctly. It also checks the data plane to verify packet transmission between

each valid pair of endpoints in the service.

The functional audit provides both a CLI verification and a troubleshooting feature that

allows you to check the status of interfaces, LDP sessions, neighbor links, and endpoints

of E-Line services. The Functional Audit Resultswindow displays information about the

service statistics for the link you are monitoring. When you click Troubleshoot button in

the Functional Audit Results window, the Troubleshooting page displays status of the

interfaces, LDP sessions, neighbor links, and endpoints.

Performing the Functional Audit
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To perform a functional audit:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

4. In the Network Services > Connectivity task pane, select Audit Results > Functional

Audit. Alternatively, you can select a service order, click the Audit button at the top of

the table of listed service orders from the Manage Network Services page and select

Run Functional Audit.

5. In the Schedule Functional Audit dialog box, do one of the following:

a. Select Audit Now, then clickOK.

The Job Details dialog box appears for you to click the Job ID link to see the

functional results. The JobManagement page displays the functional audit details

by job ID, name, percentage complete, state, job type, summary, scheduled start

time, user, and recurrence.

NOTE: Alternatively, to display the JobManagement page, click the
System icon on the Connectivity Services Director banner, and select

Manage Jobs from the Tasks pane. You can also view the CSD

Deployment Jobs page in Deploymode of Service View by selecting
the View Deployment Jobs option in the task pane.

b. Select Audit Later, enter a date and time, then clickOK.

Tomonitor the progress of an audit after selecting Audit Later, after the scheduled

time of the audit:

a. On the Junos SpaceNetworkManagement Platform user interface, select Jobs.

b. Onthe Jobs statisticspage, select theFunctionalAudit segmentof the JobTypes

pie chart.

The JobManagement page appears filtered by functional audit jobs.

c. Select the functional audit job that you want.
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Summary information about the audit appears in the quick look panel.

d. In the filter bar, select the table view icon to see additional information about

the job. If the service failed the audit, information about the failure appears in

the Summary field.
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NOTE: Functional audit can be run for multiple services from Buildmode
ofServiceViewof theConnectivityServicesDirectorGUI. FromtheManage
Network Services page, select the check boxes besidemultiple srvices,
and click the Audit/Results button at the top of the table of configured

services.WhentheAudit/Resultsbutton isclicked, theScheduleFunctional

Audit window is displayed, which enables you to perform the audit
immediately or schedule it to be run at a later time. You can viewdetailed,
ingrained information about the output of the functional audit that you
performed for a service from the Functional Audit Resultswindow. Select
the Service-name > Interface-name Device-name > Remote Interface -

Remote Device in the left pane of the window. The control plane and data

plane statusesaredisplayedby running service-specific commands in the
right pane of the window. Click Rerun Functional Audit at the top-right

cornerof thewindowtoperformtheaudit again. If theStatus fielddisplays
as Completed, an audit can be run again; else, if the Status field displays
asOngoing, it denotes that an audit is currently in progress, youmustwait
for the running instancetobecompletedtoperformafunctionalevaluation
again.

Click Reload Result at the top-right corner of the window to refresh the

results of the audit and display the updated information. You can refresh
the results only for completed audit instances. When you select
Service-name in the left pane of the window, service status information
is displayed in the right pane. The Service Status window displays details
suchas theoperational statusof theservice, thedevicename, the topology
used in the service are displayed in a tabular format. The number of UNI
interfaces and PE devices that are up and down is also shown.When you
select Service-name > Interface-name Device-name > Remote Interface -

RemoteDevice in the left paneof thewindow, endpoint status information

is shown in the right pane. The Endpoint Status window displays details
of the device name, the topology used in service, remoteUNIs status, and
device status of the selected service.

TheServiceStatus fieldcorresponding to theservice forwhichpolleddata
is not available is displayed asNA. The Service Status field represents the
overall status of a service. To calculate the overall service status, a polling
mechanism is used to retrieve data fromdevices by Connectivity Services
Director. Because the overall status of a service involvesmultiple devices,
it is possible to calculate and update service statuses, based on an event
from one of the devices because the status of all endpoints of a service
needs to be determined to compute the overall service status. It is an
expensive operation to send requests to all endpoints, based on an event
from a single device. As a result, a pollingmethod is used to obtain the
overall statusof thedevice.Because thepolleddata representsasnapshot
at a point in time, a delay occurs in updating the status of a service. Also,
whilepolling, if service information fromoneof thedevices isnotavailable,
the service is marked as down.

Copyright © 2019, Juniper Networks, Inc.1022

Connectivity Services Director User Guide



6. To view additional details about the functional audit, including results from checking

the control plane and the data plane, see “Viewing Functional Audit Results” on

page 1048 .

CLI Verification

TheCLI verification featureofa functional auditworksby runningcommands thatperform

verification and reporting relevant information.

The following table shows the commands that are used for each service type.

CLI CommandsXML Commands

Data PlaneControl PlaneData PlaneControl Plane

Service
Type/

Device Type

ping mpls l2circuit
virtual-circuit VCID
neighbor neighborIP

show l2circuit
connections neighbor
neighborIP interface
interfaceName

show ppp interface
mlppp group1 members

<request-ping-l2circuit-virtual-circuit>

<neighbor>neighborIP</neighbor>

<virtual-circuit-id>VCID</virtual-circuit-id>

</request-ping-l2circuit-virtual-circuit>

<get-l2ckt-connection-information>

<neighbor>neighborIP</neighbor>

<interface>interfaceName </interface>

</get-12-ckt-connection-information>

ELINE
Martini/

M Series and
MX Series

Where:

neighborIP = Address of remote neighbor

VC ID = Virtual Circuit ID

interfaceName = Name of interface

show l2circuit name
brief

Not supported.<get-l2circuit-information> <l2circuit-name>
name<l2circuit-name> <brief/>
</get-l2circuit-information>

Not supported.BX Series

Where:

Name = name of the l2 circuit ID

ping vpls instance
routing_instance_name
destination-mac
destMacValue
source-ip
sourceIpValue
learning-vlan-id
learningVlanID

show vpls connections
instance
routing_instance_name
local-site local-siteID
remote-site
remote-siteID

<request-ping-vpls-instance>
<instance-name> routing_instance_name

</instance-name> <destination-mac>
destMacValue

</destination-mac> <source-ip> sourceIp

</source-ip> <learning-vlan-id>
learning-vlan-id

< /learning-vlan-id>
</request-ping-vpls-instance>

<get-vpls-connection-information><instance>
routing_instance_name

</instance> <local-site> local-siteID
</local-site> <remote-site> remote-siteID

</remote-site>
</get-vpls-connection-information>

VPLS/

M Series
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CLI CommandsXML Commands

Data PlaneControl PlaneData PlaneControl Plane

Service
Type/

Device Type

Where:

routing_instance_name = Routing instance name

destMacValue = Destination MAC address

sourceIP = Source IP address

local-SiteID = Name or ID of VPLS local site

remote-SiteID = ID of VPLS remote site

learning-vlan-id = Learning VLAN identifier

ping routing-instance
routiingInstanceValue
count

show route table
bgp.l3vpn.0 rd-prefix
destinationRDprefix

<ping><routing-instance> routingInstanceValue
</routing-instance> <count>5 </count>

<get-route-information> <table>
bgp.l3vpn.0</table>
<rd-prefix>destinationRDprefix</rd-prefix>
</get-route-information>

L3VPN/

Junos

Where:

routingInstanceValue = Routing instance name

destinationRDprefix = Route Distinguisher: remote UNI IP address

destinationUniInterfaceIP = Destination UNI IP address

For the data plane, the Junos Space software places a static MAC address in the

forwarding table of the remote endpoint, which it uses to verify correct packet transfer.

NOTE: DataplanevalidationofanE-LANserviceworks forMXSeriesdevices
running Junos Release 9.4 or later. If the service under audit contains anM
Series device or an N-PE device running Junos Release 9.2 or 9.3, the
functional audit does not complete successfully and generates amessage
stating that functional audit is not supported on that platform.

The following table shows the commands for E-LAN service type:

CategoryCLI CommandsXML CommandsDevice
Family

Service
Type
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Routeshow vpls connection instance
instanceValue

<get-vpls-connection-information>
<instance>instanceValue</instance>
</get-vpls-connection-information>

M
Series

VPLS

MPLSshowmpls lsp ingress<get-mpls-lsp-information> <ingress/>
</get-mpls-lsp-information>

MPLSshowmpls lsp egress<get-mpls-lsp-information> <egress/>
</get-mpls-lsp-information>

MPLSshowmpls static-lsp ingress<get-mpls-static-lsp-information><ingress/>
</get-mpls-static-lsp-information>

Routeshow rsvp session<get-rsvp-session-information>
</get-rsvp-session-information>

Routeshow route table inet.3<get-route-information><table>inet.3</table>
</get-route-information>

UNIshow interface interfaceValue terse<get-interface-information>
<terse/><interface-name>interfaceValue</interface-name>
</get-interface-information>

UNIshow interface interfaceValue statistics<get-interface-information> <statistics/>
<interface-name>interfaceValue</interface-name>
</get-interface-information>

Routeshow route protocol bgp table
instanceValue.l2vpn.0

<get-route-information>
<table>instanceValue</table>
<protocol>bgp</protocol>
</get-route-information>

Where:

instanceValue= Name of the service

neighborIP= Address of the remote neighbor

interfaceValue= Name of the interface

The following table shows the commands for IP service type:

CategoryCLI CommandsXML CommandsDevice
Family

Service
Type
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MPLSshowmpls lsp ingress<get-mpls-lsp-information>
<ingress/>
</get-mpls-lsp-information>

M
Series

L3VPN

MPLSshowmpls lsp egress<get-mpls-lsp-information>
<egress/>
</get-mpls-lsp-information>

Routeshow interfaces
instancevalue.initvalue terse

<get-interface-information>
<terse/>
<interface-name>interfaceValue</interface-name>
</get-interface-information>

Routeshow route forwarding-table vpn
instance

<get-forwarding-table-information>
<vpn>instance </vpn>
</get-forwarding-table-information>

Routeshow rsvp session<get-rsvp-session-information>
</get-rsvp-session-information>

UNIshow interfaces instance statistics<get-interface-information>
<statistics/>
<interface-name>instance</interface-name>
</get-interface-information>

MPLSshowmpls static-lsp<get-mpls-static-lsp-information>
<ingress/>
</get-mpls-static-lsp-information>

Routeshow ospf neighbor<get-ospf-neighbor-information>
</get-ospf-neighbor-information>

Routeshow route table bgp.l3vpn.0<get-route-information>
<table>bgp.l3vpn.0 </table>
<rd-prefix>destinationRDprefix</rd-prefix>
</get-route-information>

UNIshow lacp interfaces<get-lacp-interface-information>
<interface-name>
lagInterface
</interface-name>
</get-lacp-interface-information>

UNIshow interfaces mc-ae<get-mc-ae-interface-information>
</get-mc-ae-interface-information>

UNIShow vrrp interfaceName<get-vrrp-interface-information>
<interface-name>
lnterface
</interface-name>
</get-vrrp-interface-information>

UNIShow bridge domain domainName
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<get-bridge-instance-information>
<bridge-domain-name>
domainName
</bridge-domain-name>
</get-bridge-instance-information>

Where:

instanceValue= Name of the service

neighborIP= Address of the remote neighbor

interfaceValue= Name of the interface

Related
Documentation

Performing a Configuration Audit on page 1027•

• Troubleshooting N-PE Devices Before Provisioning a Service on page 1030

• Modifying the Application Settings of Connectivity Services Director on page 1032

• Troubleshooting the Endpoints of Services on page 1038

• Viewing Configuration Audit Results on page 1046

• Viewing Functional Audit Results on page 1048

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052

Performing a Configuration Audit

A configuration audit can help you determine whether the service configuration on the

device has been changed out of band. To this end, you can compare the results of a

configuration audit with the service configuration in the Junos Space database. The

following example shows a sample comparison.

To perform a configuration audit:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

4. In the Network Services > Connectivity task pane, select Audit Results > Configuration

Audit, and from the Configuration Audit page that is launched, click the Run

Configuration Audit button. Alternatively, you can select a service order, and click the
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Auditbuttonat the topof the tableof listedservices fromtheManageNetworkServices

page and select Run Configuration Audit.

5. In the Schedule Configuration Auditwindow, either:

• Select Audit Now, then clickOK.

An informational dialog appears, stating that the configuration audit job is

successfully triggered with the job ID, and anOK button.

• Select Audit Later, enter a date and time, then clickOK.

6. Tomonitor the progress of an audit after selecting Audit Now, click the Job ID in the

Audit Informationwindow. The JobManagement page shows information about the

configuration audit job.

NOTE: Alternatively, todisplay the JobManagementpage, click theSystem

icon on theConnectivity Services Director banner, and selectManage Jobs

from the Tasks pane. You can also view the CSD Deployment Jobs page
in Deploymode of Service View by selecting the View Deployment Jobs

option in the task pane.

The State field indicates whether the service passed or failed the audit. If the service

failed the audit, then the Summary field provides information about the failure.

Tomonitor the progress of an audit after selecting Audit Later, after the scheduled

time of the audit:

a. On the Junos Space Network Management Platform user interface, select Jobs .

b. In the Job Types chart, select the Configuration Audit segment of the pie chart.

c. Select theconfigurationaudit of interest fromthe list on the JobManagementpage.

Summary information about the audit appears in the quick look panel.

d. In the filter bar, select the table view icon to see additional information about the

job. If the service failed the audit, information about the failure appears in the

Summary field.

7. In the Audit Informationwindow, click the job ID of the configuration audit.

The JobManagementwindow appears and shows a filtered view of the job inventory,

showing only the configuration audit job.

Copyright © 2019, Juniper Networks, Inc.1028

Connectivity Services Director User Guide



NOTE: If a resynchronization between a device and the Junos Space
database is ongoing when the configuration audit job starts, the
configuration audit job suspends until the resynchronization job finishes.
If the resynchronization job fails tocomplete, theaudit couldbesuspended
indefinitely. To allow the audit to proceed, go to the JobManagement

workspaceandcancel the resynchronization job, asdescribed inCanceling
a Job.

8. In theStatus column, check the status of the audit to determinewhether it succeeded

or failed.

Check the Summary column, which contains useful service information such as the

VC ID and endpoint information. For some failed deployments, this column also

contains information about why the deployment failed.

NOTE: When a configuration audit is performed, the XPATH attributes that
are present in the service configuration are used. Only the addition,
modification, ordeletionof theXPATHattributes isdetected, and thecreation
of a new attribute (child XPATH ) on a device is not determined. The audit
operationdisregardssuchattributesanddoesnot identify them.Thisbehavior
is expected and occurs because Junos Space Platform software audits only
the settings present a user template. If the template has a container, Junos
Space Platform only audits to determine whether the device is configured
with this container. If auserwants toaudit anycontainer child, theuserneeds
add it into the template. This scenario is similar to an out-of-band
configuration change on the device, which Junos Space Platform can
determineonly if the systemof record (SOR)mode is set for the JunosSpace
Network Management Platform application.

Related
Documentation

Performing a Functional Audit on page 1019•

• Troubleshooting N-PE Devices Before Provisioning a Service on page 1030

• Modifying the Application Settings of Connectivity Services Director on page 1032

• Troubleshooting the Endpoints of Services on page 1038

• Viewing Configuration Audit Results on page 1046

• Viewing Functional Audit Results on page 1048

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052
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Troubleshooting N-PE Devices Before Provisioning a Service

You can use theTroubleshoot option to check PE router configurations before you deploy

a new service or troubleshoot PE router configurations if you are unable to deploy a new

service.

To check the configuration on a PE router, follow these steps:

1. In the Network Services > Connectivity task pane, select Prestage Devices >Manage

Device Roles

TheManageDevice Roles page appears displaying all devices on the network that are

assigned the N-PE role

2. Select the device that you want to troubleshoot.

3. In the Actionsmenu, select Troubleshoot.

The Troubleshoot Devicewindow appears. The table here describes the show

commands that you can run to check the configuration on a N-PE device.

Table 136: Commands Available in the Troubleshoot DeviceWindow

Fields DisplayedDescriptionCommand

• Device name

• LSP State

• Destination Address

Display whether ingress LSP is up
and running.

showmpls lsp ingress

• Device name

• LSP State

• Destination Address

Display whether egress LSP is up
and running.

showmpls lsp egress

• Peer Address

• Peer State

Display summary information
about BGP and its neighbors to
determine if routes are received
from peers in the autonomous
system (AS). When a BGP session
is established, the peers exchange
update messages.

show bgp summary

• Interface Name

• Neighbor Address

• OSPF Neighbor State

Display information about OSPF
neighbors.

show ospf neighbor

• Peer Address

• Peer State

• Local AS

Display information about all BGP
peers.

show bgp neighbor

• Interface Name

• LDP Neighbor Count

Display standard status
informationaboutall LDP-enabled
interfaces for all routing instances.

show ldp interface
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Table 136: Commands Available in the Troubleshoot DeviceWindow (continued)

• Interface Name

• Neighbor Address

• Remaining Time—remaining hold time before the
neighbor expires, in seconds.

Displaystandard informationabout
LDP neighbors for all routing
instances.

show ldp neighbor

• Name

• LSP State

• Destination Address

For complete information about the fields displayed for
the show rsvp session command, see the Junos Software
Routing Protocols and Policies Command Reference.

Display information about
Resource Reservation Protocol
(RSVP) sessions.

show rsvp session

• Interface Name

• RSVP Status

• Static Bandwidth

• Available Bandwidth

• Total Reserved Bandwidth

Display the status of Resource
Reservation Protocol
(RSVP)-enabled interfaces and
packet statistics.

show rsvp interface

• Interface Name

• Adjacency State

• System Name

For complete information about the fields displayed for
theshow isisadjacencycommand, see the JunosSoftware
Routing Protocols and Policies Command Reference.

Display information about
intermediate
System-to-Intermediate System
(*IS-IS) neighbors.

show isis adjacency

4. Select on any show command to view device-specific configuration information.

NOTE: For additional information about a PE device configuration, you
canexplicitly runashowcommandwith theextensiveoption, for example,
showmpls lsp extensive.

Related
Documentation

Performing a Functional Audit on page 1019•

• Performing a Configuration Audit on page 1027

• Modifying the Application Settings of Connectivity Services Director on page 1032

• Troubleshooting the Endpoints of Services on page 1038

• Viewing Configuration Audit Results on page 1046

• Viewing Functional Audit Results on page 1048

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052
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Modifying the Application Settings of Connectivity Services Director

Tomodify the configuration settings of services activation-related capabilities of

Connectivity Services Director, perform the following steps:

1.
Toopen thePreferences page, click in theConnectivity ServicesDirector banner

and select Preferences from the list.

The Preferences page appears, with User Preferences as the default tab.

2. Click the Services Activation tab.

3. Click any parameter, or specify a different value for parameters that accept values,

to modify it.

NOTE: You cannot modify the application settings if another user is
currently modifying them.

4. ClickOK to save the changes that youmade in the Connectivity Services Director

application or click Cancel to retain the original settings.

Also, you canmodify the configuration settings for the Connectivity Services Director

application using the Junos Space Platform GUI.

Tomodify the configuration settings of Connectivity Services Director using the Junos

Space Platform GUI, perform the following steps:

1. From the NetworkManagement Platform task pane, select Administration >

Applications.

The Applications page that appears displays a list of the applications in the Network

Management platform.

2. Right-click Network Activate and selectModify Applications Settings.

TheModify Application Settings page that appears displays a list of the parameters

that can bemodified.

3. Click any parameter to modify it.
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NOTE: You cannot modify the application settings if another user is
currently modifying them.

4. ClickModify to save the changes that youmade in the Connectivity Services Director

application or click Cancel to retain the original settings.

To understand the parameters of the Connectivity Services Director application settings,

refer to Table 15 on page 123.

Table 137: Parameters in Connectivity Services Director Application Settings

DescriptionFields

Deployment

Select this check box to validate the version of the service being configured.Check service version

Select this check box to deploy the configuration to the device.Deployconfiguration to thedevice

Select this check box to enable the service alarms. Enabling the service alarms causes a
GUI impact on the Connectivity Services Director application. When you select the check
box and deploy the service, the interface goes down, resulting in the failure to update the
fault status. When you right-click Service and select View Service Alarms, the latter does
not appear in the results.

Enable service alarms

Select this check box to save the configuration of the device in XML format.Save configuration in XML format

Select this check box to display the configuration in set format.Show configuration in set format

Select this check box to push the configuration on all the network elements automatically,
making either one or all successful.

Usetwo-phasecommit forservice
provisioning

When this check box is selected, normalization of VLAN tags is performed using the input
or output VLANmaps.

This check box is selected by default.

NOTE: Starting in Connectivity Services Director Release 2.1R1, Use vlanmaps for flexible
tagged services under Modifying the Application Settings of Connectivity Services Director
is renamed to Use vlanmaps for E-Line services.

Use vlanmaps for E-Line services

When this check box is cleared, normalization of VLAN tags is performed using normalized
tags under routing instance.

This check box is cleared by default.

NOTE: Starting in Connectivity Services Director Release 2.1R1, normalization of VLAN tags
is performed using normalized tags under routing instance while modifying the application
settings.

Use vlanmaps for flexible tagged
services instead of normalized
vlan (VPLS)

Audit

1033Copyright © 2019, Juniper Networks, Inc.

Chapter 38: Service Provisioning: Auditing Services



Table 137: Parameters in Connectivity Services Director Application Settings (continued)

DescriptionFields

Select this check box to perform the functional audit automatically, after the service is
deployed successfully. By default, the functional audit is not checked. Extra time is taken
to complete both the functional audit and deployment.

Enable Functional Audit after
deployment

Specify the initial wait time to auto-schedule a functional audit job after deployment.

If the entered value is greater than 30minutes, it is reset to 30minutes. If the entered value
is less than 1 minute, the wait time is ignored.

The range is from 1 minute through 30minutes.

Functional AuditWaiting Time
after deployment

Select this check box tomake the functional audit ignore the data plane verification and to
consider only the control plane.

Perform Functional Audit on
Control plane only

User Interface

Select this check box to allow the templates to be changed during the servicemodification.Allow templatemodification for
service

Specify the bandwidth combo items count.

InCreate IP service order page, if the bandwidth range exceeds the bandwidth combo items
count, then the bandwidth input is taken in text field.

The default value is 100.

Bandwidth Combo Items Count

Specify the period of time in seconds as the wait period for retrieving service details during
service template modification.

Service Detail Wait Time (sec)

Monitoring

Select this check box to performmonitoring if the functional audit fails.PerformMonitoring on Failed
Functional Audit

Select this check box to dump the configuration files.

Specify the timedelay to issue the remote procedure call (RPC) call for redundancy service.
Since there is no support for the fault management for redundancy service, it should not
update the fault status asdown,when the interface goesdownas the servicewill be running
with the help of backup device. The RPC is issued to check the status of the service. If the
value of this time delay is 2 seconds and the interface goes down, it waits for 2 seconds to
check whether the service is up, with the help of the backup device and correspondingly
updates the fault status.

The default value is 2 seconds.

Pseudowire Redundancy
Transition TimeDelay

Specify the manner in which the aggregated results are returned for a query that polls and
retrieves data from devices. Two aggregation values are supported:

• Total: Sum of the number of packets received in the interval

• Average: Average of the total number of packets received in the interval

Statistics Aggregation Reporting
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Table 137: Parameters in Connectivity Services Director Application Settings (continued)

DescriptionFields

Logging

By default, the configuration files are not dumped into the log directory. This is enabled, if
there is a need to provide troubleshooting to Juniper Networks Technical Assistance Center
(JTAC).

DumpConfiguration Files

Select this check box to write the configlets and error response from the JUNOS devices
into the log directory..

DumpDeployment Data

Specify the default path of the log directory: /var/tmp/jbossLog Directory

Prestage Devices

Specify the number of seconds for which the task to trigger a job for prestaging devices
must wait after receiving the first notification for prestaging devices. For example, if you
specify the prestage wait time as 20 seconds, the prestaging task waits for a period of 20
seconds, after receiving the first notification for prestaging devices, and then initiates the
prestaging-devices job.

Pre-stageWait Time (Sec)

Specify the number of seconds after which the job for prestaging devices is initiated, if no
notification is received during the idle period. For example, if you specify the prestage idle
time as 10 seconds and if no notification for prestaging devices is receivedwithin this period,
the job for prestaging devices is triggered immediately after 10 seconds. The prestage idle
time value takes precedence over the prestage wait time value.

Pre-stage Idle Time (Sec)

Specify the logical unit of the loopback interface thatmust be used as the default loopback
logical interface for all provisioning tasks that are initiated from Connectivity Services
Director. The default logical unit for the loopback interface is 0.

Loopback Unit

Route Target

Specify the least value in the preferred range of numbers, among which a certain number
is assigned for each BGP service. Route target allows you to distribute VPN routes to only
the routers that need them.When a route target value is enteredmanually, it should be
either of the following two formats: Autonomous System number format or IPv4 format.
For Autonomous System number format, the pattern is as-number:2-byte-number. For
example, target:100:200.

Range: TheAutonomousSystemnumber format number can be in the range from 1 through
65,535.

The IPv4 format is ip-address:2-byte-number. For example, target:10.1.1.1:2.

BeginIndex
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Table 137: Parameters in Connectivity Services Director Application Settings (continued)

DescriptionFields

Specify thegreatest value in thepreferred rangeof numbers, amongwhichacertain number
is assigned for each BGP service. Route target allows you to distribute VPN routes to only
the routers that need them.When a route target value is enteredmanually, it should be
either of the following two formats: Autonomous System number format or IPv4 format.
For Autonomous System number format, the pattern is as-number:2-byte-number. For
example, target:100:200.

Range: TheAutonomousSystemnumber format number can be in the range from 1 through
65,535.

The IPv4 format is ip-address:2-byte-number. For example, target:10.1.1.1:2. The EndIndex
value should be lesser than themaximum assigned value.

EndIndex

Virtual Circuit ID

Specify the least value in the preferred range of numbers, among which a certain number
is assigned as the VirtualCircuitID to the new circuit created. This VCID can bemanually
chosen by the customer or auto-generated by the system. For example, if BeginIndex = 100
and EndIndex = 200, then the VCID would be somewhere between 100 and 200.

Minimum: 1

The value of BeginIndex should be less than or equal to EndIndex value.

The range is from 0 through 200000.

BeginIndex

Specify thegreatest value in thepreferred rangeof numbers, amongwhichacertain number
is assigned as the VirtualCircuitID to the new circuit created. This VCID can bemanually
chosen by the customer or auto-generated by the system. For example, if BeginIndex = 100
and EndIndex = 200, then the VCID would be somewhere between 100 and 200.

Maximum: 2147483647.

The range is from 0 through 200000.

EndIndex

PerformanceMonitoring

DataSetSize is the size of the performancemonitoring data set in days. This field indicates
the number of days of performancemonitoring data could be stored for display.

The default value is 2880.

DataSetSize

Select the check box to collect the performance data through scripts and opennms will
store the data in its database. If this check box is not selected, then performance data such
as one-way delay, two-way delay, and frame loss are collected through RPC and stored in
the application database.

Enable PerformanceMonitoring
through scripts

OSS Config Parameters

Specify the IP address of the primary server.Alcatel Primary Server IP

Specify the port number of the primary server.Alcatel Primary Server Port
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Table 137: Parameters in Connectivity Services Director Application Settings (continued)

DescriptionFields

Specify the IP address of the backup server.Backup Server IP

Specify the port number of the backup server.Backup Server Port

Specify the duration of HTTP connection before the time-out elapses.HTTP Connection Timeout

Specify the maximum number of simultaneous API requests permitted.MaximumAPI Requests

Specify the directory path of the OSS log directory.OSS Log Directory

Specify the OSS log filename.OSS Log Filename

Specify the user name for accessing the OSS server.OSSUser Name

Specify the hashed password for accessing the OSS server.OSSUser Password

Sets the daily time at which the CPP system synchronizes third-party devices, added or
deleted from the CPP system, with the OSS server.

Synchronize OSS Inventory daily
at given time

If the check box is enabled, the CPP system communicates with the primary OSS server.Use primary server

Service Decommission

Service Recovery

Select either of the following options from the OutofBand Notification Action list to specify
the action you want to be performed when an OutOfBand notification is received by
Connectivity Services Director:

• Make Device OutOfSync—Causes the device to bemade OutOfSync and disables
subsequent provisioning on that device until it changes to the In Sync state again

• Ignore Notification—Causes the notification to be ignored and device will remain InSync

OutofBand Notification

Select thecheckbox toenable thestorageofOutOfBandnotificationXML in theConnectivity
Services Director database. By default, this check box is not selected, which disables the
saving of OutofBand notification XML in the Connectivity Services Director database.

StoreOutofBandNotificationXML

Specify thedevice synchronizationwaiting time. This is themaximumwait time to complete
thedevice synchronization.After this timeduration, irrespectiveof thedevice synchronization
status, the resources are released.

The default value is 60 seconds.

The range is from 30 seconds through 300 seconds.

Device SyncWait Time

Reports (accessible from theModify Connectivity Services Director Settings page in the Administration workspace of the Junos
Space Platform GUI)
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Table 137: Parameters in Connectivity Services Director Application Settings (continued)

DescriptionFields

Move the slider right or left to specify the time period for which the generated reports must
be retained in theConnectivity ServicesDirector database. By default, Connectivity Services
Director keeps reports for 30 days. However, Network Administrators can change the
retention period from 0 to 365 days.

Retention period for generated
Reports days

Search (accessible from the Modify Connectivity Services Director Settings page in the Administration workspace of the Junos
Space Platform GUI)

Specify a time interval after which Connectivity Services Director initiates the next indexing
on the Search tab. By default this option is selected and the search index update interval is
set to 900 seconds. Connectivity Services Director indexes the device inventory data
periodically to enable users to perform efficient searches.

Index auto update interval in
seconds

Select this check box to stop indexingwhile devices are imported into Connectivity Services
Director. If you are running short of systemmemory, selecting this option can help save
somememory and speed up the discovery and import of new devices.

Pause indexing during device
import

Topology (accessible from the Modify Connectivity Services Director Settings page in the Administration workspace of the
Junos Space Platform GUI)

Move the slider right or left to specify a retention period for the deleted links in Topology.
You can also disable the retention of deleted links by moving the slider to the extreme left
to denote Never. You can define amaximum of 365 days for deleted links to bemaintained
in Topology View.

Retention period for Deleted Link
days

Release History Table DescriptionRelease

Starting in Connectivity ServicesDirector Release 2.1R1,Usevlanmaps for flexible
taggedservicesunderModifying theApplicationSettingsofConnectivityServices
Director is renamed to Use vlanmaps for E-Line services.

2.1R1

Starting in Connectivity Services Director Release 2.1R1, normalization of VLAN
tags is performed using normalized tags under routing instance whilemodifying
the application settings.

2.1R1

Troubleshooting the Endpoints of Services

Junos OS operation (op) scripts automate network and device management and

troubleshooting. Op scripts can perform any function available through the remote

procedure calls (RPCs) supported by either the Junos XMLmanagement protocol or the

Junos Extensible Markup Language (XML) API. Op scripts can be executedmanually in

the CLI or upon user login, or they can be called from another script. They are executed

by the Junos OSmanagement (mgd) process.

Op scripts enable you to do the following things:
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• Create custom operational mode commands

• Execute a series of operational mode commands

• Customize the output of operational mode commands

• Shorten troubleshooting time by gathering operational information and iteratively

narrowing down the cause of a network problem

• Perform controlled configuration changes

• Monitor the overall status of a device by creating a general operation script that

periodically checks network warning parameters, such as high CPU usage.

Op scripts are based on the Junos XMLmanagement protocol, and the Junos XML API.

Op scripts can be written in either the Extensible Stylesheet Language Transformations

(XSLT) or Stylesheet LanguageAlternative Syntax (SLAX) scripting language. Op scripts

use XPath to locate the operational objects to be inspected and XSLT constructs to

specify theactions toperformon the locatedoperational objects. Theactions canchange

the output or execute additional commands based on the output.

The troubleshooting featureprovidesaneasyanduniqueway to troubleshoot theservices.

You do not have to manually login to a device to check the status of services in the

ConnectivityServicesDirector application, but youcando thesameusing the functionality

of operational scripts. You do have the flexibility of writing your own scripts to view the

results.

Only JuniperNetworksdevicesare supportedby this functionalityand this isnotapplicable

to the third-party devices.

The operational scripts can either be created or imported to the platform from the local

machine before you start troubleshooting the services or you can run the scripts that are

of local typedirectly fromtheFunctionalAuditResultwindowbyclicking theTroubleshoot

button. For op scripts that are not of local type, the op scripts must be imported and

stagedon to thedeviceusing the JunosSpaceNetworkManagementPlatformapplication

before you can run the scripts fromwithin the Connectivity Services Director application

for debugging and diagnosing the service endpoints or devices. Currently, you cannot

directly add the scripts to the Connectivity Services Director GUI interface. Scripts with

execution type as “Local” (@isLocal=true annotation in the SLAX script) are also listed

in troubleshootingwindow.The listing is sortedand filteredbasedon thecontext specified

for each service.

BESTPRACTICE: Werecommend that you configure a script as a local script
for effectiveandoptimaldebuggingandanalysisof theconfigurationsettings
contained in the script. Themain advantage of a local script is that you need
not download the script to a device (because a connection is established
with the device by theGUI application and the script is run) and youneednot
remove the script from a device after you decommision a service.

The following table lists the context inwhich theOP scripts arewritten for different types

of services:
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Table 138: OP Scripts Contexts for Different Service Types

ContextService Type

@CONTEXT = "/device/configuration/protocols/l2circuit/neighbor/interface"

Example : /device[name=”deviceName”]/configuration/protocols/l2circuit/neighbor[name=”neighbor
IP”]/interface[name=”interfaceName.unitID”]

E-Line LDP

/*@CONTEXT = "/device/configuration/routing-instances/instance/vrf/interface" */

Example : /device[name=”device name”]/configuration/routing-instances/instance[name=”Service
name”]/instance-type[instance-type=”vrf”]/interface[name=”interfaceName.unitID”]

IP

/*@CONTEXT = "/device/configuration/routing-instances/instance/vpls/interface" */

Example : /device[name=”devicename”]/configuration/ routing-instances/instance[name=”Service
name”]/instance-type[instance-type=”vpls”]/interface[name=”interfaceName.unitID”]

E-LAN

/*@CONTEXT="/device/configuration/protocols/l2circuit/local-switching/interface/end-interface"
*/

Example
/device[name="MX80-1"]/configuration/protocols/l2circuit/local-switching/interface[name="ge-1/0/0.1801"]/end-interface[interface="ge-1/2/2.1881"]

E-Line(Localswitching)

/*@CONTEXT = “/device/configuration/routing-instances/instance/bgp/interface” */

Example : /device[name=”device name”]/configuration/routing-instances/instance[name=”Service
name”]/instance-type[instance-type=”bgp”]/interface[name=”interfaceName.unitID”]

E-Line BGP

/*@CONTEXT = “/device/configuration/interface/” */

Example: /device[name=”device name”]/configuration/ interface[name=”interfaceName.unitID”]

Example commands:

Commoncontext forall
services

Whenyouselect a single serviceand fromtheNetworkServices>Connectivity taskpane,

select Audit Results > Functional Audit to schedule and perform a functional audit

operation, the Functional Audit Results window is displayed after the operation of the

selected service is validated. If you have previously run a functional audit already run, the

result of the previous audit is displayed. To perform a troubleshooting of the selected

service, youmust click the Troubleshoot button. The troubleshooting task runs as a

separateevent inConnectivityServicesDirector,whereas troubleshootingwasperformed

together with functional audit in the Services Activation Director GUI.

• Troubleshooting Services Using Operational Scripts on page 1040

Troubleshooting Services Using Operational Scripts

The operational scripts or the OP scripts are written to view the statistics of a service in

the Connectivity Services Director application. All the commands in the OP scripts are

user-defined. To view the contexts for writing OP scripts for different service types, refer

Table 138 on page 1040.

To execute the OP scripts and view the status of any service:
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1. FromtheNetworkManagementPlatform taskpane, select ImagesandScripts>Scripts.

The Scripts page that appears displays a list of the existing scripts.

2. From the list of the scripts available in the SLAX format, right-click a script and click

Stage Scripts on Devices to push the script onto a device.

The Stage Scripts on Device(s) page that appears displays a list of the devices

associated with the script that you selected.

3. Select the Select DeviceManually option and select any number of devices to which

you want to push the script.

NOTE: The Enable Scripts on Devices check box is selected by default.

4. Click Stage to stage the script on all the devices that you selected.

The Stage Scripts Information dialog box confirms the successful staging of scripts

onto the selected devices along with the Job ID.

5. Click Job ID to view the status of the job on the JobManagement page.

You are redirected to the Scripts page.

6. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

7. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

8. in the Network Services > Connectivity view pane, select Audit Results > Functional

Audit. Alternatively, you can select a service order, click the Audit button at the top of

the table of listed service orders from the Manage Network Services page and select

Run Functional Audit.

9. In the Schedule Functional Audit dialog box, selectAudit Now, then clickOK. After the

audit is run, the Functional Audit Results window is displayed.

10. FromtheFunctionalAuditResultswindowthatdisplaysa list of thedevicesassociated

with the service you selected, select the check box next to the device for which you

want to diagnose and examine the associated service.

11. Click Troubleshoot to perform troubleshooting and analysis of the service for which

functional audit is performed.

12. Select the check box next to a service that you want to analyze andmonitor for its

working and efficiency. The Execute OP Scripts page is displayed.

13. Select an OP script on the Execute OP Scripts page.

14. Click the Value column to enter any additional parameter for the selected OP script,

besides the ones coded in the script.
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NOTE: Theselectionofparameters isentirelydependentontheOPscripts.
If the OP scripts support parameters, then all the parameters are listed
andyouneed toenter thevalues.Parameterscanbeoptional, on thebasis
of the OP scripts.

15. Click Execute to execute the selected OP scripts with the newly added parameters,

if any.

A dialog box confirms the execution of the OP scripts along with the Job ID.

16. ClickOK.

You are redirected to the Execute OP Scripts page.

17. Click View Last Result to view the previous OP scripts execution results.

The Execute OP Scripts Job Status dialog box is displayed with the results of the

troubleshooting operation.

NOTE: This is an optional step.

Troubleshooting E-Line Services

From theExecuteOPScripts JobStatusdialogbox, you can check status of the interfaces,

LDP sessions, neighbor links, and endpoints of an E-Line service. To select the status you

want to check, click on the device from the device list on the left, and select the show

command from the Command list. This figure shows the routing table for the selected

device in the E-Line service.

Troubleshooting E-LAN Services

From theExecuteOPScripts JobStatusdialogbox, you can check status of the interfaces,

LDP sessions, neighbor links, connection instances, and endpoints of an E-LAN service.

To select the status you want to check, click on the device from the device list on the

left, and select the show command from the Command list.

Troubleshooting IP Services

From theExecuteOPScripts JobStatusdialogbox, you can check status of the interfaces,

LDP sessions, neighbor links, and endpoints of an IP service. To select the status you

want to check, click on the device from the device list on the left, and select the show

command from the Command list.

Related
Documentation

Performing a Functional Audit on page 1019•

• Performing a Configuration Audit on page 1027

• Troubleshooting N-PE Devices Before Provisioning a Service on page 1030

• Modifying the Application Settings of Connectivity Services Director on page 1032

• Viewing Configuration Audit Results on page 1046
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• Viewing Functional Audit Results on page 1048

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052

Basic Requirements of Operational Scripts

For operational (op) scripts, the context is a required argument because a context is

transmitted to the script, when the script is run from troubleshooting operation. The

format of the argument to be pushed to the script is as follows:

var $arguments = { 
   <argument> { 
      <name> "CONTEXT"; 
      <description> "The CONTEXT."; 
   } 
} 
var $CONTEXT; 

The context has parameters based on the service type, which needs to be parsed to use

the parameters.

The following is an example of an E-Line LDP service context:

Context:

/device[name=”deviceName”]/configuration/protocols/l2circuit/neighbor[name=”neighbor

IP”]/interface[name=”interfaceName.unitID”]

The code in op script to parse the context is as follows:

var $tempContext = str:replace(str:replace($CONTEXT, "/device[name=\"", ""),
 "\"]/configuration/protocols/l2circuit/neighbor[name=\"", "|"); 
var $finalContext = str:replace(str:replace($tempContext, 
"\"]/interface[name=\"", "|"), "\"]", "");      
var $variables = jcs:split( "\\|", $finalContext ); 
var $deviceName = $variables[1]; 
var $neighborIp = $variables[2]; 
var $interfaceName = $variables[3]; 

The following is an example of an E-Line BGP service context:

Context: /device[name=”device

name”]/configuration/routing-instances/instance[name=”Service name” and

instance-type=”l2vpn”]/bgp/interface[name=”interfaceName.unitID”]

The code in op script to parse the context is as follows:

var $tempContext1 = str:replace(str:replace($CONTEXT, "/device[name=\"", ""),
 "\"]/configuration/routing-instances/instance[name=\"", "|"); 
var $tempContext2 = str:replace($tempContext1, "\" and 
instance-type=\"l2vpn\"]", ""); 
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var $finalContext = str:replace(str:replace($tempContext2, 
"/bgp/interface[name=\"", "|"), "\"]", "");      
var $variables = jcs:split( "\\|", $finalContext ); 
var $deviceName = $variables[1]; 
var $instanceName = $variables[2]; 
var $interfaceName = $variables[3]; 

The following is an example of an E-Line E-LAN service context:

Context: /device[name=”device

name”]/configuration/routing-instances/instance[name=”Service name” and

instance-type=”vpls”]/vpls/interface[name=”interfaceName.unitID”]

The code in op script to parse the context is as follows:

var $tempContext1 = str:replace(str:replace($CONTEXT, "/device[name=\"", ""),
 "\"]/configuration/routing-instances/instance[name=\"", "|"); 
var $tempContext2 = str:replace($tempContext1, "\" and instance-type=\"vpls\"]",
 ""); 
var $finalContext = str:replace(str:replace($tempContext2, 
"/vpls/interface[name=\"", "|"), "\"]", "");      
var $variables = jcs:split( "\\|", $finalContext ); 
var $deviceName = $variables[1]; 
var $instanceName = $variables[2]; 
var $interfaceName = $variables[3]; 

The following is an example of an E-Line IP service context:

Context: /device[name=”device

name”]/configuration/routing-instances/instance[name=”Service name” and

instance-type=”vrf”]/vrf/interface[name=”interfaceName.unitID”]

The code in op script to parse the context:

var $tempContext1 = str:replace(str:replace($CONTEXT, "/device[name=\"", ""),
 "\"]/configuration/routing-instances/instance[name=\"", "|"); 
var $tempContext2 = str:replace($tempContext1, "\" and instance-type=\"vrf\"]",
 ""); 
var $finalContext = str:replace(str:replace($tempContext2, 
"/vrf/interface[name=\"", "|"), "\"]", "");      
var $variables = jcs:split( "\\|", $finalContext ); 
var $deviceName = $variables[1]; 
var $instanceName = $variables[2]; 
var $interfaceName = $variables[3]; 

Predefined Scripts for Troubleshooting

Predefined troubleshooting scripts are included by default, during the installation of

Connectivity Services Director. The following are the script names for each service and

the commands supported for them.
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E-Line LDP Service

P2PLDPPredefinedScript.slax is the predefined script that is uploaded.

The following are the supported commands:

• get-l2ckt-connection-information

• get-interface-information

• get-ldp-session-information

• get-ldp-neighbor-information

E-Line BGP Service

P2PBGPPredefinedScript.slax is the predefined script that is uploaded.

The following are the supported commands:

• get-l2vpn-connection-information

• get-interface-information

• get-bgp-summary-information

• get-interface-statistics

E-LAN Service

VPLSPredefinedScript.slax is the predefined script that is uploaded.

The following are the supported commands:

• get-vpls-connection-information

• get-interface-information

• get-interface-statistics

IP Service

L3VPNPredefinedScript.slax is the predefined script that is uploaded.

The following are the supported commands:

• get-vrrp-connection-information

• get-interface-information

• get-interface-statistics

RSVP LSP Service

RSVPLSPPredefinedScript.slax is the predefined script that is uploaded.

The following are the supported commands:
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• get-mpls-connection-information

• get-mpls-lsp-information

Related
Documentation

Troubleshooting the Endpoints of Services on page 1038•

Viewing Configuration Audit Results

After performing a configuration audit, check the detailed results of the audit:

1. a. From the View selector, select Service View. The workspaces that are applicable

to routing and tunnel services are displayed.

b. Click theBuild icon in theServiceViewof theConnectivity ServicesDirector banner.

The functionalities that you can configure in this mode are displayed in the task

pane.

c. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP Ethernet service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

d. In the Network Services > Connectivity task pane, select Service Provisioning >

Audit/Results > Configuration Audit.

The configuration audit results are displayed if an audit operation was previously

performed on the selected service.

Examine the audit results for missing configuration information, and keep the

windowopen for later comparisonwith the service configuration in the JunosSpace

database.

You can validate policies for the hub and spoke (1 interface).

NOTE: In theServiceConfiguration tabof theConfigurationAuditdialog
box, you can observe several lines with the delete statement in the

service settings. Thesedelete statements indicate thepolicy attributes

that are deleted from the corresponding service onadevice.Whenever
a service is created or modified, the policy options are always deleted
from the device to prevent the previously existing policies from
interfering with the service. The presence of the delete statements is

an expected behavior and does not indicate any incorrect service
configuration.

2. To view the service configuration in the Junos Space database, in Deploy mode, from

the Network Services > Connectivity task pane, select Service Provisioning > Deploy
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Services. The Manage Service Deployment page is displayed on the bottom part of

the right pane. Select a service from theManageServiceDeployment page, then in the

Actionsmenu, select View Service Configuration.

A newwindow opens and shows the service configuration.

If a CFM is configured in E-Line service or E-LAN service, the configuration audit result

displays the CFM configuration details.

3. Compare the contents of the Service Configuration with those of the Configuration

Audit Resultswindow for each device in turn. If you see discrepancies, then it is likely

that the service configuration wasmodified out-of-band. If so, youmight need to

synchronize the device with the Junos Space database.

For step-by-step instructions about synchronizing devices, see Resynchronizing

Managed Devices with the Network for details.

After the audit job is completed, you can view the output of the operation in the

Configuration Audit Results window that is displayed on the right pane. The left pane

displays a tree of devices associated with the specified service. You can select a

Service-name> Interface-nameDevice-name in the left paneof thewindow.Theattribute

definitions and parameters defined in the service are displayed in the right pane. The

right pane contains three tabs— Service Configuration, Template Configuration, and

AuditResults. TheServiceConfiguration tabdisplays the settings specified for the service

on the device in CLI format. This tab displays the elements or components specified for

a service template in the form of configuration stanzas and hierarchy levels. This display

is similar to the show command that you can use at a certain [edit] hierarchy level to

view the defined settings. The Template Configuration tab displays the service attributes

and options defined in the service template, if any, that is associated with the service.

The Audit Results tab displays the status of the audit job that was run, such as whether

the job succeeded or failed. You can also view the service definition and associated

template details under the Service Config and Template Config tabs in Junos OS XML

API format, instead of the CLI format.

Click theShowXMLConfig button at the top-right corner of thewindow to view the audit

results inXMLAPI format.Alternatively, click theShowSetbutton toviewtheaudit results

in themanner inwhich theyaredisplayed in the JunosOSCLI interface.TheShowXML/Set

button is a toggle button.

The JunosOScommand-line interface(CLI)andthe JunosOS infrastructurecommunicate

using XML. When you issue an operational mode command in the CLI, the CLI converts

the command into XML format for processing. After processing, Junos OS returns the

output in the form of an XML document, which the CLI converts back into a readable

format for display. Remote client applications also use XML-based data encoding for

operational and configuration requests on devices running JunosOS. The Junos XMLAPI

is an XML representation of Junos configuration statements and operational mode

commands. It defines an XML equivalent for all statements in the Junos configuration

hierarchy andmany of the commands that you issue in CLI operational mode. Each

operationalmodecommandwitha JunosXMLcounterpartmaps toa request tagelement

and, if necessary, a response tag element.
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ClickReloadResultat the top-right corner of thewindowto refreshanddisplay the results

of theaudit.Whenyouclick this button, only theoutput of theaudit operation is displayed

afresh and the audit job is not run again. You can refresh the results only for completed

audit instances. When you select Service-name in the left pane of the window, service

status information is displayed in the right pane. Click Run Configuration Audit after

selecting the services you need to run the audit job again.

Configuration audit can be run for multiple services from Build mode of Service View of

the Connectivity Services Director GUI. From the Manage Network Services page, select

the check boxes beside multiple srvices, click the Audit button at the top of the table of

configured services, and select Run Configuration Audit from the drop-downmenu.

We recommend that you configure a script as a local script for effective and optimal

debugging and analysis of the configuration settings contained in the script. Themain

advantage of a local script is that you need not download the script to a device (because

a connection is established with the device by the GUI application and the script is run)

and you need not remove the script from a device after you decommision a service.

Related
Documentation

Viewing Functional Audit Results on page 1048•

• Performing a Functional Audit on page 1019

• Performing a Configuration Audit on page 1027

Viewing Functional Audit Results

To view the results of a functional audit of a service, follow this procedure:

After performing a functional audit on a service (see “Performing a Functional Audit” on

page 1019), look at the functional audit results:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

4. In the Network Services > Connectivity task pane, select Service Provisioning >

Audit/Results > Functional Audit.

The Functional Audit Resultwindow appears, displaying Service Status in the right

panel.
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If aCFM is configured in anE-Line service or E-LANservice, the functional audit results

includes the result of both E-Line and E-LAN services.

Agreenup-arrow in theServiceStatusheaderbar indicates that the servicehaspassed

the functional audit in both the control plane and the data plane. A red down-arrow

indicates that the service failed either or both the control plane validation and the

data plane validation.

Depending on the type of service, the left panel lists

• The name of the service

• Each endpoint in the service

Icons representing the endpoint indicate its role in the service and its up or down

state. Table 139onpage 1049describes these icons for apoint-to-multipoint service.

Table 139: Point-to-Multipoint Service Endpoint Icons

MeaningIcon

Hub in a point-to-multipoint service. Endpoint state is up.

Hub in a point-to-multipoint service. Endpoint state is down.

Spoke in a point-to-multipoint service. Endpoint state is up.

Spoke in a point-to-multipoint service. Endpoint state is down.

• Interface name

• A numeric value indicating the subinterface name: the VLAN-ID for an 802.1Q

interface, the service VLAN-ID for a Q-in-Q interface, or 0 for a dedicated port.

• Device name

5. To show all endpoints in the service, in the left panel header, select All. To display

only the endpoints indicating failed validation, select Failed. Failed is dimmed if the

functional audit returned no validation errors.

6. To view details for an individual interface or endpoint, select it in the left panel. The

header bar on the right panel changes to End Point or Interface Status, and details

for the selected item are displayed below.

7. Expand each device to show the link from that device to the other N-PE device in the

service.

An icon next to each link indicates whether the functional audit commands reported

correct functioningof thecontrolplaneanddataplane.Table 140onpage1050describes

these icons.
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Table 140: Functional Audit Success Status Icons

MeaningIcon

Control plane and data plane function correctly.

Errors were reported in the functioning of either the control plane or the data
plane.

8. In the left panel, select a link.

The panel to the right shows the validation results for the control plane validation and

data plane validation for the selected link. Icons indicate the success or failure of each

set of tests.

The panel to the right shows the validation results for the control plane validation and

data plane validation for the selected link. Icons indicate the success or failure of each

of thesesetsof tests.Table 141onpage 1050describes iconsandthe textual information

provided in the box beside the icon.

Table 141: Multipoint-to-Multipoint Service Control Plane and Data Plane Validation
Icons

ExplanationMeaningIcon

The text box shows the name
of the remoteN-PEdeviceand
confirms that the data plane
is operational.

Control plane up

The text box shows the name
of theconfigured remoteN-PE
device and, in the Command
status field, explains why the
test failed.

Control plane down

The text box indicates the
nameof theconfigured remote
N-PE device and, in the Result
field, an explanation as towhy
the functional audit operation
was unable to test the control
plane—for example,
configuration wasmissing on
the device.

Control plane status unknown

The text box indicates the
numberofpackets transmitted
and received, and confirms
that no data packetswere lost
during the audit.

Data plane up
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Table 141: Multipoint-to-Multipoint Service Control Plane and Data Plane Validation
Icons (continued)

ExplanationMeaningIcon

The text box indicates that
data packets were lost during
the audit.

Data plane down

The functional audit was
unable to complete the data
plane test. The Result field in
the text box indicates the
reason—for example, the
platform does not support
data plane testing, or the
connection to the remoteN-PE
device is down.

Data plane status unknown

The control plane and data plane validation checks must both show operational

status for the link to be considered operational.

9. To troubleshoot a service, click theTroubleshootbutton. To select the status youwant

tocheck, click thedevice fromthedevice list on the left, andselect the showcommand

from the Command list.

An iconnext toeachcommand indicateswhether thecommandexecution is successful

or failed. Table 142 on page 1051 describes these icons.

Table 142: Command Status Icons

MeaningIcon

Command execution is successful and the command status is up.

• Command execution is failed, or,

• In case of multiple rows, one of the status value is down

NOTE:

• Data plane information between two endpoints in an E-LAN service is
provided only for MX Series devices. This information is not provided for M
Series devices.

• JunosOSRelease 9.3 and JunosOSRelease 9.4 do not support data plane
validation. The Functional Audit Results screens do not display data plane
validation information if any device in the service is running one of these
Junos OS releases.

Related
Documentation

Viewing Configuration Audit Results on page 1046•
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• Performing a Functional Audit on page 1019

• Performing a Configuration Audit on page 1027

Viewing Functional Audit Results for an InverseMultiplexing for ATMService

To view functional audit results for an Inverse Multiplexing for ATM Service:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In theNetworkServices>Connectivity task pane, selectServiceProvisioning>Manage

Services.

4. In theManage Services screen, select the service for which you want to view the

functional audit results.

5. Right-click the service, or click the Audit/Resultsmenu, and select View Functional

Audit Results.

6. In the Functional Audit Resultswindow, click the Troubleshoot button.

In the Troubleshooting tab, when you select a show interfaces command for a UNI

interface that is configured as an IMA Group Link, the command displays details for

the IMA group interface.

Related
Documentation

Viewing Configuration Audit Results on page 1046•

• Viewing Functional Audit Results on page 1048

• Performing a Functional Audit on page 1019

• Performing a Configuration Audit on page 1027

Modifying a Saved Service Order

Before a service order can affect a service, itmust transition through the following states:

• Requested—When the service provisioner has created the service order, but has not

yet attempted to deploy it or schedule it for deployment, the service order is in the

Requested state.

• Scheduled—After the service provisioner has scheduled the service order for
deployment, the service order transitions to the Scheduled state.
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• In Progress—When a scheduled service order reaches its time for deployment, it

transitions to the transitory InProgress state. Fromthis state, the JunosSpacesoftware

attempts to deploy the service.

• Validated—When all the information in the service order is successfully validated, the

service order transitions to the Validated state.

• Completed—Successful deployment transitions the service order to the Completed
state.

• Invalid—If the Junos Space software cannot deploy the service because of invalid
information in the service order itself, the service order enters the Invalid state. The

service provisioner must resolve the issues that cause the failure before re-creating

the service order and rescheduling it for deployment.

• Failed Deploy—If the device is down or the Junos Space software is unable to push
theservice configuration to thedevice, the serviceorder transitions to theFailedDeploy

state.

• Deactivated—Whenyoudisablea serviceorder, the configurationattributesassociated

with such a service order are deactivated and commented out in the device settings.

By disabling a service, the traffic processing for the traversed packets is impacted. In

certain network topologies, youmight require a service-related settings to be disabled

for a certain period to perform troubleshooting or modification to the traffic-handling

method, and youmight want to reactivate a disabled service later when you have

completednetworkmaintenanceandanalysiswork. In suchacase, itmightbebeneficial

to use the deactivation functionality for a service order. The deactivated service is

propagated to the devices associated with the service order. To disable a service, the

servicemust not contain any pending or uncommitted changes. Also, the servicemust

be in the Deployed or Re-Activated state.

• Reactivated—After you disable a service order to deactivate the configuration settings
ondevicesmapped to the service, youmight require the service settings tobe reenabled

after you havemodified the service parameters, either directly on the device or using

the Connectivity Services Director application. In such a case, you can use the

reactivation functionality to revive and activate the service properties on devices.

devices. Todisable a service, the servicemust not contain anypendingor uncommitted

changes. Also, the service must be in the Deactivated state.

Figure 24 on page 1054 illustrates the service order states.
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Figure 24: Service Order States

Toview thestateof a serviceorder, inDeploymode, selectNetworkServices>Connectivity

from the View pane and drill down to the type of service for which you want to modify a

service order, and select Service Provisioning > Deploy Services from the task pane. The

Manage Service Deployment inventory page lists the service orders and their state.

The Junos Space Connectivity Services Director application provides the flexibility to

modify an existing service order. You canmodify a service order when the order state is

Requested, Validated, or Invalid. You cannotmodify a service order when the order state

is Scheduled, Completed, or Failed Deploy.

Tomodify a service order:

1. In Deploy mode, select Network Services > Connectivity from the View pane and drill

down to the type of service for which you want to modify a service order, and select

Service Provisioning > Deploy Services from the task pane.

2. From theManage Service Deployment page, select an existing service order, and then

clickModify.

The Modify Service Order window appears.

NOTE: Themodifyoption isunavailable if theserviceorder is inScheduled,
or Completed, or Failed Deployed state.

3. Modify the fields as needed.

NOTE: When youmodify a service or a service order, the read-only fields
in thedifferentpagesof thewizard for serviceor serviceordermodification
are grayed out to indicate that you cannot modify those attributes.
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The following table lists the fields that you canmodify in an E-Line service order,

E-LAN service order, and IP service order.

LIP Service OrderE-LAN Service OrderE-Line Service Order

NameNameName

CustomerCustomerCustomer

CommentsCommentsComments

VLAN IDVLAN IDVLAN ID

Route TargetInner VLAN IDVCID

Hub Route TargetVLAN Tag to stackCFM

Spoke Route TargetPE devicePE device

UNI InterfaceUNI interfaceUNI interface

Route DistinguisherUNI descriptionUNI description

Hub Route DistinguisherMTUMTU (Bytes)

Spoke Route DistinguisherBandwidthBandwidth

Autopick Interface IP AddressEnable P2P-SpokeRSVP LSP name

VRF Table labelEthernet Option in case of AsymmetricPWbackup settings

Export Direct RoutesNeighbor HubVPI

AS overrideBackup NeighborHubVCI

HubHubOutgoing label

MaximumprefixesCustomer VLAN Range Start-

IP address pool

NOTE: While modifying an IP service
order, youmust select the IP address
pool.

Customer VLAN Range End-

Peer ASMAC learning-

-InterfaceMAC limit-

-MAC statistics-
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LIP Service OrderE-LAN Service OrderE-Line Service Order

-MAC table size-

-Disable tunnel services-

-Disable local switching-

-Fast reroute priority-

-Label block size-

-Connectivity type-

NOTE: You can also change a local switching service order to a normal
E-Line service order.

4. Click Save.

The service order is modified. You can now deploy the service order with modified

parameters to the device.

Related
Documentation

Creating an E-Line ATM or TDM Pseudowire Service Order on page 774•

• Creating an E-Line Service Order on page 784

• Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827

• Creating a Point-to-Multipoint E-LAN Service Order on page 847

• Creating a Full Mesh IP Service Order on page 879

• Creating a Hub-and-Spoke IP Service Order on page 901

Viewing Service-Level Alarms

The Junos Space Network Application Platform has integrated a third party tool,

OpenNMS, to provide network monitoring capabilities. The OpenNMS network

management application platform provides solutions for enterprises and carriers.

OpenNMS is installedaspartofPlatform,whichexposessomeofOpenNMS’ functionality

through the Network Monitoring workspace. The default performancemanagement

configuration of OpenNMS for Space supports generic counters, CPU, memory,

temperature, and Mobility counters. For information on this default configuration, see

the subset of the OpenNMS documentation included in this Junos Space Network

Application Platform User Guide.
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CAUTION: Although additional OpenNMS functionality can be accessed by
customizing its XML files, editing these files can affect the functionality of
the Network Monitoring workspace. Juniper Networks does not support
changes to OpenNMS.

When certain types of events are persistent, or when the condition causing the event

crossesa threshold, SNMPsendsanotification, also calleda trap toConnectivityServices

Director. Connectivity Services Director correlates traps, describing a condition, into an

alarm .SNMP also plays another role in Connectivity Services Director. Enabling devices

for SNMPwith the appropriate read-only V1/V2/V3 credentials, can speed up device

discovery.

To access the alarms page for a particular service:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

3. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

4. From the task pane, select Service Provisioning > Deploy Services. The top part of the

right pane displays theManageNetwork Services page,with the table of services, and

thebottompart of the right panedisplays theManageServiceDeployment page,with

the table of service orders.

5. From the Manage Network Services page, select the check box next to the service for

which you want to view alarms.

TIP: In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
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example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

The top pane displays information about the services that have been previously

created, such as the nameof the service, the functional audit status, the performance

management status, and the status of the service. You canmodify the properties of

the service, conduct a functional or configuration audit, force-deploy or deactivate

the service, and view alarms associated with a particular service order for debugging

and corrective action. Services can be in one of the following service states:

• Completed—The service order has been successfully deployed.

• Scheduled for deployment—Theserviceprovisioner has scheduled the serviceorder

for deployment.

• Deployment Failed—An attempted service deployment was not successfully

completed or failed an audit.

• In Progress—The Connectivity Services Director application is in the process of

deploying the service.

• Requested—The service provisioner has created the service order, but has not yet

attempted to deploy it or schedule it for deployment.

• Invalid—The service order is not valid.

6. Click the View Alarms button. You are navigated to the Alarms page in Fault mode.

See “Alarm Detail Monitor (Service View)” on page 1208 for more information.

Related
Documentation

• Managing Jobs on page 118

• Deleting a Partial Configuration of an LSP Service Order on page 967

• Deleting a Service Order on page 968

• Deploying a Service on page 969

• Validating the Pending Configuration of a Service Order on page 971

• Viewing the Configuration of a Pending Service Order on page 972

• SNMPMIBs and Traps Reference

• Junos Space Network Monitoring Reference
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CHAPTER 39

Troubleshooting Devices and Services

• Performance Management Overview on page 1059

• Monitoring Performance Management Statistics on page 1061

• Viewing Performance Management Statistics on page 1065

• Service Troubleshooting Overview on page 1071

PerformanceManagement Overview

Inperformancemanagement(PM), theConnectivityServicesDirectorapplicationprovides

an option to measure the frame delay, frame loss, frame delay variation, and service

availability. These measurements are achieved in either of the following ways:

• Triggering a one-way delay

• Triggering a two-way delay

• Loss

The performancemeasurement is useful for generating periodic service level agreement

conformance reports from the deployed network and for studying traffic patterns in the

network over a period of time. The iterator profiles are configured on remote MEP for

measurement of framedelay (ETH-DM), frame loss (ETH-LM) and statistical frame loss

(SFL).

Monitoring Performance Statistics

The PM statistics can be collected in the following two ways:

1. On-DemandMode

2. Proactive Mode

NOTE: The Connectivity Services Director application supports only the
on-demandmode.
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On-DemandMode

In on-demandmode, you can trigger the measurements. You can also collect loss

measurement (ETH-LM) and delay measurements (ETH-DM).

Loss Measurement

The frame loss is calculated by collecting the counter values applicable for ingress and

egress service frames. The counters maintain a count of transmitted and received data

frames between a pair of MEPs. The loss measurement statistics are retrieved as the

output of themonitor ethernet loss-measurement commandand are also stored at the
initiator. The frame counts are stored at both the initiator and the receiver MEPs for later

retrieval.

The on-demand loss measurement statistics is collected for E-Line service only. There

are two linear charts: Near-End-CIR and Far-End-CIR. For each interval, the graph plots

three values: Average case, best case, and worst case frame loss.

Delay Measurement

To start an ethernet frame delay measurement session, the router initiates an exchange

of frames carrying one-way or two-way frame delay measurement protocol data units

(PDUs)betweenthe localand remoteMEPs.Ethernet framedelaymeasurementstatistics

are measured and stored at only one of the MEPs.

For one-way ethernet frame delay measurement, only the receiver MEP (on the remote

system) collects statistics. For two-way Ethernet frame delay measurement, only the

initiator MEP (on the local system) collects statistics.

Theon-demanddelaymeasurementstatisticsarecollected forE-LineandE-LANservices.

Either the one-way or two-way delay measurements statistics are collected for the

services at a given point of time. For each interval, the graph plots three value: Average

delay, best case delay and worst case delay.

Proactive Mode

In this mode SLAmeasurements are triggered by an iterator application. The proactive

performancemonitoring is supported only on VPWS and E-LAN.

PerformanceManagement of Test Traffic

The Connectivity Services Director application enables you to create Threshold Crossing

Alert (TCA) Profiles to apply service level agreement (SLA) parameters to test traffic as

defined by the following standards:

• L2 Ethernet OAM/ ITU-T Y.1731

• RFC2544

Specifically, the parameters are:

• Bandwidth Utilization

• Delay
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• Delay Variation—Jitter

• Frame Loss

• Throughput

See Creating a TCA Profile.

Related
Documentation

Monitoring Performance Management Statistics on page 1061•

• Viewing Performance Management Statistics on page 1065

• Service Troubleshooting Overview on page 1071

• Performing a Configuration Audit on page 1027

Monitoring PerformanceManagement Statistics

The following topics show how tomonitor the performance statistics for E-Line and

E-LAN services:

You can employ the ITU-T Y.1731 standard-compliant Ethernet loss measurement

(ETH-LM), Ethernet synthetic loss measurement (ETH-SLM), and Ethernet delay

measurement (ETH- DM) capabilities to analyze and examine the operating efficiency

and performance status. These performancemonitoring functionalities can be run for

E-Line and E-LAN services. You can start and stop the collection of performance

monitoring (PM) statistics on the services that you want to monitor. The retrieval and

computation of statistical details is performed using SNMPMIBs.

A predefined event script , Y1731_PM.slax, is available on the Scripts page of the Junos

SpacePlatformGUI,whichdisplaysall the scripts imported into the JunosSpacePlatform

database (accessible by selecting Networkmanagement platform >Images and scripts

> Scripts). This script needs to be downloaded on devices. Whenever you trigger the PM

mechanism from the Connectivity Services Director GUI, an event is initiated, which in

turn causes theSLAXscript tobe run. Theevent continues to run the script until the event

is stopped. The event runs the script at intervals of 5minutes. Themonitoring framework

is used to consolidate and display the retrieved counters and values. You can start the

PM collection utility only on one pair of devices at a time. You cannot start the PM

collection functionality onmultiple pairs of devices simultaneously.
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NOTE: Although you can start or stop the collection of PM statistics without
a predefined event script made available on the corresponding devices by
selecting OAM > Y1731 > Start or Stop from the Tasks pane in Monitor mode
of Service view (no error is displayed and the start or stop of Y1731 PM
statistics collection is successful), youmust ensure that the event script is
present on the devices before you trigger themechanism for collection of
Y1731 PM statistics. Otherwise, although the operation does not display an
error in the GUI, no backend processing occurs.

• Monitoring Statistics for an E-Line Service on page 1062

• Monitoring Statistics for an E-LAN Service on page 1064

Monitoring Statistics for an E-Line Service

You can start a performancemonitoring operation on a service to diagnose the working

efficiency and operating quality from the Monitor mode in Service View of Connectivity

Services Director.

To monitor the statistics for the E-Line service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside E-Line Services to view the E-Line service orders. Select

the E-Line service order for which you want to monitor performance statistics.

Alternatively, click the plus sign (+) beside E-LAN Services to view the E-LAN service

orders. Select the E-LAN service order for which you want to monitor performance

statistics.

5. From the tasks pane, selectOAM>Y1731 > Start. TheMonitor Performance Statistics

window is displayed.

NOTE: If aCFMprofile is not associatedwith the service, an informational
message isdisplayedstating thatanOAMorCFMprofilemustbemapped
with the service.
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NOTE: TheStartaction isenabledonly if theCFMisenabled in theselected

E-Line service. Always perform a functional audit beforemonitoring the
statistics. The Start action is disabled if the functional audit status of a

service is Down.

6. Fill in the fields as indicated in the table.

ActionField

Select a local device from the list.Source Device

Select a remote device from the list.Destination Device

Specify the number of frames to be sent to a specific peer MEP.

Range: 1 through 65,535 frames

Default: 10 frames

Request Count

Specify the wait interval for the frame transfer.

Range: 1 through 255 seconds

Default: 1 second

Delay (seconds)

Select the dot1p (IEEE 802.1p or packet classification layer 2 headers) priority of
continuity-check and link-trace packet.

Range: 0 through 7

Default: 0

Frame Priority (802.1p)

Select one of the following check boxes:

• Two-Way delay

• One-Way delay

• Loss

Monitor Statistics

7. ClickOK.

NOTE: When you stop PM statistical collection, a popup dialog box is
displayed, prompting you to confirmwhether you want to stop PM
statistical collection.ClickOK to confirmtheaction.ClickCancel todiscard

the changes.

To terminate the performancemonitoring task, selectOAM>Y1731 > Stop from the tasks

pane for the selected service.

If you are upgrading from the older version of Services Activation Director to Connectivity

ServicesDirector 1.0, youmust stopanyperformancemonitoringand restart thecollection
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of Y1731 PM statistics on the endpoints. A seamlessmigration of Y1731 PM statistics from

Services Activation Director is not supported because themechanism used to retrieve

and store the PM statistical details is different between Services Activation Director and

Connectivity Services Director. While utility MIBs (OpenNMS for SNMP trap collection

andcorrelation)and remoteprocedurecalls (RPC)areused inServicesActivationDirector,

only utility MIBs are used in Connectivity Services Director to collect the data. Also, event

scripts are different between the two applications, which causes the object ID to be

changed.

Monitoring Statistics for an E-LAN Service

You can start a performancemonitoring operation on a service to diagnoze the working

efficiency and operating quality from the Monitor mode in Service View of Connectivity

Services Director.

To monitor the statistics for the E-LAN Service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside E-Line Services to view the E-Line service orders. Select

the E-Line service order for which you want to monitor performance statistics.

Alternatively, click the plus sign (+) beside E-LAN Services to view the E-LAN service

orders. Select the E-LAN service order for which you want to monitor performance

statistics.

5. From the tasks pane, selectOAM>Y1731 > Start. TheMonitor Performance Statistics

window is displayed.

NOTE: TheOAM>Y1731>Startaction isenabledonly if theCFM isenabled

in the selected E-LAN service. Always perform a functional audit before
monitoring the statistics. TheOAM>Y1731 > Start action is disabled if the

functional audit status of a service is Down.

6. Fill in the fields as indicated in the table.

ActionField

Select a local device from the list.Source Device

Select a remote device from the list.Destination Device
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ActionField

Specify the number of frames to be sent to a specific peer MEP.

Range: 1 through 65,535 frames

Default: 10 frames

Request Count

Specify the wait interval for the frame transfer.

Range: 1 through 255 seconds

Default: 1 second

Delay (seconds)

Select the 802.1p priority of continuity-check and link-trace packet.

Range: 0 through 7

Default: 0

Frame Priority (802.1p)

Select Two-Way delay.Monitor Statistics

7. ClickOK.

To terminate the performancemonitoring task, selectOAM>Y1731 > Stop from the tasks

pane for the selected service.

If you are upgrading from the older version of Services Activation Director to Connectivity

ServicesDirector 1.0, youmust stopanyperformancemonitoringand restart thecollection

of Y1731 PM statistics on the endpoints. A seamlessmigration of Y1731 PM statistics from

Services Activation Director is not supported because themechanism used to retrieve

and store the PM statistical details is different between Services Activation Director and

Connectivity Services Director. While utility MIBs (OpenNMS for SNMP trap collection

andcorrelation)and remoteprocedurecalls (RPC)areused inServicesActivationDirector,

only utility MIBs are used in Connectivity Services Director to collect the data. Also, event

scripts are different between the two applications, which causes the object ID to be

changed.

Related
Documentation

Performance Management Overview on page 1059•

• Viewing Performance Management Statistics on page 1065

• Service Troubleshooting Overview on page 1071

• Performing a Configuration Audit on page 1027

Viewing PerformanceManagement Statistics

You can employ the ITU-T Y.1731 standard-compliant Ethernet loss measurement

(ETH-LM), Ethernet synthetic loss measurement (ETH-SLM), and Ethernet delay

measurement (ETH- DM) capabilities to analyze and examine the operating efficiency

and performance status. These performancemonitoring functionalities can be run for
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E-Line and E-LAN services. You can start and stop the collection of Y1731 performance

monitoring (PM) statistics on the services that you want to monitor. The retrieval and

computation of statistical details is performed using SNMPMIBs.

Apredefinedevent script , PM.slax, is available,whichneeds tobedownloadedondevices.

Whenever you trigger the PMmechanism from the Connectivity Services Director GUI,

an event is initiated, which in turn causes the SLAX script to be run. The event continues

to run the script until the event is stopped. The event runs the script at intervals of 5

minutes. Themonitoring framework is used to consolidate and display the retrieved

counters and values. You can start the PM collection utility only on one pair of devices

at a time. You cannot start the PM collection functionality onmultiple pairs of devices

simultaneously.

The following topics show how to view the performance statistics for E-Line and E-LAN

services:

• Viewing Y.1731 Performance Monitoring Statistics for E-Line Services on page 1066

• Viewing Y.1731 Performance Monitoring Statistics for E-LAN Services on page 1068

Viewing Y.1731 PerformanceMonitoring Statistics for E-Line Services

The Y.1731 monitoring functionality is not enabled by default. Youmust explicitly start

the PM collection mechanism by selectingOAM>Y1731 > Start from the task pane after

selecting the specified service in the View pane. The graphical representation of the

retrieved statistical details for the service is displayed, based on data availability. The

data collected is retained after you stop the PM collection utility for future reference and

correlation.

If you are upgrading from the older version of Services Activation Director to Connectivity

ServicesDirector 1.0, youmust stopanyperformancemonitoringand restart thecollection

of Y1731 PM statistics on the endpoints.

NOTE: The refresh of values and statuses of the parameters displayed in the
graphs and tables of different monitors depends on the polling interval
configured under the Monitoring tab of the Preferences page (accessible by
clicking thedownarrowbeside theSystembutton in theConnectivityServices
Director banner and selecting Preferences).

To view the statistics for the E-Line service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.
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4. Click the plus sign (+) beside E-Line Services to view the E-Line service orders. Select

the E-Line service order for which you want to monitor performance statistics.

Alternatively, click the plus sign (+) beside E-LAN Services to view the E-LAN service

orders. Select the E-LAN service order for which you want to monitor performance

statistics.

5. Select theOAM>Y1731 tab.

6. View and analyze the respective graph.

The following monitors are displayed:

Connections

This monitor shows the status of connections between peer devices. In the tabular

view, the row represents the source device and the columns denote the neighboring

and destination devices. This monitor is applicable for E-Line and E-LAN services. A

green up-arrow in the indicates that the adjoining device in the network path to the

destination device is operationally up. A red down-arrow indicates that the device is

down. For the device for which the connection status is displayed, a value of NA is

displayed under its own corresponding column to denote that it is not applicable.

ClickRefresh at the topof themonitor to update anddisplay the contents of the table.

From the Time Interval drop-down box, select 1 Hour, 8 Hours, 1 Day, 1 Week, 1 Month,

3Months, 6Months, 1 Year, orCustomto specify theduration forwhich thedatapolled

from devices needs to be displayed. If you select the Custom option, the Time range

popupdialogbox is displayed. Specify thedate fromthe calendar, and select theTime

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). Click OK to save the settings.

Else, click Cancel to discard the configuration.

LossMeasurement

The Loss Measurement graph displays a real-time linear plot of delay value with

respect to the time.Thex-axis represents the timeand they-axis represents the frame

loss ratio.Near-end frame loss refers to thecountof frame lossassociatedwith ingress

data frames. Far-end frame loss refers to the count of frame loss associated with

egress data frames. The lines represent the best case frame loss or the lowest frame

loss, the worst case frame loss or the highest frame loss, and the average frame loss

or the median of the highest and lowest frame losses. The frame loss is calculated

by collecting the counter values applicable for ingress and egress service frames. The

counters maintain a count of transmitted and received data frames between a pair

of MEPs. The loss measurement statistics are retrieved as the output of the monitor

ethernet loss-measurement command and are also stored at the initiator. The frame

counts are stored at both the initiator and the receiver MEPs for later retrieval. The

on-demand loss measurement statistics is collected for E-Line service only. There

are two linear charts: Near-End-CIR and Far-End-CIR. For each interval, the graph

plots three values: Average case, best case, andworst case frame loss. From the Loss

End drop-down list, select Near-end (CIR) to display frame loss statistics associated

with ingress data frames or Far-end (CIR) to display frame loss statistics associated

with egress data frames. Mouse over the legends to view the lines corresponding to

best-case, average, and worst-case frame loss statistics.
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DelayMeasurement

The Delay Measurement graph displays a real-time linear plot of delay value with

respect to the time. The x-axis represents the time and the y-axis represents frame

delay in microseconds. The legends reference average one-way delay, best-case

one-way delay, and worst-case one way delay for one-way delay measurement. The

green line denotes the lowest one-way frame delay for the statistics displayed, the

orange line denotes the highest one-way frame delay for the statistics displayed, and

the blue line denotes the average one-way frame delay for the statistics displayed.

The legends reference average two-way delay, best-case two-way delay, and

worst-case two-way delay for two-way delay measurement. The green line denotes

the lowest two-way frame delay for the statistics displayed, the orange line denotes

thehighest two-way framedelay for the statisticsdisplayed, and theblue linedenotes

the average two-way frame delay for the statistics displayed. From the Delay End

drop-downbox, select 1-Wayor 2-Way to display theone-wayor two-way framedelay

measurement protocols respectively.

Delay Variation

The Delay Variation graph displays the difference between the consecutive frame

delay values. The x-axis represents the time and the y-axis represents delay variation

inmicroseconds. The line denotes the average one-way delay variation or the average

one-way “frame jitter” for the statistics displayed for one-way frame delay

measurement. The line denotes the average two-way delay variation or the average

two-way “frame jitter” for the statistics displayed for two-way delay measurement.

The Loss Measurement monitor displays two real-time linear plots: Near End (CIR)

and Far End (CIR). The three parameters in each graph plot are average case, best

case, and worst case of frame-loss.

The graph is plotted in real-time. By default, the total time duration is ten minutes. If

the duration of statistics collection exceeds tenminutes, the graph scrolls and shows

the data of latest ten minutes.

See Also Performance Management Overview on page 1059•

• Monitoring Performance Management Statistics on page 1061

• Viewing Performance Management Statistics on page 1065

• Service Troubleshooting Overview on page 1071

• Performing a Configuration Audit on page 1027

Viewing Y.1731 PerformanceMonitoring Statistics for E-LAN Services

If you are upgrading from the older version of Services Activation Director to Connectivity

ServicesDirector 1.0, youmust stopanyperformancemonitoringand restart thecollection

of Y1731 PM statistics on the endpoints.

The Y.1731 monitoring functionality is not enabled by default. Youmust explicitly start

the PM collection mechanism by selectingOAM>Y1731 > Start from the task pane after

selecting the specified service in the View pane. The graphical representation of the
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retrieved statistical details for the service is displayed, based on data availability. The

data collected is retained after you stop the PM collection utility for future reference and

correlation.

NOTE: The refresh of values and statuses of the parameters displayed in the
graphs and tables of different monitors depends on the polling interval
configured under the Monitoring tab of the Preferences page (accessible by
clicking thedownarrowbeside theSystembutton in theConnectivityServices
Director banner and selecting Preferences).

To view the statistics for the E-LAN service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside E-Line Services to view the E-Line service orders. Select

the E-Line service order for which you want to monitor performance statistics.

Alternatively, click the plus sign (+) beside E-LAN Services to view the E-LAN service

orders. Select the E-LAN service order for which you want to monitor performance

statistics.

5. Select theOAM>Y1731 tab.

View and analyze the graphs.

The following monitors are displayed:

Connections

This monitor shows the status of connections between peer devices. In the tabular

view, the row represents the source device and the columns denote the neighboring

and destination devices. This monitor is applicable for E-Line and E-LAN services. A

green up-arrow in the indicates that the adjoining device in the network path to the

destination device is operationally up. A red down-arrow indicates that the device is

down. For the device for which the connection status is displayed, a value of NA is

displayed under its own corresponding column to denote that it is not applicable.

ClickRefresh at the topof themonitor to update anddisplay the contents of the table.

From the Time Interval drop-down box, select 1 Hour, 8 Hours, 1 Day, 1 Week, 1 Month,

3Months, 6Months, 1 Year, orCustomto specify theduration forwhich thedatapolled

from devices needs to be displayed. If you select the Custom option, the Time range

popupdialogbox is displayed. Specify thedate fromthe calendar, and select theTime

From (Start time in the 24-hour time format of collection of data), and Time To (End
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time in the 24-hour time format of collection of data). Click OK to save the settings.

Else, click Cancel to discard the configuration.

LossMeasurement

The Loss Measurement graph displays a real-time linear plot of delay value with

respect to the time.Thex-axis represents the timeand they-axis represents the frame

loss ratio.Near-end frame loss refers to thecountof frame lossassociatedwith ingress

data frames. Far-end frame loss refers to the count of frame loss associated with

egress data frames. The lines represent the best case frame loss or the lowest frame

loss, the worst case frame loss or the highest frame loss, and the average frame loss

or the median of the highest and lowest frame losses. The frame loss is calculated

by collecting the counter values applicable for ingress and egress service frames. The

counters maintain a count of transmitted and received data frames between a pair

of MEPs. The loss measurement statistics are retrieved as the output of the monitor

ethernet loss-measurement command and are also stored at the initiator. The frame

counts are stored at both the initiator and the receiver MEPs for later retrieval. The

on-demand loss measurement statistics is collected for E-Line service only. There

are two linear charts: Near-End-CIR and Far-End-CIR. For each interval, the graph

plots three values: Average case, best case, andworst case frame loss. From the Loss

End drop-down list, select Near-end (CIR) to display frame loss statistics associated

with ingress data frames or Far-end (CIR) to display frame loss statistics associated

with egress data frames. Mouse over the legends to view the lines corresponding to

best-case, average, and worst-case frame loss statistics.

DelayMeasurement

The Delay Measurement graph displays a real-time linear plot of delay value with

respect to the time. The x-axis represents the time and the y-axis represents frame

delay in microseconds. The legends reference average one-way delay, best-case

one-way delay, and worst-case one way delay for one-way delay measurement. The

green line denotes the lowest one-way frame delay for the statistics displayed, the

orange line denotes the highest one-way frame delay for the statistics displayed, and

the blue line denotes the average one-way frame delay for the statistics displayed.

The legends reference average two-way delay, best-case two-way delay, and

worst-case two-way delay for two-way delay measurement. The green line denotes

the lowest two-way frame delay for the statistics displayed, the orange line denotes

thehighest two-way framedelay for the statisticsdisplayed, and theblue linedenotes

the average two-way frame delay for the statistics displayed. From the Delay End

drop-downbox, select 1-Wayor 2-Way to display theone-wayor two-way framedelay

measurement protocols respectively.

Delay Variation

The Delay Variation graph displays the difference between the consecutive frame

delay values. The x-axis represents the time and the y-axis represents delay variation

inmicroseconds. The line denotes the average one-way delay variation or the average

one-way “frame jitter” for the statistics displayed for one-way frame delay

measurement. The line denotes the average two-way delay variation or the average

two-way “frame jitter” for the statistics displayed for two-way delay measurement.
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The Loss Measurement monitor displays two real-time linear plots: Near End (CIR)

and Far End (CIR). The three parameters in each graph plot are average case, best

case, and worst case of frame-loss.

The graph is plotted in real-time. By default, the total time duration is ten minutes. If

the duration of statistics collection exceeds tenminutes, the graph scrolls and shows

the data of latest ten minutes.

See Also Performance Management Overview on page 1059•

• Monitoring Performance Management Statistics on page 1061

• Viewing Performance Management Statistics on page 1065

• Service Troubleshooting Overview on page 1071

• Performing a Configuration Audit on page 1027

Related
Documentation

Performance Management Overview on page 1059•

• Viewing Performance Management Statistics on page 1065

• Service Troubleshooting Overview on page 1071

• Performing a Configuration Audit on page 1027

Service Troubleshooting Overview

Common reasons for the failure of a service are that a PE device configured for that

service is down, or that device has had its service configuration changed so that it no

longer matches the service configuration in the Junos Space database.

The primary tools in Junos Space for troubleshooting service problems are:

• Functional audit

• Configuration audit

• Job Management

If the functional audit shows the service to be running, the next step is to perform a

configuration audit to see whether the service configuration has been changed out of

band, and is no longer consistent with the service configuration in the Junos Space

database.

You can view the results of both configuration and functional audits from theManage

Services page. You can also view the service configuration from theManage Services

page.

In the JobManagementpage, use theSummarycolumntoobtain informationabout failed

deploymentsand failedaudits. Fordeployments ingeneral, theSummarycolumncontains

useful service information such as the VC ID and endpoint information. For some failed
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deployments, this column also contains information about why the deployment failed.

The following is an example of a failed deployment in the JobManagement page.

Related
Documentation

• Performing a Functional Audit on page 1019

• Performing a Configuration Audit on page 1027

• Troubleshooting N-PE Devices Before Provisioning a Service on page 1030

• Modifying the Application Settings of Connectivity Services Director on page 1032

• Troubleshooting the Endpoints of Services on page 1038

• Viewing Configuration Audit Results on page 1046

• Viewing Functional Audit Results on page 1048

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052
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PART 13

Working in Monitor Mode

• About Monitor Mode on page 1075

• Monitoring Traffic on page 1081

• Monitoring Devices on page 1101

• General Monitoring on page 1105

• Monitor Reference on page 1109

• Detecting and Examining the Health and Performance of Services on page 1133
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CHAPTER 40

About Monitor Mode

• UnderstandingMonitorMode inViewsOther thanServiceViewofConnectivityServices

Director on page 1075

• Understanding the Monitor Mode Tasks Pane in Views Other than Service

View on page 1078

UnderstandingMonitorMode inViewsOther thanServiceViewofConnectivityServices
Director

Monitor mode in Connectivity Services Director provides you visibility into your network

status and performance. Connectivity Services Director monitors its managed devices

andmaintains the information it collects from the devices in a database. Monitor mode

displays this information in easy-to-understand graphs and in tables that you can sort

and filter, allowing you to quickly visualize the state of your network, spot trends

developing over time, and find important details.

Monitormodedividesmonitoringactivity using theTraffic tab,whichprovides information

about traffic on routers and interfaces.

You can access the Traffic tab on the Monitor mode landing page. An additional tab, the

Summary tab, is available that provides a high-level dashboard for the scope selected

in theViewpane. Themonitoring informationdisplayed in theSummary tabalsoappears

on other tabs.

This topic describes:

• Scope and Monitor Tab Availability on page 1075

• Monitors and Tasks on page 1076

• Scope and Data Aggregation on page 1076

• HowConnectivityServicesDirectorCollectsandDisplaysMonitoringDataonpage 1076

• How Connectivity Services Director Displays and Stores Trend Data on page 1077

• More About the Monitor Tabs on page 1078

Scope andMonitor Tab Availability

Yourcurrent scope—that is, your viewandnodeselection in theViewpane—affectswhich

Monitor tabs are available. For example, if you select a router, the RF tab is not available.
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The shading of the tabs indicate whether a tab is selected, available, or not available:

• The currently selected tab has dark text on a light background.

• Tabs that are available but not selected have dark text on a dark background.

• Tabs that are not available for your current scope have light text on a light background.

When you enter Monitor mode from another mode, the Summary tab is selected for all

scopes. If you have selected a tab and then change scope, the tab remains selected if it

is supported in thenewscope. If it is not supported in thenewscope,ConnectivityServices

Director selects a default tab for that scope.

Monitors and Tasks

When you click a Monitor tab, the landing page for that tab is displayed, which contains

a set of monitors. These monitor enable you to see at a glance important information

about the aspect of your network being monitored. For example, the monitors in the

Traffic tabpresent high-level information about the traffic or packets flow in the selected

scope.

Detailed information is also available frommanymonitors when you click the Details

icon on themonitor. If the Details icon is not visible in the title bar of a monitor, mouse

over the monitor to make it visible. For example, if you click the Details icon from the

Current Sessions By Typemonitor, you can view detailed information about the current

sessions.

In addition to monitors, each tab provides a set of tasks available from the Tasks pane.

These tasks enable you to perform additional monitoring functions. Some tasks enable

you to viewmore specializedmonitoringdata; others enable you toperformanoperation,

such as pinging a host. For a complete list of tasks available in Monitor mode, see

“Understanding the Monitor Mode Tasks Pane in Views Other than Service View” on

page 1078.

The scope you select affectswhichmonitors are displayed andwhich tasks are available.

Scope and Data Aggregation

Connectivity Services Director enables you to more thanmonitor individual devices. It

provides a broader network viewby aggregating data fromdevices andmaking that data

available for viewing at higher scopes within the network.

Not all data is aggregated at higher scopes. For example, it does not make sense to

providepower supply statusatanyhigher scope than thedevice itself.Whenevermonitors

are available at a scope higher than the device scope, however, the data presented is

aggregated data from all devices contained in that scope.

HowConnectivity Services Director Collects and Displays Monitoring Data

Connectivity Services Director collects monitoring data from all its managed devices at

regular intervals known as polling intervals. These polling intervals can vary according

to the type of data being collected. Connectivity Services Director sets default polling
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intervals for each type of data—you can, however, change these polling intervals in

Preferences.

The polling intervals are aligned to clock time. For example, if the polling interval is set

to 5minutes, then within every hour, Connectivity Services Director collects data at :00,

:05, :10, :15, and so on. If the polling interval is set to 15 minutes, Connectivity Services

Director collects data within every hour at :00, :15, :30, and :45.

Connectivity Services Director uses the Juniper Networks Device Management Interface

(DMI) to the managed devices to collect the data. If you have a Junos Space fabric,

Connectivity Services Director balances the load of polling the managed devices across

the nodes in the fabric.

When you display a monitor, the current data is from the last polling interval. Displaying

or refreshing amonitor does not trigger Connectivity Services Director to collect data.

However, Connectivity Services Director automatically refreshesmonitors with newdata

after a polling interval completes. Eachmonitor displays the time that the data was last

refreshed.

The detail windows for monitors are not automatically refreshed after a polling period

completes. Youmust manually refresh them to obtain new polling data.

HowConnectivity Services Director Displays and Stores Trend Data

In addition todisplayingcurrentdata,ConnectivityServicesDirectoralsodisplayshistorical

data in trend graphs so that you can view trends in network performance over time.

When you display a trend graph, you can select the time period over which the data is

displayed—usually 1 hour, 8 hours, 1 day, 1 week, 1 month, 3 months, 6 months, or 1 year.

These predefined periods are always relative to the current time and date—that is, if you

select a week, the data is from the last 7 days. You can also define a custom time period,

which enables you to display data for a period between specific dates and times.

For a trend graph displaying a predefined period of 1 hour, the number of data points

depends on the configured polling interval. For periods greater than an hour, the number

of data points displayed depends on the time period selected and how Connectivity

Services Director consolidates data over time.

Toallowstoringofmonitoringdata for a longperiodof time,ConnectivityServicesDirector

consolidates older data. Consolidation involves deriving a single value from a set of

shorter term values, generally by averaging the shorter term values, and then using that

value as a data point in a longer termdata set. After the shorter termdata is consolidated

into longer term data, it is discarded to save storage space. For example, if a value is

polled every 5 minutes, the set of 12 values is consolidated into a single value after an

hour has passed. That value then becomes one of the 24 data points that makes up the

data set for a day. Similarly, after a day has passed, data is consolidated into one data

point that represents that day; after amonth has passed, data is consolidated into a one

data point that represents that month. Data is not kept for more than a year.

For all trend graphs, Connectivity Services Director will not display data until it has more

than two data points to display. This means that after you discover a device, trend data

will not appear until three polling periods have passed.
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More About theMonitor Tabs

The following sections provide more information about each tab in Monitor mode.

• The Summary Tab on page 1078

• The Traffic Tab on page 1078

The Summary Tab

TheSummary tab is displayedwhenever youenterMonitormode. It servesasahigh-level

dashboard for the current selected scope in the View pane.

Themonitors displayed in the Summary tab can belong to any of theMonitor categories.

Each scope has a predefined set of monitors that are displayed.

When you select an individual device in the View pane, the Summary tab itself displays

an arrow that indicates whether the device is up (green up arrow) or down (red down

arrow).

For the My Network scope, you can customize what monitors appear on Summary tab,

giving you theability to viewataglance thoseaspectsof networkhealthandperformance

that are most important to you.

The Traffic Tab

The Traffic tab provides information for analyzing traffic on routers. The four monitors

provideanaggregatedviewofall network traffic onadevice, suchasproportionof current

proportion of multicast, unicast, broadcast traffic or the trend in packet errors. Tasks

provide more detailed looks at traffic, such as traffic statistics for individual ports or the

degree in which a port’s bandwidth is being used.

Understanding theMonitor Mode Tasks Pane in Views Other than Service View

TheTasks pane inMonitormodedisplays a list of tasks that are available for the currently

selectedMonitor tab.These tasksprovidemonitoring functions inaddition to themonitors

available under each tab.

The tasks listed in the Tasks pane vary according to the selected tab—that is, Summary

or Traffic—and the scope you have selected in the View pane. For example, the L3 VLAN

Statistics task is available only when you select the Traffic tab and a router or a device

in the View pane.

For each Monitor mode tab, the following tables list each task and provide a short

description of the task:

• Table 143 on page 1079: Summary Tab Tasks

• Table 144 on page 1079: Traffic Tab Tasks

• Key Tasks—Connectivity Services Director enables you to group the tasks that you

perform frequently and create a list of key tasks. You can add any task from the Tasks

pane to theKeyTasks list by selecting a task and clicking the plus (+) sign that appears

adjacent to the task. For somemodes, you can see that Connectivity Services Director
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has predefined some key tasks for you. You canmodify this set of tasks to suit your

requirements. This feature is available in Task pane irrespective of your current mode,

scope, or view.

Table 143: Summary Tab Tasks

DescriptionTask

Compares statistics frommultiple devices in real time.Compare Device Statistics

From the selected device, pings the host you specify and returns the results.Ping To a Host

Displays port utilization trend information for the devices in the selected scope. You
can view overall port utilization for the selected device or can view individual port
utilization.

Port Utilization

Selects the monitors that are displayed in the Summary tabSelect Monitors to display

Shows Address Resolution Protocol (ARP) table information for a device.Show ARP Table

Show the routing instances configured on an MX Series router.Show Routing Instances

From the selected device, traces the route to the host you specify and returns the
results.

Traceroute To a Host

Table 144: Traffic Tab Tasks

DescriptionTask

Compares statistics frommultiple devices in real time.Compare Device Statistics

Displays packet in and out statistics for Layer 3 VLANs on the selected device.L3 VLAN Statistics

From the selected device, pings the host you specify and returns the results.Ping To a Host

Displays packet and error statistics for all ports on the selected device.Port Statistics

Displays port utilization trend information for the devices in the selected scope. You can
view overall port utilization for the selected device or can view individual port utilization.

Port Utilization

Shows Address Resolution Protocol (ARP) table information for a device.Show ARP Table

Show the routing instances configured on an MX Series router.Show Routing Instances

From the selected device, traces the route to the host you specify and returns the results.Traceroute To a Host

Related
Documentation

• UnderstandingMonitorMode inViewsOther thanServiceViewofConnectivityServices

Director on page 1075
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CHAPTER 41

Monitoring Traffic

• Monitoring Traffic on Devices on page 1081

• Monitoring Port Traffic Statistics on page 1082

• Monitoring Traffic on Layer 3 VLANs on page 1084

• Monitoring Port Utilization on page 1085

• Monitoring Routing Instances on page 1089

• Viewing Congestion Events on page 1099

Monitoring Traffic on Devices

Themonitors on the Traffic tab provide information about the traffic traversing routers

and virtual MX Series (vMX) routers.

Tomonitor traffic on a device:

1. ClickMonitor in the Connectivity Services Director banner.

2. Select the device in the View pane that contains the traffic you want to monitor.

3. Select the Traffic tab to open the traffic monitors.

4. To get help for a monitor, click the Help button in its title bar.

The available monitors include:

• “Unicast vsBroadcast/MulticastMonitor”onpage 1115: shows thedistributionofunicast,

broadcast, andmulticast traffic entering and leaving the device.

• “Unicast vs Broadcast/Multicast TrendMonitor” on page 1116: shows trend data about

the distribution of unicast, broadcast, andmulticast traffic entering and leaving the

device.

• “Traffic Trend Monitor” on page 1115: shows trend data about the amount of traffic

entering and leaving the device.

• “ErrorTrendMonitor”onpage 1109: shows trenddataabout theamountoferrorson the

device.
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Monitoring Port Traffic Statistics

This topic describes how tomonitor port traffic statistics on a device. You canmonitor

port traffic statistics for a router, virtual router, or a security device.

This topic describes:

• Procedure for Monitoring Port Traffic Statistics on page 1082

• Port on DeviceWindow on page 1082

• Port Traffic StatsWindow on page 1083

Procedure for Monitoring Port Traffic Statistics

1. ClickMonitor in the Connectivity Services Director banner.

2. Select a node in the View pane that contains the port traffic you want to monitor.

3. Select the Traffic tab.

4. In the Tasks pane, select View > Port Statistics.

The Port Traffic Stats window opens. For information about this window, click the

Help button in the title bar of the window or see “Port Traffic StatsWindow” on

page 1083.

Port on DeviceWindow

Port onDevicewindowdisplays the details of all the ports on devices that are configured

for network traffic analysis. Table 145onpage 1082describes the fields that aredisplayed

in the Port on Device window.

Table 145: Port on Device table field descriptions

DescriptionField Name

Identification of the port.Port Name

The administrative state of the port: enabled (UP) or disabled (DOWN).Admin State

The operational status—link up (UP) or link down (DOWN).Operational State

The actual bandwidth available on the port, in megabits (Mb).Max Bandwidth

The negotiated bandwidth based on the speed that is configured or auto-negotiated for the
interface.

Negotiated Bandwidth
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To viewmore details about the traffic on any port, select the port and click View Traffic.

The Traffic on Port window opens.

Port Traffic StatsWindow

The Port Traffic Stats window displays information about the port traffic on the node

you selected in the View pane. It contains the following elements:

• Port Traffic Trend graph—This line graph shows trends in the data and error rates on

the port selected in the ports table below it. The horizontal axis shows the timeswhen

samples were taken. The vertical axis shows the data rate on the left side (in packets

per second) and the error rate on the right side (in errors per second).

To display traffic for a different port, select the port from the table below the graph.

To change the time period over which to display the traffic trends, select a time period

from the list in the upper right corner.

NOTE: After a device is discovered, trend data does not appear
immediately—it appears only after three polling periods have elapsed.

To highlight a line on the graph, mouse over the line legend. To remove or restore a

line, click the line legend.Toseenumeric values,mouseoverwhereadata line intersects

with a dotted vertical grid line.

• Ports table (on the lower left side of the window)—This table provides information

about theports as described inTable 146onpage 1083. Selecting aport from this table

updates the Port Traffic Trend graph to display traffic information about the selected

port.

• Counter selection table (on the lower right side of the window)—This table enables

you to select which counters to display on the Port Traffic Trend graph. It includes

separate tabs for packet counters and error counters. Select the check box in theShow

column of each counter that you want to display on the graph. The Per/Sec column

shows the rate per second of that row’s counter.

Table 146: Port TrafficWindow

DescriptionTable Column

Serial number of the device to which the port belongs.Serial Num

Port name.Port Name

Port mode—either ACCESS or UPLINK.Port Usage Type

Port MAC address.MAC Addresses

Full duplex, half duplex, or unspecified.Link Type

Current rate of inbound packets.In Packets/Sec.(Current)
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Table 146: Port TrafficWindow (continued)

DescriptionTable Column

Current rate of outbound packets.Out Packets/Sec.(Current)

Monitoring Traffic on Layer 3 VLANs

This topic describes how tomonitor Layer 3 VLAN traffic statistics on a device. You can

monitor Layer 3 VLAN statistics for a router, virtual router, or a security device.

This topic describes:

• Procedure for Monitoring Layer 3 VLAN Traffic Statistics on page 1084

• L3 VLAN Traffic StatsWindow on page 1084

Procedure for Monitoring Layer 3 VLAN Traffic Statistics

1. ClickMonitor in the Connectivity Services Director banner.

2. Select a node in the View pane that contains the Layer 3 VLAN traffic you want to

monitor.

3. Select the Traffic tab.

4. In the Tasks pane, select View > L3 VLAN Statistics.

The L3 VLAN Traffic Stats window opens. For information about this window, click

the Help button in the title bar of the window or see “L3 VLAN Traffic StatsWindow”

on page 1084.

L3 VLAN Traffic StatsWindow

The L3 VLAN Traffic Stats window displays information about the Layer 3 VLAN traffic

on the node you selected in the View pane. It contains two panes:

• VLAN Traffic line graph—This graph shows the data transmission rate on the Layer 3

VLAN selected in the table beneath the graph. The horizontal axis shows the times

when samples were taken. The vertical axis shows the data rate, in bytes per second.

To show a Layer 3 VLAN on the VLAN Traffic line graph, select the Layer 3 VLAN from

the tablebeneath thegraph. Tohighlight a lineon thegraph,mouseover the line legend.

To remove or restore a line, click the line legend. To see numeric values, mouse over a

data point.

• Layer 3 VLAN traffic statistics table—This table provides information about the Layer

3VLANsasdescribed inTable 147onpage 1085.SelectingaLayer3VLANfromthis table

updates the VLAN Traffic graph to display the traffic information for the selected

Layer 3 VLAN.
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Table 147: Layer 3 VLAN Traffic Statistics Table

DescriptionTable Column

Layer 3 interface assigned to the VLAN.L3 Interface

The serial number of the device containing the Layer 3 VLAN.SerialNo

VLAN name.VLAN Name

VLAN ID.VLAN ID

VLAN description.Description

Number of packets entering the VLAN.In Packet

Number of packets leaving the VLAN.Out Packet

Monitoring Port Utilization

Connectivity Services Director provides information about port utilization in either one

of two places, depending on the node you select in the View pane:

• Port Utilization monitor—This monitor, available in the Summary tab, provides a bar

chart that shows the aggregate utilization of the ports on a device or devices over a

period of time that you select. For more information about using the Port Utilization

monitor, see Port Utilization Monitor.

• Port Utilization task—This task, available fromView > Port Utilization in the Tasks pane

of the Summary or Traffic tabs, provides a bar chart similar to the Port Utilization

monitor bar chart. Unlike the Port Utilization monitor, it also enables you to obtain

informationon individual port utilizationover timewhenyouhaveselectedan individual

device or Layer 3 Fabric in the View pane.

This topic describes the Port Utilization task. It describes:

• How to Access the Port Utilization Task on page 1085

• Port Utilization Details Window on page 1086

• Utilization for DeviceWindow on page 1086

• Utilization for IP Fabric Window on page 1088

How to Access the Port Utilization Task

1. ClickMonitor in the Connectivity Services Director banner.

2. Select a node in the View pane that contains the ports whose utilization you want to

monitor.
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3. Select the Summary or Traffic tab.

4. In the Tasks pane, select View > Port Utilization.

If you have selected a node that contains more than one device, the Port Utilization

Detailswindowopens. For informationabout thiswindow, see “PortUtilizationDetails

Window” on page 1086.

If you have selected an individual device, the Utilization for Device window opens. For

information about this window, see “Utilization for DeviceWindow” on page 1086.

If you have selected a Layer 3 Fabric, the Utilization for IP Fabric window opens. For

information about this window, see “Utilization for IP Fabric Window” on page 1088.

Port Utilization DetailsWindow

This window provides a bar chart showing the aggregate port utilization trend for the

devices within the selected scope.

Each bar in the bar chart represents the overall port utilization for all the devices at a

polling interval. The vertical axis shows the number of ports polled. The horizontal axis

shows the time when each poll was taken.

Each bar is divided into the following colored sections to indicate the distribution of port

utilization at the polling interval:

• Green indicates ports that operated at less than 50% of negotiated speed.

• Orange indicates ports that operated at between 50%and 80%of negotiated speed.

• Red indicates ports that operated at more than 80% of negotiated speed.

You can perform the following actions on the bar chart:

• Change the time period over which to display the trend data by selecting a time period

from the list in the upper right corner.

• Remove or restore a utilization category (bar color) by clicking its legend.

• Display a numeric value by mousing over a bar.

Utilization for DeviceWindow

The Utilization for Device window shows the port utilization trend for individual devices

and ports. It is available when you select a individual device in the View pane.

The Utilization for Device window provides two views of port utilization:

• Device—This view provides a trend chart of overall port use on the device over time.

• Port—This viewprovides a heatmapof all the ports on the device, enabling you to view

the utilization of individual ports. You can choose a port from the heat map to view a

utilization trend chart for that particular port.

The Device view is the default view. Click Port to change to the Port view.
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Device View

The Device view provides a bar chart that shows the trend of overall port use on the

device. Each bar represents the overall port utilization at a polling interval. The vertical

axis shows the number of ports polled. The horizontal axis shows the time when each

poll was taken.

Each bar is divided into the following colored sections to indicate the distribution of port

utilization at the polling interval:

• Green indicates ports that operated at less than 50% of negotiated speed.

• Orange indicates ports that operated at between 50%and 80%of negotiated speed.

• Red indicates ports that operated at more than 80% of negotiated speed.

You can perform the following actions in Device view:

• Change the time period over which to display the trend data by selecting a time period

from the list in the upper right corner.

• Remove or restore a utilization category (bar color) by clicking its legend.

• Display a numeric value by mousing over a bar.

Port View

The Port view provides utilization heat maps of the ports on the device—one heat map

for access ports and another for uplink ports. In the heat maps, each port on the device

is represented by a box that is color-coded to indicate the level of port utilization. Cooler

colors (for example, green) indicate lowerport utilization ,whilehotter colors (for example,

red) indicate higher port utilization.

Click a port box to display a utilization trend chart for that individual port.

You can perform the following actions in the Port view:

• On a heat map:

• Mouse over a port box to seemore information about the port such as the port

utilization percent, port type, MAC address of the port, duplex mode, device serial

number, admin status and operational status of the port, negotiated speed, and the

last flap time.

• Change the time period over which the port utilization percentage is derived.

• Click a port box to display the utilization trend chart for that port.

• Use the percentage slider under the port heat map to display only those ports for

which utilization falls within a certain percentage range.

• On the port utilization trend chart:

• Change the time period over which to display the trend data.

• Display the percentage utilization and polling time bymousing over a data point.
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Utilization for IP FabricWindow

The Utilization for IP Fabric window provides information about port utilization for the

devices and ports within a Layer 3 Fabric. It is available when you select a Layer 3 Fabric

in the View pane.

The top part of the Utilization for IP Fabric window displays a heat map of the devices

in the Layer 3 Fabric. Each device in the Layer 3 Fabric shown as either a spine or leaf

device and is color-coded to show the overall port utilization on the device.

You can interact with this fabric-level heat map as follows:

• Mouse over a box representing a device. Information about that device is displayed,

such as IP address, model, overall port utilization, and a list of the five ports with the

highest utilization.

• Click a box representing a device. The information in the remainder of the window is

changed to reflect the port utilization of the device.

You can select two different views of the port utilization on the device:

• Device—This view provides a trend chart of overall port use on the device over time.

• Port—This viewprovides a heatmapof all the ports on the device, enabling you to view

the utilization of individual ports. You can choose a port from the heat map to view a

utilization trend chart for that particular port.

The Device view is the default view. Click Port to change to the Port view.

Device View

The Device view provides a bar chart that shows the trend of overall port use on the

selected device. Each bar represents the overall port utilization at a polling interval. The

vertical axis shows the number of ports polled. The horizontal axis shows the timewhen

each poll was taken.

Each bar is divided into the following colored sections to indicate the distribution of port

utilization at the polling interval:

• Green indicates ports that operated at less than 50% of negotiated speed.

• Orange indicates ports that operated at between 50%and 80%of negotiated speed.

• Red indicates ports that operated at more than 80% of negotiated speed.

You can perform the following actions on the bar chart:

• Change the time period over which to display the trend data by selecting a time period

from the list in the upper right corner.

• Remove or restore a utilization category (bar color) by clicking its legend.

• Display a numeric value by mousing over a bar.
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Port View

The Port view provides utilization heat maps of the ports on the device—one heat map

for access ports and another for uplink ports. In the heat maps, each port on the device

is represented by a box that is color-coded to indicate the level of port utilization. Cooler

colors (for example, green) indicate lowerport utilization ,whilehotter colors (for example,

red) indicate higher port utilization.

You can perform the following actions on the device heat map:

• Mouse over a port box to seemore information about the port, such as the port

utilization percent, port type, MAC address of the port, duplex mode, device serial

number, admin status and operational status of the port, negotiated speed, and the

last flap time.

• Change the time period over which the port utilization percentage is derived.

• Use the percentage slider under the port heat map to display only those ports whose

percent utilization falls within a certain range.

• Click a port box to display the utilization trend chart for that port.

The port utilization trend chart shows the utilization trend for the selected port. You can:

• Change the time period over which to display the trend data.

• Display the percentage utilization and polling time bymousing over a data point.

Monitoring Routing Instances

This topic describes how tomonitor VPN routing instances onMXSeries routers by using

Connectivity Services Director. Using Connectivity Services Director, you can determine

which interfaces and bridge domains belong to the routing instances and view traffic

statistics for those interfaces and bridge domains. You can also display connection

information for Layer 2 VPN and virtual private LAN service (VPLS) routing instances.

Connectivity Services Director can be used to monitor the following types of Layer 2

routing instances:

• Default routing instance

• Ethernet VPN (EVPN)

• Layer 2 VPN

• VPLS

• Virtual switch
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Connectivity Services Director can be used to monitor the following types of Layer 3

routing instances:

• Layer 3 VPN

This topic describes:

• Procedure for Monitoring Routing Instances on page 1090

• Show Routing InstancesWindow on page 1090

• Show InterfacesWindow on page 1091

• Show Bridge DomainsWindow on page 1092

• Show Connections on page 1093

• Show Routing Tables on page 1096

• ShowMAC Table on page 1098

Procedure for Monitoring Routing Instances

Use the options in the Show Routing Instances window tomonitor routing instances.

1. ClickMonitor in the Connectivity Services Director banner.

2. Select an MX Series router in the View pane that contains the port traffic you want to

monitor.

3. In the Tasks pane, select Tasks > ShowRouting Instances.

The ShowRouting Instanceswindow opens. For information about this window, click

theHelpbutton in the titlebar of thewindowor see “ShowRouting InstancesWindow”

on page 1090.

ShowRouting InstancesWindow

The ShowRouting Instanceswindow lists the routing instances configured on a selected

device.Use thiswindowtodisplay the interfacesorbridgedomainsbelonging toa routing

instance and obtain traffic statistics for the interfaces. You can also display information

about theVPLSandLayer 2VPNconnections.Table 148onpage 1090describes the fields

in this window.

Table 148: Fields in the Show Routing InstancesWindow

DescriptionField

Name of the routing instance.

The default routing instance is named default-switch.

Routing
Instance
Name
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Table 148: Fields in the Show Routing InstancesWindow (continued)

DescriptionField

Identifies the routing instance type:

• EVPN

• L2VPN

• L3VPN

• Virtual Switch

The default routing instance is of this type.

• VPLS

• VRF (L3VPN)

Type

Provides the following information (if configured for the routing instance):

• Route Distinguisher—Used to identify all routes that are part of the VPN. The
route distinguisher makes IP addresses globally unique, so that the same IP
address prefixes can be used for different VPNs.

• Target—Extended BGP community used tomatch routes for import and export.

Details

Displays the number of interfaces belonging to the routing instance. Click the
number to open the Show Interfaces window, described in “Show Interfaces
Window” on page 1091.

Interfaces

Displays the number of bridge domains belonging to the routing instance. Click
thenumber toopen theShowBridgedDomainswindow,described in “ShowBridge
DomainsWindow” on page 1092.

Bridge
Domains

• Click ShowConnections to display information about Layer 2 VPN and VPLS
connections. The information described in “ShowConnections” on page 1093 is
displayed. This link is available only for Layer 2VPNandVPLS routing instances.

• ClickShowMACTable todisplay theMAC table for the selected routing instance.
For details, see “ShowMAC Table” on page 1098.

• Click ShowRouting Table to view the routing table information for the selected
routing instance. For details, see “Show Routing Tables” on page 1096.

Actions

Show InterfacesWindow

TheShow Interfaceswindow lists the logical interfaces configuredon the routing instance

andprovides the informationabout the interfacesasdescribed inTable 149onpage 1091.

Table 149: Show Interfaces Information

DescriptionField

The interface name.Interface
Name

Indicates one of twomodes—access or trunk:

• Access—The interface can be in a single VLAN only.

• Trunk—The interface can be in multiple VLANs and accept tagged packets
frommultiple devices.

Port Mode
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Table 149: Show Interfaces Information (continued)

DescriptionField

Indicates whether the interface is up or down.Interface
State

Indicates whether the interface is in a discarding (blocked) or in forwarding
(unblocked) state. (Not shown for interfaces belonging to Layer 2 VPN and Layer
3 VPN routing instances.)

STP State

Local IP address. (Shown only for interfaces belonging to Layer 2 VPN and Layer
3 VPN routing instances.)

Local IP
Address

Remote IP address. (Shown only for interfaces belonging to Layer 2 VPN and
Layer 3 VPN routing instances.)

Remote IP
Address

• Click View Statistics to display traffic statistics for the interface. The Show
InterfaceStatisticswindowopens,whichcharts thenumberof inputandoutput
packets and the number of input and output bytes.

• Click ShowMAC Table to display the MAC table for the interface. For more
details, see “ShowMAC Table” on page 1098.

Actions

ShowBridge DomainsWindow

The Show Bridge Domains window lists the bridge domains configured on the routing

instance. To display information about the VLAN IDs and interfaces configured on a

bridgedomain, select thebridgedomain.Table 150onpage 1092describes the information

provided in the Show Bridge Domains window.

Table 150: Show Bridge Domains Information

DescriptionField

The bridge domain name.Bridge
Domains

Click ShowMAC Table to display the MAC table for the selected bridge domain.
For details, see “ShowMAC Table” on page 1098.

Actions

The VLAN ID or IDs assigned to the bridge domain.VLAN ID

The name of a logical interface assigned to the VLAN ID.Interface
Name

Indicates one of twomodes—access or trunk:

• Access—The interface can be in a single VLAN only.

• Trunk—The interface can be inmultiple VLANs and accept tagged packets from
multiple devices.

Port Mode

Indicates whether the interface is up or down.Interface
State
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Table 150: Show Bridge Domains Information (continued)

DescriptionField

Indicates whether the interface is in a discarding (blocked) or in forwarding
(unblocked) state.

STP State

• Click View Statistics to display traffic statistics for the interface. The Show
InterfaceStatisticswindowopens,which charts thenumber of input andoutput
packets and the number of input and output bytes.

• Click ShowMACTable to display theMAC table for the interface. For details, see
“ShowMAC Table” on page 1098.

Actions

ShowConnections

The Show Connections window provides information about the VPN connections for

Layer 2 VPN and VPLS routing instances as described in Table 151 on page 1093.

Table 151: Show Connections Information

DescriptionField

Name of the local site.Local Site
Name

Identifier for the local site.Local Site ID

Name of the local interface.Local
Interface
Name

Indicates whether the local interface is up or down.Interface
Status

Identifier for the remote site.Remote Site
ID

IP address of the remote provider edge device (PE device).Remote IP
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Table 151: Show Connections Information (continued)

DescriptionField

Connection
Status
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Table 151: Show Connections Information (continued)

DescriptionField

Status of the connection:

• EI—The local VPN interface is configured with an encapsulation that is not
supported.

• EM—The encapsulation type received on this connection from the neighbor
does not match the local connection interface encapsulation type.

• VC-Dn—The virtual circuit is currently down.

• CM—The two routers do not agree on a control word, which causes a control
word mismatch.

• CN—The virtual circuit is not provisioned properly.

• OR—The label associated with the virtual circuit is out of range.

• OL—No advertisement has been received for this virtual circuit from the
neighbor. There is no outgoing label available for use by this virtual circuit.

• LD—All of the CE-facing interfaces to the local site are down. Therefore, the
connection to the local site is signaled as down to the other PE routers. No
pseudowires can be established.

• RD—All the interfaces to the remote neighbor are down. Therefore, the remote
site has been signaled as down to the other PE routers. No pseudowires can
be established.

• LN—The local site has lost path selection to the remote site and therefore no
pseudowires can be established from this local site.

• RN—The remote site has lost path selection to a local site or to a remote site
and therefore no pseudowires are established to this remote site.

• XX—The connection is down for an unknown reason. This is a programming
error.

• MM—The MTUs for the local site and the remote site do not match.

• BK—The router is using a backup connection.

• PF—Profile parse failure.

• RS—The remote site is in a standby state.

• NC—The interface encapsulation is not configured as an appropriate CCC
(circuit cross-connect), TCC (translational cross-connect), Layer 2 VPN, or
VPLS encapsulation.

• WE—The encapsulation configured for the interface does not match with the
encapsulation configured for the associated connection within the routing
instance.

• NP—The router detects that interface hardware is not present. The hardware
might be offline, a PICmight not be of the compatible type, or the interface
might be configured in a different routing instance.

• ->—Only the outbound connection is up.

• <-—Only the inbound connection is up.

• Up—The connection is operational.

• Dn—The connection is down.

• CF—The router cannot find enough bandwidth to the remote router to satisfy
the connection bandwidth requirement.

• SC—The local site identifier is the same as the remote site identifier. No
pseudowire can be established between these two sites. Youmust configure
different values for the local and remote site identifiers.

• LM—The local site identifier is not the minimum designated, which means it is
not of the lowest value. There is another local site with a lower value for site
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Table 151: Show Connections Information (continued)

DescriptionField

identifier. Pseudowires are not being established to this local site and the
associated local site identifier is not being used to distribute Layer 2 VPN or
VPLS label blocks. However, this is not an error state. Traffic continues to be
forwarded to the PE router interfaces connected to the local sites when the
local sites are in this state.

• RM—The remote site identifier is not the minimum designated, which means
it is not the lowest. There is another remote site connected to the same PE
router which has lower site identifier. The PE router cannot establish a
pseudowire to this remote site and theassociated remote site identifier cannot
be used to distribute VPLS label blocks. However, this is not an error state.
Traffic continues to be forwarded to the PE router interface connected to this
remote site when the remote site is in this state.

• IL—The incoming packets for the connection have no MPLS label.

• MI—The configuredmesh group identifier is in use by another system in the
network.

• ST—The router has switched to a standby connection.

• PB—Profile is busy.

• SN—The neighbor is static.

The time when the connection was last in the Up condition.Time Last Up

ShowRouting Tables

The Routing Tables window enables you view the routing table information for the

selected virtual routing instance. For L3VPN and EVP services, you can determine which

LSPs or tunnels are being used by looking at the routing tables.

• Routing Tables—The Routing Tables table shows the routing tables associated with

the virtual instance and the number of active routes in each table. Click on a routing

table to display the actual contents of the routing table.

• Details—The Details table shows the contents of the selected routing table.

Table 152 on page 1096 displays the fields that are displayed in the Details table.

Table 152: Show Routing Table Field Descriptions

DescriptionName

Name of the routing instance.Routing Instance

Number of destinations for which there are routes in the routing table.Number of Destinations

Number of routes that are active.Active Routes

Number of routes that are not used because of routing policy.Hidden Routes

Number of routes that are in the hold-down state before being declared inactive.Hold-down Routes

Total number of routes.Total Routes
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Table 152: Show Routing Table Field Descriptions (continued)

DescriptionName

Route destination (for example:10.0.0.1/24). Sometimes the route information is presented in
another format, such as:

• MPLS-label (for example, 80001).

• interface-name (for example, ge-1/0/2).

• neighbor-address:control-word-status:encapsulation type:vc-id :source (Layer 2 circuit only. For
example, 10.1.1.195:NoCtrlWord:1:1:Local/96):

• neighbor-address—Address of the neighbor.

• control-word-status—Whether the use of the controlword has been negotiated for this virtual
circuit: NoCtrlWord or CtrlWord.

• encapsulation type—Type of encapsulation, represented by a number: (1) Frame Relay DLCI,
(2) ATM AAL5 VCC transport, (3) ATM transparent cell transport, (4) Ethernet, (5) VLAN
Ethernet, (6) HDLC, (7) PPP, (8) ATM VCC cell transport, (10) ATM VPC cell transport.

• vc-id—Virtual circuit identifier.

• source—Source of the advertisement: Local or Remote.

Destination Prefix

State of the route.State

Name of the protocol fromwhich the route was learned. For example,OSPF, RSVP, and Static.Protocol

Preferred protocol for this routing instance. Junos OS uses this preference to choose which routes
become active in the routing table.

Protocol Preference

Displays how long since the route was learned.Age

Cost value of the indicated route. For routes within an AS, the cost is determined by the IGP and
the individual protocol metrics. For external routes, destinations, or routing domains, the cost is
determined by a preference value.

Metric

Ametric used by BGP sessions to indicate the degree of preference for an external route. The route
with the highest local preference value is preferred.

BGP Local Preference

Interface fromwhich the route was received.Route Learned From

AS path through which the route was learned. The letters at the end of the AS path indicate the
path origin, providing an indication of the state of the route at the point at which the AS path
originated:

• I—IGP

• E—EGP

• ?—Incomplete; typically, the AS path was aggregated.

AS Path

(BGP-learned routes) Validation status of the route:

• Invalid—Indicates that the prefix is found, but either the corresponding AS received from the
EBGP peer is not the AS that appears in the database, or the prefix length in the BGP update
message is longer than themaximum length permitted in the database.

• Unknown—Indicates that the prefix is not among the prefixes or prefix ranges in the database.

• Valid—Indicates that the prefix and autonomous system pair are found in the database.

Validation State
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Table 152: Show Routing Table Field Descriptions (continued)

DescriptionName

Next hop to the destination. An angle bracket (>) indicates that the route is the selected route.

If the destination is Discard, traffic is dropped.

Next Hop Type

The local interface used to reach the next hop.Local Interface

IP address of the interface.Address

Interface used to reach the next hop. If there is more than one interface available to the next hop,
the interface that is actually used is followed by the word Selected.

Via Interface

MPLS label and operation occurring at the next hop. The operation can be pop (where a label is
removed from the top of the stack), push (where another label is added to the label stack), or
swap (where a label is replaced by another label).

MPLS Label

ShowMAC Table

The ShowMAC table window displays the MAC table for the selected routing instance.

Table 153 on page 1098 describes the fields that are displayed in the ShowMAC Table

window.

Table 153: ShowMAC Table fields

DescriptionField Name

Name of the routing instance.Routing Instance

Identifies the routing instance type:

• EVPN

• L2VPN

• L3VPN

• Virtual Switch

The default routing instance is of this type.

• VPLS

• VRF (L3VPN)

Type

Name of the bridging domain.Bridge Domain

VLAN ID of the routing instance or bridge domain in which the MAC address was learned.VLAN ID

MAC address or addresses learned on a logical interface.MAC Address
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Table 153: ShowMAC Table fields (continued)

DescriptionField Name

Status of MAC address learning properties for each interface:

• S—Static MAC address is configured.

• D—Dynamic MAC address is configured.

• L—Locally learned MAC address is configured.

• C—Control MAC address is configured.

• SE—MAC accounting is enabled.

• NM—Non-configured MAC.

• R—Remote PE MAC address is configured.

MAC Flags

Name of the logical interface.Logical Interface

Viewing Congestion Events

This topic describes how to view congestion events on a device. A congestion event

occurs when congestion on a device port exceeds the configured threshold.

You can view congestion events only for devices that support Cloud Analytics Engine

and thathave thehigh-frequency traffic statistics featureenabled inConnectivityServices

Director.

To view congestion events on a device, youmust first do the following:

• Configure the Data Learning Engine (DLE) settings under Preferences >Monitoring >

Data Learning Engine Settings. The DLE is a component of Cloud Analytics Engine.

• Enable high-frequency traffic statistics on the device and optionally configure

thresholds.

To view congestion events on a device:

1. In the Viewpane, select a device onwhich the high-frequency traffic statistics feature

is enabled.

2. ClickMonitor in the Connectivity Services Director banner to open Monitor mode.

3. In theTasks pane, selectTasks>ViewCongestionEvents. TheViewCongestion Events

window opens.

The ViewCongestion Events window lists congestion events that occurred on the device

during the time span of 1 minute. The table column headings are the seconds within the

selectedminute. Each row represents a device interface. Each cell represents the activity

on that interface during that second. When congestion events occurred during that

second,abubbleappears in thecell. Thesizeof thebubble indicateshowmanycongestion

events occurred during that second. The color of the bubble indicates the severity of the
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congestion during that second: cooler colors indicate lower severity, and hotter colors

indicate higher severity.

You can perform these actions in the View Congestion Events window :

• Use the Select Hour and Select Minute lists to select the minute in which to display

congestion events and then click Submit.

• Mouseover aport name tochange thebubbles in its row into thenumber of congestion

events that occurred during each second.

• Clickabubble toopenabar chart that showsdetailed informationabout thecongestion

events that occurred during that second.
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CHAPTER 42

Monitoring Devices

• Comparing Device Statistics on page 1101

• Showing ARP Table Information on page 1102

Comparing Device Statistics

This topic describes how to compare statistics frommultiple network devices and

interfaces in real time. You select which devices, interfaces, and counters to compare,

and how often to poll for new statistics.

This topic describes:

• Procedure for Comparing Device Statistics on page 1101

• Compare InterfacesWindow on page 1101

Procedure for Comparing Device Statistics

1. ClickMonitor in the Connectivity Services Director banner.

You can compare device statistics in any tab in Monitor mode.

2. In the Tasks pane, select Tasks > Compare Device Statistics.

The Compare Interfaces window opens. For information about this window, click the

Help button in the title bar of the window or see “Compare InterfacesWindow” on

page 1101.

Compare InterfacesWindow

The Compare Interfaceswindow enables you to compare statistics frommultiple device

interfaces in real time. The search scope is the entire managed network, regardless of

which node is selected in the View pane.

To compare device statistics:

1. Select the devices to compare from the device tree in the Select Devices section.

2. Select a device in the Selected Devices section to select which of its interfaces to

compare.
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The Select Interfaces section lists the device’s interfaces. You can select up to two

interfaces per device.

3. Select an Interface in the Select Interfaces section to select which of its counters to

compare.

The Select Counters section lists the interface’s counters.

4. Select the counters to compare in the Select Counters section.

5. Repeat the process of selecting devices, interfaces, and counters to compare until

you are finished selecting what to compare.

6. Select how often the data will be refreshed from the Data Collection Frequency list.

7. Click the Compare button to start comparing information.

A page opens containing a line graph for each counter you selected. Each graph

displays all the interfaces for which its counter is selected.

8. To pause data collection, click the Pause button. To resume data collection, click the

Resume button.

9. To change data collection settings, click the Back button.

Showing ARP Table Information

This topic describes how to show Address Resolution Protocol (ARP) table information

for a device. ARP table information is collected from the selected device when this task

runs. You can search for ARP table records.

• Procedure for Showing ARP Table Information on page 1102

• Show ARP Table InformationWindow on page 1103

Procedure for Showing ARP Table Information

To show ARP table information for a device:

1. ClickMonitor in the Connectivity Services Director banner.

2. Select the device in the View pane that you want to monitor.

3. Select Tasks > ShowARP Table in the Task pane.

The Show ARP Table Information window opens. For information about this window,

click the Help button in the title bar of the window or see Table 154 on page 1103. You

can click the Refresh button below the table to refresh the data from the device.

Copyright © 2019, Juniper Networks, Inc.1102

Connectivity Services Director User Guide



ShowARP Table InformationWindow

The ShowARPTable InformationWindow shows information from the selected device’s

ARP table.

Table 154: Show ARP Table InformationWindow

DescriptionControl or Column

Search for ARP table records. Enter search text in the text box. The table of ARP
records displays only matching records. Click the X button to clear the search
and display all records.

Search controls

MAC address.MAC Address

IP address.IP Address

Interface name.Interface Name

Number of seconds until the record expires from the ARP table.Expiring in (sec)
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CHAPTER 43

General Monitoring

• Selecting Monitors To Display on the Summary Tab on page 1105

• Changing Monitor Polling Interval and Data Collection on page 1106

• Pinging Host Devices on page 1106

• Troubleshooting Network Connections Using Traceroute on page 1107

SelectingMonitors To Display on the Summary Tab

When you select the My Network node in the View pane, the Summary tab in Monitor

mode enables you to select which monitors to display. If you select more than four

monitors, a scroll bar appears to allow you to scroll to the additional monitors.

To select monitors to display on the Summary tab:

1. ClickMonitor in the Connectivity Services Director banner.

2. Select theMyNetwork node in the View pane (the top node in the tree).

3. To select which monitors to display on the Summary tab:

a. Click Select Monitors to Display in the Tasks pane.

The Select Monitors window opens. Themonitors that are already selected to

display are listed in the Selected list. The other available monitors are listed in the

Available list.

b. Tomove amonitor from one list to the other list, click themonitor name, and then

click the right or left arrow button, as appropriate.

c. To change the order in which the selectedmonitors appear in the tab, select a

monitor name andmove it in the list using the up and down arrow buttons. The
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arrow buttons at the top and bottom of the stack of buttons move the selected

monitor to the top or bottom of the list, respectively.

d. Click Save to save your changes, or click Cancel to cancel your changes.

4. To get information about a monitor, click the Help button in its title bar.

Related
Documentation

UnderstandingMonitorMode inViewsOther thanServiceViewofConnectivityServices

Director on page 1075

•

ChangingMonitor Polling Interval and Data Collection

Network Administrators can change the default polling interval formonitors. The default

polling period varies by monitor category. You can change these values in Preferences,

found in the Connectivity Services Director banner. You can also enable or disable the

data collection processes used bymonitors in Preferences.

Pinging Host Devices

Use the Ping Host task in Monitor mode to determine whether an MX Series host can be

reached over the network from the device selected in the network tree. Entering a

hostnameoranaddress createsaperiodicping task that sendsaseriesof InternetControl

Message Protocol (ICMP) echo (ping) requests to the specified host. The output of the

task displays in the Response Console.

The Ping from Device to a Host task is available only for ACX Series routers, M Series

routers, MX Series routers, and PTX Series routers in your network.

1. Select either IP or HostName in the Remote Host Details box.

2. Type the IP address or hostname for the device that you want to reach.

3. Click Ping to use the default settings and start the requests or select the plus (+)

symbol to use the Advanced Search Criteria. The fields in Advanced Search Criteria

are described in Table 155 on page 1106.

Table 155: Ping Host Advanced Search Criteria Field Descriptions

DefaultDescriptionField

3Indicates the number of ping requests to send. Valid values are 1 through 24.Count

0Sets the type-of-service (ToS) field in the IP header of the ping packets. The
range of values is 0 through 255. If the routing platform does not support ToS,
the field is ignored.

Type of Service
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Table 155: Ping Host Advanced Search Criteria Field Descriptions (continued)

DefaultDescriptionField

32Indicates the time-to-live hop count for the ping request packet. Valid values
are 0 through 255.

Time To Live

0Indicates the amount of time in seconds between ping requests. Valid values
are 0 through 24; a 0 value sends the request immediately.

Wait Interval

56Indicates the size of the ping request packet in bytes. The routing platform adds
8 bytes of ICMP header to this size before sending the request packet.

Packet Size

AllSends the ping requests on the interface you specify. Iif you do not specify this
option, ping requests are sent on all interfaces.

Interface

NoneUses the source address that you specify in the ping request packet.Source

Related
Documentation

UnderstandingMonitorMode inViewsOther thanServiceViewofConnectivityServices

Director on page 1075

•

Troubleshooting Network Connections Using Traceroute

Traceroute is a diagnostic tool that enables you to display the route that a packet takes

to reach thedestinationandmeasure transit delaysofpacketsacrossan InternetProtocol

(IP) network. You can use traceroute to troubleshoot and identify points of failure in your

switching network. In traceroute, the source device sends three Internet ControlMessage

Protocol (ICMP)echo requestpackets to thedestinationdevice. This is donesequentially

till the source receives an ICMP echo reply message from the destination device. The

time-to-live (TTL) value is used in determining the number of intermediate devices that

the packets traverse before reaching the destination device.

You can use traceroute for ACX, M, MX, and PTX Series routers.

To start a traceroute from the selected device to another device in your network:

1. Select either IP or HostName in the Remote Host Details box.

2. Type the IPaddressorhostnamefor thedevice towhichyouwant tostarta traceroute.

3. Click Trace to use the default settings and start the traceroute or select the plus (+)

symbol to use the Advanced Options. The fields in Advanced Options are described

in Table 156 on page 1108.
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Table 156: Traceroute Advanced Options Field Descriptions

DefaultDescriptionField

Select a value fromthe
list.

Sends the Internet Control Message Protocol (ICMP) echo request packets on
the interface you specify. If youdonot specify this option, ICMPpackets are sent
on all interfaces.

Interface

30Indicates the time-to-live hop count for the ICMPecho request packets. Default
value is 30. Valid values are 1 through 255.

Time To Live

5Indicates the amount of time in seconds between echo requests. Default value
is 5. Valid values are 1 through 24.

Wait Interval

0Sets the type-of-service (ToS) field in the IP header of the echo packets. The
range of values is 0 through 255. If the routing platform does not support ToS,
the field is ignored.

Type of Service

Related
Documentation

• UnderstandingMonitorMode inViewsOther thanServiceViewofConnectivityServices

Director on page 1075
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CHAPTER 44

Monitor Reference

• Error Trend Monitor on page 1109

• Equipment Status Summary Monitor on page 1111

• Equipment Summary By Type Monitor on page 1112

• Port Status Monitor on page 1112

• Port Utilization Monitor on page 1114

• Status Monitor for Routers on page 1114

• Traffic Trend Monitor on page 1115

• Unicast vs Broadcast/Multicast Monitor on page 1115

• Unicast vs Broadcast/Multicast Trend Monitor on page 1116

• Session Trends Monitor on page 1117

• Current Sessions by Type Monitor on page 1119

• User Session Details Window on page 1119

• Current Active Alarms Monitor (All Views Except Service View) on page 1121

• Top Sessions by MAC Address Monitor on page 1122

• Top APs by Session Monitor on page 1123

• Radio Technology Type Statistics Monitor on page 1124

• Top Talker - Wired Devices Monitor on page 1125

• Top Users Monitor on page 1126

• Top APs by Traffic Monitor on page 1127

• Top Talker - Wireless Devices Monitor on page 1128

• RF Interference Sources Monitor for Devices on page 1129

Error TrendMonitor

The Error Trendmonitor displays inbound and outbound error trends on the node you

selected in the View pane. This monitor is available in the Traffic tab.

This topic describes:

• Error Trend on page 1110

• Error Trend Details on page 1110
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Error Trend

A line graph shows the rate inbound and outbound errors over time. The horizontal axis

shows the times when samples were taken. The vertical axis shows errors per second.

NOTE: After a device is discovered, trend data does not appear
immediately—it appears only after three polling periods have elapsed.

You can perform the following actions on the line graph:

• Change the time period over which to display the traffic trends by selecting a time

period from the list in the upper right corner.

• Highlight a line in the graph bymousing over the line’s legend.

• Remove or restore a line by clicking its legend.

• Display a numeric value by mousing over a data point.

Error Trend Details

The Error Trend details window displays detailed information about errors on the node

you selected in the View pane. It contains the following elements:

• A line graph shows the rate of errors over time. The horizontal axis shows the times

when samples were taken. The vertical axis shows errors.

NOTE: After a device is discovered, trend data does not appear
immediately—it appears only after three polling periods have elapsed.

You can perform the following actions on the line graph:

• Change the time period over which to display the traffic trends by selecting a time

period from the list in the upper right corner.

• Highlight a line in the graph bymousing over the line’s legend.

• Remove or restore a line by clicking its legend.

• Display a numeric value by mousing over a data point.

• Error Trend Details table—Shows detailed information about the data gathered at

each sample. For information about this table, see Table 157 on page 1111

• Error Trend Additional Details table—Shows additional error trend details and enables

you to display them on the graph. For information about this table, see

Table 158 on page 1111.
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Table 157: Error Trend Details Table

DescriptionColumn

Time when a data sample was taken from devices.Time

Number of inbound errors reported in the sample.Errors In

Number of outbound errors reported in the sample.Errors Out

Number of inbound cyclic redundancy check (CRC) errors reported in the sample.CRC Errors In

Number of outbound CRC errors reported in the sample.CRC Errors Out

Table 158: Error Trend Additional Details Table

DescriptionColumn

Name of the data series.Series Name

Value of the data series.Series Value

Select the check box to display the series on the graph. Clear the check box to remove
the series from the graph.

Show

Equipment Status SummaryMonitor

The Equipment Status Summarymonitor provides status highlights for the routers in the

current scope. Both the summary and details show up to five available fields.

Table 159 on page 1111 describes the fields in this monitor.

Table 159: Equipment Status Summary Fields

Default ViewFunctionField

Summary
Details

Indicates the type of device.Device

Summary
Details

Indicates howmany of the devices are up.Up

Summary
Details

Indicates howmany of the devices are down.Down

Summary
Details

Indicates if the controller cannot identify the device.Unknown

Summary
Details

Indicates if the device is disabled.Disabled
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Equipment Summary By TypeMonitor

The Equipment Summary By Typemonitor provides summary and detailed information

about the typeandnumberofdevices in thescopeselected in theViewpane.Thismonitor

is available on the Summary tab in Monitor mode.

Equipment Summary By Type

The summary view of the Equipment Summary By Typemonitor shows the distribution

of device types in the selected scope. Routers in a Virtual Chassis are counted separately

from standalone routers.

Mouse over a segment of the pie chart to see the actual number of devices of that type.

Click the details icon to open the Equipment Summary By Type Detail View window.

Equipment Summary By Type Details

The Equipment Summary By Type Detail View window provides details about the

distribution of device types in the selected scope. Each table row represents a device

type. Device types are defined by the combination of a device family, platform, and

operating system version (for some device types). See Table 160 on page 1112 for a

description of the table columns.

Table 160: Equipment Summary By Type Detail View

DescriptionTable Column

Device family.Device Family

Device platform.Platform

Operating system version running on the device.OS Version

Device type.Device Type

Number of devices of this platform in the selected scope.Count

Port StatusMonitor

The Port Status monitor provides summary and detailed information about the status

of the physical network interfaces for the selected node in the View pane.

If the selected node represents an individual device, the monitor displays data specific

to the ports on the device. If the selected node contains multiple devices, the monitor

displays data aggregated from all the ports on all the devices.

This topic describes:

• Port Status Summary on page 1113

• Port Status Details on page 1113
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Port Status Summary

The summary view of the Port Status monitor displays two pie charts:

• Admin Status–Of the interfaces on the selected node, shows the proportion of

interfaces that are administratively enabled and that are administratively disabled.

• Free vs Used–Of the network interfaces that are administratively enabled, shows the

proportion of interfaces that are in use (operationally up) and that are not in use

(operationally down).

Mouse over a pie segment to view the actual number of ports. Click the details icon to

open the Port Status Details window.

Port Status Details

The Port Status Details table provides details about the physical network interfaces for

the selected node, as shown in Table 161 on page 1113.

NOTE: Youmust have a transceiver installed in an SFP, SFP+, or XFP port
for information about the port to appear.

Table 161: Port Status Details Table

DescriptionField

The name of the physical interface.Port Name

For standalone devices, the first five groups of hexadecimal digits are determined when
the device is manufactured. The device then assigns a unique MAC address to each
interface by assigning a unique identifier as the last group of hexadecimal digits.

For Virtual Chassis members, the first four groups of hexadecimal digits are determined
when the switch is manufactured. The fifth group of hexadecimal digits reflects the role
of the member in the chassis, such as master or linecard.

MAC Address

The hardware serial number of the device.Serial Number

The hostname of the device.Host Name

A text description of the physical interface.Description

The actual operating speed of the port, in megabits per second (Mbps). Depending on
the results of autonegotiation, this speedmight be less than themaximum speed
supported by the port as indicated by port type.

Current Negotiated Speed (Mbps)

The speed configured for the port. If the speed is configured to be determined by
autonegotiation, the configured speed is shown as Auto.

Configured Speed

The duplex mode: full (full-duplex), half (half-duplex), or auto (autonegotiation).Duplex Mode

The port type (for example, 1 Gigabit Ethernet or 10 Gigabit Ethernet interface).Port Type
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Table 161: Port Status Details Table (continued)

DescriptionField

Indicates the administrative state of the port as or .
Admin Status

Indicates the operational status of the port as or .
Operational Status

Dateand timeatwhich theadvertised linkbecameunavailable, and then, availableagain.Last Flap Time

Port UtilizationMonitor

The Port Utilization Monitor displays a bar chart with information about the port traffic

utilization on the node selected in the View pane. Each bar in the chart represents the

port traffic utilization data gathered at a polling interval. The vertical axis shows the

number of ports polled. The horizontal axis shows the time when each poll was taken.

The data shown in the graph is aggregated from all the ports contained in the node

selected in the View pane.

Each bar is divided into the following colored sections to indicate the distribution of port

traffic utilization at the polling interval:

• Green indicates ports that operated at less than 50% of negotiated speed.

• Orange indicates ports that operated at between 50%and 80%of negotiated speed.

• Red indicates ports that operated at more than 80% of negotiated speed.

You can perform the following actions on the bar chart:

• Change the time period over which to display the data by selecting a time period from

the list in the upper right corner.

• Remove or restore a utilization category (bar color) by clicking its legend.

• Display a numeric value by mousing over a bar.

StatusMonitor for Routers

Thismonitorprovideskey informationabout thestatus forastandaloneswitchora router

when the device is selected in any of the views. This monitor is on the Equipment tab in

Monitor mode.

Table 162 on page 1114 describes the fields in this monitor.

Table 162: Status Monitor Fields

FunctionField

Indicates the hardware serial number of the device.Serial Number
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Table 162: Status Monitor Fields (continued)

FunctionField

Indicates the IP address of the device.IP Address

Indicates the amount of time since the last boot of the unit in days, hours, minutes,
and seconds.

Uptime

Indicates whether the device is up or down.Status

Indicates the number of MAC addresses in use on the device.Used MAC Addresses

Indicates the number of VLANmemberships for this device.Used VLANs

Indicates the date and time when the device was last configured.Last Configured Time

Indicates the ambient temperature (in degrees Celsius).Temperature (°C)

Indicates the version and release level of Junos OS running on the device.Junos Version

Traffic TrendMonitor

The Traffic Trendmonitor displays inbound and outbound traffic trends on the node you

selected in the View pane. This monitor is available in the Traffic tab. A line graph shows

the rate of each type of traffic over time. The horizontal axis shows the times when

samples were taken. The vertical axis shows the data rate, in packets per second.

NOTE: After a device is discovered, trend data does not appear
immediately—it appears only after three polling periods have elapsed.

You can perform the following actions on the line graph:

• Change the time period over which to display the traffic trends by selecting a time

period from the list in the upper right corner.

• Highlight a line in the graph bymousing over the line’s legend.

• Remove or restore a line by clicking its legend.

• Display a numeric value by mousing over a data point.

Unicast vs Broadcast/Multicast Monitor

TheUnicast vsBroadcast/Multicastmonitor displaysapie chart of thecurrentdistribution

of unicast, broadcast, andmulticast traffic types on the node you selected in the View

pane. This monitor is available in the Traffic tab.
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The traffic is divided into these categories:

• Unicast inbound

• Unicast outbound

• Broadcast inbound

• Broadcast outbound

• Multicast inbound

• Multicast outbound

Mouse over a pie segment to view the actual number of packets.

Unicast vs Broadcast/Multicast TrendMonitor

The Unicast vs Broadcast/Multicast Trendmonitor displays trends in the data rates of

unicast, broadcast, andmulticast traffic on the node you selected in the View pane. This

monitor is available on the Traffic tab. A line graph shows the rate of each type of traffic

over time. The horizontal axis shows the times when samples were taken. The vertical

axis shows the data rate, in packets per second.

NOTE: After a device is discovered, trend data does not appear
immediately—it appears only after three polling periods have elapsed.

The traffic is divided into these categories:

• Unicast inbound

• Unicast outbound

• Broadcast inbound

• Broadcast outbound

• Multicast inbound

• Multicast outbound

You can perform the following actions on the line graph:

• Change the time period over which to display the traffic trends by selecting a time

period from the list in the upper right corner.

• Highlight a line in the graph bymousing over the line’s legend.

• Remove or restore a line by clicking its legend.

• Display a numeric value by mousing over a data point.
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Session TrendsMonitor

The Session Trends monitor provides summary and detailed trend information about

the number of active sessions and users within the node selected in the View pane.

NOTE: After a device is discovered, trend data does not appear
immediately—it appears only after three polling periods have occurred.

• Session Trends on page 1117

• Session Details on page 1117

Session Trends

The summary view of the Session Trendsmonitor displays a line graph of the number of

active sessionsandusersover timewithin thenodeselected in theViewpane.Thevertical

axis is thenumberofactive sessionsorusers. Thehorizontal axis shows thepolling interval

times.

You can perform the following actions on the line graph:

• Change the time period over which to display the trend data by selecting a time period

from the list in the upper right corner.

• Select which SSID to monitor from the Choose SSID list.

• Select which VLAN tomonitor from the Choose VLAN list. This option appears only

when you have selected a switch in the View pane.

• Display thenumberof sessionsor users at apolling interval bymousingover theplotted

data point.

• Highlight a line in the graph bymousing over the line’s legend.

• Remove or restore a line by clicking its legend.

Because data points plotted against the x-axis can represent data consolidated from

multiple polling periods, three lines are plotted for session count and for user count: the

maximum, minimum, and average counts that occurred during the consolidated polling

periods.

Session Details

The Session Details window provides detailed trend information about the number of

active sessions and users within the current node selected in the View pane. It contains

these panes:

• The top pane contains a line graph of the number of active sessions and users over

time within the node selected in the View pane.
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You can perform the following actions on the line graph:

• Change the time period over which to display the trend data by selecting a time

period from the list in the upper right corner.

• Display the number of sessions or users at a polling interval by mousing over the

plotted data point.

• Highlight a line in the graph bymousing over the line’s legend.

• Remove or restore a line by clicking its legend.

Because data points plotted against the x-axis can represent data consolidated from

multiple polling periods, three lines are plotted for both session count and user count:

the maximum, minimum, and average session and user counts that occurred during

the consolidated polling periods.

• Thebottompane contains a tablewith detailed information about the active sessions.

The following table describes the columns that appear in current session details tables.

Table 163: User Session Details Table

DescriptionTable Column

Client’s user nameUser Name

Client’s MAC address.MAC Address

Client’s device type.Device Type

Client’s device group.Device Group

Client’s device profile.Device Profile

IP address of the controller to which the client is connected.Controller IP

ID of the wireless access point to which the client is connected.AP ID

Name of the wireless access point to which the client is connected.AP NAME

SSID to which the wireless client is connected.SSID

VLAN to which the client is connected.VLAN

Client’s IP address.Client IP

Authorization type used for the client.Auth Type

Bandwidth used by the client.B/w[KBps]

Data transmitted and received by the client, in kilobytes.Data Usage (KBytes)

Length of time the session has been active.Elapsed Time
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Table 163: User Session Details Table (continued)

DescriptionTable Column

Time when themost recent sample was taken.Sample Time

Receivedsignal strength indication (RSSI).Specified indecibels referred to 1milliwatt
(dBm). A higher value indicates a stronger signal.

RSSI

The time when the session roamed in to the wireless access point.Roam In Time

TIP: Some table columns are hidden by default. To select which columns to
display,mouseoveranycolumnheading, click thearrowthatappears,mouse
overColumns in thedrop-downmenu, and thenselect thecolumns todisplay

from the list.

Current Sessions by TypeMonitor

TheCurrentSessionsbyTypemonitor provides summaryanddetailed informationabout

the active sessions within the node selected in the View pane. This monitor is available

in the Client tab.

NOTE: If the selected scope is a single switch, thismonitor is namedCurrent
Sessions by VLAN, and shows the distribution of current sessions by VLAN.

• Current Sessions by Type on page 1119

• Current Session Details on page 1119

Current Sessions by Type

The summary view of the Current Sessions by Typemonitor shows a pie chart of the

active sessionswithin thenodeselected in theViewpane.Thechart shows thedistribution

of sessions by the session type. To change the session type shown in themonitor, select

from the Choose Sessions By Type list.

Current Session Details

To see detailed information about the sessions in the Current Sessionsmonitor, click the

Details button in the monitor title bar. The User Session Details window opens.

User Session DetailsWindow

The User Session Details window provides information about the active sessions within

the node selected in the View pane. To open this window, click the Details button in the

Current Sessions or Current Sessions by Typemonitors.

The following table describes the columns that appear in the user session details table:
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Table 164: User Session Details Table

DescriptionTable Column

Client’s user nameUser Name

Client’s MAC address.MAC Address

Client’s device type.Device Type

Client’s device group.Device Group

Client’s device profile.Device Profile

IP address of the controller to which the client is connected.Controller IP

ID of the wireless access point to which the client is connected.AP ID

Name of the wireless access point to which the client is connected.AP NAME

SSID to which the wireless client is connected.SSID

VLAN to which the client is connected.VLAN

Client’s IP address.Client IP

Authorization type used for the client.Auth Type

Bandwidth used by the client.B/w[KBps]

Data transmitted and received by the client, in kilobytes.Data Usage (KBytes)

Length of time the session has been active.Elapsed Time

Time when themost recent sample was taken.Sample Time

Receivedsignal strength indication (RSSI).Specified indecibels referred to 1milliwatt
(dBm). A higher value indicates a stronger signal.

RSSI

The time when the session roamed in to the wireless access point.Roam In Time

TIP: Some table columns are hidden by default. To select which columns to
display,mouseoveranycolumnheading, click thearrowthatappears,mouse
overColumns in thedrop-downmenu, and thenselect thecolumns todisplay

from the list.
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Current Active AlarmsMonitor (All Views Except Service View)

TheCurrent ActiveAlarmsmonitor showsany active alarm that has not yet been cleared.

It is one of the four standard monitors available in Alarmmode. Current Active Alarms is

a table that has four fields and appear by default. However, nine fields are available for

selection. View Table 165 on page 1121 for a description of the table.

Table 165: Current Active AlarmsMonitor

Shown in
DetailedView
by Default

Shown in
Summaryby
DefaultDescriptionTable Column

YesYesThe alarm name.Name

NoNoA system and sequentially-generated identification number.ID

YesNoIf assigned to an individual, it shows the name of the person
assigned; otherwise, it shows System tomark that the alarm
is still unassigned.

Assigned To

YesYesThe severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is
necessary.

• Major—Amajor error has occurred; escalate or notify as
necessary.

• Minor—Aminor error has occurred; notify or monitor the
condition.

• Info—An informational message; no action is necessary.

Severity

YesYesThe identification of the entity responsible for causing this
alarm. The Entity ID is the key for correlation of events into
an alarm. The Entity ID could be a MAC address of a radio or
an IP address of the device.

Entity ID

NoNoThe IP address of the device or network element that
generated thealarm.TheSNMPagent is locatedat the source
IP. Inmost cases, the source IP is the IP address of the switch
or controller.

Source

YesYesThe hostname or IP address of the reporting device.Reporting Device

NoNoThe date and time the alarmwas first reported.Creation Date

YesYesThedate and time that the information for the alarmwas last
modified.

Last Updated

NoNoEither the system or the last user whomodified the alarm.Updated By

Clicking the Details icon opens Alarm Details where you can sort and disposition alarms

by state (Acknowledged, Clear, Active).
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Top Sessions byMACAddress Monitor

The Top Sessions by MAC Address monitor provides summary and detailed information

about the sessions within the node you selected in the View pane that use the most

bandwidth. This monitor is available in the Client tab.

Thismonitor includes onlywireless network sessions, not sessions onwired connections.

If the node you selected in the Viewpane contains onlywired sessions, thismonitor does

not appear. If the node contains both wired and wireless sessions, only the wireless

sessions appear in the monitor.

This topic describes:

• Top Sessions on page 1122

• Top Session by MAC Details on page 1122

Top Sessions

The summary view of the Top Sessions by MAC Address monitor displays a bar chart of

the sessions within the node you selected in the View pane that consume themost

bandwidth. Thevertical axis shows thesessionMACaddresses. Thehorizontal axis shows

different information depending on the time period you select in the list in the title bar:

• If you select theCurrent timeperiod, thehorizontal axis shows the session’s incremental

data usage.

• If you select any timeperiod other thanCurrent, the horizontal axis shows the session’s

total data usage.

You canmouse over a bar to seemore information about that session. You can select

which SSID to monitor from the Choose SSID list.

Top Session byMACDetails

The Top Session by MAC Details window displays detailed information about the top

sessions within the node you selected in the View pane.

To change the number of top sessions displayed, select a number from the Top N list in

the upper right corner.

To change the time period for which data is shown, select a time period from the time

period list. By default, the Current time period is selected. When Current is selected, the

data from themost recent polling period is shown. When any time period other than

Current is selected, the data for the entire selected time period is shown.

The following table describes the columns that appear in Top Sessions by MAC Details

table.
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Table 166: Top Session Details Table

DescriptionTable Column

Client’s user name

To copy the text in this table cell: Click the cell, highlight the text, right-click the cell,
and select Copy from the context menu.

User Name

Client’s MAC address.

To copy the text in this table cell: Click the cell, highlight the text, right-click the cell,
and select Copy from the context menu.

MAC Address

Number of sessions.Number of Sessions

Name of the wireless access point to which the client is connected.AP Name

ID of the wireless access point client is connected to.AP ID

The session’s current incremental data usage. Appears only when the Current time
period is selected.

Incremental Data Usage (KBytes)

The session’s total data usage. Appears when any time period other than Current is
selected.

Total Data Usage (KBytes)

Top APs by SessionMonitor

The Top APs by Session monitor provides summary and detailed information about the

wireless access pointswith themost active sessionswithin the node selected in theView

pane. This monitor is available in the Client tab.

• Top APs by Session Summary on page 1123

• Top APs by Session Details on page 1123

Top APs by Session Summary

The summary viewof the TopAPs bySessionmonitor displays a bar chart of thewireless

access points with the most active sessions within the node selected in the View pane.

The wireless access points are shown on the vertical axis. The number of sessions is

shown on the horizontal axis.

Top APs by Session Details

To see detailed information about the top wireless access points by sessions, click the

Details button in themonitor title bar. Table 167 on page 1123 describes the information in

the Top APs by Sessions window.

Table 167: Top APs by SessionsWindow

DescriptionColumn

Wireless access point name.AP Name
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Table 167: Top APs by SessionsWindow (continued)

DescriptionColumn

Wireless access point serial number.Serial Number

Wireless controller that controls the wireless access point.WLC Controller

Location of the wireless access point.Location

Number of active sessions on the wireless access point.Number of Sessions

Wireless access point bandwidth.Bandwidth (KBytes)

Radio Technology Type Statistics Monitor

TheRadioTechnologyTypeStatisticsmonitorprovidessummaryanddetailed information

about the usage of radio technology types within the node selected in the View pane.

This monitor is available on the Summary tab in Monitor mode.

• Radio Technology Type Statistics Summary on page 1124

• Radio Technology Type Statistics Details on page 1125

Radio Technology Type Statistics Summary

The summary view of the Radio Technology Type Statistics monitor shows summary

information about the usage of radio technology types within the node selected in the

View pane. Select the category of information to show from the Tech Type Params By

list box at the bottom of the monitor. Table 168 on page 1124 describes the information

shown for each category.

Table 168: Radio Technology Type Statistics Summary Categories

DescriptionCategory

Shows a pie chart of the distribution of radio technologies among the active sessions. You
canmouse over the slices of the pie chart to see additional information.

Sessions by Technology Type

Shows a pie chart of the distribution of radio technologies among the active users. A user
is an account that authenticates to get network access. A user can havemultiple active
sessions by using multiple network devices with the same account. You canmouse over
the slices of the pie chart to see additional information.

Users by Technology Type

Shows a bar chart of the signal-to-noise ratio (SNR) of the current sessions. Select the
radio technology type to show from the list to the left of the chart. The chart shows the
number of sessions on the vertical axis and the SNR on the horizontal axis. The average
SNR of all sessions on the chart is shown below the chart.

Average SNR by Technology Type

Shows a pie chart of the percentage of wireless bandwidth used by each radio technology.
Mouse over the slices of the pie chart to see additional information.

Bandwidth Usage by Technology
Type
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Table 168: Radio Technology Type Statistics Summary Categories (continued)

DescriptionCategory

Showsabar chart of theamountof timeeach radio technology typehasbeencontinuously
active on the network.

Amount of Time (last 10 min)

Radio Technology Type Statistics Details

To see detailed information about the radio technology type statistics, click the Details

button in themonitor titlebar. Table 169onpage 1125describes the information in theThe

Radio Type Statistics window.

Table 169: Radio Type StatisticsWindow

DescriptionColumn

Radio technology type.Tech Type

Number of sessions using the radio technology type.No. of Sessions

Number of users using the radio technology type.No. of Users

Percentage of users using the radio technology type.Users Percentage

Bandwidth used by the radio technology type.Bandwidth Usage

Percentage of bandwidth used by the radio technology type.Bandwidth Percentage

Amount of time during the polling period when at least one session using that radio
type was active. Themaximum amount is the length of the polling period.

Time Amount

Percentage of time during the polling period when at least one session using that
radio type was active.

Time Percentage

Average SNR for the radio technology type.Average SNR

Top Talker -Wired Devices Monitor

The Top Talker - Wired Devices monitor provides summary and detailed information

about the wired devices that are using the most bandwidth.

• Top Talker - Wired Devices Summary on page 1125

• Top Talker - Wired Devices Details on page 1126

Top Talker -Wired Devices Summary

The summary view of the Top Talker -Wired Devicesmonitor has a bar chart that shows

summary informationabout thewireddevices thatareusing themostbandwidth.Device

names or addresses are listed on the vertical axis. Data usage in kilobytes is shown on

the horizontal axis. You canmouse over a bar to seemore information about that device.
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Top Talker -Wired Devices Details

To see detailed information about the top talkers, click the Details button in the monitor

title bar. The Top Talker - Wired Devices monitor details window has a table containing

detailed information about the devices that are using the most bandwidth.

Table 170 on page 1126 describes the columns in the table. To close the details page, click

theMinimize button in the title bar.

Table 170: Top Hosts Monitor Details

DescriptionColumn

Host’s host name.Host Name

Host’s MAC addressMAC Address

Data used by the host, in kilobytes.Data Usage (KBytes)

Device’s serial number.Device Serial Number

Top Users Monitor

The Top Users monitor provides summary and detailed information about the users

within thenode you selected in theViewpane that use themost bandwidth. Thismonitor

is available on the Client tab.

This monitor includes only wireless network users, not users on wired connections. If the

node you select in theViewpane contains onlywired users, thismonitor does not appear.

If the node contains both wired and wireless users, only the wireless users appear in the

monitor.

This topic describes:

• Top Users on page 1126

• Top Session By User Details on page 1127

Top Users

The summary view of the Top Users monitor displays a bar chart of the top bandwidth

users within the node you selected in the View pane. The vertical axis shows the user

names. The horizontal axis shows different information depending on the time period

you select in the list in the title bar:

• If you select the Current time period, the horizontal axis shows the user’s incremental

data usage.

• If you select any time period other than Current, the horizontal axis shows the user’s

total data usage.

You canmouse over a bar to seemore information about that user. You can select which

SSID to monitor from the Choose SSID list.
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Top Session By User Details

The Top Session By User Details window displays detailed information about the top

users within the node you selected in the View pane.

To change the number of top users displayed, select a number from the Top N list in the

upper right corner.

To change the time period for which data is shown, select a time period from the time

period list. By default, the Current time period is selected. When Current is selected, the

data from themost recent polling period is shown. When any time period other than

Current is selected, the data for the entire selected time period is shown.

The following table describes the columns that appear in Top Session By Users Details

table.

Table 171: Top Session Details Table

DescriptionTable Column

Client’s user name

To copy the text in this table cell: Click the cell, highlight the text, right-click the cell,
and select Copy from the context menu.

User Name

Client’s MAC address.

To copy the text in this table cell: Click the cell, highlight the text, right-click the cell,
and select Copy from the context menu.

MAC Address

Number of sessions.Number of Sessions

Name of the wireless access point to which the client is connected.AP Name

ID of the wireless access point client is connected to.AP ID

The session’s current incremental data usage. Appears only when the Current time
period is selected.

Incremental Data Usage (KBytes)

The session’s total data usage. Appears when any time period other than Current is
selected.

Total Data Usage (KBytes)

Top APs by Traffic Monitor

The Top APs by Traffic monitor provides summary and detailed information about the

wireless access points with the most traffic within the node selected in the View pane.

This monitor is available on the Summary tab.

• Top APs by Traffic Summary on page 1128

• Top APs by Traffic Details on page 1128
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Top APs by Traffic Summary

The summary view of the Top APs by Traffic monitor displays a bar chart of the wireless

accesspointswith themost trafficwithin thenodeselected in theViewpane.Thewireless

access points are shown on the vertical axis. The traffic is shown on the horizontal axis.

Top APs by Traffic Details

To see detailed information about the top wireless access points by traffic, click the

Details button in themonitor title bar. Table 172 on page 1128 describes the information in

the Top APs by Traffic Details window.

Table 172: Top APs by Traffic DetailsWindow

DescriptionColumn

Wireless access point name.AP Name

Wireless access point serial number.Serial Number

Wireless controller that controls the wireless access point.WLC Controller

Location of the wireless access point.Location

Number of active sessions on the wireless access point.Number of Sessions

Wireless access point bandwidth.Bandwidth (KBytes)

Top Talker -Wireless Devices Monitor

The Top Talker-Wireless Devices widget provides summary and detailed information

about the top client device types that are generating wireless network traffic. Device

typescorrespond to theplatformoroperating systemof thedevice, for example,Windows

or Android.

This topic describes:

• Top Talker-Wireless Devices Summary on page 1128

• Top Talker-Wireless Devices Details on page 1129

Top Talker-Wireless Devices Summary

The summary view of the Top Talker-Wireless Devices monitor has a bar chart showing

summary information about the top client device types that are generating wireless

network traffic. Device types are listed on the vertical axis. Data usage in kilobytes is

shown on the horizontal axis. You canmouse over a bar to seemore information about

it, including the number of devices of that type.
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Top Talker-Wireless Devices Details

To see detailed information about the Top Talker-Wireless Devices, click the Details

button in the monitor title bar. The Top Talker-Wireless Devices monitor details window

has a table containing detailed information about the top client device types that are

generating wireless network traffic. Table 173 on page 1129 describes the columns in the

table.

Table 173: Top Talker-Wireless Devices DetailsWindow

DescriptionColumn

Number of devices of the device type.Number of Device(s)

Device type.Device Type

Data used by devices of the device type, in kilobytes.Data Usage (KBytes)

RF Interference SourcesMonitor for Devices

TheRF InterferenceSourcesmonitor forwirelessdevices consists of a summarypie chart

that reflects all wireless traffic experienced by the object selected in the View pane. You

can select any one of the objects listed in Table 174 on page 1129 in the view pane:

Table 174: Wireless ObjectsWith Interference Tracking

ObjectIcon

Entire Wireless Network in any view.

Wireless Mobility Domain in any view.

Controller Cluster in any view.

NOTE: You cannot see interference for a single controller.

Individual access point in any view.

Individual radio in any view.

Selecting a floor in logical view displays all access points on that floor.

Selecting a building in logical view displays all access points in that building.

Selecting a site from the logical view displays all access points in that building.
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Table 174: Wireless ObjectsWith Interference Tracking (continued)

ObjectIcon

Wiring closet—to create a wiring closet.

Connectivity Services Director tracks andmonitors interference from these sources:

• Microwave ovens—Most domestic microwave ovens use 2.45 GHz, and can interfere

withWi-Fi channels from8 to 10 (or even 7 to 11). Interference varies depending on the

model of the oven—for example, commercial restaurantmicrowave ovens sweep over

a wider spectrum and have a higher duty cycle.

• Continuous wave devices continuously transmit at a particular frequency without

attempting to share the radio frequency mediumwith other devices. Devices that use

continuous wave technology in the same frequency bands as wireless LAN networks

will interferewithwireless communications, reducingperformanceor totally preventing

communication. Several examples of devices that may use continuous wave

transmission that interferes withWi-Fi are video surveillance cameras and baby

monitors.

• Bluetooth devices

• Phone FHSS from cordless phones

• Unknown devices

To track thesedevices, ConnectivityServicesDirector polls the controllers at the standard

interval. The categories with the largest sections of the pie chart cause the most

interference.

You can perform the following actions on the pie chart:

• Change the time period over which to display interference by selecting a time period

from the list in the upper right corner.

• Display a numeric value for interference occurrences by mousing over a section of the

chart.

• Click the monitor’s title to see a list of interfering objects along with the information

listed in Table 175 on page 1130.

Table 175: Information on RF Interference Sources for a Radio

DescriptionInformation

Date and time the interference was last detected.Last Seen

If the interference is caused by an object with a MAC address, the MAC address is
displayed. If the object has no MAC address, MSS calculates a MAC address, using the
characteristics of the object. This way, you can correlate interference events over time.

Transmitter ID

MAC address of the access point that detected the interference.Listener MAC
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Table 175: Information on RF Interference Sources for a Radio (continued)

DescriptionInformation

Name of the access point that detected the interference.AP

Name of the controller that reported the interference.Controller

Channel the interference affected.Channel

Received signal strength indication (RSSI), in decibels referred to 1 milliwatt (dBm). A
higher value indicates a stronger signal.

RSSI

Reported fraction of time that the source is emitting RF.Duty Cycle

Possible sources of interference include Bluetooth, ContinuousWave, Microwave Oven,
Unknown, and Phone FHSS.

Source Type

Estimated severity of interference on this channel caused by the source.CIM (%)

Interference is frequently not a problem on wireless networks with light traffic, but as

traffic becomes heavier, throughput and capacity decrease and other problems become

apparent. RF interference can causepacket retransmission. Interference is also a security

concern because jamming can bring down the network .

Ideally, interference retransmission does not causemore than 10% of the total number

of packets sent. If your retransmission percentage is higher, you can try to lower it by:

• Locating and eliminating offending devices. If the item cannot be removed, you can

add electromagnetic interference (EMI) shielding such as groundedmesh, foils,

insulating foams, or insulating paint. This will limit the interference to a small area.

• Movingclients to channelswith less interference. Keep inmind, however, thatBluetooth

devices, cordless phones, 802.11FH devices, and jamming emissions are broadband,

so it's not possible to change channels away from them—they are everywhere in the

band.
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CHAPTER 45

Detecting and Examining the Health and
Performance of Services

• Service Monitoring Capabilities in Connectivity Services Director on page 1134

• Computation of Statistics Polled from Devices for Display inWidgets on Monitoring

Pages on page 1135

• Configuring the Aggregation Method for Viewing Monitoring Details on page 1136

• Viewing the Service Monitoring Summary Page for a Consolidated Listing of

Services on page 1138

• Monitoring the Service Summary Details of E-Line Services for Optimal

Debugging on page 1140

• Monitoring the Service Summary Details of E-LAN Services for Optimal

Debugging on page 1143

• Monitoring the Service Summary Details of IP Services for Optimal

Debugging on page 1146

• Monitoring the Service Traffic Statistics of E-Line Services for Correlating Device

Counters on page 1149

• Monitoring the Service Traffic Statistics of E-LAN Services for Correlating Device

Counters on page 1152

• Monitoring the Service Traffic Statistics of IP Services for Correlating Device

Counters on page 1154

• Monitoring theServiceTransportDetailsofE-LineServices forEasyAnalysisonpage 1156

• Monitoring theServiceTransportDetailsofE-LANServices forEasyAnalysisonpage 1159

• Monitoring the Service Transport Details of IP Services for Easy Analysis on page 1162

• Viewing Y.1731 Performance Monitoring Statistics for E-Line Services on page 1166

• Viewing Y.1731 Performance Monitoring Statistics for E-LAN Services on page 1168

• Clearing Interface Statistics on page 1171

• Viewing MAC Table Details on page 1173

• Viewing Interface Statistics on page 1174

• Viewing Interface Status Details on page 1176

• MPLS Connectivity Verification and Troubleshooting Methods on page 1178
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• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185

• Routing Table Overview on page 1187

• Viewing Routing Table Details on page 1187

Service Monitoring Capabilities in Connectivity Services Director

In a network environment, a network administrator, operator, or a supervisor must be

able to quickly and easily monitor the health (working condition), operating efficiency,

traffic-handlingcapacity, andperformancestatusof themanageddevicesandconfigured

services to be able to take corrective action and restoration measures in case of device

alarms, overload conditions, or traffic drops. Using theMonitormode of the Connectivity

Services Director application, you canmonitor the managed services on devices, and

collect and store the information from the devices in the Connectivity Services Director

application database. Themonitors or widgets are displayed to enable you to track,

diagnose, and rectify discrepancies associated with services configured on devices. The

information is displayed in easy-to-understand graphs and in tables that you can sort

and filter, allowing you to quickly visualize the state of your network, spot trends

developing over time, and find important details.. For example, youmight observe that

an IP service is reported as down from the summarized information presented for that

serviceon themonitoringpage.Thishigh-level viewenables you tonavigate to thesettings

for that service and fine-tune to function properly.

The following tabs are displayed when you click the Monitor icon in the Service View of

the Connectivity Services Director banner.

• ServiceSummary—Displays the consolidated and cumulative status of a service. This

tab is applicable for E-Line, IP, and E-LAN services. The Connectionsmonitor show the

status of the connection or link (up or down) between peer devices. In the table

displayed for thismonitor, the row represents thesourcedeviceand thecolumndenotes

thedestinationdevice. The statusof the link is displayed for E-LineandE-LANservices.

The Traffic Summarymonitor represents the total Egress (Packets out) traffic passing

through all the UNI or CE interfaces that are part of the cumulative services. It is

displayed for E-Line (P2P), IP (L3VPN), and vE-LAN (VPLS) services. The Current

Active Alarmsmonitor shows any active alarm that has not yet been cleared

• ServiceTransport—Displays the transport or packet statistics for data against time

between the source and destination devices that you select, and based on the LSP

that is used by the endpoint. The source device is the row selected in the Connection

Matrix widget on the Service Transport tab. The destination device is chosen from the

TrafficStatisticswidgeton theServiceTransport tab.Bydefault, nodestinationdevices

are selected. Service transport statistical values are displayed for E-Line, E-LAN, and

IP services.

• ServiceTraffic—Displays the end-to-end trafficmatrix that signifies the traffic between

peer devices. You can view statistical counters andmetrics for input packets, input

bytes, output packets, and output bytes. The Interface Statisticsmonitor shows traffic
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data on all the user-to-network interfaces (UNI) or site interfaces that are part of the

service. These values are on-demand statistical values and the data is retrieved from

the device directly without being cached (polling at periodic intervals and displaying

a snapshot). This tab is supported for E-Line, E-LAN, and IP services. The data is

available only if queues are enabled on the interface.

• ServicePerformance—Displays frame delay, frame loss, frame delay variation, and

service availability. These measurements are achieved by triggering a one-way delay,

two-waydelay, or lossTheperformancemeasurement is useful for generating periodic

service-level agreement conformance reports from the deployed network and for

studying traffic patterns in the network over a period of time. In proactive mode, SLA

measurements are triggered by an iterator application. An iterator is designed to

periodically transmitSLAmeasurementpackets in formof ITU-Y.1731-compliant frames

for two-way delay measurement or loss measurement for each of the connections

registered to it. Iteratorsmake sure thatmeasurement cycles do not occur at the same

time for the sameconnection toavoidCPUoverload.The iterator profilesare configured

on remote MEP for measurement of Ethernet frame delay measurement (ETH-DM),

Ethernet frame loss measurement (ETH-LM), and statistical frame loss (SFL).

• LSP Summary—Displays a comprehensive and cohesive view about the configured

LSP service. The status of the LSP and the status of connections between the ingress

router and egress routers in an LSP are displayed. The LSP status details are shown

for the ingress router. Youcanalsoviewthe ingress, egress, and transit LSP information,

such as the primary and secondary states.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

Related
Documentation

Configuring the Aggregation Method for Viewing Monitoring Details on page 1136•

Computation of Statistics Polled fromDevices for Display inWidgets onMonitoring
Pages

To interpret the statistical details and counters displayed in the charts and tables of the

monitoring pages and in the tabular layouts, it is essential to understand themanner in

which the metrics and values are retrieved from the devices and displayed in the GUI

pages. In the charts, the time intervals are shown along the x-axis and data points or

values of a particular attribute are shown along the y-axis. On the y-axis, the counter

value displayed is the differential value between two polling intervals or the aggregated

interval. For example, for the inputpacketsofan interface,Table 176onpage 1136describes

the mapping between polled and counter values.
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Table 176: Mapping Between Polled Values and Counter Values Displayed in the GUI

456840456840456825456800456789Polling value from devices

0152511–Counter value shown on the charts and
tables

If the number of data points available between two intervals is more than one, the data

is aggregated. The aggregation is based on theConnectivity ServicesDirector application

settings that youconfigureaspreferences.Oneof the following typesof statisticalmetrics

can be viewed:

• Total—Sum of the number of packets in a specific time period

• Average—Average of the total number of packets in a specific time period

For example, for the input packets for an interface, the values described in

Table 177 on page 1136 illustrate the manner in which the differential values of counters

are calculated for different time periods, based on the polling intervals that are used to

retrieve details from the devices.

Table 177: Computation of Counters Using Polling Intervals

11:4511:3011:1511:0010:4510:30StartPolling Time

640625590575555550525Polling Counter Value

15351520525–Packets Per Interval

11:4511:1510:45–Time Interval

251815–Counter Value
(Average)

504550–Counter Value (Total)

The number of actual data points varies between theminimum andmaximum number

of values, based on polling period and data availability. For the time values shown on the

graph, the end time indicated is the time at which the last polling or retrieval of data

occurred on the device. The interval between two data points is computed by using the

total duration for which statistics is displayed by subtracting the period from the end

time. The start time displayed is based on the number of intervals calculated by clocking

backward from the end time.

Related
Documentation

Configuring the Aggregation Method for Viewing Monitoring Details on page 1136•

Configuring the AggregationMethod for ViewingMonitoring Details

On the pages in Monitor mode of the Connectivity Services Director GUI that display

statistical information and counters for traffic flow and packets across peer devices for
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various services and device configuration settings, you can select the aggregation or

cumulative method that must be used for computing and displaying statistics. You can

also modify the application settings to display the aggregation of traffic.

The following two aggregation values are supported:

• Total—Sum of the number of packets received in the interval

• Average—Average of the total number of packets received in the interval

You can set the aggregation method from the Junos Space Platform GUI or the

Connectivity Services Director GUI.

To configure the aggregation method from the Junos Space Platform GUI:

1. From the Network Management Platform task pane, select Administration >

Applications.

The Applications page that appears displays a list of the applications in the Network

Management platform.

2. Right-click Connectivity Services Director and selectModify Applications Settings.

The Modify Application Settings page that appears displays a list of the parameters

that can bemodified.

3. Click theMonitoring button to specify the settings.

NOTE: You cannot modify the application settings if another user is
currently modifying them.

4. Select the PerformMonitoring on failed Functional Audit check box if you want the

monitoring functionality to be enabled for services for which functional audit failed.

Otherwise, monitoring data is displayed in the widgets in Monitor mode of Service

View only on services for which functional audit succeeded.

5. In the Pseudowire Redundancy Transition TimeDelay field, specify the number of

minutes after which a remote procedure call (RPC)must be sent from Connectivity

Services Director to the device on which redundant pseudowires are configured for

monitoring data to be collected.

By default, an RPC call is initiated every 2 minutes.

6. From the Statistics Aggregation Reporting list, select Total or Average.

The value of the aggregationmethoddetermines themanner inwhich the aggregated

results are returned for a query that polls and retrieves data from devices.

7. ClickModify to save the changes that youmade in the Connectivity Services Director

application. Alternatively, click Cancel to retain the original settings.

The aggregation method setting is modified.
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To configure the aggregation method from the Connectivity Services Director GUI:

1. To open the Preferences page, click the down arrow next to the System button on the

Connectivity Services Director banner and select Preferences.

The Preferences page opens with User Preferences as the default tab.

2. Click the Service Activation tab.

The settings that you can configure for services activation are displayed.

3. From the Statistics Aggregation Reporting list, select Total or Average.

The aggregation method that you specified is used for computation of values on the

monitoring pages.

4. ClickOK to save the changes. Alternatively, click Cancel to discard the changes.

The aggregation method setting is saved.

NOTE: For the charts and tables displayed in Monitor mode of Service
View, you can specify the polling interval and enable or disable the
following collectors:

• ProvisioningMonitorInterfaceStatusCollector—Defines the polling
interval for monitoring the interface status

• ProvisioningMonitorInterfaceStatsCollector—Defines thepolling interval
for monitoring the interface statistics

• ProvisioningMonitorServiceStatusCollector—Defines thepolling interval
for monitoring the service status

• ProvisioningMonitorLDPStatsCollector—Defines the polling interval for
monitoring the LDP statistics

• ProvisioningMonitorY1731PMCollector—Defines the polling interval for
monitoring the performancemanagement or Y.1731 statistics

• ProvisioningMonitorLSPStatsCollector—Defines the polling interval for
monitoring the LSP statistics

Related
Documentation

Service Monitoring Capabilities in Connectivity Services Director on page 1134•

• Configuring the Aggregation Method for Viewing Monitoring Details on page 1136

Viewing the Service Monitoring Summary Page for a Consolidated Listing of Services

The Service Monitoring Summary page displays a consolidated view of all of the service

instances for a particular service type. The customer associated with the service, type of

service, service definition uponwhich the service order is based, the traffic rate in bits per

second, and the traffic trend are displayed.
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NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

To view the Service Monitoring Summary page:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theDeploy iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the IP Services tree to select an IP Ethernet service.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

The Service Monitoring Summary page is displayed, if you do not select a particular

service from the Service View pane and select the E-Line Services, IP Services, or

E-LAN Services term in the Service View pane.

5. Click the ServiceSummary tab.

The Service Monitoring Summary page is displayed.

The following fields are displayed on this page:

• Name—Name of the configured service. Select the corresponding service from the

Network Services > Connectivity tree on the View pane to navigate to the Service

Summary page.

• Customer—Name of the customer associated with the service.

• Type—Service type, such as E-Line, IP, or E-LAN.

• Service Definition—Name of the service definition that is used to create the service.

• Status—Whether the status is up or down. NA indicates that the status is not

available for the corresponding service.
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• UNIs up/down—Number of user-to-network (ingress) interfaces that are in the up

and down states.

• Traffic (bps) max/min/avg—Maximum, minimum, and average rates of traffic

handled by the service in bits per second (bps).

• Traffic Trend (bps)—Line graph that signifies the rate of egress packets (packets

that are sent out from an interface) in bps.

6. Select the service name from the Network Services > Connectivity tree on the View

pane to view detailed information about the corresponding service.

The Service Summary page for the corresponding service is displayed.

You can view the consolidated and cumulative status or different types of services on

the following tabs:

• ServiceSummary tab for E-Line services—Displays the consolidated service status for

E-Line services

• ServiceSummary tab for E-LAN services—Displays the consolidated service status for

E-LAN services

• ServiceSummary tab for IP services—Displays the consolidated service status for IP

services

Related
Documentation

Monitoring the Service Summary Details of E-Line Services for Optimal Debugging on

page 1140

•

• Monitoring the Service Summary Details of E-LAN Services for Optimal Debugging on

page 1143

• Monitoring the Service Summary Details of IP Services for Optimal Debugging on

page 1146

Monitoring the Service Summary Details of E-Line Services for Optimal Debugging

YoucanviewtheServiceSummarypageofaparticular service todisplay theconsolidated

and cumulative status of a service. The overall information pertaining to the service that

you can obtain from the differentwidgets displayed on this page enables you to navigate

to theappropriatedeviceor servicesettingspageandmodify theconfigurationparameters

appropriately. You can view the connection between the different endpoints and also

examine the statistics on the packets and bytes traversing through the endpoints. Using

the Service Summary page, you can also select the source device for which you want to

viewthe transportmetricsand the traffic statisticson theotherpagesdisplayed inMonitor

mode for the specific service. This page enables you to obtain an effective graphical view

in the formof tablesof statisticsandcharts to view thehealthandperformanceofdevices

and services in your network, which enables you to analyze and troubleshoot the

parameters that are causing traffic-handling errors.
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NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

To view the Service Summary page for E-Line services:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor icon in theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

5. Expand the E-Line Services tree to select an E-Line service.

6. Fromthemaindisplayarea, click theServiceSummary tab.TheServiceSummarypage

is displayed.

NOTE: The Service Monitoring Summary page is displayed, if you do not
select a particular service from the Service View pane and select the E-Line
Services term in the Service View pane. The Summary page displays a
consolidated view of all of the service instances for a particular service type.
The customer associated with the service, type of service, service definition
upon which the service order is based, the traffic rate in bits per second, and
the traffic trend are displayed. Select the corresponding service from the
Network Services > Connectivity tree on the View pane to navigate to the
Service Summary page.

• Service Status on page 1142

• Connections on page 1142

• Traffic Summary on page 1143

• Section on page ?
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Service Status

This widget displays the cumulative, consolidated status of services, such as E-Line. The

following fields are displayed in a tabular form in this widget:

• Name—Name of the service.

• Type—Protocol configured for the service, such as ELINE, E-LAN, or IP

• Status—Whether the service is up or down.

• PEs (Up/Down)—Number of provider edge devices that are in the up and down states

• UNIs (Up/Down)—Number of user-to-network (ingress) interfaces that are in the up

and down states

• OSPF Neighbors—Number of OSPF neighbors

• BGP Neighbors—Number of BGP neighbors

• Local Switch—Whether the local switching mode to terminate multiple Layer 2 circuit

pseudowires is configured.

• Y1731 Status—Whether the connectivity faultmanagement (CFM) profile is configured

for the service and whether Y1731 performancemonitoring (PM) statistics collection,

such as one-way delaymeasurement and variation, two-way delaymeasurement and

variation, or loss measurement are configured.

Click Refresh at the top of the monitor to update and display the contents of the table.

TheService Statusmonitor is also applicable for an E-Line servicewith any one endpoint

as an unmanaged device. For an E-Line service, with unmanaged devices, the overall

service status, PEs up/down, UNIs up/down, that are based on polling of only managed

devices are displayed.

Connections

Thismonitor shows the status of connections between peer devices. In the tabular view,

the row represents the source device and the columns denote the neighboring and

destination devices. A green up-arrow in the indicates that the adjoining device in the

network path to the destination device is operationally up. A red down-arrow indicates

that the device is down. For the device for which the connection status is displayed, a

value of NA is displayed under its own corresponding column to denote that it is not

applicable. Click Refresh at the top of themonitor to update and display the contents of

the table.

One of the following values is displayed on the columns that denote the adjacent and

destination devices or endpoints:

• PR—Peer Device or Primary-Backup Pair. No Connection such as A/A or Z/Z.

• PBK—Peer Backup. No Connection.
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• OL—Noadvertisementhasbeen received for this virtual circuit fromtheneighbor. There

is no outgoing label available for use by this virtual circuit.

• NA—Not available.

Mouse over the cells in the table to display the description of the connection statuses,

such as PR, PBK or NA.

With an E-Line service that contains an unmanaged endpoint, the Connections matrix

represents the status frommanaged to unmanaged devices, based on themanaged

device polling. The connection status from unmanaged tomanaged is always displayed

as NA.

Traffic Summary

This widget displays the total number of egress packets (packets that are sent out) or

traffic passing through all the UNI or customer-edge (CE) interfaces associatedwith the

particular service. This monitor is applicable for E-Line services. The date and time at

which the page was last updated is shown. A line graph is displayed with time on the

horizontal axis and the number of output packets on the vertical axis.

From the Time Interval drop-down box, select 1 Hour, 8Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). ClickOK to save the settings. Else,

click Cancel to discard the configuration.

For an E-Line service with one endpoint as an unmanaged device, the Traffic Summary

monitor represents the total egress traffic trendofonly themanageddevices.Unmanaged

device traffic is not monitored.

Related
Documentation

Viewing the Service Monitoring Summary Page for a Consolidated Listing of Services

on page 1138

•

• Monitoring the Service Summary Details of E-LAN Services for Optimal Debugging on

page 1143

• Monitoring the Service Summary Details of IP Services for Optimal Debugging on

page 1146

Monitoring the Service Summary Details of E-LAN Services for Optimal Debugging

YoucanviewtheServiceSummarypageofaparticular service todisplay theconsolidated

and cumulative status of a service. The overall information pertaining to the service that

you can obtain from the differentwidgets displayed on this page enables you to navigate

to theappropriatedeviceor servicesettingspageandmodify theconfigurationparameters

appropriately. You can view the connection between the different endpoints and also

examine the statistics on thepackets andbytes traversering through theendpoints.Using

the Service Summary page, you can also select the source device for which you want to
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viewthe transportmetricsand the traffic statisticson theotherpagesdisplayed inMonitor

mode for the specific service. This page enables you to obtain an effective graphical view

in the formof tablesof statisticsandcharts to view thehealthandperformanceofdevices

and services in your network, which enables you to analyze and troubleshoot the

parameters that are causing traffic-handling errors.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

To view the Service Summary page for E-LAN services:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

The Connectivity tree is expanded and displayed on the View pane.

5. Expand the E-LAN Services tree to select an E-LAN service.

6. Click the ServiceSummary tab. The Service Summary page is displayed.

NOTE: The Service Monitoring Summary page is displayed, if you do not
select a particular service from the Service View pane and select the E-LAN
Services term in the Service View pane. The Summary page displays a
consolidated view of all of the service instances for a particular service type.
The customer associated with the service, type of service, service definition
upon which the service order is based, the traffic rate in bits per second, and
the traffic trend are displayed. Select the corresponding service from the
Network Services > Connectivity tree on the View pane to navigate to the
Service Summary page.
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The following widgets or widgets are displayed under this tab for E-LAN services. These

statistical counters andmetrics enable you to viewan agglomerative, cohesive snapshot

of the service configured on a device.

• Service Status on page 1145

• Connections on page 1145

• Traffic Summary on page 1146

Service Status

This widget displays the cumulative, consolidated status of services, such as E-LAN. The

following fields are displayed in a tabular form in this widget:

• Name—Name of the service.

• Type—Protocol configured for the service, such as E-Line, E-LAN, or IP.

• Status—Whether the service is up or down. A green up-arrow in the indicates that the

adjoining device in the network path to the destination device is operationally up. A

red down-arrow indicates that the device is down.

• PEs (Up/Down)—Number of provider edge devices that are in the up and down states

• UNIs (Up/Down)—Number of user-to-network (ingress) interfaces that are in the up

and down states

• Local Switch—Whether the local switching mode to terminate multiple Layer 2 circuit

pseudowires is configured

• Y1731 Status—Whether the connectivity faultmanagement (CFM) profile is configured

for the service and whether performancemonitoring (PM) statistics collection, such

as one-way delay measurement and variation, two-way delay measurement and

variation, or loss measurement are configured.

Click Refresh at the top of the monitor to update and display the contents of the table.

Connections

Thismonitor shows the status of connections between peer devices. In the tabular view,

the row represents the source device and the columns denote the neighboring and

destination devices. This monitor is applicable for E-LAN services.

One of the following values is displayed on the columns that denote the adjacent and

destination devices or endpoints:

• PR—Peer Device. Primary-Backup Pair. No Connection such as A/A or Z/Z.

• PBK—Peer Backup. No Connection.

• OL—Noadvertisementhasbeen received for this virtual circuit fromtheneighbor. There

is no outgoing label available for use by this virtual circuit.

• NA—Not available.

Mouse over the cells in the table to display the description of the connection statuses,

such as PR, PBK or NA.
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For the device for which the connection status is displayed, a hyphen (-) is displayed

under its own corresponding column to denote that it is not applicable. Click Refresh at

the top of the monitor to update and display the contents of the table.

Traffic Summary

This widget displays the total number of egress packets (packets that are sent out) or

traffic passing through all the UNI or customer-edge (CE) interfaces associatedwith the

particular service. This monitor is valid for E-LAN services. The date and time at which

the pagewas last updated is shown. A line graph is displayedwith time on the horizontal

axis and the number of output packets on the vertical axis.

From the Time Interval drop-down box, select 1 Hour, 8Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). ClickOK to save the settings. Else,

click Cancel to discard the configuration.

Related
Documentation

Viewing the Service Monitoring Summary Page for a Consolidated Listing of Services

on page 1138

•

• Monitoring the Service Summary Details of E-Line Services for Optimal Debugging on

page 1140

• Monitoring the Service Summary Details of IP Services for Optimal Debugging on

page 1146

Monitoring the Service Summary Details of IP Services for Optimal Debugging

YoucanviewtheServiceSummarypageofaparticular service todisplay theconsolidated

and cumulative status of a service. The overall information pertaining to the service that

you can obtain from the differentwidgets displayed on this page enables you to navigate

to theappropriatedeviceor servicesettingspageandmodify theconfigurationparameters

appropriately. You can view the connection between the different endpoints and also

examine the statistics on thepackets andbytes traversering through theendpoints.Using

the Service Summary page, you can also select the source device for which you want to

viewthe transportmetricsand the traffic statisticson theotherpagesdisplayed inMonitor

mode for the specific service. This page enables you to obtain an effective graphical view

in the formof tablesof statisticsandcharts to view thehealthandperformanceofdevices

and services in your network, which enables you to analyze and troubleshoot the

parameters that are causing traffic-handling errors.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).
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To view the Service Summary page for IP services:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

The Connectivity tree is expanded and displayed on the View pane.

5. Expand the IP Services tree to select an IP service.

6. Click the ServiceSummary tab.

The Service Summary page is displayed.

NOTE: The Service Monitoring Summary page is displayed, if you do not
select a particular service from the Service View pane and select the IP
Services term in the Service View pane. The Summary page displays a
consolidated view of all of the service instances for a particular service type.
The customer associated with the service, type of service, service definition
upon which the service order is based, the traffic rate in bits per second, and
the traffic trend are displayed. Select the corresponding service from the
Network Services > Connectivity tree on the View pane to navigate to the
Service Summary page.

• Service Status on page 1147

• VPN Routes on page 1148

• VPN Traffic Trend on page 1148

Service Status

This widget displays the operational status of IP services. The following fields are

displayed in a tabular form in this widget:

• Name—Name of the service

• Type—Protocol configured for the service

• Status—Whether the service is up or down.
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Click Refresh at the top of the monitor to update and display the contents of the table.

VPNRoutes

Thismonitor shows the status of routers between peer devices in a VPN connection. The

following fields are displayed in a tabular form:

• Node—Name of the device configured in a VPN tunnel

• Direct—Number of direct routes in the VPN tunnel for the specified node or device that

are up and down

• Local—Number of local routes in the VPN tunnel for the specified node or device that

are up and down

• Static—Number of static routes in the VPN tunnel for the specified node or device that

are up and down

• BGP—Number of BGP routes in the VPN tunnel for the specified node or device that

are up and down (BGP routing information includes the complete route to each

destination)

• OSPF—Number of OSPF routes in the VPN tunnel for the specified node or device that

are up and down (OSPF routes IP packets based solely on the destination IP address

contained in the IP packet header)

• Destination Count—Number of destinations for which there are routes in the routing

table.

• Total Route Count—Number of routes in the routing table and total number of routes

in the following states:

• active (routes that are active)

• holddown (routes that are in the pending state before being declared inactive)

• hidden (routes that are not used because of a routing policy)

• Active Route Count—Number of VPN routes that are active

Click Refresh at the top of the monitor to update and display the contents of the table.

VPN Traffic Trend

This widget displays the total number of egress packets (packets that are sent out) or

traffic passing through all the UNI or customer-edge (CE) interfaces associatedwith the

particular service. The date and time atwhich the pagewas last updated is shown. A line

graph is displayed with time on the horizontal axis and the number of output bytes on

the vertical axis.

From the Time Interval drop-down box, select 1 Hour, 8Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End
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time in the 24-hour time format of collection of data). ClickOK to save the settings. Else,

click Cancel to discard the configuration.

Related
Documentation

Viewing the Service Monitoring Summary Page for a Consolidated Listing of Services

on page 1138

•

• Monitoring the Service Summary Details of E-Line Services for Optimal Debugging on

page 1140

• Monitoring the Service Summary Details of E-LAN Services for Optimal Debugging on

page 1143

Monitoring the Service Traffic Statistics of E-Line Services for Correlating Device
Counters

You can view the Service Traffic page of a specific service to examine and diagnose the

transmission details of packets and themetrics on forwarded or received packets. The

interface statistical counters display the number of packets and bytes sent and received

from interfaces that are associated with the devices of the service. A pictorial

representation of the links in an E-Line service topology is also shown. You can also view

a bar chart of the class-of-service (CoS) queue information for physical interfaces. For

rate-limited interfaces hosted on Modular Interface Cards (MICs), Modular Port

Concentrators (MPCs), or Enhanced Queuing DPCs, rate-limit packet-drop operations

occur before packets are queued for transmission scheduling. For such interfaces, the

statistics for queued traffic do not include the packets that have already been dropped

due to rate limiting, and consequently the displayed statistics for queued traffic are the

same as the displayed statistics for transmitted traffic.

For rate-limited interfaces hosted on other types of hardware, rate-limit packet-drop

operations occur after packets are queued for transmission scheduling. For these other

interface types, the statistics for queued traffic include thepackets that are later dropped

due to rate limiting, and consequently the displayed statistics for queued traffic equals

the sum of the statistics for transmitted and rate-limited traffic.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

To view the Service Traffic page for E-Line services:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.
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The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

The Connectivity tree is expanded and displayed on the View pane.

5. Expand the E-Line Services tree to select an E-Line service.

6. Click the ServiceTraffic tab.

The Service Traffic page is displayed.

The following widgets are displayed on the Service Traffic tab.

• Traffic Graph on page 1150

• Pseudowire Traffic on page 1151

• Interface Traffic Statistics/Endpoint Users on page 1151

Traffic Graph

The Traffic Graphmonitor displays the number of packets transmitted between the peer

devices. A table is shown with the row representing the source device and the columns

denoting the devices or network elements in the path up to the destination device. It is

applicable for E-Line services. From the Statistics Type drop-down list, select Packets

or Bytes to display metrics corresponding to the selected parameter.

The Traffic Graphmonitor for E-Line services is displayed in a pictorial form, with the

primaryoriginorAendpoint, backuporiginorAendpoint, primarydestinationorZendpoint,

and backup destination or Z endpoints shown as circles. Color-coded legends reference

the lines that are shown in the graph. The lines correspond to the traffic traversing from

the A primary endpoint to the Z primary endpoints, from the A primary endpoint to the Z

backup endpoint, and from the Z primary and Z backup endpoints to the A primary

endpoint. The arrows indicate the direction of traffic flows. Red lines denote the Layer 2

Ethernet pseudowire traffic between the endpoints to have been dropped or the

connection to be down. Green lines denote the pseudowire traffic to be transmitted

succesfully or the connection to be up. A gray line denotes that connection state is not

available, and NA indicates that the statistic is not available. Solid lines denote the

connections between primary pseudowires, while dotted lines denote the connections

between secondary pseudowires. The numbers that are shown on the connection lines

signify the metrics or count corresponding to the type of parameter you selected, such

as output packets or output bytes.

On the Service Traffic page, the Traffic Graphmonitor is also supported for an E-Line

service with one endpoint as unmanaged device.
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For anE-Line servicewith resiliency, for the redundant pseudowires configured to remote

PE routers from the A primary or source endpoint, the traffic statistics for the primary

pseudowire overwhich customer traffic is being transmitted and the backup pseudowire

are displayed along the connection lines.

Pseudowire Traffic

This monitor is displayed for E-Line services. A line chart is displayed with time on the

horizontal axis and the number of output packets or output bytes on the vertical axis.

From the Statistics Type drop-down box at the top of the monitor, select Input Packets

or Input Bytes to display the number of packets or bytes traversing in the ingress direction

(received traffic). Alternatively, select Output Packets/Second or Output Bytes/Second

to displaymetrics corresponding to the transmitted or egress packets or bytes. From the

Select Primary Endpoint list, select the primary endpoint or device for which you want

to view the traffic details traversing through the pseudowire in the output direction.

From the Time Interval drop-down box, select 1 Hour, 8 Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6 Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). Click OK to save the settings. Else,

click Cancel to discard the configuration.

Interface Traffic Statistics/Endpoint Users

Thismonitor is displayed for E-Line services. In thismonitor, the interface statistics denote

the traffic data on all the UNI or site interfaces associated with the service. These values

areon-demandstatistical valuesand thedata is retrieved fromthedevicedirectlywithout

being cached (polling at periodic intervals and displaying a snapshot). It is supported for

E-Line, E-LAN, and IP services. The following fields are displayed in a table:

• Device Name—Name of the device

• Interface—Name of the interface

• Packets In—Number of packets received on the interface

• Packets Out—Number of packets sent from the interface

• Bytes In—Number of bytes received on the interface

• Bytes Out—Number of bytes sent from the interface

From the Automatic Refresh list, select Disabled, Every 30 Seconds, Every 45 Seconds, or

Every 1Minute to specify the frequencyatwhich the statistics in the tablemustbeupdated

and displayed. When you disable the auto-refresh capability, the page is not refreshed

periodically by itself; instead you can click the Refresh icon to update the table contents

for viewing.

For an E-Line service with one endpoint as unmanaged device, the Interface statistics

monitor displays only the managed devices in the list and the corresponding monitored

data. Unmanaged devices or its data are not displayed.
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Related
Documentation

Monitoring the Service Traffic Statistics of E-LAN Services for Correlating Device

Counters on page 1152

•

• Monitoring the Service Traffic Statistics of IP Services for Correlating Device Counters

on page 1154

• Monitoring theServiceTransportDetailsofE-LineServices forEasyAnalysisonpage 1156

• Monitoring theServiceTransportDetailsofE-LANServices forEasyAnalysisonpage 1159

• Monitoring the Service Transport Details of IP Services for Easy Analysis on page 1162

Monitoring the Service Traffic Statistics of E-LAN Services for Correlating Device
Counters

You can view the Service Traffic page of a specific service to examine and diagnose the

transmission details of packets and themetrics on forwarded or received packets. The

interface statistical counters display the number of packets and bytes sent and received

from interfaces that are associated with the devices of the service. A pictorial

representation of the links in an E-Line service topology is also shown. You can also view

a bar chart of the class-of-service (CoS) queue information for physical interfaces. For

rate-limited interfaces hosted on Modular Interface Cards (MICs), Modular Port

Concentrators (MPCs), or Enhanced Queuing DPCs, rate-limit packet-drop operations

occur before packets are queued for transmission scheduling. For such interfaces, the

statistics for queued traffic do not include the packets that have already been dropped

due to rate limiting, and consequently the displayed statistics for queued traffic are the

same as the displayed statistics for transmitted traffic.

For rate-limited interfaces hosted on other types of hardware, rate-limit packet-drop

operations occur after packets are queued for transmission scheduling. For these other

interface types, the statistics for queued traffic include thepackets that are later dropped

due to rate limiting, and consequently the displayed statistics for queued traffic equals

the sum of the statistics for transmitted and rate-limited traffic.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

To view the Service Traffic page for E-LAN services:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.
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3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

The Connectivity tree is expanded and displayed on the View pane.

5. Expand the E-LAN Services tree to select an E-LAN service.

6. Click the ServiceTraffic tab.

The Service Traffic page is displayed.

The following widgets are displayed on the Service Traffic tab.

• Traffic Graph on page 1150

• Interface Traffic Statistics/Endpoint Users on page 1151

• Traffic Pattern on page 1154

Traffic Matrix

The TrafficMatrixmonitor displays the number of packets transmitted between the peer

devices. A table is shown with the row representing the source device and the columns

denoting the devices or network elements in the path up to the destination device. It is

applicable for E-LAN services. From the Statistics Type drop-down list, select Unicast

Bytes,MulticastBytes,BroadcastBytes, or FloodedBytes todisplaymetrics corresponding

to the selected parameter.

Interface Statistics

Thismonitor is displayed for E-LANservices. In thismonitor, the interface statisticsdenote

the traffic data on all the UNI or site interfaces associated with the service. These values

areon-demandstatistical valuesand thedata is retrieved fromthedevicedirectlywithout

being cached (polling at periodic intervals and displaying a snapshot). It is supported for

E-Line, E-LAN, and IP services. The following fields are displayed in a table:

• Device Name—Name of the device

• Interface—Name of the interface

• Packets In—Number of packets received on the interface

• Packets Out—Number of packets sent from the interface

• Bytes In—Number of bytes received on the interface

• Bytes Out—Number of bytes sent from the interface

From the Automatic Refresh list, select Disabled, Every 30 Seconds, Every 45 Seconds, or

Every 1Minute to specify the frequencyatwhich the statistics in the tablemustbeupdated
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and displayed. When you disable the auto-refresh capability, the page is not refreshed

periodically by itself; instead you can click the Refresh icon to update the table contents

for viewing.

Traffic Pattern

This monitor is displayed for E-LAN services. A chord graphic displays the relationship

amongasetof entities. Theassociation in the formofchords for traffic traversing through

devices on which the service is assigned is shown.

Related
Documentation

Monitoring the Service Traffic Statistics of E-Line Services for Correlating Device

Counters on page 1149

•

• Monitoring the Service Traffic Statistics of IP Services for Correlating Device Counters

on page 1154

• Monitoring theServiceTransportDetailsofE-LineServices forEasyAnalysisonpage 1156

• Monitoring theServiceTransportDetailsofE-LANServices forEasyAnalysisonpage 1159

• Monitoring the Service Transport Details of IP Services for Easy Analysis on page 1162

Monitoring the Service Traffic Statistics of IP Services for Correlating Device Counters

You can view the Service Traffic page of a specific service to examine and diagnose the

transmission details of packets and themetrics on forwarded or received packets. The

interface statistical counters display the number of packets and bytes sent and received

from interfaces that are associated with the devices of the service. A pictorial

representation of the links in an E-Line service topology is also shown. You can also view

a bar chart of the class-of-service (CoS) queue information for physical interfaces. For

rate-limited interfaces hosted on Modular Interface Cards (MICs), Modular Port

Concentrators (MPCs), or Enhanced Queuing DPCs, rate-limit packet-drop operations

occur before packets are queued for transmission scheduling. For such interfaces, the

statistics for queued traffic do not include the packets that have already been dropped

due to rate limiting, and consequently the displayed statistics for queued traffic are the

same as the displayed statistics for transmitted traffic.

For rate-limited interfaces hosted on other types of hardware, rate-limit packet-drop

operations occur after packets are queued for transmission scheduling. For these other

interface types, the statistics for queued traffic include thepackets that are later dropped

due to rate limiting, and consequently the displayed statistics for queued traffic equals

the sum of the statistics for transmitted and rate-limited traffic.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).
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To view the Service Traffic page for an IP service:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

The Connectivity tree is expanded and displayed on the View pane.

5. Expand the IP Services tree to select an IP service.

6. Click the ServiceTraffic tab.

The Service Traffic page is displayed.

The following widgets are displayed on the Service Traffic tab.

• Interface Traffic Statistics/Endpoint Users on page 1151

• VPN Traffic Trend on page 1156

Interface Statistics

This monitor is displayed for IP services. In this monitor, the interface statistics denote

the traffic data on all the UNI or site interfaces associated with the service. These values

areon-demandstatistical valuesand thedata is retrieved fromthedevicedirectlywithout

being cached (polling at periodic intervals and displaying a snapshot). It is supported for

IP services. The following fields are displayed in a table:

• Device Name—Name of the device

• Interface—Name of the interface

• Packets In—Number of packets received on the interface

• Packets Out—Number of packets sent from the interface

• Bytes In—Number of bytes received on the interface

• Bytes Out—Number of bytes sent from the interface
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From the Automatic Refresh list, select Disabled, Every 30 Seconds, Every 45 Seconds, or

Every 1Minute to specify the frequencyatwhich the statistics in the tablemustbeupdated

and displayed. When you disable the auto-refresh capability, the page is not refreshed

periodically by itself; instead you can click the Refresh icon to update the table contents

for viewing.

VPN Traffic Trend

Thismonitor isdisplayed for IP services.A linechart isdisplayedwith timeon thehorizontal

axis and the number of output packets on the vertical axis.

From the Time Interval drop-down box, select 1 Hour, 8Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). ClickOK to save the settings. Else,

click Cancel to discard the configuration.

Related
Documentation

Monitoring the Service Traffic Statistics of E-Line Services for Correlating Device

Counters on page 1149

•

• Monitoring the Service Traffic Statistics of E-LAN Services for Correlating Device

Counters on page 1152

• Monitoring theServiceTransportDetailsofE-LineServices forEasyAnalysisonpage 1156

• Monitoring theServiceTransportDetailsofE-LANServices forEasyAnalysisonpage 1159

• Monitoring the Service Transport Details of IP Services for Easy Analysis on page 1162

Monitoring the Service Transport Details of E-Line Services for Easy Analysis

You can view the Service Transport page of a particular service to obtain detailed and

granular informationon thehigh-level statistics thataredisplayedon theServiceSummary

page. The VPN routes learned by a provider edge (PE) device from all other PE devices

are displayed. The PE routers in the provider’s core network are the only routers that are

configured to support VPNs and hence are the only routers to have information about

the VPNs. From the point of view of VPN functionality, the provider (P) routers in the

core—those P routers that are not directly connected to CE routers—are merely routers

along the tunnel between the ingress and egress PE routers. The accounting information

about configured and active label-switched paths (LSPs) is also displayed. Statistics

are not available for LSPs on the egress routing device, because the penultimate routing

device in the LSP sets the label to 0. Also, as the packet arrives at the egress routing

device, the hardware removes its MPLS header and the packet reverts to being an IPv4

packet. Therefore, it is counted as an IPv4 packet, not an MPLS packet.
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NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

To view the Service Transport page for an E-Line service:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

The Connectivity tree is expanded and displayed on the View pane.

5. Expand the E-Line Services tree to select an E-Line service.

6. Click the ServiceTransport tab.

The Service Transport page is displayed.

• Connections on page 1157

• LSP Information on page 1158

• LSP Traffic on page 1159

Connections

Thismonitor shows the status of connections between peer devices. In the tabular view,

the row represents the source device and the columns denote the neighboring and

destination devices. This monitor is applicable for E-Line services. A green up-arrow in

the indicates that the adjoining device in the network path to the destination device is

operationally up. A red down-arrow indicates that the device is down. For the device for

which the connection status is displayed, a value of NA is displayed under its own

corresponding column to denote that it is not applicable.
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LSP Information

For a destination address that contains LSP names, the corresponding LSP details, such

as the name, state, and bandwidth of the LSP, are displayed in this monitor. The details

displayed in thismonitordependon thedevice selected in theConnectionsMatrixwidget.

The following fields are displayed:

• Name—Name of the LSP

• State— State of the LSP handled by this RSVP session: Up, Dn (down), or Restart

• Bandwidth—Specifies the bandwidth in bits per second for the LSP.

• Primary State— State of the LSP that is a primary path: Up, Down, or Restart

• Secondary State— State of the LSP that is a secondary path: Up, Down, or Restart

• Received RRO—(Ingress LSP) Received record route. A series of hops, each with an

address followed by a flag. (In most cases, the received record route is the same as

the computed explicit route. If Received RRO is different from Computed ERO, there

is a topology change in the network, and the route is taking a detour.) The following

flags identify the protection capability and status of the downstream node:

• 0x01—Local protection available. The link downstream from this node is protected

by a local repair mechanism. This flag can be set only if the Local protection flag

was set in the SESSION_ATTRIBUTE object of the corresponding Path message.

• 0x02—Local protection in use. A local repair mechanism is in use to maintain this

tunnel (usually because of an outage of the link it was routed over previously).

• 0x03—Combination of 0x01 and 0x02.

• 0x04—Bandwidth protection. The downstream routing device has a backup path

providing the same bandwidth guarantee as the protected LSP for the protected

section.

• 0x08—Nodeprotection.Thedownstreamroutingdevicehasabackuppathproviding

protection against link and node failure on the corresponding path section. If the

downstream routing device can set up only a link-protection backup path, the Local

protection available bit is set but the Node protection bit is cleared.

• 0x09—Detour is established. Combination of 0x01 and 0x08.

• 0x10—Preemption pending. The preempting node sets this flag if a pending

preemption is in progress for the traffic engine LSP. This flag indicates to the ingress

legacy edge router (LER) of this LSP that it should be rerouted.

• 0xb—Detour is in use. Combination of 0x01, 0x02, and 0x08.

• Total Packets—Total number of packets and Total number of bytes transmitted over

the LSP. This counter is reset to zerowhenever the LSPpath is optimized (for example,

during an automatic bandwidth allocation).

• Total Bytes—Total number of bytes transmitted over the LSP. This counter is reset to

zerowhenever theLSPpath is optimized (for example, duringanautomatic bandwidth

allocation).
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LSP Traffic

This widget displays a line chart with the bytes per second (bps) or rate on the y-axis

and time on the x-axis to denote the LSP bandwidth utilization in bps.

From the Time Interval drop-down box, select 1 Hour, 8Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). ClickOK to save the settings. Else,

click Cancel to discard the configuration.

Related
Documentation

Monitoring the Service Traffic Statistics of E-Line Services for Correlating Device

Counters on page 1149

•

• Monitoring the Service Traffic Statistics of IP Services for Correlating Device Counters

on page 1154

• Monitoring theServiceTransportDetailsofE-LineServices forEasyAnalysisonpage 1156

• Monitoring theServiceTransportDetailsofE-LANServices forEasyAnalysisonpage 1159

• Monitoring the Service Transport Details of IP Services for Easy Analysis on page 1162

Monitoring the Service Transport Details of E-LAN Services for Easy Analysis

You can view the Service Transport page of a particular service to obtain detailed and

granular informationon thehigh-level statistics thataredisplayedon theServiceSummary

page. The VPN routes learned by a provider edge (PE) device from all other PE devices

are displayed. The PE routers in the provider’s core network are the only routers that are

configured to support VPNs and hence are the only routers to have information about

the VPNs. From the point of view of VPN functionality, the provider (P) routers in the

core—those P routers that are not directly connected to CE routers—are merely routers

along the tunnel between the ingress and egress PE routers. The accounting information

about configured and active label-switched paths (LSPs) is also displayed. Statistics

are not available for LSPs on the egress routing device, because the penultimate routing

device in the LSP sets the label to 0. Also, as the packet arrives at the egress routing

device, the hardware removes its MPLS header and the packet reverts to being an IPv4

packet. Therefore, it is counted as an IPv4 packet, not an MPLS packet.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).
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To view the Service Transport page for an E-LAN service:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

The Connectivity tree is expanded and displayed on the View pane.

5. Expand the E-LAN Services tree to select an E-LAN service.

6. Click the ServiceTransport tab. The Service Transport page is displayed.

• Connections on page 1160

• LSP Information on page 1160

• LSP Traffic on page 1161

Connections

Thismonitor shows the status of connections between peer devices. In the tabular view,

the row represents the source device and the columns denote the neighboring and

destination devices. This monitor is applicable for E-Line and E-LAN services. A green

up-arrow in the indicates that the adjoining device in the network path to the destination

device is operationally up. A red down-arrow indicates that the device is down. For the

device for which the connection status is displayed, a value of NA is displayed under its

own corresponding column to denote that it is not applicable.

LSP Information

For a destination address that contains LSP names, the corresponding LSP details, such

as the name, state, and bandwidth of the LSP, are displayed in this monitor. The details

displayed in thismonitor depend on the device selected in the ConnectionMatrix widget.

The following fields are displayed:

• Name—Name of the LSP

• State— State of the LSP handled by this RSVP session: Up, Dn (down), or Restart

• Bandwidth—Specifies the bandwidth in bits per second for the LSP.
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• Primary State— State of the LSP that is a primary path: Up, Down, or Restart

• Secondary State— State of the LSP that is a secondary path: Up, Down, or Restart

• Received RRO—(Ingress LSP) Received record route. A series of hops, each with an

address followed by a flag. (In most cases, the received record route is the same as

the computed explicit route. If Received RRO is different from Computed ERO, there

is a topology change in the network, and the route is taking a detour.) The following

flags identify the protection capability and status of the downstream node:

• 0x01—Local protection available. The link downstream from this node is protected

by a local repair mechanism. This flag can be set only if the Local protection flag

was set in the SESSION_ATTRIBUTE object of the corresponding Path message.

• 0x02—Local protection in use. A local repair mechanism is in use to maintain this

tunnel (usually because of an outage of the link it was routed over previously).

• 0x03—Combination of 0x01 and 0x02.

• 0x04—Bandwidth protection. The downstream routing device has a backup path

providing the same bandwidth guarantee as the protected LSP for the protected

section.

• 0x08—Nodeprotection.Thedownstreamroutingdevicehasabackuppathproviding

protection against link and node failure on the corresponding path section. If the

downstream routing device can set up only a link-protection backup path, the Local

protection available bit is set but the Node protection bit is cleared.

• 0x09—Detour is established. Combination of 0x01 and 0x08.

• 0x10—Preemption pending. The preempting node sets this flag if a pending

preemption is in progress for the traffic engine LSP. This flag indicates to the ingress

legacy edge router (LER) of this LSP that it should be rerouted.

• 0xb—Detour is in use. Combination of 0x01, 0x02, and 0x08.

LSP Traffic

This widget displays a line chart with the bytes per second (bps) or rate on the y-axis

and time on the x-axis to denote the LSP bandwidth utilization in bps.

From the Time Interval drop-down box, select 1 Hour, 8Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). ClickOK to save the settings. Else,

click Cancel to discard the configuration.

Related
Documentation

Monitoring the Service Traffic Statistics of E-Line Services for Correlating Device

Counters on page 1149

•

• Monitoring the Service Traffic Statistics of E-LAN Services for Correlating Device

Counters on page 1152
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• Monitoring the Service Traffic Statistics of IP Services for Correlating Device Counters

on page 1154

• Monitoring theServiceTransportDetailsofE-LineServices forEasyAnalysisonpage 1156

• Monitoring the Service Transport Details of IP Services for Easy Analysis on page 1162

Monitoring the Service Transport Details of IP Services for Easy Analysis

You can view the Service Transport page of a particular service to obtain detailed and

granular informationon thehigh-level statistics thataredisplayedon theServiceSummary

page. The VPN routes learned by a provider edge (PE) device from all other PE devices

are displayed. The PE routers in the provider’s core network are the only routers that are

configured to support VPNs and hence are the only routers to have information about

the VPNs. From the point of view of VPN functionality, the provider (P) routers in the

core—those P routers that are not directly connected to CE routers—are merely routers

along the tunnel between the ingress and egress PE routers. The accounting information

about configured and active label-switched paths (LSPs) is also displayed. Statistics

are not available for LSPs on the egress routing device, because the penultimate routing

device in the LSP sets the label to 0. Also, as the packet arrives at the egress routing

device, the hardware removes its MPLS header and the packet reverts to being an IPv4

packet. Therefore, it is counted as an IPv4 packet, not an MPLS packet.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

To view the Service Transport page for an IP service:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

The Connectivity tree is expanded and displayed on the View pane.
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5. Expand the IP Services tree to select an IP service.

6. Click the ServiceTransport tab.

The Service Transport page is displayed.

Thiswidgetprovidesdetails onSummaryMonitors,whichare shown inServiceSummary

Tab under Monitor functionality of “Service View”.

• Transport Statistics on page 1163

• VPN Routes on page 1148

• Label/LSP Information on page 1163

• LSP Traffic on page 1159

Transport Statistics

The Transport Statistics monitor shows the statistical counts for the selected data

against timebetween the source device and the specified peer or destination device, and

the LSP being used by the endpoint. The source device is the row selected in the

Connection Matrix widget. The destination device is based on the device that you chose

in the Traffic Statistics widget. By default, destination devices are empty. This monitor

is valid for E-Line services. A line graph is displayed with time on the horizontal axis and

the type of statistical parameter on the vertical axis. In the Peer Device list, all Devices

from the Connection Matrix except the source device are available for selection. In the

Statistics Type list, you can select Ingress Packets or Ingress Bytes. Color-coded legends

are used to indicate tunnel and device traffic. The purple line denotes tunnel traffic and

the brown line signifies the device (service) traffic. Because the LSP does not provide

anymetric if it is down, theremight be variations in the data point for the LSP and device.

VPNRoutes

This widget displays information about the path through which the packets traverse in

LSPs in a VPN tunnel. Select a node for which you want to view the VPN routing

information from the Select Node list at the top of the monitor. Alternatively, enter the

name of the node for which you want to view the VPN routing details as the match

criterion in the Search box and click the Search icon. The page refreshes to display the

nodes that match with the search criterion. Click Refresh to update the contents of the

table.

• Destination— Destination (egress routing device) of the session

• Next Hop— Address of the next-hop (downstream) routing device or client, interface

used to reach this neighbor, and number of packets sent to the downstream routing

• LSP/Label— Name of the LSP. For LDP signaling, NA is shown.

Label/LSP Information

Label Information
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For a destination address that you select in the VPN Routes monitor that contain

LDP-established LSPs, the corresponding label details for active and backup LSPs are

displayed in this monitor. The following fields are displayed:

• Protocol—LDP is the mechanism used to establish LSPs

• Next-hop—Network layer address of the directly reachable neighboring system.

• via—Interface used to reach the next hop. If there is more than one interface available

to the next hop, the name of the interface that is actually used is followed by the word

Selected. This field can also contain the following information:

• Weight—Value used to distinguish primary, secondary, and fast reroute backup

routes. Weight information is available when MPLS label-switched path (LSP) link

protection, node-linkprotection, or fast reroute is enabled, orwhen thestandbystate

is enabled for secondary paths. A lowerweight value is preferred. Among routeswith

the same weight value, load balancing is possible.

• Balance—Balance coefficient indicating how traffic of unequal cost is distributed

among next hops when a routing device is performing unequal-cost load balancing.

This information is available when you enable BGPmultipath load balancing.

• Label Operation—MPLS label and operation occurring at this routing device. The

operationcanbepop(wherea label is removed fromthe topof thestack), push (where

another label is added to the label stack), or swap(wherea label is replacedbyanother

label).

• Label TTLAction—State of the TTL propagation attribute, such as prop-ttl (propagate

the TTL value), prop-ttl (top) (propagate the TTL value of the outermost or top label),

no-prop-ttl (do not propagate the TTRL value), or no-prop-ttl (top) (do not transmit

the TTL value of the top label)

• LoadBalance label—Whether the load-balancingcapability basedon labels is enabled.

LSP Information

For a destination address that you select in the VPN Routes monitor that contain LSP

names, the corresponding LSP details, such as the name, state, and bandwidth of the

LSP, are displayed in this monitor. The details displayed in this monitor depend on the

device selected in the Connection Matrix widget. The following fields are displayed:

• Name—Name of the LSP

• State— State of the LSP handled by this RSVP session: Up, Dn (down), or Restart

• Bandwidth—Specifies the bandwidth in bits per second for the LSP.

• Primary State— State of the LSP that is a primary path: Up, Down, or Restart

• Secondary State— State of the LSP that is a secondary path: Up, Down, or Restart

• Received RRO—(Ingress LSP) Received record route. A series of hops, each with an

address followed by a flag. (In most cases, the received record route is the same as

the computed explicit route. If Received RRO is different from Computed ERO, there

is a topology change in the network, and the route is taking a detour.) The following

flags identify the protection capability and status of the downstream node:
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• 0x01—Local protection available. The link downstream from this node is protected

by a local repair mechanism. This flag can be set only if the Local protection flag

was set in the SESSION_ATTRIBUTE object of the corresponding Path message.

• 0x02—Local protection in use. A local repair mechanism is in use to maintain this

tunnel (usually because of an outage of the link it was routed over previously).

• 0x03—Combination of 0x01 and 0x02.

• 0x04—Bandwidth protection. The downstream routing device has a backup path

providing the same bandwidth guarantee as the protected LSP for the protected

section.

• 0x08—Nodeprotection.Thedownstreamroutingdevicehasabackuppathproviding

protection against link and node failure on the corresponding path section. If the

downstream routing device can set up only a link-protection backup path, the Local

protection available bit is set but the Node protection bit is cleared.

• 0x09—Detour is established. Combination of 0x01 and 0x08.

• 0x10—Preemption pending. The preempting node sets this flag if a pending

preemption is in progress for the traffic engine LSP. This flag indicates to the ingress

legacy edge router (LER) of this LSP that it should be rerouted.

• 0xb—Detour is in use. Combination of 0x01, 0x02, and 0x08.

• Total Packets—Total number of packets and Total number of bytes transmitted over

the LSP. This counter is reset to zerowhenever the LSPpath is optimized (for example,

during an automatic bandwidth allocation).

• Total Bytes—Total number of bytes transmitted over the LSP. This counter is reset to

zerowhenever theLSPpath is optimized (for example, duringanautomatic bandwidth

allocation).

LSP Traffic

This widget displays a line chart with the bytes per second (bps) or rate on the y-axis

and time on the x-axis to denote the LSP bandwidth utilization in bps.

From the Time Interval drop-down box, select 1 Hour, 8Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). ClickOK to save the settings. Else,

click Cancel to discard the configuration.

Related
Documentation

Monitoring the Service Traffic Statistics of E-Line Services for Correlating Device

Counters on page 1149

•

• Monitoring the Service Traffic Statistics of E-LAN Services for Correlating Device

Counters on page 1152
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• Monitoring the Service Traffic Statistics of IP Services for Correlating Device Counters

on page 1154

• Monitoring theServiceTransportDetailsofE-LineServices forEasyAnalysisonpage 1156

• Monitoring theServiceTransportDetailsofE-LANServices forEasyAnalysisonpage 1159

Viewing Y.1731 PerformanceMonitoring Statistics for E-Line Services

The Y.1731 monitoring functionality is not enabled by default. Youmust explicitly start

the PMcollectionmechanismby selectingOAM>Y1731 >Start from the Tasks pane after

selecting the specified service on the View pane. The graphical representation of the

retrieved statistical details for the service is displayed, based on data availability. The

data collected is retained after you stop the PM collection utility for future reference and

correlation.

If you are upgrading from the older version of Services Activation Director to Connectivity

ServicesDirector 1.0, youmust stopanyperformancemonitoringand restart thecollection

of Y1731 PM statistics on the endpoints.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

To view the performancemonitoring statistics for the E-Line service:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside E-Line Services to view the E-Line service orders.

5. Select the E-Line service order for which you want tomonitor performance statistics.

The E-Line Services tree is expanded and displayed on the View pane.

6. Select the Y1731 tab.

The Service Performance page is displayed.
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NOTE: You can view performancemanagement statistics only after you
start the collection of Y1731 performancemonitoring (PM) statistics by
selectingOAM>Y1731 > Start from the Tasks pane.

• Connections on page 1167

• Loss Measurement on page 1167

• Delay Measurement on page 1168

• Delay Variation on page 1168

Connections

Thismonitor shows the status of connections between peer devices. In the tabular view,

the row represents the source device and the columns denote the neighboring and

destination devices. This monitor is applicable for E-Line and E-LAN services. A green

up-arrow in the indicates that the adjoining device in the network path to the destination

device is operationally up. A red down-arrow indicates that the device is down. For the

device for which the connection status is displayed, a value of NA is displayed under its

own corresponding column to denote that it is not applicable. Click Refresh at the top of

the monitor to update and display the contents of the table.

From the Time Interval drop-down box, select 1 Hour, 8Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). ClickOK to save the settings. Else,

click Cancel to discard the configuration.

LossMeasurement

The LossMeasurement graph displays a real-time linear plot of delay value with respect

to the time. The x-axis represents the time and the y-axis represents the frame loss ratio.

Near-end frame loss refers to thecountof frame lossassociatedwith ingressdata frames.

Far-end frame loss refers to the count of frame loss associatedwith egress data frames.

The lines represent the best case frame loss or the lowest frame loss, the worst case

frame loss or the highest frame loss, and the average frame loss or the median of the

highest and lowest frame losses. The frame loss is calculated by collecting the counter

values applicable for ingress and egress service frames. The counters maintain a count

of transmitted and received data frames between a pair ofMEPs. The lossmeasurement

statisticsare retrievedas theoutputof themonitor ethernet loss-measurementcommand

and are also stored at the initiator. The frame counts are stored at both the initiator and

the receiver MEPs for later retrieval. The on-demand loss measurement statistics is

collected for E-Line service only. There are two linear charts: Near-End-CIR and

Far-End-CIR. For each interval, the graph plots three values: Average case, best case,

and worst case frame loss. From the Loss End drop-down list, select Near-end (CIR) to

display frame loss statistics associated with ingress data frames or Far-end (CIR) to
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display frame loss statistics associatedwith egress data frames.Mouse over the legends

toviewthe linescorresponding tobest-case, average, andworst-case frame lossstatistics.

DelayMeasurement

TheDelayMeasurement graphdisplays a real-time linear plot of delay valuewith respect

to the time. The x-axis represents the time and the y-axis represents frame delay in

microseconds. The legends reference average one-way delay, best-case one-way delay,

and worst-case one way delay for one-way delay measurement. The green line denotes

the lowest one-way frame delay for the statistics displayed, the orange line denotes the

highest one-way frame delay for the statistics displayed, and the blue line denotes the

average one-way frame delay for the statistics displayed. The legends reference average

two-way delay, best-case two-way delay, and worst-case two-way delay for two-way

delay measurement. The green line denotes the lowest two-way frame delay for the

statistics displayed, the orange line denotes the highest two-way frame delay for the

statistics displayed, and the blue line denotes the average two-way frame delay for the

statistics displayed. From theDelay Enddrop-downbox, select 1-Way or 2-Way to display

the one-way or two-way frame delay measurement protocols respectively.

Delay Variation

The Delay Variation graph displays the difference between the consecutive frame delay

values. The x-axis represents the time and the y-axis represents delay variation in

microseconds. The line denotes the average one-way delay variation or the average

one-way “frame jitter” for thestatisticsdisplayed forone-way framedelaymeasurement.

The line denotes the average two-way delay variation or the average two-way “frame

jitter” for the statistics displayed for two-way delay measurement.

By default, the total time duration is ten minutes. If the duration of statistics collection

exceeds tenminutes, the graph scrolls and shows the data of latest ten minutes.

Related
Documentation

Performance Management Overview on page 1059•

• Monitoring Performance Management Statistics on page 1061

• Viewing Performance Management Statistics on page 1065

• Service Troubleshooting Overview on page 1071

• Performing a Configuration Audit on page 1027

Viewing Y.1731 PerformanceMonitoring Statistics for E-LAN Services

The Y.1731 monitoring functionality is not enabled by default. Youmust explicitly start

the PMcollectionmechanismby selectingOAM>Y1731 >Start from the Tasks pane after

selecting the specified service on the View pane. The graphical representation of the

retrieved statistical details for the service is displayed, based on data availability. The

data collected is retained after you stop the PM collection utility for future reference and

correlation.
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If you are upgrading from the older version of Services Activation Director to Connectivity

ServicesDirector 1.0, youmust stopanyperformancemonitoringand restart thecollection

of Y1731 PM statistics on the endpoints.

NOTE: The values and statuses of the parameters displayed in the graphs
and tables of different widgets are refreshed, based on the polling interval
configured on the Monitoring tab of the Preferences page (accessible by
clicking the down arrow beside the System button on the Connectivity
Services Director banner and selecting Preferences).

To view the performancemonitoring statistics for the E-LAN service:

1. Select Service View from the View Selector.

The workspaces that are applicable to routing and tunneling services are displayed

on the View pane.

2. Fromthe JunosSpaceuser interface, click theMonitor iconon theConnectivityServices

Director banner.

The functionalities that you can configure in thismodeare displayedon the task pane.

3. FromtheServiceViewpane, on the left, click theplus sign (+)next toNetworkServices

to expand the tree and display the different service types that you can configure.

The Network Services tree is expanded and displayed on the View pane.

4. Click the plus sign (+) beside E-LAN Services to view the E-LAN service orders.

The E-LAN Services tree is expanded and displayed on the View pane.

5. Select the E-LAN service order for which you want tomonitor performance statistics.

6. Select the Y1731 tab.

The Service Performance page is displayed.

NOTE: You can view performancemanagement statistics only after you
start the collection of Y1731 performancemonitoring (PM) statistics by
selectingOAM>Y1731 > Start from the Tasks pane.

• Connections on page 1169

• Loss Measurement on page 1170

• Delay Measurement on page 1170

• Delay Variation on page 1171

Connections

Thismonitor shows the status of connections between peer devices. In the tabular view,

the row represents the source device and the columns denote the neighboring and

destination devices. This monitor is applicable for E-Line and E-LAN services. A green
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up-arrow in the indicates that the adjoining device in the network path to the destination

device is operationally up. A red down-arrow indicates that the device is down. For the

device for which the connection status is displayed, a value of NA is displayed under its

own corresponding column to denote that it is not applicable. Click Refresh at the top of

the monitor to update and display the contents of the table.

From the Time Interval drop-down box, select 1 Hour, 8Hours, 1 Day, 1 Week, 1 Month, 3

Months, 6Months, 1 Year, or Custom to specify the duration for which the data polled

from devices needs to be displayed. If you select the Custom option, the Time range

popup dialog box is displayed. Specify the date from the calendar, and select the Time

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). ClickOK to save the settings. Else,

click Cancel to discard the configuration.

LossMeasurement

The LossMeasurement graph displays a real-time linear plot of delay value with respect

to the time. The x-axis represents the time and the y-axis represents the frame loss ratio.

Near-end frame loss refers to thecountof frame lossassociatedwith ingressdata frames.

Far-end frame loss refers to the count of frame loss associatedwith egress data frames.

The lines represent the best case frame loss or the lowest frame loss, the worst case

frame loss or the highest frame loss, and the average frame loss or the median of the

highest and lowest frame losses. The frame loss is calculated by collecting the counter

values applicable for ingress and egress service frames. The counters maintain a count

of transmitted and received data frames between a pair ofMEPs. The lossmeasurement

statisticsare retrievedas theoutputof themonitor ethernet loss-measurementcommand

and are also stored at the initiator. The frame counts are stored at both the initiator and

the receiver MEPs for later retrieval. The on-demand loss measurement statistics is

collected for E-Line service only. There are two linear charts: Near-End-CIR and

Far-End-CIR. For each interval, the graph plots three values: Average case, best case,

and worst case frame loss. From the Loss End drop-down list, select Near-end (CIR) to

display frame loss statistics associated with ingress data frames or Far-end (CIR) to

display frame loss statistics associatedwith egress data frames.Mouse over the legends

toviewthe linescorresponding tobest-case, average, andworst-case frame lossstatistics.

DelayMeasurement

TheDelayMeasurement graphdisplays a real-time linear plot of delay valuewith respect

to the time. The x-axis represents the time and the y-axis represents frame delay in

microseconds. The legends reference average one-way delay, best-case one-way delay,

and worst-case one way delay for one-way delay measurement. The green line denotes

the lowest one-way frame delay for the statistics displayed, the orange line denotes the

highest one-way frame delay for the statistics displayed, and the blue line denotes the

average one-way frame delay for the statistics displayed. The legends reference average

two-way delay, best-case two-way delay, and worst-case two-way delay for two-way

delay measurement. The green line denotes the lowest two-way frame delay for the

statistics displayed, the orange line denotes the highest two-way frame delay for the

statistics displayed, and the blue line denotes the average two-way frame delay for the

statistics displayed. From theDelay Enddrop-downbox, select 1-Way or 2-Way to display

the one-way or two-way frame delay measurement protocols respectively.
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Delay Variation

The Delay Variation graph displays the difference between the consecutive frame delay

values. The x-axis represents the time and the y-axis represents delay variation in

microseconds. The line denotes the average one-way delay variation or the average

one-way “frame jitter” for thestatisticsdisplayed forone-way framedelaymeasurement.

The line denotes the average two-way delay variation or the average two-way “frame

jitter” for the statistics displayed for two-way delay measurement.

Related
Documentation

Performance Management Overview on page 1059•

• Monitoring Performance Management Statistics on page 1061

• Viewing Performance Management Statistics on page 1065

• Service Troubleshooting Overview on page 1071

• Performing a Configuration Audit on page 1027

Clearing Interface Statistics

By resetting interface statistics, you ensure that previous input and output errors and

packet statistics do not interfere with the current efforts to diagnose a problem. After a

graceful Routing Engine switchover, we recommend that you use the functionality to

clear interface statistics to reset the cumulative values for local statistics on the new

master Routing Engine. Sometimes, youmight require a baseline for interface statistics

to be set for computation and reporting purposes. In such cases, before you set the

baseline, youmight need to clear or restart the accumulated statistics. The system

implements the baseline by reading and storing the statistics at the time the baseline is

set and then subtracting this baseline whenever baseline-relative statistics are retrieved

To clear interface statistics:

1. From the View selector, select Service View.

The functionalities that you can configure in this view are displayed on the View pane

on the View pane.

2. Click theMonitormode icon in the Service View on the Connectivity Services Director

banner.

The workspaces that are applicable to this mode are displayed on the Tasks pane.

3. From the Service View pane, select the type of service for which you want to clear

interface statistics.

The statistics for the service typearedisplayedon themiddlepaneof themaindisplay

area.

4. From the Tasks pane, which is displayed on the right, select Tasks > Clear Interface

Statistics.
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The Clear Interface Statistics option is displayed on the Tasks pane for E-Line, E-LAN,

and IP services todeleteall the interface statistics associatedwith the selectedservice.

Adialogboxappears, prompting you toconfirm thedeletion. Thenamesof thedevices

and respective interfaces configured on the devices are shown. In this dialog box, you

can also choose to delete the interface statistics on the devices.

NOTE: You can clear interface statistics onmanaged endpoints only. For
an E-Line service with unmanaged endpoints, only managed endpoints
are shown in the endpoints table and corresponding statistics. To clear
the statistics of unmanagedendpoints, youmust clear the statistics using
the Junos CLI on the corresponding devices.

5. Select the Clear statistics fromDevices check box to clear the statistics from the

devices. This operation is equivalent to the clear interface statistics command that

you can run from the JunosOSCLI. If you select theClear statistics fromDevices check

box, the statistics are cleared on the device for all the interfaces in the service, in

addition to being removed from the Connectivity Services director database. If you

do not select this check box, the interface statistics are reset only in the application

database and not on the device.

6. ClickOK to confirm; alternatively, click Cancel to discard this operation.

The interface statistics are cleared.

Related
Documentation

Viewing MAC Table Details on page 1173•

• Viewing Interface Statistics on page 1174

• Viewing Interface Status Details on page 1176

• MPLS Connectivity Verification and Troubleshooting Methods on page 1178

• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185

• Routing Table Overview on page 1187
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ViewingMAC Table Details

The router learns unicast media access control (MAC) addresses to avoid flooding the

packets to all the ports in a bridge domain. The router creates a source MAC entry in its

source and destinationMAC tables for eachMAC address learned frompackets received

onports thatbelong to thebridgedomain. If thebridgedomain receivesacontrol protocol

data unit (PDU) which does not have a corresponding protocol configured, then the

control PDU is considered as an unknownmulticast data packet and the packets are

floodedacross all the ports that are part of the samebridgedomain. If the bridgedomain

has theprotocol corresponding to thePDUconfigured , then thecontrolPDU is considered

as a control packet and is processed by the routing engine.

MAC table aging ensures that a device tracks only active nodes on the network and that

it is able to flush out network nodes that are no longer available. TomanageMAC entries

more efficiently, you can configure an entry’s aging time,which is themaximumtime that

an entry can remain in theMAC address table before it is deleted because it has reached

its maximum age.

To view the learned MAC address information for a device associated with a particular

service:

1. From the View selector, select Service View.

The functionalities that you can configure in this view are displayed on the View pane.

2. Click theMonitormode icon in the Service View of the Connectivity Services Director

banner.

The workspaces that are applicable to this mode are displayed on the Tasks pane.

3. From the Service View pane, select the type of service for which you want to view

interface statistics.

The service statistical details are displayed in the middle pane.

4. From the Tasks pane, which is displayed on the right, select Tasks > ShowMAC Table.

The MAC Table dialog box is displayed. The name of the service is displayed in the

Service Name field.

5. From the Devices drop-down list, select the device for which you want to view the

MAC table statistical details.

The following information is displayed in the lower pane of the dialog box in a tabular

grid.

• MAC address—MAC address or addresses learned on a logical interface.

• Interface—Name of the logical interface

• Packets—Number of processed packets corresponding to the MAC address
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• Bytes—Number of processed bytes corresponding to the MAC address

• Expiring—Aging time after which theMAC address expires and is not retained in the

MAC table

6. Click Close after you complete viewing the details.

You are returned to the main or home page in Monitor Mode of Service View, which

is the Service Summary tab.

Viewing Interface Statistics

Packets that need to be forwarded to the adjacent network element or a neighboring

device along a routing pathmight be dropped by a router owing to several factors. Some

of the causes for such a loss of traffic or a block in transmission of data packets include

overloaded systemconditions, profiles andpolicies that restrict the bandwidth or priority

of traffic, network outages, or disruptionwith physical cable faults. You canuseanumber

of showcommands todetermineandanalyze the statistical countersandmetrics related

to any traffic loss and take an appropriate corrective measure. The fields displayed in

the View Interface Statistics dialog box help in diagnosing and debugging network

performance and traffic-handling efficiency problems.

To view interface statistical details:

1. From the View selector, select Service View.

The functionalities that you can configure in this view are displayed on the View pane.

2. Click theMonitormode icon in the Service View of the Connectivity Services Director

banner.

The workspaces that are applicable to this mode are displayed on the Tasks pane.

3. From the Service View pane, select the type of service for which you want to view

interface statistics.

The service statistical details are displayed in the middle pane.

4. From the Tasks pane, which is displayed on the right, select Tasks > Show Interface

Statistics.

The End Point Details dialog box is displayed for the selected service.

NOTE: The Interface Traffic Statistics dialog box displays only the
managed endpoints of the E-Line service. Unmanaged device endpoints
are not shown in the grid, and therefore the charts are also not applicable
for unmanaged endpoints of the E-Line service.

A graphical view and a tabular view of interface statistics are displayed. You can view

the interface statuses, such as errors and the operational conditions of the interfaces,
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that enables you in analyzing, troubleshooting, and rectifying problemswith dropped

packets or untransmittedbytes. Someof the causes for sucha loss of traffic or ablock

in transmission of data packets include overloaded system conditions, profiles and

policies that restrict thebandwidth or priority of traffic, network outages, or disruption

with physical cable faults. This operation is equivalent to the show interface statistics

commandthat youcan run fromthe JunosOSCLI interface.Youcansearch for specific

devices or interfaces by entering a search item and clicking the Search icon. A line

graph is displayed with the input packets and errors, and output packets and errors

shown on the vertical axis and the time shown on the horizontal axis. The following

color-coded legends reference the line graphs:

• Packets In (Orange)—Number of packets received on the interface

• Packets Out (Green)—Number of packets sent from the interface

• Errors In (Blue)—Number of inbound errors received on the interface

• Errors Out (Purple)—Number of outbound errors transmitted from the interface

The Interface Details table displays all the UNI parts of the service. Also, the physical

interface for the logical interface participating in the service is displayed.

• Device Name—Name of the device

• Interface—Name of the interface

• Interface Type—Whether the interface is physical or logical

• Encapsulation—Physical or logical encapsulation configured on the interface.

• Operational Status—Operational status of the physical interface: Up, Down.

• Admin Status—Administrative state of the interface: Enabled or Disabled.

• MAC Address—MAC address of the physical interface.

• Input Packets—Number of packets received on the interface.

• Output Packets—Number of packets sent from the interface.

• Last Poll Time—Date and time at which the statistical detail was obtained by polling

and retrieving from the device for the specified interface.

The Packet Counter tab on the right side of the page displays the following fields in a

table. It is applicable for physical interfaces only. The values displayed are in rates of

packets per second.

• Input Unicasts—Number of input unicast packets for the physical interface

• Output Unicasts—Number of output unicast packets for the physical interface

• Input Multicast—Number of input multicast packets for the physical interface

• Output Multicast—Number of output multicast packets for the physical interface

• Input Broadcast—Number of input broadcast packets for the physical interface

• Output Broadcast—Number of output broadcast packets for the physical interface

1175Copyright © 2019, Juniper Networks, Inc.

Chapter 45: Detecting and Examining the Health and Performance of Services



The Error Counter tab on the right side of the page displays the following fields in a table.

It is available for physical interfaces only. The values displayed are in rates of packets

per second.

• Input Errors—Number of errors packets received on the physical interface

• OutputDrops—Number of outgoing packets that are droppedby the physical interface

• Input Framing Errors—Number of packets with framing errors that are received on the

physical interface

• Input Drops—Number of incoming packets that are dropped by the physical interface

• Input Discards—Number of incoming packets discarded by the physical interface

• Output Errors—Number of error packets sent out from the physical interface

Related
Documentation

Clearing Interface Statistics on page 1171•

• Viewing Interface Status Details on page 1176

• MPLS Connectivity Verification and Troubleshooting Methods on page 1178

• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185

• Routing Table Overview on page 1187

Viewing Interface Status Details

You can use themonitoring functionality to view interface status or to monitor interface

bandwidth utilization and traffic statistics on the device. When you view the interface

status for a particular service, all the interfaces configured on the different devices

associated the serviceare retrievedanddisplayed. Theoperational statusof the interface,

the encapsulation type configured for the interface, and the VLAN ID specified for the

interface enable you to determine whether any changes are needed to the interface

settings to correct discrepancies with services and traffic forwarding.

To view interface status details:

1. From the View selector, select Service View.

The functionalities that you can configure in this view are displayed on the View pane.

2. Click theMonitormode icon in the Service View of the Connectivity Services Director

banner.

The workspaces that are applicable to this mode are displayed on the Tasks pane.

3. From the Service View pane, select the type of service for which you want to view

interface status information.
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The service statistical details are displayed in the middle pane.

4. From the Tasks pane, which is displayed on the right, select Tasks > Show Interface

Status.

A graphical view and a tabular view of interface configuration details are displayed.

TIP: Youcanalsoopen the InterfaceTraffic Status dialogboxby selecting
Troubleshoot > Service Audit from the Tasks pane for a specific service.

NOTE: Viewing interface information is valid on an E-Line service with
unmanaged endpoints. However, the task results are shown only for the
managed endpoint. Unmanaged endpoints are not listed in the table.

This operation is equivalent to the show interface command that you can run from

the JunosOSCLI interface.The following interface information isdisplayed ina tabular

form:

• Device Name—Name of the Device

• Interface—Name of the UNI interface

• Interface Status—Operational status of the interface: Up, Down

• Physical Encapsulation—Physical encapsulation configured on the Interface

• Logical Encapsulation—Logical encapsulation configured on the interface; else it

is not applicable

• Vlan Id—VLAN ID of the logical unit number of the interface; else it is not applicable

• Inner Vlan Id—Inner VLAN or customer VLAN tag of the interface; else it is not

applicable

• Port Mode—Operating mode for an interface can be one of the following:

• access—In thismode, the interface canbe ina singleVLANonly. Access interfaces

typically connect to single network devices such as PCs, printers, IP telephones,

and IP cameras.

• tagged-access—In this mode, the interface can accept tagged packets from one

access device. Tagged-access interfaces typically connect to servers running

Virtual machines using VEPA technology.

• trunk—In this mode, the interface can be in multiple VLANs and accept tagged

packets frommultipledevices. Trunk interfaces typically connect toother switches

and to routers on the LAN.

• NA—Not applicable

Related
Documentation

Clearing Interface Statistics on page 1171•

• Viewing MAC Table Details on page 1173
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• Viewing Interface Statistics on page 1174

• MPLS Connectivity Verification and Troubleshooting Methods on page 1178

MPLS Connectivity Verification and TroubleshootingMethods

You can use theMPLS ping application to examine the network reachability and identify

any broken links for diagnostic purposes. Before using the ping MPLS feature, make sure

that the receiving interface on the VPN or LSP remote endpoint has MPLS enabled, and

that the loopback interface on the outbound node is configured as 127.0.0.1. The source

address for MPLS probes must be a valid address on the device. When you use the ping

MPLS feature froma J Series device operating as the inbound (ingress) node at the entry

point of an LSP or VPN, the router sends probe packets into the LSP or VPN. Based on

how the LSP or VPN outbound (egress) node at the remote endpoint of the connection

replies to the probes, you can determine the connectivity of the LSP or VPN. Each probe

is an echo request sent to the LSP or VPN exit point as an MPLS packet with a UDP

payload. If the outbound node receives the echo request, it checks the contents of the

probeand returnsavalue in theUDPpayloadof the responsepacket. If thedevice receives

the response packet, it reports a successful ping response. Responses that take longer

than 2 seconds are identified as failed probes.

In IP networks, the ping and traceroute commands enable you to verify network

connectivity and find broken links or loops. In MPLS-enabled networks, you can use the

ping command to determine whether IP connectivity exists to a destination even when

the ping packets must traverse multiple LSPs. You can use the traceroute command to

determine the labels that data packets use when traversing LSPs to the destination. In

an MPLS-enabled network, however, you cannot use these IP commands to determine

MPLS connectivity to a destination. You can use the MPLS ping and trace features to

detect data plane failures in LSPs. Specificmpls ping and tracempls commands enable

you to target different types of MPLS applications and network topologies. The various

pingmpls and tracempls commands send UDP packets, known asMPLS echo requests,

to the egress LSR of MPLS packets in a given FEC. Each echo request is forwarded along

the same data path as the MPLS packets in that FEC. The echo request packets use a

destination address in the 127.0.0.0/8 range and port 3503. The default address is

127.0.0.1. This address range prevents IP from forwarding the packet, so that the echo

request must follow the MPLS data path. This behavior is different from that of the IP

pingand traceroutecommands,which send ICMPpackets to theactual destination. Each

MPLS echo request packet contains information about the FEC stack that is being

validated. LSRs that receiveanMPLSecho request respondwithMPLSecho replypackets.

(Even when MPLS is not enabled on that router, echo reply packets are sent by routers

that receiveanecho requestpacket. This situation is a transient conditionwhen the router

is receiving labeled packets. A return code in the echo replies indicates to the sending

router that no label mapping exists on the receiving router.)

The pingmpls commands perform a basic connectivity check. When the echo request

exits the tunnel at the egress LSR, the LSR sends the packet to the control plane. The

egress router validates the FEC stack to determinewhether that LSR is the actual egress

for the FEC. The egress router sends an echo reply packet back to the source address of

the echo request packet. The egress router can send the packet back bymeans of either
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the IP path or the MPLS path. The tracempls commands isolate faults in the LSP. For

these commands, successive echo request packets are sent along the path. The first

packet has aTTLof one; theTTL value is incrementedby one for each successive packet.

The first packet therefore reaches only the next hop on the path; the second packet

reaches the next router after that. Echo request packets are sent until either an echo

reply is received from the egress router for the FEC or a TTL of 32 is reached.

When a TTL expires on an LSR, that LSR sends an echo reply packet back to the source.

For transit routers, the echo reply indicates that downstreammapping exists for the FEC,

meaning that the packet would have been forwarded if the TTL had not expired. The

egress router sends an echo reply packet verifying that it is the egress. Although you

cannot send IPv6UDPpackets forMPLSping, you canuse thepingmpls l3vpn command

with an IPv6 prefix to investigate IPv6 VPNs.

For IP services, the pingmpls l3vpn command is used to examine the operability of a

MPLS Layer 3 VPN connection. For VPLS routing instances, the ping vpls instance

command is used to examine the reachability of a VPLS instance. The ping vpls instance

command uses a difference command structure and operates in a different fashion than

the pingmpls command used for VPNs and Layer 2 circuits. For E-Line services, the

pseudowire ping mechanism is used to verify the network accessibility and identify any

problems in the link.

Related
Documentation

Clearing Interface Statistics on page 1171•

• Viewing MAC Table Details on page 1173

• Viewing Interface Statistics on page 1174

• Viewing Interface Status Details on page 1176

• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185

• Routing Table Overview on page 1187

UsingMPLS Ping

Use the MPLS ping functionality to diagnose the state of label-switched paths (LSPs),

Layer 2 and Layer 3 virtual private networks (VPNs), and Layer 2 circuits. You can ping

an MPLS endpoint using various options. You can send variations of ICMP echo request

packets to the specified MPLS endpoint.

When you use the ping MPLS task from a Junos OS operating as the inbound (ingress)

node at the entry point of an LSP or VPN, the routing platform sends probe packets into

the LSP or VPN. Based on how the LSP or VPN outbound (egress) node at the remote

endpoint of the connection replies to the probes, you can determine the connectivity of

the LSP or VPN.
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Each probe is an echo request sent to the LSP or VPN exit point as anMPLS packet with

a UDP payload. If the outbound node receives the echo request, it checks the contents

of the probe and returns a value in the UDP payload of the response packet. If the Junos

OS receives the response packet, it reports a successful ping response.

Responses that take longer than 2 seconds are identified as failed probes.

Table 178onpage 1180 lists thepingMPLStasks, summarizes their functions, and identifies

corresponding CLI show commands you can enter in the CLI interface of a device.

Table 178: Ping MPLS Tasks Summary and the Corresponding CLI show Commands

Additional InformationFunction
Corresponding CLI
CommandPing MPLS Task

When an RSVP-signaled LSP has
several paths, the JunosOSsends the
ping requests on the path that is
currently active.

Checks the operability of an LSP that
has been set up by the Resource
Reservation Protocol (RSVP). The
JunosOSpingsaparticular LSPusing
the configured LSP name.

pingmpls rsvpPing RSVP-signaled
LSP

When an LDP-signaled LSP has
several gateways, the JunosOSsends
the ping requests through the first
gateway.

Ping requests sent to LDP-signaled
LSPs use only the master routing
instance.

Checks the operability of an LSP that
has been set up by the Label
Distribution Protocol (LDP). The
JunosOSpingsaparticular LSPusing
the forwarding equivalence class
(FEC) prefix and length.

pingmpls ldpPingLDP-signaledLSP

The Junos OS does not test the
connection between a PE router and
a customer edge (CE) router.

Checks the operability of the
connections related toaLayer 3VPN.
The Junos OS tests whether a prefix
is present in a provider edge (PE)
router's VPN routing and forwarding
(VRF) table, by means of a Layer 3
VPN destination prefix.

pingmpls l3vpnPing LSP to Layer 3
VPN prefix

For information about interface
names, see the CLI Explorer.

Checks the operability of the
connections related toaLayer 2VPN.
The Junos OS directs outgoing
request probes out the specified
interface.

pingmpls l2vpn
interface

Ping LSP for a Layer 2
VPN connection by
interface

Checks the operability of the
connections related toaLayer 2VPN.
The JunosOSpingsonacombination
of the Layer 2 VPN routing instance
name, the local site identifier, and the
remote site identifier, to test the
integrity of the Layer 2 VPN circuit
(specifiedby the identifiers)between
the inboundandoutboundPErouters.

pingmpls l2vpn
instance

Ping LSP for a Layer 2
VPN connection by
instance
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Table 178: Ping MPLS Tasks Summary and the Corresponding CLI show Commands (continued)

Additional InformationFunction
Corresponding CLI
CommandPing MPLS Task

Checks the operability of the Layer 2
circuit connections. The Junos OS
directs outgoing request probes out
the specified interface.

pingmpls l2circuit
interface

Ping LSP to a Layer 2
circuit remote site by
interface

Checks the operability of the Layer 2
circuit connections. The Junos OS
pings on a combination of the IPv4
prefix and the virtual circuit identifier
on the outbound PE router, testing
the integrity of the Layer 2 circuit
between the inbound and outbound
PE routers.

pingmpls l2circuit
virtual-circuit

Ping LSP to a Layer 2
circuit remote site by
VCI

Checks the operability of an LSP
endpoint. The JunosOSpings an LSP
endpoint using either an LDP FEC
prefix or an RSVP LSP endpoint
address.

pingmpls
lsp-end-point

Ping end point of LSP

Related
Documentation

Clearing Interface Statistics on page 1171•

• Viewing MAC Table Details on page 1173

• Viewing Interface Statistics on page 1174

• Viewing Interface Status Details on page 1176

• MPLS Connectivity Verification and Troubleshooting Methods on page 1178

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185

• Routing Table Overview on page 1187

Pinging VPNs, VPLS, and Layer 2 Circuits

For testing purposes, you can ping Layer 2 VPNs, Layer 3 VPNs, and Layer 2 circuits by

using the pingmpls command. The pingmpls command helps to verify that a VPN or

circuit has been enabled and tests the integrity of the VPN or Layer 2 circuit connection

between the PE routers. It does not test the connection between a PE router and a CE

router. To ping a VPLS routing instance, you issue a ping vpls instance command.

You issue the pingmpls command from the ingress PE router of theVPNor Layer 2 circuit

to the egress PE router of the same VPN or Layer 2 circuit. When you execute the ping

mpls command, echo requests are sent as MPLS packets.

Thepayload isaUserDatagramProtocol (UDP)packet forwarded to theaddress 127.0.0.1.

The contents of this packet are defined in RFC 4379, Detecting Multi-Protocol Label
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Switched (MPLS) Data Plane Failures. The label and interface information for building

and sending this information as anMPLS packet is the same as for standard VPN traffic,

but the time-to-live (TTL) of the innermost label is set to 1.

When the echo request arrives at the egress PE router, the contents of the packet are

checked, and then a reply that contains the correct return is sent by means of UDP. The

PE router sending the echo request waits to receive an echo reply after a timeout of

2 seconds (you cannot configure this value).

Youmust configure MPLS at the [edit protocolsmpls] hierarchy level on the egress PE

router (the router receiving theMPLS echo packets) to be able to ping the VPNor Layer 2

circuit. Youmust also configure the address 127.0.0.1/32 on the egress PE router’s lo0

interface. If this is not configured, the egress PE router does not have this forwarding

entry and therefore simply drops the incoming MPLS pings.

The pingmpls command has the following limitations:

• You cannot ping an IPv6 destination prefix.

• You cannot ping a VPN or Layer 2 circuit from a router that is attempting a graceful

restart.

• You cannot ping a VPN or Layer 2 circuit from a logical system.

You can also determine whether an LSP linking two PE routers in a VPN is up by pinging

the end point address of the LSP. The command you use to ping anMPLS LSP end point

is pingmpls lsp-end-point address. This command tells you what type of LSP (RSVP or

LDP) terminates at the address specified and whether that LSP is up or down.

Related
Documentation

Clearing Interface Statistics on page 1171•

• Viewing MAC Table Details on page 1173

• Viewing Interface Statistics on page 1174

• Viewing Interface Status Details on page 1176

• MPLS Connectivity Verification and Troubleshooting Methods on page 1178

• Using MPLS Ping on page 1179

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185

• Routing Table Overview on page 1187
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Monitoring Network Reachability by Using theMPLS Ping Capability

In IP networks, you can use the ping and traceroute commands to verify network

connectivity and find broken links or loops. In an MPLS-enabled network, you can use

thempls ping and tracempls commands to detect plane failures in different types of

MPLS applications and network topologies.

To perform an MPLS ping operation:

1. From the View selector, select Service View.

The functionalities that you can configure in this view are displayed on the View pane

in the GUI window.

2. Click theMonitormode icon in the Service View on the Connectivity Services Director

banner.

The workspaces that are applicable to this mode are displayed in the GUI window.

3. On the Service View pane, on the left, click the plus sign (+) next to Network Services

to expand the tree and display the different service types that you can configure.

4. Click the plus sign (+) beside Connectivity to view services based on protocols.

• Expand the E-Line Services tree to select an E-Line service.

• Expand the E-LAN Services tree to select an E-LAN service.

5. From the Tasks pane, selectMPLS Ping.

The MPLS Ping Service Type - Service Namewindow appears.

NOTE: Awarningmessage is displayed in the window stating that the
MPLS echo request to the devicemight be timed out if the response is
delayed from the device.

NOTE: MPLS ping is supported only frommanaged endpoints to
unmanaged endpoints. Therefore, unmanaged endpoints are not listed
in the Source column.

For a BGP-based E-Line service, with one endpoint as an unmanaged
device, the MPLS ping utility is not supported because the remote site ID
of the unmanaged device is not available as part of the service
configuration.The remotesite ID is required forMPLSping fromamanaged
to an unmanaged endpoint.

6. In the Endpoint Device section, do the following:
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The source device sends an MPLS echo request packet to the specified IP or IPv6

address or, alternatively, sends MPLS echo packets to the egress node in a

point-to-multipoint LSP. The MPLS echo request packets and echo reply packets

created by this command use the LDP IPv4 LSP sub-TLV described in RFC

4379—DetectingMulti-Protocol LabelSwitched(MPLS)DataPlaneFailures (February

2006).

a. From the Source Device list, select the source device, whose IP address is to be

used as the packet source address.

b. From the Destination Device list, select the target endpoint, whose IP address is

used as the target IP address for MPLS ping packets or echo requests.

7. On the Advance Options list, do the following:

a. In the Ping count (packets) field, enter the number of packets to send to the

destination address, in the range 0–4294967295. The default value is 5 and 0

(zero) means ping forever.

b. In the Ping size (bytes) field, specify the number of bytes comprising the MPLS

packet, including theheader, in the range0–64000. Thedefault value is 100bytes.

c. In the ForwardingClass field, specify the valueof the forwarding class for theMPLS

ping packets.

d. In the Sweep field, configure the payload size, which enables you to vary the sizes

of theechopacketsbeingsent.Thiscapability isuseful fordetermining theminimum

sizesof theMTUsconfiguredon thenodesalong thepath to thedestinationaddress.

This reduces packet fragmentation, which contributes to performance problems.

The default is not to sweep; all packets are of the same size.

e. From the Reply Mode field, select the reply mode for the echo request packet:

• IP-UDP—Specifies that the echo request packet is an IPv4 UDP packet

• Application Level Control Channel—Specifies that the echo request packet is

replied using the application-level control channel connection.

8. From the Format list, select XML to display the result or the response of the MPLS

ping operation in XML format. Alternatively, select ASCII to display the output in the

format inwhich it is displayed on theCLI. The Junos XMLAPI is an XML representation

of Junos configuration statements and operational mode commands. Junos XML

configuration tag elements are the contents to which the Junos XML protocol

operations apply. Junos XML operational tag elements are equivalent in function to

operational mode commands on the CLI, which administrators use to retrieve status

information for a device.

9. Click Ping to start the ping operation and to send the MPLS echo requests from the

source to the destination device.

The results of the ping operation are displayed in the Response Console pane at the

bottom of the MPLS Ping Service Type - Service Namewindow.
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Related
Documentation

MPLS Connectivity Verification and Troubleshooting Methods on page 1178•

• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185

Monitoring Network Reachability by Using the Layer 3 VPN Ping Capability

In IP networks, you can use the ping and traceroute commands to verify network

connectivity and find broken links or loops. In an MPLS-enabled network, you can use

thempls ping and tracempls commands to detect plane failures in different types of

MPLS applications and network topologies.

1. From the View selector, select Service View.

The functionalities that you can configure in this view are displayed on the View pane.

2. Click theMonitormode icon in the Service View of the Connectivity Services Director

banner.

The workspaces that are applicable to this mode are displayed on the Tasks pane.

3. Click the plus sign (+) beside Connectivity to view services based on protocols.

4. Expand the IP Services tree to select an IP service.

5. From the Tasks pane, selectMPLS Ping.

The MPLS Ping Service Type - Service Namewindow appears.

6. In the Endpoint Device section, do the following:

The source device sends an MPLS echo request packet to the specified IP or IPv6

address or, alternatively, sends MPLS echo packets to the egress node in a

point-to-multipoint LSP. The MPLS echo request packets and echo reply packets

created by this command use the LDP IPv4 LSP sub-TLV described in RFC

4379—DetectingMulti-Protocol LabelSwitched(MPLS)DataPlaneFailures (February

2006).

a. From the Source Device list, select the source device, whose IP address is to be

used as the packet source address.

b. From the Destination Device list, select the target endpoint, whose IP address is

used as the target IP address for MPLS ping packets or echo requests.

7. On the Advance Options list, do the following:
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a. In the Ping count (packets) field, enter the number of packets to send to the

destination address, in the range 0–4294967295. The default value is 5 and 0

(zero) means ping forever.

b. In the Ping size (bytes) field, specify the number of bytes comprising the MPLS

packet, including theheader, in the range0–64000. Thedefault value is 100bytes.

c. In the ForwardingClass field, specify the valueof the forwarding class for theMPLS

ping packets.

d. In the Sweep field, configure the payload size, which enables you to vary the sizes

of theechopacketsbeingsent.Thiscapability isuseful fordetermining theminimum

sizesof theMTUsconfiguredon thenodesalong thepath to thedestinationaddress.

This reduces packet fragmentation, which contributes to performance problems.

The default is not to sweep; all packets are of the same size.

e. From the Reply Mode field, select the reply mode for the echo request packet:

• IP-UDP—Specifies that the echo request packet is an IPv4 UDP packet

• Application Level Control Channel—Specifies that the echo request packet is

replied using the application-level control channel connection.

8. From the Format list, select XML to display the result or the response of the MPLS

ping operation in XML format. Alternatively, select ASCII to display the output in the

format inwhich it is displayed on theCLI. The Junos XMLAPI is an XML representation

of Junos configuration statements and operational mode commands. Junos XML

configuration tag elements are the contents to which the Junos XML protocol

operations apply. Junos XML operational tag elements are equivalent in function to

operational mode commands on the CLI, which administrators use to retrieve status

information for a device.

9. Click Ping to start the ping operation and to send the MPLS echo requests from the

source to the destination device.

The results of the ping operation are displayed in the Response Console pane at the

bottom of the MPLS Ping Service Type - Service Namewindow.

Related
Documentation

Clearing Interface Statistics on page 1171•

• Viewing MAC Table Details on page 1173

• Viewing Interface Statistics on page 1174

• Viewing Interface Status Details on page 1176

• MPLS Connectivity Verification and Troubleshooting Methods on page 1178

• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183
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Routing Table Overview

Typically, routers are attached to multiple networks and are responsible for directing

traffic across these networks. Each router maintains a routing table, which is a list of

known networks and directions on how to reach them.While processing an incoming

packet on a security device, the router performs a routing table lookup to find the

appropriate interface that leads to the destination address.

Each entry in a routing table—called a route entryor route—is identified by thedestination

network to which traffic can be forwarded. The destination network, in the form of an IP

address and netmask, can be an IP network, subnetwork, supernet, or a host. Routing

table entries can originate from the following sources:

• Directly connected networks (the destination network is the IP address that you assign

to an interface in Route mode)

• Dynamic routing protocols, such as OSPF, BGP, or RIP

• Routes that are imported from other routers or virtual routers

• Statically configured routes

You can configure three types of static routes: destination-based, source-based, and

source-interface-based routing. For each type of static route, you configure the following

information:

NOTE: Source-interface-based routing is supported in ScreenOS 5.1 and
later.

• The interface on the security device on which traffic for the destination network is

forwarded.

• The next-hop, which can be either another virtual router on the security device or a

gateway IP address (usually a router address).

• The protocol fromwhich the route is derived.

Related
Documentation

MPLS Connectivity Verification and Troubleshooting Methods on page 1178•

• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

Viewing Routing Table Details

TheRoutingTablewindowenables youview the routing table information for the selected

virtual routing instance. For IP services, you can determine which LSPs or tunnels are

being used by looking at the routing tables.
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To view extensive information about the active entries in the routing tables for a device

associated with a particular service:

1. From theView selector, select ServiceView. The functionalities that you can configure

in this view are displayed.

2. Click the Monitor mode icon in the Service View of the Connectivity Services Director

banner. The workspaces that are applicable to this mode are displayed.

3. From the Service View pane, select the IP service for which youwant to view interface

statistics. The service statistical details are displayed in the middle pane.

4. From the task pane, which is displayed on the rightmost pane, select Tasks > Routing

Table. The Routing Table window is displayed. The left pane of the window displays

the names of the devices that are associated with the particular service.

5. From the Device Name pane, select the device for which youwant to view the routing

table information. The following information is displayed in the right pane of the

window in a tabular grid.

Table 179: Routing TableWindow Field Descriptions

DescriptionName

Name of the service for which routing table statistics are displayed.Service Name

Number of destinations for which routes are present in the routing table.Number of Destinations

Total number of routes in the routing table.Number of Routes

Number of routes that are active.Active Routes

Number of routes that are not used because of routing policy.Hidden Routes

Number of routes that are in the hold-down state before being declared inactive.Hold-down Routes

Route destination (for example:10.0.0.1/24). Sometimes the route information is presented in
another format, such as:

• MPLS-label (for example, 80001).

• interface-name (for example, ge-1/0/2).

• neighbor-address:control-word-status:encapsulation type:vc-id :source (Layer 2 circuit only. For
example, 10.1.1.195:NoCtrlWord:1:1:Local/96):
• neighbor-address—Address of the neighbor.

• control-word-status—Whether the use of the controlword has been negotiated for this virtual
circuit: NoCtrlWord or CtrlWord.

• encapsulation type—Type of encapsulation, represented by a number: (1) Frame Relay DLCI,
(2) ATM AAL5 VCC transport, (3) ATM transparent cell transport, (4) Ethernet, (5) VLAN
Ethernet, (6) HDLC, (7) PPP, (8) ATM VCC cell transport, (10) ATM VPC cell transport.

• vc-id—Virtual circuit identifier.

• source—Source of the advertisement: Local or Remote.

Destination Prefix

State of the route.State
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Table 179: Routing TableWindow Field Descriptions (continued)

DescriptionName

Name of the protocol fromwhich the route was learned. For example,OSPF, RSVP, and Static.Protocol

Preferred protocol for this routing instance. Junos OS uses this preference to choose which routes
become active in the routing table.

Protocol Preference

Displays how long since the route was learned.Age

Cost value of the indicated route. For routes within an AS, the cost is determined by the IGP and
the individual protocol metrics. For external routes, destinations, or routing domains, the cost is
determined by a preference value.

BGPMetric

Ametric used by BGP sessions to indicate the degree of preference for an external route. The route
with the highest local preference value is preferred.

BGP Local Preference

AS path through which the route was learned. The letters at the end of the AS path indicate the
path origin, providing an indication of the state of the route at the point at which the AS path
originated:

• I—IGP.

• E—EGP.

• Recorded—The AS path is recorded by the sample process (sampled).

• ?—Incomplete; typically, the AS path was aggregated.

When AS path numbers are included in the route, the format is as follows:

• [ ]—Brackets enclose the local AS number associated with the AS path if more than one AS
number is configured on the routing device, or if AS path prepending is configured.

• { }—Braces encloseASsets,whichare groupsofASnumbers inwhich theorder doesnotmatter.
A set commonly results from route aggregation. The numbers in each AS set are displayed in
ascending order.

• ( )—Parentheses enclose a confederation.

• ( [ ] )—Parentheses and brackets enclose a confederation set.

AS Path

Next hop to the destination. An angle bracket (>) indicates that the route is the selected route.

If the destination is Discard, traffic is dropped.

Next Hop Type

The local interface used to reach the next hop.Local Interface

Next-hop address of the interface.Next Hop

MPLS label and operation occurring at the next hop. The operation can be pop (where a label is
removed from the top of the stack), push (where another label is added to the label stack), or
swap (where a label is replaced by another label).

MPLS Label

6. Click Close after you complete viewing the details. You are returned to the main or

home page in Monitor Mode of Service View, which is the Service Summary tab.
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PART 14

Working in Fault Mode

• About Fault Mode on page 1193

• Using Fault Mode on page 1195

• Fault Reference on page 1205
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CHAPTER 46

About Fault Mode

• About Fault Mode in All Views of Connectivity Services Director on page 1193

• Understanding the Tasks Pane in Fault Mode on page 1194

About Fault Mode in All Views of Connectivity Services Director

Fault mode in Connectivity Services Director provides you visibility into your network

status and performance by displaying alarms and events generated on devices and

configured services on devices. Connectivity Services Director monitors its managed

devices andmaintains the information it collects from the devices in a database. Fault

mode displays this information in easy-to-understand graphs and in tables that you can

sort and filter, allowing you to quickly visualize the state of your network, spot trends

developing over time, and find important details. When certain types of events are

persistent, or when the condition causing the event crosses a threshold, SNMP sends a

notification, also called a trap to Connectivity Services Director.

Connectivity Services Director correlates traps, describing a condition, into an alarm . For

example, multiple power supply traps coming from a device are correlated into a single

power supply alarm for the device. Themain purpose and benefit of monitoring

functionalities is toallow theoperators toquicklymonitor thehealth (working condition),

operating efficiency, traffic-handling capacity, and performance status of the managed

devices and configured services such as E-Line, E-LAN, and IP.

Themonitoring mechanism is tool that enables the operator to understand the network

health and status by drilling down to all the components of a device. The device status

is marked as green, red, orange, or blue, based on the health, availability, performance

and other important key performance indicators.

• Red denotes an emergency condition, which is a systempanic or other conditions that

cause the routingplatformto stop functioning. It also indicates that thedevice is offline

or turned down.

• Orange denotes an alert, which can be conditions thatmust be corrected immediately,

such as a corrupted system database.
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• Yellow indicates a notice, which signifies conditions that are not error conditions but

are of interest or might warrant special handling. It can also include a severity level

equivalent to informational or debugging messages.

• Blue denotes an informational message; no action is necessary. Informational alarms

donot necessarily indicate anerror. It could indicate that adevice or entity has changed

state.

Related
Documentation

About Build Mode in Service View of Connectivity Services Director on page 43•

• About Deploy Mode in Service View of Connectivity Services Director on page 45

• About Monitor Mode in Service View of Connectivity Services Director on page 47

Understanding the Tasks Pane in Fault Mode

The Tasks pane in Fault mode provides you with a set of tools for effectively managing

alarms on your system.

From the Tasks pane, you can:

• Filter known alarms to locate a specific alarm or error condition by clicking Search

Alarms. Use this task to isolate alarms that occurred during a known time-frame or

thathaveannotationsassociatedwith them.Althougheachof theFaultmodemonitors

can sort the alarms, Search Alarms enable you to submit multiple search and sort

arguments as part of your search query.

In addition,ConnectivityServicesDirector enables you togroup the tasks that youperform

frequently and create a list of key tasks. You can add any task from the Tasks pane to

the Key Tasks list by selecting a task and clicking the plus (+) sign that appears adjacent

to the task. For somemodes, you can see that Connectivity Services Director has

predefined some key tasks for you. You canmodify this set of tasks to suit your

requirements. This feature is available in Task pane irrespective of your current mode,

scope, or view.

Related
Documentation

• Understanding the Service View Tasks Pane in Build Mode on page 35

• Understanding the Service View Tasks Pane in Deploy Mode on page 38

• Understanding the Service View Tasks Pane in Monitor Mode on page 40

• About Build Mode in Service View of Connectivity Services Director on page 43

• About Deploy Mode in Service View of Connectivity Services Director on page 45

• About Fault Mode in All Views of Connectivity Services Director on page 47

• About Monitor Mode in Service View of Connectivity Services Director on page 47
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CHAPTER 47

Using Fault Mode

• Using Fault Management Monitors on page 1195

• Alarm Severities and States Overview on page 1198

• Events and Alarms Overview on page 1199

• Customizing Alarms on page 1200

• Changing Alarm State on page 1200

• Searching Alarms on page 1201

Using Fault Management Monitors

The Fault mode shows you information about the health of your network and changing

conditionsof your equipment.UseFaultmode to findproblemswithequipment, pinpoint

security attacks, or to analyze trends and categories of errors.

This topic describes:

• What Are Events and Alarms? on page 1195

• Alarm Severity on page 1196

• Alarm Classification on page 1196

• Alarm State on page 1197

• Alarm Notifications on page 1197

• Threshold Alarms on page 1198

What Are Events and Alarms?

Activity on a network device consists of a series of events. A software component on the

network device, called an entity, is responsible for running the Simple Network

Management Protocol (SNMP) to log andmonitor these events. When certain types of

events arepersistent, orwhen thecondition causing theevent crossesa threshold, SNMP

sends a notification, also called a trap to Connectivity Services Director. Connectivity

Services Director correlates traps, describing a condition, into an alarm . For example,

multiple power supply traps coming from a device are correlated into a single power

supply alarm for the device.

There aremany types of alarms. An alarm can be as routine aswhen the device changes

state or as serious as when a power supply has failed. When an alarm is sent, or raised,
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it stays raised until the triggering condition is resolved or cleared. The system can clear

the alarmwhen the state changes again or an administrator can clear it manually, which

indicates that the condition is now resolved.

SNMP also plays another role in Connectivity Services Director. Enabling devices for

SNMPwith the appropriate read-only V1/V2/V3 credentials, can speed up device

discovery.

Alarm Severity

Alarms are ranked by their impact to the network. The following list shows the ranking

of alarms in Connectivity Services Director from alarms that have themost impact to

alarms that have the least impact on the network. It also shows the color scheme

associated with each level of severity that is reflected in related graphs.

Critical (Red)—A critical condition exists; immediate action is necessary.

Major (Orange)—Amajor error has occurred; escalate or notify as necessary.

Minor (Yellow)—Aminor error has occurred; notify or monitor the condition.

Info (Blue)—An informational message; no action is necessary. Informational alarms do
not necessarily indicate an error. It could indicate that a device or entity has changed

state.

Administrators can override the default severity of an alarmand set the severity tomatch

their inhouse guidelines. Changing the severity level for an alarm is done on the Fault tab

of System Preferences.

Alarm Classification

Connectivity Services Director organizes alarms into categories so you can view trends

in the types of errors occurring on a network. These categories, shown in

Table 180onpage 1196are derived from theSNMPManagement InformationBase (MIB)

that is the information database ormodule containing the trap information for the event.

Table 180: Connectivity Services Director Alarm Classifications

DescriptionCategory

IndicatesalarmsforBidirectionalForwardingDetectionsessions.Thesealarmsaregenerated
from routing devices.

BFD

Indicates alarms for BGP4.BGP

Indicates alarms for device hardware, in this case, routers.Chassis

Indicates alarms about wireless network clusters andmobility domains.Cluster/Modo

Indicates alarms for configuration management.Configuration

Indicate device alarms.Controllers
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Table 180: Connectivity Services Director Alarm Classifications (continued)

DescriptionCategory

Indicates class of service alarms.CoS

Indicates local server DHCP alarms.DHCP

Indicates Digital Optical Monitoring alarms that are generated from optical interfaces.DOM

Indicates alarms that are common to all network devices, such as link up/down or
authentication.

General

Indicates MAC address alarms generated from the Layer 2 Address Learning Daemon
(L2ALD).

L2ALD

Indicates alarms generated by Layer 2 Control Protocol features.L2CP

Indicates an alarm for when MAC addresses are learned or removed from the forwarding
database of the monitored device.

MACFDB

Indicates alarms that do not fit into the other categories.Misc

Indicates alarms generated when LSP or VPN services are impactedNetwork Service

Indicates alarms that occur on a passive monitoring interface.PassiveMonitoring

Indicates alarms that a generated during a Ping request.Ping

Indicates RMON alarmsRMon

Alarm State

Once an alarm is active, it has one of these states:

• Active—Alarms that are current and not yet acknowledged or cleared.

• Cleared—Alarms that are resolved and the device or entity has returned to normal

operation.

Some alarm states go directly from active to cleared state and require little to no

administrativeeffort.However, otheralarmswithahighseverity shouldbeacknowledged

and investigated.

In addition to acknowledging and clearing an alarm, you can assign an alarm to someone

and you can append a note or annotation to an alarm. Annotations are helpful for

documenting the resolution of an alarmor timeestimates for a fix. Changes to analarm’s

state are made through the Alarm State monitor in Fault mode.

AlarmNotifications

Alarms can be enabled for email notification. When an alarmwith notification enabled

is generated, an email is sent to a set of specified addresses. There is a list of global email
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addresses that receivenotifications fromall alarmswithnotificationenabled.Eachalarm

type can also have a list of addresses that receive notification when that alarm type is

generated. Administrators can enable notification for alarm types and specify addresses

to receive email notifications. These tasks are done on the Fault tab of System

Preferences.

Threshold Alarms

Threshold alarms are alarms that are generated when amonitored value crosses the

configured threshold.Theyprovideenhancedvisibility intopotential issueson thenetwork.

Administrators configure andmanage threshold alarms the sameway as other alarms,

and can set the threshold level of individual threshold alarms on the Fault tab of System

Preferences.

Related
Documentation

Alarm Severities and States Overview on page 1198•

• Events and Alarms Overview on page 1199

• Customizing Alarms on page 1200

• Changing Alarm State on page 1200

• Searching Alarms on page 1201

• Alarm Detail Monitor (Service View) on page 1208

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213

• Alarms by State Monitor on page 1214

• Current Active Alarms Monitor (Service View) on page 1212

Alarm Severities and States Overview

By default, the Junos SpaceNetworkManagement Platform ismonitored using a built-in

SNMPmanager. The Junos Space Network Management Platform node is listed in the

node list (NetworkMonitoring>NodeList), and is referred toas the JunosSpaceNetwork

Management Platform node.

Alarm Severity

Alarms are ranked by their impact to the network. The following list shows the ranking

of alarms in Connectivity Services Director from alarms that have themost impact to

alarms that have the least impact on the network. It also shows the color scheme

associated with each level of severity that is reflected in related graphs.

Critical (Red)—A critical condition exists; immediate action is necessary.

Major (Orange)—Amajor error has occurred; escalate or notify as necessary.
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Minor (Yellow)—Aminor error has occurred; notify or monitor the condition.

Info (Blue)—An informational message; no action is necessary. Informational alarms do
not necessarily indicate an error. It could indicate that a device or entity has changed

state.

Administrators can override the default severity of an alarmand set the severity tomatch

their inhouse guidelines. Changing the severity level for an alarm is done on the Fault tab

of System Preferences.

Alarm State

Once an alarm is active, it has one of these states:

• Active—Alarms that are current and not yet acknowledged or cleared.

• Cleared—Alarms that are resolved and the device or entity has returned to normal

operation.

Some alarm states go directly from active to cleared state and require little to no

administrativeeffort.However, otheralarmswithahighseverity shouldbeacknowledged

and investigated.

In addition to acknowledging and clearing an alarm, you can assign an alarm to someone

and you can append a note or annotation to an alarm. Annotations are helpful for

documenting the resolution of an alarmor timeestimates for a fix. Changes to analarm’s

state are made through the Alarm State monitor in Fault mode.

Events and Alarms Overview

Activity on a network device consists of a series of events. A software component on the

network device, called an entity, is responsible for running the Simple Network

Management Protocol (SNMP) to log andmonitor these events. When certain types of

events arepersistent, orwhen thecondition causing theevent crossesa threshold, SNMP

sends a notification, also called a trap to Connectivity Services Director. Connectivity

Services Director correlates traps, describing a condition, into an alarm . For example,

multiple power supply traps coming from a device are correlated into a single power

supply alarm for the device. There are many types of alarms. An alarm can be as routine

aswhen the device changes state or as serious aswhen a power supply has failed.When

analarm is sent, or raised, it stays raiseduntil the triggering condition is resolvedor cleared.

The system can clear the alarmwhen the state changes again or an administrator can

clear it manually, which indicates that the condition is now resolved. SNMP also plays

another role in Connectivity Services Director. Enabling devices for SNMPwith the

appropriate read-only V1/V2/V3 credentials, can speed up device discovery.

Alarm Severity

Alarms are ranked by their impact to the network. The following list shows the ranking

in Connectivity Services Director frommost impact to least impact on the network. It

also shows the color scheme associated with each level of severity that is reflected in

related graphs.
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• Critical (Red)—A critical condition exists; immediate action is necessary.

• Major (Orange)—Amajor error has occurred; escalate or notify as necessary.

• Minor (Yellow)—Aminor error has occurred; notify or monitor the condition.

Administrators can override the default severity of an alarm and set the severity to

match their inhouse guidelines. Changing the severity level for an alarm is done on the

Alarm Settings page in system Preferences.

Customizing Alarms

Ensure that all devices are enabled for SNMP trap forwarding. This task, Set SNMP Trap

Configuration, is found in Deploy mode.

Connectivity Services Director enables you to tailor alarms by:

• Enabling or disabling individual alarms.

• Setting the amount of time alarms are retained in the system.

YoucancustomizealarmsusingPreferences in theConnectivityServicesDirector banner.

Related
Documentation

Setting Up User and System Preferences•

Changing Alarm State

When an alarmbecomes active, it remains active until either the systemdetermines that

the condition is resolved or system personnel change the status. Critical alarms always

need immediate attention and seldom resolve on their own, but informationalmessages

are often expected actions and results. When a condition is severe or persistent and

needs attention, follow these steps:

1. Locate the alarm.

a. Click Fault in the Connectivity Services Director banner to enter Fault mode.

b. Click theAlarmDetails icon on any of themonitors to open theAlarmDetails page.

Scroll or sort the alarms to find the alarm in question. As an alternatemethod, click

Search Alarms in the Tasks pane and filter the active alarm list.

c. Select the alarm.

2. Review the Event Details that triggered the trap for the alarm. These events provide

insight into the cause or location of the problem.
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3. Click Acknowledge to indicate that the problem is now known. You should receive a

message saying the alarm is acknowledged.

4. Depending whether you can resolve the alarmwith the information at hand or not,

either assign the alarm to amember of your staff or clear the alarm. Click Clear to

clear the alarm or click Assign and fill in the assignee’s name.

At any time in the life cycle of an alarm, you can attach information about the alarm to

the alarm record by clicking Annotate. Fill in your name in the Notes By field and add the

note description in the Notes field. Click Add to record the annotation.

Related
Documentation

Using Fault Management Monitors on page 1195•

• Alarm Severities and States Overview on page 1198

• Events and Alarms Overview on page 1199

• Customizing Alarms on page 1200

• Searching Alarms on page 1201

• Alarm Detail Monitor (Service View) on page 1208

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213

• Alarms by State Monitor on page 1214

• Current Active Alarms Monitor (Service View) on page 1212

Searching Alarms

Use Search Alarms, available from the Tasks pane, to filter and isolate information about

a specific alarm. Use this page to specify complex sorting and filtering criteria for all

alarms.

Each field in the Search Alarmwindow helps narrow the current list of alarms. Themore

search items you specify, the more specific your results. All fields are optional.

1. Select or type the known descriptors for the alarm. These fields are described in

Table 181 on page 1202.

2. Click Search to run the query. The Alarms Details page opens with the results of your

search.

3. Review the alarm. From this page you can change the state of the alarm, annotate,

or assign the alarm to personnel. For more information about changing the state of

an alarm, view “Changing Alarm State” on page 1200.
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Table 181: Alarm Search Fields

DescriptionSearch Criteria

Use the list to select which alarm states to search for:

• All—Alarms of all states.

• Active—Alarms that are current and not yet acknowledged or cleared.

• Clear—Alarms that are resolved and the device or entity has returned to normal
operation.

State

Fill in one of the available alarm categories:

• AP/Radio

• BFD

• BGP

• Chassis

• ClientAndUserSession

• Cluster/Modo

• Configuration

• Controllers

• CoS

• DHCP

• DOM

• FlowCollection

• GENERAL

• GenericEvent

• L2ALD

• L2CP

• MACFDB

• Misc

• PassiveMonitoring

• Ping

• RFDetect

• RMon

• SONET

• SONETAPS

• VirtualChassis

• VNetwork

Category

Pull down the list to select the severity level. Not all possible alarm severities are listed.
Only the severity levels of your current active alarms are shown. Possible selections are:

• Critical

• Major

• Minor

• Info

Severity

Advanced Search Criteria

Pull down the calendar and select the starting date of the search.(from) Date
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Table 181: Alarm Search Fields (continued)

DescriptionSearch Criteria

Pull down the list to select the starting time of the search. Search times are in military
(24-hour) clock format in 30minute intervals.

(from) Time

Pull down the calendar and select the ending date of the search.(to) Date

Pull down the list to select the ending time of the search. Search times are in military
(24-hour) clock format in 30minute intervals.

(to) Time

Enter any keywords or phases that were listed in an existing annotation.Notes

Related
Documentation

• Using Fault Management Monitors on page 1195

• Alarm Severities and States Overview on page 1198

• Events and Alarms Overview on page 1199

• Customizing Alarms on page 1200

• Changing Alarm State on page 1200

• Alarm Detail Monitor (Service View) on page 1208

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213

• Alarms by State Monitor on page 1214

• Current Active Alarms Monitor (Service View) on page 1212
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CHAPTER 48

Fault Reference

• Alarm Detail Monitor (All Views Except Service View) on page 1205

• Alarm Detail Monitor (Service View) on page 1208

• Current Active Alarms Monitor (Service View) on page 1212

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213

• Alarms by State Monitor on page 1214

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Severity Monitor (All Views Except Service View) on page 1215

• Alarms by State Monitor (All Views Except Service View) on page 1216

• Current Active Alarms Monitor (All Views Except Service View) on page 1216

• Alarm Trend Monitor (All Views Except Service View) on page 1217

AlarmDetail Monitor (All Views Except Service View)

Use the Alarm Detail monitor to sort alarms, view an alarm in depth, and to assign a

disposition to an alarm.

By clicking the Details icon, you can access the AlarmDetail monitor from any of the four

alarmmonitors available on themain page in Fault mode (Severity, Category, Current,

orState). It is alsoavailable fromtheCurrentActiveMonitors available fromtheSummary

tab in Monitor mode.

This topic describes:

• Finding Specific Alarms on page 1205

• Sorting Alarms on page 1207

• Reading Events on page 1207

• Investigating Event Attributes on page 1208

• Changing the Alarm State on page 1208

Finding Specific Alarms

Use the Alarm Detail monitor to locate a specific alarm, research the events causing the

alarm, and toassignadisposition to thealarm.Whenanalarm is highlighted in the sorting
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sequence, the events contributing to the alarmare listed in EventDetails and the variable

settings are shown in Event Attribute Detail.

To locate an alarm and to assign a disposition to the alarm:

1. Sort the list using the Display list. Sorting choices vary depending on how you arrived

here. View “Sorting Alarms” on page 1207 for details on sorting options.

2. Review the sorted list. Each entry shows aminimum of one to amaximum of nine

fields. These fields are described in Table 182 on page 1206.

3. Examine theeventsandeventattributes thatcontributed tosending thealarm.Events

andeventattributesarediscussed in “ReadingEvents” onpage 1207and “Investigating

Event Attributes” on page 1208.

Table 182: Alarm Detail Fields

Shown in Detailed
View by DefaultValueField

YesThe alarm name.Name

NoA system and sequentially-generated identification number.ID

YesIf assigned to an individual, it shows the name of the person assigned;
otherwise, it shows System tomark that the alarm is still unassigned.

Assigned To

YesThe severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is necessary.

• Major—Amajor error has occurred; escalate or notify as necessary.

• Minor—Aminor error has occurred; notify or monitor the condition.

• Info—An informational message; no action is necessary.

Severity

YesIndicates if the alarm has been acknowledged.Acknowledged

YesThe identificationof theentity responsible for causing this alarm.TheEntity
ID is the key for correlation of events into an alarm. The Entity ID could be
a MAC address of a radio or an IP address of the device.

Entity ID

NoThe IP address of the device or network element that generated the alarm.
The SNMP agent is located at the source IP. In most cases, the source IP
is the IP address of the switch or controller.

Source

YesThe hostname of the reporting device.Reporting Device

NoThe date and time the alarmwas first reported.Creation Date

YesThe date and time that the information for the alarmwas last modified.Last Updated

NoEither the system or the last user whomodified the alarm.Updated By
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Sorting Alarms

Depending on themonitor you chose to accessAlarmDetail, your sorting options change

to reflect the summary monitor. The different sort options are listed in

Table 183 on page 1207.

Table 183: Sort Options for Alarms

Alarms by State and Current Active
Alarms SortAlarms by Category SortAlarms by Severity Sort

BGPMinor

ChassisMajor

Config

CoS

DHCP

GENERAL

GenericEvent

Ping

You can also use Searching Alarms in the Tasks pane to perform searches usingmultiple

arguments. With multiple arguments, you can isolate a single alarm from a long alarm

list.

Reading Events

Whenyouselect analarm inAlarmDetail, theEventDetail tableupdateswith information

about theevents thatareassociatedwith thealarm.Table 184onpage 1207 lists the fields

in Event Detail.

Table 184: Event Detail Fields

ValueField

The event name; also known as the SNMP trap name.Name

A system-generated, hexadecimal code that uniquely identifies the event.ID

If the event is an SNMP event, it is shown as a system-generated event.Description

The type of event, either fault or system alert.Type
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Table 184: Event Detail Fields (continued)

ValueField

The category of the event message. The category corresponds to the alarm categories
shown in the Alarms by Category monitor and the Alarm Settings window. These
categories are:

• General

• Chassis

Category

The identification of the entity that is the cause of this event ; it is not necessarily the ID
of the event that generated the event.

Source

The identification of the entity that generated this event, for example, the switch IP or
controller IP address.

Originator

The date and time of the last update to the event.Time Updated

Investigating Event Attributes

The Event Attribute Detail window reflects the variables set during the event. In SNMP

terminology, theseattributesare knownasvariablebindingsor varbinds. Theseattributes

can provide key information about triggers. For example, if a fan fails, the attribute field

could indicate the location of the fan in the chassis.

Changing the Alarm State

When an alarm is first reported, it is considered an active alarm. To change the alarm

state, to assign the alarm to a person, or simply to record notes about the alarm, use the

buttons on Alarm Details. These buttons are:

• Acknowledge—Use this button to acknowledge or record that the alarm is known and

is being addressed.

• Clear—Use this button to clear or remove the alarm. The clear state says that the issue

sending the alarm has been resolved and no long requires attention.

• Annotate—Use this button to record actions taken to resolve the alarm.

• Assign—Use this button to assign active or acknowledged alarms to staff.

AlarmDetail Monitor (Service View)

Use the Alarm Detail monitor to sort alarms, view an alarm in depth, and to assign a

disposition to an alarm.

By clicking the Details icon, you can access the AlarmDetail monitor from any of the four

alarmmonitors available on themain page in Fault mode (Severity, Category, Current,

orState). It is alsoavailable fromtheCurrentActiveMonitors available fromtheSummary

tab in Monitor mode.
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This topic describes:

• Finding Specific Alarms on page 1209

• Sorting Alarms on page 1210

• Reading Events on page 1210

• Investigating Event Attributes on page 1211

• Changing the Alarm State on page 1211

Finding Specific Alarms

Use the Alarm Detail monitor to locate a specific alarm, research the events causing the

alarm, and toassignadisposition to thealarm.Whenanalarm is highlighted in the sorting

sequence, the events contributing to the alarmare listed in EventDetails and the variable

settings are shown in Event Attribute Detail.

To locate an alarm and to assign a disposition to the alarm:

1. Sort the list using the Display list. Sorting choices vary depending on how you arrived

here. View “Sorting Alarms” on page 1207 for details on sorting options.

2. Review the sorted list. Each entry shows aminimum of one to amaximum of nine

fields. These fields are described in Table 182 on page 1206.

3. Examine theeventsandeventattributes thatcontributed tosending thealarm.Events

andeventattributesarediscussed in “ReadingEvents” onpage 1207and “Investigating

Event Attributes” on page 1208.

Table 185: Alarm Detail Fields

Shown in Detailed
View by DefaultValueField

YesThe alarm name.Name

NoA system and sequentially-generated identification number.ID

YesIf assigned to an individual, it shows the name of the person assigned;
otherwise, it shows System tomark that the alarm is still unassigned.

Assigned To

YesThe severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is necessary.

• Major—Amajor error has occurred; escalate or notify as necessary.

• Minor—Aminor error has occurred; notify or monitor the condition.

• Info—An informational message; no action is necessary.

Severity

YesThe name of the service for which the alarmwas generated.Service Name

YesThe name of the customer associatedwith the service for which the alarm
was generated.

Customer
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Table 185: Alarm Detail Fields (continued)

Shown in Detailed
View by DefaultValueField

YesThe type or protocol of the service for which the alarmwas generated.Service Type

YesThe identificationof theentity responsible for causing this alarm.TheEntity
ID is the key for correlation of events into an alarm. The Entity ID could be
a MAC address of a radio or an IP address of the device.

Entity ID

NoThe IP address of the device or network element that generated the alarm.
The SNMP agent is located at the source IP. In most cases, the source IP
is the IP address of the switch or controller.

Source

YesIndicates if the alarm has been acknowledged.Acknowledged

NoThe IP address of the device or network element that generated the alarm.
The SNMP agent is located at the source IP. In most cases, the source IP
is the IP address of the switch or controller.

Source

NoThe date and time the alarmwas first reported.Creation Date

YesThe date and time that the information for the alarmwas last modified.Last Updated

NoEither the system or the last user whomodified the alarm.Updated By

Sorting Alarms

Sort the alarms based on the following parameters from the drop-down lists:

• Severity

• State

• Service

• Time (You can choose only time spans ending now, for example, Last 12 hours.)

Click Search to filter the alarms and display the alarms based on the search criteria.

You can also use Searching Alarms in the Tasks pane to perform searches usingmultiple

arguments. With multiple arguments, you can isolate a single alarm from a long alarm

list.

Reading Events

Whenyouselect analarm inAlarmDetail, theEventDetail tableupdateswith information

about theevents thatareassociatedwith thealarm.Table 184onpage 1207 lists the fields

in Event Detail.
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Table 186: Event Detail Fields

ValueField

The event name; also known as the SNMP trap name.Name

A system-generated, hexadecimal code that uniquely identifies the event.ID

If the event is an SNMP event, it is shown as a system-generated event.Description

The type of event, either fault or system alert.Type

The category of the event message. The category corresponds to the alarm categories
shown in the Alarms by Category monitor and the Alarm Settings window.

Category

The identification of the entity that is the cause of this event ; it is not necessarily the ID
of the event that generated the event.

Source

The identification of the entity that generated this event, for example, the switch IP or
controller IP address.

Originator

The date and time of the last update to the event.Time Updated

Investigating Event Attributes

The Event Attribute Detail window reflects the variables set during the event. In SNMP

terminology, theseattributesare knownasvariablebindingsor varbinds. Theseattributes

can provide key information about triggers. For example, if a fan fails, the attribute field

could indicate the location of the fan in the chassis.

Changing the Alarm State

When an alarm is first reported, it is considered an active alarm. To change the alarm

state, to assign the alarm to a person, or simply to record notes about the alarm, use the

buttons on Alarm Details. These buttons are:

• Acknowledge—Use this button to acknowledge or record that the alarm is known and

is being addressed.

• Clear—Use this button to clear or remove the alarm. The clear state says that the issue

sending the alarm has been resolved and no long requires attention.

• Annotate—Use this button to record actions taken to resolve the alarm.

• Assign—Use this button to assign active or acknowledged alarms to staff.

Related
Documentation

Alarm Trend Monitor (Service View) on page 1215•

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213

• Alarms by State Monitor on page 1214
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• Current Active Alarms Monitor (Service View) on page 1212

Current Active AlarmsMonitor (Service View)

TheCurrent ActiveAlarmsmonitor showsany active alarm that has not yet been cleared.

It is one of the four standard monitors available in Alarmmode. Current Active Alarms is

a table that has four fields and appear by default. However, nine fields are available for

selection. View Table 165 on page 1121 for a description of the table.

Table 187: Current Active AlarmsMonitor

Shown in
DetailedView
by Default

Shown in
Summaryby
DefaultDescriptionTable Column

YesYesThe alarm name.Name

NoNoA system and sequentially-generated identification number.ID

YesNoIf assigned to an individual, it shows the name of the person
assigned; otherwise, it shows System tomark that the alarm
is still unassigned.

Assigned To

YesYesThe severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is
necessary.

• Major—Amajor error has occurred; escalate or notify as
necessary.

• Minor—Aminor error has occurred; notify or monitor the
condition.

• Info—An informational message; no action is necessary.

Severity

YesYesThe name of the service for which the alarmwas generated.Service Name

YesYesThe name of the customer associated with the service for
which the alarmwas generated.

Customer

YesYesThe type or protocol of the service for which the alarmwas
generated.

Service Type

YesYesThe identification of the entity responsible for causing this
alarm. The Entity ID is the key for correlation of events into
an alarm. The Entity ID could be a MAC address of a radio or
an IP address of the device.

Entity ID

NoNoThe IP address of the device or network element that
generated thealarm.TheSNMPagent is locatedat the source
IP. Inmost cases, the source IP is the IP address of the switch
or controller.

Source

NoNoThe date and time the alarmwas first reported.Creation Date
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Table 187: Current Active AlarmsMonitor (continued)

Shown in
DetailedView
by Default

Shown in
Summaryby
DefaultDescriptionTable Column

YesYesThedate and time that the information for the alarmwas last
modified.

Last Updated

NoNoEither the system or the last user whomodified the alarm.Updated By

Clicking the Details icon opens Alarm Details where you can sort and disposition alarms

by state (Acknowledged, Clear, Active).

Related
Documentation

Alarm Detail Monitor (Service View) on page 1208•

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213

• Alarms by State Monitor on page 1214

Alarms by Category Monitor

Alarms by Category is a table of all active alarms sorted by category. Use this monitor

to view where errors are trending. These categories are the same categories shown in

the Alarm Settings page.

This monitor is available in all views in the main windowwhen in Fault mode.

The table shows the active categories and the number of alarms per category. Clicking

the Details icon on Alarms by Category opens Alarm Details where you can sort these

categories and change the state of the alarms.

To create a similar report for a specific period of time, use the Alarm Summary report in

Report mode.

Related
Documentation

Alarm Detail Monitor (Service View) on page 1208•

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Severity Monitor (Service View) on page 1213

• Alarms by State Monitor on page 1214

• Current Active Alarms Monitor (Service View) on page 1212

Alarms by Severity Monitor (Service View)

Alarms by Severity is a pie-chart that shows the breakdown of all alarms since the last

system restart. It is available on themain page when in Fault mode.
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If you mouse over each segment, the total number of alerts for those alarms is shown.

Alarm severity levels are:

• Critical (Red)—A critical condition exists; immediate action is necessary.

• Major (Orange)—Amajor error has occurred; escalate or notify as necessary.

• Minor (Yellow)—Aminor error has occurred; notify or monitor the condition.

• Info (Wedgewood Blue)—An informational message; no action is necessary.

Informational alarmsdonot necessarily indicate an error. It could indicate that a device

or entity has changed state.

Clicking the Details icon on Alarms by Severity opens Alarm Details where you can sort

and disposition individual.

Related
Documentation

Alarm Detail Monitor (Service View) on page 1208•

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Category Monitor on page 1213

• Alarms by State Monitor on page 1214

• Current Active Alarms Monitor (Service View) on page 1212

Alarms by StateMonitor

The Alarms by State monitor is a pie-chart representation of the states of an alarm:

active and cleared. Use this graph to get an overall perspective of the amount of alarms

that are active compare to those that are cleared. The Alarms by Statemonitor is on the

main pane when in Fault mode.

Mouse over each segment of the pie-chart shows the number of alarms in these states:

• Active—Alarms that are current and not yet cleared.

• Cleared—Alarms that are resolved and the device or entity has returned to normal

operation.

You can create an Alarms by State report for a specified node or a period of time using

the Alarms Summary Report in Repot mode.

Changing the state of an alarm using Connectivity Services Director is performed on the

Alarm Detail page. Clicking the Details icon on Alarms by State opens Alarm Details

where you can sort and set the disposition of the alarms.

Related
Documentation

Alarm Detail Monitor (Service View) on page 1208•

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213
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• Current Active Alarms Monitor (Service View) on page 1212

Alarm TrendMonitor (Service View)

TheAlarmTrendmonitorprovides trend informationaboutalarms.The trend information

is shown on a line chart, where each alarm severity is shown as a colored line. The legend

for the line colors is displayed below the chart. The alarm count is shown on the vertical

axis. The time of the data samples is shown on the horizontal axis. Thismonitor includes

tabs that show alarm trend information for active alarms and for new alarms. You can

select the time period to display from the list in the title bar.

Related
Documentation

Alarm Detail Monitor (Service View) on page 1208•

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213

• Alarms by State Monitor on page 1214

• Current Active Alarms Monitor (Service View) on page 1212

Alarms by Severity Monitor (All Views Except Service View)

Alarms by Severity is a pie-chart that shows the breakdown of all alarms since the last

system restart. It is available on themain page when in Fault mode.

If youmouse over each segment, the total number of alerts for those alarms is shown.

Alarm severity levels are:

• Critical (Red)—A critical condition exists; immediate action is necessary.

• Major (Orange)—Amajor error has occurred; escalate or notify as necessary.

• Minor (Yellow)—Aminor error has occurred; notify or monitor the condition.

• Info (Wedgewood Blue)—An informational message; no action is necessary.

Informational alarmsdonot necessarily indicate an error. It could indicate that a device

or entity has changed state.

Clicking the Details icon on Alarms by Severity opens Alarm Details where you can sort

and disposition individual.

Related
Documentation

Alarm Detail Monitor (Service View) on page 1208•

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Category Monitor on page 1213

• Alarms by State Monitor on page 1214

• Current Active Alarms Monitor (Service View) on page 1212

1215Copyright © 2019, Juniper Networks, Inc.

Chapter 48: Fault Reference



Alarms by StateMonitor (All Views Except Service View)

The Alarms by State monitor is a pie-chart representation of the states of an alarm:

active and cleared. Use this graph to get an overall perspective of the amount of alarms

that are active compare to those that are cleared. The Alarms by Statemonitor is on the

main pane when in Fault mode.

Mouse over each segment of the pie-chart shows the number of alarms in these states:

• Active—Alarms that are current and not yet cleared.

• Cleared—Alarms that are resolved and the device or entity has returned to normal

operation.

You can create an Alarms by State report for a specified node or a period of time using

the Alarms Summary Report in Repot mode.

Changing the state of an alarm using Connectivity Services Director is performed on the

Alarm Detail page. Clicking the Details icon on Alarms by State opens Alarm Details

where you can sort and set the disposition of the alarms.

Related
Documentation

Alarm Detail Monitor (Service View) on page 1208•

• Alarm Trend Monitor (Service View) on page 1215

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213

• Current Active Alarms Monitor (Service View) on page 1212

Current Active AlarmsMonitor (All Views Except Service View)

TheCurrent ActiveAlarmsmonitor showsany active alarm that has not yet been cleared.

It is one of the four standard monitors available in Alarmmode. Current Active Alarms is

a table that has four fields and appear by default. However, nine fields are available for

selection. View Table 165 on page 1121 for a description of the table.

Table 188: Current Active AlarmsMonitor

Shown in
DetailedView
by Default

Shown in
Summaryby
DefaultDescriptionTable Column

YesYesThe alarm name.Name

NoNoA system and sequentially-generated identification number.ID

YesNoIf assigned to an individual, it shows the name of the person
assigned; otherwise, it shows System tomark that the alarm
is still unassigned.

Assigned To
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Table 188: Current Active AlarmsMonitor (continued)

Shown in
DetailedView
by Default

Shown in
Summaryby
DefaultDescriptionTable Column

YesYesThe severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is
necessary.

• Major—Amajor error has occurred; escalate or notify as
necessary.

• Minor—Aminor error has occurred; notify or monitor the
condition.

• Info—An informational message; no action is necessary.

Severity

YesYesThe identification of the entity responsible for causing this
alarm. The Entity ID is the key for correlation of events into
an alarm. The Entity ID could be a MAC address of a radio or
an IP address of the device.

Entity ID

NoNoThe IP address of the device or network element that
generated thealarm.TheSNMPagent is locatedat the source
IP. Inmost cases, the source IP is the IP address of the switch
or controller.

Source

YesYesThe hostname or IP address of the reporting device.Reporting Device

NoNoThe date and time the alarmwas first reported.Creation Date

YesYesThedate and time that the information for the alarmwas last
modified.

Last Updated

NoNoEither the system or the last user whomodified the alarm.Updated By

Clicking the Details icon opens Alarm Details where you can sort and disposition alarms

by state (Acknowledged, Clear, Active).

Alarm TrendMonitor (All Views Except Service View)

TheAlarmTrendmonitorprovides trend informationaboutalarms.The trend information

is shown on a line chart, where each alarm severity is shown as a colored line. The legend

for the line colors is displayed below the chart. The alarm count is shown on the vertical

axis. The time of the data samples is shown on the horizontal axis. Thismonitor includes

tabs that show alarm trend information for active alarms and for new alarms. You can

select the time period to display from the list in the title bar.

Related
Documentation

• Alarm Detail Monitor (Service View) on page 1208

• Alarms by Category Monitor on page 1213

• Alarms by Severity Monitor (Service View) on page 1213

• Alarms by State Monitor on page 1214
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• Current Active Alarms Monitor (Service View) on page 1212
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PART 15

End-to-End Configuration Examples

• Configuration Scenarios on page 1221
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CHAPTER 49

Configuration Scenarios

• Example: Configuring and Deploying an E-Line Service on page 1221

• Example: Configuring and Deploying a Multipoint-to-Multipoint E-LAN

Service on page 1231

• Example: Configuring and Deploying an IP Full-Mesh Service on page 1243

Example: Configuring and Deploying an E-Line Service

This example deploys and verifies an E-Line service starting with twoMX Series devices.

Figure 25 on page 1221 shows the service.

Figure 25: Simple E-Line Service

This service provides connectivity for one VLAN, using 802.1Q interface endpoints.

Customer siteAconnects to thenetwork throughUNIge-0/0/2onanN-PEdevicenamed

SJC. Customer site B connects to the network through UNI ge-0/0/3 on an N-PE device

named SFO.

The bandwidth for each UNI is limited to 1000Mbps.

You can create this service by performing the following tasks, in order:

• Preparing Devices for Discovery on page 1222

• Discovering Devices on page 1222

• Preparing Devices for Prestaging on page 1223

• Discovering and Assigning N-PE Roles on page 1224

• Choosing or Creating a Service Definition on page 1225

• Creating a Customer on page 1227
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• Creating and Deploying an E-Line Service Order on page 1227

• Performing a Functional Audit and a Configuration Audit on page 1229

Preparing Devices for Discovery

Before you can add a device using device discovery, the following conditions must be

met:

• SSH v2 is enabled on the device. To enable SSH v2 on a device, issue the following CLI

command:

set system services ssh protocol-version v2

• The NETCONF protocol over SSH is enabled on the device. To enable the NETCONF

protocol over SSH on a device, issue the following CLI command:

set system services netconf ssh

• The device is configured with a static management IP address that is reachable from

the Junos Space server. The IP address can be in-band or out-of-band.

• A user with full administrative privileges is created on the device for the Junos Space

administrator.

• If youplan to useSNMP toprobedevices as part of device discovery, ensure that SNMP

is enabled on the device with appropriate read-only V1/V2C/V3 credentials.

Discovering Devices

Device discovery is a process that Junos Space uses to bring network devices under its

control. This example brings two MX Series routers under Junos Spacemanagement:

NOTE: Alternatively, you can import devices using the Connectivity Services
Director GUI. See Discovering Devices in a Physical Network for instructions
on discovering devices from Build mode of Connectivity Services Director.

1. Log in to Junos Space using your credentials.

2. From the Junos Space Network Management Platform user interface, select Devices

> Discover Devices > Discover Targets.

3. In the Discover Targetswindow, click +.

The Add Device Targetwindow appears.

4. Select IP range.

5. Enter the IP address information. This example uses a range of two addresses.
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6. Click Add, and then click Next.

7. In the Devices: Specify Probeswindow, select both Ping and SNMP as probes.

8. Click Next.

9. In theDevices:SpecifyCredentialswindow,click+andenter thedevice logincredentials.

10. Click Finish.

Device discovery begins. It displays a graph showing the status of the discovery

operation. Initially, two devices are discovered.When Junos Space has accessed both

devices and brought them under its management, both devices move from the

Discovered column of the graph to the Managed column.

11. To check the results of the device discovery operation, select the Devicesworkspace

again, then select DeviceManagement. TheManage Devices page shows the added

devices.

See Also Device Discovery Overview in the Junos Space Network Application Platform User Guide•

• Discovering Devices in the Junos Space Network Application Platform User Guide

Preparing Devices for Prestaging

Before prestaging devices for E-Line services, the following entities must be configured:

• MPLSmust run on each N-PE device.

• LDP signalingmust be established betweenN-PE devices that youwant to participate

in the same E-Line service.

To satisfy these configurations, ensure that the following configuration exists on each

N-PE device:

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
                address 10.1.18.2/30;
            }
            family mpls;
        }           
    }

   }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.20/32;
            }
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        }
    }

}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
     ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }

NOTE: The OSPF configuration is not required in prestaging.

Discovering and Assigning N-PE Roles

Before you can provision services, youmust prestage the devices. Prestaging includes

assigning device roles and designating interfaces on those devices asUNIs. This example

provides the steps to accept the recommendations of the Network Services application

for N-PE devices and UNIs.

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices.

View the values displayed under the Roles column of the discovered devices.

This action launches the role discovery process in which the Network Services

applicationexamines thedevicesunder JunosSpacemanagement looking fordevices

that match predefined rules that identify N-PE devices. In this example, the Role

Discovery Status graph shows that the Network Services application has discovered

two such devices.

4. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayed with the job ID of the discovery job

that is created to obtain the latest roles of the devices.
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5. To view the assignment status, in the CSDDeployment Jobswindow that you can

access from Deploy mode of Service View by selecting View Deployment Jobs from

the task pane, click the job ID of the assignment job.

The JobManagement page shows the progress and status of the role assignment job.

6. To verify the result, in Build mode, select Prestage Devices >Manage Device Roles

from the tasks pane.

TheManageDeviceRoleswindowshowstwodevices thatcanbeused forprovisioning.

7. To unassign a device fromN-PE role assignment, clickManage Device Roles and from

the drop-down list, select Unassign Role to remove the role capability of a network

element. You are prompted to confirm the operation. If you clickOK, a request is

submitted to remove the latest role of the network element or device.

See Also Discovering and Assigning All N-PE Devices on page 349•

• Discovering and Assigning N-PE Devices with Exceptions on page 351

Choosing or Creating a Service Definition

A service definition provides a template uponwhich services are built. It specifies service

attributes that are not specific to a service instance. In our example, the service definition

provides all service attributes except the N-PE devices, the UNIs, and bandwidth.

TheNetwork Services application shipswith standard service definitions. First, we check

the standard service definitions to determine whether one already exists that will work.

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Service Design >Manage

Service Definitions.

TheManageServiceDefinitionspage lists all service definitions in the system. In a new

system, the screen lists only predefined service definitions.

This example requires a service definition with UNIs that use 802.1Q interfaces and

allowyou tosetabandwidthof25Mbps.Thestandardservicedefinitionshaveseveral

examples for provisioning 802.1Q UNIs, but none that allow the setting of a 25 Mbps

bandwidth limit. You need to create a new service definition.

4. In the Network Services > Connectivity task pane, select Service Design >Manage

Service Definitions > New > E-Line Service Definition.

The General window appears.
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5. Enter a name for the service definition. For this example, enter p2p-dot1q-sd-1.

6. Click Next.

The UNI Settingswindow appears.

7. In the Connectivity Settingswindow, to pick the default connectivity settings, click

Next.

8. In the UNI Settingswindow, in the Ethernet option field, select dot1q.

9. In the Customer traffic type field, select Transport single VLAN.

10. In the VLAN ID selection field, select Selectmanually.

11. In the VLAN range for manual input field, specify the range.

12. In theOuter Tag protocol ID field, select 0x88a8

13. In the Physical IF encapsulation field, select flexible-ethernet-services.

14. In the Logical IF encapsulation field, select vlan-ccc.

15. In the Bandwidth Settings panel, select the Enable rate limiting check box.

16. In the Default Bandwidth field, enter 10, for a default bandwidth of 10 Mbps.

17. To the right of the value you just entered, select the Editable in service order check

box.

TheMin Bandwidth (Kbps), Max Bandwidth (Mbps), and Increment (Kbps) become

active.

18. In theMin Bandwidth (Kbps) field, enter 100.

19. In theMax Bandwidth (Mbps) field, enter 10000.

20. In the increment field, enter 64.

These settings of the Bandwidth range and Increment fields allow the bandwidth to

beset in theservice toany64-Kbps increment in the rangeof 100Kbps through 10000

Mbps.

21. To save and complete the service definition, click Finish.
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TheManage Service Definitions page includes the new service definition.

You have created a customized Service Definition, but it has not yet been published.

Before a service definition can be used in provisioning, it must be published.

22. To publish the service definition, in theManage Service Definitions page, select the

p2p-dot1q-sd-1 service definition; click the Publish Service Definition button.

The Publish Service Definitionwindow appears.

23. To confirm that you want to publish this service definition, click Publish.

In theManage Service Definitions page, the symbol in the upper left corner of the

service definition changes to a check mark, indicating that the status has changed to

Published.

The service definition is now ready for use in provisioning.

Creating a Customer

Beforeyoucanprovision theservice, customerdetailsmustbepresent in the JunosSpace

database. To add a customer:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In theNetworkServices>Connectivity task pane, selectServiceProvisioning>Manage

Customers > Create Customer.

4. In the Name field, enter Best Customer.

5. In the Account number field, enter 1234.

6. Click Create.

TheManage Customers page shows the new customer.

See Also Adding a New Customer on page 697•

Creating and Deploying an E-Line Service Order

Now that you have prestaged your devices, created a suitable service definition, and

added the customer information to the database, you are ready to create and deploy a

service order. To create and deploy a service order:
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1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the New icon at the top of the upper half of the page that displays previously

created service orders. The Select Service Type dialog box appears.

4. Select E-Line to create an E-Line service order.

The General/Connectivity Settings panel appears initially in the right panel, as shown

in the example.

5. In the Create E-Line Service Orderwindow, select the service named p2p-dot1q-sd-1.

This is the customized service definition you created earlier.

6. Click Next.

7. In the General/Connectivity Settingswindow, in the Name field, enter so_1.

8. In the Customer field, select Best Customer.

9. Click Next.

The Endpoint Settingswindow appears.

10. For endpoint A, in the PE device field, select SJC.

11. In the UNI interface field, select ge-0/0/2.

12. In the VLAN-ID field, enter 100.

13. Click Next.

14. In the Endpoint Settingswindow for endpoint Z, in the PE device field, select SFO.

15. In the UNI interface field, select ge-0/0/3.

16. In the Bandwidth field, select 25.

17. Click Done. You are returned to the Manage Network Services page.
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18. FromtheManageServiceOrderspage that is displayed in the lowerpart of thewindow,

select the particular service and click Deploy now.

19. ClickOK to start the deployment.

20.Tomonitor the progress and status of the deployment, in the Manage Service Orders

window, click the link in the Latest Job field. The JobManagement page shows the

status of the job.

NOTE: Alternatively, todisplay the JobManagementpage, fromthe Junos
Space Platform UI, select Jobs >Manage Jobs from the Tasks pane. You

can also view the CSD Deployment Jobs page in Deploymode of Service
View by selecting the View Deployment Jobs option in the task pane.

21. When you see in the JobManagementwindow that the deployment is successful, in

the Network Services task pane in Deploy mode, select Service Provisioning > Deploy

Services.

TheManage Network Services page shows the new service.

Performing a Functional Audit and a Configuration Audit

Nowthat yournewservice isdeployed, youshouldvalidate its configurationand functional

integrity. A functional audit runs operational commands on the device to verify that the

service is up or down. A configuration audit verifies whether the configuration that was

pushed to the device during deployment is actually on the device.

To perform a configuration audit and a functional audit of the service:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next to Network Services > E-Line Services to expand the tree and display the

different service types that you can configure.

4. Select Deploy Services from the task pane. The right pane displays two pages. The

Manage Network Services page is displayed in the upper half of the right pane.

Selectinga service fromthispagecauses theassociated serviceorders for the selected

service to be displayed in the Manage Service Orders page in the lower half of the

right pane.

5. In theManage Network Services page, select the service instance you just deployed.
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6. Select the service instance, and open the Actionsmenu and select Run Functional

Audit.

7. In the Schedule Functional Auditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, then clickOK.

8. In theOrder Information screen, clickOK.

9. Select the service instance, and open the Auditmenu and select Run Configuration

Audit.

10. In theScheduleConfigurationAuditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, and then clickOK.

11. In theOrder Informationwindow, clickOK.

When the audit jobs have finished, success is indicated by an up arrow in the top right

corner of the service.

12. To view the functional audit results:

a. From the View selector, select Service View. The workspaces that are applicable

to routing and tunnel services are displayed.

b. Click theBuild icon in theServiceViewof theConnectivity ServicesDirector banner.

The functionalities that you can configure in this mode are displayed in the task

pane.

c. From the Network Services > Connectivity > E-Line Services View pane, select the

so_1 service instance.

d. In the tasks pane, select Audit/Results > Functional Audit.

e. In the Functional Audit Resultswindow, select each device to view the results.

13. To view the results of the configuration audit:

a. From the View selector, select Service View. The workspaces that are applicable

to routing and tunnel services are displayed.

b. Click theBuild icon in theServiceViewof theConnectivity ServicesDirector banner.

The functionalities that you can configure in this mode are displayed in the task

pane.

c. From the Network Services > Connectivity > E-Line Services View pane, select the

so_1 service instance.
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d. In the tasks pane, select Audit/Results > Configuration Audit.

e. In the Configuration Audit Resultswindow, select each device in turn and review

the results. This report indicatesanypart of theserviceconfiguration that ismissing

on the device, or is inconsistent with the Junos Space database.

Following successful audit, the service is deployed and ready to be used.

Related
Documentation

Device Discovery Overview in the Junos Space Network Application Platform User Guide•

• Discovering Devices in the Junos Space Network Application Platform User Guide

Example: Configuring and Deploying aMultipoint-to-Multipoint E-LAN Service

This example shows how to deploy and verify a multipoint-to-multipoint E-LAN service

starting with three MX Series routers. Figure 26 on page 1231 shows the service.

Figure 26: Simple Multipoint-to-Multipoint Service

This service provides connectivity for one VLAN, using 802.1Q interface endpoints.

Customer site A connects to the network through anN-PEdevice namedSJC (IP address

1.1.1.1). Customer site B connects to the network through an N-PE device named SFO (IP

address 1.1.1.2). Customer site C connects to the network through an N-PE device named

BLR (IP address 1.1.1.3). In this example, we allow Network Activate to select each UNI

automatically.

Each UNI is to have its bandwidth limited to 25 Mbps.

You can create this service by performing the following tasks:

• Preparing Devices for Discovery on page 1232

• Discovering Devices on page 1232
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• Preparing Devices for Prestaging on page 1233

• Discovering and Assigning N-PE Roles on page 1236

• Choosing or Creating a Service Definition on page 1237

• Creating a Customer on page 1239

• Creating and Deploying a Multipoint-to-Multipoint Service Order on page 1240

• Performing a Functional Audit and a Configuration Audit on page 1241

Preparing Devices for Discovery

Before you can add a device using device discovery, the following conditions must be

met:

• SSH v2 is enabled on the device. To enable SSH v2 on a device, issue the following CLI

command:

set system services ssh protocol-version v2

• The NETCONF protocol over SSH is enabled on the device. To enable the NETCONF

protocol over SSH on a device, issue the following CLI command:

set system services netconf ssh

• The device is configured with a static management IP address that is reachable from

the Junos Space server. The IP address can be in-band or out-of-band.

• A user with full administrative privileges is created on the device for the Junos Space

administrator.

• If youplan to useSNMP toprobedevices as part of device discovery, ensure that SNMP

is enabled on the device with appropriate read-only V1/V2C/V3 credentials.

Discovering Devices

Device discovery is a process that Junos Space uses to bring network devices under its

control. This example brings two MX Series routers under Junos Spacemanagement.

NOTE: Alternatively, you can import devices using the Connectivity Services
Director GUI. See Discovering Devices in a Physical Network for instructions
on discovering devices from Build mode of Connectivity Services Director.

1. Log in to Junos Space using your credentials.

2. In theApplicationsChooser of the JunosSpacePlatformuser interface, selectPlatform

> Devices > Device Discovery > Device Discovery Profile.

The Device Discovery Profileswindow appears.

3. In the Device Discovery Profiles window, click +.
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The Device Discovery Target window appears.

4. Select IP range.

5. Specify the Start IP Address and End IP Address information.

6. Click Next.

7. In the Specify Probeswindow, select both Use Ping and Use SNMP as probes.

8. Click Next.

9. In the Specify Credentialswindow, select Authentication Type and enter the device

login credentials.

10. Click Discover.

Device discovery begins. It displays a graph showing the status of the discovery

operation. Initially, three devices are discovered. When the Junos Space software has

accessed all three devices and brought themunder itsmanagement, all three devices

move from the Discovered column of the graph to the Managed column.

11. To check the results of the device discovery operation, select the Devicesworkspace

again, then select DeviceManagement. TheManage Devices page shows the added

devices.

See Also Device Discovery Overview in the Junos Space Network Application Platform User Guide•

• Discovering Devices in the Junos Space Network Application Platform User Guide

Preparing Devices for Prestaging

Before prestaging devices for multipoint-to-multipoint services, the following entities

must be configured:

• MPLSmust run on each N-PE device.

• MPBGPmust run on each N-PE device that you want to participate in a

multipoint-to-multipoint service.

To satisfy the preceding criteria, ensure that the following configuration exists on each

N-PE device:

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
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                address 10.1.22.2/30;
            }
            family mpls;
        }
    }

    }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.30/32;
            }
        }           
    }

}
routing-options {
    autonomous-system 65410;
}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
    bgp {
        group CA-Peer {
            type internal;
            local-address 192.168.1.30;
            family l2vpn {
                signaling;
            }
            neighbor 192.168.1.40;
            neighbor 192.168.1.10;
            neighbor 192.168.1.20;
            neighbor 192.168.1.50;
            neighbor 192.168.1.60;
        }
    }
    ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
}

NOTE: The OSPF configuration is not required in prestaging.

TheE-LANserviceneeds tobeenabled inanetworkdevice, tomake thestaticpseudowire

functionality active in the device. You can activate the static pseudowire functionality

Copyright © 2019, Juniper Networks, Inc.1234

Connectivity Services Director User Guide



by configuring the network device through the CLI window. You need to enter the CLI

configuration mode of a network element and run the command

set protocols vpls static-vpls no-tunnel-services

commit

If the device is not configured through CLI, awarningmessage appears in the application

server log, that is the JBOSS Log:

To discover and assign the roles of devices:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices.

View the values displayed under the Roles column of the discovered devices.

This action launches the role discovery process in which the Network Services

applicationexamines thedevicesunder JunosSpacemanagement looking fordevices

that match predefined rules that identify N-PE devices. In this example, the Role

Discovery Status graph shows that the Network Services application has discovered

two such devices.

4. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayed with the job ID of the discovery job

that is created to obtain the latest roles of the devices.

5. To view the assignment status, in the CSDDeployment Jobswindow that you can

access from Deploy mode of Service View by selecting View Deployment Jobs from

the task pane, click the job ID of the assignment job.

The JobManagement page shows the progress and status of the role assignment job.

6. To verify the result, in Build mode, select Prestage Devices >Manage Device Roles

from the tasks pane.

TheManageDeviceRoleswindowshowstwodevices thatcanbeused forprovisioning.

7. To unassign a device fromN-PE role assignment, clickManage Device Roles and from

the drop-down list, select Unassign Role to remove the role capability of a network

element. You are prompted to confirm the operation. If you clickOK, a request is

submitted to remove the latest role of the network element or device.

To re-sync the role of the network elements configured:

1235Copyright © 2019, Juniper Networks, Inc.

Chapter 49: Configuration Scenarios



1. Select Prestage Devices > Prestage Devices from the tasks pane. The Devices Chart

page is displayed.

2. To re-sync the role capability of a network element, select the network element’s

name, and open theManage Device Rolesmenu.

3. Click Re-sync Role Capability. The Re-sync Role Capabilitywindow appears where you

can select the device’s name and click Re-sync.

The role is re-synced with the same device now.

Discovering and Assigning N-PE Roles

Before you can provision services, youmust prestage the devices. prestaging includes

assigning device roles and designating interfaces on those devices asUNIs. This example

provides the steps to accept the recommendations of the Network Services application

for N-PE devices and UNIs.

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In the Service View task pane, select Network Services.

4. In the Tasks task pane, select Prestage Devices > Prestage Devices.

View the values displayed under the Roles column of the discovered devices.

This action launches the role discovery process in which the Network Services

applicationexamines thedevicesunder JunosSpacemanagement looking fordevices

that match predefined rules that identify N-PE devices. In this example, the Role

Discovery Status graph shows that the Network Services application has discovered

two such devices.

5. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayed with the job ID of the discovery job

that is created to obtain the latest roles of the devices.

6. To view the assignment status, in the CSDDeployment Jobswindow that you can

access from Deploy mode of Service View by selecting View Deployment Jobs from

the task pane, click the job ID of the assignment job.

The JobManagement page shows the progress and status of the role assignment job.

7. To verify the result, in Build mode, select Prestage Devices >Manage Device Roles

from the tasks pane.
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TheManageDeviceRoleswindowshowstwodevices thatcanbeused forprovisioning.

8. To unassign a device fromN-PE role assignment, clickManage Device Roles and from

the drop-down list, select Unassign Role to remove the role capability of a network

element. You are prompted to confirm the operation. If you clickOK, a request is

submitted to remove the latest role of the network element or device.

See Also Discovering and Assigning All N-PE Devices on page 349•

• Discovering and Assigning N-PE Devices with Exceptions on page 351

Choosing or Creating a Service Definition

A service definition provides a template uponwhich services are built. It specifies service

attributes that are not specific to a service instance. In this example, the service definition

provides all service attributes except the N-PE devices, the UNIs, and bandwidth.

TheNetwork Services application shipswith standard service definitions. First, we check

the standard service definitions to determine whether one already exists that can work.

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In the Network Services task pane, select Connectivity .

4. In the Tasks task pane, select Service Design >Manage Service Definitions

TheManageServiceDefinitionspage lists all service definitions in the system. In a new

system, the page lists only predefined service definitions.

This example requires amultipoint-to-multipoint service definitionwithUNIs that use

802.1Q interfaces and allow you to set a bandwidth of 25Mbps. The standard service

definitions have several examples for provisioning 802.1Q UNIs, but none that allow

the setting of a 25Mbps bandwidth limit. You need to create a new service definition.

5. In the Mange Service Definitions page, click New > E-LAN Service Definition.

The General Settings window appears.

6. Enter a name for the service definition.

7. Click Next.

8. In the Site Settingswindow, in the VLAN Tagging field, select dot1q.
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9. In the Physical Interface Encapsulation field, select flexible-ethernet-service.

10. In the Logical Interface Encapsulation field, select vlan-vpls.

11. In the Traffic type field, select Transport single VLAN.

12. Because we intend to select a specific VLAN for each endpoint in the service—leave

the Normalized VLAN setting as the default Normalization not required.

13. In the VLAN ID selection field, choose Selectmanually.

14. In the VLAN range for manual input, specify the range.

NOTE: When the range of VLAN IDs that are automatically assigned by
the system (with the auto-pick option enabled during the creation of a
service definition) is less than or greater than the range of VLAN IDs that
aremanually specified (with themanual selection option enabled during
the creation of a service definition), the following conditions apply during
the creation of a service order with the Editable in Service Order check
box selected during service definition creation:

• If youcreateaserviceorderwith theauto-pickoptionenabled, theVLAN
ID is selected from the auto-pick range, and the value is displayed in the
VLAN range for manual input field. If you attempt to change the VLAN
IDmanually, the value is restricted to themanually configured range.

• If youcreateaserviceorderwith theauto-pickoptiondisabled, theVLAN
ID is selected from themanually configured range, and the value is
displayed in the VLAN range for manual input field. If you attempt to
change the VLAN IDmanually, the value is restricted to themanually
configured range.

15. In theOuter Tag protocol ID, select 0x8100

16. In the PE-CE Interface Rate Limiting Settings panel, select the Enable Interface Rate

Limiting check box.

17. In the Rate Limit (Mbps) field, enter 10, for a default bandwidth of 10 Mbps.

18. To the right of the value you just entered, select the Editable in service order check

box.

The Rate Limit Range for manual-config (Min in Kbps, Max in Mbps) and Increment

(Kbps) fields become active.
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19. In the Rate Limit Range for manual-config (Min in Kbps, Max in Mbps) fields, enter 10
and 64 respectively.

20. In the Increment field, enter 64.

21. Click Next to proceed to the Review page of the wizard.

22. To save and complete the service definition, click Done.

TheManage Service Definitions page includes the new service definition.

You have created a customized Service Definition, but it has not yet been published.

Before a service definition can be used in provisioning, it must be published.

23. To publish the service definition, in theManage Service Definitions page, select the

vpls-dot1q-sd-1 service definition, and click the Publish button.

The Informationwindow appears.

24.To confirm that you want to publish this service definition, click Yes.

In theManage Service Definitions page, the State column changes to Published.

The service definition is now ready for use in provisioning.

See Also Predefined Service Definitions•

• Creating a Multipoint-to-Multipoint VPLS Service Definition

• Publishing a Custom Service Definition

Creating a Customer

Beforeyoucanprovision theservice, customerdetailsmustbepresent in the JunosSpace

data base. To add a customer:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In the Service View task pane, select Customers.

4. In the Tasks task pane, select Customer >Manage Customers.

5. In the View Customers task pane, select Add (+).
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6. In the Name field, enter Best Customer.

7. In the Account number field, enter 1234.

8. Click Create.

TheManage Customers page shows the new customer.

See Also Adding a New Customer•

Creating and Deploying aMultipoint-to-Multipoint Service Order

Now that you have prestaged your devices, created a suitable service definition, and

added the customer information to the database, you are ready to create and deploy a

service order.

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next to Network Services > E-LAN Services to expand the tree and display the

different service types that you can configure.

4. SelectManage Services from the task pane. The right pane displays two pages. The

Manage Network Services page is displayed in the upper half of the right pane.

Selectinga service fromthispagecauses theassociated serviceorders for the selected

service to be displayed in the Manage Service Orders page in the lower half of the

right pane.

5. Click the New icon at the top of the upper half of the page that displays previously

created service orders.

6. In the Name field of the Service Settingswindow, in the Name field, enter vpls_so_1.

7. In theCustomer field, select the customer for which you are creating the service order.

8. In the Service Definition field, select the service definition named vpls-dot1q-sd-1.

This service definition is the customized service definition you created earlier.

9. Click Next.
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10. In the Node Settings page, add the BLR, SFO, and SJC devices or endpoints, and

configure the roles of the devices.

11. Click Next.

12. In the Site Settings page, in the Rate Limit field, select 25.

13. Clear the Autopick VLAN ID check box.

14. In the VLAN ID field, enter 600.

15. Click Next to proceed to the Review page, which is the final step of the wizard.

16. Click Done. The E-LAN service order is created.

17. Select the created E-LAN service order in the Manage Service Orders page. You can

save the service order for later deployment, schedule the service order for later

deployment, or deploy the service order now. Click Deploy now.

18. ClickOK to start the deployment.

19. Tomonitor the progress and status of the deployment, in the Manage Service Orders

page, click the job ID under the Latest Job field. The JobManagement page shows the

status of the job.

20.When you see in the JobManagementwindow that the deployment is successful, in

the Network Services task pane, select the Service Provisioningworkspace again.

21. In the task pane, select Deploy Services.

TheManageNetworkServicespage,which is displayed in the tophalf of the right pane,

shows the new service.

See Also Creating a Multipoint-to-Multipoint VPLS Service Order•

• Deploying a Service Order

Performing a Functional Audit and a Configuration Audit

Nowthat your newservice is deployed,we recommend that you validate its configuration

and functional integrity. A functional audit runs operational commands on the device to

verify that the service is up or down. A configuration audit verifies whether the

configuration thatwas pushed to the device during deployment is actually on the device.

To perform a configuration audit and a functional audit of the service:
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1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next to Network Services > E-LAN Services to expand the tree and display the

different service types that you can configure.

4. SelectManage Services from the task pane. The right pane displays two pages. The

Manage Network Services page is displayed in the upper half of the right pane.

Selectinga service fromthispagecauses theassociated serviceorders for the selected

service to be displayed in the Manage Service Orders page in the lower half of the

right pane.

5. In theManage Network Services page, select the service instance you just deployed.

6. Select the service instance, click the Auditmenu and select Functional Audit >Run

Functional Audit.

7. In the Schedule Functional Auditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, then clickOK.

8. In theOrder Information screen, clickOK.

9. Select the service instance, click the Auditmenu and select Configuration Audit > Run

Configuration Audit.

10. In theScheduleConfigurationAuditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, and then clickOK.

11. In theOrder Informationwindow, clickOK.

When the audit jobs have finished, success is indicated by an up arrow in the top right

corner of the service.

12. To view the functional audit results, select the service instance and click Audit >

Functional Audit >View Results.

In the Functional Audit Resultswindow, select each device to view the results.

13. To view the results of the configuration audit, select the service instance and click

Audit > Configuration Audit >View Results.
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In the Configuration Audit Resultswindow, select each device in turn and review the

results. This report indicates any part of the service configuration that is missing on

the device, or is inconsistent with the Junos Space database.

Following a successful audit, the service is deployed and ready to be used.

Related
Documentation

Device Discovery Overview in the Junos Space Network Application Platform User Guide•

• Discovering Devices in the Junos Space Network Application Platform User Guide

Example: Configuring and Deploying an IP Full-Mesh Service

This example showshowtoset upasimple full-meshserviceproviderVPNconfiguration,

as shown in Figure 27 on page 1243.

Figure 27: Simple IP Full-Mesh Service
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Figure 28: Example of a Simple VPN Topology
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This service provides connectivity for one VLAN, (VLAN ID = 600). Customer site A

connects to thenetwork throughanN-PEdevicenamedSJC (IPaddress 1.1.1.1). Customer

site B connects to the network through an N-PE device named SFO (IP address 1.1.1.2).

Customer siteCconnects to thenetwork throughanN-PEdevicenamedBLR(IPaddress

1.1.1.3).

• Preparing Devices for Discovery on page 1244

• Discovering Devices on page 1245

• Preparing Devices for Prestaging on page 1246

• Discovering and Assigning N-PE Roles on page 1247

• Choosing or Creating a Service Definition on page 1248

• Creating a Customer on page 1250

• Creating and Deploying an IP Service Order on page 1250

• Performing a Functional Audit and a Configuration Audit on page 1252

Preparing Devices for Discovery

Before you can add a device using device discovery, the following conditions must be

met:

• SSH v2 is enabled on the device. To enable SSH v2 on a device, issue the following CLI

command:

set system services ssh protocol-version v2

• The NETCONF protocol over SSH is enabled on the device. To enable the NETCONF

protocol over SSH on a device, issue the following CLI command:

set system services netconf ssh
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• The device is configured with a static management IP address that is reachable from

the Junos Space server. The IP address can be in-band or out-of-band.

• A user with full administrative privileges is created on the device for the Junos Space

administrator.

• If youplan to useSNMP toprobedevices as part of device discovery, ensure that SNMP

is enabled on the device with appropriate read-only V1/V2C/V3 credentials.

Discovering Devices

Device discovery is a process that Junos Space uses to bring network devices under its

control. This example brings two MX Series routers under Junos Spacemanagement.

NOTE: Alternatively, you can import devices using the Connectivity Services
Director GUI. See Discovering Devices in a Physical Network for instructions
on discovering devices from Build mode of Connectivity Services Director.

1. Log in to Junos Space using your credentials.

2. From the Junos Space Network management Platform user interface, select Devices

>Discover Devices > Discover Targets.

3. In the Discover Targetswindow, click +.

The Add Device Targetwindow appears.

4. Select IP range.

5. Enter the IP address information. This example uses a range of three addresses.

6. Click Add, and then click Next.

7. In the Devices: Specify Probeswindow, select both Ping and SNMP as probes.

8. Click Next.

9. In the Devices: Specify Credentialswindow, click + and enter the device login

credentials.

10. Click Finish.

Device discovery begins. It displays a graph showing the status of the discovery

operation. Initially, three devices are discovered. When the Junos Space software has
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accessed all three devices and brought themunder itsmanagement, all three devices

move from the Discovered column of the graph to the Managed column.

11. To check the results of the device discovery operation, select the Devicesworkspace

again, then select DeviceManagement. TheManage Devices page shows the added

devices.

See Also Device Discovery Overview in the Junos Space Network Application Platform User Guide•

• Discovering Devices in the Junos Space Network Application Platform User Guide

Preparing Devices for Prestaging

Before prestaging devices for multipoint-to-multipoint services, the following entities

must be configured:

• MPLSmust run on each N-PE device.

• MPBGPmust run on each N-PE device that you want to participate in a Layer 3 full

mesh service.

To satisfy the preceding criteria, ensure that the following configuration exists on each

N-PE device:

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
                address 10.1.22.2/30;
            }
            family mpls;
        }
    }

    }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.30/32;
            }
        }           
    }

}
routing-options {
    autonomous-system 65410;
}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
    bgp {
        group IBGP {
            type internal;
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            local-address 192.168.10.1;
            family inet-vpn {
      unicast; 
            }
            peer-as 65410;
            neighbor 192.168.10.4;
        }
    }
    ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
}

Discovering and Assigning N-PE Roles

Before you can provision services, youmust prestage the devices. prestaging includes

assigning device roles and designating interfaces on those devices asUNIs. This example

provides the steps to accept the recommendations of the Network Services application

for N-PE devices and UNIs.

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Prestage Devices > Prestage

Devices.

View the values displayed under the Roles column of the discovered devices.

This action launches the role discovery process in which the Network Services

applicationexamines thedevicesunder JunosSpacemanagement looking fordevices

that match predefined rules that identify N-PE devices. In this example, the Role

Discovery Status graph shows that the Network Services application has discovered

two such devices.

4. ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayed with the job ID of the discovery job

that is created to obtain the latest roles of the devices.
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5. To view the assignment status, in the CSDDeployment Jobswindow that you can

access from Deploy mode of Service View by selecting View Deployment Jobs from

the task pane, click the job ID of the assignment job.

The JobManagement page shows the progress and status of the role assignment job.

6. To verify the result, in Build mode, select Prestage Devices >Manage Device Roles

from the tasks pane.

TheManageDeviceRoleswindowshowstwodevices thatcanbeused forprovisioning.

7. To unassign a device fromN-PE role assignment, clickManage Device Roles and from

the drop-down list, select Unassign Role to remove the role capability of a network

element. You are prompted to confirm the operation. If you clickOK, a request is

submitted to remove the latest role of the network element or device.

See Also Prestaging Devices Overview•

• Discovering and Assigning All N-PE Devices

• Discovering and Assigning N-PE Devices with Exceptions

Choosing or Creating a Service Definition

A service definition provides a template uponwhich services are built. It specifies service

attributes that are not specific to a service instance. In this example, the service definition

provides all service attributes except the N-PE devices, the UNIs, and bandwidth.

TheNetwork Services application shipswith standard service definitions. First, we check

the standard service definitions to determine whether one already exists that will work.

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In the Network Services > Connectivity task pane, select Service Design >Manage

Service Definitions.

TheManageServiceDefinitionspage lists all service definitions in the system. In a new

system, the page lists only predefined service definitions.

This example requires a L3 VPN full mesh service definition with OSPF/Static routing

to allow each PE router to distribute VPN-related routes to and from connected CE

routers.

4. In the Network Services > Connectivity task pane, select Service Design >Manage

Service Definitions > New > IP Service Definition.
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The General Settings window appears.

5. In the name field, enter the name “l3vpn-ospf-static-full-mesh-sd” for the service

definition.

6. In the Service type field, select L3 VPN (Full Mesh).

NOTE: Thisservicedefinitiondoesnot includeaservice templatedefinition
for the service, so the Service Template Definition field is left blank.

7. In the Connectivity Settings box, select Auto pick Route Distinguisher to allow the

Network Services application to automatically select the route distinguisher.

8. Click Next to save the General Settings step information.

Continue with “Site Settings” next.

9. In the VLAN ID selection field, select Selectmanually to have the service provisioner

select a VLAN ID for the service.

10. To enable the service provisioner to override this setting in a service order, select the

Editable in service order check box.

11. In the VLAN range for manual input, enter “500” and “700” for VLAN ID start and end

values to restrict the range of VLANs to this pool.

12. In the PE-CE Settings box, select theOSPF/Static Route radio button for Allowed

RoutingProtocols touseOSPF/Static toalloweachPE router todistributeVPN-related

routes to and from connected CE routers.

13. Click Review to review and create the IP service definition.

14. To save and complete the service definition, click Finish.

TheManage Service Definitions page includes the new service definition.

You have created a customized Service Definition, but it has not yet been published.

Before a service definition can be used in provisioning, it must be published.

15. To publish the service definition, in theManage Service Definitions page, select the

vpls-dot1q-sd-1 service definition, and click the Publish Service Definition button.

The Publish Service Definitionwindow appears.

16. To confirm that you want to publish this service definition, click Publish.
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In theManage Service Definitions page, the State column changes to Published.

The service definition is now ready for use in provisioning.

Creating a Customer

Beforeyoucanprovision theservice, customerdetailsmustbepresent in the JunosSpace

database. To add a customer:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In theNetworkServices>Connectivity task pane, selectServiceProvisioning>Manage

Customers > Create Customer.

4. In the Name field, enter Best Customer.

5. In the Account number field, enter 1234.

6. Click Create

TheManage Customerswindow shows the new customer.

See Also Adding a New Customer•

Creating and Deploying an IP Service Order

Now that you have prestaged your devices, created a suitable service definition, and

added the customer information to the database, you are ready to create and deploy a

service order.

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next to Network Services > VPLS Services to expand the tree and display the

different service types that you can configure.

4. Select Deploy Services from the task pane. The right pane displays two pages. The

Manage Network Services page is displayed in the upper half of the right pane.
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Selectinga service fromthispagecauses theassociated serviceorders for the selected

service to be displayed in the Manage Service Orders page in the lower half of the

right pane.

5. Click the New icon at the top of the upper half of the page that displays previously

created service orders. The Select Service Type dialog box appears.

6. Select IP to create an IP service order.

The General/Connectivity Settings panel appears initially in the right panel, as shown

in the example.

7. In the Create L3 VPN Service Orderwindow, select the service definition named

l3vpn-ospf-static-full-mesh-sd.

This service definition is the customized service definition you created earlier.

8. In the General Settings box of the Service Settingswindow, in the Name field, enter

l3vpn_ospf_full_mesh_so.

9. In the Customer field, select Best Customer.

10. In the PE-CE Settings box, enter “1.1.1.1” as theOSPF domain ID.

11. Click Next.

12. In the Node Settingswindow, select BLR, SFO, and SJC as the endpoint devices.

13. Click Next.

14. In theSiteSettingswindow,clear theAutopickVLANIDcheckbox (thedefault setting).

15. In the VLAN ID field, enter “600”.

16. In the Interface IP field, enter an IP address/subnet for the device, for example,

10.255.245.68/28.

17. In theOSPF area ID field, enter an IP address for the OSPF area.

18. Click Save.

19. Repeat Step 10 through Step 12, for each endpoint device that you want to include in

the service.
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20.Click Next. The Review page of the wizard is displayed.

21. ClickDone. The service order is created and listed in theManage Service Orders page.

22. You can schedule the deployment of the service order for a specific time, or deploy

the service now. Select Deploy now and clickOK to start the deployment.

23. Tomonitor the progress and status of the deployment, in the Order Information

window, click the job ID. The JobManagement page shows the status of the job.

24.When you see in the JobManagement page that the deployment is successful, in the

Network Services task pane, select the Service Provisioning>ManageDeploy Services.

TheManage Network Services page shows the new IP full mesh service.

Performing a Functional Audit and a Configuration Audit

Nowthat your newservice is deployed,we recommend that you validate its configuration

and functional integrity. A functional audit runs operational commands on the device to

verify that the service is up or down. A configuration audit verifies whether the

configuration thatwas pushed to the device during deployment is actually on the device.

To perform a configuration audit and a functional audit of the service:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next to Network Services > E-Line Services to expand the tree and display the

different service types that you can configure.

4. Select Deploy Services from the task pane. The right pane displays two pages. The

Manage Network Services page is displayed in the upper half of the right pane.

Selectinga service fromthispagecauses theassociated serviceorders for the selected

service to be displayed in the Manage Service Orders page in the lower half of the

right pane.

5. In theManage Network Services page, select the service instance you just deployed.

6. Select the service instance, and open the Actionsmenu and select Run Functional

Audit.

Copyright © 2019, Juniper Networks, Inc.1252

Connectivity Services Director User Guide



7. In the Schedule Functional Auditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, then clickOK.

8. In theOrder Information screen, clickOK.

9. Select the service instance, and open the Auditmenu and select Run Configuration

Audit.

10. In theScheduleConfigurationAuditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, and then clickOK.

11. In theOrder Informationwindow, clickOK.

When the audit jobs have finished, success is indicated by an up arrow in the top right

corner of the service.

12. To view the functional audit results:

a. From the View selector, select Service View. The workspaces that are applicable

to routing and tunnel services are displayed.

b. Click theBuild icon in theServiceViewof theConnectivity ServicesDirector banner.

The functionalities that you can configure in this mode are displayed in the task

pane.

c. From the Network Services > Connectivity > IP Services View pane, select the

l3vpn_ospf_full_mesh_so service instance.

d. In the tasks pane, select Audit/Results > Functional Audit.

e. In the Functional Audit Resultswindow, select each device to view the results.

13. To view the results of the configuration audit:

a. From the View selector, select Service View. The workspaces that are applicable

to routing and tunnel services are displayed.

b. Click theBuild icon in theServiceViewof theConnectivity ServicesDirector banner.

The functionalities that you can configure in this mode are displayed in the task

pane.

c. From the Network Services > Connectivity > IP Services View pane, select the

l3vpn_ospf_full_mesh_so service instance.
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d. In the tasks pane, select Audit/Results > Configuration Audit.

e. In the Configuration Audit Resultswindow, select each device in turn and review

the results. This report indicatesanypart of theserviceconfiguration that ismissing

on the device, or is inconsistent with the Junos Space database.

Following a successful audit, the service is deployed and ready to be used.
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PART 16

Working with Chassis View

• Working with Devices on page 1257

• Managing CLI Configlets on page 1271
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CHAPTER 50

Working with Devices

• About Chassis View on page 1257

• Accessing the Chassis View from the Physical Inventory Page on page 1258

• Viewing a Graphical Image of the Chassis and Components on page 1259

• Deleting Devices from Chassis View on page 1267

• Rebooting Devices After Examining the Status in Chassis View on page 1268

About Chassis View

You can view a high-level, graphical representation of the chassis. It indicates the state

of the interfaces. When the administrative and operational status of the interface is up,

it is displayed in green. If the administrative status is down, the interface is displayed in

grey. And, if the administrative status is up and operational status is down, the interface

is displayed in red. The image is a replica of the device. If you are connected to a virtual

chassis, the image includes all the member switches of the virtual chassis. The chassis

viewalso displays a count of alarms generated in the system;major alarms are displayed

in red, andminor alarms in orange.

The purpose of the view is to try and provide a comprehensive monitoring view of the

health and status of deployed devices across the network. In this view all the managed

devices are shown with their appropriate status and health based on the services and

device settingsapplied. This viewhelps theoperator to knowthehealthandstatusacross

the network, it provides with the operator to quickly see the macro level information,

whichallows theoperator to furtheranalyze the informationprovidedandquicklynavigate

to individual devices and take any further corrective measure required. It provides a

cohesive tool for the operator to quickly see the micro-level information and take any

further remediation action required.

To view a pictorial representation of a device chassis and the configured components,

such as interfaces, line cards, and hardware elements, select a managed device listed

in theMyNetwork tree in Device Viewof Buildmode of the Connectivity Services Director

GUI, and select DeviceManagement > View Physical Inventory from the tasks pane. The

right pane displays the device image and the corresponding description of the view

selected ina tabularmanner. Thechassis view isdisplayed.Thehardwareand linemodule

details are displayed with a pictorial view of the slots of the devices and themodules

installed in these slots. The device image can be rotated to view the front, rear, top,

bottom, right and left planes of the device by clicking the respective arrow buttons on
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the page. The View Front icon and the View Back icon are denoted by a square icon with

downward and upward arrows in the square. The View Front and View Back icons are

toggle buttons. The device image can be rotated in various orientation along 360degree.

You can use the navigation options for rotating devices to view different planes on the

device and the components installed on each plane. The front view displays the

components installedand the interfacesconfiguredon thedevice.ClickRefresh toupdate

the contents of the page.

Related
Documentation

Deleting Devices from Chassis View on page 1267•

• Rebooting Devices After Examining the Status in Chassis View on page 1268

• Accessing the Chassis View from the Physical Inventory Page on page 1258

Accessing the Chassis View from the Physical Inventory Page

The Dashboard page is the landing page that is displayed when you login to the

Connectivity Services Director application. You can view all the available devices that

are managed by Connectivity Services Director from the Device Inventory page. The

Device Inventory page is accessible in Device View of Build mode as the default landing

page. Alternatively, select View Inventory in the task pane to open the Device Inventory

page.Basedonyour selectionof routers, theDevice Inventorypagedisplaysdevicedetails.

The Device Inventory page varies based on your selection in the View pane. When you

select a node in the View pane, the inventory of all devices that are included under that

node is displayed.

For example:

• Device View and My Network is selected: Displays all the devices that are managed

by Connectivity Services Director.

Youcanviewthephysical inventoryofall thedevices in yournetwork in theDevicePhysical

Inventory page. The Device Physical Inventory page displays information about the slots

that are available for a device and provides information about power supplies, chassis

cards, fans, part numbers, and so on. Connectivity Services Director displays hardware

inventory by device name, based on data retrieved both from the device during discovery

and resynchronizing operations, and from the data stored in the hardware catalog. For

eachmanaged device, the physical inventory page provides descriptions for field

replaceable units (FRUs), part numbers, model numbers, and the pluggable locations

fromwhich empty slots are determined.

To view a pictorial representation of a device chassis and the configured components,

such as interfaces, line cards, and hardware elements, select a managed device listed

in theMyNetwork tree in Device Viewof Buildmode of the Connectivity Services Director

GUI, and select DeviceManagement > View Physical Inventory from the tasks pane.

The following are the different device types in the device families that are supported in

Chassis view:
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• MX Series routers—MX5, MX10, MX40, MX240, MX480, MX960, MX2010, MX2020,

MX80, MX80-P, MX80-T, MX80-48-T, MX150, MX204, MX10003

• ACX Series routers—ACX1000, ACX1100, ACX2000, ACX2100, ACX2200, ACX4000,

ACX500-DC, ACX500-O, ACX500-O-POE, ACX5048, ACX5096, ACX5448

• PTX Series routers—PTX3000, PTX5000, PTX1000

Related
Documentation

Deleting Devices from Chassis View on page 1267•

• Rebooting Devices After Examining the Status in Chassis View on page 1268

• About Chassis View on page 1257

• Service Monitoring Capabilities in Connectivity Services Director on page 1134

Viewing a Graphical Image of the Chassis and Components

The Chassis view provides a pictorial representation of the chassis or device, and the

modules or components that are installed in it, such as the line cards, interfaces, and

other hardware elements

To view a graphical image of the chassis and its associated components:

1. From the View selector, selectDevice View. The functionalities that you can configure

in this view are displayed.

2. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and view the list of devices. Select the device for which you want to

define the optical port settings.

3. FromtheTaskspane, selectDeviceManagement>ViewPhysical Inventory. A graphical

view of the device is displayed on the right pane.

4. Click a particular module to display the associated details in the lower half of the

page. The Rotate and Perspective buttons enable you to view the images images in

required orientation.

5. Click the Rotate (arrows in a square symbol) icon to cause the device image to

continuously rotate along the x-axis.

6. Click the Perspective (cube symbol) icon to display the device image in

three-dimensional format. It is a toggle button, which causes the device image to be

shown in either three-dimensional or one-dimensional format.
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7. Select the level ofmagnification of the imageby clicking theZoom(magnifying glass)

icon.The image is expandedanddisplayed.Alternatively, use theslider control beneath

the Zoom icon to change the level of magnification.

8. Click the home icon to return to the front view of the chassis. The selected interface

is surrounded with a colored outline based on the operational status as suggested

below. An interface that is operationally up is denoted in green and an interface that

is operationally down is represented in red. The components are depicted as small

colored icons at the top left corner of the front-view equipment image.

In the graphical image of the device displayed, you canmouse over the different parts

of the device, such as the interfaces, line cards, and slots. When youmouse over the

different modules, their corresponding details are displayed as tooltips. On clicking the

device components, the corresponding description for the selected component is

displayed by default under the Component Info pane and the Equipment tab with the

following values.

• Manufacturer—Name of the company that built and shipped the device.

• Part number—Part number of the chassis component.

• Serial number—Serial number of the chassis component. The serial number of the

backplane is also the serial number of the router or switch chassis. Use this serial

number when you need to contact Juniper Networks Customer Support about the

router or switch chassis.

When you select any physical interface configured on the DPCs or PICs or MICs

provisioned, the following fields are displayed for the corresponding component for each

interface. The interface is surrounded by a colored box to show the Operational Status.

The Component Info pane and the Active Alarmsmonitor are displayed in the lower half

of the page.

The Active Alarmsmonitor shows any active alarm that has not yet been cleared. You

canview thealarmname, theunique identifier assigned to thealarm, theperson towhich

the alarm is assigned for corrective action, and the severity of the alarm. Click the Launch

AlarmMgmt icon (right upward-slanting arrow enclosed in a square) to navigate to the

Fault mode and view the four standard alarmmonitors available in Fault mode.

Active Alarms for the respective components are displayed when the component is

clicked in the graphical image of the chassis displayed. The components for which the

alarms are displayed are Flexible Port Concentrator (FPC), Dense Port Concentrator

(DPC), Physical Interface Card (PIC), Modular Interface Card (MIC), Routing Engine,

ControlBoards, fan trays,Switch InterfaceBoard (SIB), andpower supplymodule (PSM).

The following fields are displayed in the Active Alarms pane:
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Table 189: Active AlarmsMonitor

DescriptionTable Column

The severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is necessary.

• Major—Amajor error has occurred; escalate or notify as necessary.

• Minor—Aminor error has occurred; notify or monitor the condition.

• Info—An informational message; no action is necessary.

Severity

The alarm name.Name

The IPaddressof thedeviceornetworkelement thatgenerated thealarm.TheSNMP
agent is located at the source IP. In most cases, the source IP is the IP address of the
switch or controller.

Source

The date and time that the information for the alarmwas last modified.Last Updated

The following fields are displayed in the Component Info pane:

Table 190: Fields for Physical Interfaces in the Component Info Pane

DescriptionField

Hostname of the device.Host Name

Name of the physical interface.Physical Interface Name

IP address configured on the interface.IP Address

Encapsulation configured on the logical interface.Encapsulation

MAC address configured on the interfaceHardware Address

Operational status of the physical interface: Up, Down.Operation Status

Administrative state of the interface: Enabled or Disabled. If the
interface is disabled, it can provide network connectivity, but it
cannot provide power to connected devices.

Admin Status

Encapsulation type configured on the interface.Link Level Type

Data transmission type.Link Type

Speed at which the interface is running.Speed

Maximum transmission unit size on the physical interface.MTU

Specifies whether the loopback status is enabled or disabled. If
loopback is enabled, type of loopback: Local or Remote.

Loopback
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Table 190: Fields for Physical Interfaces in the Component Info Pane (continued)

DescriptionField

Configured textual description of the interface.Description

A redundant Ethernet interface is a pseudointerface that includes at minimum one

physical interface from each node of the cluster. A redundant Ethernet interface must

contain, at minimum, a pair of Fast Ethernet interfaces or a pair of Gigabit Ethernet

interfaces that are referred to as child interfaces of the redundant Ethernet interface (the

redundant parent). If two or more child interfaces from each node are assigned to the

redundant Ethernet interface, a redundant Ethernet interface link aggregation group

must be formed.

A pseudowire subscriber logical interface terminates an MPLS pseudowire tunnel from

an access node to theMXSeries router that hosts subscribermanagement, and enables

you toperformsubscribermanagementservicesat the interface.Subscribermanagement

supports the creation of subscriber interfaces over E-Line MPLS pseudowires. The

pseudowire subscriber interface capability enables service providers to extend an MPLS

domain from the access-aggregation network to the service edge, where subscriber

management is performed. Service providers can take advantage of MPLS capabilities

such as failover, rerouting, and uniformMPLS label provisioning, while using a single

pseudowire to service a large number of DHCP and PPPoE subscribers in the service

network.

NOTE: The pseudowire is a tunnel that is either anMPLS-based Layer 2 VPN
or Layer 2 circuit. The pseudowire tunnel transports Ethernet encapsulated
traffic from an access node (for example, a DSLAM or other aggregation
device) to the MX Series router that hosts the subscriber management
services. The termination of the pseudowire tunnel on the MX Series router
is similar to a physical Ethernet termination, and is the point at which
subscriber management functions are performed. A service provider can
configuremultiple pseudowires on a per-DSLAM basis and then provision
support for a large number of subscribers on a specific pseudowire. Figure 1
shows anMPLS network that provides subscriber management support.

The following table describes the fields displayed in the Pseudo Interfaces pane.

Table 191: Pseudo Interfaces Columns

DescriptionField

Name of the pseudowire subscriber logical interface.Pseudo Interface Name

Signaling type for the pseudowire interface. You can use either Layer
2 circuit signaling or Layer 2 VPN signaling. The two signaling types are
mutually exclusive for a given pseudowire.

Type

Operational status of the physical interface: Up, Down.Operation Status
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Table 191: Pseudo Interfaces Columns (continued)

DescriptionField

Administrative state of the interface: Enabled or Disabled. If the
interface is disabled, it can provide network connectivity, but it cannot
provide power to connected devices.

Admin Status

The logical interfaces configuredoneach interfacearealso shownalongwith thephysical

interface description in a tabular format. The following table describes the details

displayed for logical interfaces.

Table 192: Logical Interfaces Columns

DescriptionField

The device configuration name.Device Name

Standard information about the interface, in the format
type-/fpc/pic/port/logical interface,where type is themedia type that
identifies the network device; for example, ge-0/0/6.135.

Interface Name

The IP address for the logical interface.IP Address

The encapsulation type used on the logical interface.Encapsulation

The VLAN ID for the logical interface.Vlan

An optional description configured for the interface. It can be any text
string of 512 or fewer characters. Any longer string is truncated. If there
is no information, the column entry is blank.

Description

From the chassis view window, click the Details icon (arrow enclosed in a square) at the

top-right corner of the window to open the Chassis View Details page that lists the

configured devices and their parameters in the form of a table.

The following fields are displayed on the right pane, depending on the component or

element of the chassis you selected from the chassis image displayed.

Table 193: Fields in the Chassis View Details Page

DescriptionField

Name of the SDG and the platform type, such as MX240 or MX480. Click the plus
sign (+) toexpand the tree todisplay thecomponentsof thedevice, suchaschassis,
PIC, CPU, and PIC parameters. Information about the chassis, midplane, craft
interface (FPM), power midplane (PMP), Power Supply Modules (PSMs), Power
Distribution Modules (PDMs), Routing Engines, Control Boards (CBs) and Switch
Processor Mezzanine Boards (SPMBs), Switch Fabric Boards (SFBs), Flexible PIC
Concentrators (FPCs), PICs, adapter cards (ADCs) and fan trays is displayed.

Module

Model number of the FRU hardware component.Model
Number
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Table 193: Fields in the Chassis View Details Page (continued)

DescriptionField

Model of the FRU component.Model

Part number of the chassis component.Part
Number

Serial number of the chassis component. The serial number of the backplane is
also the serial number of the router chassis. Use this serial number when you need
to contact Juniper Networks Customer Support about the router or switch chassis.

Serial
Number
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Table 193: Fields in the Chassis View Details Page (continued)

DescriptionField

Description
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Table 193: Fields in the Chassis View Details Page (continued)

DescriptionField

Brief description of the hardware item:

• Type of power supply.

• Type of PIC. If the PIC type is not supported on the current software release, the
output states Hardware Not Supported.

• Type of FPC: FPC Type 1, FPC Type 2, FPC Type 3, FPC Type 4 , or FPC TypeOC192.

On EX Series switches, a brief description of the FPC.

On the JSeries routers, theFPCtypecorresponds to thePhysical InterfaceModule
(PIM). The following list shows the PIM abbreviation in the output and the
corresponding PIM name.

• 2x FE—Either two built-in Fast Ethernet interfaces (fixed PIM) or dual-port
Fast Ethernet PIM

• 4x FE—4-port Fast Ethernet ePIM

• 1x GE Copper—Copper Gigabit Ethernet ePIM (one 10-Mbps, 100-Mbps, or
1000-Mbps port)

• 1x GE SFP—SFP Gigabit Ethernet ePIM (one fiber port)

• 4x GE Base PIC—Four built-in Gigabit Ethernet ports on a J4350 or J6350
chassis (fixed PIM)

• 2x Serial—Dual-port serial PIM

• 2x T1—Dual-port T1 PIM

• 2x E1—Dual-port E1 PIM

• 2x CT1E1—Dual-port channelized T1/E1 PIM

• 1x T3—T3 PIM (one port)

• 1x E3—E3 PIM (one port)

• 4x BRI S/T—4-port ISDN BRI S/T PIM

• 4x BRI U—4-port ISDN BRI U PIM

• 1x ADSL Annex A—ADSL 2/2+ Annex A PIM (one port, for POTS)

• 1x ADSL Annex B—ADSL 2/2+ Annex B PIM (one port, for ISDN)

• 2x SHDSL (ATM)—G SHDSL PIM (2-port two-wire module or 1-port four-wire
module)

• 1x TGM550—TGM550 Telephony Gateway Module (Avaya VoIP gateway
modulewith one console port, two analog LINE ports, and two analog TRUNK
ports)

• 1x DS1 TIM510—TIM510 E1/T1 Telephony Interface Module (Avaya VoIPmedia
module with one E1 or T1 trunk termination port and ISDN PRI backup)

• 4x FXS, 4xFX0, TIM514—TIM514 Analog Telephony Interface Module (Avaya
VoIPmediamodulewith four analog LINEports and four analogTRUNKports)

• 4x BRI TIM521—TIM521 BRI Telephony Interface Module (Avaya VoIPmedia
module with four ISDN BRI ports)

• Crypto Accelerator Module—For enhanced performance of cryptographic
algorithms used in IP Security (IPsec) services

• MPCM 16x 10GE—16-port 10-Gigabit Module Port Concentrator that supports
SFP+ optical transceivers. (Not on EX Series switches.)

• For hosts, the Routing Engine type.

• For small form-factor pluggable transceiver (SFP) modules, the type of fiber:
LX, SX, LH, or T.

• LCD description for EX Series switches (except EX2200 switches).
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Table 193: Fields in the Chassis View Details Page (continued)

DescriptionField

MPC2—1-port MPC2 that supports two separate slots for MICs.•

• MPC3E—1-port MPC3E that supports two separate slots for MICs
(MIC-3D-1X100GE-CFPandMIC-3D-20GE-SFP)onMX960,MX480,andMX240
routers. The MPC3Emaps one MIC to one PIC (1 MIC, 1 PIC), which differs from
themapping of legacy MPCs.

• 100GBASE-LR4, pluggable CFP optics

• Supports the Enhanced MX Switch Control Board with fabric redundancy and
existing SCBs without fabric redundancy.

• Interoperates with existing MX Series line cards, including Flexible Port
Concentrators (FPC), Dense Port Concentrators (DPCs), and Modular Port
Concentrators (MPCs).

• MPC4E—Fixed configuration MPC4E that is available in two flavors:
MPC4E-3D-32XGE-SFPP and MPC4E-3D-2CGE-8XGE on MX2020, MX960,
MX480, and MX240 routers.

• LCD description for MX Series routers

Related
Documentation

Deleting Devices from Chassis View on page 1267•

• Rebooting Devices After Examining the Status in Chassis View on page 1268

• About Chassis View on page 1257

Deleting Devices fromChassis View

You can delete devices that are no longer used from Connectivity Services Director and

for which you do not want to view a pictorial representation using the Chassis View

functionality. Deleting a device removes all device configuration and device inventory

information from the JunosSpacedatabase.Onceadevice is deleted from thedatabase,

all the profiles associations, device configurations, and inventory information of the

deleted device are also deleted. However, the systemmaintains the audit logs and

monitoring data for the device even after the device is deleted.

Use the Delete Devices page to delete devices fromConnectivity Services Director.While

in Build mode, click Delete Devices from the Tasks > Device Management menu. The

Delete Devices page appears.

The Delete Devices page displays the devices contextually depending on your selection

in theViewpane. For example, if you select a site inServiceViewandclickDeleteDevices,

Connectivity Services Director displays all the devices. If you select a particular switch

family in Device View and click Delete Devices, only devices that belong to that switch

family are displayed.
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To delete devices, complete the following tasks:

1. From theView selector, select ServiceView. The functionalities that you can configure

in this view are displayed.

2. Click the Build mode icon in the Service View of the Connectivity Services Director

banner. The workspaces that are applicable to this mode are displayed.

Select the My Network scope in the View pane that contains the devices you want to

delete.

3. Select Delete Devices from the Tasks pane.

4. Select the check box adjacent to the device that you want to delete. Click Done.

5. ConnectivityServicesDirectorprompts you toconfirmthedeletion.ClickYes toconfirm

the deletion or No to go back andmake changes to the selection.

Related
Documentation

Rebooting Devices After Examining the Status in Chassis View on page 1268•

• About Chassis View on page 1257

• Service Monitoring Capabilities in Connectivity Services Director on page 1134

Rebooting Devices After Examining the Status in Chassis View

In certain situations, when you identify a certain discrepancy or malfunctioning of a

component, such as a line card or an interface, by examining the status of the hardware

module using the Chassis View, youmight require the component to be rebooted. When

a hard disk error occurs, a Routing Enginemight enter a state inwhich it responds to local

pings and interfaces remain up, but no other processes are responding. To recover from

this situation, you can reboot a single Routing Engine when a hard disk error occurs.

Similarly, you can restart the FPCs when a traffic black-hole condition is detected.

Use the Reboot Devices task to immediately reboot the selected device. This task is

available in all scopes when in Build mode. To reboot one or more devices immediately:

1. For the My Network scope, you can customize what monitors appear on Summary

tab, giving you the ability to view at a glance those aspects of network health and

performance that are most important to you.

2. Click the Build mode icon in the Service View of the Connectivity Services Director

banner. The workspaces that are applicable to this mode are displayed.

3. Select the My Network scope in the View pane that contains the devices you want to

reboot.
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4. Select Reboot Devices from the Tasks pane.

5. Expand the tree on the page as needed to locate the available devices.

6. Select the check box for one or more devices.

7. Click Done to start the reboot or click Cancel to return to the Device Inventory page.

The rebooting process triggers a Cold Start Alarm that can be seen in Fault mode.

Related
Documentation

• Deleting Devices from Chassis View on page 1267

• Accessing the Chassis View from the Physical Inventory Page on page 1258

• About Chassis View on page 1257

• Service Monitoring Capabilities in Connectivity Services Director on page 1134
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CHAPTER 51

Managing CLI Configlets

• CLI Configlets Overview on page 1271

• CLI ConfigletsWorkflow on page 1274

• Configlet Context on page 1277

• Creating a CLI Configlet on page 1282

• Modifying a CLI Configlet on page 1285

• Deleting CLI Configlets on page 1286

• Viewing CLI Configlets on page 1286

• Creating a Parameter for a CLI Configlet on page 1289

• Applying a CLI Configlet to Devices on page 1291

• Deploying CLI Configlet Details on page 1294

CLI Configlets Overview

CLI Configlets are configuration tools provided by Junos OS that enables you to apply a

configuration to a device by reducing configuration complexity. CLI Configlets contain

the Junos OS configuration as a formatted ASCII text. Junos Space uses the NETCONF

protocol to load and commit the configuration on devices.

A CLI Configlet is a configuration template that is transformed into a CLI configuration

string before being applied to a device. The dynamic elements (strings) in configuration

templates are defined using template variables. These variables act as an input to the

process of transformation to construct the CLI configuration string. These variables can

contain the interface name, device name, description text, or any such dynamic values.

The value of these variables are obtained from the user or the system or given by the

context at the time of execution. Velocity templates (VTL) are used to define CLI

Configlets.

You can access the CLI Configlets workspace by selecting CLI Configlets from the left

pane. From the CLI Configlets workspace, you can perform the following tasks:

• Viewing the statistics of CLI Configlets in Junos SpaceNetworkManagement Platform

• Creating, modifying, cloning, applying, or deleting a CLI Configlet

• Marking and unmarking CLI Configlets as favorites
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You can also apply CLI Configlets to devices from the Devices workspace. It can be

triggered from the actual elements for which the configuration has to be applied. The

context of the element for which the CLI Configlet is being applied is called an execution

context.

NOTE: CLI Configlets are not supported on SSG Series devices, NetScreen
Series devices, TCA Series devices, BXOS Series devices, and Junos Content
Encore devices.

• Configlet Variables on page 1272

• Velocity Templates on page 1272

• Directives on page 1273

Configlet Variables

Variables inCLIConfiglets includea leading “$”. CLIConfiglets use three kindsof variables:

default, user-defined, and predefined.

Default Variables

The value of these variables need not be input by the user; these values are derived from

the current execution context. Table 194 on page 1272 lists the default variables.

Table 194: Default Variables

ValueVariable

Name of the host on which the CLI Configlet is applied$DEVICE

Name of the interface for which the CLI Configlet is applied$INTERFACE

Unit number of the logical interface for which the CLI Configlet is being applied$UNIT

Context of the element for which the CLI Configlet is applied$CONTEXT

User-defined Variables

The values for these variables are entered by the user at execution time. Text fields or

selection fields are used to obtain data from the user.

Predefined Variables

These are the variables for which the values are predefined when you create the CLI

Configlet. These variables are also called invisible parameters because they cannot be

modified by the user.

Velocity Templates

Junos Space Network Management Platform enables you to define the device

configuration in the form of velocity templates (VTL). These templates are called CLI

Configlets. TheVTL variable is a reference type,which includes the leading "$" character,
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followedby aVTL Identifier. CLI Configlets are transformed into aCLI configuration string

before they are applied to the device. This transformation is directed by references and

directives of VTL.

References are used to embed dynamic contents in the configuration text. Directives

allow dynamic manipulation of the contents.

Refer tohttp://velocity.apache.org/engine/releases/velocity-1.4/user-guide.html for detailed

information about VTL.

Directives

Directives include an included CLI Configlet’s contents and parameters in the base CLI

Configlet and import themetadata information related to theparameters of the included

CLI Configlet. You can include CLI Configlets in Junos Space Platform by using two

directives: #include_configlet and #mixin directives.

#include_configlet – This directive includes an included CLI Configlet’s contents and
parameters in the base CLI Configlet and imports the metadata information related to

the parameters of the included CLI Configlet. If you define a new parameter in the base

CLI Configlet by using the #include_configlet directive, the metadata information is

fetched and used from the included CLI Configlets. The parameter values updated in the

included CLI Configlet after their inclusion into the base CLI Configlet are not updated

and available for the base CLI Configlet. If both the base CLI Configlet and included CLI

Configlet contain parameters with a common name, the metadata information related

to the parameters is ignored.

#mixin – This directive differentiates the parameters of the base CLI Configlet from the

parametersof the includedCLIConfigleton the JunosSpaceuser interface.Theparameter

values for the included CLI Configlets can bemodified even when you apply the CLI

Configlet to the device. You cannot include CLI Configlets that have a period (.) or space

in its name.

You include these directives in the base CLI Configlet in the following format:

• #include_configlet(“<name of the included configlet>”)

• #mixin(“<name of the included configlet>”)

Related
Documentation

CLI ConfigletsWorkflow on page 1274•

• Configlet Context on page 1277

• Creating a CLI Configlet on page 1282

• Modifying a CLI Configlet on page 1285

• Deleting CLI Configlets on page 1286

• Viewing CLI Configlets on page 1286

• Creating a Parameter for a CLI Configlet on page 1289

• Applying a CLI Configlet to Devices on page 1291
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CLI ConfigletsWorkflow

ACLI Configlet canbedefined from theCLI Configletsworkspace. Table 195onpage 1274

lists the parameters to be defined for a CLI Configlet.

Table 195: Parameters for a CLI Configlet

DescriptionParameter

Name of the CLI Configlet. The name cannot exceed 255 characters. Allowable
characters include the hyphen (-), underscore (_), letters, and numbers and the
period (.). You cannot have two configlets with the same name.

Name

Category of the CLI Configlet. The category cannot exceed 255 characters.
Allowable characters include the hyphen (-), underscore (_), letters, and numbers
and the period (.).

Category

Device family series for which the CLI Configlet is applicable.Device Family Series

Context for which the CLI Configlet is applicable. This is an optional field.Context

Description of the CLI Configlet. The description cannot exceed 2500 characters.
This is an optional field.

Description

Selecting the Show Parameters option displays the parameters that are present
in the CLI Configlet. The Show Configuration option displays the consolidated
configuration before the CLI Configlet is applied.

Preview options

Selecting the Show Parameters option displays the parameters that are present
in the CLI Configlet. The Show Configuration option displays the consolidated
configuration after the CLI Configlet is applied.

Post-view options

The actual CLI Configlet is defined here. The CLI Configlet can contain multiple
pages and follows a tablike structure. The configuration being applied onto the
device can be split amongmultiple pages. When the configuration is applied, all
the pages are combined in order of the pagenumbers andapplied onto thedevice
in a single commit operation. Youmust always validate the CLI Configlet before
moving to the next page.

Configlet Content

The range of values are from 1 to 216.Reference Number

NOTE: You cannotmove to the next page if the contents of the CLI Configlet
are invalid. Validation includes bracket matching.

Parameters are variables defined in the CLI Configlet whose values are either retrieved

from the environment or entered by the user during execution.When the user applies CLI

Configlets, the user is asked to input values for all variables defined in the CLI Configlet.

To configure a parameter, click the modify icon on the toolbar. The Edit Configlet

Parameter page is displayed. Use this page to set the attributes of a parameter.
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To add an additional parameter, click the add icon on the toolbar. The Add Configlet

Parameter page is displayed. The attributes of a parameter are set from this page.

Todeleteaparameter, click thedelete iconon the toolbar. Bydefault, all variablespresent

in the CLI Configlet are listed on the Parameters page. Local variables must be deleted

manually or set to the “Invisible” type.

Table 196 on page 1275 lists the attributes of the CLI Configlet parameters.

Table 196: Attributes of CLI Configlet Parameters

DescriptionCLI Configlet Parameter Attributes

Name of the parameter

If displayedwith anamespace in the<configlet name>.<parameter.name>
format, this parameter belongs to the included CLI Configlet.

Parameter

Display name of the parameterDisplay Name

Description of the parameterDescription

The types of parameters supported are:

• Text field – You can provide a custom value when executing the CLI
Configlet. Thedefault value for this field canbeconfiguredwithanXPath
in the Configured Value Xpath field or with a plain string in the Default
Value field. This returns a single value.

• Selection field – You can select a value from a set of options when
executing this CLI Configlet. The default value for this field can be
configured with an XPath in the Configured Value Xpath field or with a
plain string in the Default Value field. The options can be configured by
an XPath in the Selection Values Xpath field, or by using a CSV string in
the Selection Values field. This returns a single value.

NOTE: Though this returns a single value, the return value is of the array
type and the selected value can be taken from index 0.

• Invisible field–Youcannot edit this field. This parameter refers to values
defined explicitly as aCSV string in theDefault Value field or by anXPath
in the Configured Value Xpath field. This field returns an array of values.

• Password field – You need to enter a value when you apply a CLI
Configlet containing the parameter. This hides sensitive information in
the Apply CLI Configlet job results.

• Password Confirm field – You need to enter a value twice when you
apply a CLI Configlet containing the parameter. This hides sensitive
information in the Apply CLI Configlet job results.

Types
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Table 196: Attributes of CLI Configlet Parameters (continued)

DescriptionCLI Configlet Parameter Attributes

This field is used to give the XPath of the configured values. The behavior
of this field depends on the type of parameter. When the parameter type
isa text fieldor selection field, thecorrespondingvaluepresent in theXPath
is takenas thedefault value. This valuecanbemodified. If theXPath returns
multiple values, the first value returned is considered.When the parameter
type is an invisible field, the list of values returned by the XPath is taken as
the value of the parameter.

Invisible field has configured value XPath and selection value XPath only
when the parameter scope is either device specific or entity specific. This
is disabled if the scope is global.

NOTE: When using $INTERFACE, $UNIT, Configured Value Xpath field,
Invisible field, and Selection field, the variable definition in the Configlet
Editor should contain .get(0) in order to fetch the value from the array. For
example, $INTERFACE.get(0).

Configured Value XPath

Displays the same behavior as the Configured Value Xpath field except
that the value is given explicitly. This field is considered only when
configured value XPath is not specified or if the XPath does not return any
value.

Default Value

This field is enabled only if the parameter type is a Selection field. This field
contains the XPath (with reference to the device XML) to fetch the set of
values for the Selection field.

Selection Values XPath

This field is the same as the Selection Values XPath field except that the
value is given explicitly. This field is considered only when selection values
XPath is not specified or if the XPath does not return any value.

NOTE: Comma-separatedvaluescanbeusedtoprovideanarrayofvalues
in the Default Value and Selection Values fields.

NOTE: While defining the XPath, youmust directly access the text node
with the text () function. Otherwise the complete XML path of the node is
returned. For example,
/device/interface-information/physical-interface/name/text() to
fetch the names of all interfaces.

Selection Values

Order of the parameter. This is the relative order in which the fieldmust be
displayed for user input at the time of execution.

Order

This field contains regular expression for the parameter that is used to
validate theparameter valuewhile youapply theCLIConfiglet to thedevice.

Regex Value

Whether the parameter belongs to the base configlet or the included
configlet:

• false – This parameter belongs to the base configlet.

• true – This parameter belongs to the included configlet. The parameter
cannot bemodified or deleted from this configlet.

Read-only
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Related
Documentation

CLI Configlets Overview on page 1271•

• CLI ConfigletsWorkflow on page 1274

• Configlet Context on page 1277

• Creating a CLI Configlet on page 1282

• Modifying a CLI Configlet on page 1285

• Deleting CLI Configlets on page 1286

• Viewing CLI Configlets on page 1286

• Creating a Parameter for a CLI Configlet on page 1289

• Applying a CLI Configlet to Devices on page 1291

Configlet Context

Execution of scripts and CLI configlets may be required in some case. For example, one

might need to restrict the scope of execution of 'disable interface' script to just the

interfaces that are enabled. Having a context associated to the script or configlet solves

this problem of restricting the scope. Context of an element is basically a unique path

which leads to its XML counterpart in the device XML.

For all context related computations, we consolidate the XMLs fetched form the device

under one node called device. This includes configuration XML, interface-information

XML, chassis-inventory XML, and system-information XML.

An example of a device XML is as follows:

<device>
 <interface-information>.....</interface-information>
 <system-information>.....</system-information>
 <chassis-inventory>.....</chassis-inventory>
 <configuration>....</configuration>
 ....
</device>

Table 197 on page 1277 shows the commands to view the XML from the CLI of the device.

Table 197: Commands to View XML from the CLI

CommandXML type

> show chassis hardware | display xmlChassis Inventory

> show interfaces | display xmlInterface Information

> show configuration | display xmlConfiguration

-System Information
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NOTE: ThecommandforsysteminformationXMLisnotavailable.An instance
of the system information XML is as follows:

<system-information>
<hardware-model>ex4200-24t</hardware-model>
<os-name>junos-ex</os-name>
<os-version>11.3R2.4</os-version>
<serial-number>BM0210293858</serial-number>
<host-name>EX4200-200</host-name>
<virtual-chassis/>
</system-information>

Context of an Element

There is a need to have the ability to restrict a script or configlet execution to certain

elements of interest. For example, onemight need to restrict the scope of execution of

'disable interface' script only to the interfaces that are enabled. Having a context

associated with the script or configlet solves this scoping problem.

The context of an element is the XPath that maps to the XML node that represents the

element in thedeviceXML.Table 198onpage 1278 lists the typeofelement,XML referred,

and the content path.

Table 198: Context Path and XML node referred for different element types

Context PathXML ReferredElement Type

/deviceN/ADevice

/device/chassis-inventory/*Chassis InventoryPhysical Inventory element

/device/interface-information/*Interface InformationPhysical Interface

/device/configuration/*ConfigurationLogical Interface

Table 199 on page 1278 lists some examples for XPaths for different elements.

Table 199: XPaths for different elements

DescriptionContextElement

The context of a
device

/deviceDevice

Context of a chassis/device/chassis-inventory/chassis[name='Chassis']Chassis

The context of a
routing engine

/device/chassis-inventory/chassis[name='Chassis']/chassis-module[name='Routing
Engine 0']

Routing
Engine

Thecontext of anFPC
in slot 1

/device/chassis-inventory/chassis[name='Chassis']/chassis-module[name='FPC 1']FPC
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Table 199: XPaths for different elements (continued)

DescriptionContextElement

The context of a PIC
in slot 4 under FPC in
slot 1

/device/chassis-inventory/chassis[name='Chassis']/chassis-module[name='FPC
1']/chassis-sub-module[name='PIC 4']

PIC

The context of logical
interface ge-0/0/1.0

device/configuration/interfaces/interface[name='ge-0/0/1]/unit[name='0']Logical
Interfaces

The context of a
physical interface
ge-0/1/1

/device/interface-information/physical-interface[name='ge-0/1/1]Physical
Interfaces

Context filtering

The context attribute of the script or configlet dictates which elements(inventory

component or logical interface or physical interface) it is applicable to.

The rule to checkwhether the script or configlet is applicable to an element is as follows:

• Evaluate the context XPath associated to a script or configlet on the device XML. This

results in a set of XML nodes.

• If the resultant XMLnode list contains theXMLnode representing the subject element,

then the script/template entity is considered amatch.

Given below are few examples of script or configlet contexts with their descriptions:

• /device/chassis-inventory/chassis[name='Chassis']/chassis-module[starts-with(name,'Routing

Engine')] - Applicable to all routing engines

• /device/chassis-inventory/chassis[name='Chassis']/chassis-module[starts-with(name,'FPC')]

- Applicable to all FPCs

• /device[starts-with(system-information/os-version,"11")]/interface-information/physical-interface[starts-with(name,"ge")]

- Applicable to all interfaces of type 'ge' which has system os-version as 11

• /device/interface-information/physical-interface[admin-status=”up”] - Applicable

to all physical interfaces with admin status in up state.

• /device/chassis-inventory/chassis[name='Chassis']/chassis-module[starts-with(name,'FPC')]/chassis-sub-module[starts-with(name,'PIC')]

|

/device/chassis-inventory/chassis[name='Chassis']/chassis-module[starts-with(name,'FPC')]/chassis-sub-module[starts-with(name,'MIC')]/chassis-sub-sub-module[starts-with(name,'PIC')]

- Applicable to all PICs

NOTE: If we intend to specify the scope of a script as PICs, then wewould
have to consider two different XPaths the PIC can take (One with MIC
in-between and one without). We have to give an OR combination of both
the XPaths.
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NOTE: If no context is associated to a script or configlet, then the context of
the script is taken as “/device”. These scripts or configlets would be listed
for execution in devices.

Physical Interface Example

Consider the following device XML

<device>
 <interface-information> 
  <physical-interface> 
   <name>ge-0/0/0</name> 
   <admin-status>up</admin-status> 
    ....
  </physical-interface>         
  <physical-interface> 
   <name>ge-0/0/1</name> 
   <admin-status>down</admin-status> 
    ....
  </physical-interface>         
  .....
 </interface-information>
 ....
 <!-- ALL THE OTHER NODES -->
 ....
</device>

Context of an element

Context of physical-interface ge-0/0/0 is

/device/interface-information/physical-interface[name='ge-0/0/0']

ThisXPathmaps to thenodebelow.This is theXMLcounterpart of the interfacege-0/0/0

<physical-interface> 
 <name>ge-0/0/0</name> 
 <admin-status>up</admin-status> 
  ....
</physical-interface>   

Physical Interface in “up” state:

If the user wants to write a configlet to set the admin status of an interface down if its

up, the context of the script can be set as

/device/interface-information/physical-interface[admin-status='up']

This configlet will be enabled only for interfaces with admin status up. Since in our

example, ge-0/0/0 satisfies the above condition, this configlet can be executed on it.

To view the contexts for writing CLI configlet scripts for different service types, refer

Table 138 on page 1040.
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Table 200: CLI Configlets Contexts for Different Service Types

ContextService Type

@CONTEXT = "/device/configuration/protocols/l2circuit/neighbor/interface"

Example :
/device[name="MX80-NGCE-1"]/configuration/protocols/l2circuit/neighbor[name="30.1.2.8"]/interface[name="ge-0/1/5.784"]

P2P

/*@CONTEXT = "/device/configuration/routing-instances/instance/interface" */

Example : /device[name="kochin"]/configuration/routing-instances/instance[name="SO62441630"
and instance-type="vrf"]/interface[name="ge-0/1/3.934"]

L3VPN

/*@CONTEXT = "/device/configuration/routing-instances/instance/interface" */

Example : /device[name="kochin"]/configuration/routing-instances/instance[name="SO62441630"
and instance-type="vpls"]/interface[name="ge-0/1/3.945"]

VPLS

/*@CONTEXT = "/device/configuration/protocols/connections/interface-switch/interface" */
Example:
/device[name="MX80-1"]/configuration/protocols/connections/interface-switch/interface[name="ge-1/0/0.1801"]

P2P or L3VPNwith L2E

/*@CONTEXT="/device/configuration/protocols/l2circuit/local-switching/interface/end-interface"
*/ Example
/device[name="MX80-1"]/configuration/protocols/l2circuit/local-switching/interface[name="ge-1/0/0.1801"]/end-interface[interface="ge-1/2/2.1881"]

P2P (Local switching)

/*@CONTEXT = "/device/configuration/protocols/bgp/group" */ Example
/device[name="MX80-1"]/configuration/protocols/bgp/group[type="external"]

NPS (Network peering)

Related
Documentation

CLI ConfigletsWorkflow on page 1274•

• Creating a CLI Configlet on page 1282

• Modifying a CLI Configlet on page 1285

• Deleting CLI Configlets on page 1286

• Viewing CLI Configlets on page 1286

• Creating a Parameter for a CLI Configlet on page 1289

• Applying a CLI Configlet to Devices on page 1291
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Creating a CLI Configlet

YoucreateaCLIConfiglet topushaconfiguration todevices. Youcanalsoaddparameters

to aCLI Configlet. Parameters are the variables defined in theCLI Configletwhose values

are either obtained from the environment or given by the user during execution.

Youmust create Configlets and the parameters for a CLI Configlet using the Configlets

workspaceof the JunosSpaceNetworkManagementPlatformGUI, before you canapply

the created Configlets to devices and deploy Configlets using the Connectivity Services

Director GUI.

To create a CLI Configlet:

1. Onthe JunosSpaceNetworkManagementPlatformuser interface, selectCLIConfiglets

> Configlets.

The Configlets page is displayed.

2. Click the Create CLI Configet icon on the toolbar.

The Create CLI Configlet page is displayed.

3. In the Name field, enter a name for the CLI Configlet.

The name cannot exceed 255 characters. Allowable characters include the hyphen

(-), underscore (_), letters, numbers, and the period (.). You cannot have two CLI

Configlets with the same name.

4. In the Category field, enter a name for the category of the CLI Configlet.

Thenameof thecategory cannot exceed255characters. Allowable characters include

the hyphen (-), underscore (_), letters, numbers, and the period (.).

5. From the Device Family Series drop-down list, select the device family for the CLI

Configlet.

6. (Optional) From the Context drop-down list, select the appropriate context for the

CLI Configlet.

7. In the Reference Number field, enter a reference number for the CLI Configlet.

The default value is 1. Themaximum value is 2
16
.

8. (Optional) In the Description field, enter a description.

The description cannot exceed 2500 characters.

9. For Execution Type, select the type of execution. The option buttons available are

Single Execution and Grouped Execution.
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By default, the Single Execution option button is selected.

• If you select Single Execution, you can apply the CLI Configlet only to one device at

a time.

• If you select Grouped Execution, you can apply the CLI Configlet tomultiple devices

at a time.

10. For Preview options , clear the check boxes if you do not want to view the parameters

and the configuration in the CLI Configlet after downloading it.

The check boxes available are ShowParameters and ShowConfiguration. By default,

both check boxes are selected.

11. For Postviewoptions, clear the check boxes if you do notwant to view the parameters

and the configuration in the CLI Configlet before creating it.

The check boxes available are ShowParameters and ShowConfiguration. By default,

both check boxes are selected.

12. In the Configlet Editor area, enter the configuration for the CLI Configlet. You can type

or manually paste the configuration in the Configlet Editor.

NOTE: You cannot create a CLI Configlet if you do not enter the
configuration in the Configlet Editor.

NOTE: You can also create a CLI Configlet to erase specific configuration
from the devices. To do so, include the delete: statement above the

hierarchy level that should be deleted from the devices. When you apply
the CLI Configlet to a device, the physical interface of a device, the logical
interface of a device, or the physical inventory element of a device, the
configuration in the hierarchy level is erased on the device.

For more information about the protocol and syntax used for creating,
modifying, and deleting the configuration by using CLI Configlets, see the
Junos XMLManagement Protocol Guide.

NOTE: When you define a configuration of the CLI Configlet, you should
specify variables that accept special characters as input within double
quotationmarks.

13. Click Next.

You can add the parameters for the CLI Configlet on this page.

14. To add a parameter to the CLI Configlet:
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a. Click the Add Parameter icon.

The Add Configlet Parameter pop-up window is displayed.

b. In the Parameter field, enter the name of the parameter.

The name of the parameter cannot exceed 255 characters. Allowable characters

include the hyphen (-), underscore (_), letters, numbers, and the period (.).

c. In the Display Name field, enter a display name for the parameter.

The display name cannot exceed 255 characters. Allowable characters include

the hyphen (-), underscore (_), letters, numbers, and the period (.).

d. In the Description field, enter a description for the parameter.

e. From the Parameter Scope drop-down list, select an appropriate scope for the

parameter.

The options available are Global, Device Specific, and Entity Specific.

f. From the Parameter Type drop-down list, select an appropriate type of parameter.

The options available are:

• Text Field – You can enter any value.

• Selection Field – You can select a value from a set of options.

• Invisible Field – The field displays a value that is explicitly defined by the user or

an XPath.

• Password Field – Enter a password to apply the CLI Configlet.

• Password Confirm Field – Enter the password again to confirm the password.

g. From the Regex Value drop-down list, select an appropriate regular expression

value.

This field is enabled if you choose the type of parameter as Text Field, Password

Field, or Confirm Password Field.

h. From the Configured Value Xpath drop-down list, select an appropriate XPath

value.

This field is enabled if you choose the type of parameter as Text Field, Selection

Field, or Invisible Field. This is theXPath (with reference to the deviceXML) to fetch

the set of values.

i. In the Default Value field, enter a default value.

This field is enabled if you choose the type of parameter as Text Field, Selection

Field, or Invisible Field. This field is considered onlywhen theXPath is not specified.

j. FromtheSelectionValuesXpathdrop-down list, select anappropriateXPathvalue.

This field is enabled if you choose the type of parameter as Selection Field. This is

the XPath (with reference to the device XML) to fetch the set of values.

k. In the Selection Values field, enter an appropriate selection value.

This field is enabled if you choose the type of parameter as Selection Field.
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l. In theOrder field, enter the order in which the parameters should be listed while

applying the CLI Configlet.

m. Click Add.

15. (Optional) Addmultiple parameters.

16. (Optional) To go back to the previous page, click Back.

You are redirected to the previous page.

17. Click Create.

The CLI Configlet is created. You are redirected to the Configlets page.

Related
Documentation

CLI Configlets Overview on page 1271•

• CLI ConfigletsWorkflow on page 1274

• Modifying a CLI Configlet on page 1285

• Deleting CLI Configlets on page 1286

• Viewing CLI Configlets on page 1286

Modifying a CLI Configlet

Youmodify a CLI configlet when you want to change the properties of the CLI configlet.

To modify a CLI configlet:

1. Onthe JunosSpaceNetworkManagementPlatformuser interface, selectCLIConfiglets

> Configlets.

The Configlets page is displayed.

2. Select the CLI configlet you want to modify and click theModify button.

The Modify CLI configlet page is displayed.

3. Modify the CLI configlet properties and click Update.

The CLI configlet is modified.

Related
Documentation

CLI Configlets Overview•

• Creating a CLI Configlet

• Exporting CLI Configlets

• Importing CLI Configlets
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Deleting CLI Configlets

You delete CLI configlets when you no longer want to use them to apply configuration

to devices.

Youmust create Configlets and the parameters for a CLI Configlet using the Configlets

workspaceof the JunosSpaceNetworkManagementPlatformGUI, before you canapply

the created Configlets to devices and deploy Configlets using the Connectivity Services

Director GUI.

To delete CLI configlets:

1. Onthe JunosSpaceNetworkManagementPlatformuser interface, selectCLIConfiglets

> Configlets.

The Configlets page is displayed.

2. Select the CLI configlets you want to delete and select the Delete CLI Configlets icon

from the Actions menu.

The Delete CLI Configlet pop-up window is displayed.

3. Click Confirm.

The CLI configlets are deleted.

Related
Documentation

CLI Configlets Overview on page 1271•

• CLI ConfigletsWorkflow on page 1274

• Creating a CLI Configlet on page 1282

• Modifying a CLI Configlet on page 1285

• Viewing CLI Configlets on page 1286

Viewing CLI Configlets

YoucreateaCLIConfiglet topushaconfiguration todevices. Youcanalsoaddparameters

to aCLI Configlet. Parameters are the variables defined in theCLI Configletwhose values

are either obtained from the environment or given by the user during execution.

To view CLI Configlets:

1. From the View selector, select Device View. The workspaces that you can configure

in this view are displayed.

2. Click the Build icon in the Connectivity Services Director banner. The functionalities

that you can configure in this mode are displayed.
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3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and view the list of devices.

4. Select the device for which you want to apply CLI configlets. A graphical view of the

device is displayed on the right pane.

5. From the tasks pane, select Configuration Deployment > View Applied Configlets.

The Manage CLI-Applied Configlets page is displayed.

6. Select the device for which you want to view the applied CLI configlets. A graphical

view of the device is displayed on the right pane.

The following fields are displayed on this page:

Table 201: Columns on theManage CLI-Applied Configlets Page

DescriptionField

Name of the configuration viewName

Domain to which the configuration view is associatedDomain Name

The Category of the configlet. The Category cannot exceed 255 characters. Allowable
characters include the dash (-), underscore (_), letters, and numbers and the period (.).

Category

Description of the configlet. The description cannot exceed 2500 characters. This is an
optional field.

Description

Name of the interface or the device to which the Configlet is being deployed.Applied To

Version of the Configlet template used to create the Configlet.Version

State of the Configlet such as an invalid Configlet or a validated Configlet.Validation State

Status of deployment of the Configlet.Deployed State

Date and time when the Configlet was deployed.Deployed Time

Click this button to deploy and propagate the selected Configlet immediately to the
device.

Deploy Now

Click this button to schedule the deploy of the selected Configlet for a later time.Schedule Deploy

Click this button to delete the selected Configlet.Discard Deploy

Date and time when the Configlet was created.Creation Time

Latest time when the Configlet was last updated.Last Updated Time
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Related
Documentation

CLI ConfigletsWorkflow on page 1274•

• Configlet Context on page 1277

• Creating a CLI Configlet on page 1282

• Modifying a CLI Configlet on page 1285

• Deleting CLI Configlets on page 1286

• Creating a Parameter for a CLI Configlet on page 1289

• Applying a CLI Configlet to Devices on page 1291
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Creating a Parameter for a CLI Configlet

From the Manage Configlets page, you can also add parameters to a CLI Configlet.

Parametersare thevariablesdefined in theCLIConfigletwhosevaluesareeither obtained

from the environment or given by the user during execution. The following fields are

displayed on this page:

Table 202: Attributes of a parameter

Name of the parameter.Parameter

Display name of the parameter.Display Name

This field is used to give the XPath of the configured values. The behavior of this field
depends on the type of view. When the view type is form, the corresponding value
present in the XPath is taken as the field value. In case XPath returns multiple values,
first value returned is considered. In case the XPath returns multiple values, the first
value returned is considered. When the view type is grid, the following behavior is
followed. If more than one parameters defined then following rules should bemet.

Configured Value XPATH

• For independent index parameters, a join would be performed between the values
returned by the XPath and the existing set of rows.

• For dependent index parameters, join would be performed between the values
returned by the XPath and the correspondent row.

Fornon indexparameters, if list of values returned then theyareaggregated intocomma
separated values.

Description of the parameter.Description

Scope of the parameter, such as device/entity specific or global.Scope

Default valueof theparameter. Thebehavior is sameas that ofConfigured valueXPath
except that the value is given explicitly. This field is considered only when Configured
Value XPATH is not specified or if the XPath doesn't return any value.

Default Value

FromtheManageConfigletspage, if youclick theAddParameterbutton, youarenavigated

to theManageArgumentspage.TheManageArgumentspaneldisplaysa listofarguments

for the adding script and a form tomanage the properties for them.When you select an

argument from the grid, the lower part of the page displays the properties applicable to

the selected argument.

To add a parameter to the CLI Configlet:

1. From the Manage Configlets page, click the Add Parameter button.

The Add Configlet Parameter pop-up window is displayed.

2. In the Parameter field, enter the name of the parameter.

The name of the parameter cannot exceed 255 characters. Allowable characters

include the hyphen (-), underscore (_), letters, numbers, and the period (.).

3. In the Display Name field, enter a display name for the parameter.
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The display name cannot exceed 255 characters. Allowable characters include the

hyphen (-), underscore (_), letters, numbers, and the period (.).

4. In the Description field, enter a description for the parameter.

5. From the Parameter Scope drop-down list, select an appropriate scope for the

parameter.

The options available are Global, Device Specific, and Entity Specific.

6. From the Parameter Type drop-down list, select an appropriate type of parameter.

The options available are:

• Text Field – You can enter any value.

• Selection Field – You can select a value from a set of options.

• Invisible Field – The field displays a value that is explicitly defined by the user or an

XPath.

• Password Field – Enter a password to apply the CLI Configlet.

• Password Confirm Field – Enter the password again to confirm the password.

7. From the Regex Value drop-down list, select an appropriate regular expression value.

This field is enabled if you choose the type of parameter as Text Field, Password Field,

or Confirm Password Field.

8. From the Configured Value Xpath drop-down list, select an appropriate XPath value.

This field is enabled if you choose the type of parameter as Text Field, Selection Field,

or Invisible Field. This is the XPath (with reference to the device XML) to fetch the set

of values.

9. In the Default Value field, enter a default value.

This field is enabled if you choose the type of parameter as Text Field, Selection Field,

or Invisible Field. This field is considered only when the XPath is not specified.

10. From the Selection Values Xpath drop-down list, select an appropriate XPath value.

This field is enabled if you choose the type of parameter as Selection Field. This is the

XPath (with reference to the device XML) to fetch the set of values.

11. In the Selection Values field, enter an appropriate selection value.

This field is enabled if you choose the type of parameter as Selection Field.

12. In theOrder field, enter the order in which the parameters should be listed while

applying the CLI Configlet.

13. Click Add.

14. (Optional) Addmultiple parameters.

15. (Optional) To discard the changes and go back to the previous page, click Cancel.

You are redirected to the previous page.

16. Click Save.
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The CLI Configlet is created. You are redirected to the Configlets page.

Related
Documentation

CLI ConfigletsWorkflow on page 1274•

• Configlet Context on page 1277

• Modifying a CLI Configlet on page 1285

• Deleting CLI Configlets on page 1286

• Viewing CLI Configlets on page 1286

• Creating a Parameter for a CLI Configlet on page 1289

• Applying a CLI Configlet to Devices on page 1291

Applying a CLI Configlet to Devices

You apply a CLI Configlet to devices when youwant to push a configuration from the CLI

Configlet to the devices.

NOTE:

At the time of creating the CLI Configlet:

• If you selected the Single execution type, the CLI Configlet can be applied
to only one device.

• If youselected theGroupedexecution type, theCLIConfiglet canbeapplied
tomultiple devices simultaneously.

To apply a CLI Configlet to a device:

1. From the View selector, select Chassis View. The workspaces that you can configure

in this view are displayed.

2. Click the Build icon in the Connectivity Services Director banner. The functionalities

that you can configure in this mode are displayed.

3. From the Chassis View pane, click the plus sign (+) next to the My Network tree to

expand the tree and view the list of devices.

4. Select the device for which you want to apply CLI configlets. A graphical view of the

device is displayed on the right pane.

5. You can right-click each selectable component such as chassis or physical interfaces

in the chassis view. The shortcut menu that is displayed indicates the name of the

selected component, state of the component, context path of the component, and

theManage Configlets option. SelectManageConfiglets from the shortcutmenu. The
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Select Configlets window is displayed, listing all of the available configlet templates

that are applicable to the selected component.

6. To select a configlet to be applied to a device, do one of the following:

• Double-click the chassis component, such as physical or logical interfaces, in the

chassis view. The selected area is used as the context to list the templates in the

Configlet selection window.

• Click theApplyConfiglet iconanduse the links shownon thecomponents in chassis

view to select the context and apply configlets.

7. The Apply Configlet menu is displayed, depending on the component or context

selected:

If you selected the chassis, the device configuration context is applicable. Click the

Edit (pencil) icon beside the Zoommenu in the chassis image view. You can select

the Configlets that can be applied to the device and the device context is listed for

configuration.

If you selected a physical interface, select Apply Configlets from the Actions menu

on the rightmost pane that displays component details. You can select the configlets

from the list for the selected physical interface on the device.

If youselectedapseudo-interfaceanda logical Interface, click thepencil icondisplayed

in the the pseudo and logical interfaces grid. When you click the icon, the chassis

elementon the respective row is usedas the context element and the list ofConfiglets

that can be applied are displayed.

8. Select the CLI Configlet that you want to apply to the devices and select Apply CLI

Configlet from the Actions menu.

The Apply CLI Configlet page is displayed.

WhenyouselectaConfigletTemplate fromtheSelectConfiglets table, theparameters

panel is updatedwith the applicable parameters for the selected Configlet Template.

The field components are based on the Parameter Type.

9. Select the devices on which you want to apply the CLI Configlet and select Apply CLI

Configlet from the Actions menu.

The Apply CLI Configlet page displays the parameters. Only text field and selection

field type parameters are displayed.

To view the description of the parameter, mouse over the entry in the Parameter

column.

NOTE: You cannot select more than 25 devices. If the device selection
using the search criteria or tags lists more than 25 devices,

10. Double-click the Value column for each parameter and enter a value.
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All values are accepted for the text field type parameter. For a selection field type

parameter, you should select from one of the values you provided for the parameter.

The set of values present and the default value selected were defined when the

template was created.

11. Click Next.

The parameter value is validated against the regular expression (if given). If the

parameter value violates the regular expression, then a validation error is displayed.

The Preview area of the Apply CLI Configlet page displays the preview of the CLI

Configlet. If youselected toviewtheparametersand theconfigurationwhenpreviewing

the CLI Configlet, the parameters and the configuration are displayed.

NOTE: Contents of the Preview area depend on the preview options in
the CLI Configlet.

12. (Optional) Click Validate to validate the configuration.

The Validate Results page is displayed.

A job is triggered. The Progress column displays the progress against each device.

When thevalidation is complete, the resultsof thevalidationaredisplayed.TheStatus

column indicates the results of the validation.

NOTE: Youcanalso view the validation results from the JobManagement
page. To view the validation results, double-click the job ID and click the
View Results link corresponding to the device.

13. Click Close.

You are redirected to the Apply CLI Configlet page.

14. Select whether to apply the CLI Configlet now or later.

• To apply the CLI Configlet now:

• Click Apply.

The Configlets Results page is displayed. This page shows the job results.

• Click Close to return to the Conflglets page.

• To apply the CLI Configlet later:

a. Click Back.

You are redirected to the previous page.

b. Select Schedule at a later time.
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c. Enter the date in the Date field in the DD/MM/YYYY format.

d. Enter the time in the Time field in the hh:mm format.

e. Click Apply.

The Job Information dialog box is displayed.

f. ClickOK.

Click Cancel to return to the Device Management CLI Configlets page.

Related
Documentation

CLI ConfigletsWorkflow on page 1274•

• Configlet Context on page 1277

• Creating a CLI Configlet on page 1282

• Modifying a CLI Configlet on page 1285

• Deleting CLI Configlets on page 1286

• Viewing CLI Configlets on page 1286

• Creating a Parameter for a CLI Configlet on page 1289

Deploying CLI Configlet Details

You apply a CLI Configlet to deviceswhen youwant to push the configuration to devices.

TheCLIConfiglet canbedeployed toonlyonedevice, or theCLIConfiglet canbedeployed

to multiple devices simultaneously. The saved configlets that are being propagated to

devices can be viewed by selecting the Deployment option in the task pane. You can

select a particular Configlet and view the parameters contained in it in the form of

configuration stanzas and hierarchy levels. Each level in the hierarchy is indented to

indicate each statement's relative position in the hierarchy. Each level is generally set

off with braces, with an open brace ({) at the beginning of each hierarchy level and a

closing brace (}) at the end.

To select whether to apply the CLI Configlet now or later:

1. From the View selector, select Device View. The workspaces that you can configure

in this view are displayed.

2. Click the Deploy icon in the Connectivity Services Director banner. The functionalities

that you can configure in this mode are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and view the list of devices.

4. Select the device for which you want to view the applied CLI configlets. A graphical

view of the device is displayed on the right pane.
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5. From the tasks pane, select Configuration Deployment > View Applied Configlets.

The Manage CLI-Applied Configlets page is displayed.

6. Select a Configlet from the table of displayed Configlets that you want to deploy.

7. To apply the CLI Configlet now:•

• Click Deploy Now.

Use theCSDDeployment Jobs page inDeploymodeof ServiceView (by selecting

Service Provisioning > View Deployment Jobs) to view the status of the

deployment job created to provision the configlet to the device.

• Click Close to return to the Conflglets page.

• To apply the CLI Configlet later:

a. Select Schedule Deploy.

b. Enter the date in the Date field in the DD/MM/YYYY format.

c. Enter the time in the Time field in the hh:mm format.

d. Click Apply.

e. Use theCSDDeployment Jobspage inDeploymodeofServiceView(by selecting

Service Provisioning > View Deployment Jobs) to view the status of the

deployment job created to provision the configlet to the device.

To view a deployed CLI Configlet details:

1. From the View selector, select Device View. The workspaces that you can configure

in this view are displayed.

2. Click the Deploy icon in the Connectivity Services Director banner. The functionalities

that you can configure in this mode are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and view the list of devices.

4. From the tasks pane, select Configuration Deployment > View Applied Configlets.

The Manage CLI-Applied Configlets page is displayed.

5. Select the device for which you want to view the applied CLI configlets. A graphical

view of the device is displayed on the right pane.

The following fields are displayed on this page:
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Table 203: Columns on theManage CLI-Applied Configlets Page

DescriptionField

Name of the configuration viewName

Domain to which the configuration view is associatedDomain Name

The Category of the configlet. The Category cannot exceed 255 characters. Allowable
characters include the dash (-), underscore (_), letters, and numbers and the period (.).

Category

Description of the configlet. The description cannot exceed 2500 characters. This is an
optional field.

Description

Name of the interface or the device to which the Configlet is being deployed.Applied To

Version of the Configlet template used to create the Configlet.Version

State of the Configlet such as an invalid Configlet or a validated Configlet.Validation State

Status of deployment of the Configlet.Deployed State

Date and time when the Configlet was deployed.Deployed Time

Click this button to deploy and propagate the selected Configlet immediately to the
device.

Deploy Now

Click this button to schedule the deploy of the selected Configlet for a later time.Schedule Deploy

Click this button to delete the selected Configlet.Discard Deploy

Date and time when the Configlet was created.Creation Time

Latest time when the Configlet was last updated.Last Updated Time

6. Select a Configlet from the table of displayed Configlets for which you want to view

the configuration details. A dialog box is displayed with the configuration attributes

and parameters defined for the Configlet being deployed.

7. Click Close after you finish viewing the Configlet information. You are returned to the

page listing all of the deployed Configlets.

Related
Documentation

• CLI ConfigletsWorkflow on page 1274

• Configlet Context on page 1277

• Creating a CLI Configlet on page 1282

• Modifying a CLI Configlet on page 1285

• Deleting CLI Configlets on page 1286
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• Creating a Parameter for a CLI Configlet on page 1289

• Applying a CLI Configlet to Devices on page 1291
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PART 17

ManagingOptical Interfaces,OTUs,ODUs,
ILAs, and IPLCs on MX Series and PTX
Series Routers

• Overview of Optical Interfaces, OTUs, and ODUs on page 1301

• Overview of Optical ILAs and IPLCs on page 1369

• Configuring and Monitoring Optical Interfaces, OTUs, and ODUs on page 1411

• Configuring and Monitoring Optical Inline Amplifiers on page 1485

• Configuring and Monitoring Optical Integrated Photonic Line Cards on page 1509
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CHAPTER 52

OverviewofOptical Interfaces,OTUs, and
ODUs

• Optical Interfaces Management and Monitoring on MX Series and PTX Series Routers

Overview on page 1302

• Ethernet DWDM InterfaceWavelength Overview on page 1304

• Attenuation and Dispersion in a Fiber-Optic Cable on PTX Series Routers

Overview on page 1304

• Understanding Pre-FEC BERMonitoring and BER Thresholds on page 1305

• DWDMControllers Overview on page 1308

• PTX5000 PIC Description on page 1309

• PTX3000 PIC Description on page 1310

• 100-Gigabit Ethernet OTN Optical Interface Specifications on page 1313

• 100-Gigabit DWDMOTN PIC Optical Interface Specifications on page 1314

• 100-Gigabit DWDMOTN PIC (PTX Series) on page 1318

• 100-Gigabit Ethernet OTN PIC with CFP2 (PTX Series) on page 1326

• 100-Gigabit Ethernet PIC with CFP2 (PTX Series) on page 1329

• 100-Gigabit Ethernet PIC with CFP (PTX Series) on page 1332

• 100GbE PICs for PTX Series Routers on page 1337

• P2-10G-40G-QSFPP PIC Overview on page 1338

• Understanding the P2-100GE-OTN PIC on page 1343

• 100-Gigabit DWDMOTN PIC with CFP2 (PTX Series) on page 1347

• 100-Gigabit DWDMOTNMIC with CFP2 on page 1356

• 100-Gigabit Ethernet OTN Options Configuration Overview on page 1364

• Configuring the 10-Gigabit or 100-Gigabit Ethernet DWDM Interface

Wavelength on page 1366
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Optical InterfacesManagement andMonitoring onMXSeries and PTX Series Routers
Overview

Packetoptical networking is useful in anynetworkwithaconvergedsupercore that needs

to transport traffic in as efficient and effective a manner as possible. Packet optical

devices, such as Juniper Networks MX Series routers and PTX Series Packet Transport

Routersproperly equippedwith suitable line cards, are capableof placingpacketsdirectly

onto optical transports and receiving packets the sameway. In a packet optical network,

the packets leave the router in an optical transport envelope at the correct wavelength

and arrive the same way, bypassing much of the other external networking equipment

needed to groom or otherwise process electrical or optical signals originating on the

router.

Connectivity Services Director is the network management application implemented on

the JunosSpaceNetworkManagementapplicationandenables serviceprovidersachieve

faster IP service rollouts for business needs and reduce overall OpEx for managing the

service life cycle. Aunifiednetworkdevicemanagement interface is essential to efficiently

deploy a large number of devices that contain optic PICs. Considering that these devices

are hosted in remote locations, it is essential to ensure that the device management

interface (DMI) provides the right level of automation to reduce the time required to set

up and configure eachdevicewithout requiring additionalmanual intervention at the site

after deployment. Centralized configuration management, rapid deployment, polling,

statistics capture, and reporting are some of the essential components of a robust DMI.

Connectivity Services Director enables you to manage the packet optical functionality

provided by 100-Gigabit Ethernet Optical Transport Network (OTN) and dense

wavelength-division multiplexing (DWDM) PICs that can be installed on PTX Series

devices. In addition, you canmanage the packet optical functionality provided by the

100-Gigabit Ethernet and DWDMMICs that can be installed on MX Series routers.

Connectivity Services Director presents a topological network view and a site view. The

topological network view offers a pictorial representation of optical sites, links, and

services. The site view provides information about the status, configuration, alarms or

faults, and the performance of the optical interfaces. FCAPS (fault, configuration,

accounting, performance, and security) is an explicit model that is used to achieve the

operational objectives of networkmanagement. Connectivity Services Director offers an

effective management system for a complete FCAPS functionality.

An important aspect of any networkmanagement system is tomonitor, control, andplan

the network infrastructure that comprises a large number of devices and extensive

configuration parameters in a streamlined, easy, and cohesive way. The bulk, single-step

propagation of settings on large sets of deviceswithout impacting theworking efficiency

and traffic-handling capacity of the network is a salient objective.

You can configure, manage, andmonitor the following components on PTX3000 and

PTX5000 routers:

• 100-Gigabit DWDMOTN PIC (P1-PTX-2-100G-WDM)

• 100-Gigabit Ethernet OTN PIC with CFP (P1-PTX-2-100GE-CFP)
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• 100-Gigabit Ethernet OTN PIC with CFP2 (P2-100GE-OTN)

• 100-Gigabit DWDMOTN PIC with CFP2 (PTX-5-100G-WDM)

• P2-100GE-CFP2 (4x100G CFP2 PIC)

• P1-PTX-24-10GE-SFPP (24x10G LAN PIC)

• P1-PTX-24-10G-W-SFPP (24x10G LAN/WAN PIC)

• P1-PTX-2-100G-C-WDM-C (2x100G LH DWDMPIC)

• P1-PTX-2-40GE-CFP (2x40-Gigabit Ethernet PIC with CFP)

• P1-PTX-2-100GE-CFP (2x100-Gigabit Ethernet PIC with CFP)

• P1-PTX-2-100G-WDM—Designed for metro, regional, or long-haul applications.

• 4-port 100-Gigabit Ethernet PIC (PTX5000)

The PIC supports 100GBASE-LR4 and 100GBASE-SR10 transceivers. The

CFP2-100G-SR10-D transceiver is not dual-rate, it supports Ethernet only. The

CFP2-100G-SR10-D2 transceiver is dual-rate, butonlywhenused inaPIC that supports

OTN, such as P2-100GE-OTN.

• P2-10G-40G-QSFPP PIC on the FPC2-PTX-P1A FPC (PTX5000)

Youcanconfigure theP2-10G-40G-QSFPPPIC tooperateeither in 10-Gigabit Ethernet

mode or in 40-Gigabit Ethernet mode.

The Chassis View provides a pictorial representation of the chassis or device, and the

modules or components that are installed in it, such as the line cards, interfaces, and

other hardware elements. To view a pictorial representation of a device chassis and the

configured components, such as interfaces, line cards, and hardware elements, select a

managed device listed on the My Network tree in Device View of Connectivity Services

Director, and select DeviceManagement > View Physical Inventory from the tasks pane.

The right pane displays the device image and the corresponding description of the view

selected in a table. The Chassis View is displayed. The hardware and linemodule details

are displayed with a pictorial view of the slots of the devices and themodules installed

in these slots. Use the arrow buttons on the page to rotate the device image to view all

planes of the device and the components installed on each plane.

Click the right and left arrow buttons to view the right and left planes of the device. To

view the front and the back planes of the devices, click the double-left and double-right

arrows respectively. You can rotate the device image in different orientations along 360

degrees. The front view displays the components installed and the interfaces configured

on the device. Click Refresh to update the contents of the page. Mouse over the device

image to seebrief information of components and interfaces in tooltips. Click aparticular

componentor interface todisplaydetailed informationabout thecomponentor interface

in the lower portion of the page.

Related
Documentation

Viewing a Graphical Image of the Optical Interface Components on page 1411•
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Ethernet DWDM InterfaceWavelength Overview

Densewavelength-divisionmultiplexing (DWDM) interfacesare supportedon 10-Gigabit

Ethernet DWDMPICs, MICs, andMPCs; the 10-Gigabit Ethernet LAN/WANOTNPIC; and

the 100-Gigabit Ethernet DWDMOTNPIC.When a tunable optic transceiver is available,

youcanconfigure theDWDMinterfaceswith fullC-band InternationalTelecommunication

Union (ITU)-Grid tunable optics, as defined in the following specifications:

• Intel TXN13600 Optical Transceiver I2C Interface and Customer EEPROM Preliminary

Specification, July 2004.

• I2C Reference Document for 300-Pin MSA 10G and 40G Transponder, Edition 4, August

04, 2003.

By default, the wavelength is 1550.12 nanometers (nm), which corresponds to 193.40

terahertz (THz).

Related
Documentation

Attenuation and Dispersion in a Fiber-Optic Cable on PTX Series Routers Overview on

page 1304

•

• Understanding Pre-FEC BERMonitoring and BER Thresholds on page 1305

• DWDMControllers Overview on page 1308

Attenuation and Dispersion in a Fiber-Optic Cable on PTX Series Routers Overview

Correct functioning of an optical data link depends onmodulated light reaching the

receiver with enough power to be demodulated correctly. Attenuation is the reduction in

the power of the light signal as it is transmitted. Attenuation is caused by passive media

components, such as cables, cable splices, and connectors. While attenuation is

significantly lower for optical fiber than for other media, it still occurs in bothmultimode

and single-mode transmission. An efficient optical data link must have enough light

available to overcome attenuation.

Dispersion is the spreading of the signal in time. The following two types of dispersion

can affect an optical data link:

• Chromatic dispersion—Spreading of the signal in time resulting from the different

speeds of light rays

• Modal dispersion—Spreading of the signal in time resulting from the different

propagation modes in the fiber

For multimode transmission, modal dispersion, rather than chromatic dispersion or

attenuation, usually limits the maximum bit rate and link length. For single-mode

transmission,modaldispersion is nota factor.However, at higherbit ratesandover longer

distances, chromaticdispersion rather thanmodaldispersion limitsmaximumlink length.

An efficient optical data linkmust have enough light to exceed theminimum power that

the receiver requires to operate within its specifications. In addition, the total dispersion

must be less than the limits specified for the type of link in Telcordia Technologies
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document GR-253-CORE (Section 4.3) and International Telecommunications Union

(ITU) document G.957.

When chromatic dispersion is at the maximum allowed, its effect can be considered as

a power penalty in the power budget. The optical power budget must allow for the sum

of component attenuation, power penalties (including those from dispersion), and a

safety margin for unexpected losses.

Related
Documentation

Ethernet DWDM InterfaceWavelength Overview on page 1304•

• Understanding Pre-FEC BERMonitoring and BER Thresholds on page 1305

• DWDMControllers Overview on page 1308

Understanding Pre-FEC BERMonitoring and BER Thresholds

Optical transport network (OTN) interfaces on PTX Series Packet Transport Routers

supportmonitoring the condition of anOTN link by using the pre-forward error correction

(pre-FEC) bit error rate (BER). The following PICs support pre-FEC BERmonitoring:

• P1-PTX-2-100G-WDM

• P2-100GE-OTN

• PTX-5-100G-WDM

• P1-PTX-24-10G-W-SFPP

With pre-FECBERmonitoring enabled,when the configuredpre-FECBER signal degrade

threshold is reached, the PIC stops forwarding packets to the remote interface and raises

an interface alarm. Ingress packets continue to be processed. If pre-FEC BERmonitoring

is used with MPLS fast reroute or another link protectionmethod, then traffic is rerouted

to a different interface.

You can also configure backward fast reroute to insert the local pre-FEC status into

transmittedOTNframes, notifying the remote interfaceof signal degradation. The remote

interface can use the information to reroute traffic to a different interface. If you use

pre-FEC BERmonitoring together with backward fast reroute, then notification of signal

degradation and rerouting of traffic occurs in less time than that required through a

Layer 3 protocol.

Include the signal-degrade-monitor-enable and backward-frr-enable statements at the

[edit interfaces interface-name otn-options preemptive-fast-reroute] hierarchy level to

enable pre-FEC BERmonitoring and backward fast reroute.

NOTE: When you configure pre-FEC BER signal degrademonitoring, we
recommend that you configure both the signal-degrade-monitor-enable and

the backward-frr-enable statements.
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You can also configure the pre-FEC BER thresholds that raise or clear a signal degrade

alarm and the time interval for the thresholds. If the BER thresholds and interval are not

configured, the default values are used.

The pre-FEC BER signal degrade threshold value defines a specific amount of system

margin relative to the BER correction limit (or FEC limit) of the PIC’s receive FEC decoder.

The FEC limit is fixed on each PIC—it is intrinsic to the FEC decoder implementation.

NOTE: The following examples use Q2–factor measurements (also known

asQ–factor).Q2–factor isexpressed inunitsofdecibels relative toaQ2–factor

of zero (dBQ). Q2–factor enables you to describe systemmargin in linear

terms in contrast to BER values, which are nonlinear in nature. After you
determine the thresholds, youmust convert the threshold values from
Q2–factor to BER to enter them in the CLI by using scientific notation. BER

can be converted to Q2–factor by using the following equation:

Q2–factor = 20 * log10 (sqrt(2) * erfcinv(2 * BER))

TIP: To convert between Q2–factor and BER in a spreadsheet program, you

can approximate the values by using the following formulas:

• To calculate Q2–factor:

= 20 * LOG10(–NORMSINV(BER))

• To calculate BER:

= 1 – NORMSDIST(10^(0.05 *Q2–factor))

Table204onpage1306showstherelationshipbetweenthefixedFEClimit, theconfigurable

signal degrade threshold, and the configurable clear threshold for different PICs. In this

example, approximately 1 dBQ of systemmargin has been set between the FEC limit,

signal degrade threshold, and clear threshold.

Table 204: Example—Signal Degrade and Clear Threshold Values at 1 dBQ

Clear Threshold
Signal Degrade
ThresholdFEC Limit

FEC TypePIC
BERQ2–FactorBERQ2–FactorBERQ2–Factor

3.0E–38.7 dBQ7.5E–37.7 dBQ1.5E–26.7 dBQSD-FECP1-PTX-2-100G-WDM

1.0E–613.5 dBQ1.1E–512.5 dBQ8.0E–511.5 dBQG.709 GFECP2-100GE-OTN
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Table 204: Example—Signal Degrade and Clear Threshold Values at 1 dBQ (continued)

Clear Threshold
Signal Degrade
ThresholdFEC Limit

FEC TypePIC
BERQ2–FactorBERQ2–FactorBERQ2–Factor

1.6E–411.1 dBQ6.9E–410.1 dBQ2.2E–39.1 dBQG.975.1 I.4
(UFEC)

P1-PTX-24-10G-W-SFPP

7.5E–511.6 dBQ3.6E–410.6 dBQ1.3E–39.6 dBQG.975.1 I.7
(EFEC)

1.0E–613.5 dBQ1.1E–512.5 dBQ8.0E–511.5 dBQG.709 GFEC

To adjust the signal degrade threshold, youmust first decide on a new systemmargin

target and then calculate the respective BER value (using the equation to convert from

Q
2
–factor to BER). Table 205 on page 1307 shows the values if 3 dBQ of systemmargin

relative to the FEC limit is desired for the signal degrade threshold (while maintaining

the clear threshold at 1 dBQ relative to the signal degrade threshold).

NOTE: The choice of systemmargin is subjective, as youmight want to
optimize your thresholds based on different link characteristics and fault
tolerance and stability objectives. For guidance about configuring pre-FEC
BERmonitoring and BER thresholds, contact your Juniper Networks
representative.

Table 205: Example—Signal Degrade and Clear Thresholds After Configuration

Clear Threshold
Signal Degrade
ThresholdFEC Limit

FEC TypePIC
BERQ2–FactorBERQ2–FactorBERQ2–Factor

2.9E–410.7 dBQ1.1E–39.7 dBQ1.5E–26.7 dBQSD-FECP1-PTX-2-100G-WDM

1.1E–915.5 dBQ4.9E–814.5 dBQ8.0E–511.5 dBQG.709 GFECP2-100GE-OTN

3.1E–613.1 dBQ2.8E–512.1 dBQ2.2E–39.1 dBQG.975.1 I.4
(UFEC)

P1-PTX-24-10G-W-SFPP

9.1E–713.6 dBQ1.1E–512.6 dBQ1.3E–39.6 dBQG.975.1 I.7
(EFEC)

1.1E–915.5 dBQ4.8E–814.5 dBQ8.0E–511.5 dBQG.709 GFEC

Include the ber-threshold-signal-degrade, ber-threshold-clear, and interval statements

at the [edit interfaces interface-name otn-options signal-degrade] hierarchy level to

configure the BER thresholds and time interval.
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NOTE: Configuring a high BER threshold for signal degradation and a long
interval might cause the internal counter register to be saturated. Such a
configuration is ignoredby the router, and thedefault valuesareused instead.
A system logmessage is logged for this error.

Related
Documentation

Ethernet DWDM InterfaceWavelength Overview on page 1304•

• Attenuation and Dispersion in a Fiber-Optic Cable on PTX Series Routers Overview on

page 1304

• DWDMControllers Overview on page 1308

DWDMControllers Overview

Densewavelengthdivisionmultiplexing (DWDM)modulesupport isbasedon theOptical

Transport Network (OTN) protocol that is specified in ITU-T G.709. This standard

combines the benefits of SONET/SDH technology with the multiwavelength networks

of DWDM. It also enables forward error correction (FEC) that can allow a reduction in

network costs by reducing the number of regenerators used. To enable multiservice

transport,OTNuses theconceptof awrappedoverhead (OH).Tounderstand this format,

the following elements are involved:

• Optical channelpayloadunit (OPU)OH information isaddedto the informationpayload

to form theOPU. TheOPUOH includes information to support the adaptation of client

signals.

• Optical channel data unit (ODU)OH is added to the OPU to create the ODU. TheODU

OH includes information formaintenance andoperational functions to support optical

channels.

• Optical channel transport unit (OTU) OH together with the FEC is added to form the

OTU. The OTUOH includes information for operational functions to support the

transport by way of one or more optical channel connections.

• Optical channel (OCh) OH is added to form the OCh. The OCh provides the OTN

management functionality andcontains four subparts: theOPU,ODU,OTU, and frame

alignment signal (FAS).

Related
Documentation

Ethernet DWDM InterfaceWavelength Overview on page 1304•

• Attenuation and Dispersion in a Fiber-Optic Cable on PTX Series Routers Overview on

page 1304

• Understanding Pre-FEC BERMonitoring and BER Thresholds on page 1305
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PTX5000 PIC Description

• PTX5000 PIC Slots on page 1309

• PTX5000 PIC Function on page 1309

• PICs Supported on the PTX5000 on page 1309

• PTX5000 PIC Components on page 1309

PTX5000 PIC Slots

Each FPC has two PIC slots. Blank PICs resemble other PICs but do not provide any

physical connection or activity. When a PIC slot is not occupied by a PIC, youmust insert

a blank PIC to fill the empty slot and ensure proper cooling of the system. PICs are

hot-removable and hot-insertable.

PTX5000 PIC Function

PICs provide the physical connection to various networkmedia types, receiving incoming

packets from the network and transmitting outgoing packets to the network. During this

process, each PIC performs framing and line-speed signaling for its media type. Before

transmitting outgoing data packets, the PICs encapsulate the packets received from the

FPCs.

PICs Supported on the PTX5000

See PTX Series PIC/FPC Compatibility for a complete list of PICs supported on the

PTX5000.

PTX5000 PIC Components

Figure 29onpage 1310 showsanexample of aPIC supportedon thePTX5000. PICs have

an upper ejector handle and a lower ejector handle.
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Figure 29: PIC Faceplate
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Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•

• PTX3000 PIC Description on page 1310

PTX3000 PIC Description

• PIC Slots on page 1310

• PIC Function on page 1312

• PICs Supported on page 1312

• PIC Components on page 1312

PIC Slots

Up to eight PICs install vertically in the front of the PTX3000 (Figure 30 on page 1311).

The PIC slots are numbered 1, 3, 5, and 7 in the upper chassis, and 9, 11, 13, and 15 in the

lower chassis.

The PIC in the slot to the right of an FPC is associated with that FPC. Each PIC requires

an FPC to be installed in the adjacent FPC slot to its left as specified in

Table 206 on page 1311. For example, the PIC in slot 1 is associatedwith the FPC in slot 0.

When a slot is not occupied by a PIC, youmust insert a blank PIC to fill the empty slot

and ensure proper cooling of the system. Blank PICs resemble other PICs but do not

provide any physical connection or activity. PICs are hot-removable and hot-insertable.
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Figure 30: PIC Slots

NOTE: In the CLI, all PTX3000 PICs are represented as pic0.

Table 206: CLI Representation of PIC Slots

CLI Representation of PIC SlotsPIC Slot in ChassisFPC Slot in Chassis

fpc0-pic0-port-number10

fpc2-pic0-port-number32

fpc4-pic0-port-number54

fpc6-pic0-port-number76

fpc8-pic0-port-number98
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Table 206: CLI Representation of PIC Slots (continued)

CLI Representation of PIC SlotsPIC Slot in ChassisFPC Slot in Chassis

fpc10-pic0-port-number1110

fpc12-pic0-port-number1312

fpc14-pic0-port-number1514

PIC Function

PICs provide the physical connection to various networkmedia types, receiving incoming

packets from the network and transmitting outgoing packets to the network. During this

process, each PIC performs framing and line-speed signaling for its media type. Before

transmitting outgoing data packets, the PICs encapsulate the packets received from the

FPCs.

PICs Supported

See PICs Supported on the PTX Series for a complete list of PICs supported on the

PTX3000.

PIC Components

Figure 31 on page 1313 shows an example of a PIC supported on the PTX3000. PICs have

an upper ejector handle and a lower ejector handle.
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Figure 31: PIC Faceplate
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Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•

• PTX5000 PIC Description on page 1309

100-Gigabit Ethernet OTNOptical Interface Specifications

The 100-Gigabit Ethernet OTN (Optical Transport Network) optical interface standards

described below are supported on PTX Series routers.

To determine which transceivers support each 100-Gigabit Ethernet OTN standard, see

SupportedNetwork InterfaceStandards byTransceiver for PTXSeries Routers. The “Cables

and Connectors” section in the description for each PIC lists which standards and

transceivers are supported for that device.

• OTU4 4I1-9D1F Optical Interface Specifications on page 1313

OTU4 4I1-9D1F Optical Interface Specifications

Table 207 on page 1314 shows the optical interface specifications for the OTU4 4I1-9D1F

standard.
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Table 207: OTU4 4I1-9D1F (ITU-T 959.1) Optical Interface Specifications

EML LaserDML LaserParameter

Same as DML laserSingle-modeOptical interface

Same as DML laserITU-T 959.1Standard

Same as DML laserITU-T G.652 fiber, 6.2 miles (10 km)Maximum distance

Same as DML laser1294.53 through 1296.59 nm

1299.02 through 1301.09 nm

1303.54 through 1305.63 nm

1308.09 through 1310.19 nm

Central frequency

–2.5 through 2.9 dBm per lane–0.6 through 4.0 dBm per laneMean channel output power

–8.8 through 2.9 dBm–6.9 through 4.0 dBmMean channel input power

–10.3 dBm–8.4 dBmMinimum equivalent sensitivity per
lane

Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•

• PTX5000 PIC Description on page 1309

• PTX3000 PIC Description on page 1310

100-Gigabit DWDMOTNPIC Optical Interface Specifications

PTX Series routers support the following 100-Gigabit (DenseWavelength Division

Multiplexing) OTN (Optical Transport Network) fixed transceiver PIC:

• P1-PTX-2-100G-WDM—Designed for metro, regional, or long-haul applications.

Table208onpage1314andTable209onpage1315showtheoptical interfacespecifications

for the 100-Gigabit DWDMOTN PIC transceivers.

Table 208: 100-Gigabit DWDMOTN PIC Optical Interface Specifications

P1-PTX-2-100G-WDMSpecifications

• DWDM integrated transceiverTransceiver type

• ITU-T G.709—Interfaces for the optical transport network.

• ITU-TG.798—Characteristicsof optical transport networkhierarchyequipment functional blocks

• ITU-T G.694.1—Spectral grids for WDM applications: DWDM frequency grid

• RFC 3591—Definitions of Managed Objects for the Optical Interface Type

Standards
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Table 208: 100-Gigabit DWDMOTN PIC Optical Interface Specifications (continued)

P1-PTX-2-100G-WDMSpecifications

• Single-mode optical fiber (ITU-T G.652)Optical interface

• Line rate: 127.156441 Gbps

• Modulation format: Dual polarization-quadrature phase-shift keying (DP-QPSK),
non-return-to-zero (NRZ)

• FEC type: Soft decision

• Channel-plan wavelength range: 1529.55 through 1567.54 nm

• Channel-plan frequency range: 191.25 through 196.00 THz

• Channel spacing: 50 GHz

• Channel tunability: 96 channels—see Table 209 on page 1315

Line interface

• Output power (on): –2 dBm

• Output power (off): ≤−45 dBm

• Wavelength accuracy: +/–2.5 GHz

• Channel tuning time: ≤30 seconds

Optical transmitter

• Average receive power (input power range): –18 to –5 dBm

• Input sensitivity (unamplified/dark-fiber applications): –28 dBm

• LOwavelength accuracy: +/–2.5 GHz

• Channel tuning time: ≤30 seconds

• Damage input power threshold: +10 dBm

• MinimumOSNR (back-to-back): 13.5 dB typical

• MinimumOSNR (back-to-back): 14.5 dB worst-case, EOL

• Chromatic dispersion tolerance: +/–50,000 ps/nm

• PMD tolerance: 25 ps (mean DGD)

• Polarization tracking: 150 krad/s

Optical receiver

Table 209 on page 1315 provides the supportedwavelengths in both terahertz (THz) and

nanometers (nm).

Table 209: 100-Gigabit DWDMOTN SupportedWavelengths

50–GHz Offset100–GHz Grid

nmTHznmTHz

1567.54191.25––

1566.72191.351567.13191.30

1565.90191.451566.31191.40

1565.09191.551565.50191.50

1564.27191.651564.68191.60
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Table 209: 100-Gigabit DWDMOTN SupportedWavelengths (continued)

50–GHz Offset100–GHz Grid

nmTHznmTHz

1563.45191.751563.86191.70

1562.64191.851563.05191.80

1561.83191.951562.23191.90

1561.01192.051561.42192.00

1560.20192.151560.61192.10

1559.39192.251559.79192.20

1558.58192.351558.98192.30

1557.77192.451558.17192.40

1556.96192.551557.36192.50

1556.15192.651556.55192.60

1555.34192.751555.75192.70

1554.54192.851554.94192.80

1553.73192.951554.13192.90

1552.93193.051553.33193.00

1552.12193.151552.52193.10

1551.32193.251551.72193.20

1550.52193.351550.92193.30

1549.72193.451550.12193.40

1548.91193.551549.32193.50

1548.11193.651548.51193.60

1547.32193.751547.72193.70

1546.52193.851546.92193.80

1545.72193.951546.12193.90
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Table 209: 100-Gigabit DWDMOTN SupportedWavelengths (continued)

50–GHz Offset100–GHz Grid

nmTHznmTHz

1544.92194.051545.32194.00

1544.13194.151544.53194.10

1543.33194.251543.73194.20

1542.54194.351542.94194.30

1541.75194.451542.14194.40

1540.95194.551541.35194.50

1540.16194.651540.56194.60

1539.37194.751539.77194.70

1538.58194.851538.98194.80

1537.79194.951538.19194.90

1537.00195.051537.40195.00

1536.22195.151536.61195.10

1535.43195.251535.82195.20

1534.64195.351535.04195.30

1533.86195.451534.25195.40

1533.07195.551533.47195.50

1532.29195.651532.68195.60

1531.51195.751531.90195.70

1530.72195.851531.12195.80

1529.94195.951530.33195.90

––1529.55196.00

Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•
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• PTX5000 PIC Description on page 1309

• PTX3000 PIC Description on page 1310

100-Gigabit DWDMOTNPIC (PTX Series)

• Software Release on page 1318

• Hardware Features on page 1319

• Software Features on page 1319

• Cables and Connectors on page 1321

• LEDs on page 1321

• Alarms, Errors, and Events on page 1321

Software Release

PTXSeries routers support the following 100-Gigabit DWDM(densewavelength division

multiplexing) OTN (optical transport network) PICs:

• 100-Gigabit DWDMOTN PIC (P1-PTX-2-100G-WDM):

• PTX3000: Junos OS Release 13.3 and later
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• PTX5000: Junos OS Release 13.2 and later

For informationaboutwhichFPCs support thisPIC, seePTXSeriesPIC/FPCCompatibility.

Hardware Features

• Model number:

• P1-PTX-2-100G-WDM—Designed for metro, regional, or long-haul applications.

• Two 100-Gigabit DWDMOTN ports

• Power requirements: 6.48 A@–48 V (311 W)

• Transparent transport of two 100-Gigabit Ethernet signals with OTU4V framing

• ITU-standard OTN performancemonitoring and alarmmanagement

• Dual polarization-quadrature phase-shift keying (DP-QPSK)modulation and

soft-decision forward error correction (SD-FEC) for long haul andmetro applications

• 96 channels on C-band ITU grid with 50-GHz spacing

• Full-duplex mode

• Maximum transmission units (MTUs) up to 9500 bytes

• Latency: 32 µs (TX + RX)

NOTE: The 100-Gigabit DWDMOTN PIC is designed to comply with NEBS
regulations on the PTX5000 router when used in typical configurations. The
typical configuration for a PTX5000 router is up to eight FPCs, with one
100-Gigabit DWDMOTN PIC and one 100-Gigabit Ethernet PIC with CFP,
40-Gigabit Ethernet PIC with CFP, or 10-Gigabit Ethernet PIC with SFP+
installed in the same FPC.

The 100-GigabitDWDMOTNPIC isdesignedtocomplywithNEBSregulations
on thePTX3000 routerwhenused in typical configurationsat40°C(104°F)
at sea level. The typical configuration for a PTX3000 router is up to eight
FPCs, with one 100-Gigabit DWDMOTN PIC next to each FPC in the top row
only. The 100-Gigabit Ethernet PIC with CFP, 40-Gigabit Ethernet PIC with
CFP, or 10-Gigabit Ethernet PIC with SFP+ are supported next to any FPC.

Software Features

Table 210 on page 1319 shows the first supported release for each software feature.

Table 210: Software Features Supported

PTX5000 First Supported Junos
OS Release

PTX3000 First Supported Junos
OS ReleaseSoftware Feature

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3Compliant with ITU G.709 and G.798
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Table 210: Software Features Supported (continued)

PTX5000 First Supported Junos
OS Release

PTX3000 First Supported Junos
OS ReleaseSoftware Feature

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3Provides a transport interface and state model
(GR-1093)

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3Performancemonitoring such as alarms,
threshold-crossing alarms, OTU/ODU error
seconds and pre-FEC statistics

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3SNMPmanagement of the PIC based on RFC
3591, Managed Objects for the Optical Interface
Type

• Set functionality

• Juniper Networks Black-Link MIB

• IFOTNMIB

• Optics MIB

• FRUMIB

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3IEEE 802.1ag OAM

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3IEEE 802.3ah OAM

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3IFINFO/IFMON

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3IEEE 802.3ad link aggregation

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3Pre-FECBERmonitoringprovides interrupt-driven
link-signal-degrade BER-based detection for
MPLS fast reroute

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3Flexible Ethernet services encapsulation

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3Flexible VLAN tagging

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3Source address MAC accounting per logical
interface

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3

• PTX-2-100G-WDM-M: 14.2R3

Source address MAC filter per port

• P1-PTX-2-100G-WDM: 13.2

• PTX-2-100G-WDM-M: 14.2R3

• P1-PTX-2-100G-WDM: 13.3Source address MAC filter per logical interface

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3Destination address MAC filter per port

• P1-PTX-2-100G-WDM: 13.2• P1-PTX-2-100G-WDM: 13.3Up to 8000 logical interfaces shared across all
ports on a single PFE
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Cables and Connectors

• Single-mode optical fiber (ITU-T G.652)

• Duplex LC connector (Rx and Tx)

• Optical interface specifications

LEDs

The STATUS LED is located above theONLINEOFFLINE button. The LINK and ACT LEDs

are locatednext toeachport. Table211 onpage 1321describes the functionsof theseLEDs.

Table 211: 100-Gigabit DWDMOTN PIC LEDs

DescriptionStateColorLabel

PIC is online with no alarms or failures.On steadilyGreenSTATUS

PIC is initializing.On steadilyYellow

PIC is online but has errors or alarms.On steadilyRed

PIC is offline or not enabled.Off–

Port is online with no alarms or failures, and the link is up.On steadilyGreenLINK for
each port:

Port has detected an alarm or failure.Yellow

Port has detected amedia alarm or failure.On steadilyRed

Port is off or not enabled.Off–

Activity detected. Port is sending or receiving packets.FlashingGreenACT for
each port

No packet activity detected on the port.Off–

Alarms, Errors, and Events

Chassis and PIC:

• PIC (FRU) inserted or removed

• PIC (FRU) Admin InService/OutOfService, Oper

Unequipped/Init/Normal/Mismatch/Fault/Upgrade

• Mismatch equipment

• Temperature alarm

• Fan alarm
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Port (interface):

• Interface Admin InService/OutOfService/ServiceMA/OutOfServiceMA, Oper

Init/Normal/Fault/Degraded

OTN (optical transport network):

• LOS (loss of signal)

• LOF (loss of frame)

• LOM (loss of multiframe)

• SSF (server signal failure)

• TSF (trail signal fail)

OTU (optical channel transport unit):

• OTU-FEC-DEG (forward error correction degraded)

• OTU-FEC-EXE (excessive errors, FEC_FAIL from the transponder)

• OTU-AIS (alarm indication signal or all ones signal)

• OTU-BDI (backward defect identification)

• OTU-IAE (incoming alignment error)

• OTU-BIAE (backward incoming alignment error)

• OTU-TTIM (destination access point identifier [DAPI], source access point identifier

[SAPI], or both mismatch from expected to received)

• OTU-DEG (OTU degraded)

ODU (optical channel data unit):

• CSF (client signal failure)

• ODU-DM-TIMEOUT (DM timeout)

• ODU-LCK (ODU lock triggers for path monitoring and TCM levels 1 through 6)

• ODU-AIS (alarm indication signal or all ones signal)

• ODU-OCI (open connection error)

• ODU-BDI (backward defect indication)

• ODU-DEG (ODU degraded)

• ODU-IAE (incoming alignment error)

• ODU-DAPI-TTIM (DAPI or DAPI/SAPI mismatch from expected to receive)

• ODU-SAPI-TTIM (SAPI or DAPI/SAPI mismatch from expected to receive)

• ODU-BEI (backward error indication)

• ODU-BEI-ERR (backward error indication error)

• ODU-BIP8-ERR (bit interleaved parity 8 error)
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• ODU-SSF (server signal fail)

• ODU-TSF (trail signal fail)

• ODU-SD (signal degrade)

OPU (optical channel payload):

• OPU-PTM (payload typemismatch)

Optics:

• TX output power

Card-related status:

• Transceiver temperature high alarm

• Transceiver temperature high warning

• Transceiver temperature low alarm

• Transceiver temperature lowwarning

• Transceiver voltage high alarm

• Transceiver voltage high warning

• Transceiver voltage low alarm

• Transceiver voltage lowwarning

• Transceiver temperature monitor A/D value

• Transceiver power supply monitor A/D value (voltage)

Network lane transmit–related status:

• TX laser current bias high alarm

• TX laser current bias high warning

• TX laser current bias low alarm

• TX laser current bias lowwarning

• TX laser temperature high alarm

• TX laser temperature high warning

• TX laser temperature low alarm

• TX laser temperature lowwarning

• TX output optical power high alarm

• TX output optical power high warning

• TX output optical power low alarm

• TX output optical power lowwarning

• TX laser TEC fault
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• TX laser wavelength unlocked fault

• TXmodulator bias high alarm

• TXmodulator bias high warning

• TXmodulator bias low alarm

• TXmodulator bias lowwarning

• TX loss of signal fault

• TX current laser output power

• TXminimum laser output power over a performancemonitoring interval

• TX average laser output power over a performancemonitoring interval

• TXmaximum laser output power over a performancemonitoring interval

Network lane receive–related status:

• RX laser bias current high alarm

• RX laser bias current high warning

• RX laser bias current low alarm

• RX laser bias current lowwarning

• RX input optical power high alarm

• RX input optical power high warning

• RX input optical power low alarm

• RX input optical power lowwarning

• RX laser output high alarm

• RX laser output high warning

• RX laser output low alarm

• RX laser output lowwarning

• RX laser temperature high alarm

• RX laser temperature high warning

• RX laser temperature low alarm

• RX laser temperature lowwarning

• RX LOS

• RX Laser wavelength unlocked fault

• RX laser TEC fault

• RX current chromatic dispersion

• RX average chromatic dispersion over a performancemonitoring interval

• RXminimum chromatic dispersion over a performancemonitoring interval
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• RXmaximum chromatic dispersion over a performancemonitoring interval

• RX current Q

• RX average Q over a performancemonitoring interval

• RXminimumQ over a performancemonitoring interval

• RXmaximumQ over a performancemonitoring interval

• RX current carrier frequency offset

• RX average carrier frequency offset over a performancemonitoring interval

• RXminimum carrier frequency offset over a performancemonitoring interval

• RXmaximum carrier frequency offset over a performancemonitoring interval

• RX current SNR (signal-to-noise ratio)

• RX average SNR

• RXminimum SNR

• RXmaximum SNR

• RXmodem sync detect fault occurred over a performancemonitoring interval

• RXmodem lock fault occurred over a performancemonitoring interval

• RX loss of alignment occurred over a performancemonitoring interval

• RX out of alignment occurred over a performancemonitoring interval

• RX deskew lock fault occurred over a performancemonitoring interval

• RX LOS occurred over a performancemonitoring interval

• RX current laser output power

• RXminimum laser output power over a performancemonitoring interval

• RX average laser output power over a performancemonitoring interval

• RXmaximum laser output power over a performancemonitoring interval

Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•

• PTX5000 PIC Description on page 1309

• PTX3000 PIC Description on page 1310
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100-Gigabit Ethernet OTN PICwith CFP2 (PTX Series)

• Software Release on page 1326

• Hardware Features on page 1326

• Software Features on page 1327

• Cables and Connectors on page 1327

• LEDs on page 1328

Software Release

• PTX5000: Junos OS Release 14.1R2 and later

Hardware Features

• Four ports that can be configured as 100-Gigabit Ethernet, 100-Gigabit OTN, or a

combination of 100-Gigabit Ethernet and 100-Gigabit Ethernet OTN interfaces.

• Model number: P2-100GE-OTN

• Name in the CLI: 4x100GEOTNCFP2
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• Power requirements: 14.50A@–12 V (176W)

• Large maximum transmission units (MTUs): up to 9500 bytes

Software Features

Table 212 on page 1327 shows the first supported release for each software feature.

Table 212: Software Features Supported

First Supported Junos OS Release on
PTX5000Software Feature

14.1R2Flexible Ethernet services encapsulation

14.1R2Flexible VLAN tagging

14.1R2IFINFO / IFMON

14.1R2IEEE 802.1 ag OAM

14.1R2IEEE 802.3 ah OAM

14.1R2IEEE 802.3ad link aggregation

14.1R2Interrupt-driven link-down detection for MPLS FRR

14.1R2MAC accounting per logical interface for source addresses

14.1R2MAC filter per port for destination addresses and source addresses

14.1R2MAC filter per logical interface for source addresses

14.1R2SNMP

14.1R2Up to 4000 logical interfaces shared across all ports on a single PFE

Cables and Connectors

The following transceivers are supported on this PIC:

• CFP2-100G-LR4-D—Supports both 100GBASE-LR4 and OTU4 4I1-9D1F

• Cable: See 100-Gigabit Ethernet 100GBASE-R Optical Interface Specifications or

100-Gigabit Ethernet OTN Optical Interface Specifications

• Connector: LC

• CFP2-100G-SR10-D—Supports 100GBASE-SR10

NOTE: This transceiver supports Ethernet only, OTN is not supported.
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• Cable: See 100-Gigabit Ethernet 100GBASE-R Optical Interface Specifications

• Connector: 24-fiber MPO

• CFP2-100GBASE-LR4—Supports 100GBASE-LR4

• Cable: See 100-Gigabit Ethernet 100GBASE-R Optical Interface Specifications

• Connector: LC

• CFP2-100GBASE-SR10—Supports 100GBASE-SR10

• Cable:

• Connector: 24-fiber MPO

LEDs

TheSTATUS LED is located to the left of theONLINE/OFFLINEbutton. One LED is located

next to each port to indicate the link activity of the port. Table 213 on page 1328 describes

the functions of these LEDs.

Table 213: 100-Gigabit Ethernet OTN PIC with CFP2 LEDs

DescriptionStateColorLabel

PIC is online with no alarms or failures.On steadilyGreenSTATUS

PIC is initializing.On steadilyYellow

PIC is in failed state.On steadilyRed

PIC is offline or not enabled.Off–

Port is online with no alarms or failures, and the link is up.On steadilyGreenSingle LED
per port,
labeled 0, 1,
2, and 3

Activity detected. Port is sending or receiving packets.Blinking

Port is on but the link is down, and the port has detected a
failure with alarms.

On steadilyRed

Port is off or not enabled.Off–

Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•

• PTX5000 PIC Description on page 1309

• PTX3000 PIC Description on page 1310
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100-Gigabit Ethernet PIC with CFP2 (PTX Series)

• Software Release on page 1329

• Hardware Features on page 1329

• Software Features on page 1330

• Cables and Connectors on page 1330

• LEDs on page 1331

• Alarms, Errors, and Events on page 1331

Software Release

• PTX5000: Junos OS Release 14.1 and later

Hardware Features

• Four 100-Gigabit Ethernet ports

• Model number: P2-100GE-CFP2

• Name in the CLI: 4x100GE CFP2

• Power requirements: 1.66A@–48 V (90W)

• Large maximum transmission units (MTUs): up to 9500 bytes
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Software Features

Table 214 on page 1330 shows the first supported release for each software feature.

Table 214: Software Features Supported

PTX5000 First Supported Junos
OS ReleaseSoftware Feature

14.1Flexible-ethernet-services encapsulation

14.1Flexible VLAN tagging

14.1IFINFO / IFMON

14.1IEEE 802.1 ag OAM

14.1IEEE 802.3 ah OAM

14.1IEEE 802.3ad link aggregation

14.1Interrupt-driven link-down detection for MPLS FRR

14.1MAC accounting per logical interface for source addresses

14.1MAC filter per port for destination addresses and source addresses

14.1MAC filter per logical interface for source addresses

14.1SNMP

14.1Up to 4000 logical interfaces share across all ports on a single PFE

Cables and Connectors

The following transceivers are supported on this PIC:

• CFP2-100G-LR4-D—Supports 100GBASE-LR4

• Cable: See 100-Gigabit Ethernet 100GBASE-R Optical Interface Specifications

• Connector: LC

• CFP2-100G-SR10-D—Supports 100GBASE-SR10

• Cable: See 100-Gigabit Ethernet 100GBASE-R Optical Interface Specifications

• Connector: 24-fiber MPO

• CFP2-100GBASE-LR4—Supports 100GBASE-LR4

• Cable: See 100-Gigabit Ethernet 100GBASE-R Optical Interface Specifications

Copyright © 2019, Juniper Networks, Inc.1330

Connectivity Services Director User Guide



• Connector: LC

• CFP2-100GBASE-SR10—Supports 100GBASE-SR10

• Cable: See 100-Gigabit Ethernet 100GBASE-R Optical Interface Specifications

• Connector: 24-fiber MPO

NOTE: The dual-rate transceiver (CFP2-100G-LR4-D) cannot be configured
to useOTN framingwhenused in this PIC. The 100-Gigabit EthernetOTNPIC
with CFP2 (P2-100GE-OTN) supports OTN framing.

LEDs

TheSTATUS LED is located to the left of theONLINE/OFFLINEbutton. One LED is located

next to each port to indicate the link activity of the port. Table 215 on page 1331 describes

the functions of these LEDs.

Table 215: 100-Gigabit Ethernet PIC with CFP2 LEDs

DescriptionStateColorLabel

PIC is online with no alarms or failures.On steadilyGreenSTATUS

PIC is initializing.On steadilyYellow

PIC has an error or failure.On steadilyRed

PIC isofflineornotenabledandsafe to remove fromthe router.Off–

Port is online with no alarms or errors, and the link is up.On steadilyGreenSingle
LED per
port There is link activity on the port.Blinking

Port is on but the link is down, and the port has detected a
failure.

On steadilyRed

Port is off or not enabled.Off–

Alarms, Errors, and Events

• Laser bias current high/low alarms and warnings

• Laser Rx power high/low alarms and warnings

• Module not ready alarm

• Module low power alarm

• Module temperature high/low alarms and warnings

• Rx CDR loss of lock alarm
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• Rx loss of signal alarm

• Module not ready alarm

• Tx CDR loss of lock alarm

Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•

• PTX5000 PIC Description on page 1309

• PTX3000 PIC Description on page 1310

100-Gigabit Ethernet PIC with CFP (PTX Series)

g0
06

12
2

• Software Release on page 1332

• Hardware Features on page 1333

• Software Features on page 1333

• Cables and Connectors on page 1335

• LEDs on page 1336

• Alarms, Errors, and Events on page 1337

Software Release

• PTX3000: Junos OS Release 13.2R2 and later
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• PTX5000:

NOTE: PTX5000 does not support Junos OS Release 13.1.

• Junos OS Release 12.1X48 and later 12.1X48 releases

• Junos OS Release 12.3 and later 12.3 releases

• Junos OS Release 13.2 and later releases

NOTE: PTX5000 does not support Junos OS Releases 12.1, 12.2, or 13.1.

Hardware Features

• Two 100-Gigabit Ethernet CFP ports

• Model number P1-PTX-2-100GE-CFP

• Name in the CLI: 2x 100GE CFP

• Power requirements: 1.6 A@ –48 V (75W)

• Large maximum transmission units (MTUs):

• Junos OS Release 12.1X48: up to 9192 bytes

• Junos OS Release 12.1X48R2 and later 12.1X48 releases: up to 9500 bytes

• Junos OS Release 12.3 and later 12.3 releases: up to 9500 bytes

Software Features

Table 216 on page 1333 shows the first supported release for each software feature.

Table 216: Software Features Supported

PTX5000 First Supported Junos
OS Release

PTX3000 First
Supported Junos OS
ReleaseSoftware Feature

12.1X48

12.3

13.2

13.2R2Flexible-ethernet-services encapsulation

12.1X48

12.3

13.2

13.2R2Flexible VLAN tagging
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Table 216: Software Features Supported (continued)

PTX5000 First Supported Junos
OS Release

PTX3000 First
Supported Junos OS
ReleaseSoftware Feature

12.1X48

12.3

13.2

13.2R2IFINFO / IFMON

12.1X48

12.3

13.2

13.2R2IEEE 802.1 ag OAM

12.1X48

12.3

13.2

13.2R2IEEE 802.3 ah OAM

12.1X48

12.3

13.2

13.2R2IEEE 802.3ad link aggregation

12.1X48

12.3

13.2

13.2R2Interrupt-driven link-down detection for MPLS FRR

12.1X48

12.3

13.2

13.2R2MAC accounting per logical interface for source
addresses

12.1X48

12.3

13.2

13.2R2MAC filter per port for destination addresses and source
addresses

12.1X48

12.3

13.2

13.2R2MAC filter per logical interface for source addresses

12.1X48

12.3

13.2

13.2R2SNMP
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Table 216: Software Features Supported (continued)

PTX5000 First Supported Junos
OS Release

PTX3000 First
Supported Junos OS
ReleaseSoftware Feature

12.1X48

12.3

13.2

13.2R2Up to 8000 logical interfaces share across all ports on
a single PFE

Cables and Connectors

• 100GBASE-ER4 (model number: CFP-100GBASE-ER4)

• Duplex LC connector (RX and TX)

• Junos OS Release 12.1X48R4 and later 12.1X48 releases

• Junos OS Release 12.3 and later 12.3 releases

• Junos OS Release 13.2 and later releases

• 100GBASE-ER4(modelnumber:CFP-GEN2-CGE-ER4andpartnumber: 740-049763)

• Duplex LC connector (RX and TX)

• Junos OS Release 12.3R5 and later 12.3 releases

• Junos OS Release 13.2R3 and later 13.2 releases

• Junos OS Release 13.3 and later releases

NOTE: The “GEN2” optics have been redesigned with newer versions of
internal components for reduced power consumption.

• 100GBASE-LR4 (model number: CFP-100GBASE-LR4)

• Duplex SC connector (RX and TX)

• Junos OS Release 12.1X48 and later 12.1X48 releases

• Junos OS Release 12.3 and later 12.3 releases

• Junos OS Release 13.2 and later releases

100GBASE-LR4 (model number: CFP-GEN2-100GBASE-LR4 and part number:

740-047682)

• Duplex LC connector (RX and TX)

• Junos OS Release 12.3R5 and later 12.3 releases

• Junos OS Release 13.2R3 and later 13.2 releases

• Junos OS Release 13.3 and later releases

1335Copyright © 2019, Juniper Networks, Inc.

Chapter 52: Overview of Optical Interfaces, OTUs, and ODUs



NOTE: The “GEN2” optics have been redesigned with newer versions of
internal components for reduced power consumption.

• 100GBASE-SR10 (model number: CFP-100GBASE-SR10)

• 24-fiber MPO connectors

• Junos OS Release 12.1X48R3 and later 12.1X48 releases

• Junos OS Release 12.3 and later 12.3 releases

• Junos OS Release 13.2 and later releases

• 100GBASE-ZR (model number: CFP-100GBASE-ZR)

• Duplex LC connector (RX and TX)

• Supported in Junos OS Release 13.3R6, 14.1R4, 14.2R3, and 15.1R1 and later

• Provides advanced dual polarization-quadrature phase shift keying (DP-QPSK)

coherentdigital signalprocessing (DSP)and forwarderror correction(FEC)-enabled

robust tolerance to optical impairments and supports 80 km reachover singlemode

fiber

• The transceiver is not specified as part of IEEE 802.3 but is built according to Juniper

Networks specifications.

• Optical interfacespecifications—see 100-GigabitEthernet 100GBASE-ROptical Interface

Specifications

LEDs

The STATUS LED is located above theONLINEOFFLINE button. The LINK and ACT LEDs

are locatednext toeachport. Table217onpage 1336describes the functionsof theseLEDs.

Table 217: 100-Gigabit Ethernet PIC with CFP LEDs

DescriptionStateColorLabel

PIC is online with no alarms or failures.On steadilyGreenSTATUS

PIC is initializing.On steadilyYellow

PIC is online but has errors or alarms.On steadilyRed

PIC is offline or not enabled.Off–

Port is online with no alarms or failures, and the link is up.On steadilyGreenLINK for
each port:

Port is on but the link is down, and the port has detected a
failure with alarms.

On steadilyRed

Port is off or not enabled.Off–
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Table 217: 100-Gigabit Ethernet PIC with CFP LEDs (continued)

DescriptionStateColorLabel

Activity detected. Port is sending or receiving packets.FlashingGreenACT for each
port

No packet activity detected on the port.Off–

Alarms, Errors, and Events

• Alarm indication signal (AIS)

• Laser bias current high/low alarms and warnings

• Laser Rx power high/low alarms and warnings

• Module not ready alarm

• Module power down alarm

• Module temperature high/low alarms and warnings

• Rx CDR loss of lock alarm

• Rx loss of signal alarm

• Rx not ready alarm

• Tx CDR loss of lock alarm

• Tx data not ready alarm

• Tx laser fault alarm

• Tx not ready alarm

Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•

• PTX5000 PIC Description on page 1309

• PTX3000 PIC Description on page 1310

100GbE PICs for PTX Series Routers

Juniper Networks 4-port 100GbE PICs enable service providers to deploy high-density

100G services in a wide variety of short-reach, long-reach, and DWDM scenarios. Using

modular 100-gigabit pluggable transceiver (CFP2) optics, the 4-port 100GbE PICs are

designed for second-generation PTX Series Packet Transport Routers line cards (FPC2)

and provide line-rate performance in Ethernet and optical transport network (OTN)

applications.

Juniper Networks
®
PTX Series Packet Transport Routers are architected for

industry-leading system density in a transport-focused design that delivers the ability to

scale, rapidly qualify and deploy, and reliably support the core—all at almost half the

power of other core routers. The second generation of PTX Series hardware uses an
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optimized packaging of the succcessful Juniper Networks Junos
®
Express chip for robust,

line-rate, and low-latency packet performance at up to 960 Gbps per slot. The 4-port

100GbEPIC familyextends theexistingPTXSeriesPICportfoliobyofferingcost-optimized

flexibility of dense 100GbE solutions to service providers. Themix andmatch of 4-port

100GbEPICsallows forup to64short-reach, long-reach, and tunable1 100GbE interfaces

per chassis for ultra-high speed interconnect applications. A PTX Series router fully

equipped with second-generation line cards can demonstrate efficiency as high as 1.2

W/Gbps.

Architecture and Key Components

The 4-port 100GbE PICs for PTX Series line cards leverage the proven Junos Express

technology inoctal-PacketForwardingEngine (PFE)configuration (FPC2).Thisapproach

combines proven and qualified hardware with advanced packaging and the latest in

modular optical technology.

The4-port 100GbECFP2PICsupportsEthernetover shortreach, long-reach,andextended

long-reach distances in 100GbE SR10, LR4, and ER4 formats.

The 4-port 100GbE Ethernet/OTNCFP2 PIC is designed for the highest flexibility in local,

andmetro applications with Ethernet and OTN framing.

The 4-port 100GbE CFP2 PIC provides the benefits of a pluggable optical module in

popular short-reach and long-reach applications, where OTN framing is not required.

This includes the following applications:

• Intra-POP connectivity

• 100GbE fanout to 10GbE-optimized edge routers

• Router to DWDM shelf connections

The4-port 100GbECFP2Ethernet/OTNPIC is themost flexible 100GbEquad-portoption,

with connectivity to a broad range of long-haul equipment. The 4-port 100GbE CFP2

Ethernet/OTN PIC supports OTN performancemonitoring, and full control over OTN

features via the Juniper Networks Junos operating system.

Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•

• PTX5000 PIC Description on page 1309

• PTX3000 PIC Description on page 1310

P2-10G-40G-QSFPP PIC Overview

Starting with Junos OS Release 14.1R2 and 14.2R1, PTX5000 supports the

P2-10G-40G-QSFPP PIC on the FPC2-PTX-P1A FPC.

All the ports on the P2-10G-40G-QSFPP PIC are plugged into quad small form-factor

pluggable plus transceivers (QSFP+) that, in turn, are connected to fiber-optic cables

that support both 10-Gigabit Ethernet standards and 40-Gigabit Ethernet standards,
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thereby enabling you to configure the PIC to operate either in 10-Gigabit Ethernet mode

or in 40-Gigabit Ethernet mode.

Starting from Junos OS Release 15.1, you can perform the following on the

P2-10G-40G-QSFPP PIC on PTX5000 routers:

• You can configure the interfaces on this PIC to be a part of the mixed rates andmixed

mode aggregated Ethernet bundles.

• Port-based pseudowire class of service (CoS) classification which includes Layer 3

IPv4, IPv6, and MPLS classification for interfaces with ethernet-ccc encapsulation.

The following sections describe the P2-10G-40G-QSFPP PIC and the various framing

modes that are supported on it:

• Understanding Dual Configuration on P2-10G-40G-QSFPP PIC on page 1339

• Port Numbering on P2-10G-40G-QSFPP PIC on page 1340

• 10-Gigabit Ethernet Mode on page 1342

• 40-Gigabit Ethernet Mode on page 1342

Understanding Dual Configuration on P2-10G-40G-QSFPP PIC

All the ports on the P2-10G-40G-QSFPP PIC are QSFP+ based—that is, all the ports are

connected to fiber-optic cables by means of QSFP+ transceivers.

TheQSFP+module—which includes the transceiver and the fiber-optic cable—supports

the following standards on the P2-10G-40G-QSFPP PIC:

• 10-Gigabit Ethernet in LAN PHY framingmode (also known as native Ethernet mode)

andWAN PHY framingmode.

• 40-Gigabit Ethernet in LAN PHY framingmode.

The P2-10G-40G-QSFPP PIC provides forty-eight 10-Gigabit Ethernet ports or twelve

40-Gigabit Ethernet ports. The PIC can be configured either in 10-Gigabit Ethernetmode

or in 40-Gigabit Ethernet mode with the set chassis fpc fpc-number pic pic-number

pic-mode (10G | 40G) configuration command. By default, the PIC is configured in

10-Gigabit Ethernet LAN PHY framingmode.
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NOTE:

If you want configure the PIC in 10-Gigabit Ethernet mode to operate in
40-Gigabit Ethernet mode, youmust:

1. Delete all the interfaces in the PIC at the [edit interfaces] hierarchy level.

2. Configure the PIC to operate in 40-Gigabit Ethernet mode by using the
set chassis fpc fpc-slot pic pic-slot pic-mode 40G configuration command

and commit.

The PIC reboots and starts operating in the newmode.

The same procedure is applicable when you can configure the PIC in
40-Gigabit Ethernet PIC to operate in 10-Gigabit Ethernetmode. In this case,
youmust execute the set chassis fpc fpc-slot pic pic-slot pic-mode 10G

configurationmode command.

To check the current diagnostics of the PIC, youmust run the relevant operational mode

CLI commands such as show chassis hardware, show interfaces, show interfaces

diagnostics optics interface-name, and so on.

Port Numbering on P2-10G-40G-QSFPP PIC

Table 218 on page 1340 shows the port numbering in 40-Gigabit Ethernet mode and in

10-Gigabit Ethernet mode.

Table 218: Port Numbering Table

Port Numbering in 10-Gigabit Ethernet Mode
Port Numbering in 40-Gigabit
Ethernet Mode

QSFP+ Port
Number

et-1/1/0:0

et-1/1/0:1

et-1/1/0:2

et-1/1/0:3

et-1/1/00

et-1/1/1:0

et-1/1/1:1

et-1/1/1:2

et-1/1/1:3

et-1/1/11

et-1/1/2:0

et-1/1/2:1

et-1/1/2:2

et-1/1/2:3

et-1/1/22
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Table 218: Port Numbering Table (continued)

Port Numbering in 10-Gigabit Ethernet Mode
Port Numbering in 40-Gigabit
Ethernet Mode

QSFP+ Port
Number

et-1/1/3:0

et-1/1/3:1

et-1/1/3:2

et-1/1/3:3

et-1/1/33

et-1/1/4:0

et-1/1/4:1

et-1/1/4:2

et-1/1/4:3

et-1/1/44

et-1/1/5:0

et-1/1/5:1

et-1/1/5:2

et-1/1/5:3

et-1/1/55

et-1/1/6:0

et-1/1/6:1

et-1/1/6:2

et-1/1/6:3

et-1/1/66

et-1/1/7:0

et-1/1/7:1

et-1/1/7:2

et-1/1/7:3

et-1/1/77

et-1/1/8:0

et-1/1/8:1

et-1/1/8:2

et-1/1/8:3

et-1/1/88

et-1/1/9:0

et-1/1/9:1

et-1/1/9:2

et-1/1/9:3

et-1/1/99
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Table 218: Port Numbering Table (continued)

Port Numbering in 10-Gigabit Ethernet Mode
Port Numbering in 40-Gigabit
Ethernet Mode

QSFP+ Port
Number

et-1/1/10:0

et-1/1/10:1

et-1/1/10:2

et-1/1/10:3

et-1/1/1010

et-1/1/11:0

et-1/1/11:1

et-1/1/11:2

et-1/1/11:3

et-1/1/1111

10-Gigabit Ethernet Mode

A 10-Gigabit Ethernet interface can operate in 10-Gigabit Ethernet LAN PHY framing

mode or 10-Gigabit EthernetWAN PHY framingmode.

You can configure a 10-Gigabit Ethernet interface at the [edit interface interface-name

framing-mode (lan-phy |wan-phy)] hierarchy level to operate in 10-Gigabit Ethernet LAN

PHY framingmode or in 10-Gigabit EthernetWAN PHY framingmode.

Each P2-10G-40G-QSFPP PIC provides 48 physical interfaces. The interfaces are

represented by the et-fpc/pic/QSFP+ port:channel interface naming convention, where

the value of theQSFP+ port option ranges from0 through 11 and the value of the channel

option ranges from 0 through 3.

When a P2-10G-40G-QSFPP PIC is configured in 10-Gigabit Ethernet framingmode, it

can operate in one of the following framingmodes:

• LAN PHY framingmode. Note that by default, the PIC is in 10-Gigabit Ethernet LAN

PHY framingmode.

NOTE: The ports are set to LAN PHY framingmode by default when the
framing-mode statement is not configured at the [edit interface

interface-name] hierarchy level.

• WAN PHY framingmode

40-Gigabit Ethernet Mode

Youcanconfigure twelve40-GigabitEthernet interfaces thatoperate inLANPHYframing

mode. The interfaces are represented by the et-fpc/pic/QSFP+ port interface naming

convention, where the value of theQSFP+ port option ranges from 0 through 11.
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Understanding the P2-100GE-OTN PIC

Starting with Junos OS Release 14.1R2 and 14.2, a 100-Gigabit Ethernet OTN

PIC—P2-100GE-OTN—is supported on the FPC2-PTX-P1A FPC in PTX5000 routers. The

P2-100GE-OTN PIC provides 4-port 100-Gigabit Ethernet interfaces, which are

independently configurable in LAN PHY framingmode or in optical channel transport

unit 4 (OTU4)mode. Each interface is terminated bymeans of a CFP2 transceiver. The

FPC2-PTX-P1A FPC supports two P2-100GE-OTN PICs, in which each 100-Gigabit

Ethernet port is mapped to a Packet Forwarding Engine in the FPC.

Starting fromJunosOSRelease 15.1, youcanperformthe followingon theP2-100GE-OTN

PIC on PTX5000 routers:

• You can configure the interfaces on this PIC to be a part of the mixed rates andmixed

mode aggregated Ethernet bundles.

• Port-based pseudowire class of service (CoS) classification which includes Layer 3

IPv4, IPv6, and MPLS classification for interfaces with ethernet-ccc encapsulation.

The following sections explain this PIC in detail:

• Interface Features on page 1343

• Layer 2 and Layer 3 Features on page 1345

• OTN Alarms and Defects on page 1346

• TCA Alarms on page 1346

Interface Features

The following interface features are supported on a P2-100GE-OTN PIC:

• 4-port 100-Gigabit Ethernet interfaces, which are independently configurable in LAN

PHY framingmode or in OTU4 signal mode. Each interface is terminated bymeans of

a CFP2 transceiver.

• Each port maps to a single Packet Forwarding Engine in the FPC2-PTX-P1A FPC.

• The interfaces are named with prefix et.

• Gigabit Ethernet local loopback.

• Link-level pause frames—Youcanhalt theEthernet interface fromtransmittingpackets

for a configured period of time.

• Interface hold timer and interface damping—You can set the hold-time statement (in

milliseconds) to damp interface transitions.

• External clock

• Nonstandard tag protocol identifier (TPID):

• For each 100-Gigabit Ethernet port, you can configure up to eight TPIDs by using the

tag-protocol-id statement at the [edit interfaces interface-name gigether-options

ethernet-switch-profile] hierarchy level.
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• The tag-protocol-id statement can be configured only on the first port (port 0) of

thePIC. If anyother (nonzero)port has the tag-protocol-id configuration, theRouting

Engine registers an error in the system log and the configuration is ignored.

• The tag-protocol-id statement configured on port 0 of the PIC also applies to the

rest of the ports on that PIC.

• The interface Link Down event always generates an interrupt; however, the interface

Link Up event does not generate an interrupt. Therefore, the interface link-up event is

detected during the 1-second PIC periodic polling process.

• Generic forward error correction (GFEC) (G.709) and no-FECmodes of operation.

• Diagnostics tools:

• Line loopback

• Local loopback

• Fast reroute (FRR)—Based on configurable pre-FEC, bit error rate (BER) is supported

and is configured using the ber-threshold-signal-degrade statement at the [edit

interfaces interface-name otn-options signal-degrade] hierarchy level.

• jnx-ifotn.mib and otn-mib as defined in RFC 3591. Note that according to Junos OS

security standard, configurable parameters are not supported through SNMP. Only

the get operation is available through SNMP.

• FEC statistics—corrected errors and corrected error ratio.

• OTN payload pseudorandom binary sequence (PRBS) generation and checking by

enabling or disabling PRBSwith the prbs or no-prbs statement at the [edit interfaces

interface-name otn-options] hierarchy level.

• Optical channel data unit (ODU)-level delay measurement.

• At the physical interface level, flexible-ethernet-service, ethernet-ccc, and ethernet-tcc

encapsulations are supported. For the flexible-ethernet-service encapsulation, the

logical level supports enet2, vlan-ccc, and vlan-tcc encapsulations.

• At the logical interface level, dix, vlan-ccc, and vlan-tcc encapsulations are supported.

• Interoperability between 100-Gigabit Ethernet interfaces with CFP transceiver and

100-Gigabit Ethernet interfaces with CFP2 transceiver in LAN PHY framingmode and

in OTU4mode.

The following features are not supported on the P2-100GE-OTN PIC:

• Source MAC learning for accounting

• MAC policing

• Physical interface-level encapsulations—vlan-ccc, extended-vlan-ccc, and

extended-vlan-tcc

• Logical interface-level encapsulation—vlan-vpls

• VLAN rewrite for ccc encapsulation

• Per-queue flow control
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• Generic framing procedure-framed (GFP-F) mapping modes over OTN

• General communication channel (GCC)

• OTN interface-level Automatic Protection Switching (APS)

• Insertion, monitoring, and display of OTN header overhead byte

• Black link MIB for integration with transponders

• Optical harness support

• Transport interface and state model (GR-1093)

• Trace tone support

• 15-minute and 1-day performancemonitoring counters and historic counters

Layer 2 and Layer 3 Features

The following Layer 2 and Layer 3 features are supported on the P2-100GE-OTN PIC:

• MAC detect link up and link down based on local fault signal or remote fault signal.

• MAC statistics.

• Flow control.

• MAC oversized packet counters based on default MTU value or user-configured MTU

value.

• Per-port destination address MAC filter.

• Per-port source address MAC filter.

• Per-physical interface source address MAC filter.

• Per-logical interface source address MAC accounting.

• Maximum of 1000 source MAC filter per physical interface.

• Maximum of 32,000 filter terms to share across all filter features.

• AggregatedEthernet supports64child links that canbeconfiguredusing the setchassis

aggregated-devicesmaximum-links configuration command.

• Maximum of 1024 logical interfaces on an aggregated Ethernet physical interface.

• Support for VLAN tagging, flexible VLAN tagging, and stacked VLAN tagging.

• LACP.

• Link protection.

• 802.3 ah OAM.

• 802.1 ag OAM.

• MPLS FRR.

• SNMP.

• Supports per-VLAN queuing (using Packet Forwarding Engine).
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OTNAlarms and Defects

The following OTN alarms and defects are supported on the P2-100GE-OTN PIC:

• LOS—Loss Of Signal

• LOF—Loss Of Frame

• LOM—Loss Of Multiframe

• OTU—Degrade

• OTU—AIS

• OTU—IAE

• OTU—BDI

• OTU—TTIM

• OTU—Signal Degrade

• OTU—Signal Fail

• ODU—Signal Fail

• OTU-FEC—Degrade

• OTU-FEC—Excessive errors

• ODU—Signal Degrade

• ODU—AIS

• ODU—BDI

• ODU—OCI

• ODU—LCK

• ODU—TTIM

• OPU—PTM

TCA Alarms

Threshold-crossing alarms (TCA) are alarms that are activated when a certain

configurable threshold—near-endmeasurement threshold or far-endmeasurement

threshold—is crossedand remains sountil theendof the 15minute interval for parameters

such as OTU and ODU. The following alarms are supported:

• Background block error threshold (BBE)

• Errored seconds threshold (ES)

• Severely errored seconds threshold (SES)

• Unavailable seconds threshold (UAS)
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Related
Documentation

100-Gigabit Ethernet OTN Options Configuration Overview on page 1364•

• PTX5000 PIC Description on page 1309

• PTX3000 PIC Description on page 1310

100-Gigabit DWDMOTNPICwith CFP2 (PTX Series)

• Software Release on page 1347

• Hardware Features on page 1348

• Software Features on page 1349

• Cables and Connectors on page 1350

• LEDs on page 1350

• Alarms, Errors, and Events on page 1350

Software Release

• PTX3000: Junos OS Release 15.1F6 and later

• PTX5000: Junos OS Release 15.1F6 and later

1347Copyright © 2019, Juniper Networks, Inc.

Chapter 52: Overview of Optical Interfaces, OTUs, and ODUs



Hardware Features

• Model number: PTX-5-100G-WDM

• Name in the CLI: 5X100GE DWDMCFP2-ACO

• Five 100-Gigabit DWDMOTN ports

• Power requirement (including transceiver)

• Weight: 5.2 lb (2.4 kg)

• Supports CFP2-ACO pluggable optics

• Transparent transport of a 100-Gigabit Ethernet signal with OTU4(V) framing

• ITU-standard OTN performancemonitoring and alarmmanagement

• Dual polarization-quadrature phase-shift keying (DP-QPSK)modulation

• Supports two types of forward error correction (FEC):

• Soft-decision FEC (SDFEC)

• G.709 FEC (GFEC)

• 100 channels on C-band ITU grid with 50-GHz spacing

• Latency:

• SDFEC: 14 µs (TX + RX)

• GFEC: 6 µs (TX + RX)

• Interoperable with the CFP-100GBASE-ZR transceiver supported on the 100-Gigabit

Ethernet MIC with CFP (MIC3-3D-1X100GE-CFP) on MX Series routers and the

100-Gigabit Ethernet PIC with CFP (P1-PTX-2-100GE-CFP) on PTX Series routers.

NOTE: The 5-port 100-Gigabit DWDMOTN PIC is not directly interoperable
with the 2-port 100-Gigabit DWDMOTNPIC, but they can both operate over
the same DWDM line system.

NOTE: The 5-port 100-Gigabit DWDMOTN PIC is designed to comply with
NEBSregulationsonthePTX3000andPTX5000routerswhenthese routers
are used in typical configurations.

In a typical configuration, a PTX3000 router supports up to eight FPCs, with
up to four 5-port 100-Gigabit DWDMOTN PICs installed next to any FPC.
You can install other PICs next to any other FPC.

In a typical configuration, a PTX5000 router supports up to eight FPCs, with
up to eight 5-port 100-Gigabit DWDMOTN PICs in any FPC slot. You can
install other PICs in any FPC slot.
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Software Features

Table 210 on page 1319 shows the first supported release for each software feature.

Table 219: Software Features Supported

PTX5000 First
Supported Junos OS
Release

PTX3000 First
Supported Junos OS
ReleaseSoftware Feature

15.1F615.1F6Compliant with ITU G.709 and G.798

15.1F615.1F6Provides a transport interface and state model (GR-1093)

15.1F615.1F6Performancemonitoring such as alarms, threshold-crossing alarms,
OTU/ODU error seconds and pre-FEC statistics

15.1F615.1F6SNMPmanagement of the PIC based on RFC 3591, ManagedObjects for
the Optical Interface Type

• Set functionality

• Juniper Networks Black-Link MIB

• IFOTNMIB

• Optics MIB

• FRUMIB

15.1F615.1F6IEEE 802.1ag OAM

15.1F615.1F6IEEE 802.3ah OAM

15.1F615.1F6IFINFO/IFMON

15.1F615.1F6IEEE 802.3ad link aggregation

15.1F615.1F6Pre-FEC BERmonitoring provides interrupt-driven link-signal-degrade
BER-based detection for MPLS fast reroute

15.1F615.1F6User-configurable optics options:

• TX laser enable/disable

• TX output power

• TX/RX wavelength

• RX LOSwarning/alarm thresholds

• Threshold crossing alarms (TCAs)

15.1F615.1F6User configurable card options:

• FECmode (SDFEC/GFEC)

• Differential encoding mode

• TCAs

• Proactive protection (FRR) threshold / interval
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Cables and Connectors

Fiber-optic 100-gigabit CFP2-ACO transceiver

• Connector: Duplex LC

• Model number: TCFP2-100G-C

NOTE: When inserting the CFP2 transceiver, ensure that the transceiver sits
tightly in the port. You will hear a distinct click sound when the latch locks
into the corresponding port. The latchmust be fully engaged in the
corresponding port for the CFP2 transceiver to function properly. Failing to
do so will result in loss of connection.

To verify that the CFP2 transceiver module is inserted properly, give a gentle
pull by grasping the sides of themodule. Themodule should sit tightly.

LEDs

The STATUS LED is located in the center of the PIC faceplate adjacent to the link and

activity LED for port 2. The link and activity LEDs are located between the ports and are

numbered 0 through 4. Table 220 on page 1350 describes the functions of these LEDs.

Table 220: 100-Gigabit DWDMOTN PIC with CFP2 LEDs

DescriptionStateColorLabel

PIC is initialized and online with no alarms or failures.On steadilyGreenSTATUS

PIC is online but has errors or alarms.On steadilyRed

PIC is offline or not enabled.Off–

Port is online with no alarms or failures, and the link is up.On steadilyGreenLink and
activity LED
for each port Activity is detected on the link.Blinking

Port has detected amedia alarm or failure.On steadilyRed

Port is off or not enabled.Off–

Alarms, Errors, and Events

NOTE: For OTN alarms, see Table 221 on page 1355
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Chassis and PIC:

• PIC (FRU) inserted or removed

• PIC (FRU) Administrative State: In Service, Out Of Service

• PIC (FRU) Operational State: Unequipped, Init, Normal, Mismatch, Fault, Upgrade

• Mismatch equipment

• Temperature alarm

Port (interface):

• Interface Administrative State: In Service, Out Of Service, Service MA, Out of Service

MA

• Interface Operational State: Init, Normal, Fault, Degraded

Optical channel transport unit (OTU) threshold-crossing alarms (TCAs):

• OTU-TCA-BBE—15minute background block error TCA

• OTU-TCA-ES—15minute far-end errored seconds TCA

• OTU-TCA-SES—15minute severely errored seconds TCA

• OTU-TCA-UAS—15minute unavailable seconds TCA

Optical channel data unit (ODU) TCAs:

• ODU-TCA-BBE—15minute background block error TCA

• ODU-TCA-ES—15minute far-end errored seconds TCA

• ODU-TCA-SES—15minute severely errored seconds TCA

• ODU-TCA-UAS—15minute unavailable seconds TCA

TIP: You can viewOTU and ODU TCAs using the show interfaces transport

pm otn operational-mode CLI command.

Optics-related status:

• TX output power

• TX current output power

• TX average output power over a performancemonitoring interval

• TXminimum output power over a performancemonitoring interval

• TXmaximum output power over a performancemonitoring interval

• RX current input power

• RX average input power over a performancemonitoring interval

• RXminimum input power over a performancemonitoring interval
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• RXmaximum input power over a performancemonitoring interval

• Transceiver temperature high alarm

• Transceiver temperature high warning

• Transceiver temperature low alarm

• Transceiver temperature lowwarning

• Transceiver voltage high alarm

• Transceiver voltage high warning

• Transceiver voltage low alarm

• Transceiver voltage lowwarning

• Transceiver temperature monitor A/D value

• Transceiver power supply monitor A/D value (voltage)

• TX laser current bias high alarm

• TX laser current bias high warning

• TX laser current bias low alarm

• TX laser current bias lowwarning

• TX laser temperature high alarm

• TX laser temperature high warning

• TX laser temperature low alarm

• TX laser temperature lowwarning

• TX output optical power high alarm

• TX output optical power high warning

• TX output optical power low alarm

• TX output optical power lowwarning

• TX laser TEC fault

• TX laser wavelength unlocked fault

• TXmodulator bias high alarm

• TXmodulator bias high warning

• TXmodulator bias low alarm

• TXmodulator bias lowwarning

• TX LOS fault

• TX current laser output power

• TXminimum laser output power over a performancemonitoring interval

• TX average laser output power over a performancemonitoring interval
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• TXmaximum laser output power over a performancemonitoring interval

• RX laser bias current high alarm

• RX laser bias current high warning

• RX laser bias current low alarm

• RX laser bias current lowwarning

• RX input optical power high alarm

• RX input optical power high warning

• RX input optical power low alarm

• RX input optical power lowwarning

• RX laser output high alarm

• RX laser output high warning

• RX laser output low alarm

• RX laser output lowwarning

• RX current laser output power

• RXminimum laser output power over a performancemonitoring interval

• RX average laser output power over a performancemonitoring interval

• RXmaximum laser output power over a performancemonitoring interval

• RX laser temperature high alarm

• RX laser temperature high warning

• RX laser temperature low alarm

• RX laser temperature lowwarning

• RX LOS fault

• RX LOS occurred over a performancemonitoring interval

• RX laser wavelength unlocked fault

• RX laser TEC fault

Network lane receive–related status:

• RX current chromatic dispersion

• RX average chromatic dispersion over a performancemonitoring interval

• RXminimum chromatic dispersion over a performancemonitoring interval

• RXmaximum chromatic dispersion over a performancemonitoring interval

• RX current differential group delay

• RX average differential group delay over a performancemonitoring interval

• RXminimum differential group delay over a performancemonitoring interval
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• RXmaximum differential group delay over a performancemonitoring interval

• RX current Q value

• RX average Q value over a performancemonitoring interval

• RXminimumQ value over a performancemonitoring interval

• RXmaximumQ value over a performancemonitoring interval

• RX current signal-to-noise ratio (SNR)

• RX average SNR

• RXminimum SNR

• RXmaximum SNR

• RX current carrier frequency offset

• RX average carrier frequency offset over a performancemonitoring interval

• RXminimum carrier frequency offset over a performancemonitoring interval

• RXmaximum carrier frequency offset over a performancemonitoring interval

• RXmodem sync detect fault occurred over a performancemonitoring interval

• RXmodem lock fault occurred over a performancemonitoring interval

• RX loss of alignment occurred over a performancemonitoring interval

• RX out of alignment occurred over a performancemonitoring interval

• RX deskew lock fault occurred over a performancemonitoring interval

FEC statistics:

• Corrected Errors

• UncorrectedWords

• Corrected Error Ratio

TIP: You can view FEC statistics using the show interfaces interface-name

extensive operational-mode CLI command.

Table 221 on page 1355 describes the OTN alarms and defects that can occur on the PIC

and the link status when the alarm or defect occurs.

TIP: You can viewOTN alarms and defects using the show interfaces

interface-name extensive operational-mode CLI command.
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Table 221: OTN Alarms and Defects

Link StatusDescriptionAlarmCategory

Link downLoss of signalLOSOTN

Link downLoss of frameLOF

Link downLoss of multiframeLOM

WarningWavelength lockWavelength Lock

Link down if FRR is enabledForward error correction degradedFEC Degrade
(OTU-FEC-DEG)

OTN FEC

Possible link downExcessive errors, FEC_FAIL from the
transponder

FEC Excessive
(OTU-FEC-EXE)

Link downAlarm indication signal or all ones signalOTU-AISOTNOTU

Link downBackward defect identificationOTU-BDI

WarningIncoming alignment errorOTU-IAE

Can cause link down if
otu-ttim-act-enable is configuredat
the edit interfaces interface-name
otn-options hierarchy

Destination access point identifier (DAPI),
source access point identifier (SAPI), or both
mismatch from expected to received

OTU-TTIM

WarningBackward incoming alignment errorOTU-BIAE

WarningOTU trail signal failOTU-TSF

WarningOTU server signal failOTU-SSF
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Table 221: OTN Alarms and Defects (continued)

Link StatusDescriptionAlarmCategory

Link downAlarm indication signal or all ones signalODU-AISOTNODU

Link downOpen connection errorODU-OCI

Link downODU lock triggers for pathmonitoringandTCM
levels 1 through 6

ODU-LCK

Link downBackward defect indicationODU-BDI

Can cause link down if
odu-ttim-act-enable is configured
at the [edit interfaces
interface-name otn-options]
hierarchy

DAPI or SAPI mismatch from expected to
received

ODU-TTIM

WarningIncoming alignment errorODU-IAE

WarningLoss of tandem connectionODU-LTC

WarningClient signal failureODU-CSF

WarningTrail signal failODU-TSF

WarningServer signal failODU-SSF

Link downPayload typemismatchODU-PTIM

Related
Documentation

100-Gigabit DWDMOTNMIC with CFP2 on page 1356•

• Configuring the 10-Gigabit or 100-Gigabit Ethernet DWDM InterfaceWavelength on

page 1366

100-Gigabit DWDMOTNMICwith CFP2

• Junos 15.1F5 and laterSoftware release
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• One 100-Gigabit DWDMOTN port

• Power requirements (including transceiver) at different temperatures:

• 55° C: 1.90 A@ 48 V (91W)

• 25° C: 1.73 A@ 48 V (83W)

• Weight: 2.3 lb (1.04 kg)

• Model number: MIC3-100G-DWDM

• Name in the CLI: 1X100GE DWDMCFP2-ACO

Description

• Dual-wide MIC that installs into two MIC slots

• Supports CFP2 analog coherent optics (CFP2-ACO)

• Transparent transport of a 100-Gigabit Ethernet signal with OTU4V framing

• ITU-standard OTN performancemonitoring and alarmmanagement

• Dual-polarization quadrature phase shift keying (DP-QPSK)modulation

• Supports three types of forward error correction (FEC):

• Soft-decision FEC (SD-FEC)

• High-gain FEC (HG-FEC)

• G.709 FEC (GFEC)

• 100 channels on C-band ITU grid with 50-GHz spacing

• Latency:

• SD-FEC: 14 µs (TX + RX)

• HG-FEC: 22 µs (TX + RX)

• GFEC: 6 µs (TX + RX)

• Interoperable with the CFP-100GBASE-ZR transceiver supported on the 100-Gigabit Ethernet
MICwithCFP (MIC3-3D-1X100GE-CFP) onMXSeries routers and the 100-Gigabit Ethernet PIC
with CFP (P1-PTX-2-100GE-CFP) on PTX Series routers.

NOTE: The 1-port 100-Gigabit DWDMOTNMIC is not directly interoperable with the 2-port
100-Gigabit DWDMOTN PIC (P1-PTX-2-100G-WDM), but they can both operate over the same
DWDM line system.

Hardware features
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• Compliant with ITU G.709 and G.798

• Provides a transport interface and state model (GR-1093)

• Performancemonitoring features such as alarms, threshold-crossing alarms, OTU/ODU error
seconds and FEC and bit error rate (BER) statistics

• SNMPmanagement of the MIC based on RFC 3591, Managed Objects for the Optical Interface
Type, including the following:

• Set functionality

• Black Link MIB

• IFOTNMIB

• Optics MIB

• FRUMIB

• Pre-FEC BERmonitoring provides interrupt-driven, BER-based detection of link signal
degradation for MPLS fast reroute.

• User-configurable optics options:

• Transmit (TX) laser enable and disable

• TX output power

• Wavelength

• Receive (RX) LOSwarning or alarm thresholds

• Threshold crossing alarms (TCAs)

User-configurable card options:

• FECmode (SD-FEC, HG-FEC, or GFEC)

• TCAs

Software features

Fiber-optic 100-gigabit CFP2-ACO transceiver

• Connector: Duplex LC/UPC

• Model number: TCFP2-100G-C

NOTE: When inserting the C form-factor pluggable 2 (CFP2) transceiver, ensure that the
transceiver sits tightly in the port. You hear a distinct click sound when the latch locks into the
corresponding port. The latch must be fully engaged in the corresponding port for the CFP2
transceiver to function properly. Failing to do so can result in loss of connection.

To verify that the CFP2 transceiver module is inserted properly, give a gentle pull by grasping the
sides of the module. Themodule should sit tightly.

Cables and connectors

OK/FAIL LED, one bicolor:

• Off—MIC is powered off.

• Green—MIC is initialized and online, functioning normally.

• Amber—MIC is coming online, or is in fault state.

LINK LED, one bicolor per port:

• Off—Port is offline.

• Solid green—Link is up.

• Red—Port failure is detected.

NOTE: The port is labeled Port 0.

LEDs
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NOTE: For OTN alarms, see Table 222 on page 1363.

Chassis and MIC:

• MIC (FRU) inserted or removed

• MIC (FRU) Administrative State: In Service, Out Of Service

• MIC (FRU) Operational State: Unequipped, Init, Normal, Mismatch, Fault, Upgrade

• Mismatch equipment

• Temperature alarm

Alarms, Errors, and
Events

Port (interface):

• Interface Administrative State: In Service, Out Of Service, Service MA, Out of Service MA

• Interface Operational State: Init, Normal, Fault, Degraded

Optical channel transport unit (OTU) TCAs:

• OTU-TCA-BBE—15-minute background block error TCA

• OTU-TCA-ES—15-minute far-end errored seconds TCA

• OTU-TCA-SES—15-minute severely errored seconds TCA

• OTU-TCA-UAS—15-minute unavailable seconds TCA

Optical channel data unit (ODU) TCAs:

• ODU-TCA-BBE—15-minute background block error TCA

• ODU-TCA-ES—15-minute far-end errored seconds TCA

• ODU-TCA-SES—15-minute severely errored seconds TCA

• ODU-TCA-UAS—15-minute unavailable seconds TCA

TIP: You can view OTU and ODU TCAs by using the show interfaces transport pm otn
operational-mode CLI command.
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NOTE: If you insert an invalid CFPmodule, the CLI displays unsupportedmodule and a syslog
message is generated.

Optics-related status:

• Module temperature

• Module voltage

• Module temperature alarm:

• High alarm

• Low alarm

• High warning

• Lowwarning

• Module voltage alarm:

• High alarm

• Low alarm

• High warning

• Lowwarning

• Module not ready alarm

• Module low power alarm

• Module initialization incomplete alarm

• Module fault alarm

• TX laser disabled alarm

• RX loss of signal alarm

• Modem lock state

• TX output power:

• Current TX output power

• Minimum over a performancemonitoring interval

• Maximum over a performancemonitoring interval

• Average over a performancemonitoring interval

• TX power alarm:

• High alarm

• Low alarm

• High warning

• Lowwarning

• RX input power (signal)

• RX input power (total):

• Current RX input power (total)

• Minimum over a performancemonitoring interval

• Maximum over a performancemonitoring interval

• Average over a performancemonitoring interval

• RX power alarm:

• High alarm

• Low alarm

• High warning

• Lowwarning

• RX loss of signal alarm

• Wavelength unlocked alarm
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TIP: You can viewoptics-related status by using the show interfaces transportpmopticsand show
interfaces diagnostics optics operational-mode CLI commands.

Network lane receive-related status:

• Chromatic dispersion:

• Current chromatic dispersion

• Minimum over a performancemonitoring interval

• Maximum over a performancemonitoring interval

• Average over a performancemonitoring interval

• Differential group delay:

• Current differential group delay

• Minimum over a performancemonitoring interval

• Maximum over a performancemonitoring interval

• Average over a performancemonitoring interval

• Q2-factor:

• Current Q2-factor

• Minimum over a performancemonitoring interval

• Maximum over a performancemonitoring interval

• Average over a performancemonitoring interval

• Carrier frequency offset

• Current carrier frequency offset

• Minimum over a performancemonitoring interval

• Maximum over a performancemonitoring interval

• Average over a performancemonitoring interval

• Signal-to-noise ratio (SNR)

• Current SNR

• Minimum over a performancemonitoring interval

• Maximum over a performancemonitoring interval

• Average over a performancemonitoring interval

TIP: You can view network lane receive-related status by using the show interfaces transport pm
optics operational-mode CLI command.

FEC statistics:

• Corrected Errors—the number of bits received that were in error, but corrected.

• UncorrectedWords—the number of FEC codewords received that were uncorrectable.

• Corrected Error Ratio—the number of corrected bits divided by the number of bits received

TIP: You can view FEC statistics by using the show interfaces interface-name extensive
operational-mode CLI command.

Table 222 on page 1363 describes theOTNalarms and defects that can occur on theMIC

and the link status when the alarm or defect occurs.

TIP: You can viewOTN alarms and defects by using the show interfaces

interface-name extensive operational-mode CLI command.
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Table 222: OTN Alarms and Defects

Link StatusDescriptionAlarmCategory

Link downLoss of signalLOSOTN

Link downLoss of frameLOF

Link downLoss of multiframeLOM

Link down if FRR is enabledForward error correction degradedFEC Degrade
(OTU-FEC-DEG)

OTN FEC

Possible link downThere are uncorrected words and there are
errors in the frame header

FEC Excessive
(OTU-FEC-EXE)

Link downAlarm indication signal or all ones signalOTU-AISOTNOTU

Link downBackward defect identificationOTU-BDI

WarningIncoming alignment errorOTU-IAE

Can cause the link to be down if
otu-ttim-act-enable is configured at
the [edit interfaces interface-name
otn-options]hierarchy level

Destination access point identifier (DAPI),
source access point identifier (SAPI), or both
mismatch from expected to received

OTU-TTIM

WarningBackward incoming alignment errorOTU-BIAE

WarningOTU trail signal failOTU-TSF

WarningOTU server signal failOTU-SSF
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Table 222: OTN Alarms and Defects (continued)

Link StatusDescriptionAlarmCategory

Link downAlarm indication signal or all ones signalODU-AISOTNODU

Link downOpen connection errorODU-OCI

Link downODU lock triggers for pathmonitoring andTCM
levels 1 through 6

ODU-LCK

Link downBackward defect indicationODU-BDI

Can cause the link to be down if
odu-ttim-act-enable is configuredat
the [edit interfaces interface-name
otn-options] hierarchy level

DAPI or SAPI mismatch from expected to
received

ODU-TTIM

WarningIncoming alignment errorODU-IAE

WarningLoss of tandem connectionODU-LTC

WarningClient signal failureODU-CSF

WarningTrail signal failODU-TSF

WarningServer signal failODU-SSF

Link downPayload typemismatchODU-PTIM

Related
Documentation

Configuring the 10-Gigabit or 100-Gigabit Ethernet DWDM InterfaceWavelength on

page 1366

•

100-Gigabit Ethernet OTNOptions Configuration Overview

PTX Series routers support optical transport network (OTN) interfaces, including the

100-Gigabit Ethernet DWDMOTN PIC, and support:

• Transparent transport of two 100-Gigabit Ethernet signals with Optical Channel

Transport Unit 4 (OTU4) framing

• InternationalTelecommunicationsUnion(ITU)-standardOTNperformancemonitoring

and alarmmanagement

• Dual polarization quadrature phase shift keying (DP-QPSK)modulation and

soft-decision forward error correction (SD-FEC) for long haul andmetro applications

• Pre-forward error correction (pre-FEC)-based bit error rate (BER). Fast reroute (FRR)

uses the pre-FEC BER as an indication of the condition of an OTN link
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Use the set optics-options statement at the [edit interfaces interfaceType-fpc/pic/port]

hierarchy level to configure the optics options.

You can optionally configure pre-FEC BERmonitoring as a condition for MPLS FRR.

Pre-FEC BER FRR uses pre-FEC BER as an indication of the condition of an optical

transport network (OTN) link. When the pre-FEC BER degrade threshold is reached, the

PIC stops forwarding packets to the remote interface and raises an interface alarm.

Ingress packets continue to be processed. When Pre-FEC BER FRR is used with MPLS

FRR or another link protection method, traffic is then rerouted to a different interface.

The BER threshold and duration for calculating the BER can be configured by the user.

Use the set signal-degrade statement at the [edit interfaces interfaceType-fpc/pic/port

otn-options] hierarchy level to configure the BER threshold. Use the set

signal-degrade-monitor-enablestatementat the [edit interfaces interfaceType-fpc/pic/port

otn-optionspreemptive-fast-reroute]hierarchy level to enable signal degrademonitoring.

You can optionally enable backward FRR to inject local pre-FEC status into the

transmitted OTN frames, notifying the remote interface. The remote interface then

reroutes traffic to a different interface. When you use pre-FEC BER FRR and backward

FRR, notification of signal degradation and rerouting of traffic can occur in less time than

through a Layer 3 protocol. Use the set backward-frr-enable statement at the [edit

interfaces interfaceType-fpc/pic/portotn-optionspreemptive-fast-reroute]hierarchy level.

NOTE: ThebackwardFRR featureworks only between two JuniperNetworks
100-Gbps DWDMOTN PICs.

MX2020,MX2010,MX960,MX480,andMX240routerssupportOTN interfacesonMPC5E

and MPC6E. MPC5E-100G10G and MPC5EQ-100G10G support 100-Gigabit Ethernet

OTN interfaces and 10-Gigabit Ethernet OTN interfaces onMX240, MX480, andMX960

routers.TheOTNMICMIC6-100G-CFP2onMPC6EsupportsOTNon100-GigabitEthernet

interfaces on MX2020 and MX2010 routers. OTN support on the specified MX Series

routers includes:

• InternationalTelecommunicationsUnion(ITU)-standardOTNperformancemonitoring

and alarmmanagement

• Transparent transport of two 100-Gigabit Ethernet signals with optical channel

transport unit 4 (OTU4) framing.

• Generic forward error correction (Generic FEC)

To configure the OTN options for PTX Series routers and specific MX Series routers, use

the setotn-options statementat the [edit interfaces interfaceType-fpc/pic/port]hierarchy

level.

Related
Documentation

Ethernet DWDM InterfaceWavelength Overview on page 1304•

• Attenuation and Dispersion in a Fiber-Optic Cable on PTX Series Routers Overview on

page 1304

• Understanding Pre-FEC BERMonitoring and BER Thresholds on page 1305
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• DWDMControllers Overview on page 1308

Configuring the 10-Gigabit or 100-Gigabit Ethernet DWDM InterfaceWavelength

To configure the wavelength on 10-Gigabit Ethernet or 100-Gigabit Ethernet dense

wavelength-division multiplexing (DWDM) and OTN interfaces, include thewavelength

statement at the [edit interfaces interface-name optics-options] hierarchy level:

[edit interfaces interface-name optics-options]

To display the currently tuned wavelength and frequency for the interface, use the show

interfaces interface-name operational mode command.

For interface diagnostics, issue the show interfaces diagnostics optics interface-name

operational mode command.

Table223onpage 1366showsconfigurablewavelengthsandthecorresponding frequency

for each configurable wavelength.

Table 223:Wavelength-to-Frequency Conversion Matrix

Frequency (THz)
Wavelength
(nm)Frequency (THz)

Wavelength
(nm)Frequency (THz)

Wavelength
(nm)

192.651556.15194.401542.14196.151528.38

192.601556.55194.351542.54196.101528.77

192.551556.96194.301542.94196.051529.16

192.501557.36194.251543.33196.001529.55

192.451557.77194.201543.73195.951529.94

192.401558.17194.151544.13195.901530.33

192.351558.58194.101544.53195.851530.72

192.301558.98194.051544.92195.801531.12

192.251559.39194.001545.32195.751531.51

192.201559.79193.951545.72195.701531.90

192.151560.20193.901546.12195.651532.29

192.101560.61193.851546.52195.601532.68

192.051561.01193.801546.92195.551533.07
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Table 223:Wavelength-to-Frequency Conversion Matrix (continued)

Frequency (THz)
Wavelength
(nm)Frequency (THz)

Wavelength
(nm)Frequency (THz)

Wavelength
(nm)

192.001561.42193.751547.32195.501533.47

191.951561.83193.701547.72195.451533.86

191.901562.23193.651548.11195.401534.25

191.851562.64193.601548.51195.351534.64

191.801563.05193.551548.91195.301535.04

191.751563.45193.501549.32195.251535.43

191.701563.86193.451549.72195.201535.82

191.651564.27193.401550.12195.151536.22

191.601564.68193.351550.52195.101536.61

191.551565.09193.301550.92195.051537.00

191.501565.50193.251551.32195.001537.40

191.451565.90193.201551.72194.951537.79

191.401566.31193.151552.12194.901538.19

191.351566.72193.101552.52194.851538.58

191.301567.13193.051552.93194.801538.98

191.251567.54193.001553.33194.751539.37

191.201567.95192.951553.73194.701539.77

191.151568.36192.901554.13194.651540.16

191.101568.77192.851554.54194.601540.56

192.801554.94194.551540.95

192.751555.34194.501541.35

192.701555.75194.451541.75
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Related
Documentation

• 100-Gigabit Ethernet OTN Options Configuration Overview on page 1364
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CHAPTER 53

Overview of Optical ILAs and IPLCs

• Optical ILA Hardware Component Overview on page 1369

• Optical ILA Cooling System Description on page 1370

• Optical ILA AC Power Supply Description on page 1371

• Optical ILA DC Power Supply Description on page 1372

• Optical ILA Chassis Status LEDs on page 1373

• Optical ILA Component Redundancy on page 1375

• Optical ILA Field-Replaceable Units on page 1376

• Optical ILA Management Panel on page 1377

• Optical ILA Management Port LEDs on page 1378

• Optical Inline Amplifier Description on page 1379

• Optical ILA Power Supply LEDs on page 1381

• PTX3000 IPLC Description on page 1383

• IPLC Architecture and Functional Components Overview on page 1390

• Understanding IPLC Base and Expansion Modules on page 1393

• Understanding the IPLC Configuration on page 1395

• PTX3000 IPLC LED on page 1401

• Communication of SNMP Traps Between Optical ILA and NMS Systems on page 1402

• Communication of SNMPv2 and SNMPv3 Commands over OSC Between an Optical

ILA and NMS on page 1402

• OverviewofConfiguringandManagingOptical ILAs fromConnectivityServicesDirector

Using DMI on page 1403

• IPLC Specifications on page 1405

• Understanding the Performance Monitors and TCAs for IPLCs on page 1406

Optical ILA Hardware Component Overview

Table 224 on page 1370 describes the hardware components for the optical ILA.

1369Copyright © 2019, Juniper Networks, Inc.



Table 224: Optical ILA Hardware Components

Spare Model NumberComponent

PTX-ILA-M-AC

PTX-ILA-M-DC

Chassis

FAN-ILA-SFanmodule

JPSU-150-AC-AFOPower supplies

JPSU-150-DC-AFO

Related
Documentation

Optical ILA Cooling System Description on page 1370•

• Optical ILA AC Power Supply Description on page 1371

• Optical ILA DC Power Supply Description on page 1372

• Optical ILA Chassis Status LEDs on page 1373

Optical ILA Cooling SystemDescription

The cooling system in an optical ILA consists of three 12.4W fanmodules installed in the

field-replaceable unit (FRU) panel and two counter-rotating fans housed in each of the

power supplies.

The cooling system brings air into the vents in the front panel and exhausts warmed air

through the fans. This type of airflow is known as airflow out or front-to-back airflow.

When installed, the chassis must be positioned so that the FRUs are next to the hot air

exhaust.

NOTE: Under normal operating conditions, the fanmodules operate at a
moderatespeed.Temperaturesensors in thechassismonitor the temperature
within the chassis. The system raises an alarm if a fanmodule fails or if the
ambient temperature inside the chassis rises above the acceptable range.

• Fan Modules on page 1370

FanModules

The fanmodules in an optical ILA are hot-removable and hot-insertable FRUs. These

fanmodulescanbehot-swapped—youdonotneed topoweroff theoptical ILAordisrupt

the optical ILA function to replace a fanmodule. The fanmodule slots are numbered 0

through 2 from left to right when viewing chassis from the FRU panel side (see

Figure 32 on page 1371). Figure 33 on page 1371 shows the fanmodule for the optical ILA.

The numbers are located on the top-side of the chassis.
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Figure 32: Fan Numbering

Figure 33: FanModule

NOTE: All three fanmodulesmust be installed for optimal operation of the
optical ILA. The optical ILA continues to operate for a period of time 30
secondsduringthe replacementof thefanmodulewithout thermalshutdown.

Related
Documentation

Optical ILA Hardware Component Overview on page 1369•

• Optical ILA AC Power Supply Description on page 1371

• Optical ILA DC Power Supply Description on page 1372

• Optical ILA Chassis Status LEDs on page 1373

Optical ILA AC Power Supply Description

TheACpower supplies in the optical ILA (see Figure 35 on page 1372) are hot-removable

and hot-insertable field-replaceable units (FRUs) that you can install without powering

off theoptical ILAordisrupting theoptical ILA function. Theoptical ILAhas twoACpower

supplies. Both the power supplies are initially installed at the factory. See

Figure 34 on page 1371 for the power numbering scheme, the power supply number is

located on the top-side of the chassis.

Figure 34: Power Supply Numbering
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Figure 35: AC Power Supply in an Optical ILA

3—1— Male power connectorPower cord retainer

4—2— Ejector leverHandle

Each of the 150-W power supplies has a single AC input. The power supply provides

12-VDC output with a standby voltage of 12 VDC. An optical ILA has twice the number of

power supplies needed to power all the components in the device, which is known as 1+1

redundancy. When the optical ILA has both power supplies installed and connected to

power, thedevicehas full power redundancy. If apower supply fails or is removed, another

power supply balances the electrical load without interruption.

The fans in thepower supply provide front-to-backairflow,which is also knownasairflow

out (AFO).

CAUTION: Toavoidelectrical injury, carefully follow instructions inConnecting
AC Power to an Optical ILA, Installing a Power Supply in an Optical ILA, and
Removing a Power Supply from an Optical ILA.

Related
Documentation

Optical ILA Hardware Component Overview on page 1369•

• Optical ILA Cooling System Description on page 1370

• Optical ILA DC Power Supply Description on page 1372

• Optical ILA Chassis Status LEDs on page 1373

Optical ILA DC Power Supply Description

TheDCpower supplies in the optical ILA (see Figure 36 onpage 1373) are hot-removable

and hot-insertable field-replaceable units (FRUs) that you can install without powering

off the optical ILA or disrupting the ILA function. The DC version of the optical ILA has

two DC power supplies. Both the power supplies are initially installed at the factory.
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Figure 36: DC Power Supply in an Optical ILA

3—1— Ejector leverHandle

2—DC terminal

Each of the two 150-Wpower supplies has a single DC input. The power supply provides

12 VDC output with a standby voltage of 12 VDC. An optical ILA has twice the number of

power supplies needed to power all the components in the device, which is known as 1+1

redundancy. When the optical ILA has both power supplies installed and connected to

power, the device has full power redundancy. If a power supply fails or is removed, the

other or second power supply balances the electrical load without interruption.

The fans in the power supply provide port-to-FRU airflow, which is also known as airflow

out (AFO).

CAUTION: Toavoidelectrical injury, carefully follow instructions inConnecting
DC Power to an Optical ILA, Installing a Power Supply in an Optical ILA, and
Removing a Power Supply from an Optical ILA.

NOTE: We recommend that the 48-VDC facility DC source be equippedwith
a circuit breaker rated at 10 A (–48 VDC)minimum, or as required by local
code.

Related
Documentation

Optical ILA Hardware Component Overview on page 1369•

• Optical ILA Cooling System Description on page 1370

• Optical ILA AC Power Supply Description on page 1371

• Optical ILA Chassis Status LEDs on page 1373

Optical ILA Chassis Status LEDs

The optical ILA has five status LEDs on the front panel of the chassis (see

Figure 37 on page 1374)—twoOptical Supervisory Channel status LEDs (OSCA andOSC

B), a system status LED (SYS), an alarm LED (ALM), and a power LED (PWR) The OSC

is a separate channel that carries overhead information for network management
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purposes. The OSC, which is an important section in every DWDM system, carries voice

and data between sites for monitoring and controlling specifications in the system.

Figure 37: Chassis Status LEDs on an Optical ILA

4—1— Alarm (ALM) LEDOSC B (OSC B) LED

5—2— Power (PWR) LEDOSC A (OSCA) LED

3—System status (SYS) LED

Table 225 on page 1374 describes the chassis status LEDs on an optical ILA.

Table 225: Optical ILA Chassis Status LEDs

DescriptionStateColorName

The power is off.OffUnlitOSC A status (OSCA) LED

No OSC signal is received from the
downstream device.

On steadilyRed

OSC signal received from the upstream
device indicates a fault.

On steadilyAmber

OSC signal is communicating normally.On steadilyGreen

The power is off.OffUnlitOSC B status (OSC B) LED

No OSC signal is received from the
downstream device.

On steadilyRed

OSC signal received from the upstream
device indicates a fault.

On steadilyAmber

OSC signal is communicating normally.On steadilyGreen
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Table 225: Optical ILA Chassis Status LEDs (continued)

DescriptionStateColorName

The power is off, or the optical ILA is not
connected to any power source.

OffUnlitSystem status (SYS) LED

The optical ILA software has booted.On steadilyGreen

The optical ILA is active and is
communicating with upstream and
downstream network elements.

BlinkingGreen

The optical ILA is off, or there is no alarm.OffUnlitAlarm (ALM) LED

Amajor hardware fault hasoccurred, such
as a temperature alarm or a power or
pump failure, and the unit has halted. The
CLI is still accessible.

On steadilyRed

Aminor alarm has occurred, such as a
software error.

On steadilyAmber

The optical ILA is operating properly.SolidGreen

The optical ILA is powered off or there is
no power to the device.

OffUnlitPower (PWR)

The optical ILA is powered by a single
power supply. The second power supply
is either missing or not connected to a
power source.

On steadilyAmber

The optical ILA is powered with two
redundant power supplies.

On steadilyGreen

Related
Documentation

Optical ILA Hardware Component Overview on page 1369•

• Optical ILA Cooling System Description on page 1370

• Optical ILA AC Power Supply Description on page 1371

• Optical ILA DC Power Supply Description on page 1372

Optical ILA Component Redundancy

The following hardware components provide redundancy on the optical ILAmodels:

• Cooling system—Theoptical ILAhas three fanmodules. Each fanmodule is a redundant

unit containing one fan. If a fanmodule fails and the remaining fanmodules are unable

to keep the optical ILA within the desired temperature thresholds, chassis alarms are

raised and the optical ILA can shut down.
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• Theoptical ILA shipswith twopower supplies thatprovide 1+1 redundancy. If onepower

supply fails or is removed, the secondpower supplybalances theelectrical loadwithout

interruptionandstill provides 1+1 redundancywhile the failingpower supply is replaced.

Related
Documentation

Optical ILA Field-Replaceable Units on page 1376•

• Optical ILA Management Panel on page 1377

• Optical ILA Management Port LEDs on page 1378

Optical ILA Field-Replaceable Units

Field-replaceable units (FRUs) are components that you can replace at your site. The

optical ILA FRUs are hot-removable and hot-insertable—you can remove and replace

themwithout powering off the optical ILA or disrupting the optical ILA function.

CAUTION: Replace a failed fanmodule with a new fanmodule within 30
seconds of removal to prevent chassis overheating.

Table226onpage1376 lists theFRUsfor theoptical ILAandactions to takebefore removing

them.

Table 226: Required Actions Before Removing a FRU from the Optical ILA

Required Actions Before RemovalFRU

Disconnect the AC power and remove the AC power cord or cable for the power supply unit.

Disconnect the DC power and remove the power connector.

NOTE: You need aminimum of one powered power supply for the optical ILA to operate
properly..

Power supplies (2)

None.Fanmodules (3)

See Figure 38 on page 1376 shows the FRU panel on an optical ILA.

Figure 38: Optical ILA FRU Panel

3—1— FanmodulesGrounding

4—2— Power suppliesESD point
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NOTE: If you have a Juniper Care service contract, register any addition,
change, or upgrade of hardware components at
https://www.juniper.net/customers/support/tools/updateinstallbase/. Failure

to do so can result in significant delays if you need replacement parts. This
note does not apply if you replace existing components with the same type
of component.

Related
Documentation

Optical ILA Component Redundancy on page 1375•

• Optical ILA Management Panel on page 1377

• Optical ILA Management Port LEDs on page 1378

Optical ILAManagement Panel

Theoptical ILAmanagementpanel is foundonthe frontpanel (seeFigure39onpage 1377).

Figure 39: Optical ILAManagement Panel Components

3—1— USB port (USB). Debug only.RJ-45 console port (CON) to support
RS-232 serial ports.

4—2— USB port (USB). Debug only.RJ-45 (1000BASE-T) management
Ethernet port (MGMT).

Youmanage theoptical ILAbyusing thecommand-line interface (CLI),which isaccessible

through the console and out-of-bandmanagement ports on themanagement panel. In

addition, the front panel has system status LEDs that alert you tominor or major alarms

or other issues with the amplifier. Figure 39 on page 1377 shows themanagement panel

in detail.

Youcanalsomanage theoptical ILA throughConnectivityServicesDirector (CSD),which

is a Junos Space application developed to manage the optical functionality provided by

optical ILAs and integrated photonic line cards (IPLCs) that are installed in thePTX3000

routers. CSD is managed over a data communications network (DCN). CSD presents a

topological network view in an intuitive, comprehensive, and cohesive manner that

enables you to visualize optical sites, links, and services and a site view that provides

status, configuration, alarms/faults, and performancemonitoring functionality on the

optical interfaces. By using CSD, you can perform the following tasks for an optical ILA:
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• View the optical interface specifications that are currently applied on the device, such

as wavelength and power.

• Modify the existing parameters of the optical port to suit your network needs or resolve

any alarms caused by certain interface settings.

• View the active alarms generated for the optical interface to analyze and resolve the

condition that triggered the alarm on the device.

• Configure threshold-crossing alarms (TCAs) for the optical interface.

• View the performancemonitoring details in statistical and graphical formats for the

optical interface.

Related
Documentation

Optical ILA Component Redundancy on page 1375•

• Optical ILA Field-Replaceable Units on page 1376

• Optical ILA Management Port LEDs on page 1378

Optical ILAManagement Port LEDs

There is a management port on the optical ILA, located on themanagement panel. The

port is labeledMGMT.

The management port is an Ethernet port that supports an RJ-45 connector and has

separate LEDs for status and activity. Figure 40 on page 1378 shows the location of the

LEDs.

Figure 40: Management Port LEDs on the Optical ILA

2—1— StatusLink

Table 227 on page 1378 describes the RJ-45management port LEDs.

Table 227: Optical ILA RJ-45Management Port LEDs

DescriptionStateColorLED

No link is established, there is
a fault, or the link is down.

OffUnlitLink

A link is established, and there
is link activity.

BlinkingYellow
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Table 227: Optical ILA RJ-45Management Port LEDs (continued)

DescriptionStateColorLED

Link is down.OffUnlitStatus

Link is up.

There is data activity.

On steadily

Blinking

Green

Related
Documentation

Optical ILA Component Redundancy on page 1375•

• Optical ILA Field-Replaceable Units on page 1376

• Optical ILA Management Panel on page 1377

Optical Inline Amplifier Description

The Juniper Networks Optical Inline Amplifier is a fixed stand-alone erbium-doped fiber

amplifier (EDFA) with dual AC or DC power supplies. The optical inline amplifier (ILA)

supports bidirectional optical inline amplification. The optical ILA provides periodic

amplification of a dense wavelength-division multiplexing (DWDM) signal to enable

long-distance transmission as it propagates along the fiber . The optical ILA is typically

placed between 50miles (80 km) and 62miles (100 km) apart along the length of the

fiber. The optical ILA is used in conjunction with the integrated photonic line card (IPLC)

that is installed in the Juniper Networks PTX3000Packet Transport Routers.. The optical

ILA connects to the IPLC through the LINE IN and LINE OUT LC port connectors on the

front panel. It also connects to other optical ILAs through the LC port connectors.

The optical ILA operates with redundant hot-swappable pluggable power supplies that

are either AC or DC. The optical ILA can bemanaged by using Connectivity Services

Director (CSD), or by using the CLI console commands . The optical ILA does not support

the Junos operating system (Junos OS).

Figure 41 on page 1379 shows an E-Line configuration with the optical ILA and IPLC.

Figure 41: E-Line Configuration

In this example, the optical ILA is connected to the IPLC in the PTX3000 chassis, which

is connected to compatible PICs in the same chassis through the add and drop ports.

Themultiplexed wavelengths from the IPLC are amplified and transmitted in a single

fiber toward the line (through the Line OUT port on the IPLC) which is connected to the

optical ILA (through the LINE IN port on the ILA). Based on the distance, you can have

multiple ILAs connected. In this example, there are three ILAs to enable long-distance
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transmission. The amplified signals received by the IPLC in the remote chassis, are

demultiplexed into individualwavelengths and sent to the respective add and drop ports

(which are connected to the compatible PICs/MICs) in that PTX3000 chassis.

Formore informationabout the IPLCs, see thePTX3000PacketTransportRouterHardware

Guide. For information about configuring the IPLCs, see the Integrated Photonic Line Card

(IPLC) Feature Guide.

• Front Panel on page 1380

• FRU Panel on page 1380

Front Panel

The front panel of the optical ILA contains six LC port connectors, theON/OFF button,

the console andmanagement ports, the system status LEDs, and the USB ports.

Figure 42 on page 1380 shows the front panel of the optical ILA.

Figure 42: Optical ILA Front Panel

5—1— Management (MGMT) Ethernet portStatus LEDs

6—2— Console (CON) portLC port connectors

7—3— On/off button (ON/OFF)USB (USB) port

4—USB (USB) port

FRU Panel

The field-replaceable unit (FRU) panel of the optical ILA contains the fanmodules and

power supplies for theoptical ILA. Figure43onpage 1380shows theoptical ILAFRUpanel.

Figure 43: Optical ILA FRU Panel

3—1— FanmodulesGrounding points

4—2— Power suppliesESD point

The cooling system in an optical ILA consists of three 12.4-W fanmodules. These fan

modules can be hot-swapped—you do not need to power off the optical ILA or disrupt

the functioning of the optical ILA to replace a fanmodule. The optical ILA has two 150-W
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power supplies, either AC or DC depending on your configuration. The power supplies

need to be both AC or both DC. Only one power supply is required to power the device,

while the second power supply provides redundancy.

Related
Documentation

Optical ILA Power Supply LEDs on page 1381•

Optical ILA Power Supply LEDs

Each optical ILA power supply has two LEDs on the power supply faceplate.

Figure 44onpage 1381 shows the location of the LEDs on anoptical ILAACpower supply.

Figure 45onpage 1381 shows the location of the LEDs onanoptical ILADCpower supply.

Figure 44: AC Power Supply LEDs

2—1— AC OKDCOK

Figure 45: DC Power Supply LEDs

2—1— DC IN OKDC OUTOK

UseTable228onpage 1382andTable229onpage 1382 to interpret thestateof thepower

supply LEDs.
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Table 228: Optical ILA AC Power Supply LED

DescriptionStateColorName

There is no power to any of the power supplies.OffUnlitDC OK (left side of
FRU panel)

The power supply is present and only on standbymode.Blinking (1 Hz)Green

The power supply output is on and operating correctly.On steadily

There is a power supply failure.On steadilyRed

No AC power to this power supply only.Blinking (0.5 Hz)

There is no power to any of the power supplies.OffUnlitACOK(right sideof
FRU panel)

The power supply is present and only on standbymode.On steadilyGreen

The power supply output is on and operating correctly.On steadily

There is a power supply failure.On steadilyRed

No AC power to this power supply only.Blinking (0.5 Hz)

Table 229: Optical ILA DC Power Supply LED

DescriptionStateColorName

There is no power to the power supplies.OffUnlitDC OUT OK (left
side of FRU panel)

The power supply DC output is on and operating correctly.On steadilyGreen

The power supply is present and on standbymode.Blinking ((1 Hz))

There is a power supply failure.On steadilyRed

There is no DC power to this power supply only.Blinking (0.5 Hz)

There is no power to the power supplies.OffUnlitDC INOK(right side
of the FRU panel)

The power supply is present and on standbymode.On steadilyGreen

The power supply DC output is on and operating correctly.On steadily

There is a power supply failure.On steadilyRed

There is no DC power to this power supply only.Blinking (0.5 Hz)

Related
Documentation

Optical Inline Amplifier Description on page 1379•
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PTX3000 IPLC Description

The integrated photonic line card (IPLC) basemodule (PTX-IPLC-B-32) is an integrated

optical card that provides the combined functionalities of optical multiplexing and

demultiplexing, optical amplification, optical equalization, andoptical channelmonitoring.

The IPLCmultiplexes and enables amplification of up to 32 individual wavelengths for

transmission over single-mode optical fiber (through the add anddrop ports on the front

panel). The add and drop ports on the front panel of the IPLC connect to compatible

dense wavelength-division multiplexing (DWDM) PICs or MICs. The wavelengths from

the add and drop ports on the IPLC are amplified, monitored, and controlled and then

transmitted toward toward the line direction (through the Line IN and Line OUT ports on

the front panel). In the reverse direction the received signals from the line are amplified

toenable longdistance transmissionand thendemultiplexed into individualwavelengths

and sent to the respective add and drop ports on the front panel.

The IPLC expansion module (PTX-IPLC-E-32) is an optical multiplexing and

demultiplexing card that interfaces with the IPLC basemodule to increase the add/drop

capacity of the system up to 64 channels.

In a PTX3000 chassis, you can install an IPLC in any of the FPC or PIC slots. The IPLCs

install vertically in the front of the PTX3000. Up to 16 IPLCs or 8 basemodules and 8

expansion modules are supported in a PTX3000 chassis. Each expansion module must

be connected to a basemodule. The IPLC connects directly to the integrated DWDM

PICs/MICs (for example; the P1-PTX-2-100G-WDM or PTX-5-100G-WDM) in the same

chassis, or an external chassis through the IPLC front panel add and drop ports. Also, the

IPLC can connect to another IPLC in the same chassis through the bi-directional express

ports (XPN IN and XPNOUT) to enable an optical bypass function.

The IPLC can also connect to an optical inline amplifier (ILA) in the network to enable

transmission across longer spans. See theOptical Inline Amplifier Hardware Guide for

more details about the optical ILA.

Figure 46 on page 1383 shows a point-to-point configuration for an IPLC.

Figure 46: Point-to-Point Configuration

In this example, the IPLC in the PTX3000 chassis is connected to compatible PICs in the

same chassis through the add and drop ports. The wavelengths from the add and drop

ports on the IPLC are multiplexed and then amplified, monitored, and transmitted in a

single fiber toward the line (through the Line OUT port on the IPLC) and connected to

the IPLC (through the Line IN port) in the remote PTX3000 chassis through the optical

ILA . The IPLC connects to the optical ILA through the Line IN and Line OUT ports. The

optical ILAs provide periodic amplification of the signal to enable long distance
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transmission and are typically placed between 50miles (80 km) and 62miles (100 km)

apart . The signals received by the IPLC in the remote chassis, are demultiplexed into

individual wavelengths and sent to the respective add and drop ports (which are

connected to the compatible PICs) in that PTX3000 chassis.

For information on configuring the IPLCs, see the Integrated Photonic Line Card (IPLC)

Feature Guide.

• IPLC Base Module on page 1384

• IPLC Expansion Module on page 1387

IPLC BaseModule

The IPLC basemodule provides the following optical functions:

• Multiplexing and demultiplexing of up to 32 channels spaced at 100 GHz.

• Amplification of the aggregate multiplexed wavelengths to enable long distance

transmission.

• Per channel power monitoring and control through the use of an on-board optical

channel monitor (OCM) and wavelength selective switch (WSS).

• Bypass of optical channels between pairs of IPLCs for low-cost optical networking.

Two IPLC basemodules installed in the same chassis can form an optical bypass. In

addition, addinganexpansionmodule (connected toan IPLCbasemodule)canexpand

the number of channels supported beyond the 32 channels, up to 64 channels.

• Support for the optical supervisory channel (OSC) is transmitted through an 0C-3

1510nm signal that enables the IPLC to communicate with the remote IPLC or

communicate andmanage the optical ILA.
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IPLC BaseModule Components

Figure 47: IPLC BaseModule Faceplate

Each IPLCbasemoduleweighs6.3 lb. (2.85 kg). See Figure 47 onpage 1385. The addand

drop ports are numbered 0 to 31 and the port numbers are denoted by R and L. For

example, as shown in the lowermagnified view in Figure47onpage 1385, L15 refers to the

add and drop port on the left side and R31 refers to the add and drop port on the right

side on the front panel.

The IPLC basemodule consists of these components:

• STATUS LED that displays the status of the IPLC.

• ON/OFF button that resets the IPLC.

• Line IN and LineOUT ports—An input and an output port to connect to another optical

network element. You can use these ports to connect to another IPLC or to the optical

ILA.
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• PT IN and PTOUT ports—An input and an output port to connect to an another IPLC

basemodule. Two IPLCs can be installed in the same chassis to form an optical

express-in bypass.

• XPN IN (expansion-in) and XPNOUT (expansion-out) ports—An input and an output

port to connect to an IPLC expansion module.

• ADD and DROP ports—A total of 32 pairs of ports (32 add ports and 32 drop ports) for

32 DWDM channels.

NOTE: All the ports on the IPLC use fiber-optic cables with LC connectors.

Table 230onpage 1386provides the supportedwavelength allocation on the IPLCports.

Table 230: SupportedWavelength Allocation for the IPLC BaseModule (PTX-IPLC-B-32)

Port number on the IPLC BasemoduleCentral Wavelength (nm)Frequency (THz)

01561.01192.05

11560.20192.15

21559.39192.25

31558.58192.35

41557.77192.45

51556.96192.55

61556.15192.65

71555.34192.75

81554.54192.85

91553.73192.95

101552.93193.05

111552.12193.15

121551.32193.25

131550.52193.35

141549.72193.45

151548.91193.55
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Table 230: SupportedWavelength Allocation for the IPLC BaseModule (PTX-IPLC-B-32) (continued)

161548.11193.65

171547.32193.75

181546.52193.85

191545.72193.95

201544.92194.05

211544.13194.15

221543.33194.25

231542.54194.35

241541.75194.45

251540.95194.55

261540.16194.65

271539.37194.75

281538.58194.85

291537.79194.95

301537.00195.05

311536.22195.15

IPLC ExpansionModule

The IPLC expansion module connects to the IPLC basemodule through the XPN IN and

XPNOUT ports. It provides the following optical functions:

• Increases the total optical DWDM channel capacity by 32 ports. It does not interface

directly with the network.

• Provides multiplexing and demultiplexing of up to 32 channels spaced at 100 GHz.
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IPLC Components

Figure 48: IPLC Expansion Module Faceplate

Each IPLCexpansionmoduleweighs3.3 lb. (1.49kg). SeeFigure48onpage 1388.Theadd

and drop ports are numbered 32 to 64 and the port numbers are denoted by R and L. For

example, as shown in the lowermagnified view inFigure48onpage 1388, L47 refers to the

add and drop port on the left side and R63 refers to the add and drop port on the right

side on the front panel. The IPLC expansion module consists of these components:

• STATUS LED that displays the status of the IPLC.

• XPNIN (expansion-in)andXPNOUT (expansion-out)ports—Apair of inputandoutput

ports to connect to the IPLC basemodule.

• ADD and DROP ports—A total of 32 pairs of ports (32 add ports and 32 drop ports) for

32 DWDM channels.

NOTE: All the ports on the IPLC use fiber-optic cables with LC connectors.

Table 231 on page 1389 provides the supported wavelength allocation on the ports.
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Table 231: SupportedWavelength Allocation for the IPLC Expansion Module (PTX-IPLC-E-32)

Port number on the IPLC Expansion
ModuleCentral Wavelength (nm)Frequency (THz)

321560.61192.10

331559.79192.20

341558.98192.30

351558.17192.40

361557.36192.50

371556.55192.60

381555.75192.70

391554.94192.80

401554.13192.90

411553.33193.00

421552.52193.10

431551.72193.20

441550.92193.30

451550.12193.40

461549.32193.50

471548.51193.60

481547.72193.70

491546.92193.80

501546.12193.90

511545.32194.00

521544.53194.10

531543.73194.20

541542.94194.30
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Table 231: SupportedWavelength Allocation for the IPLC Expansion Module (PTX-IPLC-E-32) (continued)

Port number on the IPLC Expansion
ModuleCentral Wavelength (nm)Frequency (THz)

551542.14194.40

561541.35194.50

571540.56194.60

581539.77194.70

591538.98194.80

601538.19194.90

611537.40195.00

621536.61195.10

631535.82195.20

Related
Documentation

IPLC Architecture and Functional Components Overview on page 1390•

• Understanding IPLC Base and Expansion Modules on page 1393

• Understanding the IPLC Configuration on page 1395

• PTX3000 IPLC LED on page 1401

IPLC Architecture and Functional Components Overview

This topic provides an operational and configuration overview of the IPLC.

• Architecture Overview on page 1390

• Functional Component Overview on page 1391

Architecture Overview

The IPLC basemodule accepts and thenmultiplexes 32 individual wavelengths

(connected through the ADD and DROP ports on the front panel) into a single fiber pair.

If you requiremore than32channels, youcanconnect theoptional IPLCexpansionmodule

to the IPLC basemodule to increase the port capacity of the node to 64 ports.

The wavelengths from the ADD and DROP ports are then amplified, monitored, and

controlled and then transmitted towards the optical network over the Line OUT port on

front panelof the IPLC basemodule. In the reverse direction, the received signals from

the optical network on the Line IN port are amplified to overcome for loss in the optical

fiber and then demultiplexed into individualwavelengths and sent to the configuredADD

and DROP ports on the front panel.
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The 32 channels provided by the IPLC basemodule are known as the odd channels. The

32 channels provided by the optional IPLC expansion module are known as the even

channels. This odd and even designation reflects the default wavelengths the channels

support.

In themultiplexing-add path, the 32 even channels from the IPLC expansionmodule are

interleaved with the 32 odd channels from the IPLC basemodule. In the

demultiplexing-drop path, the 32 even channels are separated from the odd channels

using a deinterleaver. All 64 channels go through themain common components used

for amplification and equalization. All 32 channels on the IPLC basemodule are 100GHz

spaced, per the ITU-T Grid Specifications (G.694.1). The 32 channels on the IPLC

expansion module are offset from the IPLC basemodule channels by 50 Hz.

Single Node TwoOptical Line Terminations

The IPLC architecture can also support two-line terminations on a single node. To form

asinglenode that supports two-line terminations, simply connect two IPLCbasemodules

together through the PT IN-PTOUT ports on the front panel and entering a few simple

configuration statements in the Junos OS CLI. The IPLC basemodule and the expansion

module each require a single FPC or PIC chassis slot. This minimizes slot requirements

and ensures shelf capacity is not sacrificed in single-node east-west or north-south

configurations. These minimal slot requirements are especially important if you are

configuring a single-node, two-line termination that requires 64 channels using the IPLC

expansion modules.

The IPLC basemodule supports 32 dense wavelength division multiplexing (DWDM)

channels. Using the IPLC expansion module, you can increase the number of supported

DWDM channels to 64.

Functional Component Overview

The high-level optical functional block diagram of the combined functions of both the

IPLC basemodule and the IPLC expansion module are shown in Figure 49 on page 1391.

Figure 49: Combined Functions of the IPLC Base and Expansion Modules

IPLC BaseModule Functional Components

Themain building blocks of the IPLC basemodule architecture are as follows:
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• A 2x1WSS on the add path to select wavelengths from among all channels presented

fromthe32addportsof the IPLCbasemodule (shown inblue inFigure49onpage 1391)

and from the 32 add ports on the IPLC expansion module (shown in gray in

Figure 49 on page 1391).

• A booster erbium-doped fiber amplifier (EDFA) (E1) followed by a variable optical

attenuator (VOA) tocompensate for the lossof theWSS,multiplexer, and3dBcoupler.

• A variable gain preamplifier EDFA (E2) to compensate for the loss of the preceding

fiber span.

• An optical channel monitor (OCM) with three points of observation including the

following:

• Booster EDFA (E1) output

• Preamplifier EDFA (E2) output

• The combined channels of the local add function at the input of theWSS, which

indicates which channels (both odd and even channels) are being added locally

• Anoptical supervisory channel (OSC),which communicates inbandwith the far end

IPLCmodules and is used for the analysis of the fiber span characteristics,

performancemonitoring, and IPLC fault handing. Simple topology discovery logic

communicates with the ILAs and PTX3000 nodes.

• An optical splitter is used to broadcast the received signal from the output of the

preamplifier (E2) toward both DROP and PT IN and PTOUT ports

• Four power monitors:

• AWGAdd—Monitors the input of theWSSmeasuring the total input power of the

combined channels of the local add function

• Express In—Monitors the input of theWSSmeasuring the total input power at the

input to theWSS coming from the PT IN and PTOUT express ports

• Line IN—Monitors the input at the Line IN port, for detection of the incoming line
signal optical power

• LineOUT—Monitors the output at the LineOUT port, for detection of the outgoing
line signal optical power

IPLC ExpansionModule Functional Components

The IPLC expansion module is a passive multiplexer/demultiplexer that interfaces only

with the IPLC basemodule. The IPLC expansion module receives its sole input from and

delivers its sole output to the IPLC basemodule through the PT IN and PTOUT ports. As

such, it does not interface directly with the network or the high-speed backplane of the

PTX3000 router. Figure49onpage 1391 shows themainbuildingblocks for both the IPLC

basemodule and expansion module.

Themain building blocks of the IPLC expansion module architecture are as follows:

• Add filter capable of multiplexing 32 DWDM channels of certain wavelengths
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• Drop filter capable of demultiplexing 32 DWDM channels having the same certain

wavelengths

• Demultiplexing filterwhose input (which is also thesole input to theexpansionmodule)

is monitored through a power detector. The power detector determines whether light

is present. If light is present, the power detector determines whether the light has

reached the expansionmodule through the patch cord between the IPLC basemodule

and the IPLC expansion module.

Related
Documentation

PTX3000 IPLC Description on page 1383•

• Understanding IPLC Base and Expansion Modules on page 1393

• Understanding the IPLC Configuration on page 1395

• PTX3000 IPLC LED on page 1401

Understanding IPLC Base and ExpansionModules

This topic provides an overview of the integrated photonic line card (IPLC) basemodule

and expansion module, and includes the following sections:

• Overview on page 1393

• Configuring, Managing, and Monitoring the IPLC on page 1394

• High Availability, Resiliency, and Integrity on page 1394

• Usability, Serviceability, Security and Troubleshooting on page 1394

• Usage Scenarios on page 1395

Overview

The IPLCsupportswavelengthsup to 100Gbpsandenablesad-hocallocationofnetwork

bandwidth for high-demand, real-time applications, and network services that are

deliveredoveranoptical fiber infrastructure.The IPLCbasemoduleprovides thecombined

functionality of a 32-port reconfigurable optical add-dropmultiplexer (ROADM), optical

amplification, optical equalization, and optical channel monitoring on a single card. The

IPLC basemodule also interfaces with the optional IPLC expansion module, which

increases the port capacity to 64 add-drop ports.

Figure 50: IPLC Point-to-Point Configuration

Figure 50 on page 1393 shows a typical IPLC point-to-point configuration. In this

configuration, the Line IN and Line OUT ports on the front of the IPLC basemodules are

connected to Juniper Networks’ optical inline amplifier (ILA) in the optical fiber network.
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Optical ILA nodes are typically placed into the network where the fiber length is greater

than 80—100 km.

For ring configurations or for other east-west or north-south two-line deployment

scenarios, you can connect two IPLC basemodules together to form a single-node that

consists of two 32-port ROADMs, each with its own line-side fiber span.

Configuring, Managing, andMonitoring the IPLC

You configure, manage, andmonitor IPLCmodules in a similar fashion to a standard

PTX3000Series interface, by entering aminimum set of CLI commands andmaking the

proper connections between the ports on the IPLC front panel and the PTX Series

interfaces.

SNMP

You can also use SNMP to configure the IPLC performancemonitor thresholds, and

monitor andmanage the IPLCmodules

Connectivity Services Director

Optionally, you can use the Junos Space Connectivity Services Director to configure,

manage, andmonitor the IPLC and the optical ILA.

Optical Supervisory Channel

The IPLC uses an in-band optical supervisory channel to communicate with the IPLC

expansion module, as well as with remote IPLCmodules and optical ILA nodes.

High Availability, Resiliency, and Integrity

Because the IPLCmodules do not connect to the PTX Series high-speed backplane,

upgrades to the system software and resets do not affect traffic running on the IPLC

modules. From an optical perspective, the IPLCmodules tolerate both fast and slow

changes in physical conditions. For example, if a large number of optical channels

disappear due to a fiber cut, the IPLC has sophisticated control circuitry that prevents

any errors on the remaining channels. Similarly, slow degradation of the fiber plant is

also accommodated to ensure optimal performance across the lifespan of the system.

To ensure error-free transmission across both long fiber runs and large numbers of

wavelengths on spans, the IPLC basemodule automatically controls the power of each

channel.

Usability, Serviceability, Security and Troubleshooting

Traditionally, wavelength-division multiplexing (WDM) systems and subsystems have

relied on a high degree of manual configuration and fine-tuning from expert users to

enable signals tobe transmittederror freeacross the inherently analogmediumofoptical

fiber. The IPLC automates these activities to the point that adding a wavelength is as

simple as configuring a port on the router. No optical expertise is required because the

IPLC automates the introduction, removal, and balancing of optical channels and you

simplyneed toenable the traffic-carryingportbysettingsomebasic JunosCLI commands.
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Unlike traditionalWDM systems, the IPLC and optical ILA can accommodate fiber spans

between0dBand 30dBwith a single hardware variant, simplifying network designs and

reducing spare inventory requirements.

WDMnetworks typically containmany elements and identifying underlying failure points

is often complex. With the IPLC, if at any point traffic is interrupted, the system raises a

number of alarms to notify the management and control layers of the system and also,

to help quickly and easily identify the root cause of the failure.

PerformanceMonitors

Alarms and analog performancemonitors are available to allow expert or non-expert

users easily identify and localize faults. Performancemonitors monitor analog data and

alarms enabling you to quickly view the the health of the IPLC. You can quickly and easily

configure and enable alarm thresholds at the various monitoring points on the IPLC

module.

Usage Scenarios

Optical Bypass Node Configuration

Two IPLCs can be installed in the same shelf to form an Optical Bypass. In addition,

should need arise, two Optical Passive Expansion Cards (OPECs) can be added (one

connected to each IPLC card). In the latter case, the expansion cards expand the number

of channels supported beyond the initial 32 channels.

You can also connect two IPLCmodules to form an Optical Bypass node. In this case,

the EXPRESS IN and EXPRESS OUT of one card connected to the EXPRESS OUT and

EXPRESS IN of the other card respectively.

Optical bypassesare softwareconfigurableandcontrolled through the IPLC’swavelength

selective switch (WSS) so there is no need for manual intervention. The IPLCs software

optical bypassenableswavelengths thatdonot terminateon thegivennode tobepassed

through to the remote node without optical-electrical-optical (OEO) conversion.

Related
Documentation

PTX3000 IPLC Description on page 1383•

• IPLC Architecture and Functional Components Overview on page 1390

• Understanding the IPLC Configuration on page 1395

• PTX3000 IPLC LED on page 1401

Understanding the IPLC Configuration

This topic describes the basic configuration process for the IPLCmodules and includes

the following sections:

• Understanding the Front Panel Connections on page 1396

• Slot Placement in the Chassis on page 1396
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• Understanding How to Configure the Add and Drop Ports on page 1396

• Frequency, Wavelength, and Port Default Mapping Configuration on page 1397

Understanding the Front Panel Connections

The IPLCbasemoduleandexpansionmoduleare slide-in cards that eachoccupyasingle

slot within the PTX3000 chassis. Unlike line cards, the IPLC does not connect into the

high-speed data backplane of the chassis, but rather provides the following optical

functions that you connect through the front panel:

• Line IN and Line OUT ports—An input and an output port to connect to the optical line

system, such as the optical ILA.

• PT IN and PTOUT ports—An input and an output port to connect to another IPLC base

module. You can use these ports to connect two IPLC basemodules together to form

a single-node that provides two line-side terminations.

• XPN IN and XPNOUT ports—An input and an output port to connect to an IPLC

expansion module

• ADD and DROP ports—A total of 32 pairs of ports (32 ADD ports and 32 DROP ports)

for 32 DWDM channels

The IPLCmodules are designed to connect theADD andDROPports on the front panel

to compatible 10-Gigabit or 100-Gigabit DWDM PICs in the same chassis, or to PICs

or MICs in a remote chassis.

Slot Placement in the Chassis

BEST PRACTICE: We recommend that you place the IPLCmodules into the
same FPC/PIC slot pair on the PTX3000 chassis.

The IPLC basemodule and expansion module each require a single FPC slot. This

minimizesslot requirementsandensures that shelf capacity isnot sacrificed insingle-node

east-westornorth-southconfigurations.Theseslot requirementsareespecially important

if you are configuring a single-node two-line termination that requires 64 channels by

using the IPLC expansion modules.

Understanding How to Configure the Add and Drop Ports

The IPLC supports three possible modes of operation for IPLC add and drop ports as

follows:

• blocked—(Default) If there is no explicit configuration for the IPLC wavelength, the

wavelength is in blockedmode.

• switch—Switches the specified IPLC wavelength to an optical interface on the same

or different chassis, including a remote chassis.

To switch awavelength to an optical interface on the samechassis, enter the following

in the CLI:
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user@host# set chassis fpc fpc-slot optical-options wavelength nm switch
interface-name

To switch awavelength to an optical interface on a remote chassis, enter the following

in the CLI:

user@host# set chassis fpc fpc-slot optical-options wavelength nm switch remote

• wss-express-in—Optically bypass the specified wavelength. For example to configure

wavelength 1550.12 on the IPLC in slot 1 to be bypassed:

user@host# set chassis fpc 1 optical-options wavelength 1550.12 wss-express-in

Configuring a wavelength in express-in mode is a two-step process. First, you must

define the association between the two IPLCs and then you specify the wavelength.

For example, the following configuration creates theassociationbetween the two IPLC

modules in slot 1 and slot 6:

user@host# set chassis fpc 1 optical-options express-in fpc 6

After you create the association between the two IPLCs, youmust configure the

wavelengths in express-in mode, in either one of the IPLC slots. For example:

user@host# set chassis fpc 1 optical-options wavelength nmwss-express-in
user@host# set chassis fpc 6 optical-options wavelength nmwss-express-in

Thepreceding statements configurewavelength1 andwavelength2 inexpress-inmode

for IPLCsmodules in slot 1 and slot 6.

Frequency,Wavelength, and Port Default Mapping Configuration

All port wavelength frequencies are controlled by the IPLC’s WSS and configured on a

wavelength-by-wavelengthbasis. Table232onpage 1397 lists thedefault port, frequency,

and wavelength mapping for both of the IPLCmodules.

Table 232: Default Port, Frequency, andWavelength Mapping

Label on IPLC
Expansion
Module

Presenton IPLC
Expansion
Module

Label on
IPLCModule

Present on
IPLCModule

Central Wavelength
[nm]Frequency [THz]

NoNo0Yes1561.01192.05

32YesNoNo1560.61192.1

NoNo1Yes1560.2192.15

33YesNoNo1559.79192.2

NoNo2Yes1559.39192.25
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Table 232: Default Port, Frequency, andWavelength Mapping (continued)

Label on IPLC
Expansion
Module

Presenton IPLC
Expansion
Module

Label on
IPLCModule

Present on
IPLCModule

Central Wavelength
[nm]Frequency [THz]

34YesNoNo1558.98192.3

NoNo3Yes1558.58192.35

35YesNoNo1558.17192.4

NoNo4Yes1557.77192.45

36YesNoNo1557.36192.5

NoNo5Yes1556.96192.55

37YesNoNo1556.55192.6

NoNo6Yes1556.15192.65

38YesNoNo1555.75192.7

NoNo7Yes1555.34192.75

39YesNoNo1554.94192.8

NoNo8Yes1554.54192.85

40YesNoNo1554.13192.9

NoNo9Yes1553.73192.95

41YesNoNo1553.33193

NoNo10Yes1552.93193.05

42YesNoNo1552.52193.1

NoNo11Yes1552.12193.15

43YesNoNo1551.72193.2

NoNo12Yes1551.32193.25

44YesNoNo1550.92193.3

NoNo13Yes1550.52193.35

45YesNoNo1550.12193.4

Copyright © 2019, Juniper Networks, Inc.1398

Connectivity Services Director User Guide



Table 232: Default Port, Frequency, andWavelength Mapping (continued)

Label on IPLC
Expansion
Module

Presenton IPLC
Expansion
Module

Label on
IPLCModule

Present on
IPLCModule

Central Wavelength
[nm]Frequency [THz]

NoNo14Yes1549.72193.45

46YesNoNo1549.32193.5

NoNo15Yes1548.91193.55

47YesNoNo1548.51193.6

NoNo16Yes1548.11193.65

48YesNoNo1547.72193.7

NoNo17Yes1547.32193.75

49YesNoNo1546.92193.8

18Yes1546.52193.85

50YesNoNo1546.12193.9

NoNo19Yes1545.72193.95

51YesNoNo1545.32194

NoNo20Yes1544.92194.05

52YesNoNo1544.53194.1

NoNo21Yes1544.13194.15

53YesNoNo1543.73194.2

NoNo22Yes1543.33194.25

54YesNoNo1542.94194.3

NoNo23Yes1542.54194.35

55YesNoNo1542.14194.4

NoNo24Yes1541.75194.45

56YesNoNo1541.35194.5

NoNo25Yes1540.95194.55
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Table 232: Default Port, Frequency, andWavelength Mapping (continued)

Label on IPLC
Expansion
Module

Presenton IPLC
Expansion
Module

Label on
IPLCModule

Present on
IPLCModule

Central Wavelength
[nm]Frequency [THz]

57YesNoNo1540.56194.6

NoNo26Yes1540.16194.65

58YesNoNo1539.77194.7

NoNo27Yes1539.37194.75

59YesNoNo1538.98194.8

NoNo28Yes1538.58194.85

60YesNoNo1538.19194.9

NoNo29Yes1537.79194.95

61YesNoNo1537.40195.00

NoNo30Yes1537.00195.05

62YesNoNo1536.61195.10

NoNo31Yes1536.22195.15

63YesNoNo1535.82195.20

Related
Documentation

PTX3000 IPLC Description on page 1383•

• IPLC Architecture and Functional Components Overview on page 1390

• Understanding IPLC Base and Expansion Modules on page 1393

• PTX3000 IPLC LED on page 1401

Copyright © 2019, Juniper Networks, Inc.1400

Connectivity Services Director User Guide



PTX3000 IPLC LED

Figure 51: IPLC LED

An IPLC basemodule and an IPLC expansion module each has one LED—labeled

STATUS.Table 233 on page 1401 describes the functions of the LED.

Table 233: PTX3000 IPLC LED

DescriptionStateColorLabel

IPLC is online.On steadilyGreenSTATUS

IPLC is booting.Blinking

IPLC is in a failed state.On steadilyRed

IPLC is offline.Off

Related
Documentation

PTX3000 IPLC Description on page 1383•

• IPLC Architecture and Functional Components Overview on page 1390
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• Understanding IPLC Base and Expansion Modules on page 1393

• Understanding the IPLC Configuration on page 1395

Communication of SNMP Traps Between Optical ILA and NMSSystems

SNMP traps are required to be propagated from an optical ILA to the network

management system (NMS) server such as Connectivity Services Director. Each optical

ILA needs to be able to configure trap destinations. Because an IPLC acts as a gateway,

the traps are first received by the IPLC. From the IPLC, these traps are transmitted to the

appropriate destination. The IPLCmaintains information about the trap destination

configurationper optical ILA. Theoptical ILA sends its traps to theanchor IPLCbydefault.

The following traps are available from optical ILA:

• Temperature (abnormal, clear)

• Voltage (abnormal, clear)

• Fan temperature/speed (abnormal, clear)

• Software version (abnormal, clear)

• Optical ILA communication (abnormal, clear)

• EDFA temperature

• EDFA RFL

• Pump trap

Related
Documentation

Communication of SNMPv2 and SNMPv3 Commands over OSC Between an Optical

ILA and NMS on page 1402

•

• OverviewofConfiguringandManagingOptical ILAs fromConnectivityServicesDirector

Using DMI on page 1403

• IPLC Specifications on page 1405

• Understanding the Performance Monitors and TCAs for IPLCs on page 1406

Communication of SNMPv2 and SNMPv3 Commands over OSC Between an Optical
ILA and NMS

Each Ioptical LA device has two bidirectional optical interfaces carrying the optical

supervisory channel (OSC). The OSC signal (OC3) from two OSC ports is sent to the

OSC field-programmable gate array (FPGA). The OSC FPGA creates Ethernet packets

and sends them to a BCM or internal Gigabit Ethernet interface. The OSC traffic from

two SFP 0/1 ports is multiplexed to processor Gigbait Ethernet interface (for example,

port 3). The software uses the Gigabit Ethernet interface driver to transmit and receive

OSC packets. The front panel RJ45 is also connected to the BCM switch. This interface

can also be used for management. Both OSC and front panel RJ45 can be used

simultaneously. Themanagement packets from RJ45 interface are separated fromOSC
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management packets. These can be sent over separate CPUGbE interface (for example,

port 2 of BCM switch) by maintaining port 1 and port 2 in a VLAN.

Each optical ILA is connected to other ILAs and IPLC using optical ports. There are two

optical ports for each optical ILA, designated as OSC A and OSC B. For IP connectivity

overOSC, IPLC is usedasagateway.There is nodirect IP connectivity between theoptical

ILA and external servers. The NMS server, such as Connectivity Services Director, sends

the SNMP commandsmeant for an optical ILA to the Routing Engine of the PTX3000

router, with community string indicating the destination optical ILA. Themapping of

optical ILA and SNMP community string is configured using the Junos OS CLI interface.

Related
Documentation

OverviewofConfiguringandManagingOptical ILAs fromConnectivityServicesDirector

Using DMI on page 1403

•

• IPLC Specifications on page 1405

• Understanding the Performance Monitors and TCAs for IPLCs on page 1406

OverviewofConfiguringandManagingOptical ILAsfromConnectivityServicesDirector
Using DMI

Connectivity Services Director uses the Juniper Networks Device Management Interface

(DMI) to the managed devices to collect the data. If you have a Junos Space fabric,

Connectivity Services Director balances the load of polling the managed devices across

the nodes in the fabric. Direct SNMP communication is absent between the NMS server

such as Connectivity Services Director and the optical ILA because of IPLC design.

The requirements from Connectivity Services Director are as follows:

• Connectivity ServicesDirector needs to be able to retrieve the optical ILAperformance,

fault, and image-upgrade status. In addition, Connectivity Services Director must be

able to send configuration and upgrade commands to the optical ILA. IPLC can set or

get the optical ILA configuration andmanagement parameters through SNMP (or any

other method), save them locally and expose these through the Junos OS CLI.

Connectivity Services Director is able to access these parameters through DMI.

• This implementation requires an optical ILAmanagement client in optical ILA and

optical ILAmanagementserver in IPLC.Themanagementserverqueries theparameters

periodically. Similarly, the CLI commands are used to set parameters related to optical

ILA and initiate operations such as upgrade, which are sent as SNMPmessages to the

optical ILA client.

The following are examples of various configuration settings, andSet andGet operations

required on an optical ILA.

Configuration Settings Performed Using the CLI

• Saving configuration

• Restoring configuration

• Resetting the OS
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• Starting the firmware upgrade

• Restoring EDFA defaults

• Resetting the EDFA

Set Parameters for SNMP

• Temperature threshold parameters

• Addition and deletion of SNMP users

• Mode configuration (auto or debug)

• EDFA parameters (such as mode, gain, tilt, and LOS action)

• Optical power parameters (input and output LOS thresholds, and LOS hysteresis)

• OSC parameters (enable, add or drop power value, thresholds, and LOS hysteresis)

Get Parameters for SNMP

• Optical ILA part number, serial number, and uptime

• Temperature

• Fan speed

• Firmware upgrade status

• SNMP user information

• Mode EDFA (module type, part number, working status, gain, and temperature)

• Optical power (input power and output power)

• VOA attenuation

• OSC (index)

Alarms

• Viewing active alarms

• Viewing historical alarms

Related
Documentation

Communication of SNMP Traps Between Optical ILA and NMS Systems on page 1402•

• Communication of SNMPv2 and SNMPv3 Commands over OSC Between an Optical

ILA and NMS on page 1402

• IPLC Specifications on page 1405

• Understanding the Performance Monitors and TCAs for IPLCs on page 1406
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IPLC Specifications

The IntegratedPhotonic LineCard (IPLC) is designed to be installed in aPTX3000 router

chassis. Architecturally, this card can be plugged into either the FPC or the PIC slot. For

control andmanagement purposes, the card behaves exactly similar to an FPC in the

PTX3000 router. IPLC uses the same Processor Mezzanine Board (PMB) as the PTX

Series router FPCs, although not as a daughter card. Due to mechanical and physical

considerations, the PMB is designed onto the card directly. The card supports 100G

wavelengths, and contains 32 ports on the faceplate. The IPLC uses an extension card

to support anadditional 32ports. The IPLCmightalsohaveexternalDCMs tocompensate

for incoming dispersion on 10Gwavelengths.

The IPLCalsosupportsanOSCchannel. This is an in-bandchannel used tocommunicate

with ILAs and other optical nodes in the line system that are not directly accessible over

the Data Communications Network (DCN). DCN is an ITU terminology for a device that

provides network telemetry to remote network elements for the purpose of operations

and network element management. OSC framing logic is implemented in the FPGA.

Performancemonitoring of analog data and alarms is supported.

You can set an explicit configuration to associate an IPLC with an expansion card, to

increase thenumberofports from32 to64.Youcanaddanexpansioncard to the residing

on the same chassis. There can be only one association between one IPLC and one

expansion card. For example, the IPLC in slot 0 can be associated with expansion card

in slot 2. After IPLC slot 0 is associated with expansion card in slot, you cannot create

another association between IPLC slot 0 and expansion card in slot 4. This setting is

disallowed at the CLI configuration level itself. A corresponding alarm is triggered and

an SNMP trap generated on a failure condition.

With only the specification of the configuration settings, it is not guaranteed that the

express-in association are added to an optical IPLC. Junos OS needs to validate if the

express-in port on the optical IPLChas been connected to the express-in port of the valid

IPLC’s express-in port, and the express-in ports are UP on both the IPLCs. Only after the

validation is successful, express-in ports are moved to the UP state on the optical IPLC.

A corresponding alarm is triggered and an SNMP trap is generated on a failure condition.

Related
Documentation

Communication of SNMP Traps Between Optical ILA and NMS Systems on page 1402•

• Communication of SNMPv2 and SNMPv3 Commands over OSC Between an Optical

ILA and NMS on page 1402

• OverviewofConfiguringandManagingOptical ILAs fromConnectivityServicesDirector

Using DMI on page 1403
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Understanding the PerformanceMonitors and TCAs for IPLCs

Performancemonitors enable you toexamineanddiagnose thehealth,working capacity,

operational efficiency, and the traffic-handling condition of the integrated photonic line

cards modules (IPLCs) at various points on the optical IPLC hardware. You can enable

configure threshold-crossing alarms (TCA) for the optical IPLC performancemonitors.

TCAs are alarms that are activated when a certain configurable threshold—near-end

measurement threshold or far-endmeasurement threshold—is crossed and remains so

for 15 minutes

The IPLC supports the optical performancemonitors listed in Table 234 on page 1406.

Table 234: IPLC Optical PerformanceMonitors

TCA LowTCA High24 Hr Bin15 Min BinPerformanceMonitor

YesYesYesYesOSC TX power

YesYesYesYesOSC RX power

NoNoYesYesOSC/FPGA estimated fiber loss

YesYesYesYesLine OUT VOA attenuation

YesYesYesYesEDFA Input power (for both EDFAs)

YesYesYesYesEDFA Output power (for both EDFAs)

YesYesYesYesEDFA Signal output power (for both EDFAs)

YesYesYesYesEDFA Pump current (for both EDFAs)

YesYesYesYesEDFA Pump temperature (for both EDFAs)

YesYesYesYesOCM power readings (96 channels x 1 monitoring points)

YesYesYesYesPower monitor at ADD port

YesYesYesYesPower monitor at EXPRESS IN port

Each performancemonitor supports:

• 15-minute and 24-hour binning

• Low and high threshold levels as described in Table 235 on page 1407.
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Table 235: IPLC Threshold Crossing Alert Minimum andMaximumValues

RangeMinimum/Maximum

Default and Recommended ValueGranularityDescriptionTCA

erbium-doped fiber amplifier (EDFA) Input Power (for Both EDFAs)

390/440mW

400mW

5sIngress EDFA pump AWG high TCAedfa1-awg-high-tca

5/15 mW

5mW

Ingress EDFA pump AWG low TCAedfa1-awg-low-tca

390/440mW

400mW

Ingress EDFA pump express high
TCA

edfa1-express-high-tca

5/15 mW

5mW

IngressEDFApumpexpress lowTCAedfa1-express-low-tca

10/12 dBm

11 dBm

0.5sIngress EDFA input power high TCAedfa1-in-power-high-tca

—38/—34 dBm

-35 dBm

Ingress EDFA input power low TCAedfa1-in-power-low-tca

20/21 dBm

20.5 dBm

IngressEDFAoutputpowerhighTCAedfa1-out-power-high-tca

—1/0.5 dBmIngress EDFAoutput power lowTCAedfa1-out-power-low-tca

10/300mA1sIngressEDFApumpcurrenthighTCAedfa1-pump-current-high-tca

Ingress EDFApumpcurrent lowTCAedfa1-pump-current-low-tca

20°/25° C0.1sIngress EDFA pump temperature
high TCA

edfa1-pump-temp-high-tca

IngressEDFApumptemperature low
TCA

edfa1-pump-temp-low-tca

10/12 dBm

11 dBm

0.5sIngress EDFA signal power high TCAedfa1-sig-power-high-tca

—39/—35 dBm

—36 dBm

Ingress EDFA signal power low TCA
>

edfa1-sig-power-low-tca
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Table 235: IPLC Threshold Crossing Alert Minimum andMaximumValues (continued)

RangeMinimum/Maximum

Default and Recommended ValueGranularityDescriptionTCA

erbium-doped fiber amplifier (EDFA) Input Power (for Both EDFAs)

erbium-doped fiber amplifier (EDFA) Output Power (for Both EDFAs)

390/440mW

400mW

5sEgress EDFA pump AWG high TCAedfa2-awg-high-tca

5/15 mW

5mW

Egress EDFA pump AWG low TCAedfa2-awg-low-tca

390/440mW

400mW

EgressEDFApumpexpresshighTCAedfa2-express-high-tca

5/15 mW

5mW

Egress EDFApumpexpress lowTCAedfa2-express-low-tca

10/12 dBm

11 dBm

0.5sEgress EDFA input power high TCAedfa2-in-power-high-tca

—38/—34 dBm

—35 dBm

Egress EDFA input power low TCAedfa2-in-power-low-tca

20/21 dBm

20.5 dBm

EgressEDFAoutputpower highTCAedfa2-out-power-high-tca

—1/0.5 dBm

—0.5 dBm

Egress EDFA output power low TCAedfa2-out-power-low-tca

10/300mA1sEgressEDFApumpcurrent highTCAedfa2-pump-current-high-tca

Egress EDFA pump current low TCAedfa2-pump-current-low-tca

20°/25° C0.1sEgressEDFApumptemperaturehigh
TCA

edfa2-pump-temp-high-tca

EgressEDFApumptemperature low
TCA

edfa2-pump-temp-low-tca
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Table 235: IPLC Threshold Crossing Alert Minimum andMaximumValues (continued)

RangeMinimum/Maximum

Default and Recommended ValueGranularityDescriptionTCA

erbium-doped fiber amplifier (EDFA) Input Power (for Both EDFAs)

10/12 dBm

11 dBm

0.5sEgress EDFA signal power high TCAedfa2-sig-power-high-tca

—39/—35 dBm

—36 dBm

Egress EDFA signal power low TCAedfa2-sig-power-low-tca

Line OUT Variable Optical Attenuation (VOA)

16/25 dBm

17 dBm

0.5LOUT VOA high TCAlout-voa-high-tca

N/AN/ALOUT VOA low TCAlout-voa-low-tca

Optical Channel Monitor (OCM) Power Readings (96 channels x 1 Monitoring Points)

1/2 dBm per channel

1.5 dBm per channel

NOTE: Assumes VOA setting =0

0.5 dBmOCM Power Line Out high TCAocm-power-high-line-out-tca

—2/—1 dBm per channel

—1.5 dBm per channel

NOTE: Assumes VOA setting =0

OCM Power Line Out low TCAocm-power-low-line-out-tca

Optical Supervisory Channel (OSC) Estimated Fiber Loss

36/39 dB

37 dB

0.5 dBOSC fiber loss high TCAosc-fiber-loss-high-tca

N/AN/AOSC fiber loss low TCAosc-fiber-loss-low-tca

Optical Supervisory Channel (OSC) RX Power

5/7 dBm

6 dBm

0.5 dBmOSC RX power high TCAosc-rx-power-high-tca

—47/—46 dBm

—46 dBm

OSC RX power low TCAosc-rx-power-low-tca
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Table 235: IPLC Threshold Crossing Alert Minimum andMaximumValues (continued)

RangeMinimum/Maximum

Default and Recommended ValueGranularityDescriptionTCA

erbium-doped fiber amplifier (EDFA) Input Power (for Both EDFAs)

Optical Supervisory Channel (OSC) TX Power

5.5/7 dBm

6 dBm

0.5 dBmOSC TX power high TCAosc-tx-power-high-tca

—2/-0.5 dBm

—1 dBm

OSC TX power low TCAosc-tx-power-low-tca

Related
Documentation

• Communication of SNMP Traps Between Optical ILA and NMS Systems on page 1402

• Communication of SNMPv2 and SNMPv3 Commands over OSC Between an Optical

ILA and NMS on page 1402

• OverviewofConfiguringandManagingOptical ILAs fromConnectivityServicesDirector

Using DMI on page 1403
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CHAPTER 54

Configuring and Monitoring Optical
Interfaces, OTUs, and ODUs

• Viewing a Graphical Image of the Optical Interface Components on page 1411

• Configuring and Managing OTN Port Details of MX Series and PTX Series Routers for

Easy Administration on page 1421

• Configuring and Managing OTU Details of MX Series and PTX Series Routers for

Simplified Management on page 1429

• Configuring and Managing ODU Details of MX Series and PTX Series Routers for

Simplified Management on page 1435

• Configuring and Managing Optical PIC Details for Effective Provisioning on page 1438

• Configuring Threshold-Crossing Alarms for OTN Ports for Monitoring Link

Performance on page 1440

• Configuring Threshold-Crossing Alarms for OTUs for Monitoring Link

Performance on page 1442

• Configuring Threshold-Crossing Alarms for ODUs for Monitoring Link

Performance on page 1444

• Viewing Performance Monitoring Details of OTN Ports for Detecting and Diagnosing

Faults on page 1446

• Viewing Performance Monitoring Details of OTUs for Detecting and Diagnosing

Faults on page 1452

• Viewing Performance Monitoring Details of ODUs for Detecting and Diagnosing

Faults on page 1457

• Viewing a Graphical Image of the Chassis of PTX Series Routers on page 1461

• Diagnosing, Examining, and Correcting Optical Interface Problems on page 1466

• Changing Alarm Settings for the Optics and OTN Interfaces on page 1470

Viewing a Graphical Image of the Optical Interface Components

The Chassis View provides a pictorial representation of the optical interface, optical

channel data unit (ODU), optical channel transport unit (ODU) of anMXSeries and PTX

Series router, and themodules or components that are installed in it, such as the line

cards, interfaces, and other hardware elements.
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The purpose of this view is to try and provide a comprehensive monitoring view of the

health and status of deployed devices across the network. In this view all the managed

devices are shown with their appropriate status and health based on the services and

device settingsapplied. This viewhelps theoperator to knowthehealthandstatusacross

the network, it provides with the operator to quickly see the macro level information,

whichallows theoperator to furtheranalyze the informationprovidedandquicklynavigate

to individual devices and take any further corrective measure required. It provides a

cohesive tool for the operator to quickly see the micro-level information and take any

further remediation action required.

To view a graphical image of the optical interfaces, OTUs, and ODUs of MX Series and

PTX Series routers, and its associated components:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Click a particular component or interface to display the associated details in the lower

portionof thepage.TheRotateandPerspectivebuttonsenable you toview the images

in required orientation.

6. Click the View Back (arrows in a square symbol) icon to cause the device image to

rotate along the x-axis and display the rear view of the device. Alternatively, click the

View Front icon to view the front plane of the device. The View Back and View Front

icons are toggle options.

7. Click the Perspective (cube symbol) icon to display the device image in

three-dimensional format. It is a toggle button, which causes the device image to be

shown in either three-dimensional or one-dimensional format.

8. Select the level ofmagnification of the imageby clicking theZoom(magnifying glass)

icon. The image is expanded and displayed.
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Alternatively, use the slider control beneath the Zoom icon to change the level of

magnification.

9. Click the home icon to return to the front view of the chassis.

The selected interface is surrounded with a colored outline based on the operational

status. An interface that is operationally up is denoted in green and an interface that

is operationally down is represented in red. The components are depicted as small

colored icons at the top-left corner of the front view of the equipment image.

You canmouse over the different parts of the graphical image of the device , such as the

interfaces, line cards, and slots. When youmouse over the different modules, their

corresponding details are displayed as tooltips. On clicking the device components, the

corresponding description for the selected component is displayed by default in the

Component Info pane and the Equipment tab.

• Manufacturer—Name of the company that built and shipped the device.

• Part number—Part number of the chassis component.

• Serial number—Serial number of the chassis component. The serial number of the

backplane is also the serial number of the router or switch chassis. Use this serial

number when you need to contact Juniper Networks Customer Support about the

router or switch chassis.

When you select any physical interface configured on the DPCs or PICs or MICs

provisioned, the following fields are displayed for the corresponding component for each

interface. The interface is surrounded by a colored box to show the Operational Status.

The Component Info pane and the Active Alarmsmonitor are displayed in the lower

portion of the page.

The Active Alarmsmonitor shows any active alarm that has not yet been cleared. You

canview thealarmname, theunique identifier assigned to thealarm, theperson towhich

the alarm is assigned for corrective action, and the severity of the alarm. Click the Launch

AlarmMgmt icon (right upward-slanting arrow enclosed in a square) to navigate to the

Fault mode and view the four standard alarmmonitors available in Fault mode.

Active Alarms for the respective components are displayed when the component is

clicked in the image of the chassis displayed. The components for which the alarms are

displayedare FlexiblePortConcentrator (FPC),DensePortConcentrator (DPC), Physical

Interface Card (PIC), Modular Interface Card (MIC), Routing Engine, Control Boards, fan

trays, Switch Interface Board (SIB), and power supply module (PSM).

The following fields are displayed in the Active Alarms pane:
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Table 236: Active AlarmsMonitor

DescriptionTable Column

The severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is necessary.

• Major—Amajor error has occurred; escalate or notify as necessary.

• Minor—Aminor error has occurred; notify or monitor the condition.

• Info—An informational message; no action is necessary.

Severity

The alarm name.Name

The IPaddressof thedeviceornetworkelement thatgenerated thealarm.TheSNMP
agent is located at the source IP. In most cases, the source IP is the IP address of the
switch or controller.

Source

The date and time that the information for the alarmwas last modified.Last Updated

The following fields are displayed in the Component Info pane:

Table 237: Fields for Physical Interfaces in the Component Info Pane

DescriptionField

Hostname of the deviceHost Name

Name of the physical interfacePhysical Interface Name

IP address configured on the interfaceIP Address

Encapsulation configured on the logical interfaceEncapsulation

MAC address configured on the interfaceHardware Address

Operational status of the physical interface: Up, Down.Operation Status

Administrative state of the interface: Enabled or Disabled. If the
interface is disabled, it can provide network connectivity, but it
cannot provide power to connected devices.

Admin Status

Encapsulation type configured on the interfaceLink Level Type

Data transmission typeLink Type

Speed at which the interface is runningSpeed

Maximum transmission unit size on the physical interfaceMTU

Specifies whether the loopback status is enabled or disabled. If
loopback is enabled, the type of loopback—Local or Remote—is
displayed.

Loopback
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Table 237: Fields for Physical Interfaces in the Component Info Pane (continued)

DescriptionField

Configured textual description of the interfaceDescription

A redundant Ethernet interface is a pseudointerface that includes at minimum one

physical interface from each node of the cluster. A redundant Ethernet interface must

contain, at minimum, a pair of Fast Ethernet interfaces or a pair of Gigabit Ethernet

interfaces that are referred to as child interfaces of the redundant Ethernet interface (the

redundant parent). If two or more child interfaces from each node are assigned to the

redundant Ethernet interface, a redundant Ethernet interface link aggregation group

must be formed.

A pseudowire subscriber logical interface terminates an MPLS pseudowire tunnel from

an access node to theMXSeries router that hosts subscribermanagement, and enables

you toperformsubscribermanagementservicesat the interface.Subscribermanagement

supports the creation of subscriber interfaces over point-to-point MPLS pseudowires.

The pseudowire subscriber interface capability enables service providers to extend an

MPLSdomain fromtheaccess-aggregationnetwork to theserviceedge,where subscriber

management is performed. Service providers can take advantage of MPLS capabilities

such as failover, rerouting, and uniformMPLS label provisioning, while using a single

pseudowire to service a large number of DHCP and PPPoE subscribers in the service

network.

NOTE: The pseudowire is a tunnel that is either anMPLS-based Layer 2 VPN
or Layer 2 circuit. The pseudowire tunnel transports Ethernet encapsulated
traffic from an access node (for example, a DSLAM or other aggregation
device) to the MX Series router that hosts the subscriber management
services. The termination of the pseudowire tunnel on the MX Series router
is similar to a physical Ethernet termination, and is the point at which
subscriber management functions are performed. A service provider can
configuremultiple pseudowires on a per-DSLAM basis and then provision
support for a large number of subscribers on a specific pseudowire. Figure 1
shows anMPLS network that provides subscriber management support.

The following table describes the fields displayed in the Pseudo Interfaces pane.

Table 238: Pseudo Interfaces Columns

DescriptionField

Name of the pseudowire subscriber logical interface.Pseudo Interface Name

Signaling type for the pseudowire interface. You can use either Layer
2 circuit signaling or Layer 2 VPN signaling. The two signaling types are
mutually exclusive for a given pseudowire.

Type

Operational status of the physical interface: Up, Down.Operation Status
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Table 238: Pseudo Interfaces Columns (continued)

DescriptionField

Administrative state of the interface: Enabled or Disabled. If the
interface is disabled, it can provide network connectivity, but it cannot
provide power to connected devices.

Admin Status

The logical interfaces configuredoneach interfacearealso shownalongwith thephysical

interfacedescription in tabular format. The following tabledescribes thedetails displayed

for logical interfaces.

Table 239: Logical Interfaces Columns

DescriptionField

The device configuration name.Device Name

Standard information about the interface, in the format
type-/fpc/pic/port/logical interface,where type is themedia type that
identifies the network device; for example, ge-0/0/6.135.

Interface Name

The IP address for the logical interface.IP Address

The encapsulation type used on the logical interface.Encapsulation

The VLAN ID for the logical interface.Vlan

An optional description configured for the interface. It can be any text
string of 512 or fewer characters. Any longer string is truncated. If there
is no information, the column entry is blank.

Description

From the Chassis Viewwindow, click theDetails icon (arrow enclosed in a square) at the

top-right corner of the window to open the Chassis View Details page that lists the

configured devices and their parameters in the form of a table.

The following fields are displayed on the right pane, depending on the component or

element of the chassis you selected from the chassis image displayed.

Table 240: Fields in the Chassis View Details Page

DescriptionField

Name of the SDG and the platform type, such as MX240 or MX480. Click the plus
sign (+) toexpand the tree todisplay thecomponentsof thedevice, suchaschassis,
PIC, CPU, and PIC parameters. Information about the chassis, midplane, craft
interface (FPM), power midplane (PMP), Power Supply Modules (PSMs), Power
Distribution Modules (PDMs), Routing Engines, Control Boards (CBs) and Switch
Processor Mezzanine Boards (SPMBs), Switch Fabric Boards (SFBs), Flexible PIC
Concentrators (FPCs), PICs, adapter cards (ADCs) and fan trays is displayed.

Module

Model number of the FRU hardware component.Model
Number
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Table 240: Fields in the Chassis View Details Page (continued)

DescriptionField

Model of the FRU component.Model

Part number of the chassis component.Part
Number

Serial number of the chassis component. The serial number of the backplane is
also the serial number of the router chassis. Use this serial number when you need
to contact Juniper Networks Customer Support about the router or switch chassis.

Serial
Number
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Table 240: Fields in the Chassis View Details Page (continued)

DescriptionField

Description
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Table 240: Fields in the Chassis View Details Page (continued)

DescriptionField

Brief description of the hardware item:

• Type of power supply.

• Type of PIC. If the PIC type is not supported on the current software release, the
output states Hardware Not Supported.

• Type of FPC: FPC Type 1, FPC Type 2, FPC Type 3, FPC Type 4 , or FPC TypeOC192.

On EX Series switches, a brief description of the FPC.

On the JSeries routers, theFPCtypecorresponds to thePhysical InterfaceModule
(PIM). The following list shows the PIM abbreviation in the output and the
corresponding PIM name.

• 2x FE—Either two built-in Fast Ethernet interfaces (fixed PIM) or dual-port
Fast Ethernet PIM

• 4x FE—4-port Fast Ethernet ePIM

• 1x GE Copper—Copper Gigabit Ethernet ePIM (one 10-Mbps, 100-Mbps, or
1000-Mbps port)

• 1x GE SFP—SFP Gigabit Ethernet ePIM (one fiber port)

• 4x GE Base PIC—Four built-in Gigabit Ethernet ports on a J4350 or J6350
chassis (fixed PIM)

• 2x Serial—Dual-port serial PIM

• 2x T1—Dual-port T1 PIM

• 2x E1—Dual-port E1 PIM

• 2x CT1E1—Dual-port channelized T1/E1 PIM

• 1x T3—T3 PIM (one port)

• 1x E3—E3 PIM (one port)

• 4x BRI S/T—4-port ISDN BRI S/T PIM

• 4x BRI U—4-port ISDN BRI U PIM

• 1x ADSL Annex A—ADSL 2/2+ Annex A PIM (one port, for POTS)

• 1x ADSL Annex B—ADSL 2/2+ Annex B PIM (one port, for ISDN)

• 2x SHDSL (ATM)—G SHDSL PIM (2-port two-wire module or 1-port four-wire
module)

• 1x TGM550—TGM550 Telephony Gateway Module (Avaya VoIP gateway
modulewith one console port, two analog LINE ports, and two analog TRUNK
ports)

• 1x DS1 TIM510—TIM510 E1/T1 Telephony Interface Module (Avaya VoIPmedia
module with one E1 or T1 trunk termination port and ISDN PRI backup)

• 4x FXS, 4xFX0, TIM514—TIM514 Analog Telephony Interface Module (Avaya
VoIPmediamodulewith four analog LINEports and four analogTRUNKports)

• 4x BRI TIM521—TIM521 BRI Telephony Interface Module (Avaya VoIPmedia
module with four ISDN BRI ports)

• Crypto Accelerator Module—For enhanced performance of cryptographic
algorithms used in IP Security (IPsec) services

• MPCM 16x 10GE—16-port 10-Gigabit Module Port Concentrator that supports
SFP+ optical transceivers. (Not on EX Series switches.)

• For hosts, the Routing Engine type.

• For small form-factor pluggable transceiver (SFP) modules, the type of fiber:
LX, SX, LH, or T.

• LCD description for EX Series switches (except EX2200 switches).
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Table 240: Fields in the Chassis View Details Page (continued)

DescriptionField

MPC2—1-port MPC2 that supports two separate slots for MICs.•

• MPC3E—1-port MPC3E that supports two separate slots for MICs
(MIC-3D-1X100GE-CFPandMIC-3D-20GE-SFP)onMX960,MX480,andMX240
routers. The MPC3Emaps one MIC to one PIC (1 MIC, 1 PIC), which differs from
themapping of legacy MPCs.

• 100GBASE-LR4, pluggable CFP optics

• Supports the Enhanced MX Switch Control Board with fabric redundancy and
existing SCBs without fabric redundancy.

• Interoperates with existing MX Series line cards, including Flexible Port
Concentrators (FPC), Dense Port Concentrators (DPCs), and Modular Port
Concentrators (MPCs).

• MPC4E—Fixed configuration MPC4E that is available in two flavors:
MPC4E-3D-32XGE-SFPP and MPC4E-3D-2CGE-8XGE on MX2020, MX960,
MX480, and MX240 routers.

• LCD description for MX Series routers

Click the Apply Configlet button (pencil icon displayed beside the button) and use the

links shownon thecomponents inChassisView toselect thecontextandapply configlets.

Related
Documentation

Deleting Devices from Chassis View on page 1267•

• Rebooting Devices After Examining the Status in Chassis View on page 1268

• About Chassis View on page 1257
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Configuring andManaging OTN Port Details of MX Series and PTX Series Routers for
Easy Administration

Instead of using Junos OS CLI statements and operational commands to configure the

OTN port settings and view the configured parameters, you can view an image of the

OTN port using Connectivity Services Director to obtain an intuitive and high-level

understanding of the settings and alarms. This view enables you tomodify the OTN port

settings to suit your network deployment needs in a simplified and optimal manner.

Because the important OTN port settings can be configured alongside the visual

representation of the entire chassis that is displayed, this method of managing the OTN

port settings provides a consolidated and cohesive interface for easy administration of

the network.

You can perform the following tasks in this dialog box:

• View the optical interface specifications that are currently applied on the device, such

as wavelength and power

• Modify the existing parameters of the optical port to suit your network needs or resolve

any alarms caused by certain interface settings

To configure the full C-band International Telecommunication Union (ITU)-Grid tunable

optics for 10-Gigabit Ethernet or 100-Gigabit Ethernet dense wavelength- division

multiplexing (DWDM) interfaces:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An imageof the deviceandassociated hardware components is displayed on the right

pane.

5. In the imageof thedevice, select anOTNport or interface—for example, a 100-Gigabit

Ethernet OTN PIC installed in a PTX Series router.

TheOpticalPortdialogbox isdisplayed.At the lowerpart of thedialogbox, theOptical

Port Section pane is expanded and displayed.
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6. Click the Status/Config tab at the bottom of the dialog box.

The configuration settings that pertain to the optical interface are displayed.

7. In the Port State section, do the following:

a. The OperStatus field displays the operational status of the optical interface.

Possible values are Fault or Normal.

b. From the AdminState list, specify the administrative status of the interface as

enabled or disabled, and click Update at the top of the dialog box to save the

changes. Possible values are:

• IS—In-service with masked alarms disabled

• IS-MA—In-service with masked alarms enabled

• OOS—Out-of-service with masked alarms disabled

• OOS-MA—Out-of-service with masked alarms enabled

c. The Status field displays any of the following values:

• LOS (loss of signal)

• LOF (loss of frame)

• LOM (loss of multiframe)

• SSF (server signal failure)

• TSF (trail signal fail)

8. In the Loopbacks section, do the following:

a. From the Line Loopback list, specify whether line-loopback needs to be enabled

or disabled, and click Update at the top of the dialog box to save the changes.

When configured in line loopback mode, the router never receives data from the

network. A line loopback places an interface in external loopback state.

Instead of transmitting the signal toward the far-end device, the line loopback

sends the signal back to the originating router. If the originating router receives

back its own data link layer packets, you have verified that the problem is beyond

the originating router. Next, configure a line loopback farther away from the local

router. If this originating router does not receive its own data link layer packets, you

can assume the problem is on one of the segments between the local router and

the remote router’s interface card. In this case, the next troubleshooting step is to

configurea line loopback closer to the local router to find the sourceof theproblem.

b. From the Local Loopback list, specifywhether local-loopback needs tobe enabled

or disabled, and click Update at the top of the dialog box to save the changes.

When you create a local loopback, you create an internal loop on the interface

being tested. A local loopback loops the traffic internally on that PIC. A local

loopback tests the interconnection of the PIC but does not test the transmit and

receive ports. A local loopback enables you to configure a loop without physically

connecting the transmit port to the receive port.
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Local loopback is useful for troubleshooting physical PIC errors. Configuring local

loopback on an interface allows transmission of packets to the channel service

unit (CSU) and then to the circuit toward the far-end device. The interface receives

its own transmission, which includes data and timing information, on the local

router's PIC. The data received from the CSU is ignored

9. In the Config section, do the following:

a. From the Laser Enable field, specify whether the laser on the OTN interface must

be enabled or disabled, and click Update at the top of the dialog box to save the

changes.

b. The laser is disabledbydefault for allOTN interfaces. TheModulation fielddisplays

the type of modulation as Dual polarization quadrature phase shift keying

(DP-QPSK)modulation.

c. From theWavelength list, select the wavelength value, which can be one of the

following, and click Update at the top of the dialog box to save the changes. All

values are displayed. However, if you configure a value that is not supported by

thedevice, anerrormessage isdisplayedand thedevice is not tuned to thespecified

wavelength.

• 1528.38—1528.38 nanometers (nm), corresponds to a 50-GHz grid

• 1528.77—1528.77 nm, corresponds to 50-GHz and 100-GHz grids

• 1529.16—1529.16 nm, corresponds to a 50-GHz grid

• 1529.55—1529.55 nm, corresponds to 50-GHz and 100-GHz grids

• 1529.94—1529.94 nm, corresponds to a 50-GHz grid

• 1530.33—1530.33 nm, corresponds to 50-GHz and 100-GHz grids

• 1530.72—1530.72 nm, corresponds to a 50-GHz grid

• 1531.12—1531.12 nm, corresponds to 50-GHz and 100-GHz grids

• 1531.51—1531.51 nm, corresponds to a 50-GHz grid

• 1531.90—1531.90 nm, corresponds to 50-GHz and 100-GHz grids

• 1532.29—1532.29 nm, corresponds to a 50-GHz grid

• 1532.68—1532.68 nm, corresponds to 50-GHz and 100-GHz grids

• 1533.07—1533.07 nm, corresponds to a 50-GHz grid

• 1533.47—1533.47 nm, corresponds to 50-GHz and 100-GHz grids

• 1533.86—1533.86 nm, corresponds to a 50-GHz grid

• 1534.25—1534.25 nm, corresponds to 50-GHz and 100-GHz grids

• 1534.64—1534.64 nm, corresponds to a 50-GHz grid

• 1535.04—1535.04 nm, corresponds to 50-GHz and 100-GHz grids

• 1535.43—1535.43 nm, corresponds to a 50-GHz grid

• 1535.82—1535.82 nm, corresponds to 50-GHz and 100-GHz grids
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• 1536.22—1536.22 nm, corresponds to a 50-GHz grid

• 1536.61—1536.61 nm, corresponds to 50-GHz and 100-GHz grids

• 1537.00—1537.00 nm, corresponds to a 50-GHz grid

• 1537.40—1537.40 nm, corresponds to 50-GHz and 100-GHz grids

• 1537.79—1537.79 nm, corresponds to a 50-GHz grid

• 1538.19—1538.19 nm, corresponds to 50-GHz and 100-GHz grids

• 1538.58—1538.58 nm, corresponds to a 50-GHz grid

• 1538.98—1538.98 nm, corresponds to 50-GHz and 100-GHz grids

• 1539.37—1539.37 nm, corresponds to a 50-GHz grid

• 1539.77—1539.77 nm, corresponds to 50-GHz and 100-GHz grids

• 1540.16—1540.16 nm, corresponds to a 50-GHz grid

• 1540.56—1540.56 nm, corresponds to 50-GHz and 100-GHz grids

• 1540.95—1540.95 nm, corresponds to a 50-GHz grid

• 1541.35—1541.35 nm, corresponds to 50-GHz and 100-GHz grids

• 1541.75—1541.75 nm, corresponds to a 50-GHz grid

• 1542.14—1542.14 nm, corresponds to 50-GHz and 100-GHz grids

• 1542.54—1542.54 nm, corresponds to a 50-GHz grid

• 1542.94—1542.94 nm, corresponds to 50-GHz and 100-GHz grids

• 1543.33—1543.33 nm, corresponds to a 50-GHz grid

• 1543.73—1543.73 nm, corresponds to 50-GHz and 100-GHz grids

• 1544.13—1544.13 nm, corresponds to a 50-GHz grid

• 1544.53—1544.53 nm, corresponds to 50-GHz and 100-GHz grids

• 1544.92—1544.92 nm, corresponds to a 50-GHz grid

• 1545.32—1545.32 nm, corresponds to 50-GHz and 100-GHz grids

• 1545.72—1545.72 nm, corresponds to a 50-GHz grid

• 1546.12—1546.12 nm, corresponds to 50-GHz and 100-GHz grids

• 1546.52—1546.52 nm, corresponds to a 50-GHz grid

• 1546.92—1546.92 nm, corresponds to 50-GHz and 100-GHz grids

• 1547.32—1547.32 nm, corresponds to a 50-GHz grid

• 1547.72—1547.72 nm, corresponds to 50-GHz and 100-GHz grids

• 1548.11—1548.11 nm, corresponds to a 50-GHz grid

• 1548.51—1548.51 nm, corresponds to 50-GHz and 100-GHz grids

• 1548.91—1548.91 nm, corresponds to a 50-GHz grid
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• 1549.32—1549.32 nm, corresponds to 50-GHz and 100-GHz grids

• 1549.72—1549.72 nm, corresponds to a 50-GHz grid

• 1550.12—1550.12 nm, corresponds to 50-GHz and 100-GHz grids

• 1550.52—1550.52 nm, corresponds to a 50-GHz grid

• 1550.92—1550.92 nm, corresponds to 50-GHz and 100-GHz grids

• 1551.32—1551.32 nm, corresponds to a 50-GHz grid

• 1551.72—1551.72 nm, corresponds to 50-GHz and 100-GHz grids

• 1552.12—1552.12 nm, corresponds to a 50-GHz grid

• 1552.52—1552.52 nm, corresponds to 50-GHz and 100-GHz grids

• 1552.93—1552.93 nm, corresponds to a 50-GHz grid

• 1553.33—1554.33 nm, corresponds to 50-GHz and 100-GHz grids

• 1553.73—1554.73 nm, corresponds to a 50-GHz grid

• 1554.13—1554.13 nm, corresponds to 50-GHz and 100-GHz grids

• 1554.54—1554.54 nm, corresponds to a 50-GHz grid

• 1554.94—1554.94 nm, corresponds to 50-GHz and 100-GHz grids

• 1555.34—1555.34 nm, corresponds to a 50-GHz grid

• 1555.75—1555.75 nm, corresponds to 50-GHz and 100-GHz grids

• 1556.15—1556.15 nm, corresponds to a 50-GHz grid

• 1556.55—1556.55 nm, corresponds to 50-GHz and 100-GHz grids

• 1556.96—1556.96 nm, corresponds to a 50-GHz grid

• 1557.36—1557.36 nm, corresponds to 50-GHz and 100-GHz grids

• 1557.77—1557.77 nm, corresponds to a 50-GHz grid

• 1558.17—1558.17 nm, corresponds to 50-GHz and 100-GHz grids

• 1558.58—1558.58 nm, corresponds to a 50-GHz grid

• 1558.98—1558.98 nm, corresponds to 50-GHz and 100-GHz grids

• 1559.39—1559.39 nm, corresponds to a 50-GHz grid

• 1559.79—1559.79 nm, corresponds to 50-GHz and 100-GHz grids

• 1560.20—1560.20 nm, corresponds to a 50-GHz grid

• 1560.61—1560.61 nm, corresponds to 50-GHz and 100-GHz grids

• 1561.01—1561.01 nm, corresponds to a 50-GHz grid

• 1561.42—1561.42 nm, corresponds to 50-GHz and 100-GHz grids

• 1561.83—1561.83 nm, corresponds to a 50-GHz grid

• 1562.23—1562.23 nm, corresponds to 50-GHz and 100-GHz grids
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• 1562.64—1562.64 nm, corresponds to a 50-GHz grid

• 1563.05—1563.05 nm, corresponds to 50-GHz and 100-GHz grids

• 1563.45—1563.45 nm, corresponds to a 50-GHz grid

• 1563.86—1563.86 nm, corresponds to 50-GHz and 100-GHz grids

• 1564.27—1564.27 nm, corresponds to a 50-GHz grid

• 1564.68—1564.68 nm, corresponds to 50-GHz and 100-GHz grids

• 1565.09—1565.09 nm, corresponds to a 50-GHz grid

• 1565.50—1565.50 nm, corresponds to 50-GHz and 100-GHz grids

• 1565.90—1565.90 nm, corresponds to a 50-GHz grid

• 1566.31—1566.31 nm, corresponds to 50-GHz and 100-GHz grids

• 1566.72—1566.72 nm, corresponds to a 50-GHz grid

• 1567.13—1567.13 nm, corresponds to 50-GHz and 100-GHz grids

• 1567.54—1567.54 nm, corresponds to a 50-GHz grid

• 1567.95—1567.95 nm, corresponds to 50-GHz and 100-GHz grids

• 1568.36—1568.36 nm, corresponds to a 50-GHz grid

• 1568.77—1568.77 nm, corresponds to 50-GHz and 100-GHz grids

Table 223 on page 1366 shows configurable wavelengths and the corresponding

frequency for each configurable wavelength.

Table 241: Wavelength-to-Frequency Conversion Matrix

Frequency (THz)
Wavelength
(nm)Frequency (THz)

Wavelength
(nm)Frequency (THz)

Wavelength
(nm)

192.651556.15194.401542.14196.151528.38

192.601556.55194.351542.54196.101528.77

192.551556.96194.301542.94196.051529.16

192.501557.36194.251543.33196.001529.55

192.451557.77194.201543.73195.951529.94

192.401558.17194.151544.13195.901530.33

192.351558.58194.101544.53195.851530.72

192.301558.98194.051544.92195.801531.12

192.251559.39194.001545.32195.751531.51

192.201559.79193.951545.72195.701531.90
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Table 241: Wavelength-to-Frequency Conversion Matrix (continued)

Frequency (THz)
Wavelength
(nm)Frequency (THz)

Wavelength
(nm)Frequency (THz)

Wavelength
(nm)

192.151560.20193.901546.12195.651532.29

192.101560.61193.851546.52195.601532.68

192.051561.01193.801546.92195.551533.07

192.001561.42193.751547.32195.501533.47

191.951561.83193.701547.72195.451533.86

191.901562.23193.651548.11195.401534.25

191.851562.64193.601548.51195.351534.64

191.801563.05193.551548.91195.301535.04

191.751563.45193.501549.32195.251535.43

191.701563.86193.451549.72195.201535.82

191.651564.27193.401550.12195.151536.22

191.601564.68193.351550.52195.101536.61

191.551565.09193.301550.92195.051537.00

191.501565.50193.251551.32195.001537.40

191.451565.90193.201551.72194.951537.79

191.401566.31193.151552.12194.901538.19

191.351566.72193.101552.52194.851538.58

191.301567.13193.051552.93194.801538.98

191.251567.54193.001553.33194.751539.37

191.201567.95192.951553.73194.701539.77

191.151568.36192.901554.13194.651540.16

191.101568.77192.851554.54194.601540.56

192.801554.94194.551540.95
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Table 241: Wavelength-to-Frequency Conversion Matrix (continued)

Frequency (THz)
Wavelength
(nm)Frequency (THz)

Wavelength
(nm)Frequency (THz)

Wavelength
(nm)

192.751555.34194.501541.35

192.701555.75194.451541.75

d. The Tx Power field displays the transmit laser output power (dBm). If you did not

specify a value, the default transmit laser output power is –2 dBm.

e. The Rx Power field displays the laser received optical power, in mW and dBm.

10. From the PM collection list, specify whether the retrieval and computation of

performancemanagement statistics by polling the device must be enabled or not,

and click Update to save the changes. If you do not enable the collection of

performancemonitoring counters and values, youmight not be able to measure the

performance and the operational status of the services running in your network.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest settings be retrieved from the device and displayed.

Related
Documentation

Configuring and Managing OTU Details of MX Series and PTX Series Routers for

Simplified Management on page 1429

•

• Configuring and Managing ODU Details of MX Series and PTX Series Routers for

Simplified Management on page 1435

• Configuring and Managing Optical PIC Details for Effective Provisioning on page 1438
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Configuring andManaging OTUDetails of MX Series and PTX Series Routers for
SimplifiedManagement

Instead of using Junos OS CLI statements and operational commands to configure OTU

settings and view the configured parameters, you can view an image of the OTN port

using Connectivity Services Director to obtain an intuitive and high-level understanding

of the settings and alarms. This view enables you tomodify the OTU settings to suit your

network deployment needs in a simplified and optimal manner. Because the important

OTU settings can be configured alongside the visual representation of the entire chassis

that is displayed, this method of managing the OTU settings provides a consolidated

and cohesive interface for easy administration of the network.

You can perform the following tasks in the OTU Section pane:

• View the optical channel transport unit (OTU) specifications that are currently applied

on the device, such as wavelength and power

• Modify the existing parameters of the optical port to suit your network needs or resolve

any alarms caused by certain interface settings

To configure the OTN parameters for 10-Gigabit Ethernet or 100-Gigabit Ethernet dense

wavelength-division multiplexing (DWDM) interfaces:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, select anOTNport or interface—for example, a 100-Gigabit

Ethernet OTN PIC installed in a PTX Series router.

The Optical Port dialog box is displayed. At the lower part of the dialog box, the OTU

Section and ODU Section panes are displayed in a collapsed form.

6. Click theOTUSection header at the bottom of the dialog box.

The OTU Section pane is expanded and displayed.
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7. Click the Status/Config tab at the bottom of the dialog box.

The configuration settings that pertain to the OTU are displayed.

8. In the Status section, the OTU Status field is displayed. The OTU Status field displays

the status of the OTU. Possible values are:

• OTU-FEC-DEG (forward error correction degraded)

• OTU-FEC-EXE (excessive errors, FEC_FAIL from the transponder)

• OTU-AIS (alarm indication signal or all ones signal)

• OTU-BDI (backward defect identification)

• OTU-IAE (incoming alignment error)

• OTU-BIAE (backward incoming alignment error)

• OTU-TTIM (destinationaccesspoint identifier [DAPI], source accesspoint identifier

[SAPI], or both mismatch from expected to received)

• OTU-DEG (OTU degraded)

9. In the Config section, do the following:

• TheRate fielddisplays the line rateor speedof theOTNsignals.Oneof the following

values is displayed, if you have previously configured the OTNmode:

• fixed-stuff-bytes—Fixed stuff bytes 11.0957 Gbps.

• no-fixed-stuff-bytes—No fixed stuff bytes 11.0491 Gbps.

• pass-through—Enable OTN passthroughmode.

• no-pass-through—Do not enable OTN passthroughmode

Select a different line rate if needed from the Rate list.

• The FECMode field displays the forward error correction (FEC) mode. One of the

following values is displayed, if you have previously configured the FECmode:

• EFEC—G.975.1 I.4 enhanced forwarderror correction (EFEC) is configured todetect

and correct bit errors.

• GFEC—G.709 generic forward error correction (GFEC)mode is configured to

detect and correct bit errors.

• GFEC-SDFEC—GFECandsoft-decision forwarderror correction (SD-FEC)modes

are configured to detect and correct bit errors.

• NONE—FECmode is not configured.

• UFEC—Ultra Forward Error Correction (UFEC)mode is configured to detect and

correct bit errors.

Select a different FECmode if needed from the FECMode list.
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• From the Backward FRR list, specify whether you want to enable or disable

preemptive fast reroute(FRR) insertion.Bydefault, FRRODUbackwardFRR insertion

is disabled.

• From theSignalDegradeMonitor list, specifywhether youwant to enable or disable

preemptive fast reroute (FRR) signal degrademonitoring. By default, FRR signal

degrademonitoring isdisabled. If youdonotconfigure thesignal-degradeparameter,

the default threshold values are used.

• From the Signal Degrade Interval selector, use the up and down arrows to specify

the time interval in milliseconds (ms). This is the interval for which the BERmust

stay above the signal degradation threshold—as configured in the Ber Threshold

Signal Degrade field—for the alarm to raised. After an alarm is raised, if the BER

returnsbelowtheclear threshold—asconfigured in theBerThresholdClear field—for

the specified interval, the alarm is cleared.

The default value is 100ms. The range is from 1 ms through 100ms.

NOTE: For theP1-PTX-2-100G-WDMPIC, theBERmust stay above the
signal degradation threshold for ten consecutive intervals for the alarm
to be raised and the BERmust stay below the clear threshold for ten
consecutive intervals for the alarm to be cleared. For example, if the
interval is configured as 10ms, then theBERmust stay above the signal
degradation threshold for 100ms (10ms * 10 intervals) for the alarm
to be raised, or below the clear threshold for 100ms for the alarm to be
cleared.

NOTE: ForP1-PTX-24-10G-W-SFPPPICandP2-100GE-OTNPIC,when
the router cannot configure BERwith the given interval, it selects an
optimum interval that is supported for the given BER configuration. If
the router is still not able to support the configuration (for example,
with awider gapbetween thedegrade set andclear values), thedefault
values are used and a log is generated.

For the P2-10G-40G-QSFPP PIC, the time interval is supported in
multiples of 100ms. For example, when you configure the interval as
10ms, then it is rounded off to the nearest multiple of 100ms.

Configuring a high BER threshold for signal degradation and a long interval might

cause the internal counter register to be saturated. Such a configuration is ignored

by the router, and the default values are used instead. A system logmessage is

logged for this error.

• In the Ber Threshold Clear field, specify the bit error rate (BER) threshold to clear

the interface alarm for signal degradation. Youmust specify the BER threshold for

signal degradation in scientific notation. Both the mantissa and exponent are

configurable. Enter the value in the format xE–n, where x is the mantissa and n is

the exponent. For example, 4.5E–3.
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Themantissa must be a decimal number. There is no limit on the number of digits

before or after the decimal point. The exponent must be an integer from 0 through

9.

You can configure the BER clear threshold to customize the BER that will clear an

interface alarmwhen signal degrademonitoring is enabled.

Table 242 on page 1432 shows the default values for pre-FEC BER and ODU BER

signaldegrade thresholdvalues fordifferentPICs. If theBERsignaldegrade threshold

is not configured, the default value is used.

Table 242: Default Clear Threshold Values

Default ODU BER Clear Threshold
Value

DefaultPre-FECBERClearThreshold
ValuePIC

Not supported3.0E–3P1-PTX-2-100G-WDM

1.0E–93.0E–3P2-100GE-OTN

Not supported3.0E–3P1-PTX-24-10G-W-SFPP

• In the Ber Threshold Degrade field, specify the BER threshold is used to raise an

interface alarm for signal degradation. You can configure the BER signal degrade

threshold tocustomize theBERthatwill raisean interfacealarmwhensignaldegrade

monitoring is enabled. Youmust specify the BER threshold for signal degradation

in scientific notation. Both the mantissa and exponent are configurable. Enter the

value in the format xE–n,where x is themantissaandn is theexponent. For example,

4.5E–3.

Themantissa must be a decimal number. There is no limit on the number of digits

before or after the decimal point. The exponent must be an integer from 0 through

9.

NOTE: Configuring a high BER threshold for signal degradation and a
long interval might cause the internal bit error counter register to get
saturated. For example, for the P1-PTX-2-100G-WDMPIC, the internal
bit error counter gets saturated when the error count reaches 2E+29.
Therefore, thevalueofber-threshold-signal-degrade* line rate/ interval
must be less than 2E+29 to avoid saturation. Assuming a fixed PIC line
rate of 1.27E+11 bits per second and an interval of 1000ms, the
ber-threshold-signal-degrade valuemust be less than 4.22E–3.

If the value of the ber-threshold-signal-degrade * line rate / interval
exceeds the saturation limit, the configuration is ignored by the router,
and thedefault valuesareused instead.Asystem logmessage is logged
for this error.

Table 243 on page 1433 shows the default values for pre-FEC BER and ODU BER

signaldegrade thresholdvalues fordifferentPICs. If theBERsignaldegrade threshold

is not configured, the default value is used.
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Table 243: Default Signal Degrade Threshold Values

Default ODU BER Signal Degrade
Threshold Value

Default Pre-FEC BER Signal Degrade
Threshold ValuePIC

Not supported7.5E–3P1-PTX-2-100G-WDM

1.0E–67.5E–3P2-100GE-OTN

Not supported7.5E–3P1-PTX-24-10G-W-SFPP

10. Depending on the configured trace identifier (TTI), any of the following TTI sections

are displayed in the OTU Section pane:

• odu-dapi—ODU Destination Access Point Identifier.

• odu-expected-receive-dapi—ODU Expected Receive Destination Access Point

Identifier.

• odu-expected-receive-sapi—ODU Expected Receive Source Access Point Identifier.

• odu-sapi—ODU Source Access Point Identifier.

• out-dapi—OTU Destination Access Point Identifier.

• out-expected-receive-dapi—OTU Expected Receive Destination Access Point

Identifier.

• out-expected-receive-sapi—OTU Expected Receive Source Access Point Identifier.

• out-sapi—OTU Source Access Point Identifier

11. In the TTI-DAPI section, do the following:

• The Tx Trace and Rx Trace fields display the transmitted and received path trace

values. A path trace identifier is a text string that identifies the circuit. The text string

that identifies the circuit. SONET/SDH interfaces allow path trace bytes to be sent

inbandacross theSONET/SDHlink. JuniperNetworksandother routermanufacturers

use these bytes to help diagnosemisconfigurations and network errors by setting

the transmitted path trace message so that it contains the system hostname and

nameof thephysical interface.The receivedpath tracevalue is themessage received

from the routing device at the other end of the fiber. The transmitted path trace

value is the message that this routing device transmits.

• In the Tx Trace config field, specify the propagated path trace identifier. A common

convention is to use the circuit identifier as the path trace identifier.

• In the Rx Trace Config field, specify the received path trace identifier. A common

convention is to use the circuit identifier as the path trace identifier.

12. In the TTI-DAPI section, do the following:

• The Tx Trace and Rx Trace fields display the transmitted and received path trace

values. A path trace identifier is a text string that identifies the circuit. The text string

that identifies the circuit. SONET/SDH interfaces allow path trace bytes to be sent

inbandacross theSONET/SDHlink. JuniperNetworksandother routermanufacturers

use these bytes to help diagnosemisconfigurations and network errors by setting
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the transmitted path trace message so that it contains the system hostname and

nameof thephysical interface.The receivedpath tracevalue is themessage received

from the routing device at the other end of the fiber. The transmitted path trace

value is the message that this routing device transmits.

• In the Tx Trace config field, specify the propagated path trace identifier. A common

convention is to use the circuit identifier as the path trace identifier.

• In the Rx Trace Config field, specify the received path trace identifier. A common

convention is to use the circuit identifier as the path trace identifier.

13. Click Update at the top of the dialog box to save the modified OTU settings.

The settings are saved in the Connectivity Services Director database.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest settings be retrieved from the device and displayed.

Related
Documentation

Configuring and Managing OTN Port Details of MX Series and PTX Series Routers for

Easy Administration on page 1421

•

• Configuring and Managing ODU Details of MX Series and PTX Series Routers for

Simplified Management on page 1435

• Configuring and Managing Optical PIC Details for Effective Provisioning on page 1438
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Configuring andManaging ODUDetails of MX Series and PTX Series Routers for
SimplifiedManagement

Instead of using Junos OS CLI statements and operational commands to configure ODU

settings and view the configured parameters, you can view an image of the OTN port

using Connectivity Services Director to obtain an intuitive and high-level understanding

of the settings and alarms. This view enables you tomodify theODU settings to suit your

network deployment needs in a simplified and optimal manner. Because the important

ODU settings can be configured alongside the visual representation of the entire chassis

that is displayed, this method of managing the ODU settings provides a consolidated

and cohesive interface for easy administration of the network.

You can perform the following tasks in the ODU Path pane:

• View the optical channel data unit (ODU) specifications that are currently applied on

the device, such as wavelength and power

• Modify the existing parameters of the optical port to suit your network needs or resolve

any alarms caused by certain interface settings

To configure the ODU parameters for 10-Gigabit Ethernet or 100-Gigabit Ethernet dense

wavelength-division multiplexing (DWDM) interfaces:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, select anOTNport or interface—for example, a 100-Gigabit

Ethernet OTN PIC installed in a PTX Series router.

The Optical Port dialog box is displayed. At the lower part of the dialog box, the OTU

Section and ODU Path panes are displayed in a collapsed form.

6. Click theODUPath header at the bottom of the dialog box.

The ODU Path pane is expanded and displayed.
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7. Click the Status/Config tab at the bottom of the dialog box.

The configuration settings that pertain to the ODU are displayed.

8. In the Status section, the ODU Status field is displayed.

The ODU Status field displays the status of the ODU (optical channel data unit).

Possible values are:

• CSF (client signal failure)

• ODU-DM-TIMEOUT (DM timeout)

• ODU-LCK (ODU lock triggers for PM [pathmonitoring] and TCM levels 1 through 6)

• ODU-AIS (alarm indication signal or all ones signal)

• ODU-OCI (open connection error)

• ODU-BDI (backward defect indication)

• ODU-DEG (ODU degraded)

• ODU-IAE (incoming alignment error)

• ODU-DAPI-TTIM (DAPI or DAPI/SAPI mismatch from expected to receive)

• ODU-SAPI-TTIM (SAPI or DAPI/SAPI mismatch from expected to receive)

• ODU-BEI (backward error indication)

• ODU-BEI-ERR (backward error indication error)

• ODU-BIP8-ERR (bit interleaved parity 8 error)

• ODU-SSF (server signal fail)

• ODU-TSF (trail signal fail)

• ODU-SD (signal degrade

9. In the Config section, do the following:

• From the ODU Backward FRR list, specify whether you want to enable or disable

backward fast reroute (FRR) insertion. You can insert the ODU status into the

transmitted OTN frames andmonitor the received OTN frames for the ODU BER

status. By default, FRR ODU backward FRR insertion is disabled.

• From the ODU Signal Degrade Monitor list, specify whether you want to enable or

disable monitoring of signal degradation of ODU BER in the received OTN frames.

By default, FRR signal degrademonitoring disabled.

10. Depending on the configured trace identifier (TTI), any of the following TTI sections

are displayed in the OTU Section pane:

• odu-dapi—ODU Destination Access Point Identifier.

• odu-expected-receive-dapi—ODU Expected Receive Destination Access Point

Identifier.

• odu-expected-receive-sapi—ODUExpectedReceiveSourceAccessPoint Identifier.
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• odu-sapi—ODU Source Access Point Identifier.

• out-dapi—OTU Destination Access Point Identifier.

• out-expected-receive-dapi—OTU Expected Receive Destination Access Point

Identifier.

• out-expected-receive-sapi—OTU Expected Receive Source Access Point Identifier.

• out-sapi—OTU Source Access Point Identifier

11. In the TTI-DAPI section, do the following:

• The Tx Trace and Rx Trace fields display the transmitted and received path trace

values. A path trace identifier is a text string that identifies the circuit. The text string

that identifies the circuit. SONET/SDH interfaces allow path trace bytes to be sent

inbandacross theSONET/SDHlink. JuniperNetworksandother routermanufacturers

use these bytes to help diagnosemisconfigurations and network errors by setting

the transmitted path trace message so that it contains the system hostname and

nameof thephysical interface.The receivedpath tracevalue is themessage received

from the routing device at the other end of the fiber. The transmitted path trace

value is the message that this routing device transmits.

• In the Tx Trace config field, specify the propagated path trace identifier. A common

convention is to use the circuit identifier as the path trace identifier.

• In the Rx Trace Config field, specify the received path trace identifier. A common

convention is to use the circuit identifier as the path trace identifier.

12. In the TTI-DAPI section, do the following:

• The Tx Trace and Rx Trace fields display the transmitted and received path trace

values. A path trace identifier is a text string that identifies the circuit. The text string

that identifies the circuit. SONET/SDH interfaces allow path trace bytes to be sent

inbandacross theSONET/SDHlink. JuniperNetworksandother routermanufacturers

use these bytes to help diagnosemisconfigurations and network errors by setting

the transmitted path trace message so that it contains the system hostname and

nameof thephysical interface.The receivedpath tracevalue is themessage received

from the routing device at the other end of the fiber. The transmitted path trace

value is the message that this routing device transmits.

• In the Tx Trace config field, specify the propagated path trace identifier. A common

convention is to use the circuit identifier as the path trace identifier.

• In the Rx Trace Config field, specify the received path trace identifier. A common

convention is to use the circuit identifier as the path trace identifier.

13. Click Update at the top of the dialog box to save the modified ODU settings.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest settings be retrieved from the device and displayed.

You can collapse the contents of a particular section by clicking theminus sign (-) beside

the header and expand the contents of a section by clicking the plus sign (+) beside the

header.
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Related
Documentation

Configuring and Managing OTN Port Details of MX Series and PTX Series Routers for

Easy Administration on page 1421

•

• Configuring and Managing OTU Details of MX Series and PTX Series Routers for

Simplified Management on page 1429

• Configuring and Managing Optical PIC Details for Effective Provisioning on page 1438

Configuring andManaging Optical PIC Details for Effective Provisioning

Instead of using Junos OS CLI statements and operational commands to configure OTN

PIC settings and view the configured parameters, you can view an image of the OTN PIC

using Connectivity Services Director to obtain an intuitive and high-level understanding

of the settings and alarms. This view enables you to modify the OTN PIC settings to suit

your network deployment needs in a simplified and optimal manner. Because the

important OTNPIC settings can be configured alongside the visual representation of the

entire chassis that is displayed, this method of managing the OTN PIC settings provides

a consolidated and cohesive interface for easy administration of the network.

You can perform the following tasks in this dialog box:

• View the optical interface specifications that are currently applied on the device, such

as the PIC state and PIC type

• Modify the existing parameters of the optical port to suit your network needs or resolve

any alarms caused by certain interface settings

To configure the full C-band International Telecommunication Union (ITU)-Grid tunable

optics for 10-Gigabit Ethernet or 100-Gigabit Ethernet dense wavelength- division

multiplexing (DWDM) OTN PICs:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.
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5. In the image of the device, select an OTN PIC, such as a 2-port 100-Gigabit Ethernet

OTN PIC or a 100-Gigabit Ethernet PIC installed in a PTX Series router.

The Component Info dialog box is displayed on the right pane with the PIC

specifications.

6. Click the Status/Config tab at the bottom of the dialog box.

The configuration settings that pertain to the optical interface are displayed in the

PIC Status/Config dialog box.

7. In the PIC Details section, do the following:

a. From the PIC State list, selectOn Line to turn on the PIC so that the PIC is running

orOff Line to turn off the PIC so that the PIC is powered down. State is displayed

only when a PIC resides in the slot.

b. FromthePICType list, select the typeofPIC, suchas2X100GECFP2OTN, 24X10GE

SFPP OTN, 2x100G DWDMOTN, or 2x100GE CFP.

c. In the PIC version field, the PIC hardware version is displayed.

d. In the Uptime field, the number of days, hours, minutes, and seconds for which the

PIC has been online is displayed.

8. In the Transport State section, the following fields are displayed:

• Admin State—The administrative state of the port—In Service or Out of Service.

• Operational State—The operational status of the port—link up (UP) or link down

(DOWN).

9. Click Update to save the configured settings. Alternatively, click Cancel to discard the

modified settings.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest settings be retrieved from the device and displayed.

Related
Documentation

Configuring and Managing OTN Port Details of MX Series and PTX Series Routers for

Easy Administration on page 1421

•

• Configuring and Managing OTU Details of MX Series and PTX Series Routers for

Simplified Management on page 1429

• Configuring and Managing ODU Details of MX Series and PTX Series Routers for

Simplified Management on page 1435
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ConfiguringThreshold-CrossingAlarmsforOTNPorts forMonitoringLinkPerformance

Bymonitoring the performance of links, you ensure that an end-to-end Ethernet service

is always available over any path for a single link or multiple links spanning networks

composed ofmultiple LANs. Link performancemetrics enable operators to offer binding

service-level agreements (SLAs) and generate new revenues from rate- and

performance-guaranteed service packages that are customized to meet specific needs

of their customers. Tomonitor linkperformance, youneed toconfigure threshold-crossing

alarms (TCAs) for optical transport network (OTN) ports.

TCAs are alarms that are activated when a certain configurable threshold—near-end

measurement threshold or far-endmeasurement threshold—is crossed and remains so

until the end of the 15-minute interval and the 24-hour interval for parameters such as

optical channel transport unit (OTU) and optical data unit (ODU). A near-end

measurement is associated with ingress data frames and a far-endmeasurement is

associated with egress data frames.

You can configure TCAs for both the minimum andmaximum values for gauges and the

maximum values for counters. A gauge represents a non-negative integer, which may

increase or decrease, but never exceeds amaximum value. A gauge has its maximum

valuewhenever the information beingmodeled is greater than or equal to themaximum

value. If the TCA parameter subsequently goes below themaximum value, the gauge

alsodecreases. Acounter representsanon-negative integer thatmonotonically increases

until it reaches amaximum value of 2
32
–1.

The timely detection of TCAs is essential to proactively manage an interface. TCAs are

not an indication of a fault, but rather an indication that the entitymay be close to a fault.

You can enable the TCA that you want monitor. You can keep the default threshold

settings or change the settings.

To configure TCAs for OTN port interface parameters:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the OTN interface

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.
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5. In the imageof thedevice, select anOTN interfaceor port—for example, a 100-Gigabit

Ethernet OTNMIC installed in a PTX Series router.

The Optical Port dialog box is displayed. At the lower part of the dialog box, the OTU

Section and ODU Section panes are displayed in a collapsed form.

6. Click theOptical Port Section header at the bottom of the dialog box.

The Optical Port Section pane is expanded and displayed. This pane contains the

Equipment, Status/Config, and Performance tabs.

7. Click the Performance tab at the bottom of the pane.

The Optics PMs dialog box is displayed with the performancemonitoring gauges and

counters that pertain to the selected OTN port. This dialog box contains the Perf Mon

and TCA Config tabs.

8. Click the TCA Config tab to configure TCAs for the various attributes.

The dialog box is refreshed to display the performancemonitoring parameters.

Inline editing enables you to modify previously defined settings easily and quickly.

Embedded editing is also enabled, which causes the grids showing the devices and

interfaces to becomemodifiable directly; you do not need to highlight, edit, and save

the changes every time.

A gray triangle in the upper-right corner of a field denotes that the value of that field

or attribute has beenmodified.

9. For the parameters under each performancemonitoring category for which you want

to modify the TCA value, click the value in the Threshold-15Min or Threshold-24Hr

columns. You can also select or clear the check box in the Enable column to enable

or disable the TCA value for the specified parameter, respectively.

10. Click Update to save the configured threshold settings. Alternatively, click Cancel to

discard the configuration.

Related
Documentation

Configuring Threshold-Crossing Alarms for OTUs for Monitoring Link Performance on

page 1442

•

• Configuring Threshold-Crossing Alarms for ODUs for Monitoring Link Performance on

page 1444

• Viewing Performance Monitoring Details of OTN Ports for Detecting and Diagnosing

Faults on page 1446

• Viewing Performance Monitoring Details of OTUs for Detecting and Diagnosing Faults

on page 1452

• Viewing PerformanceMonitoring Details of ODUs for Detecting and Diagnosing Faults

on page 1457
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Configuring Threshold-Crossing Alarms for OTUs for Monitoring Link Performance

Bymonitoring the performance of links, you ensure that an end-to-end Ethernet service

is always available over any path for a single link or multiple links spanning networks

composed ofmultiple LANs. Link performancemetrics enable operators to offer binding

service-level agreements (SLAs) and generate new revenues from rate- and

performance-guaranteed service packages that are customized to meet specific needs

of their customers. Tomonitor linkperformance, youneed toconfigure threshold-crossing

alarms (TCAs) for optical channel transport unit (OTU) and optical data unit (ODU) of

optical transport network (OTN) ports.

TCAs are alarms that are activated when a certain configurable threshold—near-end

measurement threshold or far-endmeasurement threshold—is crossed and remains so

until the end of the 15-minute interval and the 24-hour interval for parameters such as

OTU and ODU. A near-endmeasurement is associated with ingress data frames and a

far-endmeasurement is associated with egress data frames.

You can configure TCAs for both the minimum andmaximum values for gauges and the

maximum values for counters. A gauge represents a non-negative integer, which may

increase or decrease, but never exceeds amaximum value. A gauge has its maximum

valuewhenever the information beingmodeled is greater than or equal to themaximum

value. If the TCA parameter subsequently goes below themaximum value, the gauge

alsodecreases. Acounter representsanon-negative integer thatmonotonically increases

until it reaches amaximum value of 2
32
–1.

The timely detection of TCAs is essential to proactively manage an interface. TCAs are

not an indication of a fault, but rather an indication that the entitymay be close to a fault.

You can enable the TCA that you want monitor. You can keep the default threshold

settings or change the settings.

To configure TCAs for OTU parameters:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.
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5. In the the image of the device, select an OTN interface or port—for example, a

100-Gigabit Ethernet optical transport network (OTN) MIC installed in a PTX Series

router.

The Optical Port dialog box is displayed. At the lower part of the dialog box, the OTU

Section and ODU Section panes are displayed in a collapsed form.

6. Click theOTUSection header at the bottom of the dialog box.

TheOTUSectionpane is expandedanddisplayed. This pane contains theEquipment,

Status/Config, and Performance tabs.

7. Click the Performance tab at the bottom of the pane.

The OTU PMs dialog box is displayed with the performancemonitoring counters and

metrics that pertain to theOTU. This dialogbox contains thePerfMonandTCAConfig

tabs. At the top-left corner of the PMs dialog box, the TCA Config tab (green right

arrow enclosed in a square) is displayed.

8. Click the TCAConfig tab to configure the TCAs for the different optical interface, OTU,

or ODU attributes. The dialog box is refreshed to display the different performance

monitoring parameters. These parameters can be edited inline.

Inline editing enables you to modify previously defined settings easily and quickly.

Embedded editing is also enabled, which causes the grids showing the devices and

interfaces to becomemodifiable directly; you do not need to highlight, edit, and save

the changes every time.

A gray triangle in the upper-right corner of a field denotes that the value of that field

or attribute has beenmodified.

9. For the parameters under each performancemonitoring category for which you want

to modify the TCA value, click the value in the Threshold-15Min or Threshold-24Hr

columns to set the TCA value for the 15-minute interval or 24-hour interval. You can

also select or clear the check box in the Enable column to enable or disable the TCA

value for the specified parameter, respectively.

10. Click Update to save the configured threshold settings. Alternatively, click Cancel to

discard the configuration.

Related
Documentation

ConfiguringThreshold-CrossingAlarms forOTNPorts forMonitoring LinkPerformance

on page 1440

•

• Configuring Threshold-Crossing Alarms for ODUs for Monitoring Link Performance on

page 1444

• Viewing Performance Monitoring Details of OTN Ports for Detecting and Diagnosing

Faults on page 1446
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• Viewing Performance Monitoring Details of OTUs for Detecting and Diagnosing Faults

on page 1452

• Viewing PerformanceMonitoring Details of ODUs for Detecting and Diagnosing Faults

on page 1457

Configuring Threshold-Crossing Alarms for ODUs for Monitoring Link Performance

Bymonitoring the performance of links, you ensure that an end-to-end Ethernet service

is always available over any path for a single link or multiple links spanning networks

composed ofmultiple LANs. Link performancemetrics enable operators to offer binding

service-level agreements (SLAs) and generate new revenues from rate- and

performance-guaranteed service packages that are customized to meet specific needs

of their customers. Tomonitor linkperformance, youneed toconfigure threshold-crossing

alarms (TCAs) for optical channel transport unit (OTU) and optical data unit (ODU) of

optical transport network (OTN) ports.

TCAs are alarms that are activated when a certain configurable threshold—near-end

measurement threshold or far-endmeasurement threshold—is crossed and remains so

until the end of the 15-minute interval and the 24-hour interval for parameters such as

OTU and ODU. A near-endmeasurement is associated with ingress data frames and a

far-endmeasurement is associated with egress data frames.

You can configure TCAs for both the minimum andmaximum values for gauges and the

maximum values for counters. A gauge represents a non-negative integer, which may

increase or decrease, but never exceeds amaximum value. A gauge has its maximum

valuewhenever the information beingmodeled is greater than or equal to themaximum

value. If the TCA parameter subsequently goes below themaximum value, the gauge

alsodecreases. Acounter representsanon-negative integer thatmonotonically increases

until it reaches amaximum value of 2
32
–1.

The timely detection of TCAs is essential to proactively manage an interface. TCAs are

not an indication of a fault, but rather an indication that the entitymay be close to a fault.

You can enable the TCA that you want monitor. You can keep the default threshold

settings or change the settings.

To configure TCAs for ODU parameters:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.
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The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the the image of the device, select an OTN interface or port—for example, a

100-Gigabit Ethernet optical transport network (OTN) MIC installed in a PTX Series

router.

The Optical Port dialog box is displayed. At the lower part of the dialog box, the OTU

Section and ODU Section panes are displayed in a collapsed form.

6. Click theODUPath header at the bottom of the dialog box.

The ODU Path pane is expanded and displayed. This pane contains the Equipment,

Status/Config, and Performance tabs.

7. Click the Performance tab at the bottom of the pane.

The ODU PMs dialog box is displayed with the performancemonitoring counters and

metrics that pertain to theODU.This dialogbox contains thePerfMonandTCAConfig

tabs.

8. Click the TCAConfig tab to configure the TCAs for the different optical interface, OTU,

or ODU attributes. The dialog box is refreshed to display the different performance

monitoring parameters. These parameters can be edited inline.

Inline editing enables you to modify previously defined settings easily and quickly.

Embedded editing is enabled, which causes the grids showing the devices and

interfaces to becomemodifiable directly; you do not need to highlight, edit, and save

the changes every time.

A gray triangle in the upper-right corner of a field denotes that the value of that field

or attribute has beenmodified.

9. For the parameters under each performancemonitoring category for which you want

to modify the TCA value, click the value in the Threshold-15Min or Threshold-24Hr

columns to set the TCA value for the 15-minute interval or 24-hour interval. You can

also select or clear the check box in the Enable column to enable or disable the TCA

value for the specified parameter, respectively.

10. Click Update to save the configured threshold settings. Alternatively, click Cancel to

discard the configuration.

Related
Documentation

ConfiguringThreshold-CrossingAlarms forOTNPorts forMonitoring LinkPerformance

on page 1440

•
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• Configuring Threshold-Crossing Alarms for OTUs for Monitoring Link Performance on

page 1442

• Viewing Performance Monitoring Details of OTN Ports for Detecting and Diagnosing

Faults on page 1446

• Viewing Performance Monitoring Details of OTUs for Detecting and Diagnosing Faults

on page 1452

• Viewing PerformanceMonitoring Details of ODUs for Detecting and Diagnosing Faults

on page 1457

Viewing PerformanceMonitoring Details of OTN Ports for Detecting and Diagnosing
Faults

Toanalyze and resolve any faults associatedwith optical transport network (OTN) ports,

it is essential to view thediagnostic data,warnings, andalarms for transport performance

monitoring. The different types of parameters related to performancemonitoring that

are retrieved from the OTN ports enable you to ensure service availability andmonitor

the performance of individual services and the network.

TheperformancemonitoringcapabilityofConnectivityServicesDirectorhelpsyou identify

problemswith theequipment, pinpoint securityattacks, andanalyze trendsandcategories

of errors. This capability uses charts and grids to provide important and cohesive

information about system conditions, discrepancies andmalfunctioning, and protocols

or components thatneed tobeexaminedanddebugged forbetter efficiencyandworking

capacity. You can assess the performance of your network, not only at a point in time,

but also over a period of time.

To view performancemonitoring details of OTN interfaces:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.
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5. In the imageof thedevice, select anOTN interfaceor port—for example, a 100-Gigabit

Ethernet optical transport network (OTN) MIC installed in a PTX Series router.

The Optical Port dialog box is displayed. At the lower part of the dialog box, the OTU

Section and ODU Section panes are displayed in a collapsed form.

6. Click theOptical Port Section header at the bottom of the dialog box.

The Optical Port Section pane is expanded and displayed. This pane contains the

Equipment, Status/Config, and Performance tabs.

7. Click the Performance tab at the bottom of the pane.

This pane contains the Perf Mon and TCAConfig tabs. The Perf Mon tab of theOptics

PMs dialog box is displayed.

The following fields are displayed in the Perf Mon tab of the Optics PMs dialog box.

The date and time at which the dialog box was last refreshed is shown.

• Carrier FrequencyOffset (MHz)—Carrier frequencyoffset inmegahertz (mHz),which

denotes thedifferencebetween thecarriers (frequencyshift in the receive spectrum)

between the expected Rx carrier frequency and the actual carrier frequency

CFO—Threshold values for carrier frequency offset

CFO-Min—Low threshold setting trigger when the carrier frequency offset falls

below this minimum value

CFO-Avg—Average threshold setting trigger when the carrier frequency offset

crosses this average value

CFO-Max—High threshold setting trigger when the carrier frequency offset rises

above this maximum value

• Chromatic Dispersion—Lane or residual chromatic dispersion measured at the Rx

transceiver port, which denotes the spreading of the signal in time resulting from

the different speeds of light rays

CD—Threshold values for chromatic dispersion

CD-Min—Minimum value of the residual chromatic dispersion measured at the Rx

transceiver port

CD-Avg—Average value of the residual chromatic dispersion measured at the Rx

transceiver port

CD-Max—Maximum value of the residual chromatic dispersionmeasured at the Rx

transceiver port

• Differential Group Delay—Lane differential group delay, which denotes the time

difference between the fractions of a pulse that are transmitted in the twoprincipal

states of polarization of an optical signal. For distances greater than several

kilometers, and assuming random (strong) polarization mode coupling, DGD in a

fiber can be statistically modeled as having a Maxwellian distribution.

DGD—Threshold values for differential group delay
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DGD-Min—Minimum value of the differential group delay belowwhich a TC is

triggered

DGD-Avg—Average value of the differential group delay at which TCA is triggered

DGD-Max—Maximum value of the differential group delay above which a TCA is

triggered

• Module Temperature (°C)—Module temperature, which denotes the laser

temperature in Celsius

MT—Threshold values for module temperature

MT-Min—High laser temperature in Celsius belowwhich a TCA is sent

MT-Avg—Average laser temperature in Celsius at which a TCA is sent

MT-Max—Maximum laser temperature in Celsius above which a TCA is sent

• Optical Lane Q2 Factor—Quality (Q or Q2) factor value estimated at the Rx

transceiver port

Lane Q2 factor—Threshold values for the quality factor

Lane Q2 factor-Min—Minimum value of the quality factor estimated at the Rx

transceiver port belowwhich a TCA is sent

Lane Q2 factor-Avg—Average value of the quality factor estimated at the Rx

transceiver port at which a TCA is sent

Lane Q2 factor-Max—Maximum value of the quality factor estimated at the Rx

transceiver port above which a TCA is sent

• Signal to Noise Ratio—Signal-to-noise ratio estimated at the Rx transceiver port

SNR—Threshold values for signal-to-noise ratio

SNR-Min—Minimumvalueof thesignal-to-noise ratioestimatedat theRx transceiver

port belowwhich a TCA is sent

SNR-Avg—Averagevalueof the signal-to-noise ratio estimatedat theRx transceiver

port

SNR-Max—Maximum value of the signal-to-noise ratio estimated at the Rx

transceiver port above which a TCA is sent

• Optical Tx Output Power—Transmitted laser optical output power in dBm

Tx-Pwr—Threshold values for transmitted laser output power

TxPwr-Min—Minimum value of the transmitted laser output power in dBm below

which a TCA is sent

TxPwr-Avg—Average value of the transmitted laser output power in dBM at which

a TCA is sent

TxPwr-Max—Maximum value of the transmitted laser output power above which

a TCA is sent

• Optical Rx Input Power—Received laser optical input power in dBm
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Rx-Pwr—Threshold values for received laser input power

RxPwr-Min—Minimum value of the received laser input power in dBm belowwhich

a TCA is sent

RxPwr-Avg—Average value of the received laser power in dBm at which a TCA is

sent

RxPwr-Max—Maximum value of the received input power in dBm above which a

TCA is sent

On the Perf Mon tab, for the TCA column, either a minus sign (–) is displayed that

denotes that an alarm for threshold-exceed is not configured or a check mark is

displayed and grayed out that indicates that the TCA for the particular attribute is

configured.

8. In the 15Minscolumn, click theChartbutton for theperformancemonitoringparameter

set forwhich youwant to view the statistics for the last 15minutes. This optionenables

you to view the statistics in a chart form. Performancemonitoring information for the

different parameters are displayed for the current 15-minute interval. By default, 96

records of 15-minute intervals are displayed.

A 15-Min parameter-name tab is displayed beside the TCA Config tab at the top-left

cornerof theOpticsPMsdialogbox.Agraphical formatof thestatistics for thespecified

parameter is displayed on this tab.

9. Click the 15 Mins parameter name tab.

a. Select one of the following options from the drop-downmenu:

• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

withdateand timealong thehorizontal axis and theparameter along thevertical

axis. A color-coding format is used to display the different lines, and legends

reference the parameter names corresponding to the lines displayed. Mouse

over thepoints in the linegraph toexpandandshowthevalueof theperformance

monitoring counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

The records are displayed in tabular format. A serial number of the count of

entries, the day, month, and year at which the entry was collected, and the time

at which the entry was collected are displayed. The timestamp is the UTC time

in the database that is mapped to the local time zone of the client computer.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.

Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.

• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.
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In the pop-up dialog box, you can do one of the following:

• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search.

• Click Reload to refresh the contents and display the updated information for

the specified time period.

• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.

The comma-separated value (CSV) format takes the rawdata from the report

anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 15-Min parameter-name tab.

10. In the24-Hrs column, click theChartbutton for theperformancemonitoringparameter

set for which you want to view the statistics for the previous day. This option enables

you to view the statistics in a chart form. Performancemonitoring information for the

different parameters are displayed for the current 24-hour interval. By default, records

pertaining to the last 30daysaredisplayedwhenyouviewtheperformancemonitoring

counters for the 24-hour duration.

A 24Hours parameter-name tab is displayed beside the TCAConfig tab at the top-left

cornerof theOpticsPMsdialogbox.Agraphical formatof thestatistics for thespecified

parameter is displayed on this tab.

11. Click the 24 Hours parameter name tab.

a. Select one of the following options from the drop-downmenu:

• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

with date along the horizontal axis and the parameter along the vertical axis. A

color-coding format is used to display the different lines, and legends reference

theparameternamescorresponding to the linesdisplayed.Mouseover thepoints

in the line graph to expand and show the value of the performancemonitoring

counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.
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Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.

• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.

In the pop-up dialog box, you can do one of the following:

• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search. Click Reload to refresh the contents and display the updated

information for the specified time period.

• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.

The comma-separated value (CSV) format takes the rawdata from the report

anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 24 Hours parameter-name tab.

12. Click the Clear PMs button at the top of the Optics PMs dialog box, and select one of

the following values from the drop-downmenu to clear optics information from the

transport performancemonitoring data.

• Current—Clear the optics information for the current interval, such as 15-minute

interval or 24-hour interval, for which monitoring data is being collected.

• Current Day—Clear the optics information for the current 24 hours.

• All Intervals—Clear the optics information for the current 15-minute interval, the 96

records of 15-minute intervals, the current day, and the previous day

After you select one of the intervals for which monitoring data must be deleted, a

Clear Optics PMs dialog box is displayed to indicate that a job is triggered to delete

the monitoring information from themodule on the device. The job ID, start and end

times of the job, percentage of completion, and status of the job are displayed.

13. Click Close to close the job dialog box; alternatively, click Refresh to update the job

status and view.

You can use the Jobs Management page (by clicking the System icon on the banner

and selecting Manage Jobs) to track the status of this job.

You can click theRefresh (rotating arrow icon) button at the top of theOptics PMsdialog

box to enable the latest performancemonitoring statistics to be polled and displayed.
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ConfiguringThreshold-CrossingAlarms forOTNPorts forMonitoring LinkPerformance

on page 1440

•

• Configuring Threshold-Crossing Alarms for OTUs for Monitoring Link Performance on

page 1442

• Configuring Threshold-Crossing Alarms for ODUs for Monitoring Link Performance on

page 1444

• Viewing Performance Monitoring Details of OTUs for Detecting and Diagnosing Faults

on page 1452

• Viewing PerformanceMonitoring Details of ODUs for Detecting and Diagnosing Faults

on page 1457

Viewing PerformanceMonitoring Details of OTUs for Detecting andDiagnosing Faults

The performancemonitoring capability in Connectivity Services Director displays

information about the health of your network and changing conditions of your optical

channel transport units (OTUs). Use this diagnosis and detectionmechanism to identify

problems with the equipment, pinpoint security attacks, or to analyze trends and

categories of errors. This feature includes fault-monitoring details in the dashboard, in

monitoring pages, and on a dedicated page that displays alarms, events, and system log

messages that are generated. Performancemonitoring parameters can be viewed in

both chart and statistical formats. These charts and statistical details provide essential

andcohesive informationaboutsystemconditions, anydiscrepanciesandmalfunctioning,

andprotocolsorcomponents thatneedtobeexaminedanddebugged forbetterefficiency

and working capacity. You can assess the performance of your network, not only at a

point in time, butalsoover aperiodof time.This featureenables you todetermine trending

and network-health parameters; for example, whether service-level agreements (SLAs)

have been violated.

To view performancemonitoring details of OTUs:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.
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An image of the device is displayed on the right pane.

5. In the the image of the device, select an OTN interface or port—for example, a

100-Gigabit Ethernet optical transport network (OTN) MIC installed in a PTX Series

router.

The Optical Port dialog box is displayed. At the lower part of the dialog box, the OTU

Section and ODU Section panes are displayed in a collapsed form.

6. Click theOTUSection header at the bottom of the dialog box.

TheOTUSectionpane is expandedanddisplayed. This pane contains theEquipment,

Status/Config, and Performance tabs.

7. Click the Performance tab at the bottom of the pane.

This pane contains the Perf Mon and TCA Config tabs. The Perf Mon tab of the OTU

PMs dialog box is expanded and displayed.

The following fields are displayed in the Perf Mon tab of the OTUPMs dialog box. The

date and time at which the dialog box was last refreshed is shown.

• OTU FE—OTU far-endmeasurement threshold

BBE—Background block error threshold-crossing defect trigger for OTU far-end

ES—Errored seconds threshold-crossing defect trigger for OTU far-end

SES—Severely errored seconds threshold-crossing defect trigger for OTU far-end

UAS—Unavailable seconds threshold-crossing defect trigger for OTU far-end

• OTU NE—OTU near-endmeasurement threshold for OTU near-end

BBE—Background block error threshold-crossing defect trigger for OTU near-end

ES—Errored seconds threshold-crossing defect trigger for OTU near-end

SES—Severely errored seconds threshold-crossing defect trigger for OTU near-end

UAS—Unavailable seconds threshold-crossing defect trigger for OTU near-end

• FEC NE (OTU only)—Near-end forward error correction threshold-crossing defect

trigger

FEC-CorrectedErrMin—Forward error correction Corrected Errors counter

FEC-UncorrectedWords—Forward error correction UncorrectedWords counter

FECMax—Maximum forward error correction

• BER NE (OTU only)—Near-end bit error rate threshold-crossing defect trigger

BER-Min—Minimum bit error rate for OTU near-end

BER-Avg—Average bit error rate for OTU near-end

BERMax—Maximum bit error rate for OTU near-end
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On the Perf Mon tab, for the TCA column, either a minus sign (–) is displayed that

denotes that an alarm for threshold-exceed is not configured or a check mark is

displayed and grayed out that indicates that the TCA for the particular attribute is

configured.

In the 15Minscolumn, click theChartbutton for theperformancemonitoringparameter

set forwhich youwant to view the statistics for the last 15minutes. This optionenables

you to view the statistics in a chart form. Performancemonitoring information for the

different parameters are displayed for the current 15-minute interval. By default, 96

records of 15-minute intervals are displayed.

A 15-Min parameter-name tab is displayed beside the TCA Config tab at the top-left

cornerof theOpticsPMsdialogbox.Agraphical formatof thestatistics for thespecified

parameter is displayed on this tab.

8. Click the 15 Mins parameter name tab.

a. Select one of the following options from the drop-downmenu:

• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

withdateand timealong thehorizontal axis and theparameter along thevertical

axis. A color-coding format is used to display the different lines, and legends

reference the parameter names corresponding to the lines displayed. Mouse

over thepoints in the linegraph toexpandandshowthevalueof theperformance

monitoring counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

The records are displayed in tabular format. A serial number of the count of

entries, the day, month, and year at which the entry was collected, and the time

at which the entry was collected are displayed. The timestamp is the UTC time

in the database that is mapped to the local time zone of the client computer.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.

Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.

• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.

In the pop-up dialog box, you can do one of the following:

• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search.

• Click Reload to refresh the contents and display the updated information for

the specified time period.

• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.

The comma-separated value (CSV) format takes the rawdata from the report
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anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 15-Min parameter-name tab.

9. In the24-Hrs column, click theChartbutton for theperformancemonitoringparameter

set for which you want to view the statistics for the previous day. This option enables

you to view the statistics in a chart form. By default, records pertaining to the last 30

daysaredisplayedwhenyouviewtheperformancemonitoringcounters for the24-hour

duration.

A 24Hours parameter-name tab is displayed beside the TCAConfig tab at the top-left

cornerof theOpticsPMsdialogbox.Agraphical formatof thestatistics for thespecified

parameter is displayed on this tab.

10. Click the 24 Hours parameter name tab.

a. Select one of the following options from the drop-downmenu:

• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

with date along the horizontal axis and the parameter along the vertical axis. A

color-coding format is used to display the different lines, and legends reference

theparameternamescorresponding to the linesdisplayed.Mouseover thepoints

in the line graph to expand and show the value of the performancemonitoring

counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.

Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.

• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.

In the pop-up dialog box, you can do one of the following:

• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search. Click Reload to refresh the contents and display the updated

information for the specified time period.

• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.
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The comma-separated value (CSV) format takes the rawdata from the report

anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 24 Hours parameter-name tab.

11. Click theClearPMs button at the top of the dialog box, and select one of the following

values from the drop-downmenu to clear OTU information from the transport

performancemonitoring data.

• Current—Clear the OTU information for the current interval, such as 15-minute

interval or 24-hour interval, for which monitoring data is being collected.

• Current Day—Clear the OTU information for the current 24 hours.

• All Intervals—Clear the OTU information for the current 15-minute interval, the 96

records of 15-minute intervals, the current day, and the previous day

After you select one of the intervals for which monitoring data must be deleted, a

Clear Optics PMs dialog box is displayed to indicate that a job is triggered to delete

the monitoring information from themodule on the device. The job ID, start and end

times of the job, percentage of completion, and status of the job are displayed.

12. Click Close to close the job dialog box; alternatively, click Refresh to update the job

status and view.

You can use the Jobs Management page (by clicking the System icon on the banner

and selecting Manage Jobs) to track the status of this job.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest performancemonitoring statistics to be polled and displayed.

Related
Documentation

ConfiguringThreshold-CrossingAlarms forOTNPorts forMonitoring LinkPerformance

on page 1440

•

• Configuring Threshold-Crossing Alarms for OTUs for Monitoring Link Performance on

page 1442

• Configuring Threshold-Crossing Alarms for ODUs for Monitoring Link Performance on

page 1444

• Viewing Performance Monitoring Details of OTN Ports for Detecting and Diagnosing

Faults on page 1446

• Viewing PerformanceMonitoring Details of ODUs for Detecting and Diagnosing Faults

on page 1457
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ViewingPerformanceMonitoringDetails ofODUs for Detecting andDiagnosing Faults

To analyze and resolve any faults associated with optical channel data units (ODUs) of

OTN ports, it is essential to view the diagnostic data, warnings, and alarms for transport

performancemonitoring. The different types of parameters related to performance

monitoring that are retrieved from theODUs enable you to ensure service availability and

verify or monitor individual services and the service network performance.

The performancemonitoring capability in Connectivity Services Director displays

information about the health of your network and changing conditions of the OTUs of

OTN ports. Use this diagnosis and detection mechanism to identify problems with the

equipment, pinpoint security attacks, or to analyze trends and categories of errors. This

feature includes fault-monitoring details in the dashboard, in monitoring pages, and on

a dedicated page that displays alarms, events, and system logmessages that are

generated.Performancemonitoringparameterscanbeviewed inbothchartandstatistical

formats. These charts and statistical details provide essential and cohesive information

about system conditions, any discrepancies andmalfunctioning, and protocols or

components that need to be examined and debugged for better efficiency and working

capacity. You can assess the performance of your network, not only at a point in time,

but also over a period of time. This feature enables you to determine trending and

network-healthparameters; for example,whether service-level agreements (SLAs)have

been violated.

To view performancemonitoring details of ODUs:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Select an optical interface in the image of the device.

The Optical Port dialog box is displayed on the right pane.

6. Click theODUPath header at the bottom of the dialog box.
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The ODU Path pane is expanded and displayed. This pane contains the Equipment,

Status/Config, and Performance tabs.

7. Click the Performance tab at the bottom of the pane.

This pane contains the Perf Mon and TCA Config tabs. The Perf Mon tab of the ODU

PMs dialog box is displayed.

The following fields are displayed in the Perf Mon tab of theODUPMs dialog box. The

date and time at which the dialog box was last refreshed is shown.

• ODU FE—ODU far-endmeasurement threshold

BBE—Background block error threshold-crossing defect trigger for ODU far-end

ES—Errored seconds threshold-crossing defect trigger for ODU far-end

SES—Severely errored seconds threshold-crossing defect trigger for ODU far-end

UAS—Unavailable seconds threshold-crossing defect trigger for ODU far-end

• ODU NE—ODU near-endmeasurement threshold for ODU near-end

BBE—Background block error threshold-crossing defect trigger for ODU near-end

ES—Errored seconds threshold-crossing defect trigger for ODU near-end

SES—Severely errored seconds threshold-crossing defect trigger for ODUnear-end

UAS—Unavailable seconds threshold-crossing defect trigger for ODU near-end

On the Perf Mon tab, for the TCA column, either a minus sign (–) is displayed that

denotes that an alarm for threshold-exceed is not configured or a check mark is

displayed and grayed out that indicates that the TCA for the particular attribute is

configured.

8. In the 15Minscolumn, click theChartbutton for theperformancemonitoringparameter

set forwhich youwant to view the statistics for the last 15minutes. This optionenables

you to view the statistics in a chart form. By default, 96 records of 15-minute intervals

are displayed.

A 15-Min parameter-name tab is displayed beside the TCA Config tab at the top-left

cornerof theOpticsPMsdialogbox.Agraphical formatof thestatistics for thespecified

parameter is displayed on this tab.

9. Click the 15 Mins parameter name tab.

a. Select one of the following options from the drop-downmenu:
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• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

withdateand timealong thehorizontal axis and theparameter along thevertical

axis. A color-coding format is used to display the different lines, and legends

reference the parameter names corresponding to the lines displayed. Mouse

over thepoints in the linegraph toexpandandshowthevalueof theperformance

monitoring counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

The records are displayed in tabular format. A serial number of the count of

entries, the day, month, and year at which the entry was collected, and the time

at which the entry was collected are displayed. The timestamp is the UTC time

in the database that is mapped to the local time zone of the client computer.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.

Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.

• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.

In the pop-up dialog box, you can do one of the following:

• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search.

• Click Reload to refresh the contents and display the updated information for

the specified time period.

• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.

The comma-separated value (CSV) format takes the rawdata from the report

anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 15-Min parameter-name tab.

10. In the24-Hrs column, click theChartbutton for theperformancemonitoringparameter

set for which you want to view the statistics for the previous day. This option enables

you to view the statistics in a chart form. Performancemonitoring information for the

different parameters are displayed for the current 24-hour interval. By default, records

pertaining to the last 30daysaredisplayedwhenyouviewtheperformancemonitoring

counters for the 24-hour duration.
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A24Hours parameter-name tab is displayed beside the TCAConfig tab at the top-left

cornerof theOpticsPMsdialogbox.Agraphical formatof thestatistics for thespecified

parameter is displayed on this tab.

11. Click the 24 Hours parameter name tab.

a. Select one of the following options from the drop-downmenu:

• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

with date along the horizontal axis and the parameter along the vertical axis. A

color-coding format is used to display the different lines, and legends reference

theparameternamescorresponding to the linesdisplayed.Mouseover thepoints

in the line graph to expand and show the value of the performancemonitoring

counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.

Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.

• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.

In the pop-up dialog box, you can do one of the following:

• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search. Click Reload to refresh the contents and display the updated

information for the specified time period.

• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.

The comma-separated value (CSV) format takes the rawdata from the report

anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 24 Hours parameter-name tab.

12. Click theClearPMs button at the top of the dialog box, and select one of the following

values from the drop-downmenu to clear ODU information from the transport

performancemonitoring data.
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• Current—Clear the optics and OTN information for the current interval, such as

15-minute interval or 24-hour interval, for whichmonitoring data is being collected.

• Current Day—Clear the ODU information for the current 24 hours.

• All Intervals—Clear the ODU information for the current 15-minute interval, the 96

records of 15-minute intervals, the current day, and the previous day

After you select one of the intervals for which monitoring data must be deleted, a

Clear Optics PMs dialog box is displayed to indicate that a job is triggered to delete

the monitoring information from themodule on the device. The job ID, start and end

times of the job, percentage of completion, and status of the job are displayed.

13. Click Close to close the job dialog box; alternatively, click Refresh to update the job

status and view.

You can use the Jobs Management page (by clicking the System icon on the banner

and selecting Manage Jobs) to track the status of this job.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest performancemonitoring statistics to be polled and displayed.

Related
Documentation

ConfiguringThreshold-CrossingAlarms forOTNPorts forMonitoring LinkPerformance

on page 1440

•

• Configuring Threshold-Crossing Alarms for OTUs for Monitoring Link Performance on

page 1442

• Configuring Threshold-Crossing Alarms for ODUs for Monitoring Link Performance on

page 1444

• Viewing Performance Monitoring Details of OTN Ports for Detecting and Diagnosing

Faults on page 1446

• Viewing Performance Monitoring Details of OTUs for Detecting and Diagnosing Faults

on page 1452

Viewing a Graphical Image of the Chassis of PTX Series Routers

In the Connectivity Services Director GUI, you can view a graphical representation of a

device from Build mode of Device View by selecting the DeviceManagement > View

Physical Inventory option from the Tasks pane. The hardware and line module details

are displayedwith a pictorial view of the slots of the PTXSeries routers and themodules

installed in these slots. TheChassisViewprovidesapictorial representationof the chassis

or device, and themodules or components that are installed in it, such as the line cards,

interfaces, and other hardware elements.

To view a pictorial representation of a device chassis and the configured components,

such as interfaces, line cards, and hardware elements, select a managed device listed

on theMyNetwork tree inDeviceViewofConnectivityServicesDirector, andselectDevice

Management > View Physical Inventory from the tasks pane. The right pane displays the
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device imageand the correspondingdescriptionof the viewselected in a tabularmanner.

The Chassis View is displayed. The hardware and line module details are displayed with

a pictorial view of the slots of the devices and themodules installed in these slots. The

device image can be rotated to view the front, rear, top, bottom, right and left planes of

the device by clicking the respective arrow buttons on the page.

To view a graphical image of the chassis and its associated components:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Click a particular component or interface to display the associated details in the lower

portionof thepage.TheRotateandPerspectivebuttonsenable you toview the images

images in required orientation.

6. Click the View Back (arrows in a square symbol) icon to cause the device image to

rotate along the x-axis and display the rear view of the device. Alternatively, click the

View Front icon to view the front plane of the device. The View Back and View Front

icons are toggle options.

7. Click the Perspective (cube symbol) icon to display the device image in

three-dimensional format. It is a toggle button, which causes the device image to be

shown in either three-dimensional or one-dimensional format.

8. Select the level ofmagnification of the imageby clicking theZoom (magnifying glass)

icon. The image is expanded and displayed.

Alternatively, use the slider control beneath the Zoom icon to change the level of

magnification.

9. Click the home icon to return to the front view of the chassis. The selected interface

is surrounded with a colored outline based on the operational status. An interface

that is operationally up is denoted in green andan interface that is operationally down
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is represented in red. The components are depicted as small colored icons at the

top-left corner of the front view of the equipment image.

In the graphical image of the device displayed, you canmouse over the different parts

of the device, such as the interfaces, line cards, and slots. When youmouse over the

different modules, their corresponding details are displayed as tooltips. On clicking the

device components, the corresponding description for the selected component is

displayedbydefault in theComponent InfopaneandtheEquipment tabwith the following

values.

• Description—Brief description of the hardware item:

• Type of power supply.

• Type of PIC. If the PIC type is not supported on the current software release, the

output states Hardware Not Supported.

• Type of FPC: FPC Type 1, FPC Type 2, FPC Type 3, FPC Type 4 , or FPC TypeOC192.

On EX Series switches, a brief description of the FPC.

On the J Series routers, the FPC type corresponds to the Physical Interface Module

(PIM). The following list shows the PIM abbreviation in the output and the

corresponding PIM name.

• 2x FE—Either two built-in Fast Ethernet interfaces (fixed PIM) or dual-port Fast

Ethernet PIM

• 4x FE—4-port Fast Ethernet ePIM

• 1x GE Copper—Copper Gigabit Ethernet ePIM (one 10-Mbps, 100-Mbps, or

1000-Mbps port)

• 1x GE SFP—SFP Gigabit Ethernet ePIM (one fiber port)

• 4x GE Base PIC—Four built-in Gigabit Ethernet ports on a J4350 or J6350 chassis

(fixed PIM)

• 2x Serial—Dual-port serial PIM

• 2x T1—Dual-port T1 PIM

• 2x E1—Dual-port E1 PIM

• 2x CT1E1—Dual-port channelized T1/E1 PIM

• 1x T3—T3 PIM (one port)

• 1x E3—E3 PIM (one port)

• 4x BRI S/T—4-port ISDN BRI S/T PIM

• 4x BRI U—4-port ISDN BRI U PIM

• 1x ADSL Annex A—ADSL 2/2+ Annex A PIM (one port, for POTS)

• 1x ADSL Annex B—ADSL 2/2+ Annex B PIM (one port, for ISDN)

1463Copyright © 2019, Juniper Networks, Inc.

Chapter 54: Configuring and Monitoring Optical Interfaces, OTUs, and ODUs



• 2x SHDSL (ATM)—G SHDSL PIM (2-port two-wire module or 1-port four-wire

module)

• 1x TGM550—TGM550 Telephony Gateway Module (Avaya VoIP gatewaymodule

with one console port, two analog LINE ports, and two analog TRUNK ports)

• 1x DS1 TIM510—TIM510 E1/T1 Telephony Interface Module (Avaya VoIPmedia

module with one E1 or T1 trunk termination port and ISDN PRI backup)

• 4x FXS, 4xFX0, TIM514—TIM514 Analog Telephony Interface Module (Avaya VoIP

media module with four analog LINE ports and four analog TRUNK ports)

• 4xBRITIM521—TIM521BRITelephony InterfaceModule (AvayaVoIPmediamodule

with four ISDN BRI ports)

• CryptoAcceleratorModule—Forenhancedperformanceofcryptographicalgorithms

used in IP Security (IPsec) services

• MPCM 16x 10GE—16-port 10-Gigabit Module Port Concentrator that supports SFP+

optical transceivers. (Not on EX Series switches.)

• For hosts, the Routing Engine type.

• For small form-factor pluggable transceiver (SFP) modules, the type of fiber: LX,

SX, LH, or T.

• LCD description for EX Series switches (except EX2200 switches).

• MPC2—1-port MPC2 that supports two separate slots for MICs.

• MPC3E—1-port MPC3E that supports two separate slots for MICs

(MIC-3D-1X100GE-CFP and MIC-3D-20GE-SFP) on MX960, MX480, and MX240

routers. The MPC3Emaps one MIC to one PIC (1 MIC, 1 PIC), which differs from the

mapping of legacy MPCs.

• 100GBASE-LR4, pluggable CFP optics

• Supports theEnhancedMXSwitchControlBoardwith fabric redundancyandexisting

SCBs without fabric redundancy.

• Interoperateswith existingMXSeries line cards, includingFlexiblePortConcentrators

(FPC), Dense Port Concentrators (DPCs), and Modular Port Concentrators (MPCs).

• MPC4E—Fixed configuration MPC4E that is available in two flavors:

MPC4E-3D-32XGE-SFPPandMPC4E-3D-2CGE-8XGEonMX2020,MX960,MX480,

and MX240 routers.

• LCD description for MX Series routers

• Model—Model number of the FRU component.

• Name—Name of the SDG and the platform type, such as MX240 or MX480. This field

displays the components of the device, such as chassis, PIC, CPU, andPIC parameters.

Informationabout thechassis,midplane, craft interface (FPM),powermidplane (PMP),

Power SupplyModules (PSMs), Power DistributionModules (PDMs), Routing Engines,

ControlBoards (CBs)andSwitchProcessorMezzanineBoards(SPMBs),SwitchFabric

Boards (SFBs), Flexible PIC Concentrators (FPCs), PICs, adapter cards (ADCs) and

fan trays is displayed.
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• Manufacturer—Name of the company that built and shipped the device.

• Part number—Part number of the chassis component.

• Serial number—Serial number of the chassis component. The serial number of the

backplane is also the serial number of the router or switch chassis. Use this serial

number when you need to contact Juniper Networks Customer Support about the

router or switch chassis.

The Active Alarmsmonitor shows any active alarm that has not yet been cleared. It is

one of the four standardmonitors available in Alarmmode. Active Alarms is a table that

has four fields and appear by default. However, nine fields are available for selection.

View Table 189 on page 1261 for a description of the table.

Table 244: Active AlarmsMonitor

NoNoA system and sequentially-generated identification number.ID

YesNoIf assigned to an individual, it shows the name of the person
assigned; otherwise, it shows System tomark that the alarm
is still unassigned.

Assigned To

YesYesThe severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is
necessary.

• Major—Amajor error has occurred; escalate or notify as
necessary.

• Minor—Aminor error has occurred; notify or monitor the
condition.

• Info—An informational message; no action is necessary.

Severity

YesYesThe identification of the entity responsible for causing this
alarm. The Entity ID is the key for correlation of events into
an alarm. The Entity ID could be a MAC address of a radio or
an IP address of the device.

Entity ID

NoNoThe IP address of the device or network element that
generated thealarm.TheSNMPagent is locatedat the source
IP. Inmost cases, the source IP is the IP address of the switch
or controller.

Source

YesYesThe hostname or IP address of the reporting device.Reporting Device

NoNoThe date and time the alarmwas first reported.Creation Date

YesYesThedate and time that the information for the alarmwas last
modified.

Last Updated

NoNoEither the system or the last user whomodified the alarm.Updated By

Related
Documentation

Viewing a Graphical Image of the Optical Interface Components on page 1411•
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Diagnosing, Examining, and Correcting Optical Interface Problems

Connectivity Services Director enables you to manage the optical functionality provided

by 100-Gigabit Ethernet PIC that can be installed in MX Series and PTX Series routers. A

topological network view is implemented, which enables you the user to visualize optical

sites, links and services and a site view that provides status, configuration, alarms and

faultmanagement, andperformancemonitoring functionalitieson theoptical interfaces.

FCAPS (fault, configuration, accounting, performance, and security) is a categorical

model of the working objectives of network management.

The faultmanagement capability inConnectivityServicesDirector showsyou information

about the health of your network and changing conditions of your equipment. Use this

diagnosis and detection mechanism to identify problems with the equipment, pinpoint

security attacks, or to analyze trends and categories of errors. This feature includes

fault-monitoring details in the dashboard, monitoring pages, and in a dedicated page

that displays thealarms, events, and system loggingmessages that are generated. These

chartsandmessagesprovideessential andcohesive informationaboutsystemconditions,

any discrepancies andmalfunctioning, and protocols or components that need to be

examined and debugged for better efficiency and working capacity.

You can assess the performance of your network, not only at a point in time, but also

over a period of time. This feature enables you to determine trending andnetwork-health

parameters; for example, whether service-level agreements (SLAs) have been violated.

The fault management data includes SNMP traps and syslogs received from PTX Series

routers. Junos Space platform is integrated with OpenNMS, which is a network

management application platform that provides solutions for enterprises and carriers,

to receive SNMP Traps. Connectivity Services Director uses OpenNMS for SNMP trap

collection and correlation.

Activity on a network device consists of a series of events. Optical interfaces generate

SNMP traps when certain types of events are persistent, or when the condition causing

theevent crossesa threshold,SNMPsendsanotification, alsocalleda trap toConnectivity

Services Director. Connectivity Services Director correlates traps, describing a condition,

into an alarm . You can use the Fault Management pagemonitor to sort alarms, view an

alarm in depth, and to assign a disposition to an alarm.

Alarms include Clear and Set alarms. All alarms are listed under OTN category and can

becritical,major, orminor severity levels. Threemain categories of alarms—Optical, OTU,

and ODU—are displayed.

Threshold-crossing alarms (TCAs) are alarms that are activated when a certain

configurable threshold—near-endmeasurement threshold or far-endmeasurement

threshold—is crossed and remains so until the end of the 15-minute interval and the

24-hour interval for parameters such as optical channel transport unit (OTU) andoptical

data unit (ODU). A near-endmeasurement is associated with ingress data frames and

a far-endmeasurement is associated with egress data frames. Monitoring the

performance of links provides for end-to-end Ethernet service assurance over any path

for either a single link or multiple links spanning networks composed of multiple LANs.

The link performancemetrics enable operators to offer binding service-level agreements
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(SLAs) and generate new revenues from rate- and performance-guaranteed service

packages that are tailored to the specific needs of their customers.

Optical Alarms, 24 Hour Threshold-Crossing Alarms (TCA), and 15Minute Threshold-Crossing
Alarms (TCA)

The following are the different optical alarms that are generated:

• AvgPowerAlarm—Average Power Alarm

• BiasCurrentHighAlarm—Bias Current High Alarm

• BiasCurrentLowAlarm—Bias Current Low Alarm

• ChromaticDispHighWarning—Chromatic Dispersion HighWarning

• ChromaticDispLowWarning—Chromatic Dispersion LowWarning

• LOS—Loss Of Signal

• LossofACPowerAlarm—Loss of Alternating Current (AC) Power Alarm

• ModuleTempHighWarning—Module Temperature HighWarning

• ModuleTempLowWarning—Module Temperature LowWarning

• OSNRLowWarning—Optical Signal to Noise Ratio (OSNR) LowWarning

• PowerHighAlarm—Power High Alarm

• PowerLowAlarm—Power Low Alarm

• QLowWarning—Q Factor LowWarning

• RxCarrierFreqHigh—Receive Carrier Frequency High

• RxCarrierFreqLow—Receive Carrier Frequency Low

• RxLossAvgPowerAlarm—Receive Loss Average Power Alarm

• RxPLLLockAlarm—Receive Phase Lock Loop Alarm

• RxPowerHighAlarm—Receive Power High Alarm

• RxPowerHighWarning—Receive Power HighWarning

• RxPowerLowAlarm—Receive Power Low Alarm

• RxPowerLowWarning—Receive Power LowWarning

• TemperatureHighAlarm—Temperature High Alarm

• TemperaturelowAlarm—Temperature Low Alarm

• TxPLLLockAlarm—Transmit Phase Loop Lock Alarm

• TxPowerHighWarning—Transmit Power HighWarning

• TxPowerLowWarning—Transmit Power LowWarning

• WavelenthLockErr—Wavelength Lock Error

The following are the threshold-crossing alarms generated when threshold is exceeded

over the last 15 minutes for optical interfaces:
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• 24HourModuleTempHighThreshAlert—24 Hour Module Temperature High Threshold

Alert

• 24HourModuleTempLowThreshAlert—24 Hour Module Temperature Low Threshold

Alert

• 24HourRxPowerHighThreshAlert—24 Hour Receive Power High Threshold Alert

• 24HourRxPowerLowThreshAlert—24 Hour Receive Power Low Threshold Alert

• 24HourTxPowerHighThreshAlert—24 Hour Transmit Power High Threshold Alert

• 24HourTxPowerLowThreshAlert—24 Hour Transmit Power Low Threshold Alert

The following are the threshold-crossing alarms generated when threshold is exceeded

over the last 24 hours for optical interfaces:

• RxPowerHighThreshAlert—15 Minute Receive Power High Threshold Alert

• ModuleTempHighThreshAlert—15 Minute Module Temperature High Threshold Alert

• RxPowerLowThreshAlert—15 Minute Receive Power Low Threshold Alert

• TxPowerHighThreshAlert—15 Minute Transmit Power High Threshold Alert

• TxPowerLowThreshAlert—15 Minute Transmit Power Low Threshold Alert

• ModuleTempLowThreshAlert—15 Minute Module Temp Low Threshold Alert

OTUAlarms, 24 Hour Threshold-Crossing Alarms (TCA), and 15Minute Threshold-Crossing
Alarms (TCA)

The following are the different OTU alarms that are generated:

• OtnLofAlarm—Loss of Frame Alarm

• OtnLomAlarm—Loss of Multi-frame Alarm

• OtnLosAlarm—Loss of Signal Alarm

• OtnNoAlarm—OTN No Alarm

• OtuBdiAlarm—OTU Backward Error Indication Alarm

• OtuBiaeAlarm—OTU Backward Incoming Alignment Error Alarm

• OtuDegAlarm—OTU Degradation Alarm

• OtuFecExcessiveErrsAlarm—OTU Forward Error Correction (FEC) Excessive Errors

Alarm

• OtuIaeAlarm—OTU Incoming Alignment Error Alarm

• OtuSsfAlarm—OTU Server Signal Fail Alarm

• OtuTimAlarm—OTU Trace Identifier Mismatch Alarm

• OtuTsfAlarm—OTU Trail Signal Fail Alarm

The following are the threshold-crossing alarms generated when threshold is exceeded

over the last 15 minutes for OTU attributes:
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• 24HourThreshBBETCA—24 Hour Background Block Error Threshold Alert

• 24HourThreshBip8TCA—24 Hour Bit Interleaved Parity (BIP-8) Threshold Alert

• 24HourThreshESTCA—24 Hour Errored Seconds Threshold Alert

• 24HourThreshPreFECBERTCA—24 Hour Pre-Forward Error Correction Threshold Alert

• 24HourThreshSESTCA—24 Hour Severely Errored Seconds Threshold Alert

• 24HourThreshUASTCA—24 Hour Unavailable Second Threshold Alert

The following are the threshold-crossing alarms generated when threshold is exceeded

over the last 24 hours for OTU attributes:

• 15MinThreshBBETCA—15 Minute Background Block Error Threshold Alert

• 15MinThreshBip8TCA—15 Minute Bit Interleaved Parity (BIP-8) Threshold Alert

• 15MinThreshESTCA—15 Minute Errored Seconds Threshold Alert

• 15MinThreshPreFECBERTCA—15 Minute Pre-Forward Error Correction Threshold Alert

• 15MinThreshSESTCA—15 Minute Severely Errored Seconds Threshold Alert

• 15MinThreshUASTCA—15 Minute Unavailable Second Threshold Alert

• 15MinThUnCorrectedWordsTCA—15 Minute UnCorrected Codewords Threshold Alert

ODUAlarms, 24 Hour Threshold-Crossing Alarms (TCA), and 15Minute Threshold-Crossing
Alarms (TCA)

The ODU tables cover both the Path and TCM layers but TCM layers are currently not

supported. The following are the different ODU alarms that are generated:

• PtmAlarm—Payload Type Mismatch Alarm

• TcmAisAlarm—Alarm Indication Signal Alarm

• TcmBdiAlarm—Backward Error Indication Alarm

• TcmCSFAlarm—CSFAlarm

• TcmDegAlarm—Degradation Alarm

• TcmIaeAlarm—Incoming Alignment Error Alarm

• TcmLckAlarm—Locked Alarm

• TcmLTCAlarm—Loss of tandem Connection Alarm

• TcmOciAlarm—Open Connection Indication Alarm

• TcmSSfAlarm—Server Signal Fail Alarm

• TcmTimAlarm—Trace Identifier Mismatch Alarm

• TcmTSfAlarm—Trail Signal Fail Alarm

• OdukTcmNoAlarm—OTN No Alarm
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The following are the threshold-crossing alarms generated when threshold is exceeded

over the last 15 minutes for ODU attributes:

• Tcm15MinThreshBBETCA—15 Minute Background Block Error Threshold Alert

• Tcm15MinThreshBip8TCA—15 Minute Bit Interleaved Parity (BIP-8)

• Threshold Alert Tcm15MinThreshESTCA—15 Minute Errored Seconds Threshold Alert

• Tcm15MinThreshSESTCA—15 Minute Severely Errored Seconds

• Threshold Alert Tcm15MinThreshUASTCA—15 Minute Unavailable Second Threshold

Alert

The following are the threshold-crossing alarms generated when threshold is exceeded

over the last 24 hours for ODU attributes:

• Tcm24HourThreshBBETCA—24 Hour Background Block Error Threshold Alert

• Tcm24HourThreshBip8TCA—24 Hour Bit Interleaved Parity (BIP-8) Threshold Alert

• Tcm24HourThreshESTCA—24 Hour Errored Seconds Threshold Alert

• Tcm24HourThreshSESTCA—24 Hour Severely Errored Seconds Threshold Alert

• Tcm24HourThreshUASTCA—24 Hour Unavailable Second Threshold Alert

Related
Documentation

Diagnosing, Examining, and Correcting Optical Interface Problems on page 1466•

Changing Alarm Settings for the Optics and OTN Interfaces

You canmodify the configuration settings for alarm settings of optical interfaces using

the Preferences page of the Connectivity Services Director application. To open the

Preferences page, click the down arrow next to the System button in the Connectivity

Services Director banner and select Preferences. The Preferences page opens with User

Preferences as the default tab. Click the Fault tab of the Preferences page of the

Connectivity Services Director GUI to enable individual alarms, set the retention period

for alarms, configure alarm notifications, configure threshold alarms, and to specify the

number of events to keep for each alarm. The Fault tab hasmultiple sections, which you

can expand and collapse by clicking the arrow next to the section title:

• Global Settings, for configuring Faults settings such as global alarm notifications and

alarm data retention.

• Individual Alarms andThreshold Settings, for configuring settings for individual alarms

and threshold alarms.

This section describes the following tasks that you can perform by using the alarm

monitors displayed in Fault mode:

• Alarms for Optical Interfaces on page 1471

• Alarms for OTN Interfaces on page 1476

• Configuring Global Alarm Notifications on page 1481
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• Retaining Alarm History on page 1481

• Specifying Event History on page 1481

• Enabling Alarms on page 1482

• Changing the Severity of Individual Alarms on page 1482

• Configuring Threshold Alarms on page 1482

• Configuring Individual Alarm Notifications on page 1483

Alarms for Optical Interfaces

The following alarms are applicable for management of the Optics interface.

• JnxOpticsLocation—Near end or far end

• jnxOpticsPerformanceMonitoring—{ jnxIfOpticsMib 2 }

• jnxOpticsAlarm—{ jnxIfOpticsMib 3 }

• jnxOpticsConfigTable—This table provides information on the optics configuration.

• jnxOpticsConfigEntry—Aconceptual row that contains information about the optics

configuration Table.

• jnxOpticsConfigContainerIndex—The associated jnxContentsContainerIndex, for

example, shelf.

• jnxOpticsConfigL1Index—The levelone indexassociatedwith this subject, forexample,

slot.

• jnxOpticsConfigL2Index—The level two index associated with this subject, for

example, port.

• jnxOpticsConfigL3Index—The level three index associated with this subject, for

example, channel.

• jnxOpticsType

• jnxLaserEnable—The transmit wavelength of the laser.

• jnxSpacing—Aminimumnominaldifference in frequency(GHz)betweentwoadjacent

channels.

• jnxModulation

• jnxTxOpticalPower—Transmit optical power.

• jnxModuleTempHighThresh—Highmodule temperature in degree Fahrenheit above

which a Threshold Crossing Alert (TCA) should be sent.

• jnxModuleTempLowThresh—Lowmodule temperature in degree Fahrenheit above

which a Threshold Crossing Alert (TCA) should be sent.

• jnxTxPowerHighThresh—Tx power above which a Threshold Crossing Alert (TCA)

should be sent.

• jnxTxPowerLowThresh—Tx Power belowwhich a Threshold Crossing Alert (TCA)

should be sent.
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• jnxRxPowerHighThresh—Rx power above which a Threshold Crossing Alert (TCA)

should be sent.

• jnxRxPowerLowThresh—Rx Power belowwhich a Threshold Crossing Alert (TCA)

should be sent.

• jnxOpticsTraceToneCfgTable—Information about the optics tests.

• jnxOpticsTraceToneCfgEntry—Information about the optics FRUs

• jnxOpticsTraceToneCfgContainerIndex—Theassociated jnxContentsContainerIndex,

for example, shelf.

• jnxOpticsTraceToneCfgL1Index—The level one index associated with this subject,

for example slot.

• jnxOpticsTraceToneCfgL2Index—The level two index associated with this subject,

for example port.

• jnxOpticsTraceToneCfgL3Index—The level three index associated with this subject,

for example channel.

• jnxOpticsTraceToneCfgTxEnable—Enable/disable the transmit Trace tone feature.

• jnxOpticsTraceToneCfgRxEnable—Enable/disable the receive Trace tone feature.

• jnxOpticsTraceToneCfgDestId—The destination Id of the link ID/ the chassis and

the blade. The transmit messages will also have the src id, which is this chassis id

and this port info.

• jnxOpticsTraceToneCfgTxMsg—The transmit data in the tracetonemessage.

• jnxOpticsTraceToneCfgRxMsg—The received data in the trace tonemessage.

• jnxOpticsPMCurrentTable—A table of current performancemonitoring entries.

• jnxOpticsPMCurrentEntry—A conceptual row that contains information about the

Performance Monitoring Current Table.

• jnxPMCurChromaticDispersion—Residual Chromatic Dispersion measured at Rx

Transceiver port.

• jnxPMCurDiffGroupDelay—Differential group delay.

• jnxPMCurPolarizationState—Polarization state.

• jnxPMCurPolarDepLoss—The polarization dependent loss (PDL) is the difference

(in dB) between themaximum andminimum values of the channel insertion loss

(or gain) of the black-link from point SS to RS due to a variation of the state of

polarization (SOP) over all SOPs.

• jnxPMCurQ—'Q' factor estimated at Rx Transceiver port.

• jnxPMCurSNR—SNR–signal-to-noise ratio.

• jnxPMCurTxOutputPower—TxOutputPower–transmit output power.

• jnxPMCurRxInputPower—RxInputPower–receive output power
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• jnxPMCurMinChromaticDispersion—Minimum Residual Chromatic Dispersion

measured at Rx Transceiver port.

• jnxPMCurMaxChromaticDispersion—Maximum Residual Chromatic Dispersion

measured at Rx Transceiver port.

• jnxPMCurAvgChromaticDispersion—AverageResidualChromaticDispersionmeasured

at Rx Transceiver port.

• jnxPMCurMinDiffGroupDelay—MinimumDifferential group delay

• jnxPMCurMaxDiffGroupDelay—MaximumDifferential group delay

• jnxPMCurAvgDiffGroupDelay—Average Differential group delay

• jnxPMCurMinPolarState—Minimum Polarization state

• jnxPMCurMaxPolarState—Maximum Polarization state

• jnxPMCurAvgPolarState—Average Polarization state

• jnxPMCurMinPolarDepLoss—Minimum polarization dependent loss (PDL)

• jnxPMCurMaxPolarDepLoss—Maximum polarization dependent loss (PDL)

• jnxPMCurAvgPolarDepLoss—Average polarization dependent loss (PDL)

• jnxPMCurMinQ—Minimum 'Q' factor estimated at Rx Transceiver port.

• jnxPMCurMaxQ—Max 'Q' factor estimated at Rx Transceiver port.

• jnxPMCurAvgQ—Average 'Q' factor estimated at Rx Transceiver port.

• jnxPMCurMinSNR—Minimum SNR–signal-to-noise ratio

• jnxPMCurMaxSNR—Maximum SNR–signal-to-noise ratio

• jnxPMCurAvgSNR—Average SNR–signal-to-noise ratio

• jnxPMCurMinTxOutputPower—Minimum TxOutputPower–transmit output power

• jnxPMCurAvgTxOutputPower—Average TxOutputPower–transmit output power

• jnxPMCurMinRxInputPower—Minimum RxInputPower–receive output power

• jnxPMCurMaxRxInputPower—Maximum RxInputPower–receive output power

• jnxPMCurAvgRxInputPower—Average RxInputPower–receive output power

• jnxPMCurSuspectedFlag—If true, the data in this entry may be unreliable.

• jnxPMCurSuspectReason—If SuspectedFlag is true, the reason for the performance

monitoring data being suspect.

• jnxOpticsPMIntervalTable—A table of current performancemonitoring entries.

• jnxOpticsPMIntervalEntry—A conceptual row that contains information about the

Performance Monitoring Interval Table.

• jnxOpticsPMIntervalNumber—This is the 15 minute interval number.

• jnxPMIntMinChromaticDispersion—Residual Chromatic Dispersion measured at Rx

Transceiver port–minimum in the 15 minute interval.
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• jnxPMIntMaxChromaticDispersion—Residual Chromatic Dispersion measured at Rx

Transceiver port–maximum in the 15 minute interval.

• jnxPMIntAvgChromaticDispersion—Residual Chromatic Dispersion measured at Rx

Transceiver port–average in the 15 minute interval.

• jnxPMIntMinDiffGroupDelay—Differential group delay measured at Rx Transceiver

port–minimum in the 15 minute interval.

• jnxPMIntMaxDiffGroupDelay—Differential group delay measured at Rx Transceiver

port–maximum in the 15 minute interval

• jnxPMIntAvgDiffGroupDelay—Differential group delay measured at Rx Transceiver

port–average in the 15 minute interval

• jnxPMIntMinPolarState—Polarization state–minimum in the 15 minute interval

• jnxPMIntMaxPolarState—Polarization state–max in the 15 minute interval

• jnxPMIntAvgPolarState—Polarization state–average in the 15 minute interval

• jnxPMIntMinPolarDependentLoss—Polarization Dependent Loss–minimum in the

15 minute interval

• jnxPMIntMaxPolarDependentLoss—Polarization Dependent Loss–maximum in the

15 minute interval

• jnxPMIntMinQ—Q–minimum in the 15 minute interval

• jnxPMIntMaxQ—Q–maximum in the 15 minute interval

• jnxPMIntAvgQ—Q–Average in the 15 minute interval

• jnxPMIntMinSNR—SNR–minimum in the 15 minute interval

• jnxPMIntMaxSNR—SNR–maximum in the 15 minute interval

• jnxPMIntAvgSNR—SNR–average in the 15 minute interval

• jnxPMIntMinTxOutputPower—TxOutputPower–minimum in the 15 minute interval

• jnxPMIntMaxTxOutputPower—TxOutputPower–maximum in the 15 minute interval

• jnxPMIntAvgTxOutputPower—TxOutputPower–average in the 15 minute interval

• jnxPMIntMinRxInputPower—RxInputPower–minimum in the 15 minute interval

• jnxPMIntMaxRxInputPower—RxInputPower–maximum in the 15 minute interval

• jnxPMIntAvgRxInputPower—RxInputPower–average in the 15 minute interval

• jnxPMIntTimeStamp—Time stamp performancemonitoring interval

• jnxPMIntSuspectedFlag—If true, the data in this entry may be unreliable.

• jnxPMIntSuspectReason—If SuspectedFlag is true, the reason for the performance

monitoring data being suspect.

• jnxOpticsPMDayTable—A table of current performancemonitoring Day entries.
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• jnxOpticsPMDayEntry—A conceptual row that contains information about the

performancemonitoring Day Table

• jnxOpticsPMDayIndex—This is 0 - cur day/ 1- prev day

• jnxPMDayMinChromaticDispersion—Residual ChromaticDispersionmeasuredatRx

Transceiver port–minimum in the day

• jnxPMDayMaxChromaticDispersion—Residual Chromatic Dispersion measured at

Rx Transceiver port–maximum in the day

• jnxPMDayAvgChromaticDispersion—Residual Chromatic Dispersion measured at

Rx Transceiver port–average in the day

• jnxPMDayMinDiffGroupDelay—Differential Group Delaymeasured at Rx Transceiver

port–minimum in the day

• jnxPMDayMaxDiffGroupDelay—DifferentialGroupDelaymeasuredatRxTransceiver

port–maximum in the day

• jnxPMDayAvgDiffGroupDelay—Differential Group Delaymeasured at Rx Transceiver

port–average in the day

• jnxPMDayMinPolarState—Polarization state–minimum in the day

• jnxPMDayMaxPolarState—Polarization state–maximum in the day

• jnxPMDayAvgPolarState—Polarization state–average in the day

• jnxPMDayMinPolarDependentLoss—Polarization Dependent Loss–minimum in the

day

• jnxPMDayMaxPolarDependentLoss—PolarizationDependentLoss–maximumin the

day

• jnxPMDayAvgPolarDependentLoss—Polarization Dependent Loss–average in the

day interval

• jxPMDayMinQ—Q–minimum in the day

• jnxPMDayMaxQ—Q–maximum in the day

• jnxPMDayAvgQ—Q–Average in the day

• jnxPMDayMinSNR—SNR–min in the day

• jnxPMDayMaxSNR—SNR–max in the day

• jnxPMDayAvgSNR—SNR–avg in the day

• jnxPMDayMinTxOutputPower—TxOutputPower–minimum in the day

• jnxPMDayMaxTxOutputPower—TxOutputPower–maximum in the day.

• jnxPMDayAvgTxOutputPower—TxOutputPower–average in the day.

• jnxPMDayMinRxInputPower—RxInputPower–minimum in the day.

• jnxPMDayMaxRxInputPower—RxInputPower–maximum in the day.

• jnxPMDayAvgRxInputPower—RxInputPower–average in the day.
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• jnxPMDayTimeStamp—Time for the Day.

• jnxPMDaySuspectedFlag—If true, the data in this entry may be unreliable.

• jnxPMDaySuspectReason—If SuspectedFlag is true, the reason for the performance

monitoring data being suspect.

Alarms for OTN Interfaces

The following alarms are applicable for management of OTN interface for Juniper

products.

• jnxIfAdminStates–Administraion state of the interface.

• jnxAdminStatInService(1)—In service.

• jnxAdminStateInServiceMA(2)—In servicemaintenance, the link is in service, but the

alarms are suppressed.

• jnxAdminStateOutofService(3)—Out of service due to a fault.

• jnxAdminStateOutofServiceMA(4)—Out of service maintenance as configured by

the user, may or may not have alarms.

• jnxIfOperStates—Operation states of the interface.

• jnxOperStateInit(1)—Starting state of the interface.

• jnxOperStateNormal(2)—The interface is working normally.

• jnxOperStateFault(3)—There is some traffic affecting fault on the interface, for

example, LOS.

• jnxOperStateDegraded(4)—There is some function affecting the performance on

the interface resulting in degradation, for example BER.

• jnxIfOtnRate—Rates for an interface.

• jnxIfOtnFecType—FECmodes of an interface.

• jnxIfOtnLayer—Layer which describes the table.

• jnxIfOtnType—Near end of far end

• jnxIfOtnDirection—Direction for the entities in the table.

• jnxIfOtnSeverity—Severity of the notification.

• jnxIfOtnServiceStateAction—Notification action on the service state.

• jnxIfOtnOtukNotificationId–IdentifiesspecificOTNalarmsthatmayexistonan interface.

• jnxIfOtnOtnLosAlarm(1)

• jnxIfOtnOtnLofAlarm(2)

• jnxIfOtnOtnLomAlarm(3)

• jnxIfOtnOtnOtuSsfAlarm(4)

• jnxIfOtnOtnOtuBdiAlarm(5)
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• jnxIfOtnOtnOtuTtimAlarm(6)

• jnxIfOtnOtnOtuIaeAlarm(7)

• jnxIfOtnOtuBiaeAlarm(8)

• jnxIfOtnOtuDegAlarm(9)

• jnxIfOtnOtuFecExcessiveErrsAlarm(11)

• jnxIfOtn15MinThreshBBETCA(12)

• jnxIfOtn15MinThreshESTCA(13)

• jnxIfOtn15MinThreshSESTCA(14)

• jnxIfOtn15MinThreshUASTCA(15)

• jnxIfOtn15MinThreshFcsTCA(16)

• jnxIfOtn15MinThUnCorrectedWordsTCA(17)

• jnxIfOtn15MinThreshPreFECBERTCA(18)

• JnxIfOtnOdukTcmNotificationId—Alarms from the ODUk and TCM layers.

• jnxIfOtnOdukTcmOciAlarm(1)

• jnxIfOtnOdukTcmLckAlarm(2)

• jnxIfOtnOdukTcmBdiAlarm(3)

• jnxIfOtnOdukTcmTimAlarm(4)

• jnxIfOtnOdukTcmDegAlarm(5)

• jnxIfOtnOdukTcmIaeAlarm(6)

• jnxIfOtnOdukTcmLTCAlarm(7)

• jnxIfOtnOdukTcmCSfAlarm(8)

• jnxIfOtnOdukTcmSSfAlarm(9)

• jnxIfOtnOdukTcmTSfAlarm(10)

• jnxIfOtnOdukTcm15MinThreshBBETCA(11)

• jnxIfOtnOdukTcm15MinThreshESTCA(12)

• jnxIfOtnOdukTcm15MinThreshSESTCA(13)

• jnxIfOtnOdukTcm15MinThreshUASTCA(14)

• jnxIfOtnOdukTcm15MinThreshFcsTCA(15)

• jnxIfOtnOdukTcmAisAlarm(16)

• jnxIfOtnOChCfgTable—This table provides information on the Otn OCh configuration.

• jnxIfOtnOChCfgEntry

• jnxIfOtnOChCfgContainerIndex
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• jnxIfOtnOChCfgL1Index

• jnxIfOtnOChCfgL3Index

• jnxIfOtnLocalLoopback—Local loopback at the line after the optics.

• jnxIfOtnLineLoopback—Line loopback at the line.

• jnxIfOtnPayloadLoopback—Payload loopback after the optics.

• jnxIfOtnAdminState

• jnxIfOtnOperState—Operation state of the interface.

• jnxIfOtnIndex-IfIndex of the interface.

• jnxIfOtnOChStatus

• jnxIfOtnOChPortMode— Port mode of the interface.

• jnxIfOtnOTUkCfgTable—This tableprovides informationon theOtnOTUkconfiguration.

• jnxIfOtnOTUkCfgEntry—Aconceptual row that contains theOtnOTUk configuration

table.

• jnxIfOtnOTUkCfgContainerIndex—The associated jnxContentsContainerIndex, for

example, shelf.

• jnxIfOtnOTUkCfgL1Index—The level one index associated with the subject, for

example, slot.

• jnxIfOtnOTUkCfgL2Index—The level two index associated with the subject, for

example, port.

• jnxIfOtnOTUkCfgL3Index— The level three index associated with the subject, for

example channel.

• jnxIfOtnOTUkCfgRate— The rate for the interface, depending on the interface/fru

type.

• jnxIfOtnOTUkCfgFecMode—The FEC type in the OTU frame, the selection depends

on the interface/fru type.

• jnxIfOtnOTUkEnableAutoFrrByteInsert—Enable or disable the automatic insertion

of the frr SF/SD byte in the overhead bytes(RES).

• jnxIfOtnOTUkEnableBERFrrSupport—Enable of disable the FRR support for BER.

• nxIfOtnOTUkPreFecBERThresholdMantissa—Sets the BER threshold(mantissa),

which when crossed triggers signal degrade.

• jnxIfOtnOTUkPreFecBERThresholdExponent —Sets the BER threshold(exponent),

which when crossed triggers signal degrade.

• jnxIfOtnOTUkPreFecBERThresholdTime—The collection time to calculate the BER.

• jnxIfOtnOTUkTIMActEnabled—Indicateswhetherornot theTrace IdentifierMismatch

(TIM) consequent action function is enabled.

• jnxIfOtnOTUkTxTTI— The Trace TTI SAPI 0..15, DAPI 16..31 32..63 user defined.
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• jnxIfOtnOTUkRxTTI— The Receive Trace TTI SAPI 0..15, DAPI 16..31 32..63 user

defined.

• jnxIfOtnOTUkExpectedRxSapi — Expected receive SAPI.

• jnxIfOtnOTUkExpectedRxDapi-Expected receive DAPI.

• jnxIfOtnOTUkStatus—The status of the interface.

• jnxIfOtnOTUkPreFecBERThresholdClearMantissa—SetstheBERthreshold(mantissa)

for clear signal degrade condition, which signal degrade condition will be cleared

when Pre-FEC error count is below the clear threshold error count.

• jnxIfOtnOTUkPreFecBERThresholdClearExponent—Sets the BER

threshold(exponent) for clear signal degrade condition, which signal degrade

conditionwill be clearedwhen Pre-FEC error count is below the clear threshold error

count.

• jnxIfOtnODUkCfgTable-This table provides information on the Otn ODUk

configuration.

• jnxIfOtnODUkCfgEntry—A conceptual row that contains information about the

Otn ODUk configuration.

• jnxIfOtnODUkCfgContainerIndex—The associated jnxContentsContainerIndex,

for example, shelf.

• jnxIfOtnODUkCfgL1Index—The level one index associated with this subject, for

example slot.

• jnxIfOtnODUkCfgL2Index—The level two index associated with the subject, for

example, port.

• jnxIfOtnODUkCfgL3Index—The level three index associated with the subject, for

example channel.

• jnxIfOtnODUkAPSPCC0—Read/Write APS PCC byte 0 for this ODUk only.

• jnxIfOtnODUkAPSPCC1—Read/Write APS PCC byte 1 for this ODUk only.

• jnxIfOtnODUkAPSPCC2—Read/Write APS PCC byte 2 for this ODUk only.

• jnxIfOtnODUkAPSPCC3—Read/Write APS PCC byte 3 for this ODUk only.

• jnxIfOtnODUkPayloadType—Read/Write Payload Type for ODUk only.

• jnxIfOtnODUkTIMActEnabled—Indicates whether or not the Trace Identifier

Mismatch (TIM) consequent action function is enabled. The default value of this

object is false(2).

• jnxIfOtnODUkTxTTI—The Trace TTI SAPI 0..15, DAPI 16..31 32..63 user defined for

this layer.

• jnxIfOtnODUkRxTTI—The Receive Trace TTI SAPI 0..15, DAPI 16..31 32..63 user

defined.

• jnxIfOtnODUkExpectedRxSapi—Expected receive SAPI for this layer.

• jnxIfOtnODUkExpectedRxDapi–-Expected receive DAPI for this layer.
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• jnxIfOtnODUkStatus—The status of the interface. Only some of these alarms are

valid for the TCM layer.

• jnxIfOtnODUkRxPayloadType—Receive payload type for ODUk only.

• jnxIfOtnTcmCfgTable—This tableprovides informationon theOtnTCMconfiguration.

• jnxIfOtnTcmCfgEntry—A conceptual row that contains information about the Otn

Tcm configuration.

• jnxIfOtnTcmCfgContainerIndex—The associated jnxContentsContainerIndex, for

example shelf.

• jnxIfOtnTcmCfgL1Index—The level one index associated with this subject, for

example, slot.

• jnxIfOtnTcmCfgL2Index—The level one index associated with this subject, for

example, port.

• jnxIfOtnTcmCfgL3Index—The level one index associated with this subject, for

example, channel.

• jnxIfOtnTcmCfgLevel—The TCM level for the table.

• jnxIfOtnTCMEnable—Enable this TCM layer (only for TCM layers)

• jnxIfOtnTcmTxTTI—The Trace TTI SAPI 0..15, DAPI 16..31 32 ..63 user defined for

this layer.

• jnxIfOtnTcmRxTTI—The Receive Trace TTI SAPI 0..15, DAPI 16..31 32 ..63 user

defined for this layer.

• jnxIfOtnTcmExpectedRxSapi—Expected receive SAPI for this layer.

• jnxIfOtnTcmExpectedRxDapi—Expected receive DAPI for this layer.

• jnxIfOtnTcmStatus—Status of this layer.

• jnxIfOtnODUkTcmTestTable—This table provides information on the Otn ODUk test

function.

• jnxIfOtnODUkTcmTestEntry—A conceptual row that contains information about

the Otn ODUk test function.

• jnxIfOtnODUkTcmTestLayer—The OTU/ODU/TCM layer for the alarm.

• jnxIfOtnODUkTcmTestTCMLevel—ForODUkwill be thiswill be 0 If layer is TCM then

this will give the TCM level 1..6.

• jnxIfOtnODUkTcmInsertAis—Insert ODU Ais into OTN stream.

• jnxIfOtnODUkTcmInsertLck—Insert ODU Lck into OTN stream.

• jnxIfOtnODUkTcmInsertOci—Insert ODUOci into OTN stream.

• jnxIfOtnODUkPayloadPRBS—Insert Payload PRBS, For ODUk layer and TCM level is

0.

• jnxIfOtnODUkPayloadPRBSResult—Result of the Payload PRBS.
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• jnxIfOtnODUkTcmDMTable—Table for OTN ODUk/TCM Delay Measurement

configuration table.

• jnxIfOtnODUkTcmDMEntry—A conceptual row that contains information about the

Delay Measurement (DM) test table.

• jnxIfOtnODUkTcmDMLayer—The layer OTU/ODU/TCM layer for the alarm

• jnxIfOtnODUkTcmDMLevel—For ODUk, this value is 0, if layer is TCM then this gives

the TCMlevel 1..6.

• jnxIfOtnDMConnectionMonitoringEndpoint—OriginateConnectionMonitoringEndpoint

for the Delay Measurement.

• jnxIfOtnDMBypass—Act as tandem, passing DM value through node.

• jnxIfOtnDMPersistFrames—Number of consecutive frames required to declare DM

Complete.

• jnxIfOtnDMEnable—Start/Stop the DMmeasurement.

Configuring Global AlarmNotifications

Youcanconfigureglobal e-mail notifications tobesentwhenanyalarmwithnotifications

enabled is generated. Toconfigureglobal e-mail notifications, enter thee-mail addresses

to receive global alarm notifications in the Alarm Notifications Destinations field in the

Global Settings section. Separate addresses with a comma (,). For information about

enabling notification for an alarm, see “Configuring Individual Alarm Notifications” on

page 152.

Retaining AlarmHistory

Use theNo.ofdays tokeepAlarm field in theGlobalSettings section to specify thenumber

of days to keep alarm history. The default retention time is 120 days; but you can specify

a period of 7 through 1000 days. Specifying a longer retention time consumesmore

database resources. To change the alarm retention duration, type a new value and click

OK and Yes to confirm the change.

Specifying Event History

Use the Events/Alarm field in the Global Settings section to specify the number of event

entries that are kept in the alarm history. The default setting for events is 20. To change

the setting, type a new value and clickOK and Yes to confirm the change.
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Enabling Alarms

Ensure all devices are configured to send traps to Connectivity Services Director. This

task is performed for the devices in Deploy mode through Set SNMP Trap Configuration.

Use the Individual Alarms and Threshold Settings section to disable and re-enable

individual alarmsor all alarms. Alarmsappear onboth tabs in the section: AlarmSettings

and Threshold Settings. Fault alarms are preconfigured and initially enabled. To enable

or disable alarms:

1. (Optional)Sort thealarms.Bydefault, the list ofalarms is sortedalphabeticallywithin

each category. You can also sort by description or alarm severity within a category by

clicking a column heading.

2. Review the alarms and either select the check box in the heading to select all of the

alarms or select the check box for the individual alarms you want to enable.

3. ClickOK and Yes to confirm the alarm change.

Changing the Severity of Individual Alarms

You can change the severity of the alarms to match your corporate procedures and

guidelines. For example, at your company a DoS attack might be considered a critical

alarm, while Connectivity Services Director has a default severity for DoS attacks as a

major alarm.Alarmsappear onboth tabs in the IndividualAlarmsandThresholdSettings

section: Alarm Settings and Threshold Settings.

To change the severity of an alarm:

1. Select the current severity in the Severity column. A list of the severity levels appear.

2. Select the new severity level for the alarm.

3. ClickOK and Yes to confirm the change to the severity setting.

To configure alarm notifications, see “Configuring Individual Alarm Notifications” on

page 152.

Configuring Threshold Alarms

Threshold alarms are alarms that are generated when amonitored value crosses the

configured threshold.Theyprovideenhancedvisibility intopotential issueson thenetwork.

You configure andmanage threshold alarms the sameway as other alarms. You also

have the option of setting the threshold level of individual threshold alarms.
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To set threshold alarm thresholds:

1. Select the Threshold Settings tab in the Individual Alarms and Threshold settings

section of the Fault tab.

2. Click Edit Settings in the Threshold Settings column of the alarm threshold you want

to edit.

3. Set the threshold in the window that opens.

4. Click Save to save the new threshold.

To configure alarm notifications, see “Configuring Individual Alarm Notifications” on

page 152.

Configuring Individual AlarmNotifications

You can configure e-mail notifications to be sent when an individual alarm is generated.

When you enable notification for an alarm, the notifications are sent to the e-mail

addresses configured for the alarm and the addresses configured for global alarm

notifications. Alarmsappear onboth tabs in the IndividualAlarmsandThresholdSettings

section: Alarm Settings and Threshold Settings.

To configure e-mail notification for an alarm name:

1. Select the check box in the alarm’s Notification column.

If you later want to disable notification for the alarm, clear the check box.

2. ClickEditNotification in theNotificationcolumn.TheAlarmNotificationDetailswindow

opens.

3. Enteroneormoree-mail addresses in theNotificationEmailAddresses field.Separate

addresses with a comma (,).

You can later edit the addresses to send notifications to different addresses.

4. (Optional) Enter a comment in the Comments field. This comment is included in the

e-mail notification message.

5. Click Save.

Related
Documentation

• Changing Alarm Settings for the Optics and OTN Interfaces on page 1470
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CHAPTER 55

Configuring and Monitoring Optical Inline
Amplifiers

• Viewing a Graphical Image of Optical Inline Amplifier on page 1485

• Viewing Optical ILA Configuration and Status Details for Simplified

Administration on page 1488

• Viewing Performance Monitoring Details of Optical ILAs for Detecting and Diagnosing

Faults on page 1493

• Configuring Threshold-Crossing Alarms for Optical ILAs for Monitoring Link

Performance on page 1501

• Changing Alarm Settings for the Optical ILAs on page 1503

Viewing a Graphical Image of Optical Inline Amplifier

The Chassis View provides a pictorial representation of the optical inline amplifier (ILA)

of a PTXSeries router. The optical ILA is used in conjunctionwith the integrated photonic

line card (IPLC) that is installed in the PTX3000 routers. The optical ILA operates with

redundant hot-swappable pluggable power supplies, which are either AC or DC.

The purpose of this view is to try and provide a comprehensive monitoring view of the

health and status of deployed devices across the network. In this view all the managed

devices are shown with their appropriate status and health based on the services and

device settingsapplied. This viewhelps theoperator to knowthehealthandstatusacross

the network, it provides with the operator to quickly see the macro level information,

whichallows theoperator to furtheranalyze the informationprovidedandquicklynavigate

to individual devices and take any further corrective measure required. It provides a

cohesive tool for the operator to quickly see the micro-level information and take any

further remediation action required.
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To view a graphical image of the optical ILA of PTX Series routers, and its associated

components:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Click a particular component or interface to display the associated details in the lower

portionof thepage.TheRotateandPerspectivebuttonsenable you toview the images

in required orientation.

6. Click the View Back (arrows in a square symbol) icon to cause the device image to

rotate along the x-axis and display the rear view of the device. Alternatively, click the

View Front icon to view the front plane of the device. The View Back and View Front

icons are toggle options.

7. Click the Perspective (cube symbol) icon to display the device image in

three-dimensional format. It is a toggle button, which causes the device image to be

shown in either three-dimensional or one-dimensional format.

8. Select the level ofmagnification of the imageby clicking theZoom(magnifying glass)

icon. The image is expanded and displayed.

Alternatively, use the slider control beneath the Zoom icon to change the level of

magnification.

9. Click the home icon to return to the front view of the chassis. The selected interface

is surrounded with a colored outline based on the operational status. An interface

that is operationally up is denoted in green andan interface that is operationally down

is represented in red. The components are depicted as small colored icons at the

top-left corner of the front view of the equipment image.
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In the graphical image of the device displayed, you canmouse over the different parts

of the device, such as the interfaces, line cards, and slots. When youmouse over the

different modules, their corresponding details are displayed as tooltips. On clicking the

device components, the corresponding description for the selected component is

displayedbydefault in theComponent InfopaneandtheEquipment tabwith the following

values.

• Description—Configured textual description of the component.

• Manufacturer—Name of the company that built and shipped the device.

• Model—Model of the FRU component.

• Name—Name of the chassis component.

• Part number—Part number of the chassis component.

• Serial number—Serial number of the chassis component. The serial number of the

backplane is also the serial number of the router or switch chassis. Use this serial

number when you need to contact Juniper Networks Customer Support about the

router or switch chassis.

The Component Info pane and the Active Alarmsmonitor are displayed in the lower

portion of the page.

The Active Alarmsmonitor shows any active alarm that has not yet been cleared. You

canview thealarmname, theunique identifier assigned to thealarm, theperson towhich

the alarm is assigned for corrective action, and the severity of the alarm. Click the Launch

AlarmMgmt icon (right upward-slanting arrow enclosed in a square) to navigate to the

Fault mode and view the four standard alarmmonitors available in Fault mode.

Active Alarms for the respective components are displayed when the component is

clicked in the image of the chassis displayed. The components for which the alarms are

displayedare FlexiblePortConcentrator (FPC),DensePortConcentrator (DPC), Physical

Interface Card (PIC), Modular Interface Card (MIC), Routing Engine, Control Boards, fan

trays, Switch Interface Board (SIB), and power supply module (PSM).

The following fields are displayed in the Active Alarms pane:

Table 245: Active AlarmsMonitor

DescriptionTable Column

The severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is necessary.

• Major—Amajor error has occurred; escalate or notify as necessary.

• Minor—Aminor error has occurred; notify or monitor the condition.

• Info—An informational message; no action is necessary.

Severity

The alarm name.Name

The IPaddressof thedeviceornetworkelement thatgenerated thealarm.TheSNMP
agent is located at the source IP. In most cases, the source IP is the IP address of the
switch or controller.

Source
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Table 245: Active AlarmsMonitor (continued)

DescriptionTable Column

The date and time that the information for the alarmwas last modified.Last Updated

From the Chassis Viewwindow, click theDetails icon (arrow enclosed in a square) at the

top-right corner of the window to open the Chassis View Details page that lists the

configured devices and their parameters in the form of a table.

Click the Apply Configlet button (pencil icon displayed beside the button) and use the

links shownon thecomponents inChassisView toselect thecontextandapply configlets.

Related
Documentation

Deleting Devices from Chassis View on page 1267•

• Rebooting Devices After Examining the Status in Chassis View on page 1268

• About Chassis View on page 1257

Viewing Optical ILA Configuration and Status Details for Simplified Administration

Instead of using Junos OS CLI statements and operational commands to view optical

ILA parameters, you can view an image of the optical ILA using Connectivity Services

Director to obtain an intuitive and high-level understanding of the settings and alarms.

This view enables you tomodify the optical ILA settings to suit your network deployment

needs in a simplified and optimal manner. Because the important optical ILA settings

can be viewed alongside the visual representation of the entire chassis that is displayed,

this method of managing the optical ILA settings provides a consolidated and cohesive

interface for easy administration of the network.

To view the optical ILA configuration and status information:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to view the optical ILA

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.
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5. In the image of the device, select an optical ILA.

The ILA Optics dialog box is displayed at the lower part of the page. At the bottom of

the dialog box, the Equipment, Status/Config, and Performance tabs are displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The configuration settings that pertain to the optical ILA are displayed in the ILA and

EDFA panes. The ILA pane is expanded and displayed by default.

7. View the following details under different sections of the ILA pane.

• In the System section, the following parameters are displayed:

• Status—Operation status of the optical ILA in conjunction with the optical IPLC

installed in the FPC or PIC slot

• Current Mode—Mode of operation of the optical ILA, such as auto

• Board Temperature (Celsius)—Temperature of the device in Celsius

• Power—The power supplies need to be both AC or both DC. Only one power

supply is required to power on the device; the second power supply provides

redundancy. When the optical ILA has both power supplies installed and

connected to the power supply, the device has full power redundancy. If a power

supply fails or is removed, another power supply balances the electrical load

without interruption. Each power supply provides 12-voltage direct current (VDC)

output with a standby voltage of 12 VDC. The power supplies can be

hot-swapped—you do not need to power off the router or disrupt the routing

function to replace a power supply.

• PowerAC—Indicates whether the AC power supply is connected or removed

TheACpower supplies in theoptical ILAarehot-removable, andhot-insertable

field-replaceable units (FRUs) that you can install without powering off the

deviceordisrupting the routing function.Theoptical ILAhas twopower supplies.

All of the power supplies are initially installed at the factory. Each of the 150-W

power supplies has a single AC input. An optical ILA has twice the number of

power supplies needed to power all the components in the device, which is

known as 1+1 n redundancy.

• PowerDC—Indicates whether the DC power supply is connected or removed

TheDCpower supplies in the optical ILA are hot-removable and hot-insertable

field-replaceable units (FRUs) that you can install without powering off the

deviceordisrupting the routing function.Theoptical ILAhas twopower supplies.

Both of the power supplies are initially installed at the factory. Each of the two

150-WpowersupplieshasasingleDC input.Anoptical ILAhas twice thenumber

of power supplies needed to power all the components in the device, which is

known as 1+1 n redundancy.

• Fan—The cooling system in an optical ILA consists of three 80-W fanmodules.

Each fanmodule has dual-counter rotating fans. These fanmodules can be
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hot-swapped—youdonot need topower off the router or disrupt routing function

to replace a fanmodule.

• Fan 1—Speedof fan 1 in revolutionsperminute (rpm). Fan speedstatus is based

on different chassis cooling requirements, such as spinning at high speed,

intermediate speed, normal speed, or low speed.

• Fan 2—Speed of fan 2 in rpm

• Fan 3—Speed of fan 3 in rpm

• OSC—Displays the details of the two optical supervisory channel (OSCs) that

are part of the optical ILA

• A—Displays the transmitted and received optical power, in milliwatts (mW) and

decibels referred to 1.0 mW (dBm), for the OSC A.

• Tx Power (dBm)—Transmit laser output power (dBm) of OSC A

• Rx Power (dBm)—Received laser input power (dBm) of OSC A

• B—Displays the transmitted and received optical power, in milliwatts (mW) and

decibels referred to 1.0 mW (dBm), for the OSC B.

• Tx Power (dBm)—Transmit laser output power (dBm) of OSC B

• Rx Power (dBm)—Received laser input power (dBm) of OSC B

8. Click the EDFA header at the bottom of the dialog box.

The EDFA pane is expanded and displayed, which shows the erbium-doped fiber

amplifier (EDFA) properties for the ILA with the integrated photonic line card (IPLC)

module installed in the FPC or PIC slot.

9. View the following details under different sections of the EDFA pane.

• A-B—Configuration and status settings of the EDFA in the direction fromOSC A to

OSC B

• Status—Operational status of the EDFA in the direction fromOSC A to OSC B

• Working Status—Working condition of the EDFA, such as output disabled or

automatic power reduction (APR) deactivated

• Actual Gain (dB)—Gain or signal strength increase in decibels (dB) in the

direction fromOSC A to OSC B. The actual gain depends on the impedance of

the attached device. An input power higher than –5 dBmcan result in an alarm

that can be cleared by correctly setting the gain value.

• Gain Range—Range of gain, such as high or low, in the direction fromOSC A to

OSC B

• Power (dBm)—Power specifications for theEDFAof theoptical ILA in thedirection

fromOSC A to OSC B
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• UpstreamOutput Power—Output power to the upstream network elements

in the direction fromOSC A to OSC B

• Input Power—Current input power in the direction fromOSC A to OSC B

• Output Power—Current output power in the direction fromOSC A to OSC B

• Downstream Input Power—Input power to the downstream network elements

in the direction fromOSC A to OSC B

• Voa—Attenuation specifications of the optical ILA in the direction fromOSC A to

OSC B

• Attenuation (dB)—Amountof reduction in transmittedpower of the light signal

in dB of the variable optical attenuator (VOA) present in the optical ILA in the

direction fromOSC A to OSC B

• B-A—Configuration and status settings of the EDFA in the reverse direction from

OSC B to OSC A

• Status—Operational status of the EDFA in the reverse direction fromOSC B to

OSC A

• Working Status—Working condition of the EDFA, such as output disabled or

ARP deactivated

• ActualGain (dB)—Gainor signal strength increase indecibels (dB) in the reverse

direction fromOSC B to OSC A. The actual gain depends on the impedance of

the attached device. An input power higher than –5 dBmcan result in an alarm

that can be cleared by correctly setting the gain value.

• Gain Range—Range of gain, such as high or low, in the reverse direction from

OSC B to OSC A

• Power (dBm)—Power specifications for the EDFA of the optical ILA in the reverse

direction fromOSC B to OSC A

• UpstreamOutput Power—Output power to the upstream network elements

in the reverse direction fromOSC B to OSC A

• Input Power—Current input power in the reverse direction fromOSC B to OSC

A

• Output Power—Current output power in the reverse direction fromOSC B to

OSC A

• Downstream Input Power—Input power to the downstream network elements

in the reverse direction fromOSC B to OSC A

• Voa—Attenuation specifications of the optical ILA in the direction fromOSC B to

OSC A
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• Attenuation (dB)—Amountof reduction in transmittedpower of the light signal

in dB of the variable optical attenuator (VOA) present in the optical ILA in the

direction fromOSC B to OSC A

10. ClickUpdateat the topof thedialogbox to save themodified ILAsettings.Alternatively,

click Cancel to discard the changes.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest settings be retrieved from the device and displayed.

Related
Documentation

Viewing a Graphical Image of Optical Inline Amplifier on page 1485•

• Viewing Performance Monitoring Details of Optical ILAs for Detecting and Diagnosing

Faults on page 1493

• ConfiguringThreshold-CrossingAlarms forOptical ILAs forMonitoringLinkPerformance

on page 1501

• Changing Alarm Settings for the Optical ILAs on page 1503

Copyright © 2019, Juniper Networks, Inc.1492

Connectivity Services Director User Guide



Viewing PerformanceMonitoring Details of Optical ILAs for Detecting andDiagnosing
Faults

To analyze and resolve any faults associated with optical inline amplifiers (ILAs), it is

essential to view the diagnostic data, warnings, and alarms for transport performance

monitoring. The different types of parameters related to performancemonitoring that

are retrieved from the optical ILAs enable you to ensure service availability and verify or

monitor individual services and the service network performance.

The performancemonitoring capability in Connectivity Services Director displays

information about the health of your network and changing conditions of your optical

ILAs. Use this diagnosis and detection mechanism to identify problems with the

equipment, pinpoint security attacks, or to analyze trends and categories of errors. This

feature includes fault-monitoring details in the dashboard, in monitoring pages, and on

a dedicated page that displays alarms, events, and system logmessages that are

generated.Performancemonitoringparameterscanbeviewed inbothchartandstatistical

formats. These charts and statistical details provide essential and cohesive information

about system conditions, any discrepancies andmalfunctioning, and protocols or

components that need to be examined and debugged for better efficiency and working

capacity. You can assess the performance of your network, not only at a point in time,

but also over a period of time. This feature enables you to determine trending and

network-healthparameters; for example,whether service-level agreements (SLAs)have

been violated.

To view the performancemonitoring details of optical ILAs:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical ILA

settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Select an optical ILA in the image of the device.

The ILA Optics dialog box is displayed at the lower part of the page, which contains

the Equipment, Status/Config, and Performance tabs.
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6. Click the Performance tab at the bottom of the pane.

The Perf Mon tab of the ILA Optics PMs dialog box is displayed.

The following fields are displayed in the Perf Mon tab of the ILA Optics PMs dialog

box. The date and time at which the dialog box was last refreshed is shown.

NOTE: PumpTurn-DownDuring a Loss of Signal— If LOS (Loss of Signal)
is detected based on lack of receipt of the OSC signal at the input port of
an amplifier, then the amplifier must turn down its pumps (to achieve no
more than 0dBm total output power), until it detects receipt of a valid
OSC signal at its input port. Likewise, if an upstreamamplifier receives an
OSCmessage from the downstream node that the OSC signal was not
received downstream (LOSwas declared downstream), it must also turn
down its ownpumps (to achieve nomore than0dBmtotal output power)
until it receives an OSCmessage that the fault has cleared. Therefore, in
addition to the automatic power reduction (APR) algorithm, the ILA
softwaremust keep the amplifier pumpsdisabled until a fiber connection
is confirmedbetween the ILAoutputportand the input to thedownstream
optical node. This fiber connection is confirmed using the “handshaking”
messagesexchangedoverOpticalSupervisorChanel (OSC).Thisbehavior
occurs during amplifier turn-up and during ongoing operation.

Local LOS—The software reads the LOS status for incoming signal from
SFP. This LOS status can be used to shut off the amplifier pump.When
local LOS is cleared, pumps need to be turned on again.

RemoteLOS—IncomingLOSstatus isconveyedtoOSC_FPGA.OSC_FPGA
in turn sends this status to nextnode through some overhead bits. The
next node OSC_FPGAwould read the overhead bits and puts it in its
“Remote LOS” register. OSC_FPGA also forwards the remote LOS status
further down the chain through overhead bits in the sameway. The
software can read the “Remote LOS” value and take appropriate action
of turning the amplifier pump on or off.

• Optical EDFA AB Input Power—Received input power of the optical erbium-doped

fiber amplifier (EDFA) in the direction from optical supervisory channel (OSC) A to

OSC B

EDFA AB Input Power—Received laser optical input power

EDFA AB Input Power-Min—Minimum received input power

EDFA AB Input Power-Avg—Average received laser power

EDFA AB Input Power-Max—Maximum received input power

• Optical EDFA AB Output Power—Transmitted output power of the optical EDFA in

the direction fromOSC A to OSC B

EDFA AB Output Power—Transmitted laser optical output power

EDFA AB Output Power-Min—Minimum transmitted laser output power
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EDFA AB Output Power-Avg—Average transmitted laser output power

EDFA AB Output Power-Max—Maximum transmitted laser output power

• Optical EDFA AB Signal Output Power—Signal output power of the optical EDFA

in the direction fromOSC A to OSC B

EDFA AB Signal Output Power—Signal laser optical output power

EDFA AB Signal Output Power-Min—Minimum signal laser output power

EDFA AB Signal Output Power-Avg—Average signal laser output power

EDFA AB Signal Output Power-Max—Maximum signal laser output power

• Optical EDFA AB Pump1 Current—Pump1 current of the EDFA in the direction from

OSC A to OSC B

EDFA AB Pump1 Current—Pump1 current of the EDFA fromOSC A to OSC B

EDFA AB Pump1 Current-Min—Minimum pump1 current of the EDFA

EDFA AB Pump1 Current-Avg—Average pump1 current of the EDFA

EDFA AB Pump1 Current-Max—Maximum pump1 current of the EDFA

• Optical EDFA AB Pump1 Temperature—Pump1 temperature of the EDFA in the

direction fromOSC A to OSC B

EDFA AB Pump1 Temperature—Pump1 temperature of the EDFA fromOSC A to

OSC B

EDFA AB Pump1 Temperature-Min—Minimum pump1 temperature of the EDFA

EDFA AB Pump1 Temperature-Avg—Average pump1 temperature of the EDFA

EDFA AB Pump1 Temperature-Max—Maximum pump1 temperature of the EDFA

• Optical EDFA AB Pump2 Current—Pump2 current of the EDFA in the direction from

OSC A to OSC B

EDFA AB Pump2 Current—Pump2 current of the EDFA fromOSC A to OSC B

EDFA AB Pump2 Current-Min—Minimum pump2 current of the EDFA

EDFA AB Pump2 Current-Avg—Average pump2 current of the EDFA

EDFA AB Pump2 Current-Max—Maximum pump2 current of the EDFA

• Optical EDFA AB Pump2 Temperature—Pump2 temperature of the EDFA in the

direction fromOSC A to OSC B

EDFA AB Pump2 Temperature—Pump2 temperature of the EDFA fromOSC A to

OSC B

EDFA AB Pump2 Temperature-Min—Minimum pump2 temperature of the EDFA

EDFA AB Pump2 Temperature-Avg—Average pump2 temperature of the EDFA

EDFA AB Pump2 Temperature-Max—Maximum pump2 temperature of the EDFA
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• Optical EDFA BA Input Power—Received input power of the optical erbium-doped

fiber amplifier (EDFA) in the direction from optical supervisory channel (OSC) B to

OSC A

EDFA BA Input Power—Received laser optical input power

EDFA BA Input Power-Min—Minimum received input power

EDFA BA Input Power-Avg—Average received laser power

EDFA BA Input Power-Max—Maximum received input power

• Optical EDFA BA Output Power—Transmitted output power of the optical EDFA in

the direction fromOSC B to OSC A

EDFA BA Output Power—Transmitted laser optical output power

EDFA BA Output Power-Min—Minimum transmitted laser output power

EDFA BA Output Power-Avg—Average transmitted laser output power

EDFA BA Output Power-Max—Maximum transmitted laser output power

• Optical EDFA BA Signal Output Power—Signal output power of the optical EDFA

in the direction fromOSC B to OSC A

EDFA BA Signal Output Power—Signal laser optical output power

EDFA BA Signal Output Power-Min—Minimum signal laser output power

EDFA BA Signal Output Power-Avg—Average signal laser output power

EDFA BA Signal Output Power-Max—Maximum signal laser output power

• Optical EDFA BA Pump1 Current—Pump1 current of the EDFA in the direction from

OSC B to OSC A

EDFA BA Pump1 Current—Pump1 current of the EDFA fromOSC B to OSC A

EDFA BA Pump1 Current-Min—Minimum pump1 current of the EDFA

EDFA BA Pump1 Current-Avg—Average pump1 current of the EDFA

EDFA BA Pump1 Current-Max—Maximum pump1 current of the EDFA

• Optical EDFA BA Pump1 Temperature—Pump1 temperature of the EDFA in the

direction fromOSC B to OSC A

EDFA BA Pump1 Temperature—Pump1 temperature of the EDFA fromOSC B to

OSC A

EDFA BA Pump1 Temperature-Min—Minimum pump1 temperature of the EDFA

EDFA BA Pump1 Temperature-Avg—Average pump1 temperature of the EDFA

EDFA BA Pump1 Temperature-Max—Maximum pump1 temperature of the EDFA

• Optical EDFA BA Pump2 Current—Pump2 current of the EDFA in the direction from

OSC B to OSC A

EDFA BA Pump2 Current—Pump2 current of the EDFA fromOSC B to OSC A

EDFA BA Pump2 Current-Min—Minimum pump2 current of the EDFA
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EDFA BA Pump2 Current-Avg—Average pump2 current of the EDFA

EDFA BA Pump2 Current-Max—Maximum pump2 current of the EDFA

• Optical EDFA BA Pump2 Temperature—Pump2 temperature of the EDFA in the

direction fromOSC B to OSC A

EDFA BA Pump2 Temperature—Pump2 temperature of the EDFA fromOSC B to

OSC A

EDFA BA Pump2 Temperature-Min—Minimum pump2 temperature of the EDFA

EDFA BA Pump2 Temperature-Avg—Average pump2 temperature of the EDFA

EDFA BA Pump2 Temperature-Max—Maximum pump2 temperature of the EDFA

• Optical OSC A Fiber Loss—Fiber loss of OSC A

Optical OSC A Fiber Loss—Fiber loss of OSC A

Optical OSC A Fiber Loss-Min—Minimum fiber loss of OSC A

Optical OSC A Fiber Loss-Avg—Average fiber loss of OSC A

Optical OSC A Fiber Loss-Max—Maximum fiber loss of OSC A

• Optical OSC A Tx Power—Transmitted power of OSC A

Optical OSC A Tx Power—Transmitted power of OSC A

Optical OSC A Tx Power-Min—Minimum transmitted power of OSC A

Optical OSC A Tx Power-Avg—Average transmitted power of OSC A

Optical OSC A Tx Power-Max—Maximum transmitted power of OSC A

• Optical OSC A Rx Power—Recieved power of OSC A

Optical OSC A Rx Power—Recieved power of OSC A

Optical OSC A Rx Power-Min—Minimum received power of OSC A

Optical OSC A Rx Power-Avg—Average received power of OSC A

Optical OSC A Rx Power-Max—Maximum received power of OSC A

• Optical OSC B Fiber Loss—Fiber loss of OSC B

Optical OSC B Fiber Loss—Fiber loss of OSC B

Optical OSC B Fiber Loss-Min—Minimum fiber loss of OSC B

Optical OSC B Fiber Loss-Avg—Average fiber loss of OSC B

Optical OSC B Fiber Loss-Max—Maximum fiber loss of OSC B

• Optical OSC B Tx Power—Transmitted power of OSC B

Optical OSC B Tx Power—Transmitted power of OSC B

Optical OSC B Tx Power-Min—Minimum transmitted power of OSC B

Optical OSC B Tx Power-Avg—Average transmitted power of OSC B
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Optical OSC B Tx Power-Max—Maximum transmitted power of OSC B

• Optical OSC B Rx Power—Recieved power of OSC B

Optical OSC B Rx Power—Recieved power of OSC B

Optical OSC B Rx Power-Min—Minimum received power of OSC B

Optical OSC B Rx Power-Avg—Average received power of OSC B

Optical OSC B Rx Power-Max—Maximum received power of OSC B

On the Perf Mon tab, for the TCA column, either a minus sign (–) is displayed that

denotes that an alarm for threshold-exceed is not configured or a check mark is

displayed and grayed out that indicates that the TCA for the particular attribute is

configured.

7. In the 15Minscolumn, click theChartbutton for theperformancemonitoringparameter

set forwhich youwant to view the statistics for the last 15minutes. This optionenables

you to view the statistics in a chart form. Performancemonitoring information for the

different parameters are displayed for the current 15-minute interval. By default, 96

records of 15-minute intervals are displayed.

A 15-Min parameter-name tab is displayed beside the TCA Config tab at the top-left

cornerof theOpticsPMsdialogbox.Agraphical formatof thestatistics for thespecified

parameter is displayed on this tab.

8. Click the 15 Mins parameter name tab.

a. Select one of the following options from the drop-downmenu:

• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

withdateand timealong thehorizontal axis and theparameter along thevertical

axis. A color-coding format is used to display the different lines, and legends

reference the parameter names corresponding to the lines displayed. Mouse

over thepoints in the linegraph toexpandandshowthevalueof theperformance

monitoring counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

The records are displayed in tabular format. A serial number of the count of

entries, the day, month, and year at which the entry was collected, and the time

at which the entry was collected are displayed. The timestamp is the UTC time

in the database that is mapped to the local time zone of the client computer.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.

Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.

• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.
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In the pop-up dialog box, you can do one of the following:

• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search.

• Click Reload to refresh the contents and display the updated information for

the specified time period.

• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.

The comma-separated value (CSV) format takes the rawdata from the report

anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 15-Min parameter-name tab.

9. In the24-Hrs column, click theChartbutton for theperformancemonitoringparameter

set for which you want to view the statistics for the previous day. This option enables

you to view the statistics in a chart form. Performancemonitoring information for the

different parameters are displayed for the current 24-hour interval. By default, records

pertaining to the last 30daysaredisplayedwhenyouviewtheperformancemonitoring

counters for the 24-hour duration.

A 24Hours parameter-name tab is displayed beside the TCAConfig tab at the top-left

corner of the Optics PMs page.

10. Click the 24 Hours parameter name tab.

a. Select one of the following options from the drop-downmenu:

• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

with date along the horizontal axis and the parameter along the vertical axis. A

color-coding format is used to display the different lines, and legends reference

theparameternamescorresponding to the linesdisplayed.Mouseover thepoints

in the line graph to expand and show the value of the performancemonitoring

counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.

Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.
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• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.

In the pop-up dialog box, you can do one of the following:

• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search. Click Reload to refresh the contents and display the updated

information for the specified time period.

• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.

The comma-separated value (CSV) format takes the rawdata from the report

anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 24 Hours parameter-name tab.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest performancemonitoring statistics to be polled and displayed.

Related
Documentation

Viewing a Graphical Image of Optical Inline Amplifier on page 1485•

• Viewing Optical ILA Configuration and Status Details for Simplified Administration on

page 1488

• ConfiguringThreshold-CrossingAlarms forOptical ILAs forMonitoringLinkPerformance

on page 1501

• Changing Alarm Settings for the Optical ILAs on page 1503
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ConfiguringThreshold-CrossingAlarmsforOptical ILAsforMonitoringLinkPerformance

Bymonitoring the performance of links, you ensure that an end-to-end Ethernet service

is always available over any path for a single link or multiple links spanning networks

composed ofmultiple LANs. Link performancemetrics enable operators to offer binding

service-level agreements (SLAs) and generate new revenues from rate- and

performance-guaranteed service packages that are customized to meet specific needs

of their customers. Tomonitor linkperformance, youneed toconfigure threshold-crossing

alarms (TCAs) for optical inline amplifiers (ILAs)

TCAs are alarms that are activated when a certain configurable threshold—near-end

measurement threshold or far-endmeasurement threshold—is crossed and remains so

until the end of the 15-minute interval and the 24-hour interval for parameters such as

the optical OLA. A near-endmeasurement is associated with ingress data frames and a

far-endmeasurement is associated with egress data frames.

You can configure TCAs for both the minimum andmaximum values for gauges and the

maximum values for counters. A gauge represents a non-negative integer, which may

increase or decrease, but never exceeds amaximum value. A gauge has its maximum

valuewhenever the information beingmodeled is greater than or equal to themaximum

value. If the TCA parameter subsequently goes below themaximum value, the gauge

alsodecreases. Acounter representsanon-negative integer thatmonotonically increases

until it reaches amaximum value of 2
32
–1.

The timely detection of TCAs is essential to proactively manage an interface. TCAs are

not an indication of a fault, but rather an indication that the entitymay be close to a fault.

You can enable the TCA that you want monitor. You can keep the default threshold

settings or change the settings.

To configure the TCAs for optical ILA parameters:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner. The workspaces that are applicable to Build mode are displayed on

the Tasks pane.

4. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The network tree is expanded and the selected device is highlighted.
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5. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

6. Select an optical ILA in the image of the device.

The ILAOptics dialog box is displayed, which contains the Equipment, Status/Config,

and Performance tabs. For example, if you select an optical inline optical amplifier

(ILA), which is used in conjunction with the integrated photonic line card (IPLC) that

is installed in the PTX3000 routers, the optical ILA Optics dialog box is displayed

beneath the graphical view of the chassis. The Equipment, Status/Config, and

Performance tabs are displayed at the bottom of the page.

7. Click the Performance tab at the bottom of the pane. The Optics PMs dialog box is

displayed with the performancemonitoring counters andmetrics that pertain to the

optical ports. This dialog box contains the Perf Mon and TCA Config tabs.

8. Click the TCA Config tab to configure the TCAs for the different optical ILA attributes.

Thedialogbox is refreshed todisplay thedifferentperformancemonitoringparameters.

These parameters can be edited inline.

Inline editing enables you to modify previously defined settings easily and quickly.

Embedded editing is enabled, which causes the grids showing the devices and

interfaces to becomemodifiable directly; you do not need to highlight, edit, and save

the changes every time.

A gray triangle in the upper-right corner of a field denotes that the value of that field

or attribute has beenmodified.

9. For the parameters under each performancemonitoring category for which you want

to modify the TCA value, click the value in the Threshold-15Min or Threshold-24Hr

columns to set the TCA value for the 15-minute interval or 24-hour interval. You can

also select Yes or No in the Enable column to enable or disable the TCA value for the

specified parameter.

10. Click Update to save the configured threshold settings. Alternatively, click Cancel to

discard the configuration.

Related
Documentation

Viewing a Graphical Image of Optical Inline Amplifier on page 1485•

• Viewing Optical ILA Configuration and Status Details for Simplified Administration on

page 1488

• Viewing Performance Monitoring Details of Optical ILAs for Detecting and Diagnosing

Faults on page 1493

• Changing Alarm Settings for the Optical ILAs on page 1503
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Changing Alarm Settings for the Optical ILAs

You canmodify the configuration settings for alarm settings of optical inline amplifiers

(ILAs) using the Preferences page of the Connectivity Services Director application. To

open the Preferences page, click the down arrow next to the System button in the

Connectivity Services Director banner and select Preferences. The Preferences page

opens with User Preferences as the default tab. Click the Fault tab of the Preferences

pageof theConnectivityServicesDirectorGUI toenable individualalarms, set the retention

period for alarms, configurealarmnotifications, configure thresholdalarms, and to specify

the number of events to keep for each alarm. The Fault tab hasmultiple sections, which

you can expand and collapse by clicking the arrow next to the section title:

• Global Settings, for configuring Faults settings such as global alarm notifications and

alarm data retention.

• Individual Alarms andThreshold Settings, for configuring settings for individual alarms

and threshold alarms.

• Alarms for Optical ILAs on page 1503

• Configuring Global Alarm Notifications on page 1505

• Retaining Alarm History on page 1506

• Specifying Event History on page 1506

• Enabling Alarms on page 1506

• Changing the Severity of Individual Alarms on page 1506

• Configuring Threshold Alarms on page 1507

• Configuring Individual Alarm Notifications on page 1507

Alarms for Optical ILAs

The following alarms are applicable for management of the optical ILA:

DescriptionAlarm Name

Generated when the EDFA in the direction from optical supervisory channel (OSC)
A to OSC B (Eab) has a calibration table error.

ILA::edfaEabCaliTableErr

Generated when the EDFA case temperature exceeds the configured threshold in
the direction fromOSC A to OSC B.

ILA::edfaEabCaseTemperature

Generated when the input loss of signal (LOS) is detected in the direction from
OSC A to OSC B.

ILA::edfaEabInputLOS

Generated when the out-of-service out-of-gain (OOS OOG) condition occurs in
the direction fromOSC A to OSC B.

ILA::edfaEabOOG

Generated when the out-of-power (OOP) condition occurs in the direction from
OSC A to OSC B.

ILA::edfaEabOOP
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DescriptionAlarm Name

Generated when an output LOS condition occurs in the direction fromOSC A to
OSC B.

ILA::edfaEabOutputLOS

Generated when the end-of-life (EoL) state for pump 1 of the EDFA occurs in the
direction fromOSC A to OSC B.

ILA::edfaEabPump1EOL

Generated when the end-of-life (EoL) state for pump 2 of the EDFA occurs in the
direction fromOSC A to OSC B.

ILA::edfaEabPump2EOL

Generated when the temperature exceeds the threshold for pump 1 of the EDFA
occurs in the direction fromOSC A to OSC B.

ILA::edfaEabPump1Temperature

Generated when the temperature exceeds the threshold for pump 1 of the EDFA
occurs in the direction fromOSC A to OSC B.

ILA::edfaEabPump2Temperature

Generated when the radio frequency loss (RFL) occurs for the EDFA occurs in the
direction fromOSC A to OSC B.

ILA::edfaEabRFL

Generated when the EDFA in the direction from optical supervisory channel (OSC)
B to OSC A (Eba) has a calibration table error.

ILA::edfaEbaCaliTableErr

Generated when the EDFA case temperature exceeds the configured threshold in
the direction fromOSC B to OSC A.

ILA::edfaEbaCaseTemperature

Generated when the input loss of signal (LOS) is detected in the direction from
OSC B to OSC A.

ILA::edfaEbaInputLOS

Generatedwhen the out-of-gain (OOG) condition occurs in the direction fromOSC
B to OSC A.

ILA::edfaEbaOOG

Generated when the out-of-power (OOP) condition occurs in the direction from
OSC B to OSC A.

ILA::edfaEbaOOP

Generated when an output LOS condition occurs in the direction fromOSC B to
OSC A.

ILA::edfaEbaOutputLOS

Generated when the end-of-life (EoL) state for pump 1 of the EDFA occurs in the
direction fromOSC B to OSC A.

ILA::edfaEbaPump1EOL

Generated when the end-of-life (EoL) state for pump 2 of the EDFA occurs in the
direction fromOSC B to OSC A.

ILA::edfaEbaPump2EOL

Generated when the temperature exceeds the threshold for pump 1 of the EDFA
occurs in the direction fromOSC B to OSC A.

ILA::edfaEbaPump1Temperature

Generated when the temperature exceeds the threshold for pump 1 of the EDFA
occurs in the direction fromOSC B to OSC A.

ILA::edfaEbaPump2Temperature

Generated when the radio frequency loss (RFL) occurs for the EDFA occurs in the
direction fromOSC B to OSC A.

ILA::edfaEbaRFL
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DescriptionAlarm Name

Generated when the ILA board temperature reaches an abnormal level.ILA::ilaBoardTemperatureAbnormal

Generated when the communication channel between the NMS system and the
ILA reaches an abnormal level.

ILA::ilaCommunicationAbnormal

Generated when the ILA AC power reaches an abnormal level.ILA::ilaACPowerAbnormal

Generated when the ILA DC power reaches an abnormal level.ILA::ilaDCPowerAbnormal

Generated when the ILA fan tray controller 1 that is online reaches an abnormal
level.

ILA::ilaFan1OnlineAbnormal

Generated when the speed of the optical ILA fan tray controller 1 reaches an
abnormal level.

ILA::ilaFan1SpeedAbnormal

Generated when the ILA fan tray controller 1 that is online reaches an abnormal
level.

ILA::ilaFan2OnlineAbnormal

Generated when the speed of the optical ILA fan tray controller 1 reaches an
abnormal level.

ILA::ilaFan2SpeedAbnormal

Generated when the ILA fan tray controller 1 that is online reaches an abnormal
level.

ILA::ilaFan3OnlineAbnormal

Generated when the speed of the optical ILA fan tray controller 1 reaches an
abnormal level.

ILA::ilaFan3SpeedAbnormal

Generated when the ILA software version reaches an abnormal level.ILA::ilaSoftwareVersionAbnormal

Generated when the ILA table error occurs.ILA::ilaTableErr

Generated when the addition of power LOS condition occurs for the OSC A.ILA::oscaAddPowerLOS

Generated when the dropping of power LOS condition occurs for the OSC A.ILA::oscaDropPowerLOS

Generated when the addition of power LOS condition occurs for the OSC B.ILA::oscbAddPowerLOS

Generated when the dropping of power LOS condition occurs for the OSC B.ILA::oscbDropPowerLOS

Configuring Global AlarmNotifications

Youcanconfigureglobal e-mail notifications tobesentwhenanyalarmwithnotifications

enabled is generated. Toconfigureglobal e-mail notifications, enter thee-mail addresses

to receive global alarm notifications in the Alarm Notifications Destinations field in the

Global Settings section. Separate addresses with a comma (,). For information about

enabling notification for an alarm, see “Configuring Individual Alarm Notifications” on

page 152.
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Retaining AlarmHistory

Use theNo.ofdays tokeepAlarm field in theGlobalSettings section to specify thenumber

of days to keep alarm history. The default retention time is 120 days; but you can specify

a period of 7 through 1000 days. Specifying a longer retention time consumesmore

database resources. To change the alarm retention duration, type a new value and click

OK and Yes to confirm the change.

Specifying Event History

Use the Events/Alarm field in the Global Settings section to specify the number of event

entries that are kept in the alarm history. The default setting for events is 20. To change

the setting, type a new value and clickOK and Yes to confirm the change.

Enabling Alarms

Ensure all devices are configured to send traps to Connectivity Services Director. This

task is performed for the devices in Deploy mode through Set SNMP Trap Configuration.

Use the Individual Alarms and Threshold Settings section to disable and re-enable

individual alarmsor all alarms. Alarmsappear onboth tabs in the section: AlarmSettings

and Threshold Settings. Fault alarms are preconfigured and initially enabled. To enable

or disable alarms:

1. (Optional)Sort thealarms.Bydefault, the list ofalarms is sortedalphabeticallywithin

each category. You can also sort by description or alarm severity within a category by

clicking a column heading.

2. Review the alarms and either select the check box in the heading to select all of the

alarms or select the check box for the individual alarms you want to enable.

3. ClickOK and Yes to confirm the alarm change.

Changing the Severity of Individual Alarms

You can change the severity of the alarms to match your corporate procedures and

guidelines. For example, at your company a DoS attack might be considered a critical

alarm, while Connectivity Services Director has a default severity for DoS attacks as a

major alarm.Alarmsappear onboth tabs in the IndividualAlarmsandThresholdSettings

section: Alarm Settings and Threshold Settings.

To change the severity of an alarm:

1. Select the current severity in the Severity column. A list of the severity levels appear.

2. Select the new severity level for the alarm.

3. ClickOK and Yes to confirm the change to the severity setting.

Copyright © 2019, Juniper Networks, Inc.1506

Connectivity Services Director User Guide



To configure alarm notifications, see “Configuring Individual Alarm Notifications” on

page 152.

Configuring Threshold Alarms

Threshold alarms are alarms that are generated when amonitored value crosses the

configured threshold.Theyprovideenhancedvisibility intopotential issueson thenetwork.

You configure andmanage threshold alarms the sameway as other alarms. You also

have the option of setting the threshold level of individual threshold alarms.

To set threshold alarm thresholds:

1. Select the Threshold Settings tab in the Individual Alarms and Threshold settings

section of the Fault tab.

2. Click Edit Settings in the Threshold Settings column of the alarm threshold you want

to edit.

3. Set the threshold in the window that opens.

4. Click Save to save the new threshold.

To configure alarm notifications, see “Configuring Individual Alarm Notifications” on

page 152.

Configuring Individual AlarmNotifications

You can configure e-mail notifications to be sent when an individual alarm is generated.

When you enable notification for an alarm, the notifications are sent to the e-mail

addresses configured for the alarm and the addresses configured for global alarm

notifications. Alarmsappear onboth tabs in the IndividualAlarmsandThresholdSettings

section: Alarm Settings and Threshold Settings.

To configure e-mail notification for an alarm name:

1. Select the check box in the alarm’s Notification column.

If you later want to disable notification for the alarm, clear the check box.

2. ClickEditNotification in theNotificationcolumn.TheAlarmNotificationDetailswindow

opens.

3. Enteroneormoree-mail addresses in theNotificationEmailAddresses field.Separate

addresses with a comma (,).

You can later edit the addresses to send notifications to different addresses.
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4. (Optional) Enter a comment in the Comments field. This comment is included in the

e-mail notification message.

5. Click Save.

Related
Documentation

• Viewing a Graphical Image of Optical Inline Amplifier on page 1485

• Viewing Optical ILA Configuration and Status Details for Simplified Administration on

page 1488

• Viewing Performance Monitoring Details of Optical ILAs for Detecting and Diagnosing

Faults on page 1493

• ConfiguringThreshold-CrossingAlarms forOptical ILAs forMonitoringLinkPerformance

on page 1501
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CHAPTER 56

Configuring and Monitoring Optical
Integrated Photonic Line Cards

• Viewing a Graphical Image of the Optical Integrated Photonic Line Card on page 1509

• Configuring Optical IPLC for Easy and Optimal Deployment on page 1513

• ViewingPerformanceMonitoringDetails ofOptical IPLCs forDetecting andDiagnosing

Faults on page 1520

• Configuring Threshold-Crossing Alarms for Optical IPLCs for Monitoring Link

Performance on page 1526

• Increasing theAddandDropPortCapacityof the IPLCNodeto64Channelsonpage 1528

• Configuring a Two-Degree IPLC Node for Express Traffic by Increasing the Line

Capacity on page 1530

• Configuring Optical IPLC Line Connectivity for Interoperation with Optical

ILAs on page 1532

• Configuring theWavelengths That Are Added and Dropped by the IPLC on page 1537

• Configuring the IPLC to Add or DropWavelengths to an Optical Interface on a Remote

Chassis on page 1541

• Configuring the IPLC to Add or DropWavelengths to an Optical Interface on the Same

Chassis on page 1543

• Bypassing aWavelength on the IPLC on page 1544

• Changing Alarm Settings for the Optical IPLCs on page 1546

• Viewing Routing Engine Switchover Indicators in the Chassis Image on page 1553

• Viewing Alarm Indicators in the Chassis Image on page 1555

• Viewing Port Statistics for OTN PICs on page 1556

• Example:ConfiguringTwoFiber LineTerminationsUsing IPLCs forOpticalAmplification

in a Metro Linear Packet Optical Network on page 1560

Viewing a Graphical Image of the Optical Integrated Photonic Line Card

The Chassis View provides a pictorial representation of the optical integrated photonic

line card (IPLC) of a PTX Series router. The optical ILA is used in conjunction with the

IPLC that is installed in the PTX3000Packet Transport Routers. The optical ILA operates

with redundant hot-swappable pluggable power supplies which are either AC or DC.
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The purpose of this view is to try and provide a comprehensive monitoring view of the

health and status of deployed devices across the network. In this view all the managed

devices are shown with their appropriate status and health based on the services and

device settingsapplied. This viewhelps theoperator to knowthehealthandstatusacross

the network, it provides with the operator to quickly see the macro level information,

whichallows theoperator to furtheranalyze the informationprovidedandquicklynavigate

to individual devices and take any further corrective measure required. It provides a

cohesive tool for the operator to quickly see the micro-level information and take any

further remediation action required.

To view a graphical image of the optical IPLC of PTX300 routers:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the PTX3000 router for which you want to view and

configure the IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. From the graphical image of the PTX3000 router, click a particular IPLCmodule to

display the associated details in the lower portion of the page. The Rotate and

Perspective buttons enable you to view the images in required orientation.

6. Click the View Back (arrows in a square symbol) icon to cause the device image to

rotate along the x-axis and display the rear view of the device. Alternatively, click the

View Front icon to view the front plane of the device. The View Back and View Front

icons are toggle options.

7. Click the Perspective (cube symbol) icon to display the device image in

three-dimensional format. It is a toggle button, which causes the device image to be

shown in either three-dimensional or one-dimensional format.

8. Select the level ofmagnification of the imageby clicking theZoom(magnifying glass)

icon. The image is expanded and displayed.
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Alternatively, use the slider control beneath the Zoom icon to change the level of

magnification.

9. Click the home icon to return to the front view of the chassis. The selected interface

is surrounded with a colored outline based on the operational status. An interface

that is operationally up is denoted in green andan interface that is operationally down

is represented in red. The components are depicted as small colored icons in the front

view of the equipment image.

In the graphical image of the device displayed, you canmouse over the different parts

of the device, such as the interfaces, line cards, and slots. When youmouse over the

different modules, their corresponding details are displayed as tooltips. On clicking the

device components, the corresponding description for the selected component is

displayedbydefault in theComponent InfopaneandtheEquipment tabwith the following

values.

• Description—Configured textual description of the component.

• Manufacturer—Name of the company that built and shipped the device.

• Model—Model of the FRU component.

• Name—Name of the chassis component.

• Part number—Part number of the chassis component.

• Serial number—Serial number of the chassis component. The serial number of the

backplane is also the serial number of the router or switch chassis. Use this serial

number when you need to contact Juniper Networks Customer Support about the

router or switch chassis.

The Component Info pane and the Active Alarmsmonitor are displayed in the lower

portion of the page.

The Active Alarmsmonitor shows any active alarm that has not yet been cleared. You

canview thealarmname, theunique identifier assigned to thealarm, theperson towhich

the alarm is assigned for corrective action, and the severity of the alarm. Click the Launch

AlarmMgmt icon (right upward-slanting arrow enclosed in a square) to navigate to the

Fault mode and view the four standard alarmmonitors available in Fault mode.

Active Alarms for the respective components are displayed when the component is

clicked in the image of the chassis displayed. The components for which the alarms are

displayedare FlexiblePortConcentrator (FPC),DensePortConcentrator (DPC), Physical

Interface Card (PIC), Modular Interface Card (MIC), Routing Engine, Control Boards, fan

trays, Switch Interface Board (SIB), and power supply module (PSM).

The following fields are displayed in the Active Alarms pane:
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Table 246: Active AlarmsMonitor

DescriptionTable Column

The severity of the alarm. Severity levels are:

• Critical—A critical condition exists; immediate action is necessary.

• Major—Amajor error has occurred; escalate or notify as necessary.

• Minor—Aminor error has occurred; notify or monitor the condition.

• Info—An informational message; no action is necessary.

Severity

The alarm name.Name

The IPaddressof thedeviceornetworkelement thatgenerated thealarm.TheSNMP
agent is located at the source IP. In most cases, the source IP is the IP address of the
switch or controller.

Source

The date and time that the information for the alarmwas last modified.Last Updated

From the Chassis Viewwindow, click theDetails icon (arrow enclosed in a square) at the

top-right corner of the window to open the Chassis View Details page that lists the

configured devices and their parameters in the form of a table.

Click the Apply Configlet button (pencil icon displayed beside the button) and use the

links shownon thecomponents inChassisView toselect thecontextandapply configlets.

Related
Documentation

Deleting Devices from Chassis View on page 1267•

• Rebooting Devices After Examining the Status in Chassis View on page 1268

• About Chassis View on page 1257
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Configuring Optical IPLC for Easy and Optimal Deployment

Insteadofusing JunosOSCLI statementsandoperational commands toconfigureoptical

integrated photonic line card (IPLC) settings and view the configured parameters, you

can view an image of the optical IPLC using Connectivity Services Director to obtain an

intuitive and high-level understanding of the settings and alarms. This view enables you

tomodify the optical IPLC settings to suit your network deployment needs in a simplified

and optimal manner. Because the important optical IPLC settings can be configured

alongside the visual representation of the entire chassis that is displayed, this method

of managing the optical IPLC settings provides a consolidated and cohesive interface

for easy deployment of settings on the optical IPLC.

To configure an optical IPLC:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the PTX3000 router for which you want to define the

optical port settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, selectanoptical IPLC—for example, anoptical IPLC installed

in a PTX3000 router.

The Component Info dialog box is displayed. At the lower part of the dialog box, the

Equipment, Status/Config, Performance, and Line Connectivity tabs are displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLC Line dialog box is displayed on the right panewith the configuration settings

that pertain to the IPLC.

7. In the Settings/Status section, do the following:
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a. From the Expansion IPLC list, select the FPC or PIC slot in which the expansion

module of the IPLC is installed. Alternatively, select NONE if you do not want to

specify an expansion module for the IPLC.

This setting creates an association between the specified IPLC basemodule and

IPLCexpansionmodule. The IPLC expansionmodule is an opticalmultiplexing and

demultiplexing card that, when associatedwith an IPLC basemodule by using this

statement, increases the ADD or DROP capacity of the system to 64 channels.

NOTE: When you increase the capacity to 64 channels, the IPLC base
module handles the odd channels and the IPLC expansionmodule
handles the even channels.

b. From the Express IPLC list, select the FPC or PIC slot in which the IPLC that you

want to configure as the express-inmode is configured. Alternatively, selectNONE

if you do not want to specify an express-in mode for the IPLC. You can switch the

IPLC’s wavelength to another IPLC residing on the same chassis by using the

express-in mode. There can be only one association between two IPLC cards in

express-inmode. For example, the IPLC in slot 0 can be configured to be bypassed

and switched to the IPLC in slot 2. If you change the association, then the latest

association is considered.

This setting enables you to form a logical connection between two IPLC base

modules to form a single two-line node that can communicate either east-west

or north-south. This configuration is used in IPLC ring scenarios and other network

scenarios that require the IPLC to support two-line terminations.

NOTE: Before setting this option, youmust connect the two IPLC base
modules together through the PT IN and PT OUT ports on the front
panel; otherwise a proper association between the twomodules is not
formed.

NOTE: You can configure only one logical association between two
IPLC basemodules in express-in mode.

c. In theMain field, view the alarm, if any, that has been generated for themain board

of the IPLC. A gray circle denotes no alarm, whereas a red circle denotes that an

active alarm is present. Firmware Consistency Alarm, Internal Diagnostic Alarm,

or Power Rail Alarm are possible values that can be displayed.

d. In the EDFA1 field, view the alarm, if any, that has been generated for the ingress

erbium-doped fiber amplifier (EDFA) of the IPLC. A gray circle denotes no alarm,

whereas a red circle denotes that an active alarm is present. Input Power alarm,

Out of Gain alarm, or Pump EOL alarm are possible values that can be displayed

for EDFA1.
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e. In the EDFA2 field, view the alarm, if any, that has been generated for the egress

EDFA of the IPLC. A gray circle denotes no alarm, whereas a red circle denotes that

an active alarm is present. Output Power alarm, Out of Gain alarm, or Pump EOL

alarm are possible values that can be displayed for EDFA2.

f. In theWSS field, view the alarm, if any, that has been generated for thewavelength

selective switching (WSS)module of the optical IPLC. A gray circle denotes no

alarm, whereas a red circle denotes that an active alarm is present. WSSModule

FAIL, WSS Firmware Image Corrupted, WSS Firmware Version out-of-date, WSS

Voltage Alarm - High,WSSVoltage Alarm - Low,WSSTemperature - High, orWSS

temperature - Low are possible values that can be displayed.

g. ClickUpdate above theSettings/Status section to save the specified configuration

settings. Alternatively, click Cancel to discard the configuration settings.

8. In theWavelength Configuration section, do the following:

All port wavelength frequencies are controlled by theWSS of the optical IPLC and

configured on awavelength-by-wavelength basis. Themapping for the wavelengths,

frequencies, and ports is fixed. Each port is assigned a specific frequency and

wavelength depending on whether the port is on the IPLC basemodule or expansion

module.

a. Select the ShowAllWavelengths check box to display all available wavelengths

supported by the PTX3000 router. The wavelength values can be any of the

following:

• 1528.38—1528.38 nanometers (nm), corresponds to a 50-GHz grid

• 1528.77—1528.77 nm, corresponds to 50-GHz and 100-GHz grids

• 1529.16—1529.16 nm, corresponds to a 50-GHz grid

• 1529.55—1529.55 nm, corresponds to 50-GHz and 100-GHz grids

• 1529.94—1529.94 nm, corresponds to a 50-GHz grid

• 1530.33—1530.33 nm, corresponds to 50-GHz and 100-GHz grids

• 1530.72—1530.72 nm, corresponds to a 50-GHz grid

• 1531.12—1531.12 nm, corresponds to 50-GHz and 100-GHz grids

• 1531.51—1531.51 nm, corresponds to a 50-GHz grid

• 1531.90—1531.90 nm, corresponds to 50-GHz and 100-GHz grids

• 1532.29—1532.29 nm, corresponds to a 50-GHz grid

• 1532.68—1532.68 nm, corresponds to 50-GHz and 100-GHz grids

• 1533.07—1533.07 nm, corresponds to a 50-GHz grid

• 1533.47—1533.47 nm, corresponds to 50-GHz and 100-GHz grids

• 1533.86—1533.86 nm, corresponds to a 50-GHz grid

• 1534.25—1534.25 nm, corresponds to 50-GHz and 100-GHz grids

• 1534.64—1534.64 nm, corresponds to a 50-GHz grid
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• 1535.04—1535.04 nm, corresponds to 50-GHz and 100-GHz grids

• 1535.43—1535.43 nm, corresponds to a 50-GHz grid

• 1535.82—1535.82 nm, corresponds to 50-GHz and 100-GHz grids

• 1536.22—1536.22 nm, corresponds to a 50-GHz grid

• 1536.61—1536.61 nm, corresponds to 50-GHz and 100-GHz grids

• 1537.00—1537.00 nm, corresponds to a 50-GHz grid

• 1537.40—1537.40 nm, corresponds to 50-GHz and 100-GHz grids

• 1537.79—1537.79 nm, corresponds to a 50-GHz grid

• 1538.19—1538.19 nm, corresponds to 50-GHz and 100-GHz grids

• 1538.58—1538.58 nm, corresponds to a 50-GHz grid

• 1538.98—1538.98 nm, corresponds to 50-GHz and 100-GHz grids

• 1539.37—1539.37 nm, corresponds to a 50-GHz grid

• 1539.77—1539.77 nm, corresponds to 50-GHz and 100-GHz grids

• 1540.16—1540.16 nm, corresponds to a 50-GHz grid

• 1540.56—1540.56 nm, corresponds to 50-GHz and 100-GHz grids

• 1540.95—1540.95 nm, corresponds to a 50-GHz grid

• 1541.35—1541.35 nm, corresponds to 50-GHz and 100-GHz grids

• 1541.75—1541.75 nm, corresponds to a 50-GHz grid

• 1542.14—1542.14 nm, corresponds to 50-GHz and 100-GHz grids

• 1542.54—1542.54 nm, corresponds to a 50-GHz grid

• 1542.94—1542.94 nm, corresponds to 50-GHz and 100-GHz grids

• 1543.33—1543.33 nm, corresponds to a 50-GHz grid

• 1543.73—1543.73 nm, corresponds to 50-GHz and 100-GHz grids

• 1544.13—1544.13 nm, corresponds to a 50-GHz grid

• 1544.53—1544.53 nm, corresponds to 50-GHz and 100-GHz grids

• 1544.92—1544.92 nm, corresponds to a 50-GHz grid

• 1545.32—1545.32 nm, corresponds to 50-GHz and 100-GHz grids

• 1545.72—1545.72 nm, corresponds to a 50-GHz grid

• 1546.12—1546.12 nm, corresponds to 50-GHz and 100-GHz grids

• 1546.52—1546.52 nm, corresponds to a 50-GHz grid

• 1546.92—1546.92 nm, corresponds to 50-GHz and 100-GHz grids

• 1547.32—1547.32 nm, corresponds to a 50-GHz grid

• 1547.72—1547.72 nm, corresponds to 50-GHz and 100-GHz grids
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• 1548.11—1548.11 nm, corresponds to a 50-GHz grid

• 1548.51—1548.51 nm, corresponds to 50-GHz and 100-GHz grids

• 1548.91—1548.91 nm, corresponds to a 50-GHz grid

• 1549.32—1549.32 nm, corresponds to 50-GHz and 100-GHz grids

• 1549.72—1549.72 nm, corresponds to a 50-GHz grid

• 1550.12—1550.12 nm, corresponds to 50-GHz and 100-GHz grids

• 1550.52—1550.52 nm, corresponds to a 50-GHz grid

• 1550.92—1550.92 nm, corresponds to 50-GHz and 100-GHz grids

• 1551.32—1551.32 nm, corresponds to a 50-GHz grid

• 1551.72—1551.72 nm, corresponds to 50-GHz and 100-GHz grids

• 1552.12—1552.12 nm, corresponds to a 50-GHz grid

• 1552.52—1552.52 nm, corresponds to 50-GHz and 100-GHz grids

• 1552.93—1552.93 nm, corresponds to a 50-GHz grid

• 1553.33—1554.33 nm, corresponds to 50-GHz and 100-GHz grids

• 1553.73—1554.73 nm, corresponds to a 50-GHz grid

• 1554.13—1554.13 nm, corresponds to 50-GHz and 100-GHz grids

• 1554.54—1554.54 nm, corresponds to a 50-GHz grid

• 1554.94—1554.94 nm, corresponds to 50-GHz and 100-GHz grids

• 1555.34—1555.34 nm, corresponds to a 50-GHz grid

• 1555.75—1555.75 nm, corresponds to 50-GHz and 100-GHz grids

• 1556.15—1556.15 nm, corresponds to a 50-GHz grid

• 1556.55—1556.55 nm, corresponds to 50-GHz and 100-GHz grids

• 1556.96—1556.96 nm, corresponds to a 50-GHz grid

• 1557.36—1557.36 nm, corresponds to 50-GHz and 100-GHz grids

• 1557.77—1557.77 nm, corresponds to a 50-GHz grid

• 1558.17—1558.17 nm, corresponds to 50-GHz and 100-GHz grids

• 1558.58—1558.58 nm, corresponds to a 50-GHz grid

• 1558.98—1558.98 nm, corresponds to 50-GHz and 100-GHz grids

• 1559.39—1559.39 nm, corresponds to a 50-GHz grid

• 1559.79—1559.79 nm, corresponds to 50-GHz and 100-GHz grids

• 1560.20—1560.20 nm, corresponds to a 50-GHz grid

• 1560.61—1560.61 nm, corresponds to 50-GHz and 100-GHz grids

• 1561.01—1561.01 nm, corresponds to a 50-GHz grid
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• 1561.42—1561.42 nm, corresponds to 50-GHz and 100-GHz grids

• 1561.83—1561.83 nm, corresponds to a 50-GHz grid

• 1562.23—1562.23 nm, corresponds to 50-GHz and 100-GHz grids

• 1562.64—1562.64 nm, corresponds to a 50-GHz grid

• 1563.05—1563.05 nm, corresponds to 50-GHz and 100-GHz grids

• 1563.45—1563.45 nm, corresponds to a 50-GHz grid

• 1563.86—1563.86 nm, corresponds to 50-GHz and 100-GHz grids

• 1564.27—1564.27 nm, corresponds to a 50-GHz grid

• 1564.68—1564.68 nm, corresponds to 50-GHz and 100-GHz grids

• 1565.09—1565.09 nm, corresponds to a 50-GHz grid

• 1565.50—1565.50 nm, corresponds to 50-GHz and 100-GHz grids

• 1565.90—1565.90 nm, corresponds to a 50-GHz grid

• 1566.31—1566.31 nm, corresponds to 50-GHz and 100-GHz grids

• 1566.72—1566.72 nm, corresponds to a 50-GHz grid

• 1567.13—1567.13 nm, corresponds to 50-GHz and 100-GHz grids

• 1567.54—1567.54 nm, corresponds to a 50-GHz grid

• 1567.95—1567.95 nm, corresponds to 50-GHz and 100-GHz grids

• 1568.36—1568.36 nm, corresponds to a 50-GHz grid

• 1568.77—1568.77 nm, corresponds to 50-GHz and 100-GHz grids

The default is 1550.12—1550.12 nm, corresponds to 50-GHz and 100-GHz grids

b. For aparticularwavelengthdisplayed in the table, click in thecell in the configuration

column, and then click the drop-down arrow. The following values are displayed

on the drop-downmenu:

• blocked—By default, if there is no explicit configuration for the IPLCwavelength,

then that wavelength is in blockedmode.

• switch—Enables you to switch a wavelength present on an IPLCmodule to an

optical interface on the same or different chassis. You can specify the dense

wavelength-divisionmultiplexing (DWDM) interfaceon the local chassis towhich

you want to switch the specified wavelength. Otherwise, you can switch the

specified wavelength on the local chassis to the remote chassis.

• express-in—Enables you to form a logical connection between two IPLC base

modules to form a single two-line node that can communicate either east-west

or north-south. This configuration is used in IPLC ring scenariosandother network

scenarios that require the IPLC to support two-line terminations.

c. For a particular wavelength setting that you specified in the configuration column

for the IPLC, click in the cell in the end-point column, and then click the drop-down

arrow.
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A list of interface names that are present on the same chassis as the IPLC are

displayed on the drop-downmenu. You can select the optical interface on the

same chassis to which the IPLC basemodule must switch the wavelength. Before

you configure this setting, be sure to configure the wavelength on the local optical

interface so that the wavelength is compatible with the wavelength you are

switching on the IPLC. Alternatively, select remote to configure the IPLC to switch

a particular wavelength to an optical interface on a remote chassis. Before you

configure this setting, be sure to configure the wavelength on the remote optical

interface so that the wavelength is compatible with the wavelength you are

switching on the IPLC.

NOTE: The end-point field displays NA if you select the value in the

configurationcolumnforaspecificwavelengthasblockedorexpress-in.

The end-point field is configurable only for switchwavelengthmode.

d. Click Update in theWavelength Configuration section to save the specified

configuration settings. Alternatively, click Cancel to discard the configuration

settings.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest settings be retrieved from the device and displayed.

Related
Documentation

ViewingPerformanceMonitoringDetails ofOptical IPLCs forDetecting andDiagnosing

Faults on page 1520

•

• Configuring Threshold-Crossing Alarms for Optical IPLCs for Monitoring Link

Performance on page 1526
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ViewingPerformanceMonitoringDetailsofOptical IPLCsforDetectingandDiagnosing
Faults

To analyze and resolve any faults associated with optical integrated photonic line cards

(IPLCs), it is essential to view the diagnostic data, warnings, and alarms for transport

performancemonitoring. The different types of parameters related to performance

monitoring that are retrieved from the optical IPLCs enable you to ensure service

availability andverifyormonitor individual servicesand theservicenetworkperformance.

The performancemonitoring capability in Connectivity Services Director displays

information about the health of your network and changing conditions of your optical

IPLCs. Use this diagnosis and detection mechanism to identify problems with the

equipment, pinpoint security attacks, or to analyze trends and categories of errors. This

feature includes fault-monitoring details in the dashboard, in monitoring pages, and on

a dedicated page that displays alarms, events, and system logmessages that are

generated.Performancemonitoringparameterscanbeviewed inbothchartandstatistical

formats. These charts and statistical details provide essential and cohesive information

about system conditions, any discrepancies andmalfunctioning, and protocols or

components that need to be examined and debugged for better efficiency and working

capacity. You can assess the performance of your network, not only at a point in time,

but also over a period of time. This feature enables you to determine trending and

network-healthparameters; for example,whether service-level agreements (SLAs)have

been violated.

To view the performancemonitoring details of IPLC optics:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the treeandselect thePTX300 router forwhich youwant todefine theoptical

IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the image of the device, select an optical IPLC in the image of the device—for

example, anoptical integratedphotonic line card (IPLC) installed inaPTX3000 router.

The Component Info dialog box is displayed. At the lower part of the dialog box, the

Equipment, Status/Config, Performance, and Line Connectivity tabs are displayed.
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6. Click the Performance tab at the bottom of the pane.

The performancemonitoring counters andmetrics that pertain to the IPLC are

displayed. The IPLC Optics PMs dialog box is displayed. This dialog box contains the

Perf Mon and TCA Config tabs.

• Line OUT VOA—Line-out Variable Optical Attenuator (VOA).

Line OUT VOA-Min—Minimum line-out VOA

Line OUT VOA-Max—Maximum line-out VOA

Line OUT VOA-Avg—Average line-out VOA

• OSC Fiber Loss—Fiber loss of the Optical Service Channel (OSC)

OSC Fiber Loss-Min—Minimum fiber loss of the OSC

OSC Fiber Loss-Avg—Average fiber loss of the OSC

OSC Fiber Loss-Max—Maximum fiber loss of the OSC

• OSC Tx Power—Transmitted power of the OSC

OSC Tx Power-Min—Minimum transmitted power of the OSC

OSC Tx Power-Avg—Average transmitted power of the OSC

OSC Tx Power-Max—Maximum transmitted power of the OSC

• OSC Rx Power—Received power of the OSC

OSC Rx Power-Min—Minimum received power of the OSC

OSC Rx Power-Avg—Average received power of the OSC

OSC Rx Power-Max—Maximum received power of the OSC

• Power AWG Add—ArrayedWaveguide Grating (AWG) added power

Power AWG Add-Min—Minimum AWG added power

Power AWG Add-Avg—Average AWG added power

Power AWG Add-Max—Maximum AWG added power

• Power Express In—Power of the express-in mode of the IPLC

Power Express In-Min—Minimum power of the express-in mode of the IPLC

Power Express In-Avg—Average power of the express-in mode of the IPLC

Power Express In-Max—Maximum power of the express-in mode of the IPLC

7. Click the IPLC LineOut PMs header at the bottom of the dialog box. The IPLC LineOut

PMspane is expandedanddisplayed. This panecontains thePerfMonandTCAConfig

tabs.

The following fields are displayed in the Perf Mon tab of the IPLC LineOut PMs dialog

box. The date and time at which the dialog box was last refreshed is shown.
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• OCMPowerChannel—Power line-out readingof theOpticalChannelMonitor (OCM)

OCM Power Channel-Min—Minimum power line-out of the OCM

OCM Power Channel-Avg—Average power line-out of the OCM

OCM Power Channel-Max—Maximum power line-out of the OCM

Thepower line-out values for 31 power channels that are present in the IPLC are listed

in the IPLC LineOut PMs dialog box.

NOTE: Anoptical channelmonitor (OCM)with threepointsofobservation
including:

• The booster EDFA (E1) output

• The pre-amplifier EDFA (E2) output.

• The combined channels of the local add function at the input of the
WSS, which indicates which channels (both odd and even channels)
are being added locally.

• An optical supervisory channel (OSC), which communicates in-band
with the far end IPLCmodules and is used for the analysis of the fiber
span characteristics, performancemonitoring, and IPLC fault handing.
Simple topology discovery logic communicates with the ILAs and
PTX3000 nodes.

• An optical splitter is used to broadcast the received signal from the
output of the pre-amplifier (E2) towards both DROP and PT IN and PT
OUT ports.

• The following are the four power monitors:

• AWGAdd—Monitors the input of the wavelength selective switch
(WSS)measuring the total input power of the combined channels of
the local add function (both odd and even channels).

• Express In—Monitors the input of theWSSmeasuring the total input
power at the input to theWSS coming from the PT IN and PT OUT
express ports.

• Line In—Monitors the input at the LINE IN port, for detection of the
incoming line signal optical power. The remaining PDs

• Line Out—Monitors the output at the LINE OUT port, for detection of
the outgoing line signal optical power.

8. Click the IPLC EDFA PMs header at the bottom of the dialog box. The IPLC EDFA PMs

pane is expanded and displayed. This pane contains the PerfMon and TCA Config

tabs.

The following fields are displayed in the Perf Mon tab of the IPLC EDFA PMs dialog

box. The date and time at which the dialog box was last refreshed is shown.
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• Ingress Input Power–Ingress EDFA input power

Ingress Input Power-Min–Minimum ingress EDFA input power

Ingress Input Power-Avg–Average ingress EDFA input power

Ingress Input Power-Max–Maximum ingress EDFA input power

• Ingress Output Power–Ingress EDFA output power

Ingress Output Power-Min–Minimum ingress EDFA output power

Ingress Output Power-Avg–Average ingress EDFA output power

Ingress Output Power-Max–Maximum ingress EDFA output power

• Ingress Signal Power–Ingress EDFA signal power

Ingress Signal Power-Min–Minimum ingress EDFA signal power

Ingress Signal Power-Avg–Average ingress EDFA signal power

Ingress Signal Power-Max–Maximum ingress EDFA signal power

• Ingress Pump Current—Ingress EDFA pump current

Ingress Pump Current-Min—Minimum ingress EDFA pump current

Ingress Pump Current-Avg—Average ingress EDFA pump current

Ingress Pump Current-Max—Maximum ingress EDFA pump current

• Egress Input Power–Egress EDFA input power

Egress Input Power-Min–Minimum egress EDFA input power

Egress Input Power-Avg–Average egress EDFA input power

Egress Input Power-Max–Maximum egress EDFA input power

• Egress Output Power–Egress EDFA output power

Egress Output Power-Min–Minimum egress EDFA output power

Egress Output Power-Avg–Average egress EDFA output power

Egress Output Power-Max–Maximum egress EDFA output power

• Egress Signal Power–Egress EDFA signal power

Egress Signal Power-Min–Minimum egress EDFA signal power

Egress Signal Power-Avg–Average egress EDFA signal power

Egress Signal Power-Max–Maximum egress EDFA signal power

• Egress Pump Current—Egress EDFA pump current

Egress Pump Current-Min—Minimum egress EDFA pump current

Egress Pump Current-Avg—Average egress EDFA pump current

Egress Pump Current-Max—Maximum egress EDFA pump current
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On the Perf Mon tab, for the TCA column, either a minus sign (–) is displayed that

denotes that an alarm for threshold-exceed is not configured or a check mark is

displayed and grayed out that indicates that the TCA for the particular attribute is

configured.

9. From the IPLC Optics PMs, IPLC LineOut PMs, or IPLC EDFA PMs dialog boxes, in the

15 Mins column, click the Chart button for the performancemonitoring parameter set

for which you want to view the statistics for the last 15 minutes. This option enables

you to view the statistics in a chart form. Performancemonitoring information for the

different parameters are displayed for the current 15-minute interval. By default, 96

records of 15-minute intervals are displayed.

A 15-Min parameter-name tab is displayed beside the TCA Config tab at the top-left

cornerof theOpticsPMsdialogbox.Agraphical formatof thestatistics for thespecified

parameter is displayed on this tab.

10. Click the 15 Mins parameter name tab.

a. Select one of the following options from the drop-downmenu:

• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

withdateand timealong thehorizontal axis and theparameter along thevertical

axis. A color-coding format is used to display the different lines, and legends

reference the parameter names corresponding to the lines displayed. Mouse

over thepoints in the linegraph toexpandandshowthevalueof theperformance

monitoring counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

The records are displayed in tabular format. A serial number of the count of

entries, the day, month, and year at which the entry was collected, and the time

at which the entry was collected are displayed. The timestamp is the UTC time

in the database that is mapped to the local time zone of the client computer.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.

Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.

• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.

In the pop-up dialog box, you can do one of the following:

• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search.

• Click Reload to refresh the contents and display the updated information for

the specified time period.
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• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.

The comma-separated value (CSV) format takes the rawdata from the report

anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 15-Min parameter-name tab.

11. From the IPLC Optics PMs, IPLC LineOut PMs, or IPLC EDFA PMs dialog boxes, in the

24-Hrs column, click the Chart button for the performancemonitoring parameter set

for which youwant to view the statistics for the previous day. This option enables you

to view the statistics in a chart form. Performancemonitoring information for the

different parameters are displayed for the current 24-hour interval. By default, records

pertaining to the last 30daysaredisplayedwhenyouviewtheperformancemonitoring

counters for the 24-hour duration.

A 24Hours parameter-name tab is displayed beside the TCAConfig tab at the top-left

cornerof theOpticsPMsdialogbox.Agraphical formatof thestatistics for thespecified

parameter is displayed on this tab.

12. Click the 24 Hours parameter name tab.

a. Select one of the following options from the drop-downmenu:

• Select View Chart or the graphical icon (elliptical curve symbol) to display the

chart of performancemonitoring statistical metrics. A line graph is displayed

with date along the horizontal axis and the parameter along the vertical axis. A

color-coding format is used to display the different lines, and legends reference

theparameternamescorresponding to the linesdisplayed.Mouseover thepoints

in the line graph to expand and show the value of the performancemonitoring

counters at a particular time.

• Select ViewGrid to switch over to the tabular format of display of performance

monitoring statistics.

• Select Save Chart, when you view the performancemonitoring statistics in

graphical format, to save the graph to a Microsoft Excel file, as a .png image.

Click thepin iconon theupper-left corner to revert the tab to theoriginal container

panel.

• Select Popout Tab or the light blue triangle icon to view the dialog box as a

separate window.

In the pop-up dialog box, you can do one of the following:
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• In the From Date field, pull down the calendar and select the start date of the

search. In the To Date field, pull down the calendar and select the end date

of the search. Click Reload to refresh the contents and display the updated

information for the specified time period.

• Click Export Data to transfer the data in graphical or statistical format to a

spreadsheet or other business applications for future reference and archival.

The comma-separated value (CSV) format takes the rawdata from the report

anddelineates the fieldswithcommasso that thedata is imported intopopular

spreadsheet programs.

• Click the ViewChart button at the top-left corner of the dialog box to view the

statistics in graphical format. Alternatively, click the ViewGrid button at the

top-left corner of the dialog box to view the statistics in tabular format. The

View Chart/Grid button is a toggle button.

• ClickOK to close the pop-up dialog box. Alternatively, press Esc to close the

dialog box after you complete viewing the statistical details.

• Click Close to close the 24 Hours parameter-name tab.

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest performancemonitoring statistics to be polled and displayed.

Related
Documentation

Configuring Optical IPLC for Easy and Optimal Deployment on page 1513•

• Configuring Threshold-Crossing Alarms for Optical IPLCs for Monitoring Link

Performance on page 1526

Configuring Threshold-Crossing Alarms for Optical IPLCs for Monitoring Link
Performance

Threshold crossing alarms (TCAs) can give the management system an early indication

as to the state of the associated entity when it crosses a certain threshold. TCAs can be

set forbothminimumandmaximumvalues for gaugesandmaximumvalues for counters.

Gauges and counters are the types of metrics for which TCAs are configured. A gauge

represents a non-negative integer, which may increase or decrease, but never exceeds

amaximumvalue. A gauge value has itsmaximumvaluewhenever the informationbeing

modeled is greater than or equal to that maximum value. If the TCA parameter

subsequently decreases below themaximum value, the gauge value also decreases. A

counter represents a non-negative integer that monotonically increases until it reaches

amaximum value of 2^32 (2 raised to the power of 32)-1.

The timely detection of TCAs is essential to proactively manage an interface. TCAs are

not an indication of a fault, but rather an indication that the entitymaybe close to a fault.

You can enable the TCA that youwantmonitor. You can either keep the default threshold

settings or change the settings.

You can enable threshold-crossing alarms (TCAs) on the IPLC for the following:
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• Erbium-doped fiber amplifier (EDFA)

• Optical Channel Monitor (OCM)

• Optical Service Channel (OSC)

• Variable Optical Attenuator (VOA)

To configure the TCAs for optical IPLCs:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the treeandselect thePTX300 router forwhich youwant todefine theoptical

IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, selectanoptical IPLC—for example, anoptical IPLC installed

in a PTX3000 router.

The Component Info dialog box is displayed. The Equipment, Status/Config,

Performance, and Line Connectivity tabs are displayed at the bottom of the dialog

box.

6. Click the Performance tab at the bottom of the pane.

The IPLCOpticsPMsdialogbox isdisplayedwith theperformancemonitoringcounters

andmetrics that pertain to the IPLC. This dialog box contains the Perf Mon and TCA

Config tabs. Apart from the IPLC Optics PMs pane, which is expanded and displayed,

the IPLC LineOut PMs and IPLC EDPA PMs panes are displayed in a collapsed form.

7. Click theTCAConfig tab to configure theTCAs for the different optical IPLCattributes.

Thedialogbox is refreshed todisplay thedifferentperformancemonitoringparameters.

These parameters can be edited in an inline form.

Inline editing enables you to modify previously defined settings easily and quickly.

Embedded editing is enabled, which causes the grids showing the devices and

interfaces to becomemodifiable directly; you do not need to highlight, edit, and save

the changes every time.
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A gray triangle in the upper-right corner of a field denotes that the value of that field

or attribute has beenmodified.

8. For the parameters under each performancemonitoring category for which you want

to modify the TCA value, click the value in the Threshold-15Min or Threshold-24Hr

columns to set the TCA value for the 15-minute interval or 24-hour interval. You can

also select or clear the check box in the Enable column to enable or disable the TCA

value for the specified parameter, respectively.

9. Click Update to save the configured threshold settings. Alternatively, click Cancel to

discard the configuration.

10. Similarly, you can configure the TCA values for the IPLC line-out and EDFAmodules.

To configure the TCA settings for the IPLC line-out and EDFAmodules, click the IPLC

LineOutPMs and IPLCEDFAPMs headers at the bottomof the IPLCOptics PMsdialog

box. The IPLC LineOut PMs and IPLC EDFA PMs panes are expanded and displayed.

Thess panes contain the Performance tab selected..

11. From the IPLC LineOut PMs and IPLC EDFA PMs panes, Click the TCA Config tab to

configure theTCAs for thedifferent optical IPLCattributes. Thedialogbox is refreshed

to display the different performancemonitoring parameters in editable form.

12. Edit the TCA values as necessary for the IPLC line-out and EDFAmodules.

Related
Documentation

Configuring Optical IPLC for Easy and Optimal Deployment on page 1513•

• ViewingPerformanceMonitoringDetails ofOptical IPLCs forDetecting andDiagnosing

Faults on page 1520

Increasing the Add and Drop Port Capacity of the IPLC Node to 64 Channels

The IPLC basemodule can accept andmultiplex (add) and demultiplex (drop) up to 32

individual wavelengths into a single fiber pair. If you require more than 32 channels, you

can increase the IPLC node capacity to 64 channels by connecting the IPLC expansion

module to the IPLC basemodule. This procedure describes how to connect these two

modules and configure the IPLC node to support 64 channels.

Before you begin, youmust physically connect the IPLC basemodule and expansion

module together as follows:

• Install the IPLCbasemoduleand the IPLCexpansionmodule into thePTX3000chassis.

BEST PRACTICE: We recommend that you place the IPLCmodules into
the same FPC or PIC slot pair in the PTX3000 chassis.

• Connect the two IPLCmodules together as follows:
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• Connect the XPN IN port of the IPLC basemodule to the XPNOUT of the IPLC

expansion module.

• Connect the XPNOUT port of the IPLC basemodule to the XPN IN of the IPLC

expansion module.

This procedure describes how to upgrade an IPLC configuration to 64 channels.

Toupgradean IPLCconfiguration to64channels youmust createanassociationbetween

the between the IPLC basemodule and the IPLC expansion module:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the treeandselect thePTX300 router forwhich youwant todefine theoptical

IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, selectanoptical IPLC—for example, anoptical IPLC installed

in a PTX3000 router.

The Component Info dialog box is displayed. At the lower part of the dialog box, the

Equipment, Status/Config, Performance, and Line Connectivity tabs are displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLC Line dialog box is displayed on the right panewith the configuration settings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.

For example, if the IPLC basemodule resides in slot 1, select the IPLC 1 component in

the image of the chassis.

8. Specify the FPC or PIC slot in which the IPLC expansion module resides.

For example, if the IPLC expansion module resides in slot 2, select FPC 2 from the

Expansion IPLC list in the Settings/Status section.
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9. Configure the wavelength supported by the OTN transponder andmake sure it is

supported by the IPLC basemodule.

For example, to configure thewavelength as 1532.29, select theShowAllWavelengths

check box, and select blocked from the drop-downmenu in the configuration column

of the table for the corresponding wavelength.

10. Click Update to save the specified configuration settings.

Related
Documentation

ConfiguringaTwo-Degree IPLCNode forExpressTrafficby Increasing theLineCapacity

on page 1530

•

• Configuring Optical IPLC Line Connectivity for Interoperation with Optical ILAs on

page 1532

• Configuring theWavelengths That Are Added and Dropped by the IPLC on page 1537

ConfiguringaTwo-Degree IPLCNodeforExpressTrafficby Increasing theLineCapacity

For metro linear andmetro ring topologies that require either north-south or east-west

communications, youcanconnect two IPLCbasemodules together to formatwo-degree

IPLC node. This enables you to run express traffic in two directions. This topic describes

how to setup and configure an IPLC two-degree node.

Using theexpress-in software capability of the IPLC, you canconfigure the IPLC toaccept

a wavelength from another IPLC residing in the same chassis. For example, when you

have configured an IPLC node using two IPLC basemodules. This topic describes how

to express-in a wavelength from one IPLC to another IPLC within the same chassis.

Before you begin, complete the following tasks:

• Install and connect the two IPLC basemodules through the PT IN and PTOUT ports.

These two IPLCmodules form the two-line IPLC node.

BEST PRACTICE: We recommend that you place the IPLCmodules into
the same FPC or PIC slot pair on the PTX3000 chassis.

To configure the IPLC for two-line terminations to express-in a wavelength from another

IPLC:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.
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3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the treeandselect thePTX300 router forwhich youwant todefine theoptical

IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, selectanoptical IPLC—for example, anoptical IPLC installed

in a PTX3000 router.

The Component Info dialog box is displayed. At the lower part of the dialog box, the

Equipment, Status/Config, Performance, and Line Connectivity tabs are displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLC Line dialog box is displayed on the right panewith the configuration settings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.

For example, if the IPLC basemodule resides in slot 1, select the IPLC 1 component in

the image of the chassis.

8. Create a logical association between the two IPLCmodules and specify that youwant

the IPLC to express-in a wavelength.

For example, if the other IPLC resides in slot 2, select IPLC 2 from the Express IPLC list

in the Settings/Status section.

9. Configure the wavelength supported by the OTN transponder andmake sure it is

supported by the IPLC basemodule.

For example, to configure thewavelength as 1532.29, select theShowAllWavelengths

check box, and select express from the drop-downmenu in the configuration column

of the table for the corresponding wavelength.

10. Click Update to save the specified configuration settings.

Related
Documentation

Increasing theAddandDropPortCapacityof the IPLCNodeto64Channelsonpage 1528•

• Configuring Optical IPLC Line Connectivity for Interoperation with Optical ILAs on

page 1532

• Configuring theWavelengths That Are Added and Dropped by the IPLC on page 1537
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Configuring Optical IPLC Line Connectivity for Interoperation with Optical ILAs

Each optical inline amplifier (ILA) is connected to other optical ILAs or optical integrated

photonic line cards (IPLCs) using optical ports or optical supervisory channels (OSCs).

There are two optical ports for each optical ILA, designated as OSC A and OSC B. For IP

connectivity over OSC, the optical IPLC is used as a gateway. There is no direct IP

connectivity between the optical ILA and external servers.

An optical IPLC is a standalone appliance in PTX3000 routers, running Linux. It has host

path connectivity to the PTX3000 Routing Engine and other FPCs in the chassis (over

internal routing instance). It does not have any router interfaces or switch fabric

connectivity; therefore, there is no data path connectivity to other FPC interfaces. The

optical IPLC software responds to SNMP commands from the network management

server (NMS). SNMP commands are received by the transport daemon (transportd)

running on the Routing Engine and are relayed to the optical IPLC CPU running the

transport process. For providing IP connectivity, all optical IPLC and optical ILA in the

chain are considered to be over a LAN.

Becauseall communication toanoptical ILA is throughanoptical IPLC, oneof theoptical

IPLCs in thechain is designatedas theanchor IPLC. All optical ILAcommandsaredirected

to the anchor IPLC (which denotes the FPC slot number of the optical IPLC on a specific

router)withaparameter indicating theoptical ILA identity (OSCmanagement IPaddress

or the serial number). The anchor IPLCmaintains a table of IP addresses for all optical

ILAOSC-managementports (alongwith theoptical ILA identifier) in the chain. This table

is created through the optical IPLC CLI. The IPLC software forwards the commands to

the required optical ILA. Each optical ILA in the chain also contains the anchor optical

IPLC configuration. This optical ILA is used to send periodic updates and traps.

To configure connectivity between an optical IPLC and an optical ILA on a PTX3000

router:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the treeandselect thePTX300 router forwhich youwant todefine theoptical

IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.
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5. In the imageof thedevice, selectanoptical IPLC—for example, anoptical IPLC installed

in a PTX3000 router.

The Component Info dialog box is displayed. The Equipment, Status/Config,

Performance, and Line Connectivity tabs are displayed at the bottom of the dialog

box.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLC Line dialog box is displayed on the right panewith the configuration settings

that pertain to the IPLC.

7. Click the Line Connectivity tab at the bottom of the dialog box.

The IPLC Line Connectivity dialog box is displayed on the right pane with the

configuration settings that can be used to establish a link between the optical IPLC

and an optical ILA. You can establish the connectivity between a particular IPLC and

optical ILAs that exist on the same PTX3000 router chassis using the fields in the

dialog box.

8. In the TE Id field, enter the traffic engineering (TE) unique identifier that you want to

use for the connectivity between the optical IPLC and optical ILA.

By default, this field is prepopulatedwith the IETF-TE-Topology value as the identifier

for the topology Information about the IPLCmodule installed in the FPC or PIC slot.

You canmodify this value as needed.

9. In the Provider Id field, specify the unique identifier of the provider or the originating

module, which is the IPLC in this case.

By default, this field is prepopulated with 1. You canmodify this value as needed.

10. In the Client Id field, specify the unique identifier of the client or the receivingmodule,

which is the optical ILA in this case.

By default, this field is prepopulated with 1. You canmodify this value as needed.

11. In theAEnd IPLC field, clickSelectbeside the field to select theendpoint or destination

IPLC with which the connection must be established.

The Choose IPLC dialog box is displayed. The dialog box contains two panes. The top

pane lists all the routers that are present in the network, and the bottom pane lists

all the optical IPLCs that reside on the router chassis that you select in the top pane.

You can sort and filter the displayed routers by entering amatch criterion, such as the

router name, in the search field, and click the Search icon in both the top and bottom

panes. Table 247 on page 1534 describes the fields displayed in the top pane of the

Choose IPLC dialog box. Table 248 on page 1534 describes the fields displayed in the

bottom pane of the Choose IPLC dialog box.
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Table 247: Choose IPLC Dialog Box—Top Pane

DescriptionField

Configured name of the device or IP address if no hostname is configuredName

IP Address of the deviceIP Address

Connection status of the device in Connectivity Services Director:

• UP—The device is connected to Connectivity Services Director.

• DOWN—The device is not connected to Connectivity Services Director.

• N/A—The device state is unavailable to Connectivity Services Director.

State

Configuration status of the device:

• In Sync—The configuration on the device is in sync with the Connectivity
Services Director configuration for the device.

• Out Of Sync—The configuration on the device does not match the
ConnectivityServicesDirector configuration for thedevice.This state is usually
the result of the device configuration being altered outside of Connectivity
Services Director.

You cannot deploy the configuration on a device from Connectivity Services
Director when the device is out-ofsync. To resolve this state, use the
Resynchronize Device Configuration task in Deploy mode.

• Sync failed—An attempt to resynchronize an out-of-sync device failed.

• Synchronizing—The device configuration is in the process of being
resynchronized.

• N/A—The device is down.

ManagedState

Model number of the device, which is PTX3000 in this casePlatform

Operating system version running on the deviceOS Version

Table 248: Choose IPLC Dialog Box—Bottom Pane

DescriptionField

Nameof the IPLCwith the slot number inwhich themodule residesName

Brief description of the hardware itemDescription

Serial number of IPLCSerial Number

Displays whether the device is active or not:

• true—IPLC is enabled and available

• false—IPLC is disabled and unavailable

Available

To select the router and the associated IPLC from the Choose IPLCs dialog box:

a. Select the check box beside a router in the top pane.
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The dialog box refreshes and displays all the corresponding IPLCs for the selected

router in the bottom pane.

b. Select the check box beside an IPLC in the bottom pane, and clickOK.

You are returned to the IPLC Line Connectivity dialog box. The router name and

the IPLC name are displayed in the two text fields, respectively, beside the Z End

IPLC field.

In the Z End IPLC field, the PTX3000 router name on which the IPLC for which you

are configuring line connectivity resides is displayed in the first field. The IPLC name,

which is the same as the one for which you are configuring settings, is displayed in the

second field. The Select button is displayed beside these text fields.

12. In the ILA Connections section, do the following:

a. Click the ILA (A -> Z) tab.

The table that contains fields to specify the optical ILAs in the connectionbetween

thesourceanddestination IPLCs isdisplayed.TheHostNameand IPAddress fields

are displayed in the ILA (A-> Z) tab, which lists the name of the IPLC and the IP

address of the optical supervisory channel (OSC) of the IPLC.

b. Click Select above the table to specify the optical ILAs that must be configured in

an ordered fashion as a chain between the source IPLC and the destination IPLC.

TheChoose ILA dialog box is displayed,with the list of all the optical ILAs available

on the chassis.

c. Select the check boxes beside the optical ILAs that must be included in the

connectivity chain with the IPLC, and clickOK.

The Choose ILA dialog box closes, and the optical ILAs that you selected are listed

in the ILA (A -> Z) tab in the order in which you selected them.

d. Click a row in the table to select an optical ILA, and then clickUp or Down tomove

the optical ILAs up or down in the table.

e. Select an optical ILA from the table, and click Remove to delete any ILA that you

do not want to participate in the IPLC connectivity chain.

You are not prompted to confirm the deletion. You can readd the optical ILAs as

necessary to the connectivity chain.

f. Click the InterfaceMatrix tab.

The wavelengths configured for the A and Z end interfaces are displayed. The

following fields are displayed in a table:

• Wavelength—All the available wavelengths supported by the PTX3000 router

• A End Interfaces—Optical interface namewith the FPC, PIC, and port number of

the A end or source interface

• Z End Interfaces—Optical interface namewith the FPC, PIC, and port number of

the Z end or the destination end of the connection. The Z end interface is an

optical interface to which the IPLC is connected (for switch mode) or the IPLC
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expansion module to which the IPLC basemodule is connected (for express-in

mode).

All port wavelength frequencies are controlled by the wavelength selective switch

(WSS of the IPLC) and configured on a wavelength-by-wavelength basis. The

mapping for thewavelengths, frequencies, and ports is fixed. Each port is assigned

a specific frequency andwavelength depending onwhether the port is on the IPLC

basemodule or expansion module.

13. Click Add/Update at the top of the IPLC Line Connectivity dialog box to save the

connection settings between the optical IPLC and optical ILAs that you specified.

A job is created and run to create IPLC line connectivity. The Create IPLC Line

Connectivity dialog box is displayed after the job is completed, with the job name,

start and end times of the job, job status, and summary. Click Close to close the job

dialog box.

You can click Refresh to update the contents of the dialog box.

14. Click Graphical View at the top of the IPLC Line Connectivity dialog box to view the

connection between the source IPLC and the destination IPLC through the specified

optical ILAs in the chain in a pictorial form.

The Line Connectivity Details dialog box is displayed, with the source and destination

PTX3000 router chassis displayed. Green connector lines are shown to indicate the

link between the source and destination routers. IPLC and optical ILA IP addresses

are displayed above the green connector lines. ClickOKwhen you have completed

viewing the graphical representation of the connectivity.

15. (Optional) Click Delete at the top of the dialog box to delete the connectivity you

created for the IPLC.

A job is created and run to delete IPLC line connectivity. The Delete IPLC Line

Connectivity dialog box is displayed after the job is completed, with the job name,

start and end times of the job, job status, and summary. Click Close to close the job

dialog box.

You can click Refresh to update the contents of the dialog box.

Alternatively, click Cancel if you want to discard the configured IPLC line connectivity

settings. You can click the Refresh (rotating arrow icon) button at the top of the dialog

box to enable the latest settings be retrieved from the device and displayed.

Related
Documentation

Increasing theAddandDropPortCapacityof the IPLCNodeto64Channelsonpage 1528•

• ConfiguringaTwo-Degree IPLCNode forExpressTrafficby Increasing theLineCapacity

on page 1530

• Configuring theWavelengths That Are Added and Dropped by the IPLC on page 1537
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Configuring theWavelengths That Are Added and Dropped by the IPLC

By default, wavelengths on the IPLC ports are in blockedmode. Youmust configure the

IPLC to add or drop a specifc wavelength. This topic describes the default wavelength

mapping for the IPLC ports and how to configure the IPLC to add or drop a specific

wavelength.

All port wavelength frequencies are controlled by the IPLC’s wavelength selective switch

(WSS) and configured on a wavelength-by-wavelength basis.

NOTE: IPLCportscanalsobeswitched-in toanoptical interfaceon thesame
chassis or a remote chassis, or you canexpress-in awavelength toadifferent
IPLC.

Table232onpage 1397 lists thedefault port, frequency, andwavelengthmapping forboth

of the IPLCmodules. The wavelength you want to support must be listed in

Table 232 on page 1397.

Table 249: IPLC Port, Frequency, andWavelength Mapping

Label on IPLC
Expansion
Module

Presenton IPLC
Expansion
Module

Label on
IPLCModule

Present on
IPLCModule

Central Wavelength
[nm]Frequency [THz]

NoNo0Yes1561.01192.05

32YesNoNo1560.61192.1

NoNo1Yes1560.2192.15

33YesNoNo1559.79192.2

NoNo2Yes1559.39192.25

34YesNoNo1558.98192.3

NoNo3Yes1558.58192.35

35YesNoNo1558.17192.4

NoNo4Yes1557.77192.45

36YesNoNo1557.36192.5

NoNo5Yes1556.96192.55

37YesNoNo1556.55192.6

NoNo6Yes1556.15192.65
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Table 249: IPLC Port, Frequency, andWavelength Mapping (continued)

Label on IPLC
Expansion
Module

Presenton IPLC
Expansion
Module

Label on
IPLCModule

Present on
IPLCModule

Central Wavelength
[nm]Frequency [THz]

38YesNoNo1555.75192.7

NoNo7Yes1555.34192.75

39YesNoNo1554.94192.8

NoNo8Yes1554.54192.85

40YesNoNo1554.13192.9

NoNo9Yes1553.73192.95

41YesNoNo1553.33193

NoNo10Yes1552.93193.05

42YesNoNo1552.52193.1

NoNo11Yes1552.12193.15

43YesNoNo1551.72193.2

NoNo12Yes1551.32193.25

44YesNoNo1550.92193.3

NoNo13Yes1550.52193.35

45YesNoNo1550.12193.4

NoNo14Yes1549.72193.45

46YesNoNo1549.32193.5

NoNo15Yes1548.91193.55

47YesNoNo1548.51193.6

NoNo16Yes1548.11193.65

48YesNoNo1547.72193.7

NoNo17Yes1547.32193.75

49YesNoNo1546.92193.8
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Table 249: IPLC Port, Frequency, andWavelength Mapping (continued)

Label on IPLC
Expansion
Module

Presenton IPLC
Expansion
Module

Label on
IPLCModule

Present on
IPLCModule

Central Wavelength
[nm]Frequency [THz]

18Yes1546.52193.85

50YesNoNo1546.12193.9

NoNo19Yes1545.72193.95

51YesNoNo1545.32194

NoNo20Yes1544.92194.05

52YesNoNo1544.53194.1

NoNo21Yes1544.13194.15

53YesNoNo1543.73194.2

NoNo22Yes1543.33194.25

54YesNoNo1542.94194.3

NoNo23Yes1542.54194.35

55YesNoNo1542.14194.4

NoNo24Yes1541.75194.45

56YesNoNo1541.35194.5

NoNo25Yes1540.95194.55

57YesNoNo1540.56194.6

NoNo26Yes1540.16194.65

58YesNoNo1539.77194.7

NoNo27Yes1539.37194.75

59YesNoNo1538.98194.8

NoNo28Yes1538.58194.85

60YesNoNo1538.19194.9

NoNo29Yes1537.79194.95
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Table 249: IPLC Port, Frequency, andWavelength Mapping (continued)

Label on IPLC
Expansion
Module

Presenton IPLC
Expansion
Module

Label on
IPLCModule

Present on
IPLCModule

Central Wavelength
[nm]Frequency [THz]

61YesNoNo1537.40195.00

NoNo30Yes1537.00195.05

62YesNoNo1536.61195.10

NoNo31Yes1536.22195.15

63YesNoNo1535.82195.20

You can configure the IPLC to switch a particular wavelength to an optical interface on

a remote chassis.

Before you start this procedure, make sure that you configure the wavelength on the

remote optical interface so that the wavelength is compatible with the wavelength you

are switching on the IPLC.

To configure an IPLC port to add or drop a specific wavelength:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the treeandselect thePTX300 router forwhich youwant todefine theoptical

IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, selectanoptical IPLC—for example, anoptical IPLC installed

in a PTX3000 router.

The Component Info dialog box is displayed. At the lower part of the dialog box, the

Equipment, Status/Config, Performance, and Line Connectivity tabs are displayed.

6. Click the Status/Config tab at the bottom of the dialog box.
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The IPLC Line dialog box is displayed on the right panewith the configuration settings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.

For example, if the IPLC basemodule resides in slot 1, select the IPLC 1 component in

the image of the chassis.

8. Specify the wavelength number for the IPLC. For example, for wavelength 1550.12,

select the ShowAllWavelengths check box, beside the 1550.12 row in thewavelength

column, modify the values in the configuration and end-point columns as necessary

for this wavelength.

9. Click Update to save the specified configuration settings.

Related
Documentation

Increasing theAddandDropPortCapacityof the IPLCNodeto64Channelsonpage 1528•

• ConfiguringaTwo-Degree IPLCNode forExpressTrafficby Increasing theLineCapacity

on page 1530

• Configuring Optical IPLC Line Connectivity for Interoperation with Optical ILAs on

page 1532

Configuring the IPLC to Add or DropWavelengths to anOptical Interface on a Remote
Chassis

The IPLC isdesigned toconnect theADDandDROPportson the frontpanel to compatible

optical PICs or MICs on the local or remote chassis. Wavelengths configured on the local

IPLCADD ports aremuliplexed and sent over the LineOUT port of the IPLC basemodule.

The remote IPLC basemodule receives the signal on the Line IN port and demultiplexes

the wavelengths to the DROP ports on the front panel of the IPLC according to the

configurationof the remote IPLC.After youhavemade thephysical connectionsbetween

the IPLC ports and the local and remote optical interfaces, you need to configure the

IPLC to switch the wavelengths to the optical interfaces. This topic describes how to

configure the IPLC to switch thewavelengths on the ADD andDROP ports to compatible

optical interfaces on the local chassis or a remote chassis.

You can configure the IPLC to switch a particular wavelength to an optical interface on

a remote chassis.

Before you begin, complete the following tasks:

• Install theoptical interfacesandconfigure thewavelengthon the local optical interface

so that it is compatiblewith thewavelength on the IPLC. See,Configuring the 10-Gigabit

or 100-Gigabit Ethernet DWDM InterfaceWavelength

• Install the IPLCmodule at the remote location and connect the ADD and DROP ports

to the respective local optical interfaces.
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To configure the IPLC basemodule to switch a wavelength to an optical interface on a

remote chassis:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the treeandselect thePTX300 router forwhich youwant todefine theoptical

IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, selectanoptical IPLC—for example, anoptical IPLC installed

in a PTX3000 router.

The Component Info dialog box is displayed. At the lower part of the dialog box, the

Equipment, Status/Config, Performance, and Line Connectivity tabs are displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLC Line dialog box is displayed on the right panewith the configuration settings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.

For example, if the IPLC basemodule resides in slot 1, select the IPLC 1 component in

the image of the chassis.

8. Specify the wavelength number and that you want to switch it to the remote chassis.

For example, if you want to switch wavelength 1550.12 on the IPLC in slot 1 to the

remote chassis, in theWavelength Configuration section, select the ShowAll

Wavelengths check box, and beside the 1550.12 row in thewavelength column, select

switch from the drop-downmenu in the configuration column of the table for the

corresponding wavelength.

9. Fromtheend-pointcolumn, click in thecell corresponding to thewavelengthof 1550.12,

and then click the drop-down arrow.
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From the drop-downmenu, select remote to specify the remote chassis to which you

want the wavelength of the IPLC basemodule to be switched.

10. Click Update to save the specified configuration settings.

Related
Documentation

Configuring the IPLC to Add or DropWavelengths to an Optical Interface on the Same

Chassis on page 1543

•

• Bypassing aWavelength on the IPLC on page 1544

Configuring the IPLC to Add or DropWavelengths to anOptical Interface on the Same
Chassis

This topic provides a procedure for switching a wavelength present on the local IPLC

modules to an optical interface on the same chassis.

Before you begin, complete the following tasks:

• Install theoptical interfacesandconfigure thewavelengthon the local optical interface

so that it is compatiblewith thewavelength on the IPLC. See,Configuring the 10-Gigabit

or 100-Gigabit Ethernet DWDM InterfaceWavelength

• Install the IPLCmodule and connect the ADD and DROP ports to the respective local

optical interfaces.

To configure the IPLC basemodule to switch a wavelength to an optical interface on the

same chassis:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the treeandselect thePTX300 router forwhich youwant todefine theoptical

IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, selectanoptical IPLC—for example, anoptical IPLC installed

in a PTX3000 router.
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The Component Info dialog box is displayed. At the lower part of the dialog box, the

Equipment, Status/Config, Performance, and Line Connectivity tabs are displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLC Line dialog box is displayed on the right panewith the configuration settings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.

For example, if the IPLC basemodule resides in slot 1, select the IPLC 1 component in

the image of the chassis.

8. Specify the wavelength you want to switch and the name of the physical optical

interface towhich youwant to switch it. For example, if youwant to switchwavelength

1550.12 on the IPLC in slot 1 to the optical interface on FPC slot 3, PIC 0, port 0, in the

Wavelength Configuration section, select the ShowAllWavelengths check box, and

beside the 1550.12 row in thewavelength column, select switch from the drop-down

menu in the configuration column of the table for the corresponding wavelength.

9. Fromtheend-pointcolumn, click in thecell corresponding to thewavelengthof 1550.12,

and then click the drop-down arrow.

From the drop-downmenu, select et-3/0/0 to which youwant thewavelength of the

IPLC basemodule to be switched.

10. Click Update to save the specified configuration settings.

Related
Documentation

Configuring the IPLC to Add or DropWavelengths to an Optical Interface on a Remote

Chassis on page 1541

•

• Bypassing aWavelength on the IPLC on page 1544

Bypassing aWavelength on the IPLC

The IPLC enables you to optically bypass a wavelength by entering a few simple

configuration statements. Bypassing a wavelength does not terminate the wavelength

at the local IPLC but instead passes the wavelength on to the next downstream IPLC

node. This topic describes how to bypass a wavelength on the IPLC.

Optical bypassesare softwareconfigurableandcontrolled through the IPLC’swavelength

selective switch (WSS) so there is no need to manual intervention. The IPLCs software

optical bypass enables wavelengths that do not terminate on the given node to be

passed-through to the remotenodewithoutoptical-electrical-optical (OEO)conversion.
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Before you begin, configure the IPLC two-degree intermediate node for express traffic.

To configure the IPLC to bypass a wavelength:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the treeandselect thePTX300 router forwhich youwant todefine theoptical

IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. In the imageof thedevice, selectanoptical IPLC—for example, anoptical IPLC installed

in a PTX3000 router.

The Component Info dialog box is displayed. At the lower part of the dialog box, the

Equipment, Status/Config, Performance, and Line Connectivity tabs are displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLC Line dialog box is displayed on the right panewith the configuration settings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.

For example, if the IPLC basemodule resides in slot 1, select the IPLC 1 component in

the image of the chassis.

8. Configure the wavelength that you want to bypass from the IPLC basemodule to

another IPLCmodule

For example, to bypass the wavelength of 1532.29, select the ShowAllWavelengths

check box, and select express from the drop-downmenu in the configuration column

of the table for the corresponding wavelength.

9. Create a logical association between the two IPLCmodules and specify that youwant

the IPLC to express-in a wavelength.
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For example, if the other IPLC resides in slot 2, select IPLC 2 from the Express IPLC list

in the Settings/Status section.

10. Click Update to save the specified configuration settings.

Related
Documentation

Configuring the IPLC to Add or DropWavelengths to an Optical Interface on a Remote

Chassis on page 1541

•

• Configuring the IPLC to Add or DropWavelengths to an Optical Interface on the Same

Chassis on page 1543

Changing Alarm Settings for the Optical IPLCs

Youcanmodify theconfiguration settings for alarmsettingsofoptical integratedphotonic

line cards (IPLCs), which are used in conjunction with optical inline amplifiers (ILAs) on

PTX3000 Packet Transport Routers, using the Preferences page of the Connectivity

Services Director application. To open the Preferences page, click the down arrow next

to theSystembutton in theConnectivityServicesDirector banner andselectPreferences.

The Preferences page opens with User Preferences as the default tab. Click the Fault

tab of thePreferences pageof theConnectivity ServicesDirectorGUI to enable individual

alarms, set the retention period for alarms, configure alarm notifications, configure

threshold alarms, and to specify the number of events to keep for each alarm. The Fault

tab hasmultiple sections, which you can expand and collapse by clicking the arrow next

to the section title:

• Global Settings, for configuring Faults settings such as global alarm notifications and

alarm data retention.

• Individual Alarms andThreshold Settings, for configuring settings for individual alarms

and threshold alarms.

• Alarms for Optical IPLCs on page 1547

• Configuring Global Alarm Notifications on page 1551

• Retaining Alarm History on page 1551

• Specifying Event History on page 1551

• Enabling Alarms on page 1551

• Changing the Severity of Individual Alarms on page 1551

• Configuring Threshold Alarms on page 1552

• Configuring Individual Alarm Notifications on page 1552
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Alarms for Optical IPLCs

The following alarms are applicable for management of the optical IPLC:

DescriptionAlarm Name

Generated as the FPC arrayed waveguide gratings (AWG) add LOS alarm
for the IPLC

jnxIplcFpcAwgAddLosAlarm

Generated as the FPC input LOSalarm for the express-inmode of the IPLC.jnxIplcFpcExpInLosAlarm

Generated as the FPCadd LOSalarm for the optical service channel (OSC)
of the IPLC. TheOSC is an in-band channel used to communicatewith ILAs
and other optical nodes in the line system that are not directly accessible
over the DCN. OSC framing logic is implemented in the FPGA.

jnxIplcFpcOscAddLosAlarm

Generated as the FPC drop LOS alarm for the OSC of the IPLC.jnxIplcFpcOscDrpLosAlarm

Generated as the FPC input line-in LOS alarm for the IPLC.jnxIplcFpcLineInLosAlarm

Generated as the FPC erbium doped fiber amplifier (EDFA) 1 reflect power
alarm for the IPLC. EDFA1 is considered as ingress EDFA and EDFA2 is
considered as egress EDFA

jnxIplcFpcEdfa1RefPwAlarm

Generated as the FPC EDFA1 output power alarm for the IPLC.jnxIplcFpcEdfa1OutPwAlarm

Generated as the FPC EDFA1 output gain alarm for the IPLCjnxIplcFpcEdfa1OutGain

Generated as the FPC EDFA1 pump end-of-life (EoL) alarm for the IPLC.jnxIplcFpcEdfa1PumpEolAlarm

Generated as the FPC EDFA1 temperature alarm for the IPLC.jnxIplcFpcEdfa1TempAlarm

Generated as the FPC EDFA1 output LOS alarm for the IPLC.jnxIplcFpcEdfa1OutLosAlarm

Generated as the FPC EDFA1 input LOS alarm for the IPLC.jnxIplcFpcEdfa1InLosAlarm

Generated as the FPC erbium doped fiber amplifier (EDFA) 1 reflect power
alarm for the IPLC. EDFA1 is considered as ingress EDFA and EDFA2 is
considered as egress EDFA

jnxIplcFpcEdfa2RefPwAlarm

Generated as the FPC EDFA2 output power alarm for the IPLC.jnxIplcFpcEdfa2OutPwAlarm

Generated as the FPC EDFA2 output gain alarm for the IPLCjnxIplcFpcEdfa2OutGainAlarm

Generatd as the FPC EDFA2 pump end-of-life (EoL) alarm for the IPLC.jnxIplcFpcEdfa2PumpEolAlarm

Generated as the FPC EDFA2 temperature alarm for the IPLC.jnxIplcFpcEdfa2TempAlarm

Generated as the FPC EDFA2 output LOS alarm for the IPLC.jnxIplcFpcEdfa2OutLosAlarm

Generated as the FPC EDFA2 input LOS alarm for the IPLC.jnxIplcFpcEdfa2InLosAlarm
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DescriptionAlarm Name

Generated as the FPCwavelength selective switching (WSS) temperature
alarm for the IPLC.

jnxIplcFpcWssTempAlarm

Generated as the FPCWSS voltage alarm for the IPLC.jnxIplcFpcWssVoltAlarm

Generated as the FPC internal diagnostic alarm for the IPLC.jnxIplcFpcInterDiagAlarm

Generated as the FPC firmware consistency alarm for the IPLC.jnxIplcFpcFwCnsistAlarm

Generated as the FPC hardware failure alarm for the IPLC.jnxIplcFpcHwFailAlarm

Generated as the FPC firmware failure alarm for the IPLC.jnxIplcFpcFwFailAlarm

Generated as the FPC optical channel monitor (OCM) failure alarm for the
IPLC.

jnxIplcFpcOcmFailAlarm

Generated as the FPCWSS failure alarm for the IPLC.jnxIplcFpcWssFailAlarm

Generated as the FPC EDFA2 failure alarm for the IPLC.jnxIplcFpcEdfa2FailAlarm

Generated as the FPC EDFA1 alarm for the IPLC.jnxIplcFpcEdfa1FailAlarm

Generated as the FPC power rail failure alarm for the IPLC.jnxIplcFpcPwrFailAlarm

Generated as an alarmwhen the OSC transmitted high power exceeds the
threshold within the 15-minute interval for the IPLC.

jnxIplcOscTxPowerHigh15minAlert

Generated as an alarmwhen the OSC transmitted low power exceeds the
threshold within the 15-minute interval for the IPLC.

jnxIplcOscTxPowerLow15minAlert

Generated as an alarmwhen the OSC received high power exceeds the
threshold within the 15-minute interval for the IPLC.

jnxIplcOscRxPowerHigh15minAlert

Generated as an alarmwhen the OSC received low power exceeds the
threshold within the 15-minute interval for the IPLC.

jnxIplcOscRxPowerLow15minAlert

Generated as an alarmwhen theOSC fiber high LOSexceeds the threshold
within the 15-minute interval for the IPLC.

jnxIplcOscFiberLosHigh15minAlert

Generated as an alarmwhen the OSC fiber low LOS exceeds the threshold
within the 15-minute interval for the IPLC.

jnxIplcOscFiberLosLow15minAlert

Generatedas the line-outVariableOpticalAttenuator (VOA)high threshold
setting trigger within the 15-minute period for the IPLC.

jnxIplcLineOutVoaHigh15minAlert

Generated as the line-out VariableOptical Attenuator (VOA) low threshold
setting trigger within the 15-minute period for the IPLC.

jnxIplcLineOutVoaLow15minAlert

Generated as the ingress EDFA input power high threshold setting trigger
within the 15-minute period for the IPLC.

jnxIplcIngressEdfaInputPwHigh15minAlert
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DescriptionAlarm Name

Generated as the ingress EDFA input power low threshold setting trigger
within the 15-minute period for the IPLC.

jnxIplcIngressEdfaInputPwLow15minAlert

Generated as the OCMmodule power high threshold setting trigger within
the 15-minute period for the IPLC.

jnxIplcOcmPwHigh15minAlert

Generated as the OCMmodule power low threshold setting trigger within
the 15-minute period for the IPLC.

jnxIplcOcmPwLow15minAlert

Generated as the OSC transmitted high power threshold setting trigger
within the 15-minute period for the IPLC.

jnxIplcOscTxPowerHigh24hourAlert

Generated as the OSC transmitted high power threshold setting trigger
within the 15-minute period for the IPLC.

jnxIplcOscTxPowerLow24hourAlert

Generated as an alarmwhen the OSC received high power exceeds the
threshold within the 24-hour interval for the IPLC.

jnxIplcOscRxPowerHigh24hourAlert

Generated as an alarmwhen the OSC received low power exceeds the
threshold within the 24-hour interval for the IPLC.

jnxIplcOscRxPowerLow24hourAlert

Generated as an alarmwhen theOSC fiber high LOSexceeds the threshold
within the24-hour interval for the IPLC.

jnxIplcOscFiberLosHigh24hourAlert

Generated as an alarmwhen the OSC fiber low LOS exceeds the threshold
within the 24-hour interval for the IPLC.

jnxIplcOscFiberLosLow24hourAlert

Generatedas the line-outVariableOpticalAttenuator (VOA)high threshold
setting trigger within the 24-hour period for the IPLC.

jnxIplcLineOutVoaHigh24hourAlert

Generated as the line-out VariableOptical Attenuator (VOA) low threshold
setting trigger within the 24-hour period for the IPLC.

jnxIplcLineOutVoaLow24hourAlert

Generated as the ingress EDFA input high power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcIngressEdfaInputPwHigh24hourAlert

Generated as the ingress EDFA input low power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcIngressEdfaInputPwLow24hourAlert

Generated as the ingress EDFA output high power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcIngressEdfaOutputPwHigh24hourAlert

Generated as the ingress EDFA output low power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcIngressEdfaOutputPwLow24hourAlert

Generated as the ingress EDFA signal high power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcIngressEdfaSignalPwHigh24hourAlert

Generated as the ingress EDFA signal low power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcIngressEdfaSignalPwLow24hourAlert
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DescriptionAlarm Name

Generated as the ingress EDFA pump current high temperature threshold
setting trigger within the 24-hour period for the IPLC.

jnxIplcIngressEdfaPumpCurrentHigh24hourAlert

Generated as the ingress EDFA pump current low temperature threshold
setting trigger within the 24-hour period for the IPLC.

jnxIplcIngressEdfaPumpCurrentLow24hourAlert

Generated as the egress EDFA input high power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcEgressEdfaInputPwHigh24hourAlert

Generated as the egress EDFA input low power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcEgressEdfaInputPwLow24hourAlert

Generated as the egress EDFA output high power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcEgressEdfaOutputPwHigh24hourAlert

Generated as the egress EDFA output low power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcEgressEdfaOutputPwLow24hourAlert

Generated as the egress EDFA signal high power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcEgressEdfaSignalPwHigh24hourAlert

Generated as the egress EDFA signal low power threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcEgressEdfaSignalPwLow24hourAlert

Generated as the egress EDFA pump current high temperature threshold
setting trigger within the 24-hour period for the IPLC.

jnxIplcEgressEdfaPumpCurrentHigh24hourAlert

Generated as the egress EDFA pump current low temperature threshold
setting trigger within the 24-hour period for the IPLC.

jnxIplcEgressEdfaPumpCurrentLow24hourAlert

Generated as the power monitor AWG add high threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcPowerMonitorAwgAddHigh24hourAlert

Generated as the power monitor AWG add low threshold setting trigger
within the 24-hour period for the IPLC.

jnxIplcPowerMonitorAwgAddLow24hourAlert

Generated as the power monitor express-in mode high threshold setting
trigger within the 24-hour period for the IPLC.

jnxIplcPowerMonitorExpressInHigh24hourAlert

Generated as the power monitor express-in mode low threshold setting
trigger within the 24-hour period for the IPLC.

jnxIplcPowerMonitorExpressInLow24hourAlert

Generated as the OCMmodule power high threshold setting trigger within
the 24-hour period for the IPLC.

jnxIplcOcmPwHigh24hourAlert

Generated as the OCMmodule power low threshold setting trigger within
the 24-hour period for the IPLC.

jnxIplcOcmPwLow24hourAlert

Generated as the FPC SFP loss of signal (LOS) alarm for the IPLC.jnxIplcFpcSfpLosAlarm

Generated as the FPC SFP loss of frame (LOF) alarm for the IPLC.jnxIplcFpcSfpLofAlarm
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Configuring Global AlarmNotifications

Youcanconfigureglobal e-mail notifications tobesentwhenanyalarmwithnotifications

enabled is generated. Toconfigureglobal e-mail notifications, enter thee-mail addresses

to receive global alarm notifications in the Alarm Notifications Destinations field in the

Global Settings section. Separate addresses with a comma (,). For information about

enabling notification for an alarm, see “Configuring Individual Alarm Notifications” on

page 152.

Retaining AlarmHistory

Use theNo.ofdays tokeepAlarm field in theGlobalSettings section to specify thenumber

of days to keep alarm history. The default retention time is 120 days; but you can specify

a period of 7 through 1000 days. Specifying a longer retention time consumesmore

database resources. To change the alarm retention duration, type a new value and click

OK and Yes to confirm the change.

Specifying Event History

Use the Events/Alarm field in the Global Settings section to specify the number of event

entries that are kept in the alarm history. The default setting for events is 20. To change

the setting, type a new value and clickOK and Yes to confirm the change.

Enabling Alarms

Ensure all devices are configured to send traps to Connectivity Services Director. This

task is performed for the devices in Deploy mode through Set SNMP Trap Configuration.

Use the Individual Alarms and Threshold Settings section to disable and re-enable

individual alarmsor all alarms. Alarmsappear onboth tabs in the section: AlarmSettings

and Threshold Settings. Fault alarms are preconfigured and initially enabled. To enable

or disable alarms:

1. (Optional)Sort thealarms.Bydefault, the list ofalarms is sortedalphabeticallywithin

each category. You can also sort by description or alarm severity within a category by

clicking a column heading.

2. Review the alarms and either select the check box in the heading to select all of the

alarms or select the check box for the individual alarms you want to enable.

3. ClickOK and Yes to confirm the alarm change.

Changing the Severity of Individual Alarms

You can change the severity of the alarms to match your corporate procedures and

guidelines. For example, at your company a DoS attack might be considered a critical

alarm, while Connectivity Services Director has a default severity for DoS attacks as a

major alarm.Alarmsappear onboth tabs in the IndividualAlarmsandThresholdSettings

section: Alarm Settings and Threshold Settings.
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To change the severity of an alarm:

1. Select the current severity in the Severity column. A list of the severity levels appear.

2. Select the new severity level for the alarm.

3. ClickOK and Yes to confirm the change to the severity setting.

To configure alarm notifications, see “Configuring Individual Alarm Notifications” on

page 152.

Configuring Threshold Alarms

Threshold alarms are alarms that are generated when amonitored value crosses the

configured threshold.Theyprovideenhancedvisibility intopotential issueson thenetwork.

You configure andmanage threshold alarms the sameway as other alarms. You also

have the option of setting the threshold level of individual threshold alarms.

To set threshold alarm thresholds:

1. Select the Threshold Settings tab in the Individual Alarms and Threshold settings

section of the Fault tab.

2. Click Edit Settings in the Threshold Settings column of the alarm threshold you want

to edit.

3. Set the threshold in the window that opens.

4. Click Save to save the new threshold.

To configure alarm notifications, see “Configuring Individual Alarm Notifications” on

page 152.

Configuring Individual AlarmNotifications

You can configure e-mail notifications to be sent when an individual alarm is generated.

When you enable notification for an alarm, the notifications are sent to the e-mail

addresses configured for the alarm and the addresses configured for global alarm

notifications. Alarmsappear onboth tabs in the IndividualAlarmsandThresholdSettings

section: Alarm Settings and Threshold Settings.

To configure e-mail notification for an alarm name:

1. Select the check box in the alarm’s Notification column.

If you later want to disable notification for the alarm, clear the check box.

2. ClickEditNotification in theNotificationcolumn.TheAlarmNotificationDetailswindow

opens.
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3. Enteroneormoree-mail addresses in theNotificationEmailAddresses field.Separate

addresses with a comma (,).

You can later edit the addresses to send notifications to different addresses.

4. (Optional) Enter a comment in the Comments field. This comment is included in the

e-mail notification message.

5. Click Save.

Related
Documentation

Configuring the IPLC to Add or DropWavelengths to an Optical Interface on a Remote

Chassis on page 1541

•

• Configuring the IPLC to Add or DropWavelengths to an Optical Interface on the Same

Chassis on page 1543

• Bypassing aWavelength on the IPLC on page 1544

Viewing Routing Engine Switchover Indicators in the Chassis Image

RedundantRoutingEnginesare twoRoutingEngines thatare installed in the same routing

platform. One functions as themaster, while the other stands by as a backup should the

master Routing Engine fail. On routing platforms with dual Routing Engines, network

reconvergence takes place more quickly than on routing platforms with a single Routing

Engine.

The Chassis View provides a pictorial representation of the chassis or device, and the

modules or components that are installed in it, such as the line cards, interfaces, and

other hardware elements. To view a pictorial representation of a device chassis and the

configured components, such as interfaces, line cards, and hardware elements, select a

managed device listed in the My Network tree in Device View of Build mode of the

Connectivity Services Director GUI, and select DeviceManagement > View Physical

Inventory from the tasks pane.

Theactiveormaster and thestandbyorbackupRoutingEngines indicatedon theRouting

Engine in the Chassis Viewwith a descriptive text label. “ACT” denotes an active Routing

Engine, whereas “SDBY” denotes a standby Routing Engine. The status is updated on

the Routing Engine only after a polling request because of the implications on the Junos

Space application and device performance.

Routing Engine Redundancy Overview

When a Routing Engine is configured as master, it has full functionality. It receives and

transmits routing information, builds andmaintains routing tables, communicates with

interfaces and Packet Forwarding Engine components, and has full control over the

chassis.When aRouting Engine is configured to be the backup, it does not communicate

with the Packet Forwarding Engine or chassis components.
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NOTE: Ondevices running JunosOSRelease8.4or later,bothRoutingEngines
cannotbeconfiguredtobemasterat thesametime.Thisconfigurationcauses
the commit check to fail.

A failover from themaster Routing Engine to the backup Routing Engine occurs

automatically when themaster Routing Engine experiences a hardware failure or when

you have configured the software to support a change in mastership based on specific

conditions. You can also manually switch Routing Engine mastership by issuing one of

the request chassis routing-engine commands. In this topic, the term failover refers to an

automatic event, whereas switchover refers to either an automatic or a manual event.

When a failover or a switchover occurs, the backup Routing Engine takes control of the

system as the newmaster Routing Engine.

• If graceful Routing Engine switchover is not configured, when the backup Routing

Engine becomesmaster, it resets the switch plane and downloads its own version of

the microkernel to the Packet Forwarding Engine components. Traffic is interrupted

while thePacket Forwarding Engine is reinitialized. All kernel and forwarding processes

are restarted.

• If graceful Routing Engine switchover is configured, interface and kernel information

is preserved. The switchover is faster because the Packet Forwarding Engines are not

restarted. The newmaster Routing Engine restarts the routing protocol process (rpd).

All hardware and interfaces are acquired by a process that is similar to a warm restart.

• If gracefulRoutingEngine switchover andnonstopactive routing (NSR)are configured,

traffic is not interrupted during the switchover. Interface, kernel, and routing protocol

information is preserved.

• If graceful Routing Engine switchover and graceful restart are configured, traffic is not

interruptedduring theswitchover. Interfaceandkernel information ispreserved.Graceful

restart protocol extensions quickly collect and restore routing information from the

neighboring routers.

Conditions That Trigger a Routing Engine Failover

The following events can result in an automatic change in Routing Engine mastership,

depending on your configuration:

• The routing platform experiences a hardware failure. A change in Routing Engine

mastership occurs if either the Routing Engine or the associated host module or

subsystem is abruptly powered off. You can also configure the backup Routing Engine

to take mastership if it detects a hard disk error on the master Routing Engine.

• The routing platform experiences a software failure, such as a kernel crash or a CPU

lock. Youmust configure thebackupRoutingEngine to takemastershipwhen it detects

a loss of keepalive signal.

• A specific software process fails. You can configure the backup Routing Engine to take

mastership when one or more specified processes fail at least four times within 30

seconds.
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If any of these conditions is met, a message is logged and the backup Routing Engine

attempts to takemastership. By default, an alarm is generatedwhen the backupRouting

Engine becomes active. After the backup Routing Engine takes mastership, it continues

to function as master even after the originally configuredmaster Routing Engine has

successfully resumed operation. Youmust manually restore it to its previous backup

status. (However, if at any time one of the Routing Engines is not present, the other

Routing Engine becomesmaster automatically, regardless of how redundancy is

configured.)

Related
Documentation

Viewing Alarm Indicators in the Chassis Image on page 1555•

• Viewing Port Statistics for OTN PICs on page 1556

Viewing Alarm Indicators in the Chassis Image

Activity on a network device consists of a series of events. A software component on the

network device, called an entity, is responsible for running the Simple Network

Management Protocol (SNMP) to log andmonitor these events. When certain types of

events arepersistent, orwhen thecondition causing theevent crossesa threshold, SNMP

sends a notification, also called a trap to Connectivity Services Director. Connectivity

Services Director correlates traps, describing a condition, into an alarm.

The Chassis View provides a pictorial representation of the chassis or device, and the

modules or components that are installed in it, such as the line cards, interfaces, and

other hardware elements. To view a pictorial representation of a device chassis and the

configured components, such as interfaces, line cards, and hardware elements, select a

managed device listed in the My Network tree in Device View of Build mode of the

Connectivity Services Director GUI, and select DeviceManagement > View Physical

Inventory from the tasks pane.

The alarms are correlated for each FPC in conjunction with other modules that are

installed on a specific device chassis. This alarm value is added as a property to the FPC

details. Apart from the Active Alarms pane that is displayed to the right of the graphical

imageof the chassis (in theComponent Info pane), you canalso view thealarm indicator

as a circle or an LED icon that is displayed at the top of each FPC. A gray circle denotes

that no alarm is present for the FPCmodule, whereas a red circle denotes that an active

alarm is present for the FPCmodule.

Related
Documentation

Viewing Routing Engine Switchover Indicators in the Chassis Image on page 1553•

• Viewing Port Statistics for OTN PICs on page 1556
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Viewing Port Statistics for OTN PICs

The performancemonitoring capability in Connectivity Services Director displays

information about the health of your network and changing conditions of your optical

interfaces. Use this diagnosis and detection mechanism to identify problems with the

equipment, pinpoint security attacks, or to analyze trends and categories of errors. This

feature includes fault-monitoring details in the dashboard, monitoring pages, and in a

dedicatedpage thatdisplaysalarms, events, andsystem logmessages thataregenerated.

Performancemonitoring parameters can be viewed in both chart and statistical formats.

These charts and statistical details provide essential and cohesive information about

system conditions, any discrepancies andmalfunctioning, and protocols or components

that need to be examined and debugged for better efficiency and working capacity. You

can assess the performance of your network, not only at a point in time, but also over a

period of time. This feature enables you to determine trending and network-health

parameters; for example, whether service-level agreements (SLAs) have been violated.

The port statistics are available for viewing when the port on the FPC is selected. The

Packets and Error counters for the selected port are displayed in the Optics PMs dialog

box.

To view the port statistical details for OTN PICs:

1. From the Junos Space user interface, click the Build icon on the Connectivity Services

Director banner.

The workspaces that are applicable to Build mode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the device for which you want to define the optical port

settings.

The selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Select an OTN PIC, such as a 2-port 100-Gigabit Ethernet OTN PIC, in the image of

the device.

The Component Info dialog box is displayed on the right pane with the PIC

specifications. For example, if you select a 100-Gigabit Ethernet PIC installed in a PTX

Series router, the Component Info dialog box is displayed to the right of the graphical

view of the chassis. Select the Performance tab at the bottom of the dialog box to

open the Optics PMs dialog box.
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6. Click the Performance tab at the bottom of the dialog box.

The Optics PMs dialog box is displayed with the performancemonitoring attributes

for the OTN PIC. The Packet Counters and Error Counters tabs are displayed in the

dialog box. The date and time at which the dialog box was last refreshed is shown.

The following fields are displayed in the Packet Counters tab of theOptics PMs dialog

box:

• UniCast In—Ingress unicast packets per second

• BroadCast In—Ingress broadcast In packet per second

• Multicast In—Ingress multicast In packet per second

• Unicast Out—Egress unicast packets per second

• Broadcast Out—Egress broadcast packets per second

• Multicast Out—Egress multicast packets per second

The following fields are displayed in the Error Counters tab of the Optics PMs dialog

box:

• Errors In—Sum of the incoming frame aborts and FCS errors.

• Drops In—Number of packets dropped by the input queue of the I/OManager ASIC.

If the interface is saturated, this number increments once for every packet that is

dropped by the ASIC's REDmechanism.

• Framing errors In—Number of packets received with an invalid frame checksum

(FCS).

• Runts In—Number of frames received that are smaller than the runt threshold.

• Policed discards In—Number of frames that the incoming packet match code

discarded because they were not recognized or not of interest. Usually, this field

reports protocols that the Junos OS does not handle.

• L3 incompletes In—Number of incoming packets discarded because they failed

Layer 3 (usually IPv4) sanity checks of the header. For example, a frame with less

than20bytesofavailable IPheader isdiscarded. L3 incompleteerrors canbe ignored

by configuring the ignore-l3-incompletes statement.

• L2 channel errors In—Number of times the software did not find a valid logical

interface for an incoming frame.

• L2mismatch timeouts In—Number of malformed or short packets that caused the

incoming packet handler to discard the frame as unreadable.

• FIFO errors In—Number of FIFO errors in the receive direction that are reported by

the ASIC on the PIC. If this value is ever nonzero, the PIC is probablymalfunctioning.

• Resource errors In—Sum of transmit drops.

• Oversized frames In—Number of frames that exceed 1518 octets.

• Jabber frames In—Number of frames that were longer than 1518 octets (excluding

framing bits, but including FCS octets), and had either an FCS error or an alignment
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error. This definition of jabber is different from the definition in IEEE-802.3 section

8.2.1.5 (10BASE5) and section 10.3.1.4 (10BASE2). These documents define jabber

as the condition in which any packet exceeds 20ms. The allowed range to detect

jabber is from 20ms to 150ms.

• Fragmentframes In—Totalnumberofpackets thatwere less than64octets in length

(excluding framing bits, but including FCS octets), and had either an FCS error or

analignmenterror. Fragment framesnormally incrementbecauseboth runts (which

are normal occurrences caused by collisions) and noise hits are counted.

• CRCerrors In—Total numberofpackets received thathada length (excluding framing

bits, but including FCS octets) of between 64 and 1518 octets, inclusive, and had

either a bad FCSwith an integral number of octets (FCS Error) or a bad FCSwith a

nonintegral number of octets (Alignment Error).

• Carrier transitions Out—Number of times the interface has gone from down to up.

This number does not normally increment quickly, increasing only when the cable

is unplugged, the far-end system is powered downand then up, or another problem

occurs. If the number of carrier transitions increments quickly (perhaps once every

10 seconds), the cable, the far-end system, or the PIC or PIM is malfunctioning.

• Errors Out—Sum of the outgoing frame aborts and FCS errors.

• Drops Out—Number of packets dropped by the output queue of the I/O Manager

ASIC. If the interface is saturated, this number increments once for every packet

that is dropped by the ASIC's REDmechanism.

• Collisions Out—Number of Ethernet collisions. The Gigabit Ethernet PIC supports

only full-duplex operation, so for Gigabit Ethernet PICs, this number should always

remain 0. If it is nonzero, there is a software bug.

• Aged packets Out—Number of packets that remained in shared packet SDRAM so

long that the systemautomatically purged them.The value in this field should never

increment. If it does, it is most likely a software bug or possibly malfunctioning

hardware.

• FIFOerrorsOut—Number of FIFOerrors in the senddirection as reportedby theASIC

on the PIC. If this value is ever nonzero, the PIC is probably malfunctioning.

• HSlinkCRCerrorsOut—Numberoferrorson thehigh-speed linksbetween theASICs

responsible for handling the router interfaces.

• MTUerrorsOut—Number of packetswhose size exceeded theMTUof the interface.

• Resource errors Out—Sum of transmit drops.

7. To view a graphical representation of the port statistics, click the ShowChart button

above thePacket Counters and Error Counters tabs. ThePort Statistics pop-up dialog

box is displayed.

You can view the interface statuses, such as errors and the operational conditions of

the interfaces, that enables you in analyzing, troubleshooting, and rectifying problems

with dropped packets or untransmitted bytes. Some of the causes for such a loss of

traffic or ablock in transmissionofdatapackets includeoverloadedsystemconditions,

profiles and policies that restrict the bandwidth or priority of traffic, network outages,
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or disruption with physical cable faults. This operation is equivalent to the show

interface statistics command that you can run from the Junos OS CLI interface. You

can search for specific devices or interfaces by entering a search item and clicking the

Search icon. A line graph is displayed with the input packets and errors, and output

packets and errors shown on the vertical axis and the time shown on the horizontal

axis. The following color-coded legends reference the line graphs:

• Packets In (Orange)—Number of packets received on the interface

• Packets Out (Green)—Number of packets sent from the interface

• Errors In (Blue)—Number of inbound errors received on the interface

• Errors Out (Purple)—Number of outbound errors transmitted from the interface

From the Time Interval drop-down box, select 1 Hour, 8 Hours, 1 Day, 1 Week, 1 Month,

3Months, 6Months, 1 Year, orCustomto specify theduration forwhich thedatapolled

from devices needs to be displayed. If you select the Custom option, the Time range

popupdialogbox is displayed. Specify thedate fromthe calendar, and select theTime

From (Start time in the 24-hour time format of collection of data), and Time To (End

time in the 24-hour time format of collection of data). Click OK to save the settings.

Else, click Cancel to discard the configuration.

The Interface Details table displays all the UNI parts of the service. Also, the physical

interface for the logical interface participating in the service is displayed.

• Serial Num—Serial number of the hardware component

• Port Name—Name of the interface

• Interface Type—Whether the interface is physical or logical

• Link Type—Operational status of the physical interface: Up, Down.

• MAC Address—MAC address of the physical interface.

• Input Packets—Number of packets received on the interface.

• Output Packets—Number of packets sent from the interface.

• LastPollTime—Dateand timeatwhich thestatisticaldetailwasobtainedbypolling

and retrieving from the device for the specified interface.

The Packet Counter tab on the right side of the page displays the following fields in

a table. It is applicable for physical interfaces only. The values displayed are in rates

of packets per second.

• Input Unicasts—Number of input unicast packets for the physical interface

• Output Unicasts—Number of output unicast packets for the physical interface

• Input Multicast—Number of input multicast packets for the physical interface

• Output Multicast—Number of output multicast packets for the physical interface

• Input Broadcast—Number of input broadcast packets for the physical interface

• Output Broadcast—Number of output broadcast packets for the physical interface
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The Error Counter tab on the right side of the page displays the following fields in a

table. It is available for physical interfaces only. The values displayed are in rates of

packets per second.

• Input Errors—Number of errors packets received on the physical interface

• Output Drops—Number of outgoing packets that are dropped by the physical

interface

• Input Framing Errors—Number of packets with framing errors that are received on

the physical interface

• InputDrops—Numberof incomingpackets thataredroppedby thephysical interface

• Input Discards—Number of incoming packets discarded by the physical interface

• Output Errors—Number of error packets sent out from the physical interface

You can click the Refresh (rotating arrow icon) button at the top of the dialog box to

enable the latest settings be retrieved from the device and displayed.

Related
Documentation

Viewing Routing Engine Switchover Indicators in the Chassis Image on page 1553•

• Viewing Alarm Indicators in the Chassis Image on page 1555

•

Example:ConfiguringTwoFiberLineTerminationsUsing IPLCsforOpticalAmplification
in aMetro Linear Packet Optical Network

For metro linear andmetro ring topologies that require either north-south or east-west

communications, youcanconnect two integratedphotonic linecard (IPLC)basemodules

together to form a single nodewith two fiber line terminations. This example shows how

to configure the Junos OS to support the IPLC basemodules in a Metro linear packet

optical configuration for adding and dropping wavelengths to a local optical interface,

and for bypassing wavelengths to another IPLC. You can set up and configure an IPLC

node with two line-side fiber terminations.

• Requirements on page 1560

• Overview on page 1561

• Configuration on page 1565

• Verification on page 1573

Requirements

This example uses the following hardware and software components:

• Three PTX3000 Packet Transport Routers running Junos OS Release 15.1F6

• Four IPLC basemodules

• Compatible 10-Gigabit or 100-Gigabit Ethernet OTN PICs
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For complete information on all PTX Series Packet Transport Routers hardware

components, see PTX Series Packet Transport Routers.

For complete information on all PTX Series Packet Transport Routers software features,

see Junos OS for PTX Series Packet Transport Routers, Release 15.1.

Before you start this procedure, complete the following tasks:

• Install the IPLCs, FPCs, and PICs in the PTX3000 chassis.

BEST PRACTICE: We recommend that you place the two IPLCmodules at
Node B into the same FPC/PIC slot pair on the PTX3000 chassis. In this
example the IPLCs at Node B are located in FPC slots 2 and 3.

• Make all connections to and from the PICs in the PTX3000 chassis to the Add and

Drop ports on front panel of each IPLC node as shown in Figure 52 on page 1562.

• Connect your fiber pairs to the Line IN and Line OUT ports on the front panel of each

IPLC node as shown in Figure 52 on page 1562.

For simplicity, Figure52onpage 1562doesnot showtheoptical ILAsbetween the three

IPLC nodes.

• On Node B, connect the two IPLCmodules together using the PT IN and PTOUT ports

on the front panel of the IPLC as shown in Figure 52 on page 1562.

• Besuretospecifywavelengthvaluesoneach interfaceasshown inFigure52onpage1562.

If youmust adjust the wavelength values, make sure that you enter a value supported

on the IPLC.

BEST PRACTICE: Anytime you need to disconnect or connect the fiber span
from the Line IN and LineOUT ports on the IPLCmodule, we recommend you

disable theoptical supervisorychannelandtheerbium-dopedfiberamplifiers
on the IPLC.

Always refer to thePTX3000PacketTransportRouterHardwareGuidewhen
connectingordisconnectingcablesonthe IPLCmodules.SeePTX3000Packet

Transport Router Hardware Guide.

Overview

This examples describes how to configure Junos OS to support IPLC basemodules in a

Metro linear packet optical deployment. The Add/Drop ports of the IPLCmodules are

physically connected to interfaces housed in the same PTX3000 chassis.

The IPLCmodulesprovide thecombined functionality of a32-portReconfigurableOptical

Add/Drop Multiplexer (ROADM), optical amplification, optical equalization, and optical

channel monitoring on a single card.
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Topology

Figure 52: IPLC in Metro Linear Packet Optical Deployment
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This procedure describes how to configure Junos OS for the IPLCmodules. This is not a

complete configuration and does not include full instructions for configuring the router

or the associated line cards. Before you start this procedure, complete the following

hardware and software tasks on the PTX 3000 router:

• Install the IPLCs, associated line cards, and PICs into the PTX3000 chassis so that the

hardwareconfigurationmatcheswhat is shown inFigure52onpage 1562. If youneed to

make changes to the positions of the cards in the chassis, adjust the FPC numbers

referenced in Figure 52 on page 1562 and configure them accordingly.

BEST PRACTICE: We recommend that you place the two IPLCmodules at
Node B into the same FPC or PIC slot pair on the PTX3000 chassis. In this
example the IPLCs at Node B are located in FPC slots 2 and 3.

• Configure the associated wavelengths on the interfaces of the PTX3000 by using the

following procedure:

1. Specify the interface to configure.

[edit]
user@host# edit interfaces interface-name]
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For example:

[edit]
user@host# edit interfaces et-6/0/0]

2. Specify the wavelength value supported on the interface.

[edit interfaces et-6/0/0]
user@host# set wavelength

NOTE: Be sure to specify wavelength values on each interface as shown
in Figure 52 on page 1562. If youmust adjust the wavelength values, make
sure that you enter a value supported on the IPLC.

• Makeall connections toand fromthePICs in thePTX3000chassis to theADDorDROP

ports on front panel of each IPLC node as shown in Figure 52 on page 1562.

• Connect your fiber pairs to the LINE IN and LINE OUT ports on the front panel of each

IPLC node as shown in Figure 52 on page 1562.

For simplicity, Figure52onpage 1562doesnot showtheoptical inlineamplifiers (optical

ILAs) between the three IPLC nodes.

• OnNode B, connect the two IPLCmodules together using the PT IN and PTOUT ports

on the front panel of the IPLC as shown in Figure 52 on page 1562.

This example results in the following configuration:

Table 250:Wavelength, Port, and IPLC NodesMapping

Node CNode BNode A

Wavelength

IPLC

Slot:

Port:

Mode:

Optical
Interface
Waveform is
Switched to
on PTX3000
Chassis

IPLC

Slot:

Port:

Mode:

Optical
Interface
Waveform is
Switched to
on PTX3000
Chassis

IPLC

Slot:

Port:

Mode:

Optical
Interface
Waveform is
Switched to
on PTX3000
Chassis

Slot: 8

Port: 8

Mode: switch

et-10/0/2Slot: 2

Port: 8

Mode: switch

et-8/0/4——1554.54
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Table 250:Wavelength, Port, and IPLC NodesMapping (continued)

Node CNode BNode A

Wavelength

IPLC

Slot:

Port:

Mode:

Optical
Interface
Waveform is
Switched to
on PTX3000
Chassis

IPLC

Slot:

Port:

Mode:

Optical
Interface
Waveform is
Switched to
on PTX3000
Chassis

IPLC

Slot:

Port:

Mode:

Optical
Interface
Waveform is
Switched to
on PTX3000
Chassis

Slot: 8

Port: 6

Mode: switch

et-10/0/3Slot: 2

Port: 6

Mode:
wss-express-in(bypass)

Slot: 3

Port: 6

Mode:
wss-express-in
(bypass)

—Slot: 1

Port: 6

Mode: switch

et-12/0/31556.15

——Slot: 3

Port: 5

Mode: switch

et-8/0/3Slot: 1

Port: 5

Mode: switch

et-12/0/21556.96

Slot: 8

Port: 1

Mode: switch

et-10/0/1Slot: 2

Port: 1

Mode: switch

Slot: 3

Port: 1

Mode: switch

et-6/0/2Slot: 1

Port: 1

Mode: switch

et-12/0/11560.20

Slot: 8

Port: 0

Mode: switch

et-10/0/0Slot: 2

Port: 0

Mode: switch

Slot: 3

Port: 0

Mode: switch

et-6/0/1

et-6/0/0

Slot: 1

Port: 0

Mode: switch

et-12/0/01561.01
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• 3x100G of Ethernet between Node A and Node B through amulti-span link.

• 3x100G of Ethernet between Node B and Node C through amulti-span link.

• 1x100G of Ethernet between Node A and Node C through amulti-span link including

an optical bypass at through Node B.

• In this example:

• Wavelengths 1561.01 and 1560.20 are dropped atNodeBandare also reused in both

directions (Node A and Node C).

• Other wavelengths such as wavelength 1556.96 between Node A and Node B and

wavelength 1554.54 between Node B and Node C are used in only a single direction.

• Wavelengths used in both directions can also be configured for optical buypass if it

was necessary to reduce the packet throughput between the nodes. You can configure

optical bypasses through the CLI, they do not require manual connection.

• If traffic changes, you could configure Node B with 1561.01 and 1560.20 as optical

bypass and that creates an additional 2x100G between Node A and Node C, leaving

only 100 Gbps of traffic to Node B (and leaving four interfaces unused).

Configuration

The following example requires you to navigate various levels in the configuration

hierarchy.

For information about navigating the CLI, see Using the CLI Editor in Configuration Mode.

Before you start this procedure, be sure to complete the tasks described in the

“Requirements” on page 1560 section of this example.

To configure the IPLC basemodules in this example, perform these tasks:

• Configuring the IPLC Base Module at Node A on page 1566

• Configuring the Two IPLC Base Modules at Node B on page 1568

• Configuring the IPLC Base Module at Node C on page 1571

• Results on page ?

CLI Quick
Configuration

To quickly configure this example, copy the following commands into a text file, remove

any line breaks, and then paste the commands into the CLI at the [edit] hierarchy level.

set chassis fpc 1 optical-options wavelength 1556.15 switch et-12/0/3
set chassis fpc 1 optical-options wavelength 1556.96 switch et-12/0/2
set chassis fpc 1 optical-options wavelength 1560.20 switch et-12/0/1
set chassis fpc 1 optical-options wavelength 1561.01 switch et-12/0/0
set chassis fpc 2 optical-options wavelength 1554.54 switch et-8/0/4
set chassis fpc 2 optical-options wavelength 1556.15 wss-express-in
set chassis fpc 2 optical-options wavelength 1560.20 switch et-6/0/2
set chassis fpc 2 optical-options wavelength 1561.01 switch et-6/0/1
set chassis fpc 2 optical-options express-in fpc 3
set chassis fpc 3 optical-options wavelength 1556.15 wss-express-in
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set chassis fpc 3 optical-options wavelength 1556.96 switch et-8/0/3
set chassis fpc 3 optical-options wavelength 1560.20 switch et-8/0/2
set chassis fpc 3 optical-options wavelength 1561.01 switch et-6/0/0
set chassis fpc 3 optical-options express-in fpc 2
set chassis fpc 8 optical-options wavelength 1554.54 switch et-10/0/2
set chassis fpc 8 optical-options wavelength 1556.15 switch et-10/0/3
set chassis fpc 8 optical-options wavelength 1560.20 switch et-10/0/1
set chassis fpc 8 optical-options wavelength 1561.01 switch et-10/0/0

Configuring the IPLC BaseModule at Node A

Step-by-Step
Procedure

This procedure describes how to configure the IPLC basemodule in slot 1 of Node A in

this example.

Before you start this procedure, be sure to complete the tasks described in the

“Requirements” on page 1560 section of this example.

To configure the IPLC basemodule in slot 1 of Node A:

1. Fromthe JunosSpaceuser interface, click theBuild iconon theConnectivityServices

Director banner.

Theworkspaces that are applicable to Buildmode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the PTX300 router for which you want to define the

optical IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Select an optical IPLC in the image of the device.

The Component Info dialog box is displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLCLinedialogbox isdisplayedon the rightpanewith theconfigurationsettings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.
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In this case, because the IPLC basemodule resides in FPC slot 1, select the IPLC 1

component in the image of the chassis.

8. Configure wavelength 1561.01 on port 0 of the IPLC basemodule to be switched to

optical interface et-12/0/0. In theWavelength Configuration section, select the

ShowAllWavelengths check box, and beside the 1561.01 row in thewavelength

column, select switch from the drop-downmenu in the configuration column of the

table for the corresponding wavelength.

9. From the end-point column, click in the cell corresponding to the wavelength of

1561.01, and then click the drop-down arrow. From the drop-downmenu, select

et-12/0/0 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

10. Configure wavelength 1560.20 on port 1of the IPLC basemodule to be switched to

optical interface et-12/0/1. In theWavelength Configuration section, beside the

1560.20 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

11. From the end-point column, click in the cell corresponding to the wavelength of

1560.20, and then click the drop-down arrow. From the drop-downmenu, select

et-12/0/1 towhich youwant thewavelengthof the IPLCbasemodule tobeswitched.

12. Configure wavelength 1556.96 on port 5 of the IPLC basemodule to be switched

to optical interface et-12/0/2. In theWavelength Configuration section, beside the

1556.96 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

13. From the end-point column, click in the cell corresponding to the wavelength of

1556.96, and then click the drop-down arrow. From the drop-downmenu, select

et-12/0/2 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

14. Configure wavelength 1556.15 on port 6 of the IPLC basemodule to be switched to

optical interface et-12/0/3. In theWavelength Configuration section, beside the

1556.15 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

15. From the end-point column, click in the cell corresponding to the wavelength of

1556.15, and then click the drop-down arrow. From the drop-downmenu, select

et-12/0/3 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

16. Click Update to save the specified configuration settings.
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Configuring the Two IPLC BaseModules at Node B

Step-by-Step
Procedure

This procedure describes how to configure the IPLC basemodule in slot 2 of Node B in

this example.

Before you start this procedure, be sure to complete the tasks described in the

“Requirements” on page 1560 section of this example.

BEST PRACTICE: We recommend that you place the two IPLCmodules in
the same FPC or PIC slot pair on the PTX3000 chassis.

To configure the IPLC basemodule in slot 2 of Node B:

1. Fromthe JunosSpaceuser interface, click theBuild iconon theConnectivityServices

Director banner.

Theworkspaces that are applicable to Buildmode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the PTX300 router for which you want to define the

optical IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Select an optical IPLC in the image of the device.

The Component Info dialog box is displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLCLinedialogbox isdisplayedon the rightpanewith theconfigurationsettings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.

In this case, because the IPLC basemodule resides in FPC slot 2, select the IPLC 2

component in the image of the chassis.
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8. Create a logical connection between this IPLC basemodule and the IPLC base

module in slot 3. Select FPC 3 from the Express IPLC list in the Settings/Status

section.

9. Configure wavelength 1561.01 on port 0 of the IPLC basemodule to be switched to

optical interfaceet-6/0/1. In theWavelengthConfiguration section, select theShow

AllWavelengths check box, and beside the 1561.01 row in thewavelength column,

select switch from the drop-downmenu in the configuration column of the table

for the corresponding wavelength.

10. From the end-point column, click in the cell corresponding to the wavelength of

1561.01, and then click the drop-down arrow. From the drop-downmenu, select

et-6/0/1 towhich youwant thewavelengthof the IPLCbasemodule tobe switched.

11. Configure wavelength 1560.20 on port 1of the IPLC basemodule to be switched to

optical interface et-6/0/2. In theWavelength Configuration section, beside the

1560.20 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

12. From the end-point column, click in the cell corresponding to the wavelength of

1560.20, and then click the drop-down arrow. From the drop-downmenu, select

et-6/0/2 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

13. Configure wavelength 1554.54 on port 5 of the IPLC basemodule to be switched

to optical interface et-8/0/4. In theWavelength Configuration section, beside the

1556.54 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

14. From the end-point column, click in the cell corresponding to the wavelength of

1554.54, and then click the drop-down arrow. From the drop-downmenu, select

et-8/0/4 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

15. Configure wavelength 1556.15 on port 6 of the IPLC basemodule in slot 2 to be

bypassed. In theWavelength Configuration section, beside the 1556.15 row in the

wavelength column, select express from the drop-downmenu in the configuration

column of the table for the corresponding wavelength.

16. Click Update to save the specified configuration settings.
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Step-by-Step
Procedure

This procedure describes how to configure the IPLC basemodule in slot 3 of Node B in

this example.

Before you start this procedure, be sure to complete the tasks described in the

“Requirements” on page 1560 section of this example.

To configure the IPLC basemodule in slot 3 of Node B:

1. Fromthe JunosSpaceuser interface, click theBuild iconon theConnectivityServices

Director banner.

Theworkspaces that are applicable to Buildmode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the PTX300 router for which you want to define the

optical IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Select an optical IPLC in the image of the device.

The Component Info dialog box is displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLCLinedialogbox isdisplayedon the rightpanewith theconfigurationsettings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.

In this case, because the IPLC basemodule resides in FPC slot 3, select the IPLC 3

component in the image of the chassis.

8. Create a logical connection between this IPLC basemodule and the IPLC base

module in slot 2. Select FPC 2 from the Express IPLC list in the Settings/Status

section.

9. Configure wavelength 1561.01 on port 0 of the IPLC basemodule to be switched to

optical interface et-6/0/0. In theWavelength Configuration section, select the

ShowAllWavelengths check box, and beside the 1561.01 row in thewavelength
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column, select switch from the drop-downmenu in the configuration column of the

table for the corresponding wavelength.

10. From the end-point column, click in the cell corresponding to the wavelength of

1561.01, and then click the drop-down arrow. From the drop-downmenu, select

et-6/0/0 towhich youwant thewavelengthof the IPLCbasemodule tobeswitched.

11. Configure wavelength 1560.20 on port 0 of the IPLC basemodule to be switched

to optical interface et-8/0/2. In theWavelength Configuration section, beside the

1560.20 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

12. From the end-point column, click in the cell corresponding to the wavelength of

1561.01, and then click the drop-down arrow. From the drop-downmenu, select

et-8/0/2 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

13. Configure wavelength 1556.96 on port 5 of the IPLC basemodule to be switched

to optical interface et-8/0/3. In theWavelength Configuration section, beside the

1560.20 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

14. From the end-point column, click in the cell corresponding to the wavelength of

1556.96, and then click the drop-down arrow. From the drop-downmenu, select

et-8/0/3 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

15. Configure wavelength 1556.15 on port 6 of the IPLC basemodule in slot 3 to be

bypassed. In theWavelengthConfiguration section, select theShowAllWavelengths

check box, and beside the 1560.20 row in thewavelength column, select express

from the drop-downmenu in the configuration column of the table for the

corresponding wavelength.

16. Click Update to save the configured settings.

Configuring the IPLC BaseModule at Node C

Step-by-Step
Procedure

This procedure describes how to configure the IPLC basemodule in slot 8 of Node C in

this example.

Before you start this procedure, be sure to complete the tasks described in the

“Requirements” on page 1560 section of this example.
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Step-by-Step
Procedure

To configure the IPLC basemodule in slot 8 of Node C:

1. Fromthe JunosSpaceuser interface, click theBuild iconon theConnectivityServices

Director banner.

Theworkspaces that are applicable to Buildmode are displayed on the Tasks pane.

2. From the View selector, select Device View.

The functionalities that you can configure in this view are displayed.

3. From the Device View pane, click the plus sign (+) next to the My Network tree to

expand the tree and select the PTX300 router for which you want to define the

optical IPLC settings.

The network tree is expanded and the selected device is highlighted.

4. From the Tasks pane, select DeviceManagement > View Physical Inventory.

An image of the device is displayed on the right pane.

5. Select an optical IPLC in the image of the device.

The Component Info dialog box is displayed.

6. Click the Status/Config tab at the bottom of the dialog box.

The IPLCLinedialogbox isdisplayedon the rightpanewith theconfigurationsettings

that pertain to the IPLC.

7. Specify the FPC or PIC slot in which the IPLC basemodule resides by selecting the

slot in the Chassis View.

In this case, because the IPLC basemodule resides in FPC slot 8, select the IPLC 8

component in the image of the chassis.

8. Configure wavelength 1561.01 on port 0 of the IPLC basemodule to be switched to

optical interface et-10/0/0. In theWavelength Configuration section, select the

ShowAllWavelengths check box, and beside the 1561.01 row in thewavelength

column, select switch from the drop-downmenu in the configuration column of the

table for the corresponding wavelength.

From the end-point column, click in the cell corresponding to the wavelength of

1561.01, and then click the drop-down arrow. From the drop-downmenu, select

et-10/0/0 to which you want the wavelength of the IPLC basemodule to be

switched.

9. Configure wavelength 1560.20 on port 1 of the IPLC basemodule to be switched to

optical interface et-10/0/1. In theWavelength Configuration section, beside the
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1560.20 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

From the end-point column, click in the cell corresponding to the wavelength of

1560.20, and then click the drop-down arrow. From the drop-downmenu, select

et-10/0/1 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

10. Configure wavelength 1554.54 on port 8 of the IPLC basemodule to be switched

to optical interface et-10/0/2. In theWavelength Configuration section, beside the

1554.54 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

From the end-point column, click in the cell corresponding to the wavelength of

1554.54, and then click the drop-down arrow. From the drop-downmenu, select

et-10/0/2 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

11. Configure wavelength 1556.15 on port 6 of the IPLC basemodule to be switched to

optical interface et-10/0/3. In theWavelength Configuration section, beside the

1556.15 row in thewavelength column, select switch from the drop-downmenu in

the configuration column of the table for the corresponding wavelength.

From the end-point column, click in the cell corresponding to the wavelength of

1556.15, and then click the drop-down arrow. From the drop-downmenu, select

et-10/0/3 towhichyouwant thewavelengthof the IPLCbasemodule tobeswitched.

12. Click Update to save the configured settings.

Verification

Confirm that the configuration is working properly.

• Verifying the Topology of Each IPLC Node on page 1573

Verifying the Topology of Each IPLC Node

Purpose Verify the topology of each IPLC node.

Action Run the show chassis fpc optical-properties topology command with the detail output

level at each IPLC node and verify that the following fields match the values listed in

Table 250 on page 1563.

• Port/Wavelength—Verify that this field lists the proper wavelength values and IPLC

port numbers for each node in this example.

• State—Verify that the values for this fieldmatchwhat is listed inTable 250onpage 1563

for the mode value of each IPLC port for each node in this example.

• ConnectedTo—If thewavelength is being switched, verify that this field lists the correct

interface the wavelength is being switched to.
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Verify the topology of each IPLC node.

1. For example, at IPLC Node A, enter the following.

user@host>show chassis fpc optical-properties topology detail fpc-slot 1

IPLC Topology Information
Wavelength(nm) / Port / Frequency(THz)        State               Connected 
To
Express-in Port                               DOWN                 NA
Expansion Port                                DOWN                 NA
1561.01         0        192.05               Switched             et-12/0/0
1560.20         1        192.15               Switched             et-12/0/1
1559.39         2        192.25               Blocked              NA
1558.58         3        192.35               Blocked              NA
1557.77         4        192.45               Blocked              NA
1556.96         5        192.55               Switched             et-12/0/2
1556.15         6        192.65               Switched             et-12/0/3
1555.34         7        192.75               Blocked              NA
1554.54         8        192.85               Blocked              NA
1553.73         9        192.95               Blocked              NA
1552.93         10       193.05               Blocked              NA
1552.12         11       193.15               Blocked              NA
1551.32         12       193.25               Blocked              NA
1550.52         13       193.35               Blocked              NA
1549.72         14       193.45               Blocked              NA
1548.91         15       193.55               Blocked              NA
1548.11         16       193.65               Blocked              NA
1547.32         17       193.75               Blocked              NA
1546.52         18       193.85               Blocked              NA
1545.72         19       193.95               Blocked              NA
1544.92         20       194.05               Blocked              NA
1544.13         21       194.15               Blocked              NA
1543.33         22       194.25               Blocked              NA
1542.54         23       194.35               Blocked              NA
1541.75         24       194.45               Blocked              NA
1540.95         25       194.55               Blocked              NA
1540.16         26       194.65               Blocked              NA
1539.37         27       194.75               Blocked              NA
1538.58         28       194.85               Blocked              NA
1537.79         29       194.95               Blocked              NA
1537.00         30       195.05               Blocked              NA
1536.22         31       195.15               Blocked              NA

2. At Node B, enter the following:

user@host> show chassis fpc optical-properties topology detail fpc-slot 2
user@host> show chassis fpc optical-properties topology detail fpc-slot 3

3. At Node C:

user@host> show chassis fpc optical-properties topology detail fpc-slot 8
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Meaning For example, in Step 1for Node A, you can see that the IPLCmodule in slot 1 includes the

following configuration:

• Wavelength 1561.01 is switched to optical interface et-12/0/0

• Wavelength 1560.20 is switched to optical interface et-12/0/1

• Wavelength 1556.96 is switched to optical interface et-12/0/2

• Wavelength 1556.16 is switched to optical interface et-12/0/3

This matches what is listed in Table 250 on page 1563 for Node A and confirms the

configuration is operating correctly.

Related
Documentation

• Viewing a Graphical Image of the Optical Integrated Photonic Line Card on page 1509

• Configuring Optical IPLC for Easy and Optimal Deployment on page 1513

• ViewingPerformanceMonitoringDetails ofOptical IPLCs forDetecting andDiagnosing

Faults on page 1520

• Configuring Threshold-Crossing Alarms for Optical IPLCs for Monitoring Link

Performance on page 1526
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PART 18

Working with User Roles

• Managing User Roles on page 1579
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CHAPTER 57

Managing User Roles

• Creating a User-Defined Role on page 1579

• Managing Roles on page 1581

Creating a User-Defined Role

You can create custom roles to grant users different access rights to the Connectivity

ServicesDirectormodes. Connectivity ServicesDirectormodes—Report, Deploy,Monitor,

Fault, and Build are available to assign to custom user roles in the list of application

workspaces and associated tasks

Junos Space Network Management Platform provides read-only predefined roles—that

is, Super Administrator, System Administrator, or User Administrator—that you can use

to create users to perform tasks that these roles permit. You can also create read-write

user-defined roles that conform to user responsibilities and access privileges required

on your network. You canmodify and delete only user-defined roles that you create. You

cannot modify or delete predefined roles.

The followingpredefined roles are applicable for Connectivity ServicesDirector to handle

different operations for devices and services with varying privileges and permissions:

• The Device Manager role allows an administrator to discover devices.

• TheServiceManager roleallowsanadministrator toperformdevicepre-stagingactions

including discovering and assigning device roles.

• The Service Designer roles allows an administrator to create and publish a service

definition.

• The Service Activator (less privileged) role allows an administrator to perform

provisioning tasks including creating andmanaging customers, service orders, and

services.

NOTE: For the ServiceManager, Service Designer, and Service Activator user
roles that are present in Services Activation Director, the roles aremigrated
with additional access privileges to enable access to the different lifecyle
modes of Connectivity Services Director after upgrading to Connectivity
Services Director, Release 1.0.
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To create a user-defined role:

1. On the Junos Space NetworkManagement Platform user interface, select Role Based

Access Control > Roles.

The Roles page appears.

2. Click the Create Role icon on themenu bar.

The Create Role page appears, allowing you to select workspaces and associated

tasks from all deployed applications.

3. In the Title text box, type a user-defined role name.

The role title cannot exceed 32 characters. The title can contain only letters and

numbers and can include a hyphen (-), underscore (_), or period (.). Also, the title

cannot start with a space.

4. In the Description text box, type a user-defined role description.

The role description cannot exceed 256 characters. The description can contain only

letters andnumbersandcan includeahyphen (-), underscore (_), period (.), or comma

(,).

5. Select an application workspace from the application selection ribbon.

Mouse over an application workspace icon to view the application and workspace

name. You can select one or more workspaces per user-defined role. An expandable

and collapsible tree of associated tasks appear below the selection ribbon for you to

modify specific tasks that you want included in the Task Summary pane.

6. Select the specific tasks that you want for the user-defined role. All application

workspace tasks are selected by default in the task tree.

Only thecurrentlyeditedapplicationworkspacenode isexpanded in theTaskSummary

pane; previously selected workspace nodes are collapsed. You can expand other

workspace nodes manually.

Selecting the topnodeorworkspaceselectsordeselects thewhole task tree. Selecting

any task node automatically selects all tasks under the task node. Selecting any task

node automatically selects its parent and grandparent.

Only the currently active task tree appears in the Task Summary pane.

In theTaskSummarypane, the top-level applicationnode in the tree is set inbold-italic;

the second-level workspace tree node is set in bold.

7. Click Create.

The user-defined role is created, saved, and appears on the Roles inventory page.

Scroll down or search to view it.
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You cannot create or save a user-defined role when the workspace tasks are not

selected. Junos Space throws the following error message:

Task tree selection can not be empty.

Creation of a role generates an audit log entry.

Related
Documentation

Predefined Roles Overview•

• Managing Roles on page 1581

• Modifying User-Defined Roles

• Deleting User-Defined Roles

• Creating Users in Junos Space Network Management Platform

Managing Roles

A role is a description of tasks a user can perform in Junos Space Network Management

Platform to allow access to application workspaces. The Role Based Access Control >

Roles inventory page allows Super Administrator or User Administrator to view all

predefined and user-defined roles that exist for Junos Space applications. The

administrator should understand all predefined roles and create any user-defined roles

before creating users.

• Viewing User Role Details on page 1581

• Performing Manage Roles Commands on page 1582

Viewing User Role Details

TheRoles inventory page displays all predefined and user-defined roles in a tabular view.

Each role is represented by a row in the table. Roles are listed in the table in ascending

alphabetical order by role title, type (that is, whether the role is a predefined role or a

custom role), description, and tasks assigned. You can show or hide table columns and

sort records in ascending or descending order.

You can search for roles by typing the first letters of the role title in the search box. Role

title starting with the first letters you type are listed.

To view a user role detail summary:

1. On the Junos Space NetworkManagement Platform user interface, select Role Based

Access Control > Roles.

The Roles page appears.

2. Double-click a role.

The Role Detail Summary page appears.

The page displays the workspace and workspace tasks.
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3. Click the expander button + adjacent to the workspaces to view subtasks.

4. ClickOK on the Role Detail Summary page to exit this page.

You are returned to the Roles page.

PerformingManage Roles Commands

You can perform a task on predefined and user-defined roles by selecting the task from

the Actions menu or the shortcut menu that is displayed when you right-click a role, or

by clicking the icons at the top of the Roles page. You can perform theModify Role and

DeleteRolescommandsonlyon read-writeableuser-defined roles.Youcannotmanipulate

read-only predefined roles. To perform a command, youmust first select the role.

You can perform one or more of the following actions on the roles from the Roles page:

• View Role Details—View details about the selected role.

• Modify Role—Modify the selected user-defined description, application workspaces,

and tasks associated with the workspaces. You cannot modify predefined roles. For

more information, seeModifying User-Defined Roles.

• Delete Roles—Delete the selected user-defined role. You cannot delete predefined

roles. For more information, see Deleting User-Defined Roles.

• CloneRoles—Clone the selecteduser-definedor predefined role. Formore information,

see Cloning Predefined and User-Defined Roles.

• Tag It—Tag one or more selected inventory objects, see, see Tagging an Object.

• View Tags—View a list of tags that exist on a selected inventory object. For more

information, see Viewing Tags for a Managed Object.

• Untag It—Untag a tag that is applied to an inventory object. For more information, see

Untagging Objects.

• Delete Private Tags—Delete tags that you created.

• Clear All Selections—Clear any role selections youmade on the Roles inventory page.

• Display Quick View—Displays or hides a small window summarizing data about the

selected object.

Related
Documentation

• Role-Based Access Control Overview

• Predefined Roles Overview

• Creating Users in Junos Space Network Management Platform

• Creating a User-Defined Role

• Modifying User-Defined Roles

• Deleting User-Defined Roles
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PART 19

Working with Tunnel Services

• Tunnel Services Overview on page 1585

• ServiceDesignandProvisioning:ManagingandDeployingTunnelServicesonpage 1615

• Monitoring and Troubleshooting Tunnel Services on page 1683
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CHAPTER 58

Tunnel Services Overview

• Tunnel Services Overview on page 1585

• Traffic Engineering Capabilities on page 1586

• Components of Traffic Engineering on page 1587

• Routers in an LSP on page 1590

• MPLS and RSVP Overview on page 1595

• Fast Reroute Overview on page 1598

• Point-to-Multipoint LSPs Overview on page 1600

• RSVP Operation Overview on page 1602

• Link Protection and Node Protection on page 1607

• Connectivity ServicesDirector–NorthStarController IntegrationOverviewonpage 1613

Tunnel Services Overview

Transport or tunnel services allow you to design, provision, and deploy label-switched

path (LSP) services that run from a specific ingress router to a specific egress router. You

can configure end-to-end point-to-point and point-to-multiple-point LSPs.

A tunnel service automates and provides a user interface for LSP service deployment,

including LSP-configured Juniper Networks device discovery from the Junos Space

Platform database, LSP definition configuration design, and LSP service validation and

deployment.

A tunnel service is integratedwith and codependent upon network services, that provide

Layer 2 and Layer 3 VPN service provisioning.

Provisioning an LSP service includes the following major tasks:

• Discover Juniper Networks devices that have been configured for MPLS-Signaled LSP

into Junos Space using the Devices workspace. See the MPLS-Signaled LSP

Configuration Guidelines in the Junos OSMPLS Applications Configuration Guide.

• Discover tunneling or transport devices from the Connectivity Services Director GUI in

Service View of Build mode. In the Network Services > Connectivity task pane, select

PrestageDevices>PrestageDevices. View the valuesdisplayedunder theRoles column

of the discovered devices.
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ClickManageDeviceRolesand fromthedrop-down list, selectDiscoverRoles to retrieve

the roles of the devices. A dialog box is displayed with the job ID of the discovery job

that is created to obtain the latest roles of the devices.

• Assign LSP roles to provide authorization for the LSP definition designer and service

activator to provision LSP services. Select Platform > Users.

• Create an LSP definition to use to create an LSP service. Select TA Design>Manage

TA Definitions.

• Create and validate LSP services. Select Service Provisioning>Manage LSPs. You can

use LSP settings in the predefined LSP definition so that they are configurable in the

LSP service order.

Related
Documentation

Traffic Engineering Capabilities on page 1586•

• Components of Traffic Engineering on page 1587

• Routers in an LSP on page 1590

• MPLS and RSVP Overview on page 1595

• Fast Reroute Overview on page 1598

• Point-to-Multipoint LSPs Overview on page 1600

• RSVP Operation Overview on page 1602

• Link Protection and Node Protection on page 1607

• Connectivity ServicesDirector–NorthStarController IntegrationOverviewonpage 1613

Traffic Engineering Capabilities

The task of mapping traffic flows onto an existing physical topology is called traffic

engineering. Traffic engineering provides the ability to move traffic flow away from the

shortest path selected by the interior gateway protocol (IGP) and onto a potentially less

congested physical path across a network.

Traffic engineering provides the capabilities to do the following:

• Route primary paths around knownbottlenecks or points of congestion in the network.

• Provide precise control over how traffic is reroutedwhen the primary path is facedwith

single or multiple failures.

• Provide more efficient use of available aggregate bandwidth and long-haul fiber by

ensuring that subsets of the network do not become overutilized while other subsets

of the network along potential alternate paths are underutilized.

• Maximize operational efficiency.
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• Enhance the traffic-orientedperformancecharacteristics of thenetworkbyminimizing

packet loss, minimizing prolonged periods of congestion, andmaximizing throughput.

• Enhance statistically bound performance characteristics of the network (such as loss

ratio, delay variation, and transfer delay) required to support a multiservices Internet.

Related
Documentation

Tunnel Services Overview on page 1585•

• Components of Traffic Engineering on page 1587

• Routers in an LSP on page 1590

• MPLS and RSVP Overview on page 1595

• Fast Reroute Overview on page 1598

• Point-to-Multipoint LSPs Overview on page 1600

• RSVP Operation Overview on page 1602

• Link Protection and Node Protection on page 1607

• Connectivity ServicesDirector–NorthStarController IntegrationOverviewonpage 1613

Components of Traffic Engineering

In the Junos
®
operating system (OS), traffic engineering is implemented with MPLS and

RSVP. Traffic engineering is composed of four functional components:

• Packet Forwarding Component on page 1587

• Information Distribution Component on page 1588

• Path Selection Component on page 1589

• Signaling Component on page 1589

Packet Forwarding Component

The packet forwarding component of the Junos traffic engineering architecture is MPLS,

which is responsible for directing a flow of IP packets along a predetermined path across

a network. This path is called a label-switched path (LSP). LSPs are simplex; that is, the

traffic flows in one direction from the head-end (ingress) router to a tail-end (egress)

router. Duplex traffic requires two LSPs: one LSP to carry traffic in each direction. An LSP

is created by the concatenation of one or more label-switched hops, allowing a packet

to be forwarded from one router to another across the MPLS domain.

When an ingress router receives an IP packet, it adds an MPLS header to the packet and

forwards it to the next router in the LSP. The labeled packet is forwarded along the LSP

by each router until it reaches the tail end of the LSP, the egress router. At this point the

MPLSheader is removed, and the packet is forwardedbased on Layer 3 information such

as the IP destination address. The value of this scheme is that the physical path of the

LSP is not limited to what the IGP would choose as the shortest path to reach the

destination IP address.
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Packet Forwarding Based on Label Swapping

The packet forwarding process at each router is based on the concept of label swapping.

This concept is similar towhatoccursat eachAsynchronousTransferMode (ATM)switch

in a permanent virtual circuit (PVC). Each MPLS packet carries a 4-byte encapsulation

header that contains a 20-bit, fixed-length label field. When a packet containing a label

arrives at a router, the router examines the label and copies it as an index to its MPLS

forwarding table. Each entry in the forwarding table contains an interface-inbound label

pair mapped to a set of forwarding information that is applied to all packets arriving on

the specific interface with the same inbound label.

How a Packet Traverses anMPLS Backbone

This section describes how an IP packet is processed as it traverses an MPLS backbone

network.

At the entry edge of theMPLS backbone, the IP header is examined by the ingress router.

Basedon this analysis, thepacket is classified, assigneda label, encapsulated inanMPLS

header, and forwarded toward the next hop in the LSP. MPLS provides a high degree of

flexibility in the way that an IP packet can be assigned to an LSP. For example, in the

Junos traffic engineering implementation, all packets arriving at the ingress router that

are destined to exit theMPLS domain at the same egress router are forwarded along the

same LSP.

Once the packet begins to traverse the LSP, each router uses the label to make the

forwardingdecision. TheMPLS forwardingdecision ismade independently of theoriginal

IP header: the incoming interface and label are used as lookup keys into the MPLS

forwarding table. The old label is replaced with a new label, and the packet is forwarded

to the next hop along the LSP. This process is repeated at each router in the LSP until

the packet reaches the egress router.

When the packet arrives at the egress router, the label is removed and the packet exits

the MPLS domain. The packet is then forwarded based on the destination IP address

contained in the packet’s original IP header according to the traditional shortest path

calculated by the IP routing protocol.

Information Distribution Component

Traffic engineering requires detailed knowledge about the network topology as well as

dynamic information about network loading. To implement the information distribution

component, simple extensions to the IGPs are defined. Link attributes are included as

part of each router’s link-state advertisement. IS-IS extensions include the definition of

new type length values (TLVs), whereasOSPF extensions are implementedwith opaque

link-stateadvertisements (LSAs). Thestandard floodingalgorithmusedby the link-state

IGPs ensures that link attributes are distributed to all routers in the routing domain. Some

of the traffic engineering extensions to be added to the IGP link-state advertisement

includemaximumlinkbandwidth,maximumreserved linkbandwidth, currentbandwidth

reservation, and link coloring.

Each router maintains network link attributes and topology information in a specialized

traffic engineering database. The traffic engineering database is used exclusively for
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calculating explicit paths for the placement of LSPs across the physical topology. A

separatedatabase ismaintained so that the subsequent traffic engineering computation

is independentof the IGPand the IGP’s link-statedatabase.Meanwhile, the IGPcontinues

its operation without modification, performing the traditional shortest-path calculation

based on information contained in the router’s link-state database.

Path Selection Component

After network link attributes and topology information are flooded by the IGP and placed

in the traffic engineering database, each ingress router uses the traffic engineering

database to calculate the paths for its own set of LSPs across the routing domain. The

path for each LSP can be represented by either a strict or loose explicit route. An explicit

route is a preconfigured sequence of routers that should be part of the physical path of

the LSP. If the ingress router specifies all the routers in the LSP, the LSP is said to be

identified by a strict explicit route. If the ingress router specifies only some of the routers

in the LSP, the LSP is described as a loose explicit route. Support for strict and loose

explicit routes allows the path selection process to be given broad latitude whenever

possible, but to be constrained when necessary.

The ingress router determines the physical path for each LSP by applying a Constrained

ShortestPathFirst (CSPF)algorithmto the information in the traffic engineeringdatabase.

CSPF is a shortest-path-first algorithm that has beenmodified to take into account

specific restrictions when the shortest path across the network is calculated. Input into

the CSPF algorithm includes:

• Topology link-state information learned from the IGP andmaintained in the traffic

engineering database

• Attributesassociatedwith the stateof network resources (suchas total linkbandwidth,

reserved link bandwidth, available link bandwidth, and link color) that are carried by

IGP extensions and stored in the traffic engineering database

• Administrative attributes required to support traffic traversing the proposed LSP (such

as bandwidth requirements, maximum hop count, and administrative policy

requirements) that are obtained from user configuration

AsCSPFconsiders eachcandidatenodeand link for anewLSP, it either acceptsor rejects

a specific path component based on resource availability or whether selecting the

component violates user policy constraints. The output of the CSPF calculation is an

explicit route consisting of a sequence of router addresses that provides the shortest

path through the network that meets the constraints. This explicit route is then passed

to the signaling component, which establishes the forwarding state in the routers along

the LSP.

Signaling Component

An LSP is not known to be workable until it is actually established by the signaling

component. The signaling component, which is responsible for establishing LSP state

and distributing labels, relies on a number of extensions to RSVP:
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• TheExplicitRouteobjectallowsanRSVPpathmessage to traverseanexplicit sequence

of routers that is independent of conventional shortest-path IP routing. The explicit

route can be either strict or loose.

• TheLabelRequestobjectpermits theRSVPpathmessage to request that intermediate

routers provide a label binding for the LSP that it is establishing.

• The Label object allows RSVP to support the distribution of labels without changing

its existing mechanisms. Because the RSVP Resv message follows the reverse path

of the RSVP path message, the Label object supports the distribution of labels from

downstream nodes to upstream nodes.

Related
Documentation

Tunnel Services Overview on page 1585•

• Traffic Engineering Capabilities on page 1586

• Routers in an LSP on page 1590

• MPLS and RSVP Overview on page 1595

• Fast Reroute Overview on page 1598

• Point-to-Multipoint LSPs Overview on page 1600

• RSVP Operation Overview on page 1602

• Link Protection and Node Protection on page 1607

• Connectivity ServicesDirector–NorthStarController IntegrationOverviewonpage 1613

Routers in an LSP

Each router in an LSP performs one of the following functions:

• Ingress router—The router at the beginning of an LSP. This router encapsulates IP

packets with an MPLS Layer 2 frame and forwards it to the next router in the path.

Each LSP can have only one ingress router.

• Egress router—The router at the end of an LSP. This router removes the MPLS

encapsulation, thus transforming it fromanMPLSpacket toan IPpacket, and forwards

the packet to its final destination using information in the IP forwarding table. Each

LSP can have only one egress router. The ingress and egress routers in an LSP cannot

be the same router.

• Transit router—Any intermediate router in the LSP between the ingress and egress

routers. A transit router forwards receivedMPLSpackets to the next router in theMPLS

path. An LSP can contain zero or more transit routers, up to amaximum of 253 transit

routers in a single LSP.

A single router can be part of multiple LSPs. It can be the ingress or egress router for one

or more LSPs, and it also can be a transit router in one or more LSPs. The functions that

each router supports depend on your network design.
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How a Packet Travels Along an LSP

When an IP packet enters an LSP, the ingress router examines the packet and assigns it

a label based on its destination, placing the label in the packet’s header. The label

transforms the packet from one that is forwarded based on its IP routing information to

one that is forwarded based on information associated with the label.

The packet is then forwarded to the next router in the LSP. This router and all subsequent

routers in the LSP do not examine any of the IP routing information in the labeled packet.

Rather, they use the label to look up information in their label forwarding table. They

then replace the old label with a new label and forward the packet to the next router in

the path.

When the packet reaches the egress router, the label is removed, and the packet again

becomes a native IP packet and is again forwarded based on its IP routing information.

Types of LSPs

There are three types of LSPs:

• Static LSPs—For static paths, youmust manually assign labels on all routers involved

(ingress, transit, and egress). No signaling protocol is needed. This procedure is similar

to configuring static routes on individual routers. Like static routes, there is no error

reporting, liveliness detection, or statistics reporting.

• LDP-signaledLSPs—TheLabelDistributionProtocol (LDP) isaprotocol fordistributing

labels in non-traffic-engineered applications. LDP allows routers to establish

label-switched paths (LSPs) through a network by mapping network-layer routing

information directly to data link layer-switched paths.

These LSPsmight have an endpoint at a directly attached neighbor (comparable to

IP hop-by-hop forwarding), or at a network egress node, enabling switching through

all intermediary nodes. LSPs established by LDP can also traverse traffic-engineered

LSPs created by RSVP.

LDP associates a forwarding equivalence class (FEC) with each LSP it creates. The

FEC associated with an LSP specifies which packets are mapped to that LSP. LSPs

are extended through a network as each router chooses the label advertised by the

next hop for the FEC and splices it to the label it advertises to all other routers. This

process forms a tree of LSPs that converge on the egress router.

• RSVP-signaled LSPs—For signaled paths, RSVP is used to set up the path and

dynamically assign labels. (RSVP signaling messages are used to set up signaled

paths.) You configure only the ingress router. The transit and egress routers accept

signaling information from the ingress router, and they set up andmaintain the LSP

cooperatively. Any errors encountered while establishing an LSP are reported to the

ingress router fordiagnostics. For signaledLSPs towork, a versionofRSVPthat supports

tunnel extensions must be enabled on all routers.

There are two types of RSVP-signaled LSPs:
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• Explicit-path LSPs—All intermediate hops of the LSP are manually configured. The

intermediate hops can be strict, loose, or any combination of the two. Explicit path

LSPs provide you with complete control over how the path is set up. They are similar

to static LSPs but require much less configuration.

• Constrained-pathLSPs—The intermediatehopsof theLSPareautomatically computed

by the software. The computation takes into account information provided by the

topology information from the IS-IS or OSPF link-state routing protocol, the current

network resource utilization determined by RSVP, and the resource requirements and

constraints of the LSP. For signaled constrained-path LSPs to work, either the IS-IS or

OSPF protocol and the IS-IS or OSPF traffic engineering extensions must be enabled

on all routers.

Scope of LSPs

For constrained-path LSPs, the LSP computation is confined to one IGP domain, and

cannot cross any AS boundary. This prevents an AS from extending its IGP into another

AS.

Explicit-path LSPs, however, can cross as many AS boundaries as necessary. Because

intermediate hops aremanually specified, the LSP does not depend on the IGP topology

or a local forwarding table.

Constrained-Path LSP Computation

The Constrained Shortest Path First (CSPF) algorithm is an advanced form of the

shortest-path-first (SPF) algorithm used in OSPF and IS-IS route computations. CSPF

is used in computing paths for LSPs that are subject to multiple constraints. When

computing paths for LSPs, CSPF considers not only the topology of the network, but also

the attributes of the LSP and the links, and it attempts to minimize congestion by

intelligently balancing the network load.

The constraints that CSPF considers include:

• LSP attributes

• Administrative groups (that is, link color requirements)

• Bandwidth requirements

• Explicit route (strict or loose)

• Hop limitations

• Priority (setup and hold)

• Link attributes

• Administrative groups (that is, link colors assigned to the link)

• Reservable bandwidth of the links (static bandwidth minus the currently reserved

bandwidth)
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The data that CSPF considers comes from the following sources:

• Traffic engineering database—Provides CSPF with up-to-date topology information,

the current reservable bandwidth of links, and the link colors. For the CSPF algorithm

to perform its computations, a link-state IGP (such as OSPF or IS-IS) with special

extensions is needed. For CSPF to be effective, the link-state IGP on all routers must

support the special extensions. While building the topology database, the extended

IGPmust take into consideration thecurrent LSPsandmust flood the route information

everywhere. Because changes in the reserved link bandwidth and link color cause

database updates, an extended IGP tends to floodmore frequently than a normal IGP.

SeeFigure53onpage1593foradiagramoftherelationshipsbetweenthesecomponents.

• Currently active LSPs—Includes all the LSPs that should originate from the router and

their current operational status (up, down, or timeout).

Figure 53: CSPF Computation Process

HowCSPF Selects a Path

To select a path, CSPF follows certain rules. The rules are as follows:

1. Computes LSPs one at a time, beginning with the highest priority LSP (the one with

the lowest setuppriority value). Among LSPsof equal priority, CSPF services the LSPs

in alphabetical order of the LSP names.

2. Prunes the traffic engineering database of all the links that are not full duplex and do

not have sufficient reservable bandwidth.

3. If the LSP configuration includes the include statement, prunes all links that do not

share any included colors.

4. If the LSP configuration includes the exclude statement, prunes all links that contain

excluded colors. If the link does not have a color, it is accepted.

5. If several paths have equal cost, chooses the onewhose last-hop address is the same

as the LSP’s destination.
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6. If several equal cost paths remain, selects the one with the fewest number of hops.

7. If several equal-cost paths remain, applies the CSPF load-balancing rule configured

on the LSP (least fill, most fill, or random).

CSPF finds the shortest path toward the LSP’s egress router, taking into account

explicit-path constraints. For example, if the path must pass through Router A, two

separate SPFs are computed, one from the ingress router to Router A, the other from

Router A to the egress router. All CSPF rules are applied to both computations.

CSPF Path Selection Tie-Breaking

If more than one path is still available after the CSPF rules have been applied, a

tie-breaking rule is applied to choose the path for the LSP. The rule used depends on the

configuration. There are three tie-breaking rules:

• Random—One of the remaining paths is picked at random. This rule tends to place an

equal number of LSPs on each link, regardless of the available bandwidth ratio. This

is the default behavior.

• Least fill—The path with the largest minimum available bandwidth ratio is preferred.

This rule tries to equalize the reservation on each link.

• Most fill—The path with the smallest minimum available bandwidth ratio is preferred.

This rule tries to fill a link before moving on to alternative links.

The following definitions describe how a figure for minimum available bandwidth ratio

is derived for the least fill andmost fill rules:

• Reservable bandwidth = bandwidth of link x subscription factor of link

• Available bandwidth = reservable bandwidth – (sum of the bandwidths of the LSPs

traversing the link)

• Available bandwidth ratio = available bandwidth/reservable bandwidth

• Minimum available bandwidth ratio (for a path) = the smallest available bandwidth

ratio of the links in a path

NOTE: For the least fill ormost fill behaviors to be used, the pathsmust have
their bandwidth (specified using the bandwidth statement at the [edit

protocolsmpls label-switched-path lsp-name] hierarchy level) or minimum

bandwidth (specified using theminimum-bandwidth statement at the [edit

protocolsmpls label-switched-path lsp-nameauto-bandwidth]hierarchy level)

configured toavaluegreater than0. If thebandwidthorminimumbandwidth
for thepaths iseithernotconfiguredorconfiguredas0, theminimumavailable
bandwidth cannot be calculated and the random path selection behavior is
used instead.
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Computing CSPF Paths Offline

The Junos OS provides online, real-time CSPF computation only; each router performs

CSPF calculations independent of the other routers in the network. These calculations

arebasedoncurrently available topology information—information that is usually recent,

but not completely accurate. LSP placements are locally optimized, based on current

network status.

To optimize links globally across the network, you can use an offline tool to perform the

CSPF calculations and determine the paths for the LSPs. You can create such a tool

yourself, or you canmodify an existing network design tool to perform these calculations.

You should run the tool periodically (daily or weekly) and download the results into the

router. An offline tool should take the following into account when performing the

optimized calculations:

• All the LSP’s requirements

• All link attributes

• Complete network topology
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MPLS and RSVPOverview

MPLSprovides amechanism for engineering network traffic patterns that is independent

of routing tables. MPLS assigns short labels to network packets that describe how to

forward them through the network. MPLS is independent of any routing protocol and

can be used for unicast packets.

In the traditional Level 3 forwarding paradigm, as a packet travels from one router to the

next, an independent forwarding decision is made at each hop. The IP network layer

header is analyzed, and the next hop is chosen based on this analysis and on the

information in the routing table. In an MPLS environment, the analysis of the packet

header is performed just once, when a packet enters theMPLS cloud. The packet is then

assigned to a stream,which is identified by a label, which is a short (20-bit), fixed-length

valueat the frontof thepacket. Labelsareusedas lookup indexes for the label forwarding

1595Copyright © 2019, Juniper Networks, Inc.

Chapter 58: Tunnel Services Overview



table. For each label, this table stores forwarding information.Youcanassociateadditional

information with a label—such as class-of-service (CoS) values—that can be used to

prioritize packet forwarding.

Packets traveling along an LSP are identified by a label—a 20-bit, unsigned integer in the

range 0 through 1,048,575. For push labels on ingress routers, no labels in this range are

restricted. For incoming labels on the transit static LSP, the label value is restricted to

1,000,000 through 1,048,575.

On MX Series, PTX Series, and T Series routers, the value for entropy and flow labels is

restricted to 16 through 1,048,575.

In the Junos OS, label values are allocated per router. The display output shows only the

label (for example, 01024). Labels for multicast packets are independent of those for

unicast packets. Currently, the Junos OS does not support multicast labels.

Labels are assigned by downstream routers relative to the flow of packets. A router

receiving labeled packets (the next-hop router) is responsible for assigning incoming

labels. A receivedpacket containinga label that is unrecognized (unassigned) isdropped.

For unrecognized labels, the router does not attempt to unwrap the label to analyze the

network layer header, nor does it generate an Internet Control Message Protocol (ICMP)

destination unreachable message.

A packet can carry a number of labels, organized as a last-in, first-out stack. This is

referred to as a label stack. At a particular router, the decision about how to forward a

labeled packet is based exclusively on the label at the top of the stack.

Figure 54 on page 1596 shows the encoding of a single label. The encoding appears after

data link layer headers, but before any network layer header.

Figure 54: Label Encoding

Figure 55 on page 1597 illustrates the purpose of the class-of-service bits (also knownas

the EXP or experimental bits). Bits 20 and 21 specify the queue number. Bit 22 is the

packet loss priority (PLP) bit used to specify the random early detection (RED) drop

profile.
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Figure 55: Class-of-Service Bits

RSVPOverview

RSVP is a resource reservation setup protocol that is used by both network hosts and

routers. Hosts use RSVP to request a specific class of service (CoS) from the network

for particular application flows. Routers use RSVP to deliver CoS requests to all routers

along the data path. RSVP also canmaintain and refresh states for a requested CoS

application flow.

RSVP treats an application flow as a simplex connection. That is, the CoS request travels

only in one direction—from the sender to the receiver. RSVP is a transport layer protocol

that uses IP as its network layer. However, RSVP does not transport application flows.

Rather, it is more of an Internet control protocol, similar to the Internet Control Message

Protocol (ICMP) and Internet Group Management Protocol (IGMP). RSVP runs as a

separate software process in the Junos OS and is not in the packet forwarding path.

RSVP is not a routing protocol, but rather is designed to operate with current and future

unicastandmulticast routingprotocols. The routingprotocolsare responsible for choosing

the routes to use to forward packets, and RSVP consults local routing tables to obtain

routes. RSVP only ensures the CoS of packets traveling along a data path.

The receiver in an application flow requests the preferred CoS from the sender. To do

this, the receiver issues an RSVP CoS request on behalf of the local application. The

request propagates to all routers in reverse direction of the data paths toward the sender.

In this process, RSVP requests might bemerged, resulting in a protocol that scales well

when there are a large number of receivers.

Because the number of receivers in an application flow is likely to change and the flow

of delivery paths might change during the life of an application flow, RSVP takes a

soft-state approach in its design, creating and removing the protocol states in routers

and hosts incrementally over time. RSVP sends periodic refresh messages to maintain

its state and to recover from occasional lost messages. In the absence of refresh

messages, RSVP states automatically time out and are deleted.
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Fast Reroute Overview

Fast reroute provides redundancy for an LSPpath.When you enable fast reroute, detours

are precomputed and preestablished along the LSP. In case of a network failure on the

current LSP path, traffic is quickly routed to one of the detours. Figure 56 on page 1598

illustrates an LSP from Router A to Router F, showing the established detours. Each

detour is established by an upstream node to avoid the link toward the immediate

downstreamnodeandthe immediatedownstreamnode itself. Eachdetourmight traverse

throughoneormore label-switched routers (or switches) thatarenot shown in the figure.

Fast reroute protects traffic against any single point of failure between the ingress and

egress routers (or switches). If there aremultiple failures along an LSP, fast reroute itself

might fail. Also, fast reroute does not protect against failure of the ingress or egress

routers.

Figure 56: Detours Established for an LSP Using Fast Reroute

If a node detects that a downstream link has failed (using a link-layer-specific liveness

detection mechanism) or that a downstream node has failed (for example, using the

RSVP neighbor hello protocol), the node quickly switches the traffic to the detour and,

at the same time, signals the ingress router about the link or node failure.

Figure 57 on page 1598 illustrates the detour taken when the link between Router B and

Router C fails.

Figure 57: Detour After the Link from Router B to Router C Fails
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If the network topology is not rich enough (there are not enough routers with sufficient

links to other routers), some of the detours might not succeed. For example, the detour

fromRouter A to Router C in Figure 56 on page 1598 cannot traverse link A-B and Router

B. If such a path is not possible, the detour does not occur.

Note that after the node switches traffic to the detour, it might switch the traffic again

to a newly calculated detour soon after. This is because the initial detour routemight not

be the best route. Tomake rerouting as fast as possible, the node switches traffic onto

the initial detour without first verifying that the detour is valid. Once the switch is made,

the node recomputes the detour. If the node determines that the initial detour is still

valid, traffic continues to flow over this detour. If the node determines that the initial

detour is no longer valid, it again switches the traffic to a newly computed detour.

NOTE: If you issue show commands after the node has switched traffic to

the initial detour, the nodemight indicate that the traffic is still flowing over
the original LSP. This situation is temporary and should correct itself quickly.

The time required for a fast-rerouting detour to take effect depends on two independent

time intervals:

• Amount of time to detect that there is a link or node failure—This interval depends

greatly on the link layer in useand thenatureof the failure. For example, failuredetection

on an SONET/SDH link typically is much faster than on a Gigabit Ethernet link, and

both are much faster than detection of a router failure.

• Amount of time required to splice the traffic onto the detour—This operation is

performed by the Packet Forwarding Engine, which requires little time to splice traffic

onto the detour. The time needed can vary depending on the number of LSPs being

switched to detours.

Fast reroute is a short-term patch to reduce packet loss. Because detour computation

might not reserve adequate bandwidth, the detours might introduce congestion on the

alternate links. The ingress router is the only router that is fully aware of LSP policy

constraints and, therefore, is the only router able to come up with adequate long-term

alternate paths.

Detours are created by use of RSVP and, like all RSVP sessions, they require extra state

and overhead in the network. For this reason, each node establishes at most one detour

for each LSP that has fast reroute enabled. Creating more than one detour for each LSP

increases the overhead, but serves no practical purpose.

To reduce network overhead further, each detour attempts to merge back into the LSP

as soon as possible after the failed node or link. If you can consider an LSP that travels

through n router nodes, it is possible to create n – 1 detours. For instance, in

Figure58onpage 1600, thedetour tries tomergeback into theLSPatRouterD insteadof

at Router E or Router F. Merging back into the LSPmakes the detour scalability problem

moremanageable. If topology limitations prevent the detour from quickly merging back

into the LSP, detours merge with other detours automatically.
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Figure 58: Detours Merging into Other Detours
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Point-to-Multipoint LSPs Overview

Apoint-to-multipointMPLSLSP is anLSPwith a single sourceandmultiple destinations.

By taking advantage of the MPLS packet replication capability of the network,

point-to-multipoint LSPs avoid unnecessary packet replication at the ingress router.

Packet replication takes place only when packets are forwarded to two ormore different

destinations requiring different network paths.

This process is illustrated in Figure 59 on page 1601. Router PE1 is configured with a

point-to-multipoint LSP to Routers PE2, PE3, and PE4.When Router PE1 sends a packet

on the point-to-multipoint LSP to Routers P1 and P2, Router P1 replicates the packet and

forwards it to Routers PE2 and PE3. Router P2 sends the packet to Router PE4.

This feature is described in detail in the Internet drafts

draft-raggarwa-mpls-p2mp-te-02.txt (expired February 2004), Establishing Point to

Multipoint MPLS TE LSPs, draft-ietf-mpls-rsvp-te-p2mp-02.txt, Extensions to Resource

Reservation Protocol-Traffic Engineering (RSVP-TE) for Point-to-Multipoint TE

Label-Switched Paths (LSPs), and RFC 6388, Label Distribution Protocol Extensions for

Point-to-Multipoint and Multipoint-to-Multipoint Label Switched Paths (only

point-to-multipoint LSPs are supported).
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Figure 59: Point-to-Multipoint LSPs

The following are some of the properties of point-to-multipoint LSPs:

• A point-to-multipoint LSP enables you to use MPLS for point-to-multipoint data

distribution. This functionality is similar to that provided by IP multicast.

• You can add and remove branch LSPs from amain point-to-multipoint LSP without

disrupting traffic. The unaffected parts of the point-to-multipoint LSP continue to

function normally.

• You can configure a node to be both a transit and an egress router for different branch

LSPs of the same point-to-multipoint LSP.

• Youcanenable linkprotectiononapoint-to-multipoint LSP. Linkprotectioncanprovide

a bypass LSP for each of the branch LSPs that make up the point-to-multipoint LSP.

If any of the primary paths fail, traffic can be quickly switched to the bypass.

• You can configure branch LSPs either statically, dynamically, or as a combination of

static and dynamic LSPs.

• You can enable graceful Routing Engine switchover (GRES) and graceful restart for

point-to-multipoint LSPs at ingress and egress routers. The point-to-multipoint LSPs

must be configured using either static routes or circuit cross-connect (CCC). GRESand

graceful restart allow the traffic to be forwarded at the Packet Forwarding Engine

based on the old state while the control plane recovers. Feature parity for GRES and

graceful restart for MPLS point-to-multipoint LSPs on the Junos Trio chipset is

supported in Junos OS Releases 11.1R2, 11.2R2, and 11.4.
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RSVPOperation Overview

A Resource Reservation Protocol (RSVP) label-switched path (LSP) tunnel enables you

to send RSVP LSPs inside other RSVP LSPs. This enables a network administrator to

provide traffic engineering fromone end of the network to the other. A useful application

for this feature is to connect customer edge (CE) routers with provider edge (PE) routers

by using anRSVPLSP, and then tunnel this edge LSP inside a secondRSVPLSP traveling

across the network core.

You should have a general understanding of MPLS and label switching concepts. For

more information about MPLS, see the Junos MPLS Applications Configuration Guide.

An RSVP LSP tunnel adds the concept of a forwarding adjacency, similar to the one used

for generalized Multiprotocol Label Switching (GMPLS).

The forwardingadjacencycreatesa tunneledpath for sendingdatabetweenpeerdevices

in an RSVP LSP network. Once a forwarding adjacency LSP (FA-LSP) has been

established, other LSPs can be sent over the FA-LSP by using Constrained Shortest Path

First (CSPF), Link Management Protocol (LMP), Open Shortest Path First (OSPF), and

RSVP.

To enable an RSVP LSP tunnel, the Junos OS uses the following mechanisms:

• LMP—Originallydesigned forGMPLS,LMPestablishes forwardingadjacenciesbetween

RSVP LSP tunnel peers, andmaintains and allocates resources for traffic engineering

links.

• OSPF extensions—OSPF was designed to route packets to physical and logical

interfaces related to a Physical Interface Card (PIC). This protocol has been extended

to route packets to virtual peer interfaces defined in an LMP configuration.

• RSVP-TE extensions—RSVP-TE was designed to signal the setup of packet LSPs to

physical interfaces. The protocol has been extended to request path setup for packet

LSPs traveling to virtual peer interfaces defined in an LMP configuration.
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The following limitations exist for LSP hierarchies:

• Circuit cross-connect (CCC)-based LSPs are not supported.

• Graceful restart is not supported.

• Link protection is not available for FA-LSPs or at the egress point of the forwarding

adjacency.

• Point-to-multipoint LSPs are not supported across FA-LSPs.

RSVP creates independent sessions to handle each data flow. A session is identified by

a combination of the destination address, an optional destination port, and a protocol.

Within a session, there can be one or more senders. Each sender is identified by a

combination of its source address and source port. An out-of-bandmechanism, such as

a session announcement protocol or human communication, is used to communicate

the session identifier to all senders and receivers.

A typical RSVP session involves the following sequence of events:

1. A potential sender starts sending RSVP path messages to the session address.

2. A receiver, wanting to join the session, registers itself if necessary. For example, a

receiver in a multicast application would register itself with IGMP.

3. The receiver receives the path messages.

4. The receiver sends appropriate Resv messages toward the sender. These messages

carry a flow descriptor, which is used by routers along the path to make reservations

in their link-layer media.

5. The sender receives the Resv message and then starts sending application data.

This sequence of events is not necessarily strictly synchronized. For example, receivers

can register themselvesbefore receivingpathmessages fromthe sender, andapplication

datacan flowbefore thesender receivesResvmessages.Applicationdata that isdelivered

before the actual reservation contained in the Resv message typically is treated as

best-effort, non-real-time traffic with no CoS guarantee.

RSVPHello Packets and Timers

RSVPmonitors thestatusof the interior gatewayprotocol (IGP) (IS-ISorOSPF)neighbors

and relies on the IGP protocols to detect when a node fails. If an IGP protocol declares

a neighbor down (because hello packets are no longer being received), RSVP also brings

down that neighbor. However, the IGP protocols and RSVP still act independently when

bringing a neighbor up.

In the Junos OS, RSVP typically relies on IGP hello packet detection to check for node

failures. RSVP sessions are kept up even if RSVP hello packets are no longer being

received, so long as the router continues to receive IGP hello packets. RSVP sessions are

maintained until either the router stops receiving IGP hello packets or the RSVPPath and

Resv messages time out. Configuring a short time for the IS-IS or OSPF hello timers

allows these protocols to detect node failures quickly.
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RSVP hellos can be relied on when the IGP does not recognize a particular neighbor (for

example, if IGP is not enabled on the interface) or if the IGP is RIP (not IS-IS or OSPF).

Also, the equipment of other vendors might be configured to monitor RSVP sessions

based on RSVP hello packets. This equipment might also take an RSVP session down

due to a loss of RSVP hello packets.

We do not recommend configuring a short RSVP hello timer. If quick discovery of a failed

neighbor is needed, configure short IGP (OSPF or IS-IS) hello timers.

OSPFand IS-IShave infrastructure tomanage rapidhellomessagesendingand receiving

reliably, even if the routing protocols or some other process are straining the processing

capability of the router. Under the same circumstances, RSVP hellos might time out

prematurely even though the neighbor is functioning normally.

RSVPMessage Types

RSVPuses the following typesofmessages toestablishand removepaths for data flows,

establishand remove reservation information, confirmtheestablishmentof reservations,

and report errors:

• Path Messages on page 1604

• Resv Messages on page 1604

• PathTear Messages on page 1605

• ResvTear Messages on page 1605

• PathErr Messages on page 1605

• ResvErr Messages on page 1605

• ResvConfirmMessages on page 1605

PathMessages

Each sender host transmits path messages downstream along the routes provided by

the unicast andmulticast routing protocols. Path messages follow the exact paths of

application data, creating path states in the routers along the way, thus enabling routers

to learn the previous-hop and next-hop node for the session. Path messages are sent

periodically to refresh path states.

The refresh interval is controlled by a variable called the refresh-time, which is the

periodical refresh timer expressed in seconds. A path state times out if a router does not

receive a specified number of consecutive path messages. This number is specified by

a variable called keep-multiplier. Path states are kept for ( (keep-multiplier + 0.5) x 1.5 x

refresh-time ) seconds.

ResvMessages

Each receiver host sends reservation request (Resv)messages upstreamtoward senders

and sender applications. Resv messages must follow exactly the reverse path of path

messages. Resv messages create andmaintain a reservation state in each router along

the way.
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Resv messages are sent periodically to refresh reservation states. The refresh interval is

controlled by the same refresh time variable, and reservation states are kept for

( (keep-multiplier + 0.5) x 1.5 x refresh-time ) seconds.

PathTear Messages

PathTear messages remove (tear down) path states as well as dependent reservation

states in any routers along a path. PathTear messages follow the same path as path

messages. A PathTear typically is initiated by a sender application or by a router when

its path state times out.

PathTear messages are not required, but they enhance network performance because

they release network resources quickly. If PathTear messages are lost or not generated,

path stateseventually timeoutwhen theyarenot refreshed, and the resourcesassociated

with the path are released.

ResvTear Messages

ResvTear messages remove reservation states along a path. Thesemessages travel

upstream toward senders of the session. In a sense, ResvTear messages are the reverse

of Resv messages. ResvTear messages typically are initiated by a receiver application

or by a router when its reservation state times out.

ResvTear messages are not required, but they enhance network performance because

they release network resources quickly. If ResvTear messages are lost or not generated,

reservation states eventually time out when they are not refreshed, and the resources

associated with the reservation are released.

PathErr Messages

When path errors occur (usually because of parameter problems in a path message),

the router sends a unicast PathErr message to the sender that issued the pathmessage.

PathErr messages are advisory; these messages do not alter any path state along the

way.

ResvErr Messages

When a reservation request fails, a ResvErr error message is delivered to all the receivers

involved. ResvErr messages are advisory; these messages do not alter any reservation

state along the way.

ResvConfirmMessages

Receivers can request confirmation of a reservation request, and this confirmation is sent

with a ResvConfirmmessage. Because of the complex RSVP flow-merging rules, a

confirmationmessagedoesnotnecessarily provideend-to-endconfirmationof theentire

path. Therefore, ResvConfirmmessages are an indication, not a guarantee, of potential

success.

Juniper Networks routers never request confirmation using the ResvConfirmmessage;

however, a Juniper Networks router can send a ResvConfirmmessage if it receives a

request from another vendor's equipment.
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MTUSignaling in RSVP

Themaximum transmission unit (MTU) is the largest size packet or frame, in bytes, that

can be sent in a network. An MTU that is too large might cause retransmissions. Too

small anMTUmightcause the router to sendandhandle relativelymoreheaderoverhead

and acknowledgments. There are default values for MTUs associated with various

protocols. You can also explicitly configure an MTU on an interface.

When an LSP is created across a set of links with different MTU sizes, the ingress router

does not knowwhat the smallest MTU is on the LSP path. By default, the MTU for an

LSP is 1,500 bytes.

If thisMTU is larger than theMTUofoneof the intermediate links, trafficmightbedropped,

because MPLS packets cannot be fragmented. Also, the ingress router is not aware of

this typeof traffic loss, because thecontrol plane for theLSPwould still functionnormally.

To prevent this type of packet loss in MPLS LSPs, you can configure MTU signaling in

RSVP. This feature is described in RFC 3209. Juniper Networks supports the Integrated

Services object for MTU signaling in RSVP. The Integrated Services object is described

in RFCs 2210 and 2215. MTU signaling in RSVP is disabled by default.

Toavoidpacket lossdue toMTUmismatches, the ingress router needs todo the following:

• Signal the MTU on the RSVP LSP—To prevent packet loss from anMTUmismatch,

the ingress router needs to knowwhat the smallest MTU value is along the path taken

by the LSP. Once thisMTU value is obtained, the ingress router can assign it to the LSP.

• Fragment packets—Using the assignedMTU value, packets that exceed the size of the

MTU can be fragmented into smaller packets on the ingress router before they are

encapsulated in MPLS and sent over the RSVP-signaled LSP.

Once both MTU signaling and packet fragmentation have been enabled on an ingress

router, any route resolving to an RSVP LSP on this router uses the signaled MTU value.

The following are limitations to MTU signaling in RSVP:

• Changes in the MTU value might cause a temporary loss of traffic in the following

situations:

• For link protection and node protection, the MTU of the bypass is only signaled at

the time the bypass becomes active. During the time it takes for the new path MTU

to be propagated, packet loss might occur because of an MTUmismatch.

• For fast reroute, theMTUof thepath isupdatedonlyafter thedetourbecomesactive,

causing a delay in an update to the MTU at the ingress router. Until the MTU is

updated, packet loss might occur if there is an MTUmismatch.

In both cases, only packets that are larger than the detour or bypass MTU are lost.

• When an MTU is updated, it triggers a change in the next hop. Any change in the next

hop causes the route statistics to be lost.
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• TheminimumMTU supported for MTU signaling in RSVP is 1,488 bytes. This value

prevents a false or incorrectly configured value from being used.

• For single-hop LSPs, the MTU value displayed by the show commands is the

RSVP-signaled value. However, this MPLS value is ignored and the correct IP value is

used.

Related
Documentation

Tunnel Services Overview on page 1585•

• Traffic Engineering Capabilities on page 1586

• Components of Traffic Engineering on page 1587

• Routers in an LSP on page 1590

• MPLS and RSVP Overview on page 1595

• Fast Reroute Overview on page 1598

• Point-to-Multipoint LSPs Overview on page 1600

• Link Protection and Node Protection on page 1607

• Connectivity ServicesDirector–NorthStarController IntegrationOverviewonpage 1613

Link Protection and Node Protection

Link protection helps to ensure that traffic going over a specific interface to a neighboring

router or switch can continue to reach this router (switch) if that interface fails. When

link protection is configured for an interface and an LSP that traverses this interface, a

bypass LSP is created that will handle this traffic if the interface fails. The bypass LSP

uses a different interface and path to reach the same destination. The path used can be

configured explicitly, or you can rely on CSPF. The RSVPmetric for the bypass LSP is set

in the range of 20,000 through 29,999 (this value is not user configurable).

If a link-protected interface fails, traffic is quickly switched to the bypass LSP. Note that

a bypass LSP cannot share the same egress interface with the LSPs it monitors.

In Figure 60 on page 1607, link protection is enabled on Interface B between Router 1 and

Router 2. It is also enabled on LSP A, an LSP that traverses the link between Router 1 and

Router 2. If the link between Router 1 and Router 2 fails, traffic from LSP A is quickly

switched to the bypass LSP generated by link protection.

Figure 60: Link Protection Creating a Bypass LSP for the Protected Interface
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Although LSPs traversing an interface can be configured to take advantage of link

protection, it is important to note that it is specifically the interface that benefits from

link protection. If link protection is enabled on an interface but not on a particular LSP

traversing that interface, then if the interface fails, that LSP will also fail.

NOTE: Link protection does not work on unnumbered interfaces.

Node Protection

Nodeprotectionextends thecapabilitiesof linkprotection. Linkprotectionhelps toensure

that traffic going over a specific interface to a neighboring router can continue to reach

this router if that interface fails.Nodeprotectionensures that traffic fromanLSPtraversing

a neighboring router can continue to reach its destination even if the neighboring router

fails.

When you enable node protection for an LSP, youmust also enable link protection. Once

enabled, node protection and link protection establish the following types of bypass

LSPs:

• Next-hop bypass LSP—Provides an alternate route for an LSP to reach a neighboring

router. This type of bypass LSP is established when you enable either node protection

or link protection.

• Next-next-hop bypass LSP—Provides an alternate route for an LSP to get around a

neighboring router en route to the destination router. This type of bypass LSP is

established exclusively when node protection is configured. If a next-next-hop bypass

LSP cannot be created, an attempt is made to signal a next-hop bypass LSP.

In Figure 61 on page 1608, node protection is enabled on Interface B on Router 1. Node

protection is also enabled on LSP A, an LSP that traverses the link transiting Router 1,

Router 2, and Router 3. If Router 2 suffers a hardware or software failure, traffic from LSP

A is switched to the next-next-hop bypass LSP generated by node protection.

Figure 61: Node Protection Creating a Next-Next-Hop Bypass LSP
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The time needed by node protection to switch traffic to a next-next-hop bypass LSP can

be significantly longer than the time needed by link protection to switch traffic to a

next-hop bypass LSP. Link protection relies on a hardware mechanism to detect a link

failure, allowing it to quickly switch traffic to a next-hop bypass LSP.

Node failures are often due to software problems on the node router. Node protection

relies on the receipt of hello messages from a neighboring router to determine whether
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it is still functioning. The time it takes node protection to divert traffic partly depends on

howoften thenode router sendshellomessagesandhowlong it takes thenode-protected

router to react to having not received a hello message. However, once the failure is

detected, traffic can be quickly diverted to the next-next-hop bypass LSP.

NOTE:

Node protection provides traffic protection in the event of an error or
interruption of the physical link between two routers. It does not provide
protection in the event of control plane errors. The following provides an
example of a control plane error:

• A transit router changes the label of a packet due to a control plane error.

• When the ingress router receives the packet, it considers the label change
to be a catastrophic event and deletes both the primary LSP and the
associated bypass LSP.

LSP Protection Overview

RSVP-TE extensions establish backup label-switchedpath (LSP) tunnels for local repair

of LSP tunnels. Thesemechanisms enable immediate re-direction of traffic onto backup

LSP tunnels, in the event of a failure.

RFC 4090, Fast Reroute Extensions to RSVP-TE for LSP Tunnels, describes two different

types of traffic protection for RSVP-signaled LSPs:

• One-to-one backup—In this method, detour LSPs for each protected LSP is created

at each potential point of local repair.

• Facility backup—In this method, a bypass tunnel is created to protect a set of LSPs

that have similar backup constraints at a potential failure point, by taking advantage

of the MPLS label stacking.

The one-to-one backup and the facility backupmethods protect links and nodes during

network failure, and can co-exist in a mixed network.

LSP Protection Types Comparison

In the Junos OS, the one-to-one backup of traffic protection is provided by fast reroute.

Each LSP requires a protecting LSP to be signaled at each hop except the egress router.

This method of LSP protection cannot be shared.

In the facillity backupmethod, the LSP traffic protection is provided on the node and link.

Each LSP requires a protecting LSP to be signaled at each hop except the egress router.

Unlike fast reroute, this protecting LSP can be shared by other LSPs.

Table 251 on page 1610 summarizes the traffic protection types.
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Table 251: One-to-One Backup Compared with Facility Backup

Facility BackupOne-to-One BackupComparison

Bypass LSPDetour LSPName of the protecting LSP

Can be shared bymultiple
LSPs

Cannot be sharedSharing of the protecting LSP

node-link-protection and
link-protection

fast-rerouteJunos configuration statements

One-to-One Backup Implementation

In the one-to-one backupmethod, the points of local repair maintain separate backup

paths for each LSP passing through a facility. The backup path terminates by merging

backwith the primary path at a node called themerge point. In this approach, themerge

point can be any node downstream from the protected facility.

In the one-to-one backupmethod, an LSP is established that intersects the original LSP

downstream of the point of link or node failure. A separate backup LSP is established

for each LSP that is backed up.

One-to-one backup is appropriate under the following circumstances:

• Protection of a small number of LSPs relative to the total number of LSPs.

• Path selection criteria, such as bandwidth, priority, and link coloring for detour paths

is critical.

• Control of individual LSPs is important.

In Figure62onpage 1611, RoutersR1andR5are the ingressandegress routers, respectively.

A protected LSP is established between the two routers transiting Routers R2, R3, and

R4.RouterR2providesuser trafficprotectionbycreatingapartial backupLSP thatmerges

with the protected LSP at Router R4. This partial one-to-one backup LSP is called a

detour. Detours arealways calculated toavoid the immediatedownstream link andnode,

providing against both link and node failure.
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Figure 62: One-to-One Backup

In the example, the protected LSP is R1-R2-R3-R4-R5, and the following detours are

established:

• Router R1—R1-R6-R7-R8-R3

• Router R2—R2-R7-R8-R4

• Router R3—R3-R8-R9-R5

• Router R4—R4-R9-R5

To protect an LSP that traverses N nodes fully, there can be as many as (N - 1) detours.

The point of local repair sends periodic refreshmessages tomaintain each backup path,

as a result maintaining state information for backup paths protecting individual LSPs is

a significant resource burden for the point of local repair. To minimize the number of

LSPs in the network, it is desirable to merge a detour back to its protected LSP, when

feasible.Whenadetour LSP intersects itsprotectedLSPatanLSRwith thesameoutgoing

interface, it is merged.

Facility Backup Implementation

In the facility backup approach, a point of local repair maintains a single backup path to

protect a set of primary LSPs traversing the point of local repair, the facility, and the

merge point. The facility backup is based on interface rather than on LSP. While fast

reroute protects interfaces or nodes along the entire path of a LSP, the facility backup

protection can be applied on interfaces as needed. As a result, fewer states need to be

maintainedand refreshedwhich results in a scalable solution. The facility backupmethod

is also called many-to-one backup.

The facility backupmethod takes advantage of theMPLS label stack. Instead of creating

a separate LSP for every backed-up LSP, a single LSP is created that serves to back up

a set of LSPs. Such an LSP tunnel is called a bypass tunnel. In this method, a router

immediately upstream from a link failure uses an alternate interface to forward traffic
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to its downstream neighbor, and themerge point should be the node immediately

downstream to the facility. This is accomplished by preestablishing a bypass path that

is shared by all protected LSPs traversing the failed link. A single bypass path can

safeguard a set of protected LSPs. When an outage occurs, the router immediately

upstream from the link outage switches protected traffic to the bypass link, then signals

the link failure to the ingress router.

Thebypass tunnelmust intersect thepathof theoriginal LSP(s) somewheredownstream

of the point of local repair. This constrains the set of LSPs being backed up through that

bypass tunnel to those that pass through some common downstream nodes. All LSPs

that pass through the point of local repair and through this common node, and that do

not also use the facilities involved in thebypass tunnel are candidates for this set of LSPs.

The facility backupmethod is appropriate in the following situations:

• The number of LSPs to be protected is large.

• Satisfying path selection criteria (priority, bandwidth, and link coloring) for bypass

paths is less critical.

• Control at the granularity of individual LSPs is not required.

InFigure63onpage 1612,RoutersR1andR5are the ingressandegress routers, respectively.

Router R2 has established a bypass tunnel that protects against the failure of Router

R2-R3 link and Router R3 node. A bypass tunnel is established between Routers R6 and

R7. There are three different protected LSPs that are using the same bypass tunnel for

protection.

Figure 63: Facility Backup
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The facility backupmethodprovidesa scalability improvement,wherein the samebypass

tunnel is also used to protect LSPs from any of RoutersR1, R2, or R8 to any of Routers

R4, R5, or R9.

Related
Documentation

Tunnel Services Overview on page 1585•

• Traffic Engineering Capabilities on page 1586

• Components of Traffic Engineering on page 1587

• Routers in an LSP on page 1590

• MPLS and RSVP Overview on page 1595

• Fast Reroute Overview on page 1598

• Point-to-Multipoint LSPs Overview on page 1600

• RSVP Operation Overview on page 1602

• Connectivity ServicesDirector–NorthStarController IntegrationOverviewonpage 1613

Connectivity Services Director–NorthStar Controller Integration Overview

The Juniper Networks NorthStar Controller is a software-defined networking (SDN)

controller that provides granular visibility and control of IP/MPLS tunnels in large service

provider and enterprise networks. Network operators can use NorthStar Controller to

optimize their network infrastructure throughproactivemonitoring, planning, andexplicit

routing of large traffic loads dynamically based on user-defined configuration.

For more information on NorthStar Controller, see the NorthStar Controller User Guide.

The integration of NorthStar and Connectivity Services Director provides a single

configuration window by allowing you to create, modify, delete, andmonitor RSVP LSPs

andSegmentRoutingLSPsusingRESTAPIs,With the integration, youcancreatesegment

routing LSPs by using NorthStar Controller, as Connectivity Services Director currently

supports the creation of RSVP LSPs only.

Starting fromRelease 3.0 onward, you can choose NorthStar Controller tomanage LSPs

fromtheConnectivityServicesDirectoruser interface.TheNorthStar tab in thePreferences

page displays the attributes listed in Table 19 on page 153.

Table 252: NorthStar Parameters

DescriptionFields

Select this check box to manage LSPs through the NorthStar Controller server.Enable NorthStar LSPManagement

Select this check box to enable PCEP as the provisioning type for LSPs.PCEP for Provisioning

Select either RSVP or Segment Routing as the provisioning type.

Default: RSVP

Provisioning Type
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Table 252: NorthStar Parameters (continued)

DescriptionFields

Enter the NorthStar server IP, Username, and Password to validate your access to
the NorthStar server.

Credentials

Related
Documentation

• Creating an LSP Service Definition on page 1618

• Creating an LSP Service Order on page 1627
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CHAPTER 59

ServiceDesignandProvisioning:Managing
and Deploying Tunnel Services

• Managing Devices and Tunnel Services Overview on page 1616

• Discovering Tunnel Devices on page 1616

• Creating an LSP Service Definition on page 1618

• Creating an LSP Service Order on page 1627

• Creating Public and Private LSPs on page 1653

• Viewing the Configured LSP Services on page 1654

• Modifying an Explicit Path in RSVP LSP Services on page 1656

• Modifying an RSVP LSP Service on page 1658

• Viewing LSP Services in Deploy Mode on page 1660

• Viewing LSP Service Orders in a Table on page 1661

• Deactivating an LSP Service on page 1662

• Reactivating an LSP Service on page 1664

• Force-Deploying an LSP Service on page 1665

• Viewing Alarms for an LSP Service on page 1667

• Managing Deployment of LSP Services Configuration to Devices on page 1668

• Deploying an LSP Service on page 1673

• Deleting a Partial Configuration of an LSP Service Order on page 1674

• Deleting an LSP Service Order on page 1675

• Validating the Pending Configuration of an LSP Service Order on page 1676

• Viewing the Configuration of a Pending LSP Service Order on page 1677

• Viewing the Configuration Details of RSVP LSP Services on page 1679

• Viewing Decommissioned LSP Service Orders on page 1680
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Managing Devices and Tunnel Services Overview

Thedesignandprovisioningworkspaces include tasks that enable you todo the following:

• Discover LSP Devices—Discovers Juniper Networks devices that have been discovered

in the Junos Space database or resynthesizes LSP and GRE devices that are already

discovered. You can discover devices to bring them under the administration and

management of Connectivity Services Director by using the Junos Space Network

Management Platform application or by using the Connectivity Services Director

application in Device View of Build mode by selecting Device Discovery > Discover

Devices from the Tasks pane.

• Manage LSP Service Orders—Enables you to manage TA service orders, such as

deploying the service orders, viewing pending configuration, deleting partial

configuration, and discarding and validating pending configuration using the Manage

Service Deployment page (accessible in Deploy mode of Service View by selecting

Service Provisioning > Deploy Services from the tasks pane).

• Manage LSP Services—Enables you tomanage services, including actions that let you

decommission services, perform functional audits, view functional audit results, and

view service configuration changes for TA services using the Manage LSP Services

page (accessible in Deploy mode of Service View by selecting Service Provisioning >

Deploy Services from the tasks pane).

The provisioning workspace allows you, the MPLS LSP service designer to create and

manage LSP definitions to use as a starting point for provisioning services. Youmust

have Service Designer privileges to create a tunnel service or LSP service definition.

Youmust first discover Juniper Networks devices that have been configured for MPLS

LSPs and create an LSP definition..

Discovering Tunnel Devices

When you start Connectivity ServicesDirector for the first time, the systemdoes not have

any devices. The first step is to build your network. Evenwith large networks, Connectivity

Services Director has made this step relatively easy and straightforward. You will add

devices to Connectivity Services Director and the database by using a process called

device discovery. Once a device is discovered, it shows in the interface and Connectivity

Services Director begins to monitor the device.

Connectivity Services Director provides a wizard for device discovery. The following

example shows the path for device discovery through the wizard. For an alternate path,

you can get a step-by-step instruction from the help system.
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Before you discover tunneling devices:

• Ensure that the devices that you want to discover are configured for MPLS with the

required interface in the Junos OS configuration hierarchy [edit protocols mpls]. See

the Junos Software MPLS Configuration Guide.

In this example, we provide an IP address range, and Connectivity Services Director

populates the database with all supported devices within that range.

1. While in the Buildmode, select Device View or CustomGroup View from the View

selector.

2. To discover physical devices, click Discover Devices in the Tasks pane. Eachmode has

a Tasks Pane that displays the actions you can take while in that mode and that

particular network view.

3. (Optional) Type a name for the discovery job. The default name is ND Discovery.

4. Click Add in the Device Targets window. You can add a single device IP address, a

range of IP addresses, an IP subnet, or a hostname. In this example, we select an IP

address range.

5. Provide the initial or the lowest IP address value and the ending or highest IP address

value for the range and click Add. You can have up to 1024 devices in a range. After

you click Add, the address range is listed in the Device Targets window.

6. Click Next or click Discovery Options to proceed to specify the device credentials and

method of discovery.

7. Click Add in the Device Credentials window and enter the username and password

assigned for administrative access.

8. Select Ping , SNMP, or both as the method of device discovery. Selecting both is the

preferred method if the device is configured for SNMP.

If you select SNMP, the Add SNMP Settings dialog box is displayed. In this example,

because we run SNMP version 2, we need to provide the community string. Click Add

to save the setting.

NOTE: You cannot choose amethod for device discovery for virtual
network discovery.

9. ClickNext or ScheduleOptions to proceed to schedule the timewhen discovery is run.
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NOTE: Scheduling options are not available for virtual network discovery.

10. Indicate whether to run the device discovery now or set up a schedule to minimize

network traffic. In this example, we set the schedule to run during off hours.

11. Click Review to review the settings before you exit the wizard.

12. Click Finish to complete the discovery setup and to save the settings.

13. Click View Discovery Status to view all scheduled and completed jobs. After a job

completes, you can click ShowDetails to view further information on any unexpected

results.

Related
Documentation

Viewing LSP Service Orders in a Table on page 1661•

• Deactivating an LSP Service on page 1662

• Reactivating an LSP Service on page 1664

Creating an LSP Service Definition

• Specifying General Settings on page 1618

• Specifying Path Settings on page 1621

• Specifying BFD Settings on page 1624

• Reviewing the Configured Settings on page 1627

Specifying General Settings

FromConnectivityServicesDirectorRelease3.0onward, youcancreateaservicedefinition

for Label-switched Paths (LSPs) and use this definition for your service order.

1. From the View selector, select Service View.

The workspaces that are applicable to routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. In the Network Services pane, select Tunnel > Service Provisioning >Manage LSP

Service Definitions. The Manage Service Definitions page appears displaying all the

configured LSP service definitions.

4. Click the New icon, which is present above the list of configured service definitions.

The Create LSP Service Definitions dialog box appears.
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NOTE: The availability of attributes in the service definition creation
workflow varies based on whether you choose Connectivity Services
Director or NorthStar Controller to manage your LSPs.

Fill in the fields in the General window.

5. Configure the general settings as indicated in Table 253 on page 1619.

Table 253: General Settings

DescriptionField

Enter a name for the service definition.Service Definition Name

Enter a brief description or other comment that you want to appear in the Service Definition table.

Range: 0 through 200 characters.

Spaces and special characters are allowed.

Description (Optional)

Displays either RSVP or Segment Routing based on the value you choose from the NorthStar tab in
the Preferences window.

Default: RSVP

Provisioning Type

Choose either NETCONF or PCEP from the drop down to specify the provisioning method.

Default: NETCONF

NOTE: PCEP is available only if the PCEP for Provisioning check box is selected from the Northstar
tab in the Preferences window.

ProvisioningMethod

Select the LSP transport topology from the list:

• P2P—Provides a point-to-point connectivity between the selected endpoints

• P2MP—Provides a point-to-multipoint connectivity between the selected endpoints

• Full Mesh—Provides any-to-any unidirectional MPLS connectivity among all the selected provider
edge router

Topology Type

This field is enabled only if Enable NorthStar LSPManagement is cleared from the Preferences
window.

Range: 0 through 10,000

Default: 0

Retry Limit

This field is enabled only if Enable NorthStar LSPManagement is cleared from the Preferences
window.

Range: 1 through 600 seconds

Default: 30 seconds

Retry Timer (sec)
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Table 253: General Settings (continued)

DescriptionField

Specify the bandwidth in Kbps.

A non-zero bandwidth requires that transit and egress routers reserve capacity along the outbound
links for the path.

The RSVP scheme is used to reserve this capacity. Any failure in bandwidth reservation (such as
failures at RSVP policy control or admission control) might cause the LSP setup to fail.

If there is insufficient bandwidth on the interfaces for the transit or egress routers, the LSP is not
established.

Range: 0 through 2147483

Bandwidth (kbps)

Select this check box to enable LDP tunneling.

NOTE: The attribute is not configurable for P2MP topology and is visible only if Enable NorthStar
LSPManagement is disabled in the Preferences window.

LDP Tunneling

Select this check box to enable fast reroute.

NOTE: The attribute is not configurable for P2MP topology and is visible only if Enable NorthStar
LSPManagement is disabled in the Preferences window.

Enable Fast Reroute

You can select either CSPF or Explicit Path options. This field is visible only if Enable NorthStar LSP
Management is disabled in the Preferences window.

Default: CSPF

Path Selection Type

You can choose either Path Protection, Local Protection, or Path and Local Protection options from
the list.

This field is visible only if Enable NorthStar LSPManagement is disabled in the Preferences window.

Default: Path Protection

LSP Protection Type

You can choose either Link Protection or Node-Link Protection type from the list.

This field is visible only if Enable NorthStar LSPManagement is disabled in the Preferences window.

Default: Link Protection

NOTE: This list is unavailable if the LSP Protection Type is Path Protection.

Local Protection Type

Select the Auto-Bandwidth check box to edit Adjust Interval, Minimum Bandwidth, and Maximum
Bandwidth fields.

NOTE: Auto-Bandwidth is not configurable for Full Mesh topology and also when path selection
type is Explicit Path.

This field is visible only if Enable NorthStar LSPManagement is disabled in the Preferences window.

Auto-Bandwidth
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Table 253: General Settings (continued)

DescriptionField

Specify the bandwidth reallocation interval.

Range: 300 through 4,294,967,295 seconds

Default: 86,400 seconds

This field is enabled only if Auto-Bandwidth check box is selected and Enable NorthStar LSP
Management is disabled in the Preferences window.

Adjust Interval (sec)

Specify theminimum bandwidth in Kbps or an LSPwith automatic bandwidth allocation enabled.

Default: 1000 Kbps

Range: 1 through 2147483 Kbps

Youmust enter the minimum bandwidth to be lower than themaximum bandwidth.

This field is enabled only if Auto-Bandwidth check box is selected and Enable NorthStar LSP
Management is disabled in the Preferences window.

MinimumBandwidth
(kbps)

Specify themaximumbandwidth in Kbps or an LSPwith automatic bandwidth allocation enabled.
You canmaintain the LSP’s bandwidth betweenminimum andmaximum bounds by specifying
values.

Default: 10000 Kbps

Range:1 through 2147483 Kbps

This field is enabled only if Auto-Bandwidth check box is selected and Enable NorthStar LSP
Management is disabled in the Preferences window.

MaximumBandwidth
(kbps)

6. Click Next to specify the Path Settings.

The Path settings that you can configure for the LSP service definition are displayed.

Specifying Path Settings

1. Fill in the parameters as indicated in t Table 254 on page 1622.
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Table 254: Path Settings

DescriptionField

Specify a decimal number.

This number corresponds to a 3-bit binary number. The two higher-order bits of the CoS value is used to select
the transmit queue to be usedon the outbound interface card. The lower order bit of the CoS value is treated
as the packet loss priority (PLP) bit and is used to select the random early detection (RED) drop profile to be
used on the output queue. If the lower order bit is 0, the non-PLP drop profile is used, and if the lower order bit
is 1, the PLP drop profile is used.

Typically, RED aggressively drops packets that have the PLP bit set. For more information about RED and drop
profiles, see the Junos OS Class of Service Configuration Guide.

Range: A decimal number from 0 through 7

This field is not available for local-Protection type of LSPs.

Class of
Service

Specify the hop limit of the LSP.

A path with two hops consists of the ingress and egress routers only.

Range: 2 through 255

Default: Each LSP can traverse amaximum of 255 hops, including the ingress and egress routers.

Hop Limit

Select this check box to have the path remain up at all times to provide immediate switchover if connectivity
problems occur.

This field is displayed only for secondary paths.

Standby
(Enable
Switchover)

Select this check box if you want to configure an LSP to be adaptive when it is attempting to reroute itself.

When adaptive, the LSP holds onto existing resources until the until the new path is successfully established
and traffic is switched over to the new LSP.

Select this check box if you want to configure an LSP to be adaptive when it is attempting to reroute itself.

When adaptive, the LSP holds onto existing resources until the newpath is successfully established and traffic
iis switched over to the new LSP.

To retain its resources, an adaptive LSP does the following:

• Maintains existing paths and allocated bandwidths—This ensures that the existing path is not torn down
prematurely and allows the current traffic to continue flowing while the new path is being set up.

• Avoids double-counting for links that share the new and old paths—Double-counting occurs when an
intermediate router does not recognize that the new and old paths belong to the same LSP and counts them
as two separate LSPs, requiring separate bandwidth allocations.

If some links are close to saturation, double-countingmight cause the setup of the new path to fail. By default,
adaptive behavior is disabled.

You can include the adaptive statement in two different hierarchy levels. If you specify the adaptive statement
at the LSP hierarchy levels, the adaptive behavior is enabled on all primary and secondary paths of the LSP.
This means both the primary and secondary paths share the same bandwidth on common links.

NOTE: This check box is not available for P2MP topology and also when the path selection type is explicit
path.

Adaptive
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Table 254: Path Settings (continued)

DescriptionField

Specify apriority value,whichdetermineswhether anewLSP thatpreemptsanexistingLSPcanbeestablished.

For preemption to occur, the setup priority of the new LSPmust specify a priority value, which determines
whether a new LSP that preempts an existing LSP can be established.

For preemption to occur, the setup priority of the new LSPmust be higher than that of the existing LSP. Also,
the act of preempting the existing LSPmust produce sufficient bandwidth to support the new LSP. That is,
preemption occurs only if the new LSP can be set up successfully.

The setup priority also defines the relative importance of LSPs on the same ingress router. When the software
starts, when a new LSP is established, or during fault recovery, the setup priority determines the order in which
LSPsare serviced.Higher-priority LSPs tend tobeestablished first andhenceenjoymoreoptimalpath selection.

This field cannot be configured for local-protection type of LSPs.

Range: Both setup-priority and reservation-priority can be a value from 0 through 7, where 0 is the highest
priority and 7 is the lowest priority.

Default: An LSP has a setup priority of 7 (that is, it cannot preempt any other LSPs) and a reservation priority
of 0 (that is, other LSPs cannot preempt it).

These defaults prevent preemption.

NOTE: When you are configuring these values, make sure that the setup priority value is lower than or equal
to the hold priority value.

Setup Priority

Specify a hold priority value.

The hold priority determines the degree to which an LSP holds onto its session reservation of the LSP that has
been set up successfully.

When the hold priority is high, the existing LSP is less likely to give up its reservation and, therefore, it is unlikely
that the LSP can bepreempted.

Youmust configure the hold priority to be greater than or equal to the setup priority. This field cannot be
configured for local-protection type of LSPs.

Range: 0 through 7, where 0 is the highest priority and 7 is the lowest priority.

NOTE: If traffic engineering admission control determines that there are insufficient resources to accept a
request to set up a new LSP, the setup priority is evaluated against the hold priority of existing LSPs.

An LSP with a hold priority lower than the setup priority of the new LSP can be preempted. The existing LSP
is terminated to make room (that is, resources are freed) for the new LSP.

Hold Priority

Use the drop-downmenu to select a routing method. Available options include RouteByPCC, default,
adminWieght, delay, constant, distance, ISIS,OSPF

NOTE: This attribute is visible only if Enable NorthStar LSPManagement is enabled in Preferences.

Default: RouteByPCC

Routing
Method

Type a value or use the up and down arrows to increment or decrement by 100.

NOTE: This attribute is visible only if Enable NorthStar LSPManagement is enabled in Preferences.

Default: RouteByPCC

Max Delay
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Table 254: Path Settings (continued)

DescriptionField

Type a value or use the up and down arrows to increment or decrement by 100.

NOTE: This attribute is visible only if Enable NorthStar LSPManagement is enabled in Preferences.

Default: RouteByPCC

Max Cost

Specify a value to configure the LSP path selection for RSVP tunnels.

NOTE: This attribute is visible only if Enable NorthStar LSPManagement is enabled in Preferences.

Default: RouteByPCC

Tunnel Metric

2. Click Next to save the Path Settings page information.

Continue with specifying BFD Settings.

Specifying BFD Settings

To provide the BFD attributes for this service definition:

1. Fill in the fields on the BFD Settings page as indicated in Table 255 on page 1624:

NOTE: You cannot configure BFD settings if Enable NorthStar LSP

management check box is selected in the Preferences window.

Table 255: BFD Settings

DescriptionField

Select the BFD setting type:

• This LSP—Configure BFD settings for all of the specific LSP.

• Primary Path—Configure BFD settings for the primary path of the specific LSP.

• Secondary Path—Configure BFD settings for the secondary path of the specific LSP.

• None–Do not configure BFD settings.

By default, BFD is not configured.

NOTE: The primary path and the secondary path are listed on BFD Detection menu only if you have
configured the primary and secondary paths.

You canmodify the BFD Detection settings in a service.

BFD Detection
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Table 255: BFD Settings (continued)

DescriptionField

Specify the minimum transmit and receive interval.

This value represents the minimum interval at which the local routing device transmits hello packets as
well as theminimum interval that the routing device expects to receive a reply fromaneighborwithwhich
it has established a BFD session.

Range: 1 through 255,000milliseconds

Default: 300

Minimum Interval

Specify the minimum receive interval.

This value represents theminimum interval atwhich the peermust receive a reply fromapeerwithwhich
it has established a BFD session.

Range: 1 through 255,000milliseconds

Default: 50

MinimumReceive
Interval

Specify the detection timemultiplier.

This value represents the number of hello packets not received by the neighbor before BFD declares that
the neighbor is down.

Range: 1 through 255

Default: 3

Multiplier

Select this check box to disable adaptation.

You can configure an LSP to be adaptive when it is attempting to reroute itself. When it is adaptive, the
LSP holds onto existing resources until the new path is successfully established and traffic has been
switched over to the new LSP.

To retain its resources, an adaptive LSP does the following:

•Maintains existing paths andallocatedbandwidths—This ensures that the existing path is not torn down
prematurely and allows the current traffic to continue flowing while the new path is being set up.

• Avoids double-counting for links that share the new and old paths—Double-counting occurs when an
intermediate router does not recognize that the new and old paths belong to the same LSP and counts
them as two separate LSPs, requiring separate bandwidth allocations.

If some links are close to saturation, double-counting might cause the setup of the new path to fail.

By default, adaptive behavior is disabled.

No Adaption
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Table 255: BFD Settings (continued)

DescriptionField

Specify the minimum transmit interval at which the local routing device transmits hello packets to a
neighbor with which it has established a BFD session.

The negotiated transmit interval for a peer is the interval between the sending of BFD packets to peers.
The receive interval for a peer is the minimum time that it requires between packets sent from its peer;
the receive interval is not negotiated between peers.

To determine the transmit interval, each peer compares its configuredminimum transmit interval with
its peer's minimum receive interval. The larger of the two numbers is accepted as the transmit interval
for that peer.

Range: 1 through 255,000milliseconds

Default: 50milliseconds

Transmit Minimum
Interval

Specify the high transmit interval triggering a trap.

The threshold is used for detecting the adaptation of the transmit interval.

When the BFD session transmit interval adapts to a value greater than the threshold, a single trap and a
single systemmessage are sent.

Range: 51 through 4,294,967,295

Default: None

Transmit Threshold

Specify the maximum time at which to trigger a trap.

Specify the threshold for the adaptation of the BFD session detection time.

When the detection time adapts to a value equal to or greater than the threshold, a single trap and a
single system logmessage are sent.

Range: 0 through 4,294,967,295

Default: None

DetectionThreshold

Select an action to take when a BFD session for an RSVP LSP goes down:

• Teardown—Causes the LSP path to be taken down and re-signaled immediately.

• Make Before Break—Attempts to signal a new LSP path before tearing down the old LSP path. When
the BFD session for an RSVP LSP goes down, the LSP is torn down and resignaled.

Traffic canbeswitched toastandbyLSP, or youcansimply teardown theLSPpath.Anyactionsperformed
are logged.

When a BFD session for an RSVP LSP path goes down, you can configure the Junos OS to resignal the
LSP path or to simply disable the LSP path.

A standby LSP path could be configured to handle traffic while the primary LSP path is unavailable. The
router can automatically recover from LSP failures that can be detected by BFD.

By default, if a BFD session fails, the event is simply logged.

Failure Action –
Teardown

Failure Action –
Make Before Break
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2. Click Next to review the configured settings.

The Review page of the wizard is displayed.

Reviewing the Configured Settings

The Review page of the service definition creation andmodification wizards enable you

to view and evaluate the service parameters and components you configured in the

preceding steps or on the preceding pages of the wizard. This page provides a

comprehensive, single-pageviewofall the serviceelementsconfiguredusing thedifferent

pages of the wizard.

You can either click the buttons corresponding to the various settings at the top of the

wizard page to directly traverse to the page you want to modify or click the navigation

buttons at the bottom of the wizard page to go to the different pages of the wizard.

To examine the configured settings, andmodify them as needed:

1. Click Review to view the defined parameters.

You can examine andmodify the created service definition parameters.

Alternatively, click the correspondingbuttonsat the topof thewizardpage tonavigate

to the specific pages that pertain to the settings you want to modify.

2. Click Edit beside any of the sections to modify the parameters corresponding to that

section.

You are taken to the page pertaining to the parameter in the wizard.

3. Click Finish to save the service definition.

4. Click Back to return to the previous page of the wizard; otherwise, click Cancel to

discard the changes.

The service definition inventory window appears.

Related
Documentation

Creating an LSP Service Order on page 1627•

Creating an LSP Service Order

The service designer is responsible for creating andmanaging service definitions and the

service provisioner uses these definitions as the basis for creating a service order. You

can create a service definition that specifies attributes that are common to a group of

service orders with similar service requirements, and a service order, which is an

implementation object or a derivative of a service definition. For label-switched path

(LSP) services, a service order can be directly created.

You can create LSP service orders that you can use as a starting point for provisioning

LSP services. For LSP service orders, unlike the framework that is available for network
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services, such as E-Line, E-LAN, and IP protocols, in which a service definition is created

independently as a separate item and a service order can be created, based on a service

definition, a service order can also be created, independent of a service definition. You

can, however, select a customized predefined service definition during the creation of an

LSP service order. When you select such a predefined service definition, the parameters

that are contained in it are populated in the corresponding fields of the service order

creation wizard.

Awizard is available to create andmodify a service order. The settings that you configure

in the service order are organized in separate pages of the wizard, which you can launch

by clicking the appropriate buttons at the top of the Create or Edit a Service Order page.

Alternatively, you can proceed to the corresponding setting-related pages by clicking the

Back and Next buttons in the wizard at any point during the creation of the service order.

To create an LSP service order, youmust first discover devices that have been configured

for the LSP.

1. Configuring LSP Service Order General Settings on page 1628

2. Configuring LSP Service Order Advanced Settings on page 1631

3. Creating a Name Pattern for LSPs in the Service Order on page 1643

4. Configuring Node Parameters for LSPs in the Service Order on page 1645

5. Configuring MPLS Path Settings on page 1646

6. Configuring LSP Primary Path Settings on page 1650

7. Configuring LSP Secondary Path Settings on page 1651

8. Reviewing the Configured Settings on page 1652

Configuring LSP Service Order General Settings

As the service activator, you can configure an LSP based on a predefined LSP service

definition. Alternatively, you can create an LSP service orderwithout basing it on a service

definition, and use the service order as a starting point for provisioning LSP services. The

service activator can configure LSP settings that the service designer specified to be

editable.

To create an LSP service order, configure the general settings.

NOTE: The availability of attributes in the service order creation workflow
varies based on the service definition you select.

1. Select Service View from the View selector.

The workspaces that are applicable to routing and tunneling services are displayed.

2. From the Connectivity Services Director user interface, click the Deploy icon on the

Connectivity Services Director banner.

The functionalities that you can configure in thismodearedisplayed in theTaskspane

of the GUI window.
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3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

The different network service types that you can configure, such as E-Line, E-LAN,

and IP, are displayed.

4. From the Service View pane, click the plus sign (+) sign next to Tunnels, and select

LSPs.

The LSPs node is expanded and displayed in the View pane.

5. From the task pane, select Service Provisioning >Manage LSP.

TheManage Network Services page is displayed in on the top rightmain display area,

and the Manage Service Deployment window is displayed on the bottom of themain

display area.

6. Click the down arrow on the Newmenu and select LSPs from the drop-downmenu.

The wizard to create an LSP is displayed.

On the General Settings page of the wizard, the Service Details pane is displayed on

the left. which contains the Basic and Advanced tabs.

7. Click the Basic tab.

The general settings are displayed.

8. Configure the settings on the Basic tab as indicated in Table 256 on page 1629.

Table 256: Basic Settings

ActionItem

Type a name that identifies the LSP service order.

A service order name cannot exceed 50 characters and can contain only letters, numbers, and some special
characters.

The special characters allowed are hyphen (-), underscore (_), and period (.)

Order Name

1629Copyright © 2019, Juniper Networks, Inc.

Chapter 59: Service Design and Provisioning: Managing and Deploying Tunnel Services



Table 256: Basic Settings (continued)

ActionItem

Perform either of the following actions to specify the method to be used for creating an LSP order:

• Select the Create option to create a service order as an entirely new one.

• Select the Import option to select an available LSP service definition that you created and published, and
select a predefined service definition from the drop-down list. The LSP service definition on the LSP
Definition drop-downmenu is available for selection only if you published the service definition.

The following are the predefined LSP service definitions:

• RSVPLSPwithBFD -PathProtection—Creates anRSVPLSPservice order that protects the LSPprimary
path by establishing a secondary path with BFD as the signaling protocol

• RSVP LSPwith BFD - P2MP Topology—Creates an RSVP LSP service order with BFD as the signaling
protocol and a point-to-multipoint topology

• RSVP LSPwith Path Protection—Creates an RSVP LSP service order that protects the primary path by
establishing a secondary path

• RSVP LSPwith Node Link Protection—Creates an RSVP LSP service order that bypasses a node or link
for redundancy.

• FullMesh LSP with Node Link Protection—Creates an RSVP LSP service order in a full-mesh topology
that bypasses a node or link for redundancy.

The parameters on the different pages of the wizard are filled out with the values of parameters retrieved
from the service definition you selected. You canmodify them as needed.

LSP
Configuration

RSVP or Segment Routing is displayed as the type of LSP based on the value you choose in the NorthStar
tab of the Preferences window.

LSP Type

Select the LSP transport topology from the list:

• P2P—Provides a point-to-point connectivity between the selected endpoints

• P2MP—Provides a point-to-multipoint connectivity between the selected endpoints

• Full Mesh—Provides any-to-any unidirectional MPLS connectivity among all the selected provider edge
router

Topology

From this list, select either CSPF or Explicit Path. In Constrained Shortest Path First (CSPF) LSPS, the
intermediate hops of the LSP are automatically computed by the software.

If you select CSPF, Junos OS calculates the best path for you. In explicit-path LSPs, all intermediate hops of
the LSP are manually configured. The intermediate hops can be strict, loose, or any combination of the two.

Path Selection
Type
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Table 256: Basic Settings (continued)

ActionItem

Select the type of protection you want to configure.

Path Protection Only—Protects the LSP primary path by establishing a secondary path.

Fast reroute can be applied to the LSP if you are selecting Path Protection Only. On the Advanced page,
specify the protection type as Path Protection Only and select the Enable Fast Reroute check box in the
Common Settings section on the Advanced tab.

Local Protection Only—Provides local repair procedures that ensure faster restoration by establishing
local protection as close to a failure as possible.

Configuringonly local protection for the ingress router of theprimaryLSPcauesRSVP-traffic engineering
to indicate to LSP setup that the primary LSP needs local protection.When there is only one path for
the LSP, you can specify either link protection or node-link protection.

Path and Local Protection—Provides redundancy using a combination of path protection and local
protection options.

The primary path is protected and local repair procedures for faster redundancy is achieved using this
methodology.

LSP Protection
Type

Specify the type of protection:

Link Protection—Provides backup support for a single link.

Node-Link Protection—Can bypass a node or a link to provide redundancy.

NOTE: This drop-down is unavailable if the LSP Protection Type is Path Protection Only.

Local
ProtectionType

9. Click the Advanced tab.

The advanced settings that you can configure for the LSP service order are displayed.

Configuring LSP Service Order Advanced Settings

On the left of the General Settings page of the wizard, the Service Details pane contains

the Basic and Advanced tabs.

To configure the settings that are globally applicable throughout the LSP in the LSP

service order:

1. Click the Advanced tab on the General Settings page of the wizard to create an LSP.

The global or system-wide settings are displayed.

You can edit these parameters if you selected 'Editable in Service Order' check box

in the service definition.
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2. You can specify the following types of settings from the Advanced tab of the LSP

service order creation wizard if you choose to create a service order without creating

a service definition.

a. Common Settings—Configure the LSP retry limit, retry timer (seconds), LDP

tunneling settings, auto-bandwidth settings, protections settings, andBFDsettings.

See “Configuring Common Settings” on page 1632 for details

b. Path Settings—Configure the primary and secondary paths on one point-to-point

or several point-to-multiple-point branches. Specify the primary path to use for

an LSP. You can configure only one primary path. You can optionally specify the

preference, CoS, and bandwidth values for the primary path, which override any

equivalent values that you configure for the LSP. See “Configuring MPLS Path

Settings” on page 1646 for details.

c. BFD Settings—Configure a Bidirectional Forwarding Detection (BFD) protocol on

MPLS IPv4 LSPs. BFD is used as a periodic Operation, Administration, and

Maintenance (OAM) feature for LSPs to detect LSP data plane faults. You can

configure a BFD protocol for LSPs that use RSVP as the signaling protocol. See

“Configuring BFD Settings for LSPs in the Service Order” on page 1640 for details.

The following sections describe the advanced settings you can configure for the LSP

service order:

• Configuring Common Settings on page 1632

• Configuring LSP Path Settings in the Service Order on page 1635

• Configuring BFD Settings for LSPs in the Service Order on page 1640

Configuring Common Settings

You can use the Common Settings page to view or configure the LSP retry limit, retry

timer (seconds), LDP tunneling settings, auto-bandwidth settings, protections settings,

and BFD settings.

Each LSP has a bandwidth value. This value is included in the sender’s Tspec field in

RSVP path setupmessages. You can specify a bandwidth value in bits per second. If you

configure more bandwidth for an LSP, it should be able to carry a greater volume of

traffic.

The default bandwidth is 0 bits per second.

The ingress router might makemany attempts to connect and reconnect to the egress

router using the primary path. You can control how often the ingress router tries to

establish a connection using the primary path and how long it waits between retry

attempts. The retry timer configures how long the ingress router waits before trying to

connect again to the egress router using the primary path. The default retry time is 30

seconds. The time can be from 1 through 600 seconds. Tomodify this value, include the

retry timer parameter in the service order.

Automatic bandwidth allocation allows an MPLS tunnel to automatically adjust its

bandwidth allocation based on the volume of traffic flowing through the tunnel. You can

configure an LSPwithminimal bandwidth; this feature can dynamically adjust the LSP’s
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bandwidth allocation based on current traffic patterns. The bandwidth adjustments do

not interrupt traffic flow through the tunnel. You set a sampling interval on an LSP

configured with automatic bandwidth allocation. The average bandwidth is monitored

during this interval. At the end of the interval, an attempt is made to signal a new path

for the LSP with the bandwidth allocation set to the maximum average value for the

preceding sampling interval. If the new path is successfully established and the original

path is removed, the LSP is switched over to the new path. If a new path is not created,

the LSPcontinues to use its current pathuntil the endof thenext sampling interval,when

another attempt is made to establish a new path. Note that you can set minimum and

maximum bandwidth values for the LSP. During the automatic bandwidth allocation

interval, the router might receive a steady increase in traffic (increasing bandwidth

utilization) on an LSP, potentially causing congestion or packet loss. To prevent this, you

can define a second trigger to prematurely expire the automatic bandwidth adjustment

timer before the end of the current adjustment interval.

To configure common settings that are applicable to all LSPs in the service order:

1. On the Advanced pane of the General Settings page, click the plus sign beside the

Common Settings section.

The parameters that are applicable to all the LSPs are available for configuration.

2. Fill in the parameters as indicated in Table 257 on page 1633.

Table 257: Common Settings

ActionItem

Specify the number of times an ingress router can attempt to
establish or reestablish a connection to the egress router by
using the primary path.

This counter is reset each time a primary path is created
successfully.

When the limit is exceeded, nomore connection attempts are
made. Intervention is then required to restart the connection.

Range: 0 through 10,000

Default: No limit is set.

Thisattribute is visibleonly ifEnableNorthStarLSPManagement
is disabled in Preferences.

Retry limit

Specify how long the ingress router waits before trying to
connect again to the egress router by using the primary path.

Range: 1 through 600 seconds

Default: 30 seconds

Thisattribute is visibleonly ifEnableNorthStarLSPManagement
is disabled in Preferences.

Retry timer
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Table 257: Common Settings (continued)

ActionItem

Specify the bandwidth in Kbps.

A nonzero bandwidth requires that transit and egress routers
reserve capacity along the outbound links for the path.

The RSVP scheme is used to reserve this capacity.

Any failure in bandwidth reservation (such as failures at RSVP
policy control or admissioncontrol)might cause theLSPsetup
to fail. If there is insufficient bandwidth on the interfaces for
the transit or egress routers, the LSP is not established.

Range: Any positive integer

Default: 0 (No bandwidth is reserved.)

Bandwidth (Kbps)

Select this check box to enable LSP for LDP tunneling. That is,
if you are using RSVP for traffic engineering, you can run LDP
simultaneously to eliminate the distribution of external routes
in the core network. The LSPsestablishedby LDPare tunneled
through the LSPs established by RSVP. LDP effectively treats
the traffic-engineered LSPs as single hops.

When you configure the router to run LDP across
RSVP-established LSPs, LDP automatically establishes
sessions with the router at the other end of the LSP. LDP
control packets are routed hop by hop, rather than carried
through the LSP. This routing allows you to use simplex
(one-way) traffic-engineered LSPs. Traffic in the opposite
direction flows through LDP-established LSPs that follow
unicast routing rather than through traffic-engineered tunnels.

Thisattribute is visibleonly ifEnableNorthStarLSPManagement
is disabled in Preferences.

Enable LDP tunneling

Select this check box to enable fast reroute.

If you enable the fast reroute, the ingress router signals all the
downstream routers that fast reroute is enabled on the LSP,
and each downstream router does its best to set up detours
for the LSP. If a downstream router does not support fast
reroute, it ignores the request to set up detours and continues
to support the LSP.

A router that does not support fast reroute will cause some of
the detours to fail, but otherwise has no impact on the LSP.

Thisattribute is visibleonly ifEnableNorthStarLSPManagement
is disabled in Preferences.

Enable fast reroute
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Table 257: Common Settings (continued)

ActionItem

Select this checkbox toallowanMPLS tunnel toautomatically
adjust its bandwidth allocation based on the volume of traffic
flowing through the tunnel.

Thisattribute is visibleonly ifEnableNorthStarLSPManagement
is disabled in Preferences.

1. In the Adjust Interval field, specify the bandwidth
reallocation interval.

Range: 300 through 4,294,967,295 seconds.

Default: 86,400 seconds.

2. In the Maximum Bandwidth (Kbps) field, specify the
maximum bandwidth in Kbps or an LSP with automatic
bandwidth allocation enabled.

You canmaintain the LSP’s bandwidth betweenminimum
andmaximum bounds by specifying values.

Default: 10000 Kbps.

Range: 1 through 2147483 Kbps.

3. In the Minimum Bandwidth (Kbps) field, specify the
minimum bandwidth in Kbps or an LSP with automatic
bandwidth allocation enabled.

Default: 1000 Kbps.

Range: 1 through 2147483 Kbps.

Youmust enter the minimum bandwidth to be lower than
themaximum bandwidth.

Auto Bandwidth

3. Click theplus signbeside thePathSettings section toconfigure thepathspecifications

for the LSP.

The Path Settings section is expanded and displayed.

Configuring LSP Path Settings in the Service Order

When IP traffic enters an LSP tunnel, the ingress router marks all packets with a CoS

value, which is used to place the traffic into a transmission priority queue. On the router,

for SDH/SONET and T3 interfaces, each interface has four transmit queues. The CoS

value is encoded as part of the MPLS header and remains in the packets until the MPLS

header is removed when the packets exit from the egress router. The routers within the

LSP use the CoS value set at the ingress router. The CoS value is encoded bymeans of

the CoS bits (also known as the EXP or experimental bits). MPLS class of service works

in conjunctionwith the router’s general CoS functionality. If you do not configure anyCoS

features, the default general CoS settings are used. For MPLS class of service, youmight

want to prioritize how the transmit queues are serviced by configuring weighted

round-robin, and to configure congestion avoidanceusing randomearly detection (RED).
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When there is insufficient bandwidth to establish amore important LSP, youmightwant

to tear down a less important existing LSP to free the bandwidth. You do this by

preempting the existing LSP. Whether an LSP can be preempted is determined by two

properties associated with the LSP:

• Setup priority—Determines whether a new LSP that preempts an existing LSP can be

established. For preemption to occur, the setup priority of the new LSPmust be higher

than thatof theexistingLSP.Also, theactofpreempting theexistingLSPmustproduce

sufficient bandwidth to support the new LSP. That is, preemption occurs only if the

new LSP can be set up successfully.

• Reservation priority—Determines the degree to which an LSP holds on to its session

reservation after the LSP has been set up successfully. When the reservation priority

is high, the existing LSP is less likely to give up its reservation, and hence it is unlikely

that the LSP can be preempted.

You cannot configure an LSP with a high setup priority and a low reservation priority,

because permanent preemption loops might result if two LSPs are allowed to preempt

each other. Youmust configure the reservation priority to be higher than or equal to the

setuppriority. The setuppriority alsodefines the relative importanceof LSPson the same

ingress router. When the software starts, when a new LSP is established, or during fault

recovery, the setupprioritydetermines theorder inwhichLSPsare serviced.Higher-priority

LSPs tend to be established first and hence enjoy more optimal path selection.

To configure LSP path settings in the service order:

1. On the Advanced pane of the General Settings page, click the plus sign beside the

Path Settings section.

The LSP path parameters that are applicable to all the LSPs are available for

configuration.

2. Fill in the parameters as indicated in Table 258 on page 1636.

Table 258: Path Settings

ActionItem

Specify the hop limit of the LSP.

Range: 2 through 255.

Apathwith twohopsconsistsof the ingressandegress routers
only.

Default: Each LSP can traverse amaximum of 255 hops,
including the ingress and egress routers.

Hop limit
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Table 258: Path Settings (continued)

ActionItem

Specify a decimal number.

This number corresponds to a 3-bit binary number. The
high-order two bits of the CoS value select which transmit
queue to use on the outbound interface card. The low-order
bit of the CoS value is treated as the packet loss priority (PLP)
bit and isused toselect the randomearlydetection (RED)drop
profile to use on the output queue. If the low-order bit is 0, the
non-PLP drop profile is used, and if the low-order bit is 1, the
PLP drop profile is used.

Typically, RED aggressively drops packets that have the PLP
bit set. Formore information about RED and drop profiles, see
the Junos OS Class of Service Configuration Guide.

Range: A decimal number from 0 through 7

This field is not applicable for local-protection type of LSPs.

Class of service

Specify a bandwidth in Kbps for an LSP. Each LSP has a
bandwidth value.

This value is included in the sender’s Tspec field in RSVP path
setupmessages. The ingress router uses the traffic
specification (Tspec) object to specify the parameters for the
traffic it is going to send. You can specify a bandwidth value
in bits per second. If you configuremore bandwidth for an LSP,
it should be able to carry a greater volume of traffic.

The default bandwidth is 0 bits per second.

Bandwidth (Kbps)

Select this check box to have the path remain up at all times
to provide immediate switchover if connectivity problems
occur.

This field is displayed only for secondary paths.

Standby (enable switchover)
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Table 258: Path Settings (continued)

ActionItem

Select this check box if you want to configure an LSP to be
adaptive when it is attempting to reroute itself.

When it is adaptive, the LSPholds onto existing resources until
the new path is successfully established and traffic has been
switched over to the new LSP.

To retain its resources, an adaptive LSP does the following:

• Maintains existing paths and allocated bandwidths—This
ensures that the existing path is not torn down prematurely
and allows the current traffic to continue flowing while the
new path is being set up.

• Avoids double-counting for links that share the newand old
paths—Double-countingoccurswhenan intermediate router
does not recognize that the new and old paths belong to
the same LSP and counts them as two separate LSPs,
requiring separate bandwidth allocations. If some links are
close to saturation, double-countingmight cause the setup
of the new path to fail.
By default, adaptive behavior is disabled.

You can include the adaptive statement in two different
hierarchy levels. If you specify the adaptive statement at the
LSP hierarchy levels, the adaptive behavior is enabled on all
primary and secondary paths of the LSP. Thismeans both the
primary and secondary paths share the same bandwidth on
common links.

This check box is not available for P2MP topology and also
when the path selection type is explicit path.

Adaptive

Configure theLSP’spreemptionpropertiesbyselectingavalue
from the Setup Priority and Hold riority lists.

Priority
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Table 258: Path Settings (continued)

ActionItem

Specify a priority value, which determines whether a new LSP
that preempts an existing LSP can be established.

Forpreemption tooccur, the setuppriority of thenewLSPmust
be higher than that of the existing LSP. Also, the act of
preemptingtheexistingLSPmustproducesufficientbandwidth
to support the new LSP. That is, preemption occurs only if the
new LSP can be set up successfully.

The setup priority also defines the relative importance of LSPs
on the same ingress router. When the software starts, when a
new LSP is established, or during fault recovery, the setup
priority determines the order in which LSPs are serviced.

Higher-priority LSPs tend to be established first and hence
enjoy more optimal path selection.

This field cannot be configured for local-protection type of
LSPs.

Range: Both setup-priority and reservation-priority can be a
value from 0 through 7, where 0 is the highest priority and 7 is
the lowest priority.

Default: An LSP has a setup priority of 7 (that is, it cannot
preempt any other LSPs) and a reservation priority of 0 (that
is, other LSPs cannot preempt it).

These defaults prevent preemption.When you are configuring
these values, make sure that the setup priority value is lower
than or equal to the hold priority value.

Setup Priority

Specify a hold priority value.

The hold priority determines the degree towhich an LSP holds
onto its session reservation of the LSP that has been set up
successfully.

When the hold priority is high, the existing LSP is less likely to
give up its reservation and, therefore, it is unlikely that the LSP
can be preempted. Youmust configure the hold priority to be
greater than or equal to the setup priority.

This field cannot be configured for local-protection type of
LSPs.

Range: 0 through 7, where 0 is the highest priority and 7 is the
lowest priority.

NOTE: If traffic engineeringadmissioncontrol determines that
there are insufficient resources to accept a request to set up
a new LSP, the setup priority is evaluated against the hold
priority of existing LSPs.

An LSPwith a hold priority lower than the setup priority of the
new LSP can be preempted. The existing LSP is terminated to
make room (that is, resources are freed) for the new LSP.

Hold Priority
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Table 258: Path Settings (continued)

ActionItem

Specify a value to configure LSP path selection for RSVP
tunnels.

Thisattribute is visibleonly ifEnableNorthStarLSPManagement
is disabled in Preferences.

Tunnel Metric

Use the drop-downmenu to select a routing method.

Available options includeRouteByPCC, default, adminWieght,
delay, constant, distance, ISIS, OSPF Note:

Thisattribute is visibleonly ifEnableNorthStarLSPManagement
is disabled in Preferences.

Default: RouteByPCC

RoutingMethod

Type a value or use the up and down arrows to increment or
decrement by 100.

Thisattribute is visibleonly ifEnableNorthStarLSPManagement
is disabled in Preferences.

Max Delay

Type a value or use the up and down arrows to increment or
decrement by 100.

Thisattribute is visibleonly ifEnableNorthStarLSPManagement
is disabled in Preferences.

Max Cost

3. Click the plus sign beside the BFD Settings section to configure the BFD parameters

for the LSP.

The BFD Settings section is expanded and displayed.

Configuring BFD Settings for LSPs in the Service Order

BFD for RSVP supports unicast IPv4 LSPs. When BFD is configured for an LSP on the

ingress router, it is enabled on the primary path and on all standby secondary paths for

that LSP. The source IP address for outgoing BFD packets from the egress side of an

MPLS BFD session is based on the outgoing interface IP address. You can enable BFD

for all LSPs on a router or for specific LSPs. If you configure BFD for a specific LSP,

whatever values configured globally for BFD are overridden. The BFD sessions originate

only at the ingress router and terminate at the egress router.

The BFD failure detection timers are adaptive and can be adjusted to bemore or less

aggressive. For example, the timers can adapt to a higher value if the adjacency fails, or

a neighbor can negotiate a higher value for a timer than the configured value. The timers

adapt to a higher value when a BFD session flap occurs more than three times in a span

of 15 seconds. A back-off algorithm increases the receive (Rx) interval by two if the local

BFD instance is the reason for the session flap. The transmission (Tx) interval is increased

by two if the remote BFD instance is the reason for the session flap.
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NOTE: Note: BFD Settings tab is unavailable if Enable NorthStar LSP

Management is enabled in Preferences.

To configure BFD settings for LSPs in the service order:

1. On the Advanced pane of the General Settings page, click the plus sign beside the

BFD Settings section.

2. Fill in the parameters as indicated in Table 259 on page 1641.

Table 259: BFD Settings

ActionField

Select the BFD setting type:

• This LSP—Configure BFD settings for all of the specific LSP.

• Primary Path—Configure BFD settings for the primary path of the specific LSP.

• Secondary Path—Configure BFD settings for the secondary path of the specific LSP.

• None–Do not configure BFD settings.
By default, BFD is not configured.

NOTE: The primary path and the secondary path are listed on BFD Detectionmenu only if you have
configured the primary and secondary paths.

You canmodify the BFD Detection settings in a service.

BFD Detection

Specify the minimum transmit and receive interval.

This value represents the minimum interval at which the local routing device transmits hello packets as
well as theminimum interval that the routing device expects to receive a reply from a neighbor with which
it has established a BFD session.

Range: 1 through 255000milliseconds

Default: 50

Minimum Interval

Specify the minimum receive interval.

This value represents the minimum interval at which the peer must receive a reply from a peer with which
it has established a BFD session.

Range: 1 through 255000milliseconds

Default: 50

MinimumReceive
Interval

Specify the detection timemultiplier.

This value represents the number of hello packets not received by the neighbor before BFD declares that
the neighbor is down.

Range: 1 through 255

Default: 3

Multiplier
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Table 259: BFD Settings (continued)

ActionField

Select this check box to disable adaptation.

You can configure an LSP to be adaptive when it is attempting to reroute itself. When it is adaptive, the
LSP holds onto existing resources until the new path is successfully established and traffic has been
switched over to the new LSP.

To retain its resources, an adaptive LSP does the following:

• Maintains existing paths andallocatedbandwidths—This ensures that the existing path is not torn down
prematurely and allows the current traffic to continue flowing while the new path is being set up.

• Avoids double-counting for links that share the new and old paths—Double-counting occurs when an
intermediate router does not recognize that the new and old paths belong to the same LSP and counts
them as two separate LSPs, requiring separate bandwidth allocations.
If some links are close to saturation, double-counting might cause the setup of the new path to fail.

By default, adaptive behavior is disabled.

No adaptation

Specify the minimum transmit interval at which the local routing device transmits hello packets to a
neighbor with which it has established a BFD session.

The negotiated transmit interval for a peer is the interval between the sending of BFD packets to peers.
The receive interval for a peer is theminimum time that it requires between packets sent from its peer; the
receive interval is not negotiated between peers.

To determine the transmit interval, each peer compares its configuredminimum transmit interval with its
peer's minimum receive interval.

The larger of the two numbers is accepted as the transmit interval for that peer.

Range: 1 through 255000milliseconds

Default: 50milliseconds

TransmitMinimum
Interval

Specify the high transmit interval triggering a trap.

The threshold is used for detecting the adaptation of the transmit interval.

When the BFD session transmit interval adapts to a value greater than the threshold, a single trap and a
single systemmessage are sent.

Range: 51 through 4,294,967,295

Default: None

Transmit
Threshold

Specify the maximum time at which to trigger a trap.

Specify the threshold for theadaptationof theBFDsessiondetection time.When thedetection timeadapts
to a value equal to or greater than the threshold, a single trap and a single system logmessage are sent.

Range: 0 through 4,294,967,295

Default: None

Detection
Threshold
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Table 259: BFD Settings (continued)

ActionField

Select an action to take when a BFD session for an LSP goes down:

• Teardown—Causes the LSP path to be taken down and resignaled immediately.

• Make Before Break—Attempts to signal a new LSP path before tearing down the old LSP path.

When the BFD session for an LSP goes down, the LSP is torn down and resignaled. Traffic can be switched
to a standby LSP, or you can simply tear down the LSP path. Any actions performed are logged.

When a BFD session for an LSP path goes down, you can configure the Junos OS to resignal the LSP path
or to simply disable the LSP path. A standby LSP path could be configured to handle traffic while the
primary LSP path is unavailable. The router can automatically recover from LSP failures that can be
detected by BFD.

By default, if a BFD session fails, the event is simply logged.

Failure Action

Specify a time to wait before the LSP path is taken down and resignaled.

If you specify a value of 0 for the teardown-timeout interval, the LSP is taken down and resignaled
immediately.

Range: 0 through 30 seconds

Default: None

Teardown
Timeout

3. Specify the LSPpattern settings. See “Creating aNamePattern for LSPs in theService

Order” on page 1643 for details.

Creating a Name Pattern for LSPs in the Service Order

Instead of using an existing predefined pattern of label-switched path (LSP) names, you

can also create an LSP name of your preference or convention. The customized LSP

name includesasetofcommonvariablesandsupportedspecial characters.TheTransport

Activate softwareappendsauniquenumber to thesecustomizednametoavoidconflicts.

To specify a name pattern for LSPs in the service order:

1. On the General Settings page, with either the Advanced or Basic tab selected, click

the plus sign (+) next to LSP Pattern Details at the bottom of the page to expand the

section.

2. Click Select adjacent to the Name field to select a pattern from the list of available

patterns.

The Select LSP Name pattern dialog box appears. The dialog box displays a table,

which includes the following patterns:

• Default LSP pattern—Uses the default LSP name pattern for a point-to-point and

point-to-multipoint topology

• Full-mesh default pattern—Uses the default LSP name pattern for a full-mesh

topology
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• User-definedRSVPpatterns—CreatesanLSPnameofyourpreferenceorconvention

3. Select the check box next to the pattern to be used in the LSP service order.

4. ClickOK to save the selection.

You are returned to the LSP Pattern Details section of the General Settings page of

the wizard.

5. In the Pattern field, view the name of the selected pattern. For example, the pattern

of Default LSP Pattern is Service Order Name_to_Egress Loopback Address.

Alternatively, to create a new name pattern, click the Create button adjacent to the

Name field.

The Create LSP Name Pattern dialog box appears.

6. From the Name list, select one of the following:

• RSVP—Name pattern for RSVP LSPs.

• General—Name pattern for general LSPs.

• Static—Name pattern for static LSPs.

The specified name pattern for the type of LSP you want to configure is selected.

7. Specify the name of the pattern in the Name box.

8. In the LSP Pattern Details section, select the Select Variable option button to select

an existing variable from the Variable drop-down list. The predefined variables are

listed in the Variable drop-down list.

Alternatively, select the Add Text option button to add a new variable.

The Variable field is available for specifying the variable.

9. Click Add to add the variable to the pattern.

The variable you add is displayed in pattern name of the Pattern field.

NOTE: You can select any of the predefined variables from the Variable
drop-down list. The variables in the Variable drop-down list are based on
the Pattern Type you select.

Alternatively, click Clear to remove the variable from the Variables drop-down list.

The variable is deleted from the pattern name in the Pattern field.

10. Select the Append unique number check box to append a unique number to these

customized names you create to avoid conflicts.
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11. Click Create to add the name pattern to the LSP service.

You are returned to the General Settings page of the wizard and the pattern name

appears in the Patterns field.

The pattern is also added to the Select LSP Name Patterns inventory page, which

you can open by clicking Select beside the Name field in the LSP Pattern Details

section. You can select this pattern name in the service order from the Select LSP

Name Patterns inventory page.

NOTE: You can view the details of a pattern on the Select LSP Name
Patterns inventory page. You cannot modify an existing pattern.

12. On the General Settings page of the wizard, click Next to proceed to the next step of

the wizard, which is to define the node or endpoint settings.

The Node Settings page of the wizard is displayed.

Configuring Node Parameters for LSPs in the Service Order

On the Node Parameters page, you can configure the endpoints or nodes for the LSP

service order.

Only fields that correspond to the type of topology that you selected on the General

Settings page of the wizard are displayed on the Node Parameters page.

1. Fill in the parameters as described in Table 260 on page 1645:

Table 260: Node Parameters

ActionItem

1. ClickSelectbeside the field toopen theSelectdevicedialog
box.

2. Select the check box next to an available router that must
function as the ingress router.
The local router is always considered to be the ingress
router, which is the beginning of the LSP. The software
automatically determines the correct outgoing interface
and IP address to use to reach the next router in an LSP.
By default, the router ID is chosen as the address of the
ingress router.

MPLS-signaled label-switched paths (LSPs) run from a
specific ingress router to a specific egress router. For basic
MPLS-signaledLSPfunction, youmustconfigure the ingress
router, but do not have to configure any other routers.

This field is unavailable if the selectedLSPservicedefinition
is a full-mesh RSVP definition.

Ingress Router

1645Copyright © 2019, Juniper Networks, Inc.

Chapter 59: Service Design and Provisioning: Managing and Deploying Tunnel Services



Table 260: Node Parameters (continued)

ActionItem

1. ClickSelectbeside the field toopen theSelectDevicedialog
box. The Select button is available only for P2P topology.

2. Select an available router thatmust function as the egress
router in the LSP connection established using the primary
path from the ingress router. For a point-to-point topology,
select one egress router.

3. If the topology is a point-to-multipoint LSP topology, click
Add in the Egress Routers table to open the Select Device
dialog box.

NOTE: The Egress Routers table is available only for P2MP
topology. Select multiple routers to function as egress
routers for the point-to-multiple-point topology.

To delete an egress router added to the LSP service, select the
device, andclickDeleteabove the tableof listedegress routers.

Egress Router

This field is available only for full-mesh LSP topology.

1. If the topology is a full-mesh LSP topology, clickAdd in the
Egress Routers table to open the Select Device dialog box.
The Egress Routers table is available only for P2MP
topology. Select multiple routers to function as egress
routers for the point-to-multiple-point topology.

2. To delete an egress router added to the LSP service, select
the device, and clickDelete above the table of listed egress
routers.

Select Devices

2. ClickNext toproceed to thenextpageof thewizard,which is to configurepath settings.

The Path Settings page of the wizard is displayed.

ConfiguringMPLS Path Settings

The Path Settings page of the service order creation wizard enables you to view existing

paths or add, edit, or delete new paths.

NOTE: ThePathSettings tab isdisabled ifEnableNorthStarLSPManagement

is selected in the Preferences tab.

1. Fill in the parameters as indicated in Table 261 on page 1646 under the Primary and

Secondary tabs of the Path Parameters page.

Table 261: MPLS Path Settings

ActionItem

Define the path to be either automatic path selection or a new path name. If you do not configure both primary
and secondary paths for an LSP, MPLS uses an automatic path selection algorithm.

Path Name
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Table 261: MPLS Path Settings (continued)

ActionItem

(Optional) Select this option from the Path Name list for an automatic path to be used for the LSP.Automatic

(Optional) Click this button create a new path.

The Create MPLS Path dialog box is displayed.

To add one or more new paths:

1. Type a name in the Path Name text box.

2. Select whether you want the LSP path to be Loose or Strict.

To configure complete path information, specify every router hop between the ingress and egress routers,
preferably by selecting the Strict attribute. To configure incomplete path information, specify only a subset
of router hops. Select the Loose attribute in places where the path is incomplete. For incomplete paths, the
MPLS routers complete thepathbyquerying the local routing table. This query is performedonahop-by-hop
basis, andeach router canobtainonlyenough information to reach thenextexplicit hop. Itmightbenecessary
to traverse a number of routers to reach the next (loose) explicit hop.

3. Type an IP address in the IP address text box.

4. Click Add to add the path to the table that displays all the configured paths. Alternatively, select a path from
the table and click Delete to remove the path for the LSP.

Create New

Specify the hop limit of the LSP.

Range: 2 through 255.

A path with two hops consists of the ingress and egress routers only.

Default: Each LSP can traverse amaximum of 255 hops, including the ingress and egress routers.

Hop limit
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Table 261: MPLS Path Settings (continued)

ActionItem

Select one of the following values to specify the class of service (CoS) type for the LSP:

• Background—Background type applications such as e-mail and FTP; has a CoS value of 1

• Best Effort—Traffic to be transmitted as a best-effort type; has a CoS value of 0

• Excellent Effort—Traffic to be transmitted as an excellent-load type; has a CoS value of 3

• CriticalApplications—Traffic to ensureahigh-quality user experience for users of business-critical applications;
has a CoS value of 2

• Video < 100ms—Streaming type applications such as video on demand andmultimedia messaging; has a
CoS value of 5

• Voice < 10ms—Voice messaging such as VoIP; has a CoS value of 6

• Internetwork Control—Packets with internetwork control precedence; has a CoS value of 4

• Network Control—Packets with network control precedence; has a CoS value of 7.

CoS enables both subscribers and services to be differentiated from each other. Premium subscribers can be
prioritized over basic subscribers, while real-time services can be prioritized over non-real-time services. The
importance of QoS increases during periods of congestion. An unloaded network canmeet the needs of all
subscribers and services. However, as the network load increases, the prioritization of traffic determineswhether
performance for subscribers and services can bemaintained or be degraded.

The high-order 2 bits of the CoS value select which transmit queue to use on the outbound interface card. The
low-order bit of the CoS value is treated as the PLP bit and is used to select the RED drop profile to use on the
output queue. If the low-order bit is 0, the non-PLP drop profile is used, and if the low-order bit is 1, the PLP drop
profile is used. Typically, RED aggressively drops packets that have the PLP bit set. For more information about
RED and drop profiles, see the Junos OS Class of Service Configuration Guide.

This field is not applicable for local-protection type of LSPs.

Class of
service

Specify a bandwidth in Kbps for an LSP. Each LSP has a bandwidth value. This value is included in the sender’s
Tspec field in RSVP path setupmessages. You can specify a bandwidth value in bits per second. If you configure
more bandwidth for an LSP, it should be able to carry a greater volume of traffic.

The default bandwidth is 0 bits per second.

Bandwidth
(Kbps)

Select this check box to have the path remain up at all times to provide immediate switchover if connectivity
problems occur.

This check box is displayed only for secondary paths.

Standby
(enable
switchover)

Select this check box if youwant to configure an LSP to be adaptivewhen it is attempting to reroute itself.When
it is adaptive, the LSP holds onto existing resources until the new path is successfully established and traffic
has been cut over to the new LSP. To retain its resources, an adaptive LSP does the following:

• Maintains existing paths and allocated bandwidths—This ensures that the existing path is not torn down
prematurely and allows the current traffic to continue flowing while the new path is being set up.

• Avoids double-counting for links that share the new and old paths—Double-counting occurs when an
intermediate router does not recognize that the new and old paths belong to the same LSP and counts them
as two separate LSPs, requiring separate bandwidth allocations. If some links are close to saturation,
double-counting might cause the setup of the new path to fail.
By default, adaptive behavior is disabled.

You can include the adaptive statement in two different hierarchy levels. If you specify the adaptive statement
at the LSP hierarchy levels, the adaptive behavior is enabled on all primary/secondary paths of the LSP. This
means both the primary and secondary paths share the same bandwidth on common links.

This check box cannot be selected for P2MP topology and also when the path selection type is explicit path.

Adaptive
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Table 261: MPLS Path Settings (continued)

ActionItem

Configure the LSP’s preemption properties by selecting a value from the Setup Priority and Hold Priority lists.Priority

Specify a priority value,which determineswhether a newLSP that preempts an existing LSP canbe established.
For preemption to occur, the setup priority of the new LSPmust be higher than that of the existing LSP. Also,
the act of preempting the existing LSPmust produce sufficient bandwidth to support the new LSP. That is,
preemption occurs only if the new LSP can be set up successfully. The setup priority also defines the relative
importance of LSPs on the same ingress router. When the software starts, when a new LSP is established, or
during fault recovery, the setup priority determines the order in which LSPs are serviced. Higher-priority LSPs
tend to be established first and hence enjoy more optimal path selection.

This field cannot be configured for local-protection type of LSPs.

Range:Both setup-priority and reservation-priority canbeavalue from0through7,where0 is thehighest priority
and 7 is the lowest priority.

Default: An LSP has a setup priority of 7 (that is, it cannot preempt any other LSPs) and a reservation priority of
0 (that is, other LSPs cannot preempt it).

These defaults prevent preemption. When you are configuring these values, make sure that the setup priority
value is lower than or equal to the hold priority value.

Setup
Priority

Specify a hold priority value.

This field cannot be configured for local-protection type of LSPs.

Range: 0 through 7, where 0 is the highest priority and 7 is the lowest priority.

The hold priority determines the degree to which an LSP holds onto its session reservation of the LSP that has
been set up successfully. When the hold priority is high, the existing LSP is less likely to give up its reservation
and, therefore, it is unlikely that the LSP can be preempted.

Youmust configure the hold priority to be greater than or equal to the setup priority.

NOTE: If traffic engineering admission control determines that there are insufficient resources to accept a
request to set up a new LSP, the setup priority is evaluated against the hold priority of existing LSPs. An LSP
withaholdpriority lower than the setuppriority of thenewLSPcanbepreempted. TheexistingLSP is terminated
to make room (that is, resources are freed) for the new LSP.

Hold Priority

2. View any administrative groups that are configured on the device. You can configure

any new administrative groups.

Administrative groups, also known as link coloring or resource class, are manually

assigned attributes that describe the color of links, such that linkswith the same color

conceptually belong to the same class. You can use administrative groups to

implementavarietyofpolicy-basedLSPsetups.Administrativegroupsaremeaningful

only when constrained-path LSP computation is enabled (CSPF, instead of Explicit

Path).

You can assign up to 32 names and values (in the range 0 through 31), which define

a series of names and their corresponding values. The administrative names and

values must be identical across all routers within a single domain.

If all interfaces are set to green or yellow, they are all appropriate to be used. The

primary path must transit green or yellow links andmust stay away from red links.
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Theprimary path is periodically recomputedand reoptimized. Finally, this path always

keeps the secondary path in hot-standby state for quick failover. You can exclude the

red interfaces or links from being part of the LSP.

Fill in the parameters as indicated in the following table under theAdminGroups table

of the Path Settings page.

ActionField

Select an administrative group from themenu to specify that the LSPmust traverse links that
include all of the defined administrative groups.

Include-all

Select an administrative group from themenu to define the administrative groups to include in an
LSP or a path’s primary and secondary paths.

Include-any

Select an administrative group from themenu to define the administrative groups to exclude from
an LSP or a path’s primary and secondary paths.

Exclude

3. Click Next to proceed to the final step of the wizard, which is to review the configured

settings.

The Review page of the wizard is displayed.

Alternatively, click the Primary tab to define the primary path settings of the LSP.

Configuring LSP Primary Path Settings

This page is unavailable if the value in the LSP protection type field is Local Protection

Only.

On the Path Settings page, click the Primary tab. The LSP Primary Path Settings page

enables you to configure primary paths on one point-to-point or several

point-to-multiple-point branches. Specify the primary path to use for an LSP. You can

configure only one primary path. You can optionally specify the preference, CoS, and

bandwidth values for the primary path, which override any equivalent values that you

configure for the LSP.

The settings that you configured in the selected LSP service definition populate the fields

on this page. If you chose to create a custom LSP service order on the General Settings

page of the wizard, the fields are not populated.

1. Fill in the parameters as indicated in Table 262 on page 1651.
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Table 262: LSP Primary Path Settings

ActionItem

Select a primary path from the LSPs pane on the left. Based on the Topology type, the paths are listed
in the following pattern:

• P2P topology
Ingress router–> Egress router

• P2MP topology
Ingress router–> Egress router 1

Ingress router–>Egress router 2

• Full Mesh topology
Router 1–> Router 2

Router 2–> Router 1

Primary Path

From the list, select the path name that you want. This is a required field.

For a primary path Ingress router–> Egress router , the Path Name list contains the paths on the ingress
router.

Path Name

Configure any primary path setting that you selected in the LSP service definition to

beeditable in theLSPserviceorder. Youcannot changeany setting that youconfigured

in the LSP service definition to not be editable.

2. Click the Secondary tab on the Node Settings page.

The LSP Secondary Path Settings page appears.

Configuring LSP Secondary Path Settings

This page is unavailable if the value in the LSP protection type field is Local protection

only, or if the value in the Topology field is P2MP.

On the Path Settings page, click the Secondary tab. The LSP Secondary Path Settings

page enables you to configure primary paths on one point-to-point or several

point-to-multiple-point branches. The settings that you configured in the selected LSP

service definition populate the fields on this page. The fields are not populated with

values if you chose to create a custom LSP service order on the General Settings page

of the wizard.

1. Fill in the parameters as indicated in Table 263 on page 1651.

Table 263: LSP Secondary Path

ActionItem

Select a secondary path from the LSPs pane on the left. Based on the Topology type, the paths are
listed in the following pattern:

• P2P topology
Ingress router–> Egress router

• Full Mesh topology
Router 1–> Router 2

Router 2–> Router 1

Secondary Path
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Table 263: LSP Secondary Path (continued)

ActionItem

From the list, select the path name that you want. This is a required field.

For aprimarypath Ingress router–>Egress router , thePathName list contains thepathson the ingress
router.

Path Name

Configure any secondary path setting that you selected in the predefined LSP service

definition to be editable in the LSP service order.

2. Click Next to proceed to the final step of the wizard, which is to review the configured

settings.

The Review page of the wizard is displayed.

Reviewing the Configured Settings

The Review page of the service definition or service order creation andmodification

wizards enable you to view and evaluate the service parameters and components you

configured in the preceding steps or on the preceding pages of the wizard. This page

provides a comprehensive, single-page view of all the service elements configured using

the different pages of the wizard. You can either click the buttons corresponding to the

various settings at the top of the wizard page to directly traverse to the page you want

to modify or click the navigation buttons at the bottom of the wizard page to go to the

different pages of the wizard.

To examine the configured settings, andmodify them as needed:

1. Click Review to view the defined parameters.

You can examine andmodify the created service order parameters. Alternatively, click

the corresponding buttons at the top of the wizard page to navigate to the specific

pages that pertain to the settings you want to modify.

2. Click Edit beside any of the sections to modify the parameters corresponding to that

section.

You are taken to the page pertaining to the parameter in the wizard.

3. Click Finish to save the service order.

4. Click Back to return to the previous page of the wizard; otherwise, click Cancel to

discard the changes.

The service order inventory window appears.
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Creating Public and Private LSPs

• Managing Public LSPs by using NorthStar Controller on page 1653

• Creating Private LSPs by Using Connectivity Services Director on page 1653

Managing Public LSPs by using NorthStar Controller

From Connectivity Services Director Release 3.0 onward, you canmanage public LSPs

that are created by using Tunnel services, through NorthStar Controller. These LSPs can

be used by any service or service instance deployed on a device and are not specific to

a service.

If the Enable NorthStar Manangement check box is selected in Preferences, the LSPs are

created through Connectivity Service Director and deployed on the device by using

NorthStar Controller.

For information on creating a public LSP service definition, see “Creating an LSP Service

Definition” on page 1618.

For information on creating a public LSP service order, see “Creating an LSP Service

Order” on page 1627.

Creating Private LSPs by Using Connectivity Services Director

From Connectivity Services Director Release 3.0 onward, you can create LSPs that are

specific to a service.

The LSP association check box in the General Settings tab of the service order creation

workflow enables you to create or associate LSPs specific to the service you choose.

If there are several termsmapping different VPNs to different LSPs, there must be a

corresponding except keywordat the endof thepolicy statement toprevent themapping

of other VPNs to the LSPs.

Sample Policy
policy-statement lsp-install {
    term 0 {
        from community VPN1;
        then {
            install-nexthop lsp testlsp
            accept;
        }
    }
    term 1 {
        then {
            install-nexthop except lsp testlsp
        }
    }
}

Alternatively, you can use the associate keyword to associate the LSP, instead of the

except keyword.
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For information about creating a private LSP by using E-Line service, see “Creating an

E-Line Service Order” on page 784 .

For information about creating a private LSP by using multipoint-to-multipoint E-LAN

service, see “Creating a Multipoint-to-Multipoint E-LAN Service Order” on page 827.

For information about creating a private LSP by using point-to-multipoint E-LAN service,

see “Creating a Point-to-Multipoint E-LAN Service Order” on page 847.

For information about creating a private LSP by using full mesh IP service, see “Creating

a Full Mesh IP Service Order” on page 879.

For information about creating a private LSP by using hub-and-spoke IP service, see

“Creating a Hub-and-Spoke IP Service Order” on page 901.

Viewing the Configured LSP Services

To view and determine the status of LSP services in a tabular form:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Junos Space user interface, click the Build icon in the Connectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. In the Network Services > Tunnel task pane, select Service Provisioning > View LSPs.

TheViewLSPServicespage isdisplayedwitha tableof serviceson thesystemappears

in the bottompane of themain display area. The following fields are displayed on this

page:

Table 114 on page 767 describes the fields in the View LSP Services table.

Table 264: Fields in the Services Table

DescriptionField

Name of the service order assigned during
service creation or edit.

Name

Label-switched path (LSP)Service Type
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Table 264: Fields in the Services Table (continued)

DescriptionField

State of the service:

• Active—Denotes a service that has been
deployed and is in an active state (enabled).

• Inactive–Denotes a service that has been
deployed and is in a deactivated state
(disabled.

• Pending—Denotes a service for which
deployment of the service to a device is
pending to be performed.

• Failed—An attempt to modify the service
failed.

State

Status of functional audit of the service.FA Status

Fault management status of the service.Fault Status

Service-level agreement status of the service.
If data exceeds the threshold value specified in
the Threshold Alarm Profile, the system
generates a threshold alarm. The value in the
SLA Status column changes to SLA Violated. If
the data does not cross the threshold value
specified in the Threshold Alarm Profile, the
value in the SLAStatus column changes to SLA
Violation Cleared.

SLA Status

Performancemanagementstatusof theservice.PM Status

Name of the service definition upon which the
service order is based.

Definition

Date and time at which the service order was
last activated.

Activation Date

Date and time at which the profile was last
updated.

Last Modified Time

In the View pane, if you select the Tunnel item in the tree under Network Services,

without expanding the tree and selecting a specific service type, such as RSVP LSPs,

the top pane displays a set of five pie charts that enable you to view the different

service orders configured, and their associated audit andmonitoring statuses. The FA

Status chart displays the functional audit status for the service orders. The Device

State graph displays the statuses of devices on which services are being provisioned

andcommissioned.TheFaultStatuschartdisplays theconnectivity faultmanagement

details for theserviceorders.TheSLAStatuschartdisplays theservice-levelagreement

details for the service orders. The PM Status chart displays the performance

management details for the service orders. The count or percentage of service orders

in the pie chart segments sum up to the total number of configured service orders.

Mouse over each segment of the pie to view the number corresponding to the
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percentage of service orders for each of the charts. These charts provide a visual

overviewof customers and service orders on your network, and enables you to quickly

access related and commonly needed information. For example, you can check for

failed service orders and then access a list of failed requests so you can begin to take

restoration measure.

5. To view details of a specific service, double-click the table row that summarizes the

service.

Modifying an Explicit Path in RSVP LSP Services

In explicit routing, the route the label-switched path (LSP) takes is defined by the ingress

node. The path consists of a series of hops defined by the ingress label-switching router

(LSR). Each hop can be a traditional interface, an autonomous system, or an LSP. You

can choose a new explicit path from the existing paths, create andmap a new explicit

path, anddelete the explicit pathassociatedwithRSVPservice.Whenexplicit-path LSPs

are configured, the LSP is established along the path you specified.

The Path Settings page of the service order modification wizard enables you to view

existing paths or add, edit, or delete paths.

To configure an explicit-path LSP:

1. Select Service View from the View selector.

The workspaces that are applicable to routing and tunneling services are displayed.

2. From the Connectivity Services Director user interface, click the Deploy icon on the

Connectivity Services Director banner.

The functionalities that you can configure in thismodearedisplayed in theTaskspane

of the GUI window.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. From the Service View pane, click the plus sign (+) sign next to Tunnels, and select

RSVP LSPs.

5. From the Tasks pane, select Service Provisioning >Manage LSP. TheManage Network

Services page is displayed in on the top right main display area, and the Manage

Service Deployment window is displayed on the bottom of the main display area.

6. Select an RSVP service and clickModify. The Modify LSP service wizard appears.

Copyright © 2019, Juniper Networks, Inc.1656

Connectivity Services Director User Guide



NOTE: Youcanmodify theprimarypathor thesecondarypathofanRSVP
service only.

7. Navigate to the Path Settings page of the wizard.

This page is unavailable if the LSP protection type is Local Protection Only.

From the Path Settings page, click the Primary tab. The LSP Primary Path Settings

page enables you to configure primary paths on one point-to-point or several

point-to-multiple-point branches. Specify the primary path to use for an LSP. You

can configure only one primary path. You can optionally specify preference, CoS, and

bandwidth values for the primary path, which override any equivalent values that you

configure for the LSP.

FromthePathSettingspage, click theSecondary tab. TheLSPSecondaryPathSettings

page enables you to configure primary paths on one point-to-point or several

point-to-multiple-point branches. The settings that you configured in the selected

LSP service definition populate the fields on this page. The fields are not populated

with values if you chose to create a custom LSP service order in the General Settings

page of the wizard.

8. Modify the primary and secondary path.

Tomodify the primary or secondary path:

a. Select a primary path or secondary path from the LSPs pane on the left. Based on

the Topology type, the paths are listed in the following pattern:

• P2P topology

Ingress router–> Egress router

• Full Mesh topology

Router 1–> Router 2

Router 2–> Router 1

b. Select the Automaticradio button for an automatic path to be used for the LSP for

the primary path or secondary path.

9. Create a new path.

To create a new primary or secondary path:

a. Select the Create New radio button to create a new path. The fields to create a

new path are displayed in the Path Name section.

b. Specify the following fields:

• Path Name—Name of the new path

• IP address—IP address of the new path

• Loose/Strict—Explicit Route Objects (EROs) type.

1657Copyright © 2019, Juniper Networks, Inc.

Chapter 59: Service Design and Provisioning: Managing and Deploying Tunnel Services



EROs limit LSP routing to a specified list of LSRs. By default, RSVPmessages

follow a path that is determined by the network IGP's shortest path. However,

in the presence of a configured ERO, the RSVPmessages follow the path

specified. EROs consist of two types of instructions: loose hops and strict hops.

Whena loosehop is configured, thehopdenotesoneormore transit LSRs through

which the LSPmust be routed. Thenetwork IGPdetermines the exact route from

the inbound router to the first loose hop, or from one loose hop to the next. The

loose hop specifies only that a particular LSR be included in the LSP.

When a strict hop is configured, the hop identifies an exact path through which

the LSPmust be routed. Strict-hop EROs specify the exact order of the routers

through which the RSVPmessages are sent.

c. Click Add to add the new path.

The new path now appears in the primary and secondary paths list.

10. ClickModify.

Connectivity Services Director modifies the explicit path of a RSVP LSP service. If the

path is topologically not feasible, either because the network is partitioned or insufficient

resources are available along some parts of the path, the LSP fails. No alternative paths

can be used.

If the setup succeeds, the LSP stays on the defined path indefinitely.

NOTE: Select the ViewDeployment Jobs option on the tasks pane in Deploy
mode to check whether the deployment jobs completed successfully.

Modifying an RSVP LSP Service

You canmodify the name of a RSVP LSP service. After modifying a service, the

configuration audit and functional audit information is cleared and the functional audit

status is set to pending.

Tomodify the attributes of a service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Fromthe JunosSpaceuser interface, click theDeploy iconon theConnectivityServices

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.
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4. From the Service View pane, click the plus sign (+) sign next to Tunnels, and select

RSVP LSPs.

5. From the task pane, select Service Provisioning >Manage LSP. The Manage Network

Serviceswindow is displayed in the toppart of the right pane, and theManageService

Deployment window is displayed in the bottom part of the right pane.

6. Select an RSVP service, and clickModify. The Modify LSP service wizard appears.

NOTE: Youcanmodify theprimarypathor thesecondarypathofanRSVP
service only.

7. Modify the fields.

For example, you can enable or disable BFD for a BFD LSP service.

NOTE: You canmodify only those fields, which are editable in the service
order.

The Full Mesh template implementation supports the generic attributes (at device

level) that are common across LSPs.

NOTE: You cannot assign specific values to each of the LSPs, because
the Full Mesh template design does not support such amodification.

For a RSVP LSP service, you can also modify the primary and secondary path. For

more information onmodifying the paths, see “Modifying an Explicit Path in RSVP

LSP Services” on page 1656.

For a full mesh RSVP service you can add or delete the devices.

8. ClickModify.

The software modifies the service.

9. Use the Jobs workspace to check for successful completion of the action.
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Viewing LSP Services in DeployMode

To view and determine the status of LSP services in a tabular form:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the tree and select the type of

service.

4. In the Network Services > Tunnel task pane, select Service Provisioning > Deploy

Services.

The Manage LSP Services page is displayed in the upper half of the window.

A table of services on the system appears in the main display area. The following

fields are displayed on this page:

In the top half of the window on the right pane, the Manage Network Services page

presents information on existing services in a table.

TheManageLSPServicespageprovides the following information about each service:

Table 114 on page 767 describes the fields in the service orders table.

Table 265: Fields in the Services Table

DescriptionField

Name of the service order assigned during service creation or edit.Name

Label-switched path (LSP)Service Type

Name of the enterprise customer who placed an order for the service.Customer

State of the service:

• Active—Denotes a service that has been deployed and is in an active
state (enabled).

• Inactive–Denotes a service that has been deployed and is in a
deactivated state (disabled.

• Pending—Denotes a service for which deployment of the service to a
device is pending to be performed.

• Failed—An attempt to modify the service failed.

Deployment State

Status of functional audit of the service.FA Status

Fault management status of the service.Fault Status
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Table 265: Fields in the Services Table (continued)

DescriptionField

Service-level agreement status of the service. If data exceeds the
threshold value specified in the Threshold Alarm Profile, the system
generates a threshold alarm. The value in the SLA Status column
changes to SLA Violated. If the data does not cross the threshold value
specified in the Threshold Alarm Profile, the value in the SLA Status
column changes to SLA Violation Cleared.

SLA Status

Performancemanagement status of the service.PM Status

Name of the service definition upon which the service order is based.Definition

Date and time at which the service order was last activated.Activation Date

Date and time at which the profile was last updated.Last Modified Time

From this page, you can create a service order, modify the properties of the service

order, conduct a functional or configuration audit, deploy or deactivate the service

order, and view alarms associated with a particular service order for debugging and

corrective action.

5. To view details of a specific service, double-click the table row that summarizes the

service.

Viewing LSP Service Orders in a Table

To view and determine the status of LSP service orders in a tabular form:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the Network Services > Tunnel

> LSPs tree and select the type of service.

4. in the Network Services > Tunnel > LSPs View pane, select Service Provisioning >

Manage LSP.

The Manage LSP Deployment page is displayed on the right pane.

A table of service orders on the systemappears in themaindisplay area. The following

fields are displayed on this page:
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• Name—Unique name assigned to the service.

• Customer—Name of the customer for which the service is provided.

• State:

• Completed—Service order has been successfully deployed.

• Failed—Device is down or the Connectivity Services Director application was

unable to push the service configuration to a device configured for the service.

• In-progress—Connectivity Services Director application is in the process of

deploying the service.

• Requested—Service provisioner has created the service order, but has not yet

attempted to deploy it or schedule it for deployment.

• Scheduled—Service provisioner has scheduled the service order for deployment.

• Invalid—Service order contains invalid data.

• Validated—When all the information in the service order is successfully validated,

the service order transitions to the Validated state.

• Service Type:

• LSP (Label-switched path)

• Latest Job—Unique identifier assigned by the system for a deployment job. Click

the link in the job ID to open the CSDDeployment Jobs. The table on that page lists

configuration deployment jobs.

• Signaling Type:

• BGP

• LDP

• Created By—The screen name of the user who created the service order

• Created Date—The date and when you created the service order.

From this page, you can create a service order, modify the properties of the service

order, conduct a functional or configuration audit, deploy or deactivate the service

order, and view alarms associated with a particular service order for debugging and

corrective action.

5. To view details of a specific service order, double-click the table row that summarizes

the service order.

Deactivating an LSP Service

Thisproceduredisablesa service for aparticular protocol that youhavepreviously created

on the network. By disabling a service, the traffic processing for the traversed packets is

impacted. In certain network topologies, youmight require a service-related settings to

be disabled for a certain period to perform troubleshooting or modification to the

traffic-handlingmethod, and youmight want to reactivate a disabled service later when
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you have completed networkmaintenance and analysis work. In such a case, it might be

beneficial to use the deactivation functionality for a service order. When you disable a

service, the configuration attributes associated with such a service are deactivated and

commented out in the device settings. The deactivated service is propagated to the

devices associated with the service. To disable a service, the service must not contain

any pending or uncommitted changes. Also, the service must be in the Deployed or

Re-Activated state.

NOTE: Tomodify a service order, it must not be in the Deactivated state.

To deactivate a service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnel to view services based on protocols, and expand

the LSPs tree to select an LSP service.

5. From the task pane, selectServiceProvisioning>ManageLSP. The toppart of the right

pane displays theManage LSPNetwork Services page, with the table of services, and

the bottompart of the right pane displays theManage LSPService Deployment page,

with the table of service orders.

6. From theManageNetwork Services page, select the check box next to the service you

want to deactivate.

7. Click thedownarrowon theActionmenu, above the tableof listed services, and select

Deactivate to disable the selected service. A dialog box is displayed prompting you to

confirm your action.

8. Do one of the following in the Confirmation dialog box:

• To deactivate the service immediately, select Deactivate now, and click Yes. If you

clickYes, apendingchange request is created for eachselectedservice.Alternatively,

if you click No, the deactivate operation is discarded.

• To deactivate the service at a later time, select Deactivate later, and select a date

and time for deployment, then click OK. The time field specifies the time kept by
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the server, but in the time zone of the client. After scheduling the service order for

deactivation, the provisioning software begins validating the service order.

9. Use the Jobs workspace to monitor the outcome of the deployment.

Related
Documentation

Reactivating a Service on page 810•

• Force-Deploying a Service on page 812

• Decommissioning a Service on page 816

Reactivating an LSP Service

After you disable a service to deactivate the configuration settings on devices mapped

to the service, youmight require the service settings to be reenabled after you have

modified the service parameters, either directly on the device or using the Connectivity

Services Director application. In such a case, you can use the reactivation functionality

to revive and activate the service properties on devices. To disable a service, the service

must not contain any pending or uncommitted changes. Also, the servicemust be in the

Deactivated state.

To reactivate a service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnel to view services based on protocols, and expand

the LSPs tree to select an LSP service.

5. From the task pane, selectServiceProvisioning>ManageLSP. The toppart of the right

pane displays theManage LSPNetwork Services page, with the table of services, and

the bottompart of the right pane displays theManage LSPService Deployment page,

with the table of service orders.

6. From theManageNetwork Services page, select the check box next to the service you

want to reactivate.
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7. Click the downarrowon theActionmenu, above the table of listed service orders, and

select Reactivate to reenable the selected service order. A dialog box is displayed

prompting you to confirm your action.

8. Do one of the following in the Confirmation dialog box:

• To reactivate the service immediately, select Reactivate now, and click Yes. If you

click Yes, the selected service is activated immediately. Alternatively, if you click

No, the deactivate operation is discarded.

• To reactivate the service at a later time, select Reactivate later, and select a date

and time for reactivating, then click OK. The time field specifies the time kept by

the server, but in the time zone of the client.

9. Use the Jobs workspace to monitor the outcome of the deployment.

Related
Documentation

Reactivating a Service on page 810•

• Force-Deploying a Service on page 812

• Decommissioning a Service on page 816

Force-Deploying an LSP Service

When a service fails a configuration audit because configuration changes on a PE device

do notmatch the configuration required for the service, you can force-deploy the service

to push the configuration to the device.

Force deployment pushes the same configuration to the device that was pushed during

thedeployment of the service, thus allowing theoperator to recover fromastate inwhich

the configuration on the device was lost or changed out-of-band.

The validation before generating the configuration for a force-deployed service orderwill

be performed against the current configuration on the device and the configuration is

not pushed if the validation fails. If the forced deployment is unable to push the

configuration again, then youmight need to manually configure the device.

This procedure forces deployment of a service on the network.

You cannot force-deploy an invalid service order.

To schedule a service for forced deployment:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.
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3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnel to view services based on protocols, and expand

the LSPs tree to select an LSP service.

5. From the task pane, selectServiceProvisioning>ManageLSP. The toppart of the right

pane displays theManage LSPNetwork Services page, with the table of services, and

thebottompart of the right panedisplays theManageServiceDeployment page,with

the table of service orders.

6. From theManage LSPNetworkServices page, select the check box next to the service

you want to forcibly deploy.

The top pane displays information about the services that have been previously

created, such as the nameof the service, the functional audit status, the performance

management status, and the deployment state of the service. You canmodify the

properties of the service, conduct a functional or configuration audit, force-deploy or

deactivate the service, and view alarms associated with a particular service order for

debuggingandcorrectiveaction. Services canbe inoneof the following service states:

• Completed—The service order has been successfully deployed.

• Scheduled for deployment—Theserviceprovisioner has scheduled the serviceorder

for deployment.

• Deployment Failed—An attempted service deployment was not successfully

completed or failed an audit.

• In Progress—The Connectivity Services Director application is in the process of

deploying the service.

• Requested—The service provisioner has created the service order, but has not yet

attempted to deploy it or schedule it for deployment.

• Invalid—The service order is not valid.

7. Open the Actionsmenu and click Force Deploy Service.

The Schedule Force Deploymentwindow appears.

8. To deploy the service immediately, select Force deploy now, and clickOK .

To deploy the service at a later time, select Force deploy later, select a date and time

for deployment, then clickOK.

The time field specifies the time kept by the server, but in the time zone of the client.

After scheduling the service order for deployment, the provisioning software begins

validating the service order.

9. Use the Jobs workspace to monitor the outcome of the forced deployment.
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Related
Documentation

Deactivating a Service on page 809•

• Reactivating a Service on page 810

• Decommissioning a Service on page 816

Viewing Alarms for an LSP Service

Activity on a network device consists of a series of events. A software component on the

network device, called an entity, is responsible for running the Simple Network

ManagementProtocol (SNMP) to log andmonitor these events. You can view thedetails

of alarms and events generated for a particular service order to examine and diagnose

theproblems thataregenerating thealarms.Thesealarmsprovideessential andcohesive

informationaboutsystemconditions,anydiscrepanciesandmalfunctioning,andprotocols

or components thatneed tobeexaminedanddebugged forbetter efficiencyandworking

capacity

To view alarm and event details for a service:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Junos Space user interface, click the Build icon in the Connectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. Click the plus sign (+) beside Tunnel to view services based on protocols, and expand

the LSPs tree to select an LSP service.

4. From the task pane, selectServiceProvisioning>ManageLSP. The toppart of the right

pane displays the Manage Network Services page, with the table of services, and the

bottom part of the right pane displays the Manage Service Deployment page, with

the table of service orders.

5. Select the check box next to the service for which you want to view alarm details.

6. Click the View Alarms button, above the table of listed services.

The Alarm Detail dialog box is displayed.

7. ClickCloseafter you finishevaluating the information to return to theManageNetwork

Services page.

Related
Documentation

Alarm Detail Monitor (Service View) on page 1208•

1667Copyright © 2019, Juniper Networks, Inc.

Chapter 59: Service Design and Provisioning: Managing and Deploying Tunnel Services



Managing Deployment of LSP Services Configuration to Devices

When youmake configuration changes in Build mode, the changes are not deployed to

devicesautomatically.Youmustmanuallydeploy thechanges todevices inDeploymode.

To start deploying configuration changes:

1. From the View selector, select Service View. The workspaces that are applicable to

this view are displayed.

2. Click Deploy in the Connectivity Services Director banner.

3. Click the plus sign (+) beside Tunnel to expand the tree in the View pane and view

the list of service types.

4. Expand the LSPs tree to view the list of LSPs.

5. In the Tasks pane, select Service Provisioning >Manage LSP. TheManage LSP Service

Deployment window is displayed in the bottom part of the right pane.

TIP: From Build mode of Service View, in the View pane, if you select the
Connectivity item in the tree under Network Services, without expanding
the tree and selecting a specific service type, such as E-Line Services, IP
Services, or E-LAN Services, the top pane displays a set of five pie charts
that enable you to view the different service orders configured, and their
associated audit andmonitoring statuses. The FA Status chart displays
the functional audit status for the service orders. The Device State graph
displays the statuses of devices on which services are being provisioned
and commissioned. The Fault Status chart displays the connectivity fault
management details for the service orders. TheSLAStatus chart displays
the service-level agreement details for the service orders. The PM Status
chartdisplays theperformancemanagementdetails for theserviceorders.
The count or percentage of service orders in the pie chart segments sum
up to the total number of configured service orders. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. These charts provide a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

In Build mode of Service View, from the View pane, if you select the
Network Services node and do not expand the Network Services >
Connectivity tree, the top pane displays a pie chart that enables you to
view and examine the different services configured for devices, and the
typesof serviceprotocols configured. TheServicesbyTypegraphdisplays
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the count of services for each type of service definition. Mouse over each
segment of the pie to view the number corresponding to the percentage
of service orders for each of the charts. This chart provides a visual
overview of customers and service orders on your network, and enables
you to quickly access related and commonly needed information. For
example, you can check for failed service orders and then access a list of
failed requests so you can begin to take restorationmeasure.

The following fields are displayed in this window:

• Name—Unique name assigned to the service.

• Customer—Name of the customer for which the service is provided.

• State—State of the service order. Service orders can be one of the following states:

• Completed—The service order has been successfully deployed.

• Scheduled for deployment—The service provisioner has scheduled the service

order for deployment.

• Deployment Failed—An attempted service deployment was not successfully

completed or failed an audit.

• In Progress—The Connectivity Services Director application is in the process of

deploying the service.

• Requested—The service provisioner has created the service order, but has not

yet attempted to deploy it or schedule it for deployment.

• Invalid—The service order is not valid.

• Signaling—Type of signaling, namely, BGP or LDP.

• Created By—Name of the user that created the service order.

• Created Date—Date and time at which the service order was created.

This topic describes:

• Selecting Configuration Deployment Options on page 1669

• Discarding the Pending Configurations on page 1670

• Deploying Service Configuration Changes to Devices Immediately on page 1671

• Scheduling Configuration Deployment of Services on page 1672

• Specifying Configuration Deployment Scheduling Options on page 1672

Selecting Configuration Deployment Options

Basedon theapprovalmode, you can choose todeploy thedevice configuration changes

in the following ways:

• When you select the auto approval mode, the page Devices with Pending Changes

open. From the Devices with Pending Changes page, you can:

1669Copyright © 2019, Juniper Networks, Inc.

Chapter 59: Service Design and Provisioning: Managing and Deploying Tunnel Services



• Deploy configuration changes immediately by selecting one or more devices and

clicking Deploy Now. For more information, see “Deploying Configuration Changes

to Devices Immediately” on page 719.

• Schedule configuration deployment by selecting one or more devices and clicking

ScheduleDeploy. Formore information, see “SchedulingConfigurationDeployment”

on page 719.

• View configuration changes that are pending on a device by clicking View in the

Configuration Changes column.

• Validate that the pending changes for a device are compatible with the device’s

configuration by selecting up to ten devices and clicking Validate Pending

Configuration Changes.

• Discard the pending configuration changes. For more information, see “Discarding

the Pending Configurations” on page 717.

Discarding the Pending Configurations

Use the Discard Local Configuration Changes Results window to discard all the pending

configurations that were made on a device. Once you discard the local configuration

changes on a device, the configuration state of the device changes to In Sync or Out of

Sync based on the system of record (SOR)mode set for the Junos Space Network

Management Platform. If the SORmode is set to Network as system of record (NSOR),

then theconfiguration statechanges to InSyncand if theSORmode is set to JunosSpace

as system of record (SSOR), then the configuration state changes to Out of Sync.

To discard the configuration changes:

1. From the View selector, select Service View. The workspaces that you can configure

in this view are displayed.

2. Click the Deploy icon in the Connectivity Services Director banner. The functionalities

that are applicable to this lifecycle mode are displayed.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnel to expand the tree in the View pane and click

LSPs to view the list of LSP services.

5. From the task pane, selectServiceProvisioning>ManageLSP. The toppart of the right

pane displays the Manage Network Services page, with the table of services, and the

bottom part of the right pane displays the Manage Service Deployment page, with

the table of service orders.
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6. From the Manage Service Deployment page, select the services for which you want

to discard the pending configuration and clickDiscardPendingConfiguration from the

Actions menu.

TheDiscard Local ConfigurationChangesResultswindowopensdisplaying the status

of the discard pending configuration job.

7. To discard the pending changes of the service immediately, select Partial delete now,

and clickOK. To discard the pending changes of the service at a later time, select

Partial delete later, select a date and time for deletion, then click OK. The time field

specifies the timekeptby the server, but in the timezoneof theclient. After scheduling

the service order for deployment, the provisioning software begins validating the

service order.

8. Click Close to close the Discard Local Configuration Changes Results window.

Deploying Service Configuration Changes to Devices Immediately

To deploy service configuration changes to devices immediately:

1. From the View selector, select Service View. The workspaces that you can configure

in this view are displayed.

2. Click the Deploy icon in the Connectivity Services Director banner. The functionalities

that are applicable to this lifecycle mode are displayed.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnel to expand the tree in the View pane and click

LSPs to view the list of LSP services.

5. From the task pane, selectServiceProvisioning>ManageLSP. The toppart of the right

pane displays the Manage Network Services page, with the table of services, and the

bottom part of the right pane displays the Manage Service Deployment page, with

the table of service orders.

6. Select the check box next to the service you want to deploy from theManage Service

Deployment page.

7. Click Deploy Now.

The Deploy Options window opens.

8. In the Deploy Options window, enter a job name in the Deployment Job Name field,

then clickOK.
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The configuration deployment job runs. The Deploy Configurationwindow opens and

shows the results of the deployment job.

Scheduling Configuration Deployment of Services

To schedule the services configuration deployment to devices:

1. From the View selector, select Service View. The workspaces that you can configure

in this view are displayed.

2. Click the Deploy icon in the Connectivity Services Director banner. The functionalities

that are applicable to this lifecycle mode are displayed.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnel to expand the tree in the View pane and click

LSPs to view the list of LSP services.

5. From the task pane, selectServiceProvisioning>ManageLSP. The toppart of the right

pane displays the Manage Network Services page, with the table of services, and the

bottom part of the right pane displays the Manage Service Deployment page, with

the table of service orders.

6. Select the check box next to the service you want to deploy from theManage Service

Deployment page.

7. Click Schedule Deploy.

The Deploy Options window opens.

8. Use the Deploy Options window to schedule the configuration deployment. See

“SpecifyingConfigurationDeploymentSchedulingOptions”onpage720foradescription

of the window.

Specifying Configuration Deployment Scheduling Options

Use the Deploy Options window to schedule configuration deployment jobs.

Table 98 on page 720 describes the actions for the fields in this window.

Table 266: Deploy OptionsWindow

ActionField

Enter a job name.Deployment Job Name

Enter the job’s start date and time.Date and Time

Copyright © 2019, Juniper Networks, Inc.1672

Connectivity Services Director User Guide



Table 266: Deploy OptionsWindow (continued)

ActionField

Click to accept changes and exit the window.OK

Click to cancel changes and exit the window.Cancel

Deploying an LSP Service

This procedure schedules a service for deployment on the network. Use this procedure

to perform the following tasks:

• Deploy a new service.

• Deploy amodified service.

• Redeploy a service order that failed deployment.

You cannot deploy an invalid service order.

To schedule a service for deployment:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the plus sign (+) beside Tunnel to expand the tree in the View pane and view

the list of service types.

4. Expand the LSPs tree to view the list of LSP services.

5. From the Network Services > Tunnel task pane, select Service Provisioning >Manage

LSP. The Manage Service Deployment page is displayed on the right pane.

6. In theManage Service Deployment page, select the service order that you want to

deploy.

7. Click the Deploy Service Order button at the top of the page.

The Deploy Servicewindow appears.

8. To deploy the service immediately, select Deploy now, and clickOK.

To deploy the service at a later time, select Schedule Deploy, and select a date and

time for deployment, then clickOK.

The time field specifies the time kept by the server, but in the time zone of the client.
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After scheduling the service order for deployment, the provisioning software begins

validating the service order.

9. Use the Jobs workspace to monitor the outcome of the deployment.

Related
Documentation

Validating the Pending Configuration of a Service Order on page 971•

• Viewing the Configuration of a Pending Service Order on page 972

Deleting a Partial Configuration of an LSP Service Order

A failed service order of type Provisioning can leave parts of the service configuration on

the devices. To remove this partial configuration:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnel to expand the tree in the View pane and view

the list of service types.

5. Expand the LSPs tree to view the list of LSP services.

6. From the Network Services > Tunnel task pane, select Service Provisioning >Manage

LSP > service order name. The top part of the right pane displays theManage Network

Servicespage,with the tableof services, and thebottompart of the rightpanedisplays

the Manage Service Deployment page, with the table of service orders.

7. In theManage Service Deployment page, select the failed service order for which you

want to delete the partial configuration.

8. Open the Actionsmenu and select Delete Partial Configuration.

9. To delete the pending changes of the service immediately, select Partial Delete Now,

and clickOK. To discard the pending changes of the service at a later time, select

Partial Delete Later, select a date and time for deletion, then click OK. The time field

specifies the timekeptby the server, but in the timezoneof theclient. After scheduling

the service order for deployment, the provisioning software begins validating the

service order.
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You are returned to the Manage Service Orders page.

Related
Documentation

Managing Service Configuration Deployment Jobs on page 957•

• Deploying Services Configuration to Devices on page 959

• Deploy ConfigurationWindow on page 724

• Managing Jobs on page 118

Deleting an LSP Service Order

You can delete a service order that is in the requested state, the scheduled state, the

invalid state, or the failed deployment state. To correct a service order in the invalid state,

youmust delete it and then recreate it; the Connectivity Services Director application

does not support modifying the service order directly.

To delete a service order from the database:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the plus sign (+) beside Tunnel to expand the tree in the View pane and view

the list of service types.

4. Expand the LSPs tree to view the list of LSP services.

5. From the Network Services > Tunnel task pane, select Service Provisioning >Manage

LSP.

6. In theManage Service Deployment page, select the service order to be deleted from

the Connectivity Services Director application database.

7. Open the Actionsmenu and select Delete Service Order.

A pop-up window appears requesting confirmation.

8. Click Delete.

TheManage Service Deployment page reappears with the deleted service orders

removed.

Related
Documentation

Creating an E-Line Service Order on page 784•

• Creating a Multipoint-to-Multipoint E-LAN Service Order on page 827
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• Creating a Point-to-Multipoint E-LAN Service Order on page 847

Validating the Pending Configuration of an LSP Service Order

This procedure validatesa serviceorder butdoesnotpush theconfiguration to thedevice.

Use this procedure to perform the following tasks:

• Validate a service request in the REQUESTED state.

• Validate a service request in the INVALID state after making necessary configuration

changes on one or more PE devices associated with the service order.

When you create a service order, it is automatically validated in Connectivity Services

Director. However, if subsequent changes to service configuration attributes and settings

have occurred for the devices or endpoints to which they are associated, you can use the

functionality to validate pending service order configuration. You can validate the

configuration of a service order that is in the requested state, the scheduled state, the

invalid state, or the failed deployment state

To schedule a service order for validation, follow these steps:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnel to expand the tree in the View pane and view

the list of service types.

5. Expand the LSPs tree to view the list of LSP services.

6. From the task pane, selectServiceProvisioning>ManageLSP. The toppart of the right

pane displays the Manage Network Services page, with the table of services, and the

bottom part of the right pane displays the Manage Service Deployment page, with

the table of service orders.

7. From the Manage Service Deployment page, select the service order you want to

validate and save.

8. Open the Actionsmenu and click Validate Pending Configuration.

The Schedule Service Request Validationwindow appears.
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9. You can validate a service now or at some future time:

• To validate the service immediately, select Validate now, and clickOK.

• To validate the service at a later time, select Validate later, select a date and time

for deployment, and then clickOK.

NOTE: When specifying a time to validate the service, the time field
specifies the time kept by the server, but in the time zone of the client.

After scheduling the service order for validation, the provisioning software begins

validating the service order.

10. You can use the JobManagementwindow to viewdetails about the service validation.

Related
Documentation

Deleting a Partial Configuration of an LSP Service Order on page 967•

• Deleting a Service Order on page 968

• Deploying a Service on page 969

Viewing the Configuration of a Pending LSP Service Order

You can view the configuration of a service order that is in the requested state, the

scheduled state, the invalid state, or the failed deployment state.

To view the configuration of such pending service orders:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the plus sign (+) beside Tunnel to expand the tree in the View pane and view

the list of service types.

4. Expand the LSPs tree to view the list of LSP services.

5. From the Network Services > Tunnel task pane, select Service Provisioning >Manage

LSPs. The Manage Service Deployment page is displayed on the bottom part of the

right pane.

6. Select a service order that is in either of the following states:

• Requested

• Invalid
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• Scheduled

• Failed deployment

NOTE: TheOrder State column displays the state of the service order.

7. Select the service order for which you want to view the configuration details.

8. Click the View Pending Order Configuration button at the top of the table of listed

service orders. The Service Configuration Viewwindow is displayed. The configuration

is displayed in CLI format.

NOTE: TheViewPendingOrderConfigurationbuttonontheManageService

Orderspageappears tobedimmed if the serviceorder state isCompleted.

9. Select a device to view the configuration details. You can also view the template

configuration if a template is attached to the service order.

Based on the application’s settings, the configuration is displayed in xml format or in set

format. To view the configuration in set format:

1. Select Platform > Administration > Applications > Connectivity Services Director.

2. Right-click theConnectivityServicesDirector applicationandselectModifyApplication

Settings. The Modify Connectivity Services Director Settings window is displayed.

3. Select the show configuration in set format check box.

Related
Documentation

Deleting a Partial Configuration of an LSP Service Order on page 967•

• Deleting a Service Order on page 968

• Deploying a Service on page 969

• Validating the Pending Configuration of a Service Order on page 971
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Viewing the Configuration Details of RSVP LSP Services

You can view the configuration of an RSVP LSP tunnel service, which enables you to see

the parameters and attributes configured for a service on the associated devices in the

form of configuration statements and commands that are displayed in the Junos OS CLI

interface. You can use these settings to examine the existing service configuration and

modify it as necessary to correct any traffic-handling problems or system discrepancies.

To view the configuration of services:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the plus sign (+) beside Tunnels to view services based on protocols, and select

LSPs to view the LSP services.

4. From the Network Services > Tunnels > LSPs task pane, select Service Provisioning >

Manage LSP. The Manage Network Services page is displayed on the top part of the

right pane.

5. Select the check box next to a service for which you want to view the configuration

details.

6. Click the View Configuration option. The Service Configuration View dialog box is

displayed. The configuration is displayed in the CLI interface structure and in the form

of configuration stanzas.

The left pane displays a tree of devices associatedwith the specified service. You can

select a Service-name > Device-name in the left pane of the window to view the

configuration parameters of the corresponding device on the right pane. The right

pane contains two tabs— Service Configuration and Template Configuration. The

Service Configuration tab displays the settings specified for the service on the device

in CLI format. This tab displays the elements or components specified for a service

template in the form of configuration stanzas and hierarchy levels. This display is

similar to the show command that you can use at a certain [edit] hierarchy level to

view the defined settings. The Template Configuration tab displays the service

attributes and options defined in the service template, if any, that is associated with

the service.

7. ClickOK to close thedialogboxafter youcomplete viewing theconfigurationattributes

and settings.
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Related
Documentation

Deleting a Partial Configuration of an LSP Service Order on page 967•

• Deleting a Service Order on page 968

• Deploying a Service on page 969

• Validating the Pending Configuration of a Service Order on page 971

Viewing Decommissioned LSP Service Orders

In certain situations, youmight decommission a service that a customer no longer needs.

You cannot decommission a service if a service order requesting action on that service

is in the Requested, Scheduled, In Progress, or Invalid state. You can view the

decommissioned service orders in a separate page to determine whether you want to

delete it completely.

To view and determine the status of RSVP LSP service orders in a tabular form:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the JunosSpace user interface, click theDeploy icon in theConnectivity Services

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.

3. From the View pane, click the plus sign (+) to expand the Network Services tree and

select the Tunnel node.

4. In the Network Services > Tunnel View pane, select Service Provisioning >

Decommissioned Service Orders.

The Manage LSP Service Deployment page is displayed on the right pane.

A table of service orders on the systemappears in themaindisplay area. The following

fields are displayed on this page:

• Name—Unique name assigned to the service.

• Customer—Name of the customer for which the service is provided.

• State:

• Deployed-Active—Denotes a service that has been deployed and is in an active

state (enabled).

• Deployed-Inactive–Denotes a service that has been deployed and is in a

deactivated state (disabled.

• Deployment-Pending—Denotes a service for which deployment of the service to

a device is pending to be performed.

• Failed Deploy—An attempt to modify the service failed.

• Service Type:
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• LSP (Label-switched path)

• Latest Job—Unique identifier assigned by the system for a deployment job. Click

the link in the job ID to open the CSDDeployment Jobs. The table on that page lists

configuration deployment jobs.

• Signaling Type:

• BGP

• LDP

• Created By—The screen name of the user who created the service order

• Created Date—The date and when you created the service order.

From this page, you can create a service order, modify the properties of the service

order, conduct a functional or configuration audit, deploy or deactivate the service

order, and view alarms associated with a particular service order for debugging and

corrective action.

5. To view details of a specific service order, double-click the table row that summarizes

the service order.
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CHAPTER 60

Monitoring and Troubleshooting Tunnel
Services

• Performing a Functional Audit for LSP Services on page 1683

• Viewing Functional Audit Results for LSP Services on page 1689

• Examining the LSP Summary Details for Effective Troubleshooting on page 1692

• Troubleshooting the Endpoints of RSVP LSP Services on page 1695

• Clearing LSP Statistics on page 1699

• MonitoringNetworkReachabilitybyUsing theMPLSTracerouteCapabilityonpage 1700

• Monitoring Network Reachability by Using the MPLS Ping Capability for RSVP

LSPs on page 1702

Performing a Functional Audit for LSP Services

A functional audit determines whether a deployed service instance is functioning. It

checks the control plane to ensure connectivity among endpoints and that the UNIs are

functioning correctly. It also checks the data plane to verify packet transmission between

each valid pair of endpoints in the service.

A functional audit works by running commands that perform verification and reporting

relevant information.
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The following table shows the commands that are used for each service type:

CLI CommandsXML Commands

Device
Family

Service
Type Control PlaneData PlaneControl PlaneData Plane

showmpls lsp lspName
p2pmxl_to_100_100_20
ingress

Not supported.<get-mpls-lsp-information>
<name> lspName
</name> <ingress> </ingress>
</get-mpls-lsp-information>

Not supported.ACX
Series,
M
Series,
MX
Series

RSVP
LSP

Where:

lspName = Name of the LSP

showmpls tunnel
tunnelName

Not supported.<get-mpls-tunnel-information>
<name> tunnelName</name>
</get-mpls-tunnel-information>

Not supported.BX7000
Gateway

Where:

tunnelName = Tunnel name

showmpls static-lsp
name lspName ingress

Not supported.<get-mpls-static-lsp-information>
<name> lspName </name>
<ingress></ingress>
</get-mpls-static-lsp-information>

Not supported.ACX
Series,
M
Series,
MX
Series

Static
LSP

Where:

lspName = Name of the LSP

showmpls tunnel
tunnelName

Not supported.<get-mpls-tunnel-information>
<name> tunnelName </name>

Not supported.BX7000
Gateway

Where:

tunnelName = Tunnel name

show interfaces
interfaceValue

Not supported.<get-interface-information>
<interface-name> interfaceValue
</interface-name>
</get-interface-information>

Not supported.ACX
Series,
M
Series,
MX
Series

BX7000
Gateway

GRE

Where:

interfaceValue = Name of the interface
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For the data plane, the Junos Space software places a static MAC address in the

forwarding table of the remote endpoint, which it uses to verify correct packet transfer.

Troubleshooting the RSVP LSP Static LSP, and GRE

From the Troubleshooting tab you can check status of the interfaces, LDP sessions,

neighbor links, and endpoints of the RSVP LSP Static LSP, and GRE. To select the status

you want to check, click the device from the device list on the left, and select the show

command from the Command list.

The following table shows the commands for RSVP LSP:

CategoryCLI CommandsXML Commands
Device
Family

Service
Type

MPLSshowmpls lsp ingress name
instanceValue

<get-mpls-lsp-information>
<regex>instanceValue</regex>
</get-mpls-lsp-information>

M
Series

RSVP
LSP

MPLSshowmpls lsp name instanceValue
extensive

<get-mpls-lsp-information>
<extensive/><regex>
instanceValue</regex>
</get-mpls-lsp-information>

Routeshow rsvp session name
instanceValue

<get-rsvp-session-information>
<session-name>instanceValue
</session-name/>
</get-rsvp-session-information>

Routeshow rsvp neighbor<get-rsvp-neighbor-information>
</get-rsvp-neighbor-information>

Routeshow rsvp interface<get-rsvp-interface-information>
</get-rsvp-interface-information>

Routeshow ospf neighbor<get-ospf-neighbor-information>
</get-ospf-neighbor-information>

Routeshow ldp session<get-ldp-session-information>
</get-ldp-session-information>

OAMshow bfd session<get-bfd-session-information>
</get-bfd-session-information>

Where:

instanceValue= Name of the service
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The following table shows the commands for Static LSP:

CategoryCLI CommandsXML Commands
Device
Family

Service
Type

MPLSshowmpls static-lsp
name instanceValue

<get-mpls-static-lsp-information>
<name>instanceValue
</name>routerType
</get-mpls-static-lsp-information>

M SeriesSingleHop
and
Multihop
LSP

MPLSshowmpls static-lsp
name instanceValue
extensive

<get-mpls-static-lsp-information>
<extensive/>routerType<regex>
instanceValue</regex>
</get-mpls-static-lsp-information>

Routeshow ospf neighbor<get-ospf-neighbor-information>
</get-ospf-neighbor-information>

Where:

instanceValue= Name of the service

routerType= Type of the router

The following table shows the commands for GRE:

CategoryCLI CommandsXML Commands
Device
Family

Service
Type

NNIshow interface
interfaceValue terse

<get-interface-information>
<terse/>
<interface-name>interfaceValue
</interface-name>
</get-interface-information>

ACX
Series,
M Series,
MX Series

BX7000
Gateway

GRE

Routeshow ldp session<get-ldp-session-information>
</get-ldp-session-information>

Routeshow ospf neighbor<get-ospf-neighbor-information>
</get-ospf-neighbor-information>

Where:

interfaceValue= Name of the interface

Performing the Functional Audit
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To perform a functional audit:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the plus sign (+) beside Tunnel to view services based on protocols, and expand

the RSVP LSPs tree to select an LSP service.

4. In the Network Services > Tunnel task pane, select Audit Results > Functional Audit.

Alternatively, you can select a service order, click the Audit button at the top of the

table of listed service orders from the Manage Network Services page and select Run

Functional Audit.

5. In the Schedule Functional Audit dialog box, do one of the following:

a. Select Audit Now, then clickOK.

The Job Details dialog box appears for you to click the Job ID link to see the

functional results. The JobManagement page displays the functional audit details

by job ID, name, percentage complete, state, job type, summary, scheduled start

time, user, and recurrence.

b. Select Audit Later, enter a date and time, then clickOK.

Tomonitor the progress of an audit after selecting Audit Later, after the scheduled

time of the audit:

a. On the Junos SpaceNetworkManagement Platform user interface, select Jobs.

b. Onthe Jobs statisticspage, select theFunctionalAudit segmentof the JobTypes

pie chart.

The JobManagement page appears filtered by functional audit jobs.

c. Select the functional audit job that you want.

Summary information about the audit appears in the quick look panel.

d. In the filter bar, select the table view icon to see additional information about

the job. If the service failed the audit, information about the failure appears in

the Summary field.
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NOTE: Functional audit can be run for multiple services from Buildmode
ofServiceViewof theConnectivityServicesDirectorGUI. FromtheManage
Network Services page, select the check boxes besidemultiple srvices,
and click the Audit/Results button at the top of the table of configured

services.WhentheAudit/Resultsbutton isclicked, theScheduleFunctional

Audit window is displayed, which enables you to perform the audit
immediately or schedule it to be run at a later time. You can viewdetailed,
ingrained information about the output of the functional audit that you
performed for a service from the Functional Audit Resultswindow. Select
the Service-name > Interface-name Device-name > Remote Interface -

Remote Device in the left pane of the window. The control plane and data

plane statusesaredisplayedby running service-specific commands in the
right pane of the window. Click Rerun Functional Audit at the top-right

cornerof thewindowtoperformtheaudit again. If theStatus fielddisplays
as Completed, an audit can be run again; else, if the Status field displays
asOngoing, it denotes that an audit is currently in progress, youmustwait
for the running instancetobecompletedtoperformafunctionalevaluation
again.

Click Reload Result at the top-right corner of the window to refresh the

results of the audit and display the updated information. You can refresh
the results only for completed audit instances. When you select
Service-name in the left pane of the window, service status information
is displayed in the right pane. The Service Status window displays details
suchas theoperational statusof theservice, thedevicename, the topology
used in the service are displayed in a tabular format. The number of UNI
interfaces and PE devices that are up and down is also shown.When you
select Service-name > Interface-name Device-name > Remote Interface -

RemoteDevice in the left paneof thewindow, endpoint status information

is shown in the right pane. The Endpoint Status window displays details
of the device name, the topology used in service, remoteUNIs status, and
device status of the selected service.

The Service Status field corresponding to the service for which polled data is not

available is displayed as NA. The Service Status field represents the overall status of

a service. Tocalculate theoverall service status, apollingmechanism isused to retrieve

data from devices by Connectivity Services Director. Because the overall status of a

service involvesmultipledevices, it is possible to calculateandupdate service statuses,

based on an event from one of the devices because the status of all endpoints of a

serviceneeds tobedetermined tocompute theoverall service status. It is anexpensive

operation to send requests to all endpoints, based on an event from a single device.

As a result, a pollingmethod is used toobtain theoverall status of thedevice. Because

the polled data represents a snapshot at a point in time, a delay occurs in updating
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the statusof a service. Also,while polling, if service information fromoneof thedevices

is not available, the service is marked as down.

6. To view additional details about the functional audit, including results from checking

the control plane and the data plane, seeViewing Functional Audit Results.

Related
Documentation

Performing a Configuration Audit on page 1027•

• Troubleshooting N-PE Devices Before Provisioning a Service on page 1030

• Modifying the Application Settings of Connectivity Services Director on page 1032

• Troubleshooting the Endpoints of Services on page 1038

• Viewing Configuration Audit Results on page 1046

• Viewing Functional Audit Results on page 1048

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052

Viewing Functional Audit Results for LSP Services

To view the results of a functional audit of a service, follow this procedure:

After performing a functional audit on a service, look at the functional audit results:

1. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Click the Build icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

3. Click the plus sign (+) beside Tunnel to view services based on protocols, and expand

the LSPs tree to select an LSP service.

4. In the Network Services > Tunnel task pane, select Audit Results > Functional Audit.

Alternatively, you can select a service order, click the Audit button at the top of the

table of listed service orders from the Manage Network Services page.

The Functional Audit Resultswindow appears, displaying Service Status in the right

panel.

Agreenup-arrow in theServiceStatusheaderbar indicates that the servicehaspassed

the functional audit in both the control plane and the data plane. A red down-arrow

indicates that the service failed either or both the control plane validation and the

data plane validation.

Depending on the type of service, the left panel lists

• The name of the service

• Each endpoint in the service

1689Copyright © 2019, Juniper Networks, Inc.

Chapter 60: Monitoring and Troubleshooting Tunnel Services



Icons representing the endpoint indicate its role in the service and its up or down

state. Table 139 on page 1049 describes these icons for a service.

Table 267: Service Endpoint Icons

MeaningIcon

Hub in a point-to-multipoint service. Endpoint state is up.

Hub in a point-to-multipoint service. Endpoint state is down.

Spoke in a point-to-multipoint service. Endpoint state is up.

Spoke in a point-to-multipoint service. Endpoint state is down.

• Interface name

• Device name

5. To show all endpoints in the service, in the left panel header, select All. To display

only the endpoints indicating failed validation, select Failed. Failed is dimmed if the

functional audit returned no validation errors.

6. To view details for an individual interface or endpoint, select it in the left panel. The

header bar on the right panel changes to End Point or Interface Status, and details

for the selected item are displayed below.

7. Expand each device to show the link from that device to the other N-PE device in the

service.

An icon next to each link indicates whether the functional audit commands reported

correct functioningof thecontrolplaneanddataplane.Table 140onpage1050describes

these icons.

Table 268: Functional Audit Success Status Icons

MeaningIcon

Control plane and data plane function correctly.

Errors were reported in the functioning of either the control plane or the data
plane.

8. In the left panel, select a link.

The panel to the right shows the validation results for the control plane validation and

data plane validation for the selected link. Icons indicate the success or failure of each

set of tests.

The panel to the right shows the validation results for the control plane validation and

data plane validation for the selected link. Icons indicate the success or failure of each
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of thesesetsof tests.Table 141onpage 1050describes iconsandthe textual information

provided in the box beside the icon.

Table 269: Control Plane and Data Plane Validation Icons

ExplanationMeaningIcon

The text box shows the name
of the remoteN-PEdeviceand
confirms that the data plane
is operational.

Control plane up

The text box shows the name
of theconfigured remoteN-PE
device and, in the Command
status field, explains why the
test failed.

Control plane down

The text box indicates the
nameof theconfigured remote
N-PE device and, in the Result
field, an explanation as towhy
the functional audit operation
was unable to test the control
plane—for example,
configuration wasmissing on
the device.

Control plane status unknown

The text box indicates the
numberofpackets transmitted
and received, and confirms
that no data packetswere lost
during the audit.

Data plane up

The text box indicates that
data packets were lost during
the audit.

Data plane down

The functional audit was
unable to complete the data
plane test. The Result field in
the text box indicates the
reason—for example, the
platform does not support
data plane testing, or the
connection to the remoteN-PE
device is down.

Data plane status unknown

The control plane and data plane validation checks must both show operational

status for the link to be considered operational.

9. To troubleshoot a service, click the Troubleshoot button to open the Troubleshooting

page. To select the status you want to check, click the device from the device list on

the left, and select the show command from the Command list.
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An iconnext toeachcommand indicateswhether thecommandexecution is successful

or failed. Table 270 on page 1692 describes these icons.

Table 270: Command Status Icons

MeaningIcon

Command execution is successful and the command status is up.

• Command execution is failed, or,

• In case of multiple rows, one of the status value is down

NOTE:

• JunosOSRelease 9.3 and JunosOSRelease 9.4 do not support data plane
validation. The Functional Audit Results screens do not display data plane
validation information if any device in the service is running one of these
Junos OS releases.

Examining the LSP Summary Details for Effective Troubleshooting

The LSP Summary page provides a comprehensive and cohesive insight about the

configured LSP service. The status of the LSP and the status of connections between

the ingress router and egress routers in an LSP are displayed. The LSP status details are

shown for the ingress router. You can also view the ingress, egress, and transit LSP

information, such as the primary and secondary states. Ingress information is for the

sessions that originate from this router, egress information is for sessions that terminate

on this router, and transit information is for sessions that transit through this router.

Extensive information about LSPs, including all past state history and the reasons why

an LSPmight have failed, can also be viewed. This page is beneficial to easily resolve

RSVP failures in your network topology by quickly analyzing the LSP status and statistics.

NOTE: The refresh of values and statuses of the parameters displayed in the
graphs and tables of different monitors depends on the polling interval
configured under the Monitoring tab of the Preferences page (accessible by
clicking thedownarrowbeside theSystembutton in theConnectivityServices
Director banner and selecting Preferences).

To view the LSP summary page:

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. Fromthe JunosSpaceuser interface, click theMonitor icon in theConnectivityServices

Director banner. The functionalities that you can configure in this mode are displayed

in the task pane.
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3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnel to view services based on protocols and expand

the LSPs tree to select an LSP service.

5. Click the LSP Summary tab. The LSP Summary page is displayed.

This widget provides details on LSP configuration details and statistics of traffic

transmitted over the LSP.

• Operational Status on page 1693

• Status Matrix on page 1693

• LSP Information on page 1694

• LSP Traffic on page 1695

Operational Status

This monitor displays the working status of the LSP service. The following fields are

displayed:

• Name—Name of the LSP service.

• Status—Operational status of the LSP service. A green up arrow indicates the LSP is

up, and a red down arrow indicates the LSP is down.

• Type—Topology type of the LSP, such as point-to-point, point-to-multipoint, or

full-mesh.

• LSPs Count—Total number of LSPs configured in the service that are in the up and

down states.

• BFD—Total number of BFD packets transmitted over the LSP. BFD for RSVP supports

unicast IPv4 LSPs. When BFD is configured for an RSVP LSP on the ingress router, it is

enabled on the primary path and on all standby secondary paths for that LSP. The

source IP address for outgoing BFD packets from the egress side of an MPLS BFD

session is based on the outgoing interface IP address.

StatusMatrix

This monitor shows the status of connections between the ingress router and egress

routers in an LSP. In the tabular view, the egress router, the LSPname, and the LSP status

are displayed. From the Ingress list, select the ingress router for the LSP topology. This

field is automatically populated for point-to-multipoint LSP topology; you need to select

it only for bidirectional P2P LSPs and full-mesh LSPs. From the Egress list, select the

output router up to which the LSP runs from an ingress router. This field is applicable for

P2P, point-to-multipoint, and full-mesh LSPs.
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A green up-arrow in the LSP Status field indicates that the LSP to the destination device

is operationally up. A red down-arrow in the LSP Status field indicates that the LSP is

down.To filter andsort thedisplayofLSPs, enter thenameof theLSPasamatchcriterion

in the Search box and click the Search icon. The page refreshes to display only the LSP

names that match with the search term. You can use the paging controls to navigate

across multiple pages of LSPs as necessary.

LSP Information

For a destination address that contains LSP names, the corresponding LSP details, such

as thename, state, andbandwidthof the LSP, aredisplayed in thismonitor. The following

fields are displayed:

• Name—Name of the LSP

• State— State of the LSP handled by this RSVP session: Up, Dn (down), or Restart

• Bandwidth—Specifies the bandwidth in bits per second for the LSP.

• Primary State— State of the LSP that is a primary path: Up, Down, or Restart

• Secondary State— State of the LSP that is a secondary path: Up, Down, or Restart

• Received RRO—(Ingress LSP) Received record route. A series of hops, each with an

address followed by a flag. (In most cases, the received record route is the same as

the computed explicit route. If Received RRO is different from Computed ERO, there

is a topology change in the network, and the route is taking a detour.) The following

flags identify the protection capability and status of the downstream node:

• 0x01—Local protection available. The link downstream from this node is protected

by a local repair mechanism. This flag can be set only if the Local protection flag

was set in the SESSION_ATTRIBUTE object of the corresponding Path message.

• 0x02—Local protection in use. A local repair mechanism is in use to maintain this

tunnel (usually because of an outage of the link it was routed over previously).

• 0x03—Combination of 0x01 and 0x02.

• 0x04—Bandwidth protection. The downstream routing device has a backup path

providing the same bandwidth guarantee as the protected LSP for the protected

section.

• 0x08—Nodeprotection.Thedownstreamroutingdevicehasabackuppathproviding

protection against link and node failure on the corresponding path section. If the

downstream routing device can set up only a link-protection backup path, the Local

protection available bit is set but the Node protection bit is cleared.

• 0x09—Detour is established. Combination of 0x01 and 0x08.

• 0x10—Preemption pending. The preempting node sets this flag if a pending

preemption is in progress for the traffic engine LSP. This flag indicates to the ingress

legacy edge router (LER) of this LSP that it should be rerouted.

• 0xb—Detour is in use. Combination of 0x01, 0x02, and 0x08.
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• Total Packets—Total number of packets and Total number of bytes transmitted over

the LSP. This counter is reset to zerowhenever the LSPpath is optimized (for example,

during an automatic bandwidth allocation).

• Total Bytes—Total number of bytes transmitted over the LSP. This counter is reset to

zerowhenever theLSPpath is optimized (for example, duringanautomatic bandwidth

allocation).

LSP Traffic

This monitor displays a line chart with the number of packets or bytes on the y-axis and

time on the x-axis to denote the LSP bandwidth utilization. From the Time Interval

drop-down box, select 1 Hour, 8 Hours, 1 Day, 1Week, 1 Month, 3Months, 6Months, 1 Year,

or Custom to specify the duration for which the data polled from devices needs to be

displayed. If you select the Customoption, the Time range popup dialog box is displayed.

Specify the date from the calendar, and select the Time From (Start time in the 24-hour

time format of collection of data), and Time To (End time in the 24-hour time format of

collection of data). Click OK to save the settings. Else, click Cancel to discard the

configuration. From the Statistics Type drop-down list, select Packets or Bytes to display

metrics corresponding to the selected parameter.

Related
Documentation

Monitoring the Service Traffic Statistics of E-Line Services for Correlating Device

Counters on page 1149

•

• Monitoring the Service Traffic Statistics of IP Services for Correlating Device Counters

on page 1154

• Monitoring theServiceTransportDetailsofE-LineServices forEasyAnalysisonpage 1156

• Monitoring theServiceTransportDetailsofE-LANServices forEasyAnalysisonpage 1159

• Monitoring the Service Transport Details of IP Services for Easy Analysis on page 1162

Troubleshooting the Endpoints of RSVP LSP Services

Junos OS operation (op) scripts automate network and device management and

troubleshooting. Op scripts can perform any function available through the remote

procedure calls (RPCs) supported by either the Junos XMLmanagement protocol or the

Junos Extensible Markup Language (XML) API. Op scripts can be executedmanually in

the CLI or upon user login, or they can be called from another script. They are executed

by the Junos OSmanagement (mgd) process.

Op scripts enable you to do the following things:

• Create custom operational mode commands

• Execute a series of operational mode commands

• Customize the output of operational mode commands

• Shorten troubleshooting time by gathering operational information and iteratively

narrowing down the cause of a network problem

1695Copyright © 2019, Juniper Networks, Inc.

Chapter 60: Monitoring and Troubleshooting Tunnel Services



• Perform controlled configuration changes

• Monitor the overall status of a device by creating a general operation script that

periodically checks network warning parameters, such as high CPU usage.

Op scripts are based on the Junos XMLmanagement protocol, and the Junos XML API.

Op scripts can be written in either the Extensible Stylesheet Language Transformations

(XSLT) or Stylesheet LanguageAlternative Syntax (SLAX) scripting language. Op scripts

use XPath to locate the operational objects to be inspected and XSLT constructs to

specify theactions toperformon the locatedoperational objects. Theactions canchange

the output or execute additional commands based on the output.

The troubleshooting featureprovidesaneasyanduniqueway to troubleshoot theservices.

You do not have to manually login to a device to check the status of services in the

ConnectivityServicesDirector application, but youcando thesameusing the functionality

of operational scripts. You do have the flexibility of writing your own scripts to view the

results.

Only JuniperNetworksdevicesare supportedby this functionalityand this isnotapplicable

to the third-party devices.

The operational scripts can either be created or imported to the platform from the local

machine before you start troubleshooting the services or you can run the scripts that are

of local typedirectly fromtheFunctionalAuditResultwindowbyclicking theTroubleshoot

button. For op scripts that are not of local type, the op scripts must be imported and

stagedon to thedeviceusing the JunosSpaceNetworkManagementPlatformapplication

before you can run the scripts fromwithin the Connectivity Services Director application

for debugging and diagnosing the service endpoints or devices. Currently, you cannot

directly add the scripts to the Connectivity Services Director GUI interface. Scripts with

execution type as “Local” (@isLocal=true annotation in the SLAX script) are also listed

in troubleshootingwindow.The listing is sortedand filteredbasedon thecontext specified

for each service.

BESTPRACTICE: Werecommend that you configure a script as a local script
for effectiveandoptimaldebuggingandanalysisof theconfigurationsettings
contained in the script. Themain advantage of a local script is that you need
not download the script to a device (because a connection is established
with the device by theGUI application and the script is run) and youneednot
remove the script from a device after you decommision a service.

The following table lists the context inwhich theOP scripts arewritten for different types

of services:

Table 271: OP Scripts Contexts for RSVP LSP Services

ContextService Type

@CONTEXT = "/device/configuration/protocols/mpls/lsp"

Example : /device[name=”deviceName”]/configuration/protocols/l2circuit/mpls/lsp[name=”LSP
name”]

RSVP LSP LDP
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Table 271: OP Scripts Contexts for RSVP LSP Services (continued)

ContextService Type

/*@CONTEXT = “/device/configuration/interface/” */

Example: /device[name=”device name”]/configuration/ interface[name=”interfaceName.unitID”]

Example commands:

Commoncontext forall
services

Whenyouselect a single serviceand fromtheNetworkServices>Connectivity taskpane,

select Audit Results > Functional Audit to schedule and perform a functional audit

operation, the Functional Audit Results window is displayed after the operation of the

selected service is validated. If you have previously run a functional audit already run, the

result of the previous audit is displayed. To perform a troubleshooting of the selected

service, youmust click the Troubleshoot button. The troubleshooting task runs as a

separateevent inConnectivityServicesDirector,whereas troubleshootingwasperformed

together with functional audit in the Services Activation Director GUI.

• Troubleshooting Services Using Operational Scripts on page 1697

Troubleshooting Services Using Operational Scripts

The operational scripts or the OP scripts are written to view the statistics of a service in

the Connectivity Services Director application. All the commands in the OP scripts are

user-defined. To view the contexts for writing OP scripts for different service types, refer

Table 138 on page 1040.

To execute the OP scripts and view the status of any service:

1. FromtheNetworkManagementPlatform taskpane, select ImagesandScripts>Scripts.

The Scripts page that appears displays a list of the existing scripts.

2. From the list of the scripts available in the SLAX format, right-click a script and click

Stage Scripts on Devices to push the script onto a device.

The Stage Scripts on Device(s) page that appears displays a list of the devices

associated with the script that you selected.

3. Select the Select DeviceManually option and select any number of devices to which

you want to push the script.

NOTE: The Enable Scripts on Devices check box is selected by default.

4. Click Stage to stage the script on all the devices that you selected.

The Stage Scripts Information dialog box confirms the successful staging of scripts

onto the selected devices along with the Job ID.

5. Click Job ID to view the status of the job on the JobManagement page.

You are redirected to the Scripts page.
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6. From the View selector, select Service View. The workspaces that are applicable to

routing and tunnel services are displayed.

7. Click the Deploy icon in the Service View of the Connectivity Services Director banner.

The functionalities that you can configure in thismode are displayed in the task pane.

8. Click the plus sign (+) beside Tunnel to view services based on protocols, and expand

the LSPs tree to select an LSP service.

9. In the Network Services > Tunnel task pane, select Audit Results > Functional Audit.

Alternatively, you can select a service order, click the Audit button at the top of the

table of listed service orders from the Manage Network Services page.

10. In the Schedule Functional Audit dialog box, selectAudit Now, then clickOK. After the

audit is run, the Functional Audit Results window is displayed.

11. FromtheFunctionalAuditResultswindowthatdisplaysa list of thedevicesassociated

with the service you selected, select the check box next to the device for which you

want to diagnose and examine the associated service.

12. Click Troubleshoot to perform troubleshooting and analysis of the service for which

functional audit is performed.

13. Select the check box next to a service that you want to analyze andmonitor for its

working and efficiency. The Execute OP Scripts page is displayed.

14. Select an OP script on the Execute OP Scripts page.

15. Click the Value column to enter any additional parameter for the selected OP script,

besides the ones coded in the script.

NOTE: Theselectionofparameters isentirelydependentontheOPscripts.
If the OP scripts support parameters, then all the parameters are listed
andyouneed toenter thevalues.Parameterscanbeoptional, on thebasis
of the OP scripts.

16. Click Execute to execute the selected OP scripts with the newly added parameters,

if any.

A dialog box confirms the execution of the OP scripts along with the Job ID.

17. ClickOK.

You are redirected to the Execute OP Scripts page.

18. Click View Last Result to view the previous OP scripts execution results.

NOTE: This is an optional step.

Related
Documentation

Performing a Functional Audit on page 1019•

• Performing a Configuration Audit on page 1027
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• Troubleshooting N-PE Devices Before Provisioning a Service on page 1030

• Modifying the Application Settings of Connectivity Services Director on page 1032

• Viewing Configuration Audit Results on page 1046

• Viewing Functional Audit Results on page 1048

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage 1052

Clearing LSP Statistics

When you clear LSP statistics on a device using Connectivity Services Director, the

operation releases the routes and states associated with MPLS label-switched paths

(LSPs), and starts new LSPs. This GUI operation is equivalent to entering the clear mpls

lsp command on a device using the Junos OS CLI interface. This command disconnects

existing Resource Reservation Protocol (RSVP) sessions on the ingress routing device.

If there is a time lag between the old path being torn down and the new path being set

up, this commandmight impact traffic traveling along the LSPs.

To clear the label-switched path (LSP) statistical details for an LSP service:

1. From theView selector, select ServiceView. The functionalities that you can configure

in this view are displayed.

2. Click the Monitor mode icon in the Service View of the Connectivity Services Director

banner. The workspaces that are applicable to this mode are displayed.

3. From the Service View pane, click the plus sign (+) beside the Network Services >

Tunnel>LSPs treeandselect the service forwhichyouwant to reset theLSPstatistics.

The service statistical details are displayed in the middle pane.

4. From the task pane, which is displayed on the rightmost pane, select Tasks > Clear

LSPStatistics. TheClear LSPStatistics task enables you todeleteall the LSPstatistics

associated with the selected service. A dialog box appears, prompting you to confirm

the deletion. The device name and LSPs associated with the device are displayed. In

this dialog box, you can also choose to delete the LSP statistics on devices.

5. Select the Clear LSP Statistics fromDevices check box to clear the statistics from

devices. This operation is equivalent to the clear mpls lsp command that you can run

from the Junos OS CLI interface. If you select the Clear LSP Statistics fromDevices

check box, the statistics are cleared on the device for all the LSPs in the service, in

addition tobeing removed fromtheConnectivityServicesdirectordatabase.Otherwise,

the LSP statistics are only reset in the application database and not on the device.

6. Click OK to confirm; alternatively, click Cancel to discard this operation.
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Related
Documentation

Viewing MAC Table Details on page 1173•

• Viewing Interface Statistics on page 1174

• Viewing Interface Status Details on page 1176

• MPLS Connectivity Verification and Troubleshooting Methods on page 1178

• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185

• Routing Table Overview on page 1187

Monitoring Network Reachability by Using theMPLS Traceroute Capability

You can performa traceroute operation to examine the network reachability and identify

connection failures from a source or ingress host to a remote host for an MPLS LSP

signaled by RSVP. It a debugging tool to locate MPLS label-switched path (LSP)

forwarding issues in a network. (Currently supported for IPv4 packets only.)

1. From the View selector, select Service View.

The functionalities that you can configure in this view are displayed.

2. Click theMonitormode icon in the Service View of the Connectivity Services Director

banner.

The workspaces that are applicable to this mode are displayed.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnels > LSPs, and select the RSVP service for which

you want to run the traceroute utility.

5. From the task pane, select MPLS Traceroute.

The MPLS Traceroute Service Type - Service Namewindow appears.

6. In the Endpoint Device section, do the following:

a. From the Ingress Device list, select the ingress device of the LSP, whose IP address

to be used as the packet source address. The local router always is considered to

be the ingress router,which is thebeginningof theLSP.The softwareautomatically

determines the proper outgoing interface and IP address to use to reach the next

router in an LSP.
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b. From the Egress Device list, select the egress device that is connected using the

LSP from the ingress LSP, whose IP address is used of the target for the MPLS

traceroute packets.

The name of the LSP is displayed in the LSP Name field.

7. On the Advance Options list, do the following:

a. In the Probe Retries field, specify the number of times to resend probe. The range

of values is 1 through 9. The default value is 3.

b. In the Hop Limit field, specify the maximum number of routers that an LSP can

traverse. The configured hop limit includes the ingress and egress routers. You can

specify ahop limit for anLSPand forbothprimaryandsecondarypaths.Bydefault,

each LSP can traverse amaximum of 255 hops, including the ingress and egress

routers. The number of hops can be from 2 through 255. (A path with two hops

consists of the ingress and egress routers only.)

c. In the Class of Service field, specify the class-of-service (CoS) value given to all

packets in theLSP.TheCoSvaluemightaffect the schedulingorqueuingalgorithm

of traffic traveling along an LSP. A higher value typically corresponds to a higher

level of service. The range is from 1 through 7. If you do not specify a CoS value, the

IP precedence bits from the packet’s IP header are used as the packet’s CoS value

8. In the Format list, select XML to display the result or the response of the MPLS

traceroute operation in XML format. Alternatively, select ASCII to display the output

in the format in which it is displayed on the CLI. The Junos XML API is an XML

representation of Junos configuration statements and operationalmode commands.

Junos XML configuration tag elements are the contents to which the Junos XML

protocol operations apply. Junos XML operational tag elements are equivalent in

function to operational mode commands in the CLI, which administrators use to

retrieve status information for a device.

9. Click Traceroute to start the traceroute application and to send the MPLS traceroute

requests from the source to the destination device.

The results of the traceroute operation are displayed in the Response Console pane

at the bottom of the MPLS Traceroute Service Type - Service Namewindow.

Related
Documentation

MPLS Connectivity Verification and Troubleshooting Methods on page 1178•

• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185
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Monitoring Network Reachability by Using theMPLS Ping Capability for RSVP LSPs

In IP networks, you can use the ping and traceroute commands to verify network

connectivity and find broken links or loops. In an MPLS-enabled network, you can use

thempls ping and trace mpls commands to detect plane failures in different types of

MPLS applications and network topologies.

1. From theView selector, selectServiceView. The functionalities that you can configure

in this view are displayed.

2. Click theMonitormode icon in the Service View of the Connectivity Services Director

banner. The workspaces that are applicable to this mode are displayed.

3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside Tunnels > LSPs, and select the service for which you

want to run the ping application.

5. From the task pane, select MPLS Ping. The MPLS Ping Service Type - Service Name

window appears.

NOTE: Awarningmessage is displayed in the window stating that the
MPLS echo request to the devicemight be timed out if the response is
delayed from the device.

6. In the Endpoint Device section, do the following:

a. From the Ingress Device list, select the source device, whose IP address is to be

used as the packet source address.

b. From the Egress Device list, select the target endpoint, which IP address of the

target for the MPLS ping packets or echo requests. The source device sends an

MPLS echo request packet to the specified IP or IPv6 address or, alternatively,

sends MPLS echo packets to the egress node in a point-to-multipoint LSP. The

MPLS echo request packets and echo reply packets created by this command use

the LDP IPv4 LSP sub-TLVdescribed in RFC4379—DetectingMulti-Protocol Label

Switched (MPLS) Data Plane Failures (February 2006).

7. On the Advance Options list, do the following:
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a. In the Ping count (packets) field, enter the number of packets to send to the

destination address, in the range 0–4294967295. The default value is 5 and 0

(zero) means ping forever.

b. In the Ping size (bytes) field, specify the number of bytes comprising the MPLS

packet, including theheader, in the range0–64000. Thedefault value is 100bytes.

c. In the ForwardingClass field, specify the valueof the forwarding class for theMPLS

ping packets.

d. In the Sweep field, configure the payload size, which enables you to vary the sizes

of theechopacketsbeingsent.Thiscapability isuseful fordetermining theminimum

sizesof theMTUsconfiguredon thenodesalong thepath to thedestinationaddress.

This reduces packet fragmentation, which contributes to performance problems.

The default is not to sweep; all packets are of the same size.

e. From the Reply Mode field, select the reply mode for the echo request packet:

• IP-UDP—Specifies that the echo request packet is an IPv4 UDP packet

• Application Level Control Channel—Specifies that the echo request packet is

replied using the application-level control channel connection.

8. From the Format list, select XML to display the result or the response of the MPLS

ping operation in XML format. Alternatively, select ASCII to display the output in the

format inwhich it is displayed on theCLI. The Junos XMLAPI is an XML representation

of Junos configuration statements and operational mode commands. Junos XML

configuration tag elements are the contents to which the Junos XML protocol

operations apply. Junos XML operational tag elements are equivalent in function to

operational mode commands on the CLI, which administrators use to retrieve status

information for a device.

9. Click Ping to start the ping operation and to send the MPLS echo requests from the

source to the destination device.

The results of the ping operation are displayed in the Response Console pane at the

bottom of the MPLS Ping Service Type - Service Namewindow.

Related
Documentation

• MPLS Connectivity Verification and Troubleshooting Methods on page 1178

• Using MPLS Ping on page 1179

• Pinging VPNs, VPLS, and Layer 2 Circuits on page 1181

• Monitoring Network Reachability by Using the MPLS Ping Capability on page 1183

• MonitoringNetworkReachabilitybyUsing theLayer3VPNPingCapabilityonpage 1185
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PART 20

Appendix: Managing Network Activate
Features Using the Older Version of
Services Activation Director

• Service Design: Working with E-Line, IP, and E-LAN Service Templates on page 1707

• Service Provisioning: Working with Threshold Alarm Profiles on page 1731
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CHAPTER 61

Service Design: Working with E-Line, IP,
and E-LAN Service Templates

• Service Templates Overview on page 1708

• Service TemplatesWorkflow on page 1709

• Applying a Service Template to a Service Definition on page 1710

• Creating a Service Template on page 1711

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715

• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

• Modifying a Service Template on page 1719

• Specifying Service-Specific Values on page 1720

• User Privileges in Service Templates on page 1728

• Provisioning Dynamic Attributes to Specify the Device XPath on page 1729

• Viewing Service Template Inventory on page 1730

1707Copyright © 2019, Juniper Networks, Inc.



Service Templates Overview

ServiceTemplatesprovidesapowerfulmechanismtoconfigureadvancedservice-related

options that are not exposed via the service order creation workflow. Create and attach

one or more service templates to a service definition to define any provisioning-related

configuration option beyond the current coverage of Network Services. Using a single

template, the sameparameter values canbepushed toall service instances.Usemultiple

templates to pushdifferent sets of parameters to different endpoints in the same service

order.

The service specific values in service templates enable configuration values to be

automatically resolved at the timeof deployment,without the intervention of the service

provisioner. The template designer can also enable the service provisioner to edit

parameters in the template.

NOTE: Service templates usually contain “Service Specific Values.” These
cannot and should not be edited by service provisioners. The service specific
values are resolved by Network Services and the device.

As an extension to Device Templates, Service Templates is designed exclusively for the

purpose of service configuration. Configuration of all other options is available through

Device Templates. See Device Templates Overview. The Service Templates workspace

is located under Service Design in Network Services.

Related
Documentation

Service TemplatesWorkflow on page 1709•

• Applying a Service Template to a Service Definition on page 1710

• Creating a Service Template on page 1711

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715

• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

• Creating a Service Order Based on a Service Definition with a Template on page 927
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Service TemplatesWorkflow

A designer, who is typically a network engineer or someone with an equivalent level of

knowledge, uses Service Templates to apply service specific values (service variables)

by creating service templates. The designer then attaches one or more templates to a

service definition.

A serviceprovisioner selectsadefinition tocreatea serviceorder. Any templatesattached

to the definition can be applied and, if required, edited by the provisioner during endpoint

configuration.

Deployment automatically resolves service specific values.

The roles of designer and provisioner require the appropriate user privileges (see “User

Privileges in Service Templates” on page 1728).

• Service Designer Tasks on page 1709

• Service Provisioner Tasks on page 1709

Service Designer Tasks

The service designer’s role in the service template workflow covers the following tasks:

1. Creating a Service Template on page 1711

2. Finding Configuration Options on page 1716

3. Specifying Service-Specific Values on page 1720

4. Applying a Service Template to a Service Definition on page 1710

5. Modifying a Service Template on page 1719

6. Deleting a Service Template on page 1714

7. Exporting a Service Template on page 1715

8. Importing a Service Template on page 1718

9. Viewing Service Template Inventory on page 1730

Service Provisioner Tasks

The service provisioner’s tasks in the service template workflow remain creating and

deploying service orders. “Creating a Service Order Based on a Service Definition with a

Template” on page 927 covers service template handling within a service order.

Related
Documentation

Service Templates Overview on page 1708•

• Applying a Service Template to a Service Definition on page 1710

• Creating a Service Template on page 1711

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715
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• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

Applying a Service Template to a Service Definition

To deploy a service template, youmust apply it to a service definition. Both templates

and definitions are service type specific. If you have an E-Line service template in the

system, you can apply it to a definition of the corresponding service type: E-Line. You

cannot attach it to a multipoint-to-multipoint, or IP service definition. Service variables

in a template must be compatible with the definition to which you attach the template.

Each service type has its own set of variables, and if the template you want to attach

contains any service variables not compatible with the service and definition type, the

template will not appear in the definition’s list of available templates.

You can apply multiple templates to a single definition.

To apply a service template to a service definition:

1. Create or import a service template. See “Creating a Service Template” on page 1711

or “Importing a Service Template” on page 1718.

2. in the Network Services > Connectivity view pane, select Service Design >Manage

Service Definitions.

3. Click Create E-Line Service Definition, or Create E-LAN Service Definition, or Create IP

Service Definition.

The Generalwindow appears.

4. From the Service Template Definition section, click Add to select a template. The

Choose Templates dialog box appears. Select the desired template(s) and clickOK

to attach the templates to the service definition.

The list of templates available is filtered according to the type of service definition.

5. For instructions on filling in the rest of the fields on this page and completing the

definition, seeCreatinganE-LineServiceDefinition, “CreatingaMultipoint-to-Multipoint

E-LANService Definition” on page 619, “Creating a Point-to-Multipoint E-LANService

Definition” on page 641, or “Creating a Full-Mesh IP Service Definition” on page 669.

Related
Documentation

Service Templates Overview on page 1708•

• Service TemplatesWorkflow on page 1709

• Creating a Service Template on page 1711

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715
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• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

Creating a Service Template

There are two stages in creating a template. This topic deals with the first stage, while

the second stage is covered by “Specifying Service-Specific Values” on page 1720.

Service templates are specific to service definitions. Both are specific to service types,

so that if you are dealingwith an IP service type, for example, both your service definition

and service template must be of that type. A service template’s type is determined by

the service variables (service specific values) it uses. Some service variables are specific

to one service type only. A table in “Specifying Service-Specific Values” on page 1720 lists

the available variables and their types.

NOTE: You can create a service template only using the older version of the
Services Activation Director GUI and not using the Connectivity Services
Director GUI.

1. Naming a Template and Selecting Configuration Options on page 1711

2. Configuration Options, Their Data Types and the Tabs Displayed on page 1713

Naming a Template and Selecting Configuration Options

You create configuration pages as part of the process of selecting configuration options,

to organize and group those options.

To name the template :

1. In the Network Activate task pane, select Service Design >Manage Service Templates

> Create Service Template.

The Create Service Template page appears, showing the supported device families

above the Available Configuration panel and the Selected Configuration Layout panel.

2. In the Name field, enter a unique name for the template (limit of 63 alphanumeric

characters without spaces).

3. (Optional) Enter a description of the template in the Description field (limit of 255

characters).

The description is displayed when you double-click the template on the Service

Template inventory page.

The list in the Available Configuration panel displays the Junos OS configuration options

available. In the Selected Configuration Layout panel, construct logical groupings by

putting the options you select into pages.
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To select configuration options and create a configuration page:

5. In the Create Service Template page, in the Available Configuration panel, expand the

list of options by opening the list or searching, as described in “Finding Configuration

Options” on page 1716.

6. Select an option in the Available Configurations panel andmove it to a page in the

Selected Configuration Layout panel.

The first page, “Config Page 1,” is available by default.

There are two ways to move an option from the Available Configurations panel to a

page in the Selected Configuration Layout panel:

a) Select an option, and drag it and drop it onto the name of the page or any options

already on a page.

b) Select the nameof a page by clicking on it, then click the desired option, and finally

click the arrow between the panels to transfer the option to the page.

Any sequence is permissible, and there is no limit on the number of options a page

can hold.

NOTE: You cannot put children of the same parent into different pages.

NOTE: Options that are either subsidiary or integral to others bring their
respective parents and children with themwhen youmove them onto a
page. If you drill down and select a parameter deep in the hierarchy, such
as L3 interface, dragging that parameter causes all the other parameters

that require configuration to comewith it. In this example, youget not only
L3 interface, but also Name, both of which are under Vlan. This ensures

that all the parameters required for a particular configuration option are
present in your configuration group.

Conversely, you cannot add an option of the ’choice’ data type directly to
a page. Instead, add a child of the choice to add the choice itself.

7. Select your configuration grouping by double-clicking the placeholder name, Config

page x.

On the right, the General tab appears.

8. (Optional) In the Label field on theGeneral tab, replace the placeholder name (Config

Page x) with amore informative name.
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9. (Optional) Enter a description of the page in the Description field.

10. Save your selections by electing another tab or another configuration option or

configuration page.

Clicking Next also saves your settings.

To save and finish the template later, click Finish. To restart work on the template,

youmust modify it.

Add or remove pages as desired.

To add a page:

• Click the plus icon [+] at the top left of the Selected Configuration Layout panel.

A new page appears: “Config Page x.”

To remove a page or a configuration option from a page:

• Select the page or configuration option and click the X at the top left of the Selected

Configuration Layout panel.

The page disappears.

Configuration Options, Their Data Types and the Tabs Displayed

Table 272 on page 1713 lists the possible data types of the configuration options, and the

tabs associated with each type.

Table 272: Data Types and Tabs

Tabs

Data Types AdvancedValidationDescriptionGeneral

**Container

****Table

****String - Key column in a table

****String

****Integer [Number]

***Boolean

***Enumeration

***Choice
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• All table configuration options have a key column by default.

• You can use any sequence to move options onto your pages.

The subsequent task is “Specifying Service-Specific Values” on page 1720.

See Also Service Templates Overview on page 1708•

• Service TemplatesWorkflow on page 1709

• Applying a Service Template to a Service Definition on page 1710

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715

• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

• Creating a Service Order Based on a Service Definition with a Template on page 927

Deleting a Service Template

If a service definition is using a template, you cannot delete that template.

To delete a service template:

1. In the Network Activate task pane, select Service Design >Manage Service Templates.

The Service Template inventory page appears.

2. Select the template you want to delete.

3. Either right-click the selected template or open the Actionsmenu and select Delete

Service Template.

The Delete Templatewindow appears, displaying the following information about it:

• The name of the template,

• The username of the person who last modified it,

• The date when it was last updated,

• Its state.

4. To delete the template, click Delete.

TheManage Service Templates page appears, displaying any remaining templates.

5. To abort deletion, click Cancel.
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TheManage Service Templates page appears, displaying all the templates.

Related
Documentation

Service Templates Overview on page 1708•

• Service TemplatesWorkflow on page 1709

• Applying a Service Template to a Service Definition on page 1710

• Creating a Service Template on page 1711

• Exporting a Service Template on page 1715

• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

Exporting a Service Template

Exporting a template enables you to transfer it to another Junos Space fabric.

Before you begin, youmust have a template already created.

To export a template:

1. In the Network Activate task pane, select Service Design >Manage Service Templates.

Select the definition to export.

2. OpentheActionsmenuandselectExportor right-click the templateandselectExport.

The Export Template dialog appears.

3. Click Download file for selected templates (tgz format).

TheOpening xxx.tgzwindow appears. (XXX is a placeholder for the name of the

template.)

4. Select Save File and clickOK.

Youmay have to toggle between the radio buttons to activate theOK button.

The Enter name of file to save to ... dialog appears.

5. Rename the file if desired and save it to the appropriate location.

The Export Template dialog reappears.

6. Click Close.

Although the exported template file is an .xml file, it is saved as a .tgz file, which is the

format the system uses to import xml files.

You can now import the template into another Junos Space fabric.
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Related
Documentation

Service Templates Overview on page 1708•

• Service TemplatesWorkflow on page 1709

• Applying a Service Template to a Service Definition on page 1710

• Creating a Service Template on page 1711

• Deleting a Service Template on page 1714

• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

• Creating a Service Order Based on a Service Definition with a Template on page 927

Finding Configuration Options

There are three ways to locate particular configuration options: you can use the search

function, or display thewhole list, or use theavailable serviceperspectives (E-Line, E-LAN,

IP).

Searching

To search for a specific configuration option:

1. Click the magnifying glass icon.

The search term bar appears.

2. Enter your search term.

As soon as you enter the first two letters, the bar opens downwards, displaying the

search results.

Search displays only the first ten matches for your term .

TIP: Search results appear while you are typing. You can continue typing
or even delete text. Note that the cursormight not be visible in the search
field if the focus is somewhere within the list of search results.

The order of the search results is not dependent on the order of those items in the

AvailableConfigurationpanel. It is basedon thesimilarityof your search termto indexed

fields.

3. While the result list is still visible, select a result by:

• Using the mouse to click on it.

• Pressing the Enter key to select the first result in the list.

• Using theupanddownarrowkeyson thekeyboard tomove through the list, pressing

the Enter key to select a result.
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The tree in the Available Configuration panel jumps to the location of the match for

the result you selected and highlights the option. The list of results disappears.

4. (Optional) To review the results that you did not select, either:

• Click the white arrows next to the Search field.

Click the arrow to the left tomove to the result listed previous to the selected result.

Click the arrow to the right to move to the resulted after the selected result.

• Use the left and right arrow keys on the keyboard.

Press thearrow to the left tomove to the result listedprevious to the selected result.

Press the arrow to the right to move to the resulted after the selected result.

5. To close the search bar, click the X in the top right corner of the bar.

Displaying all configuration options: To display the top level configuration options, click
the plus sign [+] or expansion icon at the top of the tree in the Available Configuration

panel. Many of the options contain further parameters. To display these, click on the plus

sign [+] or expansion icon left of the option.

Service Perspective: The configuration parameters are grouped service wise. In the
Connectivity Services Director application you can choose either of the following service

perspectives:

• E-Line

• E-LAN

• IP

TheAvailableConfigurationpanel displays the configuration parameters that are specific

to the selected service.

For example, if you select IP in the Available Configuration the following configuration

parameters are displayed:

• Interface

• Policy statement

• Instance

Related
Documentation

Service Templates Overview on page 1708•

• Service TemplatesWorkflow on page 1709

• Applying a Service Template to a Service Definition on page 1710

• Creating a Service Template on page 1711

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715
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• Importing a Service Template on page 1718

Importing a Service Template

Importing a service template enables you to transfer it from another Junos Space fabric.

Before you begin, make sure you have access to a template file. Although it is an xml file,

the system expects to find it packed into a .tgz file, which is the way the system exports

.xml files.

To import a template :

1. In the Network Activate task pane, select Service Design >Manage Service Templates

> Import Service Template.

The Import Service Template dialog appears.

2. Click Browse.

The File Uploadwindow opens.

3. Navigate to the appropriate file, select it, and clickOpen.

The Import Service Template dialog reappears, displaying the name of the selected

file in the Template File field.

NOTE: Under some circumstances, when the Import Definition dialog

reappears, it displays amessagebeginningConfirmnamemappingof. This

message serves as a warning that the system has changed the name of
the definition itself. This happens when you import a template with the
same name as an existing template.

4. Click Import.

TheManage Template Definitions page reappears, displaying the newly imported

template definition.

Related
Documentation

Service Templates Overview on page 1708•

• Service TemplatesWorkflow on page 1709

• Applying a Service Template to a Service Definition on page 1710

• Creating a Service Template on page 1711

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715

• Finding Configuration Options on page 1716
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• Creating a Service Order Based on a Service Definition with a Template on page 927

Modifying a Service Template

If a service is using a definition, you cannot modify any template associated with that

definition. Tomodify a template attached to a service definition that is not in use:

1. In the Network Activate task pane, select Service Design >Manage Service Templates.

TheManage Service Templates inventory page appears.

2. Select the template you want to modify.

It is not possible to select multiple templates for simultaneous modification.

3. Right-click the selected template or open theActionsmenu and selectModifyService

Template.

TheModify Service Template page appears. The options selected in the template to

bemodified are not visible initially.

4. To see the options currently selected in the template, click the plus [+] icon(s) next

to the configuration pages in the Selected Configuration Layout panel.

Whenall theplus [+] icon(s) are open, all the currently selected configurationoptions

are visible.

5. Add and/or remove configuration pages and options as required. For instructions on

this, see “Creating a Service Template” on page 1711.

6. Specify service-specific data with service variables as required. For instructions on

this, see “Specifying Service-Specific Values” on page 1720.

7. To finish modifying the template, click Finish.

Related
Documentation

Creating a Service Template on page 1711•

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715

• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

• Specifying Service-Specific Values on page 1720

• Creating a Service Order Based on a Service Definition with a Template on page 927
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Specifying Service-Specific Values

Usingservice-specific variables, youcanspecify values thatNetworkServicescan resolve

when the service order is deployed.

Service definitions filter the service templates available for attachment according to the

set of service variablesassociatedwith each servicedefinition type. If a template contains

any variables that are not in the filter set for that service definition type, the template

does not appear in the selection list, so you cannot attach it to the definition.

You can set multiple variables for a single value.

The following table shows the correlation between service definition types and service

variables:

Table 273: Service Definition Types and Associated Service Variables

IPE-LANE-Line

$CustomerName$CustomerName$CustomerName

$PEIPAddress--

--$PseudowireNeighborAddress

$RoutingInstanceName$RoutingInstanceName-

$ServiceBGPGroupName--

$ServiceBGPNeighbor--

$ServiceDefinition$ServiceDefinition$ServiceDefinition

$ServiceEndPoint$ServiceEndPoint$ServiceEndPoint

$ServiceOSPFArea--

$ServiceOSPFIntfName--

$ServiceSubInterfaceName$ServiceSubInterfaceName$ServiceSubInterfaceName

$ServiceUnitName$ServiceUnitName$ServiceUnitName

$ServiceVlan$ServiceVlan$ServiceVlan

-$ServiceVlanIdRange$ServiceVlanIdRange

-$SiteName-
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Table 273: Service Definition Types and Associated Service Variables (continued)

IPE-LANE-Line

--$KompellaServiceSubInterfaceName

$MartiniServiceSubInterfaceName

-$VPLSServiceSubInterfaceName-

--$MartiniServiceLocalSwitchInterfaceName

$VRFExportPolicy--

$VRFImportPolicy--

The following examples show how the service variablesmap to the device configuration

attributes:
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Figure 64: E-Line Example: Device Configuration Deployed Through Network Services
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Figure 65: E-LAN Example: Device Configuration Deployed Through Network Services
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Figure 66: IP Example: When OSPF Is a CE-PE Protocol
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Figure 67: IP Example: When BGP Is a CE-PE Protocol

The last two service variables, $ServiceDefinition and $CustomerName, appear in the

Service Provisioning workspace, in Service Order details.

To specify service specific values in a template:

1. in the Network Services > Connectivity view pane, select Network Services > Service

Design >Manage Service Templates > Create Service Template.

The Create Service Templatewindow appears.

2. Add the configuration option forwhich youwant to supply a service specific value (for

instructions on adding an option, see “Creating a Service Template” on page 1711).

3. Fill in information in the General tab.
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a. (Optional) To rename the selected option, in the Label box, type a name for that

configuration option.

When you save bymoving on to the next page, Specifying default values for service

parameters, the new name appears under Config Page 1 in the Selected

Configuration Layout.

TIP: The default labels are ambiguouswithout the context of the tree.
For example, there aremany options called pool.

TheDataTypeboxdisplays the selected component’s data type,whichdetermines

not only which tabs are displayed, but also the method of validation. For tables

showing the various data types and their tabs, see “Creating a Service Template”

on page 1711.

b. (Optional) If the data type of the selected option is String, you can change it to

Enumeration by clicking the String option button while the option is selected.

A box to contain the choices appears, and next to it, plus [+] andminus [-] icons.

c. To specify the enumeration choices, for each one, click the plus [+] icon and type

text in the field that appears (limit 255 alphanumeric characters).

TIP: Keepyour choices short, otherwise theyarehard to readwhenyou
specify the default values. You can create up to 23 choices.

Click OK to save each entry, or to delete it, click Close.

To close the window, click Close or the X.

d. To save your entries on the General tab, select another tab or another option, or

click Next or Finish.

4. Fill in information in the Description tab.

a. In the Description field, type [additional] descriptive text for the selected

configuration option, or leave the default text, if desired.

b. To save your the description, move to another tab or another option, or click Next.

5. Fill in information in the Validation tab.

a. Specify the parameters for the option in the appropriate fields.

If the fields already display default values and you change them, ensure that your

values do not exceed the default values.

b. To save your entries, select another tab or another option, or click Next or Finish.

6. Fill in information in the Advanced tab.

• (Optional) If you intend to use a service variable, select the Service Specific Value

check box.
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Operator visibility changes to hidden. The variable is resolved by Network Services

at the time the service is deployed. If the operator does change this variable,

deployment fails.

• If you are not using a service variable for this option, leave theService Specific Value

check box unchecked, andmake a selection from the Operator Visibility choices.

Select the Editable option button if you want the service provisioner to be able to

change the value.

7. Click Next.

The Specify default values for configuration parameters page appears.

8. Youmust set all the default values on this page; otherwise, service order deployment

fails.

9. Click Click to configure as often as necessary to reach the point where you can select

a service-specific value,whichappearsasadropdown list containing systemvariables.

10. Click the down arrow at the right of the list to display the available variables.

11. Select the appropriate variable.

If necessary, consult the previous examples to determine which variables to use.

NOTE: If you use thewrong service-specific variable, service deployment
fails. The value is not resolved, and service deployment is blocked.

If you select the wrong variable by mistake, delete it by clicking the X to the right of

the variable.

NOTE: To create customized service-specific variables:

1. Type the customized name followed by an underscore and dollar
symbol.

2. From the list, select the service-specific variable that you want to
associate.

3. To save the customized service-specific variable, click the Save link.

12. If youmove away from the page to set other parameters by clicking the breadcrumbs

above the panel, a message prompts you to save your work.
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• To save your selection, click Save.

• To cancel your selection, click Undo.

• To finish the template, click Finish.

• To abandon the template, click Cancel.

The next task is “Applying a Service Template to a Service Definition” on page 1710.

Related
Documentation

Creating a Service Template on page 1711•

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715

• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

• Modifying a Service Template on page 1719

• Creating a Service Order Based on a Service Definition with a Template on page 927

User Privileges in Service Templates

In Junos Space Users, the two roles for Service Templates users are predefined: Service

Designer for the template designer and Service Manager for the provisioner. For ease of

use, in this documentation we refer to the Service Designer as the designer, and to the

Service Manager as the provisioner.

Youmust have Service Designer privileges to create, delete, modify, andmanage service

templates and service definitions.

Youmust have Service Manager privileges to create and deploy service orders. However,

if youwish toedit service templatesoraddordelete them, youmusthaveServiceDesigner

privileges.

Related
Documentation

Creating a Service Template on page 1711•

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715

• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

• Modifying a Service Template on page 1719

• Specifying Service-Specific Values on page 1720

• Role-Based Access Control Overview
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Provisioning Dynamic Attributes to Specify the Device XPath

You have the flexibility to create and provision a dynamic attribute. You canmark an

attribute of a service template as dynamic, and you can obtain the values for these

dynamic attributes from a specific device. To create a dynamic attribute, youmust first

mark an attribute of a service template as dynamic and then specify the device XPath

for the dynamic attribute.

Tomarkanattributeasdynamic in the service template that youarecreatingormodifying,

set the Data Type as Enumeration. If a service template attribute is dynamic while you

create a service order, all possible values from the device configuration are listed in the

Flexible Service Attributes link.

If you set the Data Type as Enumeration, you need to specify a default value. This default

value is listed if the device configuration contain no values.

To specify the device XPath for dynamic attributes:

1. From the Network Activate task pane, select Service Design >Manage Service

Templates > Create Dynamic Attributes.

The Create Dynamic Attributes window appears.

The Configuration Pages pane lists all the service templates.

NOTE: The service template in the Configuration Pages pane appears
dimmed if a service template is attached to a service and you cannot set
the dynamic attributes.

2. Select a service template.

The right pane lists all the attributes of the selected service template. If youmouse

over an attribute, the XPath of the attribute is displayed.

3. Select the Dynamic check box to enable the XPath field.

NOTE: You can enable the Dynamic check box only for the attribute with

Data Type as Enumeration.

4. Specify the device XPath in the XPath field.

NOTE: The device XPathmust start with /device.
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From the specified device XPath, all the values from the device configuration are

obtained.

5. ClickOk.

Related
Documentation

Creating a Service Template on page 1711•

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715

• Finding Configuration Options on page 1716

• Importing a Service Template on page 1718

• Modifying a Service Template on page 1719

• Specifying Service-Specific Values on page 1720

Viewing Service Template Inventory

TheManage Service Templates inventory page enables you to view andmanipulate

templates individually or collectively. Youcanbrowse, zoom, filter, tag, andsort templates.

You can select one, several, or all templates and perform actions on them using the

actions in the Actionsmenu or by right-clicking a template.

To view theManage Service Templates page, in the Network Services > Connectivity task

pane, select Service Design >Manage Service Templates. TheManage Service Templates

inventory page appears.

You can do the following:

• Use the Search function to find a particular template.

• Select all templates on a page, or you can deselect them.

• You can refresh the page by clicking on the Refresh icon in the status bar.

• You can use the Actionsmenu tomodify, delete, export, and tag templates.

Related
Documentation

• Service Templates Overview on page 1708

• Service TemplatesWorkflow on page 1709

• Applying a Service Template to a Service Definition on page 1710

• Creating a Service Template on page 1711

• Deleting a Service Template on page 1714

• Exporting a Service Template on page 1715
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CHAPTER 62

Service Provisioning: Working with
Threshold Alarm Profiles

• Creating a Threshold Alarm Profile on page 1731

• Viewing Threshold Alarm Profile Performance Parameters on page 1733

• Attaching a Threshold Alarm Profile to a Service Definition on page 1734

• Viewing Threshold Alarm Profile Performance Status on page 1734

• Editing a Threshold Alarm Profile on page 1736

Creating a Threshold Alarm Profile

To create a Threshold Alarm Profile, in the Network Activate task pane, select Service

Design >Manage Threshold Alarm Profile > New.

The Create Threshold Alarm Profilewindow appears.

1. Enter information in the relevant fields of the Create Threshold Alarm Profilewindow:

ActionField

Type a name for the Threshold Alarm Profile.Name

Select the service type:

• E-Line

• E-LAN

Service type
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ActionField

Select the performance parameters that you want to include in the profile.

The available parameters depend on the Service type selected.

Valid values are:

• Average one-way delay—Average one-way frame delay for the statistics displayed.

• Average one-way delay variation—Average one-way “frame jitter” for the statistics displayed.

• Best-case one-way delay—Lowest one-way frame delay for the statistics displayed.

• Worst-case one-way delay—Highest one-way frame delay for the statistics displayed.

• Average two-way delay—Average two-way frame delay for the statistics displayed.

• Average two-way delay variation—Average two-way “frame jitter” for the statistics displayed.

• Best-case two-way delay—Lowest two-way frame delay for the statistics displayed.

• Worst-case two-way delay—Highest two-way frame delay for the statistics displayed.

• Near-end frame loss—Count of frame loss associated with ingress data frames.

• Far-end frame loss—Count of frame loss associated with egress data frames.

• Near-end loss ratio—Ratio, expressed as a percentage, of the number of service frames not delivered
divided by the total number of service frames during time interval T at the ingress interface.

• Far-end loss ratio—Ratio, expressed as a percentage, of the number of service frames not delivered
divided by the total number of service frames during time interval T at the egress interface.

• Average near-end frame loss—Average frame lossmeasured in this session associatedwith ingress data
frames.

• Average near-end loss ratio—Average frame loss ratio measured in this session associated with ingress
data frames.

• Average far-end frame loss—Average frame loss measured in this session associated with egress data
frames.

• Average far-end loss ratio—Average frame loss ratio measured in this session associated with egress
data frames.

• Near-end best case loss—Lowest frame loss measured in this session associated with ingress data
frames.

• Near-end best case loss ratio—Lowest frame loss ratio measured in this session associated with ingress
data frames.

• Near-end worst case loss—Highest frame loss measured in this session associated with ingress data
frames.

• Near-endworst case loss ratio—Highest frame loss ratiomeasured in this sessionassociatedwith ingress
data frames.

• Far-end best case frame loss—Lowest frame loss measured in this session associated with egress data
frames.

• Far-end best case loss ratio—Lowest frame loss ratio measured in this session associated with egress
data frames.

• Far-endworst case loss—Highest frame lossmeasured in this sessionassociatedwithegressdata frames.

• Far-end worst case loss ratio—Highest frame loss ratio measured in this session associated with egress
data frames.

Click Update after you select a parameter from the drop-down list to add the parameter to the threshold
alarm profile.

Performance
Parameters

Type comments to describe the Threshold Alarm Profile.Comments

This column displays the names of the parameters selected in the Performance Parameters field.Perf Parameter
Name
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ActionField

This parameter is configured automatically, depending on the performance parameters selected. You
cannot edit this field. The possible values are:

• Absolute

• Relative

Data Type

Specify the maximum duration during which threshold crossing is allowed.Observation
Interval(s)

Specify a threshold value. If the performance data exceeds the value specified in the Threshold field, the
Junos Space application or OpenNMS software generates a threshold alarm for the selected service.

Threshold

Specify the conditional status by which you want the performance data to be evaluated relative to the
specified threshold.

Condition

Specify the relative severity of the performance test results, which determines when an alarm is raised:

• Critical

NOTE: Currently, you can specify Critical only.

Severity

This column displays a message generated by the application according to the test being performed. This
message is updated in the threshold alarm.

Message

2. When you complete entering information in the Threshold AlarmProfilewindow, click

Create.

Related
Documentation

Viewing Threshold Alarm Profile Performance Parameters on page 1733•

• Attaching a Threshold Alarm Profile to a Service Definition on page 1734

• Viewing Threshold Alarm Profile Performance Status on page 1734

• Editing a Threshold Alarm Profile on page 1736

Viewing Threshold Alarm Profile Performance Parameters

To view a list of existing Threshold Alarm Profiles, in the Network Activate task pane,

select Service Design >Manage Threshold Alarm Profile. TheManage Threshold Alarm

Profilewindowappears. To view theperformanceparameters that are set for a particular

Threshold Alarm Profile:

1. Double-click the selected profile.

The View Threshold Alarm Profile Detailswindow displays the profile parameter

settings.

2. Whenyou finishviewingThresholdAlarmProfileperformanceparameters, clickClose.
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Related
Documentation

Creating a Threshold Alarm Profile on page 1731•

• Attaching a Threshold Alarm Profile to a Service Definition on page 1734

• Viewing Threshold Alarm Profile Performance Status on page 1734

• Editing a Threshold Alarm Profile on page 1736

Attaching a Threshold Alarm Profile to a Service Definition

To attach a Threshold Alarm Profile to a service definition, in the Network Services >

Connectivity view pane, select the path appropriate for the type of service definition that

you want to create, as follows:

• Service Design >Manage Service Definitions > Create E-Line Service Definition

• Service Design >Manage Service Definitions > Create E-LAN Service Definition

1. In the Generalwindow, as you enter information for the service definition, in the

Threshold Alarm Profile field, select the Threshold Alarm Profile that you want to

attach to this service definition.

2. When you complete entering information for the service definition, click Create.

Related
Documentation

Creating a Threshold Alarm Profile on page 1731•

• Viewing Threshold Alarm Profile Performance Parameters on page 1733

• Viewing Threshold Alarm Profile Performance Status on page 1734

• Editing a Threshold Alarm Profile on page 1736

Viewing Threshold Alarm Profile Performance Status

When you successfully attach aThresholdAlarmProfile to a service definition and create

an associated and functioning service order, you can check the performance status of

the service.To run performancemanagement for a service:

NOTE: Youcanperformthisprocedure fromtheConnectivityServicesDirector
GUI.

1. Select Service View from the View Selector. The workspaces that are applicable to

routing and tunnel services are displayed.

2. From the Connectivity Services Director user interface, click the Deploy icon on the

Connectivity Services Director banner. The functionalities that you can configure in

this mode are displayed in the task pane.
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3. From the Service View pane, which is the left pane in the window, click the plus sign

(+) next toNetworkServices to expand the treeanddisplay thedifferent service types

that you can configure.

4. Click the plus sign (+) beside E-Line Services to view the E-Line service orders. Select

the E-Line service order for which you want to monitor performance statistics.

Alternatively, click the plus sign (+) beside E-LAN Services to view the E-LAN service

orders. Select the E-LAN service order for which you want to monitor performance

statistics.

5. From the Network Services > Connectivity task pane, select Service Provisioning >

Manage Services.

6. Select the service you want to check and select Audit > Run Functional Audit at the

top of the table.

7. When the functional audit is running, to run performancemanagement in Monitor

mode of Service View, from the tasks pane, selectOAM>Y1731 > Start. The Monitor

Performance Statistics window is displayed.

The system begins to collect performance data pertaining to the parameters you

specified in the Threshold Alarm profile: for example, Average-Two-Way-Delay,

Best-Two-Way-Delay, or Average-One-Way-Delay.

If dataexceeds the threshold value specified in theThresholdAlarmProfile, the system

generatesa thresholdalarm.Thevalue in theSLAStatuscolumn in theManageServices

window changes to SLA Violated. If the data does not cross the threshold value

specified in the Threshold Alarm Profile, the value in the SLA Status column changes

to SLA Violation Cleared.

NOTE: ToviewY1731 PMstatistics, the functional audit status (FAStatus)

must be Up.

Related
Documentation

Creating a Threshold Alarm Profile on page 1731•

• Viewing Threshold Alarm Profile Performance Parameters on page 1733

• Attaching a Threshold Alarm Profile to a Service Definition on page 1734

• Editing a Threshold Alarm Profile on page 1736
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Editing a Threshold Alarm Profile

To edit an existing Threshold Alarm Profiles, in the Network Activate task pane, select

Service Design >Manage Threshold Alarm Profile. TheManage Threshold Alarm Profile

window appears. To edit a particular Threshold Alarm Profile:

1. Right-click the selected profile.

The Edit Threshold Alarm Profilewindow is displayed.

2. Modify the parameters. You will be able to modify the following fields only:

• Comments

• Performance parameters

• Performance Parameters Details

3. When you finish editing Threshold Alarm Profile, click Update.

The Threshold Alarm Profile is modified.

NOTE: You cannot modify the threshold alarm profile if it is associated with
a service.

Related
Documentation

• Viewing Threshold Alarm Profile Performance Status on page 1734

Copyright © 2019, Juniper Networks, Inc.1736

Connectivity Services Director User Guide


	Table of Contents
	List of Figures
	List of Tables
	About the Documentation
	Documentation and Release Notes
	Documentation Conventions
	Documentation Feedback
	Requesting Technical Support
	Self-Help Online Tools and Resources
	Creating a Service Request with JTAC


	Part 1: Overview
	Chapter 1: Working with Connectivity Services Director
	Connectivity Services Overview
	Getting Started with Connectivity Services Director
	Connectivity Services Director REST API Overview
	Format and Conventions of RESTful Web Services
	Payload and Response Types Supported in XML and JSON Formats
	Conversion of XML Format to JSON Format

	Understanding the Need for Connectivity Services Director for Managing Services
	Benefits of a Unified User Interface for Routing and Tunnel Services with Connectivity Services Director
	Connectivity Services Director Overview
	Understanding the Connectivity Services Director User Interface
	Connectivity Services Director Banner
	View pane
	Views list
	Tasks Pane
	Alarms
	Main Window or Workspace
	Filtering the Network Tree
	Expanding or Collapsing Nodes in the Network Tree
	Searching the Network Tree

	Tables in Connectivity Services Director
	Moving and Resizing Columns
	Navigating Pages
	Displaying the Column list
	Sorting a Column
	Hiding and Exposing Columns
	Searching Table Contents
	Filtering Table Contents


	Understanding the Usage and Layout of Connectivity Services Director Views and Tasks
	Understanding Task Categories in Connectivity Services Director
	Understanding Connectivity Services Director User Administration
	Logging In to Connectivity Services Director
	Accessing the Services Activation Director GUI
	Changing Your Password for Connectivity Services Director
	Logging Out of Connectivity Services Director
	Getting Started Assistant Overview in Services Activation Director

	Chapter 2: Service View Tasks and Lifecycle Modes
	Understanding the Service View Tasks Pane in Build Mode
	Understanding the Service View Tasks Pane in Deploy Mode
	Understanding the Service View Tasks Pane in Monitor Mode
	Understanding the Service View Tasks Pane in Fault Mode
	About Build Mode in Service View of Connectivity Services Director
	Manage Service Definitions
	Prestage Devices
	Prestage Services
	Manage Threshold Alarm Profiles
	Service Definition Operations
	Audit and Troubleshooting of Services

	About Deploy Mode in Service View of Connectivity Services Director
	Manage Network Services
	Manage Deployment of Service Orders

	About Fault Mode in All Views of Connectivity Services Director
	About Monitor Mode in Service View of Connectivity Services Director
	Quick Access to Important Troubleshooting Details
	Performance Monitoring
	View and Clear Interface Information
	View Interface Status
	View Routing Table
	View MAC Table
	Traceroute for an MPLS LSP
	MPLS Ping


	Chapter 3: Network Services Overview
	Getting Started with Connectivity Services Director
	Prestaging Devices Overview
	Junos Space Layer 2 Services Overview
	E-Line Services
	Port-to-Port Service
	Single VLAN Service Using 802.1Q Interfaces
	All Traffic Service Using Q-in-Q Interface
	Range of VLANs Service with Q-in-Q Interfaces

	E-LAN Services
	Service Autodiscovery
	VPLS and Normalization


	Junos Space Layer 3 Services Overview
	Overview
	Layer 3 VPN Platform Support
	Layer 3 VPN Attributes
	Device Configuration for a Layer 3 VPN

	Provisioning Process Overview
	Network Operator Tasks—Provisioning Prerequisites
	Service Designer Tasks
	Service Provisioner Tasks

	Seamless MPLS Support in Junos Space Overview
	Service Attributes Overview
	General Attributes
	Service Type
	Signaling
	Comments
	Service Template
	Threshold Alarm Profile
	Interface Type
	Enabling Additional Features
	Customer
	Enable QoS

	UNI Settings
	Ethernet Options
	Interface
	MTU
	Customer Traffic Type
	Customer VLAN ID
	Service VLAN ID and VLAN ID Range
	Physical Encapsulation
	Logical Encapsulation
	Rate Limiting and Bandwidth
	UNI Settings for TDM Interfaces
	UNI Settings for ATM Interfaces

	Connectivity Settings
	Virtual Private LAN Service Identifier (VPLS ID)
	Auto Discovery
	Virtual Circuit Identifier (VCID) (E-Line Services Only)
	Route Targets and Route Distinguishers
	Normalized VLAN (Multipoint Services Only)
	MAC Learning
	Interface MAC Limit
	MAC Statistics
	MAC Table Size


	Advanced Settings
	Tunnel Services
	Local Switching
	Fast Reroute Priority
	Label Block Size
	Connectivity Type

	Node Settings
	Static Routes
	PIM Settings
	MVPN Settings
	MAC Settings
	Topology Settings


	Service Order States and Service States Overview
	Service Order States
	Service States

	Understanding VLAN Manipulation (Normalization and VLAN Mapping) on Ethernet Services
	VLAN Translation (Normalization) for E-LAN Services
	VLAN Mapping for VPLS Services
	Sample VLAN Configuration on MX Series and M Series PE Routers

	VLAN Pool Profiles Overview
	Redundant Pseudowires for Layer 2 Circuits and VPLS
	Types of Redundant Pseudowire Configurations
	Pseudowire Failure Detection

	VPLS over GRE Overview
	Junos Space Network Topology Overview
	Service Recovery Overview
	Multicast L3VPN Overview
	Multi-Chassis Automatic Protection Switching Overview
	Inverse Multiplexing for ATM Overview
	Rendezvous Point
	Understanding Multicast Rendezvous Points, Shared Trees, and Rendezvous-Point Trees
	Understanding PIM Sparse Mode
	Rendezvous Point
	RP Mapping Options

	Configuring Shared-Tree Data Distribution Across Provider Cores for Providers of MBGP MVPNs
	Configuring SPT-Only Mode for Multiprotocol BGP-Based Multicast VPNs
	Configuring VRF Route Targets for Routing Instances for an MBGP MVPN
	Static Pseudowire Provisioning for VPLS Services


	Part 2: Getting Started With Connectivity Services Director
	Chapter 4: Understanding Connectivity Services Director System Administration and Preferences
	Understanding Connectivity Services Director User Administration
	Understanding the System Tasks Pane
	Audit Logs Overview
	Viewing Audit Logs From Connectivity Services Director
	Managing Jobs
	Collecting Logs for Troubleshooting
	Setting Up User and System Preferences
	Accessing the Preferences page
	Choosing Server Time or Local Time
	Specifying Search Preferences
	Retaining Connectivity Services Director Reports
	Modifying Services Activation Parameter Settings
	Specifying Topology Preferences
	Changing Monitor Mode Settings
	Disabling Data Collection for Monitors
	Changing the Polling Interval
	Specifying Database History Retention

	Changing Alarm Settings
	Configuring Global Alarm Notifications
	Retaining Alarm History
	Specifying Event History
	Enabling Alarms
	Changing the Severity of Individual Alarms
	Configuring Threshold Alarms
	Configuring Individual Alarm Notifications

	Disabling Optical Performance Monitoring
	Specifying NorthStar Controller Preferences



	Part 3: Working with the Dashboard
	Chapter 5: About the Dashboard
	Understanding the Dashboard

	Chapter 6: Using the Dashboard
	Using Dashboard Widgets

	Chapter 7: Dashboard Widget Reference
	Device Alarms Widget
	Service Alarms by Severity Widget
	Config Deployment Jobs Status Widget
	Config Deployment Jobs Status Widget Summary
	Config Deployment Jobs Status Widget Details

	Device & Port Utilization Heatmap Widget
	Using the Global Controls
	Interacting with the Heat Maps
	Viewing Active Flows on a Port
	Flow Analysis Details Window

	Port Status - Physical Widget
	Port Status - Physical Widget Summary
	Port Status - Physical Widget Details



	Part 4: Working in Build Mode
	Chapter 8: About Build Mode
	Understanding Build Mode in Views Other than Service View of Connectivity Services Director
	Discovering Devices
	Building the Custom View
	Configuring Devices
	Deploying Device Configurations
	Importing Device Configurations
	Out-of-Band Configuration Changes

	Managing Devices

	Understanding the Build Mode Tasks Pane in Views Other than Service View

	Chapter 9: Discovering Devices
	Discovering Devices
	Troubleshooting Device Discovery Error Messages
	Viewing the Brownfield Job

	Chapter 10: Creating Custom Device Groups
	Understanding Custom Device Groups
	Where Is the Custom Group Function Located in Connectivity Services Director?
	How Do Custom Group Rules Work?
	What Happens When I Edit a Custom Group Rule?
	When Are Rules Executed?

	Creating Custom Device Groups
	Creating Custom Groups
	Creating a Custom Group


	Chapter 11: Configuring Quick Templates
	Understanding Quick Templates
	Configuring and Managing Quick Templates
	Creating a Quick Template
	Applying Templates to Devices
	Editing a Quick Template
	Deleting a Quick Template
	Cloning a Quick Template
	Using the Quick Template Details Window
	Viewing Deployed Quick Templates


	Chapter 12: Configuring Device Settings
	Understanding Device Common Settings Profiles
	Creating and Managing Device Common Settings
	Managing Device Common Settings
	Creating a Device Common Settings Profile
	Specifying Basic Settings for Device Common Settings
	Specifying Management Settings for Routing Device Common Settings
	Specifying Protocol Settings for Routing Device Common Settings
	Reviewing and Saving a Device Common Settings Configuration
	What to Do Next

	Assigning Device Common Settings to Devices
	Assigning Device Common Settings
	Editing the Assignments of the Device Common Setting


	Chapter 13: Configuring Class of Service (CoS)
	Understanding Class of Service (CoS) Profiles
	How Would I Use CoS (also known as QoS)?
	How Do I Create CoS Groups?
	How Is CoS Different From QoS?

	How Does CoS Work?
	What Wireless Network Traffic Aspects Can I Control Using CoS?
	What CoS Parameters Can I Control?
	What Are the Default CoS Traffic Types?
	Data Center Switching CoS Configuration
	How Do I Implement Class of Service?
	Editing Discovered CoS Profiles

	Creating and Managing Wired CoS Profiles
	Managing Wired CoS Profiles
	Using the Default CoS Profiles for Routers
	Using the Default CoS Profiles for Campus Switching ELS with Hierarchical Port Scheduling
	Using the Default CoS Profiles for Data Center Switching
	Creating a Wired CoS Profile
	Specifying Settings for a Routing, Switching, and Campus Switching ELS CoS Profile
	Specifying Settings for a Campus Switching ELS CoS Profile with Hierarchical Port Scheduling (ETS)
	Specifying Settings for a Data Center Switching CoS Profile
	What to Do Next


	Chapter 14: Configuring Link Aggregation Groups (LAGs)
	Understanding Link Aggregation
	Managing and Creating a Link Aggregation Group
	Link Aggregation Group Options
	Creating a Link Aggregation Group
	What To Do Next


	Chapter 15: Managing Network Devices
	Viewing the Device Inventory Page in Device View of Connectivity Services Director
	Viewing the Physical Inventory of Devices
	Viewing Licenses With Connectivity Services Director
	Viewing a Device's Current Configuration from Connectivity Services Director
	Accessing a Device’s CLI from Connectivity Services Director
	Accessing a Device’s Web-Based Interface from Connectivity Services Director
	Deleting Devices
	Rebooting Devices


	Part 5: Building a Topology View of the Network
	Chapter 16: Downloading and Installing CSD-Topology
	CSD-Topology Installation and Configuration Overview
	Installation Prerequisites
	Installing the CSD-Topology Software Using the RPM Bundle
	Minimum Hardware and Software Requirements for Junos VM on VMWare
	Installing the JunosVM for CSD-Topology
	Setting Up the Datastore
	Creating VRR VMs
	Configuring the JunosVM
	Configuring the CSD-Topology Server with the JunosVM IP Address
	Verifying the Connectivity Between the CSD-Topology Server and JunosVM
	Verifying That the CSD-Topology Services Are Running
	Stopping Firewall on theCSD-Topology Server
	Configuring Peer Routers and Topology Acquisition on the JunosVM
	Specifying the Topology Details in the Connectivity Services Director GUI

	Connecting an x86 Server to the Network
	Interactive Method of Installing the RPM Image and CSD-Topology Software from a USB or DVD Drive

	Chapter 17: Configuring Topology Acquisition and Connectivity Between the CSD-Topology and Path Computation Clients
	Configuring PCEP on a PE Router (from CLI)
	Configuring Connectivity for BGP-LS Topology Acquisition
	Configuring BGP-LS Topology Acquisition on the CSD-Topology
	Configuring Topology Acquisition on the PCC Routers

	Configuring Connectivity for OSPF Topology Acquisition
	Configuring OSPF on the CSD-Topology
	Configuring OSPF Over GRE on the CSD-Topology

	Configuring Connectivity for IS-IS Topology Acquisition
	Configuring IS-IS on the CSD-Topology
	Configuring IS-IS Over GRE on the CSD-Topology


	Chapter 18: Accessing the Topology View of CSD-Topology
	Understanding the Network Topology in Connectivity Services Director
	Monitoring the Topology of Network Elements Managed by CSD-Topology Overview
	Specifying Topology Preferences
	CSD-Topology Topology Map Window Overview
	Working with the Graphical Image in the Topology View Window
	Expanding and Collapsing Groups by Using the Topology Map Grouping Shortcut Menu
	Filtering Links, LSPs, and Services by Using the Topology Map Node Shortcut Menu
	Removing the Highlighted LSPs by Using the Topology Map LSPs Shortcut Menu
	Viewing the Service Path by Using the Topology Map Service Shortcut Menu
	Filtering Devices, LSPs, and Services for Sorting and Segregating the Topology View
	Segregating the Displayed Devices by Searching the Entire Topology View
	Resynchronizing the Topology View
	Viewing Device Details of a CSD-Topology for Examining Traffic Transmission
	Viewing LSP Details of a CSD-Topology for Analyzing Network Changes
	Viewing Link Details of a CSD-Topology for Determining the Operational Status
	Viewing Service Details of a CSD-Topology for Monitoring and Troubleshooting Service Parameters
	Viewing Topology Map Group Details in a Pop-Up Dialog Box
	Viewing Topology Map Device Details in a Pop-Up Dialog Box
	Viewing Topology Map Link Details in a Pop-Up Dialog Box
	Viewing Topology Map LSP Details in a Pop-Up Dialog Box
	Viewing Topology Map Service Details in a Pop-Up Dialog Box
	Enabling the Collection of LSP and Service Association Details
	Using Custom Grouping for Devices in a CSD Topology
	Viewing Generated Alarms for Services in the Topology View
	Viewing the Optical Link Details for Examining the Performance of Optical Links


	Part 6: Prestaging
	Chapter 19: Prestaging Devices Overview
	Prestaging Devices Process Overview
	Prestaging Workflow in Connectivity Services Director
	Auto-Discovery and Auto Prestaging of Devices
	Parallel Prestaging Jobs
	Auto Prestaging Jobs When a Manual Prestaging Job is Running
	Manual Prestaging Jobs When an Auto Prestaging Job is Running.
	Multiple Auto Prestaging Jobs for a Device
	Multiple Auto Prestaging Jobs for a Device
	Scenarios With a Clustered Environment
	Types of Prestaging

	Prerequisites for Prestaging Devices in Connectivity Services Director
	Discovering and Assigning All N-PE Devices
	Discovering Device Roles
	Assigning Device Roles

	Discovering and Assigning N-PE Devices with Exceptions
	Including Interfaces in UNI Role Assignments
	Committing Your Prestaging Choices

	Prestaging ATM and TDM Pseudowire Devices
	Discovering and Assigning Provider Role or LSP Role for Devices with Exceptions
	Including Interfaces in UNI Role Assignments
	Committing Your Prestaging Choices

	Discovering and Assigning All Provider or LSP Devices
	Discovering LSP Device Roles
	Assigning Provider Device Roles

	Prestaging Rules
	N-PE Device Classification Rules
	UNI Classification Rules
	VLAN Pool Profile Classification Rules
	Auto Discovery Only


	Chapter 20: Prestaging: Managing Devices and Device Roles
	Discovering Tunnel Devices
	Adding a UNI
	Unassigning Device Roles
	Deleting UNIs
	Discovering Device Roles
	Excluding Devices from N-PE Role Assignment
	Excluding Interfaces from UNI Role Assignments
	Unassigning N-PE Devices
	Viewing N-PE Devices
	Viewing N-PE Devices in a Table

	Viewing Prestaging Statistics
	Viewing the Prestaged Device Details
	Viewing Services for Devices and Device Roles in a Graphical Form

	Viewing Prestaging Rules
	Viewing Prestaging Rules in a Table

	Managing Prestage Device Jobs
	Specifying the Wait and Idle Times for Prestaging Devices

	Chapter 21: Prestaging: Managing IP Addresses
	Creating an IP Address Pool
	Managing Resources
	Specifying IPv4 Addressing Assignment in IP Service Definitions

	Chapter 22: Device Configuration Prerequisites to Prestaging Examples
	Example: Base Configuration for N-PE Device in a Multipoint Service
	Example: Base Configuration for N-PE Device in an E-Line (LDP) Service
	Example: Base Configuration for a P Router

	Chapter 23: Prestaging Services
	Creating and Handling a Service Recovery Request
	Selecting a Service Definition in the Wizard for Creating a Service Recovery Request
	Specifying Devices and Filters in the Wizard for Creating a Service Recovery Request
	Reviewing the Configured Settings in the Wizard for Creating a Service Recovery Request
	Viewing Service Recovery Report
	Performing a Service Recovery on a Defined Service
	Processing of Device Change Notifications Overview
	XPaths of Relevance to Connectivity Services Director
	Processing of XPath Notifications for Out-of-Band Configuration Changes

	Handling of Out-of-Band Notifications for Service Recovery
	Viewing Service Recovery Instance Details
	Managing Out-of-Band Notifications for Recovered Services
	Viewing Details of an Out-of-Band Notification for Recovered Services
	Viewing Services Rejected During a Service Recovery
	Viewing Service Recovery Jobs
	Performing a Configuration Audit for Recovered Services
	Viewing Configuration Audit Results of Recovered Services
	Recovering Modifications and Deletions Performed for Existing Endpoints
	Recovering Parameters for E-Line Services
	Recovering Parameters for IP Services
	Recovering Parameters for E-LAN Services
	Recovering Endpoint Deletions from a Service

	REST API Changes in Connectivity Services Director for Service Recovery
	Sample XPath Notifications Received on Devices for Deleted Endpoints
	Sample XPath Notifications Received on Devices for a Modified E-LAN Service
	Sample XPath Notifications Received on Devices for a Created E-LAN Service
	Sample XPath Notifications Received on Devices for a Created IP Service
	Sample XPath Notifications Received on Devices for a Created E-Line Service
	Sample XPath Notifications Received on Devices for CFM Profiles Associated with an E-Line Service
	Sample XPath Notifications Received on Devices for CoS Profiles Associated with an E-Line Service


	Part 7: Service Design: Working with Service Definitions
	Chapter 24: Service Design: Predefined Service Definitions
	Predefined Service Definitions
	E-Line Predefined Service Definitions
	ELine-Dot1q-SingleVLAN
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-Dot1q-SingleVLAN-CCC
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-Dot1q-SingleVLAN-Ext-CCC
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-PortBased
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-AllVLAN
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-AllVLAN-CCC
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-AllVLAN-Ext-CCC
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-VLANRange
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-VLANRange-CCC
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-VLANRange-Ext-CCC
	Configuration on Endpoint A
	Configuration on Endpoint Z


	Multipoint-to-Multipoint Predefined Service Definitions
	ELAN-BGP-Dot1q-Normalized-VLAN-None
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-Dot1Q-SingleVLAN
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-PortBased
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-QinQ-AllVLAN
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-QinQ-AllVLAN-Normalized-All
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-QinQ-AllVLAN-Normalized-None
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-QinQ-Range-Normalized-VLAN
	Configuration on Endpoint A
	Configuration on Endpoint Z


	Point-to-Multipoint Service Definitions
	ELAN-Hub-Spoke-QinQ-AllVLAN
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-Hub-Spoke-QinQ-AllVLAN-No
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z



	Predefined E-Line Service Definitions
	ELine-Dot1q-SingleVLAN Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-Dot1q-SingleVLAN-CCC Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-Dot1q-SingleVLAN-Ext-CCC Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-PortBased Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-AllVLAN Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-AllVLAN-CCC Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-AllVLAN-Ext-CCC Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-VLANRange Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-VLANRange-CCC Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-QinQ-VLANRange-Ext-CCC Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z

	ELine-BGP-Port-Based
	Configuration on Endpoint A
	Configuration on Endpoint Z

	Eline-BGP-Dot1q-SingleVLAN
	Configuration on Endpoint A
	Configuration on Endpoint Z

	Eline-BGP-QinQ-AllVLAN
	Configuration on Endpoint A
	Configuration on Endpoint Z


	Predefined Multipoint-to-Multipoint Ethernet Service Definitions
	ELAN-BGP-Dot1q-Normalized-VLAN-None Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-Dot1Q-SingleVLAN Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-PortBased Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-QinQ-AllVLAN Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-QinQ-AllVLAN-Normalized-All Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-QinQ-AllVLAN-Normalized-None Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-BGP-QinQ-Range-Normalized-VLAN Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint Z


	Predefined Point-to-Multipoint Ethernet Service Definitions
	ELAN-Hub-Spoke-QinQ-AllVLAN-Normalized-All Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z

	ELAN-Hub-Spoke-QinQ-AllVLAN Service Definition
	Configuration on Endpoint A
	Configuration on Endpoint B
	Configuration on Endpoint Z


	Predefined Full Mesh IP Service Definitions
	Predefined Hub-and Spoke IP Service Definitions

	Chapter 25: Service Design: Managing E-Line Service Definitions
	Choosing a Predefined Service Definition or Creating a New Service Definition
	Choosing a Predefined Service Definition
	Creating an E-Line Service Definition
	Specifying General Information
	Specifying UNI Settings
	Specifying UNI Settings for Port-to-Port Services
	Specifying UNI Settings for Services with 802.1Q Interface Types
	Specifying UNI Settings for Services with Q-in-Q Interface Types
	UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface Types)

	Specifying Connectivity Information When Signaling Is LDP
	Specifying Connectivity Information When Signaling Is BGP
	Reviewing the Configured Settings


	Creating an E-Line ATM or TDM Pseudowire Service Definition
	Specifying General Information for the ATM or TDM Service
	Specifying UNI Settings for ATM and TDM Service Definitions
	Specifying UNI Settings for ATM Interfaces
	Specifying UNI Settings for TDM Interfaces
	Specifying Connectivity Information for an ATM or a TDM Service
	Reviewing the Configured Settings

	Modifying a Custom Service Definition
	Publishing a Custom Service Definition
	Unpublishing a Custom Service Definition
	Deleting a Customized Service Definition
	Viewing Service Definitions
	Tabular View
	Searching for Service Definitions
	Viewing Service Definition Details
	Performing Actions on Service Definitions


	Chapter 26: Service Design: Managing E-LAN Service Definitions
	Creating a Multipoint-to-Multipoint E-LAN Service Definition
	Specifying General Information for Multipoint-to-Multipoint E-LAN Service Definitions
	Specifying Advanced Settings
	Specifying Site Settings for Multipoint-to-Multipoint E-LAN Service Definitions
	UNI or Site Settings for Port-to-Port Interfaces in E-LAN Services
	UNI or Site Settings for 802.1Q Interfaces in E-LAN Services
	UNI or Site Settings for Q-in-Q Interfaces in E-LAN Services
	UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface Types)
	Reviewing the Configured Settings

	Creating a Point-to-Multipoint E-LAN Service Definition
	Specifying General Information for Point-to-Multipoint E-LAN Service Definitions
	Specifying Advanced Settings
	Specifying UNI or Site Settings for Point-to-Multipoint E-LAN Service Definitions
	UNI or Site Settings for Port-to-Port Interfaces in E-LAN Services
	UNI or Site Settings for 802.1Q Interfaces in E-LAN Services
	UNI or Site Settings for Q-in-Q Interfaces in E-LAN Services
	UNI or Site Settings for Services with Flexible VLAN Tagging (Asymmetric Interface Types)
	Reviewing the Configured Settings

	Creating a Service Definition for VPLS Access into Layer 3 Networks

	Chapter 27: Service Design: Managing IP Service Definitions
	Creating a Full-Mesh IP Service Definition
	Specifying General Settings Information
	Specifying Site or UNI Settings
	Reviewing the Configured Settings

	Creating a Hub-and-Spoke (One Interface) IP Service Definition
	Specifying General Information
	Specifying UNI or Site Settings
	Reviewing the Configured Settings

	Creating a Service Definition for E-Line Pseudowire Access into a Layer 3 VPN
	Creating a Multicast VPN Service Definition


	Part 8: Service Provisioning: Working with Customers
	Chapter 28: Service Provisioning: Managing Customers
	Adding a New Customer
	Deleting Customers
	Modifying an Existing Customer
	Viewing Customer Details


	Part 9: Working in Deploy Mode
	Chapter 29: About Deploy Mode
	Understanding Deploy Mode in Views Other than Service View of Connectivity Services Director
	Deploying Configuration Changes
	Managing Software Images
	Managing Devices
	Managing Device Configuration Files
	Managing Baseline Configuration

	Understanding the Deploy Mode Tasks Pane in Views Other than Service View

	Chapter 30: Deploying and Managing Device Configurations
	Deploying Configuration to Devices
	Selecting Configuration Deployment Options
	Using the Change Request Details Page
	Creating a Change Request
	Validating Configuration
	Discarding the Pending Configurations
	Viewing Pending Configuration Changes
	Using the Pending Changes Window
	Using the Configuration or Pending Configuration Window
	Using the Deploy Configuration Errors/Warnings Window
	Using the Configuration Validation Window
	Deploying Configuration Changes to Devices Immediately
	Scheduling Configuration Deployment
	Specifying Configuration Deployment Scheduling Options
	Editing Change Requests
	Deleting Change Request
	Resubmitting a Change Request
	Performing a Rollback

	Managing Configuration Deployment Jobs
	Selecting Configuration Deployment Job Options
	Viewing Configuration Deployment Job Details
	Canceling Configuration Deployment Jobs

	Deploy Configuration Window
	Approving Change Requests
	Enabling SNMP Categories and Setting Trap Destinations
	Viewing Eligible Devices for Trap Forwarding
	Enabling Trap Forwarding
	Deploying SNMP Trap Configurations

	Understanding Resynchronization of Device Configuration
	The Resynchronize Device Configuration Task
	How Resynchronization Works in NSOR Mode
	How Resynchronization Works in SSOR Mode
	How Connectivity Services Director Resynchronizes the Build Mode Configuration

	Resynchronizing Device Configuration
	The Resynchronize Device Configuration List of Devices
	Resynchronizing Devices When Junos Space Is in NSOR Mode
	Resynchronizing Devices When Junos Space Is in SSOR Mode
	Resynchronizing Devices in Manual Approval Mode
	Viewing the Network Changes
	Viewing Resynchronization Job Status

	Managing Device Configuration Files
	Selecting Device Configuration File Management Options
	Backing Up Device Configuration Files
	Restoring Device Configuration Files
	Viewing Device Configuration Files
	Comparing Device Configuration Files
	Deleting Device Configuration Files
	Managing Device Configuration File Management Jobs

	Enabling or Disabling Network Ports on Routers

	Chapter 31: Deploying and Managing Software Images
	Managing Software Images
	Selecting Software Image Management Options
	Adding Software Images to the Repository
	Using the Device Image Upload Window
	Viewing Software Image Details
	Using the Device Image Summary Window
	Deleting Software Images

	Deploying Software Images
	Specifying Software Deployment Job Options
	Selecting Software Images To Deploy
	Selecting Options for Software Deployment
	Summary of Software Deployment

	Managing Software Image Deployment Jobs
	Selecting Software Image Management Options
	Viewing Software Image Job Details
	Using the Device Image Staging Window
	Canceling Software Image Jobs



	Part 10: Service Provisioning: Working with Service Orders
	Chapter 32: Service Provisioning: Viewing the Configured Services and Service Orders
	Viewing Service Orders
	Viewing Service Orders in a Table

	Viewing Service Order and Service Details
	Viewing Services
	Viewing Services in a Table

	Viewing the Configured E-Line, IP, and E-LAN Services
	Viewing the Configuration Details of VPN Services

	Chapter 33: Service Provisioning: Managing E-Line Service Orders
	Creating a Service Order
	Creating an E-Line ATM or TDM Pseudowire Service Order
	Selecting the Service Definition
	Entering General/Connectivity Settings Information
	Specifying Endpoint Information
	Specifying Template Settings
	Reviewing the Configured Settings
	Deploying the New Service

	Creating an E-Line Service Order
	Selecting the Service Type
	Entering General Settings Information
	Specifying the Connectivity
	Specifying QoS Settings
	Specifying OAM Settings
	Specifying Endpoint Information
	Specifying Template Settings
	Reviewing the Configured Settings
	Specifying Connectivity and Endpoint Information for Managing VLANs
	Deploying and Monitoring the Progress of the New Service

	Creating a Bulk-Provisioning Service Order for Pseudowire Services
	Creating an Inverse Multiplexing for ATM Service Order
	Provisioning a Single-Ended E-Line Service
	Selecting Specific LSPs for Connectivity Services
	Associating an LSP with an E-Line Service
	Viewing LSP Details in a Service Order
	Viewing LSP Details in a Service
	Viewing LSP Configuration Details

	Stitching Two E-Line Pseudowires
	Deactivating a Service
	Reactivating a Service
	Force-Deploying a Service
	Recovering a Service Definition through Force Upload
	Decommissioning a Service
	Viewing Alarms for a Service
	Inline Editing of E-LAN and IP Service Orders
	Interconnecting an IP Service with an E-LAN Service
	Changing the Logical Loopback Interface for Provisioning

	Chapter 34: Service Provisioning: Managing E-LAN Service Orders
	Creating a Multipoint-to-Multipoint E-LAN Service Order
	Selecting the Service Definition
	Entering Service Parameters Information
	Specifying OAM Settings
	Selecting N-PE Devices
	Specifying Node Settings
	Setting Attributes for Nodes or Devices on a Service
	Setting Attributes for Nodes or Devices on a Service with Flexible VLAN Tagging

	Modifying Site Settings
	Specifying QoS Settings
	Specifying Template Settings
	Reviewing the Configured Settings
	Deploying the New Service

	Creating a Point-to-Multipoint E-LAN Service Order
	Selecting the Service Definition
	Entering Service Parameters Information
	Specifying OAM Settings
	Selecting N-PE Devices
	Specifying Node Settings
	Setting Attributes for Nodes or Devices on a Service
	Setting Attributes for Nodes or Devices on a Service with Flexible VLAN Tagging

	Modifying Site Settings
	Specifying QoS Settings
	Specifying Template Settings
	Reviewing the Configured Settings
	Deploying the New Service

	Creating a Service Order for VPLS Access into Layer 3 Networks
	Creating an E-LAN Service Order with CFM
	Interconnecting an E-LAN Service with an IP Service

	Chapter 35: Service Provisioning: Managing IP Service Orders
	Stitching a Pseudowire to an IP Service
	Creating a Full Mesh IP Service Order
	Selecting the Service Definition
	Configuring Service Parameters Information
	Specifying General Settings
	Specifying PE-CE Settings Information

	Selecting N-PE Devices or Nodes
	Setting Attributes for Endpoints or Nodes
	Adding and Deleting UNI Interfaces
	Setting Attributes for UNIs or Sites
	Specifying QoS Settings
	Specifying Template Settings
	Reviewing the Configured Settings
	Deploying the New Service

	Creating a Hub-and-Spoke IP Service Order
	Selecting the Service Definition
	Configuring Service Parameters Information
	Specifying General Settings
	Specifying PE-CE Settings Information

	Selecting N-PE Devices or Nodes
	Setting Attributes for Endpoints or Nodes
	Adding and Deleting UNI Interfaces
	Setting Attributes for UNIs or Sites
	Specifying QoS Settings
	Specifying Template Settings
	Reviewing the Configured Settings
	Deploying the New Service

	Selecting a Published IP Service Definition for a Service Order
	Entering IP Service Order Information
	Setting General Settings
	Entering VPN and Connectivity Settings Information
	Entering PE-CE Settings

	Selecting Endpoint PE Devices or Nodes
	Creating a Service Order Based on a Service Definition with a Template
	Deploying an IP Service Order
	Creating a Multicast VPN Service Order
	Creating Policies for an IP Service

	Chapter 36: Service Provisioning: Performing RFC 2544 Benchmark Testing
	RFC 2544 Testing Overview
	Supported Devices for RFC2544
	Before You Begin
	Performing an RFC 2544 test for a Service
	Performing an RFC 2544 Test Between Devices

	Creating an RFC 2544 Test Profile for Services
	Creating an RFC 2544 Test Profile for Devices
	Deploying RFC 2544 Tests
	Viewing RFC 2544 Test Results


	Part 11: Service Provisioning: Working with Services Deployment
	Chapter 37: Service Provisioning: Managing Deployed Services
	Managing Service Configuration Deployment Jobs
	Selecting Service Configuration Deployment Job Options
	Viewing Service Configuration Deployment Job Details
	Canceling Service Configuration Deployment Jobs

	Deploying Services Configuration to Devices
	Selecting Configuration Deployment Options
	Validating Configuration
	Deleting the Partial Service Configurations
	Discarding the Pending Configurations
	Deploying Configuration Changes to Devices Immediately
	Scheduling Configuration Deployment
	Specifying Configuration Deployment Scheduling Options

	Deploy Configuration Window
	Deleting a Partial Configuration of an LSP Service Order
	Deleting a Service Order
	Deploying a Service
	Validating the Pending Configuration of a Service Order
	Viewing the Configuration of a Pending Service Order
	Viewing Decommissioned E-Line, E-LAN, and IP Service Orders
	Modifying an E-Line Service
	Modifying a Multipoint-to-Multipoint Ethernet Service
	Adding an Endpoint
	Adding a UNI Interface
	Deleting a UNI Interface and Deleting an Endpoint
	Changing the Endpoint Bandwidth
	Changing Advanced Settings for an Endpoint

	Modifying a Point-to-Multipoint Ethernet Service
	Adding a Spoke
	Adding a Hub
	Changing a Spoke to a Hub
	Changing a Hub to a Spoke
	Adding a UNI Interface
	Deleting a UNI Interface or Deleting an Endpoint
	Changing the Endpoint Bandwidth
	Changing Advanced Settings for an Endpoint

	Modifying a Hub-and-Spoke IP Service Order
	Viewing the Service Definition
	Configuring Service Parameters Information
	Specifying General Settings
	Specifying PE-CE Settings Information

	Selecting N-PE Devices or Nodes
	Setting Attributes for Endpoints or Nodes
	Adding and Deleting UNI Interfaces
	Setting Attributes for UNIs or Sites
	Deploying the New Service

	Modifying a Full Mesh IP Service
	Adding an Endpoint
	Adding a UNI Interface
	Deleting a UNI Interface and Deleting an Endpoint

	Understanding Service Validation
	Highlighting of Endpoints in the IP, RSVP LSP, and E-LAN Service Modification Wizards


	Part 12: Auditing Services and Viewing Audit Results
	Chapter 38: Service Provisioning: Auditing Services
	Performing a Functional Audit
	Performing a Configuration Audit
	Troubleshooting N-PE Devices Before Provisioning a Service
	Modifying the Application Settings of Connectivity Services Director
	Troubleshooting the Endpoints of Services
	Troubleshooting Services Using Operational Scripts

	Basic Requirements of Operational Scripts
	Predefined Scripts for Troubleshooting
	E-Line LDP Service
	E-Line BGP Service
	E-LAN Service
	IP Service
	RSVP LSP Service


	Viewing Configuration Audit Results
	Viewing Functional Audit Results
	Viewing Functional Audit Results for an Inverse Multiplexing for ATM Service
	Modifying a Saved Service Order
	Viewing Service-Level Alarms

	Chapter 39: Troubleshooting Devices and Services
	Performance Management Overview
	Monitoring Performance Statistics
	On-Demand Mode
	Loss Measurement
	Delay Measurement

	Proactive Mode

	Performance Management of Test Traffic

	Monitoring Performance Management Statistics
	Monitoring Statistics for an E-Line Service
	Monitoring Statistics for an E-LAN Service

	Viewing Performance Management Statistics
	Viewing Y.1731 Performance Monitoring Statistics for E-Line Services
	Viewing Y.1731 Performance Monitoring Statistics for E-LAN Services

	Service Troubleshooting Overview


	Part 13: Working in Monitor Mode
	Chapter 40: About Monitor Mode
	Understanding Monitor Mode in Views Other than Service View of Connectivity Services Director
	Scope and Monitor Tab Availability
	Monitors and Tasks
	Scope and Data Aggregation
	How Connectivity Services Director Collects and Displays Monitoring Data
	How Connectivity Services Director Displays and Stores Trend Data
	More About the Monitor Tabs
	The Summary Tab
	The Traffic Tab


	Understanding the Monitor Mode Tasks Pane in Views Other than Service View

	Chapter 41: Monitoring Traffic
	Monitoring Traffic on Devices
	Monitoring Port Traffic Statistics
	Procedure for Monitoring Port Traffic Statistics
	Port on Device Window
	Port Traffic Stats Window

	Monitoring Traffic on Layer 3 VLANs
	Procedure for Monitoring Layer 3 VLAN Traffic Statistics
	L3 VLAN Traffic Stats Window

	Monitoring Port Utilization
	How to Access the Port Utilization Task
	Port Utilization Details Window
	Utilization for Device Window
	Device View
	Port View

	Utilization for IP Fabric Window
	Device View
	Port View


	Monitoring Routing Instances
	Procedure for Monitoring Routing Instances
	Show Routing Instances Window
	Show Interfaces Window
	Show Bridge Domains Window
	Show Connections
	Show Routing Tables
	Show MAC Table

	Viewing Congestion Events

	Chapter 42: Monitoring Devices
	Comparing Device Statistics
	Procedure for Comparing Device Statistics
	Compare Interfaces Window

	Showing ARP Table Information
	Procedure for Showing ARP Table Information
	Show ARP Table Information Window


	Chapter 43: General Monitoring
	Selecting Monitors To Display on the Summary Tab
	Changing Monitor Polling Interval and Data Collection
	Pinging Host Devices
	Troubleshooting Network Connections Using Traceroute

	Chapter 44: Monitor Reference
	Error Trend Monitor
	Error Trend
	Error Trend Details

	Equipment Status Summary Monitor
	Equipment Summary By Type Monitor
	Equipment Summary By Type
	Equipment Summary By Type Details

	Port Status Monitor
	Port Status Summary
	Port Status Details

	Port Utilization Monitor
	Status Monitor for Routers
	Traffic Trend Monitor
	Unicast vs Broadcast/Multicast Monitor
	Unicast vs Broadcast/Multicast Trend Monitor
	Session Trends Monitor
	Session Trends
	Session Details

	Current Sessions by Type Monitor
	Current Sessions by Type
	Current Session Details

	User Session Details Window
	Current Active Alarms Monitor (All Views Except Service View)
	Top Sessions by MAC Address Monitor
	Top Sessions
	Top Session by MAC Details

	Top APs by Session Monitor
	Top APs by Session Summary
	Top APs by Session Details

	Radio Technology Type Statistics Monitor
	Radio Technology Type Statistics Summary
	Radio Technology Type Statistics Details

	Top Talker - Wired Devices Monitor
	Top Talker - Wired Devices Summary
	Top Talker - Wired Devices Details

	Top Users Monitor
	Top Users
	Top Session By User Details

	Top APs by Traffic Monitor
	Top APs by Traffic Summary
	Top APs by Traffic Details

	Top Talker - Wireless Devices Monitor
	Top Talker-Wireless Devices Summary
	Top Talker-Wireless Devices Details

	RF Interference Sources Monitor for Devices

	Chapter 45: Detecting and Examining the Health and Performance of Services
	Service Monitoring Capabilities in Connectivity Services Director
	Computation of Statistics Polled from Devices for Display in Widgets on Monitoring Pages
	Configuring the Aggregation Method for Viewing Monitoring Details
	Viewing the Service Monitoring Summary Page for a Consolidated Listing of Services
	Monitoring the Service Summary Details of E-Line Services for Optimal Debugging
	Service Status
	Connections
	Traffic Summary
	Section

	Monitoring the Service Summary Details of E-LAN Services for Optimal Debugging
	Service Status
	Connections
	Traffic Summary

	Monitoring the Service Summary Details of IP Services for Optimal Debugging
	Service Status
	VPN Routes
	VPN Traffic Trend

	Monitoring the Service Traffic Statistics of E-Line Services for Correlating Device Counters
	Traffic Graph
	Pseudowire Traffic
	Interface Traffic Statistics/Endpoint Users

	Monitoring the Service Traffic Statistics of E-LAN Services for Correlating Device Counters
	Traffic Matrix
	Interface Statistics
	Traffic Pattern

	Monitoring the Service Traffic Statistics of IP Services for Correlating Device Counters
	Interface Statistics
	VPN Traffic Trend

	Monitoring the Service Transport Details of E-Line Services for Easy Analysis
	Connections
	LSP Information
	LSP Traffic

	Monitoring the Service Transport Details of E-LAN Services for Easy Analysis
	Connections
	LSP Information
	LSP Traffic

	Monitoring the Service Transport Details of IP Services for Easy Analysis
	Transport Statistics
	VPN Routes
	Label/LSP Information
	LSP Traffic

	Viewing Y.1731 Performance Monitoring Statistics for E-Line Services
	Connections
	Loss Measurement
	Delay Measurement
	Delay Variation

	Viewing Y.1731 Performance Monitoring Statistics for E-LAN Services
	Connections
	Loss Measurement
	Delay Measurement
	Delay Variation

	Clearing Interface Statistics
	Viewing MAC Table Details
	Viewing Interface Statistics
	Viewing Interface Status Details
	MPLS Connectivity Verification and Troubleshooting Methods
	Using MPLS Ping
	Pinging VPNs, VPLS, and Layer 2 Circuits
	Monitoring Network Reachability by Using the MPLS Ping Capability
	Monitoring Network Reachability by Using the Layer 3 VPN Ping Capability
	Routing Table Overview
	Viewing Routing Table Details


	Part 14: Working in Fault Mode
	Chapter 46: About Fault Mode
	About Fault Mode in All Views of Connectivity Services Director
	Understanding the Tasks Pane in Fault Mode

	Chapter 47: Using Fault Mode
	Using Fault Management Monitors
	What Are Events and Alarms?
	Alarm Severity
	Alarm Classification
	Alarm State
	Alarm Notifications
	Threshold Alarms

	Alarm Severities and States Overview
	Alarm Severity
	Alarm State

	Events and Alarms Overview
	Alarm Severity

	Customizing Alarms
	Changing Alarm State
	Searching Alarms

	Chapter 48: Fault Reference
	Alarm Detail Monitor (All Views Except Service View)
	Finding Specific Alarms
	Sorting Alarms
	Reading Events
	Investigating Event Attributes
	Changing the Alarm State

	Alarm Detail Monitor (Service View)
	Finding Specific Alarms
	Sorting Alarms
	Reading Events
	Investigating Event Attributes
	Changing the Alarm State

	Current Active Alarms Monitor (Service View)
	Alarms by Category Monitor
	Alarms by Severity Monitor (Service View)
	Alarms by State Monitor
	Alarm Trend Monitor (Service View)
	Alarms by Severity Monitor (All Views Except Service View)
	Alarms by State Monitor (All Views Except Service View)
	Current Active Alarms Monitor (All Views Except Service View)
	Alarm Trend Monitor (All Views Except Service View)


	Part 15: End-to-End Configuration Examples
	Chapter 49: Configuration Scenarios
	Example: Configuring and Deploying an E-Line Service
	Preparing Devices for Discovery
	Discovering Devices
	Preparing Devices for Prestaging
	Discovering and Assigning N-PE Roles
	Choosing or Creating a Service Definition
	Creating a Customer
	Creating and Deploying an E-Line Service Order
	Performing a Functional Audit and a Configuration Audit

	Example: Configuring and Deploying a Multipoint-to-Multipoint E-LAN Service
	Preparing Devices for Discovery
	Discovering Devices
	Preparing Devices for Prestaging
	Discovering and Assigning N-PE Roles
	Choosing or Creating a Service Definition
	Creating a Customer
	Creating and Deploying a Multipoint-to-Multipoint Service Order
	Performing a Functional Audit and a Configuration Audit

	Example: Configuring and Deploying an IP Full-Mesh Service
	Preparing Devices for Discovery
	Discovering Devices
	Preparing Devices for Prestaging
	Discovering and Assigning N-PE Roles
	Choosing or Creating a Service Definition
	Creating a Customer
	Creating and Deploying an IP Service Order
	Performing a Functional Audit and a Configuration Audit



	Part 16: Working with Chassis View
	Chapter 50: Working with Devices
	About Chassis View
	Accessing the Chassis View from the Physical Inventory Page
	Viewing a Graphical Image of the Chassis and Components
	Deleting Devices from Chassis View
	Rebooting Devices After Examining the Status in Chassis View

	Chapter 51: Managing CLI Configlets
	CLI Configlets Overview
	Configlet Variables
	Default Variables
	User-defined Variables
	Predefined Variables

	Velocity Templates
	Directives

	CLI Configlets Workflow
	Configlet Context
	Context of an Element
	Context filtering

	Creating a CLI Configlet
	Modifying a CLI Configlet
	Deleting CLI Configlets
	Viewing CLI Configlets
	Creating a Parameter for a CLI Configlet
	Applying a CLI Configlet to Devices
	Deploying CLI Configlet Details


	Part 17: Managing Optical Interfaces, OTUs, ODUs, ILAs, and IPLCs on MX Series and PTX Series Routers
	Chapter 52: Overview of Optical Interfaces, OTUs, and ODUs
	Optical Interfaces Management and Monitoring on MX Series and PTX Series Routers Overview
	Ethernet DWDM Interface Wavelength Overview
	Attenuation and Dispersion in a Fiber-Optic Cable on PTX Series Routers Overview
	Understanding Pre-FEC BER Monitoring and BER Thresholds
	DWDM Controllers Overview
	PTX5000 PIC Description
	PTX5000 PIC Slots
	PTX5000 PIC Function
	PICs Supported on the PTX5000
	PTX5000 PIC Components

	PTX3000 PIC Description
	PIC Slots
	PIC Function
	PICs Supported
	PIC Components

	100-Gigabit Ethernet OTN Optical Interface Specifications
	OTU4 4I1-9D1F Optical Interface Specifications

	100-Gigabit DWDM OTN PIC Optical Interface Specifications
	100-Gigabit DWDM OTN PIC (PTX Series)
	Software Release
	Hardware Features
	Software Features
	Cables and Connectors
	LEDs
	Alarms, Errors, and Events

	100-Gigabit Ethernet OTN PIC with CFP2 (PTX Series)
	Software Release
	Hardware Features
	Software Features
	Cables and Connectors
	LEDs

	100-Gigabit Ethernet PIC with CFP2 (PTX Series)
	Software Release
	Hardware Features
	Software Features
	Cables and Connectors
	LEDs
	Alarms, Errors, and Events

	100-Gigabit Ethernet PIC with CFP (PTX Series)
	Software Release
	Hardware Features
	Software Features
	Cables and Connectors
	LEDs
	Alarms, Errors, and Events

	100GbE PICs for PTX Series Routers
	Architecture and Key Components

	P2-10G-40G-QSFPP PIC Overview
	Understanding Dual Configuration on P2-10G-40G-QSFPP PIC
	Port Numbering on P2-10G-40G-QSFPP PIC
	10-Gigabit Ethernet Mode
	40-Gigabit Ethernet Mode

	Understanding the P2-100GE-OTN PIC
	Interface Features
	Layer 2 and Layer 3 Features
	OTN Alarms and Defects
	TCA Alarms

	100-Gigabit DWDM OTN PIC with CFP2 (PTX Series)
	Software Release
	Hardware Features
	Software Features
	Cables and Connectors
	LEDs
	Alarms, Errors, and Events

	100-Gigabit DWDM OTN MIC with CFP2
	100-Gigabit Ethernet OTN Options Configuration Overview
	Configuring the 10-Gigabit or 100-Gigabit Ethernet DWDM Interface Wavelength

	Chapter 53: Overview of Optical ILAs and IPLCs
	Optical ILA Hardware Component Overview
	Optical ILA Cooling System Description
	Fan Modules

	Optical ILA AC Power Supply Description
	Optical ILA DC Power Supply Description
	Optical ILA Chassis Status LEDs
	Optical ILA Component Redundancy
	Optical ILA Field-Replaceable Units
	Optical ILA Management Panel
	Optical ILA Management Port LEDs
	Optical Inline Amplifier Description
	Front Panel
	FRU Panel

	Optical ILA Power Supply LEDs
	PTX3000 IPLC Description
	IPLC Base Module
	IPLC Base Module Components

	IPLC Expansion Module
	IPLC Components


	IPLC Architecture and Functional Components Overview
	Architecture Overview
	Single Node Two Optical Line Terminations

	Functional Component Overview
	IPLC Base Module Functional Components
	IPLC Expansion Module Functional Components


	Understanding IPLC Base and Expansion Modules
	Overview
	Configuring, Managing, and Monitoring the IPLC
	SNMP
	Connectivity Services Director
	Optical Supervisory Channel

	High Availability, Resiliency, and Integrity
	Usability, Serviceability, Security and Troubleshooting
	Performance Monitors

	Usage Scenarios
	Optical Bypass Node Configuration


	Understanding the IPLC Configuration
	Understanding the Front Panel Connections
	Slot Placement in the Chassis
	Understanding How to Configure the Add and Drop Ports
	Frequency, Wavelength, and Port Default Mapping Configuration

	PTX3000 IPLC LED
	Communication of SNMP Traps Between Optical ILA and NMS Systems
	Communication of SNMPv2 and SNMPv3 Commands over OSC Between an Optical ILA and NMS
	Overview of Configuring and Managing Optical ILAs from Connectivity Services Director Using DMI
	Configuration Settings Performed Using the CLI
	Set Parameters for SNMP
	Get Parameters for SNMP
	Alarms

	IPLC Specifications
	Understanding the Performance Monitors and TCAs for IPLCs

	Chapter 54: Configuring and Monitoring Optical Interfaces, OTUs, and ODUs
	Viewing a Graphical Image of the Optical Interface Components
	Configuring and Managing OTN Port Details of MX Series and PTX Series Routers for Easy Administration
	Configuring and Managing OTU Details of MX Series and PTX Series Routers for Simplified Management
	Configuring and Managing ODU Details of MX Series and PTX Series Routers for Simplified Management
	Configuring and Managing Optical PIC Details for Effective Provisioning
	Configuring Threshold-Crossing Alarms for OTN Ports for Monitoring Link Performance
	Configuring Threshold-Crossing Alarms for OTUs for Monitoring Link Performance
	Configuring Threshold-Crossing Alarms for ODUs for Monitoring Link Performance
	Viewing Performance Monitoring Details of OTN Ports for Detecting and Diagnosing Faults
	Viewing Performance Monitoring Details of OTUs for Detecting and Diagnosing Faults
	Viewing Performance Monitoring Details of ODUs for Detecting and Diagnosing Faults
	Viewing a Graphical Image of the Chassis of PTX Series Routers
	Diagnosing, Examining, and Correcting Optical Interface Problems
	Optical Alarms, 24 Hour Threshold-Crossing Alarms (TCA), and 15 Minute Threshold-Crossing Alarms (TCA)
	OTU Alarms, 24 Hour Threshold-Crossing Alarms (TCA), and 15 Minute Threshold-Crossing Alarms (TCA)
	ODU Alarms, 24 Hour Threshold-Crossing Alarms (TCA), and 15 Minute Threshold-Crossing Alarms (TCA)

	Changing Alarm Settings for the Optics and OTN Interfaces
	Alarms for Optical Interfaces
	Alarms for OTN Interfaces
	Configuring Global Alarm Notifications
	Retaining Alarm History
	Specifying Event History
	Enabling Alarms
	Changing the Severity of Individual Alarms
	Configuring Threshold Alarms
	Configuring Individual Alarm Notifications


	Chapter 55: Configuring and Monitoring Optical Inline Amplifiers
	Viewing a Graphical Image of Optical Inline Amplifier
	Viewing Optical ILA Configuration and Status Details for Simplified Administration
	Viewing Performance Monitoring Details of Optical ILAs for Detecting and Diagnosing Faults
	Configuring Threshold-Crossing Alarms for Optical ILAs for Monitoring Link Performance
	Changing Alarm Settings for the Optical ILAs
	Alarms for Optical ILAs
	Configuring Global Alarm Notifications
	Retaining Alarm History
	Specifying Event History
	Enabling Alarms
	Changing the Severity of Individual Alarms
	Configuring Threshold Alarms
	Configuring Individual Alarm Notifications


	Chapter 56: Configuring and Monitoring Optical Integrated Photonic Line Cards
	Viewing a Graphical Image of the Optical Integrated Photonic Line Card
	Configuring Optical IPLC for Easy and Optimal Deployment
	Viewing Performance Monitoring Details of Optical IPLCs for Detecting and Diagnosing Faults
	Configuring Threshold-Crossing Alarms for Optical IPLCs for Monitoring Link Performance
	Increasing the Add and Drop Port Capacity of the IPLC Node to 64 Channels
	Configuring a Two-Degree IPLC Node for Express Traffic by Increasing the Line Capacity
	Configuring Optical IPLC Line Connectivity for Interoperation with Optical ILAs
	Configuring the Wavelengths That Are Added and Dropped by the IPLC
	Configuring the IPLC to Add or Drop Wavelengths to an Optical Interface on a Remote Chassis
	Configuring the IPLC to Add or Drop Wavelengths to an Optical Interface on the Same Chassis
	Bypassing a Wavelength on the IPLC
	Changing Alarm Settings for the Optical IPLCs
	Alarms for Optical IPLCs
	Configuring Global Alarm Notifications
	Retaining Alarm History
	Specifying Event History
	Enabling Alarms
	Changing the Severity of Individual Alarms
	Configuring Threshold Alarms
	Configuring Individual Alarm Notifications

	Viewing Routing Engine Switchover Indicators in the Chassis Image
	Routing Engine Redundancy Overview
	Conditions That Trigger a Routing Engine Failover

	Viewing Alarm Indicators in the Chassis Image
	Viewing Port Statistics for OTN PICs
	Example: Configuring Two Fiber Line Terminations Using IPLCs for Optical Amplification in a Metro Linear Packet Optical Network
	Requirements
	Overview
	Topology

	Configuration
	Configuring the IPLC Base Module at Node A
	Configuring the Two IPLC Base Modules at Node B
	Configuring the IPLC Base Module at Node C

	Verification
	Verifying the Topology of Each IPLC Node




	Part 18: Working with User Roles
	Chapter 57: Managing User Roles
	Creating a User-Defined Role
	Managing Roles
	Viewing User Role Details
	Performing Manage Roles Commands



	Part 19: Working with Tunnel Services
	Chapter 58: Tunnel Services Overview
	Tunnel Services Overview
	Traffic Engineering Capabilities
	Components of Traffic Engineering
	Packet Forwarding Component
	Packet Forwarding Based on Label Swapping
	How a Packet Traverses an MPLS Backbone

	Information Distribution Component
	Path Selection Component
	Signaling Component

	Routers in an LSP
	How a Packet Travels Along an LSP
	Types of LSPs
	Scope of LSPs
	Constrained-Path LSP Computation
	How CSPF Selects a Path

	CSPF Path Selection Tie-Breaking
	Computing CSPF Paths Offline

	MPLS and RSVP Overview
	RSVP Overview

	Fast Reroute Overview
	Point-to-Multipoint LSPs Overview
	RSVP Operation Overview
	RSVP Hello Packets and Timers
	RSVP Message Types
	Path Messages
	Resv Messages
	PathTear Messages
	ResvTear Messages
	PathErr Messages
	ResvErr Messages
	ResvConfirm Messages

	MTU Signaling in RSVP

	Link Protection and Node Protection
	Node Protection
	LSP Protection Overview
	LSP Protection Types Comparison
	One-to-One Backup Implementation
	Facility Backup Implementation

	Connectivity Services Director–NorthStar Controller Integration Overview

	Chapter 59: Service Design and Provisioning: Managing and Deploying Tunnel Services
	Managing Devices and Tunnel Services Overview
	Discovering Tunnel Devices
	Creating an LSP Service Definition
	Specifying General Settings
	Specifying Path Settings
	Specifying BFD Settings
	Reviewing the Configured Settings

	Creating an LSP Service Order
	Configuring LSP Service Order General Settings
	Configuring LSP Service Order Advanced Settings
	Configuring Common Settings
	Configuring LSP Path Settings in the Service Order
	Configuring BFD Settings for LSPs in the Service Order

	Creating a Name Pattern for LSPs in the Service Order
	Configuring Node Parameters for LSPs in the Service Order
	Configuring MPLS Path Settings
	Configuring LSP Primary Path Settings
	Configuring LSP Secondary Path Settings
	Reviewing the Configured Settings

	Creating Public and Private LSPs
	Managing Public LSPs by using NorthStar Controller
	Creating Private LSPs by Using Connectivity Services Director

	Viewing the Configured LSP Services
	Modifying an Explicit Path in RSVP LSP Services
	Modifying an RSVP LSP Service
	Viewing LSP Services in Deploy Mode
	Viewing LSP Service Orders in a Table
	Deactivating an LSP Service
	Reactivating an LSP Service
	Force-Deploying an LSP Service
	Viewing Alarms for an LSP Service
	Managing Deployment of LSP Services Configuration to Devices
	Selecting Configuration Deployment Options
	Discarding the Pending Configurations
	Deploying Service Configuration Changes to Devices Immediately
	Scheduling Configuration Deployment of Services
	Specifying Configuration Deployment Scheduling Options

	Deploying an LSP Service
	Deleting a Partial Configuration of an LSP Service Order
	Deleting an LSP Service Order
	Validating the Pending Configuration of an LSP Service Order
	Viewing the Configuration of a Pending LSP Service Order
	Viewing the Configuration Details of RSVP LSP Services
	Viewing Decommissioned LSP Service Orders

	Chapter 60: Monitoring and Troubleshooting Tunnel Services
	Performing a Functional Audit for LSP Services
	Viewing Functional Audit Results for LSP Services
	Examining the LSP Summary Details for Effective Troubleshooting
	Operational Status
	Status Matrix
	LSP Information
	LSP Traffic

	Troubleshooting the Endpoints of RSVP LSP Services
	Troubleshooting Services Using Operational Scripts

	Clearing LSP Statistics
	Monitoring Network Reachability by Using the MPLS Traceroute Capability
	Monitoring Network Reachability by Using the MPLS Ping Capability for RSVP LSPs


	Part 20: Appendix: Managing Network Activate Features Using the Older Version of Services Activation Director
	Chapter 61: Service Design: Working with E-Line, IP, and E-LAN Service Templates
	Service Templates Overview
	Service Templates Workflow
	Service Designer Tasks
	Service Provisioner Tasks

	Applying a Service Template to a Service Definition
	Creating a Service Template
	Naming a Template and Selecting Configuration Options
	Configuration Options, Their Data Types and the Tabs Displayed

	Deleting a Service Template
	Exporting a Service Template
	Finding Configuration Options
	Importing a Service Template
	Modifying a Service Template
	Specifying Service-Specific Values
	User Privileges in Service Templates
	Provisioning Dynamic Attributes to Specify the Device XPath
	Viewing Service Template Inventory

	Chapter 62: Service Provisioning: Working with Threshold Alarm Profiles
	Creating a Threshold Alarm Profile
	Viewing Threshold Alarm Profile Performance Parameters
	Attaching a Threshold Alarm Profile to a Service Definition
	Viewing Threshold Alarm Profile Performance Status
	Editing a Threshold Alarm Profile



